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Dear Reader,

Thank you for choosing Mastering Autodesk Inventor 2014 and Autodesk Inventor LT 2014. This 

book is part of a family of premium-quality Sybex books, all of which are written by outstand-

ing authors who combine practical experience with a gift for teaching.

Sybex was founded in 1976. More than 30 years later, we’re still committed to producing consis-

tently exceptional books. With each of our titles, we’re working hard to set a new standard for 

the industry. From the paper we print on, to the authors we work with, our goal is to bring you 

the best books available.

I hope you see all that refl ected in these pages. I’d be very interested to hear your comments and 

get your feedback on how we’re doing. Feel free to let me know what you think about this or 

any other Sybex book by sending me an email at nedde@wiley.com. If you think you’ve found 

a technical error in this book, please visit http://sybex.custhelp.com. Customer feedback is 

critical to our efforts at Sybex. 

 Best regards,

 

 Neil Edde

 Vice President and Publisher

 Sybex, an Imprint of Wiley

mailto:nedde@wiley.com
http://sybex.custhelp.com


To Jennifer for all of the love, support, and 

encouragement.
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Introduction

The Autodesk® Inventor® program was introduced in 1999 as an ambitious 3D parametric 

modeler based not on the familiar AutoCAD® software programming architecture but instead 

on a separate foundation that would provide the room needed to grow into the fully featured 

modeler it is now, over a decade later. Autodesk Inventor 2014 continues the development 

of Autodesk Inventor with improved modeling, drawing, assembly, and visualization tools. 

Autodesk has set out to improve this release of Autodesk Inventor by devoting as much time 

and energy to improving existing tools and features as they have to adding new ones.

With this book, the sixth edition of Mastering Autodesk Inventor and Autodesk Inventor LT, I 

have set out to update the existing pages and add new content and exercises. In these pages, 

you will fi nd detailed information on the specifi cs of the tools and the principles of sound para-

metric design techniques. Some readers will fi nd this book works best for them as a desktop 

reference, whereas others will use it primarily for the step-by-step tutorials. With this in mind, 

I’ve worked to shape the pages of this book with a mix of reference material, instructional steps, 

and tips and hints from the real world.

Who Should Read Th is Book
Th is book is written with a wide range of Autodesk Inventor users in mind, varying from 

beginner to advanced users and Autodesk Inventor instructors:

 ◆ Beginner Autodesk Inventor users who are making the move from traditional 2D CAD 

design to Autodesk Inventor 2014. These readers might have experience with AutoCAD, 

and will possess an understanding of basic design and engineering concepts as well as a 

desire to improve their skill set and stay competitive in the marketplace.

 ◆ Intermediate Autodesk Inventor users who are self-taught or have gone through formal 

Autodesk Inventor training during their company’s initial implementation of Autodesk 

Inventor, and are looking for more information on a specifi c module within Autodesk 

Inventor. This book also targets users looking for a desktop reference to turn to when they 

come upon an area of Autodesk Inventor they do not encounter on a day-to-day basis.

 ◆ Advanced Autodesk Inventor users who have mastered the Autodesk Inventor tools used 

over and over daily but want to conquer the parts of the program they do not utilize during 

their normal design tasks. This book also targets advanced users who want to add to their 

skill set to move up the ranks within their current company or want to expand their knowl-

edge in pursuit of a new position with another employer.
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 ◆ Autodesk Inventor users of any skill and experience level who are preparing for the 

Autodesk Inventor Associate or Professional exam.

 ◆ CAD and engineering instructors looking for a text to use in instructor-led classroom 

training.

Attempting to learn all the tools in Autodesk Inventor can be an intimidating experience 

because of the wide range of task-specifi c modules available. It is the goal of this book to sepa-

rate these modules into easy-to-tackle chapters relating to real-world situations for which the 

tools were designed while also including chapters on general Autodesk Inventor tools, tech-

niques, and design principles.

What You Will Learn
The following pages will explain the Autodesk Inventor settings while teaching you how each 

tool functions. Just as importantly, though, these pages are fi lled with the tips and techniques 

learned by the experts who spent years using, researching, and discussing the tools in Autodesk 

Inventor. You should come away from reading this book with a solid understanding of the capa-

bilities of Autodesk Inventor and a strong idea of how to tackle your design challenges in the 

future, as well as an abundance of time-saving tips and tricks.

What You Will Need
The fi les needed to complete the tutorial projects in this book can be downloaded from the 

Sybex website at the following location:

www.sybex.com/go/masteringinventor2014

Download the collection of ZIP fi les and extract all of the fi les to a folder on your computer, 

such as \My Documents\Mastering Inventor 2014. In this folder you will have a subdirec-

tory for each of the 20 chapters, plus a couple of other folders, as well as a fi le called Mastering 

Inventor 2014.ipj, as shown here:

Once the fi les are in place, set the Mastering Inventor 2014 project as the active project by fol-

lowing these steps. Note that if you are using Autodesk Inventor LT, the use of project fi les does 

not apply, and you can skip these steps:

http://www.sybex.com/go/masteringinventor2014
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 1. From within Autodesk Inventor, close any open fi les.

 2. From the Get Started tab, select the Projects button.

 3. From the Projects dialog box, select the Browse button.

 4. From the Choose Project File dialog box, browse to the Mastering Inventor 2014 folder, 

select the Mastering Inventor 2014.ipj fi le, and click Open.

 5. Note that the Mastering Inventor 2014 project is denoted with a check mark as being the 

active project.

 6. Click Done to close the Projects dialog box. Now you are ready to get started.

Free Autodesk Software for Students and Educators

Th e Autodesk Education Community is an online resource with more than fi ve million members 

that enables educators and students to download—for free (see website for terms and condi-

tions)—the same software used by professionals worldwide. You can also access additional tools 

and materials to help you design, visualize, and simulate ideas. Connect with other learners to stay 

current with the latest industry trends and get the most out of your designs. Get started today at 

www.autodesk.com/joinedu.

To install and run Autodesk Inventor, you should consult the system requirements informa-

tion found on the installation media and ensure that you have a system capable of running 

Autodesk Inventor adequately. For basic educational purposes, dealing with small tutorial-sized 

assemblies, Autodesk recommends a minimum of 2 GB of RAM and 16 GB of available hard disk 

space to accommodate the installation fi les and temporary fi les created during the installation. 

Note that these are the minimum requirements to install and run the program, and you might 

see slow performance when executing operations that require heavy calculations.

I recommend a system with a minimum of 6 GB of RAM for doing production work on 

moderate-sized assemblies, and encourage you to consider an appropriate workstation for under-

taking large assembly design.

Th e Mastering Series
The Mastering series from Sybex provides outstanding instruction for readers with intermediate 

and advanced skills in the form of top-notch training and development for those already work-

ing in their fi eld, as well as clear, serious education for those aspiring to become pros. Every 

Mastering book includes the following:

 ◆ Real-world scenarios, ranging from case studies to interviews, that show how the tool, 

technique, or knowledge presented is applied in actual practice

 ◆ Skill-based instruction, with chapters organized around real tasks rather than abstract 

concepts or subjects

 ◆ Self-review test questions, so you can be certain you’re equipped to do the job right

http://www.autodesk.com/joinedu


XXX | INTRODUCTION

What Is Covered in Th is Book
This is what the book covers:

 ◆ Chapter 1, “Getting Started With Autodesk Inventor,” introduces the Autodesk Inventor 

interface, project setup, and the concept of parametric 3D design.

 ◆ Chapter 2, “A Hands-on Test Drive of the Workfl ow,” explores the general workfl ow of 

modeling parts, creating detailed drawings of those parts, assembling those parts, and 

then detailing the assembly.

 ◆ Chapter 3, “Sketch Techniques,” explores the principles of creating parameter-driven 

sketches for use in modeling features and parts.

 ◆ Chapter 4, “Basic Modeling Techniques,” conquers creating parametric features and 

building 3D parts models.

 ◆ Chapter 5, “Advanced Modeling Techniques,” explores complex feature creation, including 

sweeps, lofts, and more.

 ◆ Chapter 6, “Sheet Metal,” covers how to create accurate sheet-metal models and fl at pat-

terns as well as how to create documentation and set up sheet-metal styles and templates.

 ◆ Chapter 7, “Reusing Parts and Features,” examines the different methods for reusing parts 

and features for maximum consistency and design effi ciency.

 ◆ Chapter 8, “Assembly Design Workfl ows,” gives you a thorough understanding of this key 

concept of Autodesk Inventor design, including the use of Assembly constraints, subassem-

blies, and more.

 ◆ Chapter 9, “Large Assembly Strategies,” explores tips and techniques to getting the best 

performance out of your Autodesk Inventor workstation and considers upgrade require-

ments for the future.

 ◆ Chapter 10, “Weldment Design,” explores the Autodesk Inventor weldment modeling 

environment and the weldment documentation tools.

 ◆ Chapter 11, “Presentations and Exploded Views,” gives you a thorough look at the 

presentation tools used to create exploded assembly views and animated assembly 

instructions.

 ◆ Chapter 12, “Documentation,” covers how to use the Drawing Manager to create 

traditional 2D annotated drawings.

 ◆ Chapter 13, “Tools Overview,” examines this collection of Autodesk Inventor utilities, 

including AutoLimits, the Design Assistant, the Drawing Resource Transfer Wizard, style 

tools, and much more.

 ◆ Chapter 14, “Exchanging Data with Other Systems,” shows the available options for 

importing and working with solid models from other CAD packages.

 ◆ Chapter 15, “Frame Generator,” covers how to get the most out of this utility when creating 

structural frames from the Autodesk Inventor library of common shapes.
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 ◆ Chapter 16, “Inventor Studio,” covers this powerful toolset to create photorealistic images 

and animations of all your Autodesk Inventor models.

 ◆ Chapter 17, “Stress Analysis and Dynamic Simulation,” explores the simulation tools used 

to analyze load stress and mechanism motion on your models.

 ◆ Chapter 18, “Routed Systems,” covers the cable and wire harness and tube and pipe envi-

ronments and their uses in creating routed design layouts.

 ◆ Chapter 19, “Plastics Design Features,” explores the tools used specifi cally for plastics design 

as well as the general tools used in specifi c ways for plastics design. Also included is the 

Autodesk Inventor Tooling module used to design mold tooling for plastic-part design.

 ◆ Chapter 20, “iLogic,” introduces and explores the iLogic tools used to customize, confi gure, 

and automate your Autodesk Inventor design fi les. This chapter provides a solid founda-

tion in the rules-based iLogic programming toolset and interface, allowing you to move 

forward with your advanced automation and confi guration goals.

 ◆ Appendix A, “The Bottom Line,” gathers together all the self-testing Master It problems 

from the chapters and provides a solution for each.

 ◆ Appendix B, “Autodesk Inventor Certifi cation,” points you to the chapters in this book that 

will help you master the objectives for each exam.

Autodesk Inventor LT, Autodesk Inventor, 
and Autodesk Inventor Professional
The Autodesk Inventor mechanical CAD software is available in three primary product con-

fi gurations that offer specifi c levels of functionality to fi t the needs of different users. This 

book contains information that relates to all three of these versions of the Autodesk Inventor 

software. Depending on the version you have installed, you might fi nd that parts of this book 

are relevant to your version. For instance, if you have Autodesk Inventor LT installed, you will 

fi nd that Chapter 8 of this book will not apply to your version, since Autodesk Inventor LT does 

not include tools used for assembly design. Similarly, if you have Autodesk Inventor installed, 

you’ll fi nd that Chapter 17 does not apply to your version, since that chapter addresses tools 

found only in Autodesk Inventor Professional. To gain a better understanding of your version 

of the Autodesk Inventor software and how it relates to each subject in this book, please refer to 

the feature comparison matrix provided by Autodesk online. You can fi nd this by visiting the 

Autodesk website and clicking the Features link.

How to Contact the Author
I welcome your feedback concerning Mastering Autodesk® Inventor® 2014 and Autodesk® Inventor 

LT™ 2014. I want to hear what you liked, what you didn’t, and what you think should be in 

the next edition. And if you catch me making a mistake, please tell me so that I can fi x it on the 

errata page (available at www.sybex.com/go/masteringinventor2014) and in reprints. Please 

email me at inventormasters@gmail.com, or contact Wiley customer service at http://

support.wiley.com.

http://www.sybex.com/go/masteringinventor2014
mailto:inventormasters@gmail.com
http://support.wiley.com
http://support.wiley.com
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Thank you for purchasing Mastering Autodesk® Inventor® 2014 and Autodesk® Inventor LT™ 

2014. I hope it helps you on your way to happy and successful inventing, and I look forward to 

hearing your comments and questions. You can fi nd additional tips and tricks online at my blog 

spot, http://inventortrenches.blogspot.com/, and by visiting the Autodesk Discussion 

Groups at http://forums.autodesk.com/.

http://inventortrenches.blogspot.com
http://forums.autodesk.com


Chapter 1

Getting Started with Autodesk® 
Inventor®

In this chapter, you will be introduced to the concept of parametric 3D design and the general 

tools and interface of Inventor. This chapter will focus on the concepts of parametric modeling 

and the workfl ow, tools, and interface elements found in the Autodesk® Inventor® software that 

are used to turn your ideas into a design.

In this chapter, you’ll learn to:

 ◆ Create parametric designs

 ◆ Get the “feel” of Inventor

 ◆ Use the Inventor graphical interface

 ◆ Work with Inventor fi le types

 ◆ Understand how project search paths work

 ◆ Set up library and Content Center paths

 ◆ Create and confi gure a project fi le

 ◆ Determine the best project type for you

Understanding Parametric Design
Autodesk Inventor is fi rst and foremost 3D parametric modeling software. And although it 

has capabilities reaching far beyond the task of creating 3D models, it is important for you to 

understand the fundamentals of parametric 3D design. The term parametric refers to the use of 

design parameters to construct and control the 3D model you create. For instance, you might 

begin a design by creating a base sketch to defi ne the profi le of a part. In this sketch you would 

use dimensions as parameters to control the length and width of the sketch. The dimensional 

parameters allow you to construct the sketch with precise inputs.

Creating a Base Sketch
Well-constructed parts start with well-constructed sketches. Typically, the 3D model starts with 

a 2D sketch, which is assigned dimensions and 2D sketch constraints to control the general size 

and shape. These dimensions and constraining geometries are the parameters, or input points, 

that you would then change to update or edit the sketch. For instance, Figure 1.1 shows a base 

sketch of a part being designed.
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Figure 1.1

Creating a paramet-

ric model sketch

You can see four dimensions placed on the two rectangles defi ning the length and width of 

each along with a fi fth dimension controlling the angle at which the two rectangles relate. These 

dimensions are parameters, and if you were to change one of them at any point during the 

design or revision of the part, the sketch would update and adjust to the change.

An important part of working with sketches is the concept of a fully constrained sketch. 

Fully constrained simply means that all of the needed dimensions and sketch constraints have 

been applied to achieve a sketch that cannot be manipulated accidentally or as an unintentional 

consequence of an edit. For instance, if you were to sketch four lines to defi ne a rectangle, you 

would expect two dimensions to be applied, defi ning the length and width. But you would also 

need to use 2D sketch constraints to constrain the lines so that they would stay perpendicular 

and equal to one another if one of the dimensions were to change. Without the sketch con-

straints, a dimensional edit to make the rectangle longer might result in a trapezoid or a paral-

lelogram rather than the longer rectangle you anticipated. By fully constraining a sketch, you 

can anticipate the way in which it will update. Inventor helps you with this concept by automati-

cally applying many sketch constraints, and by reporting when a sketch is fully constrained. 

This will be covered in more detail in Chapter 3, “Sketch Techniques.”

Creating a Base Feature
Not only do you add 2D sketch parameters; you also add parameters to control the 3D proper-

ties of parts. This is done by using the sketch to create a feature such as an extrusion to give a 

depth value to the sketch. The depth dimension is a parameter as well, and it can be updated at 

any time to adjust the part model as required. Figure 1.2 shows the sketch from Figure 1.1 after it 

has been given a depth using the Extrude tool.

Figure 1.2

A basic part model 

created from the 

sketch
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Adding More Features
Once the part is three-dimensional, more sketches can be added to any of the faces of the 3D 

shape, and those new sketches can be used to create some feature that further defi nes the form 

and function of the design. The model is then enhanced with more features, such as holes, fi l-

lets, and chamfers, until it is complete. Each added feature is controlled by still more parameters 

defi ned by you, the designer. If a change is required, you simply update the parameter and the 

model updates accordingly. This type of parametric design allows you to build robust and 

intelligent models very quickly and update them even faster. Figure 1.3 illustrates the typical 

workfl ow of adding secondary features to a base feature to fully realize the part design, in this 

case a simple pivot link.

Figure 1.3

Adding features to 

complete the part 

model

ExtrudeCreate
2D Sketch

Fillet Hole
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Using the Part in an Assembly
Just as well-constructed parts start with well-constructed sketches, well-constructed assemblies 

start with well-constructed parts. Once the part model is built up from the features you create, 

you can use it in an assembly of other parts created in the same manner. You can copy the part 

to create multiple instances of the same part, and you can copy the part fi le to create variations 

of the original part. To assemble parts, you create geometric relationships called assembly con-
straints defi ning how the parts go together. The constraints are parameters that can be defi ned 

and revised by you at any time in the design process as well. Part models can be arranged into 

small assemblies and placed into larger assemblies to create a fully realized subassembly struc-

ture that matches the way your design will be built on the shop fl oor. Figure 1.4 shows the part 

model from the previous illustrations placed multiple times in a subassembly, and then that 

subassembly placed in a top-level assembly.

Making Changes
Once parts are created, they are then used in assemblies, which also employ parameters to 

defi ne the offsets and mating relationships between assembled parts. Designing with the use of 

parameters allows you to make edits quickly and lends itself to creating product confi gurations, 

where parameter values are changed to create variations of a basic design.

Of course, as with building anything, there are general rules and best practices to be learned 

and followed to prevent your work from “falling apart.” For instance, what if the pivot link used 

in the previous examples were to incur a design change that made one leg of the link longer? 

How would the holes be affected? Should they stay in the same place? Or should they stay at 

some defi ned distance from one end or the other?
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Figure 1.4

A subassembly and 

an assembly model 

using the part 

model

Anticipating changes to the model is a large part of being successful with Inventor. Imagine, 

for instance, that a simple design change required that the pivot link become 50 millimeters lon-

ger on one leg. This should be a simple revision that requires you only to locate the dimension 

controlling that leg length and change the parameter value. Unfortunately, if you did not follow 

the best-practices guidelines when creating the part originally, the change in the length might 

displace the secondary features such as holes and material cuts and require you to stop and fi x 

each of those as well. This is one of the most frustrating parts of learning Inventor for any new 

user who has not taken the time to learn or follow the known best practices of parametric mod-

eling. Fortunately for you, within the pages of this book you will learn how to create models 

that are easy to update and do not “fall apart” during design changes.

Understanding History-Based Modeling and Dependencies
Inventor is often referred to as a history-based modeler, meaning that as you create sketches 

and turn them into features and then add more features and still more features, each addition 

is based on a previous feature, and so the model is said to have history. This history is recorded 

and tracked in the Model browser. The Model browser is a panel that displays on-screen and 

shows every feature you create during the design of your part. Figure 1.5 shows the Model 

browser for the pivot link fi le.

You can see that each feature is listed in the browser in the order in which it was created, 

forming a history tree. To create a part that handles changes predictably, you must create a solid 

foundation on which to build the rest of the model. In most cases, when you are designing a part 

model you will start with a sketch, much like the one shown back in Figure 1.1. This base sketch 

will be your foundation, and therefore you must create it to be as stable as possible.

Each part, no matter what it is or what it looks like, has a set of origin geometry in the form 

of the origin planes, origin axes, and a single origin point. You can fi nd these origin features 

by expanding the Origin folder in the Model browser. Figure 1.5 shows the Origin folder not 

expanded. If you expand the Origin folder in any part or assembly fi le, you will see the 

following items:
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 ◆ YZ Plane, the plane that runs infi nitely in the Y and Z directions

 ◆ XZ Plane, the plane that runs infi nitely in the X and Z directions

 ◆ XY Plane, the plane that runs infi nitely in the X and Y directions

 ◆ X Axis, the axis running infi nitely in the X direction

 ◆ Y Axis, the axis running infi nitely in the Y direction

 ◆ Z Axis, the axis running infi nitely in the Z direction

 ◆ Center Point, the point found at zero in the X, zero in the Y, and zero in the Z directions

Figure 1.5

Th e Model browser 

showing the feature 

tree (history) of 

a part named 

Pivot_Link.ipt

When creating the base sketch of a part fi le, you typically start on one of the origin planes. 

Because the origin plane cannot be edited, deleted, redefi ned, or upset in any manner, this 

base sketch is inherently stable, and as a result, the base feature you create from it is stable as 

well. If the second sketch of your part is created on a 3D face of the base feature, this sketch is 

dependent on the base sketch and is considered slightly less stable than the base sketch. This 

is because the base sketch could be edited, deleted, or redefi ned in a way that would upset the 

secondary sketch.

Understanding how dependencies are created when a sketch and features are based on one 

another will help you avoid creating a “house of cards” that will fall apart if the base is upset. 

Although you could base all of your sketches and features on origin geometry to minimize 

dependencies, it is generally not practical to do so. It should be your goal, however, to keep the 

number of chained dependencies to a minimum. Assemblies work in much the same way, using 

the faces and edges of parts to constrain them together and as a result building dependencies 

between them. Just like part fi les, assembly fi les have origin planes, axes, and a center point that 

can be used to minimize chained dependencies, thereby creating a more stable model.

Taking a Closer Look at Sketch Dimensions
A large part of creating a stable sketch comes from understanding the way sketch dimensions 

work in Inventor. To do so, you might compare Inventor dimensions with standard 

dimensions in Autodesk® AutoCAD® software. When you create a design in AutoCAD, that 
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design process is not much different from creating the same design on a paper drawing. But in 

AutoCAD, you can draw precise lines, arcs, circles, and other objects and place them precisely 

and with accurate dimensions refl ecting your design in a way that you cannot do by hand. 

When a design requires modifi cation, you erase, move, copy, stretch, and otherwise manipulate 

the existing geometry more quickly than you can by hand as well. But other than those gains in 

speed and accuracy, the workfl ow is much the same as working with pencil and paper. In short, 

AutoCAD automates drafting tasks but does less to speed up and enhance the design process. 

By comparison, Inventor’s sketch dimensions allow you to add design parameters and a bit of 

intelligence to your sketches.

Driven Dimensions

Standard dimensions in AutoCAD are called driven or reference dimensions. A driven dimension 

is controlled by the geometry, and it refl ects the actual value of the geometry being referenced 

by the dimension. If you stretch a line, for example, the dimension attached to the line will 

update to the new value. If you think about it, the only reason for a dimension on a traditional 

AutoCAD drawing is to convey the value of a feature or part to the person who is going to build 

it. If you import that 2D fi le into a computer-aided manufacturing (CAM) software, no dimen-

sions are needed because the line work contains all the information about the part.

Parametric AutoCAD

Starting with AutoCAD 2010, you can create 2D parametric dimensions and constraints much as 

you can in Inventor.

Driving Dimensions

The workfl ow in Inventor sketching is substantially different from that in traditional AutoCAD, 

even beyond dimensions. In Inventor, you create sketches in 2D and then add geometric con-

straints such as Horizontal, Vertical, Parallel, and so on to further defi ne the sketch entities. 

Adding the geometric constraints allows line work to adjust in a predictable and desired 

manner and helps control the overall shape of the sketch. Once geometric constraints are in 

place, you add parametric driving dimensions to the sketch geometry. By changing the value of 

these driving dimensions, you change or drive the size of the sketch object. Because of this, the 

Inventor dimension is far more powerful than the standard AutoCAD dimension because it not 

only conveys the value of a feature or part but also serves as a design parameter, allowing you to 

change the dimension to update the design. This is done simply by double-clicking the dimen-

sion and typing in a new value. Figure 1.6 shows a dimension being edited in a sketch on the left 

and the result on the right. 

Part Modeling Best Practices
A solid sketch is the foundation on which stable parts are built. Many new users do not under-

stand the importance of having fully constrained sketches, and they fi nd it highly frustrating 

to have a model fail when a simple change is made, all because a sketch was not properly con-

structed. This frustration can be avoided by following some basic best practices.
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Figure 1.6

Editing Inventor 

sketch dimensions

Keep Sketches Simple

The most effective way to create a healthy sketch is to keep it simple. The purpose of keep-

ing your base sketch simple is to get it fully defi ned, leaving no part of it up for interpretation. 

Underdefi ned sketch entities (lines without defi ned lengths, circles without defi ned diameters, 

and so on) will most likely not update properly and will cause your sketches to distort and 

break when you try to update them. And because you often base the rest of your model on the 

initial sketch, your entire feature tree might incur errors, requiring you to stop and spend time 

rebuilding it again. Examine the sketch in Figure 1.1 and compare it to the fi nished shape shown 

in Figure 1.5. As you can see, the simple sketch containing two rectangles dimensioned at an 

angle defi nes the basic shape and is much easier to sketch and fully constrain than the fi nished 

shape would be.

If the idea of simple sketches seems at fi rst not to fi t the type of design you do, understand 

that most designs will benefi t from the simple-sketch philosophy. More important, if you start 

out employing simple sketches, you will more quickly master the sketch tools and then be ready 

to create more complex sketches when a design absolutely requires it.

Create Simple Features from Simple Sketches

Another aspect of creating simple sketches is that it allows you to create simple features. 

Parametric, feature–based modeling relies on the creation of numerous simpler features within 

the model to achieve a complex design in the end. By creating a number of features within the 

model, you are able to independently change or modify a feature without rebuilding the entire 

model. An example of editing a feature would be changing a hole size. If you create a simple 

rectangular base feature fi rst and then create a hole feature as a secondary feature to that base 

feature, you can make changes to both independently. By contrast, if you were to include a circle 

in your base sketch and use that to create the base feature with a circular profi le pocket, your 

hole would no longer be as easily updated. 

Pattern and Mirror at the Feature Level

Although there are mirror and pattern (array) tools in the sketch environment, it is generally 

best to create a single instance of the item in the sketch and then create a feature from it, and 

create a mirror or pattern feature from that feature. The logic behind this is based on the idea of 

keeping sketches simple and the anticipation of future edits. Should the mirror or pattern fea-

ture need to be updated, it is much easier to update it as a separate feature.
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Create Sketch-Based Features and Then Placed Features

Part features can be separated into two categories: sketch-based and placed. Sketch-based features, 
as you might guess, are created from sketches. Placed features are features such as fi llets and 

chamfers that are placed by using model edges or faces and have no underlying sketch. Issues 

arise when placed features are created too early in the development of the part because you 

may then be required to dimension to the placed feature, which creates a weak dependency. For 

instance, you might place rounded fi llet features along the edges of a part. Then you could use 

the tangent fi llet edges to defi ne the placement of a hole. But then if you realize that machining 

capabilities require a beveled chamfer edge rather than a rounded fi lleted one and delete the fi l-

let feature, the hole feature is sure to fail because the tangent fi llet edges used to defi ne the hole 

placement no longer exist. Keep this in mind as you create placed features such as fi llets and 

chamfers, and reserve placed features for the end stages of the part.

Understand Dependent and Independent Features

Parametric model features are typically either dependent or independent of one another. A 

dependent feature is dependent on the existence or position of a previously created feature. If 

that previously created feature is deleted, the dependent feature will either be deleted as well 

or become an independent feature. As mentioned earlier, each part fi le contains default origin 

geometry defi ning the x-axis, y-axis, and z-axis of the part. These origin features are used to 

create the fi rst sketch in every part by default. An independent feature is normally based on an 

origin feature or is referenced off the base feature.

For instance, to create the base feature for the pivot link, you would create a sketch on a 

default origin plane, such as the XY plane. Because the XY origin plane is included in every part 

fi le and cannot be changed, your base feature is stable and independent of any other features 

that may follow. To create a hole in the base feature, you would typically select the face of the 

base feature to sketch on. Doing so would make the hole feature dependent on the base feature. 

The hole feature is then inherently less stable than the base feature because it relies on the base 

feature to defi ne its place in 3D space.

Although the specifi cs of how sketches, features, and parts are created will be covered in the 

chapters to come, remember these principles concerning part fi le best practices, and you will 

fi nd Inventor (and any other parametric modeler) much more accommodating.

Assembly Modeling Best Practices
Once you’ve created part fi les, you will put them together to build an assembly. And when you 

do, you want to build it to be as stable as possible so that if you move, replace, or remove a part, 

the rest of the assembly will not fall apart. There are two entities to an assembly fi le: links to the 

component fi les (parts or subassemblies) it is made of and the geometric information about how 

those components fi t together. Basic assemblies are not much more than that, and understand-

ing those two concepts will go a long way toward building stable assemblies.

Understand File Linking and Relationships

The assembly fi le can be thought of as an empty container fi le to start. Once you place the fi rst part 

in the assembly, the assembly fi le contains a link to the fi le for that part. When you place a second 

part and fi t it to the fi rst, the assembly then contains links to the two fi les and the information 
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about how those parts go together in this particular assembly. If you decide to rename the fi rst 

part fi le, and do so using Windows Explorer, the assembly fi le will still look for the fi le by the old 

name. When this happens, you will be prompted with a fi le resolution dialog box asking you to 

locate the fi le. You can then browse and manually point the assembly to that fi le, and the assembly 

will record the new name in its internal link. If you decide to move the second part fi le to a folder 

other than its original, the assembly fi le might again prompt you to fi nd it manually, depending 

on the folder structure. It should be your goal to never need to resolve fi le links manually, and 

understanding this part of how assemblies work is the fi rst step in reaching that goal. In the com-

ing chapters you will learn how to set up Inventor properly so it can fi nd your fi les.

Always Maintain at Least One Grounded Component

To understand how grounded parts help you build stable assemblies, you should fi rst under-

stand a little about the assembly Model browser. Figure 1.7 shows the Model browser for an 

assembly model of a small hobby-type CNC router.

Figure 1.7

Th e Model browser 

showing the model 

tree of an assembly 

named Router.iam

The Model browser shows an assembly named Router Base at the top and under it three 

other subassemblies named Y-Axis Assembly, X-Axis Assembly, and Z-Axis Assembly. The 

Z-Axis Assembly is expanded in the browser so you can see the parts it contains as well. You 

should note that the Router Base subassembly is shown in the browser with a pushpin button. 

This denotes that this subassembly is grounded, or pinned in place, and its coordinates cannot 

accidentally change. Keeping one grounded component in each assembly will allow you to fi t 

other parts to it without it moving or rotating off the x-, y-, and z-coordinates.

Recall the old carnival game where you throw a ball at a pyramid stack of metal bottles. To 

win the game, you had to knock down all the bottles. However, if the bottle in the center on the 

bottom were nailed down, it would be impossible to win the game, and as a matter of physics, it 

would be diffi cult to knock down the bottles next to it. Having a grounded component in your 

assemblies, one that is “nailed down,” will likewise keep your assemblies from falling over as 

you build onto them. By default, the fi rst component you place into an empty assembly fi le will 

automatically be grounded. You can unground it and ground another if need be, but you should 

always maintain at least one grounded component. You can also have more than one grounded 

component.



10 | CHAPTER 1 GETTING STARTED WITH AUTODESK® INVENTOR®

Make Your Models Mimic the Manufacturing Process

The simplest advice that new users can receive on the subject of assemblies is to structure them 

as you would in real life. For example, if in the design you plan to assemble several parts into a 

transmission and then drop that transmission into a housing, you should make the transmis-

sion a subassembly and insert it into the upper-level housing assembly. Alternatively, a new 

user might place all the parts into one big assembly, only to later realize that subassemblies are 

needed for the purpose of getting the bill of materials (BOM) organized. This can be accom-

plished by using the Demote assembly tool to create the subassemblies and then demote the 

parts from the top-level assembly to these new subassemblies. By making your models mimic 

the manufacturing process, you can also fi nd possible fl aws in your design, such as fasteners 

that cannot be accessed or areas where parts may interfere with each other during assembly.

In some instances a model will be developed in the research and development (R&D) 

department and then handed to the manufacturing engineering (ME) department to be built. 

Although the people in R&D may enjoy the freedom of “dreaming up” anything they can think 

of, an effective R&D designer will always think about what can actually be built within the 

capabilities of the shop fl oor. Keep this in mind during the initial development cycle, and it will 

prevent those downstream from having to re-create much of your work. However, if restruc-

turing the components into more or fewer subassemblies is required after the initial design, 

Inventor has demote and promote tools to assist with that. These tools will be covered in the 

chapters to come.

Constrain to Origin Geometry

As mentioned earlier in this chapter, each part fi le has default origin geometry built in. You 

should build parts around the origin geometry whenever possible. For instance, a transmission 

has gears, bearings, seals, and so on that are all concentric with the shaft. If you model all the 

parts so their x-axes will be aligned in the assembly, then you can use the x-axis of each part 

to constrain to in the assembly and it will be much more stable. However, if you constrain the 

parts by selecting model features, you run the risk of constraints failing once a revision to a part 

changes or removes the originally referenced geometry. To build a completely “bulletproof” 

assembly, you could constrain the origin geometry of each part to the origin geometry of the 

assembly. In this way, no matter how the geometry of the parts changes, it will not cause issues 

with assembly constraints.

You will learn more about how to create assemblies, set up search paths to avoid manual 

fi le resolutions, and work with grounded components in the coming chapters, but you should 

remember these concepts and work to abide by them.

Understanding the “Feel” of Inventor
To the new user, the ever-changing Inventor interface may seem a bit disorienting. Taking a few 

minutes to understand why menus and tools change from one context to another will go a long 

way in getting comfortable with the “feel” of Inventor and anticipating the way the user inter-

face works. If you’ve used other applications with the Microsoft ribbon-style interface, you’re 

probably already familiar with much of this context-specifi c behavior.
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Understanding the Intuitive Interface
The overall user interface of Inventor might be called context intuitive, meaning that menus 

change depending on the task and the environment. Inventor is organized by tools grouped 

onto tabs, offering only the tools needed for the appropriate task at hand. If you are sketching a 

base feature, the tools you see are sketch tools. In Figure 1.8, the Sketch tab is active, and the 

displayed tools are the ones used to create and dimension sketches.

Figure 1.8

Th e Sketch tab and 

sketch tools

Upon the completion of a sketch, click the Finish Sketch button on the far right, and you 

will exit the sketch. The 3D Model tab then becomes active and the Sketch tab is hidden. This 

allows you to see the tools that are appropriate for the immediate task, and only those tools, 

without having to hunt around for them among tools that are you are not able to use at the cur-

rent moment. If you create a new sketch or edit an existing one, the Sketch tab is immediately 

brought back. Figure 1.9 shows the active 3D Model tab.

Figure 1.9

Th e 3D Model tab 

and model tools

When you work with assemblies, the active tab changes to the Assemble tab (as shown in 

Figure 1.10), allowing you to place components, create new components, pattern them, copy 

them, and so on. When in the assembly environment, there are also a number of other tabs 

shown that you can manually switch to (by clicking on them) at any time to use the tools they 

contain. 

Figure 1.10

Th e Assemble tab 

and assembly tools

When you create a 2D drawing of parts or assemblies, you are automatically presented 

with tools needed to create views and annotation. By default, the Place Views tab is displayed 

because you need to create a view of a model before annotating it. However, you can manually 

switch to the Annotate tab by clicking it. Figure 1.11 shows the active Place Views tab and the 

inactive Annotate tab next to it.
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Figure 1.11

Th e drawing tabs 

and drawing tools

As you can see, the collection of tabs (called the Ribbon menu) changes intuitively with 

every task or environment you switch to. With this task-based user interface, there is no need 

to display every possible tool all at once. In the next section, you will explore more of the user 

interface.

Using General Tools vs. Specifi c Commands
In this section you’ll see how Inventor tools are set up, using AutoCAD tools as a comparison. 

If you’ve never used AutoCAD, you can still gain some insight from this section, although you 

may have to use your imagination concerning the references to AutoCAD. A key difference 

between AutoCAD and Inventor is that in AutoCAD, many commands are very specifi c. For 

example, there are different dimension commands for lines, angles, and circles. In contrast, 

Inventor has one General Dimension tool that creates the appropriate dimension based on what 

you select.

For instance, in AutoCAD you might select the horizontal dimension tool to place a dimen-

sion on a horizontal line, select the diameter dimension tool to place a dimension on a hole, 

select a radius dimension tool to place a dimension on a fi llet, and so on. But in Inventor you 

select the General Dimension tool and select a horizontal line, and you get a horizontal dimen-

sion; then, without exiting the General Dimension tool, you select a circle, and you automatically 

get a diameter dimension. And of course to dimension a fi llet, you continue with the General 

Dimension tool, and you will automatically get a radius dimension.

Drawing in AutoCAD Becomes Sketching in Inventor

The fundamental difference between traditional AutoCAD and Inventor is that in AutoCAD 

you draw and in Inventor you sketch. Th is diff erence sounds subtle, but it is very important. In 

AutoCAD, you likely construct lines precisely to specifi c dimensions to form the geometry required. 

In Inventor, you create lines and geometry that refl ect the general form and function of the feature 

and then use constraints and dimensions to coax it into the desired shape. Expecting Inventor to 

work just like AutoCAD is probably the single biggest stumbling block that experienced AutoCAD 

users face when starting to use Inventor.

When in Doubt, Right-Click
Inventor is very right-click–driven, meaning that many of the options are context specifi c and 

can be accessed by right-clicking the object in question. For instance, if you want to edit a 
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sketch, you right-click the sketch in the browser and choose Edit Sketch. The same is true of a 

feature. If you want to change a hole feature from a countersink to a counterbore, you right-click 

it in the browser and choose Edit Feature. You can also right-click many objects in the graphics 

window, with no need to locate them in the browser. Figure 1.12 shows a typical right-click con-

text menu with the default marking menu option enabled.

Figure 1.12

A typical 

right-click menu

Also worth mentioning are the options in the context menus. For instance, if you are editing 

a part in an assembly and want to fi nish the edit and return to the assembly level, you could 

use the Return button on the Sketch tab menu, or you could just right-click (taking care not to 

click any sketch object) and choose Finish Edit from the context menu. Both options do the same 

thing.

Traditional Right-Click Menus vs. the Marking Menus

When enabled, marking menus replace the traditional right-click context menu. Since marking 

menus are customizable, this book references the traditional right-click menu, so specifi c refer-

ences to items in the right-click menus may need to be interpreted if you choose to use the marking 

menus or have customized your marking menus. To enable or disable the marking menus, select 

Customize on the Tools tab of the ribbon and then select the Marking Menu tab. Th en check or 

uncheck the Use Classic Context Menu check box.

Selections from the marking menu can be made in either menu mode or mark mode.

Menu Mode  When you right-click in the graphics window, menu items surround the 

cursor. Simply click a menu item to select it.

Mark Mode  When you press and hold the right mouse button and immediately move the 

cursor in the direction of a known menu item, a “mark” trail appears. Release the mouse 

button to select the menu item corresponding to the direction of cursor movement in the 

marking menu.
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Using the Graphical Interface
The Inventor graphical interface might be different from what you are accustomed to in other 

general software applications and even different from other design software. In Figure 1.13, you 

see the entire Inventor window, which shows a part fi le open for editing.

Figure 1.13

Th e complete 

Inventor screen in 

part modeling mode

Inventor Title Bar
Starting at the upper left of the Inventor window, you’ll see the Inventor button (look for the 

large I character), which has a drop-down panel similar to the File menu in previous versions. 

Next to the Inventor button the title bar includes two toolbars:

 ◆ The Quick Access bar has frequently used tools.

 ◆ The Help toolbar provides access to help fi les and Autodesk websites.

You can customize the Quick Access bar for each fi le type by selecting and deselecting but-

tons from a list. The list of available tools can be accessed by clicking the drop-down arrow 

shown on the far right of Figure 1.14.

Figure 1.14

Th e Inventor 

button and Quick 

Access bar

Table 1.1 defi nes the default Quick Access bar buttons available in part modeling mode.
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Table 1.1: Quick Access bar buttons

Button Definition

Th e New button launches the New File dialog box. Th e drop-down list allows 

you to create a new part, assembly, drawing, or presentation fi le using the 

standard templates.

Th e Open button launches the Open dialog box. It displays a location defi ned 

in your active project.

Th e Save button saves the fi le.

Th e Undo button undoes the last action. Th e Undo list tracks changes for the 

current Inventor session, not just the current document. If you have two part 

fi les open, this button will undo changes that are made in both fi les. Undo will 

also close fi les if your undo sequence takes you back past the point of a fi le 

being opened or created.

Th e Redo button restores a change that was removed with Undo. It will reopen 

a fi le that was closed with Undo.

Th e Update button updates the fi les. For example, if you edit a part in an 

assembly, other parts might need to be updated because of the changes. Th is 

button is grayed out unless the fi le needs to be refreshed.

Th e Select button allows you to choose a fi lter for object selection.

Th e Material button and drop-down box allow you to change the component 

material. Clicking the button displays the material browser. Selecting a 

material from the drop-down changes the component’s material property. 

Th e Appearance button and drop-down box allow you to change the compo-

nent color. Clicking the button displays the appearance browser. Selecting an 

appearance from the drop-down changes the component’s color appearance.

Th e Adjust button allows you to modify the color and texture appearance.

Th e Clear button allows you to remove overrides to the component’s color and 

texture appearances.

Th e Parameter button is used to access the parameters table, where you can 

rename, change, and create equations in dimension and design parameters.

Th e Measure Distance button brings up the Measure tool, allowing you to 

take distance, angle, loop, or area measurements from model edges, vertices, 

and faces.

Th e Design Doctor button launches a dialog box that helps you diagnose and 

repair issues with a fi le. Th e button is grayed out unless there is an issue.
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Graphics Window Tools
Inventor has two sets of tools for manipulating the graphics window:

 ◆ The ViewCube is used to change the view orientation.

 ◆ The Navigation bar has tools such as Zoom and Pan.

Exploring the ViewCube

The ViewCube, shown in Figure 1.15, is a 3D tool that allows you to rotate the view. Here are 

some viewing options:

Figure 1.15

Th e ViewCube

 ◆ If you click a face, edge, or corner of the ViewCube, the view rotates so the selection is per-

pendicular to the screen.

 ◆ If you click and drag an edge, the view rotates around the parallel axis.

 ◆ If you click and drag a corner, you can rotate the model freely.

 ◆ If you click a face to have an orthogonal view, additional controls will display when your 

mouse pointer is near the cube.

 ◆ The four arrowheads pointed at the cube rotate the view to the next face.

 ◆ The arc arrows rotate the view by 90 degrees in the current plane.

If you click the Home button (it looks like a house), the view rotates to the default isometric 

view. Clicking the drop-down arrow or right-clicking the Home button reveals several options 

to change the default isometric view behavior. For instance, you can modify the home view 

to any view you like, and you can reset the front view in relation to your model so the named 

views of the cube match what you consider the front, top, right, and so on.

Using a Wheel Mouse and D-Input Device

Using a wheel mouse with Inventor is recommended. Scrolling the wheel will perform a Zoom 

In/Out, while pressing the wheel will perform the Pan function. In Inventor, the wheel zoom is 

reversed from AutoCAD. You can change this setting by clicking Application Options on the Tools 

tab, selecting the Display tab, and selecting Reverse Direction in the 3D Navigation group.

Another useful tool for navigating in Inventor is a 3D-input device. A popular brand is the Space 

series made by 3Dconnexion. Th ese devices are small “joysticks” or “pucks” that sit on your desk. 

Th e user grasps the puck and, by making very slight movements with the device, moves the model 

on the screen. Pulling, pushing, and twisting the puck allows you to zoom, pan, and orbit the model 

on-screen. Although you may fi nd these devices awkward at fi rst, most users say they could never 

work as effi  ciently without one after just a few days of use.
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A Look at the Navigation Bar

Continuing with the interface tour, you’ll see the Navigation bar located on the right side of 

the graphics window. At the top of the bar is the steering wheel. Below the steering wheel 

are the other standard navigation tools: Pan, Zoom, Orbit, and Look At. Figure 1.16 shows the 

Navigation bar.

Figure 1.16

Th e Navigation bar

You can use the Navigation bar’s steering wheel to zoom, pan, walk, and look around the 

graphics area. Also available is the ability to rewind through previous steering wheel actions. 

The steering wheel has more functionality than can be explored in this book. You should review 

the help topics for more information (click the steering wheel and then press F1).

Navigation Tools Tutorial

You can fi nd a video tutorial exploring the navigation tools built right into Inventor. To view this 

video tutorial, select the Get Started tab and click the Overview button in the Videos And Tutorials 

panel. Th en click the View Navigation button.

Th e Ribbon Menu
The Ribbon menu is composed of tabs and panels and is similar to the menu used in Microsoft 

Offi ce products (starting with Offi ce 2007). Each tab contains panels for a particular task, such 

as creating sketches, and each panel contains related buttons for the tools. As previously men-

tioned, the ribbon will change to the proper tab based on the current task (for example, sketch-

ing brings up the Sketch tab, which allows you to click the Line tool button), but you can select a 

different tab as needed.

You can customize the Ribbon menu by right-clicking it and choosing among the following:

 ◆ Turning off tool button text, reducing button size, or using a compact button layout

 ◆ Turning off panels that you don’t use

 ◆ Adding frequently used commands to a tab

 ◆ Minimizing the ribbon

 ◆ Undocking the ribbon so it becomes a fl oating tool palette

 ◆ Docking the ribbon on the left, right, or top of the Inventor window
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The Get Started Tab

On the Get Started tab of the Ribbon menu the tools on the Launch panel are used to access and 

create fi les. The rest of the buttons found on the Get Started tab link to help topics. You can use 

the What’s New button to read about the new features for the current release as well as the last 

few releases. The Videos and Tutorials tools contain built-in tutorials, and a collection of learn-

ing resources. Figure 1.17 shows the Get Started tab and its tools.

Figure 1.17

Tools found on the 

Get Started tab

The View Tab

The View tab, shown in Figure 1.18, has controls for object visibility and appearance, window 

control, and navigation. There are some variations in the buttons, depending on the environ-

ment, but most of the buttons are used in all of the modeling environments.

Figure 1.18

Th e View tab

Visibility Panel

The Visibility panel has tools for controlling which objects are visible. When you click Object 

Visibility, a large list is displayed so you can control the visibility of the listed objects in your 

graphics window.

Appearance Panel

The Appearance panel has tools for controlling the way models are displayed. You can dis-

play the model in a number of visual styles, such as Realistic, Shaded, Shaded With Edges, 

Illustration, and many more.

Visual Styles and Performance

Inventor includes a number of enhanced visual styles, shadows, and refl ection options that might 

have a negative impact on your graphics performance if your workstation is a bit older. If you notice 

issues with your graphics display, you can go to the Tools tab, select the Application Options button, 

click the Hardware tab, and then select the Performance or Compatibility option.
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Another important option found on the Appearance panel is the View Camera Projection 

setting, which allows you to choose between orthographic and perspective views. Setting the 

perspective options to be current displays the model with a vanishing point, as it would be in 

the real world. With the Orthographic option, points of the model are projected along lines par-

allel to the screen.

Using a perspective view may be desirable when viewing the model in a 3D view, but it can 

be distracting when sketching on a fl at face or viewing the model from a standard 2D ortho-

graphic view because you see what appear to be tapering faces and edges. However, you can get 

the best of both projections by setting the ViewCube to Perspective With Ortho Faces so that the 

model is displayed in orthographic mode when one of the standard orthographic faces is active 

and in perspective mode in any other view. To do this, simply right-click the ViewCube and you 

will see the option. Note that this setting is set for each document rather than for the application 

itself, so you will typically need to do this for each model.

Windows Panel

Most of the tools in the Windows panel are standard controls, such as for switching tiling 

windows. If you click User Interface, a list of items such as the ViewCube and the status bar 

are displayed. The Clean Screen button hides most of the UI elements. Only the title bar and a 

minimized ribbon bar are displayed. Although the Clean Screen setting certainly maximizes 

your screen real estate, it turns off one very critical interface object, the browser pane. To use the 

Clean Screen function effectively, you must turn the browser pane back on. To do so, click the 

View tab, use the User Interface drop-down, and select the Browser option. You can click the 

View tab again and then click the Clean Screen button again to disable it and display the tools 

panels again. 

Navigate Panel

Also on the View tab is a Navigate panel. The tools in the Navigate panel are the same as those 

found on the Navigation bar, as discussed earlier in the chapter. Many of these tools, such as 

Pan, Zoom, and Orbit, can be accessed by using the buttons on your mouse and/or the function 

keys. For instance, spinning the wheel on a standard three-button mouse allows you to zoom in 

and out. Similarly, if you hold down the F4 button on the keyboard, you will see that the Orbit 

tool is active.

Th e Browser Pane
The browser pane (often called the Model browser) is a listing of everything that makes up an 

Inventor fi le. The part browser shows all of the features, the assembly browser shows all of the 

components, and the drawing browser shows the sheets with the views. Because Inventor fi les are 

similar to actual parts and assemblies, the browser plays an important role in navigating the fi les.

Turning on a Missing Model Browser

Although it isn’t common to need to turn the Model browser off , you can do so. More commonly, 

you may accidentally turn it off  by clicking the X button on the right side of the browser title bar. 

To display it again, from the View tab click the User Interface button found on the Windows panel. 

You’ll most likely want to have all the items in this list selected.
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Dialog Boxes and the In-Canvas Mini-Toolbars
As you use Inventor you will notice that there are often two sets of input controls: the traditional 

dialog box controls and the in-canvas mini-toolbars. The inputs in the dialog box are the same 

as those found in the mini-toolbars, and therefore you can use either one to input information or 

change options. Changing an option in one updates it in the other. You can use the arrow at the 

bottom of the dialog box to expand or collapse it. Figure 1.19 shows both sets of controls as they 

appear for editing a simple extrusion.

Figure 1.19

Dialog box and 

mini-toolbar 

controls

If you fi nd the mini-toolbar controls are become distracting by popping up in a position that 

is in the way of making selections on-screen, you can use the Mini Toolbar Options menu but-

ton (the button on the far right of the last row) to pin the mini-toolbar to a location on-screen of 

your choosing.

Task-Based Tools
You saw in the previous section that the tabs of the Ribbon menus update based on the current 

environment. For instance, when in the sketch environment, the Sketch tab is active. The task-

based nature of the available tools is common throughout Inventor. For example, many Inventor 

dialog boxes are also task based. Instead of containing every control needed for every environ-

ment, most dialog boxes display only the controls necessary for the current task. In Figure 1.20, 

two Extrude dialog boxes are shown.

Figure 1.20

Solid and surface 

Extrude dialog 

boxes



LEARNING THE FILE TYPES IN INVENTOR | 21

Because creating and editing a solid extrusion is different from creating and editing a surface 

extrusion, some options are simply grayed out and not available. You will notice this throughout 

Inventor as options are offered and suppressed depending on the task at hand.

Learning the File Types in Inventor
If you’ve used AutoCAD, you might be accustomed to having the DWG (.dwg) fi le format as 

your primary fi le format; in Microsoft Word you might use primarily just a DOC (.doc) fi le; and 

in Microsoft Excel, you might use the XLS (.xls) fi le type for most of the work you do. All three 

of these commonly used programs use a single primary fi le type throughout. Inventor, on the 

other hand, follows the structure common to most other 3D modelers in the engineering fi eld 

today and uses different fi le types for different tasks.

The purpose of using multiple fi le types is so the data load is distributed into many different 

fi les instead of having all information in one fi le. For instance, you use an IPT (.ipt) fi le to 

create an Inventor part fi le, an IAM (.iam) fi le to assemble that part with other parts, and an 

IDW (.idw) fi le to make a detail drawing of the parts and the assembly.

Placing the data in multiple fi les permits quicker load times, promotes fi le integrity, and 

vastly improves performance across the board on large designs. For example, when you open 

an assembly made of 12 different part fi les, only the information concerning the fi le paths and 

the way the parts fi t together in the assembly is loaded along with the information required 

to display the parts. It is only when you decide to edit a part that the information about all of 

that part’s features is loaded. As you learned in the previous section, having different fi le types 

allows you to use environment-specifi c tools. So if you edit a part from within an assembly fi le, 

Inventor automatically presents the Part editing tools.

Turning on Filename Extensions

It’s often helpful when working with Inventor fi les to be able to view the fi lename extensions. By 

default, Windows hides the extensions for known fi le types. To show fi lename extensions, follow 

these steps for Windows 7:

 1. Open Folder Options by clicking the Start button, clicking Control Panel, and then clicking Folder 

Options. (If Folder Options is not available, change View By to Large Icons in the upper-right por-

tion of Control Panel.)

 2. Select the View tab, and uncheck the Hide Extensions For Known File Types option. 

Another payoff of multiple fi le types is exemplifi ed in the comparison between the way 

AutoCAD handles tasks related to model space/paper space and the way Inventor handles the 

same tasks. To put it simply, in Inventor the part and assembly fi les are the model (model space), 

and the drawing fi le is in effect paper space. Using multiple fi le types to handle the separate 

tasks required for modeling versus detailing simplifi es the interaction between both tasks, and 

as a result, the headaches of managing model space and paper space that exist in AutoCAD are 

eliminated in Inventor.
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Table 1.2 lists the fi lename extensions for the fi le formats commonly used in Inventor.

Table 1.2: Common fi lename extensions in Inventor

Extension Description Use

.ipj Inventor project fi le Used to manage fi le linking paths

.ipt Inventor single part fi le Used to create individual parts

.iam Inventor assembly fi le Used to assemble parts

.ipn Inventor presentation fi le Used to create exploded views of assemblies

.idw Inventor 2D detail drawing fi le Used to detail part, assembly, and presenta-

tion fi les

.dwg (Inventor) Inventor 2D detail drawing fi le Like IDW fi les, used to detail part, assembly, 

and presentation fi les

.dwg (AutoCAD) AutoCAD nonassociative drawing fi le Used to convert an Inventor drawing fi le to a 

standard AutoCAD fi le

.xls Excel fi les that drive iParts, threads, 

and other data

Used to manage tabled data linked or embed-

ded in a part, assembly, or drawing fi le

Although this list may seem intimidating, once you become familiar with Inventor, having 

many different fi le types will be less of a concern. The benefi t of using multiple fi le types to 

have fully associative, automatically updating designs is a cornerstone of most 3D parametric 

modelers. Performance and stability in the use of Inventor require good data management prin-

ciples, including storing the saved fi les in an effi cient and organized manner.

DWG File Size

Although the benefi ts of using an Inventor DWG instead of an IDW may be favorable, you should 

be aware that the extra abilities of the DWG fi le do come at the expense of fi le size. Inventor DWGs 

are typically two to three times larger than identical IDW fi les. If you create large assemblies, it is 

advisable to use the IDW template as opposed to the DWG to keep fi les manageable. Th e extent to 

which the DWG in Inventor is employed will largely be determined by the amount of collaboration 

required between Inventor and AutoCAD users.

What Is an Inventor Project?
Whether you use Inventor as a stand-alone user or as part of a design group, you should con-

fi gure and use an Inventor project fi le to help Inventor resolve fi le links and keep your designs 

organized. You can think of project fi les in Inventor simply as confi guration fi les that tell 

Inventor where to look for component fi les when working with assemblies and drawings. For 
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instance, an Inventor assembly fi le is essentially an empty “bucket” into which parts (and subas-

semblies) are placed and assembled. Therefore, the assembly fi le contains only the fi le path ref-

erences for the components it is composed of and the information about how those components 

are assembled. As a result, the location of referenced fi les is a key issue.

If, when an assembly is opened, referenced fi les cannot be found at the search path recorded 

in the assembly fi le, a manual fi le resolution process is activated. This happens most often when 

component fi les are renamed or moved outside the search path established in the project fi le.

A Note to Autodesk® Inventor LT™ Users

If you are using Autodesk Inventor LT software, you should be aware that it doesn’t make use of 

project fi les, and therefore this book’s instructions concerning Inventor project fi les do not apply.

Project Files and Search Paths
Project fi les are often referred to as IPJ fi les because .ipj is the extension for project fi lenames. 

You can create a project fi le anywhere it makes sense to do so, and Inventor will look at that 

location and lower in the directory structure for the fi les in your design. Take a moment and 

study the fi le structure shown in Figure 1.21.

Figure 1.21

A job-based folder 

structure

Figure 1.21 shows a typical job-based folder structure, where all fi les are located on the 

Engineering (I:) drive. Engineering contains three subfolders: CAD Files, Data Sheets, and 

Templates. In the CAD Files folder are three more folders: Content Center Files, Designs, 

and Library Files. The Designs folder contains a folder for each job (named using the job 

number) and subfolders containing revisions. So where would you create an Inventor project 

fi le? There are two basic solutions: create multiple IPJ fi les for each new job or create a single all-

encompassing IPJ fi le for the entire engineering drive. Which method you should use depends 

largely on the way your engineering department operates.

Job-Based IPJ Setups

You could create one project fi le for each of the four jobs. You would have a fi le named 

07–0114–01.ipj in the 07–0114–01 folder, one named 07–1121–01.ipj in the 07–1121–01 

folder, and so on. This strategy can work fi ne if you typically work on one project at a time and 
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then “close” the project upon completion. In Inventor, you would simply switch to the specifi c 

project fi le that matches the job number for the job you are working on (for example, 07–0114–

01), and because the IPJ fi le is stored in that folder, Inventor will only search for design fi les in 

its workspace. The workspace is defi ned as the folder containing the IPJ folder and everything 

below it. It may help to think of a workspace as a search cone, starting at the IPJ and spreading 

out from that point.

This job-based approach is fairly intuitive and is what people generally think of when they 

see the term project fi le: one IPJ fi le for each job/project. This is a common approach when a job 

has a long development cycle and designs are specifi c to that job.

But what happens if you want to use a part that was created for job 07–0114–01 in job 

08–0614–10? You could place the part into the 08–0614–10 assembly, but the next time you 

opened that assembly, Inventor would not be able to fi nd it because it exists outside of the 

08–0614–10 workspace. If you were to move a part fi le from the 07–0114–01 folder into the 

08–0614–10 folder, Inventor would not fi nd it while you were working on job 07–0114–01 

because it would now be outside of its workspace. Likewise, if you moved the fi le up to the 

Designs folder, or the CAD Files folder, or to (almost) any location that is not next to or below 

the 07–0114–01.ipj fi le, Inventor would not fi nd it as long as you are working with the 

07–0114–01.ipj project fi le. If you copy the fi le to the 08–0614–10 folder, then you have two 

versions of it and it becomes diffi cult to track changes because you need to update both copies to 

keep everything up-to-date.

The solution would be to confi gure the IPJ fi le to include a library. When a folder is confi g-

ured to be used as a library in an IPJ fi le, Inventor sees all of the fi les in that folder (and its sub-

folders) as read-only. This protects commonly used fi les from being accidentally changed and 

upsetting all of the many designs in which they may be used.

To solve the issue of the commonly used part in this example, you could confi gure each of 

your IPJ fi les to use the folder named Library Files as a library of approved, read-only parts 

to be used across multiple jobs. Whenever you open an assembly, Inventor fi rst looks in the 

library path for the parts and then looks at the workspace. So to convert a part created as part of 

the 07–0114–01 job into a library part, you would follow these steps:

 1. Copy the fi le to the library folder.

 2. If the original fi le has a job-specifi c name, rename the copy according to a defi ned library 

nomenclature.

 3. Open the assembly (or assemblies) that use the original part.

 4. Use the Replace Components tool to replace the original part with the library part in the 

assembly.

 5. Save and close the assembly.

 6. Delete the original part so that no duplicate is present.

Single IPJ Setups

The multiple project fi le strategy described previously is often not the best approach for many 

design departments, because of various contributing factors. When this is the case, using a 

single project fi le should be considered. Using the same folder structure shown in Figure 1.21 as 

an example, you could use a single all-encompassing IPJ fi le and place it in the Designs folder. 

By doing so, you would be setting the workspace at that level. This confi gures the search paths 
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in Inventor to look for fi les in the Designs folder and everything below it. Essentially, you have 

expanded the search cone by moving it up a level compared to the job-based setup. Now if you 

need to use a part that resides in the 07–0114–01 folder in the 08–0614–10 assembly, you can do 

so and Inventor will be able to fi nd it, without requiring it to be in a library folder.

Of course, you can still use library folders when using the single IPJ fi le approach, and in 

fact it is generally recommended that you convert common parts to library parts when they are 

being used in many different designs. Because folders confi gured as libraries in the IPJ fi le are 

handled as read-only, this protects them from accidental modifi cations.

One major caveat to using just a single IPJ fi le is that in order to prevent the possibility of the 

wrong part being loaded in an assembly, it is important for every part located in the search path 

to have a unique name. If Inventor fi nds two fi les named BasePlate01, it will either use the fi rst 

one it fi nds or stop and make you decide which one to use. In either case, you should consider a 

nomenclature that references the job number, date, or other unique identifi er in the name.

Item-Based Setups

If your company uses an item-based fi le management setup and tracks each part you create 

or purchase as an item, you are probably not concerned with job numbers as much as you are 

about part numbers. Most likely you will want to employ a single IPJ fi le setup as described pre-

viously and again place the IPJ fi le in the Designs folder. Additionally, your fi le structure may 

be a bit more fl at and look like Figure 1.22, where the Designs folder has no subfolders.

Figure 1.22

An item-based 

folder structure

In this fl atter structure, you can simplify the folder structure and drop all fi les into the 

Designs folder as shown in Figure 1.23.

Figure 1.23

A simplifi ed folder 

structure

Of course, you could also still populate the Designs folder with subfolders named by product 

line, by top-level item, or for each job, just as it was done back in Figure 1.21. Typically, it is best 
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to set up the IPJ fi le to accommodate your current fi le management system. However, if your 

current system is a mess or is simply no longer a good fi t for your company, you might take the 

opportunity to reorganize and plan a good system and set up Inventor accordingly.

Library Folders and Library Editor IPJ Files
As described earlier, library folders contain existing, shared components. Library folders are useful 

repositories for purchased parts such as fasteners, clamps, motors, and connectors as well as any 

other common, standard components. Library folder paths are defi ned in the IPJ fi le. Once the IPJ 

fi le is confi gured and set active, all components stored in a folder designated as a library fi le are con-

sidered to be read-only by Inventor. This prevents the component from being unintentionally edited 

or from being revised without appropriate approvals. For example, before you modify a design that 

was completed as part of another job, it’s important to determine where else that part was used. The 

goal is to ensure that the changes you plan will not render the part unusable for other designs.

Library folders should be located outside the main IPJ workspace path. In the job-based 

directory structure example shown in Figure 1.21, the Library Files folder is on the same 

directory level as the Designs folder and therefore outside the workspace search path. Library 

folders can be located anywhere outside the primary project data path, even on different drives 

or mapped servers. You should note that if you set up a library path in the IPJ fi le to a folder 

that does not exist, Inventor will create the folder as specifi ed in the path. A good way to set up 

libraries is to set the path, let Inventor create the folder so that you know it’s in the right place, 

and then populate the folder with the library fi les.

So if folders confi gured as libraries are confi gured as read-only in the IPJ fi le, how are con-

trolled, purposeful revisions carried out on library fi les? The answer is to create an IPJ fi le con-

fi gured to look at the library folder as a standard folder. For instance, you might create an IPJ 

fi le in the Library Files folder and assign it no library path. You would then switch to this IPJ 

fi le only when doing library maintenance. Because this IPJ has no library path called out, the 

fi les are not handled as read-only when Inventor is using this IPJ fi le. Often in a large engineer-

ing department only a couple of people have access to the library editor project fi le. When other 

team members see a need to change a library fi le, they would submit a change order and the 

designated person(s) would then make the change.

Content Center Files
In the previous fi gures you may have noticed a folder called Content Center Files. This is a 

special kind of library that stores component fi les generated by Inventor’s Content Center tools. 

The path to this folder is specifi ed in the IPJ fi le, much as a library fi le is.

It is important to understand what Content Center is and how it works. Content Center librar-

ies are collections of table data containing the defi nitions used to create over 800,000 standard 

parts and features. This database is managed by the Desktop Content settings or the Autodesk 
Data Management Server (ADMS). Once you’ve installed the content libraries, you can use the 

content in your designs. To do this, choose a component from the database to place into your 

design, typically by using the Place From Content Center button in the assembly environment. It 

is at this point that the Content Center part fi le is created. Up to this point, the part existed only 

as a defi nition in database table.

In your IPJ, you need to specify a Content Center fi le store location so that Inventor knows 

where to save the fi le and where to fi nd it next time. The fi le store folder will include additional 

subfolders where Content Center fi les will be stored once they are used in your designs. These 

additional folders are created automatically as parts are created. The next time a part is specifi ed 
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from Content Center libraries, Inventor fi rst searches Content Center fi le store directories and 

then creates the part from the database only if the part fi le does not already exist in the fi le store 

location. It is required that Content Center fi le store location be outside the main project data 

path. From this discussion of libraries, you can see that high importance is placed on planning 

the correct part locations and workfl ow.

How Search Paths and Project Files Are Used
The IPJ fi les in Inventor are easy to create and use, provided you understand how Inventor uses 

them. An Inventor project fi le is a confi guration fi le that lists the locations and functions of each 

search path. Inventor uses these defi nitions to resolve fi le links and locate the fi les needed for 

the parts and assemblies on which you want to work. Figure 1.24 shows how Inventor loads 

assemblies and parts inside an assembly fi le.

Figure 1.24
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When opening an assembly fi le, Inventor fi nds fi les by searching for the fi rst fi le to be located 

within the assembly fi le. Inventor fi rst looks in the library folders for that fi le. Next, Inventor 

searches in the local workspace for the fi le. When a fi le is not found in any of the referenced 

folders, Inventor launches a manual fi le resolution dialog box offering you the opportunity to 

browse and point to the fi le manually.

Explo ring Project File Types
As mentioned previously, fi le management in Inventor is handled through the use of a project 

fi le (*.ipj). A project fi le is a confi guration fi le set up and used to control how Inventor creates 

and resolves fi le links, where you edit fi les, how many old versions of the fi les to keep, and how 

Content Center fi les are stored and used. In the early days of Inventor, Autodesk offered two 

basic project types: single-user projects and multiuser projects. At this point, the Autodesk Vault 

project has replaced the earlier multiuser project types.

Unless you have installed Vault, you have only one project type to choose from by default: 

the single-user project. The term single-user could be considered a misnomer because this project 

type is widely used by one-person shops and multi-seat design departments alike. Single-user 

does not mean that only one user can access the fi les in the project, as it might suggest; instead 

it refers to the fact that there are no means of preventing fi les from being accessed for editing 

while another user is already editing the fi le. This can create a last-person-to-save-wins situa-

tion if care is not taken.

Single-User Projects among Multiple Users

What happens when two users access the same fi le in a single-user project? Typically this is fi rst 

noticed when one of the two tries to save the fi le. Inventor notifi es the person trying to save that 

they are not working with the most current version and gives the other user’s name (depending on 

the network setup) so the fi rst user knows what is going on. Inventor instructs the user that they 

must save the fi le using a diff erent name to prevent losing the changes made.

Typically, at this point a conversation takes place to determine how to proceed. If it is decided that 

the fi rst person is the one who needs to save changes, then the fi le this person was working on is 

saved using another name, the original fi le is deleted (or renamed as a reserve), and the other fi le 

is renamed to replace the original. In this way, the changes that were made to the original fi le are 

preserved.

Although this may seem like a terrible hassle, there are many design departments that use single-

user projects in a team setting eff ectively and only rarely run into this situation. More than likely 

you already have an idea of how often you and your colleagues handle the same fi les at the same 

time. But if you try to use single-user projects and fi nd this situation happens fairly often, you 

should consider a true multiuser project.

Many design departments use single-user projects effectively in collaborative environments 

because of workfl ows that lend themselves to this type of project; others make it work by simply 

maintaining good communication among the design team. For collaborative environments that 
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require some safeguard against situations in which users could potentially save over one anoth-

er’s work, using a multiuser project (Vault project) is recommended.

Autodesk Vault is a data management application that, as the name implies, locks down fi les 

for their protection. Once a fi le is in Vault, it must be checked out by a user to be edited. Vault 

typically resides on a fi le server where the entire design team can access it. When the fi le is 

checked out of the Vault server, it is placed on the user’s local machine for editing. The next user 

who comes along and attempts to access that fi le can access only a read-only version. Once the 

fi rst user has fi nished editing, the fi le is checked back into Vault and automatically versioned.

It is also important to note that Inventor installs with a default project setup. The default proj-

ect is typically not used for production work because it is not fully confi gurable and will almost 

always lead to fi le resolution issues because it has no defi ned search path.

Creating the Project File
In Inventor, two project fi le confi gurations are available:

 ◆ Single-user

 ◆ Autodesk Vault

A single-user project allows you to work in a fi le structure that is wholly contained on your 

system or on a network server location. This project fi le type is the simplest to create and works 

well when users are not working on the same design concurrently.

Autodesk Vault is an easy-to-use data management tool that integrates work created with 

Inventor, Inventor Professional, AutoCAD® Mechanical software, and AutoCAD® Electrical 

software. It includes features that allow design teams to track work in progress and maintain 

version control in a multiuser environment. Design reuse is facilitated by consolidating product 

information and storing it in one place. Vault is a SQL database environment. A subset of the 

SQL environment exists in all current Windows operating systems (back to Windows 2000). 

Vault installs separately from Inventor. The Vault installation checks to make sure that your 

system is compatible and that auxiliary programs required for operation are installed. Vault is 

included with all versions of AutoCAD and Inventor.

Now, which type of project is best for you?

One or more designers can use projects using Vault. Single-user projects are most commonly 

used when there is a single seat of Inventor in the company or when only one designer works on 

a particular job more or less exclusively.

Multiuser Vault projects rely on a Microsoft SQL Server environment. That can be as simple 

as the Autodesk data management server, which supports up to 10 users with the default 

Microsoft SQL Server Express database. If you have a larger workgroup or require a higher 

capacity, a full version of Microsoft SQL Server is recommended. In addition, a workspace folder 

located on the individual user’s system is required. Data servers should be on a separate server 

with rapid data access hard drives dedicated to the engineering department’s use.

Inventor 9 and earlier allowed you to create shared and semi-isolated project fi le types. If you 

are currently using either of these legacy project types, you should consider moving to Vault 

since Autodesk may not support the legacy types in future versions.
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Creating a Good Data-Management Plan

A good data management plan is the key to using Inventor projects successfully. Using Vault will 

not resolve a poor project fi le or data-management strategy.

One part of a successful Inventor deployment is the hardware and network on which the software 

will run. It is important that the engineering group has buy-in by the IT group. You will need to 

discuss several issues with this group, including hardware for servers and workstations, the network 

setup (100BaseT or Gigabit), mapped network drives, and user permissions. A good server can be 

the diff erence between success and failure in your rollout.

Although you do need to think about your fi le structure, don’t obsess over it. Most likely you will 

end up changing the structure at least a few times before you settle on a fi nal structure. Keep an 

open mind, and realize that if you have fi ve people in a room discussing fi le structures, you’ll end 

up with fi ve diff erent ideas. Again, involve IT in your discussions.

Finally, you should designate one person in engineering to be the engineering administrator. Th is 

person needs to have administrative privileges on the engineering server or network share. IT may 

resist, but you have to keep pushing. Th is is important because you will need the ability to easily 

create, delete, and move fi les and folders without having to submit a help-desk ticket. Nothing will 

slow down a design process faster than having to wait for IT to make a simple change. Explain this 

need to your IT administrator, and most likely they will understand.

Creating Single-User Projects
Probably the best way to learn about projects is to create a test single-user project. With single-

user projects, you can open, edit, and save fi les without checking the fi les in or out. In the 

following sections, you will investigate the single-user fi le project mode. Once you gain an 

understanding of single-user projects, you will be ready to investigate the other project fi le 

types. To create a test project, you will use the Inventor Project Wizard.

The Inventor Project Wizard

To get the most out of this exercise, open your version of Inventor, ensure that you have closed 

all the open fi les, and then access the Inventor Project Wizard by clicking the Projects button on 

the Get Started tab. Then follow these steps:

 1. In the Projects dialog box, click the New button at the bottom.

 2. If you have installed Vault, you will see two options in the Inventor Project Wizard, as 

shown in Figure 1.25. If not, you will see only one option. In either case, select New Single 

User Project, and then click Next.

Figure 1.25
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user project
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 3. Enter MI_Test_Project in the Name fi eld.

 4. Enter C:\ MI_Test_Project in the Project (Workspace) Folder fi eld.

Figure 1.26 shows a Project File page specifying the project.

Figure 1.26

Th e Project File 

page fi lled in

 5. Click Next to advance to the next page of the wizard.

 6. If you already created a folder for your library fi les and used those libraries in a previ-

ous project, their locations will appear on the Select Libraries page, shown in Figure 1.27. 

When creating a new project, you can choose to include some, all, or none of the defi ned 

library locations. Click the Finish button to include no libraries at this point.

Figure 1.27

Select Libraries 

page

 7. Click OK in the message box informing you that the project path entered does not 

yet exist.

 8. Click Finish to create and save your new project fi le. The newly created project fi le link 

will appear in the list in the Projects dialog box.

Switching and Editing Projects

Only one project can be active at a time. To switch projects, you must fi rst close all fi les that are 

open in Inventor. You cannot edit the fi le paths of the active project, but you can edit items such as 

Content Center libraries that are included. You can edit anything in an inactive project.
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The Projects Dialog Box

Now that you have created your sample project fi le, you’ll explore the options and settings avail-

able for your new project. To activate and use your new project, highlight the new project and 

click Apply. You can also activate or select a new project link by double-clicking the project link. 

Notice the check mark next to the project name MI_Test_Project, indicating that the project is 

now active, as shown in Figure 1.28.

Figure 1.28

Projects dialog box

In the lower pane, you can view and access parameter settings for the following:

 ◆ The project type

 ◆ The project location

 ◆ Optional included project fi le

 ◆ Appearance libraries path

 ◆ Material libraries path

 ◆ The workspace path

 ◆ Optional workgroup paths

 ◆ Libraries you want to use

 ◆ Frequently used subfolders

 ◆ Folder options

 ◆ Other project options

Right-click a parameter group to view the settings available within that group. In the Project 

group, you can change the project type, view the project location, and include other project fi les. 
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Project types were discussed earlier in this chapter. The project location is a read-only param-

eter. Included fi les deserve some additional discussion because the Included File parameter 

allows you to apply a master project to your current project; this setting, as well as the other 

project settings, are discussed in the coming pages.

Included Files

Although it’s not required, you can include an existing project in the confi guration of the cur-

rent project by right-clicking Included File. The properties and settings in the project fi le that 

you attach override the settings in the current project fi le. This is useful for restricting and con-

trolling a user’s ability to change the project fi le. Also, if you frequently create new project fi les, 

you might consider creating a master project fi le that contains library locations and other set-

tings you commonly use and then include the master project fi le in each new project fi le.

Appearance Libraries

An appearance library is a collection of appearances (for instance, colors) that are either 

installed with Autodesk Inventor or are created by the user. User-created libraries can contain 

appearances and materials in the same appearance library. The Autodesk Appearance Library 

contains only appearances. The active library is shown in bold text.

Material Libraries

A material library is a collection of material defi nitions (for instance, physical materials such 

as Stainless Steel) that are either installed with Autodesk Inventor or are created by the user. 

User-created libraries can contain materials and appearances in the same material library. The 

Autodesk Material Library contains only materials. The Inventor Material Library provides a 

basic set of manufacturing-related materials and appearances. The libraries that are installed 

with Autodesk products are read-only libraries. Custom libraries can be set to read-only or 

made writable using the fi le’s read-only attribute. The active library is shown in bold text.

Workspace

For single-user projects, the workspace is defi ned by the location of the project fi le (*.ipj). 

For Vault projects, the workspace is defi ned on the workstation and is confi gured to match the 

Working Folder setting in the Vault settings. The workspace is the folder that fi les are copied 

to when they are checked out. The Workspace folder may include any number of subfolders as 

required for your fi le management needs.

Workgroup

The workgroup search path specifi es a location outside the current project fi le paths where 

Inventor can search for existing fi les that are not included in a library. A workgroup is specifi ed 

when the project is created. Each single-user project should have no more than one workgroup. 

Using a workgroup path is not required and is not a common confi guration to make.

Style Library

Inventor uses styles to specify dimensions, text, colors, materials, and other properties. This is 

similar to styles used in AutoCAD. However, Inventor allows you to store styles locally within 

the templates or in an external style library that may be used with any project fi le.
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The Use Style Library function in projects specifi es whether the project uses only local styles, 

local styles and the style library, or just local styles and a read-only version of the style library. 

The read-only style library is recommended for projects that have multiple users. With mul-

tiple users, changing or editing the style library on the fl y can cause downstream problems. To 

change the Use Style Library parameter, right-click and select the new setting.

Remember that for your projects, you can right-click to select another option when it is 

appropriate. Click Yes if you want to be able to edit styles in this project. Click Read-Only (the 

default) if you want to access style libraries and local styles without enabling style-editing capa-

bilities. Click No if you want to use only the styles located within the current fi le and project 

template. You can fi nd more on using style libraries toward the end of the chapter.

Library Options

Next on the list are libraries. Library folders are located outside the project fi le path. They may 

be located anywhere on your system or on your server. If you are sharing library fi les, you 

should place them on your server in a commonly accessed location. Inventor considers the con-

tents of directories specifi ed as libraries to be read-only.

In your newly created project fi le, you have not added any library folders. If at any time you 

want to add library folders, you can do so by right-clicking Libraries and choosing Add Path, 

Add Paths From File, or Paste Path, as shown in Figure 1.29.

Figure 1.29

Adding library 

paths by 
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You can manually add a path, either by browsing or by typing a new fi le location. Be sure 

to give the library a descriptive name that identifi es the contents of the fi le location. Add Paths 

From File permits you to extract library paths from another project fi le. Paste Path allows you to 

copy and paste. Once you have specifi ed library paths, the Delete Section Paths option becomes 

available, and you can remove paths not needed by the project. Deleting unused library paths 

reduces search and resolution time.

Shortcuts to Frequently Used Files

Frequently used subfolders are similar to the bookmarks you can set in Internet Explorer. The 

subfolders must already be nested within the current project workspace, workgroup, or library. 

Adding frequently used subfolders to your project provides navigation links in your open, save, 

and place dialog boxes so you can quickly navigate to those locations. In the Mastering Inventor 
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2014 project that you will use throughout the rest of this book, the chapter folders have been 

added as frequently used subfolders.

Folder Options

The Folder Options setting allows your project to access other fi le locations that are specifi ed on 

the Files tab of the Application Options dialog box. Keep in mind that you may have to close and 

reopen Inventor in order to reinitialize the optional project fi le locations. You can use this option 

to specify different default locations for templates, design data, styles, and Content Center fi les. 

When the locations are set to the defaults, the location/storage of the fi les is specifi ed on the 

Files tab of the Application Options dialog box. Right-click any of the options entries to change 

the storage and access location. You can fi nd more information about design data, styles, and 

templates toward the end of this chapter and more about Content Center in Chapter 7, “Reusing 

Parts and Features.”

Project Options

Expand the Options heading to show the global defaults for the selected project. The Options 

settings in a project determine fi le management functions; right-click an option to edit it.

Versioning and Backup

Use the Options settings to determine how many old versions or backup copies of each fi le 

to save. The Old Versions To Keep On Save option specifi es the number of versions to store in 

the Old Versions folder for each fi le saved. The fi rst time a fi le is saved in a project, an Old 

Versions folder for that fi le is created. When the fi le is saved, the prior version is moved auto-

matically to the fi le’s Old Versions folder. After the number of old versions reaches the maxi-

mum in the setting, the oldest version is deleted when a newer version is moved into the folder.

If you are familiar with AutoCAD, you may expect Inventor versioning to be similar to 

AutoCAD’s backup scheme. AutoCAD creates a *.bak fi le saved in the same folder as the 

design. Inventor saves the backup fi les in a separate Old Versions folder. All versions located in 

the Old Versions folder have the same name and extension, except that a number is appended 

after the name. In the project options, the default setting of 1 creates one backup fi le in the 

Old Versions folder. If you are working with a complex model, you might decide to specify 

additional backup versions by changing this setting to a higher number; however, remember 

that with each additional backup version you are creating additional fi les (and using additional 

space) on your hard drive. Setting Old Versions to −1 will cause Inventor to save all backup fi les.

Restoring an Old Version

Occasionally a fi le may become corrupt, or you may have accidentally saved a design change that 

you did not intend to. In these cases, you can browse to the Old Versions folder and open the 

versioned fi le. Upon doing so you will be presented with three options:

 ◆ Open Old Version (Save Not Allowed)

 ◆ Restore Old Version To Current Version

 ◆ Open Current Version
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File-Naming Conventions

The Using Unique File Names setting in the options will allow Inventor to check for unique 

part names for all fi les in the project, including subfolders. Libraries are excluded in this option. 

Proper design workfl ow demands that each unique part have a unique fi lename. When a part is 

reused, you should ensure that any revision to it is acceptable to all designs in which it is used. 

If the revised part cannot be used in all of the designs, you should use a new part name because 

you have now created an additional unique part.

Setting the Using Unique File Names option to Yes will cause Inventor to search the entire 

project workspace to compare fi lenames, but does not prevent users from creating duplicate fi le-

names. Having this option set to Yes can cause issues when a large number of fi les are present, 

and particularly when those fi les are organized with a large number of subfolders. If the Using 

Unique File Names option is set to No, Inventor will not search to compare fi lenames.

The Using Unique File Names Setting and Slow Search Times

Consider the following scenario: Th e Using Unique File Names option for your project is set to Yes. 

You have an engineering directory with 8,500 folders and subfolders containing thousands of fi les. 

You have a drawing fi le that references a part fi le named 12–865.ipt, but you’ve renamed the part 

fi le to 22–865.ipt using Windows Explorer.

Because the internal link in the drawing fi le is still looking for 12–865.ipt, when you open the 

drawing fi le that references the renamed part fi le, Inventor will search through all of the 8,500 

folders and subfolders looking for the missing fi le. When it doesn’t fi nd the fi le, it will fi nally present 

the File Resolution dialog box, allowing you to point the drawing fi le to 22–865.ipt.

Because of the number of folders and fi les, this search may take several minutes. By contrast, if you 

had the exact same scenario but your project fi le option Using Unique File Names was set to No, 

Inventor would not search for the missing fi le. Instead, it would immediately present you with the 

File Resolution dialog box and allow you to point the drawing to 22–865.ipt right away. For this 

reason, you should set this option to No when large fi le collections are present. However, even if it 

is set to No, you should employ a unique fi le-naming scheme for all of your fi les.

Keep in mind that you can toggle this option to Yes if you fi nd yourself needing to search the 

project for unique fi lenames.

If you do not have a part-numbering scheme already, take the time to implement one to 

make working with your Inventor fi les easier. Keep in mind that the most effective numbering 

schemes are often the simplest. Many an engineering department has eventually run into unan-

ticipated limitations when using a numbering scheme that is too specifi c or when attempting to 

include too much information in some built-in code. Here are a few suggestions that may help 

you in determining a numbering scheme that will work well for you:

Sequential Project-Based: 0910–00001  Here, the fi rst four digits correspond to the project 

number and the last fi ve are sequenced, starting at 00001. This numbering system works 

well when parts are not often used across different projects. Common parts might be created 

under a “common part project” prefi x such as 7777.

Generic Date-Based: 09–0707–01  Here, the fi rst six numbers are assigned by using the 

current date when the part number is created. In this example, the part number was created 
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on July 7, 2009. The last two digits are sequenced starting with 01. This is a highly fl exible 

numbering system that allows 100 part numbers to be created per day. If more than 100 are 

needed, then backdating using an unused date can be done. The date itself holds no real sig-

nifi cance, other than helping to ensure the unique part numbers.

Sequential Product-Based: NG-00001  Here the fi rst two letters refl ect a specifi c product 

line, such as the Next Generation (NG) line, and the last fi ve are sequenced starting at 00001. 

This numbering system works well when products lines are engineered and maintained 

separately.

Once you’ve decided on a part numbering scheme, you will want to come up with a central 

part number log fi le or tracking system to be used in assigning numbers to ensure that there are 

no duplicates. If you have a resource planning system (commonly referred to as a manufactur-

ing resource planning [MRP] or enterprise resource planning [ERP] system), you likely have the 

ability to manage part numbers using that software. If not, a simple XLS spreadsheet fi le can be 

used to assist with this task.

The Projects Dialog Box’s Tool Panel

The buttons along the right side of the lower pane of the Projects dialog box provide access to 

tools that allow you to add, edit, and reorder project parameter settings and paths; check for 

duplicate fi lenames; and confi gure Content Center libraries used for the active project.

Use the magnifying glass button located on the lower-right side of the Projects dialog box 

to check your project paths for duplicate fi lenames. Figure 1.30 shows the result of searching a 

project where someone has not been careful to ensure that duplicate fi lenames are not used.

Figure 1.30

Th e Non-Unique 

Project File Names 

dialog box

Why Relative Paths?

An Inventor assembly fi le records relative paths when it links a subassembly or single parts to itself. 

Th e use of relative paths in assembly fi les allows the relocation of an assembly and its associated 

parts and subassemblies to other locations on servers or drives without requiring the resolution 

of a new location. Relative paths, however, introduce the danger of the assembly locating only the 

fi rst of two parts that happen to have the same name. For instance, if you’ve saved fi les named 

Part1 in two diff erent fi le folders, Inventor might resolve the link to the fi rst one it fi nds and then 

stop searching.

To prevent the possibility of the wrong part being loaded in an assembly, ensure that every part 

located in the search path has a unique name.
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The Projects dialog box supports the confi guration of one or more Content Center libraries. 

Content Center provides multiple database libraries that can be used in assemblies or by the 

design accelerator.

If you elected to install Content Center libraries while installing Inventor, you must confi gure 

Content Center libraries in the project before you can access them. Click the Content Center but-

ton in the lower-right corner of the project editing dialog box. Then select Content Center library 

or libraries you want to use, and click OK. Figure 1.31 shows the Confi gure Libraries dialog box.

Figure 1.31

Confi guring 

Content Center

Select Content Center libraries you think you’ll use. Installing all Content Center librar-

ies may slow your system down signifi cantly when you are accessing Content Center because 

Inventor will need to index each library upon initialization.

When you fi nish editing the project fi le, click Save, and then make sure your desired project 

fi le is active before clicking Done to exit the Projects dialog box.

Creating Multiuser Projects
Working as a team can increase productivity many times over. In a collaborative design envi-

ronment, several users may be working on a project at the same time. When you create a mul-

tiuser project, you have the option to choose Vault (if Vault is installed), shared, or semi-isolated 

project types. As stated earlier, Vault is similar to a semi-isolated project in how it works. It pre-

vents you from working on the original version of a fi le located inside Vault. Each user creates a 

local Vault project fi le that specifi es a personal workspace located on the local drive and includes 

search paths to one or more master projects.

What Is Autodesk Vault and Who Needs It?

Autodesk Vault is a fi le-management tool integrated with Inventor. Essentially, Vault allows you 

to check in and check out fi les in a collaborative workgroup so users do not accidentally save over 

one another’s work. Not every design department needs to use Vault, and in fact many fi nd that it 

is not a good solution for their particular needs. However, you should investigate Vault to see what 

it has to off er, even if you already have a data management system in place.
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To edit a “Vaulted” fi le, the user must check the fi le out of Vault. The process of checking the 

fi le out copies the fi le to the local workspace. When someone checks out a fi le for editing, the 

original stored in Vault is fl agged as “checked out” to that particular user. Other users can view 

the checked-out fi les in read-only mode, but they can’t edit it.

The user who checked out the fi le can edit and save the fi le in their local workspace with-

out checking the fi le back into Vault. When they save the fi le, they will be prompted to choose 

whether they want to check the fi le back into Vault. If they choose to check the fi le into Vault, 

the fi le will be saved into Vault and is then available for editing by a different user. Optionally, 

they may save the fi le into Vault but keep it checked out to their local workspace, allowing other 

users to view the updated fi le without being able to edit it.

Project Shortcuts

If you right-click a project in the Project dialog box, you can choose Delete to remove it from the 

list. But if you browse to the fi le location, you’ll see that the IPJ fi le is still there. What is going on?

When you create a new project fi le or point Inventor to an existing project fi le, Inventor will create 

a shortcut to that fi le. When you choose Delete and remove the project from the list, you are not 

actually deleting the IPJ fi le but instead deleting the shortcut. When you choose Browse and locate 

the IPJ fi le to add back to the list, the shortcut is re-created.

Th e path to the shortcuts can be set by accessing the Tools tab of the Ribbon menu and choosing 

Application Options. In the Application Options dialog box, click the Files tab and set the project’s 

folder path.

Collaborative design project fi les are created using the Inventor Project Wizard in much the 

same manner as a single-user project fi le is created. The fi le resolution process within a collab-

orative project fi le functions in the same way.

With Vault installed on your server or your own system, you can create and confi gure a Vault 

project. If Vault Explorer is not installed on your system, you cannot install or create a Vault 

project on your system. Before you create your fi rst Vault project, verify that Vault is correctly 

installed and that you can open and create a new Vault fi le store using the ADMS console. The 

new Vault fi le store must be accessible on your local system from Vault Explorer. If Vault func-

tions correctly, you are now ready to create a Vault project fi le. As with a single-user project, use 

the Inventor Project Wizard to name the project, specify the workspace, assign libraries for use 

with the project, and confi gure project parameters.

Again, as in other project fi le types, you will need to edit the default settings in your project 

fi le and optionally confi gure your Content Center for use.

Implementing Autodesk Vault

Once the Vault software is installed on your system, you can fi nd the Autodesk Vault Implementation 

Guide in PDF in the Help folder of the install directory. Or you can search the Internet for 

autodesk+vault+implementation+guide. Th is detailed guide provides you with information 

on Vault fundamentals and installation as well as information on confi guring and maintaining 

Autodesk Vault for your data management needs.
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Understanding Inventor Templates
You can create template fi les in Inventor by opening an Inventor fi le, making the desired edits to 

the fi le, clicking the Inventor button, choosing Save Copy As, and then choosing Save Copy As 

Template. It is typically recommended that you set the Template directory by confi guring your 

project fi le using the Folder Options node and setting the Template path to a network location. 

Often when creating a template, you might set up the following items in the fi le before saving:

 ◆ Custom iProperties

 ◆ User parameters

 ◆ Cached styles

 ◆ Specifi c document settings such as Units (by clicking the Document Settings button on the 

Tools tab)

When creating any template fi le, it is a good idea to work with a fi le that is as “clean” and 

uncluttered with extra styles as possible. The best way to do this is to hold down the Ctrl and 

Shift keys and click the New button; then select the type of fi le you want to create from the list, 

as shown in Figure 1.32.

Figure 1.32

Creating a new 

clean fi le

Working with Styles, Style Libraries, and Company 
Standards
Your Inventor fi les will use a number of styles to allow you to maintain consistencies and to save 

you from needing to defi ne common setups over and over. In part fi les, the style collections 

include lighting styles, color styles, and material styles. Color and lighting styles allow you to 

change the appearance of your model, and material styles allow you to change its physical prop-

erties. In drawing fi les, styles collections include such things as dimension styles, balloon styles, 

parts list styles, and much more. These drawing style collections are organized in standards, 
which are used to manage the standard company styles used within your organization. You can 

even have multiple standards set up, allowing you to change from one set of styles to another 

quickly and consistently.

Th e Bottom Line

Create parametric designs.  The power of parameter-based design comes from the quick 

and easy edits, when changing a parameter value drives a change through the design. To 

make changes easily, though, you need to follow certain general rules so that the changes 

update predictably.



THE BOTTOM LINE | 41

Master It  You want to create a model of a base plate, a rectangular-shaped part with 

a series of holes and rectangular cutouts. What would your initial sketch look like in 

Inventor?

Get the “feel” of Inventor.  The interface contains many elements that change and update 

to give you the tools you need to perform the task at hand. Getting comfortable with these 

automatic changes and learning to anticipate them will help you get the “feel” of Inventor.

Master It  You create an extrude feature using the Extrude button, but you cannot seem 

to fi nd an Edit Extrude button. How can you edit the extruded feature to change the 

height?

Use the Inventor graphical interface.  Inventor 2014 uses the Ribbon menu interface fi rst 

introduced in Inventor 2010. Tools are grouped, which makes fi nding them intuitive once you 

become familiar with the basic layout.

Master It  You are trying to draw a line on the face of a part, but you seem to have lost 

the Sketch tab in the ribbon. How do you get it back?

Work with Inventor fi le types.  Inventor supports many different fi le types in its native 

environment, separating tasks and fi les to improve performance and increase stability.

Master It  You have trouble keeping the various fi le types straight because all the fi le 

icons look rather similar to you. Is there a way you can see which fi le is what type?

Understand how project search paths work.  Knowing how Inventor resolves fi le paths 

when it opens linked fi les, such as assembly fi les and drawings, goes a long way toward help-

ing prevent broken links and repairing links that do get broken.

Master It  What type of fi le does Inventor use to point the assembly fi le to the parts that 

it contains?

Set up Library and Content Center paths.  Library and Content Center paths are read-only 

library confi gurations set up in the project fi le.

Master It  When you set up a Library or Content Center path to a folder that does not 

exist, what happens?

Create and confi gure a project fi le.  Project fi les are a key component of working success-

fully in Inventor, but for many people, this is a one-time setup. Once the project is created, for 

the most part you just use it as is.

Master It  After creating a project fi le initially, you want to make one or more changes to 

the confi guration, but you can’t seem to do so. What could be the problem?

Determine the best project type for you.  Although the Autodesk solution to a multiuser 

environment is Autodesk Vault, many people may not be able to use Vault. For instance, if 

you use another CAD application that links fi les together like Inventor, Vault will likely not 

know how to manage the internal links for those fi les.

Master It  Because you generally do not work concurrently on the same fi les as your 

coworkers, you think it might be best to set up a single-user project for now while you 

continue to investigate the Vault solution, but you are not sure if that will work. Can 

single-user projects be used in this manner? 





Chapter 2

A Hands-on Test Drive 
of the Workfl ow

In this chapter you will explore the basic steps involved in creating part models, creating draw-

ings of those parts, putting those parts together into an assembly model, and then creating 

a drawing of that assembly. At this point it is assumed that you have taken the time to read 

through Chapter 1, “Getting Started with Autodesk® Inventor®,” and are familiar with the 

Autodesk Inventor software interface and navigation tools. If you have not done so, you might 

want to take the time to read that chapter before continuing.

Although Inventor includes a number of tools that go far beyond the simple tasks of creating 

parts, drawings, and assemblies, the workfl ow involved in creating and detailing your designs 

is the foundation upon which you will build as you learn Inventor. The goal of this chapter is to 

get you familiar with the overall workfl ow. In the chapters to follow, you will explore the tools 

and environments in more depth.

In this chapter, you’ll learn to:

 ◆ Create a part model

 ◆ Create and detail drawings of part models

 ◆ Put part models together in assembly fi les

 ◆ Create and detail drawings of assembly models

Creating a Part Model
Throughout this chapter you will be working toward creating the simple mechanism shown 

assembled in Figure 2.1.

Figure 2.1

An assembly 

created with 

Inventor parts
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To become familiar with this assembly, you can open the fi les mi_2a_180_Complete.jpg, 

mi_2a_180_Video.mov, or mi_2a_180_Video.mp4; all are located in the Chapter 02 directory 

of your Mastering Inventor 2014 folder once you’ve downloaded this book’s companion fi les 

and created the folder structure Inventor expects for them, as described in the accompanying 

“Before You Start...” section.

To create a model of a part, you will use an Inventor *.ipt fi le template. Once your new fi le 

is created, you will create basic profi les using sketching tools such as lines, arcs, and circles 

to defi ne the shape of the features that make up the part. You’ll also add dimensions and geo-

metric constraints to the sketch. You’ll then use the sketched profi les to create the 3D features 

that will defi ne the parts. Figure 2.2 shows the basic workfl ow involved in creating a part from 

sketches and features.

Figure 2.2

Creating a part 

model Create 2D
sketch

200
25

200

Create
base feature

Create new
sketch

Create
next feature

Completed
part

Before You Start…

Before you begin, make sure you have downloaded the tutorial fi les from www.sybex.com/go

/masteringinventor2014. Place the fi les in a folder on your computer (such as \My Documents

\Mastering Inventor 2014).

If you are using the Autodesk® Inventor LT™ program, the use of project fi les does not apply and 

you can skip the steps listed here. If you are using a full version of Inventor, you’ll want to follow 

these steps to set the Mastering Inventor 2014 project active:

 1. From within Inventor, close any open fi les.

 2. From the Get Started tab, select the Projects button.

 3. From the Projects dialog, select the Browse button.

 4. From the Choose Project File dialog, browse to your Mastering Inventor 2014 folder, select 

the Mastering Inventor 2014.ipj fi le, and click Open.

 5. Note that the Mastering Inventor 2014 project is denoted as being the active project with a 

check mark.

 6. Click Done to close the Projects dialog box.

Now you are ready to get started with this book’s exercises.

http://www.sybex.com/go
http://www.sybex.com/go/masteringinventor2014
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Starting with a Part Template
Inventor installs with several part templates that you can use to create your part fi les. In the fol-

lowing steps, you’ll use a millimeter-based part template to start your model.

 1. From the Get Started tab, choose New (or press Ctrl+N on the keyboard).

 2. From the Create New File dialog box, expand the Templates folder (if required) and 

select the Metric folder from the list on the left.

 3. Click Standard (mm).ipt from the list of part templates on the right side of the dialog 

box. Figure 2.3 shows the metric templates displayed in the Create New File dialog box.

Figure 2.3

Creating a fi le 

from a metric part 

template

 4. Click the Create button at the bottom of the dialog box to create a new fi le from the 

selected template.

Leave the fi le open and continue to the next section to create a base sketch in this new 

part fi le.

Understanding Origin Geometry
When you start a new fi le from a part template, the fi le contains some basic origin geometry 

located in the Origin folder. The Origin folder is found in the browser. Figure 2.4 shows a 

model of a screw with the Origin folder expanded and the origin geometry set to be visible. 

You can see the geometry browser nodes in the list on the left and the origin planes and axes 

displayed on the right as they run through the screw geometry.

Figure 2.4

Origin geometry in 

a part model
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To create a base sketch for your part, you will use an origin plane to sketch on. Because origin 

geometry cannot be changed, using an origin plane to sketch on allows you to anchor your base 

sketch in space and provides a stable foundation upon which to create your part.

For a new fi le, the origin geometry is typically set to be invisible, but you can right-click any 

origin geometry and choose Visibility to make it appear. Right-clicking again and deselecting 

Visibility will toggle the origin feature’s visibility back off.

Creating a Base 2D Sketch
When you create a new part, Inventor will prompt you to select an origin plane on which to 

sketch, or it will create a new sketch for you on a designated origin plane. You can control this 

behavior by selecting the Tools tab and clicking the Application Options button. On the Part tab, 

you will fi nd the Sketch On New Part Creation option.

If this option is set to No New Sketch, Inventor will prompt you to select an origin plane to 

create your base sketch; otherwise, the base sketch will be created on the plane designated by this 

option automatically. Figure 2.5 shows the option for controlling the sketch behavior for new parts.

Figure 2.5

Setting the Sketch 

On New Part 

Creation option

In the following steps you will create a simple sketch to use as the base for your part. If the 

option for controlling the sketch behavior for new parts was set to use one of the origin planes 

automatically, then you can skip these steps.

 1. Fro m the 3D Model tab, select the Create 2D Sketch button.

Inventor will temporarily turn on the origin geometry and pause for you to select one of 

the planes to sketch on, as shown in Figure 2.6.

Figure 2.6

Selecting a plane to 

sketch on
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 2. Expand the Origin folder in the browser and watch the selection highlight to select the 

XY origin plane to place your sketch on. Note that you can select an origin plane by 

clicking it in the browser or by selecting the edge of the plane in the graphics area.

Once you’ve selected a plane to sketch on, you will see a Sketch node created in the browser. 

The Sketch tab is now active and displays the sketch tools, as shown in Figure 2.7.

Figure 2.7

A new, active sketch

New sketch

Active sketch tab and tools

Creating a Profi le in the Sketch
Now that you have a sketch created and active for editing in your new part fi le, you will create a 

profi le to form the base feature of your part.

 1. From the Draw panel on the Sketch tab, click the Center Point Circle button.

You should see a dot in the center of your sketch; this is the projected origin center point 

of your part.

 2. Click the dot to place your cursor on the origin center point so that the circle is centered 

and anchored on this point.

 3. Enter Dia = 200 for the diameter of the circle, as shown in Figure 2.8.

Figure 2.8

Creating a sketched 

circle

Entering Dia = 200 does two things at once. Entering 200 defi nes the value of this dimen-

sion parameter. Preceding it with Dia = defi nes the name of the parameter, making it 

easier to recall later.

 4. Press the Enter key to create the circle.
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 5. Right-click and choose OK or Cancel to exit the Circle tool.

 6. From the Sketch tab, click the Finish Sketch button to exit the sketch environment.

Creating a Base 3D Feature
Next, you’ll use the circle in your sketch as the base profi le for the base 3D feature for this part.

 1. From the 3D Model tab, click the Extrude button.

 2. Enter 25 for the extrude distance.

Note that you can enter the value in the dialog box or in the mini-toolbar controls, and 

each will have the same result. You might need to click the black arrow to expand the 

Extrude dialog box in order to see the buttons within it.

 3. Click the OK button (or the green check mark button) to create the extrude feature.

Notice that an extrusion feature has been created in the browser, and if you expand it you’ll 

fi nd Sketch1, as shown in Figure 2.9.

Figure 2.9

Th e base extrusion

Creating a Secondary 2D Sketch
Next, you’ll create a new sketch on the top face of the extrusion you just created.

 1. From the 3D Model tab, select the Create 2D Sketch button.

 2. Click the top face of the extrusion to place the sketch.

 3. From the Draw panel on the Sketch tab, click the fl yout arrow and then select the Two 

Point Center Rectangle tool, as shown in Figure 2.10.

 4. Select the projected center point to place the rectangle.

 5. Enter Dia for the fi rst input, and then press the Tab key on the keyboard. This will recall 

the value of the diameter dimension you created previously.

 6. Enter 25 for the second input, and then press the Enter key.

 7. Right-click and choose OK or Cancel to exit the Rectangle tool.
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 8. Select the outer projected edge of the base feature (the circle), and then use the 

Construction button to toggle the line type to a dashed construction line.

Figure 2.10

Creating a sketched 

rectangle

This allows Inventor to ignore the circle as a profi le boundary in the steps to come. 

Figure 2.11 shows the circle being set to a construction line.

Figure 2.11

Creating a construc-

tion boundary

 9. When your sketch looks like Figure 2.12, click the Finish Sketch button to exit the 

sketch environment.

Figure 2.12

Th e fi nished sketch
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Creating a Secondary 3D Feature
Next, you’ll cut a dovetailed slot from the part using the sketch created in the previous steps. If 

you did not complete the steps up to this point, you can open the fi le mi_2a_001.ipt, located in 

the Chapter 02 directory of your Mastering Inventor 2014 folder.

 1. From the 3D Model tab, click the Extrude button.

 2. If needed, click the black arrow to expand the Extrude dialog box in order to see the but-

tons within it. Enter 10 for the extrude distance.

Recall that you can enter the value in the dialog box or in the mini-toolbar controls, and 

each will have the same result.

 3. In the Extrude dialog box, click the Cut button to ensure that the rectangle is cut from the 

base feature (or set the Solution drop-down to Cut in the mini-toolbar controls).

 4. Click the More tab in the dialog box and enter 12 for the taper distance.

 5. Click the OK button (or the green check mark button) to create the extrude feature.

Notice that another extrusion feature for this dovetailed cut has been created in the browser; 

if you expand it you’ll fi nd Sketch2, as shown in Figure 2.13.

Figure 2.13

Th e dovetail cut 

extrusion

Patterning a 3D Feature
Next, you’ll pattern the dovetailed slot to create a second, cross slot. If you did not complete the 

steps up to this point, you can open the fi le mi_2a_002.ipt located in the Chapter 02 directory 

of your Mastering Inventor 2014 folder.

 1. From the 3D Model tab, fi nd the Pattern panel and click the Circular Pattern button.

 2. For the Features selection, click Extrusion2 in the browser list.

 3. Right-click and choose Continue to switch from the Features selection mode to the 

Rotations Axis selection mode (or you can click the red arrow in the dialog box).

 4. Click the outer face of the part to use cylindrical surface as the rotation axis.

 5. Enter 2 for the count.
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 6. Enter 90 for the angle.

Figure 2.14 shows the Circular Pattern dialog box at this point.

Figure 2.14

Th e patterned dove-

tail slot

 7. Click the OK button to create the pattern feature.

This concludes the creation of this basic part model. Although this model is somewhat sim-

ple, it demonstrates the workfl ow used to create much more complex part models as well. Keep 

in mind that for the majority of the part models you will use this workfl ow:

 ◆ Create a new fi le using an Inventor *.ipt fi le template.

 ◆ Create basic profi les using sketch tools to defi ne the shape of the features that make up 

the part.

 ◆ Use the sketched profi les to create the 3D features that will defi ne the parts.

Creating and Detailing Drawings of Part Models
In this section you’ll open an existing drawing and create views of a part model and then add 

dimensions and annotations. In the real world, often you’ll use a drawing template to create a 

new drawing, much as you did with the part model template. At other times, you will be editing 

existing drawings just as you will be doing in these steps.

Creating a Base View on a Drawing
In Inventor, drawing views are created by referencing model fi les. In the following steps, you’ll 

open a part model and then create a view of it on an existing drawing.

 1. On the Get Started tab, click the Open button.

 2. Browse for the part fi le mi_2a_004.ipt in the Chapter 02 directory of your Mastering 

Inventor 2014 folder, and click Open.

If you’d like, spin the part around and take a look at it using the ViewCube or the Orbit 

tool. Note that this is basically the same part created earlier in this chapter, with a couple 

of modifi cations. Do not close the part, because you will want to have it open in the 

upcoming steps.
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 3. Browse for the drawing fi le mi_2a_004.idw in the Chapter 02 directory of your 

Mastering Inventor 2014 folder, and click Open.

This is a drawing fi le that has been created using rather poor techniques. In the following 

steps, you’ll clean up this fi le and create views of the same part fi le but with much better 

results.

 4. Hover your cursor over the part on the page, and you will see a dotted outline 

of the view.

 5. Right-click the dotted view border and choose Delete, and then click the OK button to 

confi rm that you want to delete the view.

 6. On the Place Views tab, click the Base button to create a base view.

 7. With the Drawing View dialog box open, move your mouse pointer around on the draw-

ing, and you will see a dynamic preview of the part fi le that you opened earlier. Do not 

click the screen just yet or you will inadvertently place the drawing view.

Note that all open model fi les are listed in the File drop-down list. You can select any 

open model fi le from the list or click the Browse button to select another fi le.

 8. In the Scale fi eld enter 0.5, as shown in Figure 2.15, or use the drop-down list to select 1/2.

Figure 2.15

Base View options

 9. In the Orientation pane on the right, click through the available options and watch the 

preview at your mouse pointer change. Select Top when you’ve fi nished.

 10. In the Style area, click just the middle button to create an unshaded view with no 

hidden lines.

 11. Uncheck the Create Projected Views Immediately After Base View Creation check box, 

found in the lower-left corner.

 12. Click anywhere on the page to create the view (or click the OK button).
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 13. Hover your cursor over the view until you see a dotted outline of the view, and then click 

and drag it to move the view to the lower left of the page so that it fi ts well.

Figure 2.16 shows the drawing with the base view.

Figure 2.16

A well-placed 

base view

Creating Projected Views on a Drawing
Next, you’ll use the base view you created to project other views onto the page. If you did not 

complete the previous steps, you can open the fi le mi_2a_005.idw located in the Chapter 02 

directory of your Mastering Inventor 2014 folder.

 1. On the Place Views tab, click the Projected button to create views projected from 

the base view.

 2. Click the base view.

 3. As you drag your mouse pointer around the base view, notice the view previews that are 

being generated.

 4. Drag straight to the right and click. You will see a rectangular bounding box, indicating 

that a view will be placed there.

 5. Next, drag diagonally up and to the right from the base view (toward the top-right corner 

of the page) and click.

 6. Right-click and choose Create to generate the projected views.

 7. Select the view border (dashed bounding box) of the top-right view, and then right-click 

and choose Edit View.

 8. In the Style area at the bottom right of the dialog box, click just the blue button on the 

right to shade the view, and then click the OK button.
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Figure 2.17 shows the drawing with the additional projected views.

Figure 2.17

Projected views

Creating Dimensions on a Drawing
Next, you’ll add dimensions to the views. If you did not complete the previous steps, you can 

open the fi le mi_2a_006.idw located in the Chapter 02 directory of your Mastering Inventor 

2014 folder.

 1. Switch from the Place Views tab to the Annotate tab, and then click the Dimension 

button.

 2. Click any of the circular edges around the perimeter of the base view.

 3. Move your cursor to the outside of the part.

Note that Inventor will give you a radius dimension if you select an arc edge, and it will 

default to a diameter dimension if you happen to select an edge that is a circle. Often, 

edges in views overlap, making it diffi cult to predict whether the selection will return a 

radius or a diameter. To deal with this, you can right-click and switch the result.

 4. With the dimension still previewing at your cursor, right-click and choose Dimension 

Type; notice the various dimension types you can place with the current selection.

 5. Choose Diameter as the type, and then click on-screen to place the dimension (if the Edit 

Dimension dialog box appears, you can just click OK without making any edits).

 6. Click the line on the left side of the dovetailed slot (make sure you’re not clicking the 

green midpoint dot), and notice that the results display the length of the selected line.

 7. Click the line on the right side of the dovetailed slot, and notice that the results display 

the distance between the two selected lines, as shown in Figure 2.18.
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Figure 2.18

Placing dimensions

You can continue experimenting with the Dimension tool if you’d like, or you can move on 

to the next section and have a look at assemblies. Keep in mind that there is an entire chapter 

of this book devoted to the topic of creating and dimensioning drawing views, but this section 

hopefully gave you an idea of the workfl ow used in Inventor to create drawings from models.

Putting Part Models Together in Assembly Files
In this section, you will explore the workfl ow used to create assembly models. Assembly fi les 

start out as empty container fi les, into which you place your part models. Once the parts are 

placed, you can begin to assemble them using what are known as Assembly constraints. Assembly 

constraints are simply relationships between the geometry of different parts.

In the next set of steps, you will assemble a simple mechanism composed of just a handful 

of parts. You can open the fi les mi_2a_180_Complete.jpg, mi_2a_180_Video.mov, or 

mi_2a_180_Video.mp4 in the Chapter 02 directory of your Mastering Inventor 2014 folder 

to have another look at the fi nal assembly in action.

Inventor LT and Assembly Files

If you are using Inventor LT, you will not have the ability to create assembly fi les with your version. 

If you fi nd that you need to assemble part fi les, you might look into upgrading to the full version 

of Inventor.

Placing, Rotating, and Moving Parts in an Assembly File
In the next set of steps, you will open an assembly fi le and place a part in it. Then you will rotate 

and move the free-fl oating or unconstrained parts around in the assembly. As you’ll see, when 

parts are placed into an assembly, they are initially free to move and rotate in all directions.

 1. On the Get Started tab, click the Open button.

 2. Browse for the assembly fi le mi_2a_190.iam in the Chapter 02 directory of your 

Mastering Inventor 2014 folder, and click Open.

This assembly fi le was created from an assembly template much like the part template 

you used at the beginning of this chapter. Most of the parts have been placed into the 

assembly. However, there is one more part that needs to be placed, and you will do this 
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next. Once the part is added, you will take a few moments to rotate and move parts 

around the assembly.

 3. From the Assemble tab, click the Place button (or right-click in the graphics area and 

choose Place Component).

 4. Browse for the part fi le mi_2a_183.ipt in the Chapter 02 directory of your Mastering 

Inventor 2014 folder, and click Open.

 5. Click in the graphics area to place the part into the assembly.

 6. Note that you have the opportunity to place another instance of the same part. In this 

case, though, you will right-click and choose Cancel to exit the Place Component tool.

 7. Notice that the components are listed in the browser. Take a moment to click the various 

components and notice that when selected in the graphics area, the component is high-

lighted in the browser. When selected in the browser, it is highlighted in the graphics 

area. To deselect components you can just click in empty space. 

Turning On a Missing Model Browser

Although it isn’t common to need to turn the Model browser off , you can do so. More commonly, 

you may accidentally turn it off  by clicking the X button on the right side of the browser title bar. 

To display it again, from the View tab click the User Interface button found on the Windows panel. 

You’ll most likely want to have all the items in this list selected except for possibly the iLogic Browser 

and the Eco Materials Adviser. 

 8. Click the Free Rotate button found on the Position panel of the Assembly tab (or type 

G on the keyboard).

 9. Click any of the parts other than the large, round base part to select a part for rotating.

 10. Click and drag in the center of the rotate “target” to orbit the part around.

 11. Click and drag the outside of the rotate “target” to rotate the part around.

 12. Click and drag one of the horizontal or vertical lines on the rotate “target” to rotate the 

part on that axis.

 13. Click another part to set it active for rotating.

 14. Click anywhere in the graphics area that is not on a part to exit the Free Rotate tool.

 15. Next, click and drag any of the parts, other than the large round base part, to move 

the part. 

Note that the large, round base part cannot be rotated or moved because it is grounded in 

place. If you right-click it and deselect Grounded, it will available to rotate and move. However, 

it’s always best to have one base part that is grounded in place to provide a stable foundation on 

which to build your assembly.



PUTTING PART MODELS TOGETHER IN ASSEMBLY FILES | 57

Editing a Component by Accident

If you happen to accidentally double-click a component from within an assembly fi le, Inventor will 

switch from the assembly environment to the part-editing environment. You’ll be able to see that 

you’ve done this when the browser shows the other components grayed out, and the 3D Model 

tools are displayed in the Ribbon menu. To exit the part-editing environment and return to the 

assembly environment, you can right-click and choose Finish Edit, or use the Return button on 

the far right of the 3D Model tab.

As you’ve seen, when parts are placed into an assembly, they are initially free to move and 

rotate in all directions. This ability to move is referred to as the parts’ degrees of freedom. Your 

goal when creating assemblies is to remove these degrees of freedom until your assembly 

behaves as designed. You can close this fi le without saving changes and continue to the next 

section, where you will put the parts together.

Working with Degrees of Freedom in an Assembly
As you saw in the previous section, parts are initially free to move and rotate when placed into 

an assembly. Next, you’ll open another version of the assembly fi le and examine the behavior of 

a partially constrained part.

 1. On the Get Started tab, click the Open button.

 2. Browse for the assembly fi le mi_2a_191.iam in the Chapter 02 directory of your 

Mastering Inventor 2014 folder, and click Open.

 3. Click and drag the screw, and notice that it can move freely.

However, you’ll notice that the round base part cannot move. This is because it is 

grounded in place. To help better visualize how underconstrained parts can move, you 

can turn on the degrees of freedom (DOF) icons.

 4. From the View tab, click the Degrees Of Freedom button.

You’ll notice that arrows and other icons are overlaid on the screw. These are the DOF 

indicators and are displayed to show you the remaining degrees of freedom present. 

Figure 2.19 shows the screw with all of its DOF icons displayed. This part can move in the 

x-, y-, or z-axis and can rotate around all those axes as well.

Figure 2.19

Six degrees of 

freedom
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In Figure 2.20 the part has only two remaining degrees of freedom because it has been 

constrained to a hole. It has the ability to move in one axis and rotate about that same 

axis. This is because the centerline of the part and the centerline of the hole have been 

constrained together.

Figure 2.20

Two degrees of 

freedom

Next, you’ll place an Assembly constraint to insert the unconstrained screw into the hole 

on the large base part.

 5. From the Assemble tab, click the Constrain button (or type C on the keyboard).

 6. In the Type area of the Place Constraint dialog box, select the Mate button (hover your 

cursor over the buttons to see their names).

 7. Select the cylindrical face of the shaft for Selection 1. Notice that the highlight shows that 

the centerline is selected.

 8. Select the cylindrical face of the hole on the large round base part for Selection 2.

 9. Click the OK button in the Place Constraint dialog box to create the Mate constraint.

Notice that all but two of the DOF icons have been removed from the screw part, and the 

remaining icons indicate that the screw is free to rotate in the hole and slide in and out of the 

hole. You can click and drag the screw to confi rm this.

Constraining parts to remove degrees of freedom is the way you assemble parts in an assem-

bly fi le. If the goal is to create a mechanism that moves in a predictable manner, you will leave 

some degrees of freedom unconstrained so that those parts can still move. You can close this fi le 

and continue on to explore this idea further.

Placing Assembly Constraints to Defi ne Mechanical Movement
In this section you will place Assembly constraints between parts within an assembly fi le. Your 

goal is to constrain the parts in a way that allows the assembled mechanism to operate as it does 

in the video fi le (see mi_2a_180_Video.mov or mi_2a_180_Video.mp4).

Using Mate Constraints to Create Sliding Bearings

In the following steps you place Mate constraints on square bearings and the base part to create 

sliding motion for the bearings:

 1. On the Get Started tab, click the Open button.
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 2. Browse for the assembly fi le mi_2a_192.iam in the Chapter 02 directory of your 

Mastering Inventor 2014 folder, and click Open.

 3. Select the View tab, and click the Degrees Of Freedom button to turn on the degrees of 

freedom triad for each part that is not grounded or fully constrained.

 4. From the Assemble tab, click the Constrain button (or type C on the keyboard).

 5. In the Place Constraint dialog box, ensure that the Assembly tab is active and the Mate 

button is selected for the type. Make sure the Preview check box is selected and the 

Predict Offset And Orientation check box is cleared.

Here is an explanation of these two options:

Predict Offset And Orientation  This button measures the distance between the select-

ed faces, allowing you to eyeball a part placement and then retrieve the distance. If the 

check box is not selected, a default of 0 is entered for the offset.

Preview  This check box, denoted by the eyeglasses icon, controls whether the selected 

components will adjust position or orientation so you can review the constraint before 

clicking Apply or OK to actually create it.

 6. For Selection 1, click the blue face on one of the square bearings. Watch the on-screen 

highlights to be sure you select the face and not an edge. It may be helpful to zoom in.

 7. For Selection 2, click anywhere on the blue x-shaped face of the base part, as shown in 

Figure 2.21.

Figure 2.21

Mate constraint 

selections

You should see the part “snap” into place based on your selection points. This is just 

a preview of the constraint and is controlled by the Preview check box. To place the 

constraint, you need to click the Apply or OK button. Clicking the Apply button places 

the constraint and then leaves the dialog box open so you can place another constraint, 

whereas clicking the OK button places the constraint and then closes the dialog box.

 8. Click Apply to place the Mate constraint between the two parts.

 9. Place another Mate constraint using the tapered side face of the x-shaped slot feature and 

the tapered side face of the same bearing part.
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The selection order is not important, but be sure you are selecting faces and not edges, 

because edges will give you a different result. It might help to zoom in to select the faces. 

Recall that you can use the wheel button on your mouse to zoom in and out. Figure 2.22 

shows the faces to be selected.

Figure 2.22

Tapered face 

selections for 

the second Mate 

constraint

 10. Once your selections are made, click the OK button to place the constraint and close the 

dialog box.

 11. Click and drag on the bearing part to see it slide in the groove.

Notice too that the DOF icons for the bearing have changed to indicate that it can move in 

only one axis now.

 12. Apply two more Mate constraints to the other bearing part, so that it will slide in the 

other cross groove.

You can open the fi le mi_2a_193.iam to see the assembly completed at this stage and com-

pare it to yours.

Using Insert Constraints to Fasten Parts Together

Next, you’ll constrain the remainder of the assembly using the Insert constraint. An Insert con-

straint places a mate between a center axis and a circular edge all at once, and it’s ideal when 

you are constraining fasteners and other cylinder-shaped parts to holes.

You can continue using mi_2a_192.iam from the previous steps or close it and open 

mi_2a_193.iam in the Chapter 02 directory of your Mastering Inventor 2014 folder.

 1. Select the View tab, and click the Degrees Of Freedom button to turn on the degrees of 

freedom triad for each part that is not grounded or fully constrained.

 2. From the Assemble tab, click the Constrain button (or type C on the keyboard).

 3. In the Place Constraint dialog box, ensure that the Assembly tab is active and the click 

the Insert button for the type. Make sure the Preview check box is selected and the 

Predict Offset And Orientation check box is cleared.

 4. For Selection 1, click the circular edge of one of the bearings, as shown in Figure 2.23.

 5. For Selection 2, click the circular edge of one end of the oblong link, as shown in Figure 2.24.
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Figure 2.23

Selection 1 for the 

Insert constraint

Figure 2.24

Selection 2 for the 

Insert constraint

 6. Click Apply to place the Insert constraint between the two parts.

 7. Place another Insert constraint using the circular edge on the other bearing and the bot-

tom edge of the oblong link.

Note that because the hole is concentric to the round end of the link, this selection is the 

same as the circular edge of the hole. Figure 2.25 shows the edges to be selected.

Figure 2.25

Edge selections for 

the second Insert 

constraint

 8. Once the second insert is placed, exit the Place Constraint dialog box, and test the 

motions of the assembly by clicking and dragging the green dot in the center of the 

oblong link and “tracing” the outer circular edge of the large, round base part.
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To complete the assembly, place an Insert constraint between the fl at washers and the holes 

on the top of the oblong link, and then place Insert constraints between the bottom edge of 

the screw heads and the top of the fl at washers. When you’ve fi nished, you can open the fi le 

mi_2a_194.iam in the Chapter 02 directory of your Mastering Inventor 2014 folder to com-

pare it to your results. Then you can close all the fi les you have open and continue to the next 

section to explore the tools used to document assemblies in the 2D drawing environment.

Creating and Detailing Drawings of Assembly Models
In this section, you’ll open an existing drawing and add a detail view to the sheet. Then you’ll 

use the annotation tools to place a parts list and part number balloons in the drawing. Finally, 

you’ll export the fi nished drawing as a PDF fi le so that it can be shared with people who do not 

have Inventor.

Inventor LT and Assembly Files

If you are using Inventor LT, you will not have the ability to create drawings of assembly fi les with 

your version. If you fi nd that you need to create and detail assembly models, you might look into 

upgrading to the full version of Inventor.

Creating an Assembly Detail View
In the following steps, you’ll open a drawing that contains a single base view of an assembly 

model. You’ll create a detail view by referencing the existing base view.

 1. On the Get Started tab, click the Open button.

 2. Browse for the drawing fi le mi_2a_195.idw in the Chapter 02 directory of the 

Mastering Inventor 2014 folder, and click Open.

 3. On the Place Views tab, click the Detail button.

 4. Click anywhere on the existing base view to use it as the basis of the new detail view. 

This will open the Detail View dialog box.

In the Detail View dialog box, the View/Scale Label And Style settings can be adjusted as 

needed.

 5. Set the Scale to 1:1.

 6. Next, you’ll create the detail boundary by clicking on the existing base view. To do so, 

click the base view approximately in the center of screw on the right, as shown in 

Figure 2.26.

 7. Drag the boundary out to a size close to that shown in Figure 2.26 as well. The goal is to 

encircle the screw, the washer, and the yellow bearing.

 8. Click the screen to set the boundary size.
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Figure 2.26

Placing a detail 

view

 9. Move your cursor to the top left of the drawing and click the screen where you would 

like to place the detail view.

 10. Click the detail boundary on the base view, and note the six green grips. Click and drag 

any of the outer grips to resize the boundary, and use the center one to control the loca-

tion. Make adjustments as needed to center the boundary on the area of detail.

 11. Hover your cursor over the detail view on the page, and you will see a dotted outline of 

the view. Click and drag this border to adjust the placement of the detail view.

 12. Click and drag the label text for the detail view (it will likely read “Detail A”) to 

move it up.

Figure 2.27 shows the detail view placed on the sheet.

Figure 2.27

Th e well-placed 

detail view
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You can experiment with moving and resizing the detail boundary on the base view and 

notice that it will automatically update the detail view. In the next section, you’ll add a parts list 

to the drawing.

Placing a Parts List and Balloons
Next, you’ll create a parts list table in the upper-right corner of the drawing and then add callout 

balloons. You can continue using the drawing you have open or open the fi le mi_2a_196.idw 

located in the Chapter 02 directory of your Mastering Inventor 2014 folder.

 1. Switch from the Place Views tab to the Annotate tab and click the Parts List button (it’s 

toward the right, on the Table panel).

 2. Click either the base view or the detail on the sheet to point the parts list to the 

assembly fi le.

 3. Click the OK button, and then snap the parts list to the top-right corner of the drawing 

border.

 4. On the Annotate tab, click the Balloon button.

 5. In the base view, select the edge of the large, round base part and drag out; click once to 

place the balloon on the sheet, right-click, and choose Continue.

 6. Repeat step 5 for each part in the detail view, and then right-click again and choose 

Cancel to exit the Balloon tool.

You can click the balloons to adjust the placement of the balloon end or the arrowhead end if 

needed. Figure 2.28 shows the balloon placement.

Figure 2.28

Assembly part 

callout balloons

You can open the fi le mi_2a_197.idw in the Chapter 02 directory of your Mastering 

Inventor 2014 folder to compare your results. When you’re satisfi ed with your balloon place-

ment, you can continue to the next section to explore the steps used to export the drawing as a 

PDF fi le so that it can be emailed and viewed by others who do not have Inventor.
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Exporting a Drawing to a PDF File
In the following steps, you can use the drawing fi le you have been working on, or you can open 

the fi le mi_2a_197.idw in the Chapter 02 directory of your Mastering Inventor 2014 folder.

 1. Click the Inventor button located at the top left of the screen.

 2. From the drop-down menu, select Export.

 3. From the Export fl yout menu, select PDF.

 4. Name the fi le as you like, and then click the Options button.

 5. Select the Remove Object Line Weights option, and set the Vector Resolution to 600 DPI.

Note that if the drawing happened to have multiple sheets, this is where you’d choose to 

include all of the sheets in one PDF fi le.

 6. Click the OK button in the PDF Drawing dialog box, and then click the Save button to 

create the PDF in the Chapter 02 directory of your Mastering Inventor 2014 folder.

Review the PDF fi le, or open the fi le mi_2a_199.pdf located in the Chapter 02 directory of 

your Mastering Inventor 2014 folder to see the result of the PDF export.

Th e Bottom Line

Create a part model.  The process of creating a part model starts with an *.ipt template 

fi le. Once you’ve started a part model from a template, you create sketches to defi ne feature 

profi les, and then you make those profi les into 3D features using one of the 3D modeling fea-

ture tools.

Master It  You created a base 3D feature for your parts by extruding a sketch profi le at 

a distance of 15 mm. Then you created other sketches on the top face of the base feature. 

However, you now realize that the base feature should have been 25 mm thick. Can the 

base feature be changed after you’ve created other features on it?

Create and detail drawings of part models.  The process of creating a drawing fi le starts 

with an *.idw template fi le. Once you’ve started a drawing from a template, you create views 

of a referenced part model fi le. After the views are created, you can add dimensions and 

other annotations to the view.

Master It  You’ve created a drawing of a part model and then realize that you need to 

make a change to that model. How will the change to the part model be handled by the 

drawing fi le?

Put part models together in assembly fi les.  The process of creating an assembly model 

starts with an *.iam template fi le. Once you’ve started an assembly model from a template, 

you place part model fi les into the assembly and then use Assembly constraints to arrange 

and assemble the part models.

Master It  You’ve assembled your part models in an assembly fi le and then need to 

make a change to a part-model fi le. How will the change to the part model be handled by 

the assembly fi le?
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Create and detail drawings of assembly models.  The process of creating an assembly 

drawing starts with an *.idw template fi le, just as it did with creating part drawings. Once 

you’ve started a drawing from a template, you can create views of a referenced assembly 

model fi le. After the views are created, you can add annotations such as parts lists and call-

out balloons, as well as dimensions, text notes, and so on.

Master It  You’ve created a drawing of an assembly model and then realize that you 

need to make a change to one of the part fi les within that the assembly model. How will 

the change to the part model be handled by the drawing of the assembly? 



Chapter 3

Sketch Techniques

This chapter will cover the principles of creating parametric sketches used in part modeling 

within the Autodesk® Inventor® and Autodesk® Inventor LT™ programs. All the skills discussed 

in this chapter are based primarily on creating a single part, whether in a single-part fi le or in 

the context of an assembly fi le.

Inventor utilizes two types of sketches: a 2D sketch and a 3D sketch. A 2D sketch is created 

on any geometry plane and is the more common of the two types. A 3D sketch is not limited to 

a sketch plane and can comprise geometry in any point in space. 3D sketches are often created 

from existing geometry. Both 2D and 3D sketches are controlled by two basic parameter types: 

dimensions and sketch constraints.

In Inventor, sketches are generally “roughed out” with basic geometry and sketch constraints 

fi rst, and then fully defi ned with dimensions that drive the geometry.

The dimensions dictate the length, size, and angle of the sketch geometry. For the dimen-

sions to do this predictably, sketch objects must know how to interact with one another. This 

interaction is defi ned by the sketch constraints. This chapter will cover how to create part fea-

tures using basic 2D and 3D sketches, including the tools and settings that govern their creation. 

Also covered is how to use Autodesk® AutoCAD® data to create sketches.

In this chapter, you’ll learn to:

 ◆ Set up options and settings for the sketch environment

 ◆ Create a sketch from a part fi le template

 ◆ Use sketch constraints to control sketch geometry

 ◆ Master general sketch tools

 ◆ Create sketches from AutoCAD geometry

 ◆ Use 3D sketch tools

Exploring the Options and Settings for Sketches
Before you jump into creating a part sketch, take a look at the options and settings Inventor 

provides for sketches. Options and settings in part fi les are located in two different areas of 

Inventor, depending on whether the focus of these settings affects the application (Inventor) or 

the document (your part fi le). You’ll look at both application options and document options in 

the following sections.



68 | CHAPTER 3 SKETCH TECHNIQUES

If you have not already downloaded the Chapter 3 fi les from www.sybex.com/go/

MasteringInventor2014, please refer to the “What You Will Need” section of the Introduction 

for the download and setup instructions.

Application Options
In this section you’ll explore the options and settings found in the application options collection. 

Application options change settings for your installation of Inventor. You can adjust the applica-

tion settings as follows:

 1. From the Tools tab, click the Application Options button.

 2. Choose the Sketch tab, as shown in Figure 3.1.

Figure 3.1

Sketch tab of 

Application Options 

dialog box

The application options on the Sketch tab are as follows:

Constraint Placement Priority area  The options in this section determine the primary 

method of inferred constraint placement. In Inventor, your line work employs sketch 

http://www.sybex.com/go
http://www.sybex.com/go/MasteringInventor2014
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constraints to tell lines, arcs, and circles how to interact with one another. Many of these con-

straints are placed automatically while you sketch, based on the existing geometry. This auto-

matic placement is called constraint inference. Parallel And Perpendicular, the default setting, 

will look for relationships between geometry before looking at the coordinates of the sketch 

grid. Horizontal And Vertical does just the opposite. Figure 3.2 shows constraint placement 

with Parallel And Perpendicular on the left and Horizontal And Vertical on the right.

Figure 3.2

Constraint place-

ment priority

Overconstrained Dimensions area  This area controls the way redundant dimensions are 

handled in sketches. As an example, if you sketch a rectangle approximately 200 millimeters 

long and then place a dimension on one of the horizontal lines and set the dimension to be 

precisely 200 millimeters, the rectangle will stretch horizontally to be exactly 200 millimeters. 

But if you apply another dimension from the left vertical line to the right vertical line, Inventor 

will either warn you of the overconstrained situation or automatically place the dimension as 

a driven dimension. A driven dimension is one where the value is determined by the geometry, 

whereas a driving dimension determines the value of the geometry on which it is placed. 

Figure 3.3 shows a driving dimension at the top and a driven dimension in parentheses.

Figure 3.3

A driving dimen-

sion and a driven 

dimension

Display area  Located in the upper-right portion of the Sketch tab, this area gives you 

settings for grid lines, minor grid lines, axes, and a 2D coordinate system indicator. All of 

these options set different visual references in the form of grid lines and coordinate indica-

tors. You can experiment with these settings by deselecting the box next to each option and 

clicking the Apply button while in sketch mode.

Display Coincident Constraints On Creation check box  If selected, this option displays 

a yellow dot at all sketch points where Coincident constraints are placed when sketching. 

Hovering your mouse pointer over the dots displays the Coincident constraint symbol, as 

shown on the left in Figure 3.4. If the check box is not selected, these coincident symbols are 

not displayed initially, as shown on the right of Figure 3.4, but they can still be displayed by 

pressing the F8 key (Show All Constraints) while in a sketch.

Constraint And DOF Symbol Scale setting  This simply controls the size of the icons 

present when you’re viewing sketch constraints. You can see coincident symbols on the left of 

Figure 3.4.
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Figure 3.4

Display Coincident 

Constraints On 

Creation

Spline Fit Method area  This determines the initial type of transition for a spline between 

fi t points. Figure 3.5 shows two splines drawn with the same input points. On the left, the 

standard spline solution is in bold with the AutoCAD solution dashed; on the right, the stan-

dard solution is dashed with the AutoCAD solution in bold.

Figure 3.5

Standard spline fi t 

(left) and AutoCAD 

spline fi t (right)

Standard  Creates a spline with a smooth continuity (G3 minimum) between points. 

This spline type tends to overshoot at sharp transitions. Use this for Class A surfaces 

such as automotive design.

AutoCAD  Creates a spline using the AutoCAD fi t method (G2 minimum). This is not 

used for Class A surfaces.

Minimum Energy  Sets the fi t method to create a spline with smooth continuity (G3 

minimum) and good curvature distribution. Multiple internal points are used between 

fi t points, resulting in a nice, heavy curvature. This can also be used for Class A surfaces, 

but it takes the longest to calculate and creates the largest fi le size.

About Curve Classification

Curves are classifi ed by how smooth the continuity is where they connect to one another. Th is 

classifi cation is as follows:

 ◆ G0 controls the position at which curves touch one another.

 ◆ G1 controls the tangent angle at which curves connect.

 ◆ G2 controls the radius at which curves connect.

 ◆ G3 controls the acceleration or rate of change of curves.

Snap To Grid check box  This allows your mouse pointer to snap to a predefi ned grid spac-

ing. The grid spacing is controlled per fi le in the document settings, as will be discussed in 

the coming pages.

Edit Dimension When Created check box  This permits immediate input of a dimension 

value while applying sketch dimensions. This option can be toggled on and off by right-click-

ing while using the Dimension tool and selecting Edit Dimension from the context menu.
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Autoproject Edges During Curve Creation check box  This allows you to reference exist-

ing geometry from your sketch plane and have that geometry automatically included in your 

sketch. For example, if you sketch on the top face of a part that has a hole on the bottom face, 

you might want to fi nd the center of the hole to reference in your sketch, but since that hole 

exists on a different plane, it needs to be projected up into your current sketch before you can 

do so. Enabling this option allows you to “rub” your mouse over the hole and have it auto-

matically projected into your sketch. Figure 3.6 shows a line being sketched from the middle 

of the cylinder to the center of a hole on the bottom face. With this option on, simply rubbing 

the edge of the hole will project it to the top face so that the line can be sketched to the center 

of the projected circle. This option can be toggled on and off by selecting AutoProject in the 

context menu of most of your sketch tools, such as Line, Circle, Arc, and so on.

Figure 3.6

Autoprojecting a 

hole edge while 

sketching on the 

top face

Autoproject Edges For Sketch Creation And Edit check box  This automatically projects 

the edges of the face when you create a sketch on it. Although this ability can be convenient 

in some cases, it can also become counterproductive because it places extra line work into 

your sketches. This can add a level of complexity to your sketches that is not required. 

Figure 3.7 shows the results of selecting this option on the left and of having this option 

unselected on the right.

Figure 3.7

Results of the 

Autoproject Edges 

For Sketch Creation 

And Edit check box

Look At Sketch Plane On Sketch Creation check box  This reorients the graphics window 

so that your view is always perpendicular to the sketch plan while you are creating or edit-

ing a sketch.

Autoproject Part Origin On Sketch Create check box  This automatically projects the part’s 

origin center point whenever a new sketch is created. The origin center point is point 0 in the 

X, Y, and Z directions. Projection of this point makes it easy to constrain and anchor your 

sketch. If this option is not selected, you are required to manually project this point.

Point Alignment On check box  This allows endpoints and midpoints to be inferred by 

displaying temporary, dotted lines to assist in lining up sketch entities. Figure 3.8 shows an 

endpoint being located using the Point Alignment On option.
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Figure 3.8

Point alignment 

inferring endpoint

Enable Heads-Up Display (HUD) check box  This allows you to input numeric and angu-

lar values directly into input boxes when creating sketch entities. For instance, if you were 

to sketch a circle without HUD on, you’d rough in the approximate size and then use the 

Dimension tool to give the circle an exact diameter. With HUD, you can specify the diameter 

as you create the circle. Clicking the Settings button opens the Heads-Up Display Settings 

dialog box, where you can adjust the HUD settings.

Auto-Bend With 3D Line Creation check box  This allows corners to be automatically 

rounded when you’re creating a 3D sketch. This feature can be turned on and off via the 

context menu when using the Line tool in a 3D sketch. Figure 3.9 shows two corners created 

without the auto-bend feature enabled and four corners created with it enabled through the 

context menu. The default auto-bend radius size is set per fi le via the document settings but 

can be edited once the bends are created.

Figure 3.9

A 3D sketch line 

with and without 

Auto-Bend With 3D 

Line Creation

To set changes made to the application options, you can click the Apply button. You can save 

the changes you make to the application options for backup or distribution among other users 

by clicking the Export button at the bottom of the Application Options dialog box. In the result-

ing Save Copy As dialog box, simply specify the name of the XML fi le and click OK. You can 

import this XML fi le at any time to restore your custom settings by using the Import button at 

the bottom of the Application Options dialog box.

Document Settings
In addition to the previous settings, which are set application-wide, there are settings that con-

trol options per fi le. Document settings vary depending on the fi le type you are in. For part fi les, 

Certification
Objective
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you can modify the sketch settings by clicking the Document Settings icon on the Tools tab of 

the Ribbon menu while you are in an open part fi le. Once the Document Settings dialog box is 

open, click the Sketch tab to access the following settings:

Snap Spacing  This sets the spacing between snap points to control the snap precision when 

you’re sketching in the active part or drawing. This is relevant only when using the Snap To 

Grid option on the Sketch tab of the Application Options dialog box. The settings for the x- 

and y-axes can be different.

Grid Display  This sets the spacing of lines in the grid display for the active fi le.

Line Weight Display Options  These set the options for line weight display in the sketch 

environment. This setting does not affect line weights in printed model sketches, just the on-

screen display.

Auto-Bend Radius  This sets the default radius for 3D sketch line corners when the auto-

bend feature is used.

You may want to confi gure the document settings in a template fi le and then save those set-

tings back to that fi le so they are always set to your specifi cation. To do so, click the Inventor 

button at the top left-hand corner of the screen, and select Save As ➢ Save Copy As Template. 

This will open the template fi le location and allow you to save the fi le as a template. Note that 

Inventor uses the template path to designate templates rather than using the fi lename extension. 

Therefore, any IPT fi le saved under the template path is considered a template.

Changing the Units of a Part File

If you start a part fi le using the wrong template (inches instead of millimeters or millimeters instead 

of inches), you can change the base units of the fi le by clicking the Document Settings icon on the 

Tools tab of the Ribbon menu and selecting the Units tab. Changing the base units will automati-

cally convert parameters but will not override parameter inputs. For instance, if you enter a value 

of 3 inches for a dimension and then change the units of the fi le to millimeters, the dimension will 

show 76.2 mm; however, when you edit the dimension, you will see the original value of 3 inches.

Sketching Basics
Now that you’ve explored the sketch options and settings, you will explore the sketching tools 

by placing sketches on an existing 3D part. This will give you an introduction to creating 2D 

sketches in 3D space. The basic workfl ow for creating any 2D sketch is as follows:

 1. Establish the plane on which you want to sketch.

 2. Project geometry from an existing feature to position new geometry.

 3. Create geometry such as lines, arcs, circles, and so on.
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 4. Place sketch constraints on the geometry so the lines, arcs, and circles know how to relate 

to one another.

 5. Dimension the geometry so it is fully defi ned and there is no part of the sketch that can 

be accidentally adjusted.

Marking Menus

Th roughout this chapter, you will be instructed to right-click and select certain options as needed. 

If you have the marking menus enabled, some of the right-click options might vary, such as in 

exact placement of the option. Th erefore, you should be prepared to interpret the instructions to 

what you see on-screen if you prefer to use the marking menus. If you prefer to have options in 

this chapter’s exercises match exactly what you see on-screen, you can disable the marking menus 

and use the classic right-click context menu. Th is can be done by selecting the Tools tab and click-

ing the Customize button. On the Marking Menu tab, you will fi nd an option called Use Classic 

Context Menu.

Keep this workfl ow in mind as you go through the following steps and explore the basics of 

sketch creation. To get started, you will open an existing fi le and sketch on the faces of the part.

Creating a Sketch on an Existing Sketch

 1. From the Get Started tab, choose Open (or press Ctrl+O on the keyboard).

 2. Browse for the fi le mi_3a_001.ipt in the Chapter 03 directory of your Mastering 

Inventor 2014 folder, and click Open.

This fi le consists of a stepped block with one beige face, one face with two holes in it, and 

one face with a triangular feature on it. To start, you will create a sketch on the top, beige 

face. Before getting started, set your application options so you will not see any unex-

pected results as you follow these steps:

 3. From the Tools tab, select the Application Options button.

 4. In the Application Options dialog box, click the Sketch tab.

 5. In the Sketch tab, ensure that all the check boxes are set as shown in Figure 3.10.

Figure 3.10

Setting sketch 

options
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 6. Click Apply and then click Close to set your sketch options, and close the Application 

Options dialog box.

 7. Hover your cursor over the ViewCube until you see the Home icon (it looks like a house), 

and then click it to make sure you are looking at the model from the predefi ned home 

view.

 8. From the Model tab, select the Create 2D Sketch button.

To create a 2D sketch, you must select a plane to sketch on, as indicated by the glyph now 

present at your cursor (it looks like a pencil and paper). You should also note the input 

prompt found either at the bottom left of your screen or at your mouse pointer, depend-

ing on the Dynamic Prompting settings you have active.

 9. Click on the top, beige face to create the new sketch on it.

Turn on Dynamic Prompting

As you use the various available tools, Inventor will prompt you with a short message concerning 

the input needed from you to complete a task. By default, the prompts are displayed at the lower 

left of the screen. To help you notice them better, you can set them to display on-screen at your 

cursor. To do so, on the Tools tab, click Application Options. Select the General tab, select the 

Show Command Prompting (Dynamic Prompts) check box, then click Apply, and then click Close.

Once you’ve selected the face, you’ll notice the change in the tools displayed on the Ribbon 

menu and the activation of the Sketch tab. You should also notice that the browser has grayed 

out all of the other features and only the new sketch (it should be named Sketch6) is active, as 

shown in Figure 3.11.

Figure 3.11

Creating a new 

sketch

Projecting Geometry into Your Sketch
You’ll also notice that a sketch point (a small dot in the center of the beige face) has been auto-

matically created. This is the 0,0,0 origin point of the part. It has been automatically projected 
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into your sketch because of the Autoproject Part Origin On Sketch Create setting, as shown in 

Figure 3.10. Next, you’ll continue with the fi le you’ve been working with and project geometry 

into your sketch.

 1. Select the Project Geometry tool from the Sketch tab, and then click somewhere in the 

middle of the beige face. You will now see the rectangular edges of the beige face dis-

played as sketch lines.

 2. Right-click and choose OK or Cancel to exit the Project Geometry tool (or press the Esc 

key on the keyboard).

 3. In the browser, click the plus sign next to the Sketch6 browser node. You will see a pro-

jected loop listed under the sketch, as shown in Figure 3.12.

Figure 3.12

A projected sketch 

loop

The projected loop consists of lines that trace the outer edges of the beige face. These lines 

were created by projecting the beige face into your sketch. These projected sketch lines 

are currently locked in place to always remain associative to the face from which they 

were created. In the next step, you will break the associative link between the projected 

edges and the face.

 4. Right-click the projected loop in the browser and choose Break Link, as shown in 

Figure 3.13.

Figure 3.13

Break link for a 

projected loop
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When you break the link, the projected loop node disappears in the browser and the pro-

jected lines around the beige face change color. The color change indicates that the sketch 

lines are no longer associated with the face.

If you click and drag any of the projected lines, you’ll notice that they can be dragged 

around anywhere in the sketch plane. Because the sketch plane extends out past the 

beige face, the lines can be dragged out even beyond the extents of the face. A 2D sketch 

stretches out infi nitely in the two directions that make up the plane. Next you’ll clean up 

the projected lines and project more lines.

 5. Hold down the Ctrl key on the keyboard and select all four of the lines. Notice the color 

change indicating the selection status of the lines. If you want to remove a line from the 

current set of selected objects, you can click it again while holding the Ctrl key. To add it 

back, you would click it again, still holding the Ctrl key.

 6. With all four lines selected, right-click and choose Delete.

 7. Select the Project Geometry tool again, and this time, select just the circular edges of the 

two holes found on the lower step of the part.

Watch the color-coded selection closely to ensure that you are getting just the hole edges 

and not the entire face the holes are on. If you choose the entire face, you will get the 

four rectangular edges as well as the two hole edges, and a projected loop will be created 

under the sketch in the browser. If you do accidentally select the face, use the Undo icon 

on the Quick Access bar and then repeat step 7.

Since you selected just the circular edges, there is no projected loop created. However, 

the circles are still created so that they are associative to the holes from which they were 

created. This means that if the original holes change locations or diameter, the projected 

circles will adjust accordingly.

Another point to note is that when you project the edges of the holes into your sketch, 

they are projected up onto the sketch plane even though the holes are at a lower elevation. 

To see this clearly, you can use the ViewCube to adjust your viewing angle.

 8. Click the face of the ViewCube labeled Front, and you will be able to see that the pro-

jected hole edges are in the same plane as the beige face on which you created your 

sketch.

 9. Click the Home icon on the ViewCube to set your view back to the home view.

Breaking Links to Projected Geometry
Next, you’ll continue working with the same fi le and will break the link with the projected 

circles and the holes from which they were created. Since no projected loop was created when 
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you projected just the edges, there is no projected loop node listed under the Sketch node in the 

browser. Projected loops are created only when faces are selected. Instead, you will break the 

link by selecting the circles in the graphics area:

 1. Right-click one of the circles and choose Break Link from the context menu. The circle 

will change color, indicating it is no longer associative to the hole and, therefore, no lon-

ger constrained in place.

 2. Click the nonassociative circle and notice that you can resize it by clicking and dragging 

the circle itself, and you can move the circle by dragging the center point.

Deleting a Sketch
In the next steps, you will exit the current sketch and then delete the entire sketch. Deleting 

sketches from the browser is a common task, and understanding how to remove unneeded 

sketches is an important concept in learning how to manage sketches in the Model browser. 

Follow these steps, using the same fi le you’ve been using:

 1. Click the Finish Sketch button on the Sketch tab (or right-click and choose Finish Sketch). 

Notice that the Sketch node is no longer highlighted in the browser and the Sketch tab 

has disappeared, leaving the 3D Model tab active.

 2. Right-click the Sketch6 node in the browser and choose Delete. You will notice that 

the Sketch node is removed from the browser and, therefore, the projected circles are 

removed from the graphics area.

Creating Another New Sketch
Next, you’ll create a new sketch on the face with the triangular cut in it. Rather than using the 

Create 2D Sketch button as you did before, you will create the sketch through the context menu.

 1. Right-click the face with the triangular cut in it, and then choose New Sketch, as shown 

in Figure 3.14.

Figure 3.14

Creating a sketch 

from the context 

menu

You will see the new Sketch node created in the browser, the Sketch tab appear in the 

Ribbon menu, and the projected origin point appear in the sketch (the dot in the center of 

the triangle).

 2. Click the face labeled Front on the ViewCube to set your view perpendicular to the sketch 

plane.

 3. Select the Circle tool from the Draw panel of the Sketch tab.
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 4. Click to the left of the model to set the center of the circle, and then drag out to draw the 

circle as shown in Figure 3.15. Then type 100 in the Heads-Up Display input box and 

press the Enter key on the keyboard to set the diameter. (If you do not see the Heads-Up 

Display input, check your settings against those shown in Figure 3.10).

Figure 3.15

Placing a circle in 

the sketch

 5. Select the Project Geometry tool from the Sketch tab, and then select the face with the 

triangular cutout.

Creating Dimensions
You can use sketch dimensions to specify the size and position of your sketch entities. Keep in 

mind that Inventor’s sketch dimensions are used to “drive” the sketched objects into shape and 

into position. Using dimensions in this way allows you specify the intent of your design and 

manage it with dimensional parameters. Continue following these steps using the same fi le 

you’ve been working with:

 1. Select the Dimension tool from the Sketch tab and then click the projected bottom point 

of the triangle and the center point of the circle. Drag your cursor down until you see the 

dimension.

 2. Click the screen to set the dimension, and then enter 150 into the input box; click the 

green check mark to apply the input.

You will see that the circle is “driven” into place and repositioned to be 150 mm from the 

point of the triangle. This is what is meant by a driving dimension. The circle’s position is 

driven by the dimension.

 3. With the Dimension tool still active, select the center point of the circle and then the hori-

zontal line of the triangle, and drag your cursor to the left until you see the dimension.

 4. Click the screen to set the dimension, and then enter 150 into the input box; click the 

green check mark to apply the input.

 5. Right-click and choose Done to exit the Dimension tool.

At this point your sketch should be fully constrained, as noted in the lower right of the 

screen, and it should resemble Figure 3.16.

Figure 3.16

Th e circle dimen-

sioned in the sketch

Certification
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 6. Use the Finish Sketch button to exit the sketch.

 7. Click the Home icon on the ViewCube to set your view back to the home view.

This concludes the steps in this introductory exercise. You should now be familiar with the 

basics of creating sketches on existing part faces and projecting existing geometry, as well as 

deleting geometry and sketches. You can close the fi le without saving changes or experiment 

with this part and create more sketches just for fun.

As you create 2D sketches in Inventor, you will often do so by selecting a face on the existing 

model, as you did in this exercise. If no plane exists, you can create what is called a work plane 

and sketch on it (work planes will be covered in the next chapter). In the next section, you will 

create a new part from a template fi le and create a base sketch.

Creating a Sketch in a New Part
When you create a new part fi le from a template, Inventor can create the fi rst sketch for you 

on one of the origin planes. You can also confi gure Inventor not to create the initial sketch 

and allow you to create it yourself. This option is set by going to the Tools tab and clicking the 

Applications Options button and then clicking the Part tab. In the following exercises, you will 

create a new part fi le and further explore the tools used to create sketch entities. To create a part 

model in Inventor, you will typically start with a 2D sketch and build a base feature from 

that sketch.

Creating a New Part File from a Template
You create new part fi les from an IPT template. Once you open the IPT template, you will auto-

matically be in the sketch environment. In this exercise, you will use the Standard(mm).ipt fi le.

To explore sketch fundamentals in the next exercise, you should disable the HUD tools found 

on the Sketch tab of the Application Options dialog box. The HUD tools allow you to place 

dimensions as you create sketch geometry rather than having to go back and place dimensions 

later. Although the HUD tools are very helpful, and you will most likely want to turn them back 

on later, for the purpose of understanding sketch constraints and degrees of freedom, it is best 

to leave the dimensioning as a fi nal step.

To disable the HUD tools, click Application Options on the Tools tab. Select the Sketch tab, 

and uncheck the box labeled Enable Heads-Up Display (HUD). You can turn this helpful feature 

back on later, but understand that the following steps assume it is disabled and your results may 

not match the exercise otherwise.

To create a new fi le from a template, follow these steps:

 1. From the Tools tab click the Application Options button.

 2. Select the Part tab and set the Sketch On New Part Creation option to Sketch On X-Y 

Plane; then click the OK button to close the Application Options dialog box.

 3. From the Get Started tab click the New button. This will bring up the list of templates in 

the New File dialog box.

 4. In the New File dialog box, select Metric from the list on the left, and then select the 

Standard(mm).ipt icon (see Figure 3.17).
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Figure 3.17

Templates on the 

Metric tab

 5. Click Create to create a new part fi le based on this template.

Creating Lines Using the Line Tool
Your screen should now show the Sketch tab set active on the ribbon, and a sketch called 

Sketch1 has been created and set current in the Model browser. In the following steps, you will 

create simple geometry using the Line tool. These steps will focus on creation of 2D sketch 

constraints as well:

 1. Pause your mouse pointer over the Line tool in the Sketch tab’s Draw panel. (See 

Figure 3.18 for the location of the Line tool.)

 2. Note the tool tip that appears, providing the tool name, keyboard shortcut (in this case L), 

and a brief description of the tool. If you hover the pointer over the tool long enough, a 

second stage of the tool tip appears with a more detailed description.

 3. Click the Line button to start the Line tool.

 4. Hover your mouse pointer over the dot in the center of the drawing area. This is the 0,0,0 

origin point that has been automatically projected into Sketch1.
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Figure 3.18

Locating the Line 

tool on the Sketch 

tab

Note that when your mouse pointer moves over the dot, the dot changes to green and 

shows a small glyph symbol. This green dot is a snap symbol indicating that a point, end-

point, or midpoint has been located. The glyph symbol indicates that a sketch constraint 

is being placed. In this case, it is a Coincident constraint, which ensures that the endpoint 

of the line will stay coincident to the projected origin point. See Figure 3.19 for reference.

Figure 3.19

Endpoint snap 

symbol and coinci-

dent glyph

 5. Start your line on this point by clicking the dot and releasing the mouse button.

 6. Move your mouse pointer directly to the right, and you will see another glyph indicating 

that a Horizontal sketch constraint is being placed. The Horizontal constraint ensures 

that the line will stay positioned horizontally. Note that if you move your mouse pointer 

so that the line is being drawn at an angle, the glyph disappears.

Turning On the Projected Origin Point

If you do not see a sketch center point in your fi le, close the fi le and follow these steps to turn this 

option on:

 1. From the Get Started tab, select the Application Options tab.

 2. Choose the Sketch tab.

 3. Select the Autoproject Part Origin On Sketch Create check box.

 4. Click OK.

 5. Start a new fi le using the Standard(mm).ipt template.
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 7. Notice the status bar at the bottom of the screen indicating the length and angle of the 

line as you move the mouse pointer. Click the graphics window while the horizontal 

glyph is displayed to create a line roughly 45 mm long (the length is shown at the bottom 

right of the screen).

Don’t worry about getting an exact length. You will set the precise length later; for now, 

you are just “roughing in” a general shape. Note that the line continues when the fi rst line 

segment is placed, and you can add more segments as required.

 8. Move your mouse pointer straight up to add another line segment, and note that another 

glyph appears at the mouse pointer. This is a perpendicular glyph indicating that a 

sketch constraint is being placed that will hold the fi rst and second line segments perpen-

dicular (see Figure 3.20 for reference).

Figure 3.20

Creating a 

vertical line with 

an automatic 

Perpendicular 

constraint

 9. Click the graphics window to create the second segment at roughly 45 mm long and per-

pendicular to the fi rst segment.

 10. Right-click and choose Done to exit the Line tool. Note that the Esc key will also exit the 

active tool, as indicated in the context menu.

You should now have a single horizontal line and a single vertical line making a backward L 

shape. If you made a mistake, simply use the Undo icon at the top of the screen (or press Ctrl+Z) 

to undo and try again. Leave this fi le open for use in the next set of steps.

Understanding Sketch Constraints
The glyphs you were observing while creating the line segments were indicators that Inventor 

was placing sketch constraints automatically as you were sketching the lines. By default, the 

sketch constraints have their visibility turned off. To see the sketch constraints that are present 

and how they work, continue with the following steps:

 1. Right-click anywhere in the graphics window other than on the lines, and choose Show 

All Constraints (or press F8 on the keyboard). You will now see the Sketch Constraint 

icons for the constraints that were inferred as you created the line segments.

 2. Hover your mouse pointer over the Perpendicular constraint at the corner of the two line 

segments to see both lines highlighted, which indicates that these are the objects involved 

in this particular constraint defi nition.

 3. Hover your mouse pointer over the yellow dot at the corner of the two line segments 

and you will see two Coincident constraints appear, as shown in Figure 3.21. Hovering 

your mouse pointer over each will highlight the line to which it belongs. Coincident 

constraints are initially “rolled up” in this way because they are generally numerous and 

tend to clutter the sketch when all constraints are shown.

Certification
Objective
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Figure 3.21

Showing 

constraints

When in Doubt, Right-Click

Inventor is very right-click-driven, meaning that often you can fi nd the option you are looking for 

by right-clicking the object you are dealing with.

In Inventor, the right-click context menus are specifi c to the objects you have selected. If no objects 

are selected, right-clicking gives you the default context menu.

Unlike in some other applications, the Esc key does not clear selected on-screen entities in the 

graphics area. Instead, you can click any blank area in the graphics area to make sure you have 

nothing selected before right-clicking. Th is way you can be certain the context menu you get is not 

specifi c to an accidentally selected object.

 4. Click the X on any of the constraints to hide just that particular constraint.

 5. Next, right-click anywhere in the graphics area other than on the lines, and choose 

Hide All Constraints (or press F9 on the keyboard). You can toggle the visibility of all 

sketch constraints on and off as needed to determine how sketch entities are constrained 

together.

 6. Select the corner point of the two line segments, and hold down and drag around in a 

circle. You will notice that the horizontal line will stretch as required but will always 

remain horizontal; the vertical line will always remain perpendicular.

 7. Select the uppermost endpoint of the vertical line, and drag around in a circular motion. 

Note that the two lines will adjust lengths as permitted but will always honor the sketch 

constraints they have placed on them.

 8. Let up on the end of the line, and press F8 to show the constraints again.

 9. Right-click the Horizontal constraint.

 10. Choose Delete to remove this constraint.

 11. Press F9 to hide the constraints again.

 12. Click the corner of the lines, and hold down and drag around in a circular motion. Note 

that the lines will stretch and adjust orientation but will maintain their perpendicular 

and coincident relationships.

At this point, the constraints present in your sketch were all inferred (placed automatically). 

Letting Inventor infer sketch constraints is the quickest and often most desirable way to place 
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them; however, sometimes you’ll need to constrain sketch elements manually. To do so, you can 

use the constraint tools found in the Constrain panel of the ribbon.

To place the Horizontal constraint back on the line from which you removed it, follow these 

steps:

 1. On the Constrain panel of the ribbon, click the Horizontal Constraints icon (Figure 3.22).

Figure 3.22

Placing a 

Horizontal con-

straint manually

 2. Click the fi rst line segment you sketched to set it back to horizontal. Be careful to select 

the line itself and not the midpoint of the line (the midpoint shows as a green dot when 

selected).

Use the Line tool to add three more line segments to the sketch to complete the shape, as 

shown in Figure 3.23. Pay attention to the cursor glyphs as you sketch, and do not be concerned 

with the precise lengths of the lines or the angle of the diagonal line. You can keep this fi le open 

for use in the next set of steps or close it and use the fi le provided.

Figure 3.23

Completed sketch 

profi le with all con-

straints shown



86 | CHAPTER 3 SKETCH TECHNIQUES

Constraint Inference and Persistence

You can suppress the automatic placement of sketch constraints (constraint inference) by holding 

down Ctrl on the keyboard as you sketch. You can also disable constraint inference and persistence 

using the Constraint Inference and Constraint Persistence buttons in the Sketch tab’s Constrain 

panel.

If constraint persistence is disabled, you will still see the Constraint Glyph icon when sketching, 

and you will be able to place sketch entities in accordance with the displayed glyph; however, no 

actual constraint will be placed on the sketched object. For instance, sketching a line that is ori-

ented perpendicular to an existing line without actually having a Perpendicular constraint placed 

automatically is possible by toggling off  the constraint persistence. Coincident constraints at the 

endpoints of the lines will still be placed.

Constraint persistence is automatically disabled if constraint inference is turned off , but inference 

can be on with persistence turned off . You can also control which constraints are inferred by right-

clicking in a sketch and choosing Constraint Options.

Using Degrees of Freedom to View Underconstrained Sketch Elements
Typically, your goal is to create fully constrained sketches so that no aspect of the sketch can be 

changed without deliberate action. To examine your sketch for underconstrained elements, you 

can use the Degrees of Freedom (DOF) tool. To explore DOF, you can use the fi le you have been 

working with in the previous steps or open the fi le mi_3a_002.ipt from the Chapter 03 direc-

tory of your Mastering Inventor 2014 folder. Make sure Sketch1 is active for edits by right-

clicking it and choosing Edit Sketch. Then follow these steps:

 1. To view the DOF arrows for your sketch entities, right-click anywhere in the graphics 

area that is not on a sketch object, and choose Show All Degrees Of Freedom. Your sketch 

should resemble Figure 3.24.

Figure 3.24

Showing the 

degrees of freedom 

in a sketch

 2. Notice the arrow indicators showing the DOF for each sketched line.

 3. Drag a line endpoint, and you will see that the sketch lines will drag only in a direc-

tion or orientation that follows the DOF arrows. If your sketch becomes distorted in an 
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undesirable way, use the Undo icon at the top of the screen or press Ctrl+Z to set it back as 

it was.

Dragging to Refine Your Sketch

Experienced Inventor users rely on the click-and-drag technique to fi ne-tune the general shape of 

a sketch rather than trying to get things precisely right from the beginning. Become familiar with 

this technique so you can use it to your advantage.

 4. To toggle the DOF visibility back off, right-click again and choose Hide All Degrees Of 

Freedom.

 5. Note that you can right-click an individual sketch object or a selection set of sketch 

objects and choose Display Degrees Of Freedom to show the DOF for just those selected 

objects.

 6. Right-click and choose Show All Degrees Of Freedom again to have these displayed for 

reference in the next steps.

Using Dimensions to Fully Constrain a Sketch
To work toward your goal of a fully constrained sketch, you will now add dimensions to lock 

down lengths, angles, and so on. Adding dimensions will remove degrees of freedom from 

your sketch objects and help you defi ne the intent of your design. You will use the General 

Dimension tool to place dimensions on your sketch. Note that although the tool is called 

General Dimension, the button simply reads Dimension. You can continue with the fi le you 

are working or open the fi le mi_3a_002.ipt from the Chapter 03 directory of the Mastering 

Inventor 2014 folder. If you’re opening the prepared fi le, ensure that Sketch1 is active for edits 

by right-clicking it and choosing Edit Sketch, and then right-click and choose Show All Degrees 

Of Freedom. Then follow these steps:

 1. On the Sketch tab of the ribbon, click the Dimension icon in the Constrain panel.

 2. In the graphics area, click the bottom horizontal line and drag down to display the 

dimension.

 3. Click below the line to place the dimension; you should see an Edit Dimension box, as 

shown in Figure 3.25. If you do not see the Edit Dimension box, you can right-click any-

where in the blank space of the graphics area and click Edit Dimension to ensure that this 

box shows up after each dimension is placed. Then simply click the dimension to open 

this input box.

 4. In the Edit Dimension dialog box, type Length = 45. Because you are working in a milli-

meter-based part fi le, the units are assumed to be 45 mm, and Inventor will add the mm 

automatically.

Notice that the Edit Dimension box caption reads something such as d0. This indicates 

that this dimension parameter is named d0. Initially, Inventor names the fi rst dimen-

sion used in the fi le d0, the next is named d1, and so on. By entering Length = 45, you 
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are renaming the dimension from d0 to Length and changing this length value from the 

sketched value to a precise value of 45 mm. You are not required to rename your dimen-

sions, but it is good practice to name any that you intend to reference later.

Figure 3.25

Placing a dimension 

on the sketch

 5. Click the green check mark in the Edit Dimension box, or press the Enter key to set the 

dimension value. Take note that the dimension “drives” the sketch line to be 45 mm long. 

Also notice that some of the DOF arrows have been removed.

 6. Click the 45 mm dimension to edit it. Notice that the Edit Dimension box caption now 

reads Length and the value now reads 45 mm.

 7. Change the value to 50 mm, and click the green check mark.

 8. Click the bottom horizontal line again and drag up, but do not click to place the dimen-

sion. You will see the same horizontal dimension displayed.

 9. Click the top horizontal line and drag down; you will see the dimension change from the 

horizontal dimension evaluating the length of the bottom line to a vertical dimension 

evaluating the distance between the top and bottom lines.

 10. Click in the graphics area to place the dimension.

 11. Enter Width =.

 12. Click the 50 mm dimension you placed in the previous steps. Notice that clicking one 

dimension while editing another will create a reference between the two.

 13. Complete the formula to read Width = Length/2, as shown in Figure 3.26.

Figure 3.26

Referencing one 

parameter to 

another
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 14. Click the green check mark or press the Enter key to set the dimension value. Observe 

that the Width dimension is evaluated at half the Length dimension and that it displays 

an fx: before the value to denote that there is a function used to evaluate this dimension. 

Also notice that more DOF arrows have been removed as you have further defi ned the 

sketch.

 15. If your sketch has become a bit skewed, exit the Dimension tool by right-clicking and 

choosing Done (or by pressing the Esc key).

 16. Click the top endpoint of the vertical line to the right, and drag it so that the general 

shape of the profi le is restored.

 17. On the Sketch tab of the ribbon, click the Dimension icon in the Constrain panel, or just 

press D on the keyboard to start the Dimension tool again.

 18. Click the vertical line to the right, and then click the diagonal line. Take care to click the 

lines and not the endpoints of the lines because clicking the endpoints will result in a dif-

ferent dimension type.

 19. Click in the graphics area to place the dimension. You will be presented with an edit box 

for an angle dimension. Enter Angle1 = 108, and click the green check mark.

 20. Last, on the Sketch tab of the ribbon, click the Equal button in the Constrain panel to 

place an Equal constraint. Select the top horizontal line and the vertical line on the right 

to set those two lines equal, as shown in Figure 3.27.

Figure 3.27

Applying an equal 

constraint

Your sketch is now fully constrained and should resemble Figure 3.28.

Figure 3.28

A fully constrained 

sketch
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A fully constrained sketch is evident by taking note of the following:

 ◆ All the DOF arrows are now gone.

 ◆ You will see Fully Constrained in the status bar at the bottom right of the screen.

 ◆ Your sketch lines will have turned a different color than they were originally, before the 

sketch became constrained.

 ◆ A “thumb tack” appears (upper left) on the Browser Sketch icon once the sketch is fully 

constrained.

Understanding the Save Options
At this point, you may have seen a save reminder balloon in the top-right corner of the screen. 

It is always good practice to save often when working in any application. To save a part fi le, you 

must fi rst exit the sketch and then save:

 1. On the ribbon’s Sketch tab, click Finish Sketch in the Exit panel. Or right-click in the 

graphics area and choose Finish 2D Sketch from the menu.

 2. Click the Inventor button, and then select Save.

 3. Select your Chapter 03 folder, and name the fi le mi_001.

You should be aware of all the save options you have and how they differ. They can all be 

accessed by clicking the Inventor button and choosing Save or Save As from the Application 

menu. Here’s a list:

Save  Choosing this option saves the active document contents to the fi le specifi ed in the 

window title, and the fi le remains open.

Save All  Choosing this option saves all open document contents to the fi le specifi ed in the 

window title, and the fi les remain open.

Save As  Choosing this option saves the active document contents to the fi le specifi ed in the 

Save As dialog box. The original document is closed, and the newly saved fi le is opened. The 

contents of the original fi le are unchanged.

Save Copy As  Choosing this option saves a copy of the active fi le as specifi ed in the Save 

Copy As dialog box, and the original fi le remains open.

Save Copy As Template  Choosing this option saves a copy of the active fi le as a template to 

the template folder, and the original fi le remains open.

Adjusting the Save Options

Inventor does not have an automatic save function, but instead has a save reminder utility that 

allows you to save by just clicking within the bubble to launch a standard save operation. To adjust 

the save timer settings, select the Application Options button and then select the Save tab.
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Making a Sketch Active for Edits
To save a fi le, you are required to exit the sketch. To continue making edits to the sketch once it’s 

saved, you need to set the sketch active for edits. Here’s how to activate the sketch:

 1. Locate Sketch1 in the Model browser to the left of your screen, and either right-click and 

choose Edit Sketch or double-click the Browser Sketch icon.

 2. Notice that the Sketch node listed in the browser consists of the Sketch icon and the 

sketch name. Clicking the sketch name once and then again (don’t double-click) allows 

you to rename the sketch. Therefore, you may want to develop a habit of double-clicking 

the Sketch icon rather than the sketch name to make a sketch active for edits.

Look at the browser and notice that the rest of the browser nodes are grayed out and Sketch1 

is highlighted, letting you know that the sketch is active for editing. You’ll also notice that the 

sketch tools are available.

Using Construction Geometry
Now that the sketch is active, you will add more geometry and dimensions to further explore 

the sketch tools. You’ll start by sketching a line and then converting that line to a construction 

line. Construction geometry is often used to help locate and constrain normal sketch geometry.

The primary difference between construction geometry and standard geometry is that 

construction geometry is fi ltered out of profi le calculations. In other words, if you have a part 

profi le consisting of a rectangle and you run a construction line down the middle of it, resulting 

in two halves of the original profi le, Inventor will ignore the construction line and see only one 

profi le when you create a solid part from the sketch. To create a construction line in your sketch, 

follow these steps:

 1. Click the Line tool in the Sketch tab’s Draw panel. (Recall that you can access the Line 

tool by pressing the L key on the keyboard as well.)

 2. Start the line at the bottom-left corner of the profi le, keeping an eye on your mouse 

pointer to ensure that you see the green dot (indicating the endpoint) and the constraint 

glyph (indicating that a Coincident constraint is being inferred).

 3. Set the second point of the line on the midpoint of the diagonal line. Again, you should 

see a green dot and a coincident glyph, as shown in Figure 3.29.

Figure 3.29

Placing a construc-

tion line showing 

steps 2 and 3

2

3
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 4. Right-click and choose Cancel to exit the Line tool. 

 5. Select the new diagonal line you just created.

 6. On the Sketch tab (to the far right), click the Construction icon in the Format panel to set 

the diagonal line as a construction line, as shown in Figure 3.30.

Figure 3.30

Converting to a 

construction line

Notice that the line has changed from a solid line to a dashed line, indicating that it is now 

a construction line. If you were to turn this sketch into a 3D solid at this point, Inventor would 

not recognize the construction line as a boundary and would therefore see only one profi le from 

which to create the solid. However, if you had not made the diagonal line a construction line, 

Inventor would see two profi les, one on each side of this diagonal line.

Using the Polygon Tool and Creating an Aligned Dimension
Next, you will need to add a polygon to the midpoint of the construction line and manually 

place a constraint to position it in place. You will then need to place a dimension to size it:

 1. In the Sketch tab’s Draw panel, click the Polygon tool.

 2. Select the midpoint of the diagonal construction line, keeping an eye on your mouse 

pointer for the green midpoint dot and the coincident glyph.

 3. Leave the polygon settings at the defaults, and drag out the size and orientation to 

roughly match Figure 3.31.

Figure 3.31

Creating a polygon

 4. In the Sketch tab’s Constrain panel, click the Parallel Constraint icon.

 5. Choose any of the fl ats on the polygon and the diagonal profi le line, as shown in 

Figure 3.32, to make the two lines parallel.

 6. In the Sketch tab’s Constrain panel, click the Dimension tool.
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Figure 3.32

Setting the two 

edges to be parallel

 7. On the polygon, click two opposing points, as shown in Figure 3.33, to create a dimension 

between the two points.

Figure 3.33

Creating a point-

to-point aligned 

dimension

 8. Pull your mouse pointer to the side to preview the dimension. Notice that the orientation 

wants to be horizontal or vertical depending on the location of your mouse pointer.

 9. Right-click and choose Aligned to force the aligned solution for this particular 

dimension.

 10. Click the graphics window to place the dimension.

 11. Enter Hex_Size = 0.375 in.

 12. Click the green check mark or press the Enter key to set the dimension value. Notice that 

although you entered an Imperial unit of inches, Inventor converted the value automati-

cally to the fi le default of millimeters. This is a powerful function that allows you to use 

dimension inputs to do conversion calculations on the fl y.
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Using an Underscore in Parameter Names

When specifying parameter names, keep in mind that spaces are not allowed but you can use 

underscores.

Creating Mixed-Unit Formulas

You can mix any acceptable units in the same parameter formula and allow Inventor to do the 

conversion. For instance, entering the following into a dimension is perfectly acceptable:

3.25 ft – 1 m + 3 cm + 0.125 in

Th is would return a value of 23.775 mm in a millimeter part.

Using Off set and Creating a Th ree-Point Rectangle
You will now use the Offset and Three Point Rectangle tools to create more sketch geometry:

 1. In the Sketch tab’s Modify panel, click the Offset tool.

 2. Before selecting any geometry, right-click anywhere that is not on the sketch geometry.

 3. Ensure that the Loop Select and Constrain Offset options are both selected.

 ◆ Selecting Loop Select means that all joined geometry will be selected as a loop. With 

this option toggled off, individual line or curve segments are selected.

 ◆ Selecting Constrain Offset means the new geometry is constrained to be equidistant 

to the original. If you turn this option off, the new geometry is created unconstrained 

to the original.

 4. Click the polygon and drag to the outside.

 5. Click in the graphics window to set the offset distance.

 6. Right-click and choose Cancel to exit the Offset tool.

 7. In the Sketch tab’s Constrain panel, click the Dimension tool (or press D on the keyboard).

 8. To dimension the offset, select an edge of the original polygon, and then select the corre-

sponding edge on the new offset polygon.

 9. Drag the dimension out from the center of the polygon and place it anywhere.

 10. Enter Hex_Offset = 1/16 in, and click the green check mark. The result should appear 

similar to Figure 3.34.
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Figure 3.34

Th e off set polygon

 11. In the Sketch tab’s Draw panel, click the Rectangle fl yout, and choose Rectangle Three 

Point (Figure 3.35).

Figure 3.35

Accessing the 

Rectangle Th ree 

Point tool

 12. Create the rectangle using the three points shown in Figure 3.36. Click the top-left point 

fi rst, then the top-right point, and then the bottom-middle point. Make certain you are 

seeing the green snap dots and Coincident constraint glyphs at each point.

Figure 3.36

Placing a three-

point rectangle

 13. Right-click, and choose Cancel. If your rectangle is not fully constrained, click the corner 

and drag it away from the line and then back to the line, and set it on the line when you 

see the constraint glyph.

This completes the creation of most of your sketch objects in this exercise. Save your fi le and 

use it in the next set of steps. Your sketch should resemble Figure 3.37.



96 | CHAPTER 3 SKETCH TECHNIQUES

Figure 3.37

Your completed 

sketch

To Trim or Not to Trim

You can fi nd the Trim tool in the Sketch tab’s Modify panel. Although you might be tempted to use 

the Trim tool to tidy up the sketch, keep in mind that in Inventor you are creating solid models 

from these sketches, and therefore trimming “extra” lines from a sketch is not required.

More important, though, trimming these extra lines in a sketch often does more harm than good. 

Th is is because all the lines in the sketch have constraint relationships between them. When you 

use the Trim tool, you are inadvertently removing constraints that were holding your sketch objects 

together. As a rule, use the Trim tool only when necessary.

You might fi nd the Split tool is actually what you want. Split will divide a line into separate segments 

without removing them. And it will also maintain sketch constraints. You can fi nd the Split tool 

in the Sketch tab’s Modify panel as well. Hover your mouse pointer over it for a moment, and you 

will get a dynamic tool tip showing you how it works.

Creating Driven Dimensions
Now you’ll take a look at creating driven dimensions and editing the parameters you just cre-

ated through the Parameters dialog box. Because dimensions defi ne the parameters of your 

design, you can use them to control the design intent. At other times you may want to place a 

dimension that does not drive the design but instead is driven by other parameters. In those 

cases, such dimensions are called driven dimensions.

Unlike Inventor’s standard parametric dimensions, driven dimensions do not change the 

geometry but instead change when the geometry changes. Driven dimensions are created either 

by placing a dimension on already defi ned geometry or by explicitly making them driven.

You can use your current fi le or open the fi le mi_3a_003.ipt from the Chapter 03 direc-

tory of your Mastering Inventor 2014 folder. If you’re opening the prepared fi le, ensure that 

Sketch1 is active for edits by right-clicking it and choosing Edit Sketch. Follow these steps to 

explore driven dimensions:

 1. Double-click the 50 mm Length dimension.

 2. Replace the value of 50 with 60, and press the Enter key.
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 3. Take note that the vertical dimension retains the intent of your design and remains at 

half the Length value.

 4. In the Sketch tab’s Constrain panel, click the Dimension tool (or press D on the keyboard).

 5. Select the vertical line on the right of the sketch, and click the graphics window to place 

the dimension.

 6. Depending on the options you have selected in the Sketch tab of the Application Options 

dialog box, you might be presented with a dialog box warning you that this dimension 

will overconstrain the sketch. If so, click Accept. In either case you’ll place the dimension 

as a driven dimension by clicking the screen.

Notice that the dimension is created in parentheses, denoting it is driven by other param-

eters and, therefore, is considered a reference parameter. Driven dimensions are useful in 

capturing dimensions for use in the calculations of other features.

 7. Switch from the Sketch tab to the Manage tab on the ribbon.

 8. Click the Parameters tool. This will open the Parameters dialog box listing all the dimen-

sions you’ve created in this part as parameters, as shown in Figure 3.38.

Figure 3.38

Parameters dialog 

box

 9. Enter Vertical_Leg for the reference parameter name. Be sure to use an underscore rather 

than a space.

 10. Still in the Parameters dialog box, change the Length value from 60 mm to 65 mm.

If you have the Immediate Update check box selected, the dimension is automatically 

updated in the sketch. If not, you will need to update the dimension manually by click-

ing the Update button on the Quick Access bar at the top left of the screen, as shown in 

Figure 3.39.

Figure 3.39

Update button on 

the Quick Access 

bar

 11. Ensure that the Immediate Update check box is selected, and then click Done to return to 

the sketch.



98 | CHAPTER 3 SKETCH TECHNIQUES

 12. Right-click in the graphics area and choose Dimension Display ➢ Expression from 

the context menu. Observe the dimension names and expression values, as shown in 

Figure 3.40.

Figure 3.40

Displaying dimen-

sion expressions

 13. Right-click in the graphics area and choose Dimension Display ➢ Value from the context 

menu to set the dimension display back to display the calculated value.

You can leave this fi le open and use it in the next set of steps.

Dimension Arrangement

Although the arrangement of sketch dimensions is not all that important because these dimen-

sions will ultimately be consumed by a solid model, it is still helpful to be able to read them in the 

sketch. You can rearrange jumbled sketch dimensions by clicking the text/numbers and dragging 

them as you like. Note too that this must be done once you’ve exited the Dimension tool because 

clicking a dimension with the Dimension tool active edits that dimension. You’ll notice that because 

of the intelligence you’ve built into the sketch, when you modify and update the Length dimension 

(parameter) value, the dependent values change as well.

Next, you’ll change a driving dimension to a driven dimension and a driven to a driving. By 

doing this, you can modify the intent of your design and change which parameter is a key input. 

You can use your current fi le or open the fi le mi_3a_004.ipt from the Chapter 03 directory of 

your Mastering Inventor 2014 folder. If you’re opening the prepared fi le, ensure that Sketch1 

is active for edits by right-clicking it and choosing Edit Sketch. Then follow these steps:

 1. Click the 65 mm Length dimension.

 2. In the Sketch tab’s Format panel, click the Driven Dimension tool. Notice that the Length 

dimension is now set in parentheses, indicating that it is now driven rather than driving.

 3. Double-click any blank area in the graphics window to deselect the previous dimension.

 4. Select the vertical dimension that is in parentheses.
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 5. Click the Driven Dimension tool again to toggle this dimension from a driven to a driv-

ing dimension.

 6. Double-click the vertical dimension to edit its value.

 7. Enter 40 mm, and click the green check mark. Notice that the Vertical_Leg parameter 

now drives the Length parameter, which still drives the Width dimension.

You are beginning to see the power of parametric design. Next, you’ll add a user param-

eter and use it to drive the design. A user parameter is a design input that is not based on 

the geometry in the sketch. This allows you to enter user variables to drive your design.

 8. From the Manage tab on the ribbon, select the Parameters tool. This will open the 

Parameters dialog box.

 9. Click the Add Numeric button found at the bottom of the dialog box to create a new user 

parameter.

 10. Enter Wrench_Size for the user parameter name.

 11. Click the mm in the Unit/Type column, and select the inch input from the Length 

category.

 12. Enter 0.4 for the Equation column input.

 13. Edit the equation input for the Hex_Size parameter and replace 0.375 in with 

Wrench_Size.

You have now set the Hex_Size parameter to be driven by your user parameter named 

Wrench_Size. Your inputs should look like Figure 3.41.

Figure 3.41

Creating a user 

parameter

 14. Click the Done button to close the Parameter dialog box, and then use the Update button 

to update the sketch if needed.

Now that you’ve been introduced to the basics of creating a parametric sketch, you’ll take 

a more in-depth look at these tools in the next sections. You can close this fi le without saving 

changes.
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Taking a Closer Look at Sketch Constraints
In the following sections, you’ll take a closer look at each of the available sketch constraints. As 

you proceed, it may occur to you that you could use other sketch constraints in place of the one 

suggested in the exercise steps. Be aware that as you create sketch constraints, there are often 

multiple solutions to get the same result.

In the following exercises, you will be opening a series of part fi les, setting the sketch as 

active for edits, and applying different sketch constraints. Each of these fi les demonstrates the 

function of a different type of sketch constraint. All of these fi les contain a sketch called <—

Double Click to Edit (Sketch 1). You will edit the sketch in each fi le and apply the appropriate 

sketch from the Constrain panel of the Sketch tab, shown in Figure 3.42. 

Figure 3.42

Constraint tools

The Tangent Constraint
The Tangent constraint places one object or edge in a tangency to another object or edge. Objects 

can be tangent to each other even if they do not share a physical point. Follow these steps to 

explore the Tangent constraint:

 1. From the Get Started tab, click the Open button (or press Ctrl+O on the keyboard).

 2. Browse for the fi le mi_3h_001.ipt in the Chapter 03 directory of your Mastering 

Inventor 2014 folder, and click Open.

 3. In the Model browser, double-click Sketch1 to edit it. Or right-click it and choose Edit 

Sketch.

 4. Press the F8 key to show all the constraints. Note that there is no Tangent constraint 

between the large circle and the lines.

 5. In the Sketch tab’s Constrain panel, click the Tangent button. Click the line and circle, as 

shown in Figure 3.43.

Figure 3.43

Placing a Tangent 

constraint

 6. Repeat to set a Tangent constraint on the top line and the same circle.

 7. Right-click, and choose Cancel. 

 8. Press the F8 key to show all the constraints, and note the new Tangent constraints.

Certification
Objective

Certification
Objective



TAKING A CLOSER LOOK AT SKETCH CONSTRAINTS | 101

 9. You can exit the fi le without saving once you have fi nished.

The Perpendicular Constraint
The Perpendicular constraint constrains objects or edges to be always perpendicular. Follow 

these steps to explore the Perpendicular constraint:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_002.ipt in the Chapter 03 directory of your Mastering 

Inventor 2014 folder, and click Open.

 3. In the Model browser, double-click Sketch1 to edit it. Or right-click it and choose Edit 

Sketch.

 4. In the Sketch tab’s Constrain panel, click the Perpendicular button.

 5. Click the vertical line, as shown in Figure 3.44, and then select either of the horizontal 

lines.

Figure 3.44

Placing a 

Perpendicular 

constraint

 6. Right-click, and choose Cancel. 

 7. Press the F8 key to show all the constraints, noting the new Perpendicular constraint.

 8. You can exit the fi le without saving once you have fi nished.

Th e Parallel Constraint
The Parallel constraint constrains objects or edges to be always parallel. Follow these steps to 

explore the Parallel constraint:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_003.ipt located in the Chapter 03 directory of the Mastering 

Inventor 2014 folder, and click Open.

 3. In the Model browser, double-click Sketch1 to edit it. Or right-click it and choose Edit 

Sketch.

 4. In the Sketch tab’s Constrain panel, click the Parallel button.

 5. Click the lines as shown in Figure 3.45.

Figure 3.45

Placing a Parallel 

constraint
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 6. Right-click, and choose Cancel. 

 7. Press the F8 key to show all the constraints, and note the new Parallel constraint.

 8. You can exit the fi le without saving once you have fi nished.

Th e Coincident Constraint
The Coincident constraint places objects or points in contact with another object. Follow these 

steps to explore the Coincident constraint:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le named mi_3h_004.ipt in the Chapter 03 directory of the Mastering 

Inventor 2014 folder, and click Open.

 3. In the Model browser, double-click Sketch1 to edit it. Or right-click it and choose Edit 

Sketch.

 4. In the Sketch tab’s Constrain panel, click the Coincident button.

 5. Click the center of the circle and then on the center point, as shown in Figure 3.46.

Figure 3.46

Placing a Coincident 

constraint

 6. Right-click, and choose Cancel. 

 7. Click the endpoint of the vertical line at the top-right corner of the rectangular shape, and 

hold down as you drag to close the profi le. Note that a Coincident constraint is placed.

 8. Press the F8 key to show all the constraints, and note the new Coincident constraints, as 

shown by the yellow dots.

 9. Hover your mouse pointer over the dots to see Coincident constraint symbols.

 10. You can exit the fi le without saving once you have fi nished.

Th e Concentric Constraint
The Concentric constraint places arcs and circles so that they share the same center point. 

Follow these steps to explore the Concentric constraint:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_005.ipt located in the Chapter 03 directory of your 

Mastering Inventor 2014 folder, and click Open.

 3. In the Model browser, double-click Sketch1 to edit it. Or right-click it and choose Edit 

Sketch.

 4. In the Sketch tab’s Constrain panel, click the Concentric button.
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 5. Click the edge of the circle and then the arc, as shown in Figure 3.47.

Figure 3.47

Placing a Concentric 

constraint

 6. Right-click, and choose Cancel. 

 7. Press the F8 key to show all the constraints, and note the new Concentric constraint.

 8. You can exit the fi le without saving once you have fi nished.

Th e Collinear Constraint
The Collinear constraint lines up a line object or ellipse axis on the same line as another line 

object or ellipse axis. Follow these steps to explore the Collinear constraint:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_006.ipt located in the Chapter 03 directory of your 

Mastering Inventor 2014 folder, and click Open.

 3. In the Model browser, double-click Sketch1 to edit it. Or right-click it and choose Edit 

Sketch.

 4. In the Sketch tab’s Constrain panel, click the Collinear icon.

 5. Click the lines as shown in Figure 3.48.

Figure 3.48

Placing a Collinear 

constraint

 6. Right-click, and choose Cancel.

 7. Press the F8 key to show all the constraints, and note the new Collinear constraint.

 8. You can exit the fi le without saving once you have fi nished.

Th e Horizontal Constraint
The Horizontal constraint makes an object line up parallel to the x-axis. Two points may also 

line up horizontally. Follow these steps to explore the Horizontal constraint:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_007.ipt located in the Chapter 03 directory of your 

Mastering Inventor 2014 folder, and click Open.
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 3. In the Model browser, double-click Sketch1 to edit it. Or right-click it and choose Edit 

Sketch.

 4. In the Sketch tab’s Constrain panel, click the Horizontal button.

 5. Click the line as shown in Figure 3.49, noting the new horizontal alignment.

Figure 3.49

Placing Horizontal 

constraints

 6. Click both of the points, as indicated in Figure 3.49, noting that they will line up 

horizontally.

 7. Right-click, and choose Cancel. 

 8. Press the F8 key to show all the constraints, and note the new Horizontal constraints.

 9. You can exit the fi le without saving once you have fi nished.

Th e Vertical Constraint
The Vertical constraint makes an object line up parallel to the y-axis. Two points may also line 

up vertically. Follow these steps to explore the Vertical constraint:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_008.ipt located in the Chapter 03 directory of your 

Mastering Inventor 2014 folder, and click Open.

 3. In the Model browser, double-click Sketch1 to edit it. Or right-click it and choose Edit 

Sketch.

 4. In the Sketch tab’s Constrain panel, click the Vertical button.

 5. Click the line as shown in Figure 3.50, noting the new vertical alignment.

Figure 3.50

Placing Vertical 

constraints

 6. Click both of the points as indicated in Figure 3.50, noting that they will line up vertically.
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 7. Right-click, and choose Cancel.

 8. Press the F8 key to show all the constraints, and note the new Vertical constraints.

 9. You can exit the fi le without saving once you have fi nished.

Th e Equal Constraint
The Equal constraint makes two objects equal in length or radius. Follow these steps to explore 

the Equal constraint:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_009.ipt located in the Chapter 03 directory of your 

Mastering Inventor 2014 folder, and click Open.

 3. In the Model browser, double-click Sketch1 to edit it. Or right-click it and choose Edit 

Sketch.

 4. In the Sketch tab’s Constrain panel, click the Equal button.

 5. Click the two circles as shown in Figure 3.51, and notice that they become equal.

Figure 3.51

Placing Equal 

constraints

 6. Click the lines, as indicated in Figure 3.51, noting that they too will become equal. You 

can make two of the vertical lines equal as well if you like.

 7. Right-click, and choose Cancel.

 8. Press the F8 key to show all the constraints, and note the new Equal constraints.

 9. You can exit the fi le without saving once you have fi nished.

Th e Fix Constraint
The Fix constraint anchors any geometry or point in place within the part sketch. You should 

use this constraint sparingly. Follow these steps to explore the Fix constraint:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_010.ipt located in the Chapter 03 directory of your 

Mastering Inventor 2014 folder, and click Open.

 3. In the Model browser, double-click Sketch1 to edit it. Or right-click it and choose Edit 

Sketch.

 4. Drag the corner as indicated in Figure 3.52, and notice that it may be repositioned freely.

Certification
Objective

Certification
Objective



106 | CHAPTER 3 SKETCH TECHNIQUES

Figure 3.52

Placing Fix 

constraints

 5. In the Sketch tab’s Constrain panel, click the Fix button.

 6. Click the same corner as before.

 7. Right-click, and choose Cancel. 

 8. Drag the corner again, and notice that it is now fi xed to that position.

 9. Apply another fi xed constraint to the vertical line next to the rectangle, and be sure to 

click the line rather than the endpoint.

 10. Right-click and choose Done or OK to exit the constraint tool, and then drag either end-

point of the line. While the line position is fi xed, the endpoints are still free to change.

 11. Press the F8 key to show all the constraints, and note the new Fix constraints.

 12. You can exit the fi le without saving once you have fi nished.

Th e Symmetric Constraint
The Symmetric constraint creates a “mirror” constraint between two similar objects. This 

constraint relies on a line to serve as a centerline about which objects are to be symmetrical. 

You need to specify the centerline only once during the command cycle. Follow these steps to 

explore the Symmetric constraint:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_011.ipt located in the Chapter 03 directory of your 

Mastering Inventor 2014 folder, and click Open.

 3. In the Model browser, double-click Sketch1 to edit it. Or right-click it and choose Edit 

Sketch. You’ll work with the sketch shown in Figure 3.53.

Figure 3.53

Placing Symmetric 

constraints
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 4. In the Sketch tab’s Constrain panel, click the Symmetric button.

 5. Click the circle on the left, and then click the circle on the right.

 6. Click the centerline, and observe that the circles become symmetric.

 7. Continue by clicking a line on the square on the left side of the sketch.

 8. Click the corresponding line on the rectangle on the right. Notice that this time you did 

not need to select the centerline. When using the Symmetric constraint, you need only to 

establish the centerline once.

 9. Continue making the sketch symmetric by selecting lines on the left of the sketch and 

then selecting the corresponding lines on the right side.

 10. Right-click and choose Cancel when the sketch is symmetric.

 11. Press the F8 key to show all the constraints; note the new Symmetric constraints.

 12. You can exit the fi le without saving once you have fi nished.

Th e Smooth Constraint
The Smooth constraint creates a continuous curvature (G2) condition between a spline and 

another sketch object, such as a line, arc, or spline. The G2 condition brings the curve out past 

the tangency point to create a smooth transition from one curve into the next. Follow these steps 

to explore the Smooth constraint:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_012.ipt in the Chapter 03 directory of your Mastering 

Inventor 2014 folder, and click Open.

 3. In the Model browser, double-click Sketch1 to edit it. Or right-click it and choose Edit 

Sketch.

 4. In the Sketch tab’s Constrain panel, click the Smooth button.

 5. Click the spline and arc as indicated in Figure 3.54.

Figure 3.54

Placing a Smooth 

constraint

 6. Right-click, and choose Cancel.

 7. Press the F8 key to show all the constraints; note the new Smooth constraint.

 8. You can exit the fi le without saving once you have fi nished.
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Gaining More Sketch Skills
Many tools are available in the sketch environment, each used to draw different types of geom-

etry or modify geometry in a different way. Many of these are covered in the following pages, 

but as a reminder, if you hover your mouse pointer over the tool and then pause, you will see a 

tool tip appear; hover a bit longer, and a larger, more informative tool tip will appear. These pro-

gressive tool tips are a great help when you’re attempting to use tools that you don’t often use 

and you need a helpful hint to remember what they do and how they do it.

Creating Arcs
You can create sketch arcs by using one of three arc tools available in Inventor’s sketch environ-

ment. All three arc types are available in a drop-down menu in the Sketch tab’s Draw panel. 

Once placed, the three arcs behave the same; it is simply the manner in which they are created 

that differentiates them.

A three-point arc is an arc defi ned by two endpoints and a point on the arc. The fi rst click 

sets the fi rst endpoint, the second sets the other endpoint, and the third point sets the direction 

and radius of the arc, as shown in Figure 3.55.

Figure 3.55

A three-point arc
1 3

2

A center-point arc is an arc defi ned by a center point and two endpoints. The fi rst click sets 

the center point, the second sets the radius and start point, and the third sets the endpoint 

and/or arc length, as shown in Figure 3.56.

Figure 3.56

A center-point arc

1
3

2

A tangent arc is an arc from the endpoint of an existing curve. The fi rst click must be on the 

endpoint of an existing curve and sets a Tangent constraint on the endpoint. The second point 

sets the end of the tangent arc, as shown in Figure 3.57.

Figure 3.57

A tangent arc

1

2
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Additionally, you can create arc segments while using the Line tool, as illustrated in 

Figure 3.58.

Figure 3.58

Creating an arc 

with the Line tool

To do so, follow these steps:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_013.ipt located in the Chapter 03 directory of your 

Mastering Inventor 2014 folder, and click Open. The goal here is to re-create the 

oblong shape already present in the sketch.

 3. In the Model browser, double-click Sketch1 to edit it. Or right-click and choose Edit 

Sketch.

 4. In the Sketch tab’s Draw panel, click the Line icon.

 5. Click the projected origin point as the start point of the line, and then release the mouse 

button. This is the small dot located below the oblong shape and at 0,0 of the sketch.

 6. Pull your mouse pointer to the right, making sure you see a horizontal or parallel glyph, 

indicating that your line is horizontal.

 7. Click the screen to set the second point of the line, and then release the mouse button.

 8. Now to sketch an arc without exiting the Line tool, click and hold the endpoint you just 

created, and then (still holding down on the mouse button) drag your mouse pointer out 

to preview the arc. If the arc previews in the wrong direction, simply return your mouse 

pointer to the endpoint and try again. It may be helpful to “trace” the guideline cross and 

exaggerate the arc size to get the direction established and then bring your mouse pointer 

back in to get the size you want.

 9. Release the mouse button to end the arc and continue the Line tool.

 10. Continue creating line/arc segments, or right-click and choose Cancel to exit the Line 

tool. Practice this a few times, and you’ll have it mastered in a short time.

Creating Automatic Tangents with the Line Tool
When adding tangent line segments to a circle or arc, you can apply the Tangent constraints 

automatically. To do so, start the Line tool, and click and hold on the circle or arc on which you 

intend to create the tangent line. You will see a tangent glyph. You can drag the line segment out 

to the length and orientation desired. To change the tangent direction, simply rub your cursor 

over the tangent point again and drag the line segment the other direction. Figure 3.59 illus-

trates this technique.
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Figure 3.59

Creating automatic 

tangents with the 

Line tool

Understanding the Point/Center Point Tool
You can use the Point/Center Point tool, found in the Sketch tab’s Draw panel, to create center 

marks for locating hole centers and specifi c coordinate points. Center points are used by the 

Hole and Sheet Metal Punch tools in the modeling environment to automatically locate hole cen-

ters. Points, or sketch points as they are often called, are initially ignored by the Hole and Punch 

tools but can be manually selected for use. Another key difference between the two point types 

is that sketch points are deleted when the associated geometry is deleted. Center points are not.

You can change the center point to a sketch point, or vice versa, by selecting the point and 

clicking the Center Point button on the Format menu of the Sketch tab, as shown in Figure 3.60.

Figure 3.60

Using the Center 

Point button to 

switch points from 

simple sketch 

points (right) to 

center points (left)

Creating Sketched Slots

In Inventor 2014 you can use the new slot sketch tools found on the Sketch tab to create the fol-

lowing types of slots:

 ◆ Center to Center Linear Slots

 ◆ Overall Length Linear Slots

 ◆ Th ree Point Arc Slots

 ◆ Center Point Arc Slots

To see how each slot type is created you can pause your cursor over the tool and wait for the extended 

fl yout panel to show you the “picks and clicks.”

Projecting Geometry
When creating a sketch on the face of existing geometry or a work plane, you can project exist-

ing points and edges into the sketch by using the Project Geometry tool found in the Sketch 

tab’s Draw panel. To take a quick look at this functionality, follow these steps:

 1. From the Get Started tab, select the Open button.

Certification
Objective



GAINING MORE SKETCH SKILLS | 111

 2. Browse for the fi le mi_3h_014.ipt in the Chapter 03 directory of your Mastering 

Inventor 2014 folder, and click Open.

 3. In the Model browser, double-click Sketch3 to edit it. Or right-click and choose Edit 

Sketch.

 4. In the Sketch tab’s Draw panel, click the Project Geometry icon.

 5. Click the edges of the red oval-shaped profi le.

 6. When you have the complete profi le projected into the sketch as shown in Figure 3.61, 

click the Finish Sketch button.

Figure 3.61

Using the Project 

Geometry tool to 

project the profi le 

into the active 

sketch

 7. Next, in the Model browser, double-click Sketch4 to edit it. Or right-click and choose Edit 

Sketch.

 8. Once the sketch is active, right-click and choose Slice Graphics (or press F7 on the key-

board) to slice the part along the sketch plane.

 9. In the Sketch tab’s Draw panel, click the drop-down for Project Geometry and choose 

Project Cut Edges.

You’ll see that the sliced edges are now projected as sketch lines into the sketch. These lines 

can be used to dimension or constrain other sketch geometry too and will remain associative 

to the sliced features. Oftentimes a work plane is used to create a sketch in the middle of a part 

such as this. Work planes are covered in Chapter 4, “Basic Modeling Techniques.” For now, you 

can fi nish the sketch and close the fi le without saving changes.

Breaking the Link with Projected Geometry

Projected geometry is created by projecting an edge or a face. When you project faces, a browser 

node for a projected loop is created under the Sketch node. When you project edges, no browser 

node is created. You might need to break the link of the projected geometry in order to modify it.

 ◆ To break the link of projected faces, right-click the Projected Loop browser node and select 

Break Link.

 ◆ To break the link of projected edges, right-click the edge itself and choose Break Link.
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Learning More about Dimensions
In the following sections, you’ll take a look at more Dimension tools and settings to help you 

master this very important part of sketch creation.

Using One General Dimension Tool to Do It All

It is important to understand that you get different results from the Dimension tool depending 

on what geometry is selected or in what order it is selected. Here are the dimension types you 

can place with the General Dimension tool:

Linear dimension from one object:

Linear dimension between two objects:

Aligned dimension between two objects: Select the objects and right-click to choose the 

Aligned solution.

Angular dimension between two edges:

Angular dimension between three points:
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Dimensions to circles or arcs: Select the object and then right-click to switch between diam-

eter or radius solutions for either arcs or circles.

Dimension to the center of arcs and circles: Select the fi rst element of the dimension and then 

click anywhere on the arc or circle. Note the linear glyph indicating the linear solution you 

will get.

Dimension to the tangent of arcs and circles: Select the fi rst element of the dimension and 

then click the tangent when you see the tangent glyph appear.

2
1

Setting Up Automatic Dimensions

In addition to the General Dimension tool, Inventor has an Automatic Dimension tool. It is 

generally poor practice to use the Automatic Dimension tool to apply all dimensions to your 

sketches because it will do so in an illogical way. However, you can benefi t from this tool by 

placing the dimensions that defi ne the intent of your design with the General Dimension tool 

and then allowing the Automatic Dimension tool to place the remaining dimensions to fully 

constrain the sketch.

To take a look at the Automatic Dimension tool in action, follow these steps:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le named mi_3h_015.ipt in the Chapter 03 directory of your Mastering 

Inventor 2014 folder, and click Open.

 3. In the Model browser, locate Sketch1, and double-click to edit or right-click and choose 

Edit Sketch.
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 4. In the Sketch tab’s Constrain panel, click the Automatic Dimension icon. Notice that the 

Auto Dimension dialog box shows the number of dimensions required to fully constrain 

the sketch.

 5. Accept the default settings to add both dimensions and constraints.

 6. With the Curves button enabled, select all of the geometry in the sketch (you can do this 

quickly with a selection window).

Figure 3.62 shows that two dimensions will be added to fully constrain the sketch.

Figure 3.62

Adding automatic 

dimensions

 7. Click Apply to add dimensions to the selected geometry.

 8. When fi nished, click Done.

 9. You can close the fi le without saving changes.

Note that you can also use the Automatic Dimension tool to apply just sketch constraints by 

deselecting the Dimensions check box.

Working with Sketch Centerlines

You can create centerlines in sketches either by creating a regular line and then changing 

it to a centerline or by changing the line type to centerline fi rst and then creating the line. 

Dimensioning to a centerline gives you a diametric solution by default, but you can opt for a 

linear solution by right-clicking and deselecting Linear Diameter, as shown in Figure 3.63. In 

the following exercises, you will fi nd the steps for both methods of centerline creation as well as 

how to change the solution when dimensioning to a centerline.

To change to centerline line type before creating sketch geometry, follow these steps:

 1. Ensure that the sketch is active for editing by double-clicking it or right-clicking and 

choosing Edit Sketch.

 2. On the Sketch tab, click the Centerline icon in the Format panel.

 3. Now use the Line tool to sketch lines as you would normally. Note that the Centerline 

icon stays pushed in (On) until you click it again.
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Figure 3.63

Dimensioning to a 

centerline

To change an existing line to a centerline, follow these steps:

 1. Ensure that the sketch is active for editing by double-clicking it or right-clicking and 

choosing Edit Sketch.

 2. Select the sketch lines you intend to be centerlines.

 3. On the Sketch tab, click the Centerline icon in the Format panel.

To create a dimension to a centerline, follow these steps:

 1. Ensure that the sketch is active for editing by double-clicking it or by right-clicking and 

choosing Edit Sketch.

 2. On the Sketch tab, click the Dimension icon in the Draw panel.

 3. Select an object to the side of the centerline.

 4. Click the centerline. Note the diametric diameter.

 5. Right-click, and note the Linear Diameter option.

 6. Place the dimension on the screen.

Measuring Geometry
You can use the Measure tools to gather measurements from your model without the need to 

place a dimension in your sketch. These tools can be accessed from the Tools tab or by right-

clicking any empty place in the graphics area of the screen and choosing Measure from the 

context menu. When using the Tools tab, you can click the drop-down on the Measure panel to 

reveal the Region Measure option. The measurement tools include the following:

Measure Distance  Measures the length lines and arcs, the distance between points, and the 

radius or diameter of a circle.

Measure Angle  Measures the angle between two lines or points.

Measure Loops  Measures the length of closed loops.

Measure Area  Measures the area of enclosed regions.

Get Region Properties  Measures the area and perimeter and the Area Moment Of Inertia 

properties of sketch loop regions. This tool is available only while editing 2D sketches. 

Figure 3.64 shows the use of the Measure Region tool.
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Figure 3.64

Measuring a region

Creating Sketches from AutoCAD Geometry
Converting accurate, dimensioned 2D drawings eliminates the need to redraw all of the origi-

nal geometry. Inventor allows selective importing of 2D drawings with associative geometry 

directly into a new part sketch. If you have an existing drawing library of 2D AutoCAD fi les, 

you may fi nd it benefi cial to use those fi les to create new 3D feature-based parametric parts in 

Inventor. Success in importing existing drawings depends on the following criteria:

 ◆ The AutoCAD fi le must contain accurate original geometry.

 ◆ Duplicate geometry must be deleted from the AutoCAD fi le.

 ◆ Proper AutoCAD drawing techniques must be employed in creating the AutoCAD fi le. For 

example, there must be only one line segment between any two points. Two shorter lines 

appearing as a single line will be imported exactly as drawn in the AutoCAD fi le.

 ◆ For dimensions to be converted to Inventor parametric dimensions, the existing AutoCAD 

dimensions must be associative to the geometry. Disconnected dimensions (AutoCAD 

Defpoints not snapped to the proper geometry location) will cause problems when con-

verted to Inventor dimensions.

Importing Existing AutoCAD Designs
You begin the process of converting an AutoCAD drawing to Inventor parts by creating a new 

part fi le. When in active sketch mode, you can import AutoCAD sketch geometry by selecting 

the Insert panel on the Sketch tab and clicking the Insert AutoCAD File icon. To see this process 

yourself, follow these steps:

 1. From the Get Started tab, select the New button.

 2. In the New File dialog box, click Metric on the left-hand pane and click the 

Standard(mm).ipt icon.

 3. Click Create to create a new part fi le based on this template.
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 4. On the Insert panel of the Sketch tab, click the Insert AutoCAD File icon.

 5. In the resulting dialog box, select the fi le Import1.dwg from the Chapter 03 directory of 

your Mastering Inventor 2014 folder.

 6. Click Open to start the conversion process. Once the AutoCAD fi le opens, you will move 

into a series of Import Destination Options pages. The fi rst page is mostly grayed out 

except for specifying units, constraining endpoints, and optionally applying geometric 

constraints upon import under most conditions. Set your selections as shown in 

Figure 3.65.

Figure 3.65

DWG import 

options

 7. Click Finish to complete the import.

Creating Sketches from a Graphic Image

Occasionally you may need to create a part from a scanned image or napkin sketch. To do this, you 

can insert the scanned image or napkin sketch right into your sketch and sketch over the top of it. 

Although this is generally not a good approach for reproducing precise machined parts, it is a valid 

workfl ow when designing consumer products and the general shape and feel of parts need to be 

captured. If you have a need for this type of design on a regular basis, you may want to investigate 

Autodesk® AliasStudio™ software as well. Here are the general steps for creating sketches from 

an image:

 1. Place an image into a part sketch by clicking the Insert Image icon on the Sketch tab.

 2. Browse for the image you want to place into the sketch, and choose Open when the image is located.

 3. Th e mouse pointer is then attached to the upper-left corner of the image. To place the image, simply 

click an insert point on-screen.

 4. Once the image is placed, the edges of the image can be dimensioned and constrained like any 

other sketch entity.
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Now you can sketch on top of the image, tracing the edges to create the profi le and then use the 

Dimension tool to tweak the sketch as required.

When an AutoCAD drawing is imported into a sketch, Inventor records the unit type of the 

AutoCAD fi le. By default, the unit type is displayed within the import dialog box but grayed 

out. If the unit type is not correct or the unit is of a different type than you require, you may 

input a different input-unit type.

Selecting the Constrain End Points box allows insertion of Coincident constraints between 

sketch objects found to have endpoints that occupy the same coordinates. When the Apply 

Geometric Constraints box is checked, Inventor will add minimal constraints to the imported 

AutoCAD geometry. Note too that although some dimensions will not be imported, those that 

are will be parametric Inventor dimensions. Figure 3.66 shows the result of importing the fi le 

Import1.dwg.

Figure 3.66

Original DWG 

(left) and fi nished 

imported sketch 

(right)

If the AutoCAD geometry was created at the 0,0 origin, then it should import into Inventor 

at the same location. If the AutoCAD geometry is not located at the origin of the sketch, you can 

use the Move command, selecting both the geometry and any dimensions, to move the entire 

imported sketch into the proper location. You might also prefer to redefi ne the geometry origin 

in AutoCAD and then import or reimport it into Inventor.
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You should note that this imported drawing might be further broken down into separate fea-

tures. For instance, each hole could be a separate feature. Note too that having the round corners 

modeled as features separate from the base feature allows for easier edits in Inventor.

Copying and Pasting Existing AutoCAD Designs into Inventor
Although using the import wizard as described earlier works without having AutoCAD open 

or even installed, you can import AutoCAD geometry in an even more effi cient manner by 

simply copying from an open AutoCAD fi le straight into an Inventor sketch, as described in 

these steps:

 1. Open the existing fi le in AutoCAD.

 2. From an open AutoCAD fi le, simply select the geometry you want to import, right-click, 

and choose Copy, thereby copying the selected objects to the Windows clipboard.

 3. In Inventor and with a 2D sketch active for editing, right-click and choose Paste. You will 

be presented with a bounding-box preview of the pasted entities.

 4. At this point, you can right-click and choose Paste Options to ensure that the insert scale 

is correct or click the graphics window to place the pasted geometry.

Although importing geometry from AutoCAD can be an effi cient way to reuse existing 

AutoCAD fi les, experienced Inventor users generally prefer to model parts from scratch rather 

than import from AutoCAD. Importing from AutoCAD almost never provides results that are 

in line with the design intent of the part unless you just get lucky. Although you may fi nd this 

to be helpful initially, you will learn that importing AutoCAD fi les has a place in Inventor but 

should not be used as a substitute for creating robust parametric Inventor models.

Creating and Using 3D Sketches
3D sketches permit the creation of nonplanar 3D features. 3D sketches are created in single-

part fi les only and comprise geometry located in various XYZ locations or points within the 

fi le. Although a 3D sketch may lie in a 2D plane, in most designs that will not be the case. 3D 

sketches should never be used for creating geometry that could be created within the 2D sketch 

environment. The 3D sketch tool is accessible only from within the part environment; however, 

you can project geometry from an assembly into the part to create the 3D sketch.

Creating a 3D Path
3D sketches are often used to defi ne paths for modeling features such as sweeps and lofts and 

are generally created based on existing geometry. You can use a 3D sketch to create objects such 

as tubes, pipes, and wires as well as negative features such as cam paths, recessed parting lines, 

and so on.

In this exercise, you will use the 3D Line and Spline tools to create a path along which a pro-

fi le can be swept. This is a common use of 3D sketches. To start the exercise, follow these steps:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_016.ipt in the Chapter 03 directory of your Mastering 

Inventor 2014 folder, and click Open.
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 3. On the 3D Model tab, click the drop-down arrow on the Sketch panel below the Create 

2D Sketch icon, and then click the Create 3D Sketch icon. Or right-click in an empty area 

of the graphics window and choose New 3D Sketch.

Notice that although this is a part fi le, it has some reference surfaces in it already. These 

were included simply to emulate a situation where you might be creating a part within 

the context of an assembly. You will learn more about creating parts within an assembly 

in the chapters to come.

There is also a 2D sketch called Profi le1 already in the Model browser; you’ll use this sketch 

at the end of this exercise. Your goal is to create a 3D sketch running from the center of the 

connection input of the box through each of the large holes in the fl ange brackets.

 4. On the 3D Sketch tab, click the drop-down arrow on the Spline tool icon to reveal the 

Control Vertex and Interpolation spline options; then select the Interpolation option. 

You’ll see the 3D coordinate triad appear.

 5. With the Spline tool still active, select the Draw panel bar to reveal the fl yout menu and 

then click the Precise Input button.

Now you will see the Inventor Precise Input toolbar appear. The Precise Input toolbar 

allows you to enter coordinates to move the 3D triad. The triad displays the x, y, and z 

planes and the corresponding axes in the form of three arrows. The red arrow indicates 

the x-axis, the green arrow indicates the y-axis, and the blue arrow indicates the z-axis. 

Notice that the triad is fi rst positioned at 0,0,0.

 6. Specify a start point for the spline by clicking the front, circular edge of the connection 

input.

 7. Click the center of the large hole of the fi rst triangular fl ange bracket. It makes no 

difference whether you choose the front or back edge of the hole.

 8. Do the same for the other two fl ange brackets.

 9. Right-click, and choose Create to complete the spline.

 10. Right-click again, and choose Done to exit the Spline tool. Your screen should look 

similar to Figure 3.67.

Figure 3.67

3D sketch spline

In the next section, you will add a 3D line to your 3D spline.
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Using the 3D Coordinate Triad 
Before continuing with the 3D sketch, take a moment to explore the 3D coordinate triad and its 

functionality. Each part of the triad is selectable for different tasks, as you’ll see in the coming 

paragraphs. Figure 3.68 shows the anatomy of the triad.

Figure 3.68

Inventor’s Precise 

Input toolbar and 

the 3D coordinate 

triad

Sphere

Arrowhead

Plane

Axis

 1. Still in the 3D sketch, click the Line tool icon on the 3D Sketch tab.

 2. Notice the return of the triad and Precise Input toolbar.

 3. Click the endpoint of the spline to set the start of the line on this point.

You will see the triad move to the spline endpoint. Notice that the triad is not lined up to 

be truly perpendicular with the bracket fl ange. To remedy this, you will use the Precise 

Redefi ne button found on the Precise Input toolbar. Your goal is to set the X (red), Y 

(green), and Z (blue) arrows of the triad to the orientation shown in Figure 3.69.

Figure 3.69

Using the 

Reposition Triad 

button to realign 

the triad
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 4. Select any of the arrow shafts.

 5. On the Precise Input toolbar, click the Reposition Triad button, as shown at the top of 

Figure 3.69.

 6. Select the shaft of the red X arrow, and then click one of the bottom edges of the triangu-

lar fl ange bracket, as shown in Figure 3.69.

Note that if your X arrow faces the opposite direction, you will repeat steps 4 and 5 and 

select the other edge along the bottom of the bracket.

 7. Next, click the Reposition Triad button again, and this time select the shaft of the green Y 

arrow.

 8. Click one of the small edges on the sides of the fl ange as shown in Figure 3.69.

Again, if the result of your selection leaves your Y arrow facing the opposite direction, 

you will repeat steps 7 and 8 and select another edge along the side of the bracket.

Once the triad orientation is set so that it matches Figure 3.69, you will draw a line by 

entering coordinates.

 9. Click the triad plane between the blue and green arrows to isolate that plane to sketch on.

The triad plane should highlight red and then stay highlighted when selected (although 

this highlighting can be diffi cult to see depending on the color scheme in use). When the 

plane is selected, you will see a 0 placed in the X cell of the Precise Input toolbar.

 10. With 0 in the X input cell, enter 300 in the Y cell, and 25 in the Z cell, and press Enter.

Note that you can press the Tab key to switch among the X, Y, and Z input cells. Values 

will be input as relative coordinates. Recall that with relative coordinates, the new input 

coordinate point is based on the previous point rather than the absolute 0,0,0 origin point. 

You will now have a line running from the end of the spline out at 300 mm in the y-axis 

with a 25 mm rise in the z-axis.

 11. Still in the Line tool, right-click, and ensure that Auto-Bend is selected in the context 

menu. Auto-Bend will place a radius at the corners in your line route. The default radius 

size can be set by selecting Document Settings from the Tools tab and then selecting the 

Sketch tab. Once bends are placed, they can be edited like any other dimension.

 12. With the Line tool still active, click the plane between the green and red arrows on the 

triad to isolate the XY triad plane, and enter 200 in the X input, 200 in the Y input, and 

leave 0 in the Z input. Press Enter on the keyboard to set this line point. You will see a 

small dimensioned radius at the corner of your two line segments. This is a result of the 

Auto-Bend option.

 13. Right-click and choose Cancel to exit the Line tool. Your 3D sketch should resemble 

Figure 3.70.

 14. Click the Dimension button in the 3D Sketch tab, and add dimensions, as shown in 

Figure 3.71. Note that you can edit the bend radius dimension that was created with the 

Line tool.
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 15. Right-click and choose Done or OK to exit the Dimension tool.

 16. Right-click and choose Finish 3D Sketch.

Figure 3.70

3D sketch path

Figure 3.71

3D sketch 

dimensions

As a test to see whether you have successfully created your 3D sketch for its intended pur-

pose, run a sweep along the path. Recall that there is a 2D sketch named Profi le1 in the browser. 

This will be your sweep profi le, and the 3D sketch just created will be your path.

 1. In the 3D Model tab’s Create panel, click the Sweep icon. Profi le1 will be automatically 

selected as the sweep profi le unless you have another unconsumed, closed profi le sketch 

in your part, in which case you will need to select Profi le1 manually.

 2. Once the profi le has been selected, ensure that the Path button in the Sweep dialog box 

is enabled, and then click the 3D sketch you just created. Your sweep should look like 

Figure 3.72.

Figure 3.72

Sweeping along a 

3D sketch

You will look at the Sweep tool in more depth in Chapter 5, “Advanced Modeling 

Techniques.” As a fi nal note, the connection box and triangular bracket fl anges have been 

derived into this part fi le as a reference feature. In the real world, once you’ve fi nished with the 
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part, you would locate that feature in the browser and turn off the visibility. To do this, in the 

browser expand the feature called DerivedPart1.ipt. Right-click the feature called Derived 

Work Body1, and uncheck the Visibility box. If you’d like, you can save and close the part.

Exploring More 3D Sketch Tools
In addition to the Line and Spline tools used for sketching 3D geometry, several tools permit 

you to include and combine existing geometry to create 3D sketch elements.

Including D Geometry

You’ll often need to use edges of parts as a path for another feature, in much the same way you 

project geometry in a 2D sketch. In a 3D sketch, however, you are not really projecting the geom-

etry onto a sketch plane but simply including it for use in your 3D sketch. To see how this works, 

follow these steps:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_017.ipt in the Chapter 03 directory of your Mastering 

Inventor 2014 folder, and click Open.

This fi le has a 2D sketch named Lip Profi le already created and ready to be used in a 

sweep feature. However, before you can do that, you’ll defi ne a path along which to 

sweep the profi le.

 3. On the 3D Model tab, click the drop-down arrow below the 2D Sketch icon in the Sketch 

panel and then click the Create 3D Sketch icon. Or right-click in an empty area of the 

graphics window and choose New 3D Sketch.

 4. On the 3D Sketch tab, click the Include Geometry icon. Next, click each edge along the 

curved edge, as shown in Figure 3.73, to defi ne the sweep path.

Figure 3.73

Including geometry 

in a 3D sketch

 5. Once the edges are selected, right-click and choose Finish 3D Sketch.

The path created by including geometry could not have been created with a 2D sketch 

because it does not exist in a single plane. You can use this path to experiment with the Sweep 
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tool to sweep the profi le along the path if you’d like. The Sweep tool is covered in more depth in 

Chapter 5.

Using an Intersection Curve

You can use a 3D sketch to fi nd the intersection of two surfaces, sketch profi les, work planes, or 

some combination thereof. The resulting sketch is fully associative and will update automati-

cally should the curves change. To see it in action, follow these steps:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_018.ipt in the Chapter 03 directory of the Mastering 

Inventor 2014 folder, and click Open.

 3. On the 3D Model tab, click the drop-down arrow below the 2D Sketch icon in the Sketch 

panel and then click the Create 3D Sketch icon. Or right-click in an empty area of the 

graphics window and choose New 3D Sketch.

 4. On the 3D Sketch tab, click the Intersection Curve icon.

 5. Click the surface and the curved face, as shown in Figure 3.74.

Figure 3.74

3D intersection 

curve

 6. Click OK.

 7. Right-click the surface and choose Visibility to toggle the visibility off. Note the resulting 

intersecting curve.

 8. You can close the part without saving changes.

Using the Project Curve To Surface Tool

You can fi nd intersections of curves and faces using the Project Curve To Surface tool in a 3D 

sketch. This tool outputs three variations of projected geometry. Geometry created using these 

tools will adjust if the original geometry changes. Or, if you desire, the link can be broken from 

the parent geometry to prevent it from adjusting automatically. To see it in action, follow these 

steps:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_019.ipt in the Chapter 03 directory of your Mastering 

Inventor 2014 folder, and click Open.
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 3. On the 3D Model tab, select the Sketch panel and click the drop-down arrow below the 

2D Sketch icon. Then click the Create 3D Sketch icon. Or right-click in an empty area of 

the graphics window and choose New 3D Sketch.

 4. On the 3D Sketch tab, click the Project To Surface icon.

The fi rst output, Project Along A Vector, requires a face, a curve, and a direction. 

Projecting to a continuous face such as a cylinder results in a 3D sketch entity that follows 

the surface as if the curve were slicing straight down through the face.

 5. Click the face of the cylinder.

 6. Click the Curves button. Note the Direction button, which allows you to change the pro-

jection direction. In this case, the default direction will work, so you can leave this as is.

 7. Click the line on the far left.

The second output is called Project To Closest Point and projects curves in the shortest 

possible path normal to the surface. The result of a 3-inch line to a convex surface would 

be a curve less than 3 inches because the endpoints of the line would take the shortest 

path to the curve rather than wrapping about it.

 8. In the Output area of the Project Curve To Surface dialog box, click the middle button to 

choose the Project To Closest Point output.

 9. Click the face of the cylinder.

 10. Click the Curves button.

 11. Click the line in the middle.

The third output is Wrap To Surface. This output creates a curve that will be the same 

overall dimension as the curve from which it was created. If you wrap a string around a 

cylinder, the string stays the same length.

 12. In the Output area of the Project Curve To Surface dialog box, click the right button to 

choose the Wrap To Surface output.

 13. Click the face of the cylinder.

 14. Click the Curves button.

 15. Click the line on the right.

 16. Click OK.

 17. You can close the part without saving changes.

Figure 3.75 shows all three outputs; note the different outputs created from three identical 

lines. You can break the link of the projected curves by locating the curves in a 3D sketch from 

the Model browser, right-clicking them, and choosing Break Link. You must have the sketch 

active for edits to break the link. Doing this disallows the ability for the projected curves to 

update if the founding geometry is updated.
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Figure 3.75

Project Curve To 

Surface tool

Using a Helical Curve

You can create 3D helical curves such as thread paths and coils by using the Helical Curve tool 

within the 3D sketch tools. Helixes can be specifi ed by pitch and revolution, pitch and height, 

revolution and height, or a true spiral. A helix can be combined with other 3D sketch objects to 

compose as complex a path as required. Follow these steps to explore using the Helical Curve 

tool:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_020.ipt in the Chapter 03 directory of the Mastering 

Inventor 2014 folder, and click Open.

 3. Notice the existing 2D sketch consisting of a single line.

 4. On the 3D Model tab, select the Sketch panel and click the drop-down arrow below the 

2D Sketch icon. Then click the Create 3D Sketch icon. Or right-click in an empty area of 

the graphics window and choose New 3D Sketch.

 5. On the 3D Sketch tab, click the Helical Curve icon.

 6. For the start point, select one end of the line.

 7. Select the other end of the line for the endpoint of the helical curve.

 8. Click in the graphics window to rough in the diameter.

 9. Set the precise diameter value to 25 mm, as shown in Figure 3.76.

Figure 3.76

A helical curve
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 10. Enter 10 mm for the pitch.

 11. Enter 5 for the revolutions.

 12. Click OK.

 13. Examine the resulting helical curve, as shown in Figure 3.76.

 14. Note that you can change the inputs of the curve by right-clicking it and choosing Edit 

Helical Curve.

 15. You can close the part without saving changes.

Using a Silhouette Curve

You can create an associative 3D curve along the outer boundary of a body as defi ned by a 

selected direction. Imagine a beam of light cast on an object from a single direction. The curve 

created where the shadow line begins would be the silhouette curve. You can use the Silhouette 

Curve tool to determine the parting line of organic shapes; just follow these steps:

 1. From the Get Started tab, select the Open button.

 2. Browse for the fi le mi_3h_021.ipt in the Chapter 03 directory of the Mastering 

Inventor 2014 folder, and click Open.

 3. On the 3D Model tab, select the Sketch panel and click the drop-down arrow below the 

2D Sketch icon. Then click the Create 3D Sketch icon. Or right-click in an empty area of 

the graphics window and choose New 3D Sketch.

 4. On the 3D Sketch tab, click the Silhouette Curve icon.

 5. For the Body selection, click anywhere on the part.

 6. For the Direction selection, click the work axis.

 7. Click OK. Note the resulting curve, as shown in Figure 3.77. You can exit the sketch and 

close the fi le when fi nished.

Figure 3.77

A silhouette curve

You can break the link of the projected curves by locating the curves in a 3D sketch from the 

Model browser, right-clicking them, and choosing Break Link. Doing this disallows the pro-

jected curves to update if the founding geometry is updated.
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Refining and Constraining a D Sketch

You can anchor and constrain a 3D sketch in much the same fashion as you do a 2D sketch using 

dimensions and constraints. Additionally, with 3D splines you can add vertex points and control 

curve fi t with handles. Further refi ning can take place because you can adjust the fi t method and 

spline tension to create the exact curve shape desired.

Best Practices for Working with Sketches
Here is a list of points to remember as you continue working with sketches in Inventor. Keep 

in mind that sketches are the foundation for good modeling, and therefore the importance of 

creating stable, fully constrained sketches cannot be overstated.

 ◆ Keep sketches simple.

 ◆ Your goal should always be to have a fully dimensioned and constrained sketch.

 ◆ Sketches that are not fully constrained tend to distort unpredictably when you make 

modifi cations and updates.

 ◆ Rough out size and shape before adding dimensions and constraints to avoid distorting 

the sketch when dimensions and constraints are added.

 ◆ Add dimensions to lock down shape, and then come back to change the size.

 ◆ Endpoint, midpoint, center, and intersection snap points can be helpful when creating 

sketch entities, but be aware of how they affect dimensions compared to selecting the line 

itself rather than the snap points.

 ◆ You can use the Backspace key to clear the last-selected points. For instance, if you select a 

point for the end of a line and then realize you should have selected another point instead, 

use the Backspace key to clear the fi rst selection, and then start the line where it should 

have been.

 ◆ Use centerlines to defi ne revolution axes and diametric dimensions.

 ◆ Use construction lines to further defi ne sketches and create “helper” geometry.

 ◆ When you need to select multiple sketch entities, you can use a crossing selection or a 

window selection. A crossing selection is created from right to left and selects any object 

that is touched or contained by the window. A window selection is created from left to 

right and selects only objects that are completely contained in the window.

 ◆ Use the Delete key on the keyboard to quickly remove accidentally created geometry.

 ◆ Use the Split tool rather than the Trim tool when you can because the Split tool does not 

break previously defi ned constraints.

 ◆ Turn off automatic edge projection to avoid extra sketch geometry, and project only the 

edges you need. This will make sketches easier to edit.
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 ◆ Reserve fi llets and chamfers for the feature level whenever possible. Although you can 

fi llet and chamfer at the sketch level, it is generally best to keep your sketches simple and 

fi llet and chamfer the solid features rather than the sketches.

 ◆ You can create pattern and mirrored geometry in the sketch, but it is generally best to make 

a simple sketch, then create a feature from it, and then pattern or mirror the feature. The 

results are often the same, but the feature patterns are much easier to edit.

Th e Bottom Line

Set up options and settings for the sketch environment.  Understanding the settings 

and options that apply to the sketch environment is an essential fi rst step in working with 

Inventor.

Master It  You want to confi gure your own set of options and settings for your sketch 

environment and then back them up and/or distribute them to other workstations. How 

would you do this?

Create a sketch from a part fi le template.  Creating a sketch in a blank template fi le is the 

fundamental step in creating 3D parametric models. You will use this basic step to start most 

of your part designs.

Master It  How would you capture the intent of your design when creating a base sketch 

for a new part?

Use sketch constraints to control sketch geometry.  Understanding what each sketch con-

straint does when applied will allow you to determine when to use each type. Recall that 

often more than one constraint will work in any given situation.

Master It  How would you create a sketch that allows you to test “what if?” scenarios 

concerning the general shape and size of your part?

Master general sketch tools.  Learning the features and tricks of the sketch tools will allow 

you to master Inventor sketching.

Master It  You are given a print of mixed units to work from, and you need to enter di-

mensions exactly as they are on the print. You understand that you can enter any dimen-

sions in any unit simply by adding the correct suffi x. But how would you create a radius 

dimension on a circle or a dimension from the tangents of a slot?

Create sketches from AutoCAD geometry.  You can use existing AutoCAD fi les to create a 

base sketch for an Inventor model of the same part.

Master It  You have many existing 2D AutoCAD drawings detailing legacy parts. You 

want to reuse these designs as you convert to 3D modeling. How would you proceed?

Use 3D sketch tools.  Much of working with a 3D parametric modeler can be done by 

sketching in a two-dimensional plane and then giving depth to the sketch to create 3D fea-

tures. However, sometimes you need to create paths or curves that are not planar. In those 

cases, you use the 3D sketch tools.

Master It   You know the profi le of a complex curve as viewed from the top and side. 

How would you create a 3D sketch from this data? 



Chapter 4

Basic Modeling Techniques

This chapter covers the principles of creating a 3D parametric part with the Autodesk® 

Inventor® and Autodesk® Inventor LT™ programs, which makes it one of the most important 

chapters in this book. You’ll start by looking at the general options and settings associated with 

Inventor and part fi les and then move on to a basic exercise exploring the fundamentals of cre-

ating parametric models. Then you’ll take a deeper look at the options found in the primary 

feature tools.

All the skills in this chapter are primarily based on creating a single part, whether in a sin-

gle-part fi le or in the context of an assembly fi le. Do yourself a favor and learn or review these 

basics before jumping into the more complex features.

In this chapter, you’ll learn to:

 ◆ Confi gure options and settings for part modeling

 ◆ Create basic part features

 ◆ Use the Extrude tool

 ◆ Create revolved parts and thread features

 ◆ Create work features

 ◆ Use the Fillet tool

 ◆ Create intelligent hole features

 ◆ Bend parts

Exploring Application Options and Settings 
for Part Modeling
As in previous chapters, you should make sure your settings in the Application Options dialog 

box match the approach we’re using in this book. This will ensure that the examples you work 

on will match the results you see here.



132 | CHAPTER 4 BASIC MODELING TECHNIQUES

Specifying Global Settings
You maintain global settings for Autodesk Inventor within the Application Options dialog box. 

For this section of the chapter, you will be concentrating on the Part tab, which allows you to 

maintain part-specifi c settings. You can adjust the application settings as follows:

 1. On the Tools tab, click Application Options.

 2. Choose the Part tab, as shown in Figure 4.1.

Figure 4.1

Th e Part tab

The Part tab settings have the following functions:

Sketch On New Part Creation  This section allows you to predetermine the origin plane in 

which to place the fi rst sketch. If No New Sketch is selected, Inventor will create a new part 

fi le without an initial sketch. You can then determine the origin plane for the fi rst sketch.

Construction  The Opaque Surfaces setting determines whether created surfaces will be 

translucent by default or as opaque as parts are. The Enable Construction Environment 
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setting allows you to work with the construction environment tools when repairing imported 

surface models. 

Auto-Hide In-Line Work Features  This option allows automatic hiding of a work feature 

when it is consumed by another work feature. For instance, if you create a work plane by 

clicking a work axis and a work point, the work axis and work point will be stacked under 

the work plane in the browser.

Auto-Consume Work Features And Surface Features  This option allows Inventor to con-

sume surfaces when converted to a solid in addition to consuming work features.

Display Extended Information After Feature Node Name In Browser  This option allows 

you to see more information about each browser feature. In addition to the names of part 

features, the size and settings of the feature will be shown to allow better identifi cation of the 

part features. This option can be toggled on and off from the Browser Filters menu as well 

as through the Application Options dialog box. Be aware that you cannot edit the content or 

format of the feature name extensions.

3D Grips  These settings affect how 3D grips can modify a part fi le. In normal use, you can 

modify part features by selecting and dragging a 3D grip. If a dimension is controlling the 

feature, the dimension will update to refl ect the changes in the part.

If Never Relax is selected, any features controlled by the dimension will not change.

When Relax If No Equation is selected, a dimension value will update unless that dimension 

value is determined by an equation. Selecting Always Relax will always allow the use of 3D 

grips, even when controlled by an equation. The Prompt setting will prompt you to accept 

any changes during drag operations.

The settings in the Geometric Constraints area control how constraints will be handled dur-

ing drag operations. Never Break prevents grip editing when sketch constraints are control-

ling a sketch. Always Break allows constraints to be broken as required during grip edits. 

The Prompt setting asks you to make a decision on a case-by-case basis for each grip edit.

Edit Base Solids Using  These settings allow you to choose between the Legacy Solid Edit 

Environment and the Inventor Fusion preview tools. A base solid is one that has no param-

eter-driven features and is created from an imported model. If the Inventor Fusion option 

is selected, the solid is opened in the Fusion application and edited there and then passed 

back to Inventor. If the Legacy Solid Edit Environment is selected, the solid is edited within 

Inventor. Using the Legacy option is often quicker, but the Fusion option offers more tools for 

making edits to base solids.

Specifying Document-Specifi c Settings
To change the options in a specifi c part fi le, you’ll need to access the part’s Document Settings 

dialog box by selecting the Tools tab and clicking Document Settings while that part is open. 

The Document Settings dialog box that opens allows specifi c settings for an individual fi le in 

the following areas:

 ◆ Lighting styles

 ◆ Materials

 ◆ Units
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 ◆ Modeling dimension display values

 ◆ Individual sketch settings

 ◆ Model values

 ◆ Bill of materials (BOM)

 ◆ Default tolerances

Any changes made in the part’s Document Settings dialog box will be applied only to the 

current document. Current document settings will not affect the settings in other parts within 

an assembly.

The Standard Tab

Figure 4.2 shows the part’s Document Settings dialog box with the Standard tab active. The 

Standard tab controls the active lighting style of the current graphics window. In addition, you 

can set the physical material properties and the display appearance of the current part here.

Figure 4.2

Th e Standard tab in 

a part’s Document 

Settings dialog box

The lighting style is selected from a preset list in the drop-down menu, as is the physical 

material. The display appearance is confi gured by clicking the Settings button and adjusting the 

various settings in the resulting dialog box. To use the display appearance settings confi gured 

in the part fi le, you must fi rst select the Display tab of the Application Options dialog box and 

select Use Document Settings.

The Units Tab

The settings on the Units tab allow you to change the unit specifi cation values, as shown in 

Figure 4.3. For example, you could open a metric (mm) part and change the input settings to 

inches.

The Units tab settings have the following functions:

Modeling Dimension Display  These settings allow you to defi ne the model dimension’s 

display precision by the number of decimal places and defi ne how that dimension will 
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be displayed. Many people prefer the Display As Expression setting because it shows the 

dimension name along with any expression that exists in the dimension; if no expression 

exists, the dimension name and dimension value are displayed.

Default Parameter Input Display  These settings allow you to see the parameter name in 

the input box when you’re editing a dimension or feature input. Figure 4.4 shows the option 

set to display as the expression on the left and set to display as the value on the right. You can 

also access this setting from the context menu.

Figure 4.3

Th e Units tab in 

Document Settings

Figure 4.4

Default parameter 

input display

The Sketch Tab

On the Sketch tab, shown in Figure 4.5, you can adjust how the 2D sketch tools work and appear 

in an active sketch. In addition, you can change the preset value for Auto-Bend Radius in the 3D 

Sketch area.
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Figure 4.5

Sketch tab in 

Document Settings

Here are the Sketch tab settings along with a description of their functions:

Snap Spacing  This option allows you to set the spacing between snap points to assist with 

precise layouts. For instance, if you are using Frame Generator to create a steel frame with 

uprights at 2000 mm on center, you might set the snap spacing to 2000 mm and then on the 

Sketch tab in the Application Options dialog box, set the sketch to Snap To Grid. Then, when 

creating your skeletal base sketch, you can set line segments and spacing to 2000 mm with 

precision.

Grid Display  These settings allow you to set the major and minor grid spacing. If Snaps 

Per Minor were set to 2 with the 2000 mm snap spacing used in the previous example, the 

spacing between grid lines would be 4000 mm. If Major Every were set to 5, distance between 

the major grid lines would be 20,000 mm. To display grid lines, you select the Sketch tab 

in the Application Options dialog box.

Line Weight Display Options  These options allow the display of unique line weights in 

model sketches. Note that this does not infl uence line weights in printed model sketches. 

Display True Line Weights displays line weights on-screen as they would appear on paper 

regardless of the on-screen zoom level. Display Line Weights By Range displays line weight 

according to the entered values.

3D Sketch  This area contains only one setting, Auto-Bend Radius. When creating a 3D line, 

you can turn on the Auto-Bend Radius option and have intersecting line corners automati-

cally rounded. This setting controls the default radius at which bends are created. Once they 

are made, the bends can be edited to a different value.

The Modeling Tab

Figure 4.6 shows the Modeling tab, which allows changes to the behavior while modeling the 

current active part. Note that if you are using Inventor LT, some of these settings might vary or 

might not be present.
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Figure 4.6

Modeling tab in 

Document Settings

Here are the settings found on the Modeling tab of the Document Settings dialog box:

Adaptively Used In Assembly  This option is available only when a part is adaptive. When 

it is deselected, an adaptive part becomes static. This setting can also be controlled by right-

clicking an adaptive part in the assembly browser.

Compact Model History  This option allows Inventor to purge all rollback document his-

tory when you save the current fi le. Compacting the model history improves performance in 

large assembly fi les. You should select this option only when performance is affected in large 

assembly fi les or when existing disk space is limited.

Advanced Feature Validation  This option permits Inventor to use a different algorithm to 

compute features. Using this option can produce more accurate feature results in rare cases 

such as Shell, Draft, Thicken, and Offset features. However, this option is slower in calcula-

tion than the default option and should be used only on rare occasions where the accuracy of 

the model may be in question.

Maintain Enhanced Graphics Detail  This option enables graphics information to be saved 

with the fi le on disk. This information is used in the graphics display if the display quality is 

set to Smoother in the Application Options dialog box.

Participate In Assembly And Drawing Sections  When this option is not selected, the part 

will default to None in the section participation settings of an assembly or drawing section 

view. However, you can adjust each instance of the part to section or not section as needed. 

For instance, if you created a part fi le for an O-ring and intended to use it in the design of 
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several shaft assemblies, you could deselect this option in the O-ring fi le to ensure that the 

O-ring remained unsectioned in the section drawing views of the shafts you used the O-ring 

on. If you needed to show a particular section view of the shaft assembly with all parts sec-

tioned, you would do so by setting the section participation settings for the O-ring to section 

in that one section view of the drawing.

Tapped Hole Diameter  This option determines how the size of tapped hole features are 

controlled. Thread representations in drawings are generated correctly only when Tapped 

Hole Diameter is set to Minor.

User Coordinate System  Click the Settings button to access the UCS Settings dialog box, 

where the UCS naming prefi x can be set, the default plane defi ned, and the visibility of UCS 

and its features determined.

3D Snap Spacing  These options establish the spacing between snap points in 3D sketches. 

The settings also control the snap precision when the Move Bodies tool is used to free-drag a 

solid body.

Initial View Extents  These options set the initial visible height and width of the graph-

ics window when you’re creating a model from a template. For instance, if you create a lot 

of steel frames, you may fi nd it helpful to create a template with the setting adjusted so that 

your initial sketch is not always zoomed in to a very small area. Confi gure these settings 

in your template fi les to affect new fi les. You can set the initial height and width of the graph-

ics window. The settings affect only the initial sketch when a template is used. When you’re 

creating a secondary sketch or opening an existing part, the view is controlled by the size of 

the part.

Naming Prefi xing  These options set the default fi le-naming convention for parts generated 

from multi-body part designs. These tools are covered in Chapter 5, “Advanced Modeling 

Techniques.”

Make Components Dialog  Clicking Options in the Make Components Dialog area opens 

the Make Components Options dialog box. The Make Components settings shown in the 

options dialog box are specifi c to the active project. These options are employed when creat-

ing multi-body parts, as described in Chapter 5.

The Bill Of Materials Tab

The Bill Of Materials tab determines the structure of the current fi le and how that structure 

relates to the bill of materials in an Inventor assembly. Figure 4.7 shows the default settings for 

structure and quantity.

You can add BOM structure properties to individual parts in the Document Settings dialog 

box. Figure 4.7 shows the choices available in a model or assembly fi le for setting individual fi le 

properties. Here are the details:

Normal  These components are given an item number and included in quantity calcula-

tions. The placement of normal parts in the bill of materials is determined by the parent 

assembly properties. A normal subassembly may be composed of any combination of insepa-

rable, phantom, purchased, and reference parts without having any effect on how those parts 

are listed in the BOM. Normal is used for most components.
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Inseparable  These components are assemblies that allow the inclusion of press-fi t, glued, 

welded, or riveted components that might be damaged if taken apart. A good example is a 

hinge that is fully assembled but should be listed in the BOM as a single part. Although the 

Inseparable structure is listed in the part’s Document Settings dialog box, it is intended as an 

assembly property.

Purchased  These components are parts that are not normally fabricated or manufactured 

by your company, but instead purchased from vendors. Any purchased component, whether 

part or assembly, will be listed in a parts-only parts list. A purchased component assembly 

will not normally have the component parts listed in the BOM because that component will 

be purchased as a single unit.

Phantom  These components exist in the design, but are not included as specifi c line items 

in the BOM. A construction assembly that exists as a container (subassembly) within a 

higher-level assembly, simply to hold a number of components together for assembly pur-

poses, can be set to Phantom. When this assembly is set to Phantom, it will not appear in 

the parts list; however, the parts included within the construction assembly will be listed as 

individual parts. Phantom components are ignored by the BOM. No item number is assigned, 

and no quantity calculations are performed on the phantom assembly. However, the quantity 

of individual parts contained within the phantom assembly will be multiplied by the quan-

tity of the phantom component included in the top-level assembly.

Reference  These components are used to provide reference information within an assem-

bly design. An example of a reference part might be a product container placed in a conveyor 

assembly. The conveyor components are the parts and assemblies you are designing, but the 

container is required to ensure the clearance and function of your design. In a drawing, ref-

erence parts will be indicated in the view as hidden line geometry. Reference components are 

excluded from the BOM and are excluded from quantity, mass, and value calculations.

Base Quantity  Use this to change how the parts Base Quantity property is displayed in the 

BOM or parts list. You can change the value from Each to any parameter, such as one called 

Length. You will fi nd that components generated by the Frame Generator tools are automati-

cally set to use a length parameter for the base quantity. Once a parameter is selected, you 

can change the Base Unit, from mm to M for example.

Figure 4.7

Bill Of Materials 

tab in Document 

Settings
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The Default Tolerance Tab

Figure 4.8 shows the Default Tolerance settings. Creating tolerance values affects sketches and 

parts only. When you add tolerance values to a part fi le, you can select either Use Standard 

Tolerancing Values or Export Standard Tolerance Values, or you can select both options.

Figure 4.8

Default Tolerance 

tab in Document 

Settings

You can select the Use Standard Tolerancing Values box to use the precision and tolerance 

values set in this dialog box. You can select the Export Standard Tolerance Values box to export 

tolerance dimensions to the drawing environment.

Once you’ve selected an option, you can then add linear or angular tolerance values. You can 

add any number of tolerance values by precision to this part. When you have added your values 

to the part, click the Apply button to stay in the dialog box and apply the new settings to this 

tab, or click the OK button to apply the settings and exit the dialog box. Chapter 5 covers the use 

and setup of part tolerances in more detail.

Key Concepts for Creating Basic Part Features
Inventor 3D part modeling is based on the principle of creating a base feature and then adding 

features to the base feature to build a more complex part. Figure 4.9 illustrates the basic work-

fl ow for creating a part composed of multiple features.

Figure 4.9

Part-creation 

workfl ow Create 2D
Sketch

Create
Base Feature

Create
New Feature

Completed
Part

Create New
Sketch
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Create Your Own Template Files

Th is may seem like a lot of settings, and it’s true there are a lot, but you need to set them only once. 

Open a template, adjust all your settings the way you want them for a particular type of part (for 

instance, an inch unit part), and then use the Save Copy As Template option. Your settings will then 

be available in a template when you create a new part. Make another template for metric parts. 

Make another for sheet-metal parts, and so on, as you like. You can make as many as you think 

you’ll use, each with its own set of document settings specifi c to the template.

A good idea is to make a folder in your template directory named, for example, My Templates, and 

store all your templates in it. Th is folder (and any other folder in the template directory) will show 

up as a tab in the New File dialog box. Th is way, you will still have access to Inventor’s standard 

templates as well as your custom templates.

You can set the template fi le location in two places:

 ◆ On the Tools tab of the ribbon, click Application Options, and select the File tab in the dialog 

box that opens.

 ◆ On the Get Started tab of the ribbon, click Projects, and select the Folder Options entry in the 

dialog box that opens.

Keep in mind that if the settings in these two locations are not the same, Inventor will use the 

Projects setting.

As you create parts in Inventor, keep in mind the following concepts because each will go a 

long way toward making your modeling endeavors more productive:

 ◆ Anchor and orient your base sketch to the 0,0,0 origins of the part fi le. This will make your 

parts much easier to manage as you go forward. The base feature will generally be the larg-

est feature in the part, unless you have a specifi c reason for not making it so.

 ◆ Look for areas of your design that are likely to change, and create your part features to 

accommodate these future edits. For example, the plate thickness might change as loads 

are determined throughout the rest of the design. Creating the plate sketch from the end 

view and then extruding the length would make it easy to modify the length of the plate, 

but not as easy to modify the thickness. Therefore, a better choice would be to create the 

base sketch of the top view and extrude the thickness.

 ◆ Identify relationships between design parameters. For instance, there may be a require-

ment that the distance from the edge of a part to the edge of a bolt hole always has to be two 

times the diameter of that hole. You can set that formula directly in the distance dimen-

sion, and then whenever you change the hole diameter, the distance from the edge adjusts 

automatically.

 ◆ Keep an eye out for patterned and symmetrical design features. It is much easier to create 

and modify the fi rst instance of a pattern than it is to edit several identical features that 

were created separately.

 ◆ Build logical feature dependencies. Features are considered dependent on other part 

geometry when you cannot delete or modify a portion of the part or feature without affect-

ing another feature built later in the part. For example, if you were to create a simple block 
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and then create an additional feature on that block, you could not delete the block without 

upsetting the new feature.

 ◆ Because fi llets and chamfers often change, it is best to place them at the end of the design 

process as much as possible. Placing them at the beginning and then having to change 

them is likely to upset other features you have created afterward that might depend on the 

fi lleted or chamfered edges.

 ◆ Create simple sketches to create simple features to create complex parts. Using numerous 

features within a 3D model allows simplifi ed control over modifi cations of the model in the 

future. Separate features may be suppressed or modifi ed to alter the design without having 

to make changes in a complicated sketch. Instead of attempting to create all the geometry 

in a single sketch, analyze the proposed part fi rst and create a simple base sketch for the 

fi rst feature.

Consider Modeling vs. Machining

Although the “design as you’d manufacture” paradigm is a great philosophy to follow when creating 

3D parts, there are diff erences between modeling and machining. One major diff erence is that you 

have the ability to add material when modeling, whereas a machining operation only takes away 

material. Deciding which route to take depends on what resources are available in your shop and 

how much time you have.

Modeling and machining are important subjects to consider when designing parts. Inventor off ers 

a lot of features that may make it easy to design a part that might be impossible or at least very 

expensive to make with the tooling equipment your shop has available. In some cases, although a 

part may be easier to model as one piece, it might be less expensive to machine as multiple pieces. 

Also, consider the size of the equipment and tooling, such as end mills and drills, when creating 

parts. For example, in Inventor you can create very small fi llets or square corners in a design, but 

try to machine a 0.010 inch fi llet in a cavity that is 3 inches deep, and you’ll likely earn a scolding 

from the people on the shop fl oor who are required to turn your design into reality.

One example for how to make a realistic design for your shop is the fi xture block, as shown here. If 

a CNC machine center is available, this simple part is easy to model in Inventor and not a problem 

to create in the shop.
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However, without a CNC approach, even this simple model might prove to be diffi  cult and/or 

expensive to produce by more traditional machining techniques. Reconsidering the design to 

match the shop’s abilities will be required. In this case, you might consider a sandwich block 

design of simple parts welded and fastened together to achieve the same end result, as shown 

here.

Although this might require more thought and planning on your part within Inventor, it will make 

the design achievable with the tools and technology at hand. Often the best resource for helping 

you determine what your shop’s capabilities are will be the people who will be making the parts.

Simplifying Your Sketches
When learning to master creating parts in Inventor, there is probably no concept more impor-

tant than the idea of creating simple sketches from which to build simple features that will add 

up to create complex parts. Standard 2D drafting practice requires you to place all part details or 

components within a single view. However, it is not good practice to use the same 2D drafting 

workfl ow within any feature-based 3D modeler. Complicated sketches can drag down sketch-

ing performance and virtually eliminate easy changes to features. Consider the part shown in 

Figure 4.10. This illustration shows the base sketch that is then revolved to form the shaft.

Figure 4.10

A complex sketch 

for a revolved part

Now compare the same part modeled using the simple-sketches approach shown in 

Figure 4.11.

The version in Figure 4.10 would prove diffi cult to modify, because of the number of sketch 

constraints and dimensions required to create it. Most likely a seemingly simple change would 

result in some part of the sketch breaking. By comparison, the version in Figure 4.11 would be 

easy to modify because each feature is broken out into its own sketch or placed feature.



144 | CHAPTER 4 BASIC MODELING TECHNIQUES

Of course, sometimes creating a more complex sketch is required, but if you follow the 

simple-sketch rule of thumb, you will fi nd Inventor much more accommodating, and you will 

quickly master part creation and be ready to tackle complex sketches when they are needed.

At the end of this chapter you will fi nd an exercise that builds a part by fi rst creating a simple 

sketch and constructing a base feature from it. The exercise continues adding simple features 

to build complexity into the part. But before you get to that exercise, you’ll fi nd several shorter 

exercises exploring many of the tools used to create part features. If you have not already down-

loaded the Chapter 4 fi les from www.sybex.com/go/MasteringInventor2014, please refer to the 

“What You Will Need” section of the Introduction for the download and setup instructions.

Figure 4.11

Simple sketches and 

placed features cre-

ate a revolved part

Create
Sketch

Revolve

Revolve
Cut

Fillet

Pattern

Create
Sketch

Exploring the Extrude Tool
The Extrude tool allows you to add volume to a closed sketch profi le to create a 3D solid, or to 

add length to an open sketch profi le to create a 2D or 3D surface. You can also use the Extrude 

tool to create cutouts in solids.

To truly master the Extrude tool you have to understand several options. In the next several 

pages, you will open a series of fi les that have been set up to demonstrate the various options 

available to you. You can fi nd all of these fi les in the Chapter 04 directory of your Mastering 

Inventor 2014 folder.

http://www.sybex.com/go/MasteringInventor2014
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Marking Menus

If you have the marking menus enabled and customized, you should be prepared to interpret the 

instructions in this book concerning right-clicks to match what you see on-screen.

If you prefer, you can disable the marking menu and use the classic context menu by clicking the 

Customize button on the Tools tab. On the Marking Menu tab, you will fi nd an option called Use 

Classic Context Menu.

Extruding Basic Features
The Extrude tool is often used to create base features on which other features are created. To 

explore the creation of a base extrude feature, follow these steps:

 1. Open the fi le mi_4a_008.ipt.

 2. Click the Extrude button found on the 3D Model tab (or press E on the keyboard).

Because the sketch in this part fi le contains fi ve profi les from which you can choose, the 

Extrude tool requires you to select the profi le or profi les you want to extrude. Note that the 

large, dashed circle in the center of the hexagon is not recognized as a profi le because it is set 

as a construction line in the sketch.

Use Sketch Center Points to Create Profiles

In Sketch1 of mi_4a_008.ipt you might have noticed the presence of four sketch center points at 

the intersection of the hexagon and the two circles. Sketch center points placed at the intersection 

of overlapping profi les allow Inventor to see the profi le as separate sketch profi les, without the 

need to split or trim the sketch geometry.
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 3. Hover your cursor over each profi le to see it highlight.

 4. Click in the center of the hexagon, and you will see a preview of the extrusion that will be 

created from this profi le.

 5. Click and drag the arrow at the center of the preview to change the extrusion distance 

and/or direction.

 6. Use the Flip button to change the direction of the extrusion so that it goes down away 

from the sketch, as shown in Figure 4.12.

Figure 4.12

Creating a base 

extrude feature

 7. Set the extrude Distance to 25 mm and then click the OK button.

Notice that a feature called Extrusion1 has been created in the Model browser tree. If you 

click the plus symbol next to it, you’ll see that Sketch1 is listed under it, because Extrusion1 

consumes Sketch1.

 8. Locate Sketch2 in the Model browser and right-click it; then select Visibility to turn this 

sketch on.

 9. Click the Extrude button found on the 3D Model tab (or press E on the keyboard).

 10. Set the extrude Distance to 60 mm and ensure the direction is facing up, as shown in 

Figure 4.13; then click the OK button.

Figure 4.13

Creating a second-

ary extrude feature

Creating basic extrusions from a sketch profi le is quite a simple operation and one that you 

will use often in creating your designs. You can close the part without saving changes and 

continue to explore the Extrude option.
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Direct Manipulation Tools

Th e Direct Manipulation toolset is a set of user interface tools that enable you to modify a model 

while viewing the changes in real time. Th e buttons on the in-canvas display correspond to the but-

tons and inputs found in dialog boxes and menus. You can choose to use the Direct Manipulation 

tools, or you can use the traditional dialog boxes and menus to achieve the same result.

Th e Direct Manipulation In-Canvas Display consists of selection tags , manipulator arrows, value 

input boxes, and mini toolbars.

Selection Input

Manipulator Arrow

Value Input Box

Mini Toolbars

Once you become comfortable with the Direct Manipulation tools, you can use the arrow at the 

bottom of the dialog box of each tool and choose to roll it up to save screen space. Note that you 

cannot disable the Direct Manipulation tools.

One tip to be aware of is the ability to pin the direct manipulation mini-tools in place. For instance, 

you can drag the mini-toolbars to upper-right corner of your graphics screen, near the ViewCube, 

and then use the options menu pull-down button to select the Pin Mini-Toolbar Position option. 

Doing so will ensure that these tools will appear in this location each time you use the tool.
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Editing an Extrusion Feature
Once you create extrusions, you can quickly and easily modify them by using the same inputs 

used to create the original feature. In this next exercise you’ll open an existing part and edit an 

extrusion feature in order to change the length of the part:

 1. Open the fi le mi_4a_009.ipt. 

 2. Locate the feature named Extrusion2 in the Model browser, and then double-click it or 

right-click and choose Edit Feature.

 3. Set the Distance to 100 mm and then click the OK button.

 4. Expand the Extrusion1 node in the browser to reveal Sketch1.

 5. Right-click it and choose Edit Sketch, or double-click it to edit the sketch.

 6. Edit the Hex_Size dimension by right-clicking or double-clicking it, and then set it to 30 mm.

 7. Click the Finish Sketch button to exit the sketch and set the change.

Making edits to existing extrusions features is as simple as editing the extrusion feature 

or sketch used to create them. You can close the part without saving changes and continue to 

explore the Extrude option.

Extruding with Cut and Taper
You can use the Extrude tool’s Cut option to remove material from your parts. Although you 

may think of this as a tool to create holes, keep in mind that Inventor’s Hole tool is the better 

choice to create standard holes because of the advanced detailing functions that accompany the 

Hole tool. With that said, the Cut option in the Extrude tool will allow you to cut material using 

any sketched profi le that you might come up with. To explore the Taper option in the Extrude 

tool, follow these steps:

 1. Open the fi le mi_4a_010.ipt.

 2. Click Extrude on the 3D Model tab (or press E on the keyboard).

 3. Select the rectangle shape for the extrude profi le, and set the distance to 20 mm.

 4. Choose the Cut option, and just drag the manipulator arrow down into the part; notice 

that the preview turns red and the direction automatically switches. Change the direc-

tion so the preview is going up out of the part, and then click the OK button.

 5. Note that an error is generated, and it states that the feature you specifi ed did not change 

the number of faces. Keep this in mind as you use the Extrude tool. Inventor will gener-

ally set the correct direction for you, but occasionally you might need to set the direction 

manually. Click Edit to return to the extrude options.

 6. Change the direction again so you are indeed cutting the part, and adjust the distance to 

20 mm as required.

 7. Click the sphere on the manipulator arrow or click the More tab, as shown in Figure 4.14.

 8. Enter -12 in the Taper input box, and click the OK button. When fi nished, you can close 

the part without saving changes.

Certification
Objective



EXPLORING THE EXTRUDE TOOL | 149

Figure 4.14

A tapered cut 

extrusion

Extruding with Intersect
So far you have created extrusion features using the Join option and the Cut option. Next, you 

will use the Intersect option of the Extrude tool to modify an existing solid. You can create com-

plex shapes by sketching an intersect profi le and then using the extrude Intersect option to keep 

the combined volume of the existing solid and the sketch profi le, as shown here:

 1. Open the fi le mi_4a_012.ipt.

 2. Click Extrude on the 3D Model tab (or press E on the keyboard).

Rather than cutting the small profi les out of the existing part, you’ll use the Intersect option 

to discard all areas of the part that are not common between the existing part and the current 

sketch.

 3. Select the large H-shaped sketch profi le.

 4. Change the Extents drop-down from Distance to All.

 5. Click the Intersect button, make sure the extrude direction is going down through the 

existing part, and then click the OK button.

 6. Click the end-of-part marker in the Model browser and drag it down below the sketch 

called Slot Locations so the Slot Locations sketch is visible and available for use.

This sketch is made up of several small slots. You could select each slot and cut it from the 

existing part, but doing so would be time-consuming and subject to a missed selection, 

which will give you errant results. So instead, you’ll use the Intersect option to choose the 

area between the slots.

 7. Click Extrude on the 3D Model tab (or press E on the keyboard).

 8. Select anywhere in the rectangular sketch profi le so the selection results in a rectangle 

with the slots omitted.

 9. Change the Extents drop-down from Distance to All.

 10. Click the Intersect button, make sure the extrude direction is going down through the 

existing part, and then click the OK button.
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Figure 4.15 shows the progress of the part using the Intersect option to refi ne its shape.

Figure 4.15

A complex shape 

generated using the 

intersect extrusion

For another example of using the Intersect option, have a look at using it to create the tapered 

corners on a common hex head bolt, as demonstrated in the following exercise:

 1. Open the fi le mi_4a_013.ipt.

 2. Click Extrude on the 3D Model tab (or press E on the keyboard).

 3. Select the visible sketch for the extrude profi le (if it’s not automatically selected).

 4. Set the distance to 100 mm.

 5. Click the Intersect button, and make sure the extrude direction is correct. You want the 

extrusion going down though the bolt head and shaft.

 6. Click the sphere on the manipulator arrow or click the More tab in the dialog box.

 7. Enter 30 in the Taper input box, as shown in Figure 4.16, and click the OK button.

Figure 4.16

A tapered 

intersection 

extrusion

Your extrude options create a cone with a 30° taper, and the Intersect option keeps only the 

volume of the part shared by the existing features and the intersect cone feature, in this case 

the entire bolt except the tapered corners of the hex head. When fi nished, you can close the part 

without saving changes.

Extruding Surfaces from Open Profi les
In addition to creating solids with the Extrude tool, you can create surfaces. If the profi le is open 

and there is no other geometry to relate to, the surface solution is automatically selected. For 
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closed profi les, you are required to switch the output from solid to surface manually, as 

shown here:

 1. Open the fi le mi_4a_014.ipt.

 2. Select the Extrude button from the 3D Model tab (or press E on the keyboard).

 3. The visible shape will automatically be selected because it is the only available profi le. 

Because it is found to be an open profi le, the Surface output is automatically selected 

as well.

 4. Change the distance to 25 mm.

 5. Set the direction arrow to the symmetric option so that the surface is extruded out in 

both directions from the profi le, as shown in Figure 4.17. Then click the OK button.

Figure 4.17

Extruding an open 

profi le sketch to 

create a surface

 6. To explore how to create a surface extrusion from a closed profi le, right-click Sketch2 in 

the browser, and turn on the visibility.

 7. Select the Extrude tool, and notice that Inventor automatically selects the profi le and sets 

the output to Solid in the dialog box.

 8. Click the Surface button to change the output to an extruded surface, and then change 

the Extents option to To.

 9. Doing so allows you to specify a point or surface to extrude to. You might notice that the 

surface created in the previous step was created in two halves. Select the arc-shaped half 

(rather than the spline-shaped half), and notice that the preview terminates as if the arc 

half-wrapped around.

 10. Deselect the check box next to the To selection arrow (the Terminate Feature On Extended 

Face check box), and you will notice that the preview terminates at the farthest extent of 

the selected surface, matching the spline shape.

If you receive an error stating that the attempted surface did not terminate the toolbody, 

review step 5 and ensure that your fi rst extrusion was set to extrude symmetrically from the 

original sketch.

 11. Click the OK button to create the extruded surface.
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Figure 4.18 compares the two termination solutions when using the To option. Keep in mind 

that although this example used surface extrusions, the To option works the same for solids. You 

can close the fi le without saving changes.

Figure 4.18

Extruding a surface 

to terminate at the 

farthest extent of 

another surface

Extruding Solids from Open Profi les
In addition to extruding surfaces from open profi les, you can extrude solids, provided suffi cient 

geometry is present to allow the open profi le to solve correctly. This technique employs the 

Match Shape option and is the default solution when an open profi le is selected in the Extrude 

tool while the solid output is selected. Follow these steps:

 1. Open the fi le mi_4a_016.ipt.

 2. Select the Extrude button from the 3D Model tab (or press E on the keyboard).

 3. Click the arc profi le, and notice that the Match Shape check box is automatically selected 

in the dialog box; in addition, the preview has extended the arc down toward the plate to 

provide a closed profi le.

 4. Click in the highlighted profi le to select it.

 5. Change the Extents drop-down to Distance and enter 60 mm.

 6. Set the direction to go into the base plate feature, and click the OK button. Your result 

should look like Figure 4.19. You can close the fi le without saving changes.

Figure 4.19

Extruding an open 

profi le

To take a look at the Match Shape option and how it can be used to change the output, you’ll 

open a fi le that has two possible solutions for the fi nal matched shape. One solution will match 

Certification
Objective



EXPLORING THE EXTRUDE TOOL | 153

the shape of the existing geometry, and the other will not. Follow these steps to see how this 

works:

 1. Open the fi le mi_4a_018.ipt.

 2. Select the Extrude button from the 3D Model tab (or press E on the keyboard).

 3. Click the visible profi le sketch in the center of the part.

 4. You’ll notice that Inventor attempts to create a closed profi le from this open profi le by 

extending the profi le past the extents of the existing geometry. Select the profi le on the 

side with the grid feature.

 5. Change the Extents drop-down to Distance, enter 1 mm, and click the OK button. Notice 

how the extrusion fi lls the shape of the part.

 6. Edit the extrusion you just created, and deselect the Match Shape box in the dialog box. 

Then click the OK button.

 7. You’ll notice that the extrusion runs through the grid feature, ignoring the shape.

Figure 4.20 compares the results of an open profi le extrusion with and without the Match 

Shape option selected. You can close the fi le without saving changes.

Figure 4.20

Match Shape option 

for open profi le 

extrudes

Extruding with To
It is often helpful to extrude to existing geometry rather than entering a distance value. In this 

way, if the existing feature changes, so too will your extrusion. When you use the Extrude To 

option, you can extrude to faces and vertices as well as work planes and work points. In the 

following exercise, you’ll explore the Extrude To option:

 1. Open the fi le mi_4a_020.ipt.

 2. Select the Extrude button from the 3D Model tab (or press E on the keyboard).

 3. For the profi le, select one of the rectangular profi les.

 4. Change the Extents drop-down from Distance to To.

 5. Select the yellow face, and click the OK button.
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You will receive an error stating that the termination plane does not completely terminate the 

profi le, because of the way that the yellow face would wrap around in a circle if extended.

 6. Click the Edit button in the error dialog box to return to the Extrude dialog box.

 7. Uncheck the Terminate Feature On Extended Face check box in the Extents area, as 

shown in Figure 4.21, and then click the OK button.

Figure 4.21

Extruding to an 

extended face

 8. Use the Extrude tool and select the remaining rectangle.

 9. Change the Extents drop-down from Distance to To.

 10. Select the red face, and you will see that the preview terminates along the extended 

red face.

 11. Uncheck the Terminate Feature On Extended Face check box in the Extents area, and you 

see the preview extend to the yellow face.

 12. Click the OK button to create the extrusion. You can close the fi le without saving changes.

Although in this case the results of the two extrusion features are the same, you can see that 

the selected termination face and the termination check box can provide different results, when 

used in combination.

Follow these steps to take a look at some other Extrude To options:

 1. Open the fi le mi_4a_022.ipt.

 2. Select the Extrude button from the 3D Model tab (or press E on the keyboard).

 3. For the profi le, select one of the ellipse-shaped profi les.

 4. Change the Extents drop-down from Distance to To. Select the yellow face, and ensure 

that the Terminate Feature On Extended Face check box is checked. In this case, you 

would receive an error if this check box were not selected, Figure 4.22 shows the correct 

selections.

 5. Click the OK button, and you’ll see that the ellipse face takes on the angle of the face to 

which you extruded.
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 6. Use the Extrude tool again, select the other ellipse profi le, and change the Extents drop-

down from Distance to To, once again. This time select the work point for the terminating 

object, and click the OK button.

 7. You’ll see that the ellipse extrudes up to the work point height, as shown in Figure 4.23. 

Figure 4.22

Extruding to a face

Although in this case you’ve used a work point to extrude to, often you can use the vertex 

point of an existing feature to extrude to. Feel free to experiment with this part and extrude 

shapes to an existing point on the yellow face. When fi nished, you can close the fi le without sav-

ing changes.

Figure 4.23

Extruding to a 

point

Extruding with the Minimum Solution Option
Often when extruding to a cylindrical face, you will need to set the extrusion to solve for the 

minimum solution since the face is continuous all the way around. To do this, follow these steps:

 1. Open the fi le mi_4a_024.ipt.

 2. Select the Extrude button from the 3D Model tab (or press E on the keyboard).

 3. For the profi le, select the hex-shaped profi le.
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 4. Change the Extents drop-down from Distance to To, select the outside face of the 

cylinder, and then click the OK button.

You will notice that the hex shape stops at the closest face of the pipe. This is because the 

Minimum Solution option is the default. However, if the goal were to extend the profi le to 

the farthest extent of the cylindrical face, you would need to adjust the settings to the farthest 

extent of the cylindrical face.

 5. To fi x this, edit the extrusion you just created, and click the More tab (or click the sphere 

on the on-screen manipulator arrow).

 6. On the More tab, select the Minimum Solution check box, as shown in Figure 4.24, and 

then click the OK button.

Figure 4.24

Extruding to the 

minimum solution

You’ll see that without the Minimum Solution option selected, the extrusion extends to the 

far side of the selected face. You can close the fi le without saving changes.

Extruding with To Next
Similar to extruding to a selected entity, you can use the To Next option and let Inventor auto-

matically select the next available surface or face for you. It should be noted that solutions with 

through voids may not work with this option. To explore the Extrude tool’s To Next option, fol-

low these steps:

 1. Open the fi le mi_4a_026.ipt.

 2. Select the Extrude button from the 3D Model tab (or press E on the keyboard).

 3. For the profi le, select the rectangular profi le marked Profi le1.

 4. Change the Extents drop-down from Distance to To Next, and click the OK button.

 5. Repeat the same steps for Profi le2. When you click the OK button, you will receive an 

error because the extrusion cannot build to this solution.

 6. In the error message dialog box, click the Edit button, and then set the extrude 

extents to To.

 7. Select the back (yellow) face for the face to extrude to, and then click the OK button.

Oftentimes the geometry may require a bit of experimenting to achieve the solution you 

want. Just knowing the abilities and limitations of each option goes a long way toward knowing 
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how to proceed. You can close the fi le without saving changes. Figure 4.25 shows the results of 

using the To Next option.

Figure 4.25

Extruding with 

To Next

Extruding Between
You may need to defi ne the beginning and the end of an extrusion that are not common to your 

sketch plane. To do this, you can use the Between option:

 1. Open the fi le mi_4a_028.ipt.

 2. Select the Extrude button from the 3D Model tab (or press E on the keyboard).

 3. For the profi le, select Circle.

 4. Change the Extents drop-down from Distance to Between.

 5. Select both pipe-shaped pieces to defi ne the From and To options.

 6. Because you are extruding to hollow objects, you’ll need to use the Minimum Solution 

option. Click the More tab, and make sure the Minimum Solution check box is selected.

 7. Flip the direction using a direction button next to the Minimum Solution check box. Click 

the OK button.

Figure 4.26 shows the results of using the Between extents option. You can close the fi le 

without saving changes.

Figure 4.26

Extruding with 

Between
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Extruding Multi-Body Solids
You may have noticed a couple of other buttons in the Extrude dialog box, one called Solids and 

the other called New Solid. Figure 4.27 shows both buttons in the dialog box. These options 

allow you to create separate solid bodies within the part or choose which existing solid bodies 

to modify.

Figure 4.27

Multi-body solid 

options

1

2

The fi rst option allows you to select the solids you want to modify. Use this when selecting 

multiple solid bodies in which to create a cutout feature, for instance.

When selected, the second option allows the Extrude tool to create a separate solid body, 

rather than creating a feature of an existing solid. Separate solids can then be moved, rotated, 

colored, and modifi ed individually.

To explore the multi-body extrude options, follow these steps:

 1. Open the fi le mi_4a_030.ipt.

 2. Select the Extrude button from the 3D Model tab (or press E on the keyboard).

 3. For the profi le, select the visible rectangular sketch profi le (if it is not automatically 

selected).

 4. Change the Extents drop-down from Distance to To, and select the yellow face on the 

existing part feature.

 5. Click the New Solid button, as shown in Figure 4.28, to set this extrusion as a separate 

solid body and then click the OK button.

Because you used the New Solid option, you now have a part fi le with two separate solid 

bodies. You can expand the Solid Bodies folder in the browser to identify each one, as 

shown in Figure 4.29. Currently, the second solid interferes with the fi rst and needs to be 

dovetailed to fi t.

 6. From the Modify panel of the 3D Model tab, select the Combine button.

 7. Choose the new solid for the Base selection and choose the original solid (the one with 

the yellow face) as the Toolbody selection.
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 8. Set the operation to Cut (middle button).

 9. Select the Keep Toolbody check box and then click the OK button.

You should see the original solid disappear, and the new solid result in a dovetail where it 

intersected with the fi rst. Expand the Solid Bodies folder and ensure that you have two 

solid bodies still. If not, use the Undo button and repeat steps 6 through 9.

 10. Right-click either of the solids, and choose Show All to turn the visibility of the solid 

back on.

Next you’ll use an existing sketch to cut a notched edge into both of the solid bodies at the 

same time.

 11. Locate the sketch named Base Inset Sketch in the Model browser, right-click it, and select 

Visibility.

 12. Use the Extrude tool, set to Cut, and then use the Solids button (found under the Profi le 

button) to select both dovetailed bodies.

 13. Set the distance value to 3 mm and then click the OK button.

Figure 4.28

A multi-body part

Figure 4.29

Multiple solid 

bodies in the Solid 

Bodies folder

You can use the ViewCube to examine the resulting cut. You’ll learn more about multi-body 

parts in Chapter 5, including how to use the Make Components tool to write out each solid body 

as an individual part fi le. You can close the fi le without saving changes.
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Creating Revolved Parts
Creating turned and revolved parts is a regular occurrence in many engineering departments 

because of the types of parts designed and manufactured. The parts consist of circular features 

around a common axis. There are two different workfl ows for creating circular parts, each with 

its own advantages and disadvantages. Creating threads on a part presents another challenge.

You can create circular parts using a single sketch and revolving it around a centerline axis. 

Alternatively, you can create multiple circular extrusions to produce the same part.

There are also two different workfl ows for creating threaded features on a part. You can add 

threaded features to any circular component by means of the Thread feature, which creates cos-

metic threads on the part, or through the use of the Coil feature, which creates physical threads. 

Typically, physical threads are created only when that geometry is required for the model. 

Generally, using cosmetic threads is suffi cient because they are an intelligent feature that can be 

retrieved in the detail drawing of the part and called out as per the specifi cations of the feature.

Revolved Cylindrical Parts vs. Stacked Circular Extrusions
Revolved cylindrical parts utilize a sketch with a center axis. Figure 4.30 illustrates two ways to 

create the same sketch. The view on the left shows a sketch profi le anchored at the origin and 

dimensioned from the origin. The view on the right illustrates the same sketch anchored at the 

origin but dimensioned from a created centerline, which creates diametric dimensions. The 

two sketches will create the same revolved feature, the difference being that the centerline 

allows you to dimension the sketch using diameter dimensions to maintain the design intent 

of the part.

Figure 4.30

Dimension to 

the sketch vs. 

centerline

You create the centerline by using the Line tool with the Centerline tool toggled on. In this 

example, the centerline was created starting at the origin point and continuing to the right of 

the sketch, extending beyond the sketch for selection ease. When dimensions are created on the 
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sketch and terminated at the centerline object, they will actually extend to the other side of the 

revolved part diameter.

You could create most revolved shapes by extruding sketched circles as well, but it’s often 

best to use a revolve feature instead. The advantage of creating a revolved profi le rather than 

creating stacked circular extrusions is that the relationship of every portion of the sketch can be 

easily visualized from the start. The disadvantage is that a contour sketch is not always easily 

edited to remove or change a portion of the feature. In addition, if the sketch is not fully dimen-

sioned and constrained, it can create errors down the line with faces and edges. For this reason, 

you should always fully dimension and constrain your sketches. Figure 4.31 shows the same 

part modeled using both approaches.

Figure 4.31

Revolved circular 

feature vs. stacked 

circular extrusions

Creating Revolved Parts
Revolved features can be used to create parts or features, and they can be created as solids or 

surfaces. Follow these steps to see how revolves are created:

 1. Open the fi le mi_4a_032.ipt.

 2. Select the Revolve button on the 3D Model tab.

 3. For the profi le, select the rectangular sketch profi le and the small circle.

 4. Click the Axis button in the Revolve dialog box, and then select the line indicated on the 

part for the axis.

 5. Set the operation to Cut so that you are milling out the revolved profi le.

 6. By default the Extents drop-down is set to Full, giving you a 360-degree revolve. In this 

part, though, a full revolve cut would cut away a portion of the existing part. So you will 

set the Extents drop-down to Angle instead. Notice the other extents options available. 

They should all look familiar as options from the Extrude tool.

 7. Set the angle to 180, and then click the OK button. Figure 4.32 shows the revolve options.

This demonstrates how to create a revolved cut at a specifi ed angle. You can close this fi le 

and continue on to explore the use of the Revolve tool to create surface features.
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Figure 4.32

Revolving a cut 

feature

Next, you’ll use the Revolve tool on an open profi le to create a revolved surface. You’ll then 

use a tool called Thicken to turn the surface into a solid.

 1. Open the fi le mi_4a_034.ipt.

 2. Before creating the revolve feature, you need to supply the sketch with some missing 

dimensions. To do so, right-click Sketch1 in the browser, and choose Edit Sketch.

 3. Place dimensions from the points shown in Figure 4.33 to the centerline, and you’ll 

notice that because the line is a centerline type, the dimensions are automatically diam-

eter dimensions. Before placing the dimension, you can right-click and choose Linear 

Dimension if a diameter is not the correct choice.

Figure 4.33

Adding dimensions 

to a centerline

 4. Once you’ve added the dimensions, click the Finish Sketch button, and click Revolve on 

the 3D Model tab.

 5. For the profi le, select the sketch profi le.

 6. Click the Axis button, and then select the centerline.

 7. Because the sketch was an open profi le, the Surface output is automatically selected. Click 

the OK button to create the revolved surface.

 8. Next, you’ll add some fi llets. On the 3D Model tab, click the Fillet button, and click the 

intersecting circular edges on the surface feature.
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 9. In the Fillet dialog box, change the radius to 12 mm, and then click the OK button.

 10. In the surface panel on the 3D Model tab, click the Thicken/Offset button.

 11. Click the Quilt option in the Thicken/Offset dialog box to allow you to select all the sur-

face faces at once, and then click anywhere on the surface. Then click the OK button.

 12. Rotate the part or use the ViewCube, and you’ll see that the surface is still visible. Locate 

it in the Model browser, and then right-click and turn its visibility off. Figure 4.34 shows 

the revolved shape.

Figure 4.34

A revolved and 

thickened surface

Creating Work Features
A work feature is construction geometry used when part geometry is not present to create new 

features. There are three types of work features: work planes, work axes, and work points. In 

addition to work features that you might create, each part contains origin planes, axes, and 

an origin point. You can view these by expanding the Origin folder in the Model browser, as 

shown in Figure 4.35, right-clicking each feature, and selecting Visibility. Note that in Figure 4.35 

the 3D indicator arrows have been drawn in for clarity. If it helps you, though, you can turn the 

indicator on and have it display in the lower left of your screen by selecting the General tab of 

the Application Options dialog box.

Figure 4.35

Origin work 

features turned on
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Work Planes
A work plane is an infi nite construction plane that is parametrically attached to a feature or 

features, typically to help you defi ne other geometry. Work planes are created based on the 

geometry you select. Every work plane type is created by defi ning a location and an orientation. 

You can use the generic Plane button to create work planes or use the buttons found in the Plane 

drop-down menu. The following brief exercises will demonstrate the creation of each type of 

work plane.

Midplane between Two Parallel Planes

 1. Open the fi le mi_4a_040.ipt.

 2. Click the Plane button found on the Work Features panel.

 3. Select the yellow faces on each side of the part, and you will see a work plane placed 

halfway between them.

Three Point

 1. Open the fi le mi_4a_041.ipt.

 2. Click the Plane button found on the Work Features panel.

 3. Select the corner vertices indicated by the yellow corner faces, and a work plane will be 

created using these three points.
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Normal to Axis through Point

 1. Open the fi le mi_4a_042.ipt.

 2. Click the Plane button found on the Work Features panel.

 3. Select the corner vertex indicated by the yellow corner pointer face at the sharp point and 

the edge indicated by the other, and a work plane will be created using these two points.

Parallel to Plane through Point

 1. Open the fi le mi_4a_043.ipt.

 2. Click the Plane button found on the Work Features panel.

 3. Select the corner vertex indicated by the yellow corner pointer face at the sharp point and 

the large yellow face, and a work plane will be created using these two points.
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Two Coplanar Edges

 1. Open the fi le mi_4a_044.ipt.

 2. Click the Plane button found on the Work Features panel.

 3. Select the edges indicated by the yellow pointer faces, and a work plane will be created 

using these two edges.

Offset from Plane

 1. Open the fi le mi_4a_045.ipt.

 2. Click the Plane button found on the Work Features panel.

 3. Click the yellow face and drag in the offset direction.

 4. Enter the offset distance, and click the green check mark to create the plane.

 5. Double-click the work plane in the browser to change the offset value.
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Angle to Face around Edge

 1. Open the fi le mi_4a_046.ipt.

 2. Click the Plane button found on the Work Features panel.

 3. Select the edge indicated by the yellow pointer face and the yellow face.

 4. Enter an angle relative to the selected face, and click the green check mark to create the 

plane.

 5. Double-click the work plane in the browser to change the angle value.

Tangent to Surface and Parallel to Plane

 1. Open the fi le mi_4a_047.ipt.

 2. Click the Plane button found on the Work Features panel.

 3. Select the yellow curved face and then select the fl at yellow face, and a work plane will be 

created tangent to the curved face and parallel to the fl at face.
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Tangent to Surface through Edge

 1. Open the fi le named mi_4a_048.ipt.

 2. Click the Plane button found on the Work Features panel.

 3. Select the yellow curved face and the edge indicated by the yellow pointer face, and a 

work plane will be created tangent to the curved face and running through the selected 

edge.

Tangent to Surface through Point

 1. Open the fi le mi_4a_049.ipt.

 2. Click the Plane button found on the Work Features panel.

 3. Select the yellow, curved face and the endpoint of the sketch line, and a work plane will 

be created tangent to the curved face at the end of the selected line.

Normal to Curve at Point

 1. Open the fi le mi_4a_050.ipt.

 2. Click the Plane button found on the Work Features panel.

 3. Select any of the sketch points and then select the arc, and a plane will be created at the 

intersection of the two.
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Midplane of a Torus

 1. Open the fi le mi_4a_051.ipt.

 2. Click the fl yout arrow (the small black arrow below the Plane button) on the Work 

Features panel.

 3. Click the Midplane Of Torus button.

 4. Select anywhere on the torus, and the plane will be created.

Here are some other points to remember about work planes:

 ◆ You can right-click a work plane in the browser or the graphics window, and then select 

Show Inputs to see how that work plane was created.

 ◆ You can move a work plane by clicking an edge and dragging. This will slide the work 

plane in the plane of its defi nition only.

 ◆ When you place the mouse pointer on any corner of the work plane, a resize arrow appears, 

allowing you to drag the corner of the work plane to resize it.

 ◆ You can also right-click and set a work plane to autoresize, allowing it to resize off the 

extents of the part as it changes.

 ◆ Work planes have a positive and negative side to them. The normal (positive) side has an 

orange tint, and the non-normal (negative) side has a blue tint. You can right-click a work 

plane and choose Flip Normal if needed.
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 ◆ If you do not have the geometry you need present when creating work planes, you can 

right-click and choose Create Axis or Create Point to create an in-line work feature. In-line 

features are stacked in the Model browser and automatically set not to display.

 ◆ When you start the Work Plane tool, you can right-click and choose Repeat Command to 

set the work feature tools to stay on until you right-click and choose Done. This helps when 

you are creating a lot of work features because you do not have to keep clicking the button 

each time.

Work Axes and Work Points
Much like a work plane, a work axis or work point can be used to create helper geometry in your 

model. Work points are often created in order to defi ne work planes or work axes. Work axes are 

often created to help defi ne work planes.

Work Axes

A work axis is a construction line of infi nite length that is attached to a part based on the geome-

try used to create it. You can create a work axis on linear edges through circular faces and edges; 

through any combination of work points, midpoints, and vertex points; along 2D and 3D sketch 

lines; and at the intersection of work planes. You can locate several input-specifi c buttons for 

creating work axes by clicking the fl yout button next to the Axis button, as shown in Figure 4.36.

Figure 4.36

Methods for 

creating work axes

Work Points

Work points may be created at the intersection of planes, surfaces, edges, work axes, 2D or 3D 

sketch lines, work points, and sketch points, in any combination. They can also be placed 

directly on sketch points, vertex corners, center points, edge midpoints, or grounded work 

points. You can locate several input-specifi c buttons for creating work axes by clicking the fl yout 

button next to the Axis button, as shown in Figure 4.37.
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Figure 4.37

Methods for 

creating work 

points

Grounded Work Points

Grounded work points are much like regular work points, but they have all of their degrees of 

freedom removed and are therefore locked to a specifi c coordinate. To edit a grounded work 

point, you can right-click it, choose 3D Move/Rotate, and then use the precise input toolbar to 

make adjustments. You can right-click a regular work point and choose Ground to convert it to a 

grounded work point.

Renaming Work Features

Taking the time to rename work features can be helpful if you fi nd that you must create and 

edit a lot of them. However, if you use just one or two here and there, it may not be that helpful. 

Using a consistent naming scheme will help you easily determine the work feature’s use.

Creating Fillets
The Fillet tool in Inventor may seem daunting at fi rst because of the number of buttons and 

combination of options, but once you understand the layout of the dialog box and the intended 

use of the options, you’ll be able to create fi llets of all types. There are three basic types of 

fi llets:

Edge Fillets  These are fi llets created based on selected edges.

Face Fillets  These are fi llets created between two faces or face sets.

Full Round Fillets  These are fi llets that are tangent to three adjacent faces or face sets.

When you start the Fillet tool (on the Modify panel of the 3D Model tab), it will default to 

edge fi llets. You can switch the fi llet type by using the buttons on the left of the dialog box.
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Work Feature Visibility vs. Display

Many Inventor users fight the control of visibility of work features (work planes, work axes, 

and work points) because of a lack of understanding of the tools available to control it. Th ere are 

basically two methods of preventing work features from displaying on-screen:

 ◆ Right-click the work feature and toggle off  Visibility. (Always use this at the part level.)

 ◆ On the View tab, click Object Visibility, and then use one of the options listed. (Do not use this 

at the part level but only at the assembly level.)

Both methods turn off  the display, but only the fi rst toggles the visibility setting for each object. 

Th e second is a display override that suppresses the work feature display but does not change the 

visibility setting.

Th e diff erence between the two methods becomes important at the assembly level. If you’ve used the 

Object Visibility tool to “override” the work feature visibility setting at the part level, you will fi nd 

that all of the work features will display when you place the part into an assembly. Th is requires you 

to toggle them all off  again at the assembly level, and you will be required to do so for each instance of 

the part placed. You could use the Object Visibility tool in the assembly and suppress the display 

of all the work features for the entire assembly, but doing so doesn’t allow you to access one or two 

work features at a time. As a result, you end up with all or none of the work features displaying.

To properly control work feature visibility, you should develop the habit of always right-clicking the 

work features at the part level and explicitly toggling off  the visibility setting, and never use 

the Object Visibility override in a part. If you do this, then when the part is used in an assembly, 

you can control the work features on an individual basis, per instance of the part. Th en you can use 

the Object Visibility tool to toggle all the visible work features on and off  eff ectively.

Edge Fillets
Edge fi llets are the most common type and therefore naturally have the most options. 

When edge fi llet is the active type, you’ll see three tabs across the top of the dialog box, allowing 

you to set the following edge fi llet subtypes: constant, variable, and setbacks.

Constant Fillets

Constant fi llets have the same radius along the entire length of the edge. On the Constant tab, 

you can select a group of edges and then set the radius and type. You can create a new size 

group by clicking the Click To Add row in the selection pane and changing the radius size. 

Figure 4.38 shows two constant fi llet groups being created. In this case, each group contains 

only one edge, but they vary in radius.

Figure 4.38

Creating two edge 

fi llets of diff erent 

sizes
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Fillet Failures

If you attempt to place multiple fi llets at once, you might be alerted to the fact that some of the 

edges could not be blended successfully using the current radius size, in which case you can choose 

to place the successful fi llets and skip the others.

One of the most common issues with edge fi llets arises when you select multiple edges that converge 

on a single corner vertex. Unfortunately, when this happens, the error message might erroneously 

indicate an issue with the fi llet size. However, you can generally resolve this issue by removing one 

or more of the competing edges from the selection, applying the fi llet feature, and then applying 

another fi llet feature using the previously removed edge(s). Keep this in mind as you place edge 

fi llets, and remember that just because you can place multiple sizes of edge fi llets all in one feature 

doesn’t mean it’s always the best solution.

Also on the Constant tab you can change the selection method from Edge to Loop or Feature. 

Figure 4.39 shows the selection method set to Feature and the results of selecting a hole. Note 

that all edges created by the hole feature are selected.

Figure 4.39

Fillet selection by 

feature

You can also select All Fillets (inside corners) or All Rounds (outside corners) to apply fi llets 

to a part quickly, where it makes sense to do so. Figure 4.40 shows the same part with all fi l-

lets applied on the left and all rounds applied on the right. Keep in mind that you can select all 

rounds and fi llets at once as well.

Figure 4.40

All fi llets vs. all 

rounds
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Variable Fillets

In contrast to constant-edge fi llets are variable-edge fi llets. Variable-edge fi llets can have mul-

tiple radius sizes along the length of the edge. To create variable fi llets, click the Variable tab and 

then select an edge to make it variable. By default, the start points and endpoints are added to 

the right pane. You can add points by simply clicking the edge in the place or places you want to 

transition to a different radius.

Once points are selected, you can change the radius and position of each point. The number 

listed in the Position column is a decimal percent of the edge length rather than the length. For 

instance, Figure 4.41 shows a point has been added at 0.5000 ul or 50 percent of the edge length 

coming off the start end. Recall that ul is simply Inventor’s abbreviation for unitless, which is 

automatically applied to parameters that do not require a unit suffi x.

Figure 4.41

A variable-edge 

fi llet

Setbacks

Setbacks defi ne the corner where multiple-edge fi llets come together. Once you select edges 

in the Constant tab, you can switch to the Setbacks tab and select corners to apply setbacks to. 

Setbacks are typically used for cast and molded parts where the corners cannot be too sharp.

On the Setbacks tab, select a corner using the Vertex pane fi rst. Then enter a setback distance 

for each edge. Setback values should be no longer than the length of the edge they are placed 

on. You will typically get an error if you attempt to specify a value that is larger. If you click 

the Minimal check box, the setbacks will automatically adjust to the smallest length that can be 

built. Figure 4.42 shows a setback being created, along with the result.

Figure 4.42

A setback fi llet
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Face Fillets
Face fi llets are added between two selected face sets. These faces or sets of faces do not need to 

share a common edge. You can adjust the radius once the fi llet is previewed, but typically if you 

do not get a preview, it indicates an invalid selection set. You can add more faces, or you may 

need to use a different type of fi llet solution.

Two options are selected by default:

Include Tangent Faces  Use this option to allow the fi llet to continue over tangent, adjacent 

faces. Deselect this option to ensure that the fi llet is only between selected faces.

Optimize For Single Selection  Deselect this option when making multiple selections per 

face set. When this option is selected, the selection automatically changes from selection set 

1 to selection set 2.

Figure 4.43 shows a face fi llet created between the two dark faces.

Figure 4.43

Creating a face fi llet

Full Round Fillets
Full round fi llets can be used to quickly round over a feature without having to know the 

radius that would complete the full round. You can also use this option to create a full round 

on faces that are not parallel. To create this type of fi llet, simply select the faces in the order in 

which they occur from side to center to other side, and the center face will be replaced with the 

radius face. Figure 4.44 shows a full round. The selection options are the same as described pre-

viously for the face fi llet.

Figure 4.44

A full round fi llet
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Working with Fillet Features
In this section you’ll create the various types of fi llets discussed in the previous pages. To begin, 

open the fi le mi_4a_053.ipt. Then follow these steps:

 1. Select the Fillet tool from the Modify panel of the 3D Model tab (or press F on the 

keyboard).

 2. First, you’ll create a simple edge fi llet. Select the vertical edge where the yellow and blue 

faces intersect.

 3. Set the fi llet radius to 18 mm and click the Apply button.

 4. Next, you’ll create a variable fi llet. Click the Variable tab in the Fillet dialog box.

 5. Select the edge where the purple and red faces intersect.

 6. Set the radius for the start and endpoints to 2 mm.

 7. If needed, click the word Start to set the dialog box from edit mode back to selection 

mode, and then click anywhere on the edge between the purple and red faces.

 8. Change the radius to 6 mm and then set the position to 0.5 to set the new variable point 

to be halfway between the start and endpoints. Note that you could add additional vari-

able points to further defi ne the variation of the fi llet. In this case, though, just click the 

Apply button to create the variable fi llet.

 9. Next you’ll create a fi llet setback. To do so, switch back to the Constant tab and set the 

radius to 2 mm.

 10. If needed, click the Pencil icon in the current row to set it from edit mode to selection 

mode.

 11. Select the edge between the yellow and pink faces and then the edge between the yellow 

and green faces. It may help to zoom in on the corner.

 12. In the Fillet dialog box, click the Click To Add text to add another row to the list.

 13. Change the radius to 3 mm and then click the Pencil icon to set the row back to selection 

mode, if needed.

 14. Select the edge between the pink and green faces.

 15. Select the Setbacks tab in the Fillet dialog box.

 16. Choose the corner where the yellow, pink, and green faces intersect. You should see the 

vertex highlight as you locate it.

 17. Enter 6 mm for all of the setback values, and then click the Apply button to create the 

fi llets with setback.

 18. Next, you’ll create a face fi llet. Click the Face Fillet button on the left of the Fillet dialog 

box (the one in the middle).

 19. For Face Set 1, choose one of the orange faces; for Face Set 2, choose the other. Then click 

the Apply button.
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 20. And fi nally, you will create a full round fi llet. Click the Full Round Fillet button on the 

left of the Fillet dialog box.

 21. Select the tan faces on the protruding front feature in consecutive order (the right face 

for Side Face Set 1, the top face for Center Face Set, and the left face for Side Face Set 2, for 

example).

 22. Click the OK button to create the fi llet and close the Fillet dialog box.

Have a look at the fi llet features in the browser tree. You can right-click any of them and 

choose Edit Feature to adjust the fi llet as needed. To add edges to or remove edges from any 

given fi llet feature, you can use the Ctrl key and then click the edges on-screen. Figure 4.45 

shows the part before and after fi llets were applied. You can close the fi le without saving 

changes.

Figure 4.45

Before and after 

fi llets

Note that if you try to place a fi llet along the edges where the pink and red faces intersect, 

you will receive an error because of the way the resulting fi llet tapers. However, if you also 

choose the corresponding edges on the opposite of the rounded feature, the fi llet will build 

without problems. Keep this in mind as you work with fi llets that form sharp tapers.

Color Overrides

To change the color of any individual face on a model, you can right-click the face and choose 

Properties from the context menu. You can do the same for entire features by right-clicking them 

in the browser and choosing Properties.

To remove color overrides for entire solids, you can expand the Solid Bodies folder in the browser, 

right-click a solid, and choose Properties. In the Body Properties dialog box, you can set Body 

Appearance to As Part, select the Clear All Overrides check box, and then click the OK button. Be 

aware that parts translated from other fi le formats often come in with many color overrides and 

the Clear All Overrides action can take a while to process.

Creating Th readed Features
Inventor offers the option of creating cosmetic threads that represent actual threads in the part, 

and it creates 2D geometry information for detailing those threads. Cosmetic threads are cre-

ated with a threaded hole feature. Or you can use the Thread tool on the Feature panel bar to 
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add threads to existing part features. The thread features are added to the Model browser as 

separate features.

Creating Cosmetic Th reads Using the Th read Tool
Creating cosmetic threads on a circular part is a relatively simple procedure. Cosmetic threads 

work by wrapping a scaled graphic around the feature to represent threads. This allows the 

model fi le size to stay smaller because it is not required to calculate all of the extra edges and 

faces of the threads. However, the cosmetic Thread tool does create fully intelligent thread fea-

tures based on the specifi cations you choose, allowing you to detail the threads quickly and 

accurately in the drawing environment.

In the following steps, you will use the Split tool to divide a cylindrical surface into multiple 

faces and then apply cosmetic threads to them:

 1. Open the fi le mi_4a_056.ipt.

 2. Select the Split tool in the Modify panel on the 3D Model tab.

 3. Select Work Plane1 for the Split tool, select the face of the cylinder it runs through, and 

then click the OK button.

 4. Right-click the edge of Work Plane1, and choose Visibility to turn the plane off. Recall 

that work planes are selectable only by their edges.

 5. Now that the part is divided into two faces, click the Thread button in the Modify panel, 

and select the shortest face.

 6. Click the Specifi cation tab, set the Size to 17 and the Designation to M17x1, and then click 

the Apply button.

 7. Switch back to the Location tab, and click the end of the middle cylinder.

 8. Uncheck the Full Length check box, and enter 5 mm for the Offset and 30 mm for the 

Length. Click the direction button if you do not see the threads appear. Click the Apply 

button.

 9. Run your mouse pointer over the third cylinder, and notice that as you get closer to one 

end or the other, the offset and direction switch.

 10. Click the face, and apply another set of threads of any type you like; when you’ve 

fi nished, click the OK button. Figure 4.46 shows the Thread tool options.

Figure 4.46

Placing cosmetic 

threads
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D Threads from Your Cosmetic Threads 

Unless you are going to actually cut threads directly from your 3D model, cosmetic threads are 

usually suffi  cient. Th e advantage of these threads is that they contain all the thread information 

in the model that can later be extracted in a drawing without carrying the burden of complex 

modeling features.

Inventor pulls its thread specifi cation information from the Thread.xls fi le found in the Design 

Data folder. You can edit this fi le to contain custom thread specifi cations and include proprietary 

threads or industry-specifi c threads not commonly listed.

If you fi nd that you do need to generate 3D threads from your cosmetic threads, maybe for a 3D 

printed part, for example, you can download the Th readModeler tool from the Autodesk Exchange 

Apps website: http://apps.exchange.autodesk.com.

Using the Coil Tool to Create Physical Th reads
In addition to using the ThreadModeler add-in tool found at the http://apps.exchange

.autodesk.com website, you can create physical threads using the Coil tool. Physical threads 

create large fi le sizes compared to cosmetic threads and can seriously affect performance and 

assemblies. As a result, physical threads should be used only where absolutely necessary, such 

as in the design of a bottle or jar top or other geometries such as a worm gear. You can explore 

the creation of a physical thread with the Coil tool in these steps:

 1. Open the fi le mi_4a_057.ipt.

 2. In the Model browser, select the sketch called Thread Cut Sketch, right-click, and select 

Edit Sketch.

 3. Right-click and choose Slice Graphics (or press F7 on the keyboard) to temporarily slice 

away the material that hinders your view of the sketch. Recall that this option is available 

only while creating or editing a sketch that runs through a solid.

 4. Zoom in on the sketch, change the depth dimension to 2 mm, and then click the Finish 

Sketch button to exit the sketch.

 5. Zoom out (or double-click the mouse wheel to zoom all), and then click the Coil tool in 

the Create panel on the 3D Model tab.

 6. Select the sketch profi le if it does not automatically select, and then select the work axis in 

the center of the cylinder for the axis.

 7. Use a direction button to make sure the coil is running the correct way, and then click the 

Cut button.

 8. Click the Coil Size tab, change the pitch to 4 mm and the revolution to 12, and then click 

the OK button.

Figure 4.47 shows the Coil Size tab. Be aware that you can create coils by specifying pitch 

and revolution, revolution and height, and pitch and height or by defi ning a spiral. Also note 

http://apps.exchange.autodesk.com
http://apps.exchange
http://apps.exchange.autodesk.com
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the suffi x of ul shown in the Revolution drop-down box. This suffi x just means that the value is 

unitless. You do not have to specify this, because Inventor will do so as needed.

Figure 4.47

Creating a physical 

thread with the 

Coil tool

Hole Features
Using Inventor’s Hole tool, you can create counterbore, countersink, spotface, and drilled holes 

with user-defi ned variables such as thread designation and drill point angle. You can also spec-

ify a simple hole, a tapped hole, a tapped tapering hole, or a clearance hole.

Using the Th read and Clearance Spreadsheets
Two external fi les are related to the Hole tool: Thread.xls and Clearance.xls. Both fi les 

load at the time of installation to a Design Data folder in the install directory location, such as 

C:\Program Files\Autodesk\Inventor 2014\Design Data. If the Design Data folder has 

been relocated, you can determine its location by following these steps:

 1. On the Get Started tab, click Projects.

 2. In the Projects dialog box, ensure that you are looking at the correct project, and locate 

and expand the Folder Options node in the lower pane.

 3. Note the Design Data path listed.

 4. If the Design Data path says = Default, then your project is reading the path from 

Inventor’s options, so you should select the Tools tab, click Application Options, and 

select the File tab in the dialog box that opens. Note the Design Data path listed.

Once the path is determined, you can browse to the path and fi nd the thread and clearance 

spreadsheets and make customizations as follows. To edit the thread spreadsheet, follow these 

steps:

 1. Close Inventor.

 2. Make a copy of the original spreadsheet, and store it in a safe location (this is just a 

precaution).

 3. Open the Thread.xls fi le in Microsoft Excel.

Certification
Objective
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 4. To add or modify custom thread designations for an existing thread type, do the 

following:

 a.  Choose the worksheet you want to customize.

 b.  Edit the values in the Custom Thread Designation column to include your designa-

tions. These will then be available in the Thread and Hole tools and can be recovered 

in hole notes in a drawing.

 c.  Edit cell B1 to change the name Inventor displays in the Hole and Thread tools.

 d.  Edit cell D1 to change the order in which Inventor lists the thread types in the Hole 

and Thread tool dialog boxes.

 5. To add a new thread type, complete these tasks:

 a.  Copy an existing worksheet of the same type (parallel or taper).

 b.  Rename the custom worksheet as required.

 c.  Delete most or all of the rows below row 3. You may want to keep at least one row to 

use as a reference, at least temporarily.

 d.  Add rows as required.

 e.  Edit cell B1 to change the name Inventor displays in the Hole and Thread tools.

 f.  Edit cell D1 to change the order in which Inventor lists the thread types in the Hole 

and Thread dialog boxes.

 g.  Hover your mouse pointer over cell A1 to see the tool tip containing the letter designa-

tions, and mark your sheet as appropriate.

 6. Save the spreadsheet.

 7. Restart Inventor. Changes are read when Inventor loads.

The process to modify Clearance.xls is very similar.

Creating Holes in Parts
You have four options for placing holes with the Hole tool:

 ◆ From Sketch

 ◆ Linear

 ◆ Concentric

 ◆ On Point

To explore these placement options, open the fi le mi_4a_055.ipt from the Chapter 04 folder 

of your Mastering Inventor 2014 directory, and follow these steps:

 1. Select the Hole tool on the 3D Model tab (or press H on the keyboard).

 2. You’ll notice that the Placement option is set to From Sketch. This is because Inventor has 

detected that there are two sketches available for use. Click Cancel to exit the Hole tool.

Certification
Objective
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 3. Right-click Sketch5 in the Model browser, and choose Visibility to turn the visibility of 

this sketch off.

 4. Start the Hole tool again. This time Inventor detects that there is only one sketch available 

and automatically selects the center point found in that sketch.

 5. Click the counterbore option, set the counterbore, as shown in Figure 4.48, and then click 

the OK button.

Figure 4.48

Counterbore 

settings

 6. Right-click Sketch5, turn the visibility back on, and then click the Hole button again. 

Notice that it selects the center points automatically again. This is helpful; however, you 

do not want the hole in the hex-shaped cutout to be the same size as the others in this 

sketch. Hold down the Ctrl key, and click the center point at that location to remove it 

from the selection.

 7. Choose the spotface option, and notice that it is essentially the same as the counterbore 

with the exception of the depth measurement. In the spotface, the depth is measured 

from the bottom of the bore. Set the spotface as shown in Figure 4.49, and click the OK 

button.

Figure 4.49

Spotface settings

 8. Since you removed the one center point before placing the spotface holes, you will reuse 

that sketch to place the next hole. To do so, that sketch must be visible. The Hole tool has 

toggled the visibility back off, so you need to locate Sketch5 again and make it visible.

 9. Place a simple drilled hole using the center point in the hex-shaped cutout. Set the termi-

nation to Through All and the diameter to 9 mm, and click the OK button. Then turn the 

visibility of the sketch off one last time.
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 10. Start the Hole tool again. You’ll note that because there are no longer any visible sketches, 

the From Sketch option is no longer the default placement option. Set the placement to 

Concentric, and select the top face of the part for the Plane input.

 11. Next, you need to specify a concentric reference. Select one of the yellow faces (or the 

circular edge of the yellow face).

 12. Set the hole to the countersink option, and then set the inputs as shown in Figure 4.50. 

Click the Apply button (not the OK button just yet).

Figure 4.50

Countersink 

settings

 13. Set the plane, use the other yellow face to place another countersink of the same size, and 

then click the OK button.

 14. Change your view so that you can see the work point at the work axis intersection of the 

green face.

 15. Start the Hole tool again, and set the placement option to On Point.

 16. Select the work point for the point input and then the work axis for the direction. Flip the 

direction if needed, using the button next to the Termination drop-down.

 17. Leave the hole at the simple drilled option, and set the Termination drop-down to To.

 18. For the To selection, click the bore face of the counterbore hole, and click the Terminate 

Feature check box.

 19. Click the clearance hole option, set the options as shown in Figure 4.51, and click the OK 

button.

 20. Rotate the part so that you can see the underside, and zoom in on the feature with the 

red face.

 21. Start the Hole tool again, and select the red face for the Face input.

 22. Select one of the longer straight edges for Reference1, and set the dimension to 8 mm. 

Select one of the shorter edges, and set the dimension to 12 mm.

 23. Set the termination to Through All and the hole type to Taper Tapped Hole.

 24. Choose Din Taper from the Thread Type list, set the size to M5, and then click the OK 

button. You’ll note that the hole is cut with the appropriate taper.

You can close the part without saving changes when you have created all the holes.
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Figure 4.51

Clearance hole 

settings

As you can see, the Hole tool has an abundance of options allowing you to specify holes in a 

variety of ways. Keep in mind that features created with the Hole tool carry more intelligence 

with them than a simple circular extrude cut. This is particularly true when you begin to detail 

a part in the drawing environment.

Setting Tolerance Values in Holes
You can set tolerances for hole dimensions in the Hole dialog box. When setting a hole dimen-

sion, right-click a dimension edit box, and then select Tolerance, as shown in Figure 4.52.

Figure 4.52

Tolerance settings

You can use these general steps to access the tolerance settings:

 1. In the Tolerance dialog box, change the values as desired:

 ◆ In Precision, click the arrow to set the decimal precision of the dimension.

 ◆ In Evaluated Size, select Upper, Nominal, Median, or Lower to use when evaluating 

the dimension. This will set the size at which the hole is actually created.

 ◆ In Type, click the arrow, and select a tolerance type for the selected dimension.
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 2. Depending on your selection, enter values to set the upper and lower tolerance range and 

the tolerance for the hole and shaft dimensions (for Limits and Fits).

 3. Click the OK button.

This will return you to the Hole dialog box. Keep in mind that although the value in the 

hole input will not change, the hole will be drawn to the tolerance you selected in the model. 

For instance, if the Upper option were selected in the hole shown in Figure 4.52, the hole would 

measure 6.012 mm rather than 6.000 mm. You’ll learn more about using tolerances in Chapter 5.

Bend Parts
You can use the Bend Part tool to bend a part based on a sketched bend line. You can specify the 

end of the part to bend, the direction of the bend, the angle, the radius, and the arc length. You 

can fi nd the Bend Part tool on the Modify tab of the 3D Model tab. By default, it is hidden from 

view and must be accessed by using the fl yout (the small black triangle on the Modify panel).

Here are some guidelines to be aware of when using the Bend Part tool:

 ◆ Sketches used for bend lines must be visible and unadaptive and should be located on a 

plane or surface that contacts the part.

 ◆ A sketched line on the top face of a part does not allow for the part to be bent down, only 

up, whereas a sketch that runs through the part allows the bend to be built up or down.

 ◆ Bend Part does not account for bend allowances in the way sheet-metal features do and 

therefore should not be used with sheet-metal parts.

 ◆ You can specify the bend by Radius & Angle, Radius & Arc Length, or Arc Length & Angle.

Follow these steps to create a simple bend part:

 1. Open the fi le named mi_4a_058.ipt.

 2. Select the Bend Part tool from the fl yout of the Modify panel.

 3. Select one of the sketch lines as the bend line.

 4. Adjust the arrow buttons so that just the end is bent up. Notice that if you try to bend the 

end down, it will not work. This is because of the position of the sketch.

 5. Set the radius to 100 mm, and then click the OK button.

 6. The bend will consume your sketch, so you will need to expand the Bend feature in the 

Model browser and then right-click the sketch and choose Share Sketch.

 7. Create another bend to your specifi cations, experimenting with the other solutions.

Figure 4.53 shows the Bend Part tool in action. You can close the fi le without saving changes 

when fi nished.

Part Modeling Exercise
In the pages to follow, you will create a part similar to the part shown in Figure 4.54. You’ll 

employ some of the tools covered in this chapter and preview some that are covered in Chapter 5.
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Figure 4.53

Bending a steel 

shape

Figure 4.54

Th e part you’ll 

create in this 

exercise

Creating a Base Feature
You’ll begin by creating a new part fi le from the Standard(mm).ipt template:

 1. On the Get Started tab, click the New button.

 2. On the Metric tab of the New File dialog box, select the Standard(mm).ipt template.

 3. On the Sketch tab, locate the rectangle drop-down menu (the small black arrow next to 

the Rectangle button) and click the Rectangle Two Point Center tool.

Projecting the Origin Point

If you do not see an origin point in your sketch, you may want to take this opportunity to turn on 

the option that will automatically project it into every new sketch. To do so, just follow these steps:

 1. On the Tools tab, click Application Options.

 2. Choose the Sketch tab.
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 3. Ensure that the Autoproject Part Origin On Sketch Create option is selected, and click the OK 

button.

 4. Start a new fi le from a template, and you will see that the origin point is now present.

 4. Place the rectangle on the projected origin point.

 5. Use the Dimension tool found on the Sketch tab to dimension the sketch at 150 mm by 

300 mm, as shown in Figure 4.55.

Figure 4.55

Initial sketch

 6. Right-click and choose Finish Sketch, and then click the Extrude button on the 3D Model 

tab.

 7. If needed, click the corner of the ViewCube to fi nd an isometric view of the sketch so you 

can see the preview (if it’s not displayed, select the View tab, select the Windows panel, 

click the User Interface button, and click the drop-down arrow).

 8. Generally, Inventor will select the profi le for you if you have just one closed profi le pres-

ent to extrude. If the profi le is not selected, click anywhere in the rectangle to select it. If 

you did not make the diagonal a construction line, you will need to select both triangular 

halves of the rectangle.

 9. Enter 25 mm in the Distance input box. Click the arrow buttons to change the extrude 

direction just to see how the preview updates. Then click the left arrow button, and click 

the OK button.

Creating a Second Feature
Now that you’ve created your base feature, you will continue by adding features to it. Before 

doing so, it is a good idea to save your part. Click the Save icon from the Quick Access bar at the 

top of the screen, or click the Inventor button and then select Save. You can save the fi le in the 

Chapter 04 folder and name it anything you like.

Now that the part is saved, it’s time to create a second feature:

 1. On the 3D Model tab, click the Create 2D Sketch button, and then click the large front 

face of the part (or right-click the face and select New Sketch). Sketch2 is now created and 

active.

 2. Use the ViewCube to orient your view of the part so that you have a fl at 2D view of your 

sketch plane with the rectangle running horizontally on your screen.
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 3. If you see sketch lines outlining the base feature, then you have the Autoproject Edges 

For Sketch Creation And Edit option turned on. If you do not see those sketch lines, select 

the Project Geometry tool on the Sketch tab, and select the face again to project the edges.

Enabling Project Edges on Sketch Creation

If you see the outline of the faces automatically projected into your new sketches, you may want to 

consider turning it off . In general, I do not recommend that you use this. It may be helpful in the 

beginning, but be aware that your sketches can become cluttered with unneeded geometry. When 

all edges are projected, it is more diffi  cult to determine the design intent and edit sketches. Instead, 

consider disabling this option and developing a practice of projecting only necessary edges.

To do so, follow these steps:

 1. On the Tools tab, click Application Options.

 2. Choose the Sketch tab.

 3. Ensure that the Autoproject Edges For Sketch Creation And Edit option is selected to enable it or 

deselected to disable it, and click the OK button.

 4. Sketch a rectangle on the face selected for the sketch. Place this rectangle in the middle of 

the face, being careful not to accidentally constrain it to the origin point or the edge of the 

base feature (you will relocate it using a sketch constraint later).

 5. Select the Circle tool on the Sketch tab, and sketch a circle at the end of the rectangle 

starting with the midpoint of the vertical line on the right and snapping to the endpoint 

of the top or bottom line. You don’t need to trim the circle before converting this sketch 

into a feature, and in fact, unneeded trimming of sketch entities often works against you 

because it may remove sketch constraints.

 6. Use the Dimension tool on the Sketch tab, and add a dimension to the circle. Rather than 

just entering a value, enter Diameter = 40 mm, thereby assigning the dimension a name 

and a value (be sure you have named this dimension, because you will be using it in the 

steps to come).

 7. You’ll next create an equation for the length of the rectangle based on the length of 

the diameter value. With the Dimension tool, select the edge of the rectangle, and enter 

Slot_Length =.

 8. Click the 40 mm diameter dimension you just created. This will link the two dimensions. 

Finish the equation with *5 so that your end equation reads Slot_Length = Diameter*5. 

Note that you must use an underscore here because spaces are not allowed in parameter 

names. Your sketch should look similar to Figure 4.56.

Figure 4.56

Creating and 

dimension-

ing geometry in 

Sketch2
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 9. Create a Coincident constraint between the midpoint of the left vertical line of the 

rectangle and the midpoint of the left, projected, vertical line of the base feature.

 10. Select one (or all) of the projected lines of the base feature, and convert it to a construction 

line (this ensures that Inventor will not attempt to extrude the large projected profi le in 

the next step).

Use Work Features to Anchor Your Sketches

Another way to anchor this sketch to the midplane of the rectangle is by using work features. 

Before starting a sketch, click the Plane icon found on the Work Features panel. Select one side of 

the rectangular feature and then the other. Th is will create a parametrically centered work plane.

Th en you can create a sketch and use the Project Geometry tool and select the edge of the work 

plane. Th is will project the work plane as a line onto the sketch plane. You can then use this line as a 

centerline in your sketch-creation sequence. If you were to ever change the size of the base feature, 

then the work plane, the projected line, and hence this sketch would all update and remain centered.

 11. Finish the sketch, and choose Extrude on the 3D Model tab.

 12. If needed, use the ViewCube to view the part from an isometric view.

 13. Select the rectangle and the circle you just created for the profi le.

 14. Click the Cut button (the second button down in the list of operation buttons) so that 

the profi les will be cut out of the base feature. Your preview should be red when the Cut 

operation is selected. Check the direction arrow to ensure that the cut is going in the 

correct direction.

 15. In the Extents drop-down, select All. The All option extrudes the profi le through all the 

current features of the entire part in the specifi ed direction or in both directions if you 

chose the Midplane option. If the size of the base part features change, the cut extrusion 

feature will update accordingly. Click the OK button when your options look like 

Figure 4.57, and then save your fi le.

Figure 4.57

Extruding (cutting) 

the second feature
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Creating a Sketch-Based Hole Feature
Hole features are powerful components of Inventor. Many methods are available for 

creating Hole features. You can create holes in the following ways:

 ◆ By utilizing existing sketches containing sketch center points

 ◆ By distance from two planar edges

 ◆ On a face by referencing a concentric edge or concentric face

 ◆ By using a work point feature

You can continue with the fi le you are working on or open the fi le mi_4a_060.ipt. Follow 

these steps to create another sketch, and then use that sketch to place a hole:

 1. On the 3D Model tab, click the Create 2D Sketch button, and then click the large front 

face of the part (or right-click the face and select New Sketch). Sketch3 is now created and 

active.

 2. If needed, use the ViewCube to orient your view of the part so that you have a fl at 2D 

view of your sketch plane with the rectangle running horizontally on your screen.

 3. You might see the outline of the sketch plane face automatically projected into your 

sketch (if not, click the Project Geometry button and select the sketch plane).

 4. On the Sketch tab, select the Offset button found on the Modify panel.

 5. Before selecting anything to offset, right-click and ensure that both the Loop-Select and 

Constrain Offset options are selected:

Loop-Select  This option selects lines/curves joined at their endpoints. Deselect to select 

one or more lines/curves individually.

Constrain Offset  This option constrains the distance between the new geometry and 

the original to be equidistant.

 6. Click the radius, and then drag the offset profi le so that it is created to the inside of the 

part. Then right-click and click Cancel.

 7. Place a dimension between the offset profi le and the outside edge of the part, and enter 

Offset = 20 mm in the input box (again, be sure to name this, because you will be using it 

in the steps to follow).

 8. Window-select the entire part/sketch so that all of the lines are selected, and then click 

the Construction button and convert the lines to construction lines.

Select Objects with a Window Selection

You can create multiple entity selections using what is referred to as a window selection. Window 

selection sets include objects diff erently depending on whether the window is created from left 

to right or right to left:

 ◆ Position the pointer slightly above and to the left of the leftmost entity to select, and then 

click and drag the pointer slightly below and to the right of the rightmost entity that you want 

to select. All objects that are fully enclosed within the rectangle are selected and highlighted.
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 ◆ Position the pointer slightly below and to the right of the rightmost entity to select, and then 

click and drag the pointer slightly above and to the left of the leftmost entity that you want 

to select. All objects that are enclosed by and/or intersected by the rectangle are selected and 

highlighted.

You can use the Ctrl and Shift keys to add entities to and remove entitles from the selection sets.

 9. Select the Point tool on the Draw panel of the Sketch tab, and place a point on the corner 

of the offset loop, as shown in Figure 4.58.

Figure 4.58

Placing a sketch 

point for hole 

placement

 10. Finish the sketch, and choose the Hole tool from the 3D Model tab.

 11. If needed, use the ViewCube to view the part from an isometric view.

 12. The Hole tool should have automatically selected your sketch point; if not, make sure the 

Placement drop-down is set to From Sketch and the Centers button is selected, and then 

select the sketch point on-screen.

 13. In the Termination drop-down, select Through All to ensure that the hole depth always 

cuts through the part. Then set Type to Tapped, set the Threads options to ISO Metric 

Profi le, set the Size to 10, and then set the Designation to M10x1.5 (as shown in Figure 4.59). 

Click the OK button and save your part.

Selecting Sketched Hole Centers

Th e Hole tool will automatically select sketched center points as long as only one visible unconsumed 

sketch is available. If you fi nd that the Hole tool is not picking up your center point automatically, 

check to see that you haven’t accidentally created an extra sketch in the model tree. You can hover 

your mouse pointer over the Sketch node in the browser to see the sketched entities highlight on 

the screen. If you determine that you have accidentally created an extra sketch, you can right-click 

it and click Delete.

Note, too, that only center points (small cross marks) are automatically selected by the Hole tool 

and simple points are not. However, you can manually select simple points for hole placement. You 

can also convert center points to simple points, or vice versa, by using the Center Point button on 

the Sketch tab (you’ll fi nd it next to the Construction tool).
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Figure 4.59

Hole options

Creating a Rectangular Hole Pattern
So far, the features you’ve created have been based on a sketch. These types of features are, 

therefore, referred to as sketched features. Features not based on sketches are referred to as 

placed features. Placed features are solely dependent on existing part geometry. In the pages to 

come you will explore the steps necessary to create a placed feature in the form of a rectangular 

pattern.

When creating patterns, you have the choice of creating them at the feature level or at the 

sketch level. For instance, you could have patterned the sketch point using a sketch pattern and 

then placed multiple holes at once using the Hole tool. It is generally best, though, to create pat-

terns as features rather than sketch patterns. Here are two reasons to consider feature patterns:

 ◆ A feature pattern saves time when creating spaced, multiple instances of a feature, and it 

makes editing the spacing easily accessible.

 ◆ Using a feature pattern in a part allows you to later use that pattern to create a component 

pattern in an assembly and follow the original part pattern. For instance, if you placed 

this part into an assembly, you could pattern a bolt to occupy every hole within the pattern 

by simply constraining one bolt into the original hole feature and then use the Component 

Pattern tool to automatically pick up the hole pattern count and spacing. The Component 

Pattern tool is available only within the assembly environment.

First, you’ll need to determine the pattern spacing. From the creation of the second feature, 

you know the round end of the slot has a width of 40 mm. From the creation of the placed hole, 

you know the offset from the slot edge is 20 mm. From this information, you can determine that 
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the spacing of the two rows of holes is (2 × offset value) + 40 mm, therefore 80 mm. Assume the 

design specifi cation requires eight holes in each row and they need to be spaced at a distance 

of 25 mm apart. With this information, you are now ready to proceed with creating the hole pat-

tern. You can continue with the fi le from the previous section, or open the fi le mi_4a_061.ipt. 

Then follow these steps:

 1. On the 3D Model tab, click the Rectangular Pattern button found on the Pattern panel.

 2. In the Rectangular Pattern dialog box, you are being asked to select the features to pat-

tern. You can select the hole from the graphics area, but you may fi nd it easier to do so 

from the Model browser. No matter what method you use, check the Model browser to 

ensure that Hole1 and only Hole1 is highlighted (you can use Ctrl+click to deselect any 

accidentally selected features).

 3. Click the arrow button under Direction 1, and select the edge of the slot cutout. Use a 

direction button to change the direction if required, and set the count and spacing to 8 

and 25 mm, respectively. You can confi rm that your settings look similar to Figure 4.60.

Figure 4.60

List param-

eters from the 

Rectangular 

Pattern dialog box

 4. Click the arrow button under Direction 2, and select one of the short ends of the part. Use 

a direction button to change the direction if required, and set the count to 2.

Although you could just change the spacing value to 80 mm and complete the pattern, you 

might want to consider what would happen if the width of the slot feature were to change. 

If that were to happen, the hole pattern spacing would stay at 80 mm and no longer remain 

symmetric to the slot width. To avoid this, you will make the pattern spacing parametric 

by calling the dimensions of earlier features into your pattern spacing. In this way you are 

building a formula right into the pattern so that if those dimensions change, the spacing set-

ting will follow.

 5. To do this, fi rst clear the Direction 2 length input box.

 6. Click the arrow at the right of the length input box, and click List Parameters from the 

fl yout shown in Figure 4.60.

 7. Choose Diameter from the list, then choose List Parameters again and, fi nally, choose 

Offset.
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 8. Edit the input to read Diameter + 2* Offset.

 9. If the text shows in red, there is an error. When you have a valid formula, it will display 

in black. Check the preview, ensure that the pattern looks correct, and then click the OK 

button. Confi rm that your part looks like Figure 4.61, and then you can save your fi le.

Figure 4.61

A rectangular hole 

pattern 

Editing Sketches and Features
You will often need to modify a sketch and/or feature after you have created it. Oftentimes you 

may fi nd that because designs are similar, it is most effi cient to copy an existing part and then 

make changes to the copy.

In the next steps, you’ll edit some of the features you’ve just created, but before doing so, it 

will be helpful to understand the behaviors associated with the model tree and browser nodes. 

When a feature is sketch-based, you can expand the plus sign next to it to reveal the sketch. 

Likewise, when a feature has multiple elements such as a pattern, you can expand it to view and 

control each element. If a feature is placed rather than sketch-based, it may not have any elements 

and, therefore, will lack a plus sign. Figure 4.62 shows the anatomy of the three browser nodes.

Figure 4.62

Editing features 

and sketches



PART MODELING EXERCISE | 195

The extrusion is based on Sketch1, as you can see. However, the hole in Figure 4.62 is a placed 

feature based solely on the edges of other features and, therefore, contains no sketch (you’ll 

place a hole of this type in the pages to come). The pattern, when expanded, shows the features 

that it contains and each occurrence of those features.

Editing a Sketch

To edit a feature or a sketch, you can right-click it and choose Edit Feature or Edit Sketch, or you 

can double-click the Browser Node icon for that feature/sketch. Be sure to double-click the Node 

icon rather than the node text; otherwise, you set the text active for renaming. Follow these steps 

to explore the edit procedures of features and sketches:

 1. On the Get Started tab, choose Open (or press Ctrl+O on the keyboard).

 2. Browse for the fi le mi_4a_062.ipt located in the Chapter 04 directory of your 

Mastering Inventor 2014 folder, and click Open.

 3. In the Model browser, right-click Extrusion2 and choose Edit Sketch. You’ll notice that the 

sketch becomes active for edits, and the part displays in a rolled-back stage as it existed 

when the sketch was originally created.

 4. You want to edit the diameter dimension and change it to an inch-based value. To do so, 

double-click the dimension, type 2 in into the input box, and then press Enter.

You’ll notice that Inventor converts the value to a millimeter equivalent for you. You can mix 

units as required, but know that any value that does not have a unit is assumed to be the 

part’s base unit. This means if you were to enter 2 without the abbreviation for inch (in), the 

diameter would be set to 2 mm because this part is mm-based.

 5. Click the Finish Sketch button on the Sketch tab (or right-click and click Finish Edit) to 

return to the feature level of the part.

You’ll also notice that as a result of the sketch edit of the diameter, the length of the slot 

cutout adjusts automatically as well because it contains a formula to ensure that it is always fi ve 

times the diameter of the circle.

Editing a Feature

Note that the spacing for the rectangular pattern adjusted automatically on each side of the slot 

cutout but did not adjust for the length of the pattern. This is because the pattern contains a 

parametric formula that controls the width spacing but not the length. To fi x this, you’ll edit the 

rectangular pattern, as shown in these steps:

 1. Double-click Rectangular Pattern1 in the browser to open the edit dialog box.

 2. On the left side, clear the value of 25 mm, click the arrow button, choose List Parameters 

from the fl yout, and select Slot_Length from the list.

 3. The spacing is now adjusted so that the holes are patterned at the Slot_Length value. 

Looking at the preview, obviously this is not correct. To fi x this, click the drop-down at 

the bottom left, and change it from Spacing to Distance. Click the OK button to accept 

these changes.

You might decide that the rectangular pattern needs to include features that were not origi-

nally present when the pattern was created, such as Extrusion3 and Chamfer1 found in this 
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part. If you edit the pattern, you’ll notice that the part rolls back to the state that it existed in 

at the time the pattern was created; therefore, you cannot add the new features to the pattern. 

To resolve this, you will reorder the features and then edit the pattern.

 4. In the Model browser, select Extrusion3 and Chamfer1, and drag them above the rectan-

gular pattern.

You can reorder features in this way so long as they are not dependent on one another. For 

instance, if you attempt to drag Chamfer1 above Extrusion3, you’ll fi nd that it can’t be done. 

This is because the chamfer is based on the geometry of the extrusion.

 5. Once the features have been reordered, double-click the rectangular pattern to edit it, or 

right-click and choose Edit Feature.

 6. Ensure that the Features button is selected, and select Extrusion3 and Chamfer1 from the 

Model browser so that they are added to the pattern. Your preview should update as well. 

Click the OK button to accept these changes.

You may decide that although the pattern provides the correct spacing of the elements, you 

need to exclude some of the middle instances to accommodate other features. You can do this 

easily by suppressing the instances you do not need and still maintaining the constant pat-

tern spacing.

 7. Expand the rectangular pattern feature in the browser, and note that all the instances of 

the patterned features are listed as occurrences.

 8. Roll your mouse pointer down over the list, and you will see the instances highlight on-

screen, each indicating which occurrence it is.

 9. Identify the fourth and fi fth instances on each side of the pattern, right-click them, and 

choose Suppress. You can do this one at a time or hold Ctrl as you select them and sup-

press them all at once. Notice that these occurrences are no longer present on the part 

and are marked with strikethrough in the browser. Figure 4.63 shows the results of these 

edits. You can close the part without saving changes.

Figure 4.63

Th e edited part
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Repairing Features and Sketches
Ordinarily, you want to create chamfer and fi llet features at the end of the overall part-creation 

process. Creating chamfers and fi llets at the end of the process reduces errors caused by feature 

dependencies associated with these features. In the following exercise, however, you will create 

a chamfer before creating a hole and then make a change to illustrate both the folly of creating 

placed features too early in the design and the method of repairing a feature error:

 1. On the Get Started tab, choose Open (or press Ctrl+O on the keyboard).

 2. Browse for the fi le mi_4a_063.ipt located in the Chapter 04 directory of your 

Mastering Inventor 2014 folder, and click Open.

 3. Select the Chamfer tool on the 3D Model tab, and select the corner indicated with the 

red arrow.

 4. Set the distance to 30 mm, and click the OK button.

 5. Click the Create 2D Sketch button and create a sketch on the yellow face.

 6. Use the Point tool to place a point near the chamfered corner, dimension it as shown in 

Figure 4.64, and then click Finish Sketch.

Figure 4.64

Dimensions from 

the chamfered 

corner

 7. Select the Hole tool on the 3D Model tab, and place a counterbore hole as shown in 

Figure 4.64.

 8. At this point you decide that the chamfered corner will not work with this design and 

should have been a rounded corner. To make this change, right-click the chamfer feature 

in the Model browser, and choose Delete from the menu.

 9. Because the counterbore hole is dependent on the chamfer, you are prompted with the 

option to keep it or let it be deleted also. You will choose to keep it by deselecting the 

Dependent Sketches And Features box and clicking OK.

 10. Notice the hole feature in the browser now has a marker symbol next to it indicating it is 

“sick” and is in need of some repair. Expand the Hole2 feature node, and you will see that 
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the sketch is also marked as “sick.” Right-click the sketch and choose Recover, as shown 

in Figure 4.65.

Figure 4.65

Selecting Recover to 

examine sketches 

with errors in them

 11. In the Sketch Doctor dialog box, you will see a list of the issues present in the problematic 

sketch. Click Next to see the recommendations for resolving this problem. The recom-

mendation is to edit the sketch.

 12. Click Next again, and you will see that there is only one treatment option in this case.

 13. Click Finish and then click the OK button in the message box informing you that you are 

being taken to the sketch environment.

Depending on the extent of the error, the Sketch Doctor may offer you the ability to delete 

objects, close open loops, and so on. Of course, you could have just edited the sketch origi-

nally and ended up with the same result in this case. But in cases where you do not know the 

extent of the problems, the Recover option is often helpful in determining the issue.

 14. In the sketch, you will see the unresolved sketch entities highlighted in magenta. Right-

click the magenta line and choose Break Link. This breaks the link with the missing 

chamfer edge but does not fully fi x the problem.

 15. Select the magenta endpoint(s), and use the context menu’s Break Link option on it/them 

as well. This results in the diagonal line being underconstrained. You have two choices to 

resolve this:

 ◆ Use the Coincident constraint along with the General Dimension tool to lock down 

the diagonal line.

 ◆ Delete the diagonal line and its referencing dimensions, and redimension the hole 

center point off the edges of the base part.

 16. Once you have reconstrained the hole center by one of these methods, click Finish Sketch, 

and return to the feature level of the part. Notice that the hole and sketch are no longer 

“sick.”

 17. Choose Fillet from the 3D Model tab, and select the same edge previously used by the 

chamfer to place a 30 mm fi llet. Once you have fi nished, you can close the fi le without 

saving changes.



THE BOTTOM LINE | 199

Although there is probably no way you will ever completely avoid having to repair features 

and sketches, using placed features such as chamfers and fi llets as late in the design as possible 

will go a long way toward reducing these issues. You should also strive to avoid referencing 

these features with dimensions when they are present.

Th e Bottom Line

Confi gure options and settings for part modeling.  Understanding the settings and 

options that apply to the modeling environment is essential for getting the results you want 

from Inventor.

Master It  You want to confi gure your options and settings for your sketch environment 

and then back them up and/or distribute them to other workstations. How would you go 

about doing this?

Create basic part features.  In this chapter, you learned how to plan a workfl ow that allows 

you to create stable, editable parts that preserve the design intent.

Master It  You need to create a fairly complex part consisting of many extrusions, re-

volves, sweeps, and lofts. In addition, you will need to create holes, fi llets, chamfers, and 

other part modifi ers. This part may need signifi cant modifi cation in the future by you or 

by other designers. What considerations will guide your part creation?

Use the Extrude tool.  The Extrude tool is one of the most commonly used feature tools in 

the Inventor modeling toolset. Understanding the options and solutions available in this tool 

will prove useful throughout your designs.

Master It  Imagine that you need to create an extruded feature but don’t know the exact 

length; instead, you know the extrude will always terminate based on another feature. 

However, the location of that feature has not been fully determined just yet. How do you 

get started on the feature?

Create revolved parts and thread features.  Creating revolved features and parts in 

Inventor can often resemble the creation of turned parts and features in the real world. 

Applying thread features to a cylindrical face allows you to specify threads without having 

to actually model them.

Master It  Let’s say you have a part that you intend to fabricate on a lathe. Although you 

could create the part with a series of stepped circular extrusions, it occurs to you that the 

Revolve tool might work also. How do you decide which method to use?

Create work features.  Using work features, work planes, work axes, and work points 

enable you to create virtually any part or feature. Work features are the building blocks for 

sketch creation and use.

Master It  Your design will require creating features on spherical and cylindrical faces. 

You need to precisely control the location and angle of these features. How do you do 

that?
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Use the Fillet tool.  The Fillet tool has a great deal of functionality packed into it. Taking 

the time to explore all the options on a simple test model may be the best way to understand 

them all.

Master It  You are trying to create a series of fi llets on a part. You create four sets of edge 

selections to have four different fi llet sizes, but when you attempt to apply them, you re-

ceive an error stating that the feature cannot be built. What went wrong?

Create intelligent hole features.  Although you can create a hole in a part by sketching a 

circle and extrude-cutting it, this is typically not the recommended approach.

Master It  You need to create a part with a series of various-sized holes on a plate. You 

would like to lay out the hole pattern in a single sketch and then use the Hole tool to cut 

the holes to the sizes required. However, when you select the From Sketch option in the 

Hole tool, it selects all of the holes, so you think you must need to sketch out the hole 

pattern as circles and then use the Extrude tool to cut them out. Is this really the way to 

proceed?

Bend parts.  You can bend a portion of a part after you defi ne a bend line using a 2D sketch 

line. You can specify the side of the part to bend, the direction of the bend, and its angle, 

radius, or arc length.

Master It  You need to create a model of a piece of rolled tube and would like to specify 

the bend direction, but when you use the direction arrow, you get a preview in only one 

direction. How can you get a preview in either direction? 



Chapter 5

Advanced Modeling Techniques

Chapter 4, “Basic Modeling Techniques,” introduced some of the primary modeling tools you 

need when creating a 3D parametric part. Modern parametric modeling utilizes numerous tools 

to create stable, editable parts. The basic workfl ow of creating a part is to create a base feature 

and then build upon that base. The tools used to build the additional features can vary depend-

ing on your need and may range from simple extruded features to complex combinations of dif-

ferent feature types.

In this chapter, you will explore some of the more complex and curvy modeling techniques 

used to create models with the Autodesk® Inventor® and Autodesk® Inventor LT™ programs. 

Some of these features involve creating a base profi le sketch along with support sketches used 

for defi ning paths and shape contours. Such features are based on the same rules used to cre-

ate simpler features, such as extrudes and revolves, but they take it to the next level by using 

multiple sketches to defi ne the feature. Other advanced features covered in this chapter depart 

from these concepts and move into the new territory of feature creation. In either case, having a 

strong understanding of sketch-creation and editing principles is assumed and recommended.

All the skills in this chapter are primarily based on creating a single part, whether in a part 

fi le or in the context of an assembly fi le.

In this chapter, you’ll learn to:

 ◆ Create complex sweeps and lofts

 ◆ Work with multi-body and derived parts

 ◆ Utilize part tolerances

 ◆ Understand and use parameters and iProperties

 ◆ Troubleshoot modeling failures

Creating Complex Sweeps and Lofts

Now that you have moved on from creating simple features, you can explore the use of sweeps 

and lofts to create features with a bit more complexity. Both sweeps and lofts require one or 

more profi les to create a fl owing shape. Sweeps require one sketch profi le and a second sketched 

sweep path to create 3D geometry. Lofts typically require two or more sketch profi les and 

optional rails and/or points that assist in controlling the fi nal geometry.

Certification
Objective
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Creating and Using Sweeps
You can think of a sweep feature as an extrusion that follows a path defi ned by another sketch. 

2D or 3D sketch paths can be used to create the sweep feature. Like most Inventor geometry, a 

sweep can be created as either a solid or a surface. Sweeps can add or remove material from a 

part, or you can use the Intersect option as you can with the Extrusion tool. If your intent is to 

create multi-body parts, you can choose the New Solids option also.

Creating D Paths

When creating a sweep feature, you will typically want to fi rst create the path sketch and then 

create a profi le sketch that will contain the geometry to be swept along the path. To create the 

profi le sketch, you will need to create a work plane at the end of your path. This plane will be 

referenced to create a new sketch. It’s not mandatory that you create the path and then the pro-

fi le, but it is easier to defi ne the profi le sketch plane (that is, a work plane) by doing it this way. 

Normally, this geometry will be perpendicular to one end of the sweep path.

A basic rule of sweep features is that the volume occupied by the sweep profi le may not 

intersect itself within the feature. Some self-intersecting features are currently supported, but 

many will fail. An example of a self-intersecting feature is a sweep path composed of straight-

line segments with tight radius arcs between the segments. Assuming that the sweep profi le is 

circular with a radius value larger than the smallest arc within the sweep path, the feature will 

self-intersect and the operation will fail. For a sweep to work, the minimum path radius must be 

larger than the profi le radius. In the 2D sketch path example shown in Figure 5.1, the path radius 

is set at 12 mm. Knowing that the minimum path radius value is 12 mm, you can determine that 

the sketch profi le radius must be less than or equal to this value.

Figure 5.1

2D sketch path

Creating the Sweep Profile

Once a sketch path has been created, you can create a work plane on the path and then sketch 

the profi le on that plane. To see this process in action, follow these steps, starting with the cre-

ation of the path:

 1. On the Get Started tab, click the New button.

 2. On the Metric tab of the New File dialog box, select the Standard(mm).ipt template.

 3. Create a 2D sketch as shown in Figure 5.1.

 4. Once you’ve created the sketch path, right-click and choose Finish Sketch; then click the 

Plane button on the 3D Model tab to create a work plane.

 5. Select the endpoint of the 2D sketch path and then the path itself to create the plane. This cre-

ates a plane on the point normal to the selected line. Figure 5.2 shows the created work plane.
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Figure 5.2

Creating a work 

plane on which to 

sketch

 6. Once you’ve created the work plane, right-click the edge of it and select New Sketch.

 7. In the new sketch, use the Project Geometry tool to project the 230 mm line into this new 

sketch. It should come in as a projected point.

 8. Create a circle anchored to the projected point, give it a value of 20 mm in diameter, and 

then click the Finish Sketch button.

 9. Select the Sweep tool. If you have a single sweep profi le, it should automatically select the 

profi le and pause for you to select a path.

 10. Select a line in the path sketch to set it as the path.

Note that you can select either Solid or Surface for the feature. The sweep type will 

default to Path, and the orientation will default to Path as well. The Sweep tool also has 

an option to taper the sweep feature, as shown in Figure 5.3.

Figure 5.3

Sweep dialog box 

options

A number less than zero for the taper will diminish the cross section as the profi le fol-

lows the path. A positive number will increase the cross section. If the taper increases the 

cross section at the radius of the path to a value that exceeds the radius value, the feature 

will fail because this will create a self-intersecting path.

 11. Adjust the taper to a negative value to see the preview update. Note that if you enter a 

positive value that’s 0.5 or more, the preview will fail, indicating a self-intersecting path. 

Set the taper back to 0, and click the OK button to create the sweep.

You’ll notice that this sweep feature consumes both sketches in the browser, just as an 

extruded feature consumes the sketch it is created from. To edit the sweep, you can expand 
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the browser node by clicking the plus sign and access both the profi le and path sketches to 

make edits. You can also right-click the sweep feature node and choose Edit Feature to change 

the options in the Sweep dialog. Explore the ways to edit the sweep you just created, and then 

you can close the fi le without saving changes. In the next section you will look at more sweep 

options.

Exploring Sweep Options
Although sweeping along a path is the default option, you can also utilize the Path & Guide Rail 

or Path & Guide Surface option to control the output of the Sweep tool. These options provide 

additional control for more complex results. Often these options are utilized on sweeps based on 

a 3D sketch path, but this is not required. You can create a 3D sketch path by using the Include 

Geometry tool, or you can just use the existing geometry edges where valid selections exist.

Path & Guide Rail Option

The Path & Guide Rail option provides a means to control the orientation of a profi le as it is swept 

along a path. In Figure 5.4, the rectangular sweep profi le will be swept along the straight path but 

controlled by the 3D helical rail. This approach is useful for creating twisted or helical parts.

Figure 5.4

Sweep profi le, Path 

& Guide Rail option

The 3D helical rail is guiding the rotation of the profi le even though the sweep profi le is 

fully constrained with horizontal and vertical constraints. Creating this part starts with creat-

ing the sweep path as the fi rst sketch followed by creating a second sketch perpendicular to the 

start point of the sweep path. The 3D helical rail is created using the Helical Curve tool in a 3D 

sketch. Follow these steps:

 1. Open the fi le mi_5a_004.ipt from the Chapter 05 directory of your Mastering 

Inventor 2014 folder. If you have not already downloaded the Chapter 5 fi les from 

www.sybex.com/go/MasteringInventor2014, please refer to the “What You Will Need” 

section of the Introduction for the download and setup instructions.

 2. Click the Sweep button on the 3D Model tab.

 3. Change the Type drop-down to Path & Guide Rail, choose the straight line as the path 

and the helix as the guide rail, and then click the OK button. Your result should resemble 

Figure 5.5.
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Figure 5.5

Sweep feature with 

Path & Guide Rail 

option

Using guide rails to control the path and further defi ne the shape of the sweep greatly 

expands the range of shapes you can create with the Sweep tool. You can close the current fi le 

without saving changes and take a look at the use of a guide surface in the next section.

Path & Guide Surface Option

At times you will need to sweep a profi le that will conform to a specifi c shape and contour. This 

is often necessary when working with complex surfaces, particularly when cutting a path along 

such a surface. In the following exercise, you will use some surface tools to manipulate a solid 

shape while exploring the sweep guide’s Surface option:

 1. On the Get Started tab click Open, and open the fi le mi_5a_006.ipt from your 

Chapter 05 folder.

 2. Click the small arrow on the Surface panel of the 3D Model tab to see the Replace Face 

tool. Figure 5.6 shows the Surface panel expanded.

Figure 5.6

Surface tools

 3. Click the Replace Face tool, select the red face as the existing face, select the wavy surface 

for the new face, and fi nally, click the OK button.

 4. Right-click ExtrusionSrf1 in the browser, and select Visibility to turn it off.

 5. Click the Plane button on the 3D Model tab, click and hold down on the yellow surface, 

and then drag up to create an offset work plane at 85 mm.

 6. Right-click the edge of the work plane, and choose New Sketch.

Certification
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 7. Use the Project Geometry tool, and select the wavy face. This will result in a projected 

rectangle in your sketch.

 8. Create a circle with the center point at the midpoint of the projected rectangle and the 

tangent point on the corner of the rectangle so that your results look like the image on the 

left of Figure 5.7. Click the Finish Sketch button to exit the sketch.

Figure 5.7

Creating a sweep 

path

 9. Click the Create 3D Sketch button on the Sketch panel, or right-click in the empty space of 

the graphics window and choose New 3D Sketch from the context menu.

 10. Click the Intersection Curve tool from the 3D Sketch tab, and choose the circle and the 

wavy face. Finish the 3D sketch and turn off the visibility of the 2D sketch and the work 

plane. The result will be a curve, as shown on the right of Figure 5.7.

 11. Create a 2D sketch on the front face, as shown in Figure 5.8. Be sure to select the projected 

edges and make them construction lines so that Inventor won’t pick up the entire front 

face as a sweep profi le. The top two corners will be coincident to the curved construc-

tion line along the top. When the sketch is fully constrained and completed as shown in 

Figure 5.8, click Finish Sketch.

Figure 5.8

Creating a sweep 

profi le 7

7
3

 12. Select the Sweep tool, and choose the profi le you just sketched for the profi le input.

 13. Select the 3D intersection curve for the path.
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 14. Click the Cut button to ensure that this sweep removes material from the part, and click 

the OK button.

 15. The resulting cut sweep will be too shallow in some places, as shown on the left of 

Figure 5.9.

Figure 5.9

Path vs. Path & 

Guide Surface

 16. Edit the sweep, and set the Type drop-down to Path & Guide Surface. Select the wavy 

surface as the guide surface, and then click the OK button. The result will look like the 

image on the right of Figure 5.9.

Using a guide surface to match the exact curvature of a complex shape is often the only way 

to achieve the type of features found on plastic parts and other consumer products of stylized 

form. You can close this fi le without saving changes and move on to the next section to explore 

lofted features.

Sweep along an Edge

It’s often useful to sweep a profi le along an existing edge or edges in order to create a complex 

sweep shape. In the past you might have been required to create a 3D sketch beforehand and 

use the Include Geometry option. But you can now just use the edges for the sweep path, and 

Inventor will create the 3D sketch and included geometry for you, as demonstrated in the fol-

lowing steps:

 1. On the Get Started tab click Open, and open the fi le mi_5a_007.ipt from your Chapter 

05 folder.

 2. Click the Sweep button on the 3D Model tab.

 3. The profi le should be selected automatically since there is just one sketch to use. Select 

the outer edge of the part for the sweep path.

 4. Click the OK button to create the sketch.

 5. Expand the sweep feature in the browser and notice the presence of the automatically 

created 3D sketch.

As you can see, setting up a part fi le to use the edges for a sweep path can provide a quick 

and powerful way to create otherwise diffi cult features. You can close this fi le without saving 

changes and continue on to explore loft features.
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Creating Loft Features
Whereas a sweep allows the creation of single profi le extruded along a path, loft features allow 

the creation of multiple cross-sectional profi les that are used to create a lofted shape. The Loft 

tool requires two or more profi le sections to function. Rails and control points are additional 

options that help control the shape of a loft feature. A good example of a lofted shape is a 

boat hull.

Loft with Rails

You could create a boat hull by defi ning just the section profi les, but you can gain more control 

over the end result by creating a loft with rails. Figure 5.10 shows the completed wireframe 

geometry to create a section of a boat hull. The geometry includes four section sketches, each 

composed of a 2D spline sketched onto a work plane. There are two rails: the top and bottom 

composed of 3D sketch splines.

Figure 5.10

Loft with rails 

geometry

Follow these steps to explore the creation of a loft feature with the use of rails:

 1. On the Get Started tab click Open, and open the fi le mi_5a_008.ipt found in your 

Chapter 05 folder.

 2. Select the Loft tool in the 3D Model browser.

 3. Since the four section sketches are open profi les, the Loft tool will automatically set the 

output to Surface. Select the four cross-section sketches in consecutive order, front to back 

or back to front.

 4. Click the Click To Add button in the Rails section of the dialog box, and select 3D 

sketches named Rail1 and Rail2.

 5. If you have the Preview option selected at the bottom of the dialog box, you should see a 

preview of the surface indicating the general shape, as shown in Figure 5.11. Click the OK 

button, and the surface will be created.
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Figure 5.11

A surface loft 

with rails

Patch and Stitch Surfaces

That concludes the lofting part of the boat hull, but if you’d like, you can continue with the 

following steps to learn a bit more about working with surfaces:

 1. To fi nish the hull, select the Mirror tool on the Pattern panel of the 3D Model tab.

 2. Select the hull surface for the Features selection, and then click the Mirror Plane button.

 3. Expand the Origin folder in the browser, click YZ to use it as the mirror plane, and click 

the OK button.

 4. Next, you will create a 3D sketch to create a line for the top edge of the transom (back of 

the boat); right-click in the graphics window, and choose New 3D Sketch.

 5. On the 3D Sketch tab, click the Line tool and draw a line across the back of the boat to 

form the top of the transom. Draw another line across the bottom of the transom where 

the two sides do not quite meet. Figure 5.12 shows the back of the boat with the 3D sketch 

lines.

Figure 5.12

3D sketch lines for 

the transom

 6. Click Finish Sketch when the lines are drawn.
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Turning Off the Translucency of Surfaces to See Better

If you have diffi  culty seeing the endpoints when attempting to draw the 3D Sketch line, you can 

expand the mirror feature in the browser, locate the loft surfaces, and then right-click and deselect 

Translucent.

 7. Select the Boundary Patch tool on the Surface panel, and ensure the Automatic Edge 

Chain option is not selected. Then select your 3D sketch lines and the back curved edges 

to create a surface for the transom. When creating boundaries, you need to select the lines 

in the order in which they occur in the boundary. Click the Apply button, and then create 

another boundary patch across the top by selecting the two edges of the sides and the top 

edge of the transom. Figure 5.13 shows the selections.

Figure 5.13

Boundary patch 

selections

 8. You’ll notice the gap in the base of the hull. Use the Boundary Patch tool to create a 

surface by clicking both edges of the gap and the small edge at the bottom of the transom.

 9. Select the Stitch tool on the Surface panel, and select all fi ve of the surfaces you created. 

It’s easiest to window-select them all at once.

 10. Click the Apply button and then the Done button.

Using the Shell Tool

You should now have a solid boat. If you didn’t complete the previous exercise, you can open the 

fi le mi_5a_009.ipt to explore the Shell tool. If you’re continuing with the boat you created from 

the loft exercise, be sure to save your fi le. This is just good practice before running calculation-

intensive operations like the Shell tool, particularly on free-form shapes like this boat hull. Once 

you’ve saved your fi le or opened the one provided, follow these steps to explore the Shell tool:

 1. Once your fi le has been saved, select the Shell tool on the Modify panel of the 3D 

Model tab.

 2. Click the top face for the Remove Faces selection, and set Thickness to 10 mm.

If your system is a bit undersized, you might want to skip the next two steps and click 

the OK button now to let the shell solve for just one thickness. Otherwise, you’ll specify a 

unique thickness for the transom.

 3. Click the >> button to reveal the Unique Face Thickness settings, click the Click To Add 

row, and then click the transom face.
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 4. Set the unique face thickness value to 30 mm, and click the OK button to build the shell. 

Figure 5.14 shows the completed boat.

Figure 5.14

Th e completed boat 

Although at this point you have gone far past the initial lofted surface to fi nish the boat 

model, you started out by creating a loft from the 2D sketch profi les and then used the 3D 

sketches as rails to further defi ne the shape. Of course, if you are a boat designer, you might 

see a few areas of the design that need improvement. But, for now, you can close the fi le without 

saving changes and move on to explore the area loft options in the next section.

Area Loft

Area loft is used in the design of components where the fl ow of a gas or liquid must be precisely 

controlled. Area loft is a different way of controlling the fi ner points of creating a loft shape. 

Figure 5.15 illustrates what might be considered a fairly typical loft setup, consisting of three 

section profi les and a centerline. The goal here is to create a loft from these profi les and to create 

a fourth profi le to control the airfl ow through the resulting part cavity so that it can be choked 

down or opened up as needed.

Figure 5.15

Area loft profi les
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Follow these steps to explore the creation of an area loft:

 1. On the Get Started tab click Open, and open the fi le mi_5a_010.ipt from your Chapter 

05 folder.

 2. Start the Loft tool, and select the three sections in order, starting with the small rectangu-

lar shape.

 3. Right-click, choose Select Center Line, and then click the centerline sketch line running 

down the middle of the profi le sketches.

 4. Right-click again, and choose Placed Sections; notice as you choose an option from the 

context menu that the dialog box updates to refl ect your selections. You could have just as 

easily used the dialog box controls to do this, but oftentimes it is easier not to create the 

extra mouse travel.

 5. Slide your mouse pointer over the centerline, and then click roughly halfway between the 

circular section and the middle section.

Once you click a location, the Section Dimensions dialog box appears, as shown in 

Figure 5.16, giving you control over the position and section area of the placed section. 

You can switch the position input from Proportional Distance, where you enter a percent-

age of the centerline length, to Absolute, which allows you to enter an actual distance if 

you know it.

Figure 5.16

Section Dimensions 

dialog box

In the Section Size area, you specify the actual area or set a scale factor based on the area 

of the loft as calculated from the sections before and after the one you are creating. On the 

far left, you can switch the section from driving to driven, letting the area be calculated 

from the position. Any number of placed sections can be used to create precise control of 

the feature.

 6. Leave Section Position set to Proportional Distance, change the position to 0.75, set the 

area to 800 (as shown in Figure 5.16), and click the OK button. You can access the section 

again by double-clicking the leader information.

 7. Double-click the End section leader text, and change it from Driven to Driving using the 

radio buttons on the left. Notice that you can set the area but not the position.

 8. Change the area to 800, and then click the OK button in the Section Dimensions dialog 

box. Then click the OK button in the Loft dialog box to create the lofted solid.

Figure 5.17 illustrates the placed loft section and the modifi ed end section.
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Figure 5.17

Creating an 

area loft

Position = (End)
Area = (800.0000000 mm  2)

Position = .75
Area = 800.0000000 mm  2

Position = (0.308995)
Area = (1454.1155300 mm  2)

Position = (Start)
Area = (827.4691800 mm  2)

You may have noticed that by changing the end section to an area of 800 square millimeters, 

you altered the size of the end profi le from the original shape, in this case slightly reducing the 

diameter of the circle. Keep this in mind as you create area lofts, and you can use the original 

sketch to just rough in the shape and not worry as much about getting the size exactly right 

until you refi ne the area loft profi le. Of course, as always, you should still fully constrain the 

sketch profi le. You can close this fi le without saving changes and have a look at the centerline 

loft options in the next section.

Centerline Loft Feature

The centerline loft feature allows you to determine a centerline for the loft profi le to follow, just 

as you did with the area loft. In the following steps, you’ll create a wing feature using the center-

line loft and look at some of the condition options available in lofted features as well:

 1. On the Get Started tab click Open, and open the fi le mi_5a_012.ipt from your Chapter 

05 folder.

 2. Click the Loft button, and select the yellow face of the wing stub feature and the sketch 

point at the end of the arc as sections.

 3. Right-click, choose Select Center Line, and then click the arc. Notice how the lofted shape 

now holds the centerline, as shown in Figure 5.18.

Figure 5.18

A loft with and 

without centerline
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 4. Click the Conditions tab in the Loft dialog box so you can control the curve weight and 

transition type at the work point and wing stub profi le.

 5. Click the drop-down next to the Edges1 (Section) and set it to Tangent. Change the weight 

to 0.5 to adjust the blend from the wing stub feature.

 6. Click the small drop-down to set Point Sketch2 to Tangent and then set the weight to 1.5.

 7. Currently, the loft is extending out past the work plane. Often, this can be a problem 

because the work plane may have been established for the overall length of the part. To 

resolve this, set the drop-down to Tangent To Plane, and select the work plane on the 

screen. Notice the adjustment. Figure 5.19 shows the preview of the adjustments before 

and after the tangent plane is selected.

Figure 5.19

Adjusting curve 

weight and condi-

tion of the loft

 8. Click the OK button, and examine your lofted shape.

 9. You can use the Mirror tool to mirror the loft you just created and the wing stub feature 

using the work plane in the tail area.

Feel free to edit the loft to adjust the shape of the wing to something a bit more to your liking. 

Here is the full list of conditions available, depending on the geometry type:

Free Condition  No boundary conditions exist for the object.

Tangent Condition  This condition is available when the section or rail is selected and is 

adjacent to a lateral surface, body, or face loop.

Smooth (G2) Condition  This option is available when the section or rail is adjacent to a 

lateral surface or body or when a face loop is selected. G2 continuity allows for curve conti-

nuity with an adjacent previously created surface.

Direction Condition  This option is available only when the curve is a 2D sketch. The angle 

direction is relative to the selected section plane.

Sharp Point  This option is available when the beginning or end section is a work point.
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Tangent  This option is available when the beginning or end section is a work point. 

Tangency is applied to create a rounded or dome-shaped end on the loft.

Tangent To Plane  This option is available on a point object, allowing the transition to 

a rounded dome shape. The planar face must be selected. This option is not available on 

centerline lofts. 

The angle and weight options on the Conditions tab allow for changes to the angle of lofting 

and the weight value for an end condition transition. In this example, if the endpoint condi-

tion is changed to Tangent on the work point, the weight is automatically set to 1 and can be 

adjusted. Click the weight, and change it to 3 to see how the end condition will change in the 

preview. Experiment with the weight to see the changed conditions. If a value is grayed out, the 

condition at that point will not allow a change. Keep in mind that adding more intermediate 

profi les to the loft is often the best way to control and defi ne a specifi c loft shape.

Creating a Part Using Loft and Sculpt
It is often useful to create lofted surfaces when curved corners of differing radii are present. 

In the next exercise you’ll use the Loft tool to create the gently sloping edges of a tablet device 

housing. Then you’ll use the Mirror tool to duplicate the surface, and fi nally you’ll use the 

Sculpt tool to convert the enclosed surface into a solid.

 1. On the Get Started tab click Open, and open the fi le mi_5a_015.ipt from your Chapter 

05 folder.

 2. Click the Loft button, and set the output to be a surface using the Output button.

 3. Select sections End Profi le1 and End Profi le2 from the browser.

 4. Right-click and choose Select Rails, and select the 3D sketches named Top Rail and 

Bottom Rail from the browser.

Figure 5.20 shows the Loft dialog box and model preview with the selections made.

Figure 5.20

Creating a 

surface loft

Selecting the sketches from the browser isn’t required, but it does eliminate the chance 

that you might accidentally select an edge rather than the sketch if you try to select them 

on-screen.

 5. Click the OK button to create the lofted surface.



216 | CHAPTER 5 ADVANCED MODELING TECHNIQUES

 6. Use the Stitch tool (found on the Surface panel of the 3D Model tab) to stitch the lofted 

surface you just created and Boundary Patch1 together.

 7. Use the Mirror tool (found on the Pattern panel of the 3D Model tab) to mirror the 

stitched surface, Extrusion1, Split1, and Fillet1. Use the YZ plane found in the Origin 

folder as the mirror plane selection.

 8. Use the Mirror tool again, and this time select the mirror feature you just created as the 

feature to mirror and use the XZ plane found in the Origin folder as the mirror plane 

selection.

 9. Use the Sculpt tool and select all four quadrants of the surfaces as the surfaces selection. 

Your result should look like Figure 5.21.

Figure 5.21

A solid model 

created from 

surface lofts and 

the Sculpt tool

Creating Multi-Body Parts

It is possible to create a multi-body part fi le with separate solids representing each part of an 

assembly and then save the solids as individual parts, even having them automatically placed 

into an assembly. Creating multiple solid bodies in a single-part fi le offers some unique advan-

tages compared to the traditional methods of creating parts in the context of an assembly fi le. 

For starters, you have one fi le location where all your design data is located. Second, it is often 

easier to fi t parts together using this method by simply sketching one part right on top of the 

other, and so on.

These two advantages are also the main two disadvantages. Placing large amounts of data 

(and time and effort) into a single fi le can be risky should that fi le be lost. And creating a part 

with an overabundance of interrelated sketches, features, and solid bodies can create a “house 

of cards” situation that makes changing an early sketch, feature, or solid a risky endeavor. Used 

wisely, though, multi-body parts are a powerful way to create tooling sets, molds, dies, and 

other interrelated parts.

If you do large-machine design, you would be wise to create many smaller, multi-body part 

fi les rather than attempting to build one large one. Or you might fi nd that using multi-body 

parts will work well for certain interrelated components whereas using traditional part/assem-

bly techniques works for the rest of the design.
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Creating Multiple Solids
In the following steps, you’ll explore the creation of multi-body parts by building a simple trig-

ger mechanism. The challenge here is to defi ne the pawl feature on the trigger lever as it relates 

to the hammer bar. Figure 5.22 shows the trigger mechanism in its set position on the left and at 

rest on the right.

Figure 5.22

A simple trigger 

assembly

15

?

As the trigger lever is engaged, the hammer bar overcomes the pawl (lip), and the spring is 

allowed to force the hammer bar to swing. In the following steps, you’ll explore the multi-body 

solid options as you use one solid to determine the precise fi t with the other:

 1. On the Get Started tab click Open, and open the part named mi_5a_016.ipt from your 

Chapter 05 folder.

 2. Create a sketch on the front face of the plate.

 3. Create a rectangle, as shown in Figure 5.23, using the top hole as a reference to anchor the 

rectangle.

 4. Extrude the rectangle 3 mm away from the plate, and use the New Solid option in the 

Extrude dialog box (leave the circle unselected from your extrude profi le so that you end 

up with a hole).

 5. When you click the OK button, you’ll see that the Solid Bodies folder in the model tree 

now shows two bodies present, one representing the base plate and another representing 

the hammer bar.

 6. Create another sketch on the front of the plate, and create another rectangle toward the 

bottom, referencing the end of the hammer bar as shown in Figure 5.24.
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Figure 5.23

Th e hammer-bar 

sketch

Figure 5.24

Th e trigger-lever 

sketch

 7. Extrude the rectangle 3 mm away from the plate, use the New Solid option in the Extrude 

dialog box, and then click the OK button. This completes the base feature for the trigger 

lever.

 8. Expand the Solid Bodies folder in the browser and notice that there are three solids 

listed (if you see fewer than three, edit your extrusions, and make sure you used the New 

Solid option).

 9. Double-click the text that is your hammer bar, and rename it Hammer Bar, for reference 

later.

 10. Right-click the solid that is your trigger lever and choose Properties. In the resulting 

dialog box, set the name to Trigger Lever and change the color to blue; then click the OK 

button.

Here are several things to note at this point:

 ◆ If you expand the browser node for each solid listed in the Solid Bodies folder, you can 

see the features involved in each.

 ◆ You can right-click a solid or solids, choose Hide Others to isolate just the selected ones, 

and then use Show All to bring back any hidden solids.

 ◆ You can select the solid and then choose a color style from the Color Override drop-down 

on the Quick Access bar (at the very top of your screen).
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 ◆ You can right-click each solid and choose Properties to set the name and color, view the mass 

properties, and strip previously overridden values. For instance, if you set just the front face 

of one of the solids to be red and then decided you wanted the entire solid to be blue, you 

could use the Strip Overrides option to remove the red face and set the solid to blue. If you 

did not use the Strip Overrides option, the red face would remain red and the other faces 

would become blue.

Using One Solid to Shape Another

Next, you’ll create the pawl notch in the trigger lever. To do so, however, you will fi rst make a 

copy of the hammer bar and then turn that solid into a combined solid that represents the 

hammer bar in both the set and resting positions. After that, you’ll cut that solid away from 

the trigger lever. You can continue on with the fi le from the previous steps or open the part 

named mi_5a_017.ipt from your Chapter 05 folder. Then follow these steps:

 1. Use the ViewCube to change the view so that you can see the cylindrical face of the hole 

in the hammer bar, and then choose the Circular Pattern tool on the Patterns panel.

 2. Select the Pattern A Solid button, and click the hammer bar for the Solid selection.

 3. Click the edge or face of the top hole for the rotation axis, and set the placement count 

and angle to 2 and 15 degrees, respectively.

 4. Use the button at the top-right corner of the dialog box to set the output to Create New 

Solid Bodies (the rightmost button), as shown in Figure 5.25.

Figure 5.25

A circular pattern 

to create a new solid

 5. Ensure that the rotation direction is counterclockwise; use the Flip button if it is not, and 

then click the OK button.

If you expand the Solid Bodies folder in the browser, you will see that there are now 

four solids, the last being the patterned copy of the hammer bar. You will now turn the 

visibility of the original hammer bar off and use the copy to cut a pawl notch in the 

trigger plate.

 6. Right-click the solid named Hammer Bar in the Solid Bodies folder and choose 

Visibility to hide that solid.
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 7. Select the Circular Pattern tool again, and choose the Pattern A Solid option, as you did 

previously.

 8. Click the edge or face of the top hole for the rotation axis, and set the placement count 

and angle to 2 and 15 degrees, respectively.

 9. Set the rotation direction to go clockwise using the fl ip button. This should place the 

patterned copy in place of the original hammer bar.

 10. This time use the buttons at the top-right corner of the dialog box to set the output to 

Join, and then click the OK button. This will merge the selected solid with the new 

patterned one. Figure 5.26 shows the selections.

Figure 5.26

Using a circular 

pattern to join a 

copy to another 

solid

 11. Select the Combine tool on the Modify panel, and select the blue trigger lever for the Base 

selection.

 12. Select the fused, rotated body for the Toolbody selection, and then set the operation type 

to Cut so that you are subtracting it from the trigger lever. Then click the OK button.

 13. Select any solid in the Solid Bodies folder, and choose Show All to turn the visibility of 

all solids back on.

Now that you’ve solved the trigger-pawl shape and size by using a multi-body part, you 

could fi nish the parts by adding features to each body. You’ll note that if you create an extru-

sion, for instance, you can select which solid to add that extrusion to. If it is a cut extrusion, you 

can select multiple bodies and cut them all at once. The same is true of fi llets, holes, and so on.

Move and Rotate Solid Bodies

You can also use the Move Bodies tool to reposition solids once they are created. Try it on your 

trigger-mechanism parts. Note that to free-drag a solid you have to click the edges or outlines 

of the preview object rather than on the original object as you might suppose. You can also cre-

ate a rotation using the Move Bodies tools, or you can move and rotate a body at the same time 

by creating a two-line action in the Move Bodies dialog box. Figure 5.27 shows the Move Bodies 

options.
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Figure 5.27

Moving a solid body 

within a part fi le

The options are as follows:

Free Drag  Move via X, Y, or Z Offsets or, better yet, just click the preview and drag it.

Move Along Ray  Select an edge or axis to defi ne the move direction, and then specify an 

offset value or just click and drag it in that direction.

Rotate  Select an edge or axis to defi ne the rotational pivot, and then specify an angle or 

click and drag it.

Click To Add  Create as many move actions as you want and do them all at once.

Split Solids

Another tool that you may fi nd useful when working with multi-body parts is the Split tool. For 

instance, if you create a simple solid block by sketching a rectangle on the XY plane and then 

extruding it 40 mm in both directions, you could then use the XY plane as a parting line to split 

the solid into two separate solids. You could also create a sketched curve, extrude it as a surface, 

and use it to split the solid.

Make Part and Make Components

Once you have created your multi-body part, you can write out each solid as an individual part 

fi le. The resulting part fi les are known as derived parts. You can think of these derived parts as 

just linked copies of the solid bodies. If you make a change in the multi-body part, it will update 

the derived part. You can break the link or suppress the link in the derived part as well. Using 

the Make Part and Make Components tools allows you to detail each solid body individually in 

separate drawings. If you attempt to detail the multi-body part in the drawing, you will see all 

the solids at once. There is no control to turn off individual solid bodies in a drawing view.

Additionally, you can choose to take your multi-body part and write the whole thing to an 

assembly. The assembly will consist of all the derived parts placed just as they exist in the multi-

body part. These fi les will be grounded in place automatically so that no Assembly constraints 

are required to hold them in place. If you decide you would like to apply constraints to all or 

some of the parts, you can unground them and do so, as well as organize them into subassem-

blies, and so on.

You should be aware, too, that any additional modeling that you do in the derived part 

or assembly will not push back to the multi-body part fi le. Although this may seem like a 
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limitation, it can also be viewed as a good thing, allowing for the separation of design tasks that 

some design departments require. Here are the general steps for creating components from a 

multi-body part fi le:

 1. Click the Make Components button on the Manage tab, and then select the solid bodies 

from which you want to create parts.

 2. Select additional solids to add to the list or select from the list, and click Remove From 

Selection to exclude any solids that you decide you do not want to create parts from.

 3. Select Insert Components In Target Assembly, and then set the assembly name, the tem-

plate from which to create it, and the save path, or clear this option to create the parts 

only. If the assembly already exits, use the Target Assembly Location’s Browse button to 

select it.

 4. Click Next to accept your selections, shown in Figure 5.28.

Figure 5.28

Th e Make 

Components: 

Selection dialog box

 5. The next dialog box allows you to name and set paths for the derived parts. Click the cells 

in the table to make changes for the parts as required:

 ◆ Click or right-click a cell to choose from the options for that cell type, if any.

 ◆ You can Shift-select multiple components and use the buttons above the Template and 

File Location columns to set those values for multiple parts at once.

 6. Click Include Parameters to choose which layout model parameters to have present in the 

derived parts.

 7. Click the Apply button or the OK button to make the components (Figure 5.29). If the 

component fi les are created in an assembly, the assembly fi le is created with the parts 

placed and left open in Inventor, but the assembly and parts are not saved until you 

choose to do so. If you choose to create the parts without an assembly, you are prompted 

to save the new fi les.

You can set default behaviors of the Make Components dialog box in a multi-body part fi le 

(or a template fi le) by selecting the Tools tab, clicking Document Settings, selecting the Modeling 
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tab in the dialog box that opens, and clicking the Options button. Figure 5.30 shows these 

options.

Figure 5.29

Th e Make 

Components: 

Bodies dialog box

Figure 5.30

Setting the Make 

Components 

Options defaults
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Creating Derived Parts and Assemblies
You can create parts derived from other components using the Derive tool. Common uses of 

the Derive tool are to create scaled and mirrored versions of existing parts, to cut one part from 

another part, and to consolidate an assembly into a single-part fi le. Nonlinear scaling is accom-

plished using an add-in available in the Inventor installation directory.

Creating Derived Parts
Derived parts are base solids that are linked to the original feature-based part. Modifi cations 

to the derived part in the form of additional features are allowed. Original features are modi-

fi ed in the parent part, and changes to the parent part are moved to the derived part upon save 

and update. There is no reasonable limit to the number of times the parent part or succeeding 

derived parts can be derived again into more variations.

Deriving a Part File

To derive a single-part fi le, follow these steps:

 1. From a new part fi le, select the Manage tab, and then click the Derive button.

 2. In the Open dialog box, browse to the part fi le, and then click the Open button.

 3. Select from one of these derived styles:

 ◆ A single solid body with no seams between faces that exist in the same plane

 ◆ A single solid body with seams

 ◆ One or more solid bodies (if the source part contains multiple bodies)

 ◆ A single surface body

 4. Use the status buttons at the top to change the status of all the selected objects at once, or 

click the status icon next to each individual object to set the include/exclude status.

 5. Optionally, click the Select From Base button to open the base component in a window to 

select the components.

 6. Specify the scale factor and mirror plane if desired.

 7. Click the OK button.

If the part being derived contains just one body, it is displayed on-screen. If the part being 

derived is a multi-body part with only a single body set as visible in the part, it is displayed on-

screen. If the part being derived is a multi-body part with more than one visible body, none of 

the bodies are displayed on-screen. Select the bodies to include by expanding the Solid Bodies 

folder and toggling the status. To include all bodies, select the Solid Bodies folder, and then 

click the Include Status button. Figure 5.31 shows the Derived Part dialog box.
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Figure 5.31

Derived Part 

options

Deriving an Assembly File

To derive an assembly fi le, follow these steps:

 1. From a new part fi le, select the Manage tab, and then click the Derive button.

 2. In the Open dialog box, browse to the assembly fi le, and then click the Open button.

 3. Select from one of these derived styles:

 ◆ A single solid body with no seams between faces that exist in the same plane

 ◆ A single solid body with seams

 ◆ One or more solid bodies (if the source part contains multiple bodies)

 ◆ A single surface body

 4. Use the status buttons at the top to change the status of all the selected objects at once, or 

click the status icon next to each individual object to set the include/exclude status.
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 5. Optionally, click the Select From Base button to open the base component in a window to 

select the components.

 6. Click the Other tab to select which component sketches, work features, parameters, 

iMates, and part surfaces to include in the derived assembly.

 7. Click the Representations tab to use a design-view representation, positional representa-

tion, and/or level-of-detail representation as the base for your derived part.

 8. Click the Options tab to remove geometry, remove parts, fi ll holes, scale, and/or mirror 

the assembly.

 9. Click the OK button. Figure 5.32 shows the Derived Assembly dialog box.

Figure 5.32

Derived Assembly 

dialog box options

Modifying Derived Parts
Often, you will need to modify a derived part source fi le after having derived it into a new part. 

To do so, you can access the source part or assembly from the Model browser of the derived part 

by double-clicking it in the browser or by right-clicking it in the browser and choosing Open 

Base Component. The original fi le is opened in a new window where you can make changes as 

needed. To update the derived part to refl ect changes to the source fi le, use the Update button 

found on the Quick Access bar (the top of the screen).

You can edit a derived part or assembly by right-clicking it in the browser and choosing 

Edit Derived Part or Edit Derived Assembly. This will open the same dialog box used to create 

the derived part so that you can change the options and selections you set when the derived 

part was created. Updates will be refl ected in the fi le when you click the OK button. The Edit 

Derived Part or Edit Derived Assembly options are unavailable if the derived part needs to be 

updated.

You can also break or suppress the link with the source fi le by right-clicking the derived 

component in the browser and choosing the appropriate option. Updates made to the source fi le 

will not be made to the derived part when the link is suppressed or broken. Suppressed links 

can be unsuppressed by right-clicking and choosing Unsuppressed Link From Base Component. 

Breaking the link is permanent; it cannot be restored.
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Using the Component Derive Tool
Another way to derive components is to use the Derive Component tool on the Assembly Tools 

tab while in an assembly fi le. This tool allows you to select a part on-screen (or select a subas-

sembly from the browser) and then specify a name for the new derived part fi le. You’ll then be 

taken into the new derived part fi le. The resulting derived part or assembly uses the default 

derive options and the active assembly representations as they are saved in the source fi le. You 

can use the edit option in the derived part to change the settings if needed.

Working with Patterns

Inventor includes two tools to create patterns:

 ◆ Circular Pattern tool

 ◆ Rectangular Pattern tool

The Circular Pattern tool does just what you’d expect it to: It patterns a feature or set of 

features around an axis. The Rectangular Pattern tool also does what you’d expect, plus more. 

Using the Rectangular Pattern tool, you can create a pattern along any curve. If you select two 

perpendicular straight lines, edges, or axes, the result will be a rectangular pattern. However, 

if you select an entity that is not straight, the pattern will follow the curvature of the selected 

entity.

Rectangular Patterns

Rectangular patterns use straight edges to establish the pattern directions. You can select a 

single feature or several features for use in the pattern. Be sure to check the Model browser to 

see that you have only the features that you intend to pattern-select, because it is easy to acci-

dentally select base features when attempting select negative cut features. Start your exploration 

of patterns by creating a simple rectangular pattern, as shown here:

 1. On the Get Started tab, click Open.

 2. Open the fi le mi_5a_018.ipt from your Chapter 05 directory.

 3. Click the Rectangular Pattern button found on the Pattern panel of the 3D Model tab.

 4. With the Features button enabled, select the three features whose names start with the 

word switch in the browser.

 5. Right-click, choose Continue to set the selection focus from Features to Direction 1, and 

then click the straight edge, indicated in Figure 5.33. Use the Flip Direction button to 

ensure that the direction arrow is pointing toward the round end of the part.

 6. Set the count to 4 and the spacing length to 10 mm.

 7. Click the red arrow button under Direction 2 to set it active, and then click the straight 

edge along the bottom, indicated in Figure 5.33.

 8. Set the count to 5 and the spacing length to 10 mm.
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 9. Click the Midplane check box in the Direction 2 settings to ensure that you get two 

instances of the pattern to each side of the original.

 10. Click the OK button, and you will see the resulting pattern.

Figure 5.33

Creating a 

rectangular pattern

Direction 1 
Direction 2 

Circular Patterns

You can pattern features around an axis using the Circular Pattern tool. Angular spacing 

between patterned features can be set in two ways:

Incremental  Positioning specifi es the angular spacing between occurrences. Example: four 

holes at 90-degree increments.

Fitted  Positioning specifi es the total area the pattern occupies. Example: four holes fi t 

into 90 degrees.

You can enter a negative value to create a pattern in the opposite direction, and you can use 

the Midplane check box to pattern in both directions from the original.

Continue from the previous exercise with the open fi le, or open mi_5a_020.ipt to start 

where that exercise ended:

 1. In the Model browser, select the end-of-part marker, and drag it down below the feature 

named Indicator Cut. Or right-click the feature named Indicator Cut and choose Move 

EOP Marker.

 2. Click the Circular Pattern button found on the Pattern panel of the 3D Model tab.

 3. With the Features button enabled, select the feature named Indicator Cut.

 4. Right-click and choose Continue to set the selection focus from features to axis.

 5. Select the center face of the feature named Indicator Stud Hole.

 6. Set the count to 4 and the angle to 90; then click the >> button.
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 7. In the Positioning Method area, click the Incremental option so that the four occur-

rences of the pattern are set 90 degrees apart rather than being fi t into a 90-degree span. 

Alternatively, you could set the angle to 360 and leave the positioning method to Fitted 

and get the same result.

 8. Click the OK button. Figure 5.34 shows the resulting circular pattern.

Figure 5.34

Creating a circular 

pattern

You’ll note that your patterned objects require some adjustments. One of the occurrences 

of the Indicator Cut interferes with the switch feature, and the one opposite of that does 

not cut through the part correctly (use the ViewCube to look underneath the part to see 

this clearly). To resolve this, you will fi rst edit the circular pattern and change the way 

the occurrences solve, and then you’ll suppress the occurrence of the switch feature in the 

rectangular pattern.

 9. Right-click the circular pattern in the browser and choose Edit Feature, or double-click it 

in the browser.

 10. Click the >> button to reveal the Creation Method area, and then select the Adjust option. 

This allows each instance of the pattern to solve uniquely based on the geometry of the 

model when the feature is using a Through or Through All termination solution.

 11. Click the OK button and examine the pattern again, and you’ll notice that the top 

instance of the indicator cut that was not cutting all the way through the part now is.

 12. Expand the rectangular pattern in the browser to reveal the listing of each pattern 

occurrence.

 13. Roll your mouse pointer over each occurrence node in the browser until you highlight 

the one that interferes with the circular pattern.

 14. Right-click that occurrence, and choose Suppress.

Any occurrence other than the fi rst can be suppressed to allow for pattern exceptions or to 

create unequal pattern spacing. Figure 5.35 shows the adjusted patterns.
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Figure 5.35

Th e adjusted 

patterns

Patterns along Curves

Although the Circular Pattern tool allows you to pattern objects around a center axis, it does 

not provide a way to keep the patterned objects in the same orientation as the original. To do so, 

you can use the rectangular pattern. Keep in mind that the term rectangular pattern is a bit of a 

misnomer; this tool might more accurately be described as a Curve Pattern tool because it allows 

you to select any curve, straight or not, and use it to determine the pattern direction(s). Continue 

from the previous exercise with the open fi le, or open mi_5a_022.ipt to start where that exer-

cise ended:

 1. In the Model browser, select the end-of-part marker, and drag it down below the feature 

named Pin Insert Path Sketch. Or right-click the sketch named Pin Insert Path Sketch and 

choose Move EOP Marker.

 2. Click the Rectangular Pattern button found on the Pattern panel of the 3D Model tab.

 3. With the Features button enabled, select the feature named Pin Insert Cut.

 4. Right-click and choose Continue to set the selection focus from Features to Direction 1.

 5. Click the sketched curve (line or arc).

 6. Set the count to 10, and notice that the preview extends out into space.

 7. Click the >> button to reveal more options.

 8. Click the Start button in the Direction 1 area, and then click the center of the Pin Insert 

Cut feature on-screen to set that center point as the start point of the pattern.

 9. Change the solution drop-down from Spacing to Curve Length, and note that the length 

of the sketch curve is reported in the length box.

 10. Change the solution drop-down from Curve Length to Distance, and then type 14 at the 

end of the length value to compensate for the start point and endpoint adjustments.

 11. Toggle the Orientation option from Identical to Direction 1 to see the difference in the 

two, and then set it back to Identical.
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 12. Click the OK button to set the pattern. Figure 5.36 shows the resulting pattern and the 

dialog box settings.

Figure 5.36

A pattern along 

a curve

Th e Coil Tool and Spiral Patterns
In addition to creating patterns based on edges and sketches, you can use surfaces to defi ne 

the pattern direction. In this exercise, you’ll use the Coil tool to create a surface coil to use as a 

pattern direction. You can continue on from the previous exercise with the open fi le, or you can 

open mi_5a_024.ipt to start where that exercise ended. Follow these steps:

 1. In the Model browser, select the end-of-part marker, and drag it down below the feature 

named Coil Pattern Sketch. Or right-click the sketch named Coil Pattern Sketch and 

choose Move EOP Marker.

 2. Click the Coil button found on the 3D Model tab.

 3. In the Coil dialog box, set the output to Surface.

 4. In the graphics area on-screen, choose the line segment in the Coil Pattern Sketch feature 

at the base of the part for the Profi le selection.

 5. Select the visible work axis in the center of the part for the Axis selection.

 6. Click the Coil Size tab, and set the type to Revolution and Height.
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 7. Set Height to 25 mm and Revolutions to 4.

 8. Click the OK button to create the coiled surface.

You’ll now create two work points based on the coil location for use in placing holes. 

Once the holes are placed, you can pattern them using the surface coil.

 9. Click the Point button on the Work Features panel of the 3D Model tab, and select the 

vertical tangent edge and the surface coil to create work points at the intersections, as 

shown in Figure 5.37.

Figure 5.37

Work points at the 

coils and tangent 

edge intersections

 10. Click the Hole tool on the 3D Model tab, and set the Placement drop-down to On Point.

 11. Select one of the work points for the Point selection, and then select the fl at side face of 

the part to establish the direction.

 12. Set the termination drop-down to To, and then select the inside circular face of the part.

 13. Set the diameter to 3 mm, and then click the Apply button.

 14. Repeat the previous three steps to place the second hole, and then click the OK button.

 15. Click the Rectangular Pattern button on the 3D Model tab.

 16. Click the two holes for the features (it might be easiest to select them from the browser), 

and then right-click and choose Continue.

 17. Select the surface coil for Direction 1, and use the Flip button to change the direction so 

that you see the previewed pattern.

 18. Set the count to 10 and the length to 10 mm.

 19. Click the >> button, and choose Direction 1 for the orientation.

 20. Set the Compute option to Adjust, and then click the OK button to create the pattern.

 21. Right-click the coil and work points, and turn off the visibility of these features to see the 

fi nished part clearly. Figure 5.38 shows the pattern.
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Figure 5.38

A spiral pattern

Pattern Solids

Oftentimes a part can be modeled as a base feature and then patterned as a whole to create the 

completed part. Once the part is patterned, nonsymmetrical features can be added and/or pat-

terned occurrences can be suppressed. You can also use the Pattern Entire Solid option to create 

separate solid bodies when creating multi-body part fi les is the goal. To take a look at patterning 

these options, open the part named mi_5a_028.ipt, and follow these steps:

 1. Select the Rectangular Pattern tool on the Pattern panel of the 3D Model tab.

 2. Click the Pattern A Solid button so that the entire part is selected to be patterned. Notice 

the two buttons that appear in the top-right corner of the dialog box:

Join  This option is used to pattern the solid as a single solid body.

Create New Bodies  This option is used to pattern the solid as separate solid bodies for 

multi-body part creation.

 3. Leave this option set to Join, and set Direction 1 to pattern the solid in the direction of the 

part width four times at a spacing of 10 mm.

 4. Set Direction 2 to pattern the solid in the direction of the part thickness two times at a 

spacing of 3 mm, as shown in Figure 5.39.

Figure 5.39

Patterning a solid
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 5. Expand the pattern in the Model browser, and right-click to suppress the two middle 

occurrences on the top level. Roll your mouse pointer over each occurrence to see it 

highlight on-screen to identify which occurrences are the correct ones. Figure 5.40 shows 

the results of suppressing the correct occurrences.

Figure 5.40

Suppressed 

occurrences

 6. Now you’ll pattern the entire solid again. Select the Rectangular Pattern tool again, 

and click the Pattern A Solid button.

 7. Set Direction 1 to pattern the solid in the direction of the part length two times at a 

spacing of 50 mm.

 8. Set Direction 2 to pattern the solid in the direction of the part width two times at a 

spacing of 40 mm, as shown in Figure 5.41.

Figure 5.41

Patterning the 

solid again

 9. Create a new 2D sketch on one of the long narrow faces, and project the tangent edge of 

the slot cuts, or sketch a rectangle on the face. Do this for both ends of the face. Then use 

the Extrude tool, set the extents to To, and select the vertex as shown in Figure 5.42. The 

result will be the removal of all the partial slot features.
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Figure 5.42

Filling the end slots

 10. Create another sketch on the same face, sketch an arc from corner to corner, and set the 

radius to 400 mm. Then use the Extrude tool to extrude just the arc as a surface (click the 

Surface Output button in the Extrude dialog box). Set the extents to To again, and select 

the same vertex you previously selected.

 11. Select the Replace Face tool from the Surface panel of the 3D Model tab. You may have 

to expand the arrow on the Surface panel to expand the drop-down to fi nd the Replace 

Face tool.

 12. Select the two recessed faces for the Existing Faces selection, and then select the extruded 

surface for the New Faces selection, as shown in Figure 5.43.

Figure 5.43

Replacing faces

 13. Create a sketch on the top face, and create two rectangular profi les to use for creating an 

extrude cut, as shown in Figure 5.44. This cut removes the middle slots and holes, result-

ing in two long slots down the middle.
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Figure 5.44

Cutting the slots

 14. Finally, select the Shell tool from the Modify panel. Choose the bottom face as the 

Remove Faces selection, and set the Thickness to 1 mm. Figure 5.45 shows the fi nished 

part from the top and bottom views.

Figure 5.45

Th e fi nished part

Dynamic Patterns
It is often desirable to have features such as holes set up in a standard spacing that will dynami-

cally update based on changes to the overall length. You can do this by setting up your patterns 

with parameter formulas to calculate the spacing from the length parameter. Parts set up in this 

way can then be saved as template parts, allowing you to select them for new part creation and 

simply edit the length parameter. To set up a dynamic pattern, open the fi le mi_5a_032.ipt, and 

follow these steps:

 1. Click the Manage tab, and select the Parameters tool.

 2. Notice that many of the dimensions in this part have been named. This is good practice 

when creating formulas. To create a formula to determine the spacing, click the Add 

Numeric button in the lower-left corner of the dialog box. This will create a new user-

defi ned parameter. Enter Adjust_Len for the parameter name (recall that spaces are not 

allowed in parameter names).

 3. Click the unit cell, and set the Units to ul, meaning unitless.

 4. Type isolate(Length - End_Offset;ul;mm) into the Equation column. There are two parts 

to this equation:
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Length - End_Offset  Subtracts the distance from the end of the part from the overall 

length of the part

Isolate (expression; unit; unit)  Neutralizes the distance unit mm so that the Adjust_

Len parameter can read it as unitless

 5. Click the cell for the Count equation, and enter isolate(ceil(Adjust_Len / 
Spacing);ul;mm) in the cell. There are three parts to this equation:

Adjust_Len / Spacing  Divides the adjusted length distance by the value specifi ed in the 

pattern spacing

Ceil (expression)  Bumps the value up to the next highest whole number

Isolate (expression; unit; unit)  Neutralizes the distance unit mm so that the Count 

parameter can read it as unitless.

 6. Click the Done button, and then use the Update button to update the part (you can fi nd 

the Update button on the Quick Access bar at the top of the screen). Figure 5.46 shows the 

Parameters dialog box.

Figure 5.46

Formulas to adjust 

the hole spacing

You might notice that because the length value is currently set to 111 mm, the last hole is run-

ning off the part. Because the equation used the Ceil function to bump the calculated value to 

the next whole number, the count will always be on the high end. Depending on the part length, 

this may leave you with an extra hole. You can suppress the occurrence of this hole in the Model 

browser quite easily. Another approach is to remove the Ceil function and allow Inventor to 

round the calculated value up or down automatically. Depending on the length and spacing 

values, this might leave you with a missing hole at the end of the pattern where a value gets 

rounded down. Both are valid options, and you can decide which works best for your situation.

Edit Extrusion1 to adjust the part length, and try different values to see how the hole count 

drops out. You can also open the fi les mi_5a_033.ipt and mi_5a_034.ipt to examine similar 

hole patterns. In mi_5a_033.ipt, the Distance option is used in the pattern feature to evalu-

ate the length of the part. It holds an end offset value and then spaces the holes evenly along 

that distance. In mi_5a_034.ipt, the pattern is calculated from the center of the part rather 

than coming off one end. These are just a few examples of how to use user parameters to create 
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dynamic patterns. There are other variations as well. In the next sections, you’ll take a more in-

depth look at parameters.

Setting iProperties and Parameters
Parameters in part and assembly fi les can provide powerful control over individual parts and 

assemblies while also improving effi ciency within designs. Part parameters enable the use of 

iParts, which are a form of table-driven parts. Assembly parameters enable the use of table-

driven assemblies and confi gurations. Parameters are accessed through the Tools menu and 

within the Part Features and Assembly tool panels. In addition to parameters, you can use 

iProperties to add information to your fi les.

iProperties

iProperties, generically known as fi le properties, allow the input of information specifi c to the 

active fi le. The iProperties dialog box is accessed through the File drop-down in Inventor. iProp-

erties are a powerful way to pass information from the model fi les to the drawing fi le, allowing 

you to fi ll out information in title blocks, standard notes, and parts list automatically. The dialog 

box contains several tabs for input of information:

General  Contains information on the fi le type, size, and location. The creation date, last 

modifi ed date, and last accessed date are preserved on this tab.

Summary  Includes part information such as title, subject, author, manager, and company. 

Included on this tab are fi elds for information that will allow searching for similar fi les 

within Windows.

Project  Stores fi le-specifi c information that, along with information from the Summary, 

Status, Custom, and Physical tabs, can be exported to other fi les and used in link information 

within the 2D drawing fi le.

Status  Allows the input of information and the control of the design state and dates of each 

design step.

Custom  Allows the creation of custom parameters for use within the design. Parameters 

exported from the Parameters dialog box will also appear in the list. Formulas can be used 

within a custom parameter to populate values in preexisting fi elds within the Project and 

Status tabs.

Save  Determines the behavior of the current fi le upon save.

Physical  Allows for changing the material type used in the current fi le and displays the 

calculated physical properties of the current part, such as mass and moment of inertia, as 

determined by the material type.

Active use of iProperties will help the designer in improving overall productivity as well 

as provide the ability to link part and assembly information into 2D drawings. Adding search 

properties in the Summary tab will assist the user in locating similar fi les.

Custom iProperties are either created manually in the Custom tab of iProperties or created 

automatically by exporting individual parameters from the Parameter dialog. Custom iProper-

ties may be linked to drawings and assemblies for additional functionality.
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Accessing iProperties through Windows Explorer

When you right-click an Inventor fi le in Windows Explorer and choose Properties, you can select the 

iProperties tab from the fi le properties dialog box. Clicking the iProperties button on the iProper-

ties tab opens the Inventor iProperties dialog box just as you would see it in Inventor.

Th is can off er people in the offi  ce who do not have access to Inventor the ability to view and change 

iProperties when needed. For instance, someone in the manufacturing department can use this to 

set the Mfg. Approved Date iProperty once a part has been successfully built on the shop fl oor based 

on a given drawing and/or part fi le. To change iProperties without having Inventor installed, you 

can install Inventor View. Inventor View can be downloaded for free from the Autodesk website.

You can also use the Details tab in this way to quickly confi rm the Inventor version the fi le was 

created in and last saved under.

Part Parameters

Part parameters are composed of model parameters, user parameters, reference parameters, 

and custom parameters. Model parameters are automatically embedded as a part is dimen-

sioned and features are created. Most are a mirror image of the sketch-creation process. As each 

dimension is created on a sketch, a corresponding model parameter is created, starting with a 

parameter called d0 and incrementing each time a new parameter is created. When you name 

a dimension, you are changing the automatically assigned parameter name. To access the list 

of parameters, select the Manage tab, and click the Parameters button. Figure 5.47 represents a 

typical parameter list.

Figure 5.47

Part parameter list

Looking across the top of the dialog box, you will see columns for the parameter name, unit 

type, equation, nominal value, tolerance type, model value, parameter export, and descriptive 

comments. Take a look at each of these columns:

Parameter Name  The values in this column correspond to the name of the parameters 

assigned as the part is built. Each parameter name starts with a lowercase d followed by a 

numeric value. The parameters can be renamed to something that is more familiar, such as 

Length, Height, Base_Dia, or any other descriptive single word. Spaces are not allowed in the 

parameter name. Hovering your mouse pointer over a name will initiate a tool tip that will 

tell you where that variable is used or consumed. Parameters can be of three types:
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 ◆ Model parameters are created from dimensions or dialog box inputs that drive the 

geometry.

 ◆ Reference parameters are created from dimensions that are driven by other geometry 

entities.

 ◆ User parameters are created by you, the user, and are used in formulas and iLogic 

rules or referenced by model parameters.

Unit/Type  The unit type defi nes the unit used in the calculation. Normally, the unit type 

will be set by the process that created it. When a user parameter is created, you will be pre-

sented with a Unit Type dialog box when you click in the Unit column. This will allow you to 

select a particular unit type for the user parameter.

Equation  This column either specifi es a static value or allows you to create algebraic-style 

equations using other variables or constants to modify numeric values.

Nominal Value  This column displays the result of the equation.

Tolerance  This column shows the current evaluated size setting for the parameter. Click 

the cell to select Upper, Lower, or Nominal tolerance values. This will change the size of tol-

erance features in the model.

Model Value  This column shows the actual calculated value of the parameter.

Key  A parameter can be made a key by selecting the key check box for the parameter row.

Export Parameter  These check boxes are activated to add specifi c parameters to the custom 

properties for the model. Downstream, custom properties can be added to parts lists and 

bills of materials by adding columns. Clearing the check box will remove that parameter as 

a custom property. After a parameter is added, other fi les will be able to link to or derive the 

exported parameter. Text and True/False parameters cannot be exported.

Comment  This column is used to help describe the use of a parameter. Linked parameters 

will include the description within the link.

User Parameters

User parameters are simply parameters that a user creates by clicking the Add button in the 

lower-left portion of the Parameters dialog box. You can add numeric, text, and True/False 

parameters; however, only numeric parameters may be exported or contain expressions. Text 

and True/False parameters can be created for use in iLogic rules. User parameters can be used 

to store equations that drive features and dimensions in the model. The user-created parameter 

can utilize algebraic operators written in the proper syntax that will create an expression in a 

numerical value.

Reference Parameters

Reference parameters are driven parameters that are created through the use of reference 

dimensions in sketches and the use of derived parts, attached via a linked spreadsheet, created 

by table-driven iFeatures, or created through the use of the application programming interface 

(API). For instance, Inventor sheet-metal parts create fl at pattern extents, which are stored as 

reference parameters.



SETTING IPROPERTIES AND PARAMETERS | 241

Formatting Parameters

If needed, you can format the parameter to display differently than the default display. To do 

so you must fi rst select the Export Parameter check box in the Parameters dialog box for the 

parameter you intend to customize. Once the parameter is selected for export, you can right-

click that parameter and choose Custom Property Format to access the Custom Property Format 

settings. In the Custom Property Format dialog box you can change property type, units, for-

mat, and precision as well as control the display of unit strings, leading zeros, and trailing zeros. 

When you’ve confi gured the parameter formatting, it is refl ected in the custom iProperty for 

that parameter.

For instance, if you have a part dimension length of 100.00 mm and you want to call that 

length into the part description but do not want to see the units string (mm) or the zeros after 

the decimal point, you would go to the Manage tab, select the Parameters button, and then select 

the Export Parameter check box for the length parameter. Then you’d right-click the length 

parameter and choose the Custom Property Format option. And then fi nally you’d uncheck 

the Unit String and Leading Zeros options. To see the results, you’d exit the Parameters dia-

log box and then right-click the top-level node in the browser (typically the fi lename), choose 

iProperties, and then click the Custom tab to fi nd the custom iProperty that corresponds to the 

exported parameter.

Parameter Functions

One of the most important aspects of working with parameters is the ability to create expres-

sions using the available parameter functions. The functions in Table 5.1 can be used in user 

parameters or placed directly into edit boxes when you are creating dimensions and features.

Table 5.1: Functions and their syntax for edit boxes

Syntax

Unit 

type Description

cos (expression) Unitless Calculates the cosine of an angle.

sin (expression) Unitless Calculates the sine of an angle.

tan (expression) Unitless Calculates the tangent of an angle.

acos (expression) Angularity Calculates the inverse cosine of a value.

asin (expression) Angularity Calculates the inverse sine of a value.

atan (expression) Angularity Calculates the inverse tangent of a value.

cosh (expression) Unitless Calculates the hyperbolic cosine of an angle.

sinh (expression) Unitless Calculates the hyperbolic sine of an angle.

tanh (expression) Unitless Calculates the hyperbolic tangent of an angle.

acosh (expression) Angularity Calculates the inverse hyperbolic cosine of a value.
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Syntax

Unit 

type Description

asinh (expression) Angularity Calculates the inverse hyperbolic sine of a value.

atanh (expression) Angularity Calculates the inverse hyperbolic tangent of a value.

sqrt (expression) Unit^0.5 Calculates the square root of a value. Th e units within the sqrt 

function have to be square mm in order to return mm. For exam-

ple, sqrt(144 mm^2) returns 12.

sign (expression) Unitless Returns 0 for a negative value, 1 if positive.

Exp Unitless Returns an exponential power of a value.

For example, exp(100) returns 2.688E43.

floor (expression) Unitless Returns the next-lowest whole number.

For example, floor(3.33) returns 3.

ceil (expression) Unitless Returns the next-highest whole number.

For example, ceil(3.33) returns 4.

round (expression) Unitless Returns the closest whole number.

For example, round(3.33) returns 3.

abs (expression) Any Returns the absolute value of an expression.

For example, abs(3*-4) returns 12.

max (expression1; 

expression2)

Any Returns the larger of two expressions.

For example, max(3;4) returns 4.

min (expression1; 

expression2)

Any Returns the smaller of two expressions.

For example, min(3;4) returns 3.

ln (expression) Unitless Returns the natural logarithm of an expression.

log (expression) Unitless Returns the logarithm of an expression.

pow (expression1; 

expression2)

Unit^expr2 Raises the power of expression1 by expression2.

For example, pow(3 ul;2 ul) returns 9.

random () Unitless Returns a random number.

isolate (expres-

sion; unit;unit)

Any Used to convert the units of an expression.

For example, isolate(Length;mm;ul), where Length=100mm, 

returns 100 ul.

PI Internal 

Parameter

Returns the constant equal to a circle’s circumference divided by 

its diameter, 3.14159265359 (depending on precision).

For example, PI*50 mm returns 157.079633.

Table Functions and their syntax for edit boxes   (continued)
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Syntax

Unit 

type Description

E Internal 

Parameter

Returns the base of the natural logarithm 2.718281828459 

(depending on precision).

* 1 unit or / 1 unit Any Used to convert unit types of an expression, much like isolate.

For example, 100 mm *10 ul returns an errant value for a 

unitless parameter.

100 mm / 1 mm * 10 ul returns 1000 ul.

100 mm * 10 ul / 1 mm also works.

Setting Up User Parameters in Your Templates

Although many times parameters are used to control design input on a per-design basis, you can 

often use preestablished parameters in template fi les so only a couple of key parameters need to be 

changed in the part fi le to create a new variant of a standard part. User parameters are especially 

powerful when these types of template parts are created.

Consider, for example, a standard-type mounting bracket. Th e general shape is carried through in 

all iterations, but you can identify several key dimensions that are driven by the particulars of each 

new design situation. Dimensions such as length, width, height, and thickness are good examples 

of parameters that can be identifi ed and set up in a template part.

Other things to consider for use as parameters would be critical dimensions such as the locations 

of holes from the edge of the part, hole sizes, hole counts, and hole spacing. If the hole off set is 

determined by the material thickness and hole size, then a formula can be established in the part 

template to calculate the minimum off set value.

Once the part parameters are created and tested for accuracy, the part can be turned into a template 

by using the Save Copy As Template option in the Save As menu. Th is will save the part fi le in the 

Template directory. Template parts can be as simple or complex as you need, but generally this 

works best for simple parts. For more complex parts, consider creating iParts, covered in Chapter 

7, “Reusing Parts and Features.”

When creating parameter-based template parts, you might want to consider creating user param-

eters with descriptive names for all the key parameters so they are all grouped together. Th is way, 

you (or another user) can quickly identify key parameters used to drive the design later when 

creating parts in your real-world designs.

Assembly Parameters
Assembly parameters function in much the same way as part parameters except they will gen-

erally control constraint values such as offset and angle. When you’re authoring an iAssembly, 

other parameters will be exposed for usage, such as assembly features, work features, iMates, 

and component patterns, as well as other parameters that may exist within an assembly.

Table Functions and their syntax for edit boxes   (continued)
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Adding Part Tolerances
Inventor allows you to analyze parts in a manner that ensures valid fi t and function at dimen-

sional extremes. When parts are assembled within an Inventor assembly fi le, you can check to 

ensure that the parts can be assembled without interference, by setting each part to evaluate at 

the upper or lower tolerance value. By specifying dimensional tolerances within parts, you are 

capturing valuable design data that will assist in manufacturing and assembly. In addition to 

creating the parts separately and then assembling them, you can use multi-body parts to create 

mated parts in one fi le, making it easy to design tolerances across multiple parts.

Less Is Often More with Tolerances

When considering part designs for manufacturing, be careful not to apply precise tolerance values 

where they are not necessary for the design and assembly. Excessive and unneeded tolerances 

during the design phase can substantially increase the cost to manufacture each part. Th e secret 

to good design is to know where to place tolerances and where to allow shop tolerances to occur.

Tolerances are an important tool for communicating design intent to manufacturing. Large 

tolerances indicate that the dimensions aren’t critical to the part’s function, whereas tight toler-

ances indicate that manufacturing needs to pay extra attention to that machining operation. 

Loosening up tolerances can help manufacturing reduce the reject rate, while tightening up 

certain tolerances can reduce rework during the assembly process or in the fi eld.

Tolerances in Sketches
Yo u can add tolerances to any individual sketch dimension by right-clicking and choosing 

Dimension Properties to set precision and tolerance values. You can also access the tolerance 

setting from within the dimension edit box to set the tolerance as you set the value. Altering the 

dimension to adjust for tolerance and precision using either method will not affect any other 

dimension within the part. However, a global fi le tolerance can be specifi ed within a part using 

the Document Settings dialog box and will affect every dimension within the model.

In addition to the Dimension Properties menu option and the dimension edit box option, you 

can access and modify tolerances in the Parameters dialog box. Using the Parameters controls, 

you can set parameter values for multiple dimensions to include the tolerance as needed. No 

matter how you access the tolerance setting, there are four options you can use to evaluate the 

dimension/parameter:

+ Upper  The upper tolerance value in a stacked display. This value should be Maximum 

Material Condition (MMC). For a hole, the smallest diameter is MMC, whereas for a shaft the 

largest diameter is MMC.

▲ Median  The midway point between the upper and lower tolerances. This is commonly 

used when Computer Numerical Control (CNC) machines are programmed from the solid 

model.

– Lower  The lower tolerance in a stacked display. This value should be Least Material 

Condition (LMC). For a hole, the largest diameter is LMC, while for a shaft the smallest diam-

eter is LMC.

• Nominal  This is the actual value of the dimension.
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Figure 5.48 shows the access to the tolerance settings through the sketch dimension edit box 

as well as the settings in the Tolerance dialog box. In this case a deviation tolerance is placed on 

the 36 mm diameter, and the model is set to evaluate at the upper value (note that the plus sign 

is selected). Since this document’s settings are defaulted to three places, all sketch dimensions 

are in three places to start. In the illustration, the precision has been set to just two decimal 

places, for just this dimension.

Figure 5.48

Sketch showing 

tolerances

Tolerance vs. Allowance

Tolerance is the acceptable (but undesired) deviation from the intended (nominal) dimension.

Allowance is the intended (desired) diff erence of dimensions between two mating parts, depending 

on the type of fi t specifi ed.

Setting Global File Tolerances
Adding tolerances during the design phase pays dividends down the road. There will be fewer 

errors creating drawings, and it provides clues to design decisions that are useful when updat-

ing an existing part. You might fi nd using standard tolerances makes the design process more 

effi cient because the designer needs to focus only on the general tolerance for a dimension 

(two-place vs. three-place tolerance) and apply special tolerances where needed. You can create 

custom templates to store tolerance types and other settings for each standard. When the part is 

created using such a template, standard tolerance values can be overridden for specifi c dimen-

sional values, or you can override all tolerances within a fi le or just a specifi c dimension.

An example of this type of tolerance would be a tolerance rule that states that all decimal 

dimensions held to two places shall be +/− 0.05 and all decimal dimensions held to three places 

shall be +/− 0.001, meaning a dimension of 0.50 would be held to an upper limit of 0.55 and a 

lower limit of 0.45, whereas a dimension of 0.500 would be held to an upper limit of 0.501 and a 

lower limit of 0.499.

You can create and modify global tolerance values within a single part by selecting the Tools 

tab, clicking Document Settings, and then clicking the Default Tolerance tab within an active part 
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fi le or template. By default, a fi le will not be using any tolerance standards. In Figure 5.49, the Use 

Standard Tolerancing Values box has been selected to enable the addition of new standards for 

the fi le. To export the tolerance values to the drawing fi les, the Export Standard Tolerance Values 

check box has been selected as well.

Figure 5.49

Document settings 

for tolerance

Once the tolerance values are set, the dimension in the part will evaluate at the nominal 

value, meaning that if you entered a value of 36 for a part length, that is what the length would 

be. To evaluate the model at its upper limit at +/− 0.001, you would edit the dimension for the 

length and set the precision to three places and the evaluated size to Upper (using the + button). 

The length would then change to 36.05, if using the earlier example. The default tolerances are 

set to +/– tolerances. To select another tolerance standard, simply override the existing tolerance 

values in the tolerance setting, and choose another tolerance type, such as deviation. You can 

see all of this in action in the following steps:

 1. On the Get Started tab click Open, and open the part named mi_5a_035.ipt found in the 

Chapter 05 folder.

 2. Select the Tools tab and then click the Document Settings tab.

 3. Select the Default Tolerance tab, and notice that there are two linear tolerance standards 

and one angular tolerance standard already set up. Note that there is a linear precision 

for one decimal and another for two decimals, but there is not one for three decimals. 

Keep this in mind as you proceed.

 4. Click the check box to use the standard tolerancing values, click the Apply button, and 

then click the Close button.

Now that the part is set to use a global part tolerance, you will edit a dimension and 

change the precision setting to two decimals so it will use one of the global linear 

tolerance settings. It is important to note that the dimension precision for all of the 

dimensions in the part is currently set to three decimal places (the default setting).
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 5. Edit the 15 mm dimension by double-clicking the text of the dimension.

 6. Click the fl yout arrow in the dimension input box and select Tolerance.

 7. Set the precision to just one decimal place, and then click the blue plus sign to evaluate 

the dimension at its upper value.

 8. Click the OK button to exit the Tolerance dialog box, and then click the green check mark 

in the dimension edit box.

 9. Although the sketch automatically updates to evaluate the dimension at its upper value, 

you’ll need to update the model to see the solid update. Click the Update button on the 

Quick Access bar (at the top of the screen; it looks like a lightning bolt).

 10. To evaluate the entire part at the lower value, select the Manage tab and click the 

Parameters button.

 11. In the Parameters dialog box, click the red minus sign in the Reset Tolerance area, and 

then ensure the Immediate Update check box is selected to see the Model Values column 

update.

Compare the nominal and model values in the parameter table to see that some of the 

dimensions are now reevaluated. Since the dimension default precision for the part is set 

to three places, the 25 mm and 3 mm dimensions are using that precision (for which no 

tolerance was set) and therefore have no lower value. Don’t be confused by the precision 

being displayed in the Parameters table, because that precision is display only. You can 

click the Equation cell for each dimension and then right-click and choose Tolerance to 

access the tolerance and precision settings for each dimension to see or change them.

 12. Click Done to exit the Parameters dialog.

 13. To change the global dimension precision, select the Tools tab and click the Document 

Settings button.

 14. Select the Units tab and set Modeling Dimension Display for Linear Dim Display 

Precision to two places; then click the OK button.

Now the 25 mm dimension is using the fi le default precision of two places, and since it is still 

set to evaluate at the lower value, it changes to 24.99. You can begin to see the power of using 

tolerances in your models to evaluate tolerance ranges as you design. You can close this fi le 

without saving changes. In the next section you’ll look at using limits and fi ts tolerances.

Part Tolerances in Drawings

Keep in mind that when a part is used in the drawing environment, it will refl ect the current 

evaluated model dimensions and will show the tolerance callout only for retrieved dimensions.

Typically, it is best to create multiple dimension styles with various precision and/or tolerance 

options in the drawing environment and handle tolerance dimensioning for the print using those 

tools. You must keep in mind that the tolerance settings in the part are designed to function with 

the assembly environment and allow calculating tolerances and stack-ups within the assembly. 

Th ey are not meant to provide tolerancing in the drawing environment.
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Working with Limits and Fits
A fi t tolerance defi nes the way two components mate together. There are three basic categories 

of fi ts:

Clearance  Allows the mating components to slide together freely so they can be assembled 

and disassembled easily.

Transition  Provides a fi t close enough to securely hold the two components together but 

still allow them to be disassembled.

Interference  Often called a press fi t or friction fi t, it provides a means to hold two com-

ponents together by slightly oversizing one component that fi ts into the other. Some force 

is required to achieve the fi tting of the two components together, and disassembly is not 

intended.

You can create parts according to fi ts by adding tolerance values to sketch dimensions and 

setting the tolerance type to one of the Limits/Fits options. Using a fi ts table as a reference, you 

can then set the tolerance according to the desired fi t type.

In the following exercise, you will edit a part and set tolerances for the two mating solid bod-

ies, using Table 5.2 as guide for the fi ts. To start, you will set the inside and outside diameters to 

use tolerances based on a common diameter of 36 mm. The goal is have a loose fi t that allows 

the insert to slip freely into the sleeve. Follow these steps:

 1. On the Get Started tab click Open, and open the part named mi_5a_036.ipt from your 

Chapter 05 folder.

 2. Select the dimension called Sleeve_ID, and double-click to bring up the dimension edit 

box.

 3. Click the fl yout arrow and choose Tolerance from the list.

 4. Set the Type drop-down to Limit/Fits-Show Size Limits.

 5. Set the Hole drop-down to H11 to create a loose running fi t, as listed in Table 5.2.

 6. Click the red minus sign to evaluate the inside diameter at its lower limit.

 7. Click the OK button to exit the Tolerance dialog box, and then click the green check mark 

in the dimension edit box.

 8. Select the dimension called Insert_OD, and double-click it to bring up the dimension 

edit box.

 9. Click the fl yout arrow and choose Tolerance from the list.

 10. Set the Type drop-down to Limit/Fits-Show Size Limits.

 11. Set the Shaft drop-down to c11 to create the other half of the loose running fi t.

 12. Click the blue plus sign to evaluate the outside diameter at its upper limit.

 13. Click the OK button to exit the Tolerance dialog box, and then click the green check mark 

in the dimension edit box.

 14. Zoom in on the cutout in the sleeve, and you’ll see a green arrow on one corner. Zoom in 

closer on the green arrow, and you will see the gap between the diameter sketches of the 
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sleeve and the insert refl ecting your tolerance edits. However, the model itself currently 

displays no tolerance and needs to be updated to match the sketch.

Table 5.2: Example of limits and fi ts using a hole basis system

Type Fit Use Hole Shaft

Clearance Loose running General fi ts with smaller clearances. H11 c11

Clearance Sliding Very small clearances for accurate guiding of 

shafts, with no noticeable clearance once 

assembled.

H7 g6

Transition Locational Snug fi t with small clearance. Parts can be 

assembled and disassembled manually.

H7 h6

Transition Keying Small clearances or slight interferences. Parts 

can be assembled with little force, such as with 

a rubber mallet.

H7 k6

Interference Press Guaranteed interference, using cold pressing. H7 p6

Interference Shrink Medium interference, using hot pressing or 

large-force cold pressing.

H7 s6

 15. Click the Update button on the Quick Access bar (it looks like a lightning bolt at the top 

of the screen).

You should see a gap between the solids, providing a loose running fi t. Because the cur-

rent model is being evaluated at the extremes (the upper tolerance for the inside diameter 

and the lower for the outside diameter), you can determine whether the current design 

will provide the correct fi t. In the real world, you might determine that the outside 

diameter of the insert needs to be less than 36 mm for the nominal value so that you can 

ensure a better fi t.

Continue with the following steps to explore more options when working with part 

tolerances.

 16. Zoom back out and then click once on any blank area of the graphics screen (to clear 

any currently selected entities). Then right-click, choose Dimension Display, and choose 

Tolerance from the fl yout menu. This will show you the evaluated dimension values, as 

shown in Figure 5.50.

 17. Right-click either of the dimensions and choose Dimension Properties.

You’ll notice that you can set and adjust the tolerance options in this menu as well. You 

can use the Document Settings tab to set up standard tolerances for the entire fi le and change 

the precision and dimension display. These are the same settings you accessed by editing the 

dimensions and parameters in the previous steps.
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Figure 5.50

Dimensions 

showing limit/fi ts

This concludes the formal steps of this exercise, but you can continue experimenting with 

the tolerances using Table 5.2 as a reference. For instance, you might set up a press fi t and evalu-

ate the inside diameter at the upper value and the outside at the lower to check to see if there is 

indeed enough interference to provide a solid press fi t when both dimensions are evaluated at 

their extremes. (Note that Table 5.2 is not a complete fi ts list and is provided as reference for this 

exercise only.)

Troubleshooting Failures with the End-of-Part Marker
Once in a while, even the most skilled design engineer experiences a modeling or design failure. 

The part may be supplied by a customer or coworker who has not practiced sound modeling 

techniques, or you may have to drastically modify a base feature in a part you designed. These 

kinds of edits change a base feature to the point that dependent features cannot solve, and a cas-

cade of errors can occur. Knowing how to fi x these errors can save you hours of work.

One of the best ways to troubleshoot a part and determine exactly how the part was origi-

nally modeled is to use the end-of-part (EOP) marker to step through the creation process. In the 

Model browser, drag the end-of-part marker to a location immediately below the fi rst feature. 

This will effectively eliminate all other features below the marker from the part calculation.

Often when making modifi cations to a part, you might change a feature that causes errors to 

cascade down through the part. Moving the end-of-part marker up to isolate the fi rst troubled 

feature allows you to resolve errors one at a time. Many times, resolving the topmost error will 

fi x those that exist after it. Figure 5.51 shows a model tree with a series of errors. On the right, 

the end-of-part marker has been moved up.

Figure 5.51

Using the 

end-of-part marker 

to troubleshoot 

feature errors
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Step 1: Editing the First Feature
Normally, the fi rst feature will start with a sketch. Right-click the fi rst feature and select Edit 

Sketch. Examine the sketch for a location relative to the part origin point. Generally, the fi rst 

sketch should be located and anchored at the origin and fully dimensioned and constrained. If 

the sketch is not fully constrained, then add dimensions and constraints to correct it.

If you see sketch entities highlighted in magenta, you probably have projected geometry that 

has lost its parent feature. To resolve errors of this type, it is often required to break the link 

between the missing geometry and allow the projected entities to stand on their own. To do so, 

right-click the objects in the graphics area or expand the sketch in the browser, and right-click 

any projected or reference geometry that is showing errors; then choose Break Link. This frees 

up the geometry so that it can be constrained and dimensioned on its own or simply deleted. 

Figure 5.52 shows the Break Link option listed in the context menu for a projected loop.

Figure 5.52

Breaking projected 

object links

Once the sketch is free of errors, you can return to the feature level. Often, you’ll be greeted 

by an error message informing you that the feature is not healthy. Click Edit or Accept. Then 

edit the feature. Most often you will simply be required to reselect the profi le or reference geom-

etry. Once the feature is fi xed, drag the end-of-part marker below the next feature, and repeat 

the step. Continue through the part until all sketches are properly constrained.

Occasionally, a base sketch may become “lost” and may need to be reassociated to a sketch 

plane. To do so, you can right-click and choose Redefi ne, as shown in Figure 5.53. Depending 

on how drastic the change in the sketch plane is, this may be all that is required. Often, though, 

you will need to edit the sketch, clean up some stray geometry using the Break Link option, and 

then dimension and constrain it so that it is stable.

Step 2: Moving the EOP Marker Down One Feature at a Time
Step 2 might be called “learn from your mistakes” (or other people’s mistakes). When you have 

part/feature failures, you should take advantage of them and analyze how the part was created 

to determine why the sketch or features became unstable. It’s always good practice to create 

the major features fi rst and then add secondary features such as holes, fi llets, and chamfers at 

the end of the part. On occasion, loft and sweep features may fail or produce incorrect results 
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because fi llets and chamfers were created before the failed feature. To determine whether this is 

the case in your model, suppress any holes, fi llets, chamfers, or any other feature that you think 

might be causing the failure.

Figure 5.53

Redefi ning a sketch

Once the failed feature is corrected, introduce one suppressed feature at a time until you 

encounter a failure. This will identify the cause. You may then attempt to move the offending 

feature below the failed feature and examine the result. If you are unable to move the offending 

feature, instead reproduce the same feature below the failed feature and leave the original sup-

pressed. When the problems are corrected in a part, you can go back and delete the suppressed 

offending features.

Although it’s not always a silver bullet, you might want to try the Rebuild All tool right after 

fi xing the fi rst broken sketch or feature. Very often if the fi x was fairly minor, Rebuild All will 

save you from having to manually edit dependent features one at a time. You can access this tool 

by selecting the Manage tab and selecting Rebuild All.

Using the End-of-Part Marker to Time-Travel

Th e end-of-part marker is a powerful yet often-neglected tool. With this tool, you can go “back to 

the future” and edit or add features to your model. A good example of using the EOP marker is to 

preserve design intent. Let’s say you created a base feature, placed some holes down the center of 

the part (based on dimensions), and then altered the side faces of the part. Th e holes are linked to 

the unaltered edges of this part. You now want to tie the holes to the midplane of this part regard-

less of the feature size.

You could do this by placing a centered work plane down the part. However, you cannot do this 

now because when you go back to edit the hole sketch, the work plane would not be available for 

projection onto the sketch plane. You also cannot drag the work plane above the holes because it 

was created on the new, altered base feature faces. In this case, you’ll want to drag the EOP marker 

above the hole feature. Now you can place the work plane centered on the two faces. Drag the EOP 

marker back down to the bottom of the tree. Now edit the hole feature and project the work plane 

so that the hole centers can be constrained to it.
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You can also use the EOP marker to reduce fi le size when you email a model. If you drag the EOP 

marker to the top of the browser, only the feature tree (commonly called the part DNA or part 

recipe) is saved to disk. When the EOP marker is dragged down to the bottom again, all the feature 

data is recalculated.

Th e Bottom Line

Create complex sweeps and lofts.  Complex geometry is created by using multiple work 

planes, sketches, and 3D sketch geometry. Honing your experience in creating work planes 

and 3D sketches is paramount to success in creating complex models.

Master It  How would you create a piece of twisted, fl at bar in Inventor?

Work with multi-body and derived parts.  Multi-body parts can be used to create part fi les 

with features that require precise matching between two or more parts. Once the solid bod-

ies are created, you can create a separate part fi le for each component.

Master It  What would be the best way to create an assembly of four parts that require 

features to mate together in different positions?

Utilize part tolerances.  Dimensional tolerancing of sketches allows you to check stack-

up variations within assemblies. When you add tolerances to critical dimensions within 

sketches, you can adjust parts to maximum, minimum, and nominal conditions.

Master It  You want to create a model feature with a deviation so you can test the assem-

bly fi t at the extreme ends of the tolerances. How would this be done?

Understand and use parameters and iProperties.  Using parameters within fi les assists 

in the creation of title blocks, parts lists, and annotation within 2D drawings. Using param-

eters in an assembly fi le allows the control of constraints and objects within the assembly. 

Exporting parameters allows the creation of custom properties. Proper use of iProper-

ties facilitates the creation of accurate 2D drawings that always refl ect the current state of 

included parts and assemblies.

Master It  You want to create a formula to determine the spacing of a hole pattern based 

on the length of the part. What tools would you use?

Troubleshoot modeling failures.  Modeling failures are often caused by poor design 

practices. Poor sketching techniques, bad design workfl ow, and other factors can lead to the 

elimination of design intent within a model.

Master It  You want to modify a rather complex existing part fi le, but when you change 

the feature, errors cascade down through the entire part. How can you change the feature 

without this happening? 





Chapter 6

Sheet Metal

The sheet-metal functionality in the Autodesk® Inventor® program is an extremely powerful 

toolset, centered on productivity and capturing your manufacturing intent. When you fi rst 

begin working in the sheet-metal environment, you may feel overwhelmed because the tools 

and methods you have become familiar with to create other parts in Inventor do not yield good 

results in the sheet-metal fi le. However, a mastery of some basic fundamentals in sheet-metal 

tools can make Inventor sheet metal straightforward and highly integrated with your manu-

facturing environment. The Autodesk® Inventor LT™ program does not include the sheet-metal 

tools discussed in this chapter.

In this chapter, you’ll learn to:

 ◆ Take advantage of the specifi c sheet-metal features available in Inventor

 ◆ Understand sheet-metal templates and rules

 ◆ Author and insert punch tooling

 ◆ Utilize the fl at pattern information and options

 ◆ Understand the nuances of sheet-metal iPart factories

 ◆ Model sheet-metal components with non-sheet-metal features

 ◆ Work with imported sheet-metal parts

 ◆ Understand the tools available to annotate your sheet-metal design

Understanding Sheet-Metal Parts
The sheet-metal environment was introduced in Inventor Release 2. Since sheet-metal parts 

have so many unique requirements, such as fl at patterns and manufacturing-specifi c features, 

a modifi ed part fi le is used. The same .ipt fi lename extension is used for sheet-metal parts, but 

extra sheet-metal capabilities and data are added. To create a sheet-metal part, you can use the 

Sheet Metal.ipt template or simply click the Convert To Sheet Metal button found on the 3D 

Model tab of a standard part fi le.

To understand how sheet-metal parts work, it is important to keep in mind that sheet-metal 

design is driven by manufacturing considerations. A basic sheet-metal part consists of fl at faces 

joined by bends. For cost-effective manufacturing, all the bends and corner reliefs are generally 

the same radius. The sheet-metal template style contains the sheet thickness, bend, and relief 

information in a rule, and the style is then used during modeling. This saves you considerable 

time during design because the features automatically use the settings in the predefi ned style. 
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If you have to make a change, such as a different material thickness or bend radius, you can 

select a different style and the part automatically updates. These sheet-metal-specifi c styles are 

referred to as a sheet-metal rule.
Many sheet-metal parts are brackets or enclosures designed to fi t a particular assembly. The 

sheet-metal tools simplify the process of creating and updating models. For example, you can 

change a bend to a corner seam simply by right-clicking the bend in the browser and selecting 

Change To Corner from the context menu.

Getting to Know the Features
The Inventor sheet-metal environment contains numerous specialized tools to help you design 

components that follow your sheet-metal-manufacturing guidelines and process restrictions. 

The following sections describe general feature classifi cations and capabilities that will provide 

you with a quick road map to the features. Once you understand how the features work, you 

will be able to build models that capture your design intent.

Starting with a Base Feature
Out of all the sheet-metal tools provided, only four create what are referred to as base features. 
Base features are simply the fi rst features that appear in the feature history. The following tools 

can create base features:

 ◆ Face

 ◆ Contour Flange

 ◆ Contour Roll

 ◆ Lofted Flange

Face

The Face tool is the simplest base feature; it utilizes a closed profi le to produce a simple extru-

sion with the height automatically set to the Thickness parameter value. The profi le can be con-

structed out of any shape and can even contain interior profi les, as shown in Figure 6.1. Profi les 

for face features are often generated from the edge projections of planar faces or surfaces found 

in other part fi les, and this capability enables numerous assembly-based and derived workfl ows.

Figure 6.1

Face base feature 

containing an 

internal profi le

Contour Flange

The Contour Flange tool is a sketch-based feature (using an open profi le) that has the ability to 

create multiple planar faces and bends as the result of a single feature, as shown in Figure 6.2. 
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Profi le sketches should contain only arcs and lines; if sketch intersections are not separated by 

an arc, a bend equal to the BendRadius parameter will automatically be added at the intersec-

tion, as determined by the sheet-metal rule. To create base features with a profi le sketch, contour 

fl anges have a width extent option called Distance, which allows a simple open profi le to be 

utilized to create a sheet-metal condition extrusion of the thickened, fi lleted profi le.

Figure 6.2

Contour Flange 

base feature

You can use the Contour Flange tool to create sheet-metal base features; in fact, it is often 

the fastest way to create them. Although you could create the part shown in Figure 6.2 using the 

Face tool and then adding fl anges, it would be more time-consuming. Using the Contour Flange 

tool has one drawback, however: Since you are combining many features, you lose some fl exibil-

ity for revising the shape.

Follow these steps to explore the basics of creating a base feature with the Contour 

Flange tool:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le named mi_6a_001.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder. If you have not already downloaded the Chapter 6 fi les from 

www.sybex.com/go/MasteringInventor2014, please refer to the “What You Will Need” 

section of the Introduction for the download and setup instructions. 

 3. Select the Contour Flange tool from the Create panel of the Sheet Metal tab.

 4. For the Profi le selection, click anywhere along the sketch profi le.

Depending on where you clicked on the sketch, the preview will show either the outside 

or inside of the sketch. Also notice that the corners at each end of the 25 mm leg are auto-

matically rounded even though no radius was specifi ed in the sketch. This is due to the 

predefi ned BendRadius parameter.

 5. Use the Flip Side buttons (three arrow buttons) to change the preview so you can see how 

each changes the result. Then set the side so that the preview is to the inside of the sketch 

profi le (as in Figure 6.2) and therefore holding the overall dimensions of the sketch.

 6. Enter 6 mm in the Bend Radius input box, and notice that the corners at each end of the 

25 mm leg are updated.

Entering a value in the Bend Radius input box overrides the predefi ned BendRadius 

parameter and sets this contour fl ange feature to always use 6 mm. If the part were set to 

http://www.sybex.com/go/MasteringInventor2014
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use another predefi ned style, bends in this feature would not update to follow the style 

but would instead stay at 6 mm.

 7. Click the >> button to expand the Contour Flange dialog box (if it isn’t already expanded) 

and then set the Distance input box to 150 mm.

 8. Use the ViewCube to change the view so you can see the direction of the contour.

 9. Click the Distance Mid-Plane button so the part is created equally to both sides of the 

sketch.

 10. Click the OK button to create the feature.

In the preceding steps you created a base feature using an open profi le sketch and the 

Contour Flange tool. From this point, you could begin adding secondary features as required. 

For now though, you can close this fi le without saving changes and continue looking at other 

tools used to create base features.

Contour Roll

The Contour Roll tool is a variation of the Contour Flange tool. To create a contour roll, you 

sketch an open profi le, but you revolve it instead of extruding it. Sketch geometry is limited to 

lines and arcs, and the Contour Roll tool will automatically add a bend at line intersections. The 

rolled hat fl ange in Figure 6.3 was created using the simple sketch geometry shown.

Figure 6.3

Contour Roll base 

feature

Follow these steps to explore the basics of creating a base feature with the Contour Roll tool:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_002.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

 3. Select the Contour Roll tool from the Create panel of the Sheet Metal tab.

 4. Set the Unroll Method drop-down box to Centroid Cylinder if it is not already. For the 

Profi le selection, click anywhere along the sketch profi le.

 5. Select the centerline for the Axis selection.
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Note the options in the Unroll Method drop-down box:

Centroid Cylinder  The neutral cylindrical surface is derived by the centroid location 

of the profi le, based on the selected axis. The neutral radius and unrolled length are 

displayed.

Custom Cylinder  Allows you to select a sketched line to defi ne the cylindrical neutral 

surface. The unrolled length is displayed.

Developed Length  Allows you to enter the developed length, and displays the adjusted 

neutral radius.

Neutral Radius  Allows you to enter the neutral radius, and displays the adjusted 

unrolled length.

These options all derive the developed length by multiplying the rolled angle by a neutral 

radius but differ from one another by the type of input specifi ed.

 6. Set the unroll method to Custom Cylinder, and select the sketch line denoted as Custom 

Neutral Axis for the Neutral Axis selection. Note the displayed unrolled length.

 7. Set the unroll method to Neutral Radius and enter 60 mm in the input box. You’ll notice 

that the displayed unrolled length adjusts based on the change.

 8. Set the unroll method to Developed Length and enter 100 mm in the input box. You’ll 

notice that the displayed neutral radius adjusts based on the change.

 9. Click the OK button to create the feature.

 10. Click the Create Flat Pattern button on the Sheet Metal tab.

 11. Right-click the Flat Pattern node in the browser and choose Extents. You’ll see that the 

width of the fl at pattern has been held to 100 mm, honoring your fi nal input value.

 12. Click the Close button in the Flat Pattern Extents dialog box, and then deselect the 

Flat Pattern node in the browser (you can do so by clicking on-screen anywhere in the 

graphics area).

 13. Click the Go To Folded Part button on the Sheet Metal tab to return to the folded model.

In the preceding steps you created a base feature using an open profi le sketch and the 

Contour Roll tool. You can close this fi le without saving changes and continue looking at 

other tools used to create base features. Before continuing, though, you can open the fi le 

mi_6a_003.ipt to create a secondary contour roll feature based on the fi rst.

Lofted Flange

The Lofted Flange tool creates sheet-metal shapes typically seen in HVAC transitions and 

material-handling hoppers. Figure 6.4 shows a square-to-round transition. Basically, you create 

sketches of the beginning and end of the transition and then use the Lofted Flange tool to transi-

tion between the two. The Lofted Flange tool gives you the option of a die form or a press brake 

transition. For press brake transitions, you can defi ne the bends by chord tolerance, facet angle, 

or facet distance. The chord tolerance is the distance between the angled face and the theoretical 

curved surface. As the chord tolerance is decreased, more facets are added.
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Figure 6.4

Square-to-round 

lofted fl ange

To create a lofted fl ange, follow these steps:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_004.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

 3. Click the Lofted Flange button in the Create panel.

 4. Select the square and the circle for the profi le selections.

 5. In the output area of the dialog box, click the Die Formed button, and note that the pre-

view changes to remove the press brake facets and that the facet controls in the dialog 

box are hidden.

 6. Click the Press Brake button and use the Facet Control drop-down to experiment with 

the Chord Tolerance, Facet Angle, and Facet Distance options to familiarize yourself with 

their behavior.

Chord Tolerance  This value sets the maximum separation distance from the arc 

segment to the chord segment.

Facet Angle  This value sets the maximum angle to the chord segment at the facet face 

vertex.

Facet Distance  This value sets the maximum width of the length of the chord.

Converge  This check box sets the bends of the fl attened faceted sections to converge 

near a singular point.

Deciding which of these options to use depends largely on the design inputs you know 

and the equipment to be used to create the part on the shop fl oor.

 7. Ensure that the Converge check box is not selected, set the Facet Control drop-down to 

Facet Distance, and change the distance to 50 mm.

Note that there is a glyph icon at each of the transition corners on the model preview. If 

you hover your cursor over them, you can see them better. Clicking one of these Bend 

Zone Edit glyphs displays a dialog box to change the facet control and also displays 
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individual glyphs for each bend. The Bend Zone Edit dialog box enables you to change 

the facet control for the corner corresponding to the glyph you clicked, as shown in 

Figure 6.5. Clicking one of the bend glyphs displays a Bend Zone Edit dialog box that 

enables you to override the bend radius and unfold rule for an individual bend.

Figure 6.5

Bend Zone Edit 

dialog box

Continuing with the previous steps, investigate the use of Bend Zone Edit glyphs for 

yourself with these steps:

 8. Click one of the Bend Zone Edit glyphs.

 9. Click the check box in the Bend Zone Edit dialog box, and select Number Of Facets.

 10. Enter 2 in the edit fi eld, and note that the preview updates.

 11. Click one of the Bend Edit glyphs, and then click the Bend Radius check box in the 

resulting Bend Edit dialog box.

 12. Change the bend radius to BendRadius*10 and note the preview.

 13. Click the OK button, and note that the Bend Edit glyph has changed. A pencil is added to 

indicate that it has been overridden.

 14. Click the OK button in the Bend Zone Edit dialog box. Hover your cursor over the glyph, 

and note that a pencil has been added to it as well.

 15. Click the OK button in the Lofted Flange dialog box to create the feature.

 16. Click the Create Flat Pattern button on the Sheet Metal tab. Note that the part isn’t 

fl attened because it is a continuous piece.

 17. Click the Go To Folded Part button on the Sheet Metal tab to return to the folded model.

To get the lofted fl ange transition to fl atten, you’ll need to create a rip feature in one of the 

faces. The Rip tool will be discussed in the section “Adding, Removing, or Deforming Material” 

later in this chapter. For now, you can close the fi le without saving changes and continue to the 

next section to explore the creation of fl anges.

Creating Secondary Flange Features
Once a base feature is created, you can add secondary features in the form of fl anges. Flanges 

are planar faces connected by a bend and can be created using a number of tools. The Flange 
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tool automatically creates bends between the fl anges and the selected faces. You can also use the 

Contour Flange tool to create several fl anges at once. The Hem tool allows you to create special-

ized fl anges to hem sharp edges or to create rolled fl ange features. Another tool commonly used 

along with these tools is the Face tool. Depending on the selected tool, you can either control 

fl ange options or allow Inventor to apply predefi ned relationships and values.

Flange

The Flange tool creates a single planar face and bend for each edge selected, with controls for 

defi ning the fl ange height, bend position, and relief options at the edge intersections. For fl anges 

referencing a single edge, width extent options are also available by clicking the >> button in 

the Flange dialog box. If multiple edges have been selected for fl ange locations, corner seams are 

automatically added, as shown in Figure 6.6. The bend and corner seam dimensions follow the 

sheet-metal rule unless a value is entered to override them per that particular feature. The pre-

view displays glyphs at each bend and corner seam. If you click a glyph, a dialog box appears so 

you can override the values.

Figure 6.6

A multi-edge fl ange 

feature preview 

with bend and 

corner edit glyphs

Creating Basic Flanges

To explore the Flange tool, follow these steps:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_005.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

 3. Select the Flange tool from the Create panel of the Sheet Metal tab.

 4. Currently the Edge Select Mode button (on the left side of the Edges selection box) is 

selected, allowing you to select only one edge at a time. Click the Loop Select Mode 

button so you can select multiple edges at once.

 5. Place your cursor over the top face of the hexagonal-shaped base feature. Click the edge 

when you see all six edges highlight. Note that if you chose the bottom edge rather than 

the top, you can use the Flip Direction button to change the direction.

Certification
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 6. Click the Edge Select Mode button, and then hold the Ctrl key and click one of the cur-

rently selected edges to deselect it. The Edges selection box will indicate that you now 

have only fi ve selected.

 7. Set the fl ange height to 100 mm.

 8. Set the fl ange angle to 60.

 9. Click the Corner tab, uncheck the Apply Auto-Mitering check box to observe the preview 

change, and then reselect the check box to allow the fl anges to fl are out into the mitered 

corners.

 10. In the Miter Gap input box, enter 1 mm to reduce the gap size from the current default 

value (the GapSize parameter is currently set at 3 mm in the sheet-metal rule).

 11. Click the Apply button to create the fi ve fl anges, and leave the Flange dialog box open 

(recall that clicking the OK button creates the feature and closes the dialog box, and 

clicking Apply creates the feature but does not close the dialog box).

 12. Click the Shape tab and ensure that the Edge Select Mode button is selected.

 13. Click the edge that you removed from the previous selection set. Note that if you chose 

the bottom edge rather than the top, you can use the Flip Direction button to change the 

direction.

 14. Set Flange Angle to 90.

 15. Set the Height Extents drop-down box to To, and then click the topmost corner vertex of 

any of the existing fl anges. Figure 6.7 shows the To point being selected.

Figure 6.7

Setting a fl ange 

height using the To 

option

 16. Click the OK button to create the fl ange.

If you click the front plane on the ViewCube, you can see that all the fl anges terminate in the 

same plane. Keep this in mind as you create fl anges of varying angles. You will explore the tools 

used to close the remaining gaps in this fl ange combination later in this chapter, when looking 
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at the Corner Seam tool, but for now you can close the fi le without saving changes and continue 

to explore the Flange tool.

Control Flange Widths

In this next set of steps, you’ll create fl anges of varying widths by adjusting the extents options:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_006.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

 3. Select the Flange tool from the Create panel of the Sheet Metal tab.

 4. Select the top edge of the yellow face to place a fl ange along the edge.

 5. Set the fl ange height to 50 mm and leave the angle at 90 degrees.

Note that currently the fl ange runs along the extents of the edge. If you imagine the fl at 

pattern that would result from adding this fl ange, you’ll understand that creating this 

fl ange would create a confl ict at the inside corner. Although Inventor will not prevent you 

from creating the fl ange as is, it will issue an error to the fl at pattern. To resolve this, you 

will set the fl ange width and an offset to hold it back from the corner. There are four 

possible Width Extents settings:

Edge  Runs the fl ange the length of the selected edge.

Width  Allows you to specify the width of the fl ange and position it centered on the 

selected edge or offset from a selected reference point.

Offset  Allows you to specify offsets from both ends of the selected edge.

From To  Allows you to specify a start and end reference to establish the fl ange width.

In the real world, the option you use will depend on the result you are trying to achieve 

and the available existing geometry. Here, you’ll use the Width option.

 6. Click the >> button to expand the Flange dialog box.

 7. Change Width Extents Type to Width.

 8. Enter 96 mm in the Width input box.

 9. Switch the option from Centered to Offset.

 10. Enter 0 mm for the offset value.

 11. Click the end of the selected edge farthest from the green face to establish the offset 

point. Use the Offset Flip button to redirect the fl ange if needed.

 12. Click the OK button to create the fl ange.

 13. Click the Go To Flat Pattern button on the Sheet Metal tab to have a look at the resulting 

fl at pattern.

Although the fl ange width options are easy to overlook because they are initially hidden in 

the More Options area of the dialog box, you should keep them in mind as you create fl anges. 

For now, you can close this fi le without saving changes. Here are more options to be aware of 

when creating fl anges:
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Flange Height Datum  There are three Height Datum solutions available. These options 

control which faces are used to determine the height measurement. In Figure 6.8, each of the 

options is shown using a 40 mm fl ange.

Figure 6.8

Flange height 

datum solutions

Bend From The Intersection Of The Two Outer Faces  Measures the fl ange height from 

the intersection of the outer faces, as shown on the left in Figure 6.8.

Bend From The Intersection Of The Two Inner Faces  Measures the fl ange height from 

the intersection of the inner faces, as shown in the center in Figure 6.8.

Parallel To The Flange Termination Detail Face  Measures the fl ange height parallel to 

the fl ange face and tangent to the bend, as shown on the right in Figure 6.8.

Orthogonal and Aligned Flanges  You can use the Aligned VS Orthogonal toggle button to 

determine whether the height measurement is aligned with the fl ange face or orthogonal to 

the base face. In Figure 6.9, the fl ange on the left is orthogonal and the measurement on the 

right is aligned.

Figure 6.9

Orthogonal and 

aligned fl anges

Bend Position  There are four options to select from to determine the bend position relative 

to the face of the selected edge. Figure 6.10 compares the four options, with the dashed line 

representing the selected edge of the base feature.

Figure 6.10

Bend positions 

compared

Inside Of Base Face Extents  Positions the fl ange so that it honors the overall dimension 

of the selected base part, as shown on the far left of Figure 6.10.
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Bend From Adjacent Face  Holds the face of the selected edge as the start of the bend, as 

shown on the center left of Figure 6.10.

Outside Of Base Face Extents  Positions the inside face of the fl ange so that it remains 

outside of the face of the selected edge, as shown on the center right of Figure 6.10.

Bend Tangent To Side Face  Holds the bend tangent to the face of the selected edge, as 

shown on the far right of Figure 6.10.

Old Method  When checked, this option disables the functionality introduced in the 

Autodesk® Inventor® 2008 program. If you open a fi le created in an older version, the features 

will likely have this option selected. You can uncheck the box to update the fi le to use all the 

available options. There is no reason to check this box on parts that you create with the cur-

rent version of Inventor.

Bend and Corner Edit Glyphs  Although you will often create fl anges along multiple edges 

as a single fl ange feature, you can still control the bend and corner options individually by 

using the edit glyphs displayed on the features in the graphics area. You can access the edit 

glyphs by expanding the Flange node in the browser and then right-clicking the bend or 

corner and choosing Edit Bend or Edit Corner. Once they are displayed, you can click the edit 

glyph for the bend or corner you want to edit and make changes on an individual basis. You 

can click the edit glyphs during the creation of fl anges as well. Once bends or corners are 

edited, they can be reset to the defaults by expanding the Flange node in the browser, right-

clicking the bend or corner, and choosing Reset All Bends/Corners.

Contour Flange

In addition to creating base features as explored previously, the Contour Flange tool can be used 

to add fl anges to an existing feature. Since the Contour Flange tool uses open profi le sketches, 

it is ideal for quickly creating complex shapes and enclosure designs. As discussed earlier, the 

Contour Flange tool can either automatically bend line intersections or use sketched arcs for 

bends. A contour fl ange automatically creates a bend between itself and a selected edge on an 

existing face. The sketch profi le for the Contour Flange tool does not need to be coincident with 

the edge; it simply needs to be sketched on a plane that is perpendicular to it. If the sketch pro-

fi le is coincident with an edge, a bend will automatically be positioned to connect the sketch 

profi le to the face. If the sketch is not coincident with a reference edge and the width extent 

option is changed to Distance, the result will be a contour fl ange that isn’t attached to the part.

Just as with the Flange feature, automatic mitering of adjacent fl anges and the placement of 

corner reliefs occur when multiple edges are selected, as shown in Figure 6.11.

Figure 6.11

A multi-edge 

Contour Flange 

feature with auto-

matic mitering and 

large radius bends
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To explore the Contour Flange tool a bit more, follow these steps:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_007.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

 3. Select the Contour Flange tool from the Create panel of the Sheet Metal tab.

 4. Select the visible sketch profi le as the Profi le selection.

 5. Select one of the edges (top or bottom) that have the two work planes running through it.

You’ll note that you cannot add any more edges to the selection. This is because the 

sketch is disconnected from the base feature and therefore can only be used to create a 

fl ange along the one edge. Next, you’ll use the work planes to defi ne the width of 

the fl ange.

 6. Click the >> button to expand the dialog box and reveal the Width Extents options.

 7. Set the Type drop-down box to From To.

 8. Select the two visible work planes as the From and To selections.

 9. In the Bend Extensions area, click the left button (Extend Bend Aligned To Side Faces).

 10. Click the OK button to create the contour fl ange.

You should notice that the fl ange width starts and stops at the work planes selected for 

the width extents. You’ll also notice that the edge of the base feature extends to meet the 

fl ange. This is due to the Bend Extension option. The Bend Extension options are 

as follows:

Extend Bend Aligned To Side Faces  Extends the base feature to meet the fl ange.

Extend Bend Perpendicular To Side Faces  Extends the fl ange out to meet the base 

feature. This is the default.

You’ll explore these options a bit more in the upcoming pages, but for now you’ll edit the 

fl ange and toggle this option to compare the results.

 11. Right-click the Contour Flange feature in the browser and choose Edit Feature.

 12. In the Bend Extensions area, click the right button (Extend Bend Perpendicular To Side 

Faces).

 13. Click the OK button, and note that the fl ange has now extended to the base feature, as 

shown on the right of Figure 6.12.

 14. Right-click Sketch3 in the browser and turn the visibility on.

 15. Select the Contour Flange tool from the Create panel of the Sheet Metal tab.

 16. Select the sketch profi le in Sketch3 as the Profi le selection.

 17. Select the fi ve edges of the hex-shaped face that were not used in the previous 

contour fl ange.
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 18. Notice the automatic mitering of the corners; if this was not the desired result, you could 

disable the Apply Auto-Mitering check box option found on the Corner tab. 

 19. Click the OK button to create the fl anges. 

Figure 6.12

Bend Extension 

options

As you can see, the Contour Flange tool can be used to quickly create multiple bend fl anges 

from a basic open profi le sketch. This is often the quickest way to create even simple fl anges 

when they are the same on all edges of a base feature, particularly when the fl anges require a 

miter fi t. You can close this fi le without saving changes, and continue on to the next section to 

explore hems.

Hem

The Hem tool is like a contour fl ange because it has the ability to create multiple planar faces 

and bends for a selected edge, but it is restricted to predefi ned common hem profi les and 

geometric relationships.

To explore the different hem fl ange types and options, follow these steps:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_008.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

In this fi le, each of the four hem types has been created on one side of the part. You can 

use the cutouts on the other side to create a hem matching each of the ones on the left. 

Once you have experimented with the hem types using the cutouts, proceed to create a 

hem on the edge of the yellow face.

 3. Use the ViewCube to fi nd a view of the yellow interior face.

 4. Select the Hem tool from the Create panel of the Sheet Metal tab.

 5. Set Type to Single.

 6. Select the edge along the outside of the yellow face.

 7. Set Gap to 2 mm.

 8. Set Length to 12 mm.

 9. Click the >> button to expand the dialog box.

 10. Change Width Extents Type to Offset.
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 11. Use the appropriate offset input box to set the end that will interfere with the existing 

hem to 5 mm.

 12. Set the other offset to 0 mm so that no offset is created.

 13. Click the OK button to create the Hem fl ange.

Although the Hem tools are fairly straightforward, it is often the use of offsets that allows 

you to place hems as needed. You can close this fi le without saving changes and continue to the 

next section.

Face

The last feature capable of creating fl anges is the Face tool. The Face tool uses a closed profi le 

sketch, and it can automatically create an attaching bend on a selected edge. This automatic edge 

creation is powerful because it allows you to create a skeletal surface model of your design, project 

the planar surfaces into sketches, and create face features with attached bends. The manual con-

trols can be utilized to connect face features to preexisting geometry, create double bends (joggles), 
or even deselect edges that have been automatically inferred because they share a common edge.

You can also use the Face tool to create models from 2D fl at patterns that were created in 

another application, such as Autodesk® AutoCAD®. When the 2D fl at pattern is imported, the 

Face tool can be used to thicken it to the desired value. A fl at pattern can be produced for a pla-

nar face (no unfolding needs to actually occur), which enables a variety of uses.

In the following steps, you’ll derive a frame into your sheet-metal part and use it as a reference 

to create a face. You’ll then create another face and use the built-in Bend tools to connect them:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_009.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

 3. Select the Manage tab and click the Derive button on the Insert panel.

 4. Open the fi le mi_6a_888.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

 5. In the Derived Part dialog box, select the Body As Work Surface button at the top. This 

brings the frame in as a surface that can be turned off later.

 6. Click the OK button to create the frame surface.

 7. Expand the mi_6a_888 node in the browser and right-click the Frame:mi_6a_888.ipt 

node.

 8. From the context menu, deselect the Translucent option. This will make the frame edges 

easier to see.

 9. Right-click the face of the frame side with the triangular corner gussets and choose New 

Sketch to create a 2D sketch on the side of the frame.

 10. Click the Project Geometry drop-down menu and select Project Cut Edges. This will 

project the face of the fame into the sketch. Alternatively, you can use the Project 

Geometry tool and select the four outer edges and the eight holes.

Certification
Objective

Certification
Objective
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 11. Once the projected edges are created, click the Finish Sketch button to return to the Sheet 

Metal tab.

 12. From the Sheet Metal tab, select the Face button.

 13. Choose the sketch boundary(s) so that the entire side of the frame, minus the holes, is 

selected.

 14. Ensure that the face is not going into the frame, use the Offset button if the direction 

needs to be adjusted, and then click the OK button to create the face feature with holes. 

Figure 6.13 shows the frame and face.

Figure 6.13

Face from a 

derived frame

 15. Locate the sketch called Flange Sketch in the browser, and then right-click it and choose 

Visibility from the context menu. This sketch was prepared in the sheet-metal fi le ahead 

of time for this tutorial, but it the real world you would create it by referencing the frame 

as you did for the fi rst face feature.

 16. From the Sheet Metal tab, select the Face tool again and choose the rectangular profi le 

minus the slots as the Profi le selection.

 17. Use the Offset button to ensure that the face is coming out away from the frame.

 18. Click the Edges button in the Bend area of the dialog box, and then select the left vertical 

edge of the fi rst face feature. This will create a bend connecting to two faces.

 19. Click the OK button to create the new face with the bend feature.

If you examine the slotted fl ange face, you might notice that it does not rest on the face of the 

frame. This is because the premade sketch that you made visible was created on a work plane 

at 302 mm from the center of the 600 mm–wide frame. Using the offset work plane, a 2 mm gap 

was created, allowing space for the bend radius, insert studs, and spacer hardware that might be 

required.

Be aware that when you have fi nished with a derived work surface (the frame in this case), 

you can right-click on it in the browser and toggle off the visibility. This leaves only the sheet-

metal part showing. To create the next sheet-metal part of the frame, such as the front or back 
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covering, you would create a new sheet-metal part and derive the frame again. Once all of 

the parts are complete, you can place them into an assembly fi le knowing that they will all fi t 

around the frame they were based on. For now, though, you can close this fi le without saving 

changes and continue to the next section.

Adding, Removing, or Deforming Material
Once the general shape of a sheet-metal component is roughed in, in most cases material will 

need to be removed, deformed, or added. Several sheet-metal-specifi c features have been cre-

ated to optimize the process of adding, removing, and deforming sheet-metal parts because 

most sheet-metal-manufacturing operations (punch presses, for example) create features 

perpendicular to the surface. The current capabilities of Inventor assume that these manufac-

turing operations are done in the fl at prior to folding and therefore should not interfere with 

unfolding (Inventor does not support post-folding manufacturing operations such as gussets, 

for example).

Cut

The Cut tool is a special sheet-metal extrude. It creates a hole based on a sketched profi le. The 

Cut tool helps simplify the options of the regular Extrude tool because the distance parameter 

defaults to Thickness, and therefore cut features automatically update if the sheet-metal part is 

changed to use a different material thickness. If a cut is not intended to be the full depth of the 

material thickness, you can enter an equation based on the thickness value, such as Thickness/2 

to create half-thickness cuts.

The Cut tool can also wrap the sketch profi le across planar faces and bends, as shown in 

Figure 6.14. This option is particularly helpful because it allows you to force a uniform cut 

across multiple planar faces and bends with a value greater than zero and equal to or less 

than Thickness.

Figure 6.14

Th e Cut feature 

using the Cut 

Across Bend option

Using Cuts

With sheet-metal parts, it is often best to create your base features and fl anges and then apply the 

cuts as required. You will fi nd that this provides a more stable model when creating a fl at pattern 

and allows you to edit features individually. It’s generally best practice to use the Cut tool whenever 

possible rather than creating voids in the base sketch. You should also, as a general rule, use the 

Cut tool rather than using Extrude to cut.
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To explore the options of the Cut tool, follow these steps:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_010.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

 3. Select the Cut tool from the Modify panel of the Sheet Metal tab.

 4. Click the OK button to create the cut feature. Note how the cut remains only in the top 

plane and is not accurate for a slot that would be cut in the fl at pattern.

 5. Right-click the cut feature in the browser and choose Edit Feature.

 6. Select the Cut Across Bend check box, note the preview, and then click the OK button to 

create the cut feature. You’ll notice that it cuts through the part and across the existing 

bends.

 7. Edit the cut feature again, enter Thickness/2 in the Distance input box under Extents, and 

then click the OK button.

As you can see, the Cut tool allows you to create cutouts in the formed part that are 

accurate to the way the cutout is created in the fl at pattern. To see the difference between 

a cut across bends and an extrude cut, continue with the following steps:

 8. Locate the sketch called Sketch3 in the browser, and then right-click it and choose 

Visibility from the context menu.

 9. Select the 3D Model tab and click the Extrude button.

 10. Select the profi le in Sketch3 as the profi le selection.

 11. Set the Extents drop-down box to All.

 12. Click the Cut button in the Extrude dialog box, ensure that the direction is correct, and 

then click the OK button.

 13. Use the ViewCube to look at the part from the Top view, and note the difference in the 

extruded cut and the one using the Cut tool.

 14. Select the Sheet Metal tab, and click the Go To Flat Pattern button to examine the issues 

with the extruded cut.

If you measure the length of the two cuts, you’ll see that the extruded cut exceeds the 

intended 150 mm length, even though the sketches for both features are set at 150 mm. When 

you have fi nished comparing the two cuts, you can close the fi le without saving changes and 

continue to the next section.

Punch Tool

You can use the Punch tool to either remove material or deform it by placing predefi ned Punch 

tool geometry, as shown in Figure 6.15. Punches are special versions of iFeatures; they can be 

predefi ned with additional manufacturing information and can be built using a variety of stan-

dard and sheet-metal features.
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Figure 6.15

Multiple-instance 

punch feature plac-

ing a footing dimple

To explore the methods and options used to place punch features, follow these steps:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_011.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

 3. Click the Punch Tool button on the Modify panel of the Sheet Metal tab.

 4. In the Punch Tool dialog box, use the scroll bar in the left window to locate the 

Chapter 06 folder.

 5. Locate and select the fi le Knockout_73x.ide, and then click the Open button.

Setting the Sheet Metal Punch Tool Default Location

By default, Inventor is set to look for the punch library in the install directory on your local drive. 

If you’re working on a network share drive, you will most likely want to point the Punch tool to 

automatically go to a path on the network. To do so, click the Application Options button on the 

Tools tab, select the iFeature tab, and set Sheet Metal Punches Root to the path of your choosing.

 6. Because this part has two visible sketches, no centers are automatically selected. Select 

any one of the center sketch points on the part.

 7. Continue selecting center points, and note that you can select only points that share the 

same sketch.

 8. When you have added all of the center points you can (it will be either three or four, 

depending on which sketch the points are in), select the Size tab.

 9. Enter 35 mm for the diameter value, and then click in the space below the Diameter row 

in the dialog box.

 10. Click the Refresh button to see the diameter update on-screen. Note that if the diameter 

does not update, you probably did not click out of the Diameter row to set the edit. The 

Refresh option is a bit picky in this way. Keep in mind, however, that the punch preview 

does not need to be refreshed to build correctly.
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 11. Click the Finish button to create the punches.

 12. Right-click and choose Repeat Punch Tool, and then in the Punch Tool dialog box, use the 

scroll bar in the left window to locate the Chapter 06 folder.

 13. Once again, locate and select the fi le called Knockout_73x.ide, and then click the Open 

button.

 14. You’ll notice that because you have only one visible sketch now, all of the center points in 

the sketch are automatically selected.

 15. Click the Geometry tab and then click the Centers button.

 16. Press and hold the Ctrl key on the keyboard, and then deselect any one of the selected 

center points by clicking it in the sketch. Note that it is often easier to do this when view-

ing the sketch from straight on.

 17. With all but one of the available center points selected, change Angle to 45 degrees. Note 

that all of the current punches are rotated.

 18. Click Finish to create the punches.

 19. Locate the sketch with the unused sketch point in the browser, and then right-click it and 

choose Visibility to turn it back on.

 20. Right-click and choose Repeat PunchTool, and then in the Punch Tool dialog box, use the 

scroll bar in the left window to locate the Chapter 06 folder.

 21. Locate and select the fi le Knockout_73x.ide, and then click the Open button.

 22. The fi nal center point should be automatically selected. If not, select it and then click 

Finish to create it at the default size and orientation.

You can close this fi le without saving changes, but before moving on to the next topic, take 

a moment to understand how punch placement sketches and punch features work. In the pre-

ceding steps, you explored the options and methods used to place sheet-metal punches on an 

existing sketch. The process of applying a published Punch tool to your sheet-metal design is 

fairly straightforward. When you’re authoring a Punch tool, the fi rst sketch-based feature ref-

erenced to create the Punch tool must contain a single sketched center mark. To place a Punch 

tool, at least one sketched center mark is required in the placement sketch. Creating punch 

features (and regular iFeatures) is covered in Chapter 7, “Reusing Parts and Features.”

Corner Round and Corner Chamfer

Corner Round and Corner Chamfer are special sheet-metal tools that allow you to remove 

or break sharp edges, similar to fi lleting and chamfering. Edge selection has been optimized 

within the two tools, fi ltering out edges that are not normal to the sheet top and bottom faces for 

easy application. To explore the methods and options used to place round and chamfer features, 

follow these steps:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_012.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.
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 3. Select the Corner Round tool from the Modify panel of the Sheet Metal tab.

 4. Set the radius to 8 mm, and then click the Pencil icon in the Corner Round dialog box to 

change the focus from edit to select.

 5. Select the two sharp corner edges on the green fl ange, and then click the OK button.

 6. Right-click and choose Repeat Corner Round, and then set the Select Mode radio button 

to Feature.

 7. Select any of the yellow fl anges, and you will see that all of the sharp corners for the 

feature called Flange1 are automatically selected.

 8. Change the radius to 15 mm, and then click the OK button to create the rounds.

 9. Select the Corner Chamfer tool from the Modify panel of the Sheet Metal tab.

 10. Select the remaining two sharp corners, and set the distance to 18 mm. Click the OK 

button to create the corners.

As a fi nal step you might want to right-click Flange1 in the browser, choose Properties, and 

set Feature Color Style to As Part. You can do the same to Flange2. When fi nished, you can close 

the fi le without saving the changes and continue to the next section.

Corner Seam

The Corner Seam tool allows you to extend (as shown in Figure 6.16) or trim fl ange faces to 

manage the seam between them and select corner relief options. The Corner Seam dialog box 

contains numerous options for specifying the seam and contains two fundamentally different 

distance defi nition methods: Maximum Gap and Face/Edge. In older versions of Inventor, only 

the Face/Edge method was available for the Corner Seam tool. The Face/Edge method works 

for many situations but also tends to suffer from an inability to maintain a constant seam gap 

between planar faces that do not have an identical input angle. The Maximum Gap method was 

developed from the perspective of a physical inspection gauge, where the nominal value of the 

seam is exactly the value entered at every point, but you just might need to twist the tool as you 

draw it through the seam.

Figure 6.16

Th e Corner Seam 

feature, applying 

the No Overlap 

seam type
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Creating a Basic Corner Seam

To explore the Corner Seam tool and its options, follow these steps:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_013.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

 3. Select the Corner Seam tool from the Modify panel of the Sheet Metal tab.

 4. Select the left edge of the yellow face and either edge of the blue face next to it. In the 

preview, the red edges represent the material to be removed and the green edges repre-

sent the material to be added.

 5. In the Seam area of the Corner Seam dialog box, select the Symmetric Gap option if it’s 

not already selected.

 6. Set the gap to 1 mm and notice the change to the preview.

 7. Click the Apply button to create the seam feature.

 8. Select the right edge of the orange face and either edge of the blue face next to it, and then 

click the OK button to create this seam and close the dialog box.

As you can see, corner seams are useful when you need to close up a corner between two 

seams. You can close this fi le without saving changes and continue with the next set of steps to 

explore more of the settings in the Corner Seam tool.

Understanding Corner Seam Gap and Overlap Settings

In these steps, you’ll explore the gap and overlap settings found in the Corner Seam tool:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_014.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

 3. Select the Corner Seam tool from the Modify panel of the Sheet Metal tab.

 4. Select the short edge of the orange fl ange nearest the yellow fl ange and the short edge of 

the yellow fl ange nearest the orange fl ange.

 5. You’ll note that the preview shows that the two fl anges come together in a 45-degree 

miter. Click the Overlap button to see the preview change to extend one of the fl anges so 

it overlaps the other.

 6. Click the Reverse Overlap button to see the opposite overlap in the preview.

 7. Click the Apply button to create the seam.

 8. Click a short edge of the yellow fl ange nearest the blue fl ange and a short edge of the blue 

fl ange nearest the yellow fl ange.

 9. Set the Seam option to Maximum Gap Distance (if it is not already), and click the 

Symmetric Gap button.
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 10. Click the OK button to create the corner seam, and then click the top face on the 

ViewCube to observe the corner of the yellow and blue fl anges. Note that it may be 

helpful to zoom up on the corner.

If you measure the gap distance at the inside vertices between the two fl anges, it will be 

3 mm, which is what the Gap parameter is set to, as shown on the left of Figure 6.17.

Figure 6.17
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 11. Edit the corner feature you just created, switch the radio button to Face/Edge Distance, 

and then click the OK button.

Now the Gap parameter holds the distance between the face and edge of the two fl anges, 

as shown on the right of Figure 6.17.

 12. Edit the corner feature again, and this time click the Overlap button.

 13. Enter 0.5 in the Percent Overlap input box, and then click the OK button.

You will see that the yellow fl ange overlaps the edge of the blue fl ange exactly halfway, 

or 50 percent. You can specify the overlap as a percentage of the fl ange thickness using a 

decimal value ranging from 0.0 to 1.0. For instance, 1.0 equals 100 percent, 0.5 equals 50 

percent, and so on.

 14. Edit the corner feature once again, and click the Reverse Overlap button.

 15. Enter 1.0 in the Percent Overlap input box, and then click the OK button.

You will see that the blue fl ange now overlaps the yellow fl ange completely, or the full 100 

percent. Figure 6.18 shows a comparison of overlap values with the same gap setting of 3 mm. 

On the left the overlap is set to 1.0, or 100 percent of the 3 mm gap. In the middle the overlap is 

set to 0.5, or 50 percent of the 3 mm gap. And on the right the overlap is set to 0.0, or 0 percent of 

the 3 mm gap.

Figure 6.18

Overlap 

comparisons
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In the previous steps you explored the gap and overlap settings of the Corner Seam tool. You 

can close this fi le without saving changes and continue with the next set of steps to explore one 

more set of options in the Corner Seam tool.

Understanding Corner Seam Extend Options

In the following steps, you will look at the options for controlling the way fl anges are extended 

when their edges are not perpendicular:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_015.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

 3. Select the Corner Seam tool from the Modify panel of the Sheet Metal tab.

 4. Select the shorter edge of the blue fl ange and the closest edge of the yellow fl ange.

 5. Click the >> button in the Corner Seam dialog box and set the Extend Corner option to 

Perpendicular; then click the Apply button.

 6. Select the taller edge of the blue fl ange and the closest edge of the orange fl ange.

 7. Click the >> button in the Corner Seam dialog box again (if needed), and toggle the 

Extend Corner option between Perpendicular and Aligned to see the difference.

 8. Set the Extend Corner option to Perpendicular, and click the OK button.

Figure 6.19 shows a comparison of the Perpendicular and Aligned extend options. In the 

image on the right, the frontmost fl ange uses the Aligned solution and the other uses the 

Perpendicular solution.

Figure 6.19

Perpendicular and 

Aligned extend 

corner options

As you can see, becoming familiar with all the settings in the Corner Seam tool can make 

you aware of a great number of combinations and in the end provide the exact corner you are 

trying to achieve. You can close this fi le without saving changes and continue on to explore the 

Fold tool.

Fold

The Fold tool enables you to design a fl ange with a unique profi le by allowing you to sketch the 

position of the bend centerline on a planar face and then fold the part using the sketch line, as 

shown in Figure 6.20.
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Figure 6.20

Th e Fold tool 

being applied to a 

face with a spline 

contour

This tool is a sketch consumption feature and contains numerous controls for specifying 

exactly how a planar face should be manipulated into two planar faces connected by a bend. The 

sketch bend centerline must be coincident with the face extents, requiring you to project edges 

and constrain the sketch. When utilizing the Fold tool, remember that the feature works from 

the opposite design perspective of other sheet-metal features, where bend allowance is actually 

consumed, not added to the resulting folded feature. The Fold tool can be combined with the 

Face tool to help import preexisting 2D fl at patterns and then deform them into their fi nal shape.

To explore the Fold tool, follow these steps:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_016.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

 3. Select the Fold tool from the Create panel of the Sheet Metal tab. (Be aware that there is 

an Unfold button and a Refold button as well. You will explore those in the coming pages, 

but for now ensure that you select the Fold tool.)

 4. Select the visible sketch line on the circular feature for the Bend Line selection.

 5. Use the Flip Side and Flip Direction buttons to set the preview arrows so that they are 

going up and out from the center of the part.

 6. Set Fold Angle to 45 (degrees) and Bend Radius to 16 mm.

 7. Use the Fold Location buttons to set the fold so that it does not include the cutout.

 8. Click the OK button to create the folded feature.

 9. To reuse the sketch containing the bend lines, you’ll need to make it visible again. To do 

so, expand the Fold feature in the browser, right-click the sketch, and choose Visibility 

from the context menu.

 10. Create a fold for each of the remaining lines, setting Fold Angle to 90, Bend Radius to 

2 mm, and Fold Location to Centerline Ff Bend. Use the fl ip controls to set the folds so 

they are all going up and out from the center of the part.

Although not the most commonly used of the sheet-metal tools, the Fold tool can be very 

useful in some circumstances. If you happen to have a lot of fl at pattern drawings done in 

AutoCAD, for instance, you can use the Fold tool to convert them to folded models. You can 

close this fi le without saving changes and continue on to explore the Bend tool in the next 

section.
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Bend

The Bend tool allows you to connect two planar faces by selecting a pair of parallel edges. Since 

Inventor allows the modeling of multiple disconnected faces, the Bend tool can add either a 

single bend or a double bend, depending on the number of selections you make. For design situ-

ations in which multiple disconnected faces have been produced, the Bend tool is often used to 

combine the faces into a single body.

There are four possible double-bend results, depending on the orientation of the edges and 

selected option. If the sheet-metal edges face the same direction, the tool creates either a full round 

bend or two bends connected with a face. If the sheet-metal edges face in opposite directions, a jog-

gle is created with either two 45-degree bends and one edge fi xed or both edges fi xed and the angle 

calculated. In both cases, the faces will be extended or trimmed as necessary to create the bends.

Exploring Bend Options

The following example demonstrates the various ways in which double bends can be created:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_017.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

 3. Select the Bend tool from the Create panel of the Sheet Metal tab.

 4. Select an edge along each of the yellow faces for the Edges selection. Note that the Full 

Radius and 90 Degree Double Bend controls are enabled.

 5. Set the Double Bend option to Full Radius.

 6. Toggle the Flip Fixed Edge button and note how the preview updates. Then set it so that 

the upper face is the fi xed edge (the preview will display partially into the lower face).

 7. Click the Apply button to create the Bend feature.

 8. Select an edge along each of the orange faces for the Edges selection.

 9. Set the Double Bend option to 90 Degree.

 10. Set the Flip Fixed Edge button so that the lower face is the fi xed edge and the bend 

previews on the outermost edge.

 11. Click the OK button to create the Bend feature, and note how the lower face width is 

carried through to the upper face.

 12. Right-click the Bend feature you just created in the browser, and choose Edit Feature.

 13. Click the Extend Bend Aligned To Side Faces button in the Bend Extension area, and then 

click the OK button. Notice how the upper face width is now carried through to the bend.

 14. Select the Bend tool again, choose the edge of the blue face on the small feature with two 

holes, and then select the edge of the blue face on the large base feature (indicated with 

the arrow). Keep in mind that the selection order is important for this step. When you 

have the correct order, the preview should show the upper feature being extended down 

into the lower base feature.

 15. Set the bend radius to 18 mm, and then click the OK button.
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 16. Right-click the Bend feature you just created in the browser and choose Edit Feature.

 17. Change the Double Bend option to Fix Edges, and then click the OK button.

Although this fi le showcases the available options of the Bend tool, you would not typically 

create faces that just fl oat in space above or below one another. Instead, these tools are often 

used to create bends on faces that are modeled to fi t around other existing parts, most often by 

projecting edges in from an assembly fi le. You can close this fi le without saving changes, and 

have a look at the next steps to see the Bend tool used in a more realistic manner.

Using the Bend Tool to Create an Enclosure

In the following steps, you will mirror an existing side of an enclosure around the centerline of a 

derived frame and then use the Bend tool to join the two halves:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_018.ipt from the Chapter 06 directory of the Mastering Inventor 

2014 folder.

 3. Click the Mirror button on the Pattern panel of the Sheet Metal tab.

 4. Select the features called Right_Side_Face, Front_Flange, and Back_Flange from the 

browser for the Features selection.

 5. Click the Mirror Plane button in the Mirror dialog box, and then choose the visible YZ 

plane. Recall that you must select work planes by clicking their edges in the graphics area 

or by selecting them from the browser.

 6. Click the OK button to create the mirror feature.

 7. Select the Bend tool from the Create panel of the Sheet Metal tab.

 8. Select the top edges of the original and the mirrored faces, leave the Double Bend option 

set to 90 Degree, and note the preview of the bend connecting the two faces.

 9. Click the OK button to create the bend feature. Figure 6.21 shows the two sides being 

connected with the Bend tool.

Figure 6.21

Creating a bend to 

connect the sides of 

an enclosure
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In the previous steps, not only have you created bends, but you have essentially defi ned the 

entire top face of the enclosure with the Bend tool. Using the Bend tool to connect faces in this 

manner can be a quick way to use geometry projected in from an assembly or a derived work 

surface. You can close this fi le without saving changes and continue on to the next section to 

explore the Rip tool.

Rip

The Rip tool creates a gap in a sheet-metal part. A common workfl ow is to create a transition 

with the Lofted Flange tool and then add a Rip feature so it can be fl attened. The Rip tool cre-

ates a gap that is cut normal to the selected face. The Rip tool interface is optimized to create a 

simple gap with minimal inputs.

Inventor has three options for creating a rip:

Single Point  If the corner of a face is selected as the single point, the rip will follow the 

edge. If a sketch point located on an edge is selected, the rip will be perpendicular to 

the edge.

Point To Point  For Point To Point, a linear rip is created between the two points.

Face Extents  For face selection, all edges of the face are ripped.

Follow these steps to create a simple Rip feature on a square-to-round transition:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_019.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder .

 3. Click the Rip button in the Modify panel on the Sheet Metal tab.

 4. Set the Rip Type drop-down box to Point To Point.

 5. Select the yellow face for the Rip Face selection.

 6. Select the midpoint of the arc along the top of the yellow face and the midpoint of the arc 

along the bottom of the yellow face for the Start Point and End Point selections.

 7. Click the OK button to create the Rip feature. Figure 6.22 shows the Rip tool selections.

Figure 6.22

Ripping a crease on 

a square-to-round 

transition
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Creating Rip features allows you to open up a part for unfolding in quick and easy manner. 

Keep in mind that you can use an extruded cut to do this as well. In most cases, though, the Rip 

tool will be the best tool to use. You can close this fi le without saving changes and continue on 

to the next section to explore the Unfold and Refold tools.

Unfold and Refold

The Unfold and Refold tools are a powerful tool combination that allows you to unfold and then 

refold the model. There are several reasons to do this:

 ◆ To add features in the unfolded state

 ◆ To refold the model in bend order to see the manufacturing stages of the part

 ◆ To change the orientation of the folded model in space

One of the limitations in early versions of Inventor was that you couldn’t fold a deformation. 

Using Unfold or Refold, you can add a deformation that crosses the bend zone and then refold it. 

Since the deformation is simply calculated around the bend, there can be distortion issues when 

the deformation is large with respect to the bend radius. For best results, limit the deformation 

to the material thickness. For larger deformations, make sure the fi nal results match what would 

be created in the shop.

Another aspect of the Unfold and Refold tools involves bend order. Many sheet-metal parts 

are complex, with several bend-order possibilities. Using Unfold or Refold allows you to experi-

ment with bend order so you can determine the best way to manufacture the part.

Changing the orientation of the folded model allows for some interesting workfl ows. When 

you unfold a model, you select a face that remains stationary. When you refold the model, you 

also have to select the stationary face. If you select a different stationary face for the refold than 

you did for the unfold, the model will have a different orientation when you have fi nished.

Unfolded vs. Flat Pattern

Th e fl at pattern is a separate model object that shows the completely fl attened part for documenta-

tion. Th e fl at pattern also contains manufacturing information such as bend direction. Unfold and 

Refold features can’t be directly accessed in the drawing, so you can’t have views showing diff erent 

states of the same model. To show intermediate fold states in a drawing, use derived parts or an 

iPart to create models with refold features suppressed, and then create views of those models.

Unfolding and Refolding Sheet-Metal Parts

The Unfold/Refold process is straightforward. The selections have fi lters for the correct geom-

etry, so you are not required to focus on a small target. Follow these steps:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_020.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

 3. Click the Unfold button in the Modify panel.
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 4. Select the blue face on the part for the Stationary Reference selection.

 5. Select each of the bends on the folded model. Each bend will highlight when you hover 

your mouse pointer over it, so you know when you have a valid selection. The unfolded 

preview updates as you select each bend. Alternatively, you can use the Add All Bends 

button.

 6. Click the Sketches button, and select the visible sketch in the graphics window so that it 

is unfolded to match the face it resides on.

 7. Click the OK button. The model should look like Figure 6.23. Note that a copy of the 

sketch was placed on the unfolded model and that the original (Sketch12) is still dis-

played as a reference.

Figure 6.23

Unfolded model 

with sketch

 8. Right-click Sketch12 in the browser, and choose Visibility to toggle off its visibility so that 

the copied sketch can be more easily viewed.

You may have noticed that there was an option to turn off the visibility of the parent 

sketch in the Unfold tool as well. Most likely that is the way you would handle copied 

sketches, but in this case you’ve been instructed to do this manually to observe the way 

the sketches are copied. In the next steps you will create formed slots using the copied 

sketch:

 9. Click the Cut button in the Modify panel.

 10. Select the two oblong profi les in the copied sketch, and click the OK button.

 11. Select the 3DModel tab, and click Extrude.

 12. Select the two oblong profi les in the copied sketch.

 13. Click the fl yout arrow in the Distance input box and choose List Parameters, and then 

select Thickness from the list (or just type Thickness in the input box).

 14. Click the Symmetric button so that the extrusion will extend equally in both directions 

from the sketch plane, and then click the OK button.

 15. Expand the Unfold1 feature in the browser, right-click Sketch12:Copy, and choose 

Visibility to turn off the sketch.
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 16. Select the Sheet Metal tab, and click Refold in the Modify panel.

 17. Select the yellow face on the part to use as the new stationary reference.

 18. Click the Add All Bends button to automatically select all the bends. Then click the OK 

button.

Note that the model is in a different position than it was before the unfold action since the 

yellow face was kept stationary during the refold. If you drag the End-of-Folded marker above 

the Unfold feature, the model will be in its original position. As you can see, using the Unfold 

and Refold tools offers a lot of possibilities for placing features in a fl attened version of the 

model. You can close this fi le without saving changes.

Unfolding and Refolding Contour Rolls Features

You can also unfold or refold a contour roll. If the tools detect that the part is a contour roll, 

work planes are displayed on each end face. Since a fl at reference face is required, you can select 

one of the work planes and then unfold the contour roll, as shown in Figure 6.24.

Figure 6.24

Unfolding a 

contour roll

You can open the fi le mi_6a_030.ipt located in the Chapter 06 directory of your Mastering 

Inventor 2014 folder, and experiment with unfolding and refolding the part.

Project Flat Pattern

A well-hidden segment of sheet-metal-specifi c functionality is a special version of sketch pro-

jection called Project Flat Pattern (nested at the end of the sketch projection fl yout). Project Flat 

Pattern is available from the folded model environment and is utilized to include the projected 

edges of the fl attened sheet-metal component, oriented to the sketch plane that is active.

This option is very powerful when combined with the Cut Across Bend option because it 

allows you to create parametric dimensions and constrained relationships from the perspective 

of the fl attened sheet. When utilizing the Project Flat Pattern option, it isn’t necessary to select 

every face; just pick the ones at the extremities (ensuring that they’re on the same fl attened side 

of the part as your sketch), and all the connecting planar faces and bends will automatically be 

included.
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In the following steps, you’ll use the Project Flat Pattern tool to place sketch entities as they 

would be on the fl at pattern. You’ll then use the Cut Across Bends option of the Cut tool to cre-

ate the features in place on this rather extreme example of a bent sheet-metal part:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_021.ipt from the Chapter 06 directory of the Mastering Inventor 

2014 folder.

 3. Select the orange face and create a new 2D sketch on it.

 4. Click the drop-down arrow next to the Project Geometry button, and select Project Flat 

Pattern from the drop-down menu.

 5. Select one of the yellow faces to project the chain of faces between it and the orange face 

into the sketch; then select the other yellow face to complete both sides.

 6. Try to select the blue faces to project into the sketch, and you’ll note that nothing 

happens.

Nothing happens because the blue faces are actually opposite the original orange face 

when this part is fl attened out. You could select the underside of the blue faces to include 

them in the sketch, but in this case you can just use the green faces.

 7. Select the green faces to project the remainder of the fl at pattern into the sketch. Keep in 

mind that you really only need to project the faces you plan to use in the sketch, but for 

this example you’ve been instructed to select them all.

 8. Next, add three circles to the sketch. Two of the circles are to be placed at the center 

points of the projected yellow faces and will be 50 mm in diameter, and the third circle 

will be 25 mm in diameter and is to be placed in line with the center of the part and 

375 mm off the tip of the orange face. Figure 6.25 shows the completed sketch.

Figure 6.25

Adding geometry 

to a projected fl at 

pattern sketch

 9. Click the Finish Sketch button when the sketch is complete, and then select the Cut tool 

from the Modify panel.
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 10. Select all three of the circles for the Profi le selection.

 11. Select the Cut Across Bend check box, and then click the OK button.

The result is that the circular cuts are placed on the folded model in accordance with their 

position in the fl at pattern. This ability to lay out features in the fl at pattern and then cut them 

across existing bends is a subtle but very powerful tool. Keep in mind, too, that the projected 

fl at pattern is fully associative and will update along with changes made to the features from 

which it was created. You can close this fi le without saving changes and continue on to the next 

section.

Using Sheet-Metal Templates and Rules
Inventor offers the ability to create sheet-metal rules that can be stored in the Inventor style 

library. The style library makes sheet-metal defi nition information more manageable, reusable, 

and ultimately more powerful than simply using a template fi le to manage sheet-metal styles; 

however, using sheet-metal styles and templates to manage material and unfolding setups is 

supported.

What Are Sheet-Metal Rules?
Sheet-metal parts of a certain material and thickness often share bend, corner, and gap param-

eters. The unfold, bend, and corner settings as well as representation of punch features in the 

fl at pattern and the bending angle or open angle option when the part is shown in the fl at pat-

tern all make up a sheet-metal rule. For instance, you might have a sheet-metal rule called 3 mm 

Galvanized Steel. In this rule, the material would be set to galvanized steel, the thickness to 

3 mm, and the bend, corner, punch representation, and fl at pattern bend angle settings would be 

confi gured to output those features consistently.

When a new part is created, you can select the predefi ned sheet-metal rule, and the part will 

follow the settings outlined within it. When a new feature such as a fl ange is added, the bend 

and corner options defi ned in the rule are automatically used to defi ne it. If a setting such as a 

corner relief needs to deviate from the rule, it can be modifi ed in the feature as needed. If the 

part is changed to use a different sheet-metal rule, the overridden settings honor the overrides, 

and all others update to match the rule settings.

Creating a Sheet-Metal Rule

Sheet-metal rules are created and accessed in one of two ways. You can click the Styles Editor 

button on the Manage tab, or you can click the Sheet Metal Defaults button found on the Sheet 

Metal tab. The Sheet Metal Defaults dialog, shown in Figure 6.26, allows you to specify the 

sheet-metal rule and whether to use the thickness, material style, and unfold rules defi ned in 

the sheet-metal rule or to override them.

To create or edit a sheet-metal rule, click the Edit Sheet Metal Rule button (it looks like a pen-

cil), and the Style And Standard Editor appears. Figure 6.27 shows the sheet-metal rule options 

in the Style And Standard Editor.
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Figure 6.26

Th e Sheet Metal 

Defaults dialog box

Figure 6.27

Th e Sheet Metal 

Rule page in the 

Style And Standard 

Editor dialog box 

displaying an 

active rule

Follow these general steps to create a new rule:

 1. Select an existing rule and click the New button at the top of the screen.

 2. Enter a name for the new rule.

 3. Set the sheet material and thickness.

 4. Set an unfold rule to use.

 5. Set the gap thickness to use. You can set this to Thickness so that it will update to match 

the sheet thickness, or you can set it to a fi xed value.

 6. Set the bend angle to either Bending Angle or Opening Angle.

 7. Set the Flat Pattern Punch Representation style.

 8. Click the Bend tab and set the bend options.

 9. Click the Corner tab and set the corner options.

 10. Click the Save button along the top of the Style And Standard Editor dialog box. The rule 

is now saved in the current part fi le.
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 11. Optionally, right-click the new unfold rule name in the left list, and choose Save To Style 

Library to write the new unfold rule to the external style library XML fi le.

 12. Click Done to exit the Style And Standard Editor dialog box.

Bend and Corner Quick References in the Help Files

Autodesk has done a good job of hiding the help references for many of the sheet-metal features. 

However, once you fi nd them, they are very helpful in determining what these options adjust. 

When you fi nd them, you can create a Favorites link so they are more accessible. Here are a couple 

you might want to add to your favorites:

Sheet Metal Bend Options  Press F1 to bring up the help pages. On the Contents tab, 

expand the tree to fi nd Autodesk Inventor ➢ Parts ➢ Sheet Metal Parts ➢ Sheet Metal 

Features ➢ Faces, and then click the Quick Reference tab in the right pane. Select Sheet 

Metal Bend Options.

Sheet Metal Corner Options  Press F1 to bring up the help pages. On the Contents 

tab, expand the tree to fi nd Autodesk Inventor ➢ Parts ➢ Sheet Metal Parts ➢ Sheet Metal 

Features ➢ Corner Seams, and then click the Quick Reference tab in the right pane. Select 

Sheet Metal Corner Options.

To add them to your favorites, click the Favorites tab and click Add in the left pane while viewing 

the page. Once they are added, you can rename them via the context menu.

Sheet-Metal Rules vs. Sheet-Metal Styles

Sheet-metal rules are set up using the Style And Standard Editor. Initially, the rules are created 

in a part fi le as a local style, meaning they exist in that part fi le only. If you save the part fi le as 

a template fi le, all of your new parts will contain the sheet-metal rule. In addition to using tem-

plates to manage sheet-metal rules, you can add the rules to the style library. Style libraries are 

XML fi les that are stored externally to the part fi les and therefore can be used by newly created 

parts or existing parts. You save a rule to a library by right-clicking the rule in the Style And 

Standard Editor and selecting Save To Style Library, assuming your project (.ipj) fi le is set up 

to use a style library.

Unfold Rules

Whenever you fold a sheet-metal part on the shop fl oor, some material deformation occurs at the 

bend location. To the outside of the bend the material stretches, and to the inside of the bend 

the material is compressed. To calculate this deformation for each bend, Inventor uses sheet-metal 
unfold rules. Sheet-metal unfold rules control the method of unfolding used to calculate the fl at 

pattern for a folded sheet-metal part. You can create unfold rules using a K-factor or a bend table.

K-Factors

K-factors defi ne the theoretical percentage of the material thickness where a folded part is 

neutral and neither expands nor contracts. The reason this surface is referred to as the neutral 
surface is that it defi nes a measurable position within the bend that has the same value in the 

folded and unfolded states. For instance, if your material is 10 mm thick and you use a K-factor 
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of 0.44, bends and folds are calculated so that deformation of the bend takes place at 4.4 mm 

(or 44 percent of the material thickness). Unfolding with a K-factor is accomplished by deter-

mining the bend allowance (the amount of material required to produce a bend) for a given 

bend using the sheet thickness, the bend angle, the inner bend radius, and a K-factor value. The 

K-factor you use will depend on numerous factors, including material, thickness, and tooling. 

Most likely, you will need to perform a number of test bends on a specifi c press brake to 

determine the ideal K-factor for you.

The following equation is used to determine the developed fl at pattern length using a 

K-factor:

Total Length = Leg 1 + Leg 2 + Bend Allowance

The bend allowance is calculated using this equation:

BA = π × (A/180) × (R + K × T)

In this equation, the abbreviations have the following meanings:

 ◆ BA = bend allowance

 ◆ A = bend angle in degrees

 ◆ R = inside bend radius

 ◆ K = K-factor

 ◆ T = material thickness

Figure 6.28 shows a basic bend.

Figure 6.28

Basic bend 

references

Custom Unfold Equations

In addition to K-factors and bend tables, you can create custom unfold equations to use as an 

unfold method. You can fi nd more information concerning custom unfold equations by selecting 

the Index tab of the help fi le and searching the keyword Unfolding and then selecting Sheet Metal 

Equations from the list.
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To create an unfold rule to use a K-factor, follow these general steps:

 1. Select the Manage tab and click the Styles Editor button to open the Style And Standard 

Editor dialog box.

 2. Click the plus sign to the left of the Sheet Metal Unfold Rule node in the left pane of the 

Style And Standard Editor dialog box to display the existing unfold rules.

 3. Click an existing default rule to serve as the template for the new rule.

 4. Click the New button along the top of the Style And Standard Editor dialog box.

 5. Enter the name of the new sheet-metal unfold rule, and click the OK button.

 6. Ensure that the unfold method is set to Linear.

 7. Enter a new K-factor value.

 8. Click the Save button at the top of the Style And Standard Editor dialog box. The rule is 

now saved in the current part fi le.

 9. Optionally, right-click the new unfold rule name in the left list and choose Save To Style 

Library to write the new unfold rule to the external style library XML fi le.

 10. Click Done to exit the Style And Standard Editor dialog box.

Bend Tables

An alternative to using K-factors is to create a bend table. Using bend tables is the most accurate 

method of unfolding because bend tables are created by taking measurements of actual bent test 

parts of the exact material and thickness made on the shop fl oor. To create a bend table in Inventor, 

you must fi rst gather accurate bend information by creating bend tests. The granularity of the 

experimental values is up to you. It could be based on 15-degree increments or perhaps 0.5-degree 

increments; it depends on how much experimental data you have.

Typically, a number of test blanks are cut from a given material and thickness and then bent 

to the most common angles and radii used. If you measure the folded sample using virtual 

sharp locations, the values obtained will inherently be too large. The overmeasurement of the 

test fold sample needs to be compensated for by deducting an amount of length. By subtract-

ing your combined measurements from the initial measurement of the sample taken prior to 

folding, you will be able to determine the value of excessive length (overmeasurement); this is 

what gets entered into the bend table and is where the method name bend deduction comes from. 

Bends are then calculated as follows:

Total Length = Leg 1 + Leg 2 – Bend Deduction

You can set up a test bend table as described in the following steps:

 1. Click the Get Started tab, and choose Open.

 2. Open the fi le mi_6a_022.ipt from the Chapter 06 directory of your Mastering 

Inventor 2014 folder.

 3. From the Sheet Metal tab, select Sheet Metal Defaults.
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 4. Click the Edit button for Unfold Rule (it looks like a pencil).

 5. In the Style And Standard Editor, expand the Sheet Metal Unfold node from the list on 

the left (if it’s not already expanded), select Default_KFactor, and then click the New 

button at the top. This creates a new unfold rule based on the existing one.

 6. Enter Mastering Bend Table for the name, and click the OK button.

 7. Change the Unfold Method drop-down box to Bend Table.

 8. Set Linear Unit to millimeter (mm) to match the units of this part fi le.

 9. Click the Click Here To Add row in the Thickness box, and enter 2.00, for 2 millimeters.

 10. Enter 30 into the leftmost cell of the table to defi ne the angle at 30 degrees.

 11. Enter 1.0 in the topmost cell to defi ne the bend radius at 1 mm.

 12. Enter 0.5 in the cell to the right of the angle cell and just under the bend radius cell. This 

is the bend deduction (in this case, 0.5 is a hypothetical value).

 13. Add another bend angle row by clicking the cell containing 30 and choosing Insert Row.

 14. Enter 45 for the angle and 0.6 for the bend deduction.

 15. Add another bend radius column by clicking the cell containing 1.000000 and choosing 

Insert Column.

 16. Enter 2.0 in the column header for the bend radius, and then enter 0.55 for the 30-degree 

row and 0.65 for the 45-degree row.

 17. Add a third row of 60 degrees with 0.70 and 0.75 bend deductions in the 1.000000-degree 

and 2.000000-degree columns, respectively.

 18. Add a third column of 3.0 mm with 0.60, 0.70, and 0.80 for the 30-, 45-, and 60-degree 

rows, respectively.

 19. Bends greater than 90 degrees and bends less than 90 degrees are handled differently, so 

in this case you want to set the Angle Reference radio button to use the Bending Angle 

Reference (A) option. This allows the table to match the existing part. If you wanted to 

use the Open Angle Reference (B) option, your table angles would need to be 150, 135, 

and 120. You can check your table against the one in Figure 6.29.

Figure 6.29

Th e sample bend 

table
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 20. Click Save and then Done to fi nish the bend table.

 21. In the Sheet Metal Defaults dialog box, choose Mastering Bend Table from the Unfold 

Rule drop-down box to make it the active unfold rule for this part, and then click the OK 

button.

Bending Angle and Open Angle References

Originally, the Inventor Bend Table was designed to reference an open angle datum structure (which 

is still default) for measuring bends. However, the sheet-metal features all use a bending angle datum 

structure to create bent features. As a means to bridge this disparity in measurement convention, 

the Bend Angle option at the top of the bend table interface allows you to declare the structure in 

which your values were measured; Inventor will use this option to convert the values internally if 

necessary. Keep in mind that the angular values are not altered within the table when this option 

is changed.

As you can see, the process of creating a bend table in Inventor is a straightforward endeavor. 

Typically, the real work is in creating the test blanks and bends to gather the information to put 

into the table.

Here are a few more things to know about creating bend tables:

 ◆ Note that you can reorder rows and columns by clicking the header cell and dragging them 

into place.

 ◆ You can also right-click the top, leftmost cell and choose Paste Table to paste in a table 

copied from an Excel spreadsheet. Likewise, you can choose Copy Table to copy the table 

into Excel.

 ◆ You can add a bend table for each thickness required by clicking the Click To Add row in 

the Thickness box.

 ◆ If the bend deduction is outside of the values defi ned in the table, Inventor uses the Backup 

K-factor. You can think of this as an insurance plan that allows you to obtain a fl at pattern 

even if your bend table doesn’t defi ne what deduction to use for smaller or larger combina-

tions of bend angle and radius.

 ◆ For combinations that fall within the table boundaries but not exactly at angle/radius 

coordinate values, Inventor uses linear approximation to derive a value; depending on the 

change in bend compensation between steps in the table, you can achieve better results 

with smaller angle increments.

 ◆ You can specify a table tolerance to allow Inventor to include thicknesses, radii, and angles 

that are within the specifi ed tolerance. For example, if the angle tolerance is 0.004 and a 

bend angle measures 30.002, Inventor would use the 45-degree row in your table to calcu-

late the deduction.

To test the bend table, you can examine the fl at pattern in mi_6a_022.ipt, where a sketch 

has already been placed to display the fl at pattern length. Because the part fi le has a current 
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thickness of 2 mm, a bend angle of 60 degrees, and a bend radius of 2 mm, the bend deduction 

indexed from the bend table will be 0.75 mm, as shown in Figure 6.29.

In this case, then, the bend deduction is calculated as follows:

Leg 1 + Leg 2 – Bend Deduction = Total Flat Pattern Length

25 mm + 25 mm – 0.75 mm = 49.25 mm

If you were to change the angle to 45 degrees (and click the Update button) and check the fl at 

pattern again, you would expect to see this:

25 mm + 25 mm – 0.65 mm = 49.35 mm

What would happen if you were to set the angle to 37.5 degrees, which is halfway between 

30 and 45 degrees? Because the bend table has no entry for 37.5 degrees, Inventor uses a linear 

extrapolation of the bend deductions of 0.55 mm for 30 degrees and 0.65 mm for 45 degrees and 

arrives at the halfway point of 0.60 mm for 37.5 degrees. If you check the fl at pattern, you will 

expect to see this:

25 mm + 25 mm – 0.60 mm = 49.4 mm

K-Factors and Bend Tables: Which Should I Use?

Th e most common question asked about fl at patterns concerns the use of K-factors and bend tables. 

Which to use depends on your manufacturing processes and the capabilities of your machines. 

Th ese are the main questions to ask when determining which is right for you:

 ◆ Do you outsource your sheet-metal manufacturing?

 ◆ How accurate do your parts need to be?

Whether you build the parts in-house or you outsource them, you should be able to get the data from 

the shop. If your sheet-metal shop is unsophisticated, they may use rules of thumb to determine 

the bend allowance. In that case, you need to work with them to determine whether a K-factor or 

a bend table is the best solution. One of the advantages of using sheet-metal rules is that you can 

create rules for each shop. For example, if you generally use your shop but you outsource when you 

are busy, you can select the rule for the other shop and the fl at pattern will automatically update.

In general, K-factors are used for parts with large tolerances. Since the K-factor is an approxima-

tion, the actual value will vary depending on the machine. For parts with very tight tolerances, 

you need to know specifi c compensation values for the bend radius and angle for the machine, 

material type, and thickness. Depending on the material, you might need diff erent values based 

on the grain direction. For extremely tight tolerances with certain material types, you might even 

need diff erent values for each shipment of material.

Bend Compensation

In addition to using K-factors and bend tables, you have the ability to enter an expression for a 

bend compensation. Instead of entering values for specifi c bend angles and using linear interpola-

tion between the values, you can enter ranges of bend angles that use an expression to determine 
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the proper compensation within that range. To access the Bend Compensation settings, click the 

Style Editor button on the Manage tab, and then expand the Sheet Metal Unfold node in the left 

pane. Finally, select BendCompensation. Figure 6.30 shows the BendCompensation settings.

Figure 6.30

BendCompensation 

settings

Working with Styles and Templates
If your project location is set to use the style library, it is important to understand what has been 

defi ned within your template and what has been stored within the style library. For example, sup-

pose you have a sheet-metal rule named MyRule1 with the Thickness value equal to 2 mm stored 

only locally in your template fi le, and another sheet-metal rule also named MyRule1 but with the 

Thickness value equal to 5 mm, also stored in your style library. Each time you start a new design 

from the template referencing MyRule1, you will see a Thickness value of 5 mm being applied. 

The reason for this is that the style library is the “published” source of your standards; its defi ni-

tion will always win. After saving your design, if you want to make changes to the Thickness 

value of MyRule1, you can apply the changes without fear that they might be automatically over-

written because this occurs only when creating a new document using the template. (As a side 

note, if you did want to overwrite the local/document defi nition with the style library’s defi ni-

tion, right-clicking an existing rule will present a context menu from which you can select Update 

Style, which will manually refresh the rule’s defi nition in the document.)

It is a good practice when using the style library to have only a single generic sheet-metal 

rule embedded in your template fi le (at least one is required). Once you know what sheet-metal 

rule you want to apply to your model, selecting it either in the Style And Standard Editor dialog 

box or in the Sheet Metal Defaults dialog box will automatically draw the information into the 

active document. This process keeps extraneous information out of your document, providing a 

smaller footprint, and helps reduce the chance of style information mismatch. If you have a tem-

plate fi le that has numerous sheet-metal rules stored within it, after publishing them to the style 

library, you can use the purge functionality with the Style Management Wizard to remove them.

Working with the Flat Pattern

The fl at pattern derived from the folded model ties the design to the manufacturing environ-

ment. Within Inventor, the fl at pattern model is an actual fl attened version of the folded model 

versus a sheet that has been pieced together and thickened. Numerous tools, utilities, and data 
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sources have been provided to enable the fl at pattern to suit your individual manufacturing and 

documentation needs.

The fl at pattern contains a wealth of manufacturing information that is stored progressively 

during the design process. Punch and bend information is stored within the fl at pattern model 

specifi cally so that customers working with drawings, customers working with the application 

programming interface (API), or those who want to translate the fl at pattern to a different fi le 

version can control all their options in a common location; the fl at pattern is commonly referred 

to as the jumping-off point for all downstream consumers.

The following sections detail these capabilities and tools.

Exploring the Flat Pattern Edit Features
The fl at pattern environment has its own panel bar containing a customized set of modeling 

tools drawn from the Part Features panel bar and the Sheet Metal Features panel bar. The fl at 

pattern tools are referred to as fl at pattern edit features because they are intended to apply small 

alterations to the fl at pattern model instead of doing large-scale modeling. Flat pattern edit 

features are applied only to the fl at pattern, whereas folded model features are fi rst applied to 

the folded model and then carried over to the fl at pattern. The fl at pattern can be imagined as a 

derivative of the folded model, establishing a parent-child relationship (fl at pattern edit features 

are not refl ected in the folded model). There are many situations in which the generated fl at pat-

tern is not exactly what you need for manufacturing; fl at pattern edit features are ideal for mak-

ing small associative tweaks that previously required exporting the fl at pattern to an external 

(disassociated) fi le.

Adding Manufacturing Information to the Flat Pattern
There are two features specifi cally designed to allow you to add manufacturing information 

to the fl at pattern. The Bend Order Annotation tool enables you to specify the order in which 

bends are created. The Cosmetic Centerlines tool marks bend locations, such as cross brakes, 

where there is mild deformation.

Bend Order Annotation  When you click the Bend Order Annotation icon in the Manage 

panel, the bends are automatically numbered. You can renumber individual bends by 

double-clicking the number glyph or right-clicking and choosing one of two options for over-

riding the numbering: Directed Reorder and Sequential Reorder. Figure 6.31 shows the bend 

order being edited.

Figure 6.31

Editing the bend 

order annotation
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Directed Reorder  With this option you are prompted for the selection of a start glyph 

and an end glyph. An algorithm is used to renumber bend centerlines that lie between 

the selected start and end glyphs.

Sequential Reorder  With this option you select each bend centerline glyph in the 

reorder sequence.

You can follow these general steps to adjust bend order:

 1. Click the Go To Flat Pattern button found on the Sheet Metal tab.

 2. Click the Bend Order Annotation button found on the Sheet Metal tab.

 3. You can select a specifi c bend centerline glyph (or glyphs) and enter the new order 

number or right-click and choose one of the reorder methods.

 4. Right-click and choose Finish Bend Order.

Cross Breaks, Creases and Cosmetic Centerlines  When working with large parts made 

with thin sheet materials (such as in HVAC designs), you may have a need to show cross-

break information. Adding these features in the folded model is a challenge and is generally 

not required. Instead, you can add cross-break information to the fl at pattern in the form of 

cosmetic centerlines. Cosmetic centerlines capture bend information in the fl at pattern with-

out changing the model. Figure 6.32 shows the Cosmetic Centerlines tool in use.

Figure 6.32
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To create cross-break lines, follow these general steps:

 1. Click the Create Flat Pattern button (or the Go To Flat Pattern button if it’s already cre-

ated) found on the Sheet Metal tab.

 2. Create a new 2D sketch on the appropriate face of the fl at pattern (click the OK button if 

warned about the sketches on the fl at pattern not carrying over to the folded model).

 3. Use the Line tool to create the cross-break line(s) as needed.

 4. Click the Finish Sketch button on the Sketch tab.

 5. Click the Cosmetic Centerline button (found on the Create panel in the Flat Pattern tab) 

and select the previously sketched line(s).

 6. Adjust the manufacturing information using the controls in the Cosmetic Centerline 

dialog box, and then click the OK button.

A Cosmetic Centerline feature will be created in the browser, and it will consume the sketch 

you created. You can edit it as you would any other feature if needed.
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Using the Flat Pattern Defi nition Dialog Box
You can manipulate the fl at pattern model by using a tool called Edit Flat Pattern Defi nition, 

which is available by right-clicking anywhere in the graphics area and selecting Edit Flat Pattern 

Defi nition. The Flat Pattern Defi nition dialog box allows you to control a number of aspects pertain-

ing to the fl at pattern’s orientation and the information stored within it, as shown in Figure 6.33.

Figure 6.33
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The fi rst tab of the Flat Pattern Defi nition dialog box relates to the fl at pattern orientation. 

The selection control allows you to select either an edge or two points to defi ne the horizontal or 

vertical orientation. The orientation of the fl at pattern is important because the implied x-axis is 

used to calculate the rotational angle of Punch tools that have been applied to the model. When 

you orient the fl at pattern to your specifi c punch equipment, the required tool rotation angle 

should be directly available from your fl at pattern.

Since the fl at pattern base face is going to be either the face already selected or the backside, 

the control of the base face has been simplifi ed to a “fl ip” option. Base face defi nition is critical 

because it establishes a directional reference for bends and punch tooling as well as an associa-

tion with the front navigation tool view and the default Drawing Manager view.

The second tab is the Punch Representation tab, which allows you to override the representa-

tion setting in the sheet-metal document without having to edit the active sheet-metal rule.

The third tab is the Bend Angle tab, which allows you to declare how bend angles should 

be reported to the API and Drawing Manager. For example, this means that by changing the 

Bend Angle option to an open angle, Drawing Manager annotations of your fl attened bends will 

recover the complementary angle of the bending angle.

Controlling the Finished Face of the Flat Pattern

If you work with prefi nished surface materials, having the fi nish side up when laser cutting, punch-

ing, or breaking is often an important consideration. To control the upward-facing surface, or base 

face, when creating the fl at pattern, you can select any face of the folded part on the fi nished side 

and then click the Create Flat Pattern button. Inventor will hold the selected face as the base face.

If you need to change the base face, you can use the Flip button found in the Pattern Defi nition 

dialog box. Do this by clicking the Go To Flat Pattern button, right-clicking the Flat Pattern node 

in the browser, and selecting Edit Flat Pattern Defi nition.
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Manufacturing Your Flat Pattern
There is a very close association between sheet-metal design and manufacturing, and the fl at 

pattern solution within Inventor embraces this relationship. Inventor generically supports the 

ability to translate models to a variety of fi le formats, but Inventor sheet metal actually has its 

own utility to support the translation to SAT (.sat), DWG (.dwg), and DXF (.dxf) formats.

Saving Flat Patterns

After selecting the Flat Pattern browser node, you can right-click and select Save Copy As; this 

launches the Flat Pattern Translation dialog box. For SAT fi les, a simple option defi ning the fi le 

version will be presented. For DWG and DXF fi le formats, an extensive list of options and fi le-

processing capabilities is made available to you.

Within the Flat Pattern Translation dialog box, you will fi nd standard options for fi le type, 

but there is also a Layer tab that supports layer naming and visibility control. The last tab is 

the Geometry tab, which allows you to decide whether you want to apply a variety of manufac-

turing-specifi c options to the translation. The fi rst of these options is for spline simplifi cation 

because many Computer Numerical Control (CNC)–profi le manufacturing centers cannot 

leverage splines and are restricted to arcs and lines.

Translating Splines

The translation utility allows you to apply faceting rules to break the outer contour of fl at 

patterns into linear segments. The second options group relates to the post-processing of the 

translated fi le, allowing you to force the 2D result into positive coordinate space and to merge 

interior and exterior contours into polylines, which may be critical for a path-based tool. 

Figure 6.34 shows these settings.

Figure 6.34
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Sketching on Flat Patterns

Sometimes you’ll need additional tool path manufacturing information such as etch lines, in 

your DXF/DWG output. For this, the fl at pattern has the ability to export unconsumed sketches 

created on the fl at pattern. With these you can create a sketch containing the lines you need on 

the fl at pattern. Once you save the DXF or DWG fi le, any visible sketches located on the fl at pat-

tern are exported, and a layer called IV_UNCONSUMED_SKETCHES is added to contain these 

sketches. Note that sketch text will not export using this method. If you need to add single-line 

text paths to your fl at pattern for laser engraving, the best method is to do so in the DWG or 

DXF after it has been exported from Inventor.

Using Sheet-Metal iPart Factories
iParts are part confi gurations or part families that allow you to create a base part and then 

add a table to it. Once the table is added, the part features can be suppressed or confi gured to 

create a family of parts based on the original. The confi gured part is referred to as an iPart fac-

tory, and the individual confi gurations are called members. Sheet-metal iParts have a number 

of uses, from creating variations of basic parts to creating progressive die parts.

More iPart Information

You can fi nd more information, including step-by-step instructions for creating iParts and sheet-

metal iParts, in Chapter 7.

iParts for Confi gurations
Using iParts for sheet-metal confi gurations is common for parts that are basically the same 

but vary in the size, material, or inclusion of certain features. For example, a bracket could be 

designed and confi gured in basic mild steel, or optionally in an upgraded stainless steel version. 

Or you could create an iPart to handle variable hole locations on a standard-shaped bracket. 

Another common use would be a series of brackets that are identical in material and fold infor-

mation but vary in length. Sheet-metal confi gurations via iParts could be very benefi cial and 

profi table to a company that deals in varieties of components that need to fi t into the same space 

but utilize different materials or manufacturing processes or contain different features. Once 

different members of the iPart factory are confi gured, you can use the Generate Files option 

shown in Figure 6.35.

Figure 6.35
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This tool is intended to support the batch creation of member fi les on disk; it can also be used 

to force updates, such as the fl at pattern, out to the member fi les already in existence. In addi-

tion, you can use a pull method versus a push method. If you open the iPart factory, execute the 

Rebuild All operation, and then save the rebuilt and migrated data, the member fi les when indi-

vidually opened will “see” that they are out-of-date with the factory. Selecting the now-enabled 

Update button within the individual member fi le will then draw in the fl at pattern information 

automatically.

iParts for Fold Progression
If you have the need to show the order in which a part is created, such as detailing progressive 

dies, you might want to explore the use of iParts and the Unfold tool. Once a folded part is 

complete, you can convert it to an iPart and use the Unfold tool to detail each step of the pro-

gression. In the iPart, the unfold features can then be suppressed to show the part folding back 

up. Because each iPart member (in this case representing the same part in different stages) can 

be detailed on a drawing, you can quickly illustrate the progression of the blank, fl at piece to the 

fi nished part.

Modeling with Non-Sheet-Metal Features
Although the sheet-metal feature set is extensive, sometimes using non-sheet-metal features can 

be helpful or possibly even required to accomplish your design. The challenge when using non-

sheet-metal features is to honor the guiding principles of sheet-metal design so that the result-

ing component can be unfolded; in addition, you want to incorporate sheet-metal conditions so 

that the features are manufacturable and therefore cost-effective.

Selecting Problematic Features
Although it’s possible to design sheet-metal components using lofts, solid sweeps, and shells, 

these features can produce unpredictable and hard-to-control results. The Loft tool, unless 

highly restricted, produces doubly curved surfaces that cannot be unfolded properly. It’s pos-

sible to utilize rails to control loft curvature, but it’s time-consuming and invariably frustrating. 

Solid sweeps are a measure better than lofts, but these too can create unintended doubly curved 

surfaces. The Shell tool can be used nine times out of ten to successfully create a legitimate 

sheet-metal feature, but the tenth time, if it doesn’t work and it’s not clear why, will be con-

founding. If you use the parameter Thickness to shell your component, you’ll probably be in 

fairly good shape, but there are certain situations in which the Shell tool cannot assure uniform 

thickness after the shell. These situations are not always simple to predict.

Using Surface-Based Workfl ows
In addition to the sheet-metal-specifi c tools, you might sometimes need to use standard non-

sheet-metal tools to create complex parts or features. The most successful non-sheet-metal 

feature workfl ows typically use a surface that is later thickened. The reason these workfl ows 

are so successful is that it’s often easier to ensure that the resulting model embodies sheet-metal 

conditions (the side faces are perpendicular to the top and bottom faces and the part maintains 

a constant thickness) since the part can be thickened normal to the surface using the Thicken/

Offset tool. When you’re constructing surfaces that will be thickened, the Extrude and Revolve 

Certification
Objective



302 | CHAPTER 6 SHEET METAL

tools are excellent choices because they have restricted directions in which features are created, 

which can help ensure that only cones, cylinders, and planes are created (these can be unfolded).

The Sweep tool is possibly another good choice, but care needs to be taken to ensure that 

the profi le and the sweep path do not contain any splines or ellipses that might prevent unfold-

ing. For thickened, extruded, revolved, or swept features, the sketch profi le geometry should 

ideally be limited to arcs and lines to help ensure the creation of unfoldable geometry. When 

you’re using the Sweep tool, the Guide Surface option (see Chapter 5, “Advanced Modeling 

Techniques”) is ideal because the swept profi le is rotated along the path to ensure that it 

remains normal to the guide surface. Sometimes a thickened sheet-metal component needs to 

be trimmed with a complicated profi le. For these situations, a swept surface combined with the 

sculpt feature can result in a model that still has sheet-metal conditions.

Another common surface-generating workfl ow is to use a derived component, where you 

select the Body As Work Surface option when placing the derived component into the sheet-

metal fi le. This workfl ow can be combined well with either a thicken feature or a sheet-metal 

face feature after creating projected sketches for each planar surface. This was the method used 

earlier in this chapter when you used the Bend tool to create an enclosure from the derived 

frame.

One of the biggest benefi ts of working with surfaces is that you can apply complicated altera-

tions to the surface prior to thickening. Some of the most common features utilized to create 

cutting surfaces are Extrude, Revolve, and Sweep. Additionally, the Split tool (and perhaps 

Delete Face) can be utilized to remove faces from the thickened surface selection.

Working with Imported Parts
The Inventor sheet-metal environment has been designed to work with imported geometry 

because its solid unfold engine is concerned with topology, not with features. This means that 

fi les imported directly from other 3D modelers such as SolidWorks, CATIA, and Pro/ENGINEER, 

as well as neutral fi le types such as STEP, SAT, and IGES fi les (.step, .sat, and .iges), can 

be brought into Inventor. Once imported, they can be modifi ed with additional features and 

unfolded, provided they maintain a constant thickness that matches the thickness set in the part.

More on Importing Part Files

You can fi nd more information about importing part fi les and exchanging data with other CAD 

systems in Chapter 14, “Exchanging Data with Other Systems.”

Setting Yourself Up for Success
There are two main methods for importing parts into Inventor: the Open dialog box and the 

Import tool that’s on the Insert panel of the Manage tab. If you are able to use Open (which is 

preferred), a standard part template is going to be utilized by default to embed initial styles 

and document options, so the fi rst step will be to use the Convert To Sheet Metal tool to draw 

the sheet-metal subtype options and rules into the document. If you use the Import tool 

from within an empty sheet-metal document, the imported geometry will be in the form of 

a surface. To work with this geometry, you will need to thicken each surface, which can be a 
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time-consuming process. I recommend, when possible, that you “open” imported parts so that a 

solid body can be recovered.

The next step you need to accomplish is the measurement of the sheet thickness of your 

imported model; once you have this value, you can match it with an appropriate sheet-metal 

rule (or create a new one). Matching the thickness can be as simple as taking a measurement 

from the sheet and overriding the Thickness value within the Sheet Metal Defaults dialog box 

with a simple copy and paste. Since the solid unfolder works with evaluated topology to facili-

tate the unfolding, the thickness of the actual part must match the thickness of the active sheet-

metal rule exactly.

If the imported part contains portions that are not of uniform thickness, proper unfolding 

may not be possible; spend some time evaluating your imported model to ensure that it con-

forms to sheet-metal conditions. If your imported model contains faces defi ned by splines or 

ellipses, you are not going to be able to unfold your part. In these cases, removing these faces 

and replacing them with faces defi ned by tangent arcs may be an acceptable modifi cation.

Converting Components
On the Environments tab is the Convert To Sheet Metal tool. The purpose of this tool is to take 

a component that has been designed with a regular part template and convert that document 

to a sheet-metal subtyped document. This means all the sheet-metal reference parameters and 

the default sheet-metal rule and unfold rule are automatically added to the document.

You can also convert a sheet-metal part back to a part document. Basically, this deletes the 

fl at pattern and disables the sheet-metal functionality, but the sheet-metal parameters are not 

deleted.

Be Careful When Converting Back to a Standard Part

You should convert a sheet-metal part back to a standard part fi le only if the manufacturing process 

for a part has changed. Some people have gotten into the habit of using the convert tools to access 

the part-modeling tools. Using the convert tools to navigate back and forth can have undesirable 

eff ects. Most notably, it can delete your fl at pattern and break associations with downstream 

documentation; therefore, use the convert tools sparingly.

Annotating Your Sheet-Metal Design

The Drawing Manager environment contains several tools and functions specifi cally focused 

on helping you document your sheet-metal design. A quick overview of sheet-metal annotation 

tools might help you understand them a bit better.

Creating a View of Your Sheet-Metal Design
The fi rst step in creating your documentation will be to choose which model fi le to reference, 

but with sheet metal comes the added requirement of deciding between a folded model and 

a fl at pattern view, as shown in Figure 6.36. Once a sheet-metal model fi le is selected on the 

Component tab, a Sheet Metal View options group will appear immediately below the fi le’s path 
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information. The displayed options allow you to choose between creating a folded or fl at pattern 

view and, in the case of a fl at pattern, choose whether you want center marks to be recovered 

for any embedded Punch tools. The default view options will change based on your selection, 

because the fl at pattern has a clear distinction between its top (default) face and its bottom (back-

side) face. The actual orientation of the 3D fl at pattern defi nes what is a top face and what is a 

bottom face. This also impacts bend orientation with respect to what is reported as up and what 

is reported as down. All punch angular information is based on the virtual x-axis previewed 

during fl at pattern orientation.

Figure 6.36
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The Model State tab may also be of interest because sheet-metal iPart members can be indi-

vidually selected when a factory fi le is referenced, as shown in Figure 6.37. Choosing between 

a folded model and a fl at pattern is also necessary when creating a drawing view of the sheet-

metal iPart member. If the member has not already been placed, selecting the member from the 

Drawing View dialog box will automatically create the fi le.

Figure 6.37
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The last tab is the Display Options tab, which is important because it controls whether sheet-

metal bend extents should be drawn in the view, and it controls other annotations such as work 

features and tangent edges, as shown in Figure 6.38.

Figure 6.38
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Adding Bend, Punch, and Flat Pattern Annotations
Once you’ve created the view of your sheet-metal component, you can switch to the Drawing 

Annotate tab to complete the documentation of your design. The sheet-metal annotation tools 

within the Drawing Manager are specifi c to fl at pattern views. You can add bend notes and 

punch notes, as shown in Figure 6.39.

Figure 6.39
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Bend Annotation Tables

Bend notes allow you to recover bend angle, bend direction, bend radius, and K-factor (which 

is not on by default) for any bend centerline. You can utilize the General Table tool to create a 

Drawing Manager bend table (not to be confused with bend tables utilized for unfolding) that 

documents all the bends in a selected view. To create a Drawing Manager bend table, follow 

these steps:

 1. Select General from the Table panel of the Drawing Annotation tab.

 2. Select an existing fl at pattern view.

 3. Decide whether the chosen columns are acceptable (bend direction, angle, and so on); if 

not, alter the selected columns.
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 4. Choose the Bend ID format, and enter a prefi x if desired.

 5. Click the OK button to create the bend table.

Punch Annotation Tables

The punch note allows you to select a formed punch, center mark, or 2D alternate punch rep-

resentation in order to recover the punch angle, punch direction, punch ID, and punch depth 

(punch ID and depth need to be added to the Punch tool description when the punch feature is 

authored). When editing the punch note, you will also see a Quantity option that allows you to 

recover the number of instances of the same Punch tool in the view.

Punch table creation is a little different from bend table creation because it has been incor-

porated within the preexisting hole table annotation tools. The reason punch support was 

combined with hole tables is that you most likely used the Hole tool out of convenience, not 

necessarily to convey a manufacturing process. To make sure all of this tool-based information 

is consolidated, an enhancement to hole tables was made. After invoking the Hole Table – View 

tool and selecting a fl at pattern view, you will see that the standards in the toolbar have changed 

to refl ect predefi ned hole table standards. Within this list (as shown in Figure 6.40) is an example 

standard for punch tables, which prevents you from having to fi rst create a standard hole table 

and then edit it to add all the punch information columns.

Figure 6.40
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From within the Text tool, you can reference the sheet-metal fl at pattern extent values by 

selecting a new Sheet Metal Properties option from the Type list, as shown in Figure 6.41. Once 

you’ve selected the Sheet Metal Properties type, the Property list will provide options for enter-

ing the fl at pattern extents area, length, or width in the text box.

Figure 6.41
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Use Sheet-Metal Manufacturing Annotation Effectively

You may have noticed that diff erent toolmakers and machinists like to see diff erent annotations. 

Although there are some defi nite right and wrong ways to annotate a part, a lot of gray area exists 

concerning this as well, because there is no specifi c way to annotate the part “correctly.” It is in these 

areas where you must talk to your fabricators and outside vendors to determine what information 

they’d like to see on the prints and to explain what type of annotation you plan to provide. Don’t 

be afraid to ask the fabricators what information would make their job easier. As long as it does 

not impact your workfl ow dramatically, it might just save you some time and money on your parts.

The last annotation tool that can interact with sheet-metal properties is the Parts List tool. To 

recover fl at pattern length and width extents within the parts list, follow these steps:

 1. From within your sheet-metal model, right-click the fi lename node in the Model browser 

and choose iProperties.

 2. Select the Custom tab and create a new custom iProperty named Length.

 3. Ensure that the type is set to Text.

 4. Enter a value of = <FLAT PATTERN LENGTH> cm.

 5. Repeat steps 2 through 4 for a custom iProperty named Width, entering a value of 

= <FLAT PATTERN WIDTH> cm.

 6. Save the sheet-metal model fi le.

 7. From within the Drawing Manager, launch the Parts List tool.

 8. Using the Select View tool, select a fl at pattern view of the sheet-metal model containing 

the custom iProperties, click the OK button, and place the parts list on your drawing.

 9. Right-click your parts list, and select the Edit Parts List tool.

 10. Right-click the table, and select Column Chooser.

 11. Select the New Property tool, and enter Length.

 12. Repeat step 11, creating an additional property named Width.

 13. Click the OK button.

 14. Select the new column named Length, right-click, and select the Format Column tool.

 15. Change the formatting and precision of the length to match your needs.

 16. Repeat step 15 for the Width column, clicking the OK button when complete.

Saving Time with Custom iProperties

If custom property information is something you might routinely want to access, create the custom 

iProperty values in your sheet-metal template fi le so that they are always available.
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Th e Bottom Line

Take advantage of the specifi c sheet-metal features available in Inventor.  Knowing what 

features are available to help realize your design can make more effi cient and productive use 

of your time.

Master It  Of the sheet-metal features discussed, how many require a sketch to produce 

their result?

Understand sheet-metal templates and rules.  Templates can help get your design started 

on the right path, and sheet-metal rules and associated styles allow you to drive powerful 

and intelligent manufacturing variations into your design; combining the two can be produc-

tive as long as you understand some basic principles.

Master It  Name two methods that can be used to publish a sheet-metal rule from a 

sheet-metal part fi le to the style library.

Author and insert punch tooling.  Creating and managing Punch tools can streamline your 

design process and standardize tooling in your manufacturing environment.

Master It  Name two methods that can be utilized to produce irregular (nonsymmetric) 

patterns of punch features.

Utilize the fl at pattern information and options.  The sheet-metal folded model captures 

your manufacturing intent during the design process; understanding how to leverage this 

information and customize it for your needs can make you extremely productive.

Master It  How can you change the reported angle of all your Punch features by 

90 degrees?

Understand the nuances of sheet-metal iPart factories.  Sheet-metal iPart factories enable 

you to create true manufacturing confi gurations with the inclusion of folded and fl at pattern 

models in each member fi le.

Master It  If you created sheet-metal iPart factories prior to Inventor 2009, any instanti-

ated fi les contain only a folded model. Name two methods that you could use to drive the 

fl at pattern model into the instantiated fi le.

Model sheet-metal components with non-sheet-metal features.  Inventor doesn’t always 

allow you to restrict yourself to sheet metal–specifi c design tools; understanding how to uti-

lize non-sheet-metal features will ensure that your creativity is limitless.

Master It  Name two non-sheet-metal features that can lead to unfolding problems if 

used to create your design.

Work with imported sheet-metal parts.  Understanding the way in which Inventor accom-

plishes unfolding as well as how to associate an appropriate sheet-metal rule are keys to suc-

cessfully working with imported parts.

Master It  Name the one measured value that is critical if you want to unfold an im-

ported part.

Understand the tools available to annotate your sheet-metal design.  Designing your 

component is essential, but it’s equally important to understand the tools that are available to 

effi ciently document your design and extract your embedded manufacturing intent.

Master It  What process is required to recover fl at pattern width and height extents 

within your Drawing Manager parts list? 



Chapter 7

Reusing Parts and Features

The ability to reuse parts and features in other designs is an important step in increasing pro-

ductivity. Autodesk® Inventor® software provides this ability through different workfl ows. This 

chapter introduces you to several methods that will assist you in achieving your goal.

Developing the proper workfl ow for your company will depend on several criteria. 

Depending on your involvement with the functional-design aspect of Inventor, you may be 

converting some iParts to Content Center components. Additionally, you may decide to utilize 

iParts and iFeatures for design development if your design needs require them.

In this chapter, you’ll learn to:

 ◆ Create and modify iParts

 ◆ Create and use iFeatures and punches

 ◆ Copy and clone features

 ◆ Link parameters between two fi les

 ◆ Confi gure, create, and access Content Center parts

Working with iParts

iParts differ from standard parts in that they are essentially table-driven part factories, allow-

ing for many different variations to be generated from the same basic design. When an iPart is 

inserted into an assembly, a dialog box appears that allows you to specify a variation of the orig-

inal part from the table. Figure 7.1 shows an example of three variations of the same base iPart.

Figure 7.1
Th

the same part
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Within the iPart factory, you can confi gure feature sizes by specifying different values for 

the same parametric dimension, you can choose to include or suppress entire features, and you 

can confi gure the iProperties of a part. In addition to these general confi guration controls, you 

can confi gure thread features and work features such as work planes, axes, and points. There 

are two basic forms of iParts: table-driven and custom. Both types can be combined to create a 

table-driven part that allows custom input.

Each original iPart, often called a factory part, generates individually derived, noneditable 

member parts. Member parts placed within an assembly can be replaced with a different member 

of the factory. When a member part is replaced, generally all existing Assembly constraints will 

be retained.

iParts bring several advantages within assemblies. They essentially function as completely 

different parts, allowing dimensional changes, feature suppression, and transfer of iProperties 

and other values.

Creating and Modifying iParts
iParts are created from an existing part. Existing parts already contain features and parameters. 

Although you can modify a standard part by changing the parameter values, this will affect the 

part wherever it is used. To create confi gurations of a standard part, you must fi rst convert the 

part into an iPart.

You can publish iParts to a custom content folder for use as Content Center components or 

as additional content for functional design, such as Frame Generator and Bolted Connections. 

Published iParts can also be used in other aspects of functional design such as Frame 

Generator.

Modifying the Parameter List

Before converting a standard part into an iPart, you should modify the parameter list and 

rename the parameters to something more meaningful than the default names, such as renam-

ing d1 to Length. To explore these tools, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Browse for the fi le mi_7a_001.ipt located in the Chapter 07 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

Where to Get the Files

If you have not already downloaded the Chapter 7 files from www.sybex.com/go/

MasteringInventor2014, please refer to the “What You Will Need” section of the Introduction 

for the download and setup instructions.

 3. Click the Parameters button on the Manage tab.

 4. The Parameters dialog box opens, and you’ll note that many of the parameters have been 

named already. Change the names of the unnamed parameters d0, d1, and d2 to Length, 

http://www.sybex.com/go
http://www.sybex.com/go/MasteringInventor2014
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Width, and Height, as shown in Figure 7.2, and then click Done to exit the Parameters 

dialog box.

Figure 7.2
Th e Parameters 

dialog box

Tips for Working with Parameters

Recall that you cannot use spaces in parameter names; however, you can use an underscore or 

capital letters to help separate words in the parameter names, such as Base_length or BaseLength.

Be aware that modifying the parameter name after creating an iPart table will not automatically 

update the parameter name in the table; therefore, parameters should always be named before 

being included in the iPart table to maintain consistency.

Parameter names will be used as column header names in the iPart table. Parameters that have 

been renamed will automatically be pulled into the iPart table. You can manually add unnamed 

parameters to the iPart table; however, it is a best practice to give all parameters to be used in the 

iPart meaningful names.

Selecting the Export Parameter column permits creation of custom iProperties within the part 

fi le. By exporting parameters as iProperties, you can easily access them in parts lists and bills of 

materials (BOMs).

Creating the iPart

Continuing from the previous steps where you modifi ed the parameter list, you’ll next create 

the iPart table, confi gure it to include columns of features you want to modify, and add rows for 

each new confi guration of the part you want to create:

 1. On the Author panel of the Manage tab, click the Create iPart button. All the named 

parameters will automatically show up in the iPart table.

 2. To remove columns that you do not want to include in the table, click the parameter in 

the right pane and use the << button. You can also select column headers in the table 

and then right-click and choose Delete Column. Remove all the columns except Length, 

Width, and Height.

 3. Add a row to the table so that you can create a variation of this part. Right-click anywhere 

in row 1, and choose Insert Row.

 4. Set Height to 40 mm, and leave the other values as they are.
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 5. Create additional rows until you have eight rows with the Length, Width, and Height 

values as shown here:

Le ngth Width Height

100 mm 50 mm 20 mm

100 mm 50 mm 40 mm

100 mm 75 mm 20 mm

100 mm 75 mm 40 mm

200 mm 50 mm 20 mm

200 mm 50 mm 40 mm

200 mm 75 mm 20 mm

200 mm 75 mm 40 mm

 6. Once your table is complete, click the OK button.

 7. Find the Table node in the browser, and click the + sign to expand the node. You will see 

each member (variation) of the iPart table listed, as shown in Figure 7.3.

Figure 7.3
iPart browser list

You can switch between members of the iPart by double-clicking a member in the list or by 

right-clicking it and choosing Activate. Making changes to the features or sketches will change 

the active member but will not automatically update the table. If you make a change and then 

go to set another member as active, you will be prompted to save the changes to the table or dis-

card them. This is because the default edit mode is set to edit the entire iPart factory rather than 

the members individually. Changes made in the table will be carried through to the members 

either way. You’ll learn more about adjusting the edit scope in the sections “Working with Sheet-

Metal iParts” and “Changing Color in iParts” later in this chapter.

You can close this fi le without saving changes and continue on to the next section to explore 

the tools used to edit iParts.

Editing the iPart Table

To edit an iPart, you can double-click the Table node in the Model browser, or you can right-click 

and choose Edit Table. You can also right-click and choose Edit Via Spreadsheet to edit the table 

with Microsoft Excel. Although some iPart table-editing tasks can be done in both Inventor and 
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Excel, others should be done only in Inventor. Follow these steps to explore the process of edit-

ing an iPart table:

 1. On the Get Started tab, click the Open button.

 2. Open the fi le mi_7a_003.ipt from the Chapter 07 directory of your Mastering 

Inventor 2014 folder.

 3. Right-click the table in the browser, and choose Edit Table.

 4. In the iPart Author dialog box, right-click the Length column header, and choose Key. 

Then click the arrow and select 1 to designate that this is the fi rst parameter by which 

this part should be specifi ed.

 5. Set the width to be key 2 and the height to be key 3; then click the OK button to close the 

iPart Author dialog box.

 6. Right-click the table in the browser, and choose List By Keys. This sets the members to be 

listed by parameter keys in descending order, creating a drill-down tree so you can select 

the length, then the width, and then the height, as shown in Figure 7.4. Note that the 

active member is designated by a check mark next to the appropriate key.

Figure 7.4
iPart browser listed 

by keys

Key Selection Is Important When Creating iParts

You should take time to consider how your users will utilize the parts. For example, consider a 

socket head cap screw iPart. In the iPart, you might have diameter (¼ ,̋ 5/16 ,̋ 3/16˝), pitch (UNC or 

UNF), length (2 ,̋ 3 ,̋ 4 ,̋ 5˝), and material (stainless steel, alloy steel). Each of these columns could be 

key 1, but you should consider what makes it easiest to navigate to the correct part. In many cases, 

you might want to make the material the primary key, with the diameter, pitch, and length as the 

second, third, and fourth keys. Th is means that the user will fi rst select the material and only then 

be presented with the remaining diameters, pitches, and lengths for that given material. It would 

be a poor choice (in most cases) to have the pitch as the primary key because this is usually not the 

fi rst descriptive factor when choosing a fastener.

 7. Right-click the table in the browser, and choose Edit Table again.
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 8. Click the Properties tab to see the list of iProperties that are available for this part.

 9. Locate the Project category in the left pane, and expand it to reveal the Description 

property.

 10. Select Description, and use the >> button to include it in the iPart table.

 11. Confi rm that the Description column shows as a column in the table, and then click 

the OK button.

 12. Right-click the table in the browser, and choose Edit Table Via Spreadsheet to open 

the table in Excel.

 13. Select cells F2 through F9, and then right-click and choose Format Cells.

 14. Set the cells to General, and click the OK button. This is necessary to allow Excel to 

evaluate the expression you will build in the next step.

 15. In cell F2, enter = C2 & “X” & D2 & “X” & E2.

 16. Right-click cell F2, and choose Copy.

 17. Then select cells F3 through F9, right-click, and select Paste. Figure 7.5 shows the Excel 

table complete.

Figure 7.5
Excel table used to 

add descriptions

 18. Save the spreadsheet and close Excel.

 19. Because your table now contains data that is not in the part fi le, you will be prompted to 

update the fi le. Click Yes in the message dialog box.

 20. Right-click the table in the browser, and choose Edit Table.

 21. In the iPart Author dialog box, notice that the cells in the Description column are 

highlighted to inform you that there is a formula in those cells.

 22. Click the OK button (or Cancel if no changes were made) to exit the iPart Author 

dialog box.

You can examine the iProperties of the part fi le by clicking the part name in the Model 

browser and choosing iProperties from the context menu. If you check the Description fi eld on 

the Project tab, you’ll see the value from the iPart table/Excel spreadsheet. When you switch 

members of the iPart, the description is now automatically updated. You can then close the fi le 

without saving changes and continue to the next section.
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Converting an iPart to a Standard Part

You can convert an iPart to a standard part fi le by right-clicking the table in the Model browser and 

choosing Delete. Th e part will assume the active members’ feature values and states.

Including and Excluding Features

A common use of iParts is to create a confi guration of a part family that might include features 

in some cases and not include them in others. You can add a column to the table to control 

feature suppression. To do this, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Open the fi le named mi_7a_005.ipt located in the Chapter 07 directory of your 

Mastering Inventor 2014 folder.

 3. Right-click the table in the browser, and choose Edit Table.

 4. In the iPart Author dialog box, click the Suppression tab.

 5. Select the feature called Round_Boss1, and click the >> button to add it as a column in the 

table.

 6. Enter Suppress for the all the 100 mm length rows.

Suppressing vs. Computing

You can enter Suppress or Compute, S or C, and 0 or 1 for the suppress/compute cells. You can mix 

these options as well, meaning you can change only some values from Compute to S, for instance.

 7. Click the Verify button to ensure that you haven’t entered a value that will not work, such 

as a spelling error. Errant cells will highlight in yellow, and you should fi x them.

 8. Click the OK button to return to the model.

 9. Use the browser tree to activate different members, and notice that the boss features 

will be suppressed for all of the 100 mm members. Figure 7.6 shows the iPart Author 

dialog box.

You’ll notice that by suppressing the boss feature, we have suppressed both instances of the 

boss. This is because the boss was mirrored. To suppress just one boss, you could suppress the 

mirror feature; however, doing so would suppress one of the revolved features as well because 

it was included in the mirror. Keep this in mind when creating left and right confi gurations of 

the same part. Often, you will need to create separate features so that they can be controlled 

independently.
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Figure 7.6
Suppressing 

features

Creating Stacked, Toggled Features

Often when creating part confi gurations, you might need to create two features at the same loca-

tion so you can toggle between the two features depending on the confi guration. For instance, you 

might have an existing rectangular cut but then want to add an oblong cut in the same location 

so you can set the iPart to toggle between the two. When you attempt to place the oblong cut, 

Inventor warns that the feature did not change the number of unique faces and then results in 

an error. To correct this problem, simply accept the error, and then right-click the oblong cut and 

choose Suppress Features. Th en you can set up the iPart table to toggle between the two features.

Including or Excluding Work Features in iParts

You can use the Work Features tab to indicate whether each work feature is included or 

excluded individually. A common use for this would be to create several work features in an 

iPart and then include only the one that is to be used for mating the specifi c iPart member in the 

assembly environment to control a specifi c offset value.

Working with Threaded iPart Features

You can change the thread parameters of a tapped hole or external thread feature for each 

member of the iPart table independently. Just use the Thread tab to include any thread param-

eters, which will vary. You should include all parameters that will vary between any of the 

table members; otherwise, the hole/thread feature may generate errors when you’re switching 

between members. Often these errors may not become apparent until you attempt to publish 

your iPart to Content Center.

An example of this would be if you neglected to add the Class parameter to the table, even 

though not all of the members in the table have the same thread class. The thread class would 

then be set to the original thread class and would not be changed when the iPart is switched to 

a thread that does not include the original thread class. The same would be true, of course, if the 

Class column were included but not changed.
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Working with Sheet-Metal iParts

You can confi gure a family of sheet metal parts in the same way you would with a standard 

iPart by adjusting lengths, widths, and so on, but sheet metal parts have some additional con-

trols that can be confi gured in an iPart. For instance, you can specify the sheet-metal rule, the 

sheet-metal unfold, and a named fl at pattern orientation for individual members in an iPart. To 

edit the bend order, you must edit the member scope as opposed to making the edits per the 

iPart factory. Once the iPart is set to Member Scope, bend-order changes in the fl at pattern are 

set to the active member. You can follow these general steps to set the scope of the edits:

 1. On the Manage tab, locate the Author panel.

 2. Click the Edit Factory/Member Scope drop-down, and set it to Edit Member Scope. 

Figure 7.7 shows the drop-down.

Figure 7.7
Setting the iPart 

edits to Member 

Scope

Member Scope vs. Factory Scope

When you set the edit scope to Edit Member Scope, changes to the model such as suppressing a 

feature are automatically added to the iPart table.

Once the scope is set to edit just members, you follow these steps to adjust the bend order per 

iPart member:

 1. Activate the iPart member using the iPart table in the browser.

 2. Click the Go To Flat Pattern button found on the Sheet Metal tab.

 3. Click the Bend Order Annotation button found on the Sheet Metal tab.

 4. You can select a specifi c bend centerline glyph (or glyphs) and enter the new order 

number, or you can right-click and choose one of these reorder methods:

Directed Reorder  You are prompted for the selection of a start glyph and an end glyph. 

An algorithm is used to renumber bend centerlines that lie between the selected start and 

end glyphs.

Sequential Reorder  You select each bend centerline glyph in the reorder sequence.

 5. Right-click and choose Finish Bend Order.

When you edit the iPart table you will see that the FlatPatternBendOrder column is auto-

matically added (because you are working under the member scope edit mode). The cell for the 

edited iPart member will show that it is using something other than the Default bend order.
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Changing Color in iParts

To set iPart members to be different colors, you can create a custom iPart parameter on the 

Other tab and set it to the AppearanceColumn option. Then you can edit each member row of 

the iPart to be a different color/appearance. It is important that the name matches exactly, how-

ever, so be careful to match case. This means that entering red for Red will cause a mismatch. 

To avoid this, it is recommended that you use the member scope edit mode, as described in the 

previous section, to make color style edits to the part. This way, you can just set the member as 

active, change its appearance, and have the appearance change recorded in the iPart table 

automatically. To set up an Appearance column, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Open the fi le mi_7a_012.ipt from the Chapter 07 directory of your Mastering 

Inventor 2014 folder.

 3. Right-click the table in the browser, and choose Edit Table.

 4. In the iPart Author dialog box, click the Other tab.

 5. On the Other tab, click the Click Here To Add Value line.

 6. Type Color for the value name.

 7. Right-click the column header, and choose Appearance Column, as shown in Figure 7.8.

Figure 7.8
Creating an 

Appearance column

 8. Type Default into the Appearance column for each of the three rows. Then Click the OK 

button to exit the iPart Author dialog box.

Setting Colors

Note that if you do not enter Default or a valid Appearance style, you will receive a warning that 

states, “Errors occurred while setting factory to specifi ed member.” You can click Accept and then 

edit the table again.

 9. Ensure that Edit Member Scope is set (on the Manage tab, locate the Author panel and 

then set the drop-down to Edit Member Scope).
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 10. From the Quick Access bar (located at the top of the screen), select the Appearance Style 

drop-down and choose Cyan.

 11. Expand the iPart table, use the keys to set the 25 mm × 50 mm member active, and then 

set its color to Red.

 12. Change the edit scope to Edit Factory Scope using the iParts/iAssembly toolbar.

 13. Use the keys to set the 50 mm × 50 mm member active, and then set its color to Gold.

 14. Right-click the table in the browser, and choose Edit Table. You will receive a message 

asking whether you would like to set the table to match the document (that is, the part).

This demonstrates that when you are making edits to the model with the edit scope set 

to Factory, the changes to members do not get written back to the table automatically. 

Using the Edit Member Scope option is therefore recommended. You also get this mes-

sage if you change the active member, because the table is verifi ed every time you switch 

members.

 15. Click Yes, and then take a look at the Appearance column to ensure that the colors match 

what you have set them to.

As mentioned earlier, you could also just edit the table and type in the color name. 

Experiment with this as you like, and then you can close the fi le without saving changes and 

continue to the next section.

Exploring the Authoring Options

The Options button, located in the lower-left corner of the authoring dialog box, allows you to 

create and edit part numbers and member names for iParts. You will typically want to set these 

naming options before you begin adding rows to the iPart table so that as rows are added, they 

are automatically named according to these options.

Notice the disk symbol located in the Member column header in Figure 7.9. This indicates 

that the Member column will be used as the fi lename for each iPart member. If you prefer to 

have the Part Number column used for the fi lenames, you can right-click that column header 

and select File Name Column.

Figure 7.9
Member column 

used for fi lename

A Member Name value is automatically created for each member as rows are added based on 

the settings for the part number and member name options. You can override these by editing 
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the table in Excel, and you can even use a formula to create the names based on a concatenation 

of other column values in the table.

Generating Member Files

Once your iPart table is complete, you may want to generate the parts from the table. You can do 

this so the parts are established ahead of time, or you can allow the fi les to be generated auto-

matically as they are used. If you have an iPart table with two dozen rows, it might make sense 

to generate them ahead of time. However, if you have an iPart table of 200 member rows, then 

it might make sense to allow parts to be generated only when, for example, a particular size is 

used. To generate member part fi les, right-click the table and choose Generate Members. Each 

member in the row will be created as a derived part based on the table values.

iPart Member File Save Locations

Because these parts are often used over and over in many assemblies, I recommend that you 

store them in a library folder. Recall that folders designated as libraries in your project fi le are 

handled as read-only by Inventor. The library directory where you want to save the iPart mem-

bers is set up by you, and it is required that you use the same name as the factory library but 

preceded with an underscore. As an example, if you place the iPart factory fi le in a library folder 

named Fasteners, Inventor will automatically place all iPart members generated from that fac-

tory part in a second library folder named _Fasteners.

However, you are not required to store iParts in libraries. If you do not use libraries and you 

place an iPart member into an assembly or use the Generate Members option, Inventor will 

create a folder of the same name, and at the same level as the iPart factory, and store the iPart 

members there. For example, if you have an iPart factory fi le named ClipBracket.ipt saved at 

C:\Mastering Inventor\, then when ClipBracket.ipt is used in an assembly, a subdirectory 

called ClipBracket is created (C:\Mastering Inventor\ClipBracket) and the iPart member 

fi le is created there. Custom iPart members are always stored in a location specifi ed by the user.

Creating Custom iParts

A custom iPart is an iPart factory that has one or more columns designated as a custom param-

eter column. A custom parameter column allows input of any value and, in turn, generates a 

custom iPart with infi nite variations. Custom iParts are valuable for creating tube and pipe 

lengths, structural steel members, and other parts that require unique size input at the time of 

insertion. To designate a column as a custom parameter column, simply right-click the column 

and select Custom Parameter Column. Columns that are set as keys are not permitted to be cus-

tom columns.

Rather than setting an entire column to be custom, you may want to set only the column 

entry for a single member to be custom. To do this, you can right-click any cell in a non-key 

column and choose Custom Parameter Cell. Once cells or columns are designated as custom, 

you can right-click and set both columns and cells to restrict input to a specifi ed range and 

increment.

Here is a common example of setting a range for a custom part:

 1. Right-click the column to set the Length column to be custom (it cannot be a key column).

 2. Right-click the column to set the range so the part can be placed only in lengths from 25 

mm to 150 mm.
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 3. Right-click the column to set the increment to 5 mm so the lengths are limited to 

standard sizes within that range.

 4. When the custom iPart is placed into an assembly, the size is then specifi ed.

 5. Unlike standard iParts, custom iParts are saved to a location of your choice at the time 

of placement.

Figure 7.10 shows the options for creating a custom column.

Figure 7.10
Custom column 

settings

Testing the iPart

Before placing a completed iPart into production for others to use, test the accuracy and inter-

face of your part by inserting the iPart using Place Component within a blank assembly fi le. 

Using Place Component, insert every member in the table and inspect and/or measure the 

placed component.

Moving the test forward, create an IDW fi le with a base view of your assembly. You will also 

need to generate a parts list with the desired columns and verify the accuracy of each cell. Once 

you are assured of having accurate member components, you can place this iPart into a project 

library folder or other location to be used in production. If using this iPart in conjunction with 

the functional-design features of Inventor, you will need to publish the factory iPart to a custom 

Content Center library. Publishing to Content Center is covered in more depth later in this chapter.

No Zero-Value Dimensions

You should not attempt to create a zero-value dimension as a method of suppressing features. Zero-

value dimensions can create unpredictable results when the zero value is set back to some value 

greater than zero. Often the dimension will solve in the wrong direction, causing feature profi les 

to become invalid and create errors within your iPart. It is better to create a column to suppress 

individual features, rather than attempt to do so through dimensions.

Editing the iPart Factory

Editing an original iPart factory follows the same workfl ow as creating an iPart. If you’ve placed 

the original iPart factory into a project library folder, you will not be able to edit it within that 
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same project. Instead, you should create a new project fi le for the purpose of editing library 

parts. When creating a new project fi le, you can either defi ne the workspace for the project fi le 

by placing the project fi le in the library subfolder or just duplicate your original project fi le and 

remove the library path(s) using the Project Editor dialog box. Any fi les within the library path 

will now be editable with this specifi c project fi le.

With the new Library Edit project fi le active, open the iPart you want to edit. Locate the table 

in the Model browser, and either double-click or right-click to activate the iPart Author dialog 

box. At this point, you can edit any part of the table. When you have completed your editing, 

you can save the part to its original location.

Can’t Generate iPart Members?

When changes are made to an iPart factory and they impact existing iPart members, you should 

be able to use the Generate Files option to replace the iPart members (provided the folder or fi les 

are not set as read-only by Windows). However, sometimes you’ll fi nd that Inventor won’t generate 

new versions of existing iPart members once edits are made, even when you right-click them in the 

table and choose Generate Files and have checked the read-only status. Although the reason for this 

behavior is often unclear, you can generally get around it by browsing to the location of the iPart 

members and deleting them. Th en you can return to the iPart Factory and choose Generate Files.

You can convert an iPart factory component into a standard parametric part by deleting the 

table attached to the iPart. Simply right-click the table in the Model browser and select Delete. 

The part will revert to a parametric part with no history of the iPart functionality.

Using iParts in Designs
Using an iPart in an assembly design is a bit different from creating parts within an assem-

bly. To place an iPart member of a particular size into an assembly, you will use the Place 

Component tool to browse and place the iPart factory. Upon placing the iPart factory into the 

assembly, you’ll be presented with the Place iPart dialog box, from which you can specify the 

member or choose from the keys you set previously. Keep in mind that if you didn’t set any 

keys in the iPart table, all of the columns will be listed in the Keys tab of the Place Standard 

iPart dialog box. Figure 7.11 shows the placement of an iPart that has three keys set.

Figure 7.11
Placing an iPart 

into an assembly
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In Figure 7.11 Length is Key 1, Width is Key 2, and Height is Key 3. Keep in mind that for 

the best results keys should be set from top to bottom in the Place iPart dialog box, because the 

values are fi ltered in that order. However, Inventor does not prevent you from setting Key 3 fi rst 

and then Key 1. But working out of order with keys can create some confusion and unexpected 

results in the values you see listed in the drop-downs.

Once an iPart is placed, you might fi nd that you need to change to another size, color, or con-

fi guration. To change between iPart members, follow these steps:

 1. Locate and expand the iPart in the assembly browser tree.

 2. Right-click the table.

 3. Choose Change Component.

This opens the iPart placement dialog box, which allows you to specify a new member to be 

used in place of the existing one. Figure 7.12 shows the specifi c selection path for changing the 

component. This replacement procedure will replace only the selected component instance.

Figure 7.12
Changing the 

component

If you want to replace all exact duplicate members of the iPart within this assembly, follow 

these steps:

 1. Right-click the part within the graphics window or the Model browser.

 2. Select Component.

 3. Choose Replace All. A dialog box appears, allowing you to select the original iPart 

factory.

 4. Once the original iPart factory is selected, you will be prompted with the iPart placement 

dialog box to allow you to select the specifi c member to be used as the replacement.

When a component is replaced with a different member of the same family, as with iParts, 

normally all Assembly constraints will be retained. If the replaced component is of a different 

family, the Assembly constraints might be broken. The same is true of parts in the same family 

if the original part used a certain feature to constrain to and the replacement part has that 

feature suppressed.
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iPart Factories in Assemblies

You should be aware that Inventor does not allow an iPart factory fi le to be placed into an assembly. 

If you attempt to do so, only a member of the factory will be placed instead. However, keep in mind 

that if you create a regular part fi le, place it into an assembly, and then turn it into an iPart factory, 

changing the factory table does not place a member fi le but simply updates the factory. Using 

factory fi les in assemblies in this manner is not the intended workfl ow for iParts.

Working with iFeatures

iFeatures are features that have been extracted from an existing part fi le and confi gured for 

reuse in other parts. If you are familiar with Autodesk® AutoCAD® software, you might relate 

iFeatures to blocks, in that you can write out blocks for reuse in other drawings. Any feature 

based on a sketch can be used as an iFeature, but there are some best practices to follow when 

creating sketches and features to be extracted for iFeatures. Once extracted, the iFeature is 

stored in an external location and can be placed into any other part fi le. Inventor is supplied 

with a number of standard iFeature fi les as well. iFeatures cannot currently be published to 

Content Center.

Using iFeatures in your designs can greatly simplify your workfl ow and accelerate produc-

tivity, especially if your designs contain repetitive features. Figure 7.13 shows an example of a 

sheet-metal part that could be created very quickly using iFeatures.

Figure 7.13
Sheet-metal part 

with iFeatures

iFeatures used in sheet-metal parts are authored with center points that allow them to be 

placed as sheet-metal punches. iFeatures are stored in a Catalog folder defi ned in the Inventor 

application options. By default, the catalog is located in the Inventor install directory, but you 

can customize the location by selecting the Tools tab, clicking Application Options, and then 

choosing the iFeatures tab. On the iFeatures tab, you can set the catalog path to a directory of 

your choosing, most often located on a network server. You can create additional subfolders 

in the Catalog folder as required to better organize your iFeatures. Extracted iFeatures are 

saved with .ide fi lename extensions. iFeatures are also available online from such locations as 

http://cbliss.com. Often these online fi les contain the extracted iFeature and the original fi le 

it was created from. These can serve as good examples of how to set up complex geometry for 

iFeature extraction.
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The following are some tips for working with iFeatures:

 ◆ Keep your iFeatures clean, and do not include projected geometry or reference geometry 

unless required.

 ◆ If dependent geometry is required, have it dependent only on geometry within the 

iFeature.

 ◆ You should avoid the use of origin work planes, axes, and the origin center point for work 

features.

 ◆ Use parallel and perpendicular constraints to other geometry in the iFeature rather than 

horizontal and vertical constraints.

 ◆ Know that updating table-driven iFeatures does not update existing instances of the 

iFeature.

 ◆ Save iFeatures before placing them in other parts.

Creating iFeatures
Once you have a part that consists of a feature or features that you want to reuse in the design 

of other parts, you can easily extract those features and place them into the catalog. The chief 

advantage of using iFeatures is that the original part does not need to be open in order to copy 

the feature. In addition, you can alter any of the parameters at will when inserting the feature 

into a new part.

To extract a part feature or features, go to the Manage tab and click the Extract iFeature but-

ton found on the Author panel. Select the feature to be extracted, from either the Model browser 

or the graphics window. If additional features exist that are dependent on the selected feature, 

they will be included in the feature selection as well but can then be removed during the iFea-

ture creation process if not needed.

Recall that a feature is dependent on another feature if it uses the other feature as a reference 

in the sketch or feature creation. For instance, if you created a sketch on the face of an Extrude 

feature, that sketch (and any feature created from that sketch) is inherently dependent on the 

base Extrude feature because it uses the face as a reference plane. Therefore, if you extracted 

the base Extrude feature, the dependent feature is automatically included, but it can be removed 

if not needed. Figure 7.14 illustrates how to remove a dependent feature (Fillet1) while creating 

an iFeature.

Figure 7.14
Removing a 

dependent feature
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A standard iFeature will typically require a profi le plane in order to position the geometry 

onto a new part. Named parameters and values involved in the selected feature are transferred 

from the existing part into the new iFeature. In Figure 7.15, notice that prompts will be added for 

each of the named parameters. You can edit the prompts as needed. You’ll also notice that range 

and list limits have been set for some of the parameters. This allows you to control the input for 

iFeatures by limiting them to a predefi ned list of sizes or a specifi ed range between sizes. When 

inserting this iFeature into a different part in the future, you will be prompted to enter new val-

ues for these parameters.

Figure 7.15
Parameters and 

prompts

Placing an iFeature

To place an iFeature in a standard part (not a sheet-metal part), browse to the stored iFeature 

and select the face you want to use for placement. During the placement, you can adjust the 

rotation angle and size parameters. To see a simple example of how iFeatures are extracted and 

placed, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Open the fi le mi_7a_017.ipt from the Chapter 07 directory of the Mastering Inventor 

2014 folder.

 3. On the Manage tab, click the Extract iFeature button.

 4. In the Model browser, click Extrusion2 as the selected feature. The dialog box will be 

populated with the parameter information found in that feature.

 5. Click the parameter named E2_Ext_Ang, and use the << button to remove it from the 

parameter list. This parameter is the taper angle of the extrusion, and by removing it 

from the list you are ensuring that users of iFeatures in the future cannot specify a taper.

Adjusting Extracted Features

In this case, the parameters have been renamed previously using the Parameters dialog box. 

However, you can adjust parameter names and the corresponding prompts at this point if needed.

You can also adjust the default values for the parameters without adjusting the current model, as 

well as add lists and ranges to each parameter using the Limits column.
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 6. For this example, accept the default for the rest of the parameters, and click Save.

 7. Notice that Inventor takes you straight to the Catalog folder. This location is specifi ed 

in the Application Options dialog box on the iFeature tab and can be changed if needed. 

Use the list of Frequently Used Subfolders on the left of the Save As dialog box to go to 

the Chapter 07 folder, and name this iFeature SquareSocket.ide. Click the Save button 

to save the fi le.

 8. Next, you’ll place the iFeature back into the model as a test. On the Manage tab, select the 

Insert iFeature tool.

 9. Click the Browse button to go to the Chapter 07 folder.

 10. Locate and select the SquareSocket feature you just created (or use the fi le called 

mi_7a_025.ide), and click the Open button.

 11. Select the top face of Extrusion1 to use as the profi le plane.

 12. Once the plane is selected, set the angle to 45 degrees, use the fl ip arrow to ensure that 

the feature is placed in the correct direction, and then click Next.

 13. Enter 20 mm for the E2_Circ_Dia parameter and then click the edit icon (it looks like a 

pencil), or click in the space below the Diameter row or on another row in the dialog box 

to set the row out of edit mode.

 14. Click the Refresh button to see the diameter update on-screen. Note that if the diameter 

does not update, you probably did not click out of the Diameter row to set the edit as 

active. The refresh option is a bit picky in this way. Keep in mind, however, that the pre-

view does not need to be refreshed to build to the specifi ed value correctly.

 15. Once the size parameter has been adjusted, as shown in Figure 7.16, click Next.

Figure 7.16
Inserting a simple 

iFeature

 16. You will be presented with two options for placing the iFeature; choose Activate Sketch 

Edit Immediately, and then click Finish.

 17. You will see that the iFeature sketch is set and ready to be edited and constrained into 

place so that it can’t be moved accidentally.

You’ll notice that there is some extra geometry included in the sketch. This geometry came 

from the original feature from which you extracted the iFeature.
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It would have been the best practice to prep the sketch and remove this geometry from the 

sketch before extracting. However, in this case you were not instructed to do so, in order to 

illustrate the presence of relic geometry at this point. It’s often a good idea to save a copy of your 

original part fi le and use it to clean up unwanted geometry before extracting iFeatures.

You can click the Finish Sketch button and close the fi le without saving changes.

Taking the Time to Constrain the Sketch

You should also notice that the sketch is currently underconstrained. In particular, it has no dimen-

sions or constraints holding it in position. You can place general dimensions into the sketch to 

anchor it in place. Also present is some relic geometry that originated from the sketch from which 

the iFeature was extracted. It is poor practice to extract iFeatures without cleaning them up fi rst, 

so eliminate this stray geometry beforehand.

It is also good practice to create a separate part fi le from which to generate an iFeature rather 

than attempting to use a part fi le designed for production. You can copy the part features from a 

production part into your iFeature test part using one of the copy or cloning methods discussed 

in the upcoming pages.

Editing an iFeature File

Once iFeature (IDE) fi les have been extracted and tested, you can open them in Inventor and 

edit them much as you do iParts. Follow these steps to explore the options involved in editing 

an iFeature:

 1. Select the Get Started tab, click the Open button, and then browse for the Chapter 07 

directory in your Mastering Inventor 2014 folder.

 2. Locate and open the fi le SquareSocket.ide you created in the previous exercise. If 

you did not complete that exercise, you can use the fi le mi_7a_025.ide found in the 

Chapter 07 directory.

Continue exploring the iFeature edit tools by following these general instructions:

 ◆ Use the Edit iFeature icon to refi ne parameter names, sizes, and instructional prompts for 

the placement of iFeatures.

 ◆ If the iFeature has dependent features, you can edit them as well.

 ◆ You can rename the iFeature if you want to confi gure it in a more in-depth manner by 

using the iFeature Author Table dialog box.

 ◆ The iFeature Author Table dialog box allows a table to be added to the iFeature so that rows 

and columns can be added to confi gure the iFeature in the same way that you confi gured a 

part fi le using the iPart Author dialog box.

 ◆ Once you’ve added the table to the iFeature, you can further edit it by clicking the Edit 

Using Spread Sheet icon to open the table in Microsoft Excel.

When creating iFeatures, you’ll fi nd it a good idea to keep the original IPT fi le that you used 

to create the IDE fi le. This fi le is often useful in case you want to totally redesign the iFeature or 

make a similar iFeature.
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Creating Punch Features
Punch features are really just iFeatures with extended functions that are slightly different in 

behavior from standard iFeatures. Punch features must have a single sketch center point in the 

base sketch to be extracted. The sketch center point will be used to locate the punch feature 

upon insertion into sheet-metal parts. The destination part(s) will require an active sketch con-

taining sketch center points for the location of the punch feature. It is the center point in the 

iFeature punch and the center point in the placement sketch that allow punch features to be 

precisely placed and constrained beyond the capabilities of the standard iFeature.

Including Placement Instructions

You can embed an instructional document detailing the placement selection requirements for more 

complex shapes that require faces to be selected in a certain order or need more information about 

size and settings. Here are the steps for including placement instructions:

 1. On the Tools tab, click Insert Object.

 2. Select Create From File, browse for the precreated instruction fi le, and then click the OK button.

 3. Th e fi le will show in the 3rd Party browser node, as shown here:

 4. Right-click the embedded object and select Placement Help to allow this fi le to be accessed 

from the feature’s dialog box during placement.

Punch Features in Standard Non-Sheet-Metal Parts?

Although the Punch tool is not available for use in the standard part-modeling environment, you 

may have a need to quickly and precisely place a feature multiple times in a way that lends itself 

to the Punch tool.

To do this, you can use the Convert To Sheet Metal Part button (found on the Model tab) to tem-

porarily convert the part to a sheet-metal part. Once this is done, you can use the Punch tool as 

required.

After you’ve placed the punches, you can use the Convert To Standard Part button (found in the 

Setup drop-down of the Sheet Metal tab) to convert the part back. Th is will leave some relic sheet-

metal parameters in your part fi le, but that shouldn’t cause an issue.
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Creating Punch Features

When creating a punch feature, consider that in normal use most features extend through the 

thickness of the sheet metal. Therefore, it is important to use the Thickness parameter when 

creating the iFeature. Constructed properly, the punch feature will adjust to the thickness of any 

sheet-metal part to which it is applied.

The part used in the following steps is a simple sheet-metal part with one cut feature. Figure 

7.17 shows the sketch underlying the cut feature. The sketch was created utilizing a single center 

point, which will be used for placement when inserting the punch feature. There was no need to 

anchor the sketch since it was created for the sole purpose of extracting a punch iFeature.

Figure 7.17
A sheet-metal 

sketch

Follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Open the fi le mi_7a_027.ipt from the Chapter 07 directory of your Mastering 

Inventor 2014 folder.

 3. On the Manage tab, select the Extract iFeature tool (you’ll fi nd it on the Author panel).

 4. Select Cut1 in the Model browser.

 5. Click the radio button at the top of the dialog box to toggle the iFeature type from 

Standard iFeature to Sheet-Metal Punch iFeature.

Punches and Center Points

If you have created multiple center-point locations within your sketch, you will receive an error 

message when trying to create the punch feature. Recall that by using the Center Point icon next 

to the Construction icon, you can switch extra center points in your sketch to standard points so 

that they will not interfere. In this example, you have only one center point within the sketch, even 

though there are other points locating two of the circles on the ellipse. Th e others have been made 

standard points as described ahead of time.

 6. Under the Manufacturing area, specify the punch ID as K775. Although not required, if 

it’s included, this punch ID can be retrieved and placed onto a drawing in the form of a 

punch note or punch table so the shop fl oor will know which punch to use.

 7. Click the Select Sketch button for Simplifi ed Representation, and then click Sketch3 in the 

Model browser. Simplifi ed sketches are optional but may help represent complex sketches 

more cleanly in the detail drawing.
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 8. When your dialog box resembles Figure 7.18, click Save, and select the Punches folder in 

the Chapter 07 folder of your Mastering Inventor 2014 directory.

Figure 7.18
Extracting a 

sheet-metal 

iFeature

 9. Name the punch feature K775.ide, and then save the fi le.

iFeatures Are Powerful Tools

Th ese tools allow you to quickly create standard features in your models. Examples include o-ring 

grooves, louvers, bosses, ribs, electrical connector punches, patterns of holes, and an infi nite num-

ber of other features. Another major advantage of iFeatures is that they enforce standards. Since 

the iFeature can be designed to allow the user to select predefi ned sizes only, the possibility of 

error is greatly reduced. Take a few moments to examine your designs, and you’ll likely see many 

opportunities for iFeatures.

Placing a Sheet-Metal Punch Feature

When working on a sheet-metal part, you can access iFeatures through the Punch tool or the 

Insert iFeature button on the Manage tab. The Punch tool is optimized for sheet-metal parts, so 

unless you are placing a regular iFeature, you should always use the Punch tool. Prior to placing 

a feature, you must have an unconsumed, visible sketch containing one or more center points 

from which the punch will position itself. Follow these steps to place a sheet-metal punch:

 1. On the Get Started tab, click the Open button.

 2. Open the fi le mi_7a_029.ipt from the Chapter 07 directory of your Mastering 

Inventor 2014 folder.
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 3. Inspect the Model browser to see that Sketch2 is visible. This sketch has been prepared 

for you to use in placing your new punch feature on the three center points.

 4. Next, locate and select the Punch Tool button on the Sheet Metal tab.

 5. Select the K775.ide fi le you created in the previous exercise from the Punches folder, and 

click the Open button. (If you did not complete the previous exercise, you can browse to 

the Punches folder of the Chapter 07 directory and choose the fi le called K777.ide.) You 

will notice that every unconsumed center point within the sketch will be populated with 

the selected punch.

Center Points

If you want to reserve a sketch center point for some other feature, click the Geometry tab in the 

Punch Tool dialog box, and hold down the Ctrl key while selecting the center point to be removed. 

If you want to place only one center point, hold down the Ctrl key, click the sketch away from a 

center point, and then click the center point where you want the punch. If you have more than one 

visible, unconsumed sketch, the center points will not be automatically selected because you will 

need to tell Inventor which sketch to use.

 6. Click the Geometry tab, and set the angle to 90.

 7. Click the Size tab, and set InsertDia to 20 mm, Major to 50 mm, and Minor to 25 mm.

 8. Click the Edit icon (it looks like a pencil) or click in the space below the Diameter row or 

on another row in the dialog box to set the row out of edit mode.

 9. Click the Refresh button to see the diameter update on-screen. Note that if the diameter 

does not update, you probably did not click out of the Diameter row to set the edit as 

active. The refresh option is a bit picky in this way. Keep in mind, however, that the pre-

view does not need to be refreshed to build to the specifi ed value correctly. Figure 7.19 

shows the punch parameters.

Figure 7.19
Placing a punch
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 10. Click the Finish button to complete the punch action.

 11. Click the Go To Flat Pattern button to view the fl at pattern.

 12. Right-click the Flat Pattern node in the Model browser, and choose Edit Flat Pattern 

Defi nition.

 13. Click the Punch Representation tab, set the drop-down to 2D Sketch Rep And Center 

Mark, and then click the OK button. Note the simplifi ed version of the punches. This can 

be useful for placing grouped punches or helping to simplify drawings that have many 

punches on them.

Note that you could use the Insert iFeature option to place the punches, but you would not be 

offered the same placement options. Instead, its behavior would be similar to that of a standard 

iFeature, requiring constraint of the placed punch by anchoring it to the base feature. In general, 

it is best to use the Punch tool for sheet-metal parts rather than placing punches as a standard 

iFeature.

Note that whereas the iFeature tool is available in the standard and sheet-metal environ-

ments, the Punch tool is available only in the sheet-metal environment. You can close this fi le 

without saving changes when you have fi nished.

Reusing Existing Geometry
Geometry reuse is a productive technique in Inventor. You can reuse existing features and 

sketch geometry to create additional features within the same part or even on other open parts. 

You don’t need to create additional new sketches to utilize this technique. The following sec-

tions show how to copy sketches and features and develop dependent and independent relation-

ships between the features.

Copying Features

Copying features in Inventor is a relatively simple procedure using the Model browser. In an 

existing model, simply right-click a feature within the browser and select Copy. Next, select a 

different face within the model, right-click, and select Paste. Figure 7.20 shows a preview of the 

placement and the Paste Features dialog box.

Figure 7.20
Copied features

Certification
Objective
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Beware of Projected Loops

When you select a face with the Project Geometry tool rather than selecting individual edges, 

a Projected Loop is created. If you select an edge, a Projected Edge is created. It is important to 

understand that when you right-click a feature that is based on Projected Loops, you will not get 

an option to copy it.

To resolve this, you can locate the Projected Loop by expanding the Sketch node in the browser 

and then right-clicking it and choosing Break Link. Once you break the link of the Projected Loop, 

you can copy the sketch. When you select just an edge to project, rather than a face, the result is a 

Projected Edge. Projected Edges can be copied without breaking the link. But if you have the need 

to break the link of a Projected Edge, you can do so by right-clicking it in the graphics area and 

choosing Break Link.

There are two questions to consider when copying a feature:

 ◆ What should Inventor do with features that are built based on the feature you are copying?

 ◆ What should Inventor do with the dimensions for your new feature?

We’ll explore the features fi rst:

 1. On the Get Started tab, click the Open button.

 2. Open the fi le mi_7a_031.ipt from the Chapter 07 directory of your Mastering 

Inventor 2014 folder.

 3. Right-click Extrusion2 in the Model browser, and notice that there is no Copy option. 

This is because there is a Projected Loop present in the sketch.

 4. Choose Edit Sketch from the context menu.

 5. Expand the Sketch2 node in the browser and notice the Projected Loop. This was created 

when the face the sketch is on was projected into the sketch.

 6. Right-click the Projected Loop node and choose Break Link.

Now that the link from the loop to the face is broken, the sketch is underconstrained. 

In real life, you’d take the time to reconstrain the sketch so that future changes to 

the base feature would not upset Sketch2 or Feature2. Most likely you’d do this by 

deleting the projected outer lines and reapplying the 20 mm dimensions to the pro-

jected edges of the base feature. For this exercise, though, you can leave the sketch 

underconstrained.

 7. Click the Finish Sketch button to exit the sketch.

 8. Right-click Extrusion2 in the Model browser and choose Copy.

 9. Right-click anywhere in the blank space of the graphics area, and choose Paste.

 10. Drag your cursor over any face of the part, and you will see a preview of the copied 

feature.



REUSING EXISTING GEOMETRY | 335

 11. In the Paste Features dialog box, set the Paste Features drop-down to Dependent, and you 

will notice that the fi llets are now in the preview as well because they are dependents of 

Extrusion2.

 12. Click the front face of the part to position the new feature as shown in Figure 7.20.

 13. Use the plus sign–shaped arrows in the center of the copied feature to move the feature 

around the selected face.

 14. Use the C-shaped arrow to rotate the new feature, and notice that the rotation angle is 

refl ected in the dialog box and can be adjusted there as well.

By default, the dimensions of the new feature will be independent, meaning that because 

the original feature has a width of 25 mm, the new feature will have the same value, but 

the two will not be linked. However, if you set the Parameter drop-down to Dependent, 

the dimensions of the new feature will reference the original feature, so that if the origi-

nal width changes from 25 mm to 35 mm, the new feature follows.

 15. Set the Parameter drop-down to Dependent also, and then click Finish.

 16. Locate and edit Sketch2 in Extrusion2, and set the diameter dimension to 6 mm.

 17. Finish the sketch, and notice that the new feature follows the edits of the original.

Once you’ve copied the feature, you should edit the copied feature sketch to properly anchor 

the sketch on the destination face. When editing a dependent sketch, notice that the dimensions 

indicate that they are being driven by a parameter from the original feature. If you change the 

dimensions from a parameter value to a numeric value, you will break the dependency with the 

original sketch. You can close this fi le without saving changes, or you can leave it open to exper-

iment with cloning a feature from one part to another part in the next section.

Cloning
Cloning is the process of copying feature geometry from one open part to another. The cloning 

process creates independent features, meaning that the new feature in the new part will have no 

relationship to the original feature in the original part unless set up manually.

To clone a feature from one part to another, you must fi rst have both parts open in Inventor. 

Here are the general steps:

 1. From the source part, right-click the feature to be copied in the Model browser, and 

choose Copy.

 2. Switch to the destination part, right-click anywhere, and choose Paste.

 3. Drag your cursor over the face of the part you want to paste onto, and you will see a pre-

view of the copied feature.

 4. Click the face, and then click Finish when the part is positioned to your liking.

The primary difference between copying features within the same part and cloning features 

between two parts is that parameters can be set to be independent only during the cloning 

process.
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It will be necessary to fully constrain and anchor the feature sketch to the new part once 

the feature has been copied. To accomplish this, simply edit the new feature sketch and project 

construction geometry from the new part base feature to serve as anchor points.

Linking Parameters between Two Files

You can establish a relationship between two parts, between two assemblies, or between a part 

and an assembly by linking the fi les’ parameters. This can allow you to place all the design 

information in one fi le and link other fi les to it so the intent of the design is maintained. Here 

are the steps to do this:

 1. On the Get Started tab, click the Open button.

 2. Open the fi le mi_7a_033.iam from the Chapter 07 directory of your Mastering 

Inventor 2014 folder.

This is a simple pin and plate assembly. Your goal is to link the shaft diameter of the 

pin to the hole diameter in the plate. To do this, you will fi rst edit the pin part called 

mi_7a_034.ipt.

 3. Select mi_7a_034.ipt from the browser, right-click, and choose Edit (or just double-click 

the pin in the graphics area).

 4. Once the part is active for edits, click the Parameters button on the Manage tab.

 5. At the bottom of the Parameters dialog box, click the Link button, as shown on the left of 

Figure 7.21.

Figure 7.21
Linking parameters

 6. Adjust the Files Of Type drop-down to show Inventor Files, and then open the fi le 

mi_7a_035.ipt from the Chapter 07 directory of your Mastering Inventor 2014 

folder, and click the Open button.

 7. This opens the Link Parameter dialog box, allowing you to choose which parameters 

to link to this part. Click the button next to the parameter named Diameter, and then 

click the OK button.

Certification
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This will add the selected parameter to the user parameters in the pin part, making it 

available for you to reference in another parameter.

 8. Locate Shaft_Diameter in the list, activate the cell in the Equation column, and clear the 

existing value.

 9. Click the fl yout arrow as shown in Figure 7.22, and choose List Parameters from the 

fl yout menu.

Figure 7.22
Setting a param-

eter to reference a 

linked parameter

 10. Select Diameter from the Parameters lists and then add - 1 mm so that your fi nal shaft 

diameter equation is Diameter - 1 mm. Subtracting 1 mm from the shaft diameter creates 

a loose hole.

 11. Click Done at the bottom of the dialog box to return to the model.

 12. Click the Update button from the Quick Access bar (at the top of the graphics area) to 

see the model update if needed. Note that if you have the Immediate Update check box 

selected in the Parameters dialog box, the part updates right away but the updates may 

need to be pushed up to the assembly.

 13. Finally, right-click and choose Finish Edit to return to the assembly level.

Now the shaft diameter is linked to the hole diameter in the part called mi_7a_035.ipt. You 

can open or edit mi_7a_035.ipt and change the hole diameter value to see the change carry 

through to the shaft of the pin. Linking parameters in this way allows you to place design infor-

mation in one location and pull it into many other parts for automatic updates.

Copying Sketches
Quite often it is desirable to copy existing part sketches to another location within the same part 

or a different part. A good example of this would be creating a loft feature where each profi le 

sketch may simply change size.

In the example shown in Figure 7.23, the part contains one unconsumed sketch and multiple 

work planes parallel to the XY origin plane. To copy an existing sketch, simply right-click the 

target sketch, and select Copy. Then select the destination work plane, right-click, and select 

Paste. Pasted sketches are always independent of the original sketch and will create additional 

parameters for each copy.
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Figure 7.23
Copying a sketch

The following exercise will explore copying sketches:

 1. On the Get Started tab, click the Open button.

 2. Open the fi le mi_7a_039.ipt from the Chapter 07 directory of the Mastering Inventor 

2014 folder.

 3. Right-click Sketch1 in the Model browser, and choose Copy.

 4. Click any edge of the work plane closest to the sketch, and then right-click and choose 

Paste.

 5. Repeat this for each of the remaining work planes.

 6. Select the 20 mm dimension in each of the copied sketches and adjust the minor axis on 

each of the sketches, decreasing the dimension value by 4 mm on each subsequent sketch, 

as shown in Figure 7.23.

 7. Edit Rectangular Pattern1 and change the pattern count to 6.

 8. Right-click any edge of the new work plane, and choose New Sketch.

 9. If it’s not done automatically, project the origin center point to the sketch. You can use the 

Project Geometry tool on the Sketch tab and select the center point of the ellipse in any of 

the other sketches.

As you can see, copying sketches can be a quick way to duplicate repetitive geometry. To 

carry this thought through, you can create a loft utilizing all the sketches, including the sketch 

consisting of just the projected origin point. Apply a tangent condition to the projected point to 

achieve a result that holds the work plane as the extent of the loft.

In this example, you copied a sketch within the same part. The procedure to copy an existing 

sketch to another part requires that both parts be open at the same time. Right-click the original 

sketch, and then select Copy. Then, after selecting the destination part work plane or part face in 

the second fi le, right-click and select Paste.

Once the sketches are pasted, they can be edited at any time by adding additional geometry, 

changing dimensions, or simply using the pasted geometry for reference.
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Using Flip Normal

At times you may fi nd that your sketch “fl ips” when you’re pasting it onto a work plane. In many 

cases, you can easily fi x this by right-clicking the work plane and selecting Flip Normal. Th is fl ips 

the positive axis of the work plane. Th en when you paste the sketch onto the work plane, it will 

no longer be fl ipped.

Introducing Content Center
In Inventor 2014, Content Center is available in two forms: Desktop Content and the tradi-

tional Autodesk Data Management Server (ADMS)–based Content Center. The ADMS-based 

Content Center is a set of database libraries contained in Microsoft SQL and is generally used 

when sharing a central customized Content Center over a network. The other is a stand-alone 

install of Content Center that typically resides on your local machine. The stand-alone install 

is the default form of Content Center. No matter how you choose to install Content Center, you 

can select which libraries to use. These libraries provide standard content in several common 

international standards, such as ANSI, ISO, and DIN, just to name a few. Figure 7.24 shows the 

complete list. Once properly confi gured and populated, Content Center provides an organized 

method for part and feature reuse.

Figure 7.24
Content Center 

libraries

You can think of these libraries simply as recipes for creating parts because no actual part 

fi les exist in the Content Center fi le store. Instead, Content Center is a table of part parameters 

stored in the Content Center database. Once these library databases are installed, you can access 

them from Inventor and place common parts into your designs.

Understand that it is at this point the Content Center part fi le is created. Up until this point, the 

part existed only as a defi nition in the database table. If you work in a shared environment, 

the Content Center part fi les might typically be stored on a network server so that as users col-

laborate on designs, they have access to the same part fi les used within the assemblies. Because 

the Content Center library database fi les are just defi nitions of the fi les, they can be installed 

on the users’ local machines or on a network server, or both.
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Content Center provides support for functional design using the design accelerator, Frame 

Generator, and other features within Inventor. When you’re using these tools, the parts gener-

ated are pulled from the Content Center libraries. You can use Content Center in conjunction 

with standard iParts and iFeatures organized within libraries in the project.

Confi guring Content Center
Content Center, loaded with all the standard libraries, provides in excess of 800,000 variations in 

parts. To optimize loading, you will want to confi gure only the appropriate standards for your 

use. Installing all libraries will cause Inventor to take more time to search and index the data. 

There are two installation strategies for Content Center. Depending on how you work, you may 

want to install the desktop Content Center or the ADMS version.

Installing Content Center for a Stand-Alone User

If you work as a stand-alone user, I recommend that you use the Desktop Content method. 

No server setup or login is required because the Content Center libraries are installed in the 

Desktop Content folder on your local hard drive. This is the default installation option. You 

can insert the install media and install or reinstall the Content Center libraries at any point by 

following the installation steps. Once the libraries are installed, you use the Place From Content 

Center tool or the Open From Content Center tool to access the Content Center libraries.

Installing Content Center for a Collaborative Environment

If working in a shared group, you will likely want to install Content Center on a server location 

instead of, or in addition to, the Desktop Content libraries. When installing on a server, you will 

install the libraries on the Autodesk Data Management Server. The ADMS is essentially just the 

interface with which you interact with the SQL database program. Once the ADMS is installed 

and the required Content Center libraries are loaded, users log into the ADMS through Inventor.

When deciding whether to install Content Center libraries on a network server or install 

them locally, consider whether you plan to create and use a custom library. If not, you may not 

need to install Content Center on a server, and you can choose to install the libraries on all the 

local machines only. Because the standard Content Center libraries are all read-only databases, 

they cannot become out of sync; therefore, two users can access two different instances of the 

standard libraries and work without issue. If you plan to create custom Content Center libraries, 

however, I recommend that you install on a network server so that as the library is updated over 

time, all users are pulling from the same source. You can consult the installation media for more 

information on installing the ADMS and the Content Center libraries.

Managing Your Memory Footprint

Installing all libraries into the ADMS will increase your overall memory usage substantially. 

As mentioned earlier, installing only the libraries you use will keep Content Center effi cient. As 

you will see in the coming pages, you can create a custom Content Center library based on the 

standard libraries and include only what you require. Once the custom library is created, stan-

dard libraries can be removed from the ADMS. You can add them back at any time by reinstall-

ing them from the Inventor installation disks.
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Configuring Content Center Libraries in the Project Files

Once you’ve installed the ADMS and the required libraries, you will need to confi gure the proj-

ect fi le to ensure that all required libraries are included in the project. To do this, you will want 

to close all fi les in Inventor so that the project fi le can be edited. Then follow these steps:

 1. In Inventor, select the Get Started tab, and click the Projects button.

 2. In the Project Editor dialog box, ensure that your project is set as active, and click the 

Confi gure Content Center Libraries button at the lower right of the Projects dialog box to 

open the Confi gure Libraries dialog box, as shown in Figure 7.25.

Figure 7.25
Confi guring 

Content Center 

libraries

 3. Use the buttons at the bottom of the dialog box to update, import, add, or remove libraries 

for the project. Removing libraries from a project will speed up the interaction between 

Inventor and Content Center when placing a part because fewer library tables are 

required to be read, searched, and indexed. Once a library is removed, you can add it to 

the project again at any time.

If you only occasionally access a certain library because you typically do not work with that 

standard, you might install it but remove it from your Inventor project. When you do need to 

access this library, use the Confi gure Libraries dialog box to load it for use, and then unload it 

once you have fi nished. Although the suggestion to add and remove libraries may seem like a 

hassle, it will pay off in time savings because you will not fi nd yourself waiting for the libraries 

to load every time you access Content Center.

Using Content Center
Content Center is used in many areas of Inventor. Components from Content Center are used 

in functional-design tools, such as the Shaft Generator or Frame Generator, as well as in indi-

vidual, reusable components in general assembly design. Content Center is also available for use 

within the part environment using the Place Feature tool.
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Placing Components into an Assembly

Let’s take a closer look at placing components into an assembly from Content Center:

 1. Make sure you have either Desktop Content or the ADMS installed and the ANSI content 

library loaded to continue with this example.

 2. If you are running Content Center through the ADMS, ensure that you are logged in 

to the ADMS by clicking the Inventor icon and selecting Vault Server ➢ Content Center 

Log In.

If you are already logged in or logged into Vault, Log In will be grayed out and will not 

be an option in your menu.

 3. Enter your login information, if known. By default, the ADMS installs with a user 

account called Administrator with no password set. You can also select the Content 

Center library’s Read-Only check box to access content without logging in.

 4. Specify the name of the server on which you installed the ADMS. If you have installed 

the ADMS on your local machine, enter localhost. In the Database text box, enter the 

name of the ADMS database; the default is Vault.

Placing Parts from Content Center

Once logged in to the ADMS, or if you have installed Desktop Content (there is no login 

required), you are ready to place parts from Content Center. To do so, follow these steps:

 1. From the Get Started tab, click the Open button.

 2. Open the fi le mi_7a_044.iam from the Chapter 07 directory of your Mastering 

Inventor 2014 folder.

 3. On the Assemble tab, click the Place From Content Center icon. Check to see that the 

three buttons indicated in Figure 7.26 are selected. From left to right these buttons are 

Filters, AutoDrop, and Tree View:

Figure 7.26
Place From Content 

Center settings

Filters Button  Select ANSI to fi lter out all other standards. To turn the fi lter off after 

this exercise, click the Filters button again and deselect ANSI. If you do not have the 

ANSI library installed, you can select another library, but the size and bolt names will 

differ from the following steps.
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AutoDrop Button  This button turns on the ability to automatically size components 

based on geometry in the model.

Tree View Button  This button splits the screen so that the Category View pane is acces-

sible on the left of the dialog box.

 4. Select the Fasteners category in the left pane, browse to Bolts and then Round Head, 

select Cross Recessed Binding Head Machine Screw – Type I, and click the OK button.

 5. In the model, zoom in to one of the caster wheel assemblies, and take note of the empty 

holes.

 6. Pause your mouse pointer over one of the holes on the castor plate.

You will see the AutoDrop icon activate and fl icker as Inventor indexes the database for 

an appropriate size. If no matching size can be found in the database, a cursor note will 

appear saying so. If an appropriate size is found, a cursor note will display it, and a pre-

view of the part will be shown.

 7. Once the size appears, click the edge of the hole to set the screw in place. The AutoDrop 

toolbar will appear along with the red grip arrow.

 8. Drag the grip arrow up or down to specify the length of the screw. Note that only lengths 

found in the database are available.

 9. Click the Apply button, and continue placing screws as you see fi t. Experiment with plac-

ing the mouse pointer over one of the large diameters in the caster assembly to watch 

AutoDrop attempt to fi nd an appropriate size. Figure 7.27 shows the AutoDrop toolbar.

Figure 7.27
Placing a screw with 

AutoDrop

Once you’ve experimented with placing bolts from Content Center, you can close this fi le 

without saving changes or continue exploring the other options discussed. Here is a brief 

description of each of the tool icons shown in the AutoDrop toolbar in Figure 7.27:

Insert Multiple  The fi rst icon is available when Inventor identifi es multiple targets that are 

like the selected target. In this case, the other holes in the plate are picked up and previewed. 
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If you apply the screw now, four screws will be placed at once. If you do not want the mul-

tiples to be placed, you can click the Insert Multiple icon to turn it off.

Change Size  The second icon is grayed out while Insert Multiple is on. It inserts the part 

and opens the Part Family dialog box, which allows you to edit the component.

Bolted Connection  The next icon opens the Bolted Connection Component Generator and 

allows you to place bolt, nut, and washer sets as a group.

Apply  The fourth icon sets the previewed component(s) and allows you to continue placing 

more components of the same family.

Done  The last icon sets the component(s) and exits the autodrop mode.

The AutoDrop toolbar is context-sensitive, so the icons may vary depending on the com-

ponent to be placed and the selected geometry. If you press F1 on the keyboard while the 

AutoDrop toolbar is displayed, Inventor will open the help fi le and list all the icons and their 

descriptions.

Now that you’ve placed Content Center components, let’s examine where Inventor is storing 

the newly generated Content Center fi les. Select the Tools tab, and click Application Options; 

then click the File tab. Look for the fi le path indicating the default Content Center fi les, as shown 

at the top of Figure 7.28.

Figure 7.28
Content Center fi les 

storage path

This is where Inventor will place all standard parts placed from Content Center by default. 

Typically you should change this path to a path that is on the network server, particularly if 

you’re working in a multiuser environment. If you work only on your local hard drive, you 

will still likely want to change the path to be similar to the path where you save your Inventor 

designs.

If this path is left at the default, Content Center part fi les will be saved on your local machine. 

This causes a problem when a co-worker opens an assembly you created. There is one more 

place where you can set this path, and that is in the project fi le under Folder Options, as shown 

at the bottom of Figure 7.28. It is important to note that a path set in the project fi le takes pre-

cedence over a path set in application options. If the project fi le is set as Content Center Files = 

[Default], then the fi les are stored at the application options path.

Only standard Content Center fi les are stored at this location. Custom-sized Content Center 

part fi les, such as standard steel shapes, pipes, and so on, are stored at a path chosen by you at 

the time of their creation.
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Content Center Application Options Tab

You can access the Content Center tab from application options to confi gure the following settings:

Refresh Out-Of-Date Standard Parts During Placement  When this option is selected, 

existing standard part fi les are automatically replaced with newer versions. For instance, 

if you update a standard part with your part number in the Content Center library tables, 

but that part has already been placed in other assemblies and therefore already exists in the 

Content Center parts fi le folder, having this option selected will update the Content Center 

fi le folder and place the new version in the assemblies.

Custom Family Default  Set this option to place a custom Content Center part as a stan-

dard part. When you place a custom part as standard, the part fi le is saved in the Content 

Center fi les folder and is considered a standard part.

Access Options  Th is sets the source of the Content Center libraries. You can choose 

between Desktop Content and the ADMS/Vault server.

Customizing Content Center Libraries
Standard Content Center libraries supplied with Inventor are designated as read-only and cannot 

be modifi ed. If you need to create custom part libraries or modify standard content such as add-

ing part numbers or material types, you can do so by creating a custom Content Center library. 

Custom libraries are initially set as read-write libraries so that you can add and modify content.

Do You Need to Use Content Center?

Many people fi nd the fi le structure of Content Center–generated fi les to be at odds with the way 

they store purchased and standard parts. If you fi nd this is the case with your setup, you might 

want to use Content Center to generate parts but then save copies of them under your own fi le 

structure as needed. Often, commonly used components are generated from Content Center in 

this manner and then placed in a company’s purchase part directory after the Part Number and 

Description iProperties are adjusted.

Creating Custom Libraries for ADMS Installs

You add libraries from the Autodesk Data Management Server console when using Content 

Center with the ADMS. You can access the ADMS by selecting Start ➢ All Programs ➢ Autodesk 

➢ Autodesk Data Management ➢ Autodesk Data Management Server Console. Typically this 

would be done on the server machine. Figure 7.29 shows how to create a custom library.

Once you’re logged into the ADMS console, expand the folder in the top of the left pane, 

right-click the Libraries subfolder, and select Create Library. Create a new library called 

Mastering Inventor.
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Figure 7.29
Creating a custom 

library in the ADMS

Once the library is created, follow these steps:

 1. Select the Get Started tab.

 2. Click the Projects button.

 3. Click the Confi gure Content Center Libraries button at the bottom-right corner of the 

Project Editor dialog box.

 4. Ensure that the In Use check box for this new library is selected so that the project is con-

fi gured to include it.

Creating Custom Libraries for Desktop Content

You can create a custom Content Center library for Desktop Content through the Content Center 

confi guration of the Project Editor. To do so, follow these steps:

 1. Select the Get Started tab.

 2. Click the Projects button.

 3. Click the Confi gure Content Center Libraries button at the bottom-right corner of the 

Project Editor dialog box.

 4. Click the Create Library button, and enter Mastering Inventor into the input box, as 

shown in Figure 7.30.

Figure 7.30
Creating a custom 

library with 

Desktop Content
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 5. Click the OK button.

 6. Ensure that the In Use check box for this new library is selected so that the project is con-

fi gured to include it.

Copying Existing Libraries into Custom Libraries

After creating a custom library, you can copy entire or partial contents of existing standard 

libraries into your custom library. You might use this process when you want to simplify one of 

the standard libraries, remove portions of the library that are not needed in your work environ-

ment, or edit component properties such as part numbers. Here are the steps to copy families to 

a custom library:

 1. Access the Content Center Editor from within Inventor by selecting the Tools tab and 

clicking the Editor button on the Content Center panel. This editor looks similar to the 

Content Center dialog box.

 2. Locate the library or the part family within a library that you want to copy, right-click, 

and choose Copy To ➢ Mastering Inventor, as shown in Figure 7.31.

Figure 7.31
Copying a Content 

Center family

The library must be included in the project fi le confi guration list in order to be visible within 

the editor. If you copy an entire library to your custom library, then the entire folder structure 

and contents will be replicated in your custom library. If you copy an individual part to your 

custom library, then only the affected category structure will be replicated in the custom library 

along with the copied part.

To copy only a portion of the category structure, browse to the last hierarchical portion of the 

structure that you want to replicate. Otherwise, starting from the top and copying the structure 

will replicate the entire structure.

Setting Category Properties

Each category within Content Center contains category properties. Within the category proper-

ties is general information regarding the category itself. The General tab contains the category 

name, category image, and source library.
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Creating Multiple Material Types for Content Center Families

It’s pretty easy for your design department to have the Content Center parts refl ect their own 

internal part numbers so that bills of materials and parts lists will extract this information auto-

matically. Doing this is as simple as copying the appropriate standard Content Center categories 

to a custom read/write library and editing the tables to include the new part numbers.

However, if multiple material types are used for the same component type, then multiple copies of 

the family can be made to accommodate this. For instance, if you use stainless steel fasteners of a 

given type for certain design instances and also use galvanized fasteners of the same type in other 

design instances, you would most likely need these to have separate part numbers.

You can use the Material Guide to add materials in one of three ways:

 ◆ You can edit a family table and select the members to add new materials to. Th en click the 

Material Guide button or right-click and choose Material Guide to copy the selected members, 

add them to the family table, and assign the new materials to them.

 ◆ You can use the Material Guide for an entire family, copying all members with a new material 

and adding them to the existing family. Select the family in the Content Center Editor and 

click the Material Guide button, or right-click and choose Material Guide. Th en choose the 

option called Add Materials As New Family Members, thereby copying all members into the 

same family table and setting a new material at the same time.

 ◆ You can create new families of a diff erent material as well. Select the family in the Content 

Center Editor and click the Material Guide button, or right-click and choose Material Guide. 

Th en choose the option Create New Family For Each Material, thereby copying the entire exist-

ing family and setting a new material for this new family at the same time.

The Parameters tab contains parameters used within the category to assist in the description 

of parts located within that category. Figure 7.32 illustrates the parameter list in the ANSI Socket 

Head category.

Figure 7.32
Socket head 

parameters
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Within these parameters, some are optional and some are required. If you are placing a part 

within this category, you must map your part properties to all required fi elds for proper opera-

tion. Optional fi elds do not require mapping.

What this means is that if you are planning on publishing a large number of your own 

parts to Content Center, your part parameters must match the category parameters. If you are 

unable to match the parameters, consider creating a new category.

Expect Some Inconsistency

Th e mapping required for Content Center is not consistent for all types of parts because of the 

evolution of these tools over time. Some of the categories require authoring before you can pub-

lish a part. Other categories are open for publishing without authoring. Th e requirements for 

restricted categories are driven by tools such as the design accelerator, Bolted Connection, and 

AutoDrop, which require certain parameters so they can intelligently place components. One 

inconsistency is Frame Generator. Since Content Center steel shapes predate Frame Generator, 

which originally had its own shape library, there weren’t any authoring requirements. Just be 

aware of the inconsistencies.

Right-clicking an individual Content Center part will allow you to view the family properties 

and mapping of that part. Compare the category parameters of the part with the parameters of 

the intended category. Matching the two parameter lists ensures that the part will map easily 

into that category.

Editing a Custom Content Center Family

A Content Center family is an individual part, similar to an iPart. The part consists of a 

standard factory part with a family table attached that generates any of the optional table 

values.

You can edit any individual part by fi rst switching the library view to your custom library 

designation, as shown in Figure 7.33.

Figure 7.33
Editing a Content 

Center part

In the previous example, you switched the library view to the Mastering Inventor custom 

library. Right-click a part located within the custom library, and select Family Table. This 

launches a dialog box that allows the user to modify values, copy/paste, add/delete rows, or 

suppress existing rows within the table. The dialog box also allows the addition, deletion, and 

modifi cation of columns and properties.
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Publishing Parts to Content Center
Developing a process for reusing parts within your company’s design environment is essential 

for standardization and improved productivity. Part of this process may include publishing 

existing Inventor parts stored in project libraries. Both normal parts and iParts can be published 

to a custom Content Center library.

The act of publishing a standard part into the custom library adds a family table to the 

published part. Exported part parameters will be converted to table parameters when published 

to the custom Content Center. iPart tables are converted to family tables when published.

Preparing the Part for Publishing

If the part you intend to publish will be included in an existing Content Center family category 

(that is, fasteners, shaft parts, and so on), you can use the Component Authoring tool to prepare 

components with the necessary properties for use as “smart” content in the Content Center 

library. You can do this by following these steps:

 1. On the Get Started tab, click the Open button.

 2. Open the fi le mi_7a_064.ipt from the Chapter 07 directory of your Mastering 

Inventor 2014 folder.

 3. Select the Manage tab, and click the Component Authoring button on the Author panel 

(you may need to use the drop-down to fi nd it).

 4. From the drop-down list, select Fasteners ➢ Bolts, and select Other. Note that the 

graphics and selection prompts change depending on the category of component 

selected.

 5. Select the geometry for each row in the dialog box that corresponds to the dialog box 

graphic to map iMate placement to this part (iMates are preprogrammed Assembly 

constraints).

 6. Click the Parameter Mapping tab. Note that the parameters listed in the light yellow/

orange rows are required, whereas the others are optional. Click the … button for the 

Grip Length row.

 7. In the Part Template Parameters dialog box, expand the browser to fi nd Parameters ➢ 

User, and select GripLength. This maps the part parameter to the corresponding family 

table parameter. Click the OK button.

 8. Map the Nominal Diameter and the Nominal Length parameters to the NomDiameter 

and NomLength model parameters, respectively (you can fi nd these at Parameters ➢ 

Model rather than Parameters ➢ User).

 9. Click the OK button to write the mapped parameters and iMates to the part fi le. You 

could also click the Publish Now button to start the publishing process.

You can author parts ahead of time and use the Batch Publish tool to publish one or more 

unopened parts at once. Or you can publish one part at a time, as covered in the next section. 
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Figure 7.34 shows the Component Authoring dialog box tabs. You can close this part without 

saving changes and move on to the next section, which is about publishing parts.

Figure 7.34
Component 

Authoring tabs

Publishing the Part

To publish a part to Content Center, you must have a custom library with read/write capabil-

ity created, and your current project fi le must be confi gured to include this custom library. 

In this example, you will publish a simple part that has already been authored to the custom 

read/write Content Center library called Mastering Inventor. If you haven’t already created 

this library, review the steps in the section “Creating Custom Libraries for Desktop Content” or 

“Creating Custom Libraries for ADMS Installs,” depending on which method applies to your 

setup. Follow these steps to publish a part:

 1. On the Get Started tab, click the Open button.

 2. Browse for the fi le mi_7a_068.ipt located in the Chapter 07 directory of the Mastering 

Inventor 2014 folder, and click the Open button.

 3. Select the Manage tab, and click the Publish Part button on the Content Center panel.

 4. Select the Mastering Inventor library, and set the language as required; then click Next.

 5. Ensure that Category To Publish To is set to Fasteners ➢ Bolts ➢ Other; then click Next.

 6. Notice that most of the parameters are already mapped; this is because this part has 

previously been authored following the steps in the section “Preparing the Part for 

Publishing.” Recall that all parameters in the light yellow/orange rows are required. Click 

the … button for the Thread Type row.

 7. In the Part Template Parameters dialog box, expand the browser to fi nd Threads ➢ 

Thread1, select Type, and then click the OK button.

 8. Click Next in the Publish Guide dialog box.

 9. Select Nominal Diameter, Nominal Length, and Part Number in the left pane, and use 

the arrow button to include them in the right pane. This defi nes keys that are available 
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for selection upon placement of the Content Center part once published. At least one Key 

column must be defi ned. Click Next to continue.

 10. Enter EyeBolt for the family name, and set the Standard Organization option to ANSI. 

Only the family name is required; however, designating the Standard Organization 

option allows the part to be listed when fi ltering per standard. You can also type a cus-

tom standard into the fi eld, such as your company name. This allows you to create a fi lter 

for the parts you published.

 11. Click Next, and notice the preview thumbnail. You can use the Browse icon to select a dif-

ferent graphic fi le for use as a thumbnail, if one exists.

 12. Click Publish to complete the task and add this part to your custom Content Center 

library. Click the OK button in the successful publish confi rmation box.

This creates the part family table in the Content Center library, but at this point there is only 

one row in the table. Typically you will want to add a row for each size or different type of the 

component. You can do this by using the Content Center Editor (found on the Manage tab). 

Figure 7.35 shows the family key and properties steps of the Publish Guide. You can close this 

part without saving changes.

Figure 7.35
Publishing a part to 

Content Center

You can also convert a part to a table-driven iPart before publishing and include the rows for 

each size and type of the part confi guration in the iPart table. Once you have a workable iPart 

that behaves correctly, you can open the original factory iPart and publish the part. The iPart 

may be a custom iPart or a fully table-driven factory. iParts containing multiple row defi nitions 

in the table will convert to a fully table-driven Content Center part. You can fi nd more informa-

tion on iParts in the section “Working with iParts” at the beginning of this chapter.

Before using a newly published Content Center component in production, test the part in a 

blank assembly for proper function.
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Adding a New Category to Content Center

If you need a unique category for your own specifi c parts, you can simply add a new family of parts 

instead of using an existing category. You can do this from the Content Center Editor (accessed from 

the Manage tab). Make sure the library view is set to view only the read/write library in which you 

intend to create the new category and that the tree view is enabled. Th en right-click in the blank 

space in the Category View pane, and choose Create Category. You can also create a subcategory by 

right-clicking an existing category and selecting Create Category.

Th e Bottom Line

Create and modify iParts.  iParts are the solution to creating parts that allow for an infi nite 

number of variations without affecting other members of the same part family already used 

within your designs.

Master It  You use a purchased specialty part in your designs, and would like to create 

the many size confi gurations that this part comes in ahead of time for use within assem-

bly design. How would this be done?

Create and use iFeatures and punches.  Creating a library of often-used features is 

essential to standardization and improved productivity within your design workfl ow.

Master It  You want to be able to place common punches, slots, and milled features 

quickly rather than having to generate the feature every time. What is the best way to 

approach this?

Copy and clone features.  You do not have to create iFeatures to reuse various part features 

in your designs. If a part feature will have limited use in other designs, it is often better to 

simply copy it from part to part or from face to face on the same part.

Master It  You need to reuse features within a part or among parts. You consider 

iFeatures but realize that this feature is not used often enough to justify setting up 

an iFeature. How would you proceed?
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Link parameters between two fi les.  Linking design parameters between two or more fi les 

allows you to control design changes from a single source, making it easy to update an entire 

design from one fi le.

Master It  You want to specify the overall length and width of a layout design in a base 

part and then have other components update as changes are made to this part. What are 

the methods to do this?

Confi gure, create, and access Content Center parts.  Content Center provides a great 

opportunity to reuse database-created geometry within assemblies and within functional-

design modules. The Content Center Editor provides the means to add custom content into 

Content Center. You can create and add custom libraries to your current project fi le.

Master It  You would like to change the part numbers in some Content Center 

components to match the part numbers your company uses. You would also like to add 

proprietary components to Content Center. How do you customize Content Center?
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Assembly Design Workfl ows

A typical assembly fi le is composed of links to the included components and assembly relation-
ships. The components are parts or subassemblies that exist as separate fi les. When components 

are placed into an assembly fi le, links to those individual fi les are created in the assembly fi le. 

Initially a component is free-fl oating and can be moved and rotated in any direction unless it’s 

grounded in place or constrained to other components.

For example, if you were to create an assembly of a simple drilled base plate and a bolt to be 

inserted in the hole, you would have three fi les:

 ◆ The assembly fi le (with a fi lename extension of .iam)

 ◆ The base plate part fi le (with a fi lename extension of .ipt)

 ◆ The bolt part fi le (with a fi lename extension of .ipt)

When the part fi les are placed into the assembly fi le, links are created to the locations of 

those fi les. If the hole in the base plate part is enlarged, the assembly is automatically updated 

to refl ect that change since it is linked to the part fi le. To assemble the plate and bolt, at least 

one assembly relationship would be created by selecting the shaft of the bolt and the hole in 

the plate. Assembly relationships can be created using the Constraint tool or the Joint tool. 

Assembly relationships have two functions:

 ◆ They defi ne how two or more components relate to one another.

 ◆ They limit the degrees of freedom any one component has in the assembly.

Developing a good assembly design workfl ow is paramount to achieving performance, fl ex-

ibility, and stability in your designs. In this chapter, you’ll explore several types of workfl ows 

to achieve that goal. Included in this chapter is a discussion on how to use subassemblies to 

enhance performance. Using subassemblies within your design can substantially improve per-

formance. Component count can be in the hundreds of thousands of parts, as long as you have 

suffi cient memory on your system.

In this chapter, you’ll learn to:

 ◆ Create assembly relationships using the Constraint and Joint tools

 ◆ Organize designs using structured subassemblies

 ◆ Work with adaptive components

 ◆ Create assembly-level features

 ◆ Manage bills of materials
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 ◆ Use positional reps and fl exible assemblies together

 ◆ Copy assembly designs for reuse and confi guration

 ◆ Substitute a single part for entire subassemblies

 ◆ Work with assembly design accelerators and generators

 ◆ Use design calculators

Assembly Relationships
Mastering the use of the Constraint and Joint tools to create functional assembly relationships 

is an important part of learning to create assemblies in the Autodesk® Inventor® program. 

Assembly relationships are the glue and nails of construction when it comes to building your 

assemblies. Properly using assembly relationships will permit the construction of stable assem-

blies, assist in developing stack-up tolerances, and allow parts to be driven to show the anima-

tion of a process.

If you use assembly relationships improperly, you can create a nightmare of broken and/or 

redundant relationships, preventing assemblies from functioning properly, destroying assembly 

performance, and causing rework. Understanding how assembly relationships function in an 

assembly will help assure success in building and editing your design.

Another important concept for assembly relationships is the idea of removing or defi ning a 

component’s degrees of freedom. When you create relationships between assembly components, 

you are also changing the way those components are allowed to move in the assembly, just as 

you do when you assemble parts in the real world.

Degrees of Freedom
Initially each component within an assembly fi le possesses six degrees of freedom. The degrees 

of freedom (DOF) are bidirectional and consist of three axial degrees of freedom along the ori-

gin x-, y-, and z- axes, as well as full rotational freedom around the same axes. You might think 

of degrees of freedom like the roll, pitch, and yaw of an aircraft. In order for a pilot to maintain 

control of the aircraft, the side-to-side roll, the up-and-down pitch, and the clockwise or coun-

terclockwise yaw of the aircraft must be controlled. Likewise, you will create assembly relation-

ships between your components to prevent them from moving freely or at least to control the 

way in which they are allowed to move.

For ease of use when learning to create assembly relationships between components, it might 

help to make the degrees of freedom visible through the View tab by clicking the Degrees Of 

Freedom button. As constraints are applied to your component, the DOF triad will change to 

only show the remaining DOF. When the component is fully constrained, the triad will disap-

pear. Figure 8.1 shows the Degrees Of Freedom button and the resulting triad.

Figure 8.1

Activating the 

Degrees Of 

Freedom view
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You can also analyze the degrees of freedom for the complete assembly. The Degree Of 

Freedom Analysis button is located in the Productivity panel drop-down list found on the 

Assemble tab. A dialog box displays each component (part or subassembly) at the active level of 

the assembly. The number of translation and rotation DOF are listed.

If you select Animate Freedom at the bottom of the dialog box and then select a component 

in the list, it will move to show the DOF, assuming it is not already fully constrained. Figure 8.2 

shows the Degree Of Freedom Analysis dialog box.

Figure 8.2

Animating an 

underconstrained 

component from 

the Degree Of 

Freedom Analysis 

dialog box

Follow these steps to animate the underconstrained component:

 1. Click the Get Started tab and choose Open.

 2. Browse for the fi le mi_8a_001.iam located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder and click the Open button.

 3. Click the View tab and then click the Degrees Of Freedom button to turn on the degrees-

of-freedom triad for each part.

You’ll notice that each part has an icon denoting the axes it is able to translate along 

or rotate around. There are only three triads shown because the part called 8–001 is 

grounded and cannot move at all. You can see this by looking at the browser and noting 

the push pin icon shown on that part.

Enable the Productivity Panel

Note that if you don’t see the Productivity panel, you might need to enable it. To do so, fi rst make 

sure the Assemble tab is active, then right-click anywhere on the Ribbon menu and choose Show 

Panels, and then select Productivity from the list.

 4. Click the Assemble tab, and then click the drop-down on the Productivity panel and 

select Degree Of Freedom Analysis.

 5. Select Animate Freedom at the bottom of the dialog box.
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 6. Click 8_002 in the list. Watch it rotate in the free axis, demonstrating its DOF.

 7. Click 8_003 in the list. Watch it rotate and move up and down, demonstrating its DOF.

 8. Click 8_004 in the list. Watch it rotate and slide along the face of the plate in two direc-

tions, demonstrating its DOF.

These tools can be very helpful when you are trying to determine the assembly relationships 

applied to components in an existing assembly. In addition to animating DOF, you can also just 

click and drag on a part to see how it can move. In either case, you might fi nd that leaving the 

DOF triads turned on will help you as you learn how assembly relationships work and are cre-

ated. You can close the current fi le without saving changes and continue on to the next section.

Grounded Components
A component can be grounded in place so that it cannot move or rotate unintentionally. A 

grounded component is fully constrained and has 0 degrees of freedom. Every assembly should 

have at least one grounded component so that it will be stable. If components are not grounded, 

the assembly can become misaligned from the x-, y-, and z-axes and will cause problems when 

you try to detail the assembly in the drawing environment. You can ground or unground any 

component in an assembly by right-clicking it and selecting Grounded from the context menu.

Placing Components in an Assembly

To place components in an assembly, you can use the Place button found on the Assemble tab and 

then browse to locate the component. To ground a component while you place it, you can right-click 

during the placement preview and choose Place Grounded At Origin.

Additionally, you can drag part and assembly fi les from Windows Explorer and drop them into 

the assembly. To place additional instances of components already in the assembly, you can copy 

and paste components from the graphic window or simply click and drag them from the browser.

In certain workfl ows where parts are placed into the assembly in the correct position and 

orientation to begin with, all components can be grounded. This is done automatically when 

an assembly is created from a multi-body part using the Make Components tool. If a particular 

component needs to be adjusted, it can be ungrounded and then constrained using Assembly 

constraints or assembly connections.

The ground-all strategy can also be used to rebuild assemblies that have a great many errant 

Assembly constraints resulting from major uncontrolled changes. For instance, if you opened an 

assembly that has 50 constraints and of those 42 have errors, you might be better off to select all 

the components and ground them in place. Next, you would expand the Relationships folder 

in the browser, and then select all of the relationships with errors and delete them. You could 

then leave everything grounded or unground and reconstrain them one at a time in order to fi x 

the assembly.

How the Constraint Tool Works
In Inventor, Assembly constraints are used to attach parts or subassemblies together, creating 

assembly relationships between the components and therefore defi ning the way they fi t together 
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based on the selection of faces, edges, or vertices and user-defi ned parameters. In general prac-

tice, the function of constraints follows real-world assembly techniques where fasteners, adhe-

sives, and welds attach one component to another.

There are seven basic types of constraints in Inventor. Most of the constraint types have mul-

tiple solution types that can be used to achieve the result you are looking for. Here is a list of the 

constraint types and their solutions:

Mate constraints position components face to face or adjacent to one another.

 ◆ The Mate solution positions selected faces normal to one another, with faces coincident; 

imagine two plates butted together.

 ◆ The Flush solution aligns components adjacent to one another with faces fl ush; imagine 

two plates fl ushed along an outside corner.

Angle constraints position two components at a specifi ed angle to defi ne a pivot point.

 ◆ The Directed Angle solution always applies the right-hand rule to selected faces or 

edges.

 ◆ The Undirected Angle solution allows either orientation and is used in situations where 

component orientation fl ips.

 ◆ The Explicit Reference Vector solution defi nes the direction-of-rotation axis.

Tangent constraints position two components to contact at a point of tangency.

 ◆ The Inside solution positions the fi rst selected component inside the second selected 

component at the tangent point.

 ◆ The Outside solution positions the fi rst selected component outside the second selected 

component at the tangent point.

Insert constraints are a combination of a face-to-face Mate constraint between planar faces 

and a Mate constraint between the axes of the two components.

 ◆ The Opposed solution reverses the mate direction of the fi rst selected component.

 ◆ The Aligned solution reverses the mate direction of the second selected component.

Symmetry constraints position two components symmetrically to both sides of a selected 

plane or planar face. The Symmetry constraint is typically used in conjunction with other 

assembly relationships.

Rotation constraints allow one component to rotate based on the selection of a second 

component.

 ◆ The Rotation solution allows the fi rst selected component to rotate in relation to another 

component using a specifi ed ratio; imagine two gears.

 ◆ The Rotation-Translation solution allows the fi rst selected component to rotate as it 

translates the face of another component; imagine a rack and pinion.

Transitional constraints specify the relationship between a cylindrical component and a 

contiguous set of faces on another component, such as a cam in a slot.
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When using constraints, a minimum of two constraints are required to fully constrain two 

components together so that their relationship is fully defi ned. Underconstrained components 

allow motion in the unconstrained axis or plane. Components that are fully contained within a 

subassembly will not fi gure into the constraint analysis when the top-level assembly is opened 

or modifi ed, so it is typically best for the performance of your assembly fi les to fully constrain 

all components that are not meant to be moveable. See “Working with Constraints” later in the 

chapter for more information.

How the Joint Tool Works
The Joint tool allows you to defi ne the working relationship between a pair of components with 

a single joint relationship. With the Constraint tool you might create multiple constraint rela-

tionships to remove degrees of freedom; by contrast, you might achieve the same results with 

just one joint relationship, by defi ning the degrees of freedom you intended to remain. Although 

you can achieve the same result using the Constraint tool that you can with the Joint tool, the 

Joint tool results in fewer assembly relationships, which can be much easier to manage later.

There are six basic types of joints in Inventor, as well as an Automatic option that will choose 

a type based on the selected inputs. Here is a list of the joint types and options:

The Automatic joint option will create either a Rigid, Rotational, Cylindrical, or Ball joint, 

depending on the geometry of the selections.

Rigid joints position a component in place and remove all degrees of freedom. This joint 

type is used for glued, welded, or bolted joints that do not move.

Rotational joints position a component in place and create one rotational degree of freedom. 

This joint type is used for hinged joints and levers, and it can be created with a specifi ed 

limit value.

Cylindrical joints position a component in place and create one translational and one rota-

tional degree of freedom. This joint type is used for creating a joint between a shaft and a 

hole, for example, and can be created with a specifi ed limit value.

Ball joints position a component in place and create three rotational degrees of freedom. 

This joint type is used for socket and ball joint type joints and can be created with a specifi ed 

limit value.

Slider joints position a component in place and create one translational degree of freedom. 

This joint type is used for hinged joints, levers, and so on and can be created with a specifi ed 

limit value.

Planar joints position a component in place and create two translational and one rotational 

degree of freedom perpendicular to the planar face. This joint type is used when one object 

will move along a planar surface such as a conveyor, and it can be created with a specifi ed 

limit value.

See “Working with Joint Relationships” later in the chapter for more information.

Working with Constraints
As mentioned, there are several types of constraints available for use in an assembly. In order 

to know which one to use and when, you should be familiar with each. Keep in mind, however, 
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that certain constraint types are used more often than others. In the following pages, you will 

explore the creation of the various constraint types.

The Mate Constraint

The Mate constraint type is made up of two solutions: Mate and Flush. Figure 8.3 compares the 

two solutions. On the far left the selections are shown, in the middle the Mate solution is shown, 

and on the right the Flush solution is shown.

Figure 8.3

Mate and Flush 

solutions

To explore the Mate constraint options, you will open a simple fi xture assembly and assemble 

two plates to match the completed assembly next to it:

 1. Click the Get Started tab, and choose Open.

 2. Browse for the fi le mi_8a_002.iam located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

 3. Select the View tab, and click the Degrees Of Freedom button to turn on the DOF triad for 

each underconstrained part.

 4. From the Assemble tab, click the Constrain button (or press C on the keyboard).

 5. In the Place Constraint dialog box, ensure that the Assembly tab is active and the Mate 

button is selected for the type. Make sure the Preview check box is selected and the 

Predict Offset And Orientation check box is cleared.

Within the Place Constraint dialog box, you have three check boxes:

Pick Part First  This check box, indicated by the small red cube, is useful when parts are 

partially obscured or are positioned in such a way that clicking a face or edge is diffi cult. 

This option requires you to fi rst select the component, and then fi lters the selectable 

geometry to that single component.

Predict Offset And Orientation  This button measures the distance between the select-

ed faces, allowing you to eyeball a part placement and then retrieve the distance. If the 

check box is not selected, a default of 0 is entered for the offset.

Show Preview  This check box, denoted by the eyeglasses icon, controls whether the 

selected components will adjust position or orientation so you can review the constraint 

before clicking the Apply button or the OK button to actually create it.

 6. For Selection 1, click the orange face on the part with the triangular feature. Watch the 

on-screen highlights to be sure you select the face and not an edge. It may be helpful to 

zoom in.
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 7. For Selection 2, click the circular face on the base part.

You should see the part “snap” into place based on your selection points. This is just a 

preview of the constraint and is controlled by the Preview check box. Notice that the fi rst 

and second geometry-selection buttons are color-coded in the Place Constraint dialog 

box. Also notice that as you select faces, they are shaded to match the fi rst and second 

geometry selections.

 8. To adjust the constraint selection, press the Selection 2 button in the Place Constraint dia-

log box. This removes the previous selection (the circular face) and allows you to reselect 

the mating face.

 9. For the reselection, click the orange face on the base plate.

 10. Click Apply to place the Mate constraint on the two parts.

 11. Select the yellow face of the base plate and the yellow face of the side plate for Selection 1 

and 2 (again, ensure that you are selecting faces and not edges).

 12. You should see the two yellow faces mate together in a way that is not what you want. 

Click the Flush button in the Solutions area of the dialog box, and you should see the pre-

view update to give a more desirable result.

 13. Click the OK button to place the Flush constraint and close the dialog box.

At this point, the DOF triad should have only one remaining arrow, indicating that all of 

the other DOF triads have been removed as the constraints were added.

 14. Click and drag the part with the triangular feature and note that it will slide in the direc-

tion indicated by the DOF symbol, and only in that direction.

You can click and drag the part and see that it slides back and forth in the unconstrained 

direction indicated by the arrow. Leave this fi le open and continue to the next section, discuss-

ing the Free Rotate and Free Move tools.

Using Free Rotate and Free Move

Next, you will place the fi nal constraint required to fully assemble the two parts. But before plac-

ing the remaining constraint, it may be helpful to rotate the part so that you can easily select the 

required faces. To do so, you will use the Free Rotate tool. The Free Rotate tool allows you to rotate 

a selected component and rotate just it in the assembly. The Free Rotate tool suspends any assem-

bly relationships currently involving the selected component to allow it to be rotated. The assembly 

relationships are reactivated when the Update button is clicked or when some other action, such as 

placing another constraint, forces an update. The Free Move tool works the same as the Free Rotate 

tool regarding assembly relationships. Continue from the previous step to see how this works:

 1. From the Assemble tab, click the Free Rotate button.

 2. Select the part with the triangular feature and you will see the rotate “globe” appear.

 ◆ For free rotation, click inside the rotate globe and drag in short strokes.
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 ◆ To rotate about the horizontal axis, click the top or bottom handle of the rotate globe 

and drag vertically.

 ◆ To rotate about the vertical axis, click the left or right handle of the 3D rotate symbol 

and drag horizontally.

 ◆ To rotate fl at to the screen, place your cursor over the edge of the globe until the sym-

bol changes to a circle, and then click and drag around the globe.

 3. Spin the part so you can see the purple face.

 4. Right-click and choose Done to exit the Free Rotate tool.

 5. From the Assemble tab, click the Constrain button.

 6. Select the purple face on each part, and then click the OK button.

This will fully constrain the part and remove the fi nal DOF arrow from the display. You can 

continue to experiment with Assembly constraints on your own by copying and pasting multi-

ple instances of the parts and then constraining them together, or you can close this fi le without 

saving changes and continue to the next section to explore more constraint options.

Editing and Deleting Constraints

Each of the constraints you placed in the previous steps was added to the browser under the 

parts involved. You can access these constraints to make changes or delete them by expanding 

the browser node for one of the components. In the following steps, you will edit and delete a 

constraint:

 1. Click the Get Started tab, and choose Open.

 2. Browse for the fi le mi_8a_003.iam located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

 3. Expand the plus icon next to both of the parts in the browser to reveal the constraints 

listed below them. There are two Mates and one Flush constraining these two parts.

 4. Right-click the Flush constraint and select Edit.

You’ll notice that the options are much like those used to create the constraint. You can 

reselect selection inputs 1 and 2, modify the solution from Flush to Mate, or even change 

the type. In this case you will add an offset value.

 5. Enter –10 mm in the Offset input box. If the preview button is selected, you should see 

the part adjust to preview the fl ush offset.

 6. Click the OK button to accept the edit.

 7. Click the Flush constraint in the browser again. Notice that it now displays the offset 

value.
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The Show and Hide Relationships Tools

In addition to locating constraints in the browser, you can use the Show Relationships tool to 

select a component and locate all of the assembly relationships that involve it. Once the relation-

ship glyphs are shown, you can right-click any of them and choose from a number of options, such 

as Edit, Delete, Suppress, and so on. You can then use the Hide Relationships tool to turn off  the 

display of the relationship glyphs in the graphics area.

If any assembly relationships contain errors, you can use the Show Sick Relationships tool to fi nd 

them quickly.

 8. At the bottom of the browser is an input box where you can adjust the offset without 

needing to bring up the edit dialog box. Type 12 mm and press the Enter key on the key-

board. The part will adjust to the new offset.

 9. Double-click the icon next to the Flush constraint in the browser.

 10. An Edit Dimension box appears, offering another way to edit the offset parameter for this 

Flush constraint.

 11. It is often helpful to name constraint offset parameters for use later on. Type Block_
Offset = 40 mm into the box, and then click the green check mark button (or press the 

Enter key).

 12. On the Manage tab, click the Parameters button.

 13. In the resulting dialog box, you’ll see the Block_Offset parameter in the list. Note that 

the other two parameters are for the Mate constraints. Click the Done button to exit the 

Parameters dialog box.

 14. Select the View tab and click the Degrees Of Freedom button to turn on the DOF triad for 

each underconstrained part. In this case, no triads appear, because the assembly is cur-

rently fully constrained.

 15. Right-click the Flush constraint in the browser and choose Delete. You’ll now see a DOF 

arrow showing you that the part is free to slide along one axis.

 16. Click and drag the part to see it move in its free axis.

 17. From the Assemble tab, click the Constrain button.

 18. In the Place Constraint dialog box, click the Predict Offset And Orientation check box 

(fi nd it next to the Preview check box).

 19. Set the solution to Flush and then select the yellow faces of the two parts.

 20. Note the offset value reports the current distance between the two yellow faces. Enter 

Block_Offset = 20 mm, and then click the OK button.

Mate and Flush constraints will likely make up a majority of the constraint types you edit 

and create. Take the time to master these constraints, and you will fi nd the other constraint 



ASSEMBLY RELATIONSHIPS | 365

types much easier to learn. You can close this fi le without saving changes. If you’d like more 

practice with Mate and Flush constraints, you can open the fi les mi_8a_104.iam, mi_8a_105

.iam, mi_8a_106.iam, and mi_8a_107.iam (located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder) and assemble them using the concepts you just learned. Use 

the assembled parts as an example to put together the unassembled parts in each of these fi les.

Mate to Edges, Centerlines, and Vertices

In addition to selecting faces for creating Mate constraints, you can use edges, centerlines, and 

vertices as selections. When using edges or centerlines, keep in mind that you are defi ning a 

different number of degrees of freedom than when using faces; therefore, the results can be 

quite different. It is also important to understand that edges and centerlines have no negative 

or positive value, and therefore edge-to-edge type constraints are not a good choice for creating 

mate offsets. Instead, use a face-to-edge mate in those cases.

Depending on the available geometry, you will often need to use the Select Other drop-down 

menu tool to cycle through the available selections to select an edge or vertex. To use the Select 

Other tool, hover over a selection and wait for the Select Other drop-down menu to appear. 

Then select the available geometry from the list. Figure 8.4 shows the Select Other tool being 

used to select a center point on the left, an axis in the center, and a cylindrical face on the right.

Figure 8.4

Using the Select 

Other tool

The Angle Constraint

The Angle constraint permits three solutions within this constraint type. The solutions are 

Directed Angle, Undirected Angle, and Explicit Reference Vector. The Directed Angle solution 

always applies the right-hand rule, meaning the angle rotation will function in a counterclock-

wise direction.

The Undirected Angle allows either counterclockwise or clockwise direction, resolving situa-

tions where a component orientation will fl ip during a constraint drive or drag operation.

The Explicit Reference Vector solution allows for the defi nition of a z-axis vector by adding 

a third click to the selection. This option will reduce the tendency of an Angle constraint to fl ip 

to an alternate solution during a constraint drive or drag. Figure 8.5 illustrates the selections 

required for this solution.
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Figure 8.5

Explicit reference 

vector

1

3
2

Follow these steps to explore the Angle constraint:

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for the fi le mi_8a_007.iam located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

 3. From the Assemble tab, click the Constrain button (or type C on the keyboard).

 4. In the Type area of the Place Constraint dialog box, select the Angle button.

 5. In the Solution area, click the Directed Angle button.

 6. For Selection 1, click the large face of the painted board that the hinges are mounted on.

 7. For Selection 2, click the large face of the unpainted board that the hinges are 

mounted on.

 8. Enter 90 into the Angle input box, and note that the preview displays as expected.

 9. Click the Selection 1 and 2 buttons to clear them, and then select the unpainted board for 

Selection 1 and the painted board for Selection 2. Pay attention to which selection button 

is pushed in as you select to ensure that you get this right.

Place Assembly Constraints Using Alt-Drag

Rather than using the Place Constraint dialog box, you can press and hold the Alt key and then 

drag a component into position. Constraints are inferred based on the type of geometry selected. 

Th e constraint is previewed in the graphics area as you drag over the components involved. To set 

a specifi c constraint, release the Alt key and enter one of the following shortcut keys. You can press 

the spacebar to fl ip the constraint solution, from Mate to Flush, for example.

 ◆ M or 1 changes to a Mate constraint.

 ◆ A or 2 changes to an Angle constraint.

 ◆ T or 3 changes to a Tangent constraint.

 ◆ I or 4 changes to an Insert constraint.

 ◆ R or 5 changes to a Rotation motion constraint.
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 ◆ S or 6 changes to a Translation motion (slide) constraint.

 ◆ X or 8 changes to a Transitional constraint.

To see the Alt-drag method in action, select the Get Started tab, and click the Show Me Animations 

button. Click the Assemblies – Constraints link in the list and then choose Alt-drag Shortcut 

Animation from the next list.

You will see from the result that the 90-degree angle is dependent on the selection order. 

In this case, you could enter –90 to fl ip the angles also, but had you selected edges rather 

than faces, entering –90 would not work. Next, you will explore the Undirected Angle 

solution.

 10. To clear your selections and input before continuing, click the Cancel button to exit the 

Place Constraint dialog and then click the Constrain button to bring it back up.

 11. In the Type area of the Place Constraint dialog box, click the Angle button, and then in 

the Solution area, click the Undirected Angle button.

 12. Select the two faces and enter 90 (for 90 degrees) again. You’ll note the preview updates 

as expected.

 13. Click the Selection 1 and 2 buttons to clear them and then select the unpainted board for 

Selection 1 and the painted board for Selection 2. Pay attention to which selection button 

is pushed in as you select to ensure that you get this right.

You will notice that the angle is not dependent on the selection order. And if you try 

entering –90 for the angle input, you’ll see that the negative value does not change the 

angle. This option can be more stable for use in setting up angles that will be changed 

in confi gurations, animations, and so on, but it is still largely dependent on the other 

constraints in the assembly. If the constraints holding the hinge to the boards were modi-

fi ed, the Undirected Angle constraint may need to be adjusted. Next, you will explore the 

Explicit Reference Vector solution to see that it allows you to more fully defi ne the angle.

 14. Click the Cancel button to exit the Place Constraint dialog and then click the Constrain 

button to bring it back up.

 15. In the Type area of the Place Constraint dialog box, click the Angle button, and then in 

the Solution area, ensure that the Explicit Reference Vector button is selected.

 16. For Selection 1, click on the large face of the painted board that the hinges are mounted on.

 17. For Selection 2, click on the large face of the unpainted board that the hinges are 

mounted on.

 18. Run your cursor over the cylindrical faces in the center of either hinge. You should see 

the direction arrow fl ip back and forth depending on which face is highlighted.

 19. When you fi nd a face that points the arrow out away from the center of the assembly, 

click it. This selects the center axis of the hinge pivot and therefore defi nes the entire 
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Angle constraint without relying on other existing constraints to establish the vector 

reference.

 20. Enter 90 degrees.

You’ll note that the preview updates incorrectly, fl ipping the assembly down and causing 

an interference situation. To correct this, you can enter a negative angle or you can simply 

reselect Selection 3 so that it points the other way.

 21. Click the Selection 3 button again to clear it, and then fi nd a face that makes the arrow 

point in toward the center of the assembly and select it. You’ll notice that the preview 

updates to fl ip the assembly up, as desired.

You may be wondering why there are so many angle options. Originally Inventor did not 

include all three of these angle solutions, and options were added to improve the predictabil-

ity of Angle constraint updates. At this point, though, if you use the default Explicit Reference 

Vector solution, your Angle constraints will update predictably.

As a fi nal note on Angle constraints, you will probably fi nd that using edges rather than faces 

for Angle constraints will provide more predictable results, particularly when setting up con-

straints to be used in creating positional variations for animation or documentation purposes. 

You can close this fi le without saving changes and continue on to the next section.

Using the Right-Hand Rule

A good way to visualize the Explicit Reference Vector command is to use the right-hand rule. 

Take your right hand and make a “gun” shape with your index fi nger pointing out and your thumb 

pointing up. Now point your middle fi nger to the left, 90 degrees to the index fi nger. Your hand 

will then be making the three major axes. You can then use your thumb to determine the positive 

axes of the cross product of the x- and y-axes (the index and middle fi ngers).

The Tangent Constraint

A Tangent constraint results in faces, planes, cylinders, spheres, and cones coming in contact at 

a point of tangency. Tangency can exist inside or outside a curve, depending on the direction of 

the selected surface normal. The number of degrees of freedom a Tangent constraint removes 

depends on the geometry. When a Tangent constraint is applied between a cylinder and a pla-

nar face, the constraint will remove one degree of linear freedom as well as one degree of rota-

tional freedom from the set.

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for the fi le mi_8a_008.iam located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

 3. From the Assemble tab, click the Constrain button (or type C on the keyboard).

 4. In the Type area of the Place Constraint dialog box, click the Tangent button.
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 5. For Selection 1, click the face of one of the sphere-shaped ball bearings.

 6. For Selection 2, click the face of one of the half-sphere cutouts in the block.

 7. Note that the preview sets the bearing to the outside. To fi x this, click the Inside button in 

the Solution area of the Place Constraint dialog box.

 8. Click the Apply button and then create an identical Tangent constraint for the second ball 

bearing.

 9. Create another Tangent constraint, but this time use the Outside solution and select the 

cylinder of the shaft and the spherical face of one of the ball bearings. Click the OK but-

ton to create the constraint and exit the Place Constraint dialog box.

 10. Before creating the last Tangent constraint, click the shaft, and pull it up toward the top of 

the ball bearing it is tangential with. This is just so that the next Tangent constraint will 

not solve to the lower hemisphere and run the shaft into the block.

 11. Create another Tangent constraint, again using the Outside solution, and select the cylin-

der of the shaft and the spherical face of one of the ball bearings.

Tangent constraints are fairly straightforward, and although they are not the most com-

mon constraint type to use, they are often the only one that will allow you to get the result you 

need when working with cylinders, spheres, and curved faces. You can test the function of the 

shaft and bearing constraint set by clicking and dragging on the shaft to see it rotate, and then 

you can close the fi le without saving changes. Figure 8.6 shows the placement of a Tangent 

constraint.

Figure 8.6

Tangent constraints

The Insert Constraint

The Insert constraint is probably the best choice for inserting fasteners and other cylindrical objects 

into holes or for constraining any parts where circular or cylindrical geometries are to be con-

strained to one another. A single Insert constraint will replace two Mate constraints (one along the 

edge and one through the centerline), retaining one rotational degree of freedom. Options for the 

Insert constraint are Opposed and Aligned. The Insert constraint also allows for specifying offset 

values between components. Figure 8.7 shows common uses of Insert constraints.
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Figure 8.7

Insert constraints

Follow these steps to explore the Insert constraint:

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for the fi le mi_8a_009.iam located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

 3. From the Assemble tab, click the Constrain button (or type C on the keyboard).

 4. In the Type area of the Place Constraint dialog box, select the Insert button.

 5. Select the bottom edge of one of the screw heads for Selection 1. Notice that the highlight 

shows that the edge and the centerline are selected.

 6. Select the top edge of one of the eight holes on the plate for Selection 2.

 7. Toggle the solution button to see the difference in the two solutions, and then set the 

solution to Opposed.

 8. Enter 2 mm in the Offset input box, and then click the Apply button.

 9. Select the edge of one of the washers and then the bottom edge of the screw head you just 

inserted to place and apply another Insert constraint.

 10. Set another Insert constraint using the edge of the yellow face of one of the boss features 

on the end fl ange and one of the nuts. Use the Aligned solution to fl ip the nut so it is set 

down inside the boss feature.

 11. Use Insert constraints to place the blue cover on the base part by selecting the rounded 

corners.

You can continue to practice with the remaining hardware. Use Copy and Paste to add more 

instances if you’d like. When you’ve fi nished, you can close the fi le without saving changes. 

For further practice with insert constraints, have a look at mi_8a_109.iam and mi_8a_110.iam. 

You can investigate the constraints used in the assembled versions of these models to help if 

needed.
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Minimum Distance Using the Measure Tool

You can fi nd the minimum distance between two assembly components by using the Measure tool. 

To access the Measure tool, select the Inspect tab and select Measure Distance from the Measure 

panel. Click the Priority drop-down box in the Measure Distance tool and set it to Part Priority. 

Next, select the fi rst part and then select the second part. Th e returned value is the minimum 

distance between the two parts.

The Symmetry Constraint

The Symmetry constraint, shown in Figure 8.8, positions two components symmetrically to each 

side of a plane or planar face. When one of the components is moved or its orientation changed, 

the other component maintains its symmetrical relationship based on the existing degrees of 

freedom of each component.

Figure 8.8

Symmetry 

constraint

Follow these steps to explore the Symmetry constraint:

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for the fi le mi_8a_130.iam located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

The goal for this assembly is to create a symmetry relationship in order to maintain the 

same distance for the number one and number two bolts as they are threaded into the 

yellow receiver part. Currently the assembly has a number of constraints in place to help 

defi ne the mechanism; however, there is still something missing. If you click and drag 

on the number one screw, you’ll see that the behavior is not quite correct. If you click and 

drag on the yellow receiver part, you’ll see something closer to the correct behavior, but 

the bolts do not maintain a symmetrical distance. You’ll add the missing constraint to 

resolve this.

 3. From the Assemble tab, click the Constrain button (or type C on the keyboard).
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 4. In the Type area of the Place Constraint dialog box, select the Symmetry button.

 5. Select the blue face of one of the bolt heads for the fi rst selection.

 6. Select the blue face of the other bolt head for the second selection.

 7. For the third selection, choose the visible work plane in the center of the yellow 

receiver part.

 8. Click the OK button to create the constraint.

 9. Now you can click and drag bolt number one to see that the two bolts maintain a sym-

metrical relationship on each side of the selected work plane.

Symmetry constraints are a quick and easy way to set up your assembly to hold components 

equidistant to a planar face or work plane or maintain a symmetric orientation. In this particu-

lar assembly there are two motion constraints in place that allow the assembly to perform the 

threading action. In the next sections you’ll explore these constraints. You can close this fi le 

without saving changes in order to continue.

Within the Place Constraint dialog box are the Motion tab and the Translational tab. From 

the Motion tab, you can add Rotation constraints and Rotation-Translation constraints. A Rotation 

constraint is typically placed between two components, such as gears, simulating a ratio-based 

rotation. Rotation-Translation constraints allow a linear distance and revolution ratio to be 

applied for component pairs such as rack and pinion sets. From the Translational tab, you create 

constraints between a rotating and nonlinear translating face, such as cams and followers.

The Rotation Constraint

To create a simple Rotation constraint, fi rst place two components constrained around their 

axes. Neither component should be grounded; instead, they should be constrained to allow rota-

tion around the axes. The Rotation constraint applies a Forward or Reverse solution to the two 

components, along with a ratio that will determine rotation speeds, as shown in Figure 8.9.

Figure 8.9

Rotation constraint 

options

In the following steps you will create a reverse Rotation constraint on a small cog set:

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for the fi le mi_8a_010.iam located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder, and click the Open button.
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 3. From the Assemble tab, click the Constrain button (or type C on the keyboard).

 4. Click the Motion tab in the Place Constraint dialog box.

 5. In the Type area of the Place Constraint dialog box, select the Rotation button.

 6. For Selection 1 click the yellow face on the large cog, and for Selection 2 click the yellow 

face on the small cog.

 7. In the Solution area, click the Reverse button.

 8. Note that the Ratio is automatically set to 3 ul (ul means unitless). You could enter any 

value you want, but in this case you’ll leave it at 3 based on the selected geometry. You 

should be aware had you selected the cogs in the opposite order, the ratio would be 0.333, 

the reciprocal of its current value. Click the OK button to create the Rotation constraint.

Currently, the assembly is fully constrained and will not rotate. This is because of the 

Mate constraint named Alignment Mate, which has been placed on the XZ origin planes 

of each cog. The purpose of this Mate constraint is simply to line up the cogs in their start 

position. To let the Rotation constraint work, the mate must be suppressed or deleted.

 9. Locate the Alignment Mate constraint in the browser. You can do so by expanding either 

of the cogs in the browser.

 10. Right-click the Alignment Mate constraint and choose Suppress. The constraint will now 

be grayed out and will not calculate against the assembly.

 11. Click and drag either of the cogs to rotate them.

If you start the rotation with both yellow faces showing and count the number of times the 

small cog rotates before the yellow face on the large cog comes back around, you will see it 

make three revolutions to every one of the large cogs, as specifi ed by the ratio in the constraint 

input. You can close the fi le without saving changes and continue to the next set of steps, where 

you will create a Rotation-Translation constraint.

The Rotation-Translation Constraint

In the following steps you will create a Rotation-Translation constraint as would be used to con-

strain a rack and pinion gear set:

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for the fi le mi_8a_011.iam located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

 3. From the Assemble tab, click the Constrain button (or type C on the keyboard).

 4. Click the Motion tab in the Place Constraint dialog box.

 5. In the Type area of the Place Constraint dialog box, select the Rotation-Translation button.

 6. Hover over any of the component geometry and notice that the selection glyph displays 

a rotation arrow, indicating it is looking for the rotational selection. Selection order is 

important in this case. For Selection 1, click the yellow face on the cog.
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 7. For Selection 2, in the Solution area click along the bottom edge of the rack. Be certain to 

select the edge, not the face. Although there is nothing preventing you from selecting the 

face or anything indicating that it is not the correct selection, the constraint will simply 

not work if the face is selected.

 8. Note the value added to the Distance input box. This is the total travel of the rack for one 

revolution of the cog. This value is initially calculated from the selections, but you can 

enter your own value as required. In this case, the number is not a whole number due to 

the mix of Imperial and metric dimensions used in this model. Click the OK button to 

create the constraint.

Figure 8.10 shows the constraint selections.

Figure 8.10

Rotation-

Translation 

constraint options

Currently, the assembly is fully constrained and will not rotate. This is because of the 

Mate constraint named Start Point Mate, which has been placed on the rack and cog. To 

let the Rotation-Translation constraint work, the mate must be suppressed or deleted.

 9. Locate the Start Point Mate constraint in the browser. You can do so by expanding the 

rack in the browser.

 10. Right-click the Start Point Mate and choose Suppress. The constraint will now be grayed 

out and will not calculate against the assembly.

 11. Click and drag the rack to see the rotation and translation take place.

Although motion constraints are easy to place, be aware that often the real work is in the cal-

culations to create components with the correct geometry beforehand. If you have a need to cre-

ate a lot of gears, you’ll want to explore the gear generator found in the design accelerator tools. 

For now, you can close the fi le without saving changes and continue to the next section.

Transitional Constraints

Transitional constraints allow the movement of an underconstrained component along a path in 

a separate part. To create a Transitional constraint, you fi rst select a moving face on the under-

constrained component. Then you select a transitional face or edge on a fully constrained or 

grounded part. Figure 8.11 illustrates a cam and follower with a Transitional constraint applied.
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Figure 8.11

A Transitional 

constraint

Follow these steps to explore the Transitional constraint:

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for the fi le mi_8a_012.iam located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

 3. From the Assemble tab, click the Constrain button (or type C on the keyboard).

 4. Click the Transitional tab in the Place Constraint dialog box.

 5. For Selection 1, click the yellow face on the follower wheel. Note that the fi rst selection 

must be the moving face.

 6. For Selection 2, click the orange face on the cam. Note that this selection must be the 

translational face.

 7. Click the OK button to create the constraint.

 8. Click and drag the cam and rotate it around the axis to see the assembly in action.

Components used in Transitional constraints must always be in contact for them to work; 

therefore no offsets are permitted. The translational face (in this case the cam) can be any combi-

nation of fl at, arced, or spline-defi ned faces, but it is generally best to avoid sharp corners. When 

fi nished examining the Translational constraint functionality, you can close the fi le without sav-

ing changes.

Additional Constrain Tools and Options
In addition to the basic constraint types and options, there are a number of other tools and 

options to be aware of. These tools and options are covered in the following pages.

Using the Assemble Tool to Place Constraints

The Assemble tool allows you to move a component into place and place a constraint based on the 

selected geometry. This tool is designed to select a component and then fully constrain it. When 

using the Assemble tool, you select the component you want to move into place fi rst and then you 

select the component you want to constrain to. Because of this, you can constrain only one com-

ponent at a time with this tool. To constrain a second component, you must click the OK button to 

exit the Assemble tool and then select the Assemble button again, or right-click and select Repeat 

Assemble.



376 | CHAPTER 8 ASSEMBLY DESIGN WORKFLOWS

As constraints are placed, the geometry involved is left highlighted on-screen. These new 

constraints are not created until you exit the Assemble tool by clicking the OK button. If any 

confl icts with existing constraints are created, you are presented with the Assemble Constraint 

Management dialog box. You can fi nd options in this dialog box to resolve the confl icts.

You can open the fi le mi_8a_013.iam to explore the Assemble tool, following these general 

steps:

 1. From the Assemble tab, click the Assemble button, using the Relationships panel 

drop-down.

 2. Select some geometry on the component to be moved into place.

 3. Select some geometry on the component that is intended to stay in place.

 4. Enter values such as offsets or angle values if needed.

 5. If necessary, change the solution type (from Mate to Flush, for example).

 6. From this point you can do any of the following:

 ◆ Click the Apply button and continue to defi ne other constraints for the selected 

component.

 ◆ Click the OK button to create the constraints based on the previous selections and exit 

the Assemble tool.

 ◆ Click the Undo button to delete the current selections and then continue defi ning 

constraints.

Relationship Audio Notification

When you place a relationship in an assembly, Inventor makes a sound at the time of the preview 

or at the time of the constraint creation, depending on the preview option at the time. You can 

disable this sound by selecting the Tools tab, clicking Application Options, and then selecting 

the Assembly tab. Uncheck the Relationship Audio Notifi cation check box to disable the sound.

You can change the sound by replacing the default sound fi le with one of your choice. The 

sound fi le is Connect.wav and can be found in the C:\Program Files\Autodesk\Inventor 

2014\Bin folder (assuming that is the install path).

Constraint Sets

Constraint sets allow you to constrain two components together using their user coordinate sys-

tems (UCSs). You defi ne the UCS in the part or subassembly fi le fi rst, and then place constraints 

on the coordinate system planes and axes rather than the component geometry.

You can open the fi le mi_8a_014.iam to explore constraint sets, following these general steps:

 1. From the Assemble tab, click the Constrain button.

 2. In the Place Constraint dialog box, click the Constraint Set tab.

 3. Expand the browser nodes for both components so you can see the UCS features listed.
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 4. Select UCS1 in each part for Selections 1 and 2.

 5. Click the OK button to create a set of constraints between the two UCS triads.

Constraint sets can often be helpful when components are modeled referencing a common 

datum set in each component. When fi nished creating the Constraint Set, you can close the fi le 

without saving changes.

Constraint Limits

Constraint limits allow you to defi ne minimum and maximum constraint values so components 

can move freely within the limits but not beyond them. You can imagine a model of a door 

hinge. You might want the hinge to swing from 0 to 270 degrees, but not outside of that range or 

the hinge might interfere with itself.

You can open the fi le mi_8a_015.iam to explore constraint limits. In this assembly there are 

four parts. These would be four subassemblies in reality, but for the sake of simplicity, they 

have been condensed into part fi les. The router base is grounded in place, and the y- and z-axis 

assemblies have been fully constrained with constraint limits, so they are free to slide within the 

bounds of the bearing rods and gantry uprights. You can click and drag on the z-axis assembly 

to see how it behaves in a realistic manner thanks to the existing constraint limits. But if you 

click on the x-axis assembly, you will see that it does travel along the bearing rods realistically, 

but it can continue sliding through the router base and beyond. To fi x this, you will add a con-

straint set to the x-axis assembly, limiting its travel to a more realistic result:

 1. From the Assemble tab, click the Constrain button (or type C on the keyboard).

 2. Leave the constraint Type set to Mate, and set the solution to Flush.

 3. Select the two yellow faces for Selections 1 and 2, making sure to select the large yellow 

face on the router base for Selection 1 and the smaller yellow face on the x-axis assembly 

for Selection 2.

 4. Click the >> button to expand the dialog box.

 5. Click the Maximum and Minimum check boxes.

 6. Enter -10 mm for the maximum value.

 7. Enter -395 mm for the minimum value.

 8. Click the Use Offset As Resting Position check box.

 9. Enter -150 for the offset value (located back toward the top of the dialog box).

 10. Enter X Travel in the Name input box, and then click the OK button to create the 

constraint.

 11. Click the x-axis assembly, and you will see that it now stops before running through the 

other components.

Figure 8.12 shows the constraint limit being created.
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Figure 8.12

Placing constraint 

limits

You can drag the x-axis assembly to its minimum and maximum limits, but when you let go 

it returns to the resting value you set in the dialog box. Keep in mind that you are not required 

to use the resting position option. If no resting value is used, the assembly will stay where it was 

last placed, which is the behavior exhibited by the z-axis assembly.

Constraint limits are a great tool to use in the setup of free-moving components to get them 

to behave predictably. However, you should be aware that there may be a small performance hit 

when using too many of these at once. So keep that in mind as you use them. You can close the 

assembly without saving changes.

Driving Relationships

It is often desirable to simulate motion by driving a relationship through a beginning position 

and an ending position to confi rm the intent of the design. In general, Offset and Angle con-

straints may be selected to drive components within an assembly. To accomplish this, simply 

right-click the desired constraint and select Drive (as shown in Figure 8.13).

You can open the fi le mi_8a_016.iam to explore the drive constraint options. If you expand 

the Z-Axis Assembly node, you will fi nd two constraints labeled Drive Me. When you right-

click a constraint and choose Drive, the Drive (Angle Constraint) dialog box appears, allowing 

you to alter the constraint by specifying steps between the start position and the end position. 

When a constraint is driven, any components constrained to the driven component will move in 

accordance to their particular shared constraints. The motion may be set to forward or reverse, 

stopped at any time, and even recorded (click the Record button prior to activating the move). If 

any of the affected components are constrained to a grounded component, or if the movement 

will violate any existing constraint, then the drive constraint will fail.

Expanding the dialog box as shown in Figure 8.14 by clicking the >> button will reveal 

additional controls over the drive constraint.
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Figure 8.13

Driving a constraint

Figure 8.14

Drive constraint 

dialog box options

The increment of movement can be controlled by a value or by a total number of steps from 

beginning to end. The length of a particular driven constraint can be controlled by the num-

ber of allowable repetitions from Start to End or can be reversed by using the Start/End/Start 

option. The constraints in mi_8a_016.iam are set up in this manner.

For a continuous revolution by degrees, you may exceed 360 degrees by specifying the 

total number of degrees of revolution or by including an equation such as 360 deg * 3. Another 

approach is to set the End rotation to 360 degrees and then simply increment the Repetitions 
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value for the number of revolutions. You can open the fi le mi_8a_108.iam to further explore 

constraint limits.

Other adaptive parts properly constrained within the driven assembly will adjust to changes 

if the Drive Adaptivity option is selected. This particular option allows determination of a 

maximum or minimum condition for the adaptive part.

Checking the Collision Detection option allows for determination of an exact collision dis-

tance or angle between the driven parts. Using the Collision Detection option will help you 

determine interferences between moving parts so that those parts can be modifi ed before 

manufacturing. In mi_8a_108.iam there is a small red link that can be swiveled out of the way 

to avoid a collision of parts. If you leave it sticking out and drive the Drive Me constraint and 

enable the Collision Detection option, you can determine where the parts come into contact with 

one another. Inventor reports the angle of collision in the Drive Constraint dialog box. You can 

change the Increment value to a fraction of a degree to see a more exact value.

Contact Solver

Another method for driving components within an assembly involves the Contact Solver option. 

With this option, only minimal constraints are required to drive a number of components. 

Components are not required to be constrained to one another for the Contact Solver to work.

The Contact Solver works in much the same way as parts interact in the real world. Without 

the Contact Solver applied, moving parts can be run through one another, creating interference. 

With the Contact Solver applied, parts will stop when they contact one another. A simple exam-

ple of this is the slide arm pictured in Figure 8.15. On the left, you can see that the arm segments 

have been extended past the point that they could be in reality, allowing the slide stops to run 

through the slide slot. On the right, the parts have been added to a contact set and the Contact 

Solver has been turned on, preventing the slide stops from running through the slots.

Figure 8.15

With and without 

Contact Solver

To add parts to a contact set, right-click the part and choose Contact Set from the context 

menu. An icon appears before each component showing when it has been added to the con-

tact set. In addition to adding parts to a contact set, you must ensure that the Contact Solver is 

turned on; do this by choosing Activate Contact Solver from the Inspect menu. Once all active 

participants within the contact set are selected and the Contact Solver is activated, then a single 

driven constraint can provide a real-life simulation. Note that it is best practice to turn the 

Contact Solver off when performance is a consideration.

To explore the contact sets, open the fi le mi_8a_017.iam and follow these basic steps:

 1. Select any components you want to be added to the contact analysis.

 2. Right-click the selected components and choose Contact Set from the context menu.
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 3. Select the Inspect tab and click the Activate Contact Solver button.

 4. Drag the part with the black end cap in and out to see the assembly extend and contract 

based on the contact points.

Using the Contact Solver for Collision Detection

If you have parts that interfere (such as a dowel pin in a hole) and have the Collision Detection 

option selected, the Drive Constraint command will stop immediately because it will have detected 

this interference. If you need to test the collision of parts, look into using the Contact Solver.

Redundant Relationship and Constraint Failures

Excessive relationships are considered redundant when you have overconstrained components. 

Redundant relationships will interfere with the proper operation of your assemblies and can 

cause relationship errors and performance issues.

Two toggles will assist in fl agging bad constraints; you can fi nd them by selecting Tools 

➢ Application Options and selecting the Assembly tab. Enabling Relationship Redundancy 

Analysis allows Inventor to perform a secondary analysis of Assembly constraints and notifi es 

you when redundant constraints exist.

Enabling Related Relationship Failure Analysis allows Inventor to perform an analysis to 

identify all affected constraints and components if a particular constraint fails. Once analysis 

is performed, you will be able to isolate the components that use the broken constraint(s) and 

select a form of treatment for individual components.

Because analysis requires a separate process, performance can be affected if these two check 

boxes are active. Because of this, it is advisable to activate the analysis only when problems exist.

Working with Joint Relationships
The Joint tool allows you to defi ne the working relationship between a pair of components with 

a single joint relationship. This is done by pairing joint points found on faces and edges of com-

ponents. There are several types of joints available for use in an assembly, so in order to know 

which joint type to use and when, you should be familiar with each. Although you can achieve 

the same result using the Constraint tool that you can with the Joint tool, the Joint tool results 

in fewer assembly relationships, which can make managing them later much easier. You can 

also use the Joint and Constraint tools together to fully defi ne the assembly relationship of your 

design as you see fi t.

Joint Selection Inputs

All of the joint types are created by defi ning two origin selections and two alignment selec-

tions. Keep in mind that the alignment selections are created automatically based on your origin 

set selections. However, the inferred selections are often not the correct solution for particular 

joint, resulting in a preview that is incorrect. In these cases you can simply click the Alignment 

selection buttons again to reselect edges or faces for alignment.
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Constraints or Joints: Which Should I Use?

Because the Constraint and Joint tools provide two methods of doing the same thing, creating 

assembly relationships, you might wonder which you should use. Th e answer will likely depend on 

your experience and familiarity with both tools. If you are comfortable with the Constraint tool, 

you might fi nd that it fi ts your approach to creating assembly relationships best, in which case you 

might fi nd that you seldom end up using the Joint tool. Conversely, if the Constraint tool seems 

less intuitive to you, you might fi nd that you prefer the Joint tool.

Th e preference for one or the other of these tools might depend on the type of designs you create. 

For instance, if you create frame structures or weldments with mostly static components, you 

might fi nd that you lean toward creating Rigid joints, rather than Mate and Flush constraints. 

Of course, you might also use a mix of constraints and joints, choosing the relationship type that 

works best for you.

Rigid Joints

The Rigid joint type creates a joint between points on a pair of faces, a pair of edges, or an edge 

and a face. Rigid joints remove all degrees of freedom creating a “fi xed” joint. You can use the 

Flip Component and Invert Alignment buttons to adjust the orientation of the component if the 

preview shows the component incorrectly. Figure 8.16 shows connection points being selected 

for a Rigid joint.

Figure 8.16

Connection points

To explore the Rigid joint options, you will open a simple fi xture assembly and assemble two 

components using a Rigid joint.

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for the fi le mi_8a_120.iam located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

 3. From the Assemble tab, click the Joint button.

 4. Use the Type menu to select Rigid from the list.

 5. For the fi rst origin selection, hover over the yellow face of the component named 

Side_302.
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 6. Move your cursor down to select the center-bottom connection point, as shown in Figure 

8.16.

 7. For the second origin selection, hover over the yellow face of the base component and 

choose the center-top connection point, as shown in Figure 8.16.

 8. Use the Flip Component and Invert Alignment buttons to correct the alignment of the 

Side_302 component.

 9. Enter -5 mm in the Gap input box in order to set the far faces fl ush.

 10. Click the OK button to create the Rigid joint. Figure 8.17 shows the result.

Figure 8.17

Th e Rigid joint 

results

Next, you’ll edit the Rigid joint you just created and adjust the selections. You can continue 

with the fi le you have open or close it and open the fi le mi_8a_121.iam.

 1. Locate and expand the Relationships folder in the Model browser, and then right-click 

the Rigid joint and choose Edit.

 2. Click the second origin button in the Connect area of the dialog box, in order to clear the 

selection.

 3. Click the fi rst origin button in the Connect area of the dialog box, in order clear that 

selection as well.

 4. Next, with the fi rst origin button active still, select the center connect point of the bottom 

edge of the Side_302 component, as shown in Figure 8.18.

Figure 8.18

Selecting an edge 

connection point
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 5. For the second origin selection, select the center connect point of the top edge of the base 

component, as shown in Figure 8.19.

Figure 8.19

Selecting the other 

edge connection 

point

 6. Note that the -5 mm gap distance results in a different offset when the two edges are 

selected compared to when the two faces were selected.

 7. Set the Gap value to 0 mm.

 8. Enter Yellow Faces in the Name input box; then click the OK button to apply the changes.

You’ll note that the name in the browser is now changed to read Yellow Faces. Naming joints 

in this manner allows you to organize and quickly locate joints for editing. You can close this 

fi le when fi nished and continue to the next section to explore Rotational joints.

Rotational Joints

The Rotational joint type creates a joint between points on a pair of faces, a pair of edges, or an 

edge and a face. Rotational joints specify one degree of freedom, creating a rotating joint based 

on the connection points you select. You can use the Flip Component and Invert Alignment but-

tons to adjust the orientation of the component if the preview shows the component incorrectly. 

Additionally, you can create a rotational limit so that the rotational joint will only rotate through 

a specifi ed set of angles.

To explore the Rotational joint options, you will open a simple assembly and create one 

Rotational and one Rigid joint in order to defi ne the rotation of a handle crank.

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for the fi le mi_8a_122.iam located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

Take a moment to examine the parts listed in the model tree. If you drag your cursor over 

each part name, you will see that part highlight in the browser. You’ll refer to these part 

names in the following steps.

 3. From the Assemble tab, click the Joint button.

 4. Use the Type menu to select Rotational from the list.
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 5. For the fi rst origin selection, hover over the yellow face of the component named 8_105.

 6. Move your cursor down to select the connection point at the center of the hole.

 7. For the second origin selection, choose the connection point at the center of the yellow 

face of the component named 8_104 (the gray base component).

 8. Click the Limits tab in the Place Joint dialog box.

 9. Click the check box for the Angular Start option and enter 360 deg in the input box.

 10. Enter 180 deg in the End input box.

 11. Click the OK button to create the rotational joint. Figure 8.20 shows the result.

Figure 8.20

Th e Rotational joint 

results

You can click and drag the 8_105 component to see it rotate through the range of motion spec-

ifi ed in the Limits tab. This allows the joint to work realistically, so that it stops without running 

through the other component. Next, you’ll add a Rigid joint to complete the assembly. You can 

continue with the fi le you have open or close it and open the fi le mi_8a_123.iam.

 1. From the Assemble tab, click the Joint button.

 2. Use the Type menu to select Rigid from the list.

 3. For the fi rst origin selection, hover over the red face of the component named 8_106, and 

then click to select the center connection point of the hole.

 4. For the second origin selection, hover over the red face of the component named 8_105, 

and then click to select the center connection point.

 5. Click the fi rst alignment button and choose the blue face on the inside of the keyway; you 

might need to zoom in closely to select it.

 6. Then click the blue face on the key feature on the 8_105 component, and click the Invert 

Alignment button to set the proper alignment.

 7. Click the OK button to create the rigid joint, and then click and drag the components to 

see the behavior you’ve achieved. Figure 8.21 shows the completed assembly.
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Figure 8.21

Th e completed 

assembly

Here you’ve used a rigid joint in combination with a rotational joint to defi ne the rotational 

limits and assembly alignment of a simple mechanism. Keep in mind that you could have 

achieved the same results using the Constraint tool instead of the Joint tool, or you could have 

used the two in combination as well. You can close this fi le and continue on to the next section 

to explore the Slider joint type.

Slider Joints

Much like the Rigid and Rotational joints, the Slider joint type creates a joint between points 

on a pair of faces, a pair of edges, or an edge and a face. Slider joints specify one translational 

degree of freedom, defi ning a sliding action. As with other joint types, you can use the Flip 

Component and Invert Alignment buttons to adjust the orientation of the component if the pre-

view shows the component incorrectly. Additionally, you can create a linear travel limit so that 

the joint will only slide through a specifi ed linear distance.

To explore the Slider joint options, you will open a simple assembly and create a couple of 

Slider joints.

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for the fi le mi_8a_124.iam located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

In this fi le there are three bearing pads. One of the bearing pads has been set up to slide 

in the fi rst rail channel already. This was done using the Constraint tool. If you expand 

the Relationships folder in the browser you’ll fi nd two Mate constraints and one fl ush 

constraint. The three of these together create the relationship that allows the bearing 

pad to slide through a specifi c linear distance in the fi rst rail channel. You’ll use the Joint 

tool to create the same relationship for the remaining two bearing pads with just a single 

slider joint for each pad.

 3. From the Assemble tab, click the Joint button.

 4. Use the Type menu to select Slider from the list.

 5. For the fi rst origin selection, hover over the yellow face on either of the unconstrained 

bearing pads.

 6. Move your cursor to select the connection point at the center of the edge near the red face, 

as shown in Figure 8.22.
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Figure 8.22

Connection point 

on the bearing pad

 7. For the second origin selection, hover over the yellow face of the center channel on the 

rail.

 8. Move your cursor to select the connection point at the center of the edge near the red face, 

as shown in Figure 8.23.

Figure 8.23

Connection point 

on the channel

 9. Click the Align buttons to see which faces are being used as the alignment selections. If 

the red faces on each part are not selected, select them so that both red faces are aligned, 

as shown in Figure 8.24.

Figure 8.24

Th e correct 

alignment of the 

bearing pad

 10. Click the Limits tab in the Place Joint dialog box.
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 11. Select the Linear Start check box and then enter 0 mm in the input box.

 12. Select the Linear End check box and then enter -250 mm in the input box. The rail is 300 

mm long and the bearing pad is 50 mm long, so the linear limit is 300 - 50, or 250, and 

you use a negative value to control the direction.

 13. Click the OK button to create the slider joint.

You can click and drag the bearing pad to see it slide through the range of linear motion 

specifi ed in the Limits tab. This allows the pad to work as if the rail had end stops in place. And 

note that you’ve created this relationship with just a single joint, whereas the existing relation-

ship required three constraints.

Next, you’ll add another slider joint to the remaining bearing pad. You can continue with the 

fi le you have open or close it and open the fi le mi_8a_125.iam.

 1. From the Assemble tab, click the Joint button.

 2. Use the Type menu to select Slider from the list.

 3. For the fi rst origin selection, hover over the yellow face on the unconstrained bearing 

pad.

 4. Move your cursor to select the connection point at the center of the yellow face, as shown 

in Figure 8.25.

Figure 8.25

Th e center 

connection point of 

the bearing pad

 5. For the second origin selection, hover over the yellow face of the remaining free rail slot, 

and then click to select the center connection point, as shown in Figure 8.26.

Figure 8.26

Th e center 

connection point of 

the rail slot
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 6. Click the Align buttons to see which faces are being used as the alignment selections. If 

the red faces on each part are not selected, select them so that both red faces are aligned.

 7. Click the Limits tab in the Place Joint dialog box.

 8. Select the Linear Start check box and then enter 125 mm in the input box.

 9. Select the Linear End check box and then enter -125 mm in the input box. The rail is 300 

mm long and the bearing pad is 50 mm long. But since the connection points are in the 

center of each, you’ll use half of these values to come up with the offsets: 150 - 25 = 125. 

You use the negative of this number to specify the other direction.

 10. Click the OK button to create the slider joint.

You can click and drag the bearing pad to see it slide through the range of linear motion 

specifi ed in the Limits tab. If the bearing pad does not stop at the ends of the rail slot, edit the 

Slider joint and check your inputs and alignment selections.

Creating a slider joint is a straightforward process; however, some thought is required to 

select the correct connection points and specify the correct limit values in order to achieve the 

correct relationship for each situation. Once you’re satisfi ed with the slider joints you’ve created, 

you can close this fi le without saving changes and continue to the next section.

Cylindrical Joints

The Cylindrical joint type creates a joint between points on a pair of faces, a pair of edges, or 

an edge and a face. Cylindrical joints specify one rotational degree of freedom and one trans-

lational degree of freedom, defi ning a sliding and rotating action. As with other joint types, 

you can use the Flip Component and Invert Alignment buttons to adjust the orientation of the 

component if the preview shows the component incorrectly. For Cylindrical joints you can create 

both angular and linear limits.

To explore the Cylindrical joint options, you will open a simple slip latch assembly and create 

a Cylindrical joint.

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for the fi le mi_8a_126.iam located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

 3. From the Assemble tab, click the Joint button.

 4. In the Type menu select Cylindrical from the list.

 5. For the fi rst origin selection, select the circular yellow face of the tan-colored part.

 6. For the second origin selection, select the yellow face of the small latch catch part.

 7. Click the Align buttons to see which faces are being used as the alignment selections. 

If the red faces on each part are not selected, then select them so that both red faces are 

aligned.

 8. Click the Limits tab in the Place Joint dialog box.

 9. Select the Angular Start check box and then enter -80 deg in the input box.

 10. Select the Angular End check box and then enter -20 deg in the input box.
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 11. Select the Linear Start check box and leave the input box value at 0 mm.

 12. Select the Linear End check box and then enter 200 mm in the input box.

 13. Click the OK button to create the cylindrical joint. Figure 8.27 shows the result.

Figure 8.27

A slip latch with a 

cylindrical joint

You can click and drag the slide bolt to see it slip through the range of angular and linear 

motion specifi ed in the Limits tab. You’ll note that the catch on the slide bolt can pass through the 

rise in the latch body that defi nes the slot. To prevent this, you could create a contact set and turn 

on the Contact Solver as mentioned earlier in this chapter. When you’ve fi nished exploring the 

results of the cylindrical joint, you can close the fi le without saving changes and continue to the 

next section.

Planar Joints

The Planar joint type is pretty basic and creates a joint between points on a pair of faces, a pair 

of edges, or an edge and a face. Planar joints specify two translational degrees of freedom and 

one rotational. As with other joint types, you can use the Flip Component and Invert Alignment 

buttons to adjust the orientation of the component if the preview shows the component incor-

rectly. However, unlike many other joint types, Planar joints have no Limit options.

To explore the Planar joint options, you will open a simple assembly and create a Planar joint 

between game pieces and a game board.

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for the fi le mi_8a_127.iam located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

 3. From the Assemble tab, click the Joint button.

 4. Use the Type menu to select Planar from the list.

 5. For the fi rst origin selection, select the circular yellow face on the bottom of either of the 

tipped-over game pieces.

 6. For the second origin selection, select the center connection point of any of the squares on 

the game board.

 7. You can click the Align buttons to see which faces are being used as the alignment selec-

tions, although in this case the alignment is not important.

 8. Click the Limits tab in the Place Joint dialog box.
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 9. Notice that both the Angular and Linear limits options are grayed out and cannot be 

selected, indicating that they are not available for planar joints.

 10. Click the OK button to create the planar joint.

 11. Click and drag on the game piece you placed, and you’ll note that it can slide along in 

any direction but will stay fi xed to the top plane of the game board. Figure 8.28 shows the 

game pieces in place.

Figure 8.28

Planar joints 

placing game pieces

Although the planar joint might seem too basic to be of much use, it is often used in combina-

tion with one of the other joint or constraint types to further defi ne a mechanism or movement 

that translates in any direction along a planar surface. When fi nished, you can close the fi le 

without saving changes and continue to the next section.

Ball Joints

The Ball joint type is most often used to create a joint between center points of a pair of spherical 

faces; however, it can use a connection point found on any pair of faces, pair of edges, or an edge 

and a face. Ball joints specify three rotational degrees of freedom. As with other joint types, you 

can use the Flip Component and Invert Alignment buttons to adjust the orientation of the com-

ponent if the preview shows the component incorrectly. However, there are no Limit options for 

Ball joints.

To explore the Ball joint options, you will open a simple assembly and create a joint between 

two parts.

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for the fi le mi_8a_128.iam located in the Chapter 08 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

 3. From the Assemble tab, click the Joint button.

 4. Use the Type menu to select Ball from the list.

 5. For the fi rst origin selection, select the center connection point on the spherical yellow 

face on the blue arm part.
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 6. For the second origin selection, select the center connection point of the yellow face on 

the gray socket part.

 7. Click the Limits tab in the Place Joint dialog box.

 8. Notice that both the Angular and Linear limits options are grayed out and cannot be 

selected, indicating that they are not available for planar joints.

 9. Click the OK button to create the planar joint.

 10. Click and drag the blue arm part to see that it rotates in the socket. You’ll notice that it 

can currently pass though the other part.

 11. Select both parts and then right-click and choose Contact Set.

 12. Go to the Inspect tab and click the Activate Contact Solver button to turn the solver on.

 13. Now you can click and drag the blue arm part and see that it will not pass through the 

socket part. Figure 8.29 shows the resulting assembly.

Figure 8.29

A Ball joint

Although the Ball joint has a fairly specifi c use, it can often be the only choice for creating 

certain types of relationships between parts. When you’ve fi nished exploring the Ball joint tools, 

you can close the fi le without saving changes and continue to the next section.

Understanding Subassemblies
You create assemblies by placing assembly relationships between parts to position and hold 

those parts together. When working with small assemblies, you can often assemble all the parts 

together at one level. Working with larger assemblies, however, often requires the use of mul-

tiple levels of assemblies for the sake of organization and performance. Lower-level assemblies 

are referred to as subassemblies.
Imagine a common caster-wheel assembly. Although it may seem like a simple component, it 

is, of course, made up of many small parts. If you needed to use this caster in an assembly mul-

tiple times, you wouldn’t place all the small parts into an assembly individually over and over. 

Instead, you would package them as a subassembly and place multiple instances of the subas-

sembly throughout the top-level assembly. Figure 8.30 shows a caster-wheel assembly ready to 

be placed as a subassembly.

Most things you design and build are typically made from subassemblies of some sort. In 

manufacturing it makes sense to create subassemblies of common parts to make the assembly 
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process easier. It makes sense to design in exactly the same fashion. In the caster example, it 

saves you from having to duplicate the work of assembling the caster parts repeatedly for each 

instance of the caster that exists in the top-level assembly.

Figure 8.30

A caster-wheel 

assembly

A second benefi t to using subassemblies is the fl exibility they add to the bill of materials. 

Using the caster as a subassembly rather than as loose parts provides the ability to count the 

caster as a single item, to count the total of all the caster parts, or to do both.

Knowing When to Use Assemblies

Although it is often necessary to create parts as assemblies (to have a correct bill of materials or 

to provide the correct motion), it is not always the best choice. For example, in the caster example, 

unless you need the casters to swivel in your assembly, consider modeling the caster as a single part 

or deriving the assembly into a single part. Th is will lower the overhead of your models as well as 

reduce the number of parts to track throughout your design.

There is a third and very important concept to consider when working with subassemblies: 

model performance. Imagine that you decided to place four instances of the caster into an 

assembly as loose parts rather than as a subassembly. For the sake of simplicity, say it takes 28 

relationships among the caster parts and two relationships between the caster and the top-level 

assembly, for a total of 30 relationships. You do this for all four casters, for a total of 120 relation-

ships in the top-level assembly. Had you assembled the caster as a subassembly and then placed 

that subassembly into the top-level assembly, you would have used just 28 in the caster subas-

sembly and two per caster, as shown in Figure 8.31, for a total of only 36 relationships.

If you consider assembly relationships to be nothing more than calculations that Inventor 

must make to hold the assemblies together, then by using subassemblies, you have required 

Inventor to create and maintain 86 fewer calculations overall. This reduction in constraints 

can have a signifi cant impact on the assembly’s performance and make the task of editing the 

assembly much easier.
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Figure 8.31

Reduced assembly 

relationships

Top-Down Design
Inventor allows you to approach the creation of parts and assemblies in three basic ways. 

Figure 8.32 shows these three distinctive workfl ows for assembly design.

Figure 8.32

Design workfl ows Top Down
Design Within Assembly

Utilize Subassemblies
Share Part Geometry

Most Efficient Workflow
Facilitates Middle-Out Design

Middle Out
Design Within Assembly

Utilize Subassemblies
Share Part Geometry

Insert Parts and Assemblies
Most Commonly Used

Bottom Up
Create Single Parts

Create iParts & Features
Develop Library Items
Repair Imported Parts

Least Efficient

The fi rst of these methods is called top-down design. In the purest sense, top-down design is 

performed completely within the top-level assembly of a machine or device. Parts and subas-

semblies are created from within the uppermost assembly, as opposed to creating components 

outside the top-level assembly and then placing these components later. Using this approach, 

you can reference and project geometry from other parts within the assembly into new parts, 

thereby ensuring the fi t of the new parts. Another benefi t to top-down design is that the 

designer can better visualize how each part relates to others within the assembly. When it’s 

properly utilized, you minimize the number of overall Assembly constraints required and allow 

for a stable design.

The second method works by creating parts independently and then placing and constrain-

ing them into the assembly. This method is called bottom-up design. Bottom-up design is com-

mon when creating parts from existing drawings and new pencil sketches. This workfl ow is 

ideal for repairing imported geometry, creating standard parts for your library, and convert-

ing standard parts into iParts and iFeatures. Working in the single-part environment does not 

easily allow you to create or reference other parts that will be utilized within your assembly 

design. As a result, this is probably the least effi cient workfl ow for 3D design but is often the one 

employed by new users.
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The third method is some combination of top-down and bottom-up design and is the most 

common. This approach might be called middle-out. This is top-down design with the ability 

to add existing subassemblies and parts as needed. Utilizing various functions such as parts 

libraries, Frame Generator, Bolted Connections, and Content Center components within an 

assembly fi le is an example of middle-out design.

Developing an Effi  cient Assembly Workfl ow
Consider an example of a top-down workfl ow to better understand the benefi ts and effi ciency 

of this type of design. Within this workfl ow, you will fi rst create the top-level assembly fi le and 

then create the part fi les:

 1. On the Get Started tab, click the New button, and select the Standard.iam template.

 2. Click Create on the Assemble tab, or right-click in the browser or graphics area and select 

Create Component. The default option in the Create In-Place Component dialog box is to 

create a new component as a standard single-part fi le. Instead, click the drop-down arrow 

in the Template area, and select Standard.iam.

Available Templates

Th e choices available in the drop-down are the templates from the default tab. If you want to use 

a template from a diff erent tab, click the Browse Templates button instead. Once you click the 

Browse Templates button, you will be presented with the Open Template dialog box, which gives 

you a choice of standards and templates.

 3. Name this assembly 2nd Level Assembly, and then set the New File Location to the 

Chapter 08 folder.

If it is known at the time of creating the subassembly fi le, determine the BOM struc-

ture for this subassembly. Note that you can change this later using the BOM Editor as 

needed. Figure 8.33 illustrates the selection choices for the BOM structure.

Figure 8.33

BOM structure 

options

Certification
Objective



396 | CHAPTER 8 ASSEMBLY DESIGN WORKFLOWS

The choices for BOM structure are listed here with a brief description. You’ll take a more 

in-depth look at BOM structure settings later in this chapter in the “BOM Structure 

Designations” section.

Virtual Components  These components require no geometry, such as paint, grease, 

and so on.

Normal  This is the default structure for all parts that are intended to be fabricated.

Purchased  These are parts or assemblies that are not fabricated in-house.

Inseparable  Generally, these are assemblies that cannot be disassembled without dam-

age, such as weldments, riveted assemblies, and so on.

Phantom  Typically, this is a subassembly created to simplify the design process by re-

ducing Assembly constraints and to roll parts up into the next-highest assembly level.

Reference  This is used for construction geometry or to add detail and references to the 

top-level assembly.

 4. In this top-down design example, you will be using Normal components. Confi rm that 

Default BOM Structure is set to Normal, and click the OK button.

 5. You will then be prompted to select a sketch plane for the base component of this assem-

bly. In the Model browser, expand the assembly origin folder, and select the XY Plane 

option.

This will place and anchor the new assembly to the top-level assembly origin. The origin 

planes of the new assembly will be anchored to the selected top-level assembly origin 

plane upon creation and will be grounded to the top-level origin plane. This new, second-

level assembly will be activated within the Model browser, ready for editing, as shown in 

Figure 8.34.

Figure 8.34

Second-level 

assembly active
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 6. With the second-level assembly active, select Create Component once again, and this time 

use the Standard.ipt template to create a new part. Name this component Rotary Hub, 

and set it to be saved in a subdirectory called Parts within your workspace, as shown in 

Figure 8.35. If the subdirectory does not exist, you will be prompted to create it. Leave the 

BOM structure setting as Normal, and then click the OK button.

Figure 8.35

Creating Rotary 

Hub.ipt in the Parts 

subdirectory

 7. To place the part, select the XZ plane from the Origin folder in 2nd Level Assembly.iam.

 8. Now you are in the Rotary Hub part fi le. Use the Create 2D Sketch button and select the 

XZ plane. You might need to expand the Origin folder to determine which plane is 

the XZ plane.

 9. Create and dimension the sketch, as shown in Figure 8.36.

Figure 8.36

Rotary Hub sketch

 10. Press E to display the Extrude dialog box, and extrude the outer ring to a length of 1 inch.

 11. Create a sketch on the top face of the ring. Sketch a concentric circle offset 0.5 inch to the 

inside of the overall diameter. Place a center point on the offset circle.
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 12. Start the Hole tool. The center point will be automatically selected. Set the diameter to 

0.375 inch, and set Termination to Through All.

 13. Create a circular pattern of the hole feature with six instances, as shown in Figure 8.37.

Figure 8.37

A circular pattern 

of the hole feature

 14. Click the Save icon. Since the part is active, it is saved, but the top- and second-level 

assemblies are not. Click the Return button twice to return to the top-level assembly.

 15. Click Save again, and you will be prompted to name the top-level assembly fi le. Name the 

fi le Top Level Assembly, and click the OK button.

 16. The Save dialog displays the state of all the assembly fi les. Both of the assembly fi les are 

marked Initial Save. This means that they exist only in memory and haven’t been saved 

to hard drive (or network drive) yet. If you were to click in the Save column to change it to 

No, the fi les would be closed without saving, and you would just have the part fi le on the 

disc drive. Confi rm that the both fi les are marked Yes, and click the OK button.

These steps illustrate the method of creating a true top-down design, starting with the assem-

bly, then defi ning the subassembly, and fi nally creating a part to reside in the assembly struc-

ture. If this seems like a purely academic exercise because it is not the way you typically work, 

you might fi nd that the concepts can still be useful to you every now and again. Often, the top-

down, middle-out, or bottom-up approach is dictated by the need to assign part numbers and 

create assembly structure to match. Keep these things in mind as you work with Inventor assem-

blies, and you will more than likely fi nd an opportunity to use them somewhere along the way.

Layout Sketches
Another top-down (and/or middle-out) design workfl ow is the use of layout sketches or sketch 
blocks. Layout sketches are created in a part fi le, using sketch blocks to represent individual parts 

as basic 2D symbols. The 2D blocks are “assembled” in the part sketch and can be dimensioned 

and constrained to simulate simple assembly mechanisms to test function and to some extent 

fi t. The fi rst step in creating a layout sketch is to create a part fi le and a sketch. Next, 2D sketch 

geometry is created and turned into sketch blocks, with a single block representing each com-

ponent within the mechanism. Nested blocks (blocks made of other blocks) can be used to rep-

resent subassemblies and can even be set as fl exible to allow them to pivot around or translate 

motion along an axis. Once the basic 2D layout design is complete, you can use the Make Part 

Certification
Objective
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and Make Component tools to write out the blocks as individual part models from the sketch 

blocks. From there, a 3D assembly can be created based on, and linked to, the sketch blocks. In 

this way, if you update the sketch layout, the parts and assemblies will automatically update.

The following example will introduce layout and sketch-block functionality:

 1. Click the Get Started tab, and click Open.

 2. Browse for the fi le mi_8a_019.ipt located in the Chapter 08 directory of the Mastering 

Inventor 2014 folder, and click Open.

 3. Locate the sketch called Layout Assembly in the browser and click the plus sign to 

expand it.

 4. Notice that the sketch contains a block called Base Mount. Right-click on the sketch and 

choose Edit Sketch.

 5. Select the Create Block button from the Layout panel.

 6. Select all of the geometry on the left of the sketch with the visible dimensions.

 7. Click the Insert Point button in the Create Block dialog box, and then select the lower-left 

corner of the rectangle as the insert point.

 8. Enter Base Plate for the block name, and then click the OK button to create the block.

 9. Expand the Blocks folder in the browser and notice that the Base Plate block has been 

added to the block defi nitions. The geometry you selected has been converted to a block 

as well, and now behaves as a single entity.

 10. Place a Concentric constraint on each of the half-circle shapes on the base plate and the 

corresponding half-circle shape on the base mount. Exit the Constraint tool by right-click-

ing and choosing the OK or Cancel button.

 11. Select the Arm Assembly block from the Blocks folder and drag it into the graphics area 

to place an instance of it.

 12. Place a Concentric constraint on the right circle of the Base Mount block and the large 

dashed circle on the bottom link of the Arm Assembly block. Exit the Constraint tool by 

right-clicking and choosing the OK or Cancel button.

 13. Select the Cylinder Assembly block from the Blocks folder and drag it into the graphics 

area to place an instance of it.

 14. Place a Concentric constraint on the left circle of the Base Mount block and the larger 

circle on the Cylinder Assembly block. Exit the Constraint tool by right-clicking and 

choosing the OK or Cancel button.

 15. Right-click on the Cylinder Assembly and choose Flexible. This allows the undercon-

strained geometry to solve independently at the top-level block.

 16. Click and drag the free end of the Cylinder Assembly block to see the plunger slide in the 

cylinder.

 17. Place a Concentric constraint on the free end of the Arm Assembly block and the free end 

of the Cylinder Assembly block.
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 18. Click Finish Sketch to return to the feature level. Figure 8.38 shows the layout sketch.

Figure 8.38

Blocks folder and 

blocks in the sketch

Notice that you can continue to drag the sketch assembly to see the adjustment of the cylin-

der and the angle for the arm assembly. As you can see, creating layout sketches in this fashion 

allows you to solve linear and pivot motion layouts in 2D. Once the sketch layout has been 

completed, you can use the Make Components tool to write each block out to an individual part 

and/or assembly fi le. You can close the current fi le without saving changes or use it to explore 

the Make Components workfl ow using these general steps:

 1. Click the Make Components button on the Manage tab, and then select the sketch blocks 

you want to create components for.

 2. Select additional blocks to add to the list, or select from the list and click Remove From 

Selection to exclude any blocks you decide you do not want to create components for.

 3. Select Insert Components In Target Assembly, and then set the assembly name, the tem-

plate from which to create it, and the save path, or clear this option to create the parts 

only. If the assembly already exists, use the target assembly location’s Browse button to 

select it.

 4. Click Next to accept your selections.

 5. The next dialog box allows you to name and set paths for the fi les to be created. Click the 

cells in the table to make changes for the components as required:

 ◆ Click or right-click a cell to choose from the options for that cell type, if any.

 ◆ You can Shift+click multiple components and use the buttons above the Template and 

File Location columns to set those values for multiple components at once.
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 6. Click Include Parameters to choose which layout model parameters to have present in the 

created parts.

 7. Click the Apply or OK button to make the components. If the component fi les are created 

in an assembly, the assembly fi le is created with the parts (and subassemblies) placed and 

left open in Inventor, but the assembly and parts are not saved until you choose to do so. 

If you choose to create the components without an assembly, you are prompted to save 

the new fi les as they are created.

 8. You can then open each part fi le and create 3D geometry based on the sketch block. 

Changes to the original layout sketch push through to the 3D part and assembly.

Layout sketches can boost your productivity. During the initial stage of design, there are fre-

quent changes as you nail down the details. When you initially create the layout sketch, you can 

easily investigate “what if?” scenarios. You can add as much or as little detail as you need to defi ne 

the function and form. If you do need to make a change in the relationship of components, you 

can do that in the layout sketch, and then the update will get pushed to all the components. Once 

components are generated from the blocks, you can edit them and build the model parts based on 

the basic blocks. You can open the assembly called mi_8a_020.iam to examine a simple assembly 

created from the layout sketch used in the completed version of the previous exercise.

Flexibility
When multiple instances of the same subassembly are used within a design, each instance can 

be made fl exible, allowing underconstrained components in the subassembly to be solved at the 

top-level assembly. The caster assemblies in Figure 8.39 have been made fl exible so they can be 

swiveled and positioned independently as they would in the real world.

Figure 8.39

Flexible 

subassemblies

A subassembly instance is made fl exible by right-clicking the instance within the browser 

and selecting Flexible. Flexible subassemblies are displayed with an icon next to the instance 

name in the browser so that you can easily determine which instances are fl exible.

Flexible assemblies can be nested into fl exible subassemblies and will still update whenever 

the original assembly is changed. One common use of fl exible assemblies would be in the cre-

ation of hydraulic cylinders that require extensions of different lengths when used in multiple 
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locations within a top-level assembly. When each instance of the assembly is made fl exible, each 

cylinder can move accordingly within the top-level assembly.

If a subassembly with nested fl exible subassemblies is to be placed into a top-level assembly, 

you simply right-click that subassembly to bring forward the fl exibility of the nested fl exible 

assemblies. Consider the example of the hydraulic cylinder. Multiple instances of the cylinder 

might be placed into an extension arm assembly and each instance made fl exible so that they 

can be allowed to adjust as they are constrained to the extension-arm parts.

If two instances of the extension arm are then placed into a top-level assembly, those 

instances need to be made fl exible as well in order to allow the cylinders to demonstrate fl exibil-

ity. You can use the fi le mi_08a_030.iam to explore fl exible subassemblies.

Adaptivity
Cross-part adaptivity is a powerful feature of Autodesk Inventor, and it can be turned on or off 

at will. Adaptively is an option that allows a sketch or feature in one part to update based on a 

sketch or feature found in another part. Although adaptivity is a powerful tool when properly 

used, it can also cause performance problems when used indiscriminately in large assemblies 

or when an adaptive part is utilized in another assembly without its related part. But you can fi x 

both situations with very simple methods.

Because active adaptive parts can cause performance issues in large assemblies, you should 

turn off adaptivity after use. If a related part is edited, adaptivity on the associated part should be 

turned on and the assembly should be updated to refl ect the changes on the related part. Once this 

is done, that adaptivity should be turned off once again.

Tracking Adaptivity

It is a good idea to turn off  adaptivity when it’s not in use; however, Inventor does not have a good 

method to tell you what parts were adaptive. One way is to rename the browser nodes so that you 

can tell what parts were adaptive. A simple way to do this is to append -A on the browser node. Now 

you’ll know which parts were adaptive even where they are not currently adaptive.

If an adaptive part is to be used in other designs, save the part with a different fi lename and 

remove the adaptivity from the new part. Otherwise, the adaptive relationships will carry over 

into the other design, and you won’t be able to edit shared parts.

Creating Adaptivity
This example creates an adaptive relationship between two parts and demonstrates how they 

are linked together:

 1. On the Get Started tab, click Open.

 2. Browse to Chapter 08 in the Mastering Inventor 2014 directory, and open 

mi_08a_021.iam.

 3. Click the Create button on the Assemble tab, or right-click in the browser or graphics area 

and select Create Component.
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 4. Name the new part fi le Gasket. For New File Location, browse to the Chapter 08 folder, 

confi rm that “Constrain sketch plane to selected face or plane” is selected, and click the 

OK button.

 5. Select the top face of the rotary hub part for the new part sketch. Depending on the 

Application Options Sketch settings, Inventor might create Sketch1 for you or you might 

need to do this manually. If no sketch is created, use the Create 2D Sketch button and 

select the top face of the rotary hub part again.

 6. Click Project Geometry on the Sketch tab, and select the top face of the existing part. The 

geometry is projected into the sketch. Note that adaptive glyphs have been added to the 

browser to indicate that the part and sketch are adaptive. Also, there is a Reference1 node 

nested under the sketch. This node contains the information linking the two parts, as 

shown in Figure 8.40.

Figure 8.40

Part marked with 

the adaptive icon in 

the browser

The adaptive glyph is displayed when adaptivity is turned on. You can turn adaptivity on 

and off by right-clicking the node in the browser. You can toggle the feature or sketch adap-

tivity while editing the part, but you have to return to the assembly level to toggle adaptiv-

ity on the part. Additionally, you can disable the creation of adaptive loops when projecting 

geometry altogether; to do so, select the Tools tab, click Application Options, select the 

Assembly tab, and then uncheck the Cross Part Geometry Projection option.

 7. Finish the sketch by right-clicking and selecting Finish 2D Sketch from the context menu, 

as shown in Figure 8.41. Do not click Finish Edit or Inventor will not only fi nish the 

sketch, but it will also exit the part and return you to the assembly.

Figure 8.41

Selecting Finish 2D 

Sketch, not Finish 

Edit
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 8. Extrude the Gasket part to a thickness of 2 mm, click the Return button to return to the 

assembly, and then click Save.

 9. To see how adaptivity works, double-click the rotary hub component to activate that 

part for editing. You can double-click the part in the graphics area or the icon next to 

the part name in the Model browser to activate any part for editing.

 10. In the Model browser, right-click Extrusion1, and select Edit Sketch. Change the overall 

diameter from 130 mm to 160 mm, and click the OK button.

 11. You will notice that the overall diameter and the diameter of the hole pattern of the 

rotary hub component have changed, but the corresponding gasket part remains 

unchanged.

 12. Click Return to move up to the second-level assembly design state once again. Both parts 

are active at the subassembly level, so the gasket part updates to match the rotary hub 

component.

As you can see, the ability to adapt one part to another can make updates across parts very 

easy. You can close this assembly without saving changes and continue on.

Removing Adaptivity from Parts
Once a design has been approved and released for production, you should completely remove 

adaptivity from all parts within your assembly. Removing the adaptivity ensures that the part 

can be reused within other designs without confl ict and will not be updated accidentally.

If you decide to retain adaptivity within your original assembly but plan on using the adap-

tive part in other assemblies, the adaptive icon will not display on those instances of the part. 

This is because only one occurrence of a part can defi ne its adaptive features. However, all 

occurrences refl ect changes and adaptive updates, including occurrence in other assemblies. It is 

for this reason that you must use adaptivity carefully.

To completely remove adaptivity from a part, either activate or open the adaptive part, and 

activate the adaptive sketch. Expand the sketch and right-click Reference to select Break Link, as 

shown in Figure 8.42.

Figure 8.42

Breaking the 

adaptive link
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When the adaptive link is broken, the reference geometry is converted to normal sketch 

geometry. This geometry will need to be fully dimensioned and constrained. Once the geome-

try has been converted to normal sketch geometry, the part will no longer be able to be adaptive.

Making Temporary Use of Adaptivity

Use adaptivity to fi nd mounting holes for positioning hardware components on a base part. For 

example, consider a mounting clip and a base plate.

Constrain the clip to the base plate; then make the base plate active for editing, and create a sketch 

on the plate surface. With the sketch active, project the mounting holes, locating holes, and other 

needed geometry from the mounting clip to the base plate. Th is creates adaptive relationships in 

the base plate to the mounting clip.

Once the design is fi nalized and all the mounting clips are properly located, simply turn adaptivity 

off  on the base plate. When the design is released for production, or at any other desired time, con-

vert the reference geometry created when you projected the geometry to normal sketch geometry. 

Th en dimension and constrain the mounting holes as you would any other feature.

Assembly Features
An assembly feature is a feature created and utilized purely within the active assembly fi le and 

environment. Because this feature was created within the assembly fi le, it does not exist at the 

single part or subassembly level. A good example of an assembly feature in use is the technique 

of creating drilled holes through a standard tabletop within an assembly. Common practice is 

to place brackets on the tabletop to fi nd the mounting-hole locations. This allows the holes to be 

drilled at the same time, ensuring an exact match and placement. Assembly features in Inventor 

mimic this approach.

Examining the individual tabletop fi le reveals that the part fi le does not contain the drilled 

holes, simply because the drill operation was performed at the assembly level rather than the 

part level. To understand the reasoning behind this, you might consider that the tabletop is a 

common part stocked in the shop and then machined as required for each assembly in which 

it is used. Although the stock part might exist as a cataloged item with no holes, it may exist in 

many different assemblies with holes of various sizes and locations. Using assembly features 

allows you to work in this manner.

Other examples of assembly features are contained within the weldment environment, 

where preparations used to facilitate welding components together are at the assembly level. 

Preparation features allow trimming of soon-to-be-welded components to eliminate interfer-

ences between welds and other parts of the weldment.

Care must be taken when creating geometry within the context of the assembly because it 

is easy to create an assembly feature when intending to create a part feature. Although this is a 

common mistake that new users will make, it is one that anyone can experience. In a multilevel 

top-down design, always make sure you are working in the proper assembly or component by 

double-clicking the assembly or component in the Model browser for the purpose of opening 

that component for editing.
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To explore the creation of assembly features, follow these steps:

 1. On the Get Started tab, click Open.

 2. Browse to Chapter 08 in the Mastering Inventor 2014 directory, and open 

mi_08a_022.iam.

This assembly is made up of three parts, two of which are instances of the same part, 

Part_100_8. The other component, Part_200_8, currently interferes with the other two 

parts. Your goal is to cut a keyhole in both instances of Part_100_8 so that the keyed bar 

will fi t into them. Part_100_8 is a stock bracket used in many assemblies; therefore, you 

must take care not to create a feature in it that will have a negative impact on its use in all 

of the assemblies that consume it. To start, you will explore a keyway created by another 

user at the part level.

 3. Double-click on the front instance of Part_100_8 to set it active for edits.

 4. Locate the feature called Keyway Cut in the browser, right-click it, and choose 

Unsuppress Features.

 5. Right-click and choose Finish Edit to return to the assembly level.

Notice how the keyway cuts the part in the same location on each instance of the part, 

missing the location on the second instance due to the orientation of the two instances of 

Part_100_8. Another important aspect of the keyway is that it impacts every instance of 

the part, in every assembly it was used in. To fi x this, continue on.

 6. Double-click the front instance of Part_100_8 to set it active for edits again.

 7. Locate the feature called Keyway Cut in the browser, right-click it, and choose Delete. 

Click the OK button in the delete confi rmation dialog box.

 8. Right-click and choose Finish Edit to return to the assembly level.

 9. From the 3D Model tab, click the Create 2D Sketch button, and choose the large front face 

of the front instance of Part_100_8 to create the sketch on.

 10. From the Sketch tab, click the Project Geometry button.

 11. Select the circular edge and the three fl at edges of the keyed bar’s end profi le, projecting 

the complete key profi le into the sketch.

 12. Click the Finish Sketch button. Notice the sketch location in the browser.

 13. From the 3D Model tab, click the Extrude button. Notice that the only operation available 

in the Extrude dialog box is Cut. You cannot add material at the assembly level.

 14. Set the Extents drop-down box to All, ensure that the cut is going the right direction, and 

then click the OK button.

 15. You should see the keyhole cut through both instances of Part_100_8 and the keyed bar 

(Part_200_8) disappear.

 16. Expand the Extrusion1 feature in the browser and you will see the listing of all compo-

nents involved in the extrusion cut.



MANAGING THE BILL OF MATERIALS | 407

 17. Right-click Part_200_8 and choose Remove Participant so the keyway cut does not cut the 

keyed bar.

 18. Finally, right-click either instance of Part_100_8 and choose Open. Notice that the keyhole 

is not present in the part fi le because it exists only as an assembly-level feature.

You can close this fi le without saving changes. You should know that in addition to removing 

participating components from an assembly-level feature, you can add components to an assembly 

feature by right-clicking the feature, choosing Add Participant from the menu, and then choos-

ing the component from the browser. On the right of Figure 8.43, a component named Top-103:2 is 

being removed from the feature named Extrusion 1, so that the extrusion cut does not go through 

that part. On the left, another component is being added to the extrusion feature.

Figure 8.43

Adding/removing 

participants from 

assembly features

Assembly features can be made with the Extrude, Revolve, Hole, Sweep, Fillet, Chamfer, 

and Move Face tools. Keep in mind that all assembly features are allowed only to cut or remove 

material and cannot add material to a part. Other commonly used assembly feature commands 

within the Assembly panel environment are the Mirror and Patterns commands.

Isolate Components Before Creating Assembly Features

If you select the components to be involved in an assembly feature fi rst and then create the feature, 

you will not need to remove participants that you didn’t intend to cut in the fi rst place.

Managing the Bill of Materials
In Inventor, the BOM is the internal, real-time database that exists within every assembly. Real-
time means that as components are added to the assembly, they are automatically added and 

counted in the BOM. Although you might be accustomed to referring to the tabled list of parts 
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on the 2D drawing as a bill of materials, in Inventor such a table is called a parts list. Parts lists 

pull directly from the assembly BOM.

The BOM is controlled at two levels: the part level and the assembly level. Both levels factor 

in certain aspects of how the bill of materials is generated, how components are represented, 

and ultimately how the parts list is generated within the drawing environment.

Parts-Level BOM Control
In the part environment, the designer has the ability to defi ne the BOM structure of just a part. 

At this level, the structure can be defi ned as Normal, Inseparable, Purchased, Phantom, or 

Reference. Determining the default setting at the part level allows control of how the component 

is identifi ed within the overall BOM for any assembly the component is used in. By setting the 

structure at the part level, you can control the assembly BOM display according to the part set-

tings. Any structure settings at the part level can be overridden and changed to Reference at the 

assembly level.

Another important structure setting at the part level is the Base Quantity property. This set-

ting controls how the part is listed in the BOM. If the Base Quantity is set to Each, the part is 

tallied by count. This is the default for most standard parts. The Base Quantity can also be set 

to refl ect the value of any given model parameter. This is most often set to a length parameter 

so that the Base Quantity property will tally the total length of a part used in an assembly. Parts 

pulled from Content Center and Frame Generator have their Base Quantity property set to pull 

a length parameter by default. The Base Quantity property is set by choosing Tools ➢ Document 

Settings and selecting the Bill Of Materials tab.

Assembly-Level BOM Control
BOM control accelerates at the assembly level. You can access the Bill Of Materials dialog box 

by clicking the Bill Of Materials icon on the Manage panel of the Assemble tab. In the drawing 

environment, the BOM Editor dialog box is accessible by right-clicking the parts list and select-

ing Bill Of Materials.

The Bill Of Materials dialog box allows you to edit iProperties, BOM properties, and the BOM 

structure; override quantities for components; and sort and create a consistent item order for 

generating parts lists. Figure 8.44 shows the Bill Of Materials dialog box.

Exporting a bill of materials is a straightforward process, with icons across the top of the dia-

log box allowing the export of the BOM data in a structured or parts-only view in formats such 

as MDB, dBase, or various Excel formats. The Engineer’s Notebook icon permits the export of 

database information as a note.

Adding and Removing Columns

You can add columns to the model in any of the three tabs in the Bill Of Materials dialog box by 

clicking the Choose Columns icon, which will display a dialog box list in which you can drag 

a desired column to a specifi ed location, as shown in Figure 8.45. To remove a desired column, 

simply drag the column to be removed back to the dialog box list.

The next icon at the top of the Bill Of Materials dialog box allows you to add custom 

iProperty columns. The drop-down list shown in Figure 8.46 within the Add Custom iProperty 

Columns dialog box will display a combined list of all the available custom iProperties 

contained within the assembly.
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Figure 8.44

Bill Of Materials 

dialog box

Figure 8.45

Choose Column 

dialog box

Figure 8.46

Custom iProperty 

list
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If a desired custom iProperty does not exist within the list of components, you can add it 

manually by selecting the <Click To Add iProperty Column> option displayed in the list box. Be 

sure to set the data type to the correct format when manually adding a custom iProperty to the 

assembly fi le. Manually added iProperties will be stored in the assembly fi le. Figure 8.47 shows 

the addition of a custom iProperty column called Assembly Station.

Figure 8.47

Creating a new 

custom iProperty

Once custom iProperty columns have been added to the assembly bill of materials, indi-

vidual parts can be populated with custom iProperties as needed. Individual parts that already 

contain those iProperties will show the values within the respective row and column. iProper-

ties that are edited or added to a respective part row will be pushed down to the part level; 

therefore, fi lling out iProperties at the assembly level is often the most effi cient way to populate 

part iProperties.

The Create Expression icon located at the beginning of the Formula toolbar launches the 

Property Expression dialog box so you can create an iProperty expression. The newly created 

expression can contain a combination of custom text and iProperty names in brackets. The 

iProperty expression will be substituted for the fi eld in which the expression was created once 

the expression is evaluated. In Figure 8.48, the expression is created in the Description fi eld.

Figure 8.48

Creating property 

expressions

Looking across the top of the Bill Of Materials dialog box, the two icons to the far right are 

Part Number Merge Settings and Update Mass Properties Of All Rows. Clicking the Update 

Mass Properties Of All Rows icon recalculates the total mass for all components within the 

assembly.

Clicking the Part Number Merge Settings icon allows different components possessing the 

same part number to be treated as the same component. For instance, say six base plates of the 

same size are used in an assembly. Four of these plates have holes drilled upon installation, and 

two have holes placed during fabrication. As far as the shop is concerned, all six are the same 

part, but in the design both plate types exist as separate part fi les.
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To have the BOM count the total number of plates, you set the Part Number property to 

match on both items and then use Part Number Merge Settings to have these fi les counted as a 

single item.

BOM Structure Designations

You can choose from fi ve designations when assigning BOM structure to components: Normal, 

Inseparable, Purchased, Phantom, and Reference. Any part or assembly fi le can be assigned one 

of these designations within the BOM. The designation is then stored in the fi le, meaning that if 

a part is marked as Purchased in one assembly, it will be designated as Purchased in all assem-

blies. The structure designations are as follows:

Normal  This is the default structure for most components. The placement and participa-

tion in the assembly bill of materials are determined by the parent assembly. In the previous 

example, you created an assembly fi le rather than a single part. As a result, you will be deter-

mining the characteristics of how this assembly fi le will behave in the top-level assembly bill 

of materials. With a Normal BOM structure, this assembly will be numbered and included in 

quantity calculations within the top-level assembly.

Inseparable  These are generally assemblies that cannot be disassembled without damage. 

Examples of inseparable assemblies might include weldments, glued constructions, and riv-

eted assemblies. In a parts-only parts list, these assemblies will be treated as a single part. 

Another example is a purchased part such as a motor.

Purchased  This designation is typically for parts or assemblies that are not fabricated 

in-house. Examples of purchased components are motors, brake calipers, programmable 

controllers, hinges, and the like. A purchased component is considered as a single BOM item 

regardless of whether it is a part or a subassembly. Within a purchased assembly, all child 

parts are excluded from the BOM and quantity calculations.

Phantom  Use Phantom components to simplify the design process. A Phantom component 

exists within the design, but is not shown as a line item in the BOM. A common use for a 

Phantom component would be a subassembly of parts that are grouped for ease of design. 

Setting the subassembly to be a Phantom component allows the parts to be listed in the 

BOM individually. Other examples of Phantom components could include hardware sets, 

screws, nuts, bolts, washers, pins, and various fastener-type components. A good example 

of a Phantom assembly would be a collection of parts that are normally assembled onto the 

machine one at a time. However, in the interest of reducing the overall number of Assembly 

constraints within the design, the engineer might choose to preassemble the various compo-

nents within a Phantom assembly. That assembly could then be constrained as one compo-

nent instead of multiple parts.

Reference  Mark components as Reference when they are used for construction geometry or 

to add detail and references to the top-level assembly. A good example of a Reference compo-

nent is a car body and frame that represents the outer shell for placement of a power train. In 

the 2D documentation, the car body and frame would be shown as hidden lines illustrating 

the overall design while highlighting the power train as the principal component within a 

view. Reference geometry is excluded from quantity, mass, or volume calculations regardless 

of their own internal BOM structure. As a result, they are not included within the parts list. 

They are placed only within the overall assembly to show design intent and position.
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In addition to using these fi ve BOM structure designations for component fi les, you have the 

ability to create a virtual component, which has no geometry and does not exist as an external 

fi le. A virtual component can have a complete set of properties that are similar to real compo-

nents but are primarily used to represent bulk items such as fasteners, assembly kits, paint, 

grease, adhesive, plating, or other items that do not require creating an actual model. A virtual 

component can be designated as any of the previous BOM structure types and can contain cus-

tom properties, descriptions, and other aspects of the BOM data like any other component.

A virtual component will be shown in the Model browser as if it were a real part. Virtual 

components can be created by selecting the check box next to the Default BOM Structure drop-

down in the Create In-Place Component dialog box, as shown in Figure 8.49.

Figure 8.49

Creating a virtual 

component

Virtual Components in Templates

If you use the same virtual components in most of your assemblies, you might want to create them 

in a blank assembly, fi ll out their BOM properties using the BOM Editor, and then save the assembly 

as a template fi le. Th en when you create a new assembly, the virtual components will already be 

present. Any of them not required can simply be deleted.

BOM View Tabs

Each tab in the Bill Of Materials dialog box represents a different BOM view. All tabs permit 

ascending or descending sorting of the rows in the BOM by clicking the respective column 

header. You can also reorder rows by simply clicking and dragging a component’s icon.

With the Model Data tab active, you see the components listed just as they exist in the Model 

browser. You can add or remove columns to populate the Model Data tab independently of 

the other BOM view tabs. On this tab all components are listed in the BOM regardless of BOM 

structure designation. Item numbers are not assigned on the Model Data tab. The model data 

is not exportable or available for placement as a parts list. Instead, this tab is typically used for 

organizing the BOM and assigning the BOM structure designation.

Figure 8.50 shows a bill of materials on the Model Data tab. Notice that there are no item 

numbers listed and that all component structure types are displayed, including Reference and 
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Phantom components. Notice too that the last two parts listed are virtual parts and have been 

given different BOM structure designations.

Figure 8.50

BOM Model 

Data tab

In addition to the Model Data tab are the Structured and Parts Only tabs. These tabs are dis-

abled by default. To enable them, right-click the tab, and choose Enable BOM View; alternatively, 

click the View Options button along the top of the Bill Of Materials dialog box.

The Structured tab can display all components of the assembly, including subassemblies and 

the parts of the subassemblies. In Structured view, additional icons will be active on the toolbar, 

allowing you to sort by item and renumber items within the assembly BOM. The order of the 

BOM item numbers is stored in the assembly fi le.

The View Options icon allows you to enable or disable the BOM view and set the view 

properties from the drop-down. Choose View Properties to modify the Structured view. The 

resulting Structured Properties dialog box contains two drop-down lists defi ning the level, the 

minimum number of digits, and the assembly part delimiter value. If the level is set to First 

Level, subassemblies are listed without the components contained within. If set to All Levels, 

each part is listed in an indented manner under the subassembly, as shown in Figure 8.51.

Figure 8.51

Structured 

Properties 

dialog box

The Parts Only tab lists all components in a fl at list. In this BOM view, subassemblies des-

ignated as Normal are not listed as an item, but all their child components are displayed. By 

contrast, Inseparable and Purchased subassemblies are displayed as items, but their child com-

ponents are not displayed.
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Bill of materials settings that are modifi ed by the Bill Of Materials dialog box will carry for-

ward into the drawing parts lists contained in the assembly. Note that if both the Structured 

and Parts Only views of the BOM are enabled, the same part may have a different item number 

in each view.

Figure 8.52 shows a bill of materials in the Structured view compared to the same assembly in 

the Model Data view. The fi rst thing to note is that all the components have been assigned item 

numbers in the Structured view. You might also notice that the Reference and Phantom compo-

nents that are listed in the Model Data view are fi ltered out of the Structured view. Closer inspec-

tion reveals that although the Phantom subassembly named TK-035-001 is not included in the 

Structured view, its child parts are listed, each with an arrow next to the icon to denote that they 

are part of a subassembly. Recall that Phantom subassemblies are used to group parts for design 

organization and to reduce Assembly constraints while allowing the parts to be listed individually.

Figure 8.52

BOM structured 

view

Figure 8.53 shows a bill of materials in the Parts Only view. This Parts Only view fi lters out 

Reference and Phantom components just as the Structured view does. Notice too that although 

the subassemblies are not listed as items, their child parts are. The exceptions to this are 

Purchased and Inseparable assemblies. In the fi gure, the Purchased subassembly lists as a single 

item, since it is a Purchased component comprising two Purchased parts and is assumed to be 

purchased as one item. Note that if you had the need to list the parts as items rather than the 

subassembly, you would designate the subassembly as Phantom rather than Purchased.

Figure 8.53

BOM Parts Only tab

Take a look also at the Inseparable subassembly named TK-035-004. It lists as an item along 

with one of its child parts named K-035-01. This child part lists because it is a Purchased item 
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and needs to be ordered. Had both children of the Inseparable subassembly been Normal parts, 

neither would be listed in the Parts Only view.

Adding Two Parts with the Same Part Number

You may occasionally have the need to add two separate part fi les to an assembly but have them 

listed as the same part number. For instance, when you’re using Frame Generator, each member is 

created as a separate part even though those parts might be identical in profi le and length. Th is is 

done so you can modify each part individually as needed. However, if the parts remain identical 

once the design is complete, you can use the BOM Editor and set each identical part fi le to use the 

same part number even though the part fi les have diff erent names. Th is allows the BOM to count 

the parts as a single item.

Assembly Reuse and Confi gurations
Quite frequently, existing assemblies are used in other designs or are used in multiple locations 

within the top-level assembly. There are three basic workfl ows for reusing and confi guring 

assemblies in a design:

 ◆ Copying designs

 ◆ Using view, positional, and level-of-detail representations

 ◆ Using iAssemblies (table-driven assemblies)

Copying Designs
Quite often you’ll need to copy a previous design to create a similar design based on the origi-

nal. Part of the challenge of doing this with Inventor is creating copies of only the parts that will 

be modifi ed in the new design while reusing parts that do not incur changes, all while main-

taining healthy fi le links. To do this effectively, you can employ the Copy Components tool from 

within the assembly to be copied.

iCopy

Depending on the design, you might be called on to create subassemblies containing similar geom-

etry but having diff erent sizes and/or positions in the top-level assembly. Rather than manually 

creating each of these subassemblies, you can use the iCopy tool. iCopy combines skeletal modeling 

(using a part fi le as the “skeleton” on which to arrange other components) and adaptivity. If you 

design curtain walls, trusses, bridge-type frames, or any design where subassemblies are basically 

the same but vary in size and position, you may want to explore the iCopy tool. Th ere are four 

general steps to using iCopy:

 1. Create a target assembly, using the skeletal target layout part.

 2. Create the subassembly to be patterned, using the template layout part.
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 3. Use the iCopy Author tool in the subassembly to make it usable as an iCopy template.

 4. Use the iCopy tool to copy/pattern the subassembly.

You can fi nd a full tutorial for the iCopy tool by selecting the Get Started tab, clicking the Tutorials 

button, selecting the Experienced Users tab, and choosing the iCopy panel toward the bottom of 

the screen.

To begin this process, fi rst select the top-level assembly from the browser tree, and then 

click the Copy Components button in the tool panel. You will be presented with the Copy 

Components: Status dialog box, which lists the top-level assembly and the components within, 

as shown in Figure 8.54. Use the Status buttons next to each component to set the component to 

be copied, reused, or excluded from the copy operation.

Figure 8.54

Copy Components: 

Status dialog box

In the example in Figure 8.54, the component named mi_08_309_PCB is the only part that 

needs to be redesigned for the new assembly; therefore, it is the only part set to be copied. In the 

original design, there are two that have been excluded in this copy operation because they will 

be swapped out for other parts that are already created, after the copy has been made. You will 

notice that the other components except the top-level assembly are set to be reused. Once the 

copy status of each part is set, click the Next button to move to the Copy Components: File Names 

dialog box, shown in Figure 8.55.

Figure 8.55

Copy Components: 

File Names 

dialog box
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In the Copy Components: File Names dialog box, you want to set the destination button to 

Open In New Window in order to create a new, separate assembly fi le. You can then use the 

Prefi x and/or Suffi x controls to modify the existing fi lenames, or you can type in new names 

as required. By default, File Location is set to Source Path, meaning that the new fi les will land 

right next to the existing ones. If that is not desirable, you can right-click each File Location cell 

and choose User Path or Workspace. Care should be taken to ensure that fi le location paths are 

not set outside the project search path. When the fi lename and paths are set, click the OK button.

Rolling Revisions

A large part of any engineering department’s time and energy is focused on revision control. You 

can think of a revision roll as just a copy of an existing design with improvements. Here is a gen-

eral procedure for rolling the revision of an approved design, where Rev1 is complete and Rev2 is 

being created:

 1. Open the Rev1 assembly and start the Copy Components tool.

 2. Configure the Copy Components list to include, exclude, and reuse components as required 

for Rev2.

 3. Set the destination button to Open In New Window, and click the OK button to create the Rev2 

assembly.

 4. Rename and set the fi le location for all copied components as well as for the Rev2 assembly fi le.

 5. Add additional components to the Rev2 assembly as needed and make any other modifi cations 

required.

 6. Open the Rev1 drawing fi le, and use Save As to create a Rev2 copy.

 7. In the Rev2 drawing, click the Manage tab and use the Replace Model Reference button to exchange 

all of the Rev1 views, parts lists, and other references with Rev2.

The new assembly fi le will open in a separate window. Interrogation of the Model browser 

should reveal that the components set to be reused are listed just as they were in the original 

assembly, the components set to be copied are listed as specifi ed, and the components set to be 

excluded are not present at all.

Using Representations
Inventor provides the ability to create and store three basic types of representations within 

an assembly fi le. Representations allow you to manage assemblies by setting up varying 

views, positions, and levels of detail for your models. Each of these allows for the creation 

of user-defi ned representations, and each has a master representation. Note that although 

user-defi ned representations can be renamed and deleted as required, master representations 

cannot. Using representations enhances productivity and improves performance in large 

assembly design.

Once representations are created in an assembly, you can open that assembly fi le in any com-

bination of those representation states by clicking the Options button in the Open dialog box, as 

shown in Figure 8.56. Keep in mind that although you can open or place a fi le by typing the fi le-

name rather than scrolling and clicking the icon, you cannot access the Options button without 

explicitly scrolling and selecting the fi le in the dialog box.
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Figure 8.56

Opening a fi le in a 

representation

View Representations

View representations, also known as design views and ViewReps, are used to confi gure the display 

of an assembly and save that display for later use. View representations control the following 

settings:

 ◆ The visibility state of components, sketch features, and work features

 ◆ Component color and styles applied at the assembly level

 ◆ The enabled/not enabled status of components

 ◆ The “camera view,” meaning the on-screen zoom magnifi cation and orientation

 ◆ The browser tree state

In effect, view representations allow “snapshot views” of portions of an assembly fi le. Each 

view representation is saved within the assembly fi le and has no effect on individual parts or 

subassemblies. View representations are relatively simple to create and use. To create a view 

representation, follow these general steps:

 1. While in the assembly, simply zoom and rotate your model until you have the desired 

view showing in the current graphics window.

 2. Expand the Representations folder, and right-click View to select New, as shown in 

Figure 8.57.

 3. Turn off the visibility of a few parts; these visibility changes will take place only within 

this view representation.
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Figure 8.57

Creating a new view 

representation

 4. After creating the new view representation, click Save to preserve the newly created 

representation.

You can protect the view representation you create from accidental edits by right-clicking it 

and choosing Lock. View representations can be accessed either by double-clicking the desired 

representation or by right-clicking the desired representation and selecting Activate. Private 

view representations are views created in early releases of Inventor and are not associative.

Activating a New View Representation to Prevent Errors

Probably one of the most misunderstood “errors” in Inventor is the “Th e current Design View 

Representation is locked” message. Th is tells you that changes will not be saved, and it alarms a 

lot of new users. What this means is that you have turned off  the visibility (or enabled status or 

any number of other things) while in the master view representation. Since the master is locked, 

these changes will not be saved, and the next time you open the fi le, the model will be back at the 

previous state. To circumvent this issue, be sure to activate a new ViewRep or use the one called 

Default, make your changes, and then save. Th is way, your visibility, color overrides, and other 

settings will be saved in the ViewRep.

Positional Representations

Positional representations, often referred to as PosReps for short, can be employed to set up and 

store components in various arrangements and are used to help test and analyze assembly 

motion. Positional representations work by overriding Assembly constraints, assembly patterns, 

or component properties.

To create a new positional representation, expand the Representations heading in the 

browser, right-click the Positional Representations heading, and then choose New. Continue 

by right-clicking the component, pattern, or constraint in the Model browser that you want 

to change. Choose Override from the context menu. The Object Override dialog box will 

open to the Relationship, Pattern, or Component tab, depending on the entity type that you 
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right-clicked. You can rename the new representation from the default name to something more 

meaningful; however, you cannot rename the master representation.

In the following exercise, you will create positional representations to control the movement 

for the components of a hobby-type CNC router. Note that there are four components in this 

assembly. In the real world, these four components would be modeled as subassemblies; how-

ever, they have been created as simple part fi les in order to simplify the model. Follow these 

steps to explore the options involved in creating simple positional representations:

 1. On the Get Started tab, click Open, and then select the fi le mi_08a_023.iam from the 

Chapter 08 folder of the Mastering Inventor 2014 folder.

 2. Click and drag the component named Z-Axis Assembly_08, and notice how it can be 

dragged to cause interference and into an unrealistic location.

Currently this assembly has two sets of constraints defi ned. One set defi nes the X, Y, 

and Z travel limits, and the other set defi nes the home position for each of the assembly 

components. In the current state, all of these constraints have been suppressed. In the 

next steps you will create a positional representation and unsuppress the home position 

constraints.

 3. Click the plus sign to expand each component in the browser and notice the suppressed 

constraints.

 4. Locate the Representations folder in the browser and then click the plus sign next to 

the icon to expand it. 5. Right-click Position and choose New to create a new positional 

representation, as shown in Figure 8.58.

Figure 8.58

Creating a 

new positional 

representation

 6. Expand the Position node, if needed, and notice that a positional representation called 

Position1 has been created and is currently active, as denoted by the check mark.

 7. Select Position1, then click it and rename it Home Position.

 8. Right-click the Z Home constraint listed under the Z-Axis Assembly component and 

choose Override, as shown on the left of Figure 8.59.
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Figure 8.59

Overriding a con-

straint value

 9. In the Override Object dialog box, click the Suppression check box and set the drop-down 

box to Enable.

 10. Click the Value check box and set the value to -580 mm; then click the OK button. This 

sets the z-axis assembly to a static up and down position. You can click and drag the 

component to see this.

 11. Right-click the Y Home constraint and choose Override.

 12. In the Override Object dialog box, click the Suppression check box and set the drop-down 

box to Enable.

 13. Click the Value check box and set the value to -28 mm; then click the OK button. This 

sets the y-axis assembly to a static left and right position. If you click and drag the z-axis 

assembly, you will see that it is now locked in place.

 14. Right-click the X Home constraint listed under the X-Axis Assembly component and 

choose Override.

 15. In the Override Object dialog box, click the Suppression check box and set the drop-down 

box to Enable.

 16. Click the Value check box and set the value to 395 mm; then click the OK button. This sets 

the x-axis assembly to a static forward and backward position.

 17. Right-click the Master positional representation and choose Activate. Click and drag the 

z-axis assembly and notice that it is free to drag again.
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 18. Right-click the Home Position representation and choose Activate to set the assembly 

back to its defi ned home position; notice that it is constrained in place.

In the next set of steps you will create another positional representation and unsuppress 

the set of constraints that will control the X, Y, and Z travel limits.

 19. Right-click Position at the top level of the Positional representation node and choose New 

to create a new positional representation.

 20. Expand the Position node, if needed, and notice that a new positional representation has 

been created and is currently active, as denoted by the check mark.

 21. Rename the new positional representation to Set to Range.

 22. Right-click the Z Travel constraint and choose Suppress (Override), as shown in 

Figure 8.60.

Figure 8.60

Enabling a 

suppressed 

constraint

This toggles the suppression value of the Z Travel constraint and enables it so the travel 

is limited in the z-axis to hold it to a realistic range of motion. Next, you will do the same 

for the Y and X Travel constraints.

 23. Right-click the Y Travel constraint and choose Suppress (Override).

 24. Right-click the X Travel constraint and choose Suppress (Override). Note that you may 

need to expand the x-axis assembly component in the browser to fi nd this constraint.

 25. Right-click the Home Position representation and choose Activate. Click and drag the 

z-axis assembly to set the assembly back to its home position.

 26. Right-click the Set to Range representation and choose Activate to set the assembly so it 

can be dragged within its defi ned range of travel.

As you can see from the previous steps, positional representations are a powerful way to 

show components in multiple positions as required during the operation of a mechanism. You 

can close the current fi le without saving changes and continue on to explore the use of posi-

tional representations in subassemblies. Follow these steps to discover the tools used for han-

dling positional representations in subassemblies:

 1. On the Get Started tab, click Open, and then select the fi le mi_08a_024.iam from the 

Chapter 08 folder of the Mastering Inventor 2014 directory.

 2. Expand the Representations folder for the top-level assembly (located at the top of the 

browser tree).
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 3. Right-click Position and choose New to create a new positional representation.

 4. Expand the Position node, if needed, and notice that a positional representation called 

Position1 has been created and is currently active, as denoted by the check mark.

 5. Select Position1; then click it and rename it Range of Travel.

 6. Expand the component called CNC Hobby Router, and then expand the 

Representations folder for this subassembly.

 7. Expand the Position node to reveal the positional representations already created in this 

subassembly.

 8. Right-click the Set To Range positional representation and choose Activate.

At this point, you have created a positional representation for the top-level assembly and 

then set that positional representation to use the Set To Range positional representation 

in the subassembly.

 9. Click and drag the router assembly and notice that the parts will not move. To fi x this, 

you need to set the subassembly to be fl exible within the positional representation.

 10. Right-click the CNC Hobby Router (either in the browser or in the graphics area) and 

choose Override from the context menu. In the Override Object dialog box, you will 

notice that Set To Range is the active positional representation as defi ned previously.

 11. Click the Flexible Status check box and set the drop-down box to Flexible; then click the 

OK button.

 12. Click and drag the router assembly and notice that the parts will now move according to 

the Set To Range positional representation that is defi ned in the subassembly.

Once you’ve explored the nested positional representations, you can close this fi le without 

saving changes. Positional representations also allow the reuse of identical subassemblies 

within a top-level assembly fi le. By using positional representations in conjunction with fl ex-

ible assemblies, you can demonstrate a subassembly in different positions. Figure 8.61 shows an 

assembly containing multiple instances of a cylinder subassembly, each at a different extension 

length. This model could be created by setting up positional representations in the cylinder 

subassembly defi ning each extension value or by leaving the cylinder subassembly undercon-

strained and then setting each subassembly to be fl exible.

Figure 8.61

Multiple instances 

of a cylinder 

subassembly
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To help manage positional representations, you can set up the browser to display only the 

overrides present in each positional representation, as shown in Figure 8.62. The buttons along 

the top of the Representations browser allow you to create a new positional representation, vali-

date the overrides to ensure that no errors are created in the representations, and manage the 

overrides via Microsoft Excel.

Figure 8.62

Th e 

Representations 

browser

Because the positional representation properties of an assembly are stored separately, mul-

tiple views can be created in the drawing environment, representing different positions of the 

same assembly. Figure 8.63 shows an example of an overlay view showing both available posi-

tions of a bucket assembly on a front loader.

Figure 8.63

Overlay view 

of a positional 

representation

Level of Detail Representations

Proper use of level of detail (LOD) improves speed and reduces the memory required to load 

and navigate large assemblies. When working with a large assembly, you suppress components 

that are not required for a certain aspect of working with the design and then save that suppres-

sion state as a level-of-detail representation. For instance, if you are designing a large material-

handling unit, you might open the unit in the LOD representation with everything suppressed 

except the frame while you work on the frame skins, thereby signifi cantly reducing the number 

of parts loaded into memory.
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Suppression vs. Visibility

It is a common misconception that making components invisible reduces the overhead of your 

assemblies. When a component’s visibility is toggled off , it is still loaded into memory. To unload 

it from memory, you must utilize LOD reps. If you work with large assemblies, you can set All 

Components Suppressed as the default LOD. Th e assembly will open more quickly, and then you can 

select a previously defi ned LOD or unsuppress just the parts you want to work with. Th is method 

consumes less RAM than opening the complete assembly and then suppressing components.

Another common example of LOD representations might be to suppress external components 

while working on internal components simply for convenience. In addition to this standard 

method of suppressing components to create LOD, you can employ substitute LOD representa-

tions to trade out a large multipart assembly with a single part derived from that assembly.

Just as view and positional representations have master representations, so does the LOD. 

However, there are three additional default LOD representations: All Components Suppressed, 

All Parts Suppressed, and All Content Center Suppressed. These system-defi ned LODs cannot 

be removed or modifi ed.

All Components Suppressed  Suppresses everything within the assembly, allowing you to 

quickly open the assembly and then unsuppress components as required.

All Parts Suppressed  Suppresses all parts at all levels of the assembly; however, subassem-

blies are loaded, allowing you to examine the assembly structure without loading all the part 

fi les.

All Content Center Suppressed  Suppresses any component in the assembly that is stored 

in the Content Center Files directory as designated by the IPJ (project) fi le.

Although Chapter 9, “Large Assembly Strategies,” covers the specifi c steps to create LODs, 

here are the general procedures.

To create a user-defi ned LOD, follow these steps:

 1. Expand the Representations heading in the browser, right-click the Level Of Detail head-

ing, and then choose New Level Of Detail.

 2. Continue by right-clicking the component or components you want to suppress and 

choosing Suppress from the menu.

 3. Once this is done, you must save the assembly while still in the LOD.

 4. After saving the assembly, you can create more LOD representations or fl ip from one to 

another to compare the results.

To create a substitute LOD, you start by expanding the Representations heading in the 

browser, right-click the Level Of Detail heading, and then choose New Substitute. There are two 

methods for creating substitutes. The fi rst method simply prompts you to select any existing 

part fi le to swap out for the assembly fi le in the LOD, and the second creates a derived part from 

the source assembly. When using the Derive Assembly method, you are asked to specify a part 
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template to use and then are brought right into the derive assembly process. The derived part is 

automatically marked as a substitute during the derive process and placed into the LOD.

On the left, Figure 8.64 shows an assembly in its master LOD with 302 component occur-

rences in the assembly and 77 unique fi les open in the Inventor session, denoted by the num-

bers at the bottom of the image. On the right, the same assembly is set to a substitute LOD and 

reduced to a single component in the assembly and only two unique fi les open in the Inventor 

session. As you can imagine, you can achieve a signifi cant savings in memory by placing an 

assembly with a substitute LOD active into a top-level assembly.

Figure 8.64

Substitute LOD 

representation

It is important to understand that substitute LODs are intended to be used either by exclud-

ing components during the derive process or in combination with user-defi ned LODs to exclude 

components. Simply making a substitute LOD of an assembly with all components included 

may not give you the performance gain you anticipated unless you have made the substitute 

from another LOD that has parts suppressed, or you have excluded parts while creating the 

substitute LOD.

LOD states are created automatically when you suppress components while in the master 

LOD. To save suppressions to a new LOD representation, click Save and you will be prompted 

to click Yes or No to save the LOD. If you choose Yes, you can specify a name for the LOD. If you 

choose No, the suppression states of the component are discarded, and the assembly is saved in 

the master LOD.

Temporary LOD representations are created in subassemblies when a subassembly com-

ponent is suppressed from a top-level assembly. A tilde and index number are listed after the 

subassembly name to denote a temporary LOD state. Note that the subassembly is not modifi ed. 

You can open the subassembly on its own and save the suppression states as a named LOD if 

desired.

It is important to understand the difference between LOD representations and iAssembly 

confi gurations with respect to how they affect the bill of materials. Although you can suppress 
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features at will and substitute part fi les for assemblies with the use of LOD representations, 

Inventor still understands that all the parts in the master LOD will be included in the bill of 

materials. When you suppress a component in an LOD representation used in a drawing view, 

the view updates and any balloons attached to that component are deleted. However, the parts 

list will still list the component because it always refers to the master bill of materials.

If your intent is to create an assembly confi guration where some parts are to be listed in the 

bill of materials and others excluded, an iAssembly is the correct tool.

LODs and Parts Lists

New Inventor users often attempt to use LODs to create a parts list in the drawing environment 

that shows only the unsuppressed components. However, this is not allowed outright. To use an 

existing LOD for parts-list purposes, you should right-click it in the browser and choose Copy To 

View Rep. Once the View Rep is created, it can be used in the parts list by editing the parts list, 

clicking the Filter Settings button in the Parts List edit dialog box, and then selecting Assembly 

View Representation from the list.

Using iAssemblies
An iAssembly is a table-driven assembly fi le that allows the use of component part confi gura-

tions to build variations of a design. Some of the strengths of assembly confi gurations of this 

type are the abilities to swap out one component for another, to include or exclude components 

altogether, and to adjust assembly constraint offset values to create various confi gurations of the 

original assembly.

It is important to understand that when you create an iAssembly, you create what is called 

an iAssembly factory. The confi gurations that will be output from this factory are called the 

iAssembly members. It may help to think of the factory as the parent fi le and the members as 

children.

To create an iAssembly, most often you start with an assembly composed of iParts. First, the 

iParts are created for all parts that will vary in size or confi guration of features. Next, create the 

assembly using iPart members where required. Once the basic assembly is created, you add the 

confi guration table, turning the assembly into an iAssembly.

The assembly used in the next exercise represents a simplifi ed push-button panel. Your goal 

is to create an assembly confi guration with variations in the number and type of buttons used, 

as shown in Figure 8.65.

Figure 8.65

Confi gurations of a 

push-button panel
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Follow these steps:

 1. On the Get Started tab, click Open.

 2. Browse to Chapter 08 in the Mastering Inventor 2014 directory and open 

mi_08a_025.iam.

 3. Switch to the Manage tab and click Create iAssembly on the Author panel. This will open 

the iAssembly Author dialog box, shown in Figure 8.66.

Figure 8.66

Th e iAssembly 

Author dialog box

 4. The fi rst thing you should do is consider the naming conventions for the iAssembly 

members. Click the Options button at the bottom of the dialog box to bring up the nam-

ing options. Here, you would typically confi gure the name for the member part number 

and the member names so that as you add rows to the iAssembly table, the naming drops 

out automatically. In this case, you will simply click the OK button to choose the defaults.

Either column can be set to be the fi lename column from which member part numbers 

are generated. You can do so by right-clicking the Member or Part Number column head-

ers and choosing File Name Column from the menu. The fi lename column is indicated by 

the save or disk symbol.

 5. Examine the Components tab and expand the tree next to the part called cover_

plate_08:1. In the tree of each part are four different nodes that you can use to add a 

column to the table. Select Table Replace from the tree, and use the >> button to add it as 

a column in the table.

 6. Now that you have added a column to the table, you will add a row. Right-click anywhere 

on row 1 in the lower pane of the dialog box, and choose Insert Row. Your table should 

now resemble Figure 8.67.

The Table Replace column allows you to replace an iPart member for another iPart mem-

ber within the assembly. In this case, the part named CP_001-03 is the sheet-metal cover 

plate. This plate is an iPart that has four different sizes within the iPart table.

 7. Click the cell in row 2 in the cover_plate_08:1 Table Replace column to activate a drop-

down menu.

 8. Click the arrow for the drop-down menu, as shown in Figure 8.67. Then select CP_001-04, 

and click the OK button to exit the dialog box.



ASSEMBLY REUSE AND CONFIGURATIONS | 429

Figure 8.67

Confi guring an 

iAssembly table

 9. Examine the Model browser, and you will notice that a table has been added to the 

browser. Expand the table, and you will fi nd a listing of the iAssembly members, 

mi_08a_025-01 and mi_08a_025-02.

 10. mi_08a_025-01 will have a check mark next to it, informing you that this is the active 

member of the iAssembly. To set mi_08a_025-02 as active, right-click it and choose 

Activate, or simply double-click it.

Working with iAssemblies

Many iAssemblies require only a few size variables and a few components that can be interchanged. 

Although in the exercise using iAssemblies both the plate and buttons are iParts, often an iAssembly 

requires only a few components to be iParts for confi guration.

It is typically best to tackle iAssemblies in a very structured manner, confi guring only one part of 

the table at a time and then returning to the model to test that change. Making many changes in the 

table at once may make it diffi  cult to determine how changes aff ect the model.

Once a couple of rows are added using the iAssembly Author interface, you can edit the table with 

Microsoft Excel to add many rows at once and quickly make changes to the column entries. Also 

in Excel, you can create formulas to concatenate column entries, calculate entries, or use if/thens 

to determine entries.

 11. Now that you have used a different-sized plate, you will need to add another button to 

the assembly. To do so, select the existing black button, and use Copy and Paste to add a 

new instance to the assembly.

 12. Place an Insert constraint between the new instance of the button and the empty hole on 

the plate, as shown in Figure 8.68.

 13. Once the new button is constrained, set mi_08a_025-01 to be active again in the table 

tree, and notice that you are presented with an error message warning you that the new 
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constraint is looking at geometry that is no longer present. Click Accept in the error 

dialog box.

Notice that the new button remains even though the hole it was constrained to is gone. To 

address this, you need to edit the table further and confi gure the iAssembly to suppress 

the extra button when not needed.

Figure 8.68

Adding an Insert 

constraint

 14. Right-click the Table icon in the Model browser, and choose Edit Table.

 15. Locate part push_button_08:4 in the tree, and use the >> button to place Include/Exclude 

in the table as a column.

 16. Set the value for this column to be Exclude for row 1, as shown in Figure 8.69. Click the 

OK button to return to the model, and activate both members to see that no constraint 

errors occur.

Figure 8.69

Exclude/include 

components in an 

iAssembly

 17. Next, you will change out the black buttons in member mi_08a_025-02 to use a second 

green and a second red button. Edit the table, and choose the last two instances of part 

push_button_08 from the tree in the top-left pane. Locate the Table Replace parameter for 

each, and use the >> button to include them in the table.

 18. Set the Table Replace values in row 2 to Red and Green, as shown in Figure 8.70.

You do not need to change the values in row 1 because one of the buttons is already set to 

Black as required and the other, as you recall, you excluded so that it does not show in the 

row 1 confi guration.
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Figure 8.70

Table Replace in the 

iAssembly Author 

dialog box

 19. Click the OK button to exit the table-authoring dialog box, and then activate 

mi_08a_025-02 from the table. Note the changes to the four-button confi guration. You 

should now have two red and two green buttons in an alternating pattern.

 20. Last, you will set one of the buttons to be in a different position. Edit the table to return to 

the iAssembly Author dialog box again, and activate the Parameters tab.

 21. Expand the Constraints folder, select Insert:1, and use the >> button to add it as a 

column in the table.

 22. Set the value of this column to 7 mm for row 2 of the confi gurations.

 23. Click the OK button to exit the dialog box, and notice that one of the buttons is now 

pushed in because you have modifi ed the constraint offset value.

You can close this assembly fi le without saving changes. iAssemblies allow you to create con-

fi gurations of your assemblies by including and excluding components, confi guring constraints 

values, setting iProperties, and much more. When creating drawing fi les for iAssemblies, you 

often need a drawing for each member. The members have the same annotations and tables, 

with only some values differing.

Use Assembly Design Accelerators
The functional-design tools enable you to create complex geometry by entering size data. Before 

any geometry is created, you can verify whether the design meets the requirements by perform-

ing calculations. The formulas used for the calculations are based on international standards, 

and they are fully documented in the Engineer’s Handbook. This allows you to override or 

ignore certain calculations when experience dictates.

Functional Design vs. Geometric Modeling
Rather than modeling geometry fi rst and then hoping that the form satisfi es all the design crite-

ria, in the functional-design method you use the tools to make sure the design operates correctly 

given the design criteria prior to fi nalizing the product’s shape. If functional design is done well, 

the geometry will be the result of the design process rather than the input to it.
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Functional Design in the Real World

You might already use functional design every day but might not identify it by that name. Consider 

the following scenario: You’re called on to specify a V-belt for a current pulley system design. You 

could space the pulleys and then hope to fi nd a belt that fi ts well, but that wouldn’t be typical. 

Instead, you’d most likely narrow down the general size of the belt needed and determine the load 

and speed required, and then use this information to look up a proper belt size from a supplier 

catalog, thereby letting the function drive the design and assist you in specifying the belt. You can 

use design accelerators in Inventor to do the same thing.

Working with Design Accelerators
Design accelerators can be overwhelming at fi rst because of the sheer number of accelerators, 

and because the user interface is slightly different from the rest of Inventor. Therefore, we’ll look 

at the dialog boxes, the browser structure, and the user interface for these tools.

Design Accelerators Input

Design accelerators are available only in the assembly environment. Design accelerator dialog 

boxes are tabbed dialog boxes, as shown in Figure 8.71. The Design and Calculation tabs appear 

in most of the dialog boxes. Two particular areas in these dialog boxes are worth pointing out.

The Results pane displays the calculated values for a particular design. The Summary 

pane indicates whether a design is acceptable with the given parameters. These panes are 

hidden by default, and can be displayed by double-clicking the double line on the right and 

bottom edges of the dialog box or by clicking the >> button along the borders. The border of 

the design accelerator window turns red to indicate a design failure or to fl ag a more general 

error.

The calculation is not an automatic operation; for example, if a calculation fails and the values 

turn red, you typically change the parameters to correct the problem. You will not see the result 

of your change unless you click the Calculate button. Many calculators offer different types of 

calculations. Choosing a particular calculation method will disable certain fi elds (driven values) 

and enable some other fi elds (input values).

Remember to Calculate (or Not to Calculate)

One common mistake is not clicking the Calculate button. Th e design accelerators will not update 

when you simply change values. You must click the Calculate button.

Also keep in mind that you can deselect the Calculate button in order to not calculate the design 

and just place design accelerator components that might not comply with design inputs. Th is can 

often be helpful in the early stages of a design when you just need a form to start with.
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Figure 8.71

A typical design 

accelerator 

dialog box

Summary

Results

Design Accelerators Output

There are two sorts of functional design tools: generators and calculators. It is important to 

understand the difference between these two categories. The output generated by design genera-
tors consists of subassemblies with actual geometry in them. For example, the V-belt generator 

will generate a belt part. But it can create pulleys as well.

Design calculators don’t generate any geometry, but the result of the calculation places a sub-

assembly node in the browser and can be edited and repeated with different values. The dialog 

box for calculators is also restricted to one tab: the Calculation tab.

Most (but not all) design generators use parts generated from Content Center. Table 8.1 

lists the various design accelerators and their dependency on the Content Center library 

databases.
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Table 8.1: Design accelerators’ use of Content Center database

Generator/accelerator Needs Content Center

Bolted Connections Yes

Weld Calc No

Tolerance Stack Up Calc No

Limits and Fits Calc No

Beam Calc No (but recognizes section properties of Content Center and Frame 

Generator parts; see Chapter 15, “Frame Generator”)

Column Calc No (but recognizes section properties of Content Center and Frame 

Generator parts; see Chapter 15)

Plate Calc No

Shaft Generator No

Cam Generator No

Gear Generator No

Bearing Generator Yes

Key Connection Generator Yes

Spline Generator No

Belt Generator No

Sprocket and Chain Generator Yes

Spring Generator Yes (but only for Belleville springs)

Pins Generator Yes

Seals and O-rings Generator Yes

Engineer’s Handbook No

Design Accelerator Solve States

Many design accelerators use solve states to control when and how they solve for and update 

the geometry contained within them. The solve state of the generator subassemblies is indicated 

by an icon in the browser. Manual Solve is the default mode, but you can change it to Automatic 

Solve by right-clicking the design accelerator component, selecting Component, and then the 
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solve mode you want to use. Figure 8.72 shows the Automatic Solve icon next to the synchro-

nous belt component.

Figure 8.72

Synchronous belt 

in Automatic Solve 

mode

There are three solve states that can be changed in the Component context menu, as 

described in Table 8.2.

Table 8.2: Solve states of design accelerator components

State Explanation

Solve Off Changes to design accelerator input conditions have no eff ect on the design 

accelerator component.

Manual Solve Changes to design accelerator input conditions have an eff ect only after editing 

the design accelerator component.

Automatic Solve Changes to design accelerator input conditions immediately aff ect the design 

accelerator component.

The Solve Off, Manual Solve, and Automatic Solve options are mutually exclusive, meaning 

that when you select one option it turns the current one off. The Solve Off menu does exactly 

what its name suggests: It turns off the solver completely so that the design accelerator compo-

nent is frozen until the next edit.

The difference between Manual Solve and Automatic Solve is simple. Using the example of 

a V-belt, when the distance between the axes changes, a V-belt will automatically readjust the 

pulley positions if Automatic Solve is on. If Manual Solve is on, the user will have to update 

the pulley positions by clicking the Manual Solve menu. A red lightning bolt will appear in the 

browser. Manual Solve is used as the default for performance reasons and to prevent interac-

tions with the assembly solver.

The Calculate option on the context menu is a toggle between two states; clicking it once 

turns it on, and clicking it again turns it off. You can toggle this option by using the Calculate 
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button at the top right of each design accelerator dialog box as well. When calculation is turned 

off, the performance of the generator is faster.

Because design accelerator assemblies typically consist of multiple parts that are constrained 

together, Inventor offers specifi c edit, delete, promote, and demote tools for design accelerator 

entities.

Using Default Values

Th e values used in the last calculation of a design accelerator component will be reused when you 

create a new design accelerator component with the same generator. If you want to use the default 

values of a design accelerator, hold down the Ctrl key when starting the design accelerator tool.

Bolted Connection Generator

This generator is the most popular design accelerator tool because it is able to make an entire 

set of bolts, washers, nuts, and the necessary holes in the supporting geometry as an all-in-one 

operation. Figure 8.73 shows placement options for the Bolted Connections tool; you might 

notice the similarity between these options and the Hole tool placement options.

Figure 8.73

Placement options 

in a bolted 

connection

There are four placement options:

Linear  Allows the creation of a bolted connection without any preexisting sketch by select-

ing a distance to two different linear edges.

Concentric  Uses any circular edge (the edge does not have to be part of a hole feature; the 

edge can be part of a cylindrical extrusion) to make a bolted connection with a larger or 

smaller hole size.

By Hole  Requires an existing hole, and the bolted connection will incorporate the existing 

hole.

On Point  Requires an existing work point or vertex as input.

Although the Bolted Connections tool will create holes for you, it is often best to create the 

holes fi rst with the regular Hole tool and then use the By Hole option rather than using the 

Linear or Concentric option. The disadvantage of the latter two options is that they create only 

a point in a sketch, but the point is not dimensioned and could easily move. When the sketch 

point moves, the bolted connection will not follow the new position of the hole.

Certification
Objective
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When you use By Hole, the bolted connection will automatically follow any positional change 

of the preexisting holes but will not follow diameter changes automatically. Keeping the diam-

eter of the holes generated by the bolted connection in sync with the diameter changes in the 

preexisting hole requires manually selecting a different diameter in the Diameter fi eld of the 

bolted connection. The reason this was done is to give you a choice because you don’t necessar-

ily want all your bolts to increase in diameter when the underlying hole diameter increases.

Placing a Bolted Connection Pattern

In the following example, you will connect the cap with the plate using bolted connections. The 

cap has three holes drilled in it, and they form a circular pattern.

 1. On the Get Started tab, click Open and browse to mi_08a_027.iam in the Chapter 08 

folder of the Mastering Inventor 2014 folder.

 2. Select the Design tab and then click the Bolted Connection button.

 3. In the Placement area, confi rm that By Hole is selected in the drop-down list.

 4. Select the top face of the cap as the start plane.

 5. Select one of the holes. Since there is a hole pattern, the preview will display at the origi-

nal instance of the hole no matter which hole you select. Note too that the Follow Pattern 

option is displayed in the Bolted Connection dialog box. Check the box so that all the 

holes will get fasteners.

 6. Click the Termination button and select the back side of the plate. The Bolted Connections 

generator is smart enough to know which side of the plate is valid for termination. When 

you hover over the plate, the back side highlights and you can click to accept.

 7. In the Thread area, set the diameter to 8 mm to match the holes in the cap. In Figure 8.74, 

you can see that holes have been added to the dialog browser pane.

Figure 8.74

Following the 

holes of an existing 

pattern

Note that there are three drilled holes automatically added to the plate. You could click 

the Drilled Hole bar in the right pane and then click the down arrow to select a different 
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hole type (for example, counterbore). The Bolted Connections generator is clever enough 

to fi lter out countersink hole types for holes on faces that are not exposed.

At this point, you can add all necessary hardware to fi nish the connection. It is important 

to note that the order of the icons in the pane on the right represents the stacking order 

of the bolted connection beginning from the start plane and moving down. If you want 

to place a bolt on the start plane, you just click the area marked with Click To Add A 

Fastener.

 8. Click the area marked Click To Add A Fastener above the holes.

 9. In the resulting selection window, set Standard to DIN and Category to Socket Head 

Bolts.

 10. Select DIN 404 (or something comparable).

The bolt is automatically sized to be long enough to go through the selected components, 

if the bolt type library selected has a length that is long enough. If you want to change the 

bolt length, you can drag the preview arrow at the end. Only valid lengths from Content 

Center can be selected.

 11. To fi nish the bolted connection by adding a nut and washer, click the area marked Click 

To Add A Fastener below the holes and select a washer.

 12. Click the lower Click To Add A Fastener bar again and select a nut.

At this point, you might realize that you want to add a washer between the bolt head and 

the top face of the cap part.

 13. Click the Click To Add A Fastener bar below the bolt and choose a washer.

 14. Click Apply to create the patterned bolted connection.

You can continue experimenting with the bolted connection tool or close the fi le and con-

tinue to the next section.

Creating a Threaded Hole in the Plate

If you wanted to thread the plate to avoid adding a nut and washer, you could do so by clicking ISO 

Drilled Hole section of the pane and then clicking the button with the three small dots. Doing so 

would bring up the Hole options, allowing you to change the hole type to threaded.

Calculating the Bolt Strength

Next, you’ll edit a bolted connection and calculate its strength. The design problem you are try-

ing to solve is as follows: Considering an axial force of 750 N and a tangential force of 300 N, 

will three bolts be suffi cient to hold the cap on the plate?

 1. On the Get Started tab, click Open and browse to mi_08a_028.iam in the Chapter 08 

folder of the Mastering Inventor 2014 folder.
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 2. Locate the existing Bolted Connection in the Model browser and then right-click it and 

choose Edit Using Design Accelerator. Note you may need to expand Component Pattern 

2 and then expand Element:1 to fi nd the Bolted Connection node.

 3. In the Bolted Connection Component Generator dialog box, click the Calculation tab.

The Calculation tab provides four strength calculation options:

 ◆ Bolt Diameter Design

 ◆ Number Of Bolts Design

 ◆ Bolt Material Design

 ◆ Check Calculation

Do you meet the design criteria with just three bolts? It all depends on the material you 

choose for the bolts.

 4. Set the Type of Strength Calculation drop-down to Number Of Bolts Design.

 5. In the Loads area, enter 750 N for Maximal Axial Force and 300 N for Maximal Tangent 

Force.

 6. Assume that this application requires fasteners with high thermal conductivity. In the 

Bolt Material area, check the box next to the material fi eld and select Copper-Nickel 

C96200. To narrow down the material choices, type Copper in the text fi eld below the 

Material column header. Note that the text fi lter name is case sensitive.

 7. Click Calculate to analyze the fasteners.

In the Bolts section, you will see that the Number Of Bolts (z) is now calculated at 4 (recall 

that ul means unitless in Inventor).

 8. Click the OK button to close the Bolted Connection Component Generator dialog box.

To comply with the calculation, you need to edit the cap and update the hole pattern from 

three to four. Once you’ve done so, the bolted connection pattern will follow accordingly 

if the Automatic Solve option is enabled.

 9. Right-click the existing Bolted Connection in the Model browser and then select 

Automatic Solve from the list.

 10. Right-click the component named mi_08a_028_Cap in the browser and choose Edit. This 

will set the cap active for edits.

 11. Locate the feature called Circular Pattern 1 in the browser; right-click it and choose Edit 

Feature. This pattern controls the number of holes.

 12. Change the Placement value from 3 to 4; then click the OK button.

 13. To return to the assembly, click the Return button on the Ribbon menu or right-click and 

choose Finish Edit.

As a result of the changes you’ve made to the number of bolt holes, the bolted connection 

pattern has updated as well. Although all of the design accelerators are slightly different, they 
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all share a common way of solving problems and creating components. Autodesk provides tuto-

rials covering each of the design accelerators online at the Autodesk Inventor wiki help site:

http://wikihelp.autodesk.com/Inventor

Th e Bottom Line

Create assembly relationships using the Constraint and Joint tools.  Assembly relation-

ships are an important part of working with Inventor assembly fi les. Assembly constraints 

determine how assembly components fi t together. As relationships are applied between com-

ponents, degrees of freedom are removed.

Master It  You are new to 3D and fi nd the concept of assembly relationships a bit chal-

lenging. Where can you fi nd a simple overview of constraints?

Organize designs using structured subassemblies.  Subassemblies add organization, 

facilitate the bill of materials, and reduce assembly relationships; all this results in better per-

formance and easier edits. One of the habits of all Inventor experts is their effective use and 

understanding of subassemblies.

Master It  You need to hand off an accurate BOM for fi nished designs to the purchas-

ing department at the end of each design project. How can the BOM be extracted from 

Inventor?

Work with adaptive components.  Geometry can be set to be adaptive so that it can be 

sized and positioned in the context of where it is used in the assembly. You can set undercon-

strained geometry to be adaptive by specifying the elements allowed to adapt.

Master It  You want to set a feature of a part to be adaptive so that it can adapt to anoth-

er part in an assembly. However, the feature is based on a fully constrained sketch. How 

would this be done?

Create assembly-level features.  An assembly feature is a feature created and utilized 

within the active assembly fi le. Because the feature is created within the assembly fi le, it does 

not exist at the single-part or subassembly level.

Master It  You want to make a notch in a standard part that will not affect its use in ev-

ery other assembly it is used in. Can this be done?

Manage bills of materials.  Managing a bill of materials can be a large part of any assembly 

design task. Understanding the BOM structure goes a long way toward successfully confi g-

uring your bill of materials.

Master It  You need to mark a component as a reference component in just one assembly 

fi le. However, when you attempt to do so using the BOM Editor, it is designated as a ref-

erence in every assembly. How can you set just a single instance of a component to be a 

reference component?

http://wikihelp.autodesk.com/Inventor
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Use positional reps and fl exible assemblies together.  Often, you may need to show a 

design in various stages of motion to test interference and/or proof of concept. Copying 

assemblies so that you can change the assembly relationships to show different assembly 

positions can become a fi le management nightmare. Instead, use fl exible subassemblies and 

positional representations.

Master It  You need to show your assembly in variations dependent on the position of 

the moving parts and the task the machine is accomplishing at given stages of its opera-

tion. How do you do this?

Copy assembly designs for reuse and confi guration.  Because of the live linked data that 

exists in Inventor assemblies, using Windows Explorer to copy designs and rename parts is 

diffi cult and often delivers poor results. Using the tool provided in Inventor will allow you to 

copy designs and maintain the links between fi les.

Master It  How do you duplicate an existing design to create a similar design?

Substitute a single part for entire subassemblies.  Working with large assemblies, particu-

larly where large, complex assemblies are used over and over as subassemblies within a top-

level design, can tax almost any workstation if not approached in the correct manner.

Master It  You would like to swap out a complex assembly for a simplifi ed version for 

use in layout designs or to use in large assemblies in an attempt to improve performance. 

What is the best way to do that?

Work with assembly design accelerators and generators.  Design accelerators and genera-

tors allow you to rapidly create complex geometry and the associated calculations that verify 

the viability of your design.

Master It  Your design needs a bolted connection, but you are not certain about the 

number of bolts to use to ensure a proper connection. How do you determine this?

Use design calculators.  Design calculators do not create any geometry, but they permit you 

to store the calculations in the assembly and repeat the calculation with different input val-

ues at a later time.

Master It  You need to calculate the size of a weld between two plates to withstand a 

certain lateral force. What tool do you use? 





Chapter 9

Large Assembly Strategies

Working with large assemblies is more manageable than ever before with the Autodesk® 

Inventor® software’s Express mode tools. Using Express mode allows you to open a large assem-

bly four to six times more quickly than opening the same fi le using Full mode. Combining 

Express mode with the use of tools such as shrinkwrap and substitute level of detail (LOD) 

representations improves performance and minimizes the time spent waiting. Substitute LODs 

allow you to swap out complex subassemblies with single substitute parts of less detail, all the 

while maintaining model properties and an accurate bill of materials (BOM).

Although each design department may have a different view on what a large assembly is, 

everyone can benefi t from the large assembly tools and strategies discussed in this chapter. 

You can create fully functional digital prototypes ranging from 10 to 100,000 components if you 

approach the task with an eye to the topics covered here.

In this chapter, you’ll learn to:

 ◆ Select a workstation

 ◆ Adjust your performance settings

 ◆ Use best practices for large assembly

 ◆ Manage assembly detail

 ◆ Simplify parts

Selecting a Workstation
Ensuring that you have an adequate system to accomplish the type of design work you intend 

to do is an important, but often overlooked, step in achieving successful large assembly design 

with any parametric modeler. Understanding the capabilities and limitations of your computer 

and then budgeting for upgrades is a crucial part of working in today’s design world.

If you consider the time you spend waiting and the loss of work experienced when work-

ing on an undersized computer, you will likely determine that a workstation upgrade will pay 

for itself within a year. If you budget for upgrades every two years, you could argue that the 

upgrade is paying for itself in the second year of use. Although this scenario might not fi t your 

situation exactly, it demonstrates the idea that operating costs (hardware and software alike) 

should be budgeted and planned for, and always measured against lost work and downtime.
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Physical Memory vs. Virtual Memory
When your system runs low on physical memory (RAM) and requires more to complete an 

operation, Windows begins writing to a portion of the system hard drive known as virtual 

memory to continue. Virtual memory is often called a pagefi le.
When considering a workstation for doing large assembly design, it should be your goal to 

work in RAM as much as possible because when Windows begins to write to virtual memory, 

you will notice a considerable drop in performance. One of the weakest links in terms of speed 

on even the most adequate workstation is the hard drive. Accessing data from RAM can be 

thousands of times faster than accessing data from the hard drive. Therefore, one of the best 

ways to beef up a workstation is to simply add more RAM.

If you are running an older computer or you skimped on RAM when you upgraded, you 

will notice that as you attempt to load large assemblies or drawing fi les of large assemblies in 

Inventor, you quickly use up available RAM. You will fi nd yourself waiting for Windows to 

write data to the hard drive and then read that data. Although the unknowing user might think 

that Inventor has suddenly become slow, you should understand that no application can over-

come the hardware and operating system limitations upon which it is installed.

Autodesk recommends a minimum of 12 GB of RAM for working with large or complex 

assemblies, with 24 GB or more being ideal.

Hardware
Hardware upgrades are an important part of any design department. Budgeting properly and 

knowing what components to allocate more money to can make these upgrades more manage-

able. Dollar for dollar, you should give priority to the components described in the following 

sections, in the order listed.

RAM

When it comes to RAM, the more your system has, the better it will handle large and complex 

assemblies in Inventor. You can use the number of unique parts in your assemblies (unique 

parts as opposed to multiple instances of the same part) as a general rule of thumb when deter-

mining how much RAM to consider. Here is a list of recommendations based on unique part 

count:

 ◆ More than 5,000 unique parts: 6 GB of RAM

 ◆ More than 10,000 unique parts: 12 GB of RAM

 ◆ More than 15,000 unique parts: 18 GB of RAM

 ◆ More than 20,000 unique parts: 24 GB of RAM

Calculating the ROI of New Hardware

It’s often hard to convince management (especially nontechnical managers) that you really do need 

that new computer to get your job done. After all, you’re currently getting your work done, right? 

So why do you need the faster computer? Th is is where a return on investment (ROI) calculation 

will come in handy.
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Let’s say you routinely have to open, modify, and print large assembly drawings. To calculate the 

ROI, follow these steps:

 1. Measure how long it takes to complete this process on your old machine.

 2. Look at some benchmarks or talk to others who have faster machines, and make a conservative 

estimate of how long it would take you to do the same operations on the faster machine.

 3. Subtract the second number from the fi rst. You now have your time savings per operation.

 4. Multiply this by the number of times in a day or week you perform these tasks.

 5. Multiply it by an hourly rate for your industry (you can always use your hourly salary) to get the 

dollar savings per time period (per week, month, and so on).

 6. Now you can take the cost of the new system and divide it by this cost savings per unit of time. 

Th is gives you the amount of time it will take to pay off  that new computer.

Furthermore, once this time period has passed, you are actually making money because you are 

saving the company money once the investment has been paid off . When you can show that the 

hardware will pay for itself relatively quickly, you should have fewer problems convincing manage-

ment to upgrade your equipment.

Another consideration for the ROI is who will inherit your old system. Generally, some person in the 

offi  ce will also benefi t from a faster system, even if they run general offi  ce applications. For instance, 

if the receptionist is required to access many documents quickly across a network while assisting 

customers and other offi  ce staff , there is a good chance that your old CAD station will improve the 

ability to do so. Because this key person is the fi rst point of information for so many people, the 

ROI is exponential. Passing old workstations to the shop fl oor to allow shop staff  to access digitally 

stored fi les quickly is another way to achieve ROI and justify workstation upgrades.

You can check the specifi cations of your motherboard to determine how much RAM your 

system can accept. Many RAM manufactures, such as Crucial (www.crucial.com), have utilities 

on their websites that will look at your system and tell you the RAM confi gurations that your 

system can accommodate.

Graphics Cards

In the past it was generally recommended that you consider an OpenGL (developed by Silicon 

Graphics) graphics card that was tailored for CAD stations via a custom driver. Graphics card 

manufacturers and CAD developers worked together to produce and certify cards and drivers 

to offer the best results. With the introduction of Windows Vista, Autodesk began developing 

Inventor to work with Direct3D (part of Microsoft’s DirectX application programming inter-

face). Inventor 2014 was developed to work with versions of DirectX not available on earlier 

operating systems; therefore Windows 7 with a DirectX 10 or newer–compatible graphics card is 

recommended.

With the move to Direct3D, using OpenGL and custom drivers is no longer necessary. I rec-

ommend that to fi nd the best card for your workstation, you buy the card with the best perfor-

mance within your budget. You can research cards by using a DirectX graphics processing unit 

benchmark website such as PassMark (www.cpubenchmark.net).

http://www.crucial.com
http://www.cpubenchmark.net
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Gaming Cards for CAD?

In the past, high-performing gaming cards were not recommended for CAD applications because 

the drivers were developed for diff erent purposes, and they often performed poorly when running 

CAD software. Now, though, with Direct3D not relying on custom drivers, gaming cards may very 

well off er the best performance for the dollar.

To ensure that Inventor has the optimal settings, select the Tools tab, click Application 

Options, and select the Hardware tab in the dialog box that opens. Inventor will automatically 

detect the appropriate level for your card, but you can set it manually to infl uence system perfor-

mance if needed. You can choose from the following setting choices:

Quality  This setting sacrifi ces system performance for better graphics presentation. If 

you’re running Windows 7 or Vista, anti-aliasing is turned on to improve the visual quality 

of the graphics display. For machines running Windows XP, there is no difference between 

Quality and Performance.

Performance  This setting favors system performance over graphic presentation. If you’re 

running Windows 7 or Vista, anti-aliasing is turned off. This is the default setting.

Compatibility  This setting uses the same graphics processes as the Inventor 2009 and earlier 

releases. Options such as Visual Styles and Realistic Appearance Materials are not available.

Software Graphics  This setting uses software-based graphics processing instead of hard-

ware-based processing. The setting is often used to troubleshoot issues with a graphics card. 

For more information and recommendations on graphics cards and other hardware, refer to 

the following website:

www.inventor-certified.com/graphics/

Hard Drives

Inventor fi les are segmented, meaning that the graphics are separate from the feature infor-

mation. When an assembly is fi rst opened, only the graphics segments are loaded. When you 

edit a fi le, the additional data is loaded at that time. This makes a fast hard drive important for 

performance.

Another aspect of hard drive performance stems from fi le storage and workspace setup. In 

Inventor, working from your local drive is the preferred method, and Autodesk has often rec-

ommended that you avoid working on Inventor fi les across a network (although many or even 

most Inventor users do work across a network without issue). The reason for this is simply the 

number of fi les that you might be editing at one time. For instance, a change to a large assembly 

could potentially modify hundreds of part fi les, requiring all those fi les to be saved at once. 

Doing this across a network, particularly one with latency issues, may result in fi le corruption if 

the fi les are not saved correctly. Autodesk Vault is set up to store fi les on a server and copy those 

fi les locally when checked out for editing. When working in this manner, Inventor has a higher 

performance requirement than standard offi ce applications, and the hard drive workload is very 

http://www.inventor-certified.com/graphics
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heavy. Therefore, it may be worth it to consider upgrading your hard drive to a higher-speed 

drive.

Processors

When considering processors for an Inventor 2014 workstation, the chief question should con-

cern multicore processors. As a minimum, you should consider a dual-core processor even 

though Inventor is not truly a multithreaded application. (Multithreaded means that the oper-

ating system or the application will spread the processing load across the processor.) If you 

opt for a dual-core processor, you can still take advantage of it because Inventor will run on 

one core and other applications will run on the other. There are parts of Inventor—such as 

InventorViewCompute.exe, which computes drawing views, and Inventor Studio’s rendering 

engine—that are multithreaded, so if you work with large or complex drawings or plan to do a 

lot of image and animation rendering in Inventor, you will likely benefi t from more cores.

Working with Performance Settings
Whether or not upgrading workstations is an option, you should ensure that your system is set 

up for optimal performance for working with large assemblies. A number of options in Inventor 

will facilitate this.

Express Mode
Express mode accelerates fi le opening for large assembly fi les by not loading all of the assembly 

tools that Inventor offers in Full mode. Once an assembly fi le is opened in Express mode, you 

can click the Full mode button to enable the additional tools when necessary. This simple but 

effective mode switching can allow you to access your large assembly fi les an average of four to 

six times more quickly.

One of the primary differences you see when using Express mode is that you cannot edit 

components in the context of the assembly fi le. That is, when you right-click a component in 

the assembly, you will not see the Edit option. Instead, you will need to right-click and choose 

Open, and then make the edits to the component. Once the edits are made, they will be refl ected 

in the assembly, even though it is still in Express mode.

To open an assembly in Express mode you fi rst need to enable the Express mode option, and 

then save the assembly fi le so that the additional Express mode information will be included 

in the fi le. You can enable Express mode by selecting the Tools tab, clicking the Application 

Options button, and then selecting the Assembly tab in the dialog box that opens. Select the 

Enable Express Mode Workfl ows option, and then set the File Open Options to a unique fi le 

threshold that fi ts your typically large assembly and workstation. For instance, if your worksta-

tion typically struggles when you open an assembly that references roughly 400 unique fi les, 

you’d set this number to 400.

You can also bypass the unique fi le threshold and use Express mode to open an assembly fi le 

with fewer unique fi les, by browsing to the fi le, selecting it, and then clicking the Options button 

found in the Open dialog box. Here you’ll see the Open Express check box, which will force the 

fi le to open using Express mode regardless of the unique fi le number. If the Express mode check 
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box is grayed out, the fi le needs to be saved with the Enable Express Mode Workfl ows option 

enabled fi rst, to include the Express mode information in that fi le.

Working with Drawing Settings
Generating and hiding lines when creating and editing drawing views in Inventor can be some 

of the most processor-intensive tasks in Inventor. To help ease the demand on the system when 

you’re working with large assembly drawings, you should be aware of several settings. You can 

fi nd these settings by selecting the Tools tab, clicking Application Options, and selecting the 

Drawing tab in the dialog box that opens, as shown in Figure 9.1.

Figure 9.1

Drawing applica-

tion options
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Display Line Weights

The Display Line Weights check box enables or disables the display of unique line weights in 

drawings. Deselect the box to show lines without weight differences. Line weights will still 

print correctly, even with this box selected. Deselecting this box will speed up the performance 

of your drawing during edits and annotation work.

View Preview Display

The options in the Show Preview As drop-down box set the type of preview you get when 

creating a view. All Components is the default, but you will fi nd that selecting the Partial or 

Bounding Box option will improve performance because Inventor will not be required to create 

and update the preview as you drag your mouse pointer around the screen. The preview setting 

does not affect the drawing view result. Bounding Box previews a simple rectangle during the 

view creation, and Partial previews a simplifi ed representation of the view. Bounding Box is the 

most effi cient.

When using this option, you can still preview the assembly if you’d like by selecting the 

Preview check box in the Drawing View creation dialog box, but the default will be a simple 

bounding box. Using the Bounding Box option is suggested if you fi nd yourself waiting for the 

preview to generate during drawing view creation.

The Section View Preview As Uncut check box will also provide some performance improve-

ments when selected. This option will allow Inventor to display the section view preview as 

unsectioned in order to be more effi cient. The section view will still be generated as normal.

Enable Background Updates

When background updates are enabled, raster views are created temporarily until the computa-

tion is complete. This is indicated by green border corners on the views and a green view node 

in the browser. Raster views are simplifi ed placeholder pictures of the view, used to create and 

place the view quickly so as not to slow you down when creating views of large or complex mod-

els. Precise drawing views are calculated in the background while you work with raster views.

You can hover your mouse pointer over the drawing view node in the browser to see the 

percentage of compute progress. Heavy view computation is spread over multicore processors 

using InventorViewCompute.exe, as is evident in the Windows Task Manager.

While a view of a large assembly or complex model is computing, you can continue to create 

other views or annotations. However, some tools are disabled during view computation. These 

tools are listed here:

 ◆ Automated Centerlines

 ◆ Auto Balloon

 ◆ Project Geometry

 ◆ Hidden Annotations

 ◆ Model Features
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Drawings containing raster views can be saved and closed while background computations 

are still working. If the drawing is closed during background updates, the updates will stop and 

be restarted the next time the drawing is opened.

Memory Saving Mode

Memory Saving Mode sets the way Inventor loads components into memory during view cre-

ation. When this option is selected, Inventor loads components into memory before and during 

view creation, and then unloads them from memory once the view is created.

Although memory is conserved using this mode, view creation and editing operations can-

not be undone while this option is enabled. You’ll notice that the Undo/Redo buttons will be 

grayed out after a view creation or edit. This option will also have a negative impact on perfor-

mance when you’re editing and creating views because the components must be loaded into 

memory each time. Because of this, you should consider setting this option as an application 

setting only if you always work with very large assemblies.

It is generally preferred to set this option per document by selecting the Tools tab, clicking 

Documents Settings, selecting the Drawing tab in the dialog box that opens, and then setting 

the Memory Saving Mode drop-down list to Always. Figure 9.2 shows the default setting of Use 

Application Options.

Figure 9.2

Drawing Document 

Settings
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Shaded Views

Also in the document settings, you can adjust the way that shaded views are displayed. Setting 

the Use Bitmap drop-down list to Always, as shown in Figure 9.2, improves performance by 

applying raster shading as opposed to a vector style. The difference impacts the display but 

typically does not affect printing.

You can also adjust the bitmap resolution; setting it lower conserves memory and speeds 

up performance. The default is 100 DPI. Setting the DPI to 200 or higher will invoke a prompt, 

warning you that increasing this setting for large assemblies may not be possible.

Troubleshooting Graphics Issues and Crashes

It’s often diffi  cult to determine the source of graphics issues and graphics-related crashes without 

knowing how to isolate and illuminate some of the variables. One of the best ways to do this is to 

go to the Hardware tab of the Application Options dialog box and set the Graphics Setting radio 

button to use Software Graphics.

This setting uses Inventor, rather than your graphics card, to render the on-screen graphics. 

Th erefore, any graphics anomalies that exist while using this setting can be attributed to some-

thing other than the graphics card. If you set this option to Software Graphics and your graphics 

issues go away, your video card (or video card driver) is mostly likely the cause. If the issue returns 

when you set the option back to the recommended setting, then you should look into updating or 

rolling back your graphics card driver or getting a diff erent graphics card that handles Inventor 

graphics better.

Keep in mind that this is a just a test, and I don’t recommend running Inventor using the Software 

Graphics setting all of the time, since it will cause Inventor to run slowly.

Working with Model Display Settings
When working within the modeling environment, you can adjust several settings to have a posi-

tive impact on performance. You can access these settings by selecting the Tools tab, clicking 

Application Options, and selecting the Display tab in the dialog box that opens, as shown in 

Figure 9.3.

Appearance

All of the various display options can be controlled as application settings or as document set-

tings. Using the application settings allows consistency across all of the documents that you work 

with. Document settings will adopt the settings that were used when the document was saved.

Not all settings are controlled by the Appearance option, but very useful settings such as 

displaying the model in orthographic or perspective view and what visual style you want active 

can be defi ned.

Display Quality

Setting the Display Quality drop-down shown in Figure 9.3 to Rough will speed up perfor-

mance by simplifying details. Navigation commands such as zooming, panning, and orbiting 
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are particularly affected by this setting. If you fi nd that the rough display is not to your liking, 

you can toggle back and forth according to the size of the assembly model you are working 

with.

Figure 9.3

Th e Display tab in 

the Application 

Options dialog box

View Transition Time (Seconds)

The View Transition Time (Seconds) setting controls the time required to transition smoothly 

between views when using zooming and viewing commands. A zero transition time takes you 

from the beginning view to the end view instantaneously. For instance, if you were zoomed in 

on a small component and wanted to zoom to show all components while this slider was set to 

zero, you would not see the gradual zooming out. While this might provide a gain in perfor-

mance, understand that it can make display changes concerning position and orientation less 

clear, with the result that your adjustments would appear somewhat erratic.
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Minimum Frame Rate (Hz)

You can use the Minimum Frame Rate (Hz) setting to specify how slowly the display updates 

during zooming and orbiting commands. It may be hard to see the effects of this option on a 

normal-sized part or assembly because the views will typically update more quickly than the 

rate of this setting, but with large assemblies the results become obvious as components are 

dropped from the display during zoom and orbit updates. Here is a quick description of how 

the slider setting corresponds to the frame rate:

 ◆ 0 always draws everything in the view, no matter the time required.

 ◆ 1 tries to draw the view at least one frame per second. (Inventor will simplify or discard 

parts of the view if needed but will restore them when movement ends.)

 ◆ 5 draws at least fi ve frames per second, 10 draws at least ten frames per second, and so on, 

up to a maximum of 20. Using the maximum frame rate of 20 will speed up zoom and orbit 

operations and give you the best results for large assemblies.

The settings in the Display tab can affect the performance of the system as well as the user’s 

comfort when working in Inventor.

Working with General Settings
The following sections describe a few general settings that you can adjust to help the perfor-

mance of large assemblies. You can access these settings by selecting the Tools tab, clicking 

Application Options, and selecting the General tab in the dialog box that opens. That tab is 

shown in Figure 9.4.

Update Physical Properties On Save

When checked, the Update Physical Properties On Save setting, located in the Physical 

Properties area on the right side of the dialog box, recalculates the mass properties of the model 

when you save the fi le. This ensures that mass properties are up-to-date. Setting this to Parts 

Only will ensure that the parts are all up-to-date without requiring you to wait on the recalcula-

tion for large assemblies. Note that this setting is disabled altogether by default but is recom-

mended to be set to Parts Only if you fi nd it helpful. Note too that the same function can be 

performed manually from the Bill Of Materials Editor and the Manage tab.

Undo File Size

The Undo File Size option, on the lower-right side of the dialog box, sets the maximum size 

of the temporary fi le that records changes to a fi le so that actions can be undone. It’s typically 

required to increase the size of this setting when working with large models and drawings 

because each undo action is typically a larger calculation. Autodesk recommends adjusting this 

in 4 MB increments.

Enable Optimized Selection

The Enable Optimized Selection setting, located on the lower-right corner of the dialog box, 

improves the performance of graphics during prehighlighting in large assemblies. When the 
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Enable Optimized Selection setting is activated, the algorithm for the Select Other function 

fi lters for only the group of objects closest to the screen. If you click through this fi rst group of 

objects, the next group is considered for highlighting.

Figure 9.4

Default application 

options

Status Bar

The status bar displays information concerning the number of fi les being accessed by Inventor, 

at the bottom-right corner of the Inventor screen, as shown in Figure 9.5. The number to the left 

is the total number of occurrences of all components in the active document. The next number is 

the total number of fi les open in the Inventor session.
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Figure 9.5

Th e status bar

Using the Memory Probe
Included in your install of Inventor is a utility designed to monitor memory use for your system. 

The MemProbe utility, shown in Figure 9.6, looks at the Inventor process and displays its use of 

physical and virtual memory. It can often be useful in troubleshooting issues of capacity and 

slow performance. You can fi nd this tool at the following location. You might fi nd it useful to 

create a desktop shortcut to it, if you fi nd yourself using it often:

C:\Program Files\Autodesk\Inventor 2014\Bin\memprobe.exe

Figure 9.6

Th e MemProbe 

utility

Working with System Settings
You can adjust several settings in the operating system to help with performance. Inventor users 

commonly set the pagefi le size to twice the amount of RAM to gain performance. There are also 

many visual effects that you may have grown accustomed to that actually cost you resources. If 

you are serious about turning your workstation into a large-assembly workhorse, it is advisable 

to disable these features.
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Adjusting the Virtual Memory Paging File Size

To change the size of the virtual memory paging fi le in Windows 7, right-click the Computer 

icon and choose Properties. On the System Properties tab, click the Advanced System Settings 

tab, click Performance Options, and fi nally, under Virtual Memory, deselect Automatically 

Manage Paging File Size For All Drives. Then click Change.

Windows 7 is set to an Automatic or System Managed paging fi le size. If you choose to set 

a Custom paging fi le size, you should refer to the recommended size that the dialog box offers 

and set the minimum and maximum to the same value to minimize fragmentation of the pag-

ing fi le if it needs to expand. Figure 9.7 shows the Virtual Memory dialog box.

Figure 9.7

Setting the pagefi le 

size

Setting Virtual Memory

Search the Internet and you will fi nd hundreds of incorrect theories as to how to set the values for 

your virtual memory. One of the major myths is that you should set the initial and maximum to 

diff erent values. If you are dedicating a portion of your hard drive for a pagefi le, why start it small 

and then let it grow? Just provide the maximum amount of space you can and let it be.

Disabling Common Visual Effects

Windows provides many options to set the visual effects of your computer. Many of them have 

a surprisingly high impact on performance when memory is scarce. Here are a few you might 

consider disabling in order to conserve resources:

Screen Saver  To disable the screen saver, you can right-click your desktop and choose 

Personalize; then set the Screen Saver option to None. While you are working, screen savers 

are just another running process. You may want to set the Power Saving Mode option to turn 
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off the monitor after a certain amount of time. If you use an LCD monitor, understand that 

screen savers do nothing to save an LCD screen.

Visual Settings  Many of the fade and shadow settings used in Windows look nice but 

come with a performance price if your system is on the slow side. To adjust these settings you 

can right-click your desktop and choose Personalize; then select the Windows Classic theme.

Screen Resolution  If you’re fortunate enough to have a nice, large-screen monitor, you 

probably have set up the screen resolution to maximize your space. However, this may be 

working against your large assembly pursuits. Experiment with setting the screen resolution 

to a lower setting such as 1024×768 to see whether you gain any performance when working 

with large assemblies.

Large Assembly Best Practices
Oftentimes, Inventor users don’t think about large assembly performance until it has already 

become an issue with the model on which they are working. It is possible for two Inventor users 

working on two identical workstations to create two seemingly identical models, and yet those 

two models might perform in dramatically different ways.

If the fi rst user has been mindful of large assembly management all along, his model and 

drawings will be much easier to open and work with. If the second user concentrated only on 

her design and gave no thought to the memory demands of the fi les she was creating, her model 

will be slow to open and work with and ultimately more likely to cause application crashes and 

data corruption. When the next job comes along, user one can reuse his model to create a similar 

design, whereas user two will likely re-create the assembly model because she does not trust the 

integrity of the fi rst model she created.

Understanding where performance savings can be gained as you create the model will pay 

off once the large assembly is created and will make it much more manageable to work with 

along the way. And of course, a large assembly model can be revisited and cleaned up according 

to best practices to make it more manageable as well. Either way, having a model that is manage-

able and can be reused for similar work in the future should always be your goal.

You should be considering assembly performance when creating and editing a model, when 

opening the model, and also when detailing and annotating the model.

Working with the Model
You can use several methods to ensure that your large assembly will not become unmanageable. 

It is important to remember that the term large assembly is subjective. To you a large assembly 

may be 200 components, whereas it may be 20,000 to someone else. Either way, following best 

practices ensures that you are developing good procedural habits and are prepared for the day 

when you are asked to design a much larger assembly than you typically do today.

As was discussed earlier in this chapter, hardware limitations might be an obstacle that you 

cannot overcome even if you follow every best practice, but you’ll need to follow these practices 

to know that for certain. Conversely, even if you have a workstation that is extremely capable, 

you will still benefi t by developing good work habits and making your models easier to handle 

on less-capable workstations of others you collaborate with.

Improving File Open Time
It is a good practice to shut down Inventor and other Windows applications if you will be leav-

ing them for an extended period of time. Closing these applications can allow the system to free 
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up memory “leaked” by drivers and subroutines that take up memory when executed but do not 

release it when fi nished, even if you don’t use those functions again.

When working with large datasets, shutting down the application and reloading the model 

can be time-consuming. There is a default setting on the File tab of the Application Options dia-

log box that saves the last-opened assembly and its component fi les in cache. You can also defi ne 

a specifi c fi le to be kept so that you can work with others and maintain the benefi ts of the Quick 

File Open setting for a specifi c assembly.

Reducing Assembly Constraints
Using subassemblies within upper-level assemblies can reduce assembly constraints. The 

importance of this concept cannot be overstated. Reducing assembly constraints can eliminate 

the number of redundant calculations Inventor must make to solve your model, and therefore 

it pays off immediately in that respect. The improved organization and ability to reuse compo-

nents already organized into subassemblies is a benefi t that may be realized in the future.

To reorganize an assembly that has not been created using subassemblies, you can use the 

Demote option. To explore this concept, let’s make some changes to an assembly:

 1. Open the fi le mi_9a_001.iam located in the Chapter 09 directory of your Mastering 

Inventor 2014 folder. If you have not already downloaded the Chapter 9 fi les from 

www.sybex.com/go/MasteringInventor2014, please refer to the “What You Will Need” 

section of the Introduction for the download and setup instructions.

Although not a large assembly by anyone’s standard, this assembly has been created 

without using subassemblies to demonstrate the ability to demote components into sub-

assemblies from the top down. Currently, this assembly has a total of 31 constraints being 

used at the top-level assembly. Your goal is to restructure this assembly into three subas-

semblies so that you can reduce constraints and create subassemblies that can be used in 

other stapler designs.

 2. At the top of the Model browser, you’ll see the words Assembly View with a drop-down 

arrow next to them. Use the drop-down arrow to change the browser view to modeling 

view.

Assembly View  Displays assembly constraints and connections nested below the as-

sembly components, as well as in the Relationships folder. Part modeling features are 

hidden.

Modeling View  Displays all assembly constraints and connections in a folder named 

Relationships at the top of the browser tree. Each part’s modeling features are dis-

played below the part.

 3. Click the plus sign next to the Relationships folder found at the top of the browser tree 

to display the list of all the constraints in the assembly.

 4. In the Model browser, select all the components with a prefi x of 100.

 5. Once you’ve selected those components, right-click and choose Component ➢ Demote, as 

shown in Figure 9.8.

 6. You are presented with a Create In-Place Component dialog box, where you can specify 

the name of the new subassembly, the template fi le, the fi le location, and the default BOM 

structure. Enter 100 for the name, set the BOM structure to Phantom, and then click OK.

http://www.sybex.com/go/MasteringInventor2014
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Figure 9.8

Demoting com-

ponents to a 

subassembly

Phantom Subassemblies

Setting a subassembly as Phantom prevents it from being listed in the bill of materials while still 

allowing the parts contained within the subassembly to be listed.

 7. Click Yes in the warning stating that assembly constraints will be moved with the 

demoted components, shown in Figure 9.9.

Figure 9.9

Restructuring com-

ponents warning

This warning simply states that any constraints between the 100-series parts and the 

200- and 300-series parts will now be redefi ned to be between subassembly 100 and 

the 200- and 300-series parts. The constraints between the 100-series parts and other 

100-series parts are maintained in subassembly 100.

This is important in large assemblies because it can signifi cantly reduce the number of 

constraints used. Consider the fi ve components you selected to demote in the stapler. If 

these components all had just one assembly constraint, each relating it to some part that 

will not be in the new subassembly, those fi ve constraints will be discarded.

Continuing with the example, you should now see the subassembly named 100.iam in 

the Model browser. Because of the restructure, you will need to ground the assembly so 
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that it cannot be accidentally moved. Then you can continue to demote components into 

another subassembly.

 8. Right-click 100.iam, and click Grounded to set it in place.

 9. In the Model browser, select all the components with a prefi x of 200.

 10. Right-click, and choose Component ➢ Demote.

 11. Enter 200 for the name, set the BOM structure to Phantom, and then click OK. Click Yes 

in the warning dialog box.

 12. Repeat the steps for demoting for all the components with a prefi x of 300 until your 

browser looks like Figure 9.10.

Figure 9.10

Subassemblies cre-

ated by demoting

If you look in the Relationships folder at the top of the browser tree, you’ll see that the 

number of constraints that exist at the top level of the assembly has been reduced considerably.

You can also restructure components by dragging a component listed in the assembly 

browser, either in or out of a subassembly browser node. Moving components up out of a sub-

assembly is called promoting rather than demoting. Because you can promote or demote uncon-

strained and underconstrained components, you may need to edit the subassembly and ensure 

that components are constrained properly within that subassembly.

Assembly Constraint and Adaptivity Options

Th ere are three Application Options settings to be aware of that can impact assembly performance. 

When working with large assemblies, you might want to have all three of these options deselected. 

You can fi nd them by selecting the Tools tab, clicking the Application Options button, and then 

selecting the Assembly tab. Th e options are as follows:

 ◆ Enable Constraint Redundancy Analysis

 ◆ Enable Related Constraint Failure Analysis

 ◆ Features Are Initially Adaptive
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Adaptivity
Too many cross-part adaptive features can cripple the performance of even a modest-sized 

assembly if used without discretion. As discussed in Chapter 8, “Assembly Design Workfl ows,” 

adaptivity should generally be turned off once the adaptive feature or part is created.

Often features and parts are made adaptive during the early design stages of a model, when 

changes are made quickly and you want many parts to follow these changes. Turning off the 

adaptive status in the part ensures that your assembly performance will not be affected. If 

the adaptive part needs to be edited, you can turn on its adaptive status so that you can make 

adjustments.

Many times parts become adaptive by default when a new part or feature is created in an 

assembly, because a reference sketch is projected from one part to another. You can disable 

this by clicking Application Options on the Tools tab, selecting the Assembly tab in the dialog 

box that opens, and then deselecting the Enable Associative Edge/Loop Geometry Projection 

During In-Place Modeling option under Cross Part Geometry Projection.

You can also hold the Ctrl key while selecting individual edges for projection into your 

sketch. This works only when you’re selecting individual edges. Selecting a face will build an 

adaptive relationship. Either technique will create fewer accidental adaptive parts, but may 

require more manual effort in projecting geometry across parts.

Selection Tools
When working with a large assembly, combing through all the many parts within that assembly 

that you want to select for a given task can be time-consuming and diffi cult if you attempt to 

locate them using the standard Pan, Zoom, and Orbit methods. Instead, make yourself familiar 

with the options in the assembly selection tools.

You can use selection tools to suppress sets of components based on such factors as size, 

internal components that are not visible because of the presence of external housings, and so on. 

For instance, to maintain performance, you may not want to load all the internal components 

into memory when they are not important to your current design task. Once you’ve selected 

the internal components, you can suppress them and create an external-part-only level of detail 

representation. If you’ve not created level of detail (LOD) representations before, you can fi nd 

information on how to do so in Chapter 8. 

Another use of assembly selection tools is to create view representations in the assembly to 

aid in the creation of views in the drawing fi le. As an example, when you place a view in the 

drawing using a design view that was created with the All In Camera tool, only the components 

in the screen view plane are calculated. This increases performance and memory capacity. 

Figure 9.11 shows the available selection tools.

The following selection tools are available:

Select Component Priority  Sets the selection to pick up the topmost structure level of com-

ponents. If set, this will pick up subassemblies and not their children.

Select Part Priority  Sets the tool to select parts, no matter what their subassembly 

structure. 

Select Body Priority  Sets the tool to select solid bodies within their parent part fi le, no mat-

ter what their subassembly structure. This option works best when using the Modeling view. 

When using the Assembly view, the Find In Browser option does not work.
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Select Feature Priority  Selects individual features rather than the parts that contain them.

Select Faces And Edges  Allows you to highlight and select faces or the curves that defi ne 

those faces.

Select Sketch Features  Allows you to highlight and select sketches or the curves that 

defi ne those sketches.

Select Visible Only  Selects only visible components in a selection set.

Enable Prehighlight  Displays prehighlighting when your cursor moves over an object. 

This does not affect the Select Other tool, which always shows prehighlighting.

Invert Selection  Deselects all components previously selected, and selects all components 

previously unselected.

Previous Selection  Reselects all components in the previous selection set.

Select All Occurrences  Selects all instances in the current fi le of the selected component.

Select Constrained To  Selects all components constrained to a preselected component or 

components.

Select Component Size  Selects components by the percent set in the Select By Size box. 

Size is determined by the diagonal of the bounding box of the components. Click the arrow 

to select a component, and measure its size to use as a scale. Figure 9.12 shows the Select By 

Size dialog box.

Figure 9.11

Available selection 

tools

Figure 9.12

Select By Size dialog 

box
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Select Component Offset  Selects components fully or partially contained within the 

bounding box of a selected component plus a specifi ed offset distance.

Select Sphere Offset  Selects components fully or partially contained within the bounding 

sphere of a selected component plus a specifi ed offset distance.

Select By Plane  Selects components fully or partially intersected by a specifi ed face or 

plane.

Select External Components  Selects external components based on a percentage of the 

component’s viewable surface.

Select Internal Components  Selects internal components based on a percentage of the 

component’s viewable surface.

Select All In Camera  Selects all components in the current view screen based on a percent-

age of the component’s viewable surface.

Using the Feature Selection Filter to Select Work Planes

It can be a major pain to try to select a work plane while in a busy assembly fi le. To make it easier, 

use the Select Feature Priority fi lter or the Select Faces And Edges fi lter. Your cursor will no longer 

select parts but only features, making it easy to select even the most obscured work planes.

View Representations
View representations are often used in large assemblies to navigate to a predefi ned viewing 

angle so that you do not have to tax your system with heavy graphics regeneration. For instance, 

if you have an assembly that contains an entire production line of material-handling equipment, 

you may fi nd it diffi cult to orbit around to the backside of the assembly to complete a simple 

task such as selecting a face or just looking at the assembly. If you set a design view before orbit-

ing and then set another once you have orbited to the desired view, you can then easily toggle 

between the two views of this assembly, thereby increasing performance during navigation 

between these predefi ned views.

View representations have other large-assembly benefi ts as well. When creating a drawing 

view of a large assembly, you can specify a preset view representation and reduce the time it 

takes to create the drawing view. If you have turned off the visibility of some components in the 

assembly view representation, the drawing view can generate even faster and provide you with 

a clearer and more concise view. Of course, if you already have the assembly open when creat-

ing the drawing view, the components are likely already loaded into memory.

Another way that the experienced Inventor user may use view representations is to navigate 

the Model browser. For instance, if you set up a view representation to zoom in on a particu-

lar subassembly so that you can navigate to that component quickly, you can save that view 

representation while the entire model tree is rolled up and only the subassembly of interest is 

expanded. This browser state will be saved within the view representation.

Once a view representation is created, you can right-click it and choose Copy To Level Of 

Detail to copy the view representation to an LOD representation. This allows you to transfer the 

visibility settings from the view representation to the LOD where they will be suppressed. In 

this way, you do not have to duplicate the process of turning parts off.
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Find
Navigating a large-assembly Model browser can be a chore. To help with this, you can employ 

the Find tool to defi ne search criteria for constraints, components, features, sketches, and welds. 

Searches can be saved for future use and recalled as needed using the Open Search button, 

shown in Figure 9.13.

Figure 9.13

Th e Find tool in an 

assembly fi le

You can access the Find tool in the following ways:

 ◆ From within a fi le, click the binoculars icon in the Model browser.

 ◆ In the Inventor Open dialog box, click the Find button.

Opening the Model
One of the most important aspects of working on a large assembly fi le is being able to open the 

fi le. Although this seems obvious, many Inventor users seem to approach opening a model as 

an afterthought. Consider it in this way—if you were tasked with carrying a pile of stones up a 

fl ight of stairs, you would probably be unlikely to attempt to carry them all up the stairs at once. 

But this is exactly the kind of heavy lifting you are asking your workstation to do when opening 

a large assembly.

To allow your workstation to make multiple trips when opening an assembly fi le, you will 

use LOD representations. You create LOD representations by suppressing components in an 

assembly. Once the LOD is created, you can access it the next time you begin to open the fi le by 

using the Options button, shown in Figure 9.14. Once the assembly fi le is open, you can unsup-

press components as required, and those components will then be loaded into memory. You 
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can also specify a default LOD so that the assembly opens to it without your having to use the 

Options dialog box every time. This is done from Application Options on the Assembly tab. 

You’ll learn more about creating LODs later, in the “Managing Assembly Detail” section of this 

chapter.

Figure 9.14

Opening LODs

If you need to open a large assembly that has not been properly managed, you may fi nd 

yourself having to locate or skip a number of parts and subassemblies. This can be a tedious 

task, but the Skip All Unresolved Files option in the File Open dialog will bypass locating miss-

ing components and load the members of the assembly that can be located automatically.

LOD in Subassemblies

Often, you might create a complex assembly model as a stand-alone design because you need to 

insert that model into an upper-level assembly as part of a larger system. Because the original 

design was required to generate production drawings and an accurate BOM, it includes all the 

components in the design.

However, because you will be placing multiple instances of this subassembly, you want to avoid 

placing it at the full level of detail. You might create an LOD in the subassembly where all internal 

components, all external hardware, and all internal and external fasteners are suppressed, leaving 

only the external housing and frame components.

LOD representations of subassemblies can be accessed from the Options button in the Place 

Component dialog box when you are placing them into upper-level assemblies. By placing a subas-

sembly at a reduced level of detail, you have created a much smaller, top-level assembly fi le and yet 

still have the ability to pull an accurate BOM even from the top-level assembly.
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Working with Large Assembly Drawings
Although large assembly fi les require some forethought and management; so do the drawing 

fi les of these large assemblies. Because Inventor generates the line work from the models that 

you create views from automatically, it is easy to take for granted the large number of calcula-

tions required to do this. Stop for a moment and consider all the hidden lines, sectioned parts, 

and so on that Inventor has to consider in order to render your drawing views accurately.

It is for this reason that you will want to adopt slightly different techniques than those you 

use to make part or small assembly drawings. If you have not yet worked with Inventor’s draw-

ing environment much at this point, you can fi nd more information specifi c to Inventor draw-

ings in Chapter 12, “Documentation.” Keep in mind that many of the options mentioned in 

section are covered in more depth in Chapter 12.

Working with High-Speed Raster Views

You can enable an option to create raster views for large or complex models. When enabled, a 

draft preview of a drawing view will be displayed while the precise drawing view is calculated 

in the background. Raster drawing views enable you to continue to work and annotate the 

drawing while the precise calculation of a drawing view is completed.

To enable a raster view you can use either of two methods. One creates a raster view until the 

view calculation is complete, at which time it converts to a precise view. The other option main-

tains the view as a raster view until you choose to make it a precise view. 

To enable temporary raster view creation, select the Drawing tab of the Application Options 

dialog box, and then select the Enable Background Updates option (toward the bottom) to use 

raster views. By default this option is not selected. This setting will create the view as a ras-

ter view but will allow the raster view to convert to a precise view when the calculations are 

complete. 

To create views that persist as raster views, you can select the Raster View Only check box 

found at the bottom of the Drawing View creation dialog box, as shown in Figure 9.15. In order to 

convert a raster view to a precise view once it has been created, you can right-click the view and 

choose Make View Precise. You can convert it back to a raster view by right-clicking again and 

choosing Make View Raster.

Raster views are indicated by green corner glyphs in the graphic window and by either the 

green circular arrows icon in the browser if the view is calculating toward becoming precise 

or a red slash across the view icon in the browser for a static raster view. If you place your 

cursor on a calculating raster view icon, you’ll see a tool tip showing the progress of precise 

calculation. 

There are several features that are not available or will work differently while the precise 

views are being calculated and the raster view is displayed. This alternative functionality is 

intended to handle the situations where the less-detailed raster views might cause confusion or 

problems.

These features are not available for raster views:

 ◆ Automated Centerlines cannot be created for raster views.

 ◆ Auto Balloons cannot be used for raster views.

 ◆ Model Features cannot be selected as edges in raster views.
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These features work differently for raster views:

 ◆ Tangent model edges are always shown in raster views, and their properties or visibility 

cannot be edited.

 ◆ Interference edges are not shown in raster views.

 ◆ Reference Parts might have incomplete geometry in raster views.

 ◆ Hole Tables are not available to use the View and Feature options for raster views.

 ◆ Thread Annotations are not displayed in raster views. New or existing thread notes are 

attached to thread features after views turn precise.

 ◆ Printing when a drawing includes raster views provides three options: You can print the 

current precise views, wait until all views are precise, or cancel the print. However, I do not 

recommend that you print raster views, because geometry on printed raster views can be 

different from the fi nal precise views.

 ◆ Export to AutoCAD DWG, DWF, DXF, or PDF cannot be completed for a drawing with ras-

ter views. If a precise view calculation is in progress, a progress bar is displayed. You can 

wait until the calculation fi nishes or cancel the export.

 ◆ Save and Close for drawings containing raster views can be executed as expected. If the fi le 

is closed and reopened, the raster views are automatically recalculated as precise.

Figure 9.15

Creating a raster 

drawing view from 

an LOD

Creating Large Assembly Drawing Views

When creating drawings of large assemblies, it is advised that you do so from an LOD rep-

resentation already created in the model. Doing so reduces the number of fi les Inventor is 

required to access to create and update the line work in the view. To create views from assembly 
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representations, you specify the representation(s) you want to use in the Drawing View dialog 

box, as shown in Figure 9.15 earlier. Keep in mind that when browsing for the fi le to create a 

view of, if you use the Options button in the Open dialog box to specify the representation, you 

will reduce the time it takes to create the view.

Although using LODs will help with drawing views, be aware that because Inventor employs 

a global bill of materials, as soon as you place a parts list, balloon, or other annotation referenc-

ing the bill of materials, the number of fi les loaded into memory increases to include all of the 

parts in the bill of materials. This situation somewhat defeats the purpose of the LOD tools, but 

currently no solution is available.

View Preview Display

If you fi nd yourself waiting for the preview of your assembly to generate before being able to 

proceed with view creation options, you will want to change the preview display to use bounding 

boxes and then enable the preview on fi les as required on a case-by-case basis by clicking the pre-

view icon shown at the bottom left of Figure 9.15. Note that enabling/disabling the preview is an 

option only when using the Bounding Box or Partial option. To fi nd this setting, select the Tools 

tab, click Application Options, select the Drawing tab in the dialog box that opens, and look in the 

View Preview Display section.

Reducing Hidden Lines

Hidden-line generation can be one of the most memory-intensive aspects of creating a drawing 

view. Generally, with large assemblies it is not desirable to show the hidden lines of all compo-

nents. Instead, you typically will want to enable hidden lines for just those components where 

hidden lines add clarity.

Rather than selecting the Hidden Line style in the Drawing View dialog box, fi rst create the 

view with no hidden lines. Next, locate and expand the view you just created in the browser, 

and select the components you intend to be shown with hidden lines. Right-click the compo-

nents, and choose Hidden Lines.

You will be prompted with a message box informing you that you are changing the view 

style to show hidden lines and that any children of this view will be granted an independent 

view style based on their current setting, as shown in Figure 9.16. The result will be that only 

the components you chose will be displayed with hidden lines.

Figure 9.16

Managing hidden 

lines
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Creating Title Block Logos

A sure way to slow down your drawing’s performance is to create an unnecessarily complex 

title block. If you have included a bitmap of your company logo in your title block, ensure that 

the bitmap fi le is reduced in resolution and fi le size as much as possible. You can use any photo 

editor to do this.

Once you’ve reduced the bitmap fi le as much as possible, consider embedding the fi le into the 

title block rather than linking it. Although linking the bitmap does give you greater fl exibility in 

updating the logo independent of the title block, Inventor will be required to locate the bitmap 

each time the drawing is loaded. To embed rather than link the logo bitmap, simply deselect the 

Link check box when inserting the bitmap.

If you have pasted the logo in from Autodesk® AutoCAD® software, ensure that the logo is 

as clean as possible. You may be better off removing the hatches from the logo in AutoCAD and 

then adding them using the Fill/Hatch Sketch Region tool in Inventor.

Reducing the Number of Sheets and Views per Drawing File

Although it is possible to create a large number of sheets in a single drawing fi le, it is generally 

accepted that this is not good practice. Instead, you should consider making a new fi le for each 

drawing sheet when possible. Or at the very least, keep the number of sheets per fi le as low as 

possible. There are two primary reasons for doing so.

The fi rst reason is simply to keep the fi le size down. If you have a drawing of a large assem-

bly fi le that includes four sheets and has a fi le size of 80 MB, you could split this into two fi les, 

each with two sheets and a fi le size of approximately 40 MB. In this way, you do not need to load 

the extra 40 MB in sheets 3 and 4 just to make an edit to sheet 1.

The second reason to minimize drawing sheets is so you are not guilty of placing all your 

eggs in one basket. Creating multiple tab or sheet fi les in any application can be risky. Imagine 

you created a load calculation spreadsheet and you developed the habit of adding a tab for each 

new calculation you do rather than creating a new fi le for each calculation. If the fi le becomes 

corrupt, you’ve lost all your calculations rather than just one set of calculations. The same thing 

could happen with your Inventor drawing if you habitually create new sheets instead of 

new fi les.

Managing Assembly Detail
In Chapter 8, you learned about creating LOD representations within your assemblies to reduce 

the memory requirements of working with large assemblies. Here you will consider how you 

can use these LOD representations to handle large assemblies more effi ciently.

LOD Strategies
All Inventor assemblies have four default LODs predefi ned and ready for you to use. Learning 

to use them and creating your own LODs is an important part of working with large assemblies. 

The default LODs are as follows:

Master  This LOD shows your assembly with no parts suppressed. You can think of it as the 

highest level of detail for any assembly.
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All Components Suppressed  This LOD suppresses everything within the assembly. You 

can think of it as the lowest level of detail for any assembly.

All Parts Suppressed  This LOD suppresses all parts at all levels of the assembly, but subas-

semblies are loaded.

All Content Center Suppressed  This LOD suppresses any component in the assembly that 

is stored in the Content Center Files directory as designated by the IPJ (project) fi le or the 

Application Options settings.

When opening a large assembly, you can use the All Components Suppressed LOD to 

quickly open the fi le and then manually unsuppress components as required. However, it is 

more practical to create your own LODs and use them to effi ciently open your assemblies. 

Consider creating intermediate LODs based on your design process.

For a closer look at LODs in action, follow these steps:

 1. From the Get Started tab, choose Open.

 2. Open the fi le mi_9a_002.iam from the Chapter 09 directory of your Mastering 

Inventor 2014 folder.

 3. Expand the Representations folder and the Level Of Detail node in the Model browser 

if they are not already expanded.

 4. Right-click the Level Of Detail header, and choose New Level Of Detail. Change the 

name from LevelofDetail1 to MediumLOD.

 5. In the Quick Access toolbar (along the top of the screen), click the selection tool drop-

down list (see Figure 9.17), and set your selection focus to Select Component Priority if it 

is not already.

 6. Using the same drop-down list, now choose Internal Components, shown in Figure 9.17.

Figure 9.17

Selecting internal 

components

 7. Set the slider to 85 percent, and click the green check mark.

 8. Right-click anywhere on the screen, and choose Isolate to get a better view of the compo-

nents you selected. Your screen should look similar to Figure 9.18.

 9. Now you’ll bring back one component to add to your selection set. Select the component 

called MA- 001:1 in the browser, right-click, and choose Visibility. You should see the 

motor subassembly become visible.
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Figure 9.18

Isolated internal 

components

 10. Select all the components on the screen. You can use a crossing window to do this 

quickly.

 11. Right-click, and choose Suppress.

 12. Right-click anywhere, and choose Undo Isolate to bring back the visibility of the remain-

ing unsuppressed components.

 13. Save the assembly to ensure that the changes to your newly created level of detail are 

recorded.

 14. Switch back and forth between the master LOD and your MediumLOD to observe the 

differences.

 15. To modify MediumLOD, activate it and suppress any component you’d like; then save the 

assembly.

In the preceding steps you used selection fi lters to quickly select the internal parts and then 

used the Isolate tool to toggle the visibility setting of the unselected components. Then you 

suppressed the visible components. Understand that it is the Suppress option that creates and 

modifi es LOD representations. Changing visibility affects only View representations and has 

no impact on the LOD. When you’ve fi nished experimenting with this fi le, you can close it and 

continue on to the next section.

 Substitute LODs
You can use substitute LOD representations to trade out a large multipart assembly with a single 

part derived from that assembly. Substitute LODs improve effi ciency by reducing the number 

of fi les Inventor is referencing and, if created from other LODs, can also reduce the amount of 

geometry required.

For example, in the blower assembly, you could create a substitute LOD from the entire 

assembly and then place that substitute into a top-level assembly as needed. You would cer-

tainly gain some effi ciency by doing this because the top-level assembly is referencing only one 

fi le. However, if you created a substitute from MediumLOD, you would be maintaining an even 

higher level of performance in the top-level assembly because all the internal geometry that was 

suppressed in the creation of that LOD would be omitted.
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To create a substitute LOD, follow these steps:

 1. From the Get Started tab, choose Open.

 2. Browse for the fi le mi_9a_003.iam located in the Chapter 09 directory of the Mastering 

Inventor 2014 folder, and click Open.

 3. Expand the Representations folder and the Level Of Detail node in the Model browser 

if they are not already expanded.

 4. Double-click MediumLOD to set it as the active LOD if not already done.

 5. Right-click the Level Of Detail header in the browser, and choose New Substitute and 

then Shrinkwrap. Notice that Inventor is asking you to specify a fi lename, a fi le template, 

and a location to create this fi le.

 6. Enter mi 9a 003 Substitute 100 for the name in the New Derived Substitute Part dialog 

box, and leave the template and fi le location at the defaults.

 7. Click OK. Inventor opens a new part fi le and takes you directly into the shrinkwrap pro-

cess, bringing up the Assembly Shrinkwrap Options dialog box.

 8. In the Style area at the top, ensure that the Single Composite Feature option is selected. 

The following are the descriptions of each of the four available options:

Single Solid Body Merging Out Seams Between Planar Faces  Produces a single solid 

body without seams. Merged faces become a single color, where required.

Solid Body Keep Seams Between Planar Faces  Produces a single solid body with 

seams. Colors are retained.

Maintain Each Solid As A Solid Body  Produces a single part fi le with multiple bodies. 

This is the closest approximation to an assembly.

Single Composite Feature  Produces a single surface composite feature and the smallest 

fi le. Colors and seams of the original components are maintained. The mass properties of 

the original assembly are stored in the fi le for reference.

 9. Ensure that the Remove Geometry By Visibility check box is selected.

 10. Select Whole Parts Only.

 11. Play around with the slider, clicking the Preview button to see what is removed.

 12. Set the slider to 78 percent.

 13. Under Hole Patching, select All.

 14. Ensure that Reduced Memory Mode is selected at the bottom of the dialog box. When 

selected, this option allows the derived part to be created using less memory by not 

including the source bodies of the assembly parts.

 15. Refer to Figure 9.19 to check the settings, and then click OK.
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 16. Click Yes when asked about the mass properties. Note that Inventor closes the derived 

part fi le and returns to the assembly and that an LOD named SubstituteLevelofDetail1 

has been created. You can rename it if you like by clicking it once and then a second time.

Figure 9.19

Deriving a 

shrinkwrap LOD

 17. Save the assembly.

 18. Double-click MediumLOD to set it as active, and compare the substitute LOD by clicking 

back and forth between the two.

 19. To see that the substitute shrinkwrap is a surface model, click the View tab, and choose 

the Half Section View icon from the drop-down list on the Appearance panel.

 20. Click Workplane2 in the Model browser.

 21. Right-click, and choose Done.

 22. Choose End Section View from the drop-down list on the Appearance panel to turn off 

the section view.

Figure 9.20 shows the substitute LOD as it appears in the browser.
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Figure 9.20

Substitute LOD

Recall that all LODs maintain an accurate BOM listing. To confi rm this, select the Assemble 

tab, click Bill Of Materials, and interrogate the BOM to see that even though the substitute LOD 

consists of a single part, Inventor still maintains the BOM information for the entire assembly. 

You can close this fi le without saving changes and move on to the next section.

 Subassembly LODs
Subassembly use is where LOD representations really begin to pay off in terms of performance. 

Once LOD representations have been created in your assembly, you can switch the LOD in the 

subassemblies to match in three ways:

 ◆ Place the subassemblies into a top-level assembly with the matching LOD by using the 

Options button.

 ◆ Switch the LOD manually in the subassembly in the Model browser.

 ◆ Use the Link Levels Of Detail tool at the top-level assembly to automatically set the subas-

semblies to the matching LOD.

In Figure 9.21, all of the subassemblies contain LODs named Frame Layout, Exhaust 

Connection, and Harness Layout set up within them. These LODs were linked using the Link 

Levels of Detail tool, as indicated in the browser by the LOD name shown in parentheses next to 

the assembly name.

You might take this concept one step further and edit your assembly templates to automati-

cally include standard LOD names already in them. This way you do not have to create the 

LODs, but instead you can simply activate them and then suppress parts as required to “fi ll 

them out.”

Recall that Inventor specifi es your template location on the File tab of the Application 

Options dialog box. Note that this can be overridden in your project fi le. Check this by selecting 

the Get Started tab and then clicking the Projects button, and look in the Folder Options section 

of the Project File Editor that opens. If a path is specifi ed there, that is where your templates are 

located. If it shows = Default, the path found in application options is where your templates are 

located.
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Figure 9.21

Nested LODs with a 

consistent naming 

scheme

In the following exercise, the subassemblies all have LODs created in them. These are called 

Bolts, Washers, Nuts, and Galvanized. Each subassembly was confi gured with these LODs set 

up as described in the previous exercise. The top-level assembly has three LODs created, called 

Bolts, Washers, and Nuts. Although these LODs have been created, they have not been confi g-

ured and currently do not differ from the master LOD. The following steps take you through the 

linking of the Bolt LOD at the top-level assembly to the Bolt LODs in the subassemblies:

 1. From the Get Started tab, choose Open.

 2. Open the fi le mi_9a_004.iam from the Chapter 09 directory of your Mastering 

Inventor 2014 folder.

 3. Expand the Representations folder and the Level Of Detail node in the Model browser.

 4. Double-click the LOD named Bolts to set it active, or right-click it and choose Activate.

 5. Click the Assemble tab, expand the drop-down list for the Productivity panel, and choose 

Link Levels Of Detail.

 6. Click Bolts in the Link Levels Of Detail dialog box.

 7. Click OK in the Link Levels Of Detail dialog box, and click OK to accept the warning that 

the assembly will be saved.

Note that the subassemblies have all been set so that the Bolts LOD is active in them. If one 

of the subassemblies did not have an LOD called Bolts, it would be left at its current LOD. You 

can continue this exercise by repeating these steps for the Washers and Nuts LODs if you’d like. 

Note too that each of the subassemblies has an LOD called Galvanized in which all parts that 
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are not galvanized steel have been suppressed. You can create an LOD called Galvanized in the 

top-level assembly and then use the Link LODs tool to suppress all the parts not made of galva-

nized steel. You can also set different instances of a subassembly to display differing 

LOD representations.

Using LOD Naming Conventions

Th ere is an infi nite number of naming conventions for LODs, including the one suggested here 

(High, Moderate, and Low). Making LODs that have certain parts of the design turned on can be 

useful as well—for example, Frame Only, Frame & Transmission, Transmission Only, Conveyors 

Off , No Robots, and so on. If you give them descriptive names, other users can select the appropri-

ate LOD for the work they need to complete.

Simplifying Parts
It’s often suggested that things be made as simple as possible but not simpler. This is a good con-

cept to keep in mind when creating models in Inventor. Adding extraneous details to common 

parts can have a negative impact on large assembly performance. Of course, if the part fi le is to 

be used for fabrication, then a certain level of detail is required. Oftentimes, though, we create 

models of common parts to be used in an assembly for the end goal of getting an accurate bill 

of materials. Assembly performance could most likely be improved by reducing the amount of 

detail in those types of parts.

Removing or Suppressing Unneeded Features
Reducing the number of edges and faces in a part is a sure way to minimize the size of the part 

fi le. Removing fi llets and chamfers for purchased parts is a good way to eliminate extra faces. 

If you have common parts that are used in large numbers throughout your assemblies, you 

might consider creating two versions of these parts: one version for use in large assemblies and 

another for use in creating production drawings and Inventor Studio renderings. In Figure 9.22, 

you can see two versions of the same part. The fi le for the part on the left is approximately 600 

KB, whereas the one on the right is less than 175 KB.

Figure 9.22

A simplifi ed part
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In the following steps, you will derive a simplifi ed version of a part and set the part numbers 

to match so the two fi les report the same in the BOM and parts lists. To create a simplifi ed part, 

follow these steps:

 1. From the Get Started tab, choose Open.

 2. Open the fi le mi_9a_010.ipt from the Chapter 09 directory of the Mastering Inventor 

2014 folder.

 3. Click the end-of-part (EOP) marker in the Model browser, and drag it to just below the 

feature named Revolution1 (or right-click Revolution1 and choose Move EOP Marker).

 4. Change the appearance to Default (at the top of the screen in the Quick Access toolbar, 

click the Appearance drop-down arrow, and scroll for Default).

 5. Do not save the part.

Figure 9.23 shows the end-of-part marker being placed above the existing features.

Figure 9.23

Using the EOP 

marker to simplify 

the original part

 6. From the Get Started tab, choose New.

 7. Choose the Standard.ipt template to create the new fi le, and click the OK button.

 8. In the new part, right-click and choose Finish Sketch if required. This might not be 

needed if you have your Application Options setting set up so that a new sketch is not 

created automatically when a new part is created. 

 9. On the Manage tab, click the Derive button on the Insert panel.

 10. In the resulting Open dialog box, browse for the fi le mi_9a_010.ipt located in the 

Chapter 09 directory of your Mastering Inventor 2014 folder, and click the Open 

button.

 11. In the resulting Derived Part dialog box, choose the Derive Style option called Single 

Solid Body Merging Out Seams Between Planar Faces as the derive style.

 12. Click the OK button to create the derived body.

 13. In the Model browser, right-click the part name mi_9a_010.ipt, and choose Suppress 

Link With Base Component. This ensures that the derived part will remain in the simpli-

fi ed state when you set the original part back to its fully detailed state.
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 14. Click the fi lename at the top of the Model browser, and choose iProperties.

 15. Choose the Project tab of the iProperties dialog box, and enter mi_9a_010 as the part 

number. This ensures that as you use the simplifi ed part in an assembly, it will have the 

same part number as the original part and report an accurate BOM.

 16. Save the fi le as mi_9a_010_simple.ipt.

 17. Return to the original part (mi_9a_010.ipt).

 18. Either close the fi le and click No when asked to save changes, or drag the EOP marker 

back to the bottom of the Model browser, reset the part color, and then save the fi le.

The result is two fi les representing the same part. Both will list as the same component in 

the BOM, but the derived component will add far less overhead when used over and over in an 

assembly. Note that if the original part were to require a revision to the overall length, you would 

want to edit the simplifi ed part fi le and unsuppress the link, so that the changes are carried 

through. You can place both fi les in an assembly fi le to test this workfl ow if you’d like, or you can 

close these fi les and continue on.

Th e Bottom Line

Select a workstation.  Having the right tool for the job is the key to success in anything you 

do. This is true of selecting a large assembly workstation. You have learned that for optimal 

performance you should strive to keep your system working in physical memory (RAM).

Master It  You notice that your computer runs slowly when working with large assem-

blies and you want to know whether you should consider a 64-bit system. How do you 

determine if your system is adequate or if it’s time to upgrade?

Adjust your performance settings.  You have learned that there are many settings in 

Inventor and in Windows that you can use to confi gure the application to work more effi -

ciently with large assemblies.

Master It  You want to make your current workstation run as effi ciently as possible for 

large assembly design. What are some ways to do that?

Use best practices for large assembly.  Knowing the tools for general assembly design is 

only half of the battle when it comes to conquering large assemblies. Understanding the 

methods of large assembly design and how they differ from those for general assembly 

design is a key to success.

Master It  You want to create adaptive parts so that you can make changes during the 

initial design stage and have several parts update automatically as you work through the 

details. But you are concerned about how this will adversely affect your assembly perfor-

mance. How do you keep your performance level high in this situation?
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Manage assembly detail.  Inventor includes several tools to help manage assembly detail so 

that you can accomplish your large assembly design goals.

Master It  You want to reduce the number of fi les your large assembly is required to ref-

erence while you are working on it and yet maintain an accurate bill of materials. How do 

you do that?

Simplify parts.  Creating highly detailed parts may be required for generating production 

drawings or Inventor Studio renderings, but using those high-detail parts in large assemblies 

may have an adverse effect on performance.

Master It  You want to create a lower-level-of-detail part fi le for common parts to be 

reused many times over in your large assemblies but are concerned about managing two 

versions of a part. How do you avoid versioning problems? 





Chapter 10

Weldment Design

For this chapter, you must have a good understanding of parts, assemblies, and drawings. You 

will explore the various aspects of weldment design. Starting from weldment workfl ows and 

design methodologies, you’ll look at preparations, weld beads, machining features, and weld 

symbols, as well as how to document the weldment design. You will also learn some tips and 

tricks along the way.

Weldments are available in the assembly environment as a subtype of the assembly docu-

ment. Most of the topics in this chapter involve working with assembly fi les. Therefore, this 

chapter is not applicable if you have only the Autodesk® Inventor LT™ program installed.

In this chapter, you’ll learn to:

 ◆ Select and use the right weldment design methodology

 ◆ Create and edit weld preparations and machining features

 ◆ Create and edit different kinds of weld beads, such as cosmetic, fi llet, and groove

 ◆ Document weldment stages in drawings

 ◆ Generate and maintain a consistent BOM across welded assemblies, drawings, and 

presentations

Exploring Weldment Design Methodologies
One of the basic questions in weldment design is what design methodology should be used to 

create weldments. Unfortunately, there is no “one-size-fi ts-all” strategy. The design methodol-

ogy you use depends on your individual needs and requirements. You will start by defi ning the 

different design methodologies:

As-assembled  A view of the assembly with no weld preparations, beads, or machining 

features.

As-welded  A view of the assembly with weld preparations and weld beads but no machin-

ing features.

As-machined  A view of the fi nal welded assembly with the machining features created 

after the welding had been done. This view includes features that might penetrate or cut 

through weld beads.

All these represent the various stages in weldment design. Once the weldment design is 

done, it helps to document the various stages of weldment design in the drawing.
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Depending on the need for documentation, interference analysis, mass properties, and other 

design criteria, you can group the weldment design methodologies into the following four broad 

categories, which are defi ned in more detail in this section:

 ◆ Part fi les and part features

 ◆ Weldment assembly and derived technology

 ◆ Weldment assembly

 ◆ Multi-body part fi les

Part Files and Part Features
You can create a weldment design using part features in part fi les. With this approach, you use 

the rich modeling features of the part (sweeps, chamfers, fi llets, and lofts) to create a wide variety 

of weld bead shapes. However, this will be one big mess of a design that has no logical partitions. 

The main diffi culty is creating drawings with different stages — for example, as-assembled, as-

welded, and so on — from a single design. You will not be able to see certain edges separating 

weld beads and components in drawings because they will not even exist (they will be merged 

out) in the part design. In addition, the bill of materials (BOM) will not list all the individual 

components needed to assemble the welded structures. Still, this might be an acceptable strategy 

for small weldment designs that have minor design changes over a period of time. Besides, the 

assumption is that the designer does not need to create the different stages in design documenta-

tion from a single weldment assembly. You could place the part weldment into an assembly and 

then create presentations and drawings of that assembly. (However, in drawings, you will not be 

able to create the different stages of weldment design.) Figure 10.1 shows this methodology.

Figure 10.1

Part fi les and part 

features Parts,
Welds

Drawings
As-welded

Weldment Assembly and Derived Technology
With this approach, you can derive the weldment assembly (.iam) into a single-part fi le (.ipt) 

and model the welds in the derived assembly fi le using part features. Optionally, you can derive 
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the part fi le into another part fi le to show machining on welded assemblies. Disadvantages 

similar to the ones mentioned in the fi rst method exist; however, you can modify assembly con-

straints to create variants of weldment assemblies with this approach. The preparations, welds, 

and machining features will all exist in the derived component fi les. This might be a good strat-

egy for weldments where a BOM listing is required and there is no need to document different 

stages of weldment design from a single weldment assembly. Figure 10.2 shows the document 

layout of this methodology.

Figure 10.2
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Weldment Assembly
With this approach, you use a mixture of cosmetic, fi llet, and groove welds with preparations, 

machining features, and weld symbols at the assembly level. The main advantage is that the 

weldment can be documented as-assembled, as-welded, and so on. The BOM outlines the dif-

ferent part components. It does not preclude fi nite element analysis (FEA), since the weldment 

assembly can be derived into a part. You might fi nd this approach diffi cult initially, but you can 

see large gains in productivity later while documenting the weldment. This is the recommended 

approach for large weldments that need mass properties, interference analysis, and complete 

documentation. (Examples are structural frames, piping, industrial gates, fences, and steel fur-

niture.) You can use a combined approach of all four methods if that’s what works best for your 

needs. However, when new enhancements are made to weldments, this approach lends itself 

to easily leverage the new functionality. Figure 10.3 shows the document layout of this design 

methodology. (The fi gure doesn’t show the various subassemblies that the weldment assembly 

might contain by breaking it into logical pieces.) Good planning helps in generating a well-built 

design that can be understood and easily maintained by designers. All in all, you should use 

this design methodology if you cannot decide on one of the other three methods.
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Figure 10.3
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Multi-Body Part Files
Since a completed weldment exists in a larger assembly as a single component, an interesting 

way of defi ning the weldment can be by using multi-body parts. To use this approach, you cre-

ate separate bodies within the single part fi le by using the New Solid option in the Extrude, 

Revolve, and other sketched feature dialogs. This creates a virtual assembly made up of multiple 

features in a single fi le. Once the component is defi ned, it can be divided into an assembly using 

the Make Components tool as described in Chapter 5, “Advanced Modeling Techniques.” From 

that point on you can treat your weldment assembly as though you created it from separate part 

fi les from the beginning, with one notable exception: You can then update the assembly and the 

weldment by editing the multi-body part you created initially. Figure 10.4 shows the layout of 

the multi-body method.

Figure 10.4
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You can create a weldment assembly in two ways. For the fi rst method, you create a new 

weldment assembly by selecting any of the weldment templates provided by the Autodesk® 

Inventor® software. To do this, just select the Get Started tab, click the New button, and then 

select an assembly template designated as a weldment template. Or you can convert an exist-

ing assembly document into a weldment assembly by selecting the Assemble tab and clicking 

Convert To Weldment.

Once you convert an assembly into a weldment, it is not possible to convert it back into a reg-

ular assembly. Also note that in a weldment document, you cannot create new positional repre-

sentations or use fl exible assembly functionality, because a weldment is meant to be an assembly 

of parts fi xed in place. Once you’ve created a weldment assembly, you can go to the next logical 

step of modeling preparations.

Communication Is the Key to Dealing with Weldments

Depending on your needs, weldments can be as simple as a single part or as complex as assembly 

weldments with preparations, welds, and machining. Talk to the group that is going to be manufac-

turing your parts (whether the job is farmed out or in-house), and fi nd out what level of detail the 

group requires when making the parts to your prints. Often, you will fi nd that what is important to 

the designer is not as important to the welder (and vice versa). By speaking with these groups, you’ll 

get a better understanding of what path you should take for your weldment models and drawings.

Modeling Preparations
Imagine that you’ve created the weldment assembly for a boxed container and want to add weld 

beads. Before adding the weld beads, the assembly needs weld preparations to create space for 

the weld bead to be placed. You can model a variety of preparation features to mill or remove 

material. Note that preparations are assembly features only, meaning that these features exist 

only in the assembly and not at the part level. Here are the most common preparation features:

 ◆ Extrude

 ◆ Revolve

 ◆ Hole

 ◆ Sweep

 ◆ Chamfer

 ◆ Move Face

Figure 10.5 shows the preparation environment and the relevant tools. To create the fea-

tures in the previous list, you use the same set of steps that you used in part (Chapter 4, “Basic 

Modeling Techniques”) or assembly modeling (Chapter 8, “Assembly Design Workfl ows”). The 

Move Face functionality is primarily intended for weld preparation in the assembly environ-

ment, and is available in both the part and assembly environments.
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Figure 10.5

Weldment features

Groove welds are classifi ed by the different kinds of weld preparations. Figure 10.6 shows 

some commonly used weld preparations. In the left column, from top to bottom, you can see the 

Square Groove, Bevel Groove, and U-Groove types. In the right column, from top to bottom, you 

can see the Double Bevel Groove, V-Groove, and Double-U Groove types. Observe that these 

preparations might be referred to by slightly different names in the welding industry. Although 

most groove welds require nothing more than a simple chamfer, in most cases groove welds 

require some sort of material-removal preparation.

Figure 10.6

Types of weld 

preparations Square Groove

Bevel Groove

U-Groove

Double Bevel Groove

V-Groove

Double-U

The alternative to weld preparation is to build the shape of the preparation using the sketch 

and then a swept volume (Extrude, Revolve, and Sweep) cut using that sketch to create the 

feature shape in the part fi le. However, it is recommended that you use the weld preparation 

feature, which helps show the manufacturing process. In addition, it aids in documenting the 

weldment in a drawing with just the components and preparations. Another advantage is that 

the designer, weld fabricator, or manufacturing instruction–generating program can easily fi nd 

these features in one place — in other words, in the Preparations folder. This might be useful 

for generating the desired manufacturing information.
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To create a preparation feature, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Open the fi le mi_10a_045.iam from the Chapter 10 directory of your Mastering 

Inventor 2014 folder. 

If you have not already downloaded the Chapter 10 fi les from www.sybex.com/go/

MasteringInventor2014, please refer to the “What You Will Need” section of the 

Introduction section at the beginning of this book, for the download and setup instructions.

 3. You have three choices for this step: double-click the Preparations folder in the Model 

browser to activate the weld bead features, right-click the Preparations folder and select 

Edit, or click the Preparation button on the Process panel of the Weld tab.

 4. Click the Chamfer button on the Preparation And Machining panel, and select the bot-

tom edge of the yellow face.

 5. Set the chamfer size to 7 mm, and click OK.

 6. Exit the preparation environment either by clicking the Return button or by right-clicking 

and choosing Finish Edit.

You can double-click the Preparations folder and edit the individual preparation features as 

needed. Think of the Preparations folder as a separate environment with its own set of tools. 

The End Of Features (EOF) node in the browser works differently than the End-Of-Part (EOP) 

node in the part modeling browser. In the part modeling browser, when the EOP node is moved 

around, it sticks at that location even after an update. In the preparation environment, the EOF 

node can be moved to above or below any feature location in the Preparations folder, just as in 

part modeling.

However, when you leave the preparation environment — either by double-clicking the top-

level assembly node in the weldment assembly or by right-clicking and selecting Finish Edit 

in the graphics window — the EOF node is rolled all the way to the end in the Preparations 

folder. It might be thought of as a browser node that does not stick in its dragged browser loca-

tion, unlike parts. The EOF node has similar behavior whether you are in the preparation, 

welds, or machining environment.

Once you’ve placed the weld preparations, you are ready to place welds. Keep in mind that 

you do not have to create preparations. Also, you can return to the preparation environment 

even after having placed welds.

Exploring Cosmetic Welds
To create or edit a weld feature, click the Welds button on the Process panel, or right-click 

the Welds folder in the Model browser and select Edit. You can also double-click the Welds 

folder and edit the individual features. Figure 10.7 shows the available features in the welds 

environment.

The Cosmetic Weld feature is available by clicking the Cosmetic button in the Weld panel. 

Figure 10.8 shows the Cosmetic Weld dialog box. When using the Cosmetic Weld feature, 
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you simply select edges of the model. These edges can belong to part components or other 

weld beads.

Figure 10.7

Weld features panel

Figure 10.8

Cosmetic Weld 

dialog box
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Cosmetic welds are recommended for use when you have the following conditions:

 ◆ A need for lightweight representation.

 ◆ No requirement for interference analysis.

 ◆ No need for the estimated total mass of the assembly with solid weld beads. However, you 

could optionally have the cosmetic weld participate in mass property calculations.

Note that the bead (which you defi ne in the upper portion of the weld dialog boxes) and the 

weld symbol (defi ned in the lower portion of the weld dialog boxes) are decoupled; in other words, 

optionally you can create a weld symbol. This applies to all types of weld beads. In addition, 

you can use a single weld symbol to denote multiple welds involving cosmetic, fi llet, and groove 

welds. Cosmetic welds can represent a wide variety of welds. You can create them using edges 

(the Edge option), tangent continuous sets of edges (the Chain option), or loops (the Loop option).

Selecting the option of applying a weld symbol will place a symbol on the screen without 

being prompted for its placement. You can move the symbol after the weld has been added.

Create a Simple Cosmetic Weld
In this exercise you’ll create a basic cosmetic weld and a weld symbol by selecting models edges 

and entering the specifi cation of the desired weld:

 1. On the Get Started tab, click the Open button.

 2. Browse for the fi le mi_10a_001.iam located in the Chapter 10 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

 3. You have three options for this step:

 ◆ Double-click the Welds folder in the Model browser to activate the weld bead features.

 ◆ Right-click the Welds folder and select Edit.

 ◆ Click the Welds button in the Process panel of the Weld tab.

 4. Once the weld environment is set active by using one of the three methods listed, click 

the Cosmetic button on the Weld panel.

 5. In the Cosmetic Weld dialog box, select the Create Welding Symbol check box (if it is not 

already selected).

 6. Select the Chain option, and select the edges as shown in Figure 10.9. The Chain option 

is similar to the Automatic Edge Chain option in the Fillet dialog box in part modeling. 

It collects all the tangent continuous edges in a loop on a single face. Note that you may 

need to use the Select Other tool to toggle through the available loops.

 7. Enter 6 mm for both legs in the weld symbol, as shown in Figure 10.8.

 8. In the Area input box, enter 18 mm ^2 for the bead cross section based on the leg lengths.

The bead cross section can be calculated using the following equation:

Bead cross section = (1/2 × Leg Length 1 × Length 2)

 9. Click the OK button to create the weld and close the dialog box.
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Figure 10.9

Creating a cosmetic 

weld

The bead cross section area value is critical in determining the mass of cosmetic welds. Later, 

in the section “Understanding Bead Property Report and Mass Properties,” you’ll see how to 

use this for mass-properties calculations. For now, though, you can close this fi le without saving 

changes and continue on to explore more options for the cosmetic weld.

Using Split Faces to Place Cosmetic Welds
In certain cases when there is no edge to click as input, you can split the faces of the components 

in the part fi le (.ipt) at the location where it is welded and use the split edges as input to the 

cosmetic weld feature. On the left of Figure 10.10, for example, there are no explicit edges to click 

at the intersection of the planar face on the hollow tube and the cylindrical face on the cylinder. 

Therefore, you could edit the cylindrical part and create a work plane that is offset from the end 

of the cylinder, and then use the Split tool to split the cylindrical face of the cylindrical part with 

the work plane, so that you can use those split edges to create the cosmetic weld feature. The cen-

ter of Figure 10.10 shows the split edge. Work points cannot be clicked as part of the cosmetic weld 

feature. The edges need to have fi nite length in order to be clickable for the cosmetic weld feature.

Figure 10.10

Cosmetic welds 

using split edges

Place Cosmetic Welds with Extents
You can specify extents with parallel planes or planar faces. The extent trims the cosmetic weld 

bead between the From and To termination planes or planar faces. To generate the From-To cos-

metic weld in Figure 10.11, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Open the fi le mi_10a_002.iam from the Chapter 10 directory of your Mastering 

Inventor 2014 folder.
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 3. You have three options for this step:

 ◆ Double-click the Welds folder in the Model browser to activate the weld bead features.

 ◆ Right-click the Welds folder and select Edit.

 ◆ Click the Welds button in the Process panel of the Weld tab.

 4. Click the Cosmetic weld tool on the Weld panel. Select the edge shown in Figure 10.11.

 5. In the Extents drop-down menu in the Cosmetic Weld dialog box, select From-To.

 6. Click the From button, and select one of the assembly work planes.

 7. Click the To button, and select the other assembly work plane.

 8. Click OK in the Cosmetic Weld dialog box to create the weld and see the result.

Figure 10.11

Cosmetic welds 

with extents

Creating Weld Beads
A weld bead feature is a parametric, solid representation of the real-world weld bead. It can be 

generated from input faces of a single component or from input faces of multiple components, 

including the faces of existing weld beads in the weldment assembly. You can also create a weld 

on a single part that is placed in a weldment assembly. Here are some examples:

Example 1  Place a single sheet-metal part in a weldment assembly, and create fi llet welds at 

fl ange corners to create a container.

Example 2  Create a fi llet or groove weld between two plates (two parts or one part that has 

two extrusion features for the plates).

Example 3  Create a fi llet or groove weld between two plates and another weld bead.

Weld beads automatically contribute to mass property calculations, and can take part in 

interference analyses. All weld bead features create an independent body that does not take part 

in Boolean operations with the assembly components. Other machining features can cut into 

weld beads. There are two major weld features to create physical 3D welds:

Fillet Weld Feature  A fi llet weld builds up corners by adding weld material between faces. 

Fillet welds are the most commonly used type of weld in industrial machinery. You should 

use this feature when there is no gap between the components. A specialized kind of fi llet 

weld with a gap is supported.
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Groove Weld Feature  A groove weld feature predominantly fi lls gaps between compo-

nents. However, you can also use it when the components are touching each other. There are 

many opportunities to combine fi llet and groove welds to generate the desired weld beads.

Weld Calculators

Th e weldment environment also has several weld calculators (only if the design accelerator add-in 

is loaded). Weld calculators assist you in the design of weld joints. You can check typical welds with 

diff erent types of loading. You can use these calculators to check static weld loading and to check 

butt and fi llet weld joints for both static and fatigue loading.

Creating Fillet Welds
The basic idea behind a fi llet weld is that you are joining two sets of faces. You can control the 

weld bead defi nition parametrically by using the parameters shown in Figure 10.12. This is 

known as leg-length measurement. You can enter the two leg lengths used to generate the bead 

and also specify the throat measurement. Throat measurement is the distance from the root of 

the fi llet weld to the center of its face. You just enter the throat length, and Inventor calculates 

the rest of the size of the weld bead. The offset value has relevance only when you declare 

the weld to be concave or convex. Figure 10.12 shows the two leg lengths and the two types of 

measurement.

The top shape of a fi llet weld can be fl at, convex, or concave, as shown in Figure 10.13 

(from left to right). For fl at, the offset is 0.0. For concave or convex based on the offset, Inventor 

calculates the necessary bump or depression shape.
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Figure 10.12

Fillet weld 

defi nition

Offset

Leg Length

Throat
Measurement

Leg 2

Leg 1

Figure 10.13

Flat, convex, and 

concave shapes for 

fi llet welds

Modeling a Fillet Weld
Fillet welds are likely the most common weld type you will use in your weldment designs. To 

create a simple fi llet weld, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Open the fi le mi_10a_003.iam from the Chapter 10 directory of your Mastering 

Inventor 2014 folder.

 3. You have three choices here: double-click the Welds folder in the Model browser to 

activate the weld bead features, right-click the Welds folder and select Edit, or click the 

Welds button in the Process panel of the Weld tab.

 4. Click the Fillet weld tool on the Weld panel. You will see the dialog box shown in 

Figure 10.14.

 5. Enter the leg length value for the Leg1 in the input box as 15 mm. Leg2 is assumed to be 

same as Leg1 if the input box is left blank.

 6. Ensure that the fi rst Select Faces button (the red arrow) is selected, and then click the 

yellow face.

 7. Click the second Select Faces button (or right-click and select Continue), and then click 

the red face. Note the lightweight weld bead preview, as shown in Figure 10.15.
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Figure 10.14

Fillet Weld dialog 

box with start and 

end off sets

Figure 10.15

Fillet weld preview 

and fi llet weld

 8. In the Extents area of the dialog, enter 5 mm in the Start Offset box.

 9. Click the Direction button on the left of the dialog box to change the start position of the 

weld bead.

 10. Enter 15 mm in the End Offset box, and click OK.

 11. Locate the Welds folder in the Model browser, and expand it to fi nd the Beads folder.

 12. Expand the Beads folder, right-click the weld bead found within, and then click Edit 

Feature.

 13. In the Extents area of the Fillet Weld dialog box, click the top drop-down list, and change 

the extents solution from All to Start-Length.

 14. Notice that Start Offset remains the same but End Offset is replaced with a length input. 

You can use this option to specify a known weld length when required.

 15. Set the length to 50 mm, and click OK.
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This exercise has illustrated a basic fi llet weld and some of the extents options available. You 

can close this fi le without saving changes and continue reading about other options for placing 

fi llet welds.

Fillet Welds and Gaps
You can place a fi llet weld between two parts even if they do not contact, using the fi llet weld 

to bridge the gap. If the goal is to fi ll the gap, you would likely use a groove weld. Figure 10.16 

shows a hole gap through which a cylinder is passing. You can use a fi llet weld to bridge the 

gap, but it will not fi ll the gap. The fi llet weld will work even if the two components are sepa-

rated by a gap at some places and touch at other places.

Figure 10.16

Shaft through plate

To create these fi llet welds, you still click the two faces, as shown in Figure 10.16. Inventor 

infers the gap and generates the fi llet weld bead. To fi ll the gap between the two mating faces of 

components, you should use groove welds.

Figure 10.17 shows another variant of two components that are separated by a gap. Here, the 

solution is dependent on the size of the weld and the amount of face available. On the left, a 10 mm 

weld comes up short on the corners. On the right, an 18 mm weld runs past the fl at edges of the 

tube and therefore will not build as selected. The weld adjusts to fi t as required. If the weld size is 

too small to bridge the gap at all or is too large for the selected face, the weld will not be built.

Figure 10.17

Shaft through 

hollow tube

Figure 10.18 shows a simple gap being bridged with two fi llet welds.
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Figure 10.18

Fillet welds across 

a gap

Don’t Forget to Speak with Those Manufacturing the Parts

Inventor provides just about every possible option that you could want as a designer with regard to 

weld sizes, shapes, and contours. However, you should always speak with those who will be manu-

facturing the parts to determine whether what you have designed can be built effi  ciently. It would 

be unfortunate to spend a lot of time with specifi c contours, sizes, and fi nishes if the weld shop 

is just going to give you a standard fi llet weld regardless of the details you call out. You’ll need to 

decide whether it’s time to fi nd a new welder or whether you are putting too much information into 

the part. More than one designer has found this out the hard way when that $10 bracket suddenly 

ends up costing $100 because of the demanding weld callouts placed on the print.

Creating Intermittent Fillet Welds
Intermittent fi llet welds essentially produce patterns of the weld bead along a set of edges. 

Figure 10.19 shows an example of an intermittent fi llet weld using the Start-Length extents 

solution to adjust the orientation to avoid interference with the existing holes.

Figure 10.19

Intermittent ISO 

fi llet weld
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There are three ways that intermittent welds can be specifi ed, depending on which standard 

you are using. To change the standard, select the Tools tab and click the Document Settings 

button. From there you will see the Default Standard setting on the Standard tab. Here is a list 

describing the differences, as shown in Figure 10.20:

ANSI Standard  Specify bead length and the distance between bead centers.

ISO, BSI, DIN, and GB Standards  Specify the bead length, the spacing between beads, 

and the number of beads.

JIS Standard  Specify the bead length, the distance between bead centers, and the number 

of beads.

Figure 10.20

Intermittent fi llet 

weld parameters

ANSI ISO/BSI/DIN/GB JIS

The Extents control allows you to select the beginning and ending planar faces or planes 

between which the weld bead will be created. The steps to produce a From-To fi llet weld bead 

are similar to the steps outlined for extents and cosmetic welds earlier in this chapter. When 

you’re welding a long piece of metal, often intermittent welds are cost effective and reduce 

warping in the part.

Creating Groove Welds
A groove weld is primarily used to fi ll gaps between two sets of faces. Once such gaps are fi lled, 

you might top the groove weld with a fi llet weld. Figure 10.21 shows some examples.

Figure 10.21

Groove weld 

examples

Like a fi llet weld, a groove weld needs two sets of facesets. The Full Face Weld option, when 

selected, tells Inventor to use the full face to generate the weld. When this option is not selected, 

only a portion of the face will be used to generate the weld. Inventor calculates the specifi c 
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portion of the face by projecting the smaller faceset to the larger faceset (if the two facesets are 

the same size, Inventor picks one of them to project). Figure 10.22 shows the resulting weld 

beads with Full Face Weld off (left) and on (right).

Figure 10.22

Full Face Weld 

option

The Ignore Internal Loops option controls whether to ignore or consider the internal loop to 

generate the weld bead. When selected, it results in a “solid” weld bead (Figure 10.23, left); when 

it’s not selected, the result is a “hollow” grove weld (Figure 10.23, right).

Figure 10.23

Ignore Internal 

Loops option

The fi ll direction is used to project one set of faces to another to generate the groove weld 

bead. In Figure 10.24, you can see the difference between the resulting weld bead shapes.

Figure 10.24

Fill direction

Be aware that the Fill Direction option is not available when you use the Full Face Weld 

option for both faceset 1 and faceset 2 or when using the Radial Fill option. When you are using 
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the Fill Direction option, you might observe that Inventor can create welds that are not manufac-

turable, depending on the direction you choose.

You can select the following for the fi ll direction:

 ◆ Planar faces and work planes (specifi es the direction normal to chosen face/plane)

 ◆ Cylindrical, conical, or toroidal faces (specifi es the direction of the surface’s axis)

 ◆ Work axes

 ◆ Linear part edges

One question that comes up frequently is, What direction should be selected for the fi ll? 

One guideline you can use is to imagine the average geometric center of faceset 1 and the 

average geometric center of faceset 2. The line connecting the two geometric centers will be 

the fi ll direction to generate the groove weld bead. You are not required to calculate the geo-

metric centers of the facesets. It is advisable to try different fi ll directions to get the desired 

weld bead shape.

You can use the Radial Fill option to project the weld bead around a curve. When you’re 

using the Radial Fill option, the Fill Direction option is not available. Figure 10.25 shows a 

radial-fi lled groove weld.

Figure 10.25

Th e Radial Fill 

option

To create a simple groove weld, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Open the fi le mi_10a_004.iam from the Chapter 10 directory of your Mastering 

Inventor 2014 folder.

 3. You have three options for this step: double-click the Welds folder in the Model browser 

to activate the weld bead features, right-click the Welds folder and select Edit, or click the 

Welds button in the Process panel of the Weld tab.

 4. Click the Groove weld tool on the Weld panel.

 5. Select the yellow face for faceset 1 and the red face for faceset 2. Note that you may need 

to rotate the view to see the red face.

 6. Click the Fill Direction button, and click the visible work axis or any edge or face that 

establishes the direction to be the same as the work axis.
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 7. Select the Full Face Weld option for faceset 1 to extend the weld to cover the entire yellow 

face. Note that selecting Full Face Weld for faceset 2 does not change the weld since the 

weld bead already covers the entire face.

 8. Click OK; your result should resemble Figure 10.26.

Figure 10.26

Groove weld results

As a general rule, if the preview comes up, it is almost certain that the bead will succeed.

Performing Machining Operations
Once you’ve created the preparations and welds, you can create machine features. The features 

available for machining are similar to the features in the preparation environment. In terms of 

operations, they are performed after the generation of weld beads. One of the main advantages 

of providing the machining operations in a separate environment is that in drawings, you can 

document them in the as-machined state. Holes and extrude cuts are typical post-weld machin-

ing features.

Figure 10.27 shows a welded assembly with machining operations performed on it.

Figure 10.27

Machining features 

on a weldment 

assembly

To create the machining features, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Open the fi le mi_10a_005.iam from the Chapter 10 directory of your Mastering 

Inventor 2014 folder.

 3. Double-click the Machining folder in the Model browser to activate it for editing, right-

click the Machining folder and select Edit, or click the Machining button in the Process 

panel of the Weld tab.
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 4. From the Weld tab, click the 2D Sketch button to create a new sketch.

 5. Choose the yellow face to place the sketch, and place two hole centers corresponding to 

the two holes shown in Figure 10.27.

 6. Right-click and choose Finish Sketch, and select the Hole feature from the Preparation 

And Machining panel.

 7. Set the hole size to 10 mm and the termination to Through All, and click OK.

 8. Right-click and choose Finish Edit (or double-click the top-level assembly in the browser) 

to exit the machining environment.

Holes that are important to the location of welds should be placed into the parts that are 

being welded together. Because the machined view of the weldment is a subset of the welded 

view, you cannot refer to “machined” holes when detailing an as-welded model.

Machining features include, but are not limited to, the following:

 ◆ Extrude

 ◆ Revolve

 ◆ Hole

 ◆ Sweep

 ◆ Chamfer

 ◆ Move Face

Exploring Weld Properties and Combinations
The following sections cover the additional aspects of weldments: setting weld properties, 

replicating welds, combining fi llet and groove weld beads to produce the desired weld bead 

shape, and using the split technique.

Weld Properties
To turn off the visibility of all weld beads in an open assembly, select the View tab, and select 

Object Visibility ➢ Welds. You can also expand the Welds folder in the Model browser, right-

click the Beads folder, and then deselect Visibility to turn off the weld beads of a particular 

assembly or subassembly. You can suppress individual weld bead features in the Model 

browser; the suppress feature is similar to part feature suppression.

You can choose the weld material during the initial conversion of an assembly to a weldment 

or change it after the fact. Welded Aluminium-6061 is the default material as shown in the Weld 

Bead Material drop-down list in the Convert To Weldment dialog box, in Figure 10.28. To change 

it after fact, you can right-click the Welds node in the browser and choose iProperties. Then 

select the Weld Bead tab of the iProperties dialog box.

In existing weldments, you can change the weld color styles using the weld properties. In 

the Model browser, right-click the Welds node, select iProperties, select the Weld Bead tab, and 

choose the weld bead color style or the end fi ll color style. You can use the weld bead color style 
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to assign different color styles to the weld bead. Similarly, the end caps (faces) that you selected 

in the weldment assembly can be assigned an end fi ll color style.

Figure 10.28

Specifying a custom 

weld bead material 

in the Convert 

To Weldment 

dialog box

Replication
Welds (cosmetic, fi llet, and groove beads) can be copied or mirrored in assemblies through the 

Copy Components and Mirror Components tools. Both sets of components that support the 

weld need to be copied or mirrored for the welds to be copied or mirrored. For example, if a 

cosmetic weld exists only on component Plate1 and if Plate1 is copied or mirrored, the cosmetic 

weld is also copied or mirrored. You cannot copy or mirror the weld without its components 

being copied or mirrored. Weld beads can be derived from the assembly into another part docu-

ment using the Derived Component tool in parts.

Groove and Fillet Weld Combinations
Most welds can be generated using a combination of groove and fi llet welds. Figure 10.29 shows 

an example of welding two hollow tubes with a groove weld. The horizontal tube is welded 

with a vertical tube. Faceset 1 comprises the two fi llet faces on the horizontal member, and 

Faceset 2 is made up of the single mating face on the bottom of the vertical member. The fi ll 

direction is established by selecting a vertical edge or a horizontal face.

Figure 10.29

Generating the 

groove weld bead
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In Figure 10.30, a fi llet weld is applied. Faceset 1 is composed of three faces, the top 

horizontal face and the two corresponding fi llet faces, as indicated by the light arrows. 

Faceset 2 is composed of the three corresponding component faces on the vertical tube, as 

shown by the dark arrows in Figure 10.30. A second fi llet weld would then be generated in the 

same way on the other side.

Figure 10.30

Generating the fi l-

let weld bead

Split Technique
Since welds work on input faces (the two facesets that you select to do the weld), it is sometimes 

required and at other times desirable to split the input faces in order to have the weld bead only 

on a certain portion of the face or to have better control of the resulting weld. Essentially, you 

are helping Inventor use the partial face that is generated from the split.

In certain situations, using fi llet welds that involve multiple possibilities might make it dif-

fi cult to control the placement of welds. One instance of this is when controlling the offset of 

welds around a cylindrical face. Figure 10.31 shows the difference between using a cylinder with 

a split face and one without. If the cylindrical face is split, you can place the weld in two parts 

and control the start and end offsets so that holes are given proper clearance. If the face is not 

split, Inventor automatically breaks the weld where it encounters the holes, but you can adjust 

the offsets for the fi rst hole only.

Figure 10.31

Using a split to 

create multiple 

fi llet welds

Without split face

With split face
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In the following steps you will use the Split tool to control the start and stop positions of the 

weld bead:

 1. On the Get Started tab, click the Open button.

 2. Open the fi le mi_10a_006.iam from the Chapter 10 directory of your Mastering 

Inventor 2014 folder.

Take a look at the existing fi llet weld around the blue cylinder. Notice that the offset on the 

one hole is not adequate. You will create a similar weld on the yellow cylinder but use the 

Split tool to ensure that you have full control of the offsets.

 3. Locate the part called mi_10a_014 in the Model browser, and double-click it to set it 

active for edits (or right-click and choose Edit).

 4. Click the Split button on the Modify panel of the 3D Model tab.

 5. Select WorkPlane1 from the Model browser for the Split tool.

 6. Select the cylindrical face for the Faces selection.

 7. Click OK. Note that the cylindrical face is now split into two halves. Figure 10.32 shows 

the Split selections.

Figure 10.32

Creating a split face 

in the part

 8. Return to the weldment assembly by right-clicking in the graphics screen and choosing 

Finish Edit.

 9. You have three options for this step: double-click the Welds folder in the Model browser 

to activate the weld bead features, right-click the Welds folder and select Edit, or click the 

Welds button in the Process panel of the Weld tab.

 10. Click the Fillet weld button to bring up the input dialog.

 11. Click one of the cylindrical halves for faceset 1.

 12. Click the top (red) face of the mating plate for faceset 2.

 13. Enter 10 mm for the size.

 14. Enter 4 mm in the Start Offset and Stop Offset boxes, as shown in Figure 10.33.

 15. Click Apply, repeat steps 11 through 14 to create the other half of the weld, and click OK.
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Figure 10.33

Creating a fi llet 

weld with start and 

end off sets

 16. Right-click and choose Finish Edit (or double-click the top-level assembly in the browser) 

to exit the weld environment.

 17. Compare the welds you created to the existing weld.

If you do not want to see the split edges in the weldment drawing, you can turn those edges 

off individually by right-clicking them in the drawing view and deselecting Visibility, as shown 

in Figure 10.34.

Figure 10.34

Turning off  split 

edges in a drawing

Using the Weld Symbol
You can create a weld symbol in assemblies by clicking the Welds folder and using the Weld 

Symbol tool. In drawings, you can fi nd this tool in the Annotate tab. You have to make a deci-

sion to create them in the right place (assemblies or assemblies and drawings) based on your 

communication with the welding department and other departments that are involved in 

producing the weldment. The weld symbol, which is optional in the assembly environment, has 

certain key characteristics:

 ◆ It cannot be created without a weld bead consuming it.

 ◆ The primary bead is the weld bead to which the welding symbol is attached.

 ◆ You’re allowed to activate the weld symbol grips and reattach the weld symbol to any other 

visible bead edge from that symbol’s group.

 ◆ Multiple weld beads (including cosmetic weld beads) can be grouped under a single weld 

symbol.
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 ◆ The weld symbols are listed in a separate folder below the Weld Beads folder.

 ◆ A bead can be consumed by only one welding symbol object at any given time.

 ◆ A linked bead that is moved out of its welding symbol group causes the parent welding 

symbol to become unassociated.

 ◆ Cross-highlighting is supported for both the bead objects and the welding symbol object. 

If you select a welding symbol node in the Model browser, the welding symbol and all the 

beads consumed by that welding symbol will be cross-highlighted in the graphics win-

dow. Alternatively, if you select a bead node from either the welding symbols portion of the 

browser or the Beads folder portion of the browser, the bead will be cross-highlighted in 

the graphics window.

 ◆ A new welding symbol can be created for an already created weld feature.

 ◆ Welding symbols have visibility control.

 ◆ If a weld symbol references a weld feature, then it is consumed. Otherwise, the bead is 

unconsumed by any weld symbols. Therefore, three browser fi ltering options are avail-

able from the Beads folder context menu: Show All, Show Consumed Only, and Show 

Unconsumed Only.

Figure 10.35 shows a single weld symbol for the multiple weld beads.

Figure 10.35

Single weld symbol 

for multiple welds

To add multiple weld beads to the same existing symbol, follow these steps:

 1. Right-click the desired weld symbol.

 2. Choose Edit Welding Symbol.

 3. Add weld beads by selecting them in either the model window or the Model browser.

Only unconsumed weld beads should appear highlighted in the model window. Right-clicking 

the browser or model window lets you select weld beads and quickly see which weld beads have 

been unconsumed. To disassociate a weld bead from its corresponding symbol, right-click the 

bead in the Model browser, and choose the Unconsumed Bead tool from the context menu.

Understanding Bead Property Report and Mass 
Properties
To estimate accurate weld rod usage, fabrication time, and bead weights, the weld property 

reporting tool is available in assemblies. This can be used to help estimate costs. This tool allows 
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you to query the mass, volume, length, type, and name of individual beads in the assembly. 

Through an option (available after you select Bead Report from the Weld panel of the Weld tab), 

you can retrieve this data for the current assembly and all of its child weldment assemblies. This 

information will be exported to a standard Microsoft Excel spreadsheet, as shown in Figure 

10.36. In the weldment workfl ow, you can generate a weld bead report for the core packaging 

unit that contains the three subassemblies.

Figure 10.36

Weld bead 

property reporting 

in assemblies

To calculate the total length of weld beads, you can sum up the total length using the Excel 

Sum functions. Length and area values are not reported for groove welds. The default “save to” 

location is the parent assembly’s directory, but you can change this location. Weld properties 

are, at best, estimates. Many factors can change the weight of a weld bead. If the weight of a part 

is critical, consider machining the part to meet the criteria after welding.

The cross section entered in the Cosmetic Weld dialog box is multiplied by the length of the 

cosmetic weld bead and is optionally considered in the mass properties to calculate volume. 

When the Include Cosmetic Welds option is checked in the Physical tab of the iProperties dialog 

box, this volume is included in the calculations. The mass is determined by the selected weld 

material. This option is useful where you need only lightweight representation but at the same 

time need the welds to participate in mass properties.

Creating Drawing Documentation
The Welding Symbol dialog box, being the same in assemblies and drawings, is specifi c to the 

engineering standard you’re using. Figure 10.37 shows an example of the Welding Symbol (ISO) 

dialog box in drawings, and when you hover your mouse pointer over each input control, a tool 

tip will show its title. Table 10.1 describes what the various controls do.

Figure 10.37

Welding Symbol 

dialog box in an 

ISO drawing; see 

the defi nitions of 

the controls in 

Table 10.1.
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Table 10.1: Welding Symbol dialog box controls

C ontrol* Definition

1 Select this option to have the identifi cation line above or below the symbol or to omit it.

2 Toggle this to switch the values and options from above the reference line to below the 

reference line and vice versa.

3 Select this option for fi llet weld symbols when they are set on both sides of the reference 

line. Th is option includes the following settings:

No Stagger

Weld Stagger – Move (ANSI)

Weld Stagger – Move (ISO)

Weld Stagger – Mirror

4 Enter a prefi x for the symbol, such as depth of bevel, size, and strength, depending on the 

weld.

5 Select this option to specify text to be associated to the welding symbol, such as specifi ca-

tion, process, or reference text. Th e Enclose Text option will enclose the note in a box at the 

tail of the symbol.

6 Use these controls to specify multiple welding symbols attached to a single leader:

Add: Adds a symbol to the current symbol

Delete: Removes the current symbol

Previous: Cycles to the last symbol

Next: Cycles to the next symbol

7 Enter the leg lengths for fi llet weld. Other weld types may specify size, depth diameter, and 

so on in this area, depending on the type of weld.

8 Th e Symbol drop-down menu lets you select diff erent types of welds, such as V-Groove 

Weld, Flare-Bevel Weld, Seam Weld, Spot Weld, and so on. If you’re using a drafting stan-

dard based on ANSI, a secondary fi llet-type button can be used.

9 Specifi es the number of welds, if applicable to the standard.

10 Specifi es the length of the weld.

11 Specifi es the contour fi nish of the weld. Choose from Flush or Flat fi nish, Convex fi nish, or 

Concave fi nish, or if using the DIN standard, you can choose Toes Blended Smooth.

12 Specifi es the space between welds.

13 Use this option to add the fi eld weld fl ag to the welding symbol.

14 Th e All Around Symbol toggle allows you to add an all-around symbol to the welding 

symbol. Note that the GB standard includes a third symbol; all other standards will present 

a dual-state toggle.

*(Referenced by number in Figure 10.37)
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Be Explicit with Symbols

Although you can refer to any textbook on welding for the correct use of the symbols referred to 

in Table 10.1, keep in mind that many shops have their own “shorthand” versions of weld symbols. 

It is imperative that you communicate with the welders to make sure you agree on the symbols. 

Many weld shops do not know the “standard” yet still produce excellent parts.

A perfect example is the “all-around” symbol. Some shops take this to mean only opposite sides of 

the indicated line, whereas others interpret this symbol to mean you want all contiguous surfaces 

welded. When in doubt, you should be explicit with your symbols.

Weldment Design Stages
Now that you’ve explored the tools available in the weldment environment, you’ll explore how 

to document the four major stages of weldment design in the drawing. You can create a weld-

ment drawing in the following stages:

Assembly  As-assembled with no assembly features

Preparation  As-prepped

Welds  As-welded

Machining  As-machined

Figure 10.38 shows a weldment in the four stages during its creation. Figure 10.39 shows 

drawing views of the same weldment detailed at the various stages.

Figure 10.38

Four stages of the 

weldment assembly
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Figure 10.39

Four stages of the 

weldment assembly 

as drawing views

To create a model state view as shown in Figure 10.39, follow these steps:

 1. Create a new drawing from an IDW or DWG template of your choosing.

 2. Right-click and select Base View, browse for the fi le mi_10a_007.iam located in the 

Chapter 10 directory of your Mastering Inventor 2014 folder, and click the Open 

button.

 3. Back in the Drawing View dialog box, set Orientation to Top.

 4. Click the Model State tab, and select Assembly, Machining, Welds, and Preparation while 

watching your view preview. Notice that the view changes for each weldment stage as 

you select it.

 5. Select Preparation, and click the drop-down list to explore the options. Note that you 

can detail each part fi le individually, showing its preparations clearly without having to 

perform any extra steps to hide other parts in the assembly.

 6. Once you’ve explored the different model states, click the Display Options tab.

 7. Choose Weld Annotations and Model Welding Symbols.

 8. Click the screen to set the view.

 9. Check to see that your view resembles Figure 10.40.

Figure 10.40

A weldment view 

created with weld 

annotations and 

welding symbols 

turned on
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More on Weldment Drawings

You can fi nd more about working with weldment drawings in the section “Working with Weldment 

Views” in Chapter 12, “Documentation.”

You can also retrieve associative weld symbols from the model by right-clicking the drawing 

view and selecting Get Model Annotations ➢ Get Welding Symbols. You can retrieve associative 

weld end fi lls in the model by right-clicking the view and selecting Get Model Annotations ➢ 

Get Weld Annotations. You can also add nonassociative weld annotations to your drawing. You 

can create cosmetic weld symbols or weld beads using the Annotate tab by clicking the Welding 

or Caterpillar tool on the Symbols panel. Figure 10.41 shows the annotation retrieval tools in 

drawings.

Figure 10.41

Retrieving weld 

symbols

End Fill
In the Symbols panel, you will see the End Fill tool, which is used to represent seam weld end 

fi lls and the gap/groove process shape (concave and convex). Clicking the End Fill tool brings up 

the End Fill dialog box, shown in Figure 10.42. Note that you can create any weld process shape 

that is desired in drawings without generating the specifi ed weld in the model.

Figure 10.42

Th e End Fill 

dialog box
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To create a seam weld process shape, follow these steps:

 1. Click the End Fill button on the Symbols panel of the Annotate tab (you might need to 

use the fl yout menu to fi nd it).

 2. Select the preset shape — for example, Seam Weld.

 3. Select two points that represent the shape’s arc chord length to create an arc. You can 

drag above or below the chord line to have the arc above or below.

 4. Select the Options tab, and select Check Solid Fill.

 5. Select a color, such as orange.

In the End Fill dialog box, the fi llet process shape has Leg1 and Leg2 as parameters. J-Type, 

V-Type, and U-Type Preset Shape have controls for the width and depth.

Drawing Weld Symbol
If your assembly has weld beads modeled and weld symbols created in the model, using the 

Get Welding Symbols option shown in Figure 10.41 is the best way to add weld symbols to the 

drawing.

If your assembly has weld beads modeled but does not have weld symbols created in the 

model, you can use the Welding symbol tool and then select a weld bead to retrieve the bead 

information automatically, based on the information found in the weldment model. However, 

you should be aware that the symbol won’t update if the weld bead is updated in the model.

Many times you may need to just create the weld symbol in the drawing without having to 

create any weld beads in the assembly. Although this may suffi ce for your needs much of the 

time, remember that you cannot perform any interference analysis or mass-properties calcula-

tions the way you can with modeled welds.

To create a welding symbol in the drawing, follow these steps:

 1. Select the Welding symbol button on the Symbols panel of the Annotate tab (you might 

need to use the fl yout menu to fi nd it).

 2. This activates the selection. The command message string displays the text “Click On A 

Location.”

 3. Select a weld bead (if present) or any entity or location in the graphics area to defi ne the 

location of the welding symbol.

When placing a symbol in the drawing, you can create a complex leader by selecting more 

than one point as you are placing the symbol. If you would like to add more later, you can do 

so by right-clicking the existing leader and selecting Add Vertex/Leader in the context menu.

 4. Right-click within the graphics area, and select Continue from the context menu. The 

Welding Symbol dialog box appears.

 5. Specify the desired welding symbol.

 6. The welding symbol preview dynamically updates.

 7. Click OK, and the specifi ed welding symbol appears at the specifi ed location.
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Caterpillar
You can create and use caterpillars (2D weld representations) in drawings when you want to use a 

lightweight representation for solid weld beads. As long as the welder is comfortable with this rep-

resentation, you can use caterpillars. Figure 10.43 shows the dialog box for the Weld Caterpillars 

tool in drawings. You can create weld caterpillars using the boundary (extent) edges of the welds. 

This drawing annotation is not associated with weldments in the assembly model. In other words, 

you can create the caterpillar on any edge without the presence of any corresponding weld bead 

in the assembly. This is useful when you want to quickly document weld beads in drawings. The 

caterpillar could be used in addition to the weld symbol to make the documentation better.

Figure 10.43

Weld Caterpillars 

dialog box

To create a caterpillar, follow these steps:

 1. Select the Caterpillar tool from the Symbols panel found on the Annotate tab.

 2. Click Edges, and select one of the long edges (the lateral edge) of the groove weld.

 3. Click Options, and enter the Width parameter. Adjust other parameters such as Angle, 

Arc %, and Spacing.

 4. Click the direction to change the shape to concave or convex.

 5. The Start/Stop options in the dialog box, which are specifi ed by points, are useful to 

terminate the caterpillar between the From and To locations. The caterpillar preview 

shows the effect of changing options.

Figure 10.44 shows the resulting caterpillar for a groove weld.

Figure 10.44

Weld caterpillar
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Caterpillars can be useful when you want to represent a weldment using a single-part fi le 

and create a drawing from it. You can then indicate the position and detail of the welds along 

the edge. Use the Split tool, which will allow you to create edges where none may exist.

Weldment Workflows

You are a designer working for a company in the packaging industry. Th e entire packaging system 

consists of several functional units that form its structure. You are interested in the high-level core 

packaging unit that consists of three subassemblies: A, B, and C. Let’s say it contains parts consist-

ing of a boxed container (A), a lift-arm mechanism (B) for the boxed container, and railings (C) on 

which the container moves from one station to another. Each subassembly comprises structural 

steel shapes and/or tubes that are bent and plates that are welded together.

You want to analyze subassembly A, which forms the container in the context of the top-level 

assembly, to check for interferences. For this, you need accurate solid weld beads to analyze the 

interference. You want to pattern these solid weld beads and their components and create a draw-

ing of this subassembly. To accomplish this, you would place modeled fi llet and groove weld beads.

On subassembly B, which forms the lift-arm mechanism, the weld beads are not very complex, so 

you don’t require a modeled weld for each bead, but you do need mass analysis of welds. So in this 

case, you’ll place lightweight, cosmetic welds and document them in the drawing.

On weld subassembly C, which forms the railings on which the container moves, you are interested 

neither in interference analysis nor in mass properties in assemblies. For C, you are interested only 

in quickly documenting the weldments in drawings. You need a streamlined interface to document 

the welds in drawings, and you want to generate any weld bead or symbol regardless of the weld 

standard. To do this, you will use just the Weld Symbol tool in the drawing environment.

By using the various weld tools in conjunction with one another, you can design and document 

weldments in a way that makes sense to the task at hand. You can take advantage of the fl exibility 

that comes with using any of these tools together to make weldment design accommodate your 

specifi c needs even though they fulfi ll diff erent design and documentation requirements.

Generating a Bill of Materials and Parts List
Once a weldment design is done, you typically need to generate a bill of materials (BOM) and a  

parts list. Also, you’ll want to customize the BOM to represent a weldment.

You can automatically generate and maintain a consistent bill of materials across welded 

assemblies, drawings, and presentations. Components that are deemed “inseparable” are assem-

blies that cannot be taken apart without doing damage to one or more of their components, 

typically weldments. Manufacturing processes treat inseparable assemblies like purchased 

components, and they are represented as a single line item.

When documented in its own context, an inseparable assembly is treated as a standard one 

in that all of the parts are listed. Figure 10.45 shows the BOM for an assembly that is made up of 

a weldment assembly and single-piece part. On the left, the weldment is shown in a structured 

BOM view, listing the weldment and the parts within. On the right, the BOM is shown as Parts 

Only; note that the weldments are listed as a single component.
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Figure 10.45

Inseparable 

components as han-

dled by the BOM

To modify the BOM structure, follow these steps:

 1. Open the weldment assembly.

 2. Click the Bill Of Materials button on the Manage panel of the Manage tab.

 3. On the Model Data tab, double-click in the BOM Structure column, select the drop-down 

for each component, and select Inseparable.

 4. Click Done in the Bill Of Materials dialog box.

You can change the BOM structure of several components at once by right-clicking the BOM 

Structure cell of a component marked as inseparable, right-clicking and choosing Copy, Shift-

clicking multiple components, and then right-clicking and choosing Paste.

Th e Bottom Line

Select and use the right weldment design methodology.  You’ve been shown three weld-

ment design methodologies. Before you start on any weldment design, it is imperative to 

keep the documentation, interference analysis, mass properties, and other design criteria in 

perspective and select the right design methodology.

Master It  How do you choose the right weldment strategy for you?

Create and edit weld preparations and machining features.  Following the weldment 

methodology, you need to plan on creating the gaps needed (weld preparations) to deposit 

the weld beads. You need to create post-weldment machining features that go through the 

weld beads.

Master It  Weld preparations and machining features are similar to part modeling 

features. Based on the weld-bead shape needed, you should plan on creating the prepa-

rations in advance. Once the welds are done, you must create the features for the machin-

ing processes. Where can you fi nd preparation and machining features, and when do you 

use them?

Create and edit different kinds of weld beads, such as cosmetic, fi llet, and 
groove.  Weldment design involves the optimal mix of cosmetic and solid weld beads, based 

on the requirements of your design goals and model verifi cation needs.

Master It  You should create the weld annotations only in drawings, without any need 

to create them in the model. You have weld subassemblies that need only lightweight rep-

resentation in both the model and drawings. In situations involving accurate interference 

and mass properties, you require accurate weld beads. The question is, What type of weld 

beads should you use?
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Document weldment stages in drawings.  Welds need to be documented in assemblies or 

drawings. It is important to show the different stages of weldment design in drawings to get 

a good idea of how to manufacture the weldment. You can use the drawing tools effectively 

to annotate the welds in drawings. This will help the welder understand the design intent 

better.

Master It  Several tools are used for weld documentation. You can annotate the welds 

in assemblies. If you prefer to document the welds in drawings, you could document 

the four stages of weldment design: the as-assembled, as-prepped, as-welded, and 

as-machined stages in drawings. Name two other drawing tools that customize weld 

documentation.

Generate and maintain a consistent BOM across welded assemblies, drawings, and 
presentations.  You have been shown how to generate and maintain a consistent bill of 

materials for weldment assemblies and a parts list in drawings. Mark parts or assemblies as 

inseparable to designate them as weldments.

Master It  How do you generate the BOM and parts list for your weldment?



Chapter 11

Presentations and Exploded Views

It is often useful to show an assembly of parts in a disassembled or exploded view for use in 

assembly instructions, repair manuals, and replacement part diagrams for catalogs. Inventor 

has a specifi c environment and fi le type that allows you to create these views in 3D using the 

assembly fi les you’ve already created. You can even animate the assembly (or disassembly) of 

your designs and create video fi les or animated DWF fi les. Be aware that in order to access the 

presentation tools, you must be using a full version of the Autodesk® Inventor® program. The 

Autodesk® Inventor LT™ software does not include the presentation tools.

In this chapter, you’ll learn to:

 ◆ Create an exploded assembly view by creating a presentation

 ◆ Create basic linear tweaks

 ◆ Create rotational tweaks

 ◆ Group, reorder, and animate tweaks

 ◆ Publish presentation fi les

Working in the Presentation Environment
Presentations are generally used to document how an assembly model is put together or taken 

apart. Your end result could be as simple as a static explosion that you’ll use to generate a 2D 

view in a drawing, or it could be a dynamic video where a design is assembled or disassembled 

through animation.

To access the presentation tools, you will use a new fi le template with the fi le extension .ipn. 

These are referred to as presentation fi les in Inventor. When you fi rst create a new presentation 

fi le, you’ll fi nd that the environment looks similar to the other part and assembly modeling 

environments, but it has a signifi cantly reduced set of tools. The 3D navigation tools detailed 

earlier in this book (Orbit and ViewCube® tools), as well as the browser, are used in presenta-

tions as well as in the 3D modeling environments. In the following pages, you will create a basic 

exploded assembly and explore how to create tweaks, animations, and assembly instructions.

Creating a Basic Explosion
In the following sections, you’ll take a look at the basics of creating a presentation from an 

assembly fi le. This includes accessing an IPN template fi le, creating an IPN view (explosion), 
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and creating linear tweaks. You’ll start by creating a presentation fi le from a template, and then 

choosing an assembly to explode.

If you have not already downloaded the Chapter 11 fi les from www.sybex.com/go/

MasteringInventor2014, please refer to the “What You Will Need” section of the Introduction 

for the download and setup instructions.

Accessing an IPN Template

You create presentation fi les by using an IPN (.ipn) template and then referencing an existing 

assembly fi le (.iam). To create this presentation, start with the Standard (mm).ipn template:

 1. On the Get Started tab, click the New button.

 2. In the Create New File dialog box, select the Metric tab, and choose the Standard (mm)

.ipn template.

 3. Click the OK button.

Figure 11.1 shows the Create New File dialog box and the IPN template.

Figure 11.1

Selecting the IPN 

template

Creating an IPN View

The fi rst step in creating an assembly explosion is referencing an assembly fi le. A presentation 

fi le can reference only one assembly fi le at a time, but the assembly can be used to generate 

http://www.sybex.com/go
http://www.sybex.com/go/MasteringInventor2014
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as many explosions as you might need to properly document your design. For example, you 

may create one explosion to be used as a 2D drawing view and another explosion to be used 

as an animation. You may also choose to explode each subassembly in its own explosion. Walk 

through the following steps to create an assembly explosion:

 1. On the Presentation tab, click the Create View button.

 2. In the Select Assembly dialog box, shown in Figure 11.2, browse for mi_11a_001.iam 

located in the Chapter 11 directory of your Mastering Inventor 2014 folder, and click 

the Open button.

Figure 11.2

Th e Select Assembly 

dialog box

 3. Click the Options button to specify which view, position, or LOD representation of the 

selected assembly you want loaded into the presentation environment.

 4. Set the view representation to Default, and leave the positional and LOD representations 

set to Master.

 5. Click the Associative check box to ensure that the presentation view will update if the 

assembly view representation is updated.

 6. Click the OK button when the File Open Options dialog box looks like Figure 11.3.

Figure 11.3

Th e File Open 

Options dialog box
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If you have a relatively small assembly and it was modeled with a full and robust set 

of assembly constraints,  you may choose to create an automatic explosion in the Select 

Assembly dialog box and then make minor modifi cations to meet your needs. In most 

cases, though, you’ll use the manual method.

 7. Ensure that the Manual option is selected.

 8. Click the OK button.

 9. Locate Explosion1 in the Model browser, and click the plus sign to expand it so you can 

see a list of all the components in the assembly, as shown in Figure 11.4.

Figure 11.4

Explosion1 in the 

newly created pre-

sentation fi le

Creating Linear Tweaks
You’ll now see the selected assembly (an arbor press assembly) in your presentation graphics 

area. It’s time to start adding tweaks to move or explode the assembly components. A tweak is 

simply a stored movement vector for a selected set of one or more components. You can defi ne 

both linear tweaks that move in an x-, y-, or z-axis and rotational tweaks that rotate around 

those axes. In the next steps, you’ll create a linear tweak by fi rst establishing a move direction, 

choosing a component to move, and then setting the move distance:

 1. Click the Tweak Components button on the Presentation tab.

 2. In the resulting dialog box (shown in Figure 11.5), ensure that the Direction button is 

enabled.

Figure 11.5

Th e Tweak 

Component dialog 

box
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 3. Select the yellow face of the faceplate to defi ne the direction of the tweak.

Note that the Components button in the dialog box is now enabled and ready for you to 

select the component(s) to be moved.

 4. Select the component with the yellow face (FACE PLATE) and all four of the components 

named CAP SCREW. Do this either in the graphics area or from the browser, as shown in 

Figure 11.6.

Figure 11.6

Setting the direc-

tion and selecting 

components to 

tweak

More on Selecting Components

If you select extra components by accident, simply hold down the Ctrl key and click them again to 

remove them from your selection set.

If you would like to select an entire subassembly, you must select it from the Model browser rather 

than the graphics area, unless you change your selection fi lter.

 5. Specify the tweak vector by choosing the Z button in the Transformations area of the dia-

log box (if it is not already selected).

 6. Click somewhere in an empty space of the graphics area, and drag your mouse pointer in 

the positive Z direction (pull toward the lower left of the screen).

 7. Note the tweak distance reported in the dialog box as you drag. Enter 100 mm in the dia-

log box.

 8. Click the green check mark to set the distance.

 9. Hold down the Ctrl key and click the FACE PLATE component to deselect it. Check the 

browser to ensure that it is deselected.
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 10. You’ll create a tweak for just the cap screws. This time, rather than clicking in the graphics 

window, click the triad to select the Z vector, and drag the triad to approximately 75 mm.

This simply demonstrates that the triad can be used to tweak components, allowing you 

to switch directions easily, as opposed to using the buttons in the dialog box to do this.

 11. Enter 30 mm in the dialog box, and click the green check mark to set the distance. By 

doing this you have set the tweak to 30 mm even though the initial drag value was 

approximately 75 mm. Clicking the check mark sets the fi nal tweak value.

 12. Click the Close button in the Tweak Component dialog box.

 13. On the Model browser, click the Filter button and choose Tweak View from the list.

 14. You should see the two tweaks just created listed in the browser, as shown in Figure 11.7.

Figure 11.7

Setting the browser 

to view tweaks

Once you create a tweak or tweaks based on one set of selections and inputs, you can con-

tinue to tweak additional components with new selections and inputs by fi rst clicking the Clear 

button. This allows you to create tweaks quickly without dismissing the dialog box.

Now that you have created a basic linear tweak, in the next section you’ll explore how to cre-

ate more advanced tweaks.

Creating Advanced Presentations
In the following sections, you will look at some of the more advanced functions associated with 

creating presentations, particularly for use as 3D animations. You will explore how to create 

rotational tweaks; how to modify tweak trails; and how to group, reorder, and animate tweaks. 

You’ll also discover how to create assembly instructions and publish animations and assembly 

instructions to a lightweight DWF fi le that can be easily shared.

Creating Rotational Tweaks
You can add rotational tweaks in much the same way you created the linear tweaks, though 

rather than indicating the x-, y-, or z-axis for linear direction, you’ll use the x-, y-, or z-axis as an 

axis of rotation and enter the tweak value as degrees of rotation rather than a linear distance. 

Follow these steps:

 1. You can continue using the open fi le where you left off in the previous section or you can 

open mi_11a_001.ipn in the Chapter 11 directory of your Mastering Inventor 2014 

folder. Click the Tweak Components button on the Presentation tab.

 2. In the resulting dialog box, ensure that the Direction button is enabled.
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 3. Select the shaft of one of the cap screws.

 4. With the Components button enabled, select the same cap screw.

 5. In the Transformations area of the dialog box, make sure the z-axis button is selected.

 6. Switch the radio button to select the rotational option rather than the linear one.

 7. Enter 6.25 * 360 in the input box (for six and a quarter revolutions of 360 degrees), as 

shown in Figure 11.8.

Figure 11.8

Rotational tweak 

inputs

 8. Click the green check mark to set the rotation.

 9. In the browser, confi rm that the tweak is listed.

 10. Click Clear to remove the selections and inputs from the dialog box.

 11. Repeat steps 3 through 7 for the other three cap screws.

 12. Once you’ve added rotational tweaks for each cap screw, click Close to continue.

Creating Tweaks with Drag and Drop
If you’re tweaking only one component at a time and you’re comfortable with the selection, ori-

entation, and direction behavior, you can establish direction, choose your component, and input 

the tweak distance all by dragging and dropping the selected component. You can try this with 

the light blue–colored gib plate:

 1. Start the Tweak Component tool.

 2. Click the front face of the gib plate, continue holding the left mouse button while drag-

ging the plate away from the main assembly, and then release the mouse button when 

you’ve moved it out approximately 45 mm.

Your presentation should look similar to Figure 11.9. You can close this fi le without saving 

changes; you will open another IPN fi le to continue in the following sections.

Understanding Tweak Trails
Trails are added by default. A trail is a line (or an arc in the case of a rotation tweak) that is dis-

played in the graphics area showing the start and endpoints of a particular tweak. By default, 
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the start and endpoints are defi ned by the three-dimensional geometric center of all the com-

ponents that are chosen for a tweak. However, an optional fourth step in the tweak-creation 

process is to manually select the tweak points by clicking one or more points on each of your 

selected components. Here are a few more points to know about trails:

 ◆ By default, one trail is added per selected component in your tweak.

 ◆ Deselecting the Show Trails check box when creating tweaks will turn off the visibility of 

all tweak trails.

 ◆ You can control the visibility of individual tweak trails by expanding a tweak in the Model 

browser, right-clicking the component name, and choosing Visibility (assuming tweak 

view is being used).

 ◆ You can control the visibility of trails for each component by right-clicking a component 

and choosing Hide Trails.

 ◆ You can edit a tweak by right-clicking the trail and choosing Edit or by clicking and drag-

ging the endpoint of a tweak trail.

 ◆ You can delete a tweak or delete a component from a multiple-component tweak by right-

clicking the trail and choosing Delete.

 ◆ These trails are also visible in drawing views of presentations.

Figure 11.9

Creating tweaks

More about Tweaks
Don’t forget that the browser fi lter controls the way tweaks are listed in the browser. When in 

the assembly view, as you create a tweak a browser node representing that tweak is generated in 

your browser and nested under the selected components that are part of that tweak.

Editing Tweak Values

In the tweak view, tweaks are listed as line items and the components are nested below them. 

By selecting a tweak in the browser, you can edit the movement value in the input box that 

appears at the bottom of the browser. In Figure 11.10, a 45 mm tweak is selected, and a new 

value of 60 mm has been entered.
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Figure 11.10

Editing tweak 

values

Adding and Removing Components Used in Tweaks

You can add or remove components from an existing tweak by clicking the Filter button and 

choosing Tweak View from the list. To remove a component from a tweak, right-click it and 

choose Delete. This doesn’t delete the component from the assembly; it just removes the compo-

nent from the tweak.

To add a component to a tweak, expand the assembly model tree in the browser, select the 

component to be added, and then drag and drop it onto the Tweak node in the browser. You’ll 

see a black bar appear in the browser when your cursor is in a valid location.

Create Multiple Views/Explosions
If your assembly is large or complex, consider making several explosions and tweaking only a 

few components per explosion. You can add explosions by clicking the Create View tool. Each 

subsequent time the Select Assembly dialog box is shown, however, a new assembly fi le cannot 
be specifi ed. You can choose a different view, positional, or LOD representation than you used 

for your previous explosions. Figure 11.11 shows a presentation with three explosions created. 

Explosion 3 contains just one Translate tweak, which has been expanded to show the two com-

ponents involved in that tweak.

Figure 11.11

Multiple explosions
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D Presentations Views

If the end goal of your presentation is to create an explosion that looks good in one or more 2D 

drawing views, then you already know just about everything you need to know, and you never have 

to use more than the Create View and Tweak Components tools inside the presentation environ-

ment. You can learn more about creating views in 2D drawings in Chapter 12, “Documentation.”

Save Camera
Before you save your presentation fi le and move on to creating a drawing fi le that uses the 

exploded view, make sure to set your camera view up exactly as you’d like to see it on the page. 

Use Zoom, Orbit, and the ViewCube in conjunction with the Precise View Rotation tool to get 

a view that makes things as clear as possible. Then right-click in the graphics area and choose 

Save Camera. You can use this saved camera to create a view in the 2D drawing. You can also 

right-click and choose Restore Camera any time you have changed the camera view, as shown in 

Figure 11.12. 

Figure 11.12

Saving a camera 

view

Understanding Group, Reorder, and Animate Tweaks
You can group and reorder tweaks for the purpose of animating components in a presentation. 

For instance, in the steps in the section “Creating a Basic Explosion” earlier in this chapter, you 

pulled the cap screws out all at once and then rotated them one at a time. You may want to have 

these actions separated, reordered, or grouped in order for them to behave correctly when ani-

mated. To see how this works, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_11a_002.ipn in the Chapter 11 directory of your Mastering Inventor 

2014 folder, and click the Open button.
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 3. If you have zoomed or orbited the assembly, right-click and choose Restore Camera.

 4. On the Presentation tab, click the Animate button.

 5. In the Animation dialog box, click the >> button (at the bottom-right corner) to expand 

the dialog box so you can view the animation sequence, as shown in Figure 11.13.

Figure 11.13

Tweak sequences 

in the Animation 

dialog box

You’ll notice there are currently seven sequence steps. Next, you’ll group some of them to 

reduce the number of sequence steps used.

 6. Click the Play Forward button to animate the tweaks; note how the rotation tweaks just 

spin in place.

 7. Click the Reset button.

 8. In the Animation Sequence area, hold down Ctrl on the keyboard, and select all of the 

rotation tweaks (2250 deg) and all of the 30 mm tweaks.

 9. Click the Group button to group these tweaks into a single sequence step.

 10. Click the gib plate and use the Move Up button to change it to sequence step 1.

 11. When the gib plate is sequence step 1 and the group of 2250 deg and 30 mm tweaks are 

sequence step 2, as shown in Figure 11.14, click the Apply button.

 12. Click the Play Forward button to animate the tweaks, and note that the cap screws now 

rotate and move at the same time.

 13. Click the Reset button and the Cancel button to exit the Animation dialog box.
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Figure 11.14

Reordered tweak 

sequence

Note that the Cancel button does not undo the changes you just made, and should be 

labeled Done rather than the Cancel button.

 14. In the Model browser, click the Filter button and choose Sequence View from the list.

 15. Expand the Task node to see the sequence steps.

You’ll notice the sequences correspond with the groups you created in the previous steps. 

This is essentially the same set of steps you saw in the Animation dialog box.

Here are more things to know about working with sequences in the browser:

 ◆ You can drag and drop the sequences in the browser to reorder them.

 ◆ You can expand the browser node for each sequence to see the list of components grouped 

in the sequence.

 ◆ To remove a component from a sequence, you can right-click it in the browser and choose 

Delete.

 ◆ To remove a component from a sequence and add it to a new sequence, you can right-click 

it in the browser and choose New Sequence.

Although the rotation of the cap screws is still not true to life in this example, you should be 

able to see that you can create tweaks in any order you choose and then group and reorder them 

as required later until you get the result you need. Feel free to experiment with this fi le to add, 

remove, group, or reorder tweaks as you see fi t to get the screws to rotate and move into place 

realistically. When fi nished, you can close this fi le without saving changes and continue to the 

next section.

Recording Exploded Presentations

Many design departments use presentations to create short animated movie fi les to be viewed by 

the people on the shop fl oor who assemble the product. You can use the Record button found in 

the Animation dialog box to save an AVI or WMV movie fi le of your assembly being assembled or 

disassembled.
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Other companies use these tools to record assembly movies for customer support when dealing 

with replacement part installation, posting them online, or including them on a disc.

When creating movie fi les in this way, you may fi nd it best to create shorter clips and then use 

video-editing software (often included with Windows) to put the clips together and add voiceover 

or text slides.

Creating and Sharing Assembly Instructions
You can create assembly instructions for a presentation animation to share with a customer, to 

present to a group, or to be used by people on the shop fl oor. The animations and instructions 

can be published to a DWF fi le and viewed with the free Autodesk® Design Review application. 

Or you can use the DWFx extension and use Microsoft Internet Explorer as the viewer. Follow 

these steps to explore how to create assembly instructions:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_11a_003.ipn in the Chapter 11 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. In the Model browser, click the Filter button and choose Sequence View from the list.

 4. Locate Explosion2 in the browser, and double-click it to activate it.

Creating Multiple Explosions

Recall that you can create multiple explosions of the same assembly by using the Create View 

button. Each view becomes a separate explosion with a diff erent camera view. You might show 

the assembly of external housing components in Explosion1 and then use Create View to create 

a second explosion. In Explosion2, you can turn off  the visibility of the housing components and 

concentrate on just the internal components. Remember, too, that if you have created view or LOD 

representations to control the visibility of internal and external parts, you can use them when 

creating the explosion by clicking the Options button.

You can also copy existing explosions by right-clicking an explosion in the browser and choosing 

Copy. Th en right-click in the IPN fi lename node (the topmost node) in the browser and choose 

Paste from the context menu.

 5. Expand Explosion2 to see that there are two tasks within it.

 6. Double-click Task2a to activate it.

 7. In the resulting Edit Task & Sequences dialog box, click the Play button at the top.

 8. Click Reset when it is done playing.

 9. Click the Play button in the middle to play just Sequence1.

Certification
Objective
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 10. Click Reset when it is done playing.

 11. Enter the following into the Description area for Task2a: Assemble collar as shown.

Figure 11.15 shows the Edit Task & Sequences dialog box.

Figure 11.15

Adding assembly 

instructions

 12. Enter 10 in the Interval fi eld to speed up the playback of this sequence.

 13. Click Apply.

 14. Click the Sequence1 Play button to view the faster playback, and click Reset when 

fi nished.

 15. Switch the Sequences drop-down from Sequence1 to Sequence2.

 16. Note that the instructions have been fi lled out already.

 17. Use the ViewCube, the Orbit tool, or your 3D controller to change the camera view so that 

you can see the ram and the shaft without obstruction. Zoom in as you see fi t.

 18. Click the Set Camera button.

 19. Click the Apply button.

 20. Click the Play button at the top to see the entire Task2a play back again. Note the changes 

to the camera view you made.

 21. Click the OK button.

Here are a couple of other actions you can take to organize tasks:

Create Tasks  When you create tweaks within an explosion, they are initially all created in 

a single task. To create multiple tasks, use the fi lter to set the view to sequence view, and then 

right-click an explosion and choose Create Task. Then just drag the sequences into the task 

as needed.
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Hide Components  You can hide components per sequence by expanding the sequence 

while in sequence view and revealing the Hidden folder. Then just select the component from 

the model tree and drag it up into the Hidden folder. If it appears in the Hidden folder of a 

sequence, that component will not be visible for that particular sequence.

If you need to share assembly animations and instructions with someone who does not 

use Inventor, such as the people on the shop fl oor, you can publish the presentations to a DWF 

(.dwf) fi le:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_11a_004.ipn in the Chapter 11 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. Click the Inventor button and choose Export ➢ Export To DWF.

 4. In the Publish Presentation dialog box, select one of the following:

Express  Static exploded views are published. BOM data, design views, and positional 

representations are not published.

Complete  The DWF fi le contains all presentation views, including animations, assem-

bly instructions, and the associated assembly as well as its design views, positional repre-

sentations, and BOM.

Custom  You have full control over which animations and assembly instructions are 

included or excluded as well as whether to include the assembly, the BOM, and so on.

Figure 11.16 shows the Publish Presentation dialog box.

Figure 11.16

Publishing a 

presentation

 5. Confi gure the general options for markup, measure, printing, and password protection.

 6. Click Publish.

 7. Set the fi lename and location as you see fi t, and choose DWF or DWFx for the fi le type.

 8. Click Publish.
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The key differences between the two DWF fi le types is that the 2D DWFx can be read by 

Windows Vista and XP (with Internet Explorer 7 or later installed) without the need for an extra 

viewer such as Autodesk Design Review. 3D DWFx and DWF fi les still require Design Review. 

Note too that the DWFx fi le is generally about twice as large.

You can invite vendors and clients as well as the shop fl oor to download Design Review for 

free from the Autodesk website.

Display Published File in Viewer for DWF and PDF

At the bottom of the Publish Presentation dialog box, there is a check box allowing you to choose 

whether or not the published fi le will automatically be displayed in the designated viewer appli-

cation (typically Design Review for DWF fi les). Be aware that this option also controls whether 

PDFs that are generated using Export To PDF are automatically displayed in the designated PDF 

application or not. If you’d rather not have Design Review or Adobe Reader open each time you 

save a DWF or PDF, uncheck this option.

Th e Bottom Line

Create an exploded assembly view by creating a presentation.  Presentation fi les are used 

to virtually disassemble an assembly so downstream consumers can better visualize the 

design. The explosion created in the presentation fi le can be referenced in an assembly draw-

ing to complement nonexploded assembly views.

Master It  Your assembly design is complex and contains many internal components 

that can’t be visualized in traditional assembly drawing views. What is a good approach 

to showing those components?

Create basic linear tweaks.  Tweaks are used to move (or translate) components along a 

specifi ed axis. This allows you to pull your assembly apart, in order to show how it goes 

together.

Master It  Your assembly design includes a number of hardware connections, and you’d 

like to show how they go together in a clear and concise way. How should you do this?

Create rotational tweaks.  Rotational tweaks allow you to move components in an orienta-

tion that is not along the standard x-, y-, and z-axes, and that can be used to show rotation of 

parts for animations.

Master It  Your assembly has a housing that you’d like to tip out of the way to show both 

the parts within and the connection features of the housing. When you apply a linear 

tweak, you can move the housing up and off the assembly to show the parts, but you can-

not see the connection features. What do you need to do to see the connection features?

Group, reorder, and animate tweaks.  Once tweaks are created, you may want to group 

several of them together into the same sequence instead of steps, and reorder them to show a 

specifi c assembly step in an animation.

Master It  You want to create an animated assembly presentation of your assembly go-

ing together, but when creating the tweaks, you did so by going from top to bottom of 
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the assembly rather than following the order in which the assembly would actually take 

place. Can this be resolved?

Publish presentation fi les.  Although you can place views of your presentation fi le on a 2D 

drawing, it can be helpful to include the 3D animation for customers and colleagues in the 

form of a DWF or DWFx fi le.

Master It  You want to supply the shop fl oor with assembly instructions of your assem-

bly going together. What is a good way to do this?





Chapter 12

Documentation

At any point in your design process, you can choose to begin documenting your design with the 

Autodesk® Inventor® program. Although creating drawings was traditionally something that 

had to wait until the design was fully complete, there are no such restrictions in Inventor. You 

can start to develop an annotated 2D drawing fi le at any point in your process. It is generally 

recommended, however, that you start documenting as late in the design as possible.

The ultimate goal of this chapter is to illustrate how you can use the Drawing Manager in 

Inventor to generate traditional 2D annotated drawings. You can then output your documenta-

tion in a variety of fi le formats, including DWF and PDF.

In this chapter, you’ll learn to:

 ◆ Create templates and styles

 ◆ Utilize drawing resources

 ◆ Edit styles and standards

 ◆ Create drawing views

 ◆ Annotate part drawings

 ◆ Annotate assembly drawings

 ◆ Work with sheet-metal drawings

 ◆ Work with weldment views

 ◆ Work with iParts and iAssembly drawings

 ◆ Share your drawings outside your workgroup

Using the Drawing Manager
Once you have created your 3D design, you can choose to document it with conventional 2D 

orthographic drawing views and traditional drafting tools. This kind of documentation is cre-

ated in the Drawing Manager environment.

These high-level Drawing Manager tasks are discussed in the following sections:

 ◆ Creating Templates and Styles

 ◆ Utilizing Drawing Resources

 ◆ Editing Styles and Standards
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 ◆ Creating Drawing Views

 ◆ Annotating Part Drawings

 ◆ Annotating Assembly Drawings

 ◆ Working with Sheet-Metal Drawings

 ◆ Working with Weldment Views

 ◆ Working with iParts and iAssembly Drawings

 ◆ Sharing Your Drawings outside Your Workgroup

Creating Templates and Styles
Although several drawing templates are installed with Inventor, before you begin to document 

your own designs and models you should create your own custom template or templates to best 

meet your needs. This is because most users have to adhere to a specifi c set of drafting stan-

dards dictated by their company, customer, or vendor specifi cations. These standards are typi-

cally derivatives of one of several international drafting standards such as ANSI, ISO, or DIN. 

Therefore, Inventor installs with a set of templates and drafting styles confi gured for the follow-

ing international standards:

 ◆ ANSI (both imperial and metric units)

 ◆ BSI

 ◆ DIN

 ◆ GB

 ◆ GOST

 ◆ ISO

 ◆ JIS

When creating your own custom template, it is sometimes best to start with a standard tem-

plate that closely meets your requirements and modify the styles already found within it as 

needed. At other times it might be best to create a template from a “clean” template fi le that con-

tains no styles and create them yourself.

Creating templates in the Drawing Manager is not unlike creating templates in other appli-

cations. The primary difference is that many applications use a special fi le format for template 

fi les, whereas Inventor uses the same fi le format but uses a folder location to designate all fi les 

within the template location as templates. As a result, you can use any IDW or DWG fi le as a 

drawing template; you just need to save it in the template location.

To create a drawing template from an existing, Autodesk-provided template, follow these 

general steps:

 1. Select the New File button from the Get Started tab.

 2. Choose an IDW or DWG template that is close to your needs (for instance, you might 

select the DIN.idw fi le if your company uses the DIN standard).
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 3. Click the Inventor button (the large I in the upper-left corner) and choose Save As ➢ Save 

Copy As Template.

 4. Create a new folder for your custom template location.

 5. Rename your custom template to a name of your choice.

 6. Make changes to the styles and standards as needed and then use the Save Copy As 

Template option to update the template fi le.

To create a drawing template from a “clean” template fi le that contains no styles, follow these 

general steps:

 1. Hold down the Ctrl and Shift keys and select the New File button from the Get Started 

tab, as shown in Figure 12.1.

Figure 12.1

Creating a new fi le 

with no styles

New

 2. Select Drawing from the New dialog box and then click the OK button.

 3. Click the Inventor button and choose Save As ➢ Save Copy As Template.

 4. Create a new folder for your custom template location.

 5. Rename your custom template to a name of your choice.

 6. Make changes to the styles and standards as needed and then use the Save Copy As 

Template option to update the template fi le.

Understanding Template Locations
By default, Inventor templates are stored in and accessed from C:\Users\Public\Documents

\Autodesk\Inventor 2014\Templates. You set the default location initially from the Tools tab 

by clicking the Application Options button and then selecting the File tab and entering a folder 

location in the Default Templates box. For stand-alone users working on a local drive, consider 

using the same location where you store your design projects for your template fi le location. If 

you’re part of a networked design group, you should create a template folder on a shared net-

work drive and change the default templates' path accordingly.

The default template location can be overridden on a per-project basis as well by setting the 

template location in the project fi le confi guration. Keep in mind that if you have a template loca-

tion set in Application Options and another set in the project fi le, the project fi le always takes 

precedence. Setting the template path in the project and having everyone use the same project 

fi le can often be the best way to ensure that all members of the design group are using the same 

templates.
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Standard Templates

If you use the New File drop-down menus to access templates, you should know that these tem-

plates are hard-coded to use fi les named Standard.ipt, Standard.iam, Standard.ipn, and 

Standard.idw (or .dwg) located at the route of your template location. If you remove or rename 

the fi les named Standard, the drop-down menus will not work. Unfortunately, there is no way to 

point the drop-downs to use a template of a diff erent name. However, if you create a copy of your 

template fi les, place them at the root of your template directory, and name them Standard, you 

can then access your customized templates using the standard drop-down menus.

Choosing a File Format
Prior to Inventor 2008, the IDW fi le format was the only native 2D fi le type recognized by 

Inventor. DWG TrueConnect, introduced with Inventor 2008, enables you to use both DWG and 

IDW as valid fi le formats in the Drawing Manager.

Using DWG as your fi le format enables you to open Inventor DWG fi les in the AutoCAD® 

program (or an AutoCAD vertical product such as AutoCAD® Mechanical) without going 

through a translation process. Although the data you create natively in Inventor cannot be 

manipulated directly in AutoCAD, all of the Inventor data can be viewed, measured, and 

printed using conventional AutoCAD commands.

By choosing DWG as your default fi le format, you allow downstream users of your designs to 

view the 2D drawing documents in AutoCAD without having to purchase or install Inventor or 

download the Inventor fi le viewer. Vendors, customers, or other internal personnel can open the 

native Inventor DWG fi le and view, measure, and print the Inventor data, or they can even add 

AutoCAD data to the fi le to create a hybrid document that can be viewed quickly and effi ciently 

in either application. AutoCAD users with older versions of AutoCAD might need to download 

the Autodesk DWG TrueConnect Object Enablers to view the Inventor proxy objects. Use the 

search phrase “TrueConnect Object Enabler” to locate the downloads online.

Be Aware of File Size

Although many design departments fi nd the convenience of having their Inventor drawings in DWG 

format well worth it, you should understand that Inventor DWG fi les will be larger than Inventor 

IDW fi les. Th e diff erence in size may vary depending on the content, but diff erences of up to three 

times as large can be common. Save a dozen typical drawing fi les as both Inventor DWG and IDW, 

and compare the sizes yourself to determine which is right for you.

For Inventor users, there is essentially no difference between using DWG and using the tra-

ditional IDW fi le format. The native DWG fi le includes a Layer 0 in the layer list and an AutoCAD 

Blocks folder in Drawing Resources. These are the only noticeable differences between the 

two fi le formats. An IDW fi le can always be saved as an Inventor DWG, and vice versa, without 

any loss of fi delity or data. If there’s a good chance of someone wanting to see a DWG version 

of your Inventor fi le, you might consider choosing DWG as your default fi le format. The Task 

Scheduler in Inventor enables you to batch-convert a set of IDW fi les into DWG fi les.



UTILIZING DRAWING RESOURCES | 539

Utilizing Drawing Resources
You should customize three areas of the template to conform to your chosen drafting standards 

and personal preferences: Drawing Resources, Document Settings, and Styles And Standards.

Drawing resources are simply a collection of reusable sketches and formats that are stored 

in a drawing fi le. There are four types of drawing resources: sheet formats, borders, title blocks, 

and sketched symbols. If you’ve decided to use DWG as your template format, you’ll notice that 

AutoCAD blocks are also managed as Inventor drawing resources.

Drawing resources are accessed from your drawing browser under the Drawing Resources 

folder, as shown in Figure 12.2. If you expand the Drawing Resources node, you’ll see a folder for 

each of the drawing resource types listed, and contained in each of the subfolders are drawing-

resource defi nitions. Double-click any drawing resource to place an instance in your drawing.

Figure 12.2

Th e Drawing 

Resources node 

in the drawing 

browser

You can employ several document-management techniques with respect to templates, sheet 

sizes, borders, and title blocks. Although you could create and maintain separate drawing 

templates for each sheet size and title block you might need, it’s generally recommended that a 

single drawing template be used to maintain each of these different confi gurations. In the fol-

lowing sections, you’ll take a look at the various drawing resources.

Sheet Size
When you start a new drawing from one of the templates installed with Inventor, a border and 

title block are already present on the sheet, and the sheet is set to a default size. You can change 

the default sheet size by right-clicking the sheet in the browser and choosing Edit Sheet from the 

context menu. For example, if you are using the ANSI (in) template, the default sheet size is C. If 

you change the sheet size to D, the border on the sheet updates automatically to accommodate 

the change in sheet size.

To have your templates default to a different sheet size, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Browse to your template location, and open a drawing fi le, such as Standard.idw (see the 

section “Understanding Template Locations” earlier in this chapter).

 3. Right-click the sheet in the browser, and choose Edit Sheet.

 4. Click the arrow in the drop-down box, and choose the size or sheet format from the list.

 5. Click the Inventor button and choose Save (or press Ctrl+S on the keyboard).
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Now when you start a new fi le from the template, this new sheet size will be active.

Multiple Sheets
If needed, you can add sheets to your template, which is recommended if most of your design 

documents require more than one sheet. To insert a new sheet into your document, follow these 

steps:

 1. Right-click on any blank area on the page, and choose New Sheet (or click the New Sheet 

button on the Place Views tab).

 2. Note that this adds the border and title block and the same size sheet as the active sheet.

 3. To switch between sheets, double-click the sheet node in the browser.

Multiple Sheet Drawing Files

Use caution when creating multiple sheet sets of a sizable number because performance will likely 

suff er, depending on the size and complexity of the models you are detailing. Be aware too of “put-

ting all of your eggs in one basket” should a fi le become corrupted or lost. It is generally considered 

best practice to create a single drawing for each part number in an assembly, rather than attempting 

to manage an entire drawing set for an assembly in a single drawing fi le. However, certain industries 

approach this aspect of drawing sets diff erently.

Creating a Border
The default border used on the Inventor templates may not meet your needs. To create a new 

border you’ll fi rst follow these steps to remove the instance of the old border:

 1. Expand the sheet node in the browser.

 2. Right-click the border instance, and choose Delete.

Doing so removes the instance of the border from the sheet. The border defi nition is still 

stored in the Borders folder of the Drawing Resources node. To create a new, custom border in 

your template, follow these steps:

 1. In your template fi le, expand the Drawing Resources node in the browser.

 2. Right-click the Borders folder, and choose Defi ne New Border. You might have the option 

to choose Defi ne New Zone Border, but you’ll use a simple border here to explore the 

steps required. Here is a brief description of both border types:

Defi ne New Zone Border  Brings up an input dialog box where you can specify the 

number of horizontal and vertical zones, alpha or numeric zone labels, font and font size, 

and margin spacing. A sketch is created from your input automatically.

Defi ne New Border  Creates a sketch with the four corners of the sheet projected in. You 

can sketch a rectangle to create a simple custom border and use dimensions to specify the 

margins from the sheet corners. Dimensioning to the sheet corners allows your border to 

automatically resize to any sheet size, holding the specifi ed margins. Borders can be as 

simple or complex as required, but the sketch should always be fully constrained.
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 3. On the Sketch tab, select the Two Point Rectangle tool.

 4. Sketch a small rectangle on the screen; ensure that you do not sketch it on the sheet cor-

ners, because this will constrain the rectangle to the corners.

 5. On the Sketch tab, select the Dimension tool.

 6. Place dimensions from the corners of your rectangle to the projected corner points of the 

sheet so that the edges of the rectangle will be 10 mm from the edge of the sheet.

Formatting Color and Line Weight in a Border Sketch

By default, all geometry created in a border is set on a layer named Border. You can change the 

color and line weight of that layer to modify all the entities of your border, or you can override the 

properties of individual entities as required. To do the latter, right-click the object you want to 

modify, and select Properties.

 7. When your border sketch is complete, right-click and choose Save Border (or click the 

Finish Sketch button on the Sketch tab).

 8. Enter the name of your border defi nition.

 9. Click Save.

 10. Look in the Borders folder of the Drawing Resources node in the browser for your new 

border defi nition.

 11. Right-click your border, and choose Insert to place an instance of it on the current sheet.

 12. If you need to modify the border defi nition, right-click your border instance or the defi ni-

tion in Drawing Resources, and choose Edit Defi nition or Edit.

Because the border is dimensioned to the edge/corners of the sheet, if you edit the sheet size the 

border will automatically resize as needed, holding the margin distance, 10 mm in this example.

Creating a Title Block
Title blocks are customized in much the same way borders are customized. Title blocks typically 

contain more text-based information than borders, so the focus will be on creating sketch text in 

this section. There are three common ways of creating a custom title block:

 ◆ You can use an existing title block originally drawn in AutoCAD.

 ◆ You can modify a default Inventor title block.

 ◆ You can create one completely from scratch in Inventor, drawing the line work and insert-

ing the text fi elds.

In this section, you will bring in an existing AutoCAD title block and make it intelligent to 

Inventor. In doing so, you will explore the tools used to create a title block employed in the other 

tile block creation methods mentioned. You should probably fi rst delete the default title block 

from your current sheet before creating a new title block, just to reduce confusion. 
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If you have not already downloaded the Chapter 12 fi les from www.sybex.com/go/

MasteringInventor2014, please refer to the “What You Will Need” section of the Introduction 

for the download and setup instructions.

Once you’re sure you have the Chapter 12 fi les in place, follow these steps to explore the cre-

ation of a title block:

 1. From your template fi le (or any standard Inventor drawing fi le), expand the sheet node in 

the browser.

 2. Right-click the title block instance, and choose Delete.

 3. On the Get Started tab, click the Open button.

 4. Browse for mi_12a_033.dwg in the Chapter 12 directory of your Mastering Inventor 

2014 folder. You may need to change the Files Of Type drop-down to All Files or 

AutoCAD Drawings (*.dwg) to locate the fi le.

 5. Click the Options button in the Open dialog box.

 6. Ensure that Open is selected; otherwise, Inventor will take you to the DWG/DXF File 

Wizard.

 7. Click the OK button.

 8. Click the Open button.

Notice that when you open an AutoCAD drawing in Inventor, you can view and measure 

the fi le. You should see a black background, and if you check the browser, you will see 

that you are viewing the model space environment of the fi le.

 9. Right-click the title block, and choose Copy.

 10. Use the Open Documents tabs at the bottom of the screen to switch back to your template 

fi le (or press Ctrl+Tab on the keyboard).

 11. In the Drawing Resources folder in the browser, right-click the Title Blocks folder, and 

choose Defi ne New Title Block. This will place you in the Sketch environment.

 12. Right-click in the graphics area, and choose Paste.

 13. Click in the middle of the sheet to place the title block.

You’ll notice that the line work is underconstrained and not dimensioned at all. You 

can take the time to dimension it if you’d like, but because this will become a block, and 

therefore a static entity, you most likely will not need to do so.

Continue adding intelligence to the text now.

 14. Right-click the text fi eld containing CDW, and choose Edit Text.

 15. In the Format Text dialog box, select the text, and press Delete on the keyboard.

 16. Locate the Type drop-down and set it to Properties – Drawing, as shown in Figure 12.3.

 17. Set the Property drop-down to Designer.

http://www.sybex.com/go
http://www.sybex.com/go/MasteringInventor2014
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Figure 12.3

Customizing the 

title block

 18. Click the Add Text Parameter button  to set the Designer property to the 

text fi eld.

 19. Click the OK button.

 20. Repeat steps 14 through 19 for the date fi eld directly to the right of the fi eld you just 

edited. Use the Creation Date property instead of Designer.

 21. Right-click and choose Save Title Block (or click the Finish Sketch button on the 

Sketch tab).

 22. Enter a name for the new title block defi nition, such as My Title Block.

 23. Look in the Title Block folder of the Drawing Resources node in the browser for your 

new title-block defi nition.

 24. Right-click your title block and choose Insert to place an instance of it on the current 

sheet.

 25. If you need to modify the title block defi nition, right-click your title block instance or the 

defi nition in Drawing Resources, and choose Edit Defi nition or Edit.

Obviously, you have not confi gured the entire title block at this point, but before going any 

further, it is important to understand where the properties you linked to the title block text 

fi elds are coming from. You can fi nd these properties in the fi le iProperties. Follow these steps 

to change an iProperty in the drawing fi le and see that change show up in the title block:

 1. Click the Inventor button and choose iProperties.

 2. On the iProperties Project tab, change the Designer input to Test Designer.
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 3. Change the Creation Date input fi eld to 1/1/2014.

 4. Click the OK button to apply the changes and close the iProperties dialog box.

Your title block will have updated the two fi elds automatically based on the iProperty 

changes you made, demonstrating that you have linked those fi elds to the iProperties of this par-

ticular drawing fi le. If you intend to use this title block for your drawing template, you should 

continue to confi gure your title block to retrieve the iProperties needed, until all of the fi elds 

are automatically fi lled out by updating the iProperties. For now, you can close the fi le you have 

open without saving changes and continue to the next section to learn more about iProperties.

iProperties and Title Blocks

Each Inventor fi le has its own set of iProperties, allowing you to pull information from that fi le 

into your title block. There are two distinct methods you can use to retrieve iProperties into 

your title block:

 ◆ You can retrieve iProperties from the drawing fi le.

 ◆ You can retrieve iProperties from the model fi le that is referenced in the drawing fi le.

The following is a list of the standard iProperties available. Each of these can be accessed 

from the Type drop-down in the Text Format dialog box as described in the previous steps. 

You’ll learn more about iProperties in Chapter 13, “Inventer Tools.”

Author Designer Mfg Approved Date

Authority Eng Approval Date Part Number

Category Eng Approved By Project

Checked By Engineer Revision Number

Checked Date Estimated Cost Status

Comments Filename Stock Number

Company Filename And Path Subject

Cost Center Keywords Title

Creation Date Manager Vendor

Description Mfg Approved By Weblink

Design Date

Linking Your Model and Drawing iProperties

Often, you will want the iProperties for the model fi le and drawing fi le to match. You can use the 

Copy Model iProperty Settings option to have this happen automatically.

To do so, open your drawing template, select the Tools tab, click Document Settings, select the 

Drawing tab in the dialog box that opens, and click the Copy Model iProperty Settings button at 

the bottom. You can have some or all of the model properties copied to the drawing.

Note that once copied, the properties do not update automatically when they are changed in the 

model. To update them, select the Manage tab, and click Update Copied Model iProperties.
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Follow these steps to modify a title block so it is pulling information from the model iProp-

erties. You’ll note that this title block is calling the model fi lename iProperty for the drawing 

title. Most of the other fi elds are being pulled from the drawing fi le’s iProperties. The fi eld you 

will be modifying is static and needs to be set to pull from the model fi le’s iProperties. Here are 

the steps:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_024.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder.

 3. Expand the sheet node in the browser (if it is not already expanded).

 4. Right-click the title block instance (named MI_TB_04) in the browser, and choose Edit 

Defi nition.

 5. Zoom up on the title block, and locate the Part Number area toward the bottom.

 6. Right-click the text fi eld showing ###, and choose Edit Text.

 7. In the Format Text dialog box, select the text (###), and press Delete on the keyboard.

 8. Locate the Type drop-down, and choose Properties – Model.

 9. Set the Property drop-down to Part Number.

 10. Click the Add Text Parameter button to set the property to the text fi eld.

 11. Click the OK button.

 12. Right-click, and choose Save Title Block (or click the Finish Sketch button on the 

Sketch tab).

 13. Click Yes at the Save Edits prompt.

To ensure that the part number in the title block is coming from the part model and not 

the drawing fi le, you will open the model fi le and change its iProperties.

 14. Locate the View2:Arbor_Frame.ipt node in the browser, and then right-click it and 

choose Open.

 15. Once the part model is open, right-click the top-level node (Arbor_Frame.ipt) in the 

browser and choose iProperties.

 16. Select the Project tab, and then edit the Part Number fi eld to read 98765.

 17. Click the Apply button and then the Close button.

 18. Use the Open Documents tabs at the bottom of the screen to switch back to the drawing 

fi le (or use Ctrl+Tab to switch between all open documents).

You will see that the title block has read the model part number and displays the change in 

the Part Number fi eld.

Experiment with the title block to understand the way it works with iProperties from the 

model, and then you can close the fi le without saving changes. You might notice that this title 

block does not contain dimensions. Instead, the objects within it were anchored in place using 

sketch constraints.
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The i CHECK IT Add-in for Inventor

Th ere are several add-ins available that check to ensure that users have not forgotten to fi ll out 

required iProperties. One such add-in is i CHECK IT from Tata Technologies. i CHECK IT goes 

far beyond just checking iProperties, however; it will also check to ensure that the fi le naming 

convention has been followed, that the fi rst sketch of a model is constrained to the origin, that 

all sketches are fully constrained, that only approved dimension styles are used, and much more. 

Th ere are over 100 checks that can be defi ned. Visit

http://apps.exchange.autodesk.com/INVNTOR/Home/Index

to download a 30-day free trial version.

General File Properties and Title Blocks

In addition to iProperties, you can use some other standard fi le properties to fi ll out your title 

block automatically. You can access them from the Type drop-down in the Text Format dialog 

box just as you did the iProperties. Table 12.1 lists several general properties that can be called 

into a text fi eld.

Table 12.1: Available properties

Physical properties 

of the model

General drawing 

properties

Drawing sheet 

properties

Sheet-metal 

flat pattern 

properties

Area Number Of Sheets Sheet Number Flat Area

Density Sheet Revision Flat Length

Mass Sheet Size Flat Width

Volume

Follow these steps to set up the sheet number area of the title block to call on general fi le 

properties of the drawing fi le to automatically fi ll out the title block:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_025.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder.

 3. Expand the sheet node in the browser.

 4. Right-click the title block instance (named MI_TB_05), and choose Edit Defi nition.

 5. Zoom up on the title block, and locate the SHEET ?? OF ??? area at the bottom right.

 6. Right-click the text fi eld showing SHEET ?? OF ???, and choose Edit Text.

http://apps.exchange.autodesk.com/INVNTOR/Home/Index


UTILIZING DRAWING RESOURCES | 547

 7. In the Format Text dialog box, select the two question marks between the word SHEET 

and the word OF, and press Delete on the keyboard.

 8. Locate the Type drop-down, and choose Sheet Properties.

 9. Set the Property drop-down to Sheet Number.

 10. Click the Add Text Parameter button to set the Number Of Sheets property to the 

text fi eld.

 11. Still in the Format Text dialog box, select the three question marks after the word OF, and 

press Delete on the keyboard.

 12. Locate the Type drop-down, and choose Drawing Properties. (Note that there is one 

called Properties – Drawing also, so ensure that you have the correct one.)

 13. Set the Property drop-down to Number Of Sheets.

 14. Click the Add Text Parameter button to set the Sheet Number property to the text fi eld.

 15. Ensure that the text in the text displays as SHEET <Sheet Number> OF <Number of 

sheets>. Then click the OK button.

 16. Right-click, and choose Save Title Block (or click the Finish Sketch button on the 

Sketch tab).

 17. Click Yes at the Save Edits prompt.

Experiment with adding new sheets and reordering the sheets (just drag and drop the sheets 

in the browser) to see how the title block updates, and then you can close the fi le without saving 

changes.

Prompted Entry
You can also create fi elds in your title block to enter information manually using what is known 

as a prompted entry. Prompted entry text is keyed in by the user and not retrieved from the fi le 

properties in the way that iProperties are. Because of this, experienced Inventor users will tell 

you that iProperties are favored over prompted entries for two reasons.

First, information entered into a prompted entry fi eld is stored in that one title-block instance 

and nowhere else. If you need to update the title block for your entire drawing library at some 

point in the future, you can do so easily with the Drawing Resource Transfer Wizard, which can 

swap out old title-block defi nitions with a new one, en masse. (See Chapter 13 for more on this 

Inventor tool.) This works well when title blocks have been populated with iProperties because 

the information resides in the fi le, not the title block. However, if a prompted entry was used, 

that information will not be carried over because it exists only in the old title-block instance.

Second, since iProperties are stored in the fi le, there are a couple of important tasks that can 

be performed on them:

 ◆ iProperties can be viewed, searched, and copied easily using a number of tools such as 

Find, Design Assistant, and Vault.

 ◆ Non-Inventor users can use iProperties to sign off on drawings without opening the fi le in 

Inventor.
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Getting in the habit of using iProperties will pay large dividends in the future, once you have 

created many Inventor fi les. With these things in mind, you should use prompted entries in title 

blocks rarely. Here are the steps for creating a prompted entry in a title block if you determine 

that it is required:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_026.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder.

 3. Expand the sheet node in the browser.

 4. Right-click the title block instance (named MI_TB_06), and choose Edit Defi nition.

 5. Zoom up on the title block, and locate the Tracking Code area at the bottom left.

 6. Right-click the text fi eld showing #####, and choose Edit Text.

 7. Locate the Type drop-down, and choose Prompted Entry.

 8. Replace ##### with Enter Tracking Code.

 9. Click the OK button.

 10. Right-click any empty space in the graphics area, and choose Save Title Block.

 11. Click Yes at the Save Edits prompt.

 12. Enter 12345 for the tracking code, when prompted.

 13. Click the OK button.

You can edit a prompted entry in a title block by expanding the block instance in the browser 

and double-clicking the Field Text node. If no prompted entry is established, you will only be 

able to view the fi elds. If you edit Sheet 2 and add the MI_TB_06 title block to it, you will imme-

diately be prompted for the tracking-code entry. When you’ve fi nished exploring prompted 

entries, you can close the fi le without saving changes.

Sketched Symbols
Sketched symbols are created, edited, placed, and managed much like other drawing resources, 

but there is no limit to the number of sketch symbol instances you can place on a sheet. Like other 

drawing resource defi nitions, sketched symbols are placed by double-clicking the defi nition node 

in the browser or using the User Symbols button found on the Symbols panel of the Annotate tab.

Sketched symbols can optionally include a leader. Using a leader, you can associate a sketch 

symbol with a model so that model-specifi c properties can be displayed in the symbol. For 

example, you could create a sketch symbol that calls out a component’s mass:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_030.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder.

 3. Expand the Drawing Resources browser folder.

 4. Right-click the Sketch Symbol folder, and select Defi ne New Symbol.
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 5. In the Draw panel of the Sketch tab, click the Text button (or press T on the keyboard).

 6. Click anywhere on the page to set the text location.

 7. In the Format Text dialog box, type in a static text string that reads Mass: (be sure to 

include a space after the colon).

 8. Locate the Type drop-down, and choose Physical Properties – Model.

 9. Set the Property drop-down to MASS.

 10. Click the Add Text Parameter button to set the MASS property to the text fi eld.

 11. Click the OK button.

 12. Right-click anywhere in the graphics area, and choose the OK button.

 13. Choose Save Sketched Symbol from the context menu.

 14. Enter Mass for the name, and click Save.

 15. To insert the symbol into the drawing, right-click the Mass sketch symbol defi nition in 

the drawing browser, and select Symbols.

 16. Ensure that the Mass symbol is chosen from the list on the left side of the Symbols dialog 

box, and select the Leader option.

 17. Click the OK button.

 18. Click any model edge in the drawing view.

 19. Click again for each leader vertex you’d like, and then choose Continue from the context 

menu.

 20. Continue to place additional symbol instances, but be sure to point to a different Arbor 

Press component each time.

You’ll notice that the symbol in Figure 12.4 has a bit more geometry than the simple symbol 

you just created. You can make a sketch symbol as elaborate as you like, but for the purposes 

of this exercise, the Mass property reference is all that is required. A fi nished symbol named 

Mass_2 has been created for you in this drawing fi le. If the Mass shows up as N/A, it indicates 

that the model needs to be updated. You can open the assembly model, select the Manage tab, 

and click the Update Mass button to do this. Then return to the drawing to see the update.

Figure 12.4

Applying sketched 

symbols to a draw-

ing view
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Formatting Your Text to Center Your Symbols

Generally, text objects are created with a justifi cation setting other than middle center. However, 

a middle-center justifi cation will allow you to center your text in the symbol geometry by using 

sketch constraints.

Here are some more sketch symbol points to remember:

 ◆ Sketched symbols are often used to create standard blocks of text notes.

 ◆ Sketched symbols can be placed as needed on new documents or placed on the template 

itself, which can be useful for standard drawing notes that will be placed in every 

drawing.

 ◆ If there is fi eld text in the sketch symbol, it becomes populated just like title block fi eld text 

when you create a new drawing.

 ◆ If you need to establish a symbol reference to a model but do not want to see the leader, you 

can edit the symbol and then double-click or select Edit Symbol from the symbol’s context 

menu, and uncheck the leader Visibility option.

 ◆ You cannot graphically rotate or scale static sketched symbols as you can symbols that are 

not static.

 ◆ Sketched symbols placed by double-clicking the defi nition are set to Static by default; you 

can set this option prior to placement if you click the User button on the Symbols panel of 

the Annotate tab.

 ◆ Sketched symbols placed by right-clicking on the defi nition and choosing Symbols, or by 

clicking the User button on the Symbols panel of the Annotate tab are set to have more 

controls than static symbols initially.

 ◆ You can switch a static symbol to be not static by right-clicking it and choosing Edit 

Symbol.

 ◆ When you mouse over a sketch symbol that is not static, a single blue hot point is shown on 

the center top of the symbol and four yellow hot points are displayed at the four corners of 

the symbol.

 ◆ Clicking and dragging the blue hot point causes the symbol to rotate, whereas clicking and 

dragging any of the yellow hot points enables dynamic scaling.

 ◆ You can change the insert point of a sketched symbol by adding a point to the sketch 

and then using the Set Insertion Point Grip button to mark it as the insertion point. This 

button can be found next to the Driven Dimension button on the Format panel of the 

Sketch tab.
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 ◆ Sketched symbols can be patterned by right-clicking an instance of a symbol and choosing 

Pattern Symbol.

 ◆ Sketched symbols are a good place to use prompted entry text.

AutoCAD Blocks
Blocks created in AutoCAD can be used in Inventor in the same way sketched symbols are 

used. However, differences exist between the way they are created and used. AutoCAD blocks 

are available for use only when you are using an Inventor DWG fi le and cannot be used in an 

Inventor IDW fi le. Also, you cannot create or edit AutoCAD blocks in Inventor. There are two 

ways to bring blocks into an Inventor DWG fi le:

 ◆ Copy and paste from AutoCAD.

 ◆ Right-click the AutoCAD Blocks folder found in the Drawing Resources folder, and choose 

Import AutoCAD.

Here are some other points to remember about blocks:

 ◆ Once blocks are imported, you can scale, rotate, and pattern them by right-clicking the 

block instance.

 ◆ Blocks containing attributes can be modifi ed by right-clicking the block instance and 

choosing Edit Attributes.

 ◆ Color and layer properties can be modifi ed by right-clicking the block instance and choos-

ing Properties.

 ◆ You can create a block from your drawing views by right-clicking the browser node for the 

view and selecting Insert In Model Space from the context menu.

Sheet Formats
Sheet formats are preset collections of a drawing sheets, borders, title blocks, sketched symbols, 

and/or base and projected views. They essentially give you the ability to quickly generate mul-

tiview drawings just by referencing a single model fi le. To create a multiview drawing, follow 

these steps:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_037.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder.

 3. Expand the Drawing Resources browser folder.

 4. Expand the Sheet Formats folder.

 5. Right-click the A Size, 4 Views, 1/2 Scale format, and choose New Sheet.
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 6. Browse for mi_12a_038.ipt in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 7. Click the OK button in the Select Component dialog box.

You will note that a new sheet has been created to the specifi cations of the sheet format and 

set active. This technique is ideal if you fi nd yourself detailing similar designs of common size 

and complexity. You can close the fi le without saving changes.

To save your own sheet format, set up your sheet the way you like it, right-click the active sheet 

node in the browser, select Create Sheet Format, and then name the sheet format as you’d like.

Here are some more sheet format points to remember:

 ◆ Only base and projected views are saved in a sheet format. Section, detail, and other such 

views will not be included.

 ◆ Placed drawing resources such as standard notes (in the form of sketched symbols) can be 

included in a sheet format.

 ◆ You can preload your drawing template as a sheet format as well. Simply open a template, 

create base and projected views of any model, and then save and close them. When you 

next use your template for a new drawing, you’ll be immediately prompted to reference a 

model fi le, and the drawing views will be automatically created.

Transfer Drawing Resources
You can copy drawing resource defi nitions from drawing to drawing by following these steps:

 1. Right-click the defi nition of the title block, sketched symbol, or other drawing resource 

you want to copy, and select Copy from the context menu.

 2. Right-click the appropriate drawing resource node (or the Drawing Resources folder 

itself in the target document).

 3. Select Paste.

You can use this technique to add new drawing resources and update existing resources. 

You can also select the entire Drawing Resources folder in one drawing and paste it into the 

Drawing Resources folder of another drawing. You will be prompted to replace or make a new 

instance of any duplicate resources.

The copy-and-paste technique is effi cient for single changes or transfers between two draw-

ings, but to push one or more new or updated design resource defi nitions to multiple drawings, 

use the Drawing Resource Transfer Wizard discussed in Chapter 13.

Area Code Changes

In 2002, the phone number area code for Rochester, New York, and the surrounding areas changed 

from 716 to 585. Th is meant that every manufacturing, engineering, and architectural group in 

the area suddenly had hundreds and thousands of working drawings with the wrong phone num-

ber in the title block. Many companies that wanted or needed to update their title blocks had to
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manually copy and paste title blocks on each drawing in their archives (the savvier groups wrote 

custom application scripts to perform this task). Unfortunately, the Drawing Resource Transfer 

Wizard was not released until some years later. It would have likely saved thousands of hours 

of work.

Editing Styles and Standards
As it does with color, material, lighting, and sheet-metal styles in the modeling environment, 

the Drawing Manager makes heavy use of XML-based styles. The basic framework of draw-

ing styles is no different from those in the modeling environment. Drawing style settings are 

viewed and edited using the Style And Standard Editor dialog box. They can be shared among 

a workgroup via the library that contains the modeling styles, and they can be imported and 

exported as stand-alone XML fi les.

Drawing styles differ from modeling styles more in concept than in practice, however, and 

the drawing styles themselves are a collection of drafting rules that include the following and 

many more:

 ◆ Dimension styles

 ◆ Text styles

 ◆ Balloon styles

To explore the use of styles, study the scenario described in the section “Styles in Use, a Case 

Study” and refer to it in the example to come.

Object Defaults
The true key to understanding how styles are used to determine the formatting of everything 

you can create on a drawing sheet is the notion of object defaults.

In the case-study example, it is clear that the majority of a designer’s day-to-day drawing 

work is focused on creating prints for manufacturing. Therefore, the styles used for that type of 

drawing would be the styles set up as the object defaults. Object defaults are automatically set 

as the current styles in the template drawings. For Mastering Inventor, Inc., the object defaults 

would likely be confi gured as shown in Table 12.2.

Table 12.2: Object-default styles

Style type Object default

Dimension style Dim_Shop

Text style Text_125

Balloon style Balloon_Item_Count

Certification
Objective



554 | CHAPTER 12 DOCUMENTATION

Styles in Use, a Case Study

A standard is a collection of styles. A company called Mastering Inventor, Inc. has created a basic 

company standard using dimension styles, text styles, and balloon styles. Th e various styles’ names 

are listed here, followed by the style category:

Dim_Shop: Dimension style

Dim_Client: Dimension style

Dim_Marketing: Dimension style

Text_125: Text style

Text_250: Text style

Text_Script: Text style

Text_Partslist: Text style

Balloon_Item_Count: Balloon style

Balloon_Partnumber: Balloon style

Balloon_Partname: Balloon style

Having these styles set up allows Mastering Inventor, Inc. to create three types of standard 

drawings:

 ◆ Th e majority of the drawings are created for use by the shop fl oor to make parts. Th ese draw-

ings are required to be clear, concise, and detailed with tolerances.

 ◆ Also required are client approval drawings, showing some design specifi cs but also purposely 

limited in detail so that a competitor cannot manufacture from them.

 ◆ Occasionally, stylized drawings for use on the company web page or at trade shows are created.

To facilitate this, Mastering Inventor, Inc. has created a separate dimension style for each of these 

three drawing types. Th e company has also created several diff erent text styles, which are called 

into the dimension styles and used independently as notes and so on. Also created were balloon 

styles, each set up to call diff erent iProperties from the models. Th is works well because Inventor 

users can quickly switch to the style needed without having to stop and defi ne a style, override 

another style, or worry about not maintaining consistency and/or corrupting the company standard.

Th e question then becomes this: If this company has three sets of styles in the company standard, 

how does Inventor know which one to use by default? Th e answer is object defaults.

Now that you understand the overall concept of object defaults, follow these steps to see how 

they are managed:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_041.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder.
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 3. Zoom to the top of the drawing, and note the three balloons.

Each balloon on the sheet is using a different balloon style. Each balloon style is calling a 

different set of iProperties, as you will see by comparing the balloons to the parts list. To 

see how object defaults work, you’ll now create more balloons on the ram part, which is 

the square-shaped bar with teeth cut into it.

 4. Select the Annotate tab and then click the Balloon button (on the right side).

 5. Note the two style drop-downs all the way to the right of the Annotate tab. The top one 

controls layers, and the second controls styles.

 6. Click the Style drop-down to show the available balloon styles. You should see one style 

denoted as By Standard and three listed below that, one of which is the one called out in 

the By Standard line.

 7. Select the Balloon_Partname style from the list, and then select any edge of the ram.

 8. Drag out and place the balloon on the page by clicking.

 9. Right-click, and choose Continue (or press Enter on the keyboard).

 10. Repeat steps 6 through 9 for the other two balloon styles, until you have three balloons 

on the ram part, each using a different balloon style.

 11. Right-click, and choose Cancel when complete.

This demonstrates the use of different styles and shows that one of these styles is set as 

the company standard default style. You’ll now go into the Style And Standard Editor 

and change the object default for the balloon style.

 12. Select the Manage tab, and then click the Styles Editor button. You will be presented with 

the Style And Standard Editor. (It may take a few seconds to index the styles initially.)

 13. Ensure that the fi lter at the top right is set to Active Standard, and then use the plus sign 

to expand the Balloon, Dimension, Object Defaults, and Text style categories, as shown in 

Figure 12.5. Note the style names listed under each style category. Look at the following 

items:

 ◆ Company Standard (Mastering Inventor, Inc.)

 ◆ Balloon styles

 ◆ Dimension styles

 ◆ Object Defaults (MI, Inc.)

 ◆ Text styles

 14. Click Object Defaults (MI, Inc.).

 15. Locate the Balloon row in the Object Type column.

 16. Click the Object Style cell for the Balloon row, and set the drop-down to 

Balloon_Item_Count.
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Figure 12.5

Standards, styles, 

and object defaults

 17. Click the Layer cell for the Balloon row, and set the drop-down to Balloons.

 18. Click the Save button at the top of the editor.

 19. Click Done to exit the editor.

 20. Select the Balloon button from the right of the Annotate tab.

 21. Select any edge of the ram and place another balloon just as you did before.

 22. Note that the Balloon tool now defaults to the Balloon_Item_Count style and is placed on 

the Balloon layer.

When setting object defaults, you typically want to use the most common style. Of course, 

you can always use another style by manually selecting the style from the Style drop-down 

as you place the object. You can also select an existing object, and the Style and Layer drop-

downs will display that object’s style and layer, allowing you to change layer and style assign-

ment as needed.

Objects that have been set to a specifi c style, rather than following the By Standard option, 

will not update if you make any modifi cations to the object defaults. However, the objects will 

update if the specifi c style is updated. A quick way to get a set of objects (like your balloons, 

for example) to return to their object default is to window-select or Ctrl+click the objects on the 

screen and then select By Standard from the style drop-down. All the objects will update to use 

the newly selected standard.
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Set the Style Drop-Down to Last Used

You can set the Style drop-down to remember the last-used object style by selecting the Tools tab, 

clicking the Application Options tab, and then selecting the Drawing tab. On the right side of the 

Drawing tab, you will fi nd a Default Object Style setting. If you set the drop-down to Last Used, 

the last-used object and dimension style is the default. For example, if you are placing dimensions 

on a drawing using a fractional style but the decimal style is the default, you can set the applica-

tion option to Last Used so you do not need to keep changing the style back to fractional every 

time you access the dimension style. Th e Last Used setting is for the current editing session for the 

drawing, so if you close the fi le and reopen it, the Object Default will list again, until it’s changed.

Creating Styles
As evident in the balloon example, you can have multiple styles for the same object type. Or 

you can have a single style that you always use. It’s up to you to choose how many styles you 

have for each type, and this will be dictated largely by need. Although this section will not go 

through all the settings for all the styles, you will explore how to create and confi gure a new 

style as a foundation to creating all style types. Here are the steps:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_046.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder.

 3. Select the Manage tab, and click the Styles Editor button.

 4. Ensure that the fi lter drop-down at the top right is set to Active Standard, and then in the 

left pane expand the Text node to see the list of text styles.

 5. Expand the Balloon node to see the list of balloon styles.

 6. Click the balloon style named Balloon_Partnumber to display the style settings in the 

right pane.

 7. Click the New button at the top of the editor dialog box, and enter Balloon_Item_Qty for 

the style name.

 8. Ensure that the Add To Standard check box is selected, and click the OK button.

 9. In the Balloon Style settings, under the Sub-Styles section, use the drop-down to set the 

text style to use the style called Text_Script.

 10. Click the Shape button, and select the second shape (Circular – 2 Entries) from the list.

 11. Below that, in the Property Display area, click the Property Chooser button.

 12. Click the Part Number property in the right pane, and click the Remove button to take it 

out of the property list for this balloon style.

Certification
Objective
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 13. In the Left pane, locate the ITEM and ITEM QTY properties, and use the Add button to 

pull them into the right pane. Do this one at a time.

 14. Use the Move Down and Move Up buttons to set ITEM as the top property.

 15. Click the OK button.

 16. Click the Save button.

 17. Click the Help button in the lower-left corner of the Style And Standard Editor, and notice 

that this takes you to a listing and description of each setting in the balloon style. This is 

true of all of the style types.

 18. Close the Help dialog box, and click Done in the Style Editor.

 19. Select the Annotate tab, and click the Balloon button.

 20. From the Styles drop-down on the far right of the Annotate tab, choose your new Balloon 

style, Balloon_Item_Qty, from the list. 

 21. Click the edges of parts to place on the drawing balloons that will list the item number 

and quantity using a script font for the text.

Although the settings for each style type vary, the concepts for creating them remain consis-

tent throughout all styles. These concepts are as follows:

 ◆ Create a new style based on an existing style.

 ◆ Specify substyles (if applicable).

 ◆ Confi gure the style settings as desired.

 ◆ Save the new style.

Working with Substyles
A basic example of a substyle in the modeling environment is the color style, which is a substyle 

of the material style. Once you apply a new material to a part, not only are you changing its 

physical parameters, but you’re also potentially changing its color so that it shows the material’s 

color substyle. In the previous balloon style exercise, you used a text substyle called Text_Script 

when creating the balloon style.

The use of substyles in the Drawing Manager is extensive. Almost every kind of annotation 

you create in a drawing contains some kind of text (dimensions, weld symbols, and parts lists), 

and many make use of leaders. The text style and leader style, therefore, are frequently used 

as substyles of other styles. This basically provides one-stop shopping if you want to quickly 

change all the text on your document. If you wanted to change the font for all text, for example, 

you wouldn’t have to go to the parts-list style and change the font, then to the dimension style 

and change the font, and so on; instead, you would simply change just one or two text styles that 

are being called into those other styles.

Substyles are coupled with their parent styles, which means a substyle cannot be purged if 

it’s in use by another style. If you cache a high-level style into your document from the library 
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or if you save a high-level style into the library from your fi le, all substyles participate in those 

operations.

Styles are extremely powerful formatting tools that enable you to quickly change the entire 

face of a document. This also serves as a warning that modifying styles without understanding 

how they work can quickly generate unexpected results.

Take the Time to Understand Styles

Although there’s probably never been a single person who decided to use Inventor just for the “excit-

ing” styles and standards tools, these tools are extremely powerful, and you’ll be doing yourself 

a disservice if you don’t spend some time getting to know them. Th ey may seem complex at fi rst, 

but once you understand them, they will become very powerful tools. Play around with changing 

styles in a scratch drawing and see how the annotations change.

Another good resource for learning more about styles can be found by inserting the installation disc 

and clicking the Read Th e Documentation link on the fi rst screen of the setup program; then click 

Fundamentals For Th e Autodesk Inventor CAD Manager under the Installation Guides category. 

Th is will open the CAD Manager Fundamentals PDF fi le. If you do not have the installation discs, 

you can fi nd an older copy of this document included with the tutorial fi les in the Chapter 12 

directory of the Mastering Inventor 2014 folder.

Once you have a good understanding of styles, sit down with your design group and come up with 

a set of standards with which everyone is happy. Apply these styles to your documents and use 

them for a while. One of the great aspects of the style library is that if you want to make a change, 

you can make it to the library and everyone will have access to this new/changed style each time 

they open a fi le.

Drawing Style Administration
Each drawing template that comes with Inventor has a full set of styles saved (cached) in the 

drawing document. Although you can use the style library as a sharing and update tool, there 

is no direct link between objects on your sheet and styles in your library. Any in-use style is 

loaded into your document either automatically or manually.

If your project is set to use the style library (the Use Style Library setting is Yes or Read 

Only), then it’s important to keep your style defi nitions in sync between your template fi le 

and the library. If your project is using the style library, you have a style in the library that 

has the same name as a style in your template, and those styles have different settings, the 

defi nition in the library automatically overwrites the defi nition in the template each time it’s 

used to start a new drawing (a warning dialog box is shown when this condition is detected).

The best way to ensure synchronization is to open your template fi le and run either the 

Update Styles tool (which pulls updates from the library) or the Save Styles To Style Library tool, 

depending on which way you want to transfer the styles. You can fi nd both of these options and 

the Purge tool on the Manage tab.
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Creating Drawing Views
You will explore the various view-creation and -editing tools in the following sections as you 

cover documenting different types of 3D models: part, assembly, sheet metal, weldment, and 

iPart/iAssembly.

Drawing views reference part, assembly, or presentation fi les. The workfl ows involved in cre-

ating and editing views from these different sources are similar, but with some notable excep-

tions detailed in the following sections.

Green Brackets and Raster Views

Th e Raster View option in the drawing view dialog box creates a static raster-based view that 

approximates some view features. If this check box is selected, the computation of the view is 

quicker, but the view is less precise. Raster views can be used to speed up the drawings of large 

and complex general assemblies.

Green corner brackets around the drawing view are used to denote that a view is a raster view. 

Additionally, raster view browser nodes are marked with a red diagonal line through the browser 

node icon.

You can right-click a view in the graphics area or on a view’s browser node to toggle it between pre-

cise and raster view methods. You can also right-click in the graphics area and select Make All Views 

Precise or select Make All Views Raster to toggle all of the views from one method to the other.

Creating a Base View
Creating views in an Inventor drawing is a very intuitive process. You’ll start by creating some 

basic views of a part fi le while exploring the procedure and options along the way. Before you 

create any views, fi rst open the part to become familiar with it:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_048.ipt in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. Spin the part around and take a look at it using the ViewCube® or the Orbit tool. Do not 

close the part.

 4. On the Get Started tab, click the New button.

 5. Select the Metric node from the list on the left and then choose the ANSI(mm).idw tem-

plate from the Drawings section on the right.

 6. On the Place Views tab, click the Base button to create a base view.

 7. With the Drawing View dialog box open, move your mouse pointer around on the draw-

ing and you will see a dynamic preview of the part fi le. Do not click the screen just yet or 

you will inadvertently place the drawing view.
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 8. Note that all open model fi les are listed in the File drop-down. You can select any open 

model fi le from the list or click the Browse button to select another fi le.

 9. In the Scale input box enter 2, or use the drop-down to select 2:1. You can specify scales in 

fractional or decimal formats (1/2 or 0.5 both work for half scale).

 10. Click the lightbulb button to turn on the View/Scale label.

 11. In the View Identifi er input, type Front.

 12. In the Orientation pane on the right, click through the available options and watch the 

preview at your mouse pointer change. Select Top when you’ve fi nished. You’ll note that 

although the orientation is called top, you have entered Front in the view identifi er box. 

The orientation name can be considered a suggestion, and the word top will not show up 

anywhere but here.

Custom View Orientations

If the view you need to show does not exist in the Orientation pane, you can use the Change View 

Orientation button to step into the model and create any view orientation possible.

 13. In the Style area, click just the middle button to create an unshaded view with no hidden 

lines. Note that the shaded button (blue) can be toggled on and off independently of the 

other two, but the hidden lines and no hidden lines buttons are mutually exclusive to one 

another.

 14. Uncheck the Create Projected Views Immediately After Base View Creation check box, 

found in the lower-left corner.

 15. Click anywhere on the page to create the view (or click the OK button).

Here are some tips for working with base views:

 ◆ Right-click any view and choose Open to open the model in a new window.

 ◆ Most of the options you see in the Drawing View dialog box can be altered later by editing 

the view, but it’s important to set the orientation correctly originally because it cannot be 

changed once placed.

 ◆ To delete a view, simply hover your mouse pointer over it and then select the dotted view 

boundary, right-click, and choose Delete.

 ◆ Right-click or double-click a view to edit it.

 ◆ Tangent edges and thread features that are not showing up in the view can be turned on by 

editing the view, selecting the Display Options tab, and selecting the respective boxes.

 ◆ Views can be moved by selecting the dotted view boundary that appears when hovering 

over them and dragging it into place.
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 ◆ Clicking a line or lines in a view gives you control options for just those lines.

 ◆ Right-click lines, arcs, or circles and uncheck Visibility to hide those entities.

 ◆ Right-click the view and choose Show Hidden Lines to bring back lines that were hidden.

 ◆ Each base view created is listed in the browser; note the Base View button.

 ◆ Expanding the view node in the browser shows the model tree for that view, where you can 

select all the edges of features at once. You can then right-click the selected objects on the 

page and toggle off the visibility, change the layer, and so on.

 ◆ To rotate a view, right-click it and choose Rotate; then select an edge to make horizontal or 

vertical, or use the drop-down to specify by angle.

 ◆ You can have as many base views as you need on a drawing, but the iProperties will be 

pulled from the fi rst view placed.

 ◆ Views can be renamed in the browser or by editing.

 ◆ To display the view name without the scale for a single view, right-click View Label, and 

choose Edit View Label; then remove <Scale> from the text box.

 ◆ You can suppress a view by right-clicking it and choosing Suppress.

Once you’ve explored the settings and edit options for the base view, you can close the fi le 

without saving changes and continue.

Set View Preferences in the Standard

You can set up view preferences for your company standard by accessing the Styles Editor, selecting 

Standard, and then selecting the View Preferences tab. Th is allows you to choose which properties 

to display or not display in the view label, set the First or Th ird Angle projection, and much more.

Creating Projected Views
Once a base view is created, you can quickly create other views based on it without having to 

specify the model again:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_049.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. Select the Projected button on the Place Views tab.

 4. Click the base view.

 5. As you drag your mouse pointer around the base view, notice the view previews that are 

being generated.
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 6. Drag straight to the right and click. You will see a rectangular bounding box indicating 

that a view will be placed there.

 7. Drag straight up from the base view and click, again, noting the preview.

 8. Finally, drag diagonally up and to the right from the base view and click.

 9. Right-click and choose Create to generate the projected views.

 10. Expand the plus sign next to the Front view in the browser to see that the projected views 

are listed, as shown in Figure 12.6.

Figure 12.6

Drawing views in 

the browser

Here are some tips for working with projected views:

 ◆ Orthographic projected views are linked to the parent view in style and alignment, and 

stacked below it in the browser tree.

 ◆ To break the style link between a projected view and its parent view, double-click to 

edit the projected view and deselect the Style From Base button in the lower right of the 

Drawing View dialog box. Then change the shading and hidden-line options as you like.

 ◆ Isometric views are not linked to the parent view in style and alignment and are listed 

separately in the browser tree.

 ◆ To break the alignment between a projected view and its parent view, right-click the pro-

jected view and choose Alignment ➢ Break. A view arrow will be placed next to the parent 

view, and the projected view will be labeled to match.

 ◆ To break the alignment without getting a view arrow, right-click the projected view, and 

choose Rotate. You can set an already horizontal edge to be horizontal and still break the 

alignment.

 ◆ To reset the alignment, right-click the projected view, and choose Alignment and then 

Horizontal or Vertical as appropriate. The projected view will move back into place. 

Choose In Position to link the projected view to the parent in its current position.

 ◆ By default, deleting a parent view or a base view will remove all projected views as well.

 ◆ To delete a parent view without removing the projected views, click the >> button in the 

Delete View dialog box, click Yes next to the views you want to keep, and set them to No.
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 ◆ Projected views can be created from views other than base views, such as detail views, sec-

tion views, and even other projected views.

 ◆ You can select the parent view fi rst and then issue the projected view tool, or you can issue 

the tool and then select the view. Either order is acceptable. If you have a view preselected 

accidentally and click the projected view button, that will be the view you are projecting.

 ◆ If you select the Create Projected Views Immediately After Base View Creation check box, 

found in the lower-left corner of the Base View creation dialog box, you can create base 

views and projected views at the same time.

 ◆ You can suppress a view by right-clicking it and choosing Suppress.

You can close the current fi le without saving changes and continue.

Moving and Copying Views
You can move drawing views between sheets by dragging and dropping the browser nodes. 

When a projected view is moved to a different sheet than its parent, a view arrow is generated 

automatically on the parent view.

To move a view, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_050.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. Expand the Front view node in the browser to show projected views 2 and 3.

 4. Click the browser node of View2, and drag it down to the Sheet2 browser node.

 5. Rest your mouse pointer over the top of the Sheet2 browser node icon, and release the 

mouse button.

 6. Sheet2 becomes active to show you where View2 has been moved. Notice that there is a 

browser icon for the Front view with an arrow and the sheet name in parentheses. This 

indicates it is linked to the parent view on Sheet1. Notice too that the moved view has 

been renamed.

 7. Right-click the Front view icon in the Sheet2 browser, and choose Go To to be returned to 

Sheet1.

 8. Notice that a view arrow has been created next to the Front view.

To copy a view, follow these steps:

 1. With mi_12a_050.idw still open, make sure you are on Sheet1.

 2. Right-click View3, and choose Copy.

 3. Right-click the browser node for Sheet2, and choose Paste.

 4. Sheet2 becomes active to show you where the view has been copied to. Notice that the 

new view has been named with the next available view number.
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Copying and moving views is often useful when you’ve detailed a complex view on one 

sheet and then run out of space and need to expand the drawing to another sheet. Note that 

when you copy or move a view with dimensions or other annotations applied, the annota-

tions are moved or copied as well. You can close the current fi le without saving changes and 

continue.

Creating Section Views
Section views are created by “sketching” a line across an existing view to defi ne the section cut. 

The sketch is created automatically for you as you defi ne the section line.

To create a section view, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_051.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. On the Place Views tab, click the Section button.

 4. Click the Front view to choose it as the view to be sectioned.

 5. Hold down the Ctrl key, and click to the left of the view. This ensures that you do not 

accidentally constrain the start point of your section line to any midpoints, center points, 

or endpoints.

 6. Let up on the Ctrl key, drag the line across the part, and click to the right of the part, 

ensuring that you see either a perpendicular or horizontal constraint to indicate you are 

getting a straight line.

 7. Right-click, and choose Continue.

 8. In the Section View dialog box, note that you can change the section identifi er, scale, style, 

and section depth. You can also create a zero-depth section called a slice. Leave all these 

options at the defaults.

 9. Drag your cursor above the original view, and notice how the placement is constrained 

perpendicularly to the section line.

 10. Hold down the Ctrl key, and click the screen to create and place the section view any-

where you like.

 11. Click the section arrow, and drag it up or down to see the section update automatically.

 12. To align the section view with the base view, right-click the section view and choose 

Alignment and then Vertical.

 13. Click the base view to specify it as the view to align the section to.

 14. Click the section view boundary to see how the alignment works.

Look at the browser to see how the section view was added as a child view of the base. 

Also, notice the sketch that was created on the base view listed just above the section view 

node (Figure 12.7). This sketch is the section line itself and can be edited like any other sketch. 
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You can add or remove constraints (including sketch dimensions) as needed to precisely posi-

tion the section line around your base view. You do this by right-clicking the sketch in the 

browser and choosing Edit Sketch, just as you would any other sketch.

Figure 12.7

A part section view

Here are some tips for working with section views:

 ◆ Section line appearance is controlled by a layer and a style just like most other annotation 

objects. To determine which layer and style are used, switch to the Annotate tab and then 

click the section line. Note the Layer and View Annotation style in the Layer and Style 

drop-downs on the far right of the Annotate tab.

 ◆ Project a section view to create an isometric section.

 ◆ Orthographic section views are hatched automatically, but isometric sections are not.

 ◆ Edit or hide a hatch by right-clicking it.

 ◆ Display a hidden hatch or turn a hatch on for isometric section views by editing the 

view (right-click and select Edit View), selecting the Display Options tab, and selecting 

Hatching.

 ◆ You can hatch by material if you have mapped the materials and hatch patterns in your 

standard.

 ◆ Flip the section arrow direction by right-clicking the section line and choosing Reverse 

Direction.

 ◆ Show just the arrows of the section line by right-clicking the section line and choosing 

Show Entire Line.

 ◆ Edit the section depth by right-clicking the section line and choosing Edit Section 

Properties.

 ◆ To constrain a section line to the center of a hole, run your mouse over the hole to project 

the center point when you are creating the sketch line.

You can close the current fi le without saving changes and continue.

You defi ned the section line on the fl y during the previous exercise. Now you will bring in 

a sketch created in the part model, and use it to create a section view. Figure 12.8 shows the 

sketched line in the model.
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Figure 12.8

Section line sketch 

on model

Mapping Materials to Hatch Patterns

You can set up your template to use a predefi ned hatch pattern per the material of the sectioned 

part so that copper parts are hatched with one hatch pattern, mild steel parts are hatched with 

another, and so on:

 1. Select the Styles And Standards panel of the Manage tab, and click Styles Editor to open the Style 

And Standard Editor.

 2. In the left pane, expand Standard, and then click your standard.

 3. In the right pane, click the Material Hatch Pattern Defaults tab.

 4. Set the Default Hatch Style option for new materials added in the mapping.

 5. Click the From File button to select a part fi le that contains all the material styles you want to 

import (set this up ahead of time), or use the From Style Library button.

 6. For each imported material, click the Hatch Pattern fi eld, and select a new hatch pattern from the 

list. Use Ctrl or Shift to change several materials at the same time.

 7. Click Save to save the changes to the current document, and then click Done to close the 

dialog box.

To create a section from a model sketch, proceed with these steps. If you still have 

mi_12a_051.idw open, you can skip to step 3.

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_052.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. Locate the sheet node in the browser, and then click the plus symbol to expand it.

 4. Expand the view node called Front to reveal the model.

 5. Finally, expand the model node to reveal the part features.

 6. On the part node (mi_12a_048.ipt), right-click and choose Get Model Sketches.

 7. You will now see that a model sketch called Section Sketch:Model is present; right-click it, 

and choose Include.
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 8. This will reveal a zigzag line on the part view.

 9. On the Place Views tab, click the Section button.

 10. Click any part of the included sketch, or click the sketch in the browser to use it as the 

section line.

 11. In the Section View dialog box, click the Include Slice check box and then select the Slice 

The Whole Part check box to create a zero-depth section. Leave the other options at the 

defaults.

 12. Drag your cursor to the right of the original view and click on-screen to create the 

section.

 13. To change the section properties, right-click the section line and choose Edit Section 

Properties.

 14. Deselect the Slice The Whole Part check box and the Include Slice check box to change the 

section to a full-depth section; then click the OK button.

 15. Right-click the hatch, and choose Edit; then click the Double check box.

 16. Click the OK button to close the Edit Hatch Pattern dialog box.

Your section should look similar to Figure 12.9.

Figure 12.9

Section using model 

sketch

You can close the current fi le without saving changes and continue.

Import Hatch Patterns

You can load hatch patterns from an external PAT fi le to add custom hatch patterns to your draw-

ings. To do this, edit a hatch and select Other from the Pattern list, and then click Load. You can 

also do this in the Style And Standard Editor to add custom hatches to your company standard.

Slice Views
Slice views are simply zero-depth section views. They are often used to create cut profi les of 

complex surfaced parts such as automobile bodies, aircraft wings, boat hulls, and so on. A slice 
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view is generated by creating a sketch associated with a source view and then using that sketch 

as the slice profi le to create a slice section through a different target view. The slice is then exe-

cuted on the selected target view. Slice views can be created on part views or assembly views.

To create a Slice operation defi ned by two existing views and sketch geometry, follow these 

general steps:

 1. Select an existing view to use as the source view (the view you will sketch the slice onto).

 2. From the Place Views tab click the Create Sketch button.

 3. Create sketch geometry to defi ne an open profi le to use for the slice.

 4. Click the Finish Sketch button to exit the sketch.

 5. From the Place Views tab click the Slice button.

 6. Select a view other than the view you sketched on for the target view, you’ll see the Slice 

dialog box displayed.

 7. Select the previously defi ned sketch profi le to use as the Slice Line Geometry selection.

 8. You can choose to select the Slice All Parts check box, in order to override the browser 

component section settings and slice all parts in the view (assuming the slice sketch runs 

through them).

 9. Click the OK button to create the Slice operation.

When working with assemblies and the slice tool, you can control which components are 

sliced by expanding the node for the target view in the browser and then right-clicking each 

component in the view model tree and choosing an option from the Section Participation fl y-

out menu.

Using Slice Participation with Assembly Views

You can use the Slice tool to fi ne-tune your assembly views. However, there is a trick to getting it 

to work correctly. 

 1. First, start the Slice tool.

 2. Next, select your cutting line, but do not select the Slice All Parts check box.

 3. You will be prompted with a warning: “Th e slice operation did not result in any sliced compo-

nents…,” Click the OK button in the warning dialog box. 

 4. In the browser, fi nd the node for the assembly model of the sliced target view and right-click it, and 

then choose Section Participation and select Slice. Th is will slice all of the parts in the assembly.

 5. Th en you can select individual components and change the Section Participation back to none as 

you see fi t.

Th e trick here is that if you had selected the Slice All Parts option when creating the slice, you 

would not be allowed to control the individual section participation in the target view components.
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Using Breakout Views
You can also use a breakout to show a cutaway. Unlike the Section View tool that creates a new 

view, a breakout is a cut operation you perform on an existing view. Breakouts start with a 

closed-loop profi le drawn on a view sketch, so you’ll begin there as well. It is important to note 

that in order to use a sketch for a breakout, it must be associated with the drawing view. To cre-

ate an associated sketch, fi rst select the view, and then click the Create Sketch button. Clicking 

the Create Sketch button without selecting the view fi rst will result in a sketch that is not associ-

ated with any view.

To create a breakout view, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_067.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. Select the view named Front View. You can determine that the view is selected by looking 

at the browser; it should be highlighted.

 4. On the Place Views tab, click the Create Sketch button.

 5. Sketch a shape similar to Figure 12.10. The results don’t need to be exact, but you do need 

to ensure that the sketch is a closed loop.

Figure 12.10

Creating a breakout 

sketch

 6. Click the Finish Sketch button on the Sketch tab when your sketch is complete.

 7. To ensure that the sketch has been created correctly, you can select the view on the sheet 

and drag it around a bit. If the sketch travels with the view, then it is associated with the 

view. If it stays put, it is not. You can also look at the browser and ensure that the Sketch 

node is stacked under Front View. If you see it above Front View, it is not associated and 

will not work for the breakout.

 8. On the Place Views tab, click the Break Out button.

 9. Select Front View.

 10. Your sketch should automatically be selected as the profi le, provided you have only one 

unconsumed sketch. Otherwise, you will select the sketch for the profi le. If you cannot 

select the sketch, review step 3.

 11. Make sure the Depth area is set to From Point, and then click the center of the upper-

rightmost hole.

 12. Enter a depth value of 25 mm, and click the OK button.
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Your result should look similar to Figure 12.11. Note the Break Out view node in the browser. 

You may be able to see some portions of the internal parts because they have been cut away as 

well. You’ll explore how to control this in the coming pages; for now, you can close the fi le with-

out saving changes.

Figure 12.11

Th e Break Out view 

node and the result-

ing sketch

Next, you’ll open a fi le and modify a breakout view to explore the other depth options:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_072.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. In the browser, right-click the Break Out node, and choose Edit Break Out. You may have 

to expand the sheet node and the Front View node to locate it.

 4. In the Depth area, set the drop-down to To Sketch.

 5. Select the zigzag sketch line in the top view. Recall that we created this sketch associated 

with the top view by selecting the view fi rst and then creating the view. This is required 

to use it as a To Sketch.

 6. Click the OK button.

Examine the isometric view, and you will see that the breakout used the zigzag line as 

the depth extents and cut the internal and external parts. You can adjust this by going 

to the model tree and removing the fi le from section participation as explained in the 

following steps.

 7. Select the model node for Front View. Hover your mouse pointer over model nodes in 

the browser, and watch the views on the sheet to make sure you are selecting the one for 

Front View.

 8. Expand the model node to reveal all the part fi les, and select the parts ending in 04 

through 07, as shown in Figure 12.12.

 9. Right-click the selected parts, choose Section Participation, and then select None.

 10. The views will update on the sheet to show these parts un-sectioned.

 11. In the browser, right-click the Break Out node, and choose Edit Break Out. Click the 

Section All Parts check box. This will override the Section Participation settings.

 12. Change the Depth option to To Hole, and click the hole/circular edge in the view named 

Top View.

 13. Click the OK button.
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Figure 12.12

Removing parts 

from the breakout

 14. Notice that the zigzag sketch line reappears because it is no longer used by the breakout. 

Also notice that the breakout depth has adjusted to stop at the center of the hole.

 15. Edit the breakout once again, and set the Depth drop-down to Through Part.

 16. In the browser, select the parts ending in 02, 03, 08, and 09 (use the Ctrl key to select mul-

tiple parts at the same time) to ensure that they are sectioned through.

 17. Click the OK button; your results should be similar to Figure 12.13.

Figure 12.13

A breakout using 

the Th rough Part 

option

You can turn on the hatching of the sectioned parts in this view by editing the view 

(double-click the view or right-click and choose Edit View, and then select the Display Options 

tab and click the Hatching check box.
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Section Participation

Section participation can be controlled per the part fi le or per the part instance. If the part is a 

standard part such as a fastener, you might want to set section participation per fi le so the part is 

never sectioned. If you just want to exclude a part from a particular section or breakout view for 

clarity, you can do so per instance.

To control section participation per fi le, open the part fi le you want to change the section participation 

for, select the Tools tab, select Document Settings, and then choose the Modeling tab. Uncheck the 

Participate In Assembly And Drawing Sections check box. Th e part will now default to None in Section 

Participation for new section and breakout views, but it can be set to participate on a per-instance basis.

To control section participation per instance, place the section or breakout view of the assembly, 

expand the view node in the browser, and then locate the browser node for the parts for which you want 

to adjust section participation. Right-click, choose Section Participation, and set it to None as needed.

If the part was set to be sectioned in the document settings before a view was created and you 

change the document settings so it is not to be sectioned, the drawing view will stay sectioned and 

will need to be changed per instance.

It should be pointed out that the preceding steps have created a situation that may yield 

inconsistent results by excluding some of the parts from the section participation settings and 

then setting the depth of the breakout to Through Part. Typically, you would use the section par-

ticipation settings only with the fi rst three depth options and not with the Through Part option.

You will have noticed that as you modifi ed the breakout, the isometric view was linked to 

those changes. This is because isometric projected views created for views that already have a 

breakout inherit the breakout by default. Orthographic projected views, such as the top view, do 

not inherit the breakout.

To switch the inheritance setting of the isometric view, right-click it and select Edit View. 

In the Display Options tab in the Drawing View dialog box, deselect the Break Out check box in 

the Cut Inheritance area, as shown in Figure 12.14. You can also turn on hatching from this tab. 

You can use the current fi le to explore these hatch settings, and then you can close the fi le with-

out saving changes.

Figure 12.14

Cut Inheritance set-

tings for isometric 

views

Using Detail Views
You can use the detail view to enlarge and segregate a particular portion of a drawing view as a 

new view. Follow these steps to explore the options of detail views:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_077.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.
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 3. On the Place Views tab, click the Detail button.

 4. Click anywhere on the Front view to use it as the basis of the new detail view.

 5. In the Detail View dialog box, you can modify the View/Scale Label And Style settings 

just as you can in other view-creation dialog boxes. You can also set a fence and cutout 

shape. The Full Boundary and Connection Line options are available only if you’re using 

the Smooth Cutout option. Figure 12.15 shows examples of the Smooth Cutout options.

 6. Leave the dialog options set at the defaults, and then click Front View, approximately in 

the center of the crescent-shaped feature, as shown in Figure 12.15.

 7. Drag the boundary out to a size close to that shown in Figure 12.15 as well.

 8. Click the screen where you would like to place the detail view, and the detail is created.

 9. Click the detail boundary on Front View, and note the six green grips. Click and drag any 

of the outer grips to resize the boundary, and use the center one to control the location.

 10. You can also double-click the two grips near the arrowhead and change the head style.

Figure 12.15

Detail view options

Jagged Cutout Square Fence Full Boundary Connection Line

Here are more options for detail views:

 ◆ Right-click the detail boundary and choose Attach to anchor the detail to a specifi c point 

on the base view.

 ◆ Right-click the detail boundary and choose Options to change the detail from rough to 

smooth, then to add a full detail, and then to add a connection line.

 ◆ Click and drag on the detail label character (the letter A in Figure 12.15) in the boundary 

fence to reposition it.

 ◆ To move the detail label character out away from the boundary, right-click the detail 

boundary, click Leader, and then click the detail label character and drag it; it will be 

attached with a leader.

 ◆ Right-click or double-click the detail view to edit the view and change scale, style, detail 

name, and so on, as you would any other view.

Use the current fi le to explore these detail options and then close the fi le without saving 

changes.
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Using Detail View Annotation

Although detail views are created at a scale larger than the base view, Inventor takes this into 

account when creating dimensions for the detail view. Th erefore, all your dimensions will be to 

the correct scale.

Creating Break Views
Often when detailing components that are much longer proportionally than they are tall, such 

as frame components, it is a good idea to use the Break tool to remove portions of the model. 

This allows the detail of the end treatments to be the focus of the drawing. Follow these steps to 

explore the Break tool:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_078.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. On the Place Views tab, locate the Break button on the Modify panel and click it.

 4. Click anywhere on the Front view.

 5. In the Break dialog box, set the gap to 10 mm.

 6. Click the view just to the left of where it extends past the drawing border on the left side.

 7. Drag the break symbol over and click just to the right of where the view extends past the 

drawing border on the right side, and then click on-screen.

 8. Notice that the break is carried through to both views.

 9. Zoom in on the break symbol and then click it.

 10. Click and drag the green grip point to the left to reposition it.

 11. Select the right half of the break symbol and drag it to the right, and then let up. This will 

remove more material from the view.

 12. Select the right half of the break symbol and drag it to the left, and then let up. This will 

add more material to the view.

 13. Adjust the view until it fi ts on the drawing sheet.

 14. Click the view named Top View and choose Edit View.

 15. Click the Display Options tab and uncheck the Break check box in the Cut Inheritance 

area. Then click the OK button. You’ll notice that the view no longer inherits the break 

from the parent view (in this case, Front View).

 16. Click the break symbol on Front View and choose Delete.

 17. Right-click Sheet 2 in the browser and choose Activate.
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 18. Click the Break button and place the break on the view named Top View.

 19. Notice the Propagate To Parent View check box. Uncheck this option to break only the 

view named Top View and leave the parent view from which it was created without a 

break.

 20. Click the start point and endpoint on the view to create the break, and you’ll see that the 

parent view is left as is.

You can continue to experiment with the Break tool and then close this fi le without saving 

changes. Here are some more points to know about break views:

 ◆ To edit an existing break, right-click the break symbol and choose Edit Break.

 ◆ The distance value entered in the Break dialog box refers to the space on the paper between 

the break symbols.

 ◆ You can break views vertically and horizontally using the options in the dialog box, 

but there is not a way to break a view at an angle when a component is not vertical or 

horizontal.

 ◆ There is no “pipe break” symbol for round components.

 ◆ By default, a dimension placed on the view will be broken as well, providing the break 

intersects it.

 ◆ You can slide the dimension break view under the dimension text to hide it on a per-

instance basis.

 ◆ You can edit the dimension style and turn off the dimension break symbol option if you 

like. The setting is found on the Display tab of the dimension style settings.

Break Symbols for Structural Detailing

If you detail plate girders and built-up members with vertical stiff eners, gussets, clip plates, and 

so on, you might fi nd that the break symbol on the drawing view causes confusion. To break a view 

without showing the break symbol, you can confi gure it so that it does not show, as described here:

 1. Use the slider bar in the Break dialog box to set the break symbol to the smallest scale (slide it to 

the far left).

 2. Set the break gap to 0.0001 or some number nearing zero (Inventor will not allow a zero value).

 3. Select the break symbol (it will now display as a vertical line) and then switch to the Annotate tab. 

Use the Layer drop-down box to place the break symbol on a non-plotting layer (you will likely 

need to create such a layer in your drawings).

You can try this with the fi le named mi_12a_078.idw; there is a layer called No Plot already cre-

ated in this drawing.
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Cropping Views
You can use the Crop tool found on the Modify panel of the Place Views panel to crop unneeded 

areas of a drawing view, in much the same way a photograph is cropped. You can specify the 

crop boundary as part of the crop operation, or create a sketch on the view fi rst and then use 

it as the crop boundary. When you create a sketch to be used as a crop boundary, you must 

fi rst select the view and then create the sketch, thereby associating the sketch to the view. 

Unassociated sketches cannot be used as a crop boundary.

The following view types cannot be cropped:

 ◆ Views containing a view break

 ◆ Views with overlays

 ◆ Views that have been suppressed

 ◆ Views that have already been cropped

For a quick reference on how to crop views, on the Get Started tab, click the Show Me 

Animations button. On the Show Me Animations screen, select the Drawing – Drawing Views 

link, and then click the Crop View Animation link on the resulting screen.

Using Draft Views
Draft views are essentially just 2D sketches created in a drawing and packaged in a view “con-

tainer,” allowing them to be scaled and handled like other drawing views. For instance, if you 

have standard details drawn in AutoCAD, you might copy them into a draft view and then 

place and scale them as needed.

To create standard details from Inventor views, you can use Save Copy As to create an 

AutoCAD DWG fi le, and then paste the detail back into Inventor as a draft view. However, draft 

views have limited capabilities for sharing between drawings, so you might consider sketched 

symbols for standard details you plan to use over and over.

To create a draft view, follow these general steps:

 1. From the Place Views tab, click the Draft button found on the Create panel.

 2. In the Draft View dialog box, set the label and scale, and then click the Label Visibility 

button (it looks like a lightbulb) to display the view name and scale on the drawing.

 3. Click the OK button to close the Draft View dialog box.

 4. An empty view and sketch are created. Use the sketch tools to add geometry, text, and 

dimensions as needed, or paste in copied geometry from AutoCAD.

 5. Click the Finish Sketch button to create the sketch and draft view.

Creating Overlay Views
You can create overlay views to show positional representations overlaid on top of one another, 

thereby communicating the change in position between the positional representations. This 

allows you to effectively show an assembly motion of multiple positions using a single view. 
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To create an overlay view, the assembly must fi rst have positional representations set up to be 

used. Follow these steps to explore overlay views:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_080.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. On the Place Views tab, click the Overlay button, and select the existing view on the 

sheet.

 4. In the Overlay View dialog box, choose Closed from the Positional Representation drop-

down, and then click the OK button.

The result is a view of the alternative position shown in a phantom linetype overlaid on the 

original. You can dimension to the overlay lines as you would any others to capture a mecha-

nism’s extension length, rotation angle, and so on. The key to overlay views is in setting up the 

positional representations in the assembly beforehand.

When you create the overlay, you are given the opportunity to specify a view representa-

tion for the overlay view. It’s recommended that before you create an overlay view, you create a 

view representation that visibly isolates only the components that move as a result of the posi-

tional representation. Otherwise (as is the case in this example), all the nonmoving components 

are redrawn over the same components in the base view.

To change positional representations used in an overlay view, delete the existing overlay 

view and specify a different positional representation when placing a new overlay view. Also, 

be aware that because weldments are not allowed to use positional representations, overlays 

are not allowed for weldment drawing and will be removed if they exist when an assembly is 

converted to a weldment.

You can close the fi le without saving changes.

View Representations and Positional Representations

It’s often helpful to create a view representation in your assembly and turn off  the visibility all of 

the parts that are not moving. Th en you can use this view representation in your overlay view for 

added clarity.

Annotating Part Drawings
Once you’ve created the appropriate views to document the model, you can add annotations. 

You can fi nd the annotation tools on the Annotate tab. The Annotate tab is divided into several 

groups of tools, including Dimension, Feature Notes, Text, Symbols, Sketch, Table, and Format 

tools. The following sections explore the annotation tools.

Using Centerline and Center Marks
There are four standard centerline and center mark tools as well as an automated centerline 

tool. These tools are called Centerline, Centerline Bisector, Center Mark, and Centered Pattern, 
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and you can access them from the Symbols panel of the Annotate tab (look for the four buttons 

next to the Create Sketch button). Recall that hovering your mouse pointer over a tool button 

provides a tool tip with the button name and that hovering a moment longer displays a dynamic 

tool tip showing an illustrated example of the tool. The automated centerline tool is accessed dif-

ferently than the other centerline and center mark tools, as explained in the coming pages.

Centerline

Use Centerline to draw a centerline-style line, arc, or circle by specifying points. When center-

line arcs are created using circles or arcs as the selection points, a center mark is drawn on the 

arc along with the centerline:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_082.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. From the Annotate tab, select the Centerline tool.

 4. On VIEW 1, click the hole at the 12 o’clock position and then the hole at 2 o’clock. Notice 

that the tool is drawing a straight line at this point.

 5. Click the hole at 4 o’clock, and notice that the centerline becomes an arc.

 6. Continue around, clicking each hole, and then close the centerline by clicking 12 o’clock 

once again; then right-click and choose Create. Your centerline should resemble the one 

on the left of Figure 12.16.

 7. You should still be in the Centerline tool at this point. On VIEW 4, click the center of hole 

A1, then B1, then B2, and fi nally A4.

 8. Right-click and choose Create; then right-click and choose Cancel. Your centerline should 

resemble the one on the right of Figure 12.16.

Figure 12.16

Centerlines

As you can see, the Centerline tool will triangulate the fi rst three points and attempt to 

establish a centered pattern. In this way, you can use it to draw centerline arcs, circles, and lines. 

However, if you just need to draw a series of lines, this functionality can get in the way.

To draw just centerlines, click the fi rst two points, and click on any blank space on the sheet, 

then click the next two points and click on a blank area again, and so on. The blank clicks 

are the same as right-clicking and choosing Create. Try this on VIEW 5 to draw centerlines 

between each of the corner holes.
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Watch Your Mouse Clicks During Centerline Creation

Th e Centerline tool is a bit specifi c in the order it wants to see mouse clicks. After you have selected 

the fi nal features on which to place the center mark, right-click and select Create. If you do not 

select Create and continue to select the next hole, you might end up with undesirable results. It 

takes a little getting used to, but you’ll fi gure it out.

Centerline Bisector

Use Centerline Bisector to create a centerline halfway between two edges or two points. Note 

that the edges do not have to be parallel or the same length. You can even select two circles, and 

you will get a centerline halfway between them:

 1. Still in mi_12a_082.idw, select the Centerline Bisector tool on the Annotate tab.

 2. Zoom in on the center shaft area of view Section A-A.

 3. Click the top and bottom lines on the shaft to create a centerline running down the mid-

dle of the section view. Notice that the distance between the two lines is bisected with a 

centerline.

 4. Place bisector centerlines in two holes in Section A-A by clicking the opposing 

lines for each.

 5. Right-click, and choose Cancel.

 6. Click the centerline you placed in the center shaft and drag out the left end so it extends 

past the shaft. Bisector centerlines are created based on the size of the lines you choose 

and may need to be adjusted. Your section view should resemble Figure 12.17.

Figure 12.17

Bisecting 

centerlines

SECTION A-A

Center Mark

Use the Center Mark tool to annotate hole centers, circular edges, cylindrical geometry, and arcs 

such as fi lleted corners. Center marks, as well as centerlines, are primarily formatted by the 

Center Mark style, but there is a distinct difference between how ANSI and non-ANSI center 

marks are drawn, so be sure your active standard is set properly for your needs. Follow these 

steps to explore the Center Mark tool:



ANNOTATING PART DRAWINGS | 581

 1. Continuing with mi_12a_082.idw, select the Center Mark tool on the Annotate tab.

 2. Zoom in to VIEW 2.

 3. Click the edge or the centers of each hole.

 4. Click the outermost circle as well.

 5. Right-click, and choose the OK button (or Cancel).

 6. Select the large center mark you just created and then click the Style drop-down box 

(found on the Format panel of the Annotate tab).

 7. Select the style called Center Mark (ISO) from the list to set the existing center mark to 

the ISO style. You’ll notice the change in style.

Here are some Center Mark tool options to be aware of:

 ◆ For large center marks that are mostly solid lines, you can right-click them, choose Edit ➢ 

Add/Remove Dashes, and then click the lines to place the dashes. Do the same to remove 

extra dashes once they are placed.

 ◆ Once extra dashes have been added, click them to slide them into place.

 ◆ To lock down extra dashes, right-click and choose Edit ➢ Uniform Spacing.

 ◆ You can align center marks with an angled edge by right-clicking them, choosing 

Edit ➢ Align To Edge, and then selecting a diagonal edge in the view.

 ◆ You can adjust center mark overshoots by clicking the ends and dragging in or out as 

required.

 ◆ To reset overshoots, right-click the center mark and choose Edit ➢ Fit Center Mark.

 ◆ To simplify center marks to just a center cross, right-click them and choose 

Edit ➢ Extension Lines.

 ◆ You can right-click a center mark and choose Edit Center Mark Style to adjust the way 

center marks are drawn by default.

Centered Pattern

Use Centered Pattern to create a centerline on parts or features that have a consistent pattern. 

If the pattern is circular, a center mark is automatically placed:

 1. Continuing with mi_12a_082.idw, select the Centered Pattern tool on the Annotate tab.

 2. Zoom in to VIEW 3.

 3. Click the center hole fi rst to establish the pattern axis.

 4. Click all the holes in the pattern, and click the starting hole again to close the pattern.

 5. Right-click and choose Create, and then right-click and choose Cancel.

There are many options for creating centerlines and center marks manually, but in the next 

section you’ll create them in a more automatic fashion. You can close the current fi le without 

saving changes and continue.
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Automated Centerlines

Rather than placing centerlines and center marks manually, you can use the Automated 

Centerlines tool. This tool is in the context menu of each view, and you can run it on multiple 

views on the same sheet at one time (multiselect views while holding your Ctrl key down before 

executing the tool). Follow these steps to explore the Automated Centerlines tool:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_084.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. Hold the Ctrl key, and select all four views.

 4. Right-click, and choose Automated Centerlines. If you do not see this option in the con-

text menu, you have most likely selected something other than a view (such as a line or 

hatch pattern).

 5. In the Automated Centerlines dialog box, use the Apply To buttons to select the type of 

objects to which you want to apply center marks and centerlines. In this case, choose all 

of the following:

 ◆ Hole features

 ◆ Cylindrical features

 ◆ Revolved features

 ◆ Circular patterned features

 6. In the Projection area, ensure that both the Axis Normal and Axis Parallel projection but-

tons are selected; otherwise, the sections’ views will be ignored.

 7. In the Radius Threshold area, enter 3 in the Maximum box for Circular Edges. This will 

ensure that no center mark is placed for the outer edge of the revolved part or for the 3.94 

radius circle in the hub.

 8. Click the OK button, and notice the centerlines and marks that have been created.

You can set the defaults for automated centerlines by selecting the Tools tab, clicking 

Document Settings, and selecting the Drawing tab in the dialog box that appears. Do this in 

your template, and you will not have to go through the process of selecting the Apply To buttons 

or specifying minimum and maximum threshold values each time.

Use the Undo button to reset the drawing, and then experiment with the options to gain 

more understanding of the different features. When you have fi nished, you can close the fi le 

without saving changes.

Creating Dimensions
A signifi cant portion of any detailing job is placing and modifying dimensions; therefore, it is 

important to become familiar with the various dimension tools and formatting options available 

in the Drawing Manager. Here is a quick reference of the dimension types available:

Certification
Objective
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 ◆ Linear dimension from one element. For instance, select a line and drag and drop the 

dimension.

1.00

 ◆ Linear dimension between two elements. Select two endpoints, and drag and drop the 

dimension.

.50

 ◆ Aligned dimension between two elements. For instance, select two endpoints of an angled 

line, right-click, and select Aligned to force an aligned solution.

.71

 ◆ Angular dimension between three points. Select three points; they can be endpoints, mid-

points, center points, and so on.

135°

 ◆ Angular dimension of an interior angle. Select two angular lines, and drag to the 

minor angle.

53°
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 ◆ Angular dimension of an exterior angle. Select two angular lines, and drag to the 

major angle.

127°

 ◆ Angular dimension from a reference line, such as a line from an object line and a centerline 

or a projected work axis.

45°

 ◆ Radius dimension. Select any circle or arc, and right-click to choose either a radius or a 

dimension. Radius is the default for arcs.

R.51

 ◆ Diameter dimension. Select any circle or arc, and right-click to choose either a radius or a 

dimension. Diameter is the default for circles.

ϕ1.02

 ◆ Baseline dimensions. Select objects, and then set the direction and base dimensions.

.50
1.00

 ◆ Ordinate dimensions. Select objects, and then set the direction and origin dimensions.

.00 .50 1.00
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 ◆ Chain dimensions. Select objects, and then set the direction and chain dimensions.

.50

.50

 ◆ Implied intersection dimension. Select the fi rst intersecting object, then right-click and 

choose Intersection, and fi nally, select the second intersecting object. Next, select an object 

to dimension the intersection point to.

1.50

 ◆ Apply General, Ordinate, and Baseline dimensions to spline endpoints.

 ◆ Apply General and Ordinate dimensions to the X and Y Min/Max points of a spline.

Most of these dimensions can be created with just one tool, the General Dimension tool.

General Dimensions

You can fi nd the General Dimension tool by clicking the Dimension button on the Annotate tab. 

This will be your primary dimensioning tool. It works very much like the Sketch Dimension 

tool discussed earlier in this book in that this single tool can generate several different types of 

dimensions depending on the geometry you select.

Once geometry is selected, you can right-click to choose the applicable options for placing 

the type of geometry you’ve selected. You can also control snap options, arrowhead options, and 

leader options specifi c to each dimension type from the context menu.

A few more types of dimensions are available in drawings than can be generated in sketches 

using the General Dimension tool. For instance, once an arc is selected (not a full circle), a radius 

Certification
Objective
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dimension is created by default, but prior to placement, you can right-click and choose Diameter, 

Angle, Arc Length, or Chord Length from the Dimension Type fl yout, as shown in Figure 12.18.

Figure 12.18

Arc dimension 

options

Prior to placing a linear dimension between two points or two parallel lines, you can create 

Linear Diameter or Linear Symmetric dimensions by choosing from the dimension’s context 

Dimension Type fl yout. These types of dimensions are used commonly with symmetrical parts, 

especially turned cylindrical parts. Figure 12.19 shows the Linear dimension options available 

when two points or two parallel lines have been selected.

Figure 12.19

Linear dimension 

options

Prior to placing diameter dimensions, you can right-click and switch to a radius or change 

the leader options, as shown in Figure 12.20.

Figure 12.20

Diameter dimen-

sion options
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Dimension Filters

You can create and access selection fi lters by holding your Shift key down and right-clicking or 

by clicking the selection drop-down from the Quick Access bar at the top of the screen. Selection 

fi lters specify the elements that can be selected when working in a drawing. For instance, if 

you choose the Detail selection fi lter, only objects common to detailing tasks are selectable, and 

items such as view boundaries, view labels, section view lines, and so on are fi ltered out and 

cannot be selected. If you choose Select All Inventor Dimensions, you can quickly select all of 

the drawing dimensions and then use the Style drop-down menu to change them all to a differ-

ent dimension style. You can create a custom fi lter also by Shift+right-clicking and choosing Edit 

Select Filters.

Recovering Model Dimensions

Another way to quickly add dimensions to your model views is to use the Retrieve Dimensions 

tool. You can access this tool from the view’s context menu or from the Annotate tab. This tool 

allows you to recover sketch and feature dimensions that were used to model your part and 

bring them into the drawing view. To recover model dimensions, follow these steps:

 1. On the Annotate tab, click the Retrieve button.

 2. Select the view you want to retrieve dimensions for.

 3. You can choose to retrieve dimensions per feature or per part, depending on what makes 

sense. You might choose per part when working with an assembly view, for instance. Set 

the radio button as you require.

 4. Select the feature(s) or part(s) in the graphics window. You can select multiple objects 

by holding down the Shift or Ctrl key as you select them. Or you can window-select the 

whole view.

 5. When selected, the part or feature will display all of the dimensions normal to the view. 

Click the Select Dimensions button to choose which dimensions to keep. Again, you can 

use a window selection to select them all.

 6. Click the Apply button, and then select another view to retrieve or click the OK button.

Be Warned About Model Dimensions

You should be aware that there are often dimensions required to model features that are not 

necessarily required or desired for use on a drawing. For example, if you were to recover model 

dimensions for View 7 in the fi le mi_12a_084.idw, you would see that the pocket is dimensioned 

from one end of the part and the holes are dimensioned from the other end. Not only is this poor 

practice, since it requires the machinist to rezero the mill, but it can also cause a tolerance stack-up.

Recovered model dimensions behave similarly to regular, placed dimensions with respect 

to editing and formatting. Recovered model dimensions cannot be detached or reattached from 

the geometry they’re referencing.
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Model dimension values can be directly edited from the drawing view, thus changing the 

model parameter value and affecting the size and shape of your model feature. Access the 

dimension value by selecting Edit Model Dimension from the dimension’s context menu.

The ability to change model dimension values is set during Inventor installation; the default 

setting is to have the ability enabled. If you would prefer that users can retrieve model dimen-

sions but not be allowed to edit them from the drawing, go through the installation confi gura-

tion settings to disable this.

Exercise Caution When Editing Model Dimensions

Th e option to enable edits of model dimension values from the drawing can be very powerful and very 

dangerous. Editing a model dimension from a drawing is a quick way to edit the size and shape of a 

model, but it is often blind to other issues it may create. For example, if a part is used in an assembly 

and another part references holes adaptively in that assembly, changing the model dimension may 

aff ect this second part without your knowledge. It is suggested that you always open the assembly 

to see what else your changes will aff ect.

Once a particular model dimension is recovered in one view, it cannot be recovered again 

in any other view in the same fi le. You can move recovered model dimensions between views, 

however, provided appropriate attachment points exist in the target view. To do this, right-click 

the dimension and choose Move Dimension.

Baseline Dimensions and Baseline Dimension Sets

Baseline dimensions are a series of linear dimensions that terminate at a common point (or base-

line). The Baseline Dimension and Baseline Dimension Set tools offer a mechanism to quickly 

add dimensions to a drawing view in an orderly way.

When you execute the Baseline Dimension tool, you’re left with a series of conventional lin-

ear dimensions. This tool simply automates what you could do on your own with the General 

Dimension tool. The Baseline Dimension Set tool, however, generates a collected group of linear 

dimensions that are edited and moved (through dragging and editing) as a single group.

To understand this more fully, open the fi le mi_12a_085.idw in the Chapter 12 directory of 

your Mastering Inventor 2014 folder, and compare the two dimensioned views. The one on 

the left was done with the Baseline Dimension tool, and the one on the right was done with the 

Baseline Dimension Set tool.

Use the views on the bottom to create baseline dimensions. Start either tool, click the left 

vertical part edge (this will be the baseline), and then manually select or multiselect additional 

features (these can be model edges or hole centers). When you’ve selected all the geometry you 

want to dimension, right-click and click to place the dimensions (shown in Figure 12.21). After 

you place the dimensions, you can continue to select points on the view (points on geometry 

rather than explicit geometry), or you can right-click and select Create.

Once a baseline set is created, you can right-click any of the dimensions and choose from the 

options to add a member, delete a member, detach a member, and arrange the entire set. You can 

also choose Make Origin to reset the base of the set. You can fi nd the Baseline Dimension Set tool 

by clicking the small arrow next to the Baseline Dimension tool, to reveal the drop-down list.

Certification
Objective



ANNOTATING PART DRAWINGS | 589

Figure 12.21

Baseline 

dimensions

Chain Dimensions and Chain Dimension Sets

Chain dimensions and chain dimension sets enable you to quickly select objects and then place 

a chain of dimensions from point to point along the selected direction. To understand chain 

dimensions more fully, open the fi le mi_12a_092.idw in the Chapter 12 directory of your 

Mastering Inventor 2014 folder, and compare the two dimensioned views. The one on the top 

left was done with the Chain Dimension tool, and the one on the top right was done with the 

Chain Dimension Set tool.

Use the view on the bottom left to create chain dimensions:

 1. From the Dimension panel of the Annotate tab, select Chain.

 2. On the drawing, select the geometry to be dimensioned by clicking to select individual 

edges or by clicking and dragging a window from right to left to select multiple edges.

 3. Right-click and select Continue.

 4. Move your cursor to preview the placement, and then click to set the direction.

 5. When fi nished, right-click and select Create.

Use the Chain Dimension tool to select the baseline dimensions in the bottom center view to 

convert them to chain dimensions:

 1. From the Dimension panel of the Annotate tab, select Chain.

 2. On the drawing, select all of the baseline dimensions by clicking and dragging a window 

from right to left.

 3. Right-click and select Continue.

 4. Select the center marks for the two smaller holes to add additional dimensions.
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 5. Right-click and select Create.

Note that there appears to be a bit of a bug in the way the dimensions are arranged. 

To remedy this, use the Arrange button, as described here.

 6. From the Dimension panel of the Annotate tab, select Arrange.

 7. On the drawing, select all of the chain dimensions you just created by clicking and drag-

ging a window from right to left.

 8. Right-click and choose Contour Entity.

 9. Select the edge of the part (or optionally click anywhere to the right of the part).

Use the view on the bottom right to create a chain dimension set:

 1. From the Dimension panel of the Annotate tab, select Chain Set from the Chain drop-

down list.

 2. On the drawing, select just the top and bottom edge of the part and any one of the holes.

 3. Right-click and select Continue.

 4. Move your cursor to preview the placement and then click to set the direction.

 5. Select an additional hole to add to the set.

 6. Right-click and select Create.

 7. Add more members to the set by right-clicking on the set and choosing Add Member.

 8. Select all of the geometry needed to complete the set so that it matches the top right view 

and then right-click and choose Done.

 9. Right-click any of the dimensions in the set and choose Delete Member.

Once you’ve experimented with the chain dimension options, you can close the fi le without 

saving changes.

Ordinate Dimensions and Ordinate Dimension Sets

Ordinate dimensions and ordinate dimension sets are created much the same way as baseline 

and chain dimensions and dimension sets. Again, a dimension set is managed and formatted as 

a single, selectable object (with some exceptions), whereas the Ordinate Dimension tool results 

in independently controlled dimensions.

Another key difference between ordinate dimensions and an ordinate dimension set is that 

you can have multiple ordinate sets on a single view with different origin points. However, 

once you specify an origin for ordinate dimensions on a view, all ordinate dimensions placed 

on that view will reference that origin as well as any hole tables referencing that view. The 

reverse is true as well: Once an origin is specifi ed for a hole table, ordinate dimensions on that 

view share the origin.
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Changing Origins

You can set the origin for an ordinate dimension set after you have selected the geometry. Th e 

default origin is the fi rst selected geometry, but you can change it. Th is is very powerful for updat-

ing a drawing. For ordinate dimensions, you can click the origin indicator and drag it to a diff erent 

endpoint, midpoint, or center point to change the geometry reference. You can also hide the origin 

indicator by right-clicking it and then show it again by right-clicking any of the origin dimensions.

To understand this more fully, open the fi le mi_12a_099.idw in the Chapter 12 directory 

of your Mastering Inventor 2014 folder, and compare the two dimensioned views. The one 

on the left was done with the Ordinate Dimension tool, and the one on the right was done with 

the Ordinate Dimension Set tool. Use the views on the bottom to create ordinate dimensions 

and ordinate dimensions sets matching the views at the top. Once they are created, explore 

the context menu options for the dimensions and the dimension set. You can fi nd the Ordinate 

Dimension Set tool by clicking the small arrow next to the Ordinate Dimension tool, to reveal 

the drop-down list.

Dimensions in Isometric Views

Although you may have been taught at some point that dimensions should never be placed on 

isometric views because traditional detailing techniques do not allow an accurate dimension 

to be pulled from an isometric, Inventor can overcome this by pulling the intelligence from the 

physical model. When you use the General Dimension tool to add dimensions to an isometric 

view, the resulting dimensions are fundamentally different from those you place in ortho-

graphic views.

This is immediately noticeable when you see how the resulting dimensions are drawn on the 

sheet: All of the dimension geometries (text, arrowheads, extension lines, and dimension lines) 

are drawn in 3D space and not in sheet space. Dimensions generated on isometric views are 

called true (meaning they refl ect the true model-space dimensional value). Dimensions added 

to orthographic views are known as projected because the dimension value represents the calcu-

lated distance or angle between endpoints or geometry projected onto the sheet.

When placing an isometric dimension, Inventor tries to determine an appropriate annotation 

plane based on your geometry selection. In many cases, particularly with linear dimensions, 

multiple inferred annotation planes are available. Prior to placing the dimension, you can toggle 

through these inferred annotation planes by pressing the spacebar.

If none of the inferred work planes meets your needs, you can project the dimension either 

onto the sheet plane or onto a model work plane. For instance, oftentimes you will fi nd that hole 

notes and leader dimensions such as radii and diameters look better placed on the sheet plane 

rather than in the isometric plane; therefore, you can right-click and choose Use Sheet Plane 

when placing them.

The change in dimension behavior (true vs. projected) happens automatically depending on 

the view orientation. Any projected isometric or base isometric view results in true dimensions. 

As a rule, newly added dimensions to a view are treated as true if none of the model’s origin 
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planes is parallel to the sheet (with the exception of auxiliary views). You can override this rule 

on a view-by-view basis by right-clicking a view and changing the dimension type (true or 

projected).

Retrieve Dimensions from Isometric Views

A quick way to place dimensions on an isometric view is to right-click the view and choose Retrieve 

Dimensions.

Isometric dimensions are functionally identical to orthographic dimensions; however, they 

cannot be “moved.” That is, they cannot be detached and reattached to different geometry, and 

they can’t be moved using the dimension Move option on the dimension’s context menu. All for-

matting options and behavior are otherwise identical.

Although placing isometric dimensions may seem unconventional, you can, in fact, often 

eliminate the number of views required to concisely communicate the design by placing dimen-

sions on an isometric view. Try adding dimensions to the isometric view in mi_12a_105.idw, as 

shown in Figure 12.22.

Figure 12.22

Isometric view 

dimensions

Formatting and Editing Dimensions

All the different types of dimensions discussed in this section are initially formatted by an asso-

ciative dimension style. Indeed, each different type of dimension can be set to use a different 
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dimension style if needed. Almost every formatting option available for dimensions is set 

through the dimension style. There are literally dozens of individual style settings—too many 

to list here. To learn how to change dimension formatting through styles, you’ll walk through 

setting up a new dimension style to apply a symmetrical tolerance:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_107.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. On the Manage tab, click the Styles Editor button.

 4. In the Style And Standard Editor, expand the Dimension node on the left side, and click 

the Default – mm (ANSI) dimension style.

 5. Click the New button along the top, thus creating a new style based on the Default – mm 

(ANSI) style. You can also right-click the dimension style you want to start from and 

choose New Style.

 6. Enter PM1 for the dimension name, and click the OK button.

 7. Click the Tolerance tab, and set the Method drop-down to Symmetric.

 8. Enter 0.100 for the Upper value fi eld, and then set Linear Precision to three places, as 

shown in Figure 12.23.

Figure 12.23

Dimension style 

tolerance settings

 9. Select the Units tab, and change the Linear Precision setting to three places (3.123).

 10. Click the Save button along the top, and close the Style And Standard Editor dialog box.

 11. Apply this dimension style to the existing dimensions on the sheet by fi rst selecting them 

and then selecting the Annotate tab and choosing PM1 from the Style drop-down (found 

just under the Layer drop-down to the top right of the screen). The selected dimensions 

will immediately update to refl ect the new style assignment.
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Creating Dimension Styles

It is a good idea to create all your standard dimension styles before rolling out your style library. 

By creating standards for all users to use, you eliminate any discrepancy that comes from mul-

tiple users all trying to create drawings that look the same. You can create all your decimal-place 

dimensions (one place, two place, three place, and so on), toleranced dimensions, and even dowel-

pinhole-toleranced dimension styles that users need only select.

 12. Double-click the 25 mm dimension to edit it, and click the Precision And Tolerance tab. 

The ±0.100 tolerance setting is refl ected here in the Edit dialog box. Change the tolerance 

value to ±0.200, and then click the OK button.

You’ve now created two formatting overrides for the 25 mm dimension. You have over-

ridden the standard dimension style assignment by setting it to a dimension style other 

than the By Standard style, and you then set a tolerance override. In addition to making 

style-level formatting changes to dimensions, you can copy and paste dimension format-

ting between dimension objects on your sheet.

 13. Right-click the 25 mm dimension you just edited, and select Copy Properties.

 14. Click the 30 mm dimension. It will adopt both the style formatting and the local tolerance 

value override from your source dimension.

You can confi gure which properties are copied before selecting the target dimension by 

right-clicking and selecting Settings after invoking the Copy Properties tool. To edit a dimen-

sion’s style, right-click the object and choose Edit Dimension Style, which will take you right 

into the Style Editor and highlight the dimension style. You can do this with just about any 

annotation object.

Hole and Th read Notes
A hole note differs from a traditional diameter dimension by calling out feature information 

beyond just the hole diameter. The Hole/Thread Notes command (in the Feature Notes panel) 

generates a leadered note that displays all pertinent hole feature information derived from the 

hole edge that is selected.

For example, a hole note pointing to a simple blind hole might appear as 10 × 20. A hole 

note pointing to a through partial-tapped hole might appear as 10–32 UNF-2B × 20.00. Inventor 

provides you with the ability to tailor the exact contents of the hole note through your dimen-

sion style.

Use the Hole/Thread Notes tool to add a single note for the mounting hole and tapped hole 

in the faceplate front view. You can confi gure hole notes to display whatever string of descrip-

tion text you prefer, as well as set the various hole parameter values’ Precision and Tolerance 

settings. These preferences are set and stored in the dimension style.

You can confi gure more than 50 types of holes in this interface; they generally correspond to 

the different kinds of holes you can create using the Hole feature tool in part and assembly mod-

eling (“holes” as a result of circular-extruded cuts, voids, or circular sheet-metal cut features are 

also supported by hole notes).
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You can confi gure hole notes to display the hole quantity as part of the note. You can add a 

quantity note either directly on an individual note through the Edit Hole Note dialog box (right-

click a hole note and choose Edit Hole Note) or at the style level (right-click a hole note and 

choose Edit Dimension style) so they appear for all holes of the same type. You can use the hole 

note in mi_12a_109.idw to explore this.

To add a quantity note at the style level, make sure you’re editing the dimension style associ-

ated with the hole notes on your drawing (the best way to ensure this is to right-click the hole 

note and choose Edit Dimension Style). Select Blind - Depth Thread in the Note Format drop-

down, and then click in the text fi eld so that the cursor is in front of the note text; fi nally, click 

the button with the # sign on it. This inserts the <QTYNOTE> variable token in front of the note, 

as shown in Figure 12.24.

Figure 12.24

Hole note settings 

in dimension style

You can customize the quantity note by clicking the Edit Quantity Note button on the dimen-

sion style’s Notes And Leaders tab, as shown at the bottom left of Figure 12.24. By default, the 

quantity note is set up as a prefi x to the full hole note (2 ×). This dialog box also lets you set how 

the hole quantity is determined (either the number of holes in a feature or pattern or a complete 

evaluation of identical holes in a view where all the hole axes are normal to the view).

As soon as you save the changes to your dimension style, you should see the hole note for the 

tapped holes update to include the quantity of holes (2 ×).

The dimension style’s Notes And Leaders tab also enables you to preconfi gure other kinds 

of feature notes, including chamfer notes (which are actually calculated notes and not feature-

dependent), punch notes, and bend notes (the latter two of which are available only for views of 

sheet-metal parts).

Leadered Symbols
Many of the annotations you can apply to a drawing belong to a common class of annotations 

often referred to as leadered symbols. These are all grouped together in the Drawing Annotation 

panel: Surface Texture Symbol, Welding Symbol, Feature Control Frame, Feature ID Symbol, 

Datum ID Symbol, and fi ve different Datum Target tools. Each of these is created the same way, 

and each is formatted with its own dedicated style.
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In the following steps, you will walk through an exercise that involves adding geometric 

dimensioning and tolerancing symbols to a drawing of a faceplate:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_109.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. On the Annotate tab, use the drop-down on the Symbols panel and click the Datum 

Identifi er Symbol button.

 4. Click the far-right edge of the part, and drag the leader to the desired length.

 5. Click the screen to set the leader, and then right-click and choose Continue.

 6. Accept the default A value in the text editor, and click the OK button.

 7. Click the bottom edge to add a second datum ID (B), but rather than placing a leader, 

right-click and choose Continue immediately after clicking the initial part edge point. 

You can do this with most Inventor leader features.

 8. On the Annotate tab, use the drop-down on the Symbols panel, and choose the Feature 

Control Frame button.

 9. Rather than attaching the frame to the part, hover your mouse pointer near the bottom 

middle of the hole note until you see a green dot indicating the snap point (just below the 

N in UNF), and then click it.

 10. Right-click and choose Continue to place the frame without a leader. This will attach the 

frame to the dimension text.

 11. Fill out the appropriate fi elds for a positional tolerance relative to the A datum and the B 

datum, as shown in Figure 12.25; then click the OK button.

Figure 12.25

Feature control 

frame attached to 

hole note

 12. To see that the frame is attached, select the hole note and then drag the leader landing to 

move the note. Notice how the frame remains constrained to the hole note.
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Drawing Text
You can add text to your drawing in multiple ways. The Text tool (found on the Annotate tab) is 

used to create general drawing notes. This kind of text is limited because it can’t be associated (con-

strained) to a drawing view and because it offers no control over which component iProperties and 

parameters are being accessed when you have multiple components detailed on the same sheet.

In addition to using the Text tool, you can use the Leader Text tool (also found on the 

Annotate tab), which can be associated to a view or a component, allowing you to extract and 

display iProperty and model parameter values from the component to which the leader is 

attached. If view associativity is required but you don’t want a leader, you can right-click the 

leader text and choose Delete Leader.

Each of these tools utilizes the generic Format Text dialog box. This dialog box is used to edit 

any text-specifi c annotations as well as annotations such as hole tags and datum and feature 

IDs. The general text formatting for any drawing annotation containing text ultimately comes 

from a text style. Text style formatting (size, font, color, and so on) can be overwritten in the 

Format Text dialog box.

General Tables
You can create a table on a drawing sheet by using the General Table tool found on the Annotate 

tab (the button is located on the Table panel and is called General). When you click the General 

button, you are presented with the Table dialog. You can create an empty table and then add 

information, or you can choose a data source from which to populate the table:

iParts and iAssemblies  These can be used to create tabulated confi guration tables. For 

instance, you might have an iPart bracket in six different lengths. You could select the iPart 

fi le to use as the table data source, and then place a table with a row for each of the six 

lengths listed by their part numbers. You would choose the Length parameter to use as the 

column, and each row would be populated with the appropriate length value, as defi ned in 

the iPart. You can then place a view of one of the brackets and edit the dimension to read 

Length rather than the numeric value.

Sheet-Metal Parts  These parts can be used to create bend tables. Selecting an existing fl at 

pattern view as the data source allows you to choose the parameters you want to use in the 

bend table and then place a table indexing the bends on the fl at pattern. Bend ID numbers are 

automatically placed on the fl at pattern view. Editing the bend ID in the table updates the ID 

number on the fl at pattern. Editing the table overrides the bend order annotation of the part 

fi le; therefore, it is typically best to use the Bend Order Annotation tool in the sheet-metal 

part to set the order.

XLS Files  You can link an Excel spreadsheet fi le to a general table. Use the General Table 

tool and select the XLS fi le to place the table on the drawing sheet and link to the original fi le.

 ◆ To update the table, right-click it in the browser and choose Edit to open the XLS fi le. 

If the XLS fi le is linked, you can edit it outside of Inventor and right-click to choose 

Update to bring in the changes.

 ◆ To point the table to a different XLS fi le, expand the 3rd Party folder, right-click the 

table link, and choose Change Source. Be aware that there are limitations to the num-

ber of rows you can have using this method. Also note that blank rows in the XLS fi le 

will be read as the end of the table.
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Splitting Tables

If your table has a large number of rows it might be too long to fi t on the drawing sheet. In these 

cases you can split the table. To do so, click on the row where you want to split the table and then 

right-click and choose Table ➢ Split Table. You can split a table into multiple sections by using the 

Split Table option on a previously split table. Be sure to select the table row and not the table line 

before you right-click; otherwise the Split Table option will be grayed out.

Once the table is split you can drag the sections into place on the sheet as needed. In the browser 

you’ll see the split section nested under the original table node. To rejoin the table, you can right-

click the browser node or the actual table, and choose Table ➢ Un-split Table. Changes to the 

original table section are applied to all split sections; however, changes applied to a split section 

are applied to itself only.

You can use the Split Table option on general tables, parts list tables, revision tables, and hole tables.

Hole Tables
You can document hole descriptions, quantities, and locations on a view by using a hole table 

rather than using hole notes. Indeed, you can use the hole table to document not only hole 

features but sheet-metal punches as well. You can even use a hole table to call out locations of 

recovered work points in your model. This technique can be used to detail specialized features 

such as slots and bosses.

Hole tables, like most types of annotation in Inventor, are initially formatted by an asso-

ciative style—a Hole Table style in this case. The Hole Table style enables you to select which 

columns you want displayed in your table, format precision and units for the X and Y location 

columns, change line formatting, fi lter on different hole types, and confi gure various grouping 

mechanisms depending on your needs.

Everything about the hole table is formatted by the Hole Table style except for the description 

string for the hole. The description string uses the same confi guration as your hole notes and 

receives this particular formatting by the hole tag’s dimension style (hole tags are created with 

the hole table and are formatted by a dimension style).

In the following steps, you’ll walk through setting up a Hole Table style and creating a hole 

table for the faceplate:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_111.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. On the Manage tab, click the Styles Editor button.

 4. In the left pane of the Styles Editor, expand the hole table node, and click the style named 

Hole Table – mm (ANSI). The right pane will update to show the settings for this style, as 

shown in Figure 12.26.

 5. At the top of the right pane, click the New button, and set the name of the new hole table 

style to HT_02.

 6. Click the Column Chooser button, and select the Quantity property on the left of the 

resulting property list.
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Figure 12.26

Hole Table Style 

dialog

 7. Click the Add button to add it to the included list of columns on the right.

 8. Use the Move Up button to move the Quantity column up in the list as you like; then click 

the OK button.

 9. Right-click the XDIM property in the Default Column Settings frame, and select Format 

Column.

 10. In the Format Column dialog box, change the precision to three places, and change the 

column heading to X LOCATION. Note that you can format columns in this manner in 

almost all of the annotation tables, such as parts lists and so on.

 11. Click the OK button, and repeat for the YDIM column.

 12. Click the Save button to save the changes, and exit the Style And Standard Editor dialog 

box by clicking the Done button.

You will now need to place a hole table on the drawing. Three hole table variations are avail-

able on the Table panel of the Annotate tab:

Selection  This option allows you to select the holes you want to include in the table, and 

then only those holes are included.

View  This option documents all holes in a view, although you can use fi lters to exclude cer-

tain hole types. As holes are added to the part, the hole table updates to include them.

Features  This option allows you to select an instance of the types of holes you want to 

include in the table, and then all holes of that type are included.

To continue this exercise, you’ll choose to place a hole table using the View method:
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 1. On the Annotate tab, select the Hole drop-down on the Table panel, and choose Hole 

View.

 2. Select the view on the sheet.

 3. Next, you need to place the origin on the view. You can click any edge or vertex of the 

part, or you can project the edges to fi nd the apparent intersection of the lower-left corner.

 4. To place a table using the table style you created, choose HT_02 from the Style drop-down 

at the top right of the screen.

Finding a Corner Intersection

To fi nd an apparent intersection for placement of an origin marker, zoom into the lower-left corner 

of the part. Th en scrub your mouse pointer over the vertical and horizontal edges of the part, and 

bring your mouse pointer to the apparent intersection; you should see the edge projected down 

and over and see a yellow dot at the intersection. When you do, click the dot to set the origin at 

that point. Be sure you run over the edges (lines) and not just the endpoints of the edges.

 5. Click the screen to set the hole table on the sheet.

For each hole in the view, a hole tag is placed next to the hole edge, and a corresponding row 

is generated in the hole table. Also notice that because each hole is called out individually in this 

table, each row has a quantity of 1 (shown in Figure 12.27). You can edit the hole table by right-

clicking it and choosing Edit Hole Table. From there, you can set the table to roll up all A-type 

holes and all B-type holes from the Options tab by selecting the Rollup radio button.

Figure 12.27

Th e hole table gen-

erated for the face 

plate

You can also edit the Tag, Note, or Description text by right-clicking the text in the table. 

You can make direct overrides to hole descriptions by double-clicking the description text, 

and you can override X and Y location precision by right-clicking an individual cell. You can 

access several other options by right-clicking the text in the table as well, so be certain to explore 

them all. When fi nished, you can close the fi le without saving changes.
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Hole Tables Save Time on Large Parts

For large plates with many diff erent holes, hole tables are wonderful. A large plate could take a half 

hour or more to fully dimension. Furthermore, it’s often diffi  cult for a machinist to tell where all 

fi ve of the same holes are located if they are not all called out individually. Th e hole table gives the 

machinist X and Y locations of the holes that they can use to program their CNC milling machine 

extraordinarily quickly. Don’t be surprised if the machinist asks you to dimension all your parts 

using hole tables.

Annotating Assembly Drawings
Creating/annotating drawing views of assemblies is similar to doing so for parts. All the same 

views and annotation tools discussed in the previous sections can be executed when working 

with assembly and presentation models. When creating views of assemblies, you will typically 

create parts lists and balloons and may need to control reference parts, interference edges, and 

assembly representations. These subjects and others dealing specifi cally with assembly fi les are 

covered in the following sections.

Assembly Representations
The view options available for assembly views are among the most signifi cant differences 

between part and assembly model views. When an assembly fi le is referenced in the base view, 

representation options become available on the Component tab of the Drawing View dialog box. 

These controls allow you to specify which assembly view, positional, or level-of-detail (LOD) 

representation is displayed in the resulting drawing view.

View representations can optionally be made associative to the view (using the check box 

at the top of the View Representation control). Specifi cally, an associative view representation 

means that as a component’s visibility is changed in the assembly, the change is witnessed in 

the drawing view as well. If the associative option is deselected, you can toggle component 

visibility from the drawing itself by expanding the view node in the browser, expanding the 

model tree on the view node, and then right-clicking a component and choosing Visibility. If the 

Visibility option is grayed out, the view is associative and the component visibility is being con-

trolled in the assembly.

Making Your Views Associative

Most of the time you will want to make your views associative. If you do not, you’ll be scratching 

your head trying to fi gure out why the drawing view is not matching your view representation.
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Recall the general defi nitions of each assembly representation type:

View Representations  These control component visibility, color overrides, and parts list 

fi lters.

Positional Representations  These show an assembly in different physical positions.

Level-of-Detail Representations  These control visibility and manage memory consump-

tion by suppressing components.

In the next several steps, you will edit a view of an assembly to see how to use assembly rep-

resentations in drawing views:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_115.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. In the browser, expand the Sheet1 node to reveal the node for each existing view.

 4. Expand the Main View node to reveal the assembly node, and then expand the assembly 

node to reveal the parts tree.

 5. Right-click the view called Main View and choose Edit View to examine the view options 

dealing with representations. Notice the different representations, as shown in 

Figure 12.28.

Figure 12.28

Assembly base view 

creation

 6. In the View area, choose the view representation named Frame And Ram, and then click 

the OK button.

You’ll notice that all of the parts are gone now except the frame and ram. This was set up 

in the assembly by toggling the visibility state off for all the other parts, and then saving 

the view confi guration as a view representation. Examining the browser, you’ll see 

that the parts set to not be visible are grayed out.

 7. Right-click the view called Main View, and choose Edit View again.
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 8. In the Level Of Detail area, choose the representation named Handle And Ram, and then 

click the OK button.

You’ll note that only the ram remains on-screen. This is because you have the view set 

to use two different representations at once. In the view representation, the visibility is 

turned off for everything but the frame and ram, but the frame was suppressed in the 

level of detail. Examining the browser, you’ll see that suppressed parts are not listed.

Typically, it’s best not to use these two representations together because it can be confus-

ing as to what is being controlled where. However, there are times when this is the best 

way to achieve the desired results.

 9. Right-click the view called Main View, and choose Edit View once again.

 10. Set the view representation to Master, and set the positional representation to Closed 

(leave the LOD as is); then click the OK button.

You’ll see that now just the handle, shaft, and ram parts are shown (because of the LOD 

representation), and the positional representation is controlling the positions of these 

parts.

 11. Right-click the view called Main View, and choose Edit View once more.

 12. Set the view representation to Default, and click the Associative check box button (it looks 

like a chain link).

 13. Set the LOD representation to Master, and then click the OK button.

 14. In the browser, right-click the Arbor Frame node and notice that the Visibility option is 

grayed out.

 15. Right-click the Main View node, and choose Edit View one more time.

 16. Uncheck the Associative check box button, and then click the OK button.

 17. In the browser, right-click the Arbor Frame node and notice that the Visibility option is 

now available.

 18. Click Visibility to toggle it off, and notice that the frame is removed from the view.

You are now controlling component visibility at the drawing level rather than using the 

assembly view representation’s visibility controls. You can continue experimenting with the rep-

resentation options and then close the fi le without saving changes.

Reference Data in Drawing Views
Assembly components can be designated as Reference. You can apply this attribute as a docu-

ment setting on the part or assembly fi le itself or on a per-instance basis when it’s placed in a 

higher-level assembly. In addition to being omitted from the assembly mass property calcula-

tions, BOM, and subsequent drawing-parts lists, reference components are drawn and calcu-

lated differently in assembly drawing views.
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By default, all reference component edges are mapped to a unique layer with a broken line 

style (double-dash chain). Hidden-line calculation, by default, is run separately for reference 

components and nonreference components. Finally, reference components do not affect the 

calculation of the drawing boundary. This means that if you have a reference component well 

apart from nonreference parts in an assembly, it may not be visible in a drawing view until you 

increase the reference margin.

To explore these settings, you can open the fi le mi_12a_117.idw in the Chapter 12 direc-

tory of your Mastering Inventor 2014 folder and compare the two views. The view on the left 

shows the reference part at the default settings. The view on the right has been adjusted to show 

the reference part as a standard part. Right-click the view and choose Edit to adjust all the refer-

ence data view behaviors on the Model State tab of the Drawing View dialog box. Figure 12.29 

shows the default settings.

Figure 12.29

Reference data 

settings

Interference and Tangent Edge Display
As you place and constrain components in an assembly fi le, it may be necessary to create an 

interference condition between parts. This is common for press-fi t conditions such as pins in 

undersized holes. This condition is common in Inventor even when you have a threaded fas-

tener being inserted into an equal-diameter threaded hole. These edges are designated as inter-

ference edges and can be turned on or off as needed.

You can also control the display of tangent edges for cylindrical faces, fi llet edges, and so on 

in your drawing views. Both tangent and interference edges can be enabled by editing the view 

and selecting the Interference Edge check box on the Display Options tab.

Figure 12.30 shows the difference between two views with these edges turned off and turned 

on. The interference edge in this case is the small set screw in the middle of the plate. All other 

differences are tangent edges.

Parts Lists
A parts list is a formatted report of the assembly bill of materials placed on the drawing in a 

table. Most of the data you see in a parts list comes ultimately from the assembly BOM, but the 

BOM and the parts list are managed separately inside Inventor, providing control and fl exibility 

for managing both.
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Figure 12.30

Tangent and 

Interference edges

Parts lists have a dedicated formatting style that provides dozens of formatting variations. 

You’ll walk through a typical parts-list editing and creation workfl ow to see what kind of capa-

bilities can be leveraged in the parts lists:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_119.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. On the Manage tab, click the Styles Editor button, expand the Parts List node, and click 

the style named MI_PL_02.

 4. Click the Column Chooser button, and add the Material property from the list on the left. 

Then click the OK button.

 5. Click the Heading button, and change the placement to Bottom.

 6. Save your changes, and exit the Style And Standard Editor dialog box using the Done 

button.

 7. On the Annotate tab, click the Parts List button.

The Parts List dialog box allows you to either click an assembly or presentation drawing 

view or browse directly to an assembly or presentation fi le (you can create a parts list on 

a drawing with no drawing views). You can choose either a structured (fi rst or all levels) 

or parts-only parts list. If the parts list is too long for the sheet size you’re placing it on, 

you can also enable the option to wrap the parts list based on a specifi ed number of rows.

 8. Click the view on the sheet, and ensure that Structured is selected for the BOM view 

type, and the Direction To Wrap Table option is set to Right. Click the OK button, and 

then snap the parts lists to the lower-left corner of the drawing border.

Although you can specify the default column width at the style level, you may need 

to adjust the width based on the length of the text strings read in from the component 

iProperties. You can adjust column width by clicking and dragging the vertical column 

lines on the parts list on your sheet.

 9. Resize the Material column on the parts list to better accommodate the long 

description text.
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The initial item numbering for the components and the row order come from the last 

saved state of the assembly BOM but can be changed by editing the parts list. 

 10. Double-click the parts list to launch the Parts List dialog box (or right-click and choose 

Edit).

 11. Click the Sort button, sort by part number in descending order, and then click the OK 

button.

 12. Click the Renumber Items button, and notice how new item numbers are assigned based 

on the sort order.

The new item numbers appear blue and bold in the Parts List dialog box to indicate that 

they do not match the BOM. Changes you make to any of the cells in the Parts List dialog 

box (except for custom rows or custom columns) are treated as overrides to the BOM data. 

However, only item number overrides can be written back to the BOM. All other over-

rides are preserved at the parts-list level, allowing for greater fl exibility of parts-list edits 

at the drawing level without worries that they will be discarded if updated in the BOM. 

Item number changes can be saved to the assembly BOM cell by cell from the context 

menu or for the entire parts list in one of three ways:

 ◆ While editing the parts list, click the Save Item Overrides To BOM button along the 

top.

 ◆ Right-click the parts list itself on the sheet, and choose Save Item Overrides To BOM.

 ◆ Right-click the Parts List browser node, and choose Save Item Overrides To BOM.

If you intend for the overrides of properties other than the item numbers to match in both 

the BOM and parts list, you should make those edits in the BOM, where they will push 

through to the parts list. You can access the BOM quickly by right-clicking the parts list 

and choosing Bill Of Materials. Edits made in the BOM editor are written back to compo-

nent iProperties and, therefore, push through to the parts list, provided no parts list over-

rides have already been made.

 13. Click the OK button to apply the changes and exit the Parts List dialog box.

 14. Right-click the drawing view and choose Edit View.

 15. Set the view representation to Frame And Ram, and then click the OK button.

Notice that the parts list still displays the full assembly even though the view now shows 

only the frame and ram parts. To set the two to coincide, you will apply a parts list fi lter.

 16. Edit the parts list and click the Filter button, found along the top of the Parts List dialog 

box.

 17. From the Defi ne Filter Item drop-down box, select Assembly View Representation.

 18. Choose Frame And Ram from the drop-down box, and then click the green check mark. 

Then click the OK button to apply the fi lter.

 19. Click the OK button in the Parts List dialog box.
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You’ll see the parts list update to show only the parts corresponding to the view representa-

tion. The parts list is not directly associated with any drawing view (if you choose a view when 

you create the parts list, it acts only as a pointer to the assembly fi le itself). You can close the fi le 

without saving changes. In the next section, you’ll explore balloons.

Balloons
Assembly drawing views are related to parts lists by ballooning the components in the assem-

bly drawing view. Balloons are perhaps the only type of annotation relevant for assembly 

views only. By default, balloons are set to display just a component’s assigned item number, but 

through changes to the balloon style, a balloon can be confi gured to display any component 

iProperty or BOM property. Review the creation and editing of balloon styles in “Editing Styles 

and Standards” earlier in this chapter.

You should know that only items visible in a view can be selected for placing a balloon; how-

ever, you can string multiple balloons together on a single leader, including parts that are not 

visible, virtual parts, and even line items added to the parts list that do not exist in the assembly 

BOM. This is also a common technique when ballooning a collection of hardware such as a 

screw, lock washer, and split washer.

Follow these steps to explore methods and options for balloon placement:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_120.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. On the Annotate tab, click the Balloon button. Select the cap on the end of the handle, 

drag out and click to place the balloon on the sheet, right-click and choose Continue, and 

then right-click again and choose Cancel.

 4. Right-click the balloon, and select Attach Balloon.

 5. Click the lever arm. The balloon for the lever arm is shown attached to the handle cap’s 

balloon (Figure 12.31). Drag your mouse pointer around the balloon to set the position of 

the attached balloon, and then click to place it.

Figure 12.31

Attached balloons
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 6. Right-click the balloon, and select Attach Balloon From List.

 7. Select the box next to Spare Cap, and click the OK button. The spare cap is a virtual com-

ponent created in the assembly BOM.

Balloons can be added one at a time, or you can use the Auto Balloon tool (under the 

Balloon fl yout) to quickly add multiple balloons to a drawing view.

 8. Click the drop-down on the Balloon button, and select Auto Balloon.

 9. Select the view on the sheet, and then window-select all the components in the view.

 10. Click the Select Placement button, and change the placement options. Move your mouse 

pointer around the sheet to see how the preview graphics update.

 11. Set the placement option to Horizontal, place the balloons above the assembly, and then 

click the OK button.

Here are some tips for working with balloons:

 ◆ Click a balloon to reposition it on-screen.

 ◆ Click the leader and drag it off the part edge and onto a part face if using the edge does not 

make clear what part is being specifi ed.

 ◆ Be aware that items are not updated in balloon contents when they’re not attached to an 

edge, so if you pull a balloon from the edge of item 1 and place it on the face of item 2, the 

balloon will still read item 1.

 ◆ You can reassociate balloons from one part to another part by dragging the arrowhead 

from one part edge to the edge of a different part.

 ◆ Balloons not attached to an edge use an alternative leader style (most often a dot). You can 

specify a different alternative leader style in the balloon style.

 ◆ If you right-click a balloon and choose Edit Balloon, you can change the item number and 

have it update the part list, or you can type in an override and it will not update the parts 

list.

 ◆ If you right-click a balloon leader, you can choose Attach Text To Leader and add text along 

the leader line.

Explore the balloon options and then close the fi le without saving changes.

Center of Gravity Display
You can display the center of gravity (COG) of a part or assembly in a drawing view as a center 

mark. Only one COG can be shown per view, with the exception of overlay views. Using a draw-

ing containing an overlay view, you will take a look at displaying the COG marker in a drawing 

to show the change in the COG between the two overlaid positional representations:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_123.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.
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 3. Expand the sheet node in the browser, and locate the Base View node and expand it.

 4. Right-click the mi_12a_115 assembly icon, and select Center Of Gravity.

Doing so recalculates the model’s center of gravity (it does not read the value in from the 

model’s physical properties) and draws a center mark at the calculated location.

 5. Locate the overlay node in the browser, and expand it.

 6. Right-click the mi_12a_115 assembly icon listed in the overlay tree, and select Center Of 

Gravity.

 7. Finally, dimension the location of these center marks relative to the bottom-right corner of 

the Arbor Press frame.

 8. Double-click to edit one of these dimensions, and add (COG) as a suffi x to the dimension 

value on the Text tab of the Edit Dimension dialog box.

 9. Right-click the dimension and use the Copy Properties option to copy this appended text 

to the other COG dimensions, as shown in Figure 12.32.

Figure 12.32

Overlay view with 

recovered COG

Working with Sheet-Metal Drawings
Drawing views of sheet-metal parts offer some unique options beyond those normally avail-

able for conventional part fi les. Among these are the inclusion of bend notes, bend lines, punch 

notes, bend tables, and the creation of fl at pattern views.

Flat Pattern Views
When a sheet-metal part fi le has a fl at pattern defi nition, you can create a drawing view of the 

folded model or the fl at pattern. You can include both as well, but you need to separate base 

views to do so. To take a look at these options, follow these steps to create a fl at pattern drawing 

view to start off:
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 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_130.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. Right-click the existing isometric view, and choose Open to open the model fi le.

 4. Take a look at the model, and note that this fi le has been created using the sheet-metal 

tools discussed in Chapter 6, “Sheet Metal,” and that a fl at pattern has been generated in 

the model.

 5. Use the fi le tabs at the bottom of the screen to switch back to the drawing fi le (or press 

Ctrl+Tab).

 6. On the Place Views tab, click the Base View button.

 7. Ensure that the component listed in the File drop-down is mi_12a_130.ipt.

 8. On the Component tab in the Drawing View dialog box, select the Flat Pattern option as 

well as the Recover Punch Center option, set the scale to fi t that sheet, and then place the 

view of the fl at pattern on the sheet.

Leave this fi le open because you will use it in the following pages.

Bend Centerlines and Extents
Bend centerlines are drawn on sheet-metal fl at pattern views where the center of the bend is 

located on the material face. Inventor tracks negative and positive bend centerlines indepen-

dently of one another to enable users to apply different line formatting for these two conditions. 

This has already been done in mi_12a_130.idw, but it should be noted that the default behavior 

is to have both positive and negative bend lines placed on the same layer. If you want to sepa-

rate them, simply create a new layer called Bend Centerline (negative), and then under Object 

Defaults in the Styles And Standards Editor, assign Sheet Metal Bend Centerline (+) and (-) to the 

appropriate layers.

Lines representing bend extents can be enabled by right-clicking the fl at pattern view, choos-

ing Edit View, selecting the Display Options tab, and selecting the Bend Extents option.

Bend and Punch Notes
You’ll fi nd two sheet-metal-specifi c annotation tools on the Annotate tab: Bend Notes and Punch 

Notes.

Bend notes are placed on bend centerlines in sheet-metal fl at pattern views and can convey 

information about the bending operation, including the bend radius, direction, angle, and 

K-factor. To place bend and punch notes, continue working with the mi_12a_130.idw fi le or 

open this fi le and activate Sheet2 to pick up from this point:

 1. Click the Bend button on the Feature Notes panel of the Annotate tab.

 2. Click one of the bend centerlines in the drawing view to place a single note.
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 3. To place the rest of the bend notes, window-select the entire view. This tool looks only 

for bend centerlines, so you needn’t be concerned about unintentionally selecting regular 

model edges.

By default, the bend notes are drawn adjacent to the bend centerlines, but where the note may 

be obscured in the view, you can drag individual bend notes to fl ip them to the opposite side of 

the bend centerline, or you can drag away from the bend centerline, and a leader will be gener-

ated back to the bend centerline. Try this with the two outermost bend notes on the electrical-

box fl at pattern view (shown in Figure 12.33).

Figure 12.33

Bend notes in fl at 

pattern view

The style formatting and direct editing of bend notes is identical to formatting and editing 

hole notes. You can preconfi gure the contents of the note with the note’s dimension style by add-

ing one or more variable tokens for the bend note attributes. Punch notes are used to convey 

information about sheet-metal punch features (a special kind of iFeature). Punch notes can be 

applied only to fl at pattern views of sheet-metal parts. They can be attached to recovered punch 

centers (shown as center marks in the fl at pattern drawing) or on any model edge generated by 

the punch.

Punch notes can be confi gured to display the punch identifi er (defi ned as part of the iFeature 

defi nition), the punch angle, the depth, and the direction. Punch notes are likewise formatted 

through dimension styles and have a similar editing interface to hole notes.

Bend Tables
Bend information can alternatively be displayed in a table rather than a note. A bend table is 

generated using the General button on the Table panel on the Annotate tab. The Table tool basi-

cally morphs into several different kinds of tables depending on what you specify as a data 

source. If a fl at pattern view is selected, a bend table will be generated.



612 | CHAPTER 12 DOCUMENTATION

General Tables

If no data source is selected in the Table dialog box, you’ll end up with an empty table that you 

can populate manually. You can also browse and import data from a CSV or XLS fi le into the table.

To create a bend table for mi_12a_130.idw, activate Sheet3 and then follow these steps:

 1. Click the General button on the Table panel of the Annotate tab.

 2. Select the fl at pattern view.

 3. Click the Column Chooser button, and select Bend Radius from the list on the right.

 4. Click the Remove button, and then click the OK button.

 5. For Bend ID, select the Alpha option, and then click the OK button.

 6. Place the table on the sheet, and adjust the bend ID tags as required by clicking them and 

dragging.

A bend table is edited and maintained like a parts list. The Table dialog box is essentially 

identical, and any changes to the cell data are treated as overrides to the data source (in this 

case, the bend data stored in the sheet-metal fi le). You can close the fi le without saving changes. 

Figure 12.34 shows a simple bend table and bend ID tags.

Figure 12.34

Bend table

Punch Tables
Punch information can likewise be displayed in a table, but because punches closely resemble 

holes with respect to the kind of information required to be displayed, a hole table is used to 

generate tabulated punch data. The only difference between creating a hole table and creating 

a punch table is that you use a predefi ned hole table style that is set to pick up only sheet-metal 

punch features. Here are the general steps used to create a punch table:
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 1. Ensure that your fl at pattern view has been set to collect punch centers. (Right-click and 

select Edit View ➢ Recover Punch Centers.)

 2. Start the Hole Table – View tool (using the Hole View button found on the Table panel of 

the Annotate tab).

 3. Select the fl at pattern view.

 4. Select an origin point.

 5. Prior to placing the table, change the table’s style to a punch table style. If you forget this 

step, you can always select the existing hole table and change it to the punch table style 

using the Style drop-down (top right of the screen).

Figure 12.35 shows a simple punch table.

Figure 12.35

Punch table

Working with Weldment Views
Weldments are a special kind of assembly model and offer unique drawing view and annota-

tion options in the Drawing Manager. Here, you’ll take a quick look at the way drawing views 

handle weldment stages for detailing. For more information on working with weldments and 

weldment annotation, refer to Chapter 10, “Weldment Design.” A drawing view of a weldment 

assembly can display any of the weldment states, which are as follows:

Assembly  Displays the base assembly prior to the preparation, welding, and machining 

stages.

Machining  Displays assembly features that represent the post-weld machining and 

fi nishing.

Welds  Displays the assembly as it exists during the weld stage, before machining but after 

preparations have been made. Weld beads are also shown.

Preparations  Displays assembly features such as chamfers, extrude cuts, and holes used 

to remove material to prepare the assembly for welding. You can set the view to display the 

entire assembly during the preparation stage or set the view to look at a single component as 

it exists at the preparation stage.
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Follow these steps to explore the way weldments are handled in drawings and 

drawing views:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_139.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. Notice the following about the views on this drawing sheet:

 ◆ View-1 through View-4 show the assembly with no preparations, welds, or 

machining.

 ◆ View-P1 through -P3 show each part at the preparation stage.

 ◆ View-W1 shows the weldment with welds but no machining done after the weld stage.

 4. Right-click View-1, and choose Edit View; then click the Model State tab in the Drawing 

View dialog box.

 5. Currently, this view and the views projected from it are set to the assembly state. Select 

the Machining option, as shown in Figure 12.36, so the view displays the completed 

weldment. Click the OK button.

Figure 12.36

Weldment state 

settings

 6. Notice that View-1 through View-4 now show the weldment at its completion, including 

the machined holes that run through the weld on one side (see Detail A).

 7. Edit View-W1 and check the Model State tab to see that it is set to the Welds option.

 8. Click the Display Options tab, and select the options to recover weld annotations and 

model weld symbols. Then click the OK button.

 9. Because the weldment included the weld symbols, they can be pulled into the drawing. 

Click each symbol, and use the grip snaps to arrange them as you like.

You’ll also notice a series of arcs indicating the weld bead brought in via the Weld 

Annotations option. You can right-click those and choose Edit Caterpillar to adjust the 
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appearance of each, or you can turn the visibility off as required. Figure 12.37 shows the 

view with recovered weld annotation and symbols.

Figure 12.37

Weldment draw-

ing with recovered 

annotation and 

weld symbols

 10. Edit View-P1 through View-P3 to check the Model State tab settings for these views. 

Notice that each of these views is actually created from the assembly fi le, but is set to look 

at the individual parts at their preparations stage.

You might also note that the balloons on View-P1 through View-P3 are calling out the fi lenames, 

and that both of the side plates are the same fi le but have opposing chamfers. This is because a 

common plate was used for both sides and then prepared as required in the weldment assembly. If 

you were to make views of the parts themselves instead of each part at the weldment preparation 

stage, the chamfers would not be present. You can close this fi le without saving changes.

If you don’t need to use the weldment tools in assembly modeling but still need to convey 

welding information in a drawing, you can create weld symbols and weld annotations (end fi lls 

and caterpillars) manually on the drawing view. Each is available in the Symbols panel of the 

Annotate tab (as shown in Figure 12.38) and is formatted by a dedicated style (the Weld Symbol 

style and Weld Bead style, respectively).

Figure 12.38

Weldment annota-

tion and weld sym-

bols can be created 

in the drawing

Working with iParts and iAssembly Drawings
When your drawing view references an iPart or iAssembly, you can choose, from the drawing 

view Model State tab, which member fi le you want to document.

Annotations (particularly dimensions) attached to drawing views of iParts and iAssemblies 

generally remain attached if you edit the base view and change the iPart member on the Model 



616 | CHAPTER 12 DOCUMENTATION

State tab. This means you can fully annotate just one iPart or iAssembly member and select Save 

Copy As for each unique member after changing the member referenced in the base view. Or 

you can create a tabulated drawing detailing all of the iPart/iAssembly members on a single 

sheet. To look at this workfl ow, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_12a_148.idw in the Chapter 12 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. On the Annotate tab, click the General button found on the Table panel.

 4. Select the fl at pattern view on the sheet to set the focus of the table.

 5. Because this part fi le is both a sheet-metal part and an iPart, you are given the choice to 

create either a bend table or an iPart table (you can create both but need to do so in suc-

cessive steps). Set the table data source to iPart/iAssembly Table.

 6. Click the Column Chooser button, and use the Add button to include the Length param-

eter; then click the OK button.

 7. Click the OK button in the Table dialog box, and place the table on the sheet.

 8. Right-click the 100 mm dimension at the top of the fl at pattern, and choose Edit. Select 

the Hide Dimension Value box, and then type Length in the text box below. Then click 

the OK button.

 9. Right-click the table and choose Edit, and then right-click the Member header in the table 

and select Format Column.

 10. Deselect the Name From Data Source box, enter Mark #, click the OK button, and then 

click the OK button again to return to the sheet. Your table should resemble Figure 12.39.

Figure 12.39

A tabulated iPart 

drawing

If you create a tabulated drawing in this manner and then add rows to the iPart/iAssembly 

table, your drawing table will automatically add the new row(s) as well. Rows can then be hid-

den in the table if needed simply by editing the table on the sheet and then right-clicking the 

row in the table editor and unselecting Visibility. You can close the fi le without saving changes.

Sharing Your Drawings outside Your Workgroup
Once your design is fully annotated, you can share the design documents with others in numer-

ous ways. Of course, the traditional hard-copy route is available from the Print tool, but there 
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are electronic means to share your Inventor drawings with people who do not have Inventor. 

The native fi le formats offer several possibilities. Inventor IPT, IAM, IPN, and IDW fi les can 

be viewed using the freely distributed Inventor View application. A version of this is already 

installed with Inventor but can be downloaded for free from the Autodesk website.

As mentioned earlier, if you use DWG as your drawing-fi le format, anyone with a copy of 

AutoCAD or AutoCAD LT ® 2007 software or newer can view, plot, and measure the Inventor 

drawing. There are object enablers on the Autodesk website that even allow older versions of 

AutoCAD to open Inventor DWG fi les.

Using the Publish tool you can generate a neutral DWF or DWFx fi le. The DWF or DWFx fi le 

can store both your 2D drawing and the 3D models referenced in the drawing. DWF fi les are 

viewed using Autodesk Design Review, which is available for download from the Autodesk 

website. To publish a DWF fi le, fi rst click the Inventor button (the large I in the upper-left corner) 

and then select Export ➢ Export To DWF.

You can fi nd any of the products mentioned earlier by going to www.autodesk.com or 

www.google.com and searching for one of these terms:

 ◆ Autodesk Inventor View

 ◆ Autodesk Object Enabler

 ◆ Autodesk Design Review

PDF is a popular publishing format that can be read by Adobe Acrobat Reader. You can save 

a PDF from Inventor using the Save Copy As option and changing the fi le type to PDF or by 

using Export ➢ Export To PDF. You can also download a number of PDF printer drivers that 

will allow you to print to PDF. Acrobat Reader is available for download from Adobe’s website: 

www.adobe.com.

There are some options for creating PDFs found by clicking the Options button in the Save 

Copy As dialog box when the fi le type is set to PDF. For instance, you might want to include 

all sheets in the PDF and create it in black and white. You can do so using the Options button. 

Unfortunately, you cannot confi gure these options to be the defaults.

You should note that the option to have the PDF viewer automatically open the PDF when it 

is created is a bit hidden and is set with the Publish options used when creating a DWF. To dis-

able the automatic view of PDFs, click the Inventor button (the large I in the upper-left corner) 

and select Export ➢ Export To DWF. Then uncheck the Display Published File In Viewer option.

Additional Resources
In addition to the step-by-step information and exercises in this chapter, there are tutorials that 

can be found by choosing the Get Started tab and looking in the Videos And Tutorials area.

Th e Bottom Line

Create templates and styles.  Inventor provides numerous methods to create, store, and 

use drawing templates and styles. Careful planning as to how and where to manage these 

resources is important. Consideration must be given to how templates are deployed on your 

network and whether to use the style library.

Master It  Rather than using one of the out-of-the-box drawing settings, you need to set 

up a drawing template, a drafting standard, and annotation styles to conform to a par-

ticular international, industry, or company drafting standard. How do you get started?

http://www.autodesk.com
http://www.google.com
http://www.adobe.com
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Utilize drawing resources.  Each Inventor drawing fi le contains a number of commonly 

used drawing-resource defi nitions, such as title blocks, borders, symbols and so on. These 

resource defi nitions allow you store preconfi gured items for quick and easy reuse.

Master It  You have blocks of general notes that you place on every drawing fi le. 

However, some drawings get one set of notes, and others get another, so making these 

notes part of the title block seems to be the wrong approach. Is there a way to handle this 

in Inventor? 

Edit styles and standards.  Inventor’s drawing styles and standards allow you to set up 

your dimension styles, layer styles, and so on in advance, so that you can maintain consis-

tency across all of your drawings.

Master It  You have set up your object defaults to use an inch-based dimension style, but 

occasionally you want to place a millimeter-based dimension. Can this be done easily or 

do you have to override the dimension style?

Create drawing views.  Drawing views allow you to make 2D views of your 3D models. 

The hidden line generation and alignment of your projected views are automatic, as are 

updates to the 2D views when your 3D models change. 

Master It  When placing a drawing view, the lines on curved edges don’t show up. Is 

there an option to turn these on?

Annotate part drawings.  Adding annotation to your part drawings is accomplished pri-

marily using the tools found on the Annotate tab. Many of these tools automate traditional 

drafting annotation, but you might still fi nd the need to add annotation in a more manual 

way.

Master It  You need to create sheet-metal fl at patterns for your parts with laser etch-

ing on them. Often this is text, but you’ve noticed that if you attempt to create text as an 

extrusion on the part, you end up with a stencil effect, rather than single-line characters 

used for etching. Is there a way to do this?

Annotate assembly drawings.  Often, much of the annotation created for assembly draw-

ings concerns bill of materials information, but you can use most of the same annotation 

tools used for part drawings in an assembly drawing.

Master It  You created a section view of your assembly model and then noticed that you 

could hide the hatch pattern by right-clicking it and choosing Hide. But now when you 

right-click the drawing view, you can’t fi nd an option to bring back the hatch pattern. Is 

gone for good? 

Work with sheet-metal drawings.  Inventor sheet-metal drawings give you access to the 

folded model and the fl at pattern, provided that a fl at pattern has been created in the 3D 

model.

Master It  When you place a bend note on a fl at pattern drawing, it places the direction, 

angle, and bend radius. Your shop is accustomed to seeing only the direction and angle. 

Is there a way to remove the bend radius?

Work with weldment views.  Weldment views offer some extra functionality over standard 

assembly views in that they allow you to document your assembly in each weldment stage.
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Master It  You want to create a drawing package that shows all of the weldment pieces 

in the prepped stage and then show the weldment assembly in the completed form. 

What’s the best way to do this?

Work with iParts and iAssembly drawings.  One of the benefi ts of creating part and 

assembly families as iParts and iAssemblies is the ability to created tabulated drawings that 

show each member and its key dimensions in a table.

Master It  You’ve created an iPart table and want to set the dimension on the sheet to 

match the table heading. Is this possible?

Share your drawings outside your workgroup.  You can save your drawings in DWF, 

DWFx, and PDF formats in order to share them with people who do not have Inventor. You 

can use Autodesk Design Review to access DWF fi les and Adobe Acrobat Reader to access 

PDF fi les; both are free viewer applications.

Master It  You have a multi-page Inventor drawing, but when you export it as a PDF fi le 

you only get the fi rst page. Is this a bug, or is just the way it is?





Chapter 13

Tools Overview

Using the various Autodesk® Inventor® tools effectively helps you improve your productivity 

and get the most out of the program. In this chapter you will explore many of the tools that 

are included with your Inventor installation. Some of these are located within Inventor itself 

and others are external applications. Initially, a certain amount of familiarity is required to be 

productive with these tools; however, spending the time to become familiar with them pays off 

in the long run. Most of the topics in this chapter do not apply to the Autodesk® Inventor LT™ 

program.

This chapter assumes you have a good understanding of parts, assemblies, and drawings. 

You will learn about the various aspects of Inventor tools and about some of the add-ins. You’ll 

look at the key aspects of the tools and add-ins that come with Inventor as well as relevant 

workfl ows. Many other tools can be built using the application programming interface (API). 

Although the API is not covered in this book, you can fi nd a great deal of information online 

about using it to develop your own tools.

This chapter covers a number of tools, including the BIM Exchange, AutoLimits, Design 

Assistant, Drawing Resource Transfer Wizard, style tools, Supplier Content Center, the Task 

Scheduler, the iProperties tool, the Measure tool, the Customer Involvement Program (CIP), 

customer error reporting (CER), and more.

In this chapter, you’ll learn to:

 ◆ Take your models from Inventor to the Autodesk Building Systems program

 ◆ Create AutoLimits (design sensors)

 ◆ Manage design data effi ciently using Inventor tools

 ◆ Manage styles

 ◆ Create expressions with iProperties

 ◆ Give feedback to Autodesk

Exploring the BIM Exchange
The Building Information Modeling (BIM) Exchange is an add-in environment for parts and 

assemblies. Using the BIM Exchange, you can import Inventor models into AutoCAD® MEP and 

Autodesk® Revit® MEP, which are Autodesk products used for building design and construc-

tion systems. The MEP products are used to document the mechanical, electrical, and plumbing 
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information of the designs. To access the BIM Exchange environment, you must fi rst have a part 

or an assembly fi le open and then select the Environments tab and click BIM Exchange. 

Assembly Model Simplifi cation
Typically, when you author an Inventor model for use with a building systems application (such 

as Revit, for example), you will want to reduce the amount of detail in that model so the fi le size 

is smaller and so you are not giving away too much intellectual property. You can start with an 

assembly fi le and use the Simplify tools to prepare your model for exporting and sharing with 

BIM applications. To access these tools you can click the Simplify tab in the assembly environ-

ment, where you will fi nd the following tools:

Include Components  Use this tool to create a view representation using only the selected 

components. You can then choose this view representation to create the exported BIM model. 

For instance, you might use this tool to select only the externally visible components of a 

condensing unit assembly, to prepare it for use in Autodesk Revit MEP. The result would be 

a new view representation created in the Representations folder of the browser and named 

something like Simple View1. To edit the resulting view representation, you simply right-

click it in the browser and choose Edit Include Components.

Defi ne Envelopes  Use this tool to replace an assembly component with a rectangular or 

cylindrical bounding box. For instance, you might use this to remove extra detail for com-

ponents such as fasteners. Defi ning the envelope of a bolt allows a model to be used for fi t 

checks and sizing where, for example, a protruding bolt head might be important, while at 

the same time it greatly reduces the number of model faces and edges the component is made 

up of.

Create Simplifi ed Parts  Use this tool to create a simplifi ed part fi le from an assembly 

view by referencing the current view representation. For instance, if you used the Include 

Components tool to create a view representation of just the externally visible components of a 

condensing unit assembly, you could then use the Create Simplifi ed Part tool to combine the 

remaining visible components into a single part model.

Exploring the Include Components Tool

If you have not already downloaded the Chapter 13 fi les from www.sybex.com/go/

MasteringInventor2014, please refer to the “What You Will Need” section of the Introduction 

for the download and setup instructions.

Once you’re sure you have the Chapter 13 fi les in place, follow these steps to see the Include 

Components tool in action:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_13a_014.iam in the Chapter 13 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. From the Simplify tab click the Include Components button.

http://www.sybex.com/go
http://www.sybex.com/go/MasteringInventor2014
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 4. In the tool controls, locate the Select All Occurrences button and click it. When it’s 

selected, you’ll see a check mark next to the button, as shown in Figure 13.1.

Figure 13.1

Th e Select All 

Occurrences button 

in the tool controls

 5. Next, use the browser to locate and select all of the components except the ones named:

 ◆ mi_13a_Clip

 ◆ mi_13a_Washer

 6. Once your selection is complete, use the tool controls to toggle the view control to View 

Excluded. The result should turn off all of the components, except the ones listed in 

step 5.

 7. Next, use the tool controls to toggle the view control to View All, and then click the OK 

button (the green check mark button) to create the simplifi ed view representation. The 

results are shown in Figure 13.2.

Figure 13.2

Th e resulting 

simplifi ed view 

representation

 8. Expand the Representations folder in the browser if required, and locate the node for 

the active, simple view representation. It will have a check mark next to it.

 9. Right-click the simple view representation and choose Edit Include Components, to bring 

back the Include Components tools.

 10. Hold the Ctrl key on the keyboard and click the components named mi_13a_4035 to 

exclude them from the simplifi ed view representation, and then click the OK button in 
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the tool controls to update the simplifi ed view representation. The results are shown in 

Figure 13.3.

Figure 13.3

Th e fi nal simplifi ed 

view representation

In this example the resulting simple view representation is not really that much simpler, but 

you’ve explored the methods used to create and updated a simplifi ed view representation using 

the Include Components tool. You can close the current fi le without saving changes and con-

tinue to the next section.

Exploring the Define Envelopes Tool

The Defi ne Envelopes tool can be used to reduce the number of faces and edges present in an 

assembly model, which will help reduce the fi le size of the BIM export version. You can follow 

these steps to see the Defi ne Envelopes tool in action:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_13a_016.iam in the Chapter 13 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. From the Simplify tab click the Defi ne Envelopes button.

 4. In the tool controls locate the Select All Occurrences button and ensure that the check box 

is selected.

 5. Find an instance of the cap screw named mi_13a_4762 and select it.

 6. In the tool controls, locate the Bounding Box/Bounding Cylinder control and change it to 

Bounding Cylinder, as shown in Figure 13.4.

Figure 13.4

Creating a bound-

ing cylinder
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 7. Use the grip arrows to adjust the size of the bounding cylinder to your liking.

 8. Click the Apply button (it looks like a green plus sign) found in the tool controls to defi ne 

the bounding envelopes for the screws.

 9. Notice that the browser nodes for both of the mi_13a_4762 components are gray, indicat-

ing that they have been hidden. And notice, too, that a browser node named Envelope1 

has been created to represent the screws.

 10. Select one of the mi_13a_Bushing components and set it to use a bounding box, and then 

click the OK button to create the bounding boxes for both bushings, as shown in 

Figure 13.5.

Figure 13.5

Th e resulting 

envelopes

You’ll notice that a new envelope is created in the browser for the bushing components. If 

you need to modify the envelope, you can right-click it and choose Edit Envelope, Delete, or 

Show Original. Feel free to experiment with the Defi ne Envelope tool to see how you can use 

it to reduce the details of other components in the assembly. When you have fi nished, you can 

close the current fi le without saving changes and continue to the next section.

Exploring the Create Simplified Part Tool

The Create Simplifi ed Part tool can be used to derive the active assembly fi le into a new part fi le, 

using the current view representation and any component envelopes that might be present. You 

can follow these steps to create a derived part using the Create Simplifi ed Part tool:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_13a_018.iam in the Chapter 13 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. From the Simplify tab click the Create Simplifi ed Part button.

 4. Use the Combine Style buttons to select a Solid Body style. This option handles how the 

components of the assembly will be combined as solid bodies in the resulting derived 

part fi le. If your goal is to reduce the amount of intellectual property in the fi le you 
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provide others, you’d want to use the leftmost button to merge the seams between solid 

bodies and make it more diffi cult for the fi le you create to be used to reverse-engineer the 

design.

 5. Enter Simple_mi_13a_018 in the New Component Name input.

 6. Accept the default value for the template fi le, or use the Browse Templates button (it looks 

like a blank sheet of paper) to select a different part fi le template.

 7. Set the New File Location path to the Chapter 13 directory of your Mastering Inventor 

2014 folder, and then click the OK button. Figure 13.6 shows the Create Simplifi ed Part 

dialog entries and selections.

Figure 13.6

Creating a simpli-

fi ed part

 8. Examine the browser in the resulting new part fi le to fi nd the derived assembly node and 

extrusion features for each assembly-level envelope, as shown in Figure 13.7.

Figure 13.7

Th e simplifi ed 

derived part

The simplifi ed derived part behaves the same as any other derived part, which means that 

edits to the original assembly fi le are carried through to the simplifi ed part version unless you 

right-click the derived assembly browser node and choose to suppress or break the link to the 

base component. Keep in mind that, at this point, your new simplifi ed derived part exists only 

in the current Inventor session and has not yet been saved to disk. If you’d like to explore the 

link between the original fi le and the simplifi ed fi le, you can save both fi les now. Otherwise, you 

can close the current simplifi ed part fi le and the original assembly fi le without saving changes 

and continue to the next section.
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Part Model Simplifi cation
In addition to the tools available to simplify assembly models, you can also use the BIM Feature 

Recognition and Simplify tools in the parts environment to reduce details that are not needed 

for BIM models, and you can use the Recognize Revit Features tools to make your models 

friendlier to Autodesk Revit.

Simplify Part Models

One of the issues with handing part models created in Inventor to the BIM user is that the 

models often contain cosmetic or manufacturing features that are important in the mechani-

cal design, but are not required for the BIM layout and planning application. For example, if 

you create a model of a machined part in Inventor, you will likely need to include and specify 

rounded edges, holes, and other features as part of the mechanical design. However, these fea-

tures are not important to the BIM user and can slow down the BIM application. So to help with 

this, Inventor includes part simplifi cation tools to remove detail and voids, as well as reduce the 

number of faces and edges in a part model.

Parametric Features Beware

It’s important to understand that the Simplify tools will strip your part of parameter-driven fea-

tures and convert the model to a static base solid. Th erefore, it might be best to save a copy of your 

original model and use the copy to simplify parts.

These Simplify tools can be found by going to the Environments tab and clicking the BIM 

Feature Recognition button. The Simplify tools include the following:

Remove Details  Use this tool to reduce the number of faces and edges by removing small 

cosmetic fi llets and chamfers as well as any other face selections you decide to remove.
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Fill Voids  Often a part contains holes and pockets that are meaningful in the mechani-

cal design but are not important in BIM layout. You can use this tool to select and fi ll these 

voids in order to reduce the number of edges and faces, and therefore simplify the model’s 

geometry.

Defi ne Envelopes  Use this tool to reduce the number of faces and edges of complex fea-

tures in order to make part models easier to work with. For instance, you might represent a 

highly intricate machined feature with a simple bounding box.

Recognize Revit Features

Many Inventor users create models to be used in Autodesk Revit libraries. To assist with this, 

it can helpful to set up the model so that it imports into Revit smoothly and predictably. You 

can make your models more “BIM ready” by using the Recognize Revit Features tools. Once 

features are recognized, you can enter the BIM Exchange environment to author the model for 

Revit export.

Recognize Extrude  Recognizes Inventor extruded features and converts them to extrusions 

recognized by Revit

Recognize Revolve  Recognizes Inventor revolved features and converts them to revolu-

tions recognized by Revit
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Recognize Sweep  Recognizes Inventor swept features and converts them to sweeps recog-

nized by Revit

Auto Recognize  Automatically recognizes Inventor extruded and revolved features and 

removes fi llets and chamfers

Model Authoring
The BIM Exchange environment allows you to author Autodesk Revit family data in your 

Inventor model and create connector objects such as cables, conduits, ducts, and pipes on the 

simplifi ed model. These connector objects defi ne the interfaces, which are the connection points 

between Inventor and the BIM model. Inventor allows you to create, edit, and delete connector 

objects. Here are the steps to create a conduit connector:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_13a_444.ipt in the Chapter 13 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. Select the Environments tab, and click the BIM Exchange button.

 4. From the MEP Author panel, click the Conduit Connector button.

 5. In the Conduit Connector dialog box, select Circular as the shape for the connector (using 

Undefi ned allows you to select any oval, circular, or rectangular face).

 6. Select the yellow circular face to place the connector. The location of the connector 

appears as a cylindrical arrow. Click the direction button to reverse the connector direc-

tion so that it points out away from the box.

 7. Click the check box in the Size fi eld and enter a value. Or you can leave the check box 

deselected to have the value linked to the model.

 8. In the Connection Type drop-down menu, select Threaded.

 9. Click the OK button to create the connector. Figure 13.8 shows the Conduit Connector 

dialog box.

Figure 13.8

Adding a conduit 

connection
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 10. Use the Pipe Connector button on the MEP Author panel to add a supply pipe connection 

to the blue circular face. Take a moment to explore the System Type options, and author 

this connection with a type and property values of your choice.

 11. Use the Duct Connector button on the MEP Author panel to add an exhaust duct con-

nector to the rectangular face on the top of the unit. Again, set the properties to values of 

your choice and explore the options available.

 12. Expand the MEP System Connections folder in the browser, as shown in Figure 13.9, and 

you’ll fi nd all of your connections categorized in subfolders. You can edit, delete, and 

suppress connectors as needed.

Figure 13.9

MEP system con-

nections in the 

browser

Feel free to create new connections to explore these tools further. When fi nished, you can 

close the fi le without saving changes.

Model Publishing
A part in the BIM Exchange is the basic unit, that is, a specifi c size of the component placed 

within a part family. The part has instance-specifi c properties associated with it, such as a 

name and geometric representation. You can use the Export Building Components tool to save 

model geometry, properties, and connectors to an Autodesk Exchange File (*.adsk) or a Revit 

Family File (*.rfa). An ADSK fi le can be read by programs such as Revit MEP and Autodesk® 

AutoCAD® MEP. However, Revit Family Files are typically preferred by Revit users because 

they provide a more direct handoff of the library data.

When publishing a model it’s often useful to set up the user coordinate system (USC) to 

match the destination coordinate orientation so that the models do not import upside down 

or fl ipped over. You can do this in the BIM Exchange environment by creating a UCS and then 

specifying its use when exporting the data.

In the following exercise you will set up a model to be exported from Inventor and imported 

into Autodesk software. Follow these steps to publish a model in the BIM Exchange tools:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_13a_445.ipt located in the Chapter 13 directory of your Mastering 

Inventor 2014 folder, and then click the Open button.

 3. Choose the Environments tab, and then click the BIM Exchange button. Note that the 

connectors have been authored already. Do not be too concerned that this exercise model 

Certification
Objective
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is not realistic in its confi guration; its purpose is merely to demonstrate the available 

tools.

 4. Click the UCS button in the BIM Exchange tab to defi ne a new user coordinate system.

 5. Specify the origin by choosing the vertex at the corner indicated with the black arrow, as 

shown in Figure 13.10.

Figure 13.10

Creating a new user 

coordinate system

 6. Specify the x-axis by choosing the corner near the black X, and specify the y-axis by 

choosing the corner near the black Y.

 7. Notice the new UCS node in the browser. You can rename it by clicking it twice slowly.

 8. Click the Check Design button, and notice the listing of information. The green check 

marks indicate that the information required is present. Yellow check marks warn you if 

some information is missing. Click the OK button.

 9. Click the Check Feature button, and wait for the *.html report to open in your web 

browser.

In the Feature Check Report you’ll see that there is an error with the feature called Base2. 

To resolve this you could exit the BIM Exchange environment and use the BIM Feature 

Recognize tool to convert Base2 into extrude features that Revit will recognize. For now, 

though, you can ignore the error, close the report, and continue on.

 10. On the BIM Exchange tab, click the Export Building Components button.

 11. To set the component type, click the Browse button.

 12. Choose the following selections from the drop-down menu using the plus buttons to 

expand the selections:

 ◆ 23.75.00.00 Climate Control (HVAC)

 ◆ 23.75.70.00 HVAC Distribution Devices
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 ◆ 23.75.70.17 Water Heated And Cooled

 ◆ 23.75.70.17.34 Unit Heaters

 13. Click the OK button.

 14. Enter the following information in the Component Properties area. All iProperty fi elds 

pulled from the model have a cyan-colored background. When the Model Property 

option is selected, model properties are exported with the component. You can clear this 

if you do not want to include this information.

Description  Enter Climate Control Unit Heater.

Manufacturer  Enter MI, Inc.

Model  Enter 12345–6T.

 15. Choose a user UCS from the Orientation drop-down.

 16. Change the File Type drop-down at the top of the dialog box so that it is set to Autodesk 

Exchange Files (*.adsk).

 17. Set the Thumbnail option to Import From File, and then click the Import button to browse 

for the fi le called Unit Heater 1200 Series.png, found in the Chapter 13 folder.

 18. When the thumbnail is set, click the Apply Changes button.

 19. Click the OK button in the Export Building Components dialog box to save an ADSK fi le 

(you can click Cancel and choose not to save this fi le if you’d like).

A Typical Scenario for the BIM Exchange

Say your company uses Inventor and specializes in electrical and mechanical designs, and that you 

supply the air conditioner for a building being designed by an architectural fi rm. To minimize the 

risk of losing information and future rework, you meet with the architectural and construction 

fi rms to ensure that the interfaces between your product and the building are all agreed on. Th e 

architects and contractors do not care about any internal details of the air conditioner unit and 

actually prefer having a lightweight model that will not add extra overhead to the Revit model, but 

they are extremely sensitive to any changes in the interfaces between your product and their work.

Th e plan is to author your model and interfaces in Inventor and send the design to the architectural 

fi rm so that they can use your model to know exactly the dimensions and locations to tie into. 

Although you can output the fi les from the BIM Exchange tools to Revit users as is, it becomes 

apparent that having your products authored in Revit format will allow Revit designers to specify 

your products in their designs more quickly and accurately.

Depending on the relationship you have with the architectural fi rm, you may be able to trade the 

simplifi ed models that you output from the BIM Exchange tools in return for the fully functional 

and tested Revit family fi les to be placed on your company’s website for download by other fi rms 

that would like to specify your product line in their designs. If the architectural fi rm does not have 

the time to do this for you, it may be determined that hiring outside help to test and verify Revit 

fi les is the way to go.
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Using AutoLimits
The AutoLimits tool allows you to monitor model changes so that you can reduce errors and 

engineering changes. You can think of it as a sensor. For example, say you are a plastics manu-

facturer and want to analyze the situation when the wall thickness of the components becomes 

too thin, or perhaps you are a machinist and want to know when two holes come too close to 

one another. You want to defi ne this “check” and ensure that such a situation is caught early in 

the design. With AutoLimits, you can set up these limits and let the system warn you.

The AutoLimits that you create with the tool are passive and do not drive geometry or stop a 

feature from violating a limit. They simply notify you when it does. Another way to look at the 

AutoLimits tool is as a persistent Measure tool. With the standard Measure tool, the result of 

a measurement and is not saved, whereas with the AutoLimits tool the measurement persists. 

When you open a fi le, the AutoLimits you have created are not shown unless you activate the 

AutoLimits panel bar.

The AutoLimits tool monitors the following limits:

Dimensional  Length, Distance, Angle, Diameter, Minimum Distance

Area-Perimeter  Area, Perimeter

Physical Property  Volume, Mass

Figure 13.11 shows the AutoLimits tool icons as accessed from the AutoLimits panel of the 

Inspect tab. If you do not see the AutoLimits tools on the Inspect tab, navigate to the Tools tab 

and click the Add-Ins button. Click AutoLimits in the Add-Ins list, and then select the Loaded/

Unloaded check box at the bottom of the dialog to load the AutoLimits tools. You can select the 

Load Automatically check box to have Inventor load them for you on startup.

Figure 13.11

AutoLimits access

Feedback is given to the user in terms of shape and color, as in the following examples:

 ◆ A green circle means it is within the boundary limit.

 ◆ A yellow inverted triangle means it is near the boundary limit.

 ◆ A red square means it is beyond the limit.

Figure 13.12 shows the different types of AutoLimits and their settings. (Click the AutoLimits 

Settings button shown in Figure 13.11 to access this dialog box.) You can control the visibility 

of each AutoLimits type by using the On and Off radio buttons. In an assembly, only the edited 

document’s AutoLimits are visible in the browser; in other words, AutoLimits at subassembly 

levels are not visible or available unless that subassembly is edited.

To see AutoLimits in action, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_13a_002.ipt located in the Chapter 13 directory of your Mastering 

Inventor 2014 folder, and click the Open button.
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Figure 13.12

Th e AutoLimits 

Settings dialog box

 3. On the Inspect tab, click the AutoLimits Settings button, ensure that all three Default 

Visibility options are enabled, and then click the OK button. This part has a layout sketch 

on which the solid was based. The length has been left undefi ned by creating the visible 

driven dimension. Two AutoLimits have been added. The fi rst alerts you if the distance 

from the front edge to the rectangular cut becomes too thin, and the second alerts you if 

the mass of the part becomes too heavy. To adjust the model, follow these steps:

 A. Click the sketched point or construction line, and drag in or out.

 B. Use the Update button (select it from the Quick Access bar) to see the edit take place.

 4. Drag the sketch point out so that the visible dimension is around 470, and click the 

Update button. Note the red square in the middle of the part. This is the Mass AutoLimit, 

indicating that the current length causes the part to be too heavy.

 5. Drag the sketch point in so that the visible dimension is less than 300, and click the 

Update button. Note the red square on the edge of the part; this is a lower limit, Length 

AutoLimit, indicating that the current overall length causes the width between the rect-

angular cut and the edge of the part to become too thin.

To see these AutoLimits in the browser, you can click the white arrow on the browser bar and 

change from the Model browser to the AutoLimits browser (you might need to use the Refresh 

button on the AutoLimits panel fi rst). Once you’ve explored these existing AutoLimits, you can 

close this fi le without saving the changes and continue on to create AutoLimits.

Loading AutoLimit Tools

When you load a fi le that contains existing AutoLimits, the AutoLimits tools are not loaded or dis-

played in that fi le until you use an AutoLimits tool. A quick way of doing this is to use the Refresh 

button found on the AutoLimits panel.
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Creating AutoLimits
AutoLimits come in three types: Dimensional, Area-Perimeter, and Physical Properties. In the 

following steps, you’ll create a Minimum Distance limit and then defi ne the limit boundaries:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_13a_003.ipt located in the Chapter 13 directory of your Mastering 

Inventor 2014 folder, and click the Open button.

 3. On the Inspect tab, click the AutoLimits Settings button.

 4. Set all three default settings to On, and click the OK button.

 5. Click the Dimensional button in the AutoLimits panel.

 6. On the left of the dialog box, click the Minimum Distance AutoLimits button (the last one 

on the bottom).

 7. For the selections, you can click the edges with work axes running through them, or you 

can click the axes (the axes are not required and have been placed just to help identify the 

correct edges).

 8. Click the Boundary tab.

 9. Click the Click To Add bar to place the green target AutoLimit.

 10. Set the Lower value to 50 mm.

 11. Rather than setting an Upper value, you will change the USign column so that the Upper 

limit is open-ended. Click the < under USign, and choose the blank or empty entry from 

the drop-down.

 12. You want to add another row to defi ne the lower limits. To do so, hold down the Ctrl key, 

and click the Click To Add bar. The new row should appear above the previous row in the 

table.

Setting AutoLimits Boundaries

Hold down Alt and click the Click To Add bar before you add any boundaries. Th is will place all 

fi ve boundary levels at once, allowing you to defi ne the green “target” boundary as well as a yellow 

“warning” and a red “danger” boundary on each side of the target.

Clicking the Click To Add bar always adds an upper boundary unless the green target boundary 

has been set to have no upper value. Clicking the Click To Add bar while holding down the Ctrl key 

always adds a lower boundary unless the green target boundary has been set to have no lower value.

You can add as many ranges as required when using the standard Click To Add or Ctrl-click methods; 

however, you can have only one range (fi ve boundaries) when using the Alt-click method.

 13. Click the yellow triangle twice slowly in the Level column, and change it to the red 

square in the drop-down.
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 14. Set the Upper value to 49.999 mm.

 15. Change the LSign column so that the lower limit is open-ended. Click the < under LSign, 

and choose the blank or empty entry from the drop-down. Your boundary defi nition 

should resemble Figure 13.13.

Figure 13.13

Th e Dimensional 

AutoLimits dialog 

box

 16. Click the OK button, and then click the OK button in the message dialog box.

 17. You should see a green dot appear on your model; this is your AutoLimit.

 18. Double-click the Length dimension, and change the value to 299 mm.

 19. Click the Update button (select it from the Quick Access bar) to see the edit take place. 

Note that the AutoLimit displays the red square, indicating that the distance is now 

below the value set as acceptable.

 20. Change Length Dimension to 300 mm, and click Update. Note that the AutoLimit dis-

plays a gray X. This indicates that there is a gap in the AutoLimit.

 21. Hover your mouse pointer over the gray X until it changes color; then right-click and 

choose Edit AutoLimits.

 22. Click the Boundary tab.

 23. Select the Lower limit for the green row, change 50 mm to 49.9999 mm, and then click 

any other cell. Note that it sets the value back to 50.000 mm.

 24. Click the OK button to return to the model, and note that the AutoLimit is now green, as 

shown in Figure 13.14.

AutoLimits are quite simple to set up and use. You can continue experimenting with this fi le 

and create other types of AutoLimits. Then you can close the fi le and continue on.
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Figure 13.14

Length AutoLimits

Editing AutoLimits
You can view all the existing AutoLimits in your model by clicking the white arrow on the 

browser bar and changing from the Model browser to the AutoLimits browser. You can edit 

AutoLimits in the AutoLimits browser by selecting an AutoLimits entry and right-clicking it. 

I recommend that you set the selection fi lter to Feature Priority because doing so makes it easier 

to select the AutoLimits glyphs. You can copy or delete AutoLimits by right-clicking them in the 

browser and choosing the appropriate command.

You can also create a group of AutoLimits to control the visibility of related AutoLimits. To 

do so, follow these steps:

 1. Right-click the top node in the AutoLimits browser, and select Create Group.

 2. Right-click any AutoLimit, and choose Copy AutoLimit.

 3. Right-click the group, and choose Paste AutoLimit.

 4. Now you can right-click the group to toggle visibility.

Don’t Go Crazy with AutoLimits

In an assembly, use only the minimum number of AutoLimits required to monitor just the critical 

design information of interest. Using more than 10 AutoLimits can begin to impact the process-

ing speed of your model. You can use AutoLimits in all environments except the Inventor Studio 

environment, the BIM Exchange, Dynamic Simulation, the construction environment, Solid Edit, 

the Flat pattern environment, and Engineer’s Notebook.

Using the Design Assistant
The Design Assistant helps you fi nd, manage, and maintain Inventor fi les and related docu-

ments, spreadsheets, and text fi les. Imagine your company is evaluating a new design that 

involves making minor changes to an existing design. You would like to reuse the parts, 
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assemblies, drawings, and presentations as much as possible. Once you make the required 

changes and fi nish the new design work, you need to send the existing and modifi ed designs to 

another department for their input on the overall design. The Design Assistant and Pack And 

Go tools can help in this scenario. You can perform searches, create fi le reports, and work with 

links across Inventor fi les. In addition, you can preview and view the iProperties.

You can launch the Design Assistant in any of three ways:

 ◆ Within Inventor, while a fi le is open click the Inventor button and choose Manage ➢ Design 

Assistant.

 ◆ Right-click a fi le in Windows Explorer, and select the Design Assistant tool.

 ◆ Select Start ➢ All Programs ➢ Autodesk ➢ Autodesk Inventor 2014 ➢ Design Assistant 2014.

Managing Files in the Design Assistant

Note that the Manage button will not be visible if you open the Design Assistant from an actively 

open fi le in Inventor. To manage the links, you must open the fi le from the Design Assistant directly 

or via Windows Explorer, and they cannot be open in Inventor while you do this.

The Design Assistant dialog box, shown in Figure 13.15, contains three buttons in the left 

column: Properties, Preview, and Manage. You can open fi les using File ➢ Open. Figure 13.15 

shows the result of selecting File ➢ Open in an assembly named Demote_Stapler.iam. The 

assembly is listed in the left pane, and all parts related to the assembly are listed in the right 

pane.

Figure 13.15

Th e Design 

Assistant dialog box

You can right-click any fi le in the Design Assistant and select View With Inventor View 1.0, 

which launches the Inventor View dialog box, shown in Figure 13.16. In this dialog box, you can 

use view functions such as Zoom, Pan, and Rotate.



USING THE DESIGN ASSISTANT | 639

Figure 13.16

Th e Inventor View 

dialog box

Using the Inventor View Dialog Box

Autodesk Inventor View is a lightweight version of Inventor that can be used to view models and 

drawings. You can access it from the Design Assistant or from the Windows Start menu, or you can 

simply right-click a fi le in Windows Explorer and select View With Inventor View. Th is application 

is especially useful for nonengineering users who might need to view and print models and draw-

ings, but do not have the authority to edit or create models. Th e program can be downloaded from 

the Autodesk site and installed on a computer without installing Inventor.

To view the preview in the Design Assistant, you can click the Preview button in the Design 

Assistant dialog box, shown in Figure 13.17. The Design Assistant shows the preview for all the 

fi les. The fi gure shows the preview of the top-level assembly and one of the parts contained in 

the assembly. You can choose any listed fi le to display its preview.

Figure 13.17

Th e Preview but-

ton in the Design 

Assistant dialog box
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Using the Find Files Tool
You can use the Find Files tool to locate all references to a specifi ed fi le. This can be very use-

ful when you are trying to determine how an edit, revision, or change order will affect existing 

designs. To use the Find Files tool, follow these steps:

 1. Click the Manage button in the left column, as shown in Figure 13.18.

Figure 13.18

Using the Find Files 

function

 2. Click the Drawings, Assemblies, and Parts check boxes. These check boxes are located 

next to the text Include Files Of Type in the Design Assistant dialog box (only two are 

shown in Figure 13.18).

 3. You can check Search Subfolders, shown next to the Parts check box in the Design 

Assistant dialog box, to include subfolders.

 4. Find Files will fi nd the fi les that use the selected fi le. In Figure 13.18, 300-Channel—

Spring Clip.ipt has been selected, as is shown in the top pane (the .ipt fi le extension 

is not shown), and the referencing fi les found are listed in the bottom pane.

Right-clicking a fi le and selecting iProperties gives you the properties for the selected part or 

assembly without opening the part or assembly in Inventor, as shown in Figure 13.19. Note that 

you do this after clicking the Properties or Preview button; the iProperty option is not available 

from the Manage view.

Using the Where Used Tool
Selecting Tools ➢ Find ➢ Where Used shows all the fi les that use the current fi le. For example, to 

fi nd out which fi les use Assembly1.iam, you can do the following:

 1. Select Tools ➢ Find ➢ Where Used (in the Design Assistant dialog box). You will see the 

dialog box shown in Figure 13.20.

 2. Select options in the Where Used dialog box, such as Parts, Drawings, Include Subfolders, 

and so on.
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 3. Click Search Now.

Figure 13.19

iProperties in the 

Design Assistant

Figure 13.20

Th e Where Used 

dialog box

In the Path area under Look In, you can add paths that you want to search. The Where Used 

tool will list all the fi les where the specifi ed fi le is used in some way. File relationships can 

include but are not limited to derived components and using a part or assembly in an assembly, 

drawing, presentation, and so on. Figure 13.21 shows a Where Used search that has been run 

using the Design Assistant on a fi le in the local Vault workspace. However, the Design Assistant 

is often used without Vault.

Figure 13.21

Results of clicking 

Search Now in the 

Where Used dialog 

box
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Renaming, Copying, and Replacing Files
You can use the Design Assistant to perform management tasks such as renaming, copying, and 

replacing Inventor fi les without breaking the links to the fi les that reference them. This is because 

the Design Assistant not only performs the management task on the fi les, but also “cracks” the 

referencing fi les and updates the link to the fi le at the same time. This is the fundamental differ-

ence between doing these operations in Windows Explorer (generally not recommended) and 

doing them in the Design Assistant.

Renaming Files with the Design Assistant

To rename a fi le that is in an assembly, drawing, or presentation, follow these steps:

 1. Close Inventor.

 2. Open the assembly, drawing, or presentation fi le in the Design Assistant.

 3. Click the Manage button. In the Manage browser, click to select the component to be 

renamed. Right-click in the Action column, and select Rename. All occurrences of the 

component are highlighted.

 4. Right-click the Name column, and select Change Name. In the Open dialog box, change 

the name and select Open (you’re not really opening anything; you are just setting the 

name).

 5. Click Save to apply the changes.

Copying Files with the Design Assistant

To copy a fi le that is in an assembly, drawing, or presentation, follow these steps:

 1. Close Inventor.

 2. Open the fi le in the Design Assistant.

 3. Click the Manage button. In the Manage browser, click to select the component to be 

renamed. Right-click the Action column, and select Copy. All occurrences of the compo-

nent are highlighted.

 4. Right-click the Name column, and select Change Name. In the Open dialog box, enter the 

name of the new copy and select Open (you’re not really opening anything; you are just 

setting the name).

 5. Repeat steps 3 and 4 for all the fi les you want to copy. For instance, if you are copying 

a drawing and the part that this drawing details, you would complete steps 3 and 4 for 

both the drawing and the part.

 6. Click Save to create the copies. Your copies will be created right next to the original fi les.

This technique can be incredibly useful when you want to create a copy of an existing 

detailed design so that you can make changes to the copy. Create the copy of the drawing(s) and 

the components and then make the changes.
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Replacing Files with the Design Assistant

If you want to replace a part or assembly fi le with an assembly, you can right-click the Action 

cell and then select Replace. Right-click the Name cell for the component, and then click Change 

Name. In the dialog box, select the replacement fi le. After a fi le is replaced, renamed, or copied, 

other fi les that reference the original fi le need an update. The Update option will be useful, as 

shown here:

 1. Open the assembly fi le in the Design Assistant.

 2. Click Manage, and select fi les that are being modifi ed from the upper browser.

 3. In the lower browser, select the fi le types you want to include in the update.

 4. Click Find Files. The referencing fi les are displayed in the lower browser.

 5. Click the Save button to apply the changes.

The Design Assistant cannot make changes in certain circumstances. For example, it can’t 

make changes when the active project is set to Semi-isolated, when the design state of a fi le is 

set to Released, when read-only permissions are set, or when you’re trying to change the work-

group copy of the fi le.

The Design Assistant vs. Vault

Th e Design Assistant can make many of the changes discussed here, but if you fi nd yourself copy-

ing designs, changing fi lenames, and relinking projects often, you owe it to yourself to investigate 

Autodesk Vault. Vault can do all of these operations and much, much more.

Using Pack And Go
You can use the Pack And Go tool to package an Inventor fi le, such as a top-level drawing or 

assembly, and collect all of its referenced Inventor fi les in a single location. This is a useful fea-

ture for archiving a design and all the fi les related to the design into a single ZIP fi le. For exam-

ple, suppose you had the following assembly:

 ◆ Assembly1.iam

 ◆ Part1.ipt

 ◆ Part2.ipt

 ◆ Part3.ipt

The problem is that you are not sure what directories the part fi les are in. Pack And Go can 

fi nd all the parts for Assembly1.iam and copy them into a new directory. You can then zip the 

fi les in that new directory to be archived or sent to other users. You can access the Pack And Go 

tool by right-clicking in Microsoft Windows Explorer or from a Design Assistant session started 
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outside Inventor. Click the Properties or Preview tab, and right-click the assembly to access the 

Pack And Go tool.

To use Pack And Go on an assembly, follow these steps:

 1. Click the Inventor button and choose Save As ➢ Save As Pack And Go. This will open the 

Pack And Go dialog box.

 2. Set the destination directory to the folder in which you want to copy the fi les.

 3. If you have multiple project fi les, use the Browse button to ensure that you are looking at 

the proper one.

 4. Click the More button to display more Pack And Go options, as shown in Figure 13.22 

(once clicked, the More button toggles to the Less button).

Figure 13.22

Th e Pack And Go 

dialog box

 5. Click Search Now to fi nd the IPT and IAM fi les that are referenced by the assembly fi le. 

They will appear in the Files Found section at the bottom of the dialog box.
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 6. This fi nds all the fi les referenced by the assembly fi le, but what if you know that the 

assembly and part fi les have drawings detailing them? To search for referencing fi les, 

click the Search Now button in the Search For Referencing Files area.

 7. If fi les are found, you can select which ones to add and then click the Add button. Note that 

there is no progress bar in this dialog box, so you have to watch the top of the dialog box 

and wait for “Found # fi le(s)” to appear to know that it is done, as shown in Figure 13.23.

Figure 13.23

Pack And Go refer-

encing fi les found

 8. Click the Start button to start the copying process. Once the fi les are copied, the Cancel 

button turns into a Done button to let you know.

Typically you will want to confi gure some of the options because these will yield different 

Pack And Go results:

Copy To Single Path  Copies the referenced fi les to a single folder, reducing folder hierar-

chies. If any fi les have the same fi lename, only one of the fi les can be placed at the destination 

folder.

Keep Folder Hierarchy  Preserves the folder hierarchy under the destination folder. Use 

this option for round-trip fi le transfers such as sending fi les to a contract worker or customer 

or when you are packing fi les to work on a laptop while offsite. Maintaining the folder hier-

archy will allow you to move the fi les back to the original destination smoothly when they 

return.

Model Files Only  Copies only Inventor fi les (with fi lename extensions .iam, .ipt, .idw, 

.dwg, and .ipn) to the destination folder. Referenced fi les such as spreadsheets, embedded 

pictures, and text fi les are not copied.

Include Linked Files  Includes referenced fi les such as spreadsheets, embedded pictures, 

and text fi les.

Skip Libraries  When this is selected, all fi les found in a library path, such as Content 

Center fi les and user-defi ned library fi les, are excluded from the Pack And Go tool.

Collect Workgroups  If this is selected, workgroups and the workspace are collected into a 

single folder. This is typically relevant only when working with a legacy project type.

Skip Styles   If this is selected, style XML fi les are not copied with the packaged fi le.

Skip Templates  Templates are not copied with the Pack And Go fi les when this option is 

selected. You can generally use this option and deselect it only for special circumstances.
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It is important to note that Pack And Go does not modify the source fi les. When you package 

Inventor fi les, they are copied to the new destination. A log fi le and a copy of the original project 

fi le with a .txt suffi x are also copied to the destination folder. Changes made to the packaged 

fi les do not affect source fi les.

Here are some common uses for Pack And Go:

 ◆ Archiving so that you can package fi les on a CD or DVD.

 ◆ Sending fi les to another user.

 ◆ Separating the referenced fi les from other fi les in the same source folders.

 ◆ Copying an assembly to a new location and then creating a design variant by making 

changes to the copy. The original is unaffected.

Using Pack And Go as a Cleanup Tool

Pack And Go can be useful as a project cleanup tool. Often, a project folder will become cluttered 

with numerous unused fi les. Use Pack And Go on the top-level drawing or assembly and copy all 

the fi les to a secondary location. Th en delete the contents of the original folder and replace them 

with the cleaned-up copies.

Pack And Go uses the active project fi le. You can change the active project fi le. If you have 

fi les in multiple locations, the project fi le must specify all those locations.

Using the Drawing Resource Transfer Wizard
The Drawing Resource Transfer Wizard helps copy drawing resources such as borders, title 

blocks, and sketched symbols from one source drawing to one or more destination drawings. To 

use the tool, you have to close Inventor just to avoid a situation where you are in the middle of 

modifying a drawing and you want to use that drawing as part of the process for transferring 

resources.

For example, imagine your company has hundreds of drawings in Inventor. However, there 

has been a change in the standard note that is on every drawing. If the standard note was cre-

ated as a sketched symbol, this update can be batched. The transfer wizard is an ideal solution 

to solve this kind of problem.

Follow these steps to use the wizard:

 1. Select Start ➢ All Programs ➢ Autodesk ➢ Autodesk Inventor 2014 ➢ Tools ➢ Drawing 

Resource Transfer Wizard.

 2. On the welcome screen, click Next.

 3. On the Select Source Drawing And Resources screen, select the drawing template, and 

then click the OK button.

 4. This loads the preview (if available) under Preview and shows the available drawing 

resources hierarchy in the source under Source Resources. You can deselect the resources 

you don’t want to transfer to the destination. Figure 13.24 shows the source drawing 

resources.
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Figure 13.24

Selecting source 

drawing resources

 5. Click Next to go to the Select Target Drawings screen. On this page, select one or more 

drawings (by Shift+clicking), and click Open. You can click the fi le or path column name 

to sort fi les.

 6. Click Next, and select Yes or No for replacing resources in the target fi le with the same 

name as in the source. If you select Yes, the same name is used as the source for the target 

fi le. Selecting No gives a unique name to target drawing resources that have the same 

name as those in the source fi le. For instance, instead of writing over a title block defi ni-

tion named TB_100, you would end up with TB_100 and Copy of TB_100 in your fi les.

 7. Click Start, which shows the progress bar and a Pause button to temporarily halt the 

process.

 8. When the progress bar fi nishes, click Exit to complete the process.

If you have a number of old drawings that you need to bring up-to-date with a new standard, 

this tool is very useful.

Using the Wizard for New Title Blocks

A problem that pops up quite often in manufacturing is changing title blocks. Companies change 

addresses, change logos, and get bought or merged; any number of things can happen to require 

you to have to change your title block. Th is is where the Drawing Resource Transfer Wizard can 

come in handy. Simply edit the title block as required in your template fi le and then transfer it to 

all your old drawings.

Using the Style Library Manager
A helpful Style tool that is external to Inventor is the Style Library Manager. This tool can 

be used to manage style libraries in your template fi les and set up style libraries. You should 

consider using this tool when attempting to remove unwanted styles from templates. You can 
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access it by selecting Start ➢ All Programs ➢ Autodesk ➢ Autodesk Inventor 2014 ➢ Tools ➢ Style 

Library Manager.

You can use this tool to copy, rename, and delete style libraries. For example, imagine you are 

a CAD administrator who rolls out all the standards for your company, and you want to ensure 

that a good library of styles exists for others to use. The Style Library Manager comes to the 

rescue in this situation. You can create a new style library using the Create New Style Library 

button, shown in Figure 13.25 under the Style Library 2 column. Any changes in the style library 

are not available in other documents until Inventor closes and a new session is reopened.

Figure 13.25

Th e Style Library 

Manager

You can reuse your styles by copying them from one style library to another. Follow these 

steps:

 1. Click the Style Library Manager tool.

 2. In Style Library 1, click the drop-down arrow to select the source library styles you want 

to copy, or use the Browse button.

 3. In Style Library 2, you have three options:

 ◆ Choose an existing library.

 ◆ Copy an existing style library.

 ◆ Create an empty style library.

Use the Create New Style Library button to select the last two options, and use the 

Browse button to use the fi rst. Figure 13.26 shows a new empty library being created.

 4. Click one or more styles in Style Library 1, and then click the >> button to add them to 

Style Library 2. Click the arrow buttons to add styles to or remove styles from the desti-

nation as desired.

Creating a new empty library and then bringing in approved styles one at a time is the 

best way to ensure that you a get a clean style library with only the styles you want and 

nothing else.
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Figure 13.26

Creating a new style 

library

 5. In Style Library 1 or 2, you can right-click a style name and select Rename or Delete. A 

warning will appear that all document links to that style will be broken or the style will 

be permanently deleted from the style library. Click Yes to continue, and enter a new 

name. Click No to cancel the Rename or Delete operation. Note that you cannot undo or 

reverse a deletion.

 6. Changes are saved as you make them. Once all changes have been made, click the Exit 

button.

Using the Task Scheduler
A large design repository needs to have a way to manage tasks for effi ciency and repeatabil-

ity. Nonproductive and mundane tasks tend to be expensive and tedious. The purpose of the 

Task Scheduler is to precisely automate such tasks. To access the Task Scheduler, select Start ➢ 

Programs ➢ Autodesk ➢ Autodesk Inventor 2014 ➢ Tools ➢ Task Scheduler.

Imagine you are working for a service company that handles outsourcing work for auto sup-

pliers. The supplier works with hundreds of fi les and is trying to decide whether to move to 

Inventor 2014. You have been asked to evaluate this for the supplier. You want to do testing and 

present quantitative data on the results of migration or some other custom tasks the supplier 

normally performs on legacy fi les. The main purpose of the Task Scheduler is to automate the 

tasks and quickly give you results. The Task Scheduler has the ability to create tasks such as the 

following:

 ◆ Migrating a set of fi les from Autodesk® AutoCAD, Autodesk® Mechanical Desktop®, and 

Autodesk Inventor software

 ◆ Converting Inventor IDWs to Inventor DWGs

 ◆ Publishing DWF fi les

 ◆ Importing fi les and exporting fi les

 ◆ Updating parts, assemblies, and drawings

 ◆ Checking out and checking in from Vault

 ◆ Retrieving fi les from Vault

 ◆ Printing sheet sets

 ◆ Refreshing Content Center components used in assemblies
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 ◆ Running a custom macro (such as a Visual Basic routine)

 ◆ Creating a single part from an assembly using the Shrinkwrap tool

Creating a Task for Migrating Files
To create a task to migrate fi les in Task Scheduler, follow these steps:

 1. Open Task Scheduler by selecting Start ➢ Programs ➢ Autodesk ➢ Autodesk Inventor 

2014 ➢ Tools ➢ Task Scheduler.

 2. Select Create Task ➢ Migrate Files, as shown in Figure 13.27.

Figure 13.27

Th e Create Task 

menu

 3. In the Migrate Files dialog box (see Figure 13.28), enter the task name, frequency, start 

time, and start date. If Immediately is checked, the task will start immediately after you 

click the OK button. The log fi le helps you to see the output of the task.

Figure 13.28

Migrating fi les
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 4. Use one of the three buttons along the top to add fi les in one of the following ways:

Add Files  Select fi les from the active project to add to the task.

Add Folder  Browse to a folder or folders to add to the task. Use the File Name drop-

down to select which fi le type to process. Ensure that the Recursive check box is selected 

to include subfolders.

Add Project  Select a project to include all fi les in that project’s search paths.

 5. Click the Options button to open the Migration Options dialog box, shown in 

Figure 13.29. The options are also listed here:

Figure 13.29

Th e Migration 

Options dialog box

Total Rebuild  Rebuilds all the parts and assemblies.

Skip Migrated Files  Ignores fi les created in the current version or fi les already 

migrated.

Skip Files With Unresolved References  Ignores fi les with broken links and references.

Include Assembly Graphics For Express Mode  This setting allows you to save Express 

mode graphics in the assembly when migrating assembly fi les. With Express mode 

graphics included, your migrated assemblies can then be opened in Inventor’s Express 

mode. Without these graphics, assembly fi les can only be opened in Full mode.

Set Defer Updates (Drawings Only)  Toggles on the setting that allows drawings to be 

made static so that they do not update as the part or assembly they detail updates. This 

can be toggled off manually from the drawing later.

Purge Old Versions  Deletes former versions after the migration task fi nishes, keeping 

fi le size to a minimum.

Compact Model History  Purges fi le history used for fast feature editing. This is intend-

ed for working with large assemblies when you experience capacity limitations. Do not 

select this option when migrating fi les to a new release.
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 6. Click the OK button to run the task. When the task is done, you will see the status shown 

as completed.

Users can run, edit, delete, or disable tasks once they are created, as shown in Figure 13.30. 

Tasks are also saved so they can be run again. You can click the Task ID or Name column to sort 

the data by task ID or name.

Figure 13.30

Editing a task

Performing Sequential Tasks
You can create several subtasks to set up multiple tasks and schedule them to run in a specifi ed 

sequence at a specifi ed time. Custom subtasks can be used also in a sequential task. One subtask 

can depend on the output of the previous subtask. Here are some examples of multiple subtasks:

 ◆ Importing fi les

 ◆ Updating designs

 ◆ Publishing DWF fi les

 ◆ Printing fi les

 ◆ Generating a cost report (custom task)

Performing Custom Tasks
A form of a COM object that implements the COM interface could be a custom task. For 

instance, you can use a custom task to open a batch of text fi les. A type library fi le called 

ServiceModuleInterfaceDef.tlb is shipped with the Task Scheduler. To access the COM inter-

face, reference this fi le within your project. You can create custom tasks in any programming 

language that supports COM.

Tweaking Multi-Process Settings
In the Multi-Process Settings dialog box, shown in Figure 13.31, you can tweak parameters to 

complete batch jobs in less time by leveraging the multiprocess support in the Inventor Task 

Scheduler. Up to 16 processes can be run at the same time. You can set the number of processes 

and the amount of memory to be used. You can fi nd this setting in Task Scheduler by selecting 

Settings ➢ Multiple Process.

Batch Plotting with the Task Scheduler

One of the most powerful uses of the Task Scheduler is to batch-plot a number of drawings. Simply 

select Print Files from the Create Task menu and then select the fi les to be printed. Click Options 

to set the paper size and other print parameters.



USING IPROPERTIES | 653

Figure 13.31

Th e Multi-Process 

Settings dialog box

Publishing DWF Files and Filenames
If you were to use the Task Scheduler to publish a DWF fi le named MI777.ipt, then that would 

become the destination fi le MI777.ipt.dwf. Some users fi nd this fi lenaming scheme diffi cult 

to accept. The motivation to rename it not as filename.dwf is as follows: If Inventor were to 

produce MI777.dwf from MI777.ipt, it might be overwritten if you have two fi les with the 

same name but different fi le extensions, that is, MI777.ipt and MI777.idw. Therefore, the Task 

Scheduler takes the current fi lename with the extension (such as .ipt or .idw) and appends 

.dwf at the end. There are programs available on the Internet, or Windows scripting commands 

to rename fi les from MI777.ipt.dwf to MI777.ipt, which could be used to fi x the fi lenames.

Using iProperties
Inventor fi les have fi le-specifi c properties known as iProperties. The iProperties dialog box 

helps you specify and view them. You can enter custom data into iProperties, search by those 

fi elds, and update your title blocks and parts lists in drawings and BOMs. You can launch this 

dialog box by clicking the Inventor button and then iProperties or by right-clicking the fi lename 

in the browser and selecting iProperties. Figure 13.32 shows the iProperties dialog box for a 

part. The iProperties dialog box in the parts and assemblies environments contains seven tabs, 

whereas the iProperties dialog box in the drawing environment contains only six tabs (the latter 

is missing the Physical properties tab).

You can also right-click a fi le in Windows Explorer and choose Properties ➢ iProperties to 

add or edit iProperties outside of Inventor. Or from Windows Explorer, right-click a fi le and 

choose Design Assistant to work with fi les outside of Inventor. In the iProperties dialog box, you 

can modify data on the Summary, Project, Status, and Custom tabs. On unsaved fi les, changing 

the iProperties using the Design Assistant could lose unsaved changes. You can save any open 

Inventor fi les before using the Design Assistant to change iProperties.

The various tabs in the iProperties dialog box are as follows:

General  Contains fi elds that cannot be modifi ed by the user.

Summary  Contains fi elds that can be modifi ed by the user, such as Title, Subject, and 

Author.

Project  Contains important fi elds such as Part Number, Revision Number, and Project.
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Status  Contains drop-down controls for Part Number, Status, Checked Date, and so on.

Custom  Helps defi ne your attributes. These attributes follow the Name, Type, and Value 

format. For example, you can have Name=Department, Type=Text, and Value=Design123.

Save  Helps you specify whether to save the preview picture of the fi le so that it can be used 

in most “browse for fi le” dialog boxes. You can also specify an image fi le to use for this pre-

view picture.

Physical  Lets you calculate and display the physical properties (area, volume, inertia, and 

so on) for a part or an assembly. The material selected is used to calculate the mass proper-

ties. The Update button on the Physical tab is useful to update the physical properties based 

on changes to your models.

Figure 13.32

Physical properties 

with aluminum as 

the material

The Summary, Project, Status, and Custom tabs are used to search fi les to update the BOM 

and parts lists.

Figure 13.32 shows an example of iProperties on a simple part. If this were a multi-body part, 

the mass properties of an individual property could be evaluated by setting the Solid drop-

down to look at just the specifi ed solid.

Also notice the hand icon next to the Mass input box. This indicates that the mass has been 

overridden or manually entered rather than being calculated from the part. The calculator icon 
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shown next to the Volume input box indicates that the volume is being calculated from the 

part and will update as changes are made. The Density fi eld cannot be changed in this dialog 

box. To change the density for this example, select the Manage tab, click Styles Editor, and fi nd 

Aluminum-6061 under Material. Then change the density.

Overriding Mass and Volume for a Simplified Representation

Sometimes you’ll want to model a simplifi ed representation of a part but still need to have an accu-

rate measure of its mass or volume. In these cases, type over the mass or volume in the iProperties 

dialog box. Th e calculator icon will then change to the hand icon, signifying that the mass and/or 

volume has been overridden. To allow Inventor to recalculate the mass or volume, delete all the 

text from the box and click the Update button. Inventor will then compute the mass and volume 

based on the size and density of the model.

Copying iProperties to Drawings
You can copy the model iProperties to the drawing iProperties so that they are the same. Copied 

model iProperties can be used in part lists, title block standard notes, or any annotation that 

accesses the iProperties. If the iProperties are set up in your drawing template, when you place 

views of the model on a new drawing, the selected iProperties are copied to the drawing from 

the source fi le.

Be aware that, once copied, the properties do not update automatically when changed in 

the model. To update the copied model iProperties in the drawing, select the Manage tab (from 

the drawing fi le), and click Update Copied Model iProperties. Note also that a drawing will 

pull properties from only one source. So if you have views of two different models on a single 

drawing, the properties are pulled from the fi rst model from which a view was created. If you 

remove all the views of the fi rst model, the drawing will pull from the second model, but you 

will need to use the Update button to make this happen.

You can copy iProperties from a model fi le to a drawing fi le by following these steps:

 1. In the Drawing fi le, select the Tools tab and click Document Settings; then select the 

Drawing tab.

 2. Click the Copy Model iProperty Settings button, which opens the dialog box shown in 

Figure 13.33.

 3. Select the boxes for the properties you want to copy. You can select the All Properties 

check box at the bottom to copy all the properties.

Creating Expressions with iProperties
If you have a need to create a “stock size” of your parts to be used in your BOM with associativ-

ity to model parameters, you can create and manage expressions for iProperties by using the 

following steps:

 1. Click the Inventor button and then iProperties, and select the Summary, Project, Status, 

or Custom tab. Then click a fi eld where an expression needs to be created.
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Figure 13.33

Th e Copy Model 

iProperty Settings 

dialog box

 2. Start with the = sign, and type the text. If you want to include parameters or iProperty 

names, simply include them in brackets. A detected expression is denoted by fx. Figure 

13.34 shows an expression that concatenates the thickness, width, and length parameters. 

This is the expression used:

= <Th ickness> x <Width> x <Length>

The resulting Stock Number property is as follows:

12.000 mm x 38.000 mm x 75.000 mm

Figure 13.34

Concatenating text 

and parameters in 

iProperties

 3. To edit an existing expression, you can right-click the expression and choose Edit 

Expression.
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Before creating the expression from parameters, you should visit the Parameters dialog box 

(select the Manage tab and click the Parameters button) and do the following:

 ◆ In the Export Parameter column, click the check box next to all parameters you want to use 

in expressions. If you forget this step, the expressions will not build.

 ◆ In the Equation column, right-click the parameter, and choose Custom Property Format. 

The Export parameter must be selected to get this option. Figure 13.35 shows the Custom 

Property Format options. Notice that you can click the option to apply the formatting to 

all comparable parameters. In other words, if it’s a length parameter, set this format for all 

length parameters; if it’s a volume parameter, set this format for all volume parameters; 

and so on.

Figure 13.35

Customizing an 

exported parameter 

format

To promote reuse, create a template fi le with predefi ned expressions for iProperties that lets 

you unify your parts list and other documentation. The Bill Of Materials dialog box provides 

the Property Expression Builder, which helps you create expressions for iProperties as well. You 

can then copy the expression to the parameter fi eld of multiple parts in the Bill Of Materials 

Editor. Using the Bill Of Materials Editor allows you to “reach into” several parts at once and set 

an expression en masse. Figure 13.36 shows an iProperty expression being created in the Bill Of 

Materials Editor.

Figure 13.36

Expression Builder 

in the Bill Of 

Materials Editor



658 | CHAPTER 13 TOOLS OVERVIEW

Working with the Design Assistant and iProperties
You can use the Design Assistant to copy design properties from one Inventor fi le to another. To 

do so, use the following procedure:

 1. In Inventor, click the Inventor button and choose Manage ➢ Design Assistant.

 2. In the Design Assistant, select Tools ➢ Copy Design Properties to access the Copy Design 

Properties dialog box.

 3. Set the source fi le in the Copy From box.

 4. Select the properties to copy.

 5. Select the destination fi les to receive the properties.

 6. Click the Copy button.

 7. If the properties exist in the destination fi le, you are prompted to overwrite them one by 

one; you can choose Yes To All or No To All as well.

 8. Once the properties are copied, click Done.

 9. You can then step into the fi les (from Inventor or the Design Assistant) and change the 

values of the copied iProperties as required.

Figure 13.37 shows the custom iProperties of one fi le being copied to another fi le. You can refer 

to the section “Using the Design Assistant” earlier in the chapter to learn more about the Design 

Assistant and iProperties. If the active project is set to Shared or Semi-isolated, you cannot copy 

properties to a fi le that is checked out to someone else or into the workgroup version of a fi le.

Figure 13.37

Copying custom 

iProperties from 

one fi le to another
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Creating Design Property Reports
You can use the Design Assistant to create a design property report that shows the iProperties 

you’ve selected. The report is written out to a TXT fi le. In the properties view browser in the 

Design Assistant, you can select the design properties to display for fi les:

 1. While in the properties view, select View ➢ Customize in the Design Assistant, and select 

the required property group.

 2. Select the properties to display. Clicking the Add or Remove button helps you move a 

property from the Available Properties list to the Selected Properties list. You could also 

double-click it. The Name property is a default property that is mandatory in all displays.

 3. To include custom properties that you’ve created yourself, follow these steps:

 A. Set the Property Group drop-down to Custom Properties.

 B. Click the New button.

 C. Expand the Add New Property column using the >> button.

 D. Use Ctrl or Shift to select multiple properties.

 E. Click Apply. Note that only nine properties may be listed.

 4. Click Done. Notice that the properties you selected are now listed as columns.

 5. Select Tools ➢ Reports, and choose the report type you want:

Hierarchy Report  Shows the hierarchy within the selected folder or assembly. If a fold-

er is selected, the report shows the subfolders it contains. If an assembly fi le is selected, 

the report shows the paths for the fi les in the assembly.

Design Property Report  Shows values of the specifi ed properties for the fi les in the 

selected fi le or group of fi les.

 6. Choose the number of levels to display, and click Next.

 7. Specify the report name and save location.

Using the Measure Tools
The Measure tools let you measure distances, angles, loops, and areas. These tools, shown in 

Figure 13.38, are available by selecting the Inspect tab and then looking on the Measure panel. 

They are available in the assemblies, parts, sheet-metal, fl at pattern, construction, and 2D and 

3D sketch environments. You can select sketches, edges, faces, bodies, and work geometry to 

take measurements. In addition to the measurement tools mentioned, you can use Measure 

Regions while in a 2D sketch.
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Figure 13.38

Measure tools

Distance  Lets you measure the length of a line, an arc, or the distance between points and 

so on.

Angle  Lets you measure the angle between points, edges, or two lines. To measure between 

points, click two points to defi ne a line and then a third point to measure the angle.

Loop  Gives you the length of the loops. For 2D sketches, it measures open or closed loops. 

For 3D sketches, it measures only open loops.

Area  Gives you the area of closed regions.

Region Properties  Calculates the area, perimeter, and the area moment of inertia proper-

ties of 2D sketch loops. Measurements are taken from the sketch coordinate system.

Using Measurement Helpers
Measurements can be accumulated, cleared, and displayed in different ways. Figure 13.39 shows 

some of the options that are useful while using the Measure tools. Here’s a list:

Figure 13.39

Measurement 

helpers

Add To Accumulate  Adds the current measurement to the total sum

Clear Accumulate  Resets the sum to zero

Display Accumulate  Displays the current sum

Dual Unit  Lets you see the measurement in the desired units

Precision  Displays eight formatting values and the option to display all decimals

One of the advantages of the Measure tools is the ability to enter feature parameters by 

measuring instead of by directly entering them. For example, in Figure 13.40, extrusion depth 

can be entered as a known value. Alternatively, you can select the Measure tool from the Depth 
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fl yout and then select a model edge. The length of the edge will appear in the Depth control of 

the Extrude dialog box. This is a convenient way to input dimensions by measuring instead of 

directly entering the values into the dialog box. In the graphics window, click the geometry to 

measure. The measurement is transferred to the dialog box automatically. Note that this tool can 

be used with sketch dimensions as well.

Figure 13.40

Measure tool and 

feature parameters

Also shown in Figure 13.40 is the Show Dimensions option. Choosing this option allows you 

to select an existing feature to temporarily see the consumed dimensions within that feature. 

You can then select a dimension on-screen to link the value of that dimension to the dimension 

you are currently entering. This differs from the Measure method in that the value will update 

if the object changes, whereas the measured value will stay static.

Measuring in Assemblies
Since you have faces and components in assemblies, there is a need to differentiate measuring 

between them. In the context menu, you can change the selection priority.

When Component Priority is selected, the minimum distance is measured between subas-

semblies. Part priority signifi es measurement between parts only. Faces And Edges Select 

Priority lets you select only faces and edges, which is the default when nothing is preselected. 

Changing the selection priority resets any existing selections. Figure 13.41 shows the priority 

type pull-down with the selection fi lters for Component, Part, and Faces/Edges.

Figure 13.41

Selection priority 

for measurements

You can measure preselected entities by selecting the object fi rst and then clicking the 

Measure button. If a selection set is valid for a measurement, the select fi lter in the Measure dia-

log box is updated, and the measurement is displayed. For example, if you select two points and 

then start the Measure Distance tool, you will get the distance between the points. However, if 
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you select three points and start the Measure Angle tool, the selection set is cleared because the 

tool doesn’t know which point is the vertex of the angle.

Participating in the CIP and CER
The Customer Involvement Program (CIP) aids in collecting information about your use of the 

Inventor software. Customer error reporting (CER) aids in sending information to Autodesk 

when the software program closes unexpectedly.

Participating in the CIP
To guide the direction of the Autodesk design software in the future, your use of the Inventor 

software is forwarded to Autodesk if you participate in the CIP. You can access this feature by 

selecting Help ➢ Customer Involvement Program. In the Customer Involvement Program dialog 

box, you can select a level of participation and then click the OK button. The following informa-

tion might be collected:

 ◆ Autodesk product version and name

 ◆ Inventor commands and time spent

 ◆ Error conditions (catastrophic and nonfatal)

 ◆ Information such as system confi guration, IP address, and so on

The CIP is committed to privacy protection. It can collect neither drawing or design data, nor 

personal information such as names, addresses, and phone numbers. It will not contact users 

by email or any other way. The Customer Involvement Program aids in letting Autodesk know 

about the most commonly used tools and features, the most common problem areas, and so on. 

You can stop participation at any time by accessing the controls from the Autodesk Help menu. 

Your system administrator can also choose to block the CIP.

Participating in CER
Customer error reporting is a process by which Inventor users can report crashes to Autodesk. 

A software crash happens when the software program closes unexpectedly. When you have 

an unexpected error, Inventor shows a dialog box, and you can choose to send the error to 

Autodesk. CER records the subset of the code that was in use before the crash. The CER report 

collects a variety of information, such as the following:

 ◆ Operating system and graphics driver name, version, and confi guration

 ◆ Autodesk software name and version

 ◆ List of recently used Autodesk commands

 ◆ Lines in the code where the crash happened

You can enter the step-by-step process that led to the crash. In addition, you can include your 

email and contact information. The error data is sent to Autodesk using a secure Internet con-

nection in an encrypted form. If you have concerns about security and personal confi dential 

information being sent to Autodesk, please do not send the customer error report.
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At Autodesk, an automated system sorts the reports based on the code call stack so that the 

Autodesk development teams can analyze them. Each set of reports is prioritized based on the 

number of users having the same issue and how often the problem happens. If there is no cur-

rent update, Autodesk will use that information for a future update or major release. When 

the issue is fi xed, it is included in either a future maintenance update or a future release of the 

product. Customers who reported the error are notifi ed. If there is a current update (immediate 

update notifi cation), it is immediately sent to the customer. If not (delayed update notifi cation), 

customers are notifi ed when their error is addressed in a future software update.

Using Miscellaneous Tools
In the following sections, I will cover some miscellaneous tools: the Inventor Multi-Sheet Plot, 

the Add-In Manager, and the Project Editor. The tools are available by choosing either Start ➢ All 

Programs ➢ Autodesk ➢ Autodesk Inventor 2014 or Start ➢ All Programs ➢ Autodesk ➢ Autodesk 

Inventor 2014 ➢ Tools. If you fi nd that you are using these tools often, it may be helpful to create a 

desktop shortcut to them.

Using the Autodesk Multi-Sheet Plot Tool
The Autodesk Multi-Sheet Plot tool opens the dialog box shown in Figure 13.42. It allows you to 

print one or more drawing sheets of various sizes. Clicking Next takes you to another dialog box 

that allows you to select drawings. Once the drawings are selected, you can schedule to print 

the multi-sheet. This tool helps you reduce paper usage and reduce plot setup time. Besides, 

it optimizes sheet layout on a selected paper size that you can print directly or save as a batch 

fi le. You can access the Multi-Sheet Plot tool by choosing Start ➢ All Programs ➢ Autodesk ➢ 

Autodesk Inventor 2014.

Figure 13.42

Th e Autodesk 

Multi-Sheet Plot 

dialog box
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Using the Add-In Manager
The Add-Ins button opens an Add-In Manager dialog box that lets you select the add-ins you 

want to load or unload when Inventor starts up. You can access this tool by choosing Start ➢ 

All Programs ➢ Autodesk ➢ Autodesk Inventor 2014 ➢ Tools or, when in Inventor, by selecting 

the Tools tab and clicking the Add-Ins button found on the Options panel. Once the Add-In 

Manager dialog box is open, click the add-in in the Available Add-Ins area, and at the bottom of 

the dialog box under Load Behavior, deselect the Loaded/Unloaded option to unload it.

Using the Add-in Manager to Speed Inventor Load Time

If there are add-ins you know you do not use, you can use the Add-In Manager to prevent them from 

loading when Inventor loads. Th is will slightly speed up the load time (and reduce the amount of 

RAM Inventor uses). Be sure you understand what specifi c add-ins do, because some are required 

for the proper operation of the software.

Using the Project Editor
Selecting the Project Editor tool opens a dialog box for the Inventor Project Editor. This is similar 

to the dialog box that opens after you select the Get Started tab and click Projects in Inventor. You 

can select each project, make changes to it, and save it without having to open Inventor. You can 

access this tool by choosing Start ➢ All Programs ➢ Autodesk ➢ Autodesk Inventor 2014 ➢ Tools 

or by right-clicking any IPJ fi le from Windows Explorer and choosing Edit. Project fi les can also 

be edited from within Inventor by selecting the Get Started tab and clicking the Projects button.

Th e Bottom Line

Take your models from Inventor to the Autodesk Building Systems program.  If you 

frequently need to take your Inventor models to ABS, BIM Exchange can help you in this pro-

cess with three simple steps. Inventor provides a variety of ways to simplify the model and 

author it. Such models can be published in ABS.

Master It  Describe the basic steps involved in moving Inventor models to Autodesk 

Building Systems.

Create AutoLimits (design sensors).  You use AutoLimits to monitor design parameters in 

which you are interested.

Master It  You want to use AutoLimits for every dimension in your model. How many 

AutoLimits can you use at once?

Manage design data effi ciently using Inventor tools.  There are different tools for managing 

design data, which is typically distributed across part, assembly, and drawing fi les. You can 

associate Excel spreadsheets, text fi les, Word documents, and so on with these tools.

Master It  Name some of the Inventor tools for managing design data. Describe what 

each one does and how to initiate it.
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Manage styles.  You can use the Style Library Manager to organize your styles to keep them 

simple and clean.

Master It  Styles normally need to be copied, edited, and deleted. How do you manage 

your styles? How can you create a central repository of styles?

Create expressions with iProperties.  Property fi elds can be concatenated to produce desired 

customized information in BOM and parts lists. For example, you can break down your parts 

by stock size to be used in your BOM with associativity to model parameters.

Master It  How do you create and manage expressions for iProperties?

Give feedback to Autodesk.  You can participate in the Customer Involvement Program 

(CIP). Customer error reporting (CER) helps Autodesk know about any issue you might 

experience.

Master It  You have a repeatable crash that you suspect is related to a specifi c fi le or a 

specifi c machine, and want to know if Autodesk can help you determine this. 





Chapter 14

Exchanging Data with Other 
Systems

The need to bring fi les created by other CAD applications into Autodesk® Inventor® software, or 

to export to other formats, is common to many Inventor users. For instance, if you design com-

ponents that others use in their designs, you might need to output fi les to a standard format so 

that others can use them with a different software package. Or, if you are a manufacturing “job 

shop,” you may receive many different fi le formats from customers that you need to bring 

into Inventor.

In this chapter, you’ll learn to:

 ◆ Import and export geometry

 ◆ Use Inventor fi le translators

 ◆ Work with imported data

 ◆ Work with Design Review markups

Importing and Exporting Geometry
Essentially, three data types make up a 3D model: curves (or wires), surfaces, and solids. Wire-

frame models are composed of only wires that defi ne the size and shape but lack volume. A 

surface model, on the other hand, is composed of wires and faces that defi ne the surfaces but 

still lacks a solid fi lled volume. A solid model is composed of wires and faces that defi ne 

surfaces that in turn defi ne the solid fi lled volume. Understanding the hierarchy of geometry 

data will help you understand the issues that can occur when translating from one of these data 

types to another.

There are different ways in which wires and curves are defi ned. If you are translating fi les 

that represent wires and curves as Non-Uniform Rational B-Splines (NURBS) to a format that 

represents wires and curves as simpler basis splines (B-splines), there might be something lost 

in translation. Likewise, when you translate a surface model, if the surface normal direction 

were to get reversed (think positive vs. negative), you will have translation issues. And so it is 

with translating solids; if a solid model is translated so that a gap is formed where two surfaces 

meet, then translation may not be complete.
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Translation of curves, surfaces, and solids occurs between different software packages 

because these packages use different methods of geometric accuracy. Accuracy controls such 

things as how close two points in space are before being considered a single point or how close 

two edges can be before they are considered connected, and so on.

To help with translating from one software package that solves curves using method A to 

software that uses method B, you can create an intermediate, or neutral, fi le. Some common 

neutral fi le formats are Initial Graphic Exchange Specifi cation (IGES), Standard for the Exchange 

of Product (STEP), and Standard ACIS Text (SAT), among others. Other common translations 

include importing fi les from AutoCAD® and Autodesk® Mechanical Desktop® software into 

Inventor. In these cases you will be working with the DWG fi le type.

Working with Neutral File Formats

Although using neutral formats will help avoid problems, keep two things in mind when translat-

ing fi les:

 ◆ Generally speaking, you should strive to keep the number of fi le formats between the source 

software and the destination software as low as possible.

 ◆ Not all neutral fi le formats are created equal.

Translating DWG and DXF Files
When a DXF or DWG fi le is imported into Inventor, the fi le is translated into an Autodesk 

Inventor part, assembly, and/or drawing fi le, based on the import settings and the geometry 

present in the original fi le. When imported, the original DXF or DWG fi le is not changed; 

instead, the data is created in a new Inventor fi le or multiple Inventor fi les. When exported from 

Inventor to a DWG, a fi le is translated into AutoCAD objects and a new DWG fi le is created. The 

new translated DWG is not linked to the Inventor fi le from which it was created. Instead, the 

DWG data is fully editable within AutoCAD. You can use the fi le mi_14a_014.dwg located in the 

Chapter 14 directory of your Mastering Inventor 2014 folder to explore the import options 

for DWG fi les.

Translating DXF and DWG fi les follow similar steps. To import a DWG fi le, follow these 

steps:

 1. Click Open on the Get Started tab.

 2. Set the Files Of Type drop-down to AutoCAD Drawings (*.dwg).

 3. Select the DWG fi le you are going to import.

 4. Click the Options button and choose Import. (If you are translating a number of 

DWG fi les, you can set Import to be the default by clicking the Tools tab, selecting the 

Application Options button, and choosing the Drawing tab.)

 5. Once you’ve selected Import, as shown in Figure 14.1, click the OK button.
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Figure 14.1

Importing a DWG 

fi le

 6. This returns you to the Open dialog box, where you will click the Open button to start 

the DWG/DXF File Wizard. Note the Confi guration drop-down box.

 7. If you have an import confi guration already saved, you can specify it now and click 

Finish. If you have not yet created a confi guration template, click Next to go to the Import 

Destination Options dialog box.

You need to consider a number of options when importing DWG fi les, depending on the 

DWG data input and the intended translation output. The following sections discuss these con-

siderations in relation to the import options.

Layers and Objects Import Options

Once you click Next in the DWG/DXF File Wizard screen, you will be presented with the Layers 

And Objects Import Options screen. In this screen you can select which layers or objects to 

include or exclude for importing. There are two methods of selection available:

Select By Layer  Use the check boxes to control which layers will be imported. Unchecking 

a layer will exclude all objects located on that layer.

Select By Object  Uncheck the All check box, and then select objects in the Import Preview 

window.

You can combine layer and object selections in order to create a specifi c selection set. Once 

the layers and objects are selected, you can click the Next button to continue to the Import 

Destination Options screen.

Importing D Solids

Once you’ve selected the layers and objects to be imported, you will be presented with the 

Import Destination Options screen. If the AutoCAD DWG has 3D solids, you can check 
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the 3D Solids check box to translate them into Inventor part fi les. Use the Solids To Single Part 

File check box if you want multi-body solids to be translated into an Inventor part fi le. Leave 

this option unchecked if you want each solid body in the DWG to be created as an individual 

Inventor part fi le and automatically placed in an Inventor assembly. Figure 14.2 shows the 

import options for 3D solids.

Figure 14.2

3D solids options

Set the destination folder to a path in which you want to have the part fi les created and 

choose Use Default File Names to allow Inventor to name the resulting part fi les automatically. 

If you choose this option, the new Inventor parts will be given a name based on the DWG name 

and be incremented by a value of 1.

For instance, if the DWG is named Engine.dwg, then the solids in the DWG will be named 

Engine1.ipt, Engine2.ipt, Engine3.ipt, and so on. If Use Default File Names is left 

unchecked, each solid in the DWG will be named Part1.ipt, Part2.ipt, Part3.ipt, and so on.

Importing D Data

If the DWG contains a combination of 3D and 2D data that you want to import, you can set the 

options in the Destination For 2D Data area to handle the 2D data. If the DWG has only 2D data 

or has both, but you only want to import the 2D data, then you can leave the 3D Solids check box 

deselected and only set the Destination For 2D Data area of the Import Destination Options dia-

log box, as shown in Figure 14.3. Selecting the New Drawing radio button translates the DWG 

data to a new Inventor DWG or IDW. If you check Promote Dimensions To Sketch, the 2D data is 

placed in a draft view that is created in the Inventor drawing.

Figure 14.3

2D data options
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Importing Title Blocks and Borders

You can use the Title Block and Border radio button to convert an AutoCAD title block DWG 

into an Inventor title block or border. When you do this, be sure to click the Mapping Options 

button (located in the lower-left corner of the dialog box) to set the layer and font mapping 

options shown in Figure 14.4. You can click the Symbol radio button to translate the 2D data into 

a sketched symbol for use in an Inventor DWG or IDW fi le.

Figure 14.4

Mapping Options

Importing AutoCAD Blocks as Sketched Symbols

To import AutoCAD blocks as Inventor sketched symbol defi nitions you can use the Symbol 

radio button. This can provide a quick way to convert common drawing symbols for use in your 

Inventor drawing templates.

Importing AutoCAD Part Drawings as New Inventor Parts

Click the New Part radio button to translate AutoCAD 2D data into a new IPT sketch to be used 

for the creation of a new part model. Choose to create either a 3D or 2D sketch within the fi le, 

depending on the type of geometry needed.

Inventor has both a decimal and a fractional unit style for dimensions. When dimensions are 

translated, if Inventor detects that the AutoCAD fi le employs a scientifi c, decimal, engineering, 

or Windows Desktop style, those styles are converted to decimal style. AutoCAD fraction and 

architectural styles are mapped to Inventor fractional style.

Think Before Importing AutoCAD Geometry

Although you might be tempted to import 2D AutoCAD geometry and start extruding away, you 

do need to keep a few things in mind. If this is a part that will never change, or if it is a reference 

part, this approach is probably fi ne. However, if you are re-creating old AutoCAD data to be used 

in your Inventor models as part of a fully parametric design, you might consider modeling the 

parts from scratch. It will take longer, no doubt. However, modeling from scratch allows you to 

place the design intent into the parts, which you simply cannot do by importing. You can create 

the model in a proper order and with the proper constraints that will allow you or others to easily 

modify it in the future.
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Units, Templates, Constraints, and Configurations

Whether importing to 2D or 3D, you will use the Templates area to specify which template to 

use for each of the fi le types to translate to. In the Import Files Units area, you can specify 

the units if they do not match the units that Inventor detects from the AutoCAD fi le. The 

detected unit is based on the INSUNITS system variable in the DWG fi le.

You can use the Constrain End Points and Apply Geometric Constraints check boxes to allow 

Inventor to place constraints on sketch entities when it can. Endpoints found to be coincident 

will be given Coincident constraints, lines found to be parallel will be given parallel constraints, 

and so on.

Once all these options are confi gured, you can click the Save Confi gurations button, shown 

in Figure 14.5, to write out a fi le to use the next time you convert a DWG fi le. Doing this allows 

you to convert fi les more accurately and more quickly.

Figure 14.5

More import desti-

nation options

When all the confi guration settings have been made and saved, click Finish to start the 

import process. Inventor will create the new fi les based on your confi gurations and leave the 

fi les open in the current Inventor session.

Mechanical Desktop DWG
Autodesk® Mechanical Desktop (MDT) was a 3D parametric modeler similar to Inventor that 

was developed on top of the existing AutoCAD platform. Once Inventor was created, Autodesk 

stopped developing MDT and has since discontinued support for it. If you have fi les that were 

created using MDT, they can be translated to Inventor part and assembly fi les. If the source 

fi les contain geometry or features that are not recognized in Inventor, they are omitted, and the 

missing data is noted in the browser or the translation log fi le. No links are maintained to the 

existing MDT fi les. You must have MDT on your computer to import fi les into Inventor. Note 

that the AutoCAD Inventor suite does not ship with MDT. If you have a need to use MDT for 

translation, the 2009 version can be downloaded from the Autodesk website or you can purchase 

or request installation media. MDT 2009 is the last version that Autodesk released.

MDT’s native fi le format was the DWG fi le, and you can import MDT DWG fi les using the 

Options button in the Open dialog box just as you would a regular DWG. However, if Inventor 

detects that it is an MDT fi le, you are given the option to read the data as an MDT fi le or as an 

AutoCAD or AutoCAD Mechanical fi le, as shown in Figure 14.6.
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Figure 14.6

Reading MDT fi le 

contents

Although many of the options for templates, units, and confi guration settings are the same as 

previously described for regular DWG fi les, the assembly and part options are specifi c to MDT 

fi les, as shown in Figure 14.7.

Figure 14.7

MDT assembly and 

part options

Consider the following items when migrating MDT fi les to Inventor:

 ◆ Broken views, base section views, and breakout section views from MDT will be turned 

into base views.

 ◆ Exploded views will become unexploded views (no tweaks applied).

 ◆ Importing discards (AMPARDIMS) from MDT automatically creates associative model 

dimensions in Inventor.

 ◆ If Move With Parent is selected in an MDT fi le, Inventor aligns all views according to the 

view type.

 ◆ If a parent view is missing in an MDT fi le, a child view is not created in Inventor.

 ◆ Inventor centerlines and center marks are automatically generated during translation; 

therefore, they might not be the same as in the MDT fi le.

 ◆ Radial section views have broken alignment in Inventor.

In addition to importing MDT fi les one at a time, you can use the Inventor Task Scheduler 

to batch the translation from MDT to Inventor. It is important to ensure that the MDT fi les are 

migrated to the latest version of MDT before attempting to translate them into Inventor fi les.

STEP and IGES
Standard for the Exchange of Product (STEP) and Initial Graphic Exchange Specifi cation (IGES) 

are nonproprietary fi le formats you can write data to in order to exchange data among propri-

etary software. When a STEP or IGES fi le is opened in Inventor, one part fi le will be created if 
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the fi le contains only one part body; otherwise, you can create multiple Inventor part fi les placed 

within an assembly fi le.

Although no links are maintained between the original STEP or IGES fi le and the Inventor 

fi les created from them, when importing an updated STEP or IGES fi le, Inventor updates the 

geometry and maintains all modeling constraints and features applied to that STEP or IGES fi le. 

You can use the fi les called mi_14a_014.stp and mi_14a_014.igs located in the Chapter 14 

directory of your Mastering Inventor 2014 folder to explore the import options for STEP and 

IGES fi les.

To import a STEP or IGES fi le, follow these steps:

 1. Click Open on the Get Started tab, and set the Files Of Type drop-down to STEP Files 

(*.stp, *.ste, *.step) or IGES Files (*.igs, *.ige, *.iges).

 2. Select the fi le you intend to import.

 3. Click the Options button, and you will be presented with the Import Options dialog.

In the Import Options dialog, you can choose from three save options:

Save In Workspace  Writes the fi les to the Workspace folder defi ned in your current project 

fi le. The fi les are saved as Inventor fi les during the import process.

Select Save Location  Allows you to specify where the resulting Inventor fi les will be saved. 

If the translated fi le contains separate solid bodies, you can confi gure the import to save 

those fi les to one location and the top-level assembly fi le to another location.

Save At Import File Location  Writes the resulting Inventor fi le(s) to the same location as 

the original fi le. Figure 14.8 shows the import save options.

Figure 14.8

STEP or IGES save 

options

In the Translation Report area choose to embed the report in the imported 3D model fi le (it 

will be placed as a node in the browser), or choose to save the report to disk. Note that you can 

choose both of these options or deselect them both in order to skip saving the translation report 

altogether. 

In the Entity Types To Import area, use the selection buttons to specify the inclusion of sol-

ids, surfaces, wires, and points in the import action. Click the Import Assembly As Single Part 

check box to turn a multi-body STEP or IGES into a single-part fi le. Then choose from one of two 

options:

Single Composite Feature  This option allows you to import the assembly as a single com-

posite feature into a single-part fi le.

Multiple Solid Part  With this option, you can import the assembly as individual solid bod-

ies into a single-part fi le.
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The Import Into Repair Environment option checks the model for errors and creates a repair 

node in the browser. You can edit, diagnose, and repair imported base bodies in the repair 

environment.

Click the Import Multiple Solid Parts As Assembly check box to turn a multi-body STEP or 

IGES into individual part fi les. When imported, the new Inventor parts will be given a name 

based on the fi lename and incremented by a value of 1. For instance, if an IGES were named 

4278_T.igs, then the Inventor parts will be named 4278_T 1.ipt, 4278_T 2.ipt, 

4278_T 3.ipt, and so on.

If you leave both of those check boxes deselected, you can specify how surface objects will be 

translated:

Individual Surface Bodies  Imports surfaces as individual surfaces in a single-part fi le.

Single Composite Feature  Imports surfaces as a single composite in a single-part fi le.

Multiple Composite Features  Imports surfaces as multiple composites all contained in a 

single-part fi le. Composites are created for each level, layer, or group, according to the Create 

From information specifi ed.

A composite is a collection of surfaces, as opposed to a single quilt of surfaces. A composite 

can consist of any combination of single- or multiple-faced surfaces or closed volume surfaces. 

Often these surfaces will not be connected, even if they appear to be. Composites can be used 

when many surfaces are imported as an expedient way of getting surface data into Inventor for 

reference or inspection.

You can also specify which units the imported geometry will be converted to and the post-

process options, as listed here:

Check Parts During Load  This option performs a quality check on the imported data. Bad 

data is marked with a symbol in the browser and any remaining data is not checked. If the 

parts are determined not to have any errors, they are marked with a green check mark in the 

browser. Checking parts can signifi cantly increase the time required to translate a fi le.

Auto Stitch  This option stitches surfaces into a quilt or solid, when possible. If the stitch 

results in a single body, it is promoted out of the construction environment; otherwise, it 

remains in the construction environment.

Enable Advanced Healing  This option allows small alterations in the surface geometry in 

order to stitch the surfaces.

Figure 14.9 shows the STEP and IGES options.

Many Inventor users prefer to send and receive STEP fi les to and from vendors or clients 

because they fi nd that STEP fi les import better than other fi le formats such as IGES. Here is a list 

of attributes that make STEP a popular choice:

 ◆ STEP fi les can retain the original part names when importing to an assembly.

 ◆ STEP creates instances for duplicated parts. If you are sent a STEP of an assembly created 

in another software package and that assembly has 12 instances of a certain screw size, 

Inventor will typically create just one fi le for the screw and instance it 12 times instead of 

creating 12 different fi les.

 ◆ STEP fi les can maintain assembly hierarchy, meaning that subassembly structure can be 

translated. In other formats, assemblies may be translated with all parts at the top-level 

assembly.
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 ◆ STEP translates part colors, whereas other formats generally do not contain the informa-

tion needed to carry part colors across different platforms.

 ◆ STEP format is governed independently and is not tied to a particular modeling kernel; as 

a result, it is often considered a more standard format.

Figure 14.9

STEP or IGES 

import options

To export a fi le as a STEP, click the Inventor button, and then select Save Copy As. In the 

resulting dialog box, set Save As Type to STEP Files (*.stp, *.ste, *.step). Click the Options button 

to set the STEP version. You can also choose to include sketches. Included sketches are trans-

lated to the STEP fi le in named groups.

To export a fi le as an IGES, click the Inventor button, select Save Copy As, and set Save As 

Type to IGES Files (*.igs, *.ige, *.iges). Click the Options button to set the IGES output to either 

surfaces or solids. You can choose to include sketches. Included sketches are translated to the 

IGES fi le in named layers.

SAT
Standard ACIS Text (SAT) fi les are written in the standard fi le exchange format for the ACIS 

solid modeling kernel. You can use the fi le mi_14a_014.sat located in the Chapter 14 directory 

of your Mastering Inventor 2014 folder to explore the import options for SAT fi les. To import 

an SAT fi le, follow these steps:

 1. Click Open on the Get Started tab.

 2. Set the Files Of Type drop-down to SAT Files (*.sat).

 3. Select the fi le you want to import.

 4. Click the Options button, and you will be presented with the Import Options dialog box.

In the Import Options dialog box, you can choose from three save options:

Save In Workspace  Writes the fi les to the Workspace folder defi ned in your current proj-

ect fi le (see Chapter 1, “Getting Started with Autodesk® Inventor,” for more on projects and 

workspaces). The fi les are saved as Inventor fi les during the import process.
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Select Save Location  Allows you to specify where the resulting Inventor fi les will be saved. 

If the translated fi le contains separate solid bodies, you can confi gure the import to save 

those fi les to one location and the top-level assembly fi le to another location.

Save At Import File Location  Writes the resulting Inventor fi le(s) to the same location as 

the original fi le.

In the Entity Types To Import area, use the selection buttons to specify the inclusion of solids, 

surfaces, and wires in the import action. 

The Import Into Repair Environment option checks the model for errors and creates a repair 

node in the browser. You can edit, diagnose, and repair imported base bodies in the repair 

environment.

Use the Import As Single Part check box option to turn a multi-body SAT into a single-part 

fi le. Then choose from one of two options:

Single Composite Feature  Imports the assembly as a single composite feature into a single-

part fi le.

Multiple Solid Part  Imports the assembly as individual solid bodies into a single-part fi le.

If you leave this check box deselected, you can specify how surface objects will be translated:

Individual Surface Bodies  Imports surfaces as individual surfaces in a single-part fi le.

Single Composite Feature  Imports surfaces as a single composite in a single-part fi le.

Some CAD software outputs SAT fi les in a default unit without regard for the units used to 

create the original fi le. You can specify the units to which the imported geometry will be con-

verted as well as the postprocess options listed here:

Check Parts During Load  This option performs a quality check on the imported data. Bad 

data is marked with a symbol in the browser and any remaining data is not checked. If the 

parts are determined not to have any errors, they are marked with a green check mark in the 

browser. Checking parts can signifi cantly increase the time required to translate fi les.

Auto Stitch  This option stitches surfaces into a quilt or solid, when possible. If the stitch 

results in a single body, it is promoted out of the construction environment; otherwise, it 

remains in the construction environment.

Enable Advanced Healing  This option allows small alterations in the surface geometry in 

order to stitch the surfaces.

To export a fi le as SAT, click the Inventor button, choose Save Copy As, and set Save As Type 

to SAT Files (*.sat). Click the Options button to set the SAT version. The default is version 7.0. You 

can also choose to include sketches. Included sketches are translated to the SAT ungrouped.

Watch for SAT File Versions

As of Inventor release 5.3, Autodesk broke away from the ACIS SAT standard when it created its 

ShapeManager kernel. Th is means that Inventor cannot read in any SAT fi le that is newer than 

version 6.0. Keep this in mind when requesting models from third parties or when downloading 

them from a vendor’s website.
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Using Inventor File Translators
With Inventor, you can access fi les from other CAD systems without downloading an add-in or 

translating the fi les to an intermediate format such as STEP, IGES, or SAT. Instead, you simply 

open the fi le, and Inventor will translate the fi le into an Inventor fi le on the fl y. You can translate 

all of the fi le types in the following list by clicking Open on the Get Started tab and then setting 

the Files Of Type drop-down to the appropriate type. Once the fi le type is selected, click the 

Option button to confi gure the import options.

 ◆ CATIA V4

 ◆ CATIA V5

 ◆ Pro/ENGINEER

 ◆ Unigraphics

 ◆ Parasolids

 ◆ SolidWorks

 ◆ Rhino

In the Import Options dialog box, you can choose from three save options:

Save In Workspace  Writes the fi les to the Workspace folder defi ned in your current project 

fi le (see Chapter 1 for more on projects and workspaces). The fi les are saved as Inventor fi les 

during the import process.

Select Save Location  Allows you to specify where the resulting Inventor fi les will be saved. 

If the translated fi le contains separate solid bodies, you can confi gure the import to save 

those fi les to one location and the top-level assembly fi le to another location.

Save At Import File Location  Writes the resulting Inventor fi le(s) to the same location as 

the original fi le.

The Import Into Repair Environment option checks the model for errors and creates a repair 

node in the browser. You can edit, diagnose, and repair imported base bodies in the repair 

environment.

For each of these fi le types, you can specify the units to which the imported geometry will be 

converted as well as the postprocess options listed here:

Check Parts During Load  This option performs a quality check on the imported data. Bad 

data is marked with a symbol in the browser and any remaining data is not checked. If the 

parts are determined not to have any errors, they are marked with a green check mark in the 

browser. Checking parts can signifi cantly increase the time required to translate fi les.

Auto Stitch  This option stitches surfaces into a quilt or solid, when possible. If the stitch 

results in a single body, it is promoted out of the construction environment; otherwise, it 

remains in the construction environment.

Enable Advanced Healing  This option allows small alterations in the surface geometry in 

order to stitch the surfaces.
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CATIA Import Options
When importing CATIA (Computer-Aided Three-Dimensional Interactive Application) V4 or 

V5 fi les, you can choose between solids, surfaces, meshes, wires, and points. You can use the 

fi le mi_14a_014.CATProduct in the Chapter 14 directory of your Mastering Inventor 2014 

folder to explore the import options for these fi les. To open CATIA fi les, follow these steps:

 1. Click Open on the Get Started tab.

 2. Set the Files Of Type drop-down to CATIA V5 Files (*.CATPart; *.CATProduct).

 3. Select the CATIA fi le you want to open and click the Options button.

In the Entity Types To Import area, use the selection buttons to specify the inclusion of solids, 

surfaces, wires, and points in the import action. Use the Import Assembly As Single Part check 

box to turn a multi-body CATIA fi le into a single-part fi le. Then choose from one of two options:

Single Composite Feature  Imports the assembly as a single composite feature into a 

single-part fi le.

Multiple Solid Part  Imports the assembly as individual solid bodies into a single-part fi le.

If you leave the Import Assembly As Single and Import Into Repair Environment check boxes 

deselected, you can specify how surface objects will be translated:

Individual Surface Bodies  Imports surfaces as individual surfaces in a single-part fi le.

Single Composite Feature  Imports surfaces as a single composite in a single-part fi le.

Pro/ENGINEER Import Options
You can use the fi le mi_14a_014.asm located in the Chapter 14 directory of your Mastering 

Inventor 2014 folder to explore the import options for Pro/ENGINEER fi les. To open models 

created in Pro/ENGINEER, follow these steps:

 1. Select Open from the Get Started tab.

 2. Set the Files Of Type drop-down to Pro/ENGINEER (*.prt*; *.asm*) or (*.g) or (*.neu*).

 3. Select the Pro/ENGINEER fi le you want to open, and click the Options button.

In the Entity Types To Import area, use the selection buttons to specify the inclusion of solids, 

surfaces, wires, work planes, work axes, and work points in the import action. Use the Import 

Assembly As Single Part check box to turn a multi-body Pro/ENGINEER fi le into a single-part 

fi le. Then choose from one of two options:

Single Composite Feature  Imports the assembly as a single composite feature into a single-

part fi le.

Multiple Solid Part  Imports the assembly as individual solid bodies into a single-part fi le.

If you leave the Import Assembly As Single and Import Into Repair Environment check boxes 

deselected, you can specify how surface objects will be translated:
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Individual Surface Bodies  Imports surfaces as individual surfaces contained in a single-

part fi le.

Single Composite Feature  Imports surfaces as a single composite in a single-part fi le.

To import Pro/ENGINEER parts or assemblies that contain instances of family tables, the 

accelerator fi les (*.xpr or *.xas) must be saved independently of the Pro/ENGINEER part and 

assembly fi les.

When the fi les are opened in Inventor, they will consist of a base solid, work features, and 

a translation report. You can then add features to the base solid using standard Inventor part-

modeling tools.

Unigraphics and Parasolids Import Options
You can access Unigraphics and Parasolids fi les in the same way you would Pro/ENGINEER 

fi les. You can use the fi le mi_14a_014.prt located in the Chapter 14 directory of your 

Mastering Inventor 2014 folder to explore the import options for Pro/ENGINEER fi les. To do 

so, follow these steps:

 1. Click Open on the Get Started tab.

 2. Set the Files Of Type drop-down to Parasolids Text Files (*.x_t), Parasolids Binary Files 

(*.x_b), or Unigraphics (*.prt).

 3. Browse for the fi le you want to open and click the Options button.

In the Entity Types To Import area, use the selection buttons to specify the inclusion of wires, 

solids, surfaces, and points in the import action. Use the Import Assembly As Single Part check 

box to turn a multi-body Parasolid fi le into a single-part fi le. Then choose from one of two 

options:

Single Composite Feature  Imports the assembly as a single composite feature into a single-

part fi le.

Multiple Solid Part  Imports the assembly as individual solid bodies into a single-part fi le.

If you leave the Import Into Repair Environment and Import Assembly As Single Part check 

boxes deselected, you can specify how surface objects will be translated. Here are the options:

Individual Surface Bodies  Imports surfaces as individual surfaces contained in a single-

part fi le.

Single Composite Feature  Imports surfaces as a single composite in a single-part fi le.

SolidWorks Import Options
You can use the fi le mi_14a_014.SLDASM located in the Chapter 14 directory of your Mastering 

Inventor 2014 folder to explore the import options for SolidWorks fi les. To open models cre-

ated in SolidWorks, follow these steps:

 1. Click Open on the Get Started tab, and set the Files Of Type drop-down to SolidWorks 

(*.prt, *.sldpart, *.asm, and *.sldasm).

 2. Select the SolidWorks fi le you want to open, and click the Options button.
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In the Entity Types To Import area, use the selection buttons to specify the inclusion of wires, 

solids, and surfaces in the import action. Use the Import Assembly As Single Part check box to 

turn a multi-body SolidWorks fi le into a single-part fi le. Then choose from one of two options:

Single Composite Feature  Imports the assembly as a single composite feature into a single-

part fi le.

Multiple Solid Part  Imports the assembly as individual solid bodies into a single-part fi le.

You can use the Import Multiple Solid Parts As Assembly check box to turn a multi-body 

SolidWorks fi le into individual part fi les. When imported, the new Inventor parts will be given a 

name based on the name of the original fi les.

If you leave the Import Into Repair Environment and Import Assembly As Single Part check 

boxes deselected, you can specify how surface objects will be translated. Here are the options:

Individual Surface Bodies  Imports surfaces as individual surfaces in a single-part fi le.

Single Composite Feature  Imports surfaces as a single composite in a single-part fi le.

Rhino Import Options
You can use the fi le mi_14a_014.3dm located in the Chapter 14 directory of your Mastering 

Inventor 2014 folder to explore the import options for Rhino fi les. To open models created in 

Rhino, follow these steps:

 1. Click Open on the Get Started tab, and set the Files Of Type drop-down to Rhino (*.3dm).

 2. Select the Rhino fi le you want to open, and click the Options button.

In the Entity Types To Import area, use the selection buttons to specify the inclusion of solids, 

surfaces, wires, and/or points in the import action. Use the Data Organization options to select 

how the fi le will import:

Create Surfaces As  Select the surface types to create during the import. You can choose 

from the following options:

Individual Surface Bodies  Imports each surface as a single surface body in the part 

environment.

Single Composite Feature  Imports the surfaces as a single composite in the part 

environment.

Multiple Composite Features  Imports the surfaces as multiple composites in the part.

IDF Board Files
Intermediate Data Format (IDF) is the standard data exchange format for transferring printed 

circuit assembly (PCA) fi les between printed circuit board (PCB) layouts and mechanical design 

programs. You can access IDF board fi les by clicking Open on the Get Started tab and setting 

the Files Of Type drop-down to IDF Board Files (*.brd, *.emn, *.bdf, and *.idb).

IDF board fi les can be imported into Inventor as assembly or part fi les. When brought in 

as an assembly, board components are translated into individual parts contained in the new 

assembly. When imported as a part, the board components are translated into sketches and fea-

tures. Inventor will translate IDF outlines, keepouts, group areas, drilled holes, and components.
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Part fi les are automatically named based on the information in the existing board fi le. Once 

imported, the fi les can be placed into Inventor assemblies and detailed in Inventor drawings just 

as you would any other Inventor model. Figure 14.10 shows the IDF import options. You are pre-

sented with this dialog box automatically when you open an IDF board fi le.

Figure 14.10

Importing an IDF 

board fi le

You can use the fi le mi_14a_014.brd located in the Chapter 14 directory of your Mastering 

Inventor 2014 folder to explore the import options for IDF fi les.

Placing Components from Other CAD Systems
So far, you have learned about importing and translating fi les into Inventor using the Open 

dialog box to convert them into Inventor fi les. You can also access most of these fi le types in 

the assembly environment and place them straight into your Inventor assembly fi le just as you 

would any other model.

To place a non-Inventor component into an Inventor assembly, click the Place Components 

icon in the Assembly panel. In the Open dialog box, select the fi le type of the component you 

intend to place, or set the fi le type to All Files. Select the fi le, and then click the Options button. 

Confi gure the options as required, and click the OK button. Click Open to translate and place 

the component into the assembly.
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Configuring Your System to Translate Automatically

Depending on how you work with translated fi les, you might want to confi gure your system to 

automatically translate other CAD formats to Inventor fi les when they are accessed. For instance, 

if you use a lot of supplier content from a website that downloads in the form of STEP fi les, you 

could set up Inventor to be the default application to open STEP fi les. To do so, right-click a STEP 

fi le in Windows Explorer and choose Open With and then choose Default Program. In the result-

ing dialog, choose Inventor or click the Browse button and browse for Inventor. Now when you 

double-click a STEP fi le, it will automatically be translated and opened as an Inventor fi le with the 

last set of options you used.

Working with Imported Data and Using Inventor Fusion
In a perfect world, you would not need to import or export data at all. Instead, all fi les would 

exist in one perfect, universal fi le format. Of course, this perfect world does not exist, and you 

are probably required to import fi les created in another program from time to time. In a near-

perfect world, imported data would always come in healthy and without any problems. But that 

is rarely the case.

Instead, importing data can sometimes be a struggle. Typically, the biggest struggles come 

with importing surface models. Inventor provides a construction environment for repairing 

poorly translated surfaces. Once repaired, imported surfaces must be promoted to the part envi-

ronment for use in parametric modeling or so they can be seen in an assembly.

You can add features to the base solid by sketching any of the desired surfaces and using the 

standard Inventor part-modeling tools.

The Autodesk® Inventor® Fusion application installs as an add-in and allows you to quickly 

manipulate data from all of the applications listed in the translation information. Note that 

in order to use the Inventor Fusion tools, you must have selected to install them during the 

installation and setup of Inventor. You also need to set the Inventor option to edit base solids 

with Fusion. Select the Tools tab and click the Application Options button; then select the Part 

tab in the Application Options dialog box. Toward the bottom of the dialog box, you will see an 

option called Edit Base Solids Using. Set it to Inventor Fusion. To edit the imported body, follow 

these steps:

 1. On the Get Started tab, click the Open button.

 2. Browse for and select the fi le mi_14a_003.ipt located in the Chapter 14 directory of 

your Mastering Inventor 2014 folder.

 3. Right-click the Base1 feature in the browser and choose Edit Solid.

This will open a dialog (Figure 14.11) informing you that Inventor will open the Inventor 

Fusion 2013 application to edit the base solid.
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Figure 14.11

Base solids are 

edited with 

Inventor Fusion.

 4. Click the OK button to open Inventor Fusion.

 5. Once the model is open in Fusion, rotate it so that you can see the bottom edge, as shown 

in Figure 14.12.

Figure 14.12

Editing the com-

ponent in Inventor 

Fusion

 6. Select the circular face of the bottom of the shaft, as shown in Figure 14.13.

Figure 14.13

Extending or con-

tracting a solid 

body

 7. Once the face is selected, right-click and choose Press-Pull.



VIEWING DWF MARKUP | 685

 8. Drag the yellow arrow out until the Value frame reads 1 cm, as shown in Figure 14.14.

Figure 14.14

Moving a face

 9. Right-click again and select the OK button (green check mark) to accept the edit.

 10. Select the Return To Inventor button at the right end of the ribbon to transfer the changes 

back to Inventor.

Selecting the Return To Inventor icon will reopen Inventor and close Fusion. This is only a 

basic example of the potential interaction between Fusion and Inventor.

Viewing DWF Markup
Autodesk® Design Review (ADR) software offers Inventor users and anyone they work with a 

simple and effective way to view and mark up both 2D and 3D DWF fi les. Design Web Format 

(DWF) fi les are lightweight versions of your Inventor fi les that you can publish from Inventor 

and email to a collaborator to be viewed and redlined with ADR. Non-Inventor users can down-

load and install ADR free of charge from the Autodesk website.

The DWF markup process begins from within Inventor where you will publish a DWF from 

your Inventor fi les. Once the DWF is published, it is sent to the reviewer and marked up with 

ADR. You can then bring those markups into your Inventor fi le and change the status of a 

markup, add comments, or accept the markup. You have the additional choice of publishing to 

DWFx format, allowing reviewers to access the fi le directly through Internet Explorer.

A typical DWF markup process is as follows:

Publish  You write out the DWF fi le from Inventor 2D and/or 3D fi les.

Receive  The reviewer receives the DWF fi le from you and opens it with ADR to check for 

errors and omissions.

Review  The reviewer can comment on and mark up the DWF fi le using callouts, text 

blocks, shapes, dimensions, stamps, and custom symbols. Then they save those markups to 

the DWF fi le.

Return  The reviewer then sends the markups back to you for your review.

Revise  You load the marked-up DWF into Inventor and revise the Inventor fi les as 

required.

Republish  After revising, you write out the DWF fi le from Inventor 2D and/or 3D fi les 

again.
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Publishing a DWF or DWFx File
With the fi le you intend to publish open in Inventor, click the Inventor button and select 

Export ➢ Export To DWF, which opens the Publish dialog box. There are three options for 

publishing the DWF or DWFx:

Express  Publishes only the active sheet without the 3D model.

Complete  Publishes all sheets and all 3D models except sheets excluded from printing.

Custom  Chooses sheets and 3D models to publish, depending on the type of fi le you are 

publishing. Extra tabs appear in the Publish dialog box for each fi le type as required. Here’s 

what’s included for each fi le type when you are using the Custom option:

Drawing Files  The DWF or DWFx fi le includes all sheets and tables as well as the com-

plete referenced 3D models.

Assembly Files  The following assembly options are available:

 ◆ The DWF or DWFx fi le includes the assembly with view and positional representa-

tions as well as enabled BOM views.

 ◆ The DWF or DWFx fi le includes all members and the iAssembly table with view and 

positional representations.

 ◆ The DWF or DWFx fi le includes the assembly with view and positional representa-

tions as well as enabled BOM views, weld beads, and weld symbols.

 ◆ When an assembly is at any LOD other than the master, only that LOD is published to 

the DWF or DWFx. All view and positional representations, as well as enabled BOM 

views, are also published.

Part Files  The following part options are available:

 ◆ The DWF or DWFx fi le includes only the part model.

 ◆ The DWF or DWFx fi le includes the folded model and fl at pattern (if one exists).

 ◆ The DWF or DWFx fi le includes all iPart members and the iPart table.

 ◆ The DWF or DWFx fi le includes only the iPart model.

 ◆ The DWF or DWFx fi le includes the model with stress/constraint indicators as well as 

a stress scale.

Presentation Files  The DWF or DWFx fi le includes the presentation views, animations, 

and assembly instructions as well as the complete assembly.

DWF or DWFx fi les can be published with the ability to measure, print, and enable and dis-

able markups. They can be password protected for security also. Figure 14.15 shows the publish 

options for an iAssembly factory.

Once you choose the appropriate options, click Publish to specify either the DWF or DWFx 

format, and specify a location to create the fi le. The resulting fi le can be opened in Design 

Review to create markups.
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Figure 14.15

DWF or DWFx pub-

lish options

Reviewing and Marking Up DWF and DWFx Files
Once a DWF or DWFx fi le is open in Design Review, you can create markups in the form of call-

outs, text blocks, shapes, stamps, custom symbols, and measurements. Figure 14.16 shows the 

Markup & Measure tab.

Figure 14.16

Markup & Measure 

tools

When markups are created, they are listed in the Markups palettes and organized by the 

sheet on which they reside. Most markups contain the following collection of properties: Status, 

Notes, History, Created, Creator, Label, Modifi ed, and Sheet. Drawn markups such as lines do 

not have properties.

Each markup can have its own status. The status can be <None>, For Review, Question, or 

Done. When you click a markup in the Markups palettes, the screen will zoom to the markup at 

the same zoom scale at which it was created. Once markups are complete, the DWF or DWFx fi le 

can be saved. Figure 14.17 shows a view marked up in Design Review.
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Figure 14.17

Marked-up view in 

Design Review

Accessing DWF or DWFx Markups in Inventor
To open a markup set in Inventor, select the Get Started tab and click Open; then choose DWF 

Markup File from the Files Of Type drop-down and select the DWF fi le to bring in. The DWF 

markups will be overlaid onto the Inventor drawing, and the Markups browser will display 

the markup set in the tree view. You can then edit the status and properties of each markup by 

right-clicking the markup in the browser, as shown in Figure 14.18.

Figure 14.18

Markups loaded 

into Inventor

To experiment with markups, you can open the fi le mi_14a_016.idw from the Chapter 14 

directory of your Mastering Inventor 2014 folder and use the fi le mi_14a_016.dwfx to import 

the markups.

DWF in the Real World

When communicating with vendors and clients who have never used Design Review and are accus-

tomed to receiving PDF fi les, I recommend that you do not force DWF on them. Generally, you will 

have much better luck getting the uninitiated to use and eventually request DWF fi les if you send 

them both PDF and DWF fi les initially. Include a link to the Design Review download on the 

Autodesk website in your email and mention that the download is free and that the fi les can be 

viewed in 3D. Th is approach allows the person on the other end to make the choice at their conve-

nience. Typically, once they have used Design Review, this is the format they will request.
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Once you’ve reviewed all markups, you can save the markups back to the DWF or DWFx fi le. 

You can choose to republish only the sheets that are marked up or republish all sheets. You can 

access these commands by right-clicking the DWF or DWFx fi lename in the Markups browser, 

as shown in Figure 14.19.

Figure 14.19

Saving and repub-

lishing markups

Th e Bottom Line

Import and export geometry.  In the design world today, you most likely need to transfer 

fi les to or from a customer or vendor from time to time. Chances are, the fi les will need to be 

translated to or from a neutral fi le format to be read by different CAD packages.

Master It  You are collaborating with another design offi ce that does not use Inventor. 

You are asked which you would prefer, IGES or STEP fi les. Which one should you 

request?

Use Inventor fi le translators.  Inventor offers native fi le translators for CATIA, Pro/ENGI-

NEER, SolidWorks, Unigraphics, and other CAD fi le types. This allows you to access these fi le 

formats with Inventor and translate the fi les into Inventor fi les directly.

Master It  You are a “job shop” and in the past have been required to maintain a copy 

of SolidWorks in addition to your copy of Inventor to work with customers who send you 

SolidWorks fi les. You would like to eliminate the cost of maintaining two software pack-

ages. What is a good strategy for doing that?

Work with imported data.  Using the construction environment in Inventor, you can repair 

poorly translated surface fi les. Often, a fi le fails to translate into a solid because of just a few 

translation errors in the part. Repairing or patching the surfaces and promoting the fi le to a 

solid allows you to use the fi le more effectively.

Master It  You download an IGES fi le from a vendor website, but when you attempt to 

use the component in your design, the surface data is found to have issues. How should 

you proceed?
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Work with Design Review markups.  Design Review offers you and the people you col-

laborate with an easy-to-use electronic markup tool that can be round-tripped from Inventor. 

Design Review markups can be made on both 2D and 3D fi les.

Master It  You want to use Design Review to communicate with vendors and clients 

to save time and resources, but you have found that others are unsure of what Design 

Review is and how to get it. What are some good ways to help others begin to use this 

handy application? 



Chapter 15

Frame Generator

Frame Generator consists of several tools to automate frame modeling. You can select lines, 

edges, and points to specify the location of members. Frame Generator derives the selections 

into a part. This part is called a skeleton because it provides the framework for the members. The 

skeleton part automatically updates when a change is made to the original geometry, which 

updates the frame member size or position.

Frame Generator gets structural profi les from Content Center. In addition to the structural 

profi les included in the Autodesk® Inventor® libraries, you can author and publish your own pro-

fi les. This capacity is useful for adding profi les of extruded aluminum, plastic, and other materi-

als because the structural profi les in the Inventor libraries are standard steel shapes.

In this chapter, you’ll learn to:

 ◆ Work with frame fi les

 ◆ Insert frame members onto a skeleton model

 ◆ Add end treatments to frame members

 ◆ Make changes to frames

 ◆ Author and publish structural profi les

 ◆ Create BOMs for Frame Generator assemblies

Accessing Frame Generator Tools
The Frame panel, shown in Figure 15.1, is on the Design tab of the Assembly ribbon. It has tools 

specifi c to Frame Generator plus the Beam/Column Calculator from the design accelerators.

Figure 15.1

Frame Generator 

tools on the Design 

tab of the Assembly 

ribbon



692 | CHAPTER 15 FRAME GENERATOR

The tools fall into four categories:

Creating Frame Members  Frame members can be created using the Insert Frame and 

Change tools.

Creating End Treatments  End treatments can be created with these tools:

 ◆ Miter

 ◆ Trim To Frame

 ◆ Trim/Extend

 ◆ Notch

 ◆ Lengthen/Shorten

 ◆ Remove End Treatments

Performing Maintenance  Maintenance can be performed with the Frame Member Info and 

Refresh tools.

Performing Calculations and Analysis  Calculations and analysis can be performed with 

the Beam/Column Calculator.

About Frame Generator

Th e Frame Generator application is an add-in that uses the Inventor application programming 

interface (API). Since the API does not provide access to all the Inventor functionalities, there are 

some user interface diff erences between add-ins and core Inventor tools. For example, the edit 

fi elds in the core Inventor tools have an extensive fl yout menu. Th e add-ins do not have access to 

this functionality, so their edit fi elds are more limited.

Exploring the Frame Generator File Structure
When you create the fi rst members in a frame assembly, a dialog box prompts you for fi lenames. 

Frame Generator creates a subassembly and a skeleton fi le in the parent assembly. The subassem-

bly does several things. It acts as a container for the skeleton and frame members, isolating them 

from the assembly solver, and it acts as a fi lter so Frame Generator tools, such as Frame Member 

Info, ignore other assembly components. The skeleton fi le is created in the subassembly and is 

made up of all of the edges and points you select when placing frame members. Each frame mem-

ber is created as a separate fi le and saved into a subdirectory named after the frame assembly.

As an example, imagine you create a cube to use as the basis on which to model a frame. You 

name the cube fi le Cube_Frame and then place this cube into an assembly called Cube_Frame_
Assembly. Both fi les are saved in a folder called My_Frames. You could then use the cube to 

create a basic frame, using each of its edges as a placement reference for the frame members. 

When you create the frame, you will be prompted to supply the following items:

 ◆ A new frame fi lename and location; these are the name and location of the frame 

subassembly.

 ◆ A new skeleton fi lename and location; these are the name and location of the frame 

skeleton reference.
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If you just accept the defaults, you will end up with a folder such as \My_Frames\Cube_Frame_

Assembly\Frame\. In this folder (once you have saved the top-level assembly), you will fi nd an 

assembly fi le named Frame0001.iam and a part fi le named Skeleton0001.ipt. Special attributes 

in the frame subassembly contain references to the parent assembly. This enables the frame skele-

ton to maintain references to the other assembly components. Figure 15.2 shows the default frame 

subassembly and skeleton fi le naming.

Figure 15.2

Creating a new 

frame

Make Sure You Save

When you click the OK button to create the Frame Generator assembly and place the fi rst mem-

bers, a folder is created in the directory. However, like all Inventor fi les created in the context of 

an assembly, the parts are not written to disk until you save the assembly. Th is is true when you 

create frame members as well, and since it is so easy to create members, it may not be obvious that 

you need to save them after the initial creation. Pay attention to the Save reminders and limit the 

amount of data you risk losing between saves.

Copying Frames

If you have a completed frame design that you would like to copy, you can use the iLogic Design 

Copy tool (see Chapter 20, “iLogic”) to do so. Keep in mind that you needn’t have used iLogic to 

use the iLogic Design Copy tool for copying frames. You can fi nd the iLogic Design Copy tool by 

closing all of your Inventor fi les and then going to the Tools tab and looking on the iLogic panel.

Use the Assemblies list panel in the iLogic Design Copy dialog box to select the frame assembly you 

want to copy. All fi les referenced by the frame assembly will be selected in the other lists. You can 

then specify a target folder to copy to, and specify a naming prefi x or suffi  x as needed.

Once you start the copy process, the frame fi les will be copied and the internal references will 

be updated.

Note that there are a couple of limitations to be aware of. First, you cannot create more than 

one frame subassembly in the same assembly. Another limitation is that you can’t use copies 

of the frame generated with the assembly Copy tool in other assemblies and maintain Frame 

Generator functionality.
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Exploring the Anatomy of a Frame Member
Frame Generator initially creates frame members the same length as the selected geometry. 

When you add end treatments, the length is adjusted to make the member longer or shorter. To 

accomplish this, the structural profi les are created with a From-To extrusion between two work 

planes, as shown in Figure 15.3.

Figure 15.3

A typical frame 

member

When the part is fi rst created, the start plane is coincident with the XY plane and the end 

plane is set to the initial length. When an end treatment is added, the start or end plane is 

moved to shorten or lengthen the member.

The parameter relationships that control the length are complex. Three parameters drive 

the length, two parameters are driven by those parameters to determine the length, a reference 

parameter reports the overall length, and a parameter is used in the BOM, as indicated in 

Figure 15.4.

Table 15.1 lists the length parameters.

Table 15.1: Frame member parameters

Parameter Description

B_L Th e initial length of the member.

G_OFFSET_

START

Th e off set value of the start work plane.

G_OFFSET_END Th e off set value of the end work plane.

d13 Th e parameter for the start work plane. It is driven by G_OFFSET_START.

d14 Th e parameter for the end work plane. It is driven by G_OFFSET_END.

d19 A reference dimension that measures the overall length of the part.

G_L Th e length parameter that is used in the BOM. It is equal to the reference dimension.
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Figure 15.4

Frame member 

Parameters

Inserting Frame Members
The process for inserting frame members can be broken down into three basic steps. You select 

the frame member profi le (this comes from Content Center), select the placement geometry for 

placing the frame members, and then adjust the orientation of the frame members.

Specifying a Structural Shape
The left side of the Insert dialog box, shown in Figure 15.5, has a series of drop-down fi elds for 

specifying the structural shape.

Figure 15.5

Frame Member 

Selection group
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You use the Standard, Family, and Size fi elds to select the member from Content Center. 

These fi elds are progressive from top to bottom, with one updating when changes are made to 

the one above it. However, the update behavior varies depending on the fi eld selected. If you 

select a new standard, the fi rst family is automatically selected. If you select a new family, the 

size is not automatically selected.

Changing the Orientation
After you have selected the placement geometry, you can change the position and orientation of 

the member. A thumbnail of the profi le is displayed in a grid of radio buttons that control the 

position of the member, as shown in Figure 15.6. These positions are based on the rectangular 

bounds of the profi le. As a result, the corner positions of a pipe that’s 1 inch in diameter are the 

same as they are in a 1-inch-by-1-inch square tube. 

Figure 15.6

Orientation group

You can fi ne-tune the placement position by entering values in the horizontal and vertical 

offset fi elds. You can also rotate the member. For example, food processing equipment fre-

quently has horizontal members rotated 45 degrees so spilled food doesn’t build up on top of 

square tubing.

The Mirror Frame Member button is shown in the lower-right corner of Figure 15.6. This but-

ton is used for profi les that don’t have rotational symmetry, such as C-channel and angle iron. 

The orientation changes affect all the members of a select set. Depending on the geometry, it 

might be more effi cient to use a batch select tool and change the orientation of a few members 

afterward, or you might want to select only those members that have a similar orientation.

Since structural shapes are extruded, Frame Generator needs a method for determining 

the extrude direction. When an edge is selected, Frame Generator uses the closest endpoint as 

the start of the extrusion. Depending on where you select an edge, the same radio button can 

cause the member to be in a different position. The thumbnail is the view of the profi le look-

ing at the XY plane. It takes some practice to get a good feel for the relationship between how 

an edge is selected and the behavior of the radio buttons. Once you understand this relation-

ship, you will be able to predict the behavior and use it to increase your productivity.

Do I Need to Use D Sketches with Frame Generator?

Although you can use 3D sketches to base a frame on, you don’t need to. You can create 3D solids 

or surfaces to create a frame base. Once you have a 3D shape, you can then add 2D sketches to the 

various faces and use those sketches as selection edges as well. So you don’t need to be well versed 

in the 3D sketch tools to create 3D frames.
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When you’re using a custom profi le with an alternate insertion point defi ned, the Custom 

Point control is enabled. This adds another insertion point to the nine standard ones. The cus-

tom point is not displayed in the thumbnail image, so you should confi rm that the preview is in 

the expected position relative to the selected edge. Figure 15.7 shows a profi le with an alternate 

insertion point.

Figure 15.7

Profi le with an 

alternate insertion 

point

Selecting Placement Geometry
When selecting placement geometry, you can select edges of 3D models and visible sketch lines, 

or you can select two endpoints. For instance, if you had a cube-shaped base solid, you would 

use the edges to place vertical and horizontal frame members. To place diagonal cross bracing, 

you would use the corner endpoints.

Insert Selection Methods

When you use the default Insert Members On Edges option, you can select edges and lines 

for placement references. Using edges for placement allows you to insert multiple members 

at once. When you use the Insert Members Between Points option, you select two vertices or 

endpoints. This method allows you to place only one member at a time. The most common 

placement method is by selecting lines and edges. This allows the most fl exibility in geometry 

selection and the use of batch select tools.

There are two philosophies for placing frame members. Some people like to place frame 

members individually, making sure each one is in the correct position and orientation. Others 

like to place as many members as possible and then edit them as necessary. The method you 

choose will depend on the type of models you work with, how much effort you put into setting 

up the skeleton models, and, most importantly, the way you like to work.

Batch Select Tools

Frame Generator has several tools for selecting geometry. Multi Select is the default selection 

mode. The standard methods for creating a Multi Select selection allow you to select individual 

edges, use selection windows, and use the Shift and Ctrl keys to add and remove objects to or 

from the selection. In addition to Multi Select, two other select modes are available in the con-

text menu shown in Figure 15.8; they are Chain Select and Sketch Select.
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Figure 15.8

Select mode context 

menu

Chain Select automatically selects all lines and edges that are tangentially connected to the 

selection. Chain Select will not follow past a point that has multiple lines or edges, even if one 

of them is tangential. For instance, if you have a rectangular sketch profi le with rounded cor-

ners, you can use Chain Select and select just one of the lines or arcs, and all of the others will 

be added automatically. By contrast, if you have the same profi le in a 3D shape, Chain Select 

will not automatically select the edges, because each edge of the 3D shape has multiple edge 

intersections.

Sketch Select selects all the lines in a sketch. You can select the sketch in the browser or click 

a line in the graphics window. For instance, if you have a ladder-shaped sketch, you can use 

Sketch Select and automatically select the rungs and rails all at once.

The Merge option is enabled when there are connected lines or edges. Merge combines the 

selections into one member. Although Merge is useful when you want to have one continuous 

member, you cannot add end treatments to merged members.

Creating a Basic Frame
To create an elementary frame, you’ll use a prepared fi le that has been set up for you. If you have 

not already downloaded the Chapter 15 fi les from www.sybex.com/go/MasteringInventor2014, 

please refer to the “What You Will Need” section of the Introduction for the download and setup 

instructions.

The prepared fi le you’ll be using is an assembly fi le consisting of just two parts and the frame 

subassembly. One of the parts contains an unconsumed sketch that you will use to place frame 

members. The frame members will be automatically placed in the predefi ned frame subassem-

bly. When creating your own frame designs from scratch, you’ll be asked to supply the name 

and locations for the frame subassembly and skeleton fi les. In this design, you’ll add frame 

members to be embedded in a monument base to support a sign plate:

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for mi_15a_001.iam located in the Chapter 15 directory of your Mastering 

Inventor 2014 folder, and click the Open button.

 3. From the Design tab, click the Insert Frame button.

 4. Set the Standard drop-down box to use the standard of your choice.

 5. Set the Family drop-down box to use a square tube or square hollow section profi le.

 6. Set the Size drop-down box to use an 80 mm×80 mm (or 3"×3") section, using a wall thick-

ness of your choice.

 7. Select the middle vertical sketch line on the back of the sign plate in the model.

 8. Use the radio buttons in the Orientation area of the Insert dialog box to orient the frame 

member so it matches up with the square cutout in the base.

http://www.sybex.com/go/MasteringInventor2014
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 9. Select the other four vertical sketch lines as well. Note that the two end members are not 

centered in the cutouts.

 10. Holding the Ctrl key, select the two end members to remove them from the selection.

 11. Click the OK button to generate the frame members; then click the OK button in the 

Frame Member Naming dialog box to accept the defaults.

 12. Click the Insert Frame button again and click the bottom half of one of the outside verti-

cal sketch lines.

 13. Use the radio buttons in the Orientation area to orient the frame member so it matches up 

with the square cutout.

 14. Select the bottom half of the other outside vertical sketch line, and notice that the frame 

member preview does not match the cutout.

 15. Using the Orientation radio buttons, you’ll notice that none of the solutions allow both 

members to match the cutouts.

 16. Holding the Ctrl key, click one of the frame members to remove it from the selection.

 17. Select the sketch line again, this time toward the top, and you’ll see that this fl ips the 

orientation to provide the correct solution.

 18. Uncheck the Prompt For File Name check box (found along the bottom of the dialog box). 

This suppresses the fi le-naming dialog prompt and automatically accepts the default 

naming for the frame members.

 19. Click the OK button. Your assembly should resemble Figure 15.9.

Figure 15.9

Frame members 

placed using Frame 

Generator

In this simple example you explored the basics of placing frame members, noting the use of 

the Ctrl key on the keyboard to remove selections. You also noticed that orientation of frame 
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members is sometimes infl uenced by the location of your lines or edge selections. You can close 

this fi le without saving changes and continue to the next section. In the next example, you’ll 

explore more selection and orientation options.

Where Are the Other Common Sizes?

You might note that there are several common sizes you use daily that are not listed in the Size 

drop-down. Th is is because Inventor includes only the sizes that are ratifi ed to the various structural 

shape standards. Of course, most mills produce other sizes commonly used in general design. You 

can add those sizes using the Structural Shape authoring tools.

In the following steps you will explore the offset, rotation, and merge options, as well as the 

context menu selection options:

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for mi_15a_002.iam in the Chapter 15 directory of your Mastering Inventor 

2014 folder, and click the Open button.

 3. From the Design tab, click the Insert Frame button.

 4. Set the Standard drop-down box to use the standard of your choice.

 5. Set the Family drop-down box to use a fl at bar section profi le.

 6. Set the Size drop-down box to use a 50 mm (or 2-inch) bar, using a thickness of your 

choice.

 7. Right-click in the graphics area, and set the selection method to Chain Select.

 8. Click on any part of the C-shaped sketch, and notice that the entire sketch loop is 

selected; you don’t need to click each sketch segment.

 9. Set the Horizontal Offset to -100 mm.

 10. Set the Rotation to 90 degrees.

 11. Click the Merge check box to ensure that the result is a continuous piece of rolled fl at bar 

rather than a piece for each segment of the loop.

 12. Click Apply to create the frame member.

 13. Right-click in the graphics area, and set the selection method to Sketch Select.

 14. Select any of the segments in the ladder sketch, and notice that the entire sketch is 

selected.

 15. Set the horizontal offset to 0 mm and the rotation to 0 degrees.
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 16. Click Apply to create the frame members.

 17. Right-click in the graphics area and set the selection method back to the default Multi 

Select option.

 18. In the Placement area of the Insert dialog box, click the Insert Members Between Points 

button, and then select endpoints of the gap in the C-shaped sketch.

 19. Set the rotation to 90 degrees.

 20. Click the OK button to create the short length of fl at bar, and close the dialog box. 

Figure 15.10 shows the fi nal result.

Figure 15.10

Flat bar frame 

members

As you can see, the selection options along with the offset, rotation, and merge options allow 

you to create frame members using just a simple sketch and still get a varied result. You can 

close this fi le without saving changes and continue to the next section.

Aligning Frame Members
Frame Generator follows two rules to give a frame member its initial orientation. If you are 

creating the fi rst member in a selection set, the member is aligned to adjacent geometry or the 

coordinate system. For the rest of the selection set, Frame Generator tries to align the members 

to the fi rst selection. These rules work well for most rectangular machine frames. However, if 

part of the frame is at an angle and there isn’t a good reference, Frame Generator might select an 

orientation that doesn’t match your design intent.

The frame in Figure 15.11 has two sketch lines running down from the center point to be 

used for supports. The members for the base and back have already been inserted, and the two 

angled supports need to be inserted. When a member is inserted on angled lines, the orientation 

is skewed, as shown in the inset in Figure 15.11.
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Figure 15.11

Skewed orientation

To resolve this, a reference line can be selected fi rst to establish the orientation, and then the 

angled line can be selected to add the support member and have it follow this orientation. Once 

the angled line is selected, the reference line can be deselected and the angled line will hold the 

proper orientation, as shown in Figure 15.12.

Figure 15.12

Using a helper 

line to establish 

orientation

Using reference geometry for angled frame members is a bit of an art. If you regularly create 

these types of frames, you will develop a feeling for the ways that Frame Generator aligns mem-

bers, and you will learn when and how you need to add references. To better understand the use 

of reference geometry for alignment, follow these steps:

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for mi_15a_003.iam located in the Chapter 15 directory of your Mastering 

Inventor 2014 folder, and click the Open button.

 3. From the Design tab, click the Insert Frame button.

 4. Set the Standard drop-down box to use the standard of your choice.
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 5. Set the Family drop-down box to use a rectangular tube or rectangular hollow section 

profi le.

 6. Set the Size drop-down box to use a 100 mm×50 mm (or 4"×2") tube, using a thickness of 

your choice.

 7. Ensure that the placement option is set to Insert Members On Edges and that the offsets 

and rotation fi elds are set to zero. Set the orientation to be centered, and then click the 

diagonal line that runs into the frame peak.

 8. Click the OK button to create the member.

Notice how the frame member is coming in at a skewed orientation. To resolve this, you 

will fi rst delete this member and then place another, but this time you’ll use a helper edge 

to establish the orientation.

 9. In the browser, expand Frame_MI_1503 so you can see the frame members.

 10. Hover over each member until you see the one you just created highlighted in the graph-

ics area (it should be at the bottom of the list).

 11. Right-click it and choose Delete With Frame Generator.

Using this option not only deletes the part, but also cleans up any end treatments involv-

ing other members related to the deleted one.

 12. Click the Insert Frame button again. Click the diagonal line that runs into the frame peak 

fi rst, and then select the Align check box.

 13. Click the sketch line located in the base of the frame to use as the alignment selection.

 14. Adjust the rotation angle by 90 degrees.

 15. Click the OK button to create the frame member in the correct orientation.

Keep this alignment trick in mind as you create frames, and you will likely fi nd it to be very 

helpful. You can close the fi le without saving changes.

Using the Change Tool
You can use the Change tool to change the standard, family, size, material, color, and orientation 

of an existing frame member. You can use the check boxes to set the various options to allow or 

prevent changes. To see the Change tool in action, follow these steps:

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for mi_15a_004.iam located in the Chapter 15 directory of your Mastering 

Inventor 2014 folder, and click the Open button.

 3. From the Design tab, click the Frame panel drop-down arrow.

 4. Select the Frame Member Info button from the list.

 5. Click one of the shorter uprights in the frame. The Frame Member Info dialog box dis-

plays the information about this part. Click Done to close the dialog box.
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 6. From the Design tab, click the Change button.

 7. Click one of the shorter uprights in the frame again, and then select the other one. Notice 

that the selection allows only one frame member to be selected at a time.

 8. Click the Multi Select check box in the Change dialog box, and then select the other short 

upright member.

 9. Click the Change Orientation check box and then set the rotation to 45 degrees.

 10. Change the Appearance setting to Cadet Blue or something similar, and then click the 

OK button.

This simple exercise demonstrates the use of the Change tool to modify frame members. 

Keep in mind that if you make a change that requires a new fi le to be generated, such as chang-

ing the size, the old part will be replaced with a new one but the old fi le will remain in the 

folder in which it is saved. You can close this fi le without saving changes.

Adding End Treatments
The end treatments are among the most powerful Frame Generator tools. As you add end treat-

ments, the frame member length automatically updates. The end treatments also carry over if 

you change the frame member to a different profi le. End treatments are listed under the frame 

member node in the browser and can be accessed by expanding the browser node, as shown in 

Figure 15.13.

Figure 15.13

End treatments in 

the browser

You can delete end treatments from the browser, or you can use the Remove End Treatments 

tool found on the Frame drop-down list of the Design tab. When you use the Remove End 

Treatments tool, all end treatments are stripped from the selected frame member.

If a member has end treatments on it already and you attempt to add another, you will need 

to select the Delete Existing End Treatment(s) check box in the dialog box; otherwise, an error 

such as the one shown in Figure 15.14 may be created.

If you do encounter an error, simply undo the change and reapply the end treatment, this 

time using the Delete Existing End Treatment(s) option.
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Figure 15.14

Confl icting end 

treatment error

Miter
The Miter end treatment makes angle cuts on two members. Figure 15.15 shows the Miter dialog 

box. You can miter multiple members by applying the end treatment to each pair of members. 

You can add a gap between the members by entering a value in the gap input box. The default 

gap is split between the two members. If you want the gap to be taken from just one member, you 

can use the Miter Cut At One Side button, and the gap will be taken from the fi rst member you 

selected. The gap option buttons and input box are shown in Figure 15.15.

Figure 15.15

Miter dialog box

The default selections cut along an angle, resulting in full-face contact between the members, 

as shown in Figure 15.16. Bi-sect Miter splits the angle between the members. Figure 15.17 shows 

that the cut is located where the centers of the two members intersect.

Figure 15.16

Th e standard miter 

joint has full-face 

contact.
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Figure 15.17

Th e optional bi-sect 

miter cuts both 

members at the 

same angle.

Figure 15.18 shows a one-sided gap where the horizontal member was selected fi rst.

Figure 15.18

Miter gap on one 

member

Figure 15.19 has a miter end treatment between the two angled members, and a vertical mem-

ber running through them. The vertical member needs to be mitered to fi t. Figure 15.19 shows 

the left member and the vertical member being selected for the fi rst step to create the miter.

Figure 15.19

First miter cut

The vertical member still needs a miter to trim the other side, so the miter is repeated with 

the same settings, this time choosing the member on the right and the vertical member, as 

shown in Figure 15.20.

The resulting miter, shown in Figure 15.21, requires two cuts on each member. An alternate 

method that produces a more cost-effective joint can be made using the Trim/Extend To 

Face tool.
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Figure 15.20

Second miter cut

Figure 15.21

Resulting miter 

joint between the 

three members

You can open the fi le mi_15a_006.iam to explore the Miter tool. Practice creating miter gaps 

and two- and three-member miters to understand the process.

Trim/Extend to Face
This end treatment is the only one that can trim multiple members at once. When trimming or 

extending to a face, you select the members you want to trim and then select the cutting face. A 

separate end treatment feature is created for each frame member. If you edit or delete the end 

treatment for a particular member, it does not affect the other members. Figure 15.22 shows a 

typical trim-to-face situation. You would select the vertical member for the member to trim and 

the top face of the horizontal member as the face to trim to.

Figure 15.22

A trim-to-face 

scenario
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This end treatment can also be used to create miters. Applying miter end treatments to 

already mitered frame members results in a costly complex joint cut for all three members. 

Trimming the third member to fi t the fi rst two angled members using the Trim/Extend To Face 

tool, results in the less-expensive detail shown in Figure 15.23.

Figure 15.23

Creating a miter 

using Trim

You can open the fi le mi_15a_007.iam to explore the Trim/Extend tool. Remember, you can 

select multiple frame members to trim to the same face. Experiment with this fi le as you like—

there is no set solution to the fi nal frame outcome.

Which Side Is Trimmed?

Be aware that when using the Trim tools in Frame Generator, the short end is always the one to 

be discarded.

Trim to Frame Member
This end treatment trims or extends both members so they are fl ush. The fi rst selection is made 

fl ush to the second selection, and the second selection butts up to the fi rst. Figure 15.24 shows 

the selections, and Figure 15.25 shows the results.

Figure 15.24

Trim To Frame 

selections

You can open the fi le mi_15a_008.iam to explore the Trim To Frame tool. Experiment with 

this fi le as you like—there is no set solution to the fi nal frame outcome. If you cannot get the 

result you want from the Trim To Frame tool alone, consider the Trim/Extend To Face tool as 

well. These tools are often used together to achieve a specifi c result.
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Figure 15.25

Trim To Frame 

results

Notch Frame Members
The Notch tool cuts one frame member to match the other. It uses the profi le to create a cut-

ting surface. By default you can’t create an offset, so the cut is an exact match. This is simply 

a cut operation, so the frame member is not shortened or extended before the cut. If you have 

authored a notch profi le into a custom frame member library fi le, you can select the Apply 

Notch Profi le check box; however, if the member does not contain a notch profi le defi nition, the 

check box is grayed out.

If you were to notch the shorter I-beam shown in Figure 15.26, which extends past the taller 

I-beam, the extra lump would remain on the left, as shown in Figure 15.27. If the members don’t 

intersect, the notch will have no effect.

Figure 15.26

Frame members 

before notch

Figure 15.27

Th e result of remov-

ing the intersecting 

material

Because of this, it’s often best to create a notch as a secondary end treatment. For example, 

if you had two intersecting frame members as shown in Figure 15.26, it might be best to add 

a Trim/Extend To Face end treatment fi rst and then use a notch to remove any intersecting 
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material. To explore the Notch tool, open the fi le mi_15a_009.iam. Use the fl anged beams to cre-

ate notches in the T-shaped members.

Creating Accurate Notches

Notch shapes are driven by manufacturing requirements. Typically, the shape is simplifi ed to reduce 

cost, and there may be a gap between the members to allow for tolerances. Th e easiest way to create 

these shapes is to add a Trim/Extend To Face to make the member the correct length and then add 

an iFeature to trim the end of the member to the correct shape. You can also defi ne notch profi les 

in custom frame member defi nitions.

Lengthen/Shorten Frame Member
You can use the Lengthen/Shorten tool to change the length of a frame member. By default, 

frame members are initially assigned the length of the reference edge or the distance between 

selected points. However, you will often have the need to change the length. Much of the time 

you will simply use another frame member and one of the Extend or Trim tools. Sometimes, 

though, there isn’t another frame member you can use as a reference, so in those cases you 

would use the Lengthen/Shorten tool.

When you use the Lengthen/Shorten At One End option, the Extension value is applied 

to the end closest to the pick point, meaning that if you select a vertical frame member toward 

the top end and specify an extension length of 100 mm, that value will be applied to the top 

end. When using the Lengthen/Shorten At Both Ends option, the Extension value is applied 

to both ends. So if you applied a 100 mm extension value, the frame member would grow 100 

mm on both ends for a total of 200 mm. If you enter a negative value, the frame member will 

be shortened.

Frame End Treatments Are Not Exempt from Design Intent

You should spend time planning your frame design to minimize the number of end treatments 

required, because each end treatment is an opportunity for the model to fail if a change is made. 

For example, if you create a skeleton to the inside dimensions of a frame, you can off set members 

during placement so the members butt against one another without adding end treatments.

Maintaining Frames
Maintaining existing assemblies can be time consuming. Frame Generator provides several 

tools that help streamline the process of modifying end treatments, and determining how 

frames were originally designed.

Remove End Treatments
The Remove End Treatments tool removes all end treatments from a selected frame member. 

You can also select multiple members for the batch removal of end treatments. This is handy if 
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you need to change the end treatments on a few members or if you have to rebuild a frame. You 

can fi nd the Remove End Treatments tool in the Frame drop-down list indicated by the small 

black arrow found on the Frame panel of the Design tab. (See Figure 15.1 earlier in the chapter.)

Frame Member Information
The Frame Member Information tool is used to query frame members. It displays the family 

and size information, mass properties, and material. This is a useful tool because it quickly 

gives you information about a member. For example, it can help you quickly determine the dif-

ference in the wall thickness of two similarly sized hollow tubes. Since the tool fi lters for only 

frame members, you can use it at any level of the assembly. You can fi nd the Frame Member 

Information tool in the Frame drop-down list indicated by the small black arrow found on the 

Frame panel of the Design tab.

Refresh
The Refresh tool is a Content Center tool. It checks Content Center for the latest revision of the 

members in the frame. If a newer version is available, it will prompt you to replace it. End treat-

ments are retained during refresh, but other features, such as holes, are not carried over to the 

new member. You can fi nd the Refresh tool in the Frame drop-down list indicated by the small 

black arrow found on the Frame panel of the Design tab.

Managing Frame Generator Files

Frame Generator uses an algorithm to create default fi lenames. You can rename the fi les as you 

create them, when prompted by the Frame Member Naming dialog. But often this slows the design 

process and requires you to enter information you may not currently know.

Another approach is to let Inventor apply the fi lenames automatically. To do so, you can uncheck 

the fi le-naming prompt check box in the Insert Frame dialog box, and Inventor will create the 

fi lenames and save the fi les to the location specifi ed when the frame subassembly and skeleton 

fi les were initially created. It is a good idea to set the frame subassembly and skeleton fi lenames 

and locations to use a well-planned naming scheme, whether you specify the frame member names 

or let Inventor do so.

If you decide to accept the default fi lenames, it is a good idea to use the BOM Editor to set the part 

number iProperty for each fi le to match your standard. In this way, you have a unique identifi er for 

each part member. You can set two identical frame members to have the same part number so they 

are rolled up together in the BOM. Using part numbers (you can think of them as mark numbers), 

rather than the fi lenames, to manage the frame members provides a more fl exible and real-world 

workfl ow for the typical frame design.

Once part numbers have been defi ned, you can also set the assembly browser to use the part num-

ber rather than the fi lenames. Th is allows you to quickly index individual frame parts more easily. 

Do this by selecting the Assembly tab, clicking the drop-down list on the Productivity panel, and 

choosing the Rename Browser Nodes tool.

Although Frame Generator can create frames (and therefore a lot of part fi les) very quickly, once 

the frame is modeled you should slow down and take the time to manage part numbers. Th is allows 

your design to be managed properly in the detailing and revision stages.

You can fi nd a supplemental PDF fi le called Frame Generator BOM in the Chapter 15 directory 

of your Mastering Inventor 2014 folder.
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Performing Calculations and Analysis
Included in the standard Frame Generator tools are two calculator tools: the Beam And Column 

Calculator and the Plate Calculator. These calculators are design accelerator tools that can do 

a simple stress analysis. The Beam And Column Calculator, for instance, can analyze a single 

beam or column, but it assumes a uniform cross section, so it does not take into account holes or 

end treatments.

If you have Inventor Professional or Inventor Simulation, you can use the Frame Analysis 

tools that are part of those packages. You can learn more about the Frame Analysis tools in 

Chapter 17, “Stress Analysis and Dynamic Simulation.”

Th e Beam and Column Calculator
You can fi nd the Beam And Column Calculator tool in the Frame drop-down list indicated by 

the small black arrow found on the Frame panel of the Design tab. As with other design accel-

erator dialog boxes, the message pane at the bottom and the calculation results pane on the right 

side can be opened and closed by clicking the small >> symbols. You can drag the splitter bar 

(double gray lines) to resize the panes, or you can double-click the splitter bar to open or close 

the panes.

Calculating Section Properties

As you explore the subjects in the following pages, you can refer to the conveyor assembly in the 

fi le mi_15a_014.iam. Take a moment to open this fi le from the Chapter 15 directory to become 

familiar with it. You will use this fi le to complete the exercise steps presented later.

Select an Object

In this assembly, the Beam And Column Calculator might be used to calculate the loading on 

the power roller supports. When one of the gold tubes is selected, the calculator automatically 

loads the section properties from Content Center, as shown in Figure 15.28. Although Content 

Center has most of the section properties, be aware that some data is missing. You can use sev-

eral methods for determining the properties.

Figure 15.28

Th e section proper-

ties for a selected 

object are loaded 

from Content 

Center.
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Use the Region Properties Tool

Inventor has a tool to calculate the properties of a closed sketch profi le. If you want to use this 

tool for the section properties of a frame member, you can open the frame member, place a 

sketch on one end, and project the face. Once you have the profi le, select the Inspect tab, and 

click the Region Properties tool found on the Measure panel. Select the profi le you want to ana-

lyze and click Calculate. The basic region properties for any closed loop are calculated. You can 

then calculate the rest of the properties based on those results.

The region properties are calculated with respect to the sketch origin. Depending on the pro-

fi le, you may have to edit the sketch coordinate system to locate the sketch origin at the center of 

the profi le.

Use the Section Button

Another option for calculating section properties is to use the Section button in the Beam And 

Column Calculator. When you click the button, a list of geometric shapes appears. When you 

select a shape, a dialog box like Figure 15.29 appears and allows you to enter dimensions. The 

calculated properties assume sharp corners and constant thickness, so the results won’t be accu-

rate for profi les with tapered fl anges, but may be good enough for many applications.

Figure 15.29

Calculating section 

properties for a 

rectangle

The Flip Section button is used to change the orientation of the x- and y-axes. The z-axis is 

always in the direction of the extrusion. Gravity is always in the negative y-axis direction, so it is 

important to make sure the calculation coordinates match the assembly coordinates. If the beam 

is at an angle, you have a couple of options for handling gravity. You can place a copy of the 

beam horizontally in the assembly. If you want to ignore the effect of gravity, there is an option 

on the Beam Calculation tab to turn the gravity load off.

Both Beam and Column calculations are available. The Beam calculations focus on defl ection 

based on loads and supports. The Column calculation checks for buckling. You can select Beam, 

Column, or both calculation types. The Calculation tabs are turned on and off based on the 

selections.

The default material properties do not correspond to a material style, and are not linked to 

the style library in any way. Instead, these materials provide you with a starting point and an 

example of the required properties. You can enter properties for a particular material, or you 

can select one of the generic materials listed. When you check the box, a dialog box appears with 

materials such as gray cast iron, steel, and aluminum. These properties can be used for initial 

calculations, but for more accurate results, you should enter the properties for the particular 

alloy you are using.
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The following steps use the power roller supports found in the conveyor assembly 

mi_15a_014.iam. Follow these steps to enter the member data into the dialog box:

 1. Click the Beam/Column button to start the calculator. Recall that this button can be 

found in the drop-down list indicated by the small black arrow found on the Frame panel 

of the Design tab.

 2. Select the lower, gold-colored support for the power roller.

 3. If necessary, click the padlock icon for the Section Length row in the table, thereby 

unlocking it for editing. Change the value to 12 inch.

 4. Click the Section button, and select Rectangle from the drop-down list.

 5. In the Rectangle dialog box, enter the tubing dimensions. Enter 1.5 inch for the outside 

dimensions (B and H) and 1.125 inch for the inside dimensions (b and h). Then click the 

OK button.

 6. Select both the Beam and Column calculation check boxes in the Calculation Type area.

 7. Click the check box next to the Material fi eld to launch the Material Types dialog box. 

Select Steel, and click the OK button.

 8. Note the Yield Strength of 44000 psi.

 9. Leave this dialog open because you will use it in the next set of steps, where you’ll work 

with loads and supports.

The coordinate system alignment is correct for this example. So in this case, gravity could 

be ignored, but having the correct orientation simplifi es adding the loads and interpreting the 

results.

The dialog box should look like Figure 15.30. Note that all the section properties except Shear 

Displacement Ratio are calculated. This property is optional for the calculations. Comparing 

the calculated values with the original ones, Section Area and Moments Of Inertia are close but 

higher.

Figure 15.30

Model data entered 

into the Beam And 

Column Calculator
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The Beam Calculation Tab

The Beam Calculation tab, shown in Figure 15.31, has controls for defi ning the loads and sup-

ports for beams and columns as well as the calculation options. The Engineer’s Handbook (hid-

den away in the Power Transmission panel drop-down list; it’s called Handbook) contains the 

equations used in the calculations. You might want to review those equations before using the 

calculator.

Figure 15.31

Th e Beam 

Calculation tab

Loads & Supports

The Loads & Supports area contains controls along the top and a browser pane for adding and 

removing loads and supports for the frame member. All of the controls can be accessed by using 

the buttons at the top or by right-clicking and choosing them from the context menu in the 

browser pane area.

The drop-down menu switches the browser between Loads view and Supports view. The 

controls, shown in Table 15.2 and Table 15.3, change depending on whether Loads or Supports is 

set current.
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Table 15.2: Loads buttons

Button Description

Adds a force.

Adds an axial force.

Adds a distributed force.

Adds a bending moment—a single twisting force perpendicular 

to the z-axis.

Adds a torque load—a twisting force around the z-axis. Two 

equal and opposite torque loads are required.

Adds a combined load—any of the forces added at the same 

point on the beam.

Table 15.3: Supports buttons

Button Description

Displays the Options dialog box.

Adds a fi xed support.

Adds a free support.

Fixes one end of the beam.

The Options dialog box, shown in Figure 15.32, gives access to visibility controls for the 2D 

and 3D previews. By default, the loads and supports dynamically update to maintain the same 

size as the view scale changes. You can turn off the automatic update and set a static scale value. 

The Options dialog box is the same whether it is launched from the Loads control or Supports 

control.

Each load or support can be edited in the browser by double-clicking or by clicking the 

browse (…) button. A Properties dialog box displays controls for specifying the location, size, 

and direction of the force.
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Figure 15.32

Loads & Supports 

Options dialog box

Calculation Properties

The Calculation Properties group, as shown in Figure 15.33, has four controls that adjust how 

the calculations are made.

Figure 15.33

Th e Calculation 

Properties group

The Use Density check box adds gravity as a load. This is selected by default. The Use Shear 

Displacement Ratio check box is used when calculating the twist angle caused by torsional 

loads. The value is determined by the profi le shape. It is also called the form factor of shear. This 

check box is selected by default.

The default setting for Number Of Beam Divisions is 1000. Increasing the number of divi-

sions can result in improved accuracy for longer beams. You should experiment with different 

values to see whether the number of divisions causes a signifi cant change in the results.

Mode Of Reduced Stress has two options for modeling the stress distribution. The Huber-

Mises-Hencky (HMH) method is based on the maximum-energy-distortion criterion, and the 

Tresca-Guest method is based on the maximum-shearing-stress criterion. The HMH method is 

the default selection.

Results

The Results pane on the right side of the Beam Calculation tab updates when you click the 

Calculate button. Warnings will appear in the lower pane if the calculation indicates that 

stresses are too high.

For the conveyor example, the support will be welded to the frame at one end and unsup-

ported at the other. The power roller weighs 150 pounds, and the torque is 40 pound-feet. The 

torque causes the power roller to twist between the supports. The edge of the fl at is 1.5 inches 

from the center of the power roller. This means the reaction force at that point is 320 pounds. 
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Both the weight and the reaction force are split between the two sides. Follow these steps to 

explore the results and calculation workfl ow.

 1. Ensure that the fi rst load type is set to Radial Force.

 2. Click the … button to add a force for the power roller weight.

 3. Enter 10 (inches) for the distance and 75 (pounds-force) for the force. This is the maxi-

mum distance for the power roller. Click the OK button to close the Radial Force dialog 

box.

 4. Click the Add Torque button to add a torque reaction force.

 5. Enter 11.12 (inches) for the distance and 160 (pounds-force) for the force, and then click 

the OK button.

 6. Click the drop-down list to switch from Loads to the Supports browser.

 7. Delete the Free support by selecting it and then clicking the red X button.

 8. Click the drop-down arrow for the Fixed support and select Restraint.

 9. Leave the Use Density option checked.

 10. Deselect Use Shear Displacement Ratio since you don’t have a value for that property.

 11. Click the Calculate button, and compare the reduced stress to the yield strength of the 

specifi ed material.

 12. Leave this dialog open, and use it to explore the next topics.

The dialog box should look like Figure 15.34. Note that the forces are displayed in the graph-

ics window. If you hover over a force arrow on the model, a tool tip displays the information. 

You can drag the force to a different position, or you can double-click the force to display the 

properties dialog box.

The Beam Graphs Tab

On the Beam Graphs tab, the Graph Selection pane allows you to select the results you want to 

display. The selected graph displays in the bottom of the Graph area. At the top of the Graph 

area is a schematic of the beam, supports, and loads. You can drag the supports and loads to 

different positions to update them. If you double-click a support or load, the properties dialog 

box displays so you can directly edit the data. The Calculate button is not available on the Beam 

Graphs tab, so you need to switch back to the Beam Calculation tab to update the results.

The Beam Graphs tab is primarily intended for reviewing results. Twenty-two graphs are avail-

able on the tab. This example is a pretty simple analysis. You should experiment with other loads 

(torques and bending moments) and support types and then view the results on the graphs.

The Column Calculation Tab

The Column Calculation tab checks for column buckling. In the Loads area, you enter the axial 

load and the safety factor and select a coeffi cient for the end loading conditions. When you click 

the … button, a dialog box appears with four end conditions. If you have different end condi-

tions, you should enter the proper coeffi cient from a reference book.
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You shouldn’t need to enter any data in the Column area. The length, section area, and least 

moment of inertia are carried over from the Model tab. The reduced length value is calculated 

by multiplying the length by the end coeffi cient.

Figure 15.34

Loads & Supports 

data entered into 

the calculator

For example, imagine that during transport, the frame shifts and the power roller supports 

slam into the trailer wall. The power roller was removed during shipping, so the supports take 

all the force from the impact, estimated at 4,000 pounds evenly distributed across the four sup-

ports. Set the axial load to 1,000-pound force, and click Calculate to determine whether the 

supports will buckle. Figure 15.35 shows the results.

HTML Results

When you click the Results button in the upper-right corner of the dialog box, an HTML page 

appears with all the data, calculation results, and graphs. You can save or print this fi le for your 

records.

File Naming

The File Naming button, found next to the Results button in the upper-right corner of the dialog 

box, allows you to specify the calculation’s fi lename. When you click the OK button to exit the 

Beam And Column Calculator dialog box, a subassembly fi le is created in the assembly fi le. This 

subassembly fi le is just a container for the calculations, allowing you to access them again at any 

point. A browser node is created for the calculations. To edit the results, simply right-click the 

browser node and choose Edit Using Design Accelerator.
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Figure 15.35

Column calculator 

results

Publishing Frame Members
Frame Generator’s frame member library is integrated with Content Center. The authoring and 

publishing process is similar to that used to create any custom Content Center fi les. Since Frame 

Generator requires specifi c modeling techniques, the authoring process will make some changes 

to the model and the parameters to ensure that all of the required parameters are included.

Authoring a Part
The authoring process for a frame member is similar to component authoring. The Structural 

Shape Authoring tool, located on the Part-Modeling panel bar, is used to prepare the part for 

publishing. The tool identifi es the geometry used for placement, sets the parameters, and modi-

fi es the part so Frame Generator can use it.

This example uses a rubber bumper iPart fi le, as might be attached to frames to guard 

against impact. In the iPart table there are parameters to control the dimensions and three sizes 

defi ned. If this were a true frame member profi le, the engineering properties (moments of iner-

tia and so on) might need to be calculated, and therefore that information would be set up as 

well. Since this isn’t a load-bearing part, those properties aren’t required. To explore the author-

ing process, follow these steps:

 1. Click the Get Started tab, and choose the Open button.

 2. Browse for mi_15a_020.ipt located in the Chapter 15 directory of your Mastering 

Inventor 2014 folder, and click the Open button.
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 3. From the Manage tab, locate the drop-down list on the Author panel, and then click the 

Structural Shape button.

 4. When the authoring tool starts, everything is blank. Once a category is selected, the dia-

log box will update with the appropriate controls. Because this is an unusual part, select 

the Other category, as shown in Figure 15.36.

Figure 15.36

Selecting the 

category

Frame Generator looks in the Structural Shapes category only, so you have to select one 

of the standard categories or create a new one in Content Center editor. You can’t add a 

category through the authoring tool, so you have to add the category to Content Center 

before authoring. See Chapter 7, “Reusing Parts and Features,” for more information on 

Content Center.

Since there is only one extrusion in the part, the base feature is automatically selected. 

The default base point is indicated at the center of the profi le. For this part, the inside cor-

ner of the fl anges is the natural insertion point.

 5. Click the drop-down list and choose Select Geometry, and then select that point in the 

model, as shown in Figure 15.37. Note that you may need to use the ViewCube to look at 

the end view of the part to see the insert point selection.

The Notch Profi le option is used when you are authoring frame members and you want 

to include a predefi ned notch profi le to be used with the Notch tool. In this case, there is 

no notch profi le.

 6. Click the Parameter Mapping tab.

 7. Set the Base Length row to use the Length parameter by clicking the Please Select cell in 

the table and then choosing Length from the list.

The Parameter Mapping tab has one required fi eld: Base Length. This is the param-

eter for the extrusion distance. Since this is an iPart, when you click in the fi eld, the 
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iPart properties are listed as shown in Figure 15.38. If this were a regular part, the Part 

Template Parameters dialog box would display a browser tree, as shown in Figure 15.39. 

The rest of the parameters are optional. They are mechanical properties of the profi le nec-

essary for calculating loads with the Beam And Column Calculator.

Figure 15.37

Selecting the 

Default Base Point

Figure 15.38

Specifying the 

length parameter 

for an iPart

When the geometry and Base Length parameter are mapped, the Publish Now and OK 

buttons are enabled.

 8. Click the OK button to update the part with the authoring changes.

Clicking either the Publish Now or OK button will update the part and close the dialog 

box. Publish Now will also launch Content Center publishing wizard. Once the part is 
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updated, a dialog box displays with information about the changes. A log fi le that lists 

the changes to the part, as shown in Figure 15.40, is created in the project directory.

Figure 15.39

Specifying param-

eters for a regular 

part

Figure 15.40

Log fi le for an 

authored part

 9. Click the OK button in the Structural Shape Authoring notice dialog box.

 10. You can close the fi le without saving changes or use this fi le to explore the publishing 

options.

If you inspect the part after authoring, you will see that the browser and parameters have 

been updated. The details of the model and parameters are discussed in the section “Exploring 

the Anatomy of a Frame Member” earlier in this chapter.

Test Before You Publish

Before you publish the member for your team to use, be sure to test it in every conceivable situation. 

Even a seemingly well-constructed frame member can cause issues after end treatments are applied.
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Publishing a Part
The publishing process uses the Publish Guide wizard. Since the part was authored, most of the 

publishing information has already been added to the fi le. If you aren’t familiar with publishing 

to Content Center, review the end of Chapter 7.

These publishing steps are important for Frame Generator:

 ◆ When you defi ne the family key columns, the Length parameter must be set as a key 

column.

 ◆ In the Family Properties pane, the standard organization is used to categorize the member 

during insertion. If you leave this fi eld blank, the category selection will be Unknown.

 ◆ In the thumbnail image pane, a special thumbnail is displayed. Since the thumbnail is used 

as the orientation image in the dialog boxes, it is important to use the thumbnail that Frame 

Generator creates.

Frame Assemblies and BOMs
By default, Frame Generator parts are set to calculate their base quantity from the length of the 

part. This differs from standard parts that calculate their base quantity from the number of 

parts in the assembly. When parts are authored for use in Frame Generator, the Base Quantity 

setting is automatically set to the length. To get a part count in the parts list for your assemblies, 

you will want to confi gure them to read the item quantity rather than the base quantity. You can 

use both columns if that fi ts your needs, or you can have the BOM display one quantity and the 

parts list display the other.

You can also use the BOM expression builder to create a description built off the Stock Number 

property and GL parameter (Length). You can use the CUTDETAIL parameters in expressions to 

show the end treatment information for each member. Note that you can copy the expression in 

one cell of the BOM, multiselect the rest of the column, and then right-click and choose Paste to set 

the expression to all of the parts in the BOM. Figure 15.41 shows the BOM Editor listing the base 

quantity and the item quantity along with an expression being built to fi ll out the description.

Figure 15.41

Using the BOM 

expression builder

It is a good idea to let Frame Generator name the frame members for you and use the Part 

Number property rather than the part name to manage the parts. Once you’ve set an expression 



THE BOTTOM LINE | 725

as just described, you can sort the BOM by that column to group the like items, set one of the part 

numbers, multiselect the items, and choose Paste from the context menu to set them all the same. 

If you want the items to be merged, leave the Part Number Merge Settings options selected. The 

Part Number Merge Settings button is in the top right of the BOM Editor dialog box.

In the drawing environment, use a Parts List style similar to the default Material List style 

found in the standard templates. This parts list is already confi gured to group by stock number 

and material, as well as sum the values of each unique stock number type. Figure 15.42 shows a 

parts list placed using the Material List style to roll up the lengths.

Figure 15.42

A parts list using 

the Material List 

style

Th e Bottom Line

Work with frame fi les.  Frame Generator puts all the members at the same level in the 

assembly.

Master It  You have a frame that is built up in sections that are welded together. How do 

you document the manufacturing process?

Insert frame members onto a skeleton model.  Frame Generator builds a skeleton model 

for the frame from the selected lines and edges.

Master It  Since Frame Generator builds its own skeleton model, you don’t have to build 

a master model before you start creating the frame. What would you reference in your 

assembly to use as a frame skeleton?

Add end treatments to frame members.  Frame Generator does not support end treatments 

on merged members.

Master It  Let’s assume you are building a stairway and the handrail has curved sec-

tions. How would you approach the curved handrail so that its ends can be treated?

Make changes to frames.  Inventor provides detailed frame-member information.

Master It  You need to determine the size and wall thickness of the tubing and make it 

either thicker or larger. How do you do that?

Author and publish structural profi les.  Frame Generator uses structural shapes from 

Content Center.

Master It  How would you add custom aluminum extrusions to Content Center so 

Frame Generator can access them?

Create BOMs for Frame Generator assemblies.  Frame Generator has special parameters 

for frame members.

Master It  How do you add the profi le dimensions and the length of your frame 

members to the Description fi eld? 





Chapter 16

Inventor Studio

The means to communicate your design to sell your concept or product is valuable whether 

your customer is internal or external to your company. Visualization, through static imagery or 

animation, has the potential to improve that communication by providing your customers with 

a conceptual or practical demonstration of your design. Inventor Studio, a rendering and ani-

mation environment in the Autodesk® Inventor® program, is a visualization tool built into the 

assembly and part environments.

With Inventor Studio, you can create and apply appearance styles that enhance the realism 

of your components and create lighting styles that draw attention to specifi c aspects of your 

design. Inventor Studio comes with many surface styles and a modest set of lighting and scene 

styles to use. You can modify the delivered styles or make as many new ones as you need. The 

goal is to make your image as true to your concept as you want.

Inventor Studio uses assembly constraints and positional representations for animation 

purposes. You can animate a single part or an assembly. This chapter will discuss how to use 

Inventor Studio to create the images and animations that communicate your design to the tar-

geted audience.

In this chapter, you’ll learn to:

 ◆ Create and animate cameras

 ◆ Start new animations, modify animations, and use the various animation tools

 ◆ Use multiple cameras to create a video production of your animation

 ◆ Use props to enhance your scene

 ◆ Render shaded and illustrative images

 ◆ Render animations and video productions

Exploring the Inventor Studio Environment
The Inventor Studio environment contains the tools required for creating realistic imagery and 

animations of mechanistic movement. This section will introduce you to the various tools, envi-

ronment settings, and browser in the Inventor Studio environment.

Before entering Inventor Studio, you may want to consider what you will be using as 

resources (diffuse maps, bump maps, decals, and so on) for your images. Inventor comes with 
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a collection of diffuse and bump maps, but if you have any images for textures or bump maps, 

you should include the directories where these fi les reside in your project fi le. Doing so ensures 

that those resources will be available when you work in Inventor Studio. Then, plan ahead by 

storyboarding your animation, giving thought to camera positions and settings, lighting, and 

animation.

To enter the Inventor Studio environment from either a part fi le or an assembly fi le, select the 

Environments tab and click the Inventor Studio button, shown in Figure 16.1.

Figure 16.1

Accessing Inventor 

Studio

This will set the Render tab active along the top of the graphics area, and it opens the 

Inventor Studio Scene browser in place of the Model browser. The Render tab is divided into 

four panels organized by task—Render, Scene, Animate, and Manage—each containing tools for 

those tasks. Figure 16.2 shows the Render tab.

Figure 16.2

Th e Render tab in 

Inventor Studio

The Scene browser is a custom browser that contains folder nodes specifi c to Inventor Studio. 

Right-clicking a folder node allows you to create one or more productions, animations, cameras, 

and local lights within the same fi le. The instances are maintained in the corresponding folder.

Creating and Managing Styles
Three types of styles are used in Inventor Studio: appearance, lighting, and scene styles. Each 

has a different purpose and contributes to the fi nal image you produce. Lighting and scene 

styles are created and modifi ed using tools specifi c to the Inventor Studio environment, whereas 

appearance styles are created and modifi ed using the same tools used in the rest of Autodesk 

Inventor.

Applying Appearance Styles
Appearance styles are used to create and modify colors, patterns, and textures for your compo-

nents. The appearance styles interface has a variety of controls to assign colors, patterns, and 

textures to the model based on selected faces or features, or to the entire component.
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Applying Appearance Adjustments and Overrides per Face

It’s often useful to apply a color or texture to specifi c faces in order to achieve a more realistic 

appearance. To do so, you can use any of these methods:

Right-Click  Select a face on the model and then right-click and choose Properties. Then 

select an appearance from the drop-down list.

Quick Access Toolbar  Select a face on the model and then use the Appearance Override 

drop-down list found on the Quick Access toolbar at the top of the screen.

Appearance Adjust Button  Select a face on the model and then click the Appearance 

Adjust button found on the Tools tab.

The Appearance Adjust button provides more control in applying the override than just sim-

ply changing the appearance color and texture. When you click the Appearance Adjust button, 

you are presented with the Adjust in-canvas tools, as shown in Figure 16.3.

Figure 16.3

Th e Appearance 

Adjust tools

Using the Adjust Appearances Drop-Down List

Once the Appearance Adjust tools are displayed, you can use the drop-down list to select an 

existing appearance style to use for the selected face. The Inventor project fi le (.ipj) specifi es 

the material and appearance libraries that are accessible from the list.

Using the Tinting Color Wheel

Once you select an appearance style, you can click and drag on the color wheel to apply a 

color tint override. As you do so, the RGB values will adjust and be shown in the controls. 

Alternatively, you can set the controls to use HSL values. Once a color is selected using the color 

wheel, you can click and drag on the crosshairs located in the center of the color wheel to adjust 

the brightness of the color tint.

Using the Scale and Rotate Controls

If the selected appearance uses a texture, you can use the scale and rotate controls displayed on 

the selected face to adjust the angle and size of the texture. These controls highlight as you place 

your cursor over them and are shown on the left of Figure 16.3.

If you want to adjust the appearance of multiple faces at the same time, you can press and 

hold the Ctrl key on the keyboard and then click each face. To accept the adjustments you’ve 

made, click the Apply button (the green plus sign) or the green check mark. If you want to dis-

card the adjustments, you can click the Cancel button (the red X).

Keep in mind that the option to display textures must be enabled in order to see the scale and 

rotation of appearance textures. You can enable and disable the display of textures by selecting 

the View tab and clicking the Textures On/Off drop-down menu.
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Clearing Appearance Adjustments and Overrides

To remove appearance overrides, you can click the Clear button found on the Material And 

Appearance panel of the Tools tab, as shown in Figure 16.4.

Figure 16.4

Use the Clear 

button to remove 

appearance 

overrides.

Once the Clear controls are active, you can select the faces from which you want to clear 

existing appearance overrides, or you can use the Clear All button to remove all appearance 

overrides and set the model to use the appearance style assigned to the current material.

Applying Appearance Adjustments per Feature, Solid, or Part

In addition to applying appearance overrides to faces, you can apply them to specifi c features. 

To do so, select the Tools tab and click the Adjust button. Then, from the browser, select the fea-

ture to be adjusted. The Adjust and Clear controls work in the same way with features as they 

do with faces.

To apply adjustments to an entire solid, select the outer edge, or select it in the browser when 

you are working in the part modeling environment. To select the entire part when in the part 

modeling environment, select the top-level node in the browser.

When working with an assembly fi le, you can choose individual parts to apply adjustments 

to by selecting them on-screen or in the browser. To apply adjustments to entire subassemblies, 

select the subassembly from the browser. Clearing appearance adjustments in the assembly 

environment works the same as it does in the part environment.

Appearance Styles vs. Material Styles

You might be wondering about the diff erence between an appearance style and a material style. 

A material style contains information about the physical properties of a material and specifi es a 

default appearance style. For instance, a material style called Aluminum 5052-O might use an 

appearance style called Aluminum Polished. Th erefore, the material style consumes the appear-

ance style. When you apply appearance adjustments to the model, it is as if you are painting the 

various surfaces and features, but the model is still using the original material to determine its 

physical properties.

Creating Appearance Styles and Appearance Libraries
To create or modify appearance styles, you can click the Appearance button found on the Tools 

tab. This will open the appearance browser, as shown in Figure 16.5.
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Figure 16.5

Th e appearance 

browser

At the top is the Document Appearances area, showing the appearances cached in the active 

model. Listed below are the Autodesk Material Library, the Autodesk Appearance Library, and 

any custom libraries that exist. To create a custom library or custom appearance style, you can 

use the buttons located at the bottom-left corner of the appearance browser.

When creating a custom appearance, you set the properties using the Appearance Editor, as 

shown in Figure 16.6.

Figure 16.6

Creating a custom 

appearance

Exploring Lighting and Lighting Styles
Several lighting styles are provided with Inventor, and you can use them as is or modify them 

to meet your needs. You can also create new lighting styles to suit your needs. Lighting styles 

differ from appearance and scene styles. Lighting styles have settings that affect all lights in the 

style, and individual lights have settings for only the selected light. However, you can set indi-

vidual lights to use the style settings to allow consistent control across multiple lights.

In the Inventor Studio environment, on the Render tab you’ll fi nd the Lighting Styles tool. 

Click to activate it and display the Lighting Styles dialog box. The New Light button (the light 
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bulb at the top of the dialog box) adds a new light to the selected lighting style. The New Light 

dialog box appears, and you can specify the settings.

Next, you’ll explore the light styles and what they control.

Lighting Styles

The lighting style settings affect all lights in the style. In the Lighting Styles dialog box, a list of 

lighting styles is presented on the left. Each style has a set of controls:

 ◆ Brightness

 ◆ Skylight

 ◆ Ambience

 ◆ Bounced Light

 ◆ Shadows

 ◆ Orientation

 ◆ Scale

 ◆ Position

Note that the active style, currently displayed in the scene and used for rendering, is listed 

with bold letters, and the selected style, the one whose settings are exposed for editing, has 

background fi ll, as shown in Figure 16.7. You can double-click a style in the list to edit it. The 

style does not have to be the active one.

Figure 16.7

Active and selected 

styles

Selected

Active

Besides the common style tools, you’ll also see a New Light tool in the tools area of the 

Lighting Styles dialog box. This tool adds a new light to the lighting style you have selected in 

the list. The new light is then made the active edit target so you can complete the defi nition.

Th e General Tab

Brightness, on the General tab of the Lighting Styles dialog box, controls the overall style bright-

ness. This tool affects all lights in the style.

Skylight is the tool that provides uniform, directionless illumination in the scene. When 

it’s enabled, you are able to specify light intensity and color, or you can use an image for light-

ing the scene. The image supplies colors for the lighting but should not be confused with high 

dynamic range image (HDRI) illumination.
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Using the Skylight and Bounced Light tools is computationally intensive, and therefore they 

should be used sparingly, usually for fi nal renders only.

Th e Indirect Tab

On the Indirect tab, the Ambience setting controls the amount of ambient light used in the 

scene. Setting the value higher increases the amount of light in the scene, so if you have a scene 

that is lit but is too dark and needs a minor adjustment to get more light, try increasing the 

Ambience setting.

The Bounced Light setting is a component of global lighting and is included when the 

Skylight option is selected. However, you can use Bounced Light without the Skylight option. 

Bounced Light provides the lighting that comes from objects as light encounters them and then 

refl ects off the surfaces. With Bounced Light, you have the option of using preset values for the 

number of rays that are sampled for bounced lighting. There is also a custom setting should you 

decide you need a value other than those provided.

Th e Shadows Tab

The Shadows tab provides access to the following:

Type  You can specify None, Sharp, and Soft.

Quality  You can specify Low, Medium, and High.

Density  You can specify 0 to 100 percent.

Light Parameter  Here, you specify the spherical diameter for a soft shadow effect.

If the light casts no shadow, the Type should be set to None, and all other controls on the 

page are disabled and not used.

Sharp shadows provide a well-defi ned shadow. The boundaries of an object defi ne a sharp 

contrast between shadow and nonshadow areas.

Soft shadows blur the area between shadow and nonshadow areas. The Light Parameter 

setting, available only for soft shadows, defi nes the spherical diameter of infl uence for soft 

shadows.

Figure 16.8 shows a comparison of the three shadow types: None, Sharp, and Soft shadows.

Figure 16.8

Shadow types: 

None, Sharp, and 

Soft

Note that the Light Parameter setting controls the penumbra (dispersing area around the 

darkest part of the shadow) and that it is a diameter dimension.

Shadow density provides an additional level of control because you can set the density 

on a per-light basis. As Figure 16.9 shows, the shadow density increases with the value of the 

parameter.
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Figure 16.9

Shadow density 

at 15, 45, and 75 

percent

It is easy to see how by working with these settings you can greatly affect the results of your 

rendered image or animation.

As mentioned earlier, the Light Parameter setting is a spherical diameter value that controls 

the infl uence of soft shadows. If you want soft shadows around the whole scene, the sphere 

must be set to be somewhat larger than the scene. If the infl uence is to be limited, you can use a 

lower setting. A good rule of thumb is to estimate the extents of your assembly and add 10 to 15 

percent for a reasonable penumbra.

Th e Position Tab

The Position tab gives you access to the orientation, scale, and location of the lighting style.

Orientation is derived from one of the following:

Canonical Origin Planes  XY plane, XZ plane, YZ plane.

Scene Style Ground Planes  Available in the drop-down list.

Any Model Face or Work Plane  Use the Select button.

If you want to reverse the lighting style orientation, you can use the Flip button next to the 

drop-down list and invert the direction of the lighting style.

Scale affects all lights in the style. This allows you to quickly modify your lighting style to fi t 

the model conditions. You can specify any scale factor from 1 to 1000 percent.

Lighting style position is expressed in model units and is based on the center of the top-level 

assembly. If you want to relocate the entire style, the position settings allow you to easily reposi-

tion the lighting style.

Adding a New Light

To add a new light to an existing style, use the New Light tool in the dialog box or context menu 

in the light style list. Then follow these steps to produce a new light:

 1. Specify a face to act as the light target and normal. The face selection determines the light 

target location and beam direction.

 2. After selecting a face, you’ll see a straight line proceeding from the target or face; drag 

your mouse pointer along that line to defi ne the light position.

 3. In the dialog box, modify the light parameters to fi t your needs.

If you adjust the settings before defi ning the position, return to the General tab, and select 

the Target or Position tool to begin specifying the light position interactively.
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Creating a New Lighting Style

You can create new lighting styles in three ways:

 ◆ Use the New Lighting Style tool, which is also available from the list context menu. The 

new lighting style contains one each of the three light types with default values.

 ◆ Copy an existing lighting style. Then edit it to suit your needs.

 ◆ Import a lighting style from a fi le.

When you create a new lighting style, you are provided with each of the three types of dis-

crete lights. You can change the light types, add more lights, and modify parameters to achieve 

the lighting effect you want.

If you copy an existing lighting style, you are able to rename it, modify the parameters, add 

new lights, or change the light types for the existing lights.

If you have an exported lighting style that you want to import and use, you can use the 

Import tool, which is the button at the bottom of the dialog box; navigate to the appropriate fi le 

and then import it. Be advised, though, that if you import a lighting style with the same name as 

an existing lighting style, the imported style will overwrite the current, same-named style.

Discrete Lights

In the Lighting Styles dialog box, you can create and edit individual discrete lights for each light 

style by using the New Light button. When you create a new light, the tabs in the Lighting Style 

dialog box refl ect the settings for that light rather than the style. Discrete lights can be one of 

three types: directional, point, or spotlight. Certain controls for the discrete light types differ 

from the style controls, but shadow parameters can be linked to the style and managed globally 

for the style from the Shadows tab of the Lighting Style dialog box.

Discrete lights, though three different types, all have only one set of parameters. Based on 

the light type, access to invalid parameters is blocked. This provides a distinct ease-of-use fea-

ture, the ability to switch between light types without having to delete and re-create new ones. 

You can experiment with different light types quickly and determine which is best for your 

circumstances.

A point light sends light in every direction, whereas the spotlight can be pointed and focused 

on an area of interest. As you work with lights, experiment so that you learn their characteristics 

and are able to easily add the type of light you want to a scene.

Th e General Tab

When you create a new light or select an existing light to edit, you’ll see the options on the 

General tab become specifi c to that light. On the General tab, you’re able to do the following:

 ◆ You can defi ne the light type; you can choose Directional, Point, or Spot.

 ◆ You can set the on/off condition. This condition can be animated.

 ◆ You can redefi ne the position and, for the Directional and Spot types, the target.

 ◆ You can fl ip the light, reversing the target and position locations.
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You can copy and paste lights, so once you’ve set one up, you can quickly duplicate it. You 

cannot create patterns of lights.

Th e Illumination Tab

The Illumination tab contains controls for light color and intensity. Intensity is a percentage 

value from 0 to 100 percent.

Light color, as most people realize, helps inject emotion into a scene. Warm colors (yellows, 

oranges, reds, and so on) evoke a different response than do cool colors (blues, greens, and so 

on). Let’s say you want light in the scene, but would like to give the impression it is turned off at 

a certain point. However, you want enough light to see the scene clearly. How can you achieve 

this? Instead of actually turning the light off, you could change the color and intensity of the 

light from yellow at 80 percent to light blue at 30 percent, giving the impression the light is off 

while still illuminating the scene.

Th e Shadows Tab

The Shadows tab for discrete lights duplicates the style Shadows tab. Thus, the shadows of 

any discrete light can be linked to the style shadows and derived from there. If you choose to 

have the selected light use different settings, deselect the Use Style Settings check box. Then 

specify the settings for the selected light.

Th e Directional Tab

Directional lights provide parallel beams of light from a single direction. The light source is 

considered an infi nite distance away. Thus, you could use directional light to simulate sunshine. 

The positional information for a directional light is defi ned by longitude and latitude values.

The longitude and latitude controls easily relate to seasonal positioning for lighting. You 

need to be familiar with where the seasonal lighting is for your geography.

Directional lights do not participate in soft shadow lighting. The control is disabled for any 

directional light.

Th e Point Tab

Point lights cast light in all directions and therefore have only position parameters for locating 

the light. The light target is ignored and, for all intents and purposes, is considered as traveling 

with the light position. Position values are listed in absolute X, Y, and Z values based on the top-

level assembly origin.

The light decay controls apply to point lights and spotlights only. These controls have an 

impact on how real the lighting looks. There are three decay types:

None  This option specifi es that light energy will not decay over distance. If you want 

indirect light to remain constant throughout the scene, regardless of the distance between 

objects, use this setting.

Inverse  Light energy decays at a rate proportional to the distance traveled. Photon energy 

is 1/r, where r is the distance from the light source.

Inverse Squared  Light energy decays at an inverse square rate. Photon energy is the 

inverse of the square of the distance from the light source—that is, 1/r2.
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In the real world, light decays at an inverse square rate. However, for lighting to be realistic, 

the light values must also be real-world accurate. You’ll fi nd that it takes more lights to amply 

light a scene when you use Inverse Squared for decay.

The rendering cost, in time, increases as you move from no decay to Inverse and again from 

Inverse to Inverse Squared. For most renders, you can use None or Inverse and get good results 

based on how you set up your lighting style. When using light decay, you are able to specify 

the distance from the light source when the decay begins to occur. The greater the decay start 

distance, the brighter the light will appear to be. This means that if you have a lighting style you 

prefer but want to make it less bright in some areas, you can change specifi c lights to use Inverse 

decay and have a considerable effect on the output. Light decay is a setting that takes experi-

mentation to get a feel for when and how to use it.

Th e Spot Tab

Spotlights provide light in a more focused manner, at a specifi c location. For spotlights, there are 

more controls for adjusting the light parameters. You can do the following:

 ◆ Explicitly position the light target or light source.

 ◆ Specify the light hotspot and falloff.

 ◆ Specify the light decay type and start distance.

As discussed thus far, you can modify lighting styles, giving explicit values for input. For 

example, you can edit position, target, hotspot, and falloff interactively.

To modify any of these settings, you must fi rst edit the light you intend to change. Place your 

mouse pointer over the light graphic, which is the light node in the Scene browser, and right-

click; then select Edit from the context menu. At this point, place your mouse pointer over the 

graphical representation of the element you want to edit, and do one of the following:

 ◆ Click the light source to display the 3D Move/Rotate tool for modifying the position 

or target.

 ◆ Click and drag the graphic representing the hotspot or falloff to change its size.

 ◆ Click the line representing the light beam; it connects the position graphic to the target 

graphic. The 3D Move/Rotate triad is placed over the center of the line, enabling a reposi-

tion of the entire light. Click and drag the arrow to move the light in that direction.

Local Lights

Local lights are discrete lights that belong to the scene, but not the lighting style. They are use-

ful for control panel lights, for example, that you may want to animate individually. Thus, local 

lights come only in the Spot or Point light type. Local lights travel with components, so if you 

create a lightbulb component, you can specify a local light for use with the bulb object.

Local lights use the same controls as discrete style lights. In fact, you can easily create a local 

light by right-clicking any style-based discrete light and selecting the tool in the context menu.

Local light settings and position can be animated only when the light is at the top level of the 

assembly or part model.
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Exploring the Scene Styles Dialog Box
Scene styles provide a backdrop for your scene. You can use a single solid color, a gradient color, 

an image, or a spherical image. What you use depends on how you want to compose your scene.

Scene styles provide a built-in ground plane that eliminates the need for you to add geometry 

in the model to provide the illusion of ground or a surface on which your assembly is sitting. 

However, if you have specifi c needs or use props that replace the ground plane, then it is not 

necessary to show shadows or refl ection. The Scene Styles tool is located in the tool panel next to 

the Lighting Styles tool.

Looking at the Background Tab

The Background tab provides access to the various controls for specifying the type of back-

ground and location of images to use. You can forgo specifying any of this information by 

selecting the Use Application Options check box. The current Inventor background will be used. 

You can choose from four background types, covered next.

Solid Color

If you want to use a single color for the background, click the Solid Color button, and specify the 

color to use in the Colors section.

You could use the Solid Color option to produce an image so that the background could 

be removed or specifi ed as a transparent color. However, there is a much easier method that 

we’ll discuss when it comes time to render images, in the section “Composing and Rendering 

Images” later in this chapter.

Color Gradient

Color Gradient is a popular choice because it has the potential to look more like a presentation. 

Both color controls become enabled, and you specify the top and bottom gradient colors, respec-

tively. With the environment controls, you can further tune the background, using shadows and 

refl ection, to make the scene style complement your model.

Experiment with different solutions. You’ll fi nd some really nice sets of colors that work well 

together. For example, the use of dark blue (top) and black (bottom), with refl ections on and set 

to 80 percent looks very elegant with the proper lighting.

Image

The Image setting enables the image controls at the bottom section of the dialog box. When you 

activate this choice, the Open dialog box is automatically displayed so you can select the desired 

image. The default location for the image choices is the Textures directory that is created and 

populated during the Inventor installation. If you plan to use images other than those supplied, 

you should do one of two things:

 ◆ Edit the project fi le to include the directory where the images are located as a library. (This 

is recommended.)

 ◆ Place any image you will use in the installed Textures directory.

Figure 16.10 demonstrates the use of the forest 2.bmp background image (installed by 

default to the Inventor install directory, such as C:\Program Files\Autodesk\Inventor 2014\

Backgrounds). This background contains a green backdrop with a receding grid ground plane. 
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The proper placement of the assembly relative to the background enhances the end product. Be 

sure to take the time to analyze your background to see what may need to be adjusted to opti-

mize your output. In this instance, a lower camera angle was used and shadows were turned on 

in the scene style. The lighting style was set to produce soft shadows.

Figure 16.10

A scene style 

with an image 

background

When the Image setting is enabled, you have three choices of how to use the image in the 

scene. You can center, tile, or stretch the image. If you choose to tile the image, the Repeat con-

trols are enabled for your use. A little later, in the section “Matching Your Camera to an Image,” 

you’ll learn how to match the model view to your image.

Image Sphere

If you use the Image Sphere option, the selected image is mapped to an environment sphere. 

The image is stretched to map to the sphere.

Looking at the Environment Tab

The Environment tab manages the ground plane orientation, shadows, refl ection, and 

environment mapping.

Direction and Off set

The scene style ground plane orientation is based on one of the three canonical assembly work 

planes. Select the orientation you desire and specify an offset, if any is required, to position the 

plane at the proper height for your model. Negative values position the ground plane below 

the assembly plane to which it is parallel.

Show Shadows

The option to show shadows is useful when the scene style is acting like a ground plane for 

the assembly—in other words, not using any prop models or other model to serve as a fl oor. The 

Show Shadows setting specifi es whether shadows are cast on the scene style ground plane.

Show Refl ections

If your scene style is serving the purpose of a model ground plane and you want to refl ect the 

model in the ground plane, select the Show Refl ections option and adjust the percentage of 
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refl ection you want in the rendered image. The higher the number, the more refl ection you see 

in the ground plane. If set to 100 percent, it will refl ect the assembly as if it were sitting on a 

mirror.

Refl ection Image

The Use Refl ection Image setting is there for you to specify an environment image map. This is 

the image you will see refl ected in those parts that have refl ectance in their surface style when 

rendered. Depending on the image, it can have minor to major infl uence on the rendered out-

come. Here again, experimentation is the best teacher.

Collect or produce a set of widely different images, and make new scene styles using the 

images for refl ection mapping. Render the same model with the different styles to see what sort 

of infl uence the image produces.

Matching Your Camera to an Image

If you want to match your model up to a photograph, use the Image Background type for the 

scene style. Analyze the photo you will use for the background. Determine where the light is 

coming from and how much shadow is being cast. Then, set your view to use a perspective 

camera. Orient the model so that its horizon and vanishing point are similar to the image. Next, 

create or modify a lighting style so that it produces light and shadows similar to those in the 

photo. Do a few test renders, and refi ne the camera position and lights until you’re able to get 

something that looks like what you want.

If you have not already downloaded the Chapter 16 fi les from www.sybex.com/go

/MasteringInventor2014, please refer to the “What You Will Need” section of the Introduction 

for the download and setup instructions.

Here’s an example of the workfl ow you can use:

 1. On the Get Started tab, click the Open button.

 2. Browse for the fi le mi_16a_001.ipt located in the Chapter 16 directory of your 

Mastering Inventor 2014 folder, and click the Open button.

 3. Select an image, and make a scene style using the Image background type. You can use 

the mountain background image mi_16a_001.tif in the Chapter 16 directory.

 4. Orient the model, as shown in Figure 16.11, to look like it fi ts into the scene.

Figure 16.11

Model orientation

http://www.sybex.com/go
http://www.sybex.com/go/MasteringInventor2014
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 5. Use the Outdoor lighting style, and scale it to fi t the scene. To make sure the shadows are 

close, modify the style orientation to match the shadow angles on the mountains. Do a 

test render, make a couple of tweaks to the style position, and then render the image, as 

shown in Figure 16.12.

Figure 16.12

Platform with 

background

In the next example, Figure 16.13, an existing Inventor background image was used and cen-

tered in the scene. This time, the goal was to produce an image for marketing purposes. The 

model was oriented in a way that made it emerge from the image and made it large enough to 

extend beyond the background image, giving the illusion that it protrudes from the image.

Figure 16.13

Scene style example 

Composing and Rendering Images
Although it is good to know how to use the tools to produce styles, it is also important to know 

the purpose of the image you are composing and rendering. What is its use? Who is the target 

audience? The type of image you compose and render will be different based on the answers to 

those questions. For example, if you are producing imagery for an assembly or repair manual 
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used by technicians, you may elect to use an illustration style of output as opposed to a realis-

tic style. The noncritical content may be simplifi ed to a degree. However, if you are presenting 

a product to a group of investors or potential customers, you may want to compose an image 

showing the product in its anticipated environment. The use of props can add context to your 

image or animation and possibly add more realism.

Since you are using an engineering assembly to create an image, it is likely you do not want 

to alter the engineering models for the sake of the image—that is, you don’t want to add extra 

“stage prop” content to engineering models. So, the recommended step is to place the product 

model into a wrapper assembly. Wrapper assemblies are simply a level higher, include the engi-

neering assembly, and can contain nonengineering content that serves as props for composing 

the fi nal rendered images or animations. Let’s say you are producing a product that is used in a 

machine shop. You place the product’s fi nal assembly in a wrapper assembly and add shop con-

tent, such as walls, tables, tools, and so on, to set the stage for the rendered image or animation, 

as shown in Figure 16.14.

Figure 16.14

A wrapper assembly 

with props

As you can see, there is nonessential content in the scene, but when combined, those items 

contribute to communicating a purpose for the items in the image. Even the surface style on the 

tabletop evokes a sense of a well-used workbench. It is small touches such as these that enhance 

your images.

Creating and Using Cameras

Although you might conclude that cameras would be best used for animations, they are also 

very useful for working with images. Cameras make it easy to recall view orientation, and they 

can be animated. There are two methods for creating cameras: using the Camera tool and using 

the view context menu.

Th e Camera Tool

To use the Camera tool, located on the Render tab, do the following:

 1. Click the Camera tool.

 2. Select the target, a component face. The camera direction line is presented normal to the 

face preview and selection. Click to select the target. The tool then cycles to the camera-

position input.
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 3. Specify the camera position by moving the mouse pointer along the camera direction line 

and then moving it along the line. When the preview is satisfactory, click to select the 

camera position.

 4. If you select the Link Camera To View check box, the camera graphics are hidden and the 

view is changed to what the camera sees. When the check box is deselected, the camera 

graphics are restored. This gives you an easy way to check your settings.

 5. Set the Camera Zoom value to fi t your requirements.

 6. Depth Of Field provides two methods of setting the range of focus: Focus Limits and 

f-Stop. Click the Enable option and then choose one of the Depth Of Field methods of set-

ting the range of focus: Focus Limits or f-Stop.

The Focus Limits setting provides you with near and far values, in model units. Content 

between the near and far values will be in focus. Content outside those values will be 

proportionally out of focus. f-Stop, the other method, uses an f-Stop value and a Focus 

Plane setting.

To make setting up the camera a little easier, you can link the focus plane to the camera 

target. Then, whenever the target is moved, the depth of fi eld adjusts to fi t with the cam-

era. That makes less work when it comes to updates.

 7. Click the OK button, and the camera is created. You can rename the camera with the 

browser node slow-click method.

Current View

The graphic region context menu method is useful for rapidly creating a camera using the 

current view. To access the other camera settings, you must edit the camera after creating it. To 

use the graphic-region context menu method, simply orient the view so it displays what you 

want the camera to show, right-click, and click Create Camera From View. A camera is added for 

this position. You can edit the other camera parameters via the Camera dialog box.

It is not unusual to have eight to ten cameras defi ned when you consider the various vantage 

points from which you might look at a product.

Rendering Images

Now that the stage is set, the lighting selected, and the model positioned, you’re probably anx-

ious to render something to see how it’s coming. You can always render using the current view. 

Whatever position you set the view to, you can render and get results. It is not required that you 

have a camera defi ned to render. However, repeatedly getting back to that same camera location, 

settings, and so on requires that you defi ne a camera. So, before discussing rendering, here is a 

brief description of setting up a camera.

The easiest method, by far, is to orient your model, choose orthographic or perspective view-

ing, and then in the graphic region, right-click and select Create Camera From View. That’s it! 

You have defi ned a camera. Now you can easily recall that camera if you change the view orien-

tation. As you can in any Inventor browser, you can click the node twice and rename it. I recom-

mend naming your cameras for ease in selecting, recalling, or animating them.

The Render Image tool presents the Render Image dialog box with three tabs: General, 

Output, and Style. The following sections will briefl y discuss the controls and use of the Render 

Image tool.
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General Tab

The General tab contains controls for sizing the image and for specifying the camera, lighting 

style, scene style, and render type to use in producing the image. Active styles prepopulate the 

style choice fi elds.

The size controls, Width and Height, provide you with explicit image size control. Directly 

to the right is a drop-down list of predefi ned image sizes that are typical in the industry. 

Beneath the drop-down list is a check box for locking the image aspect ratio. If you determine 

that a specifi c image size is consistently used, you can enter the values, lock the aspect ratio, and 

then create images at that ratio or at any size within the permitted limits. This makes scaling an 

image, post-rendering, easy.

As mentioned earlier, the camera choices include those you have defi ned and Current View. 

If you are doing test renders at a low resolution by moving the camera around to see where the 

best shot will be taken from, use Current View. It’s simple and straightforward. Once you deter-

mine the camera locations, you can then defi ne and refi ne those positions and camera settings.

The Lighting Style drop-down list shows all the available lighting styles, local (document) 

styles, and global styles (the style library), including those you have made and maintained 

locally or in the style library. If you have activated a lighting style, it is preselected. Specify the 

desired lighting style.

As with the lighting style, you make your selection based on available local and global styles.

As you were composing the scene, you likely determined whether the end result would be 

rendered as a shaded or illustration image. Here is where you set that choice. The choice dictates 

what controls are available on the Style tab.

Th e Output Tab

The Output tab contains controls for where the image is saved, and whether to use antialiasing 

and to what extent to use it.

If you want to save the image, select the Save Rendered Image box. When you do so, the Save 

dialog box appears. You specify the location and name for the image. If you don’t specify this in 

advance, you are still able to save the image from the render window.

Output PNG Files with a Transparent Background

If you set the fi le output type to PNG and then click the Options button, you can select the Alpha 

Channel check box. Doing so sets the image background to transparent, allowing the image to be 

composited easily in a photo-editing application. Th is is often useful when preparing images for 

brochures and presentations.

The antialiasing tools include the following choices, from left to right:

None  Antialiasing is not used. This selection requires the least render time and provides 

the coarsest results.

Low  This option specifi es a low antialiasing setting. This eliminates the major coarseness 

seen in the None selection but still displays a degree of coarseness.

High  This option specifi es a high antialiasing setting. This setting virtually eliminates all 

signs of coarseness in the image. For fi nal renders, in scenes without soft shadows, this selec-

tion performs very well.
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Highest  This option specifi es the highest antialiasing setting. This setting is provided par-

ticularly for use with refi ning the image’s soft shadows.

With each selection there is an increase in quality accompanied by an increase in render 

time. Thus, when you select the Highest setting, recommended for soft shadow use only, the 

quality is increased, as is rendering time. It is up to you to determine what meets your need.

Style Tab

When you’re using the Shaded style, there is only one control on the Style tab: True Refl ections. 

When selected, this option ensures that the objects in the scene are seen in refl ective surfaces. If 

it’s not selected, the image map specifi ed in the surface style or scene style is used. When you’re 

using the Illustration style, several settings yield a variety of results. To render a line-art illustra-

tion like you might see in a technical or assembly manual, do the following:

 1. Set the graphics display to use the Presentation color scheme with the background 

set to one color. Color scheme selection can be set by selecting the Tools tab, clicking 

Applications Options, and selecting the Colors tab in the dialog box that opens.

 2. In Inventor Studio, set up the model conditions to fi t your requirements. If you want to 

show something during the course of the movement, use an animation and select a time 

position that illustrates the condition.

 3. Activate the Render Image tool, and specify the Render Type setting as Illustration.

 4. On the Style tab, set Color Fill Source to No Color, as shown in Figure 16.15. Since there 

is no color, you likely want the exterior and interior edges to show. Select both options in 

the Edges section.

Figure 16.15

Illustration render 

type settings

 5. Render the scene. The results will be something like Figure 16.16.
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Figure 16.16

Th e result of setting 

the Render Type to 

Illustration with no 

color

Take some time to experiment with these settings and you will be able to come up with some 

very interesting imagery. For example, make the following changes to the Illustration rendering 

type settings:

 1. On the Style tab, set Color Fill Source to Surface Style.

 2. Set Levels to 5 (midway across the slider).

 3. Select the Show Shiny Highlights option.

 4. On the General tab, set the lighting style to Table Top.

 5. Render the scene. The results will look something like Figure 16.17.

Figure 16.17

Th e Render Type set 

to Illustration with 

the Surface Style 

option

As you can see, with just a few changes, you can get dramatic differences. Using the same 

settings, render the scene with a different scene style. The results really start to get interesting.
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Animating with Inventor Studio
Inventor Studio was designed to use Assembly constraints to produce the mechanistic move-

ment within your assemblies. You should consider the following basic concepts when it comes 

to animating with Inventor Studio:

 ◆ When you enter the Inventor Studio environment, the model is considered to be in model 
state, that is, whatever the condition the model was in when you left the part or assembly 

environment. This means that when you exit Inventor Studio, modify the assembly, and 

then reenter Inventor Studio, the assembly changes are refl ected in the model state. That 

includes view representations, positional representations, component visibility, position, 

color, and so on. For animations, the model state represents frame zero. Therefore, all 

modifi cations affecting the model state also affect all animations in that document because 

frame zero has changed.

 ◆ Modifi cations made in frame 0 of the animation become the starting point for that anima-

tion. For example, component 1 in animation 1 is fl ush with component 2. In animation 2, 

the fl ush constraint for component 1 is offset by 1.5”. By changing the constraint in frame 0 

for animation 2, you don’t cause a change in animation 1. Had you changed the fl ush offset 

in the assembly or Inventor Studio model state, animation 1 would also be affected.

 ◆ Because Inventor Studio animates constraints, the free-form movement of a component, 

part, or assembly may require suppressing constraints that limit movement or the compo-

nent’s degrees of freedom.

 ◆ Animation actions are a result of modifying constraints; thus, any component that is con-

strained to a moving object will also move.

 ◆ The Animation Favorites folder contains all the constraints that have been animated in 

the active animation. It also contains any parameters you have nominated to appear there. 

This makes it easier to locate any parameters intended for animation and those constraints 

that have been animated.

 ◆ There is a common workfl ow through the Animation dialog boxes—specify the animation 

parameters, and specify the time parameters. Based on the animation action target (com-

ponent, light, camera), the dialog box presents controls relative to the target.

 ◆ To edit an animation action, you use the same dialog box and therefore virtually the same 

workfl ow.

Using Animation Tools
All animation tools are applicable to assemblies. However, in part models, only cameras, lights, 

and parameters can be animated. The Render tab is divided into panels. Animation tools are 

grouped on the Animation panel.

Using Animation Timeline

You can fi nd the Animation Timeline tool on the Animate panel of the Render tab. The ani-

mation timeline is where animation actions for any object are maintained and managed. 

Anytime you use an animate tool, it results in an animation action that is placed in the timeline. 
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Animation actions can be interactively changed using the start or end handle; you can also use 

the action’s location along the timeline by using the middle section of the action graphic or by 

editing the animation action.

To edit an animation action, use the action’s context menu, or double-click the action graphic 

in the timeline.

The playback tools are along the top left of the window. These are similar to other timeline or 

video playback controls you have used. Figure 16.18 shows these and the other timeline controls.

Figure 16.18
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The tools provided are as follows:

Go To Start  Moves the timeline slider to frame 0 and updates the graphics region to show 

frame 0.

Play Animation In Reverse  Does what the name implies. You move the slider to a point in 

time, you click the tool, and the animation plays in reverse.

Current Time Position  Specifi es the current time position. You may type into the fi eld to 

explicitly change to another time position. The graphics region updates content to show what 

the animation looks like at that time.

Play Animation  Does what the name implies; plays the animation forward from its current 

position.

Go To End  Puts the time slider at the end of the animation. The graphics region updates 

content to show what the animation looks like at that time.

Toggle Repeat  Turns on the repeat tool. When you play the animation, it will automatically 

repeat until you click Stop.

Record Animation (or Render Animation)  Activates the Render Animation tool and dis-

plays the dialog box.

You can edit selected actions with the dialog box by double-clicking the action in the track 

section, where the action bars appear, or by right-clicking and selecting Edit from the context 

menu.
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You can edit action duration without going to the dialog box; just hover the mouse pointer 

over the start or end handle, and then click and drag the handle to change the position. 

Hovering over the center of the action and then clicking and dragging moves the entire action in 

the timeline.

Using Animation Favorites

Animation Favorites is a list that contains any animated constraint or parameter that you have 

nominated for animation. The purpose is to make it easy to fi nd those animation targets when 

you need to see or use them.

To populate the folder with a parameter, you must nominate the parameter. To do this, acti-

vate the Parameters Favorites tool. The Parameters Favorites dialog box, shown in Figure 16.19, 

displays, and you select the box in the row of any parameters that you plan to animate.

Figure 16.19

Th e Parameters 

Favorites dialog box

Selecting the box causes the parameter to populate the Favorites list. From there you can use 

the Animate Parameters tool however you’d like.

Populating the Parameter Favorites List

For parameters to show up in the list, you might need to set them to be exported in the general 

model parameter settings. To do so, exit the Inventor Studio environment and click the Parameters 

button on the Assemble tab. Th en select the check box for the Export Parameter column for each 

parameter to be exported. When you return to the Inventor Studio environment, the exported 

parameters will be listed in the Parameter Favorites list.

Using Common Animation Controls

In each animation tool dialog box is a section titled Time. It contains all the controls to manage 

an animation action’s time allocation. You specify whether the action starts from the end of a 

previous action, starts in a specifi ed time range, or starts instantaneously.

Based on the time method, you are able to specify a start time and duration, duration and 

end time, start time and end time, or simply an end time (instantaneous only). The default 

method is From Previous, which starts the action at frame zero if there is no previous action 

defi ned; otherwise, the new action begins at the end of the previous action. The other common 

tools are those on the Acceleration tab.

The Velocity Profi le setting defi nes how rapidly an action starts, proceeds, and ends. You can 

specify an action to occur at a constant speed. The default option specifi es that the action starts 

with zero velocity and then takes 20 percent of the action duration to achieve complete accel-

eration. The next 60 percent of the duration is at full acceleration. For the last 20 percent of the 
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duration, the action decelerates until it reaches zero. The longer the action, the more observable 

this becomes.

Think in terms of an electric motor; when it powers up, acceleration is not immediate but 

occurs over a period of time, however long or short. When the power is turned off, the armature 

decelerates and eventually comes to a halt. This is essentially what occurs with the animation 

action based on the Velocity Profi le setting.

The values presented in the dialog boxes are in the document’s units. You can access the 

appropriate animation tool from the context menu of the item that is to be animated. For example, 

you can right-click a constraint and select Animate Constraints to animate the selected con-

straint. The same is true of the other animation tools and their corresponding browser nodes.

Using Animate Component

You can fi nd the Animate Component tool on the Render tab. Animate Component is used for 

the unconstrained animation of parts or assemblies. Think of it as animating a component’s 

degree of freedom. Note that if a component does not move when you create an animation 

action for it using Animate Component, it likely has a confl icting constraint.

The Animate Component controls are as follows:

Select Components  By default, this option is active when the dialog is initiated; select the 

component, part, or assembly that will be animated.

Position  This option displays the 3D Move/Rotate triad to allow you to implicitly move or 

rotate the component as desired. On the triad, the arrowhead controls a move vector and an 

axis controls a rotation axis.

Distance  This option is where you enter the distance value. Specify this value after select-

ing the vector on the Position triad.

Rotation  This option is explicit input in degrees for a rotation action. Select the axis to be 

used for rotation.

Revolution  This option is explicit input for the number of revolutions the animated compo-

nent will make. This is an alternate way to input rotation.

Path  This option has two settings, Sharp and Smooth. Sharp uses no smoothing between 

the start, duration, and end values. Smooth uses a continuous motion curve between the 

start, duration, and end values.

Using Animate Fade

You can fi nd the Animate Fade tool on the Render tab. The Animate Fade setting changes the 

opacity of a component over time. The parameters allow for this to happen over any defi ned 

period of time or instantly if you desire. You can animate to any level of opacity, from 0 to 100 

percent.

This tool is useful for fading components to reveal interior components while still giving a 

sense of the overall envelope, as shown in Figure 16.20.

Animate Fade is not associated with a component’s visibility state; rather, it is a separate con-

trol for animating component opacity. This means you must create an instantaneous action in 

frame 0 for the component if you want to start out with less than 100 percent opacity.
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For example, if you were to start an animation of a transmission with the housing at 10 

percent opaque, you must create the action at frame 0 for the opaque value. Then, during the 

animation, you could create a different action to increase the Opacity value to make the housing 

100 percent opaque.

Figure 16.20

A faded exterior

The Animate Fade controls are as follows:

Select Components  Active (default) to allow selection of the objects to fade

Start  The component’s percent Opacity value at the start of the action

End  The component’s percent Opacity value at the end of the action

Using Animate Constraints

You can fi nd the Animate Constraints tool on the Render tab. Assemblies are built using con-

straints that remove degrees of freedom and cause components to remain in place in relation to 

one another. They also work as engines to cause mechanistic movement. Thus, constraints make 

it easy to animate objects.

The Animate Constraints tool is used to modify a constraint over time. The component’s ori-

entation changes as constraints are modifi ed.

The constraint’s current value is the starting value. The value you give the end parameter 

determines the degree to which the object, and those constrained to it, responds.

When you’re animating with constraints, there will be times when something does or does 

not respond. This is most often caused by other constraints causing a confl ict with the animated 

constraint. One way to overcome this condition is to suppress the confl icting constraint, if that 

doesn’t cause a radical change in the animation or its purpose.

Using Animate Parameters

You can fi nd the Animate Parameters tool on the Render tab. If you have used parameters in 

your assembly and want to animate the parameters, this is the tool you will use. The parameter 

must fi rst be added to the Animation Favorites folder, as discussed earlier.

You can also use Animate Parameters with part parameters. As a result, you can morph the 

physical shape of a part given the right set of parameters and animation actions. For example, 

let’s say you are designing a vascular stent. As part of the product presentation, you want to 
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show the degree to which the stent can expand and perform its function. How would you do 

this?

 1. Create a stent diameter parameter in the part model.

 2. In Inventor Studio, use the Parameter Favorites tool to nominate the parameter for anima-

tion use.

 3. Set the timeline to 2 seconds.

 4. Use Animate Parameters and change the stent diameter, thereby demonstrating the 

expansion the product undergoes.

If you’ve created user parameters on a part or assembly, you can access the parameters and 

animate them with these basic steps.

Using Animate Positional Representations

You can fi nd the Animate Positional Representations tool on the Render tab. Positional rep-

resentations (aka PosReps) use constraints to locate components while respecting the other 

constraints. You could conclude that they work almost like keyframes for an Inventor Studio 

animation. And, in fact, Inventor Studio treats them almost like that. Inventor Studio allows you 

to animate between positional representations.

All that is required is specifying the two PosReps and the time over which the transition 

is made. Inventor Studio does the rest. To animate a positional representation that is “deep”—

meaning it is deeper within the assembly hierarchy—you will need to set the subassemblies 

between the top level and the component owning the positional representation to Flexible. You 

do so by using the component’s context menu. The top-level PosRep must cause the “deep” 

PosRep to be activated.

You can also activate a “deep” PosRep by creating PosReps in each of the subsequent subas-

semblies. Each higher-level assembly has a PosRep that calls the child subassemblies’ PosRep. 

Repeat this for each subsequent subassembly.

Editing a PosRep animation action is like editing any other action, but there is a bonus. If you 

select the PosRep and expand the node in the Animation browser, you will see the participat-

ing members of the PosRep. Each of the members has an action bar, and you can edit the dura-

tion and position of the members interactively. The values must stay within the bounds of the 

defi ned PosRep. Initially, all members occupy the full span of the action, but you can change 

that by editing the PosRep. When you edit the PosRep, the members become enabled so you can 

adjust them. For an example of what this looks like, see Figure 16.21.

Using Animate Camera

You can fi nd the Animate Camera tool on the Render tab. When animating a camera, you use 

the current camera parameters as the “from” parameters of the animation action. Using the 

Animate Camera controls, you defi ne the “to” parameters for the animation action. With these 

controls, you can do the following:

 ◆ You can change the Camera Defi nition interactively or through a dialog box.

 ◆ You can use the view tools to position the camera and snapshot it as a keyframe using the 

Add Camera Action tool in the Animation Timeline window.
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 ◆ You can use the turntable functionality.

 ◆ You can defi ne a path and have the camera and/or target follow the path.

Figure 16.21
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In the Animate Camera dialog box, you select the camera to animate from the drop-down 

list. Then, using one of two methods, you defi ne the end position of the camera for that anima-

tion action.

The fi rst method is to use the Defi nition tool. To access its dialog box, just click the Defi nition 

button in the Camera section. The steps are similar to when you defi ne a camera using the dia-

log box, such as setting the target and position selection, as well as when you use additional 

animation options.

When you click the Defi nition button, the Camera dialog box displays, and you are able to 

specify the following:

Target Placement  Sets the line of sight the camera uses.

Fixed  The target does not change positions.

Floating  The target maintains the positional relationship to the camera.

Path  The target follows a path made of 2D or 3D sketch geometry.

Camera Position  Sets the camera position relative to the target.

Fixed  The camera does not change positions.

Floating  The camera maintains the positional relationship to the target.

Path  The camera follows a path made of 2D or 3D sketch geometry.

Roll Angle  Defi nes rotation around the camera to the target axis, displayed as a line 

between the camera components.

Zoom  Defi nes a horizontal fi eld of view.
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The second method for defi ning camera animation is to use the current view. The steps to do 

this are as follows:

 1. In the Timeline Active Camera list, select the camera you want to animate.

 2. Position the timeline slider at the time position representing the end of the action you are 

defi ning.

 3. In the Scene browser, right-click the camera you specifi ed in the list, and click Animate 

Camera in the context menu. Alternatively, you can select the camera in the graphics 

region.

 4. Use the view tools to orient the graphics region to the view you want to see at that time 

position.

 5. Click Add Camera Action (the camera button) next to the Timeline Active Camera list. 

You will see the view briefl y revert to the last known position and then update to the 

current position.

Repeat steps 2, 4, and 5 as needed for as many cameras as you want.

If you simply want a camera to travel around your part or assembly in a circle, the Turntable 

function makes this very easy. To use the Turntable functionality, do the following:

 1. Right-click the camera you want to use as a turntable camera, and click Animate Camera. 

Alternatively, use the view tools to set the camera to its initial position, right-click, and 

click Create Camera From View.

 2. In the Animate Camera dialog box, select the Turntable tab.

 3. Select the Turntable check box to enable the turntable controls. A graphic preview of 

the current axis is displayed in the graphics region. In the Axis list, select from any 

of the canonical axes or the current camera horizontal (Camera-H) or vertical (Camera-V) 

handles.

 4. Specify the direction of rotation around the selected axis.

 5. Specify the number of revolutions.

 6. Qualify the number of revolutions by selecting the literal (+/–), per minute, or per second 

option. For partial turntable effects, use a value less than one.

 7. In the Time section, select whether to loop the camera or use a time period to defi ne the 

length of the action.

As mentioned earlier, when you select the camera defi nition method, you have the option to 

specify that the target or camera follows a path.

If you are planning on animating a camera along a path, you must defi ne the path geom-

etry in advance. You do this in a separate part fi le using 2D or 3D sketch objects. The part fi le 

is added to the assembly and positioned where you want it before ever entering the Inventor 

Studio environment. You can, of course, add the path fi le later and then animate the camera, 

associating it with the path.

Note that in order for the path part fi le to be hidden from the bill of materials, the part should 

be designated as a reference part.
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When you select the Path option, move your mouse pointer into the graphic region and select 

the path you want to use. The tool searches for sketch geometry, so there are no confl icting 

inputs when you are in the graphics region.

After you select the path geometry, two handle glyphs appear on the path (Figure 16.22): a 

green triangle at the beginning of the path and a red square at the end of the path. The glyphs 

perform two functions:

Figure 16.22
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 ◆ They tell you the direction the camera is traveling along the path.

 ◆ Also, the glyphs can be moved along the path, serving as a limit setting for how much of 

the path is used. To adjust a glyph position, place the mouse pointer over the glyph, and 

click and drag along the path. Release the mouse button to accept the location.

Using Animate Light

You can fi nd the Animate Light tool on the Render tab. You can approach animating lights in a 

few ways. You can animate the lighting style, lights within a style, or local lights. For animating 

lights, the Animate Light dialog box has the same controls that were used to create or edit the 

lights. When defi ning an animation action for a light, you specify the light parameters as they 

will be at the end of the action. Inventor Studio tools use the previous parameter values as the 

starting point of the animation action and the new parameter values as the ending point of the 

animation action. You specify the time period over which the action occurs.

The fi rst steps for animating a light are the same regardless of the object to be animated:

 1. Activate the Animate Light tool. Alternatively, select the object to be animated and use 

the context menu entry, Animate Light. The Animate Light dialog box displays.

 2. If nothing was selected to start, specify the lighting style, style light, or local light to be 

animated. The Select tool is active by default.

 3. Click the Defi nition button.

 4. The corresponding dialog box appears, and only parameters capable of being animated 

are enabled.
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 5. If a style is selected for Lighting Style, you are able to animate the style brightness and 

ambience parameters.

 6. For a local light or a light in a style, a variety of parameters are enabled for animating. 

Specify the values you want represented in the animation at the selected time position.

 7. Click the OK button to commit to the values for the animation. An action is added to the 

timeline.

Local lights, when defi ned in components deeper in the assembly, are not accessible at the 

top-level assembly for animation. Local lights are meant to be light sources that travel with com-

ponents. Thus, if you defi ne a local light to be in a part used in the top-level assembly, that light 

will be lit and be a source of light in any renders or animations. The local light is part of the 

component, and wherever the component goes, the light goes also. Examples where local lights 

might be used are lighted gauges, switches, headlights, and so on.

Figure 16.23 shows a sequence of frames at time positions 2.3, 2.6, and 2.8. The local light has 

both intensity and position animated.

Figure 16.23

Animated local 
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Lights within lighting styles can provide animated scene lighting. Examples of uses are 

gallery lights, showroom lighting, and so on. Exploring the various ways to animate lights is 

worth the effort, not only for gaining experience but also for getting an idea of how much the 

light affects everything in the scene.

Dynamic Simulation to Studio

If you use Dynamic Simulation, part of the Autodesk® Inventor® Professional program, you will 

see the Publish To Studio tool in that environment’s tool panel, which allows you to render your 

simulation in Inventor Studio. The tool is used after you have run a simulation but before you 

leave run mode. You must run the simulation before using the tool.

The tool initiates the studio environment, creates a new animation called Dynamic_

Simulation, and adds a new parameter called Simulation_Timeline. The parameter is placed in 

the Animation Favorites folder and is ready to animate. The parameter represents the time 

steps used in the simulation. For this reason, it is recommended that you use the same number 

for the parameter value that is used for the images in the simulation. This way, you will be able 

to relate the animation to the simulation.

Animate the parameter, using the Animate Parameters tool, to see your simulation. Then use 

the other Inventor Studio tools, such as lighting and scene styles, to help enhance the animated 

result. When you’re ready, render the animation.
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Using Video Producer
Video Producer provides the ability to compose a single animation from one or more anima-

tions. To access these tools, click the Video Producer button, located on the Animate panel. You 

are able to select from all cameras that you have set up, whether animated or not. Reasonably, to 

provide content for a production, you must create one or more cameras and usually at least one 

animation.

Video Producer supports the following:

 ◆ Multiple cameras in the same animation

 ◆ Camera transitions

 ◆ Multiple productions in the same assembly document

 ◆ Interactive modifi cation of camera shots and transitions

It is also possible to create a production of still shots using a variety of cameras. Video 

Producer is presented in a window similar to the Animation Timeline window but with differ-

ent controls. The playback controls are the same as those in the Animation Timeline window 

and most other playback or player software.

The composing timeline and tabbed browser on the left are where you will fi nd the shots and 

transitions. Shots are the cameras that have been defi ned in Inventor Studio, whether animated 

or not. Transitions are available to use between shots. Transitions are overlays over the shots, not 

segments between shots. Therefore, transitions extend into the shot in one or two directions. 

This means that when you plan to use transitions, you will need to specify enough shot time to 

allow for the transitions.

When you activate Video Producer, all cameras are collected, and all image representa-

tions are made and listed in the Shot browser. This action is session based. Thereafter, only the 

cameras that change will be updated when you return to Video Producer during that Inventor 

session.

Four transition types are available, but fi ve possibilities exist when you consider “no transi-

tion” as an option. The transitions are as follows:

Fade  From color to shot, shot to shot, shot to color

Gradient Wipe  From left to right

Slide Left  Moves from left to right

Slide Right  Moves from right to left

You can compose with Video Producer in two ways: via a dialog box, or by dragging and 

dropping. Each has its own advantage.

Editing Shots and Transitions via Drag and Drop

First we’ll discuss dragging and dropping, or the interactive means of creating and editing. This 

method’s advantage is fast production layout. Note that the composition is an additive process, 

starting from the beginning of the production.
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Using the interactive method, you simply determine the camera shot you want to use 

and then drag and drop it onto the production track. You change the length of the shot by 

positioning the mouse pointer over either end, horizontally, and then clicking and dragging. 

Figure 16.24 shows an example of each of these techniques.

Figure 16.24

Interactive edit 

handles

You can also drag and drop to reorder the shots in the timeline. Transitions behave in a simi-

lar manner. You simply drag and drop one onto the track and then adjust them as needed.

To make it easier to edit contiguous production timeline members, you can select one and 

then move your mouse pointer over the neighboring member that is to be edited. The selected 

member displays a cyan highlight, and the new select target gets a red highlight, as shown in 

Figure 16.25. When both are highlighted, click and drag the boundary between them; they edit 

and update simultaneously.

Figure 16.25

A multimember edit

Selected member New select target

Editing Shots and Transitions via Dialog Boxes

For more precise control over the time used and shot segment, double-click the shot and edit the 

parameters. Alternatively, use the Edit option in the context menu.

In the Shot dialog box there are two sections: Animation Footage and Shot Footage. 

Animation Footage refers to what the camera records in the animation. Shot Footage is the 

portion of animation footage that is used in the active production.

In the production timeline, the shot footage displayed is the amount of time in the 

production that footage is displayed. Any portion of the selected camera, from the designated 

animation footage, can be displayed during that shot duration.

For Transitions, double-clicking or using the context menu to select Edit will give you explicit 

control over the effects parameter values. In the Effects dialog box, you can edit the type of tran-

sition and its parameters.
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Color is used for the secondary member of transitions that start or fi nish a production. Use 

the color selection to change the selection.

In the Shot dialog box, you can specify the following:

 ◆ The animation from which the footage came

 ◆ The point in time in the footage to begin using it

 ◆ The particular camera to get footage from

 ◆ The time frame of the camera footage to use

In the Effects dialog box, you can specify the following:

 ◆ The transition type

 ◆ The transition color

 ◆ The start, duration, and end timeline positions

These are the same parameters that are being edited when you do so interactively.

Rendering Video or Animations
It is important to note that if a production is active when you use the Render Animation tool, the 

active production, and not the animation, will render. If you want to render a single animation 

and you have productions, be sure to deactivate the production before rendering.

The available animation formats are WMV and AVI, which will be discussed in more detail 

in a moment.

The Render Animation dialog box is used whether rendering an animation or production. 

With productions, you have already selected the camera(s), so that fi eld is disabled. If you are 

rendering an animation, the camera input is enabled.

The General and Style tabs of the Render Animation dialog box use the same controls as the 

Render Image dialog box. The Output tab, shown in Figure 16.26, has controls that specify the 

various parameters for rendering the animation.

Figure 16.26
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On the Output tab, you specify the name for the fi le(s) that will be created. If you use a video 

format, you can choose from Windows Media Video (WMV) or Audio Video Interleave (AVI). 
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Based on the fi le type selection and after the OK button has been clicked, you are asked to spec-

ify the fi nal parameters before rendering:

WMV Format  You are asked to specify Advanced Systems Format (ASF) Export properties, 

in particular, the network bandwidth. If you use one of the default choices and the output is 

not to your liking, use the custom setting; start with 700 Kbps and increase from there.

AVI Format  You are asked to specify the video codec of choice. One or more codecs may 

have been delivered with the computer software. However, these, at times, may not produce 

the desired results.

Over the past few years, two video codecs have emerged as ones that routinely give good-

quality results with small to medium AVI fi le sizes. Although this is not an endorsement, it is 

good to know that the TechSmith (www.techsmith.com) and DivX (www.divx.com) codecs pro-

vide very good results.

In the Time Range section, specify whether the entire animation or a time range will be ren-

dered. If Time Range is selected, the timeline fi elds enable so you can specify the start and end 

times. If you want to reverse the rendered animation, select the Reverse check box.

Note that the controls on the right side of the input fi elds give access to the most recent values 

specifi ed for the tool.

The Antialiasing settings are the same as those used in the Render Image dialog box. From 

left to right they are None, Low, High, and Highest.

The Format section is where you specify whether the animation is output in video format or 

as a list of frame sequences. If frame sequence is specifi ed, incremented numbers are appended 

to the name provided as images are created. If you plan on adding comments within the video 

or if you do not have enough disk space, you can output as images and then composite them 

later. This allows you to move the images to another location and continue rendering.

Then, specify the number of frames per second the video will output with. You will fi nd that 

24 and 30 frames per second (fps) are commonly used in broadcast and fi lm media. A 15 fps ani-

mation may look good to you. Try it at 24 or 30 fps; you will notice the improvement.

A major concern of anyone rendering is the amount of time it takes to generate an image or 

animation. Rendering an animation without some idea of what it will look like is a potentially 

expensive proposition at best. To enable better decision-making processes, you are able to cre-

ate a preview render; just select the box. Preview renders do not use lighting styles and render 

quickly. This gives you a means of determining whether any adjustments are needed before 

committing to rendering over a lengthy period of time.

These are the tools and concepts to accomplish rendering and animation in Inventor Studio. 

The creative part is up to you. Spend time experimenting and you’ll fi nd you can create compel-

ling imagery.

Th e Bottom Line

Create and animate cameras.  Although static camera animations are a common part of any 

animation, by creating and animating cameras, you give your renderings a much more pro-

fessional feel.

Master It  You know that the most expedient means of capturing camera keyframe posi-

tions is to create a camera and animate it. How do you do this?

http://www.techsmith.com
http://www.divx.com
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Start new animations, modify animations, and use the various animation tools.  Animating 

your assemblies so that the function of the mechanism is showcased is often the purpose of an 

assembly animation.

Master It  You have an existing animation but want to do a variation on it. How do you 

copy and edit an existing animation?

Use multiple cameras to create a video production of your animation.  Video Producer 

provides the means to combine camera shots into a single video output.

Master It  You have created several cameras, animated and static, and want to make a 

composite animation. What are the general steps you will follow?

Use props to enhance your scene.  Inventor assemblies can be combined with other compo-

nents to create a more realistic scene for rendering.

Master It  You have completed a design and want to render a realistic image of it in its 

working environment. How do you do this?

Render shaded and illustrative images.  Inventor provides the means to render both 

shaded and illustrative images.

Master It  With your new product nearing completion, the marketing department has 

asked for rendered images for marketing collateral and technical documents such as 

white papers. What are the general steps for both realistic and illustration rendering?

Render animations and video productions.  Inventor provides the means to render anima-

tions and video productions.

Master It  You’ve created a wrapper assembly and set up the scene with cameras, light-

ing, and a scene style. Now you want to render an animation, for design review and a 

video production, for a multidisciplinary review or marketing. What are the basic steps 

in each process?





Chapter 17

Stress Analysis and Dynamic 
Simulation

This chapter will cover the tools of the Stress Analysis and Dynamic Simulation environments 

found in the Autodesk® Inventor® Professional software. The Stress Analysis environment 

allows you to perform static and modal analysis on parts and assemblies by defi ning component 

materials, loads, constraints, and contact conditions. A second type of stress analysis (referred 

to as frame analysis in this chapter) uses beam elements represented with a line segment that is 

centered in a Frame Generator member and interpolates the effects of loads on the geometry of 

the frame. This greatly improves the speed of the analysis.

The Dynamic Simulation environment allows you to analyze an assembly in motion by 

specifying loads, constraints, motion joints, velocities, acceleration, and environmental factors 

such as gravity and friction. These environments can be used together to determine motion 

loads enacted upon one component by another component at a given point in time.

In this chapter, you’ll learn to:

 ◆ Set up and run Stress Analysis simulations

 ◆ Set up and run Dynamic Simulations

 ◆ Export results from the Dynamic Simulation environment to the Stress Analysis 

environment

Introduction to Analysis
Although the terms stress analysis and fi nite element analysis (FEA) are often used interchangeably 

in conversation, it may be helpful to understand them as they relate to the tools available to 

you in the Inventor Stress Analysis environment. FEA is an analysis of a complex object solved 

by dividing that object into a mesh of smaller elements upon which manageable calculations 

can be run. The stress analysis done by Inventor uses this method to allow you to analyze your 

design, under a given set of conditions specifi ed by you, in order to determine basic trends in 

regard to the specifi cs of your design.

Deriving an exact answer from the analysis of a model is generally reserved for an analyst 

with specifi c training, often for a more powerful set of analysis tools. With that said, you can use 

the Inventor simulation tools to run basic analyses to confi rm design validity. This can be useful 

to determine design basics before going down a wrong path. Or you can use these tools to help 

fi nd out, for example, whether a component or assembly is being over- or underdesigned for a 
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given set of loads and/or vibrations. The stress analysis tools in Inventor are also useful when 

determining how feature size and locations will affect the integrity of the part. For instance, 

how close to the edge of a bracket can you move a hole? Is another brace required to prevent a 

sheet-metal face from “pillow casing” because of a pressure load? These tools are ideal for ques-

tions of this nature and can signifi cantly reduce the number of physical prototypes required to 

prove a fi nal design.

Dynamic simulation allows you to set the components of your model in motion to verify how 

those parts interact with one another, and to determine the force enacted on one component (or 

group of components) by another component (or group of components). The Dynamic Simulation 

environment allows you to defi ne the way parts relate to one another and how the forces present 

create motion in the context of a timeline. From the simulation, you can determine how and when 

parts interact as well as the amount of force present for any point in time. For example, you might 

use these tools to simulate a force applied to a shaft used to turn a lever, which in turn contacts 

a catch stop, where the goal is to determine the maximum force present throughout the entire 

sequence. Once this maximum force is determined, it can be applied to the shaft as loads in a 

stress analysis study.

Autodesk Inventor Simulation Tutorials

If you have Inventor Professional installed, you can fi nd a number of tutorials for the simulation 

tools by visiting http://wikihelp.autodesk.com. Once the tutorial fi les are downloaded, you’ll 

need to point Inventor to the fi les by setting the project search path to tutorial_fi les. To do so, 

follow these steps:

 1. In Inventor, close any open fi les.

 2. From the Get Started tab, click the Projects button.

 3. In the Projects dialog box, select tutorial_fi les from the list.

 4. Click the Apply button at the bottom of the Projects dialog box.

 5. Note the check mark next to tutorial_fi les in the list, denoting that it is the active project, and 

then click Done to close the Projects dialog box.

Now you can return to the Wiki Tutorials site and follow along.

Conducting Stress Analysis Simulations
You can simulate a stress situation on your design to determine the effects of various load and 

constraint scenarios to determine areas of weakness, better design alternatives, how much a part 

is over- or underbuilt, to what extent a design change will impact a design, and so on. Using 

parametric studies, you can determine a combination of these elements to see how multiple 

changes impact a design at the same time. For more information on this topic, refer to the sec-

tion “Conducting Parameter Studies” later in this chapter. This is an important task because 

understanding the basic tools and workfl ow is the fi rst step to setting up effective simulations.

http://wikihelp.autodesk.com
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The basic stress analysis workfl ow is as follows:

 1. Enter the Stress Analysis environment (on the Environment tab, select Stress Analysis).

 2. Create a simulation.

 3. Specify the type of simulation you want to conduct (for instance, when working 

with assemblies, you may want to use an alternate view, positional, or level of detail 

representation).

 4. Specify the materials for the components.

 5. Specify the load types, locations, and amounts.

 6. Specify the support types and locations.

 7. For assemblies, gather and refi ne contact between components.

 8. Generate a mesh.

 9. Run the simulation.

 10. Interpret the results.

To aid you in the process of learning how to conduct a stress analysis study, Autodesk has 

built in the Simulation Guide.

Simulation Guide
The Simulation Guide can be found toward the right end of the Stress Analysis tab once you 

have started to construct a simulation. To access the Simulation Guide, click the Guide button 

and the Simulation Guide panel will appear.

This tool was built with two types of users in mind: the novice who is looking for an under-

standing of the process of conducting a simulation, and the intermediate user who has been 

using an FEA tool in the past and is looking for additional advice on using the Inventor toolset 

or seeking to improve their knowledge.

The tool can be launched before you begin a simulation, or if you’ve already started setting 

up a simulation, it will open to the next appropriate step to offer guidance. To help in selecting 

load and constraint types, the guide contains a series of hyperlinks that will step you through 

various options on how the component or assembly is constructed and how it moves or is sup-

ported. It will even check with you to see if there are features that may not infl uence the result 

of the analysis but may add unnecessary time to the process.

Static Stress vs. Modal Analysis
You can perform static and modal stress analysis on parts and assemblies in the Stress Analysis 

environment. To enter this environment, click the Stress Analysis button on the Environments 

tab. Once in the Stress Analysis environment, you use the Create Simulation button and specify 

either Static Analysis or Modal Analysis. It’s important to understand the difference between 

static and modal analysis:

Static Analysis  Attempts to determine the stress placed on a component by a particular 

set of loads and constraints. The stress is considered static because it does not vary due to 
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time or temperature. You can import motion loads determined from the Dynamic Simulation 

environment to analyze the stress at any given time step for moving parts.

Modal Analysis  Attempts to determine the dynamic behavior of a model in terms of its 

modes of vibration. An example would be trying to determine whether the vibration gen-

erated by a running motor would create signifi cant disturbance to a sensitive mechanism 

within the design.

Simplifying Your Model
When working with assemblies, you should exclude parts that are not affected by the simulation 

or do not add to its results, in order to simplify the simulation and reduce the time required to 

run it. Excluding small parts such as fasteners, whose functionality is replicated by simulation 

constraints or forces, is also recommended. You can do this by expanding the assembly browser 

node, right-clicking the part to be excluded, and then selecting Exclude From Simulation.

When working with a part fi le in the simulation environment, you can suppress small fea-

tures that are irrelevant to stress concentrations, such as outer fi llets and chamfers. These “fi n-

ish” features typically only complicate the mesh needed for the simulation and add overhead to 

the analysis. Other features that are typically excluded from simulations are small holes with 

diameters of less than 1/100 the length of the part, embossed or engraved text, and other aes-

thetic features. Excluding features of these types can have a signifi cant impact on the meshing 

process and the simulation’s run time. Figure 17.1 shows the exclusion of features from a part fi le 

on the left and the exclusion of parts from an assembly on the right. Using the appropriate selec-

tion fi lter, you can select features and parts to exclude in the design window using typical right-

click context menu behavior while in the assembly.

Figure 17.1

Th e Exclude 

features for a 

simulation

Specifying Materials
To specify the material of each part in a simulation, use the Assign button on the Material panel 

of the Stress Analysis tab. Material properties must be fully defi ned in order for the material 

to be used for the simulation. Materials with incomplete information are marked with an icon. 

Figure 17.2 shows the Assign button used to access the Assign Materials dialog box as well as 

the icon indicating that incomplete materials have been specifi ed.
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Figure 17.2

Assigning materials

You can specify the original material for each component or specify an override (per simu-

lation) from the Material Library. To change the original material of the part fi le while in the 

Stress Analysis environment, click the Inventor button, select iProperties, and then select the 

Physical tab. You can use the Styles Editor button in the Assign Materials dialog box to step into 

the Style And Standard Editor to edit, add, or just review the properties of any material style. 

You can fi nd the physical characteristics of a given material from a number of resources on the 

Internet, such as www.matweb.com.

It is assumed that materials are constant, meaning there is no change because of time or 

temperature to the structural properties of the material. All materials are assumed to be homog-

enous, with no change in properties throughout the volume of the part. And it is also assumed 

that stress is directly proportional to strain for all materials.

By default, the browser will display the names of components with overridden materials 

under the material name. You can also display all materials assigned to components by right-

clicking the Material category in the browser and then selecting All Materials from the con-

text menu.

Applying Simulation Constraints
Constraints added in the simulation limit the movement or displacement of the model for the 

purposes of the simulation. To constrain a model for static simulations, you should remove all 

free translational and rotational movements. You should also strive to neither over- nor under-

constrain your model because both can impact the simulation results.

You can create all the constraint types by clicking the constraint tool buttons on the 

Constraints panel of the Stress Analysis tab, shown in Figure 17.3.

Figure 17.3

Th e simulation con-

straint tools

These are the types of simulation constraints available:

Fixed Constraints  These remove all translational degrees of freedom and can be applied to 

faces, edges, or vertices, typically to simulate a part that is bonded or welded to another com-

ponent. You can click the >> button to specify the Use Vector Components option and free 

http://www.matweb.com
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the component in a given vector plane. Fixed constraints can also be used to specify a known 

displacement of a component to determine the force required to create the displacement.

Frictionless Constraints  Use these constraints to prevent the selected surface from deform-

ing or moving in a direction normal to it. You can also use frictionless constraints to simulate 

linear bearings and slides. Because most surface-to-surface situations are not entirely fric-

tionless, you can expect the simulation to return more moderate results. If friction is consid-

erable, it can be compensated for in the Dynamic Simulation environment, and the results 

can be imported into the Stress Analysis environment.

Pin Constraints  These are used to apply rotational constraints on a selected cylindrical 

face (or faces), such as where holes are or where parts are supported by pins or bearings. 

Use the >> button to set the direction options. A pin that rotates in a hole would have only 

the tangential direction free, one that slides in a hole but does not rotate would have only 

the axial direction free, one that slides and rotates would have both the axial and tangential 

directions free, and so on.

Figure 17.4 shows the simulation constraint dialog boxes.

Figure 17.4

Th e simulation con-

straint dialog boxes

Applying Loads
Loads are forces applied to a part or assembly resulting in stress, deformation, and displace-

ment in components. A key to applying loads is being able to predict or visualize how parts will 

respond to loads. For simple static simulations, this is generally fairly straightforward, but for 

more complex designs where one component exerts a force on another, which exerts a force on 

yet another, loads will likely need to be determined through the use of the Dynamic Simulation 

tools, as discussed later in this chapter.

You can access all the load types from the Loads panel of the Stress Analysis tab, as shown in 

Figure 17.5.

Figure 17.5

Th e load tools
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These are the types of load available:

Force  This is specifi ed in newtons (N) or pounds-force (lbf or lbforce). Forces can be applied 

by selecting a single face, edge, or vertex (or a set of faces, edges, or vertices) for the loca-

tion. Selection sets must be of the same type, meaning that once you select a face, you can 

add faces to the selection set but not edges or vertices. The force direction can be specifi ed 

by selecting an edge or face and then changed using the Flip Direction button. Direction is 

automatically set to the normal of the face (with the force directed at that face) when a face 

is selected for either a location or a direction. You can avoid stress singularities by selecting 

faces or the location rather than edges or vertices.

Pressure  This is specifi ed in megapascals (MPa) or pounds per square inch (psi). Pressure 

can be applied only to a face or set of faces. Pressure is uniform and is applied in a direction 

normal to the surface at all locations. When applying loads to faces that are involved in con-

tacts, you should use pressure instead of force.

Bearing  These are specifi ed in newtons (N) or pounds-force (lbf or lbforce). Bearing loads 

are applied only to cylindrical faces. By default, the load is along the axis of the cylinder, and 

the direction is radial. You can specify the direction by selecting a face or edge. These are 

generally used to simulate a radial load such as a roller bearing.

Loads and Constraints

Loads and constraints can be applied to the same entity as long as they are compatible. When 

incompatible loads and constraints exist on the same entity, such as a face fi xed in the X direction 

while a load is applied in the same direction to the same face, the constraints will override the forces.

Moment  These are specifi ed in units of torque such as newton meters (N m or N*m) or 

pounds-force inch (lbforce in or lbf*in). Moment locations can be applied to faces only. Direc-

tion can be defi ned by selecting faces, straight edges, axes, and two vertices.

Remote Force  These can be used as an alternative to applying a force load directly to a part 

by specifying the location in space from which the force originates. Apply Remote Force by 

selecting faces and specifying in N or lb.

Gravity  These are specifi ed in units of acceleration such as millimeter per second squared 

(mm/s2) or inch per second squared (in/s2). Apply gravity to a face or parallel to a selected 

edge. The default gravity value is set to 386.220 in/s2 or 9810.000 mm/s2.

Motion  Unlike with the other forces, there is no tool to apply motion loads in the Stress 

Analysis environment; instead, these are created from reaction forces determined from the 

Dynamic Simulation environment using the Export To FEA tool for a component per specifi ed 

time step(s). Once they are created, you can use motion loads by one of the following methods: 

For a new simulation, click the Create Simulation button on the Stress Analysis tab. For an 

existing simulation, right-click the existing simulation in the browser node, and select Edit 

Simulation Properties.
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In either case, once the Simulation Properties dialog box is open, you follow these steps:

 1. In the Simulation Properties dialog box, select the Motion Loads Analysis check box.

 2. Select the part from the enabled list.

 3. Select the time step from the list.

 4. Click the OK button.

Body  These are specifi ed in units of acceleration such as millimeter per second squared 

(mm/s2) or inch per second squared (in/s2). Body loads are the forces acting on the entire 

volume or mass of a component, such as gravity, linear acceleration, centripetal force, and 

centrifugal force. Select a planar face for linear acceleration or a cylindrical face for an axial 

direction. Use a body force to simulate the effect of outside forces. Only one body force per 

simulation is allowed.

Use the Linear tab to specify linear acceleration and the Angular tab to specify angular 

velocity or angular acceleration. The Angular tab has three possible results depending on 

what is specifi ed and how:

 ◆ Velocity and acceleration have the same rotation axis, with an unspecifi ed location. 

The solver determines the location along the axis.

 ◆ Velocity and acceleration have different rotation axes, with an unspecifi ed location. 

The solver determines the location along the axis. A point is selected along the veloc-

ity rotation axis for the acceleration location.

 ◆ Velocity and acceleration have different rotation axes, with a specifi ed location. The 

solver determines the location the same as when you defi ne the point with the vector 

components.

Using Split to Apply Loads Accurately

When you assign bearing loads to components, you may need to split the face fi rst in order to select 

just a portion of a continuous face. For instance, consider applying a load to a shaft. If you 

select the cylindrical face, the load might be distributed along the entire face rather than con-

centrated on just the area intended to be loaded. You can use a work plane to split the face. Th is 

can be useful when placing loads on fl at surfaces as well. Use a sketch to divide the surface into a 

face appropriate to the load. You can access the Split tool in the modeling environment from the 

Modify panel of the Model tab.

Specifying Contact Conditions
Contacts between components are detected when the simulation is run and automatically listed 

in the browser under the contact node. However, you can run the Automatic Contact tool to see 

them before running the simulation and then modify any of the automatic contacts listed or 
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manually add other contacts. To add contacts, click either the Automatic or Manual button on 

the Contacts tab, shown in Figure 17.6.

Figure 17.6

Contact tools

For contacts to be added, the faces must meet the following criteria:

 ◆ The selected faces must be within 15 degrees of parallel. This 15-degree limit is a system 

setting and cannot be changed.

 ◆ The distance between the selected faces cannot exceed the Tolerance setting specifi ed in 

the simulation’s properties. You can access the simulation’s properties by right-clicking the 

simulation node in the browser for existing simulations, or you can specify them when you 

create the simulation.

Contacts are listed in the contact node in the browser and categorized per contact type. The 

type and components involved are set in the contact node name. Contacts are also listed under 

the browser node of each involved component. Modal analysis lists only the Bonded and Spring 

contact types, whereas all types are available for static analysis. You can change the contact type 

of automatic contacts by right-clicking a contact and choosing Edit Contact or by using the Ctrl 

or Shift key to multiselect contacts and then right-clicking and choosing Edit Contact. You can 

suppress contacts as well. Figure 17.7 shows the edit options.

Figure 17.7

Contact edit 

options

These are the available contact types:

Bonded  This creates a rigid bond between selected faces.

Separation  This partially or fully separates selected faces while sliding.

Sliding/No Separation  This creates a normal-to-face direction bond between selected faces 

while sliding under deformation.

Separation/No Sliding  This partially or fully separates selected faces without them sliding 

against one another.
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Shrink Fit/Sliding  This creates conditions similar to Separation but with a negative dis-

tance between contact faces, resulting in overlapping parts at the start.

Shrink Fit/No Sliding  This creates conditions of Separation/No Sliding but with a nega-

tive distance between contact faces, resulting in overlapping parts at the start.

Spring  This creates equivalent springs between the two faces. You defi ne total Normal 

Stiffness and/or Tangential Stiffness. The Normal Stiffness and Tangential Stiffness options 

are available for the Spring contact only.

You can change the contacts between two components to see how the simulation results 

change. Figure 17.8 shows the same simple assembly simulation with a different contact applied 

between the two plates. On the left, a bonded contact is used, and the results show that the verti-

cal plate is deformed by the load and that stress is concentrated at, and distributed out from, the 

contact joint. On the right, a Sliding/No Separation joint is used, and the results show that the ver-

tical plate is essentially pushed along the horizontal plate, with the stress being spread over the 

vertical plate and little or no concentration and no stress being distributed to the horizontal plate.

Figure 17.8

Contact comparison Bonded Sliding/No Separation

Preparing Th in Bodies
Your models sometimes contain components that have thin walls compared to the overall size 

of the model, such as sheet metal or plastic parts. As a result of this variation, standard analysis 

can cause long meshing times and instabilities in the computation. To deal with this you can use 

the tools found on the Prepare panel to simplify thin wall bodies to be seen as surface shells. 

When you use the Find Thin Bodies tool, the model is scanned and any bodies found to have 

a high Length/Thickness ratio are identifi ed as potential thin bodies, and you are given the 

option to generate mid-surfaces for the body. Alternatively, you can use the MidSurface tool to 

generate mid-surfaces for bodies you know to be considered thin bodies in advance. You can also 

use the Offset tool to create a shell from selected faces.

Once mid-surfaces or offset shells are created, you can convert them back to solids by selecting 

them in the browser, right-clicking, and choosing Delete. Keep in mind that loads and constraints 

applied to solid bodies before preparing them as thin bodies become sick when converted to shell 

elements and might need to be deleted. Figure 17.9 shows the Prepare tools on the left.
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Figure 17.9

Prepare and Mesh 

tools

Generating a Mesh
Although you can accept the default mesh settings and run the simulation, often you will want 

to adjust the mesh settings to compensate for areas where a fi ner mesh is required. You can 

adjust the global mesh settings or use a local mesh control when needed. Figure 17.9 shows the 

Mesh tools on the right.

Mesh Settings

Use the Mesh Settings tool to change these mesh properties:

Average Element Size  Controls the mean distance between mesh nodes. Setting Average 

Size to a smaller value results in a fi ner mesh. This setting is relative to the overall size of the 

model. A value from 0.100 to 0.050 is generally recommended.

Minimum Element Size  Controls the minimum distance between mesh nodes as a fraction 

of the Average Size value. Increasing this will decrease the mesh element density. Decreasing 

this value will increase the mesh element density. This setting is sensitive, and changes typi-

cally result in dramatic changes to the mesh quality. A value from 0.100 to 0.200 is generally 

recommended.

Grading Factor  Controls the ratio of adjacent mesh edges where fi ne and coarse mesh areas 

come together. The smaller the factor used, the more uniform the mesh will be. A value of 1 

to 10 can be used, but a value from 1.5 to 3.0 is typically recommended.

Maximum Turn Angle  Controls the maximum angle for meshes applied to arcs. Specifying 

a smaller angle results in a fi ner mesh on curved areas. A value between 30 and 60 degrees is 

typically recommended.

Create Curved Mesh Elements  Controls the creation of meshes with curved edges and 

faces. If this is unselected, a less-accurate mesh is created, but performance may be better.

Use Part-Based Measure for Assembly Mesh  This sets part mesh sizes relative to the over-

all dimensions of the part models. Deselecting this option sets the mesh size relative to the 

overall assembly dimensions. Use this option for assemblies composed of several parts of 

varying sizes. This setting is available only in an assembly.

Once the mesh settings have been adjusted, you can click the Mesh View button to generate 

the mesh initially and then toggle on the visibility of the mesh afterward. It is not required that 

you generate the mesh manually, because it will be done during the simulation, but doing so 

may allow you to identify areas of importance on the model that are not meshed to your liking 

and then apply a local mesh.
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Local Mesh Control

You can use the Local Mesh Control button to select faces and edges that require a fi ner mesh-

ing than what is required for the rest of the model. This allows you to manually improve the 

mesh quality for small or complex faces. A browser node is created in the Mesh node for each 

local mesh you create. You can right-click the local mesh and select Edit Local Mesh Control to 

change the mesh size or change the faces or edges selected.

When mesh settings or local mesh controls have been updated, a lightning bolt icon will dis-

play in the browser to indicate that the mesh is out-of-date. You can right-click the Mesh browser 

node and choose Update Mesh, as shown in Figure 17.10. This fi gure shows a simple cube with a 

local mesh applied to the top face; the other faces are meshed according to the mesh settings.

Figure 17.10

Updating a mesh

Understanding Mesh Settings

To understand the way these settings aff ect the mesh generated, you can use the fi le mi_17b_88

.ipt in the Chapter 17 directory of the Mastering Inventor 2014 folder and apply a mesh 

to it. Th is fi le is a simple cube with rounded edges. Experiment with the options using the Mesh 

Settings tools. Th en apply a local mesh. Exit the Stress Analysis environment, edit the model, and 

change the value for Extrusion1 to 30 mm (all of the dimensions of the cube are set to be the same 

and will update to match).

Return to the Stress Analysis environment, and update the mesh. Note that the mesh adjusts as 

the cube size increases, whereas the local mesh holds an absolute size. Use the Mesh Settings tool 

to take a look at the other settings as well. Understanding the impact of each setting on a simple 

part model will allow you to determine the eff ect of each setting on your more complex models.

Mesh Errors

When model errors prevent a mesh from being created, a mesh failure warning is displayed. 

Errors are reported in the Mesh progress dialog box, in the Mesh browser node, and with an 

error label and leader on the model in the graphics area.
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An Interface Option Worth Noting

Th e previous sections discuss the selection of materials, application of loads, and generation of 

meshes. Th ese things are categorized in the browser.

An alternative to accessing the tools from the Stress Analysis tab is to right-click these categories 

in the browser and select the same tools from the context menu presented.

Running the Simulation
Once you have set the material, loads, constraints, and contacts, you are ready to run the simula-

tion. To run a simulation, click the Simulate button on the Solve panel, or right-click the Simulation 

node in the browser and select Simulate. The Simulate dialog box displays information about the 

simulation to be run and will display warning and stop errors when not all criteria are available 

to run. For instance, if you have forgotten to set a material type, the Simulate dialog box will stop 

you and tell you this. If you need to cancel a simulation in process, click the Cancel button or press 

the Esc key.

When a simulation becomes out-of-date because of changes to mesh settings, loads, con-

straints, or other design parameters, you will see a red lightning bolt next to the Results browser 

node. To update the simulation, simply right-click the browser node and click Simulate, or just 

click the Simulate button on the Solve panel again.

When working with parametric studies, it is possible to run simulations for more than one 

confi guration at a time. You can run an Exhaustive Set or Smart Set of confi gurations or just run 

the current confi guration. You can fi nd more information on simulating confi gurations in the 

section “Conducting Parameter Studies” later in this chapter.

External Linked Files Created by Simulation Results

Be aware that by default the Results fi les are created and linked to your fi le when you run a simu-

lation. Th ese externally linked fi les can cause fi le-resolution problems when you move or copy 

simulation fi les or if you use Autodesk Vault. You can avoid the linked fi les by clicking the Stress 

Analysis Settings button and then activating the Solver tab. Th en locate the Create OLE Link To 

Result Files option, and uncheck the check box.

To remove links created when this check box was selected, you can go to the Tools tab and click the 

Links button found on the Options panel. In the Document Links And Embeddings dialog box, 

select a link path and use the Break Link button to remove the link.

Interpreting the Results
Once a simulation is run, the Results node of the browser is populated, and the graphics area 

updates to show the shaded distribution of stresses. You can switch between available results 
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types by double-clicking each type in the Results browser folder. Figure 17.11 shows a typical 

simulation result. Note the Results folder in the browser.

Figure 17.11

Simulation results

The Results node of the browser will display the subcategories of results, each displayed 

on the model by the use of color contours. The colors displayed on the model correspond to the 

value ranges shown in the color bar legend. Typically, areas of interest are displayed in warm 

colors such as red, orange, and yellow. These colors represent areas of high stress, high deforma-

tion, or a low safety factor. You can adjust the number of colors used in the color bar as well as 

the position and size of it by clicking the Color Bar button on the Display panel. Listed here 

are the result subcategories:

Von Mises Stress  Maximum stress theory states that failure will occur when the maximum 

principal stress in a component reaches the value of the maximum stress at the elastic limit. 

This theory works to predict failure for brittle materials. However, in elastic bodies subject to 

three-dimensional loads, complex stresses are developed, meaning that at any point within 

the body there are stresses acting in various directions. The Von Mises criterion calculates 

whether the combining stress at a given point will cause failure. This is represented in the 

Results node as the Von Mises Stress, also commonly known as equivalent stress.

1st Principal Stress  Principal stresses are calculated by converting the model coordinates 

so that no shear stresses exist. The 1st principal stress is the maximum principal stress and is 

the value of stress that is normal to the plane in which shear stress is zero. This allows you to 

interpret maximum tensile stress present because of the specifi ed load conditions.

3rd Principal Stress  The 3rd principal stress is the minimum principal stress, and it acts 

normal to the plane in which shear stress is zero. It helps you to interpret the maximum com-

pressive stress present in the part because of the specifi ed load conditions.

Displacement  The displacement results show you the deformed shape of your model in a 

scaled representation, based on the specifi ed load conditions. Use the displacement results to 

determine the location and extent to which a part will bend, and how much force is needed 

for it to bend a given distance.
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Safety Factor  The safety factor is calculated as the yield strength of the material divided 

by principal stress. This shows you the areas of the model that are likely to fail under the 

specifi ed load conditions. The calculated safety factor is shown on the color bar legend as the 

value followed by min. A safety factor of less than 1 indicates a permanent yield or failure.

Frequency Modes  Modal results appear under the Results node in the browser as fre-

quency modes only when a modal analysis is running. You can view the mode plots for the 

number of specifi ed natural frequencies. In an unconstrained simulation, the fi rst six modes 

will occur at 0 Hz, corresponding to the six standard rigid body movements.

Using the Result, Scaling, Display, and Report Tools
You can use several display tools to adjust the Results display to clearly interpret the calculated 

results. You can access these tools on the Result, Display, and Report panels, as shown in 

Figure 17.12.

Figure 17.12

Result, Scaling, 

Display, and Report 

tools

The following list describes the Result, Scaling, Display, and Report tools available on the 

Display panel:

Same Scale  Maintains the same scale while different results are viewed. This might be 

grayed out if no parametric table has been created.

Color Bar  Opens the Color Bar dialog box so you can adjust the color bar display settings.

Probe  Allows you to select the model and display results information for the selection. 

Right-click a label to edit or delete it.

Probe Labels Display  Toggles the visibility of probe labels.

Shading  Displays color changes using a blended transition when set to Smooth Shading, 

striated shading when using Contour Shading, and no color shading when set to No Shading.

Maximum  Turns on and off the display of the point of maximum result, which allows you 

to quickly identify the maximum result on the model.

Minimum  Turns on and off the display of the point of minimum result, which allows you 

to quickly identify the minimum result on the model.

Boundary Condition  Turns on and off the display of load symbols on the part.

Adjust Displacement Scale  Allows you to select from a preset list of displacement exag-

geration scales.
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Element Visibility  Displays the mesh over the top of the result contours.

Animate Displacement  Animates the displacement for the current result type and dis-

placement scale.

Report  Generates reports of analysis simulations in HTML format with PNG graphics.

Conducting Parameter Studies
Often the purpose of a stress analysis simulation is to determine how a change to a design fea-

ture will impact the part or assembly’s strength. The parametric study tools allow you to make 

comparative evaluations based on different parameter values at the feature, part, and assem-

bly levels. To create a parametric study, you nominate certain parameters for evaluation in the 

study, defi ne the range for each parameter, specify the design constraints that you are interested 

in seeing for those parameters, and fi nally, analyze the results of each variation.

To create a parametric study, use these steps as a guideline:

 1. Set the simulation’s design objective to Parametric Dimension. How you do this depends 

on whether you are creating a new simulation or editing an existing one. You can set the 

design objective to Parametric Dimension by using the Create Simulation button when 

creating a new simulation or by right-clicking an existing simulation in the browser and 

choosing Edit Simulation Properties, as shown in Figure 17.13.

Figure 17.13

Setting a simulation 

to the Parametric 

Dimension design 

objective

 2. Nominate selected parameters for use in the study by expanding the browser node for 

the model and then right-clicking the assembly, part, or feature node you want to use in 

the study and selecting Show Parameters. Figure 17.14 shows a parameter called 

Side_Offset being nominated.

Figure 17.14

Nominating a 

parameter
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 3. Defi ne the range for the selected parameters by following these steps:

 A. Click the Parametric Table button on the Manage panel of the Stress Analysis tab.

 B. Enter a parameter range in the Values column; values must be in ascending order.

 C. Create a simple range by separating the minimum and maximum values with a 

hyphen; for instance, you can enter 70-85.

 D. Specify specifi c values in a range by separating each value with a comma, colon, 

hyphen, or slash; for instance, you can enter 70, 75, 80, 85.

 E. Add a colon to a range to specify the number of points included; for instance, you can 

enter 70-85: 4.

 F. Use the slider to set the current value.

 G. Right-click the parameter row, and choose from the options to generate the geometry 

confi gurations. For instance, if you were to set the range of a hole position to 70, 75, 80, 

85, four model confi gurations would be created with the hole positioned at each of 

those values. Figure 17.15 shows a Parametric Table confi guration for the Side_Offset 

parameter.

Figure 17.15

Defi ning a param-

eter range

 4. Add design constraints to the Parametric Table by following these steps:

 A. In the Design Constraints area of the Parametric Table, right-click a row, and select 

Add Design Constraint.

 B. In the Select Design Constraint dialog box, specify a results component, such as Von 

Mises Stress, Displacement, Safety Factor, and so on.

 C. Specify the value of interest, such as Minimum or Maximum (this applies to all 

geometry).
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 D. You can modify the selection set by selecting Include or Exclude and then selecting 

bodies, faces, or edges on-screen. Doing so focuses the results to a specifi c area of inter-

est. Figure 17.16 shows the Safety Factor design constraint being added.

Figure 17.16

Adding a design 

constraint

 5. Specify the constraint type, set limits, enter a safety factor, and review the results using 

the following steps:

 A. In the Parametric Table dialog box, click the Constraint Type drop-down, and select 

from the list.

 B. Enter a value in the Limit column to fi lter the results to the set that meets the bounding 

limit when you’re optimizing other design constraints.

 C. Enter a safety factor to specify at what extent a variable can be exceeded before causing 

the design constraint to fail. A comparison to the limit factored by the Safety Factor 

setting determines whether it meets the limit or range.

 D. The Result Value column displays the value of the design constraint for the simulation. 

When the value is within the limit, it displays green. When the limit is exceeded, it dis-

plays red. When out of range, it displays gray and the closest value is displayed. 

Figure 17.17 shows the Mass design constraint being confi gured.

Figure 17.17

Confi guring a 

design constraint
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 6. When multiple parameters are added to the table, confi gurations can be created. These 

confi gurations can then be generated and simulated by following a few simple steps:

 A. In the Parametric Table dialog box, set the parameter values to the combination you 

want to simulate, right-click any parameter row, and choose Simulate This 

Confi guration.

 B. To simulate all confi gurations, exit the Parametric Table dialog box, and click the 

Simulate button on the Solve panel. You can choose to run an exhaustive set, a smart 

set, or the current confi guration.

 C. Once the simulations have been run, you can use the slider bar in the Parametric Table 

dialog box for each parameter to set the combinations and observe the results.

 D. The Exhaustive Set Of Confi gurations setting runs all possible combinations of 

parameter settings, whereas the Smart Set Of Confi gurations setting runs only those 

combinations of parameter settings that Inventor determines have not yet been run. 

Figure 17.18 shows the choices for running simulation confi gurations.

Figure 17.18

Simulation 

confi gurations

Once you determine that a given confi guration satisfi es your design needs using the 

Parametric Table dialog box, you can right-click any of the parameter rows in the table and 

choose Promote Confi guration To Model. This will write the parameter values of the confi gura-

tion to the source fi les.

Conducting a Frame Analysis
As you learned in Chapter 15, “Frame Generator,” having a library of predefi ned metal shapes 

can save a tremendous amount of work because you won’t have to re-create standardized 

geometry. Frame Analysis allows you to further leverage those predefi ned shapes by using the 

known behavior of the shape under load and calculating what the loads would be along the cen-

ter of a length of material rather than the surface.

The process of conducting a frame analysis is similar to performing an assembly analysis, 

but frames add some additional tools that allow for an even more effi cient solving process. Here 

is the process, including some optional steps:

 1. Enter the Frame Analysis environment through the Environments tab or by using the 

icon on the Design tab.

 2. Create a simulation.

 3. Specify the support types and locations.
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 4. Specify the load types, locations, and amounts.

 5. Specify connections between beams, additional nodes, or releases (optional).

 6. Run the simulation.

 7. Interpret the results.

Frame Analysis Settings
You can adjust Frame Analysis settings by clicking the Frame Analysis Settings button found on 

the Frame Analysis tab. On the General tab, you can adjust the colors, scales, and interface dis-

play. If you deselect the Use HUD In Application check box, you can use the traditional dialog 

box interface. By default, the Heads Up Display (HUD) interface is selected.

On the Beam Model tab, you can choose to automatically create rigid links, which allows 

you to adjust the model during automatic conversion. When the check box is cleared, rigid links 

are not created automatically during model conversion, but you can create rigid links manually 

later. You can also use the Trim Mitered Beam Ends option to trim overlapping ends during 

automatic model conversion, which simplifi es the model and improves the accuracy of the simu-

lation results.

The Solver and Diagrams tabs can be used to tweak the style of the simulation outputs and 

graphs ahead of time.

Frame Constraints
The concept of the constraint is the same for Frame Analysis but the realities of how a frame 

is constructed can be different. Portions of the frame may be built with the ability to have one 

end move freely or slide along another member. This opens up the need to be able to approach 

things differently to assure accuracy.

You can access all the constraint types from the Constraints panel of the Frame Analysis tab, 

as shown in Figure 17.19.

Figure 17.19

Th e frame 

constraints

These are the types of constraints available:

Fixed Constraints  Like the Fixed constraint in FEA, it restricts all movement of the beam or 

node to which it is applied.

Pinned Constraints  Applying the Pinned constraint to a beam or node will allow rotation 

about the selected element, but it cannot move in space.

Floating Constraints  This constraint allows free rotation of the beam or node, but it also 

allows movement in one plane.

Custom Constraints  If you need a node or beam to be able to move or rotate within 

a boundary or with an amount of elasticity, the Custom constraint can establish those 
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conditions in any or all directions, including the ability for that movement to be unidirec-

tional for one value and free in another direction.

Frame Loads
When the need to apply a mesh to a frame model is removed, it may become necessary to defi ne 

the loads in a different manner. This means that there are more options for loads in frame 

analysis.

The three primary loads are shown in the Loads panel of the Frame Analysis tab, as shown in 

Figure 17.20:

Figure 17.20

Th e frame loads

Force  This is specifi ed in newtons (N) or pounds-force (lbf or lbforce). The value of the force 

can be applied to a node along the length of a beam. Once an approximate position has been 

selected, a dialog will appear and prompt you for the position along the beam element. The 

icon that appears has a series of handles that allow you to change the angle of the plane in 

which the force is applied and the angle to the plane of the force; if you click the arrow that 

represents the direction of the force, the dialog will prompt you for the magnitude of force.

Continuous Load  This is specifi ed in newtons (N) or pounds-force (lbf or lbforce). This 

force applies evenly to the entire beam segment. The settings allow you to specify End 

Magnitude, Direction, Offset, and Length values.

Moment  This is specifi ed in units of torque such as newton meters (N m or N*m) or 

pounds-force per inch (lbforce in or lbf*in). A moment can be applied to a point at the end 

or along the beam segment with a graphical input very similar to the on-screen feedback for 

applying a force.

There are also two types of load you can choose under Moment in a drop-down menu:

Axial Moment  This is specifi ed in units of torque such as newton meters (N m or N*m) or 

pounds-force per inch (lbforce in or lbf*in). This is a moment that can be applied along the 

axis of the selected beam. You can control the position of the moment along the axis, but it is 

automatically normal to the axis.

Bending Moment  This is specifi ed in units of torque such as newton meters (N m or N*m) 

or pounds-force per inch (lbforce in or lbf*in). A bending moment can be applied to a point at 

the end or along the beam segment. It is applied in the plane of the axis. You can change the 

angle about the axis to which it is applied.

Connections
Working with Frame Generator by its nature involves situations where additional information 

may need to be added to the model for a proper simulation: conditions where there are gaps or 

fl exibility in the model or you want to add additional nodes.
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The tools for adding additional information are located in the Connections panel of the Frame 

Analysis tab, as shown in Figure 17.21:

Figure 17.21

Th e Frame 

constraints

Release  This connection can be applied to a beam adjacent to another loaded beam. You 

can control the fl exibility between the beams. The resistance to the movement can be con-

trolled in the primary planes and about the axes using either a specifi c force or a partial stiff-

ness coeffi cient.

Custom Node  You can add additional nodes along the beam to represent where contact 

will be made or to shortcut the loading process.

Rigid Link  If you have a machined or cast part built into your design, the Frame Analysis 

tool may not properly account for a rigid element between two points that appears to be free 

in the Frame Generator model. The Rigid Link tool allows you to select a parent node and 

have a child node maintain its position to it through the simulation.

Results
People doing Frame Analysis need to understand what is happening to the model along the 

length of a beam. In an FEA model, this is easy to visualize, and the coloration of the beam ele-

ment also helps. Over time, methods for diagramming a beam have been developed, and to offer 

a familiar way to understand the results of the simulation, diagramming tools have been added 

to the Frame Analysis environment.

These tools are located in the Result panel of the Frame Analysis tab, as shown in Figure 17.22:

Figure 17.22

Diagramming tools

Beam Detail  This tool launches a dialog that allows you to see the basic results on the right 

and diagrams of the specifi c results for the selected beam on the left.

Animate  Results can be animated and recorded in order to observe the displacement or 

stress build up over a sequence of images.

Probe  Once a simulation is run, result values for specifi c points on the model can be visual-

ized using the Probe tool. The Probe Labels button controls the visibility of probe results.

Diagram  Selecting this tool opens a dialog where you can request various results to be dis-

played on the model.

Additional tools in the Display panel will place beam and node labels in the design window 

(rather than highlighting them in the browser) so you can more easily understand where these 

elements are.
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For static stress analysis, the tools offered for parts, assemblies, and frames will offer you a 

great opportunity to better know the effects of changes to your designs.

Considering Every Load Scenario

An engineer was involved in a redesign of an equipment accessory that had unfortunately failed in 

the fi eld. Th e problem originated from two sources. One was the use of an incorrect material that 

off ered too much fl exibility under a particular load condition.

However, the second dynamic of this failure stemmed from the way the design was actually used in 

the fi eld. During the design process, the considerations were mostly focused on how the mechanism 

would be operated during installation and how it would hold up under its highest load during use. 

Both were valid design considerations, but neither predicted the ultimate failure of the design.

As it turned out, it was the way these accessories were uninstalled that led to their high rate of 

failure. Not having anticipated this part of the way the product was used, the design team had no 

means to understand the unique torque loads that would ultimately make a good design fail. In the 

end, a slight modifi cation to the design and the use of a diff erent material type resolved the issue, 

but not before many dollars were wasted purchasing components that ultimately could not be used.

Keep this in mind as you create simulations, and remember that the results you generate can only 

be as good as the assumptions you make. Simulating every loading situation your design might 

encounter will expose these things before the fi rst part is made or purchased.

Conducting Dynamic Simulations
Dynamic simulation is useful during the prototyping stages of design to test the function of 

interacting parts and for use in failure analysis where interacting parts enact stresses upon 

one another. When creating a dynamic simulation, you should follow the basic workfl ow 

listed here:

 1. Defi ne joints to establish component relationships.

 2. Defi ne environmental constraints such as gravity, forces, imposed motions, joint friction, 

and joint torque.

 3. Run the simulation.

 4. Analyze the output graph to determine maximum or minimum stress at a given time 

step, maximum or minimum velocities, and so on.

 5. Export the results to the Stress Analysis environment for motion stress analysis 

simulation.

To access the Dynamic Simulation tools, fi rst open the assembly in which you want to create 

the simulation, and then click the Dynamic Simulation button on the Environments tab.
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Working with Joints
In the Dynamic Simulation environment, joints are used to defi ne the way that components 

can move relative to one another. Although you might at fi rst associate joints with assembly 

relationships such as constraints, joints and constraints are actually two separate concepts. In 

the assembly environment, all components are assumed to have six degrees of free motion until 

grounded or constrained in such a way that some or all of these degrees of freedom (DOF) are 

removed. Standard joints approach the issue of DOF from the opposite end. In the Dynamic 

Simulation environment, all components are assumed to have zero DOF until joints are applied 

to add free motion. You can then add special joint types manually to restrict degrees of freedom.

Understanding the difference between assembly relationships and joints is important when 

working with joints. However, if you have a properly constrained model, much of the joint 

creation can be automated by setting the Simulation Settings option to Automatically Convert 

Constraints To Standard Joints. You can do this by clicking the Simulation Settings button on 

the Dynamic Simulation tab. Figure 17.23 shows the Automatically Convert Constraints To 

Standard Joints option.

Figure 17.23

Automatic 

constraint-to-joint 

conversion

When the Convert Constraints option is on, any assembly relationships that are changed 

will automatically update and be converted to a standard joint when possible. You can apply 

relationships while in the Dynamic Simulation environment by switching to the Assemble tab. 

When joints are built automatically from assembly relationships, you can retain them in the 

model when the translator is turned off. This allows you to customize the standard joints built 

from relationships and author new standard joints, without starting from scratch.

When the Convert Constraints option is off, you can use the Convert Constraints button to 

manually convert assembly relationships. To convert constraints manually, you must have the 

automatic Convert Constraints option turned off and the Convert Assembly Constraint button 

enabled. Using the Convert Assembly Constraint tool, you simply select the parts to which you 

want to apply a joint, and the Assembly constraints that exist between the two will appear in the 

dialog box. You can deselect one or more of the constraints to apply a less-restrictive joint solu-

tion. Figure 17.24 shows the different results achieved by selecting or deselecting the relation-

ships that exist on a shaft and handle.

Figure 17.24

Manual constraint-

to-joint conversion
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In addition to the automatic joint creation, you can (and most often need to) apply joints to 

your model manually. You can access the joint tool by clicking the Insert Joint button. When you 

do so, the Insert Joint dialog box offers a drop-down with all the joint types listed. Alternatively, 

you can click the Display Joints Table button next to the drop-down to display the fi ve joint 

categories as buttons in the top of the table. Clicking a category button shows the available joint 

types for that category. Figure 17.25 shows the joint categories.

Figure 17.25

Joint categories Standard joints

Rolling joints

Sliding joints

2D Contact joints

Force joints

Standard Joints

Standard joints are created by converting assembly relationships to joints, either automatically 

or manually. Only one type of standard joint, called Spatial, is listed in the Display Joints table 

when the option to automatically create constraints is on. Here is a list of all the standard joints:

Revolution Joints  Used to create a rotational relationship between cylindrical faces and 

axes of two components.

Prismatic Joints  Used to constrain the edge of one component to the edge of another.

Cylindrical Joints  Used to constrain the axis of one cylindrical component to the axis of 

another, thereby allowing the second component to slide along the axis of the fi rst.

Spherical Joints  Used to create ball-and-socket joints between two components.

Planar Joints  Used to constrain the planar face of one component to the planar face of 

another. The fi rst component is the motionless component, and the second is allowed to move 

along the face of the fi rst.

Point-Line Joints  Used to constrain the center point of a sphere to the axis of a cylinder or a 

point on another component.

Line-Plane Joints  Used to constrain a planar face of one component to a point on another.

Point-Plane Joints  Used to constrain the point of one component to the planar face of 

another.

Spatial Joints  Used to create a relationship between two components where all six degrees 

of freedom are allowed without causing errors of redundancy in the simulation.

Welding Joints  Used to create a relationship between two components so there are no 

degrees of freedom between them and they are considered a single body in the simulation.
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Rolling Joints

Ten types of rolling joints are available. Rolling joints are used to restrict degrees of freedom. 

Here is a list of the rolling joint types:

Rolling Cylinder On Plane Joints  Used to constrain a rotating cylindrical face to a 2D pla-

nar face. The relative motion between the two selected components is required to be 2D. A 

basic, continuous cylindrical face is required for this joint type.

Rolling Cylinder On Cylinder Joints  Used to constrain one rotating cylindrical face to 

another rotating cylindrical face. The relative motion between the two selected components 

is required to be 2D. A basic, continuous, cylindrical face is required for this joint type.

Rolling Cylinder In Cylinder Joints  Used to constrain one rotating cylindrical face to the 

inside of another rotating cylindrical face. The relative motion between the two selected com-

ponents is required to be 2D. A basic, continuous, cylindrical face is required for this joint type.

Gears and Rolling Joints

If you have created a gear using the design accelerator, you will fi nd a basic surface cylinder present 

in the part model. To make the surface available for use in the creation of rolling joints, you can 

edit the part and set the surface to be visible.

Rolling Cylinder Curve Joints  Used to constrain a rotating cylindrical face to maintain 

contact with a curved face such as a cam. The relative motion between the two selected 

components is required to be 2D.

Belt Joints  Used to constrain a belt component to two cylindrical components that rotate. 

Faces, edges, and sketches can be selected.

Rolling Cone On Plane Joints  Used to constrain a rotating conical face to a 2D planar face. 

Faces, edges, and sketches can be selected.

Rolling Cone On Cone Joints  Used to constrain a rotating conical face to another rotating 

conical face. Faces, edges, and sketches can be selected.

Rolling Cone In Cone Joints  Used to constrain a rotating conical face to the inside face of a 

component that is not rotating. Faces, edges, and sketches can be selected.

Screw Joints  Used to constrain components that screw together by specifying a thread pitch 

to defi ne the travel per rotation. Faces, edges, and sketches can be selected.

Worm Gear Joints  Used to constrain a component to a helical gear by specifying a thread 

pitch to defi ne the travel per rotation. Faces, edges, and sketches can be selected.

Sliding Joints

The fi ve joint types in the sliding category are used to restrict degrees of freedom between the 

two components selected. In all fi ve, the relative motion between the two selected components is 

required to be 2D. Here are the fi ve types of sliding joints:

Sliding Cylinder On Plane Joints  Used to constrain a cylindrical face to a 2D planar face 

so that it will slide along the plane without rotating.
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Sliding Cylinder On Cylinder Joints  Used to constrain a cylindrical face to slide on 

another cylindrical face.

Sliding Cylinder In Cylinder Joints  Used to constrain a cylindrical face to slide inside 

another cylindrical face.

Sliding Cylinder Curve Joints  Used to constrain a cylindrical face to slide on a curved face 

such as a cam.

Sliding Point Curve Joints  Used to constrain a point on the second component to slide 

along a curve defi ned by the selected face, edge, or sketch on the fi rst component.

D Contact Joints

There is only one joint type in this category, and it is used to restrict degrees of freedom:

2D Contact Joints  Creates contact between curves on two selected components. Curves can 

be faces, edges, or sketches, but the relative motion between the selections must be planar. 

The contact is not required to be permanent for this joint type.

D Contact Joints

3D contact joints create an action or reaction force when applied. This category consists of just 

two joint types:

Spring/Damper/Jack Joints  These create joints for resisting forces, shock absorption, and 

lift jacking forces.

3D Contact Joints  These detect the contact and interference between all the surfaces of two 

selected parts. Subassemblies are not considered in this joint type.

More on Working with Joints
When components are assigned joints, either manually or automatically, they are grouped 

according to the results of the joints in the browser. For instance, if components are fully 

constrained to one another in the assembly, they will be assigned a weld joint and listed in 

the browser as a welded group. If one of those components is grounded, the welded group 

will be listed in the Grounded folder in the browser. If one of them is used in a motion joint, 

it will be listed in the Mobile Groups folder. Figure 17.26 shows an assembly with two 

welded groups present. One is listed under Grounded, and the other is listed under Mobile 

Groups. You’ll notice that both are used in the joint called Revolution:2.

Figure 17.26

Browser grouping
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Here are some points to remember when creating joints:

 ◆ The Joint Table displays a pictorial representation for each joint type to assist you with 

determining which to use.

 ◆ Assembly relationships are not converted to joints in a one-to-one fashion, but, instead, 

joints are often created by combining assembly relationships. For instance, a Mate and two 

Flush constraints between two parts might be converted to a weld joint.

 ◆ Dynamic simulation performance is affected by the number of joints present. If you are sim-

ulating a particular set of components in a large assembly, it might be benefi cial to manu-

ally weld most of the components and consider motion only for the set you need.

 ◆ When placing a joint, you are often required to align the z-axis of the joint on both compo-

nents. Failing to do so will prompt a warning.

 ◆ If you have the option to automatically convert assembly relationships selected, any assem-

bly relationship you place in the Dynamic Simulation environment will automatically be 

converted to a standard joint.

When placing joints, you should keep an eye on the coordinate triad and ensure that the 

arrows align when required. Figure 17.27 shows the use of the fl ip arrow to align the z-axis.

Figure 17.27

Aligning compo-

nent axes

To more easily review the joints that you’ve placed, you can select components in the browser 

or the design window and joints associated with them will be highlighted in the browser.

Working with Redundancy
In the Dynamic Simulation environment, joints are said to contain redundancy when they are 

overconstrained or have too many unknowns to solve. When redundancy occurs in a joint, 

Inventor prompts you to use the Repair Redundancy tool to repair the joint. In most cases, this 

tool suggests one or more solutions. Figure 17.28 shows a link assembly that has a redundancy 

in joint 4, the cylindrical joint. To resolve this, the Mechanism Status tool is selected.

In the Mechanism Status And Redundancies dialog box, you can use the << button to expand 

the options for resolving a redundancy. Typically, a new joint type is suggested for the redun-

dant joint. Often you can expand the drop-down and select from a list of possible alternatives, 

as shown in Figure 17.29. This dialog can also be shown while the simulation is running.
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Figure 17.28

Using the 

Mechanism Status 

tool to resolve 

redundant joints
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Figure 17.29

Resolving a redun-

dant joint

Also listed in the Mechanism Status and Redundancies dialog box are the redundant con-

straints. Tx, Ty, and Tz are the translational (linear) constraints, and Rx, Ry, and Rz are the 

rotational constraints. In Figure 17.29, the cylindrical joint shows that the Rotational X (Rx) and 

Rotational Y (Ry) are redundant.

Working with Environmental Constraints
Once joints are applied to the model, it is often necessary to apply environmental constraints to 

make the joints perform more realistically or to set the simulation up more effi ciently. 
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For example, if you apply a prismatic joint between a rail and a linear bearing pad, a certain 

amount of friction would be anticipated, so you would modify the joint and apply a dry friction 

coeffi cient value. You might also want to create an imposed spring to emulate a spring cush-

ion in the slide channel, or set the start position of the slide for the simulation. And then you 

might want to apply an imposed motion on the joint so that it moves during the simulation as 

expected. All of this can be done by right-clicking the joint and choosing Properties. When an 

environmental constraint for a particular joint is added, the constraint is marked with a green 

pound sign next to it in the browser, as shown in Figure 17.30.

Figure 17.30

A joint with an 

environmental con-

straint set

Modifying the Initial Position

Often you will want to change the initial position of a component involved in a joint so that the 

simulation will run differently from the way it is constrained. For instance, the rail and bearing 

pad example might be constrained so that the bearing is in the start position, but for the pur-

poses of reducing the time of the simulation, it needs to run only from the middle of the cycle 

to the end. Setting the initial position allows this. To adjust the initial position of a joint, follow 

these steps:

 1. Right-click the joint in the browser, and select Properties.

 2. Select the appropriate DOF tab. Depending on the joint, there may be multiple DOFs.

 3. Click the Edit Initial Conditions button.

 4. Enter a new position value in the input box.

Here are some additional options that may apply, depending on the simulation and results 

you are trying to achieve:

 ◆ Select Locked so that the joint cannot be modifi ed in the simulation.

 ◆ Deselect the Velocity check box to manually set the initial velocity of this degree of free-

dom, or leave it selected to allow the software to automatically compute the initial velocity. 

I recommend that you leave this set at Computed and impose a velocity using the Impose 

motion option (covered in the coming pages).

 ◆ Set the initial minimum or maximum bounds values for the degree of freedom, if desired. 

Value sets the boundary for the force or torque of this DOF, Stiffness sets the stiffness of 

this DOF, and Damping sets the damping boundary for this DOF.

Joint Torques

Joint torques can be set to control damping and friction and also to impose a spring cushion. 

Depending on the simulation, you can often apply these things to a few key joints and have 
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other dependent joints react off them. Of course, this depends on the mechanism and the simu-

lation. To adjust a joint for these things, follow these steps:

 1. Right-click the joint in the browser, and select Properties.

 2. Select the appropriate DOF tab (depending on the joint, there may be several).

 3. Click the Edit Joint Torque button (the appearance of this button varies between rota-

tional and translational joints).

 4. Select the Enable Joint Torque check box.

 5. Right-click an input box, and choose the input type required. Use Constant Value if the 

value does not change over time, or use the Input Grapher to enter a graduated input.

Figure 17.31 shows the Joint Torque properties for a prismatic joint.

Figure 17.31

Adding friction and 

damping to a joint

The range of inputs for Damping, Elastic Stiffness, and Friction are listed here:

 ◆ Damping is proportional to the velocity of the DOF.

 ◆ Free Position sets the position at which an imposed spring exerts no force.

 ◆ Elastic Stiffness sets the imposed spring stiffness.

 ◆ Friction is added as a coeffi cient between 0 and 2.

Imposed Motion

Although motion can be created by applying external forces where that is important, often an 

imposed motion on a joint is desired to allow control of the timing and position of components 
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not involved in an external force. For instance, in the rail and bearing pad example, the bear-

ing might need to slide out of the way of another component that is being driven by an external 

force. Setting the imposed motion in the joint properties allows this to happen without the need 

to apply an external force on the bearing pad. To adjust a joint to include an imposed motion, 

follow these steps:

 1. Right-click the joint in the browser, and select Properties.

 2. Select the appropriate DOF tab (depending on the joint, there may be multiples).

 3. Click the Edit Imposed Motion button.

 4. Select the Enable Imposed Motion check box.

 5. Select a Driving motion parameter type, and enter a value. The parameter types are as 

follows:

Position  Imposes a motion to a specifi ed position, typically specifi ed using the 

Input Grapher to set the position relative to a time step (for example, move 100 cm over 

10 seconds).

Velocity  Imposes a motion at a specifi ed velocity. Use constant input or use the Input 

Grapher to enter a variable velocity to account for startup times and so on.

Acceleration  Imposes a motion as a specifi ed acceleration. Use constant input or use the 

Input Grapher to enter a variable acceleration.

Using the Input Grapher

The Input Grapher is available in a number of input boxes used throughout the Dynamic 

Simulation environment. When an input is set to use the Input Grapher, a Graph button is pres-

ent in the input box. If no Graph button is present, you can right-click in the input box and select 

Input Grapher from the context menu. To open the Input Grapher, simply click the Graph button.

Typically, the Input Grapher is used to specify a value that varies over time. In Figure 17.32, 

a velocity is being imposed on a joint starting at 0 in/s and coming up to 100 in/s in the fi rst 10 

seconds, at which time it levels off for the next 10 seconds before returning to 0 in/s at 30 sec-

onds. The user has right-clicked in the graph to add a control point.

Each portion of the graph between points is selectable as a sector by clicking the graph. In 

Figure 17.32, the fi rst sector is selected and is shaded. When a sector is selected, the inputs in the 

bottom half of the Input Grapher dialog box are specifi c to that sector. You can edit the sector’s 

start point and endpoint as well as the law applied to that specifi c sector.

You can modify the input graph by changing the x-axis variable, the laws applied, the freeing 

sector condition, and more. Here is a brief description of these graph input variables.

Input References

By default, Time is the x-axis variable for the curve graph in the Input Grapher. In many inputs, 

you can specify a different x-axis reference. Clicking the Reference button displays all variables 

available to be used as x-axis variables in the curve graph. Imposed motions cannot use x-axis 

references other than Time. Figure 17.33 shows a curve graph being set to call Velocity as the 

x-axis of the curve.
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Figure 17.32

Adding a veloc-

ity curve with the 

Input Grapher

Figure 17.33

Setting the Input 

Grapher to use 

Velocity rather than 

Time

Laws

To defi ne each sector of a curve, you can assign mathematical functions, or laws. These laws can 

be applied individually or in combination as needed to fully defi ne the sector curve. To assign a 

sector a specifi c law, select the law from the list in the drop-down, and then use the arrow but-

ton to apply the law. Use the plus button to add laws to the sector, and use the minus button to 

remove laws from the sector. Here is a list of the available laws:

 ◆ Linear Ramp

 ◆ Cubic Ramp

 ◆ Cycloid

 ◆ Sine

 ◆ Polynomial
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 ◆ Harmonic

 ◆ Modifi ed Sine

 ◆ Modifi ed Trapezoid

 ◆ Spline

 ◆ Formula

Freeing and Application Conditions

Each sector can be set to Active, Free, or Condition. Active indicates that the sector has no condi-

tions. Free indicates that the sector has no values defi ned. Condition indicates that one or more 

conditions have been assigned to the sector.

To create a condition, click the Condition radio button. By default, the Freeing Conditions 

dialog box appears. To edit or add a condition, click the Defi ne Conditions button, and then click 

the Variable, Equal, or Value links to set those options. Use the plus and minus signs to add or 

remove conditions. Figure 17.34 shows a condition being added.

Figure 17.34

Adding conditions

More Functions

The Input Grapher has a few functions that might not be apparent but are useful to know about 

when you’re setting up and using it:

 ◆ The bottom display is dependent on what is selected in the graph. Selecting a point gives 

inputs for just that point, selecting a sector gives sector options, and clicking in the graph 

outside all sectors gives Out Of Defi nition options that are used to describe the part of the 

curve on the left or right of the fi rst and last points.

 ◆ Using the wheel button on your mouse, you can pan and zoom in the graph. This can be 

helpful when dealing with sectors that are dramatically different in scale. You can also use 

the Zoom button in the Input Grapher dialog box.

 ◆ Curve defi nitions can be saved and loaded using the Save Curve and Load Curve buttons.

External Forces

To set a component in motion, you can apply an imposed motion on the joint or apply an exter-

nal force on the component itself. External forces consist of loads and gravity. External forces 
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can be used to initiate, complement, or resist movement. For instance, in the rail and bearing 

pad example, if the bearing traveled past a catch stop mechanism designed to prevent back 

travel, you might apply an external force on the bearing pad at that position to ensure that it 

can overcome a maximum resistance. External forces are often used just to set the simulation in 

motion as well. Loads and gravity are further defi ned here.

Loads

You can apply as many force and torque loads as required and manage them from the External 

Loads browser node, where all force and torque loads are listed once created. To apply 

external load forces, click the Force or Torque button on the Load panel, and set the location, 

direction, magnitude, and so on, as described here:

Location  For the Location setting, a vertex must be selected. You can select a vertex, circu-

lar edge, sketch point, work point, and so on.

Direction  For the Direction setting, select an edge or face, and then use the Flip button to 

change it if needed.

Magnitude  Enter the Magnitude setting as a constant, or select Input Grapher.

Fixed and Associative Load Buttons  Use the Fixed and Associative load buttons to desig-

nate the load direction method. Fixed sets the load to be constant to the direction in which 

it is defi ned. Associative sets the direction to follow the component as it moves during the 

simulation. For instance, if an Associative direction is established using the edge of a hinge, 

the direction will stay aligned to that edge as the hinge swings.

The >> Button  Use the >> button to set the vector components as required.

Display Check Box  Set the Display check box to see the Force or Torque arrow, and then set 

the scale and color of the arrow.

Gravity

You can defi ne the gravity for the entire simulation by expanding the External Load node in 

the browser, right-clicking the Gravity button, and choosing Defi ne Gravity. A default value 

of 386.220 in/s2 or 9810.000 mm/s2 is supplied, but you can edit this to any value required. To 

defi ne gravity, you simply select an object face or edge and then use the Flip button to set the 

direction. You should choose static components to defi ne gravity.

Running a Simulation
Once the model is defi ned with joints, loads, and environmental constraints, you are ready 

to run the simulation. Running the simulation involves two primary controls: the Simulation 

Player and the Output Grapher. The tools are generally used together.

Simulation Player

You use the Simulation Player to run and stop the simulation. The Simulation Player is dis-

played by default but can be toggled on and off using the Simulation Player button on the 

Manage panel of the Dynamic Simulation tab. Figure 17.35 shows the Simulation Player options, 

and Table 17.1 provides a description of each.
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Figure 17.35
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Table 17.1: Simulation Player options

Item number Title Definition

1 Construction 

Mode

Once the simulation is run, use this button to return to the 

construction mode to make changes.

2 Final Time Enter the simulation’s running time.

3 Simulation Time Displays the current time step in the running simulation.

4 Percentage Of 

Completed 

Simulation

Displays the percent complete value for the running simulation.

5 Images Th is value is set in construction mode to control the number of 

image frames displayed during the simulation. A higher number 

results in a higher-quality simulation display (smoother motion), 

but comes at the expense of performance.

6 Real Time Of 

Computation

Displays the amount of time it has taken to run the simulation.

7 Filter Sets the number of images displayed during the simulation 

playback. If this is set to 10, for instance, image 1 is displayed and 

then image 10, skipping 2 through 9. Th is can be used to gain 

performance for large or complex simulations.

8 Player Controls Th ese include the standard play, stop, rewind to the beginning, 

fast-forward to the end, and continuous loop controls as well as a 

Deactivate Screen Refresh During Simulation control. 

Deactivating the screen refresh speeds up the simulation.
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The Output Grapher

You can access the Output Grapher during or after running a simulation to view and use the 

data collected during the simulation. Data can be exported to Microsoft Excel or marked for use 

in the Stress Analysis environment. You can also export the results as an IAA (*.iaa) fi le and 

import the fi le into another simulation for comparison of the graph results.

Once the curve type is selected, you can examine the time steps to see the value for each step. 

Figure 17.36 shows an acceleration curve displayed in the Output Grapher. The time step for 6 

seconds is selected (1) and is marked in the graph area with a vertical line (2). You can click in 

the graph area to select a time stamp or select it from the top pane. You can also use the arrow 

keys on the keyboard to advance through each step.

Figure 17.36

An acceleration 

curve in the Output 

Grapher

1

2

You can use the Save Simulation button to save a simulation result before making 

changes and then use the Import Simulation button to bring it back in once the modifi ed 

simulation has been run. This allows both simulation curves to be overlaid for comparison. 

Figure 17.37 shows the location of the Save and Import Simulation buttons in the Output 

Grapher dialog box. In this illustration, the original acceleration curve has been imported 

and overlaid onto a modifi ed simulation. You can see that the changes made just after 6 sec-

onds have slowed the extended lag time and have reduced the end acceleration from 8 in/s 

in the original to just over 6 in/s in the modifi ed version. Both simulations are marked in the 

browser.

Also shown in Figure 17.37, the context menu is obtained by right-clicking either of the 

curve columns. From this menu you can search for the minimum and maximum values as 

well as zero values. You can also select Curve Properties and change the curve colors as well 

as analyze the average, minimum, maximum, median, standard deviation, and amplitude of 

the curve.
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Figure 17.37

An imported accel-

eration curve

Exporting to FEA
You can use the Output Grapher to identify maximum forces and then export those forces for 

use in the Stress Analysis environment. Although the maximum stress is likely the most com-

mon value to be exported, you can export the force for any time step in the simulation. This can 

be useful when trying to focus on a particular event in the simulation. Here are the steps for 

exporting a maximum force:

 1. Select that force in the left pane of the Output Grapher.

 2. Right-click and choose Search Max.

 3. Select the check box for the time step identifi ed as the maximum value.

 4. Click the Export To FEA button in the Output Grapher or on the Dynamic Simulation tab.

 5. Select the part or parts to export the load information to.

 6. Select the load-bearing faces on the part or parts.

Figure 17.38 shows the steps involved in exporting the time step to FEA. Notice that once the 

time step is exported, it is listed in the Export To FEA node in the Output Grapher browser. You 

should also note that you can export multiple time steps at once by selecting them all before 

clicking the Export To FEA button.
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Figure 17.38

Exporting a maxi-

mum load time step 

to FEA

Using the Dynamic Simulation Information in 
Stress Analysis
Once you’ve exported the information from the Dynamic Simulation environment, you can 

select the Environments tab and select the Stress Analysis button to enter that environment. 

Follow these steps:

 1. Click the Create Simulation button, or right-click an existing simulation and choose Edit 

Simulation Properties.

 2. In the Simulation Properties dialog box, select the Motion Loads Analysis check box, and 

then select the part and time step on which you intend to run the simulation analysis. 

Then click the OK button.

 3. Make modifi cations to the simulation parameters if needed, and then run the 

simulation.

You should note that a motion-loads analysis is limited to a single part occurrence and a sin-

gle time step, per simulation. You can create multiple simulations to consider other time stamps 

or parts. All other components are automatically excluded from the simulation for motion loads. 

Figure 17.39 shows the Motion Loads Analysis option in the Simulation Properties dialog box.
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Figure 17.39

Enabling motion 

loads from dynamic 

simulation

Th e Bottom Line

Set up and run Stress Analysis simulations.  Oftentimes, you may fi nd yourself guessing 

at what impact a change to your design might have on the strength and overall integrity of 

your part. Questions such as “Can I make this part a bit lighter?” or “Can I move this cutout 

closer to the edge?” become important to the success of your design.

Master It  Set up a parameter study in your model to explore the consequences of edit-

ing features and their locations. Nominate all the crucial parameters to the table, and 

then create the confi guration simulations for all of the combinations.

Set up and run Dynamic Simulations.  When you fi nd yourself working out the details of 

a design with many moving parts, consider using the Dynamic Simulation tools early in the 

process to prove what will or will not work before going forward.

Master It  Even before the assembly is complete, switch over to the Dynamic Simulation 

environment and create assembly relationships in the simulation. Test the motion as you 

build the parts, and attempt to understand how contact will occur from the beginning.

Export results from the Dynamic Simulation environment to the Stress Analysis 
environment.  Often when setting up a stress analysis simulation, you are guessing at what 

the loads might be, based on rough calculations. As you make changes to the design, those 

calculations become out-of-date and therefore invalid.

Master It  How do you use the Dynamic Simulation tools to determine the force exerted 

on one part by another? 



Chapter 18

Routed Systems

This chapter will cover the tools of the routed systems environments found in the Autodesk® 

Inventor® Professional suite and the Inventor Routed Systems Suite. Inventor routed systems 

comprise two primary toolsets: tube and pipe, and cable and harness. The tube and pipe tools 

are used in routing pipe and hosing through mechanical assembly designs. The cable and har-

ness tools are used for electrical design where routing wires and cables around obstacles and 

checking for fi t are important.

In this chapter, you’ll learn to:

 ◆ Create routes and runs

 ◆ Author a tube and pipe component

 ◆ Author an electrical component

 ◆ Create and document cable and harness assemblies

Tube and Pipe
The tube and pipe tools are based on Inventor fundamental concepts such as sweeps, 3D sketch 

paths, adaptive parts, subassembly structure, and more. The tube and pipe tools automate many 

of these fundamentals, making the design of tube and pipe routes faster, more intuitive, and 

less tedious. However, it is best to have an understanding of these fundamental concepts before 

jumping into the tube and pipe tools so you can understand how Inventor does things and, 

therefore, how to proceed when required to manually adjust or repair your designs. A lack of 

understanding of these fundamentals can often bring inexperienced Inventor users to a screech-

ing halt in their tube and pipe endeavors and may leave them with a perception that the tools 

just don’t work. Therefore, in the following sections, you will explore how to create routes, runs, 

and general tube and pipe assembly structure and learn to work with tube and pipe styles.

Understanding Routes, Runs, and Assembly Structure
Understanding the way that tube and pipe assembly structure is created is an important part of 

successfully creating and managing your tube and pipe designs. There are three primary levels 

to any tube and pipe assembly:

 ◆ A top-level assembly

 ◆ A tube and pipe run assembly

 ◆ A run assembly
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All tube and pipe designs are made up of runs. A run is a subassembly that contains one or 

more route paths, pipe or hose segments, and fi ttings. For instance, a standard hot-water sup-

ply line is a run.

When you begin a tube and pipe design, you start with a new assembly template and click 

the Tube And Pipe button on the Environments tab. Doing so opens the Create Tube & Pipe 

Run dialog box, prompting you to set a name and location for the tube and pipe run assembly 

fi le and the fi rst run assembly fi le. Figure 18.1 shows the Create Tube & Pipe Run dialog box for 

a top-level assembly, named mi_18a_100, being created. You can also add a new tube and pipe 

assembly to an existing assembly.

Figure 18.1

Th e Create Tube & 

Pipe Run dialog box

Notice that the default paths are created based on where the top-level assembly is stored. In 

this case, mi_18a_100.iam is stored in a subfolder of the Chapter 18 folder called mi_18a_100. 

The tube and pipe runs assembly is simply a container assembly created to contain the multiple 

runs you might create in the design. It is prefi xed with the top-level assembly name and defaulted 

to a folder under it named the same as the top-level assembly and then AIP\Tube and Pipe.

The run assembly is prefi xed with the top-level assembly name, given an incremental suffi x 

(in this case 01), and defaulted to a subfolder named Run plus the increment number located in 

the same directory as the assembly. Although you can change this fi le structure per tube and 

pipe assembly, accepting the default does maintain a certain standardization of structure. Figure 

18.2 shows the assembly browser structure and fi le structure of a tube and pipe design set to the 

default paths.

Once a run is created, you can create a route within it. Routes are 3D paths created to defi ne 

the path for pipes, tubes, or hoses to follow. In Figure 18.2, there are two elbow fi ttings (DIN 

2605 90 Deg Elbow) that were placed outside the run and in the tube and pipe runs assembly. 

Route01 was then created as a component of Run01, starting from one of the DIN elbows and 

running to the other. Run01 consists of Route01, three pipe segments, and two 90-degree elbows.

Although the pipe segments and the route path fi les were saved under the Run01 folder, 

you’ll notice that the elbow fi les were saved to the Content Center Files path. Because fi ttings 

such as elbows, tees, and couplings are generated from Content Center, these part fi les are auto-

matically saved to the Content Center Files path defi ned in either your project fi le or your 

Application Options settings.
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Here are a few things to note when working with tube and pipe runs:

 ◆ A unique part fi le is created for each pipe, tube, and hose segment in the run, even if more 

than one segment is the same length. Although this approach may seem a departure from 

what you’d expect, it is key to allowing runs to be edited downstream.

 ◆ Enter meaningful names for the runs and routes as you create them. As you create more 

complex designs, having multiple Route01s scattered throughout the assembly may create 

confusion during edits.

Figure 18.2

Assembly and fi le 

structure of tube 

and pipe design

Assembly Structure File Structure

Exploring the Tube and Pipe Styles
Runs and routes are determined by tube and pipe styles. Properties such as material, diameter, 

and fi tting types are set in the tube and pipe style. Rules such as minimum and maximum 

segment length can also be set in the style. The Inventor tube and pipe tools load with several 

default styles based on the ANSI, DIN, ISO, and JIS tube and pipe standards and the Parker hose 

and fi ttings. Styles fall into three primary categories:

Flexible Hose  These are single hose segments connected by a start point and endpoint 

selection. The hose style can include, but is not required to have, fi ttings for the start and stop 

points.

Tubing with Bends  This does not contain elbows and follows a default bend radius. The 

radius can be set per bend as needed. Minimum and maximum segment lengths are set in 

the style, and couplings are placed where segments connect.

Rigid Pipe with Fittings  These styles are required to include 90-degree elbow fi ttings and 

can include 45-degree elbows, fl anges, and couplings. There are three subcategories for rigid 

piping styles:
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Self Draining  These styles require a pipe, a coupling, a 45-degree elbow, a 90-degree 

elbow, and a custom elbow or tee to match the desired slope angle.

Butt Welded  These styles require a pipe and a 90-degree elbow. Butt welded styles re-

quire a weld gap size.

Flanged  These styles require a pipe, an elbow, a fl ange, and optionally a gasket.

Mixed Units  If a fl anged style is selected for rigid pipe, the Mixed Units option is en-

abled as a style choice for the end treatment. This option indicates that the style contains 

fl anged fi ttings that use imperial units and metric units. 

Figure 18.3 shows a fl exible hose run, a rigid tubing run, and a rigid piping run, from top 

to bottom.

Figure 18.3

Hose, tube, and 

pipe runs

The Tube & Pipe Styles Dialog Box

You can access the Tube & Pipe Styles dialog box from the master tube and pipe runs assembly, 

the run assembly, or by clicking the Tube And Pipe Styles button on the ribbon or using the 

default right-click context menu. The dialog box is divided into a pane on the left listing the 

styles and two tabs on the right controlling the general settings and the style rules. Figure 18.4 

shows the Tube & Pipe Styles dialog box with a Hydraulic Hose style set active, denoted in bold. 

A second style is selected and has been right-clicked, showing the options that correspond with 

the buttons along the top of the dialog box.

When you’re editing, copying, or creating a new style, some components may be either 

required or optional, depending on the style type. If the component is not specifi ed and it is 

required, it will be marked with a red arrow next to it in the General tab. If it is empty and 

shows a gray arrow, it is optional. When the component is selected, the arrow will be green. 

Figure 18.5 shows a pipe style being created from scratch.
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Figure 18.4

Th e Tube & Pipe 

Styles dialog box

Figure 18.5

Creating pipe styles

This new style is a Butt Welded style and requires a pipe and a 90-degree elbow. The pipe has 

been selected, but the elbow is still required, as indicated by the red (dark) arrow. The 45-degree 

elbow is not required, and its optional status is indicated by the gray (light) arrow. In Figure 18.5 

the user has right-clicked in the Elbow 90 row and selected Browse in order to specify the 

required elbow type. You can also double-click a row to open the style library browser.

In the style library browser, you can select from the list of available styles based on the size, 

schedule, and material settings made in the General tab and the availability from the Content 

Center library. You can set additional fi ltering in the style library browser. When you set the 

fi lter to a particular standard, the materials available for that particular standard are listed. If an 

asterisk is displayed, all the content for that setting is displayed.



808 | CHAPTER 18 ROUTED SYSTEMS

Back in the Tube & Pipe Styles dialog box, you can specify a minimum and maximum size 

range for creating route segments on the Rules tab. I recommend that you set the minimum seg-

ment length to at least 1.5 times the nominal diameter value to avoid minimum segment length 

violations that occur when pipe segments are too small in relation to the nominal diameter.

Each style type has different rule criteria:

 ◆ For Rigid tubes, you can set the default bend radius for the bends.

 ◆ For Flexible hoses, you can set a minimum bend radius and hose length round-up value.

 ◆ For Butt Welded pipe styles, you can set the gap size for the groove welds and control the 

display of the gaps in the graphics display and in drawings.

 ◆ For Butt Welded Flanged pipes, you can specify the coupling style.

 ◆ Fitting connections are determined by the end treatment set for the particular fi tting.

 ◆ All other end treatments use a gap at segments and fi tting joints.

Generally, it is best practice to set the style before creating routes and placing fi ttings. 

However, you can create and apply styles at any time. Styles can be set in a number of ways. You 

can change the active style for the tube and pipe assembly so that all new runs follow the style; 

you do this by selecting a style from the Style drop-down. Or you can change the style for the 

active route by setting that route as active and using the Style drop-down to select a different 

style. You cannot change a rigid pipe route to a fl exible hose style or vice versa. To make such a 

change, you must delete the route and re-create it.

Authoring Tube and Pipe Components

Tube and pipe components, like components for other applications, require authoring before 

they can be published into Content Center. The tube and pipe authoring process is more com-

plex because the router uses the component geometry. For example, the router needs to know 

the difference between a tee and an elbow, and it needs to know how much the connector over-

laps the pipe.

If you have not already downloaded the Chapter 18 fi les from www.sybex.com/go/

MasteringInventor2014, please refer to the “What You Will Need” section of the Introduction 

for the download and setup instructions. Once you have the fi les downloaded, you can follow 

this example to author a PVC pipe to an NPT adaptor:

 1. On the Get Started tab, click the Open button, and browse to the Chapter 18 directory in 

your Mastering Inventor 2014 folder.

 2. Open the fi le mi_18a_010.ipt.

 3. Switch to the Manage tab, and select the Tube And Pipe Authoring button from the drop-

down list on the Author panel (it might be displaying Component by default). The Tube & 

Pipe Authoring dialog box displays, and the part changes to shaded wireframe display.

 4. Select Adapters from the Type drop-down, as shown in Figure 18.6.

 5. Change the number of connections, and observe that the connection buttons update to 

match. Confi rm that Connections is set to 2.

http://www.sybex.com/go
http://www.sybex.com/go/MasteringInventor2014
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Figure 18.6

Setting the 

fi tting type

 6. Confi rm that the End Treatment is set to Threaded, and enter 1/2 in for the Nominal Size 

setting.

 7. By default, the button for connection 1 is active. Select one of the circular edges to defi ne 

the connection point. Click the Axis button, and select the z-axis from the Origin folder 

in the browser. An arrow appears, showing the connection direction, as shown in 

Figure 18.7. The default connection type is Female, but you can set it to Male or Neutral 

(for fl anged or butt-welded fi ttings).

Figure 18.7

Defi ning the 

connection and 

engagement

 8. The Engagement settings defi ne the maximum and minimum overlap between the con-

nector and pipe. The router needs a range because the pipe usually has a minimum 

length increment. The engagement range allows the router to adjust the position of the 

pipe in the fi ttings.

 9. To determine the engagement, navigate to the Design Data folder (the default location is 

C:\Program Files\Autodesk\Inventor 2014\Design Data) and open Threads.xls. 

Select the NPT For PVC Pipe And Fitting tab. For tapered threads, the engagement value 

depends on how tightly the fi tting is screwed onto the pipe. You need the maximum 

engagement value, so add the Handtight Engagement value, which is 0.32, and the Wrench 

Makeup, Internal value, which is 0.1429. Set Max to Distance, and enter 0.4629 for the total 

value. For Min, divide the Handtight Engagement value, 0.32, by the total engagement value, 

0.4629, which comes to 69%.
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 10. Click the 2 button to defi ne the other connection.

 11. In this example, Socket Welded was chosen as the End Treatment setting since that 

seemed to be the best description. You should choose an end treatment that is consistent 

with your other parts.

 12. Select a circle at the opposite end of the part for the connection point, and select the z-axis 

again. You will see that the arrow points into the adapter and the orange line represent-

ing the engagement is outside the part. Using the fl ip/arrow button next to the Axis 

button, change the direction so that the arrow is to the outside and engagement is to the 

inside, as shown in Figure 18.8.

Figure 18.8

Connection 

direction and 

engagement

 13. The depth of the socket is 0.84 inch. You don’t want to design to full-depth engagement 

because of tolerances, so set Max to Distance and specify 0.75 as the depth. For Min, 

accept the default value of 50%.

 14. The ISOGEN data is optional. For this exercise, this information will be left blank. Click 

the OK button to complete authoring the adapter.

Now that the part has been authored as a tube and pipe adaptor, it is ready to be published 

to a read/write Content Center library. You can fi nd more information on publishing parts to 

Content Center in Chapter 7, “Reusing Parts and Features.”

Placing Fittings
Fittings can be placed from Content Center or from a user-created directory of authored fi t-

tings. As a rule, you should use the place tools found on the 0 rather than placing fi ttings as 

you would normal assembly parts. The place options on the Tube and Pipe tabs ensure that the 

authored connections are used as intended. Figure 18.9 shows the place options available on the 

Pipe Run tab.

Figure 18.9

Place options avail-

able on the Pipe 

Run tab
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When fi ttings are placed, either from Content Center or from a user-defi ned library of 

authored fi ttings, you can drag the fi tting over the route segments or nodes and you will see the 

placement point appear. Use the spacebar to toggle through available orientations if more than 

one exists. When you click to place the fi tting, the Select Orientation tool appears, allowing you 

to rotate the orientation to the desired position.

You can edit connections by right-clicking them while the route is active for edits and choos-

ing Edit Fitting Connections. In the Edit Connections dialog box, you can select a segment and 

then use the X button to remove the connection. You can also select Change Fitting Diameter, as 

shown in Figure 18.10.

Figure 18.10

Editing fi tting 

options

Quickly Place Fittings

If you need additional fi ttings that are identical to previously placed or populated fi ttings, you can 

select the fi tting and then select the Place Fitting button from the Route panel. Th is will place a 

new fi tting that matches the existing fi tting. Note that you can do the same thing by selecting the 

fi tting and right-clicking and choosing Place Fitting.

If your model contains a fi tting of certain size, and you want to place the same family of fi tting 

but in a diff erent size, you can select the existing fi tting and then select the Place button from 

the Content panel. Th is will open Content Center with that fi tting family active, allowing you to 

double-click the family and select the new size.

Creating Routes
Routes defi ne the path for pipe and hose segments and the corresponding fi ttings. Route paths 

can have a simple start point and endpoint or can include as many intermediate points as are 

required. Several tools and options are used to start and create route paths:

Authored Connection Points  You can use any of the predefi ned connection points for any 

library fi tting or custom-authored part. When you move your mouse pointer over the library 

fi tting, the connection point(s) will highlight.
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Circular Edges  You can use any circular edge in the assembly to set the route point at the 

center of it with the exception of authored parts such as fi ttings. For those parts, only the 

authored connection points can be used.

Precise and Offset Start Points  You can hover your mouse pointer over an edge to display 

a direction arrow. Running your mouse pointer along that arrow allows you to select the 

arrow to set the offset at that distance, or you can right-click and choose Enter Distance. If the 

arrow points in the wrong direction, you can use the spacebar to toggle it or right-click and 

choose Select Other Direction. Figure 18.11 shows the offset start point options.

Figure 18.11

Off setting a 

start point

Turning on Dynamic Prompts

You can watch the lower left of your screen to see the help prompts Inventor gives you as you select 

tools and hover over objects on- screen, or you can turn on Dynamic Prompts to place these tips 

at your cursor so they are more noticeable.

To turn on Dynamic Prompts, go to the Tools tab and click the Application Options button; then 

click the General tab, locate the Prompting Interaction area in the dialog box, and select the Show 

Command Prompting (Dynamic Prompts) option.

3D Orthogonal Route Tool  Once a start point is selected, run your mouse pointer along the 

projected axis and click or use the context menu’s Enter Distance option to set a value for the 

second point. You will then be presented with the 3D Orthogonal Route tool. You can use the 

control handles to change the angle or rotate the control. The cross arrow toggles between 

90-degree and 45-degree solutions, and the arc arrows allow you to rotate the route tool. You 

can also right-click and choose Custom Bend to enter an angle other than 90 or 45. When you 

enter a Custom Bend angle that cannot be accommodated with an elbow fi tting, Inventor will 

place a bend in the tube or pipe segment. When the 3D Orthogonal Route tool is displayed, 

you can use the + and – keys to change the size of it on-screen. Figure 18.12 shows the 3D 

Orthogonal Route tool in use.
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Figure 18.12

Using the 3D 

Orthogonal Route 

tool

Route Nodes  When placing a point along a route or setting an offset start point, you will see 

a colored dot tracking along the Route tool. If it is a yellow X, the offset is not enough to cre-

ate a minimum segment as set in the style rules and the point cannot be selected. If it is a blue 

dot, the segment might be too short to accommodate an elbow, but you are allowed to select 

it. If it is a green dot, the location is satisfactory to all of the style rules. You can right-click and 

choose Enter Distance to display an input box. In Figure 18.13, the node (which looks like a 

dot) at the left of the image shows the placement with a distance of 2200 mm entered.

Figure 18.13

Route nodes

Autoroute Options  You can select the start point and endpoint of a route and use the 

Autoroute tool to fl ip through the available Autoroute solutions. You can also use this to 
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close two parts of an already created route. Use the Select Other tool to toggle through all the 

Autoroute variations. Once an Autoroute is created, use the Move Segment button to adjust 

the segments and create new solutions. Figure 18.14 shows an Autoroute with a suggested 

variation.

Figure 18.14

Autoroute and 

move segment 

options

Sketched Routes  Route paths can also be based on an existing 3D sketch. These 3D 

sketches are used as the route by deriving the geometry into the route. Changes to the 3D 

sketch update the route automatically. You can use the Include Geometry tool to include any 

existing part edges in the route. You can also switch to the 3D Sketch tab while creating a 

route and use the standard 3D sketch tools to create route geometry as required. Whether 

routing in the tool or using a derived route, watch the visual cues offered by the sketch.

Creating a Route from an Existing Sketch

Now you will use a combination of tools to create a pipe and tubing route based on an existing 

sketch:

 1. On the Get Started tab, click the Open button, and browse to the Chapter 18 directory in 

your Mastering Inventor 2014 folder.

 2. Open the fi le mi_18a_015.iam.

 3. From the Environments tab, select the Tube And Pipe button found on the Begin panel.

 4. Accept the defaults offered in the Create Tube & Pipe Run dialog by clicking the OK 

button.

In the browser you will see that a run has been created and it is active. There is also a 

specialized tab added to the ribbon named Pipe Run.

 5. From the Manage panel of the Pipe Run tab, use the pull-down to select the 

B36.10M-ASME B16.11 – Steel Threaded Pipe style.

 6. Select the New Route button from the Route panel.



TUBE AND PIPE | 815

 7. Make note of the route part fi le location, and then click the OK button to approve the 

default values for the Create Route dialog.

 8. Another new tab will appear named Route. Select the Derived Route button from the 

Create panel.

 9. Select the path that is already present in the assembly, as shown in Figure 18.15.

Figure 18.15

Selecting an exist-

ing 3D sketch as a 

piping route

 10. Right-click and select Done from the context menu to use the selected sketch as part of 

your pipe route.

This will add four route points to the route in the browser. Rather than focusing on all of 

the geometry, you’ll use just the points, which improves the assembly performance for 

the initial calculations and updates.

 11. Select the Finish Route tool from the Route tab to return to the Pipe Run tools.

 12. From the Route panel, select the Populate Route button to create the pipe and fi ttings for 

this route.

 13. Once the route is populated, you can select the Finish Tube And Pipe Run button. Your 

pipe run should look like Figure 18.16.

 14. Select the Finish Tube And Pipe button on the Tube And Pipe tab to exit the tube and pipe 

environment and return to the top level of the assembly.

 15. In the browser, expand the mi_18a_012 part in the browser and double-click the 3D 

sketch to edit it.

 16. Change the 9-inch dimension in the sketch to 11.

 17. Change the 135-degree dimension that does not have parentheses around it to 90, as 

shown in Figure 18.17.
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Figure 18.16

Th e piping run cre-

ated from the 3D 

sketch

Figure 18.17

Th e updated 

3D sketch

 18. Click the Finish Sketch button and then click the Return button to update the assembly 

and the pipe route that you created based on it.

 19. Turn off the visibility of the 3D sketch by right-clicking the sketch in the browser.

The use of a 3D sketch is not necessary to place a run like this, but it can be easier for some 

users to visualize the route before starting the routing tools. It is also a great tool for people 

who’ve used 3D sketches and sweep features to replicate piping runs in the past. You can save 
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your work if you wish to investigate the folders and fi le paths created, or you can close the fi le 

without saving changes and continue to the next set of steps.

Creating a Route Using the D Orthogonal Route Tool

Now you’ll look at using the 3D Orthogonal Route tool to create a tubing section when no 3D 

sketch tool exists. To do so, open the fi le mi_18a_016.iam from the Chapter 18 directory. Then 

follow these steps:

 1. From the Environments tab, select the Tube And Pipe button and click the OK button in 

the dialog to create a new run, noting that the run name has been incremented from the 

previous run.

 2. In the Manage panel, set the style to ASTM B 88-ASME B16.22 – Soldered Copper Tubing.

 3. Select the New Route button and click the OK button to accept the default naming.

 4. Select the Route button from the Create panel.

 5. Rotate the assembly so you can see the inside of the short fl ange of the base part. You will 

be working with the light-blue center fi tting.

 6. As you near the fi tting’s point of engagement, arrows indicating the initial direction of 

a run will appear. If you hover your cursor over the various circular edges of the fi tting, 

you’ll see the arrows fl ip directions. Select the option that will set the direction toward 

the fi ttings on the other fl ange of the base part, as shown in Figure 18.18, and click the 

mouse button when it is highlighted.

Figure 18.18

Setting the direc-

tion toward the 

other fi ttings

After the selection is made, a centerline will be displayed. Move your cursor along the 

line and a dimension will display the distance from the selected point, as shown in 

Figure 18.19. You can increase the length of the line by pressing the + key on the key-

board, or you can use the keyboard to enter an explicit value. If you move your cursor 

to the 2.000 location or a location with a lower value, you’ll see the selection indicator 

change to a yellow X. For anything above 2.000 the selection indicator will change to a 

green dot. This behavior is due to the bend radius default listed under the Rules tab of 

the Tube & Pipe Styles dialog box.
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Figure 18.19

Th e preview allows 

you to visually place 

the end of the fi rst 

segment.

 7. Type 7 on the keyboard to set the length, and press Enter to create the fi rst segment 

at 7 inches.

 8. After the fi rst segment appears and the route nodes appear, right-click in an open area of 

the design window and ensure that Rotation Snap is selected in the context menu.

Rotation Snap

Th e Rotation Snap option allows you to snap to the other fi tting in the middle of the rotate action 

so that the angle is derived from the selections. If you happen to know the angle needed, you can 

simply click and drag the curved rotation arrow and enter an angle.

 9. Click and drag the curved arrow on the green axis, move your mouse to the opposite fi t-

ting, as shown in Figure 18.20, and select that fi tting.

Figure 18.20

Rotation and 

point snaps aid in 

building between 

fi ttings.
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Restarting a Route

If at any time during the creation of a route you make a mistake in selection, simply use the Undo 

button to back up a step, click the Route tool again, and click the end of your last route segment.

This method will align the route nodes to the second fi tting and allows a great deal of 

fl exibility in building a complex route.

 10. Click the end of the second fi tting to set an endpoint for the route.

 11. This will present a preview of a route. The preview will include the number of segments 

and the Select Other tool so you can cycle between options.

 12. Click the green arrows of the Select Other tool until you see the option that will create 

three segments, and then click the green icon in the center of the Select Other tool to set 

the route.

 13. Finish the route and then click the Populate Route button from the Pipe Run tab to popu-

late the route with parts.

 14. Select Finish Tube And Pipe Run.

Using the 3D Orthogonal Route tool allows you to create a route based on existing geometry 

without the need to use an existing sketch. This can speed up the layout process and simplify 

your design. You can save your work if you wish to investigate the folders and fi le paths created, 

or you can close the fi le without saving changes and continue to the next set of steps.

Creating a Flexible Hose Route

Flexible hose routes are similar to rigid pipe routes with just a few exceptions. Whereas a rigid 

pipe path is a series of line segments connected with arcs or points, a fl exible hose path consists 

of a single spline segment. Flexible routes offer a couple of tools and options specifi c to this 

type of route, such as the ability to right-click a surface, select Enter Offset, and then adjust the 

hose length. You can open the fi le mi_18a_017.iam from the Chapter 18 directory and use the 

options in these steps to create a fl exible hose route:

 1. Locate and right-click the Tube & Pipe Runs 01 node in the browser and choose Edit.

 2. Select the Create Pipe Run button and accept the defaults.

 3. Set the style to Hydraulic Hose–Male Taper Thread.

 4. Select the New Route button and click the OK button to accept the default naming.

 5. Click the Route button.

With this style of hose, rather than selecting an existing fi tting on which the hose will 

begin, you’ll be asked to select the location for two fi ttings that will be placed before any 

routing options are offered.
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 6. Place the fi rst fi tting on the remaining unused anchor fi tting on the small fl ange of the 

sheet-metal base part.

 7. Place the second fi tting on the last remaining fi tting on the opposite side.

Placing the second fi tting will generate the spline centerline of the hose. At this point you 

can create additional points offset from faces on the part, or even use natural centers on 

curved faces to pass the hose through.

 8. Select the curved edge of the hose retainer, as shown in Figure 18.21, to route the hose 

through the retainer.

Figure 18.21

Routing the hose 

through a retainer

 9. Once the hose center is displayed, use the Hose Length tool in the Manage panel and use 

the slide bar to set the hose length to 44 inches.

 10. Click the OK button to complete the path for the hose.

 11. Finish and populate the route and then fi nish the tube and pipe run. Compare it to 

Figure 18.22.

Figure 18.22

Th e completed 

routes
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There are a number of options for creating these routes that you should explore. You also 

have the ability to add fi ttings inline. These added fi ttings will break the segments of pipes and 

tubes to create room for the fi ttings and set their engagement with the fi ttings automatically. If 

you later remove the fi tting, the pipe will be “healed” and restored to a single segment.

Exporting ISOGEN Files
Often isometric centerline drawings are required for documentation of tube and pipe designs. 

The ISOGEN Output tool is available on both the Tube And Pipe tab and the Pipe Run tab. You 

can save all your tube and pipe runs as an ISOGEN (*.pcf) fi le directly from the master run 

assembly; just click the ISOGEN Output button on the Tube And Pipe tab. Or you can use the 

ISOGEN Output button while at an individual run level to save just that run. When fl anged 

routes are created, gaskets are required for fl anged connections if ISOGEN fi les are to be created 

from them.

Cable and Harness
The cable and harness tools in Inventor are based on the fundamental tools of part and assem-

bly creation; however, the parts and assemblies created with the cable and harness tools are 

structured differently than standard part and assembly models. Understanding these differ-

ences requires a solid understanding of the way standard parts and assemblies are created and 

structured. In the following sections, you will explore the creation and placement of electrical 

parts, harnesses, wires, cables, and segments as well as how to copy and document cable and 

harness designs.

Creating and Placing Electrical Parts
You can use any Inventor model as an electrical connector by adding pin features specifi c to 

cables and harnesses to it. Parts can be created from scratch using standard modeling tech-

niques or downloaded from supplier websites as well as a number of 3D content websites, such 

as http://mfgcommunity.autodesk.com/content/.

When downloading content from the Internet, you will often fi nd models in other formats, 

such as STEP, IGES, SolidWorks, and so on. These fi les can be translated into Inventor fi les using 

the methods described in Chapter 14, “Exchanging Data with Other Systems.”

Authoring Electrical Components

The basic steps to turn a standard Inventor part into an electrical component are as follows:

 1. Open the part fi le in Inventor.

 2. Click the Place Pin button in the Harness panel of the 3D Model tab.

 3. Select one of the following to place the pin:

 ◆ Center point of any circular edge, face, or hole

 ◆ Visible sketch points

 ◆ Work points

http://mfgcommunity.autodesk.com/content


822 | CHAPTER 18 ROUTED SYSTEMS

 ◆ Model vertex points

 ◆ Any model face

 4. Enter a unique pin name/number.

 5. Click the Harness Properties button in the pin-naming input box to enter additional pin 

properties if required.

 6. Repeat steps 3 and 5 for each pin.

 7. Click the Harness Properties tool in the Harness panel of the 3D Model tab.

 8. Enter a reference designator (RefDes) placeholder. The RefDes property is intended to 

be used at the assembly level, where each instance of the connector will have a unique 

RefDes.

 9. Select a Gender option (Male, Female, or None).

 10. Set a wire offset point if required.

Creating a Connector

In the following steps, you will open an existing Inventor part fi le and create pins as just 

described. Figure 18.23 shows the Harness tools available in the parts environment.

Figure 18.23

Harness part tools

Follow these steps to explore the steps used in creating a connector:

 1. On the Get Started tab, click the Open button.

 2. Browse for the fi le mi_18a_007.ipt in the Chapter 18 directory of the Mastering 

Inventor 2014 folder, and open it.

 3. Click the Place Pin button in the Harness panel of the 3D Model tab.

 4. Select the visible sketch point.

 5. Enter A1 in the Place Pin input box, and click the Harness Properties button.

 6. Select the Custom tab, click the Name drop-down, and select Embedded Length.

 7. Enter 5 mm in the Value input box, click Add, and then click the OK button. Then click 

the green check mark, or press Enter on the keyboard to set the pin.

 8. To place the next pin, click the rounded edge on one of the top cutouts, enter A2 for the 

pin name, and then set the pin without entering any harness properties. Click the green 

check mark to set the pin.

 9. Click roughly in the center of the blue square face to set the third pin, and enter B1 for the 

name. Click the green check mark to set the pin.
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 10. Right-click and choose Done to exit the Place Pin tool.

 11. In the Work Features panel of the 3D Model tab, click the Point button to create a 

work point.

 12. Right-click and select Loop Select, and then click the square profi le edge for the remain-

ing cutout. Be certain you are selecting the outer edge loop and not the inner loop. 

 13. Select the Place Pin tool again, and select the work point you just created. Set the name to 

B2, right-click, and choose Done.

 14. Edit Extrusion1, and change the Distance from 10 mm to 15 mm.

Notice which work points hold their positions relative to the geometry and which ones 

remain at the position in which they were created. You can right-click the pins that didn’t update 

as expected and choose Redefi ne Feature or 3D Move/Rotate to adjust them. Understanding 

how pin locations will update is important when defi ning a connector part intended for use in 

iPart creation, where you will want the pin location to update as different pin sizes are created. 

For static pins not likely to change, nonassociative pins work just fi ne.

In addition to redefi ning the pin location, you can right-click any pin in the browser and 

choose Harness Properties to change the name or add/edit properties. Keep in mind that pin 

names must be unique.

Place Pin Groups

Although the Place Pin tool works well for defi ning pins not arranged in a pattern or for small 

numbers of patterned pins, you can use the Place Pin Group tool to place larger numbers of pat-

terned pins. The following steps explore the Place Pin Group tool:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_18a_009.ipt in the Chapter 18 directory of your Mastering Inventor 

2014 folder, and open it.

 3. Click the Place Pin Group button in the Harness panel of the 3D Model tab.

 4. For Start Location, select WorkPoint1.

 5. Enter 8 for the number of pins per row.

 6. Enter 4.5 mm for the pin pitch (spacing), and then select an edge to establish the pin 

direction. Use the fl ip arrow if required.

 7. Enter 2 for the number of rows.

 8. Enter 4.5 mm for the row pitch, and then select an edge to establish the pin direction. Use 

the fl ip arrow if required.

 9. Enter A for the prefi x letter and 101 for the start number.

 10. Switch the radio button for the numbering scheme options to Sequential Column, then to 

Circumventing, and then back to Sequential Row to see the differences in each.

 11. Click the OK button to set the pins. Figure 18.24 shows the Place Pin Group dialog box 

settings and pin group.
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Figure 18.24

Creating a pin 

group

Notice the 16 pins created and listed in the Model browser. You can right-click any of 

the pins and choose Edit Pin Group to change the start point, spacing, and direction if 

required. You can also right-click and select Delete Pin Group to start over, or you can 

select Delete to remove an individual pin. Note too that you can right-click any of the 

pins and choose Redefi ne Feature to set an individual pin to a nonpatterned location.

As a fi nal step, you will create four work points in front of the connector for use later as a 

stop point for the wire or cable segment.

 12. Click the Point button on the Work Features panel of the 3D Model tab.

 13. Right-click and ensure that Loop Select is not selected.

 14. Click the edge of the visible work plane and then one of the work axes. You’ll see a work 

point created at the intersection. Do the same for the remaining three axes, and then 

right-click each axis and the plane and turn off their visibility.

The work points allow you to place the end-of-wire segments appropriately off the connector. 

Figure 18.25 shows a connector utilizing a segment-end work point.

Figure 18.25

Work points for 

segment ends
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Creating a Harness
Electrical components, including connectors, wires, and cables, are assembled and constructed 

within a harness subassembly. Although you can place connectors at any structure level within 

the assembly and route wires to them, as a rule you typically place connectors within the har-

ness assembly when the harness and connectors are purchased together so that your BOM will 

refl ect the harness as an item. The steps for creating and routing a wire harness are as follows:

 1. In an assembly fi le, place and constrain connector parts that will not be part of the har-

ness assembly into the assembly either at the top level or within a subassembly.

 2. Click the Cable And Harness button in the Begin panel of the Environments tab.

 3. Enter a name and location for the harness subassembly fi le to be created.

 4. Place and constrain connectors to be part of the harness.

 5. Use the Create Wire, Create Cable, or Create Ribbon Cable tool to connect the pins of the 

connectors.

 6. Use the Create Segment tool to create wire bundles, routing them around geometry 

obstacles of other parts in the assembly.

 7. Use the Route or Automatic Route tool to route the wires or cables through the segments 

(wire bundles).

 8. Use the Create Splice tool to create wire or segment splices as required.

When a harness is created, it is composed of a harness assembly fi le and a harness part fi le 

of the same name. The part fi le is the container in which the wires, cables, and segments will be 

built as they are added. Both fi les make up the overall harness and are required for the harness 

to work. Inventor will warn you if you try to edit these fi les directly rather than through a top-

level assembly using the wire harness tools.

In the following steps, you will open an existing Inventor assembly fi le, create a simple har-

ness assembly, and then place connectors:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_18a_018.iam in the Chapter 18 directory of your Mastering Inventor 

2014 folder, and open it.

 3. On the Environments tab, click the Cable And Harness button in the Begin panel.

 4. Accept the default name and location for the new harness assembly, and click the OK but-

ton. Note the harness subassembly and part nodes listed in the browser.

 5. Click the Assemble tab, and then click the Place Component button.

 6. Browse for and locate the connector fi le mi_18a_004.ipt, and click the Open button.

 7. Click twice in the graphics area to place two instances of the connector; then right-click 

and select Cancel.

To assemble the connectors (residing in the subassembly) to the base part (residing in 

the top-level assembly), you’ll need to return to the top-level assembly and place the 

constraints. Parts within the harness can constrain to the parts in the top-level assembly 

because the harness subassembly is adaptive.
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 8. Click the Finish Cable And Harness button to return to the top-level assembly.

 9. Place an Insert constraint on the connectors and the holes on the outside fl anges. Ensure 

that the connector pins face the inside of the base part.

 10. Click the Finish Cable And Harness button to return to the top-level assembly. You can 

close this fi le when fi nished.

This simple exercise illustrates the steps required to create a harness subassembly and place 

connectors within it. You can also place connectors in the top-level assembly before creating the 

harness assembly and then demote components from the top-level assembly into the harness 

subassembly. To do so, follow these general steps:

 1. Place the connectors in the top-level assembly.

 2. Create the harness assembly.

 3. While the harness subassembly is active, expand it in the browser.

 4. Click the connector components in the browser, and drag them down into the harness 

assembly.

Setting Global Harness Settings

You can access the settings for the entire harness by right-clicking the top-level node of the harness 

in the browser while it is active for edits.

Placing Wires
Once the harness assembly is created and the electrical connector parts are added and con-

strained, you can add wires and/or cables. When wires are created, you enter a unique wire 

ID name, select a wire category, and set the wire name (type). Then you select the two pins 

from which and to which you want to run a wire. To see how the Create Wire tool works, open 

mi_18a_020.iam in the Chapter 18 directory of your Mastering Inventor 2014 folder, and 

follow these steps:

 1. Double-click the harness subassembly to set it active for edits (or right-click it and 

choose Edit).

 2. On the Cable And Harness tab, click the Create Wire button.

 3. Set Wire ID to Wire101.

 4. Select Generic from the Category drop-down.

 5. Set the Name drop-down to 14AWG-BLK.

 6. Select Pin 1 (work point) on one of the red connectors for the Pin 1 selection. You’ll see the 

pin number when you pause your mouse pointer over the pin. Figure 18.26 shows the pin 

selection and wire settings.
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Figure 18.26

Placing a wire on 

Pin 1

 7. Select Pin 1 (work point) on the other red connector for the Pin 2 selection.

 8. Click Apply to set the wire. It should run in a straight line between the two connectors.

 9. Set the remaining three pins for the red connectors as listed here:

 ◆ Pin 2 = Wire102, Generic 14AWG-RED

 ◆ Pin 3 = Wire103, Generic 14AWG-WHT

 ◆ Pin 4 = Wire104, Generic 14AWG-GRN

 10. Click Cancel to exit the Create Wire dialog box.

 11. In this assembly, a segment (blue wire bundle) has already been created. Click the Route 

button to route a wire through the segment.

 12. Click just one of the wires for the Wires selection, and then click the segment for the First 

Segment selection.

 13. Select the Single Segment check box, and then click Apply. Note that the segment will 

shrink to size based on the wire.

 14. Click Cancel to exit the Route dialog box, and then click the Automatic Route button.

 15. In the Auto Route dialog box, select the All Unrouted Wires check box, and click the 

OK button.

 16. Expand the Harness1 part node in the browser, and you’ll notice a Wires folder contain-

ing all of the wires you created. Right-click Wire101, and choose Harness Properties. 

Browse the tab to examine the read/write and read-only properties available for this 

wire. When fi nished, return to the Occurrence tab, set Bend Radius to 2 × Diameter, and 

then click the OK button.

 17. Right-click the Wires folder in the browser, and select Bend Radius ➢ Check All 

Bend Radii.

 18. Note that you will receive a warning stating that one or more objects contain an empty 

bend radius. Click the OK button, and note that wires 102 through 104 are marked with a 

warning icon in the browser.
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In this case, the warning indicates the bend radius has not been set. You can edit the wire 

property, set the bend radius, and then repeat the bend radii check. If the bend radius 

for each wire in the model is in compliance with the setting for that wire, then the check 

will clear. Editing segments will be covered later, in the section “Placing and Editing 

Segments.” Now that the problem area is identifi ed, you could make the decision to either 

change the general layout of the assembly or edit the segment route to change the fi t so 

that the bend isn’t so sharp.

 19. Click the Finish Cable & Harness button to return to the top-level assembly. You can close 

this fi le when fi nished.

This simple exercise demonstrated how to create wires in a harness and the routing of these 

wires in an existing segment. The wire categories and names listed in the Create Wires dialog 

box are drawn from the Cable & Harness library.

Using the Cable & Harness Library
The Cable & Harness library is located in the Design Data folder but can be set per harness. 

In most cases, you will want to confi gure it per the Inventor Design Data folder. You can set 

this option by right-clicking a harness assembly while it is active for edits, selecting Harness 

Settings, and then selecting the File Locations tab.

The library fi le that installs by default is Cable&HarnessDefaultLibrary.iwl. You can locate 

this fi le by checking the Design Data path in your Inventor project fi le (*.ipj) or by select-

ing the File tab of the Application Options dialog box. Recall that the project Design Data path 

trumps the application’s Options path if set.

To add objects to the Cable & Harness library, click the Library button on the Manage panel 

of the Cable And Harness tab. You can add new wire, cable, and segment objects, just to name 

a few, and you can create your own custom object type. Figure 18.27 shows the library being 

edited.

Figure 18.27

Th e Cable & 

Harness library
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Placing Cables
Adding cables is much like adding wires. To explore the cable tools, open the fi le mi_18a_022.iam 

in the Chapter 18 directory of your Mastering Inventor 2014 folder. Then follow these steps:

 1. Double-click the harness subassembly to set it active for edits, or right-click it and 

select Edit.

 2. Click the Create Cable button on the Cable And Harness tab.

 3. Set Cable ID to C201, and set Category to Alpha.

 4. Select 2254/4 from the Name drop-down.

 5. Note that Conductor ID 1 is set active. Select Pin 1 (work point) on one of the gray con-

nectors for the Pin 1 selection. You’ll see the pin number when you pause your mouse 

pointer over the pin.

 6. Select Pin 1 (work point) on the other gray connector for the Pin 2 selection. Note that the 

conductor ID advances automatically to the next line.

 7. Set the remaining three pins for the gray connectors as listed here:

 ◆ Pin 2 = C201:2, Red

 ◆ Pin 3 = C201:3, White

 ◆ Pin 4 = C201:4, Green

 8. Click the OK button to set the cable.

 9. Click the Automatic Route button, select the All Unrouted Wires check box, and click the 

OK button.

 10. Expand the Cables folder in the browser and then right-click the listed cable and choose 

Harness Properties. Note that the bend radius is set to 10 × Diameter. If you click in the 

input box, you will see that the value is being pulled from the Cable & Harness library. 

Click the OK button to exit the dialog box.

 11. Right-click the cable, and choose Bend Radius ➢ Check. Click the OK button in the warn-

ing dialog box.

 12. Note that the cable browser node has turned red and displays a warning sign next to 

it to indicate a problem. Right-click it in the browser, and select Bend Radius ➢ Show 

Violations. You will see a red marker on the segment in the graphics area along with a 

dialog box. Click the OK button.

 13. Click the Finish Cable And Harness button to return to the top-level assembly. You can 

close this fi le when fi nished.
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The Check Bend Radius function allows you to locate problem areas with a design. You could 

remedy the violation here either by adjusting the segment points in an attempt to modify the 

fi t of the cable route, or by moving components and/or features in the assembly. Often a design 

might require adjusting both the assembly arrangement and the cable routing. But it’s important 

to be able to check for bend radius violations so that you can determine what needs adjustment. 

In the next section, you will explore segment creation and editing.

Placing and Editing Segments
Segments are used to defi ne the route path in which wires and cables will be run though a 

design to avoid interference and identify possible problem areas where bend radii may be too 

tight. A segment is created by selecting geometry on-screen, either outright or as an offset base. 

For each selection or offset point, a work point is created.

Once segments are created, you can refi ne them by adding points or redefi ning existing 

points. To explore the cable tools, open the fi le mi_18a_024.iam in the Chapter 18 directory of 

your Mastering Inventor 2014 folder. Then follow these steps:

 1. Double-click the harness subassembly to set it active for edits, or right-click it and 

select Edit.

 2. Click the Create Segment button on the Cable And Harness tab.

 3. You will fi rst run a route segment from the red to green connectors. Select the work point 

in front of the red connector for the start point of the segment.

 4. Click any circular edge on the black grommet hole; this will select the center. Repeat this 

for the green grommet hole.

 5. For the third point, you will specify an offset value and then select the fl ange with the 

two square-shaped notches along the top.

 ◆ First, right-click and choose Edit Offset.

 ◆ Enter 10 mm in the Edit Offset box, and then click the OK button.

 ◆ Rub your mouse pointer around on different faces to observe the way the offset 

behaves. Then select roughly in the center of the face of the notched fl ange in front of 

the green connector.

 6. Select the work point in front of the green connector.

 7. Right-click and choose Continue.

 8. Create another short segment from the orange connector and tie it into the fi rst segment. 

Select the work point in front of the orange connector.

 9. Click the work point at the center of the green grommet hole, and right-click and select 

Finish. Figure 18.28 shows the segments.

Use the Automatic Route tool and select the All Unrouted Wires option to route the wires 

through the segments. Upon doing so, you’ll notice two things:

 ◆ The segments adjust to compensate for the wire diameters.

 ◆ The cable coming off the blue connector has routed in an undesirable way.
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Figure 18.28

Th e created 

segments

Use the Unroute tool, and select any of the wires at the blue connector. Because they all 

belong to a cable, you need to select only one, and then they all highlight. Once they are 

unrouted, you can use the Create Segment tool to create a new segment from the blue connector 

to the black grommet hole and then use Route or Automatic Route to reroute the cable. 

Importing Wire Data from AutoCAD Electrical

Depending on the size and structure of your design department, you might want to import sche-

matic data created by AutoCAD® Electrical software users. You can use the Import Harness Data 

tool in Inventor Professional or routed systems to connect multiple wires and cables in the harness 

assembly based on a schematic created in AutoCAD Electrical. A key to doing this successfully is 

making sure the wire and connector numbering is unique throughout the schematic. To do this, 

you must fi rst export the harness data from AutoCAD Electrical as described in these steps:

 1. On the Import/Export Data tab, click the Inventor button. 

 2. In the Export dialog box, specify the scope of the export (export the project or just the current 

drawing), and then click the OK button.

 3. In the XML File Export dialog box, defi ne the location and fi lename for the export fi le.

Once the data is exported from AutoCAD Electrical, you can import it into Inventor as described 

in these steps:

 1. Double-click the harness assembly in which you want to import the harness data.

 2. Check and/or assign reference designators on the connector and splice occurrences used in the 

harness data fi le to ensure that the names match the schematic.

 3. Click the Import Harness Data button on the Cable And Harness tab. Th en browse for the harness 

data fi le (.xml or .csv) exported from AutoCAD Electrical. If you’re importing a CSV fi le, click 

Browse to locate the confi guration fi le (.cfg).

 4. Click the OK button to add the harness data to the active harness assembly.

Th e properties imported from AutoCAD Electrical are as follows:

 ◆ Component tags imported as RefDes

 ◆ Wire numbers imported as the wire ID

 ◆ Th e cable conductor wire layer imported as the cable ID
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You’ll notice that the middle section of the segment needs to be adjusted. To do so, follow 

these steps:

 1. Run your mouse pointer over the centerline of the segment, right-click, and choose Add 

Points.

 2. Select roughly in the middle of the segment, and then right-click and select Finish.

 3. Right-click the new work point, and select Redefi ne Point.

 4. Right-click, select Edit Offset, enter 10 mm for the offset value, and click the OK button.

 5. Click roughly in the center of the square emboss on the base part.

 6. Make an adjustment using the 3D triad. Right-click the same work point, and select 3D 

Move/Rotate.

 7. Click the blue cone (z-axis) of the triad, enter 4 mm, and then click Apply.

 8. Select the small plane between the blue arrow and the green arrow (YZ plane), enter 

-6 mm in both the Y and Z inputs, and then click the OK button.

 9. Edit the segment type. Select Assign Virtual Parts on the Cable And Harness tab, and 

select the centerline of all the segments. From the Type drop-down, select Loom. Set the 

Category drop-down to Sample, set the Name drop-down to Wire Sleeve, click the Add 

button, and then click the OK button. Note that the selections in this dialog box are inter-

dependent. For instance, you might need to set the category fi rst to get the option selec-

tions for the name.

Segment Defaults

You set the default Edit Off set, Color Style, and Diameter settings, and more per harness by right-

clicking the harness browser node, selecting Harness Settings, and then selecting the Segments tab.

Because the middle segment routes all the wires and the cable, it is larger in diameter. This is 

based on a setting in the harness properties. To determine its evaluated size, right-click the seg-

ment centerline and choose Harness Properties. You can determine the diameter at the bottom 

of the Occurrence tab. Because the grommet holes have an inside diameter of 10 mm, you can 

make a judgment as to whether a larger hole size is required.

On the Wire/Cables tab of the Segment Properties dialog box, you can review the wire and 

cable information. Double-clicking a line item will open the properties of that wire or cable. 

Figure 18.29 shows the properties of a wire contained in a segment.

Copying Cable and Harness Designs
Because of the adaptive relationships between assemblies and the harness assemblies and their 

containing harness part fi le, copying existing harness and assembly designs must be done in 

a particular way so as not to break the adaptive relationship between the original fi les when 

working on the new fi les. Before looking at the steps to copy a harness, take a look at 

Figure 18.30 to understand the fi les involved. Each harness comprises an assembly fi le, where 
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you can place connectors and other components, and a part fi le, where the wires, cables, seg-

ments, and other harness components are created.

Figure 18.29

Wire properties

Figure 18.30

Harness assembly 

structure

To copy a harness design, open the fi le mi_18a_028.iam in the Chapter 18 directory of your 

Mastering Inventor 2014 folder. Then follow these steps:

 1. Expand the assembly browser so that you can identify the harness assembly and part 

nodes.

Notice that the harness used in the assembly is called mi_18a_26.Harness2 and the part 

within is named the same. This is because this top-level assembly fi le was created by 

using the Save Copy As tool and, therefore, still references the original harness. Although 

it may seem logical to use the assembly Replace tool or some other method to swap out 

the harness, such methods can’t be used because the adaptive relationships must be 

updated throughout the fi le references.

 2. Right-click the mi_18a_26.Harness2.iam fi le in the browser, and choose Delete.

 3. Click the No button in the prompt box so that adaptivity is not cleared in the original 

assembly.
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 4. On the Assemble tab, click the Place button.

 5. Browse for the Harness_Files folder in the Chapter 18 directory, select mi_18a_26

.Harness1.iam, and click the Open button.

 6. Click anywhere in the graphics screen to place the harness; then right-click and select OK 

or Cancel.

 7. Typically, you would constrain the harness using assembly constraints at this point. For 

the purpose of this exercise, though, you don’t have to do so. Instead, right-click the har-

ness assembly in the browser, and choose Make Adaptive. If prompted to save, click Yes.

 8. In the Make Adaptive dialog box, you can set the new names for harness fi les or accept 

the default names.

 9. In the Location area at the bottom of the dialog box, click the Browse button, browse for 

the Harness_Files folder in the Chapter 18 directory, and then click the OK button. 

Note that by default, a subdirectory of the same name as the top assembly is created 

along with subfolders for the component organization. You can accept this path and just 

make that part of your standard fi le management if you like.

 10. Click the OK button and the new fi les are created, are made adaptive, and are ready for 

your design edits.

To make copies of a harness within the same assembly, you can simply copy and paste an 

existing harness, or you click an existing harness node and drag and drop it into the graphics 

area. Then right-click, choose Make Adaptive, and follow the renaming and location options 

detailed in the earlier steps.

Creating Nailboard Drawings
Documenting harnesses is a pretty straightforward process with purpose-built tools for 

detailing harnesses as traditional nailboard drawings. To explore these options, open the fi le 

mi_18a_026.iam in the Chapter 18 directory of your Mastering Inventor 2014 folder, and 

follow these steps:

 1. Double-click the harness subassembly to set it active for edits, or right-click it and select 

Edit.

 2. Click the Nailboard button on the Cable And Harness tab.

 3. Select a drawing template of your choice from the Open Template dialog box, and click 

the OK button.

 4. You will be taken into an active sketch within the drawing. Click the Nailboard tab to 

switch to the nailboard sketch tools.

Switching to the Nailboard Tab

To use detailing tools specifi c to nailboard drawings, you must manually switch from the Sketch 

tab to the Nailboard tab once the nailboard view is created or edited. Using the Dimension tool 

on the Sketch tab will not give you the same results as using the Harness Dimension tool on the 

Nailboard tab.
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 5. Use the Harness Dimension tool to place dimensions from the points on the harness. 

These will display as driven sketch dimensions for now, but will show as drawing style 

dimensions once out of sketch mode.

 6. Click the Pivot button on the Nailboard tab, and then select the sketch point at one of the 

90-degree intersections. Then click a sketch endpoint of the harness leg, and drag to pivot 

the angle. Right-click and choose Finish.

 7. Zoom to any end on the harness, and select all of the wires (you can use a selection win-

dow to do this quickly).

 8. Once the wires are selected, the Fan In and Fan Out buttons are available on the 

Nailboard tab. Click the Fan Out button, enter 180, and then click the OK button. Note the 

change in the wire fan angle. You can window the entire harness and use the Fan In/Out 

tools to set all the fans to the same angle as well. You can also manually click and drag 

each wire if needed.

 9. Click the Finish Sketch button when you are satisfi ed with the dimensions, leg pivots, 

and fan angles.

 10. Click the Place Connector Views button on the Nailboard tab.

 11. Accept the defaults, and click the OK button.

 12. Note that a drawing view of each connector is placed near each wire fan. Right-click one 

of these views, and select Edit View Orientation. Notice that you can change the styl-

ing, scale, and other properties, as you would with any Inventor view, but you can also 

change the view orientation.

 13. Feel free to experiment with view settings, and then click the OK button.

 14. Click the Edit button on the Nailboard tab. If the Sketch tab becomes active, switch to the 

Nailboard tab.

 15. On the Nailboard tab, click the Property Display button.

 16. Set Selection Filter to All Wires.

 17. Choose Wire ID from the Property Name list, and then click Apply.

 18. Click on-screen to establish the position of the ID label to the wire, and you will see all 

the wire ID labels placed. Click the OK button. Click and drag labels to adjust them.

 19. Expand the Segment browser node, select all the listed segments, and then right-click and 

deselect the Display As Actual Diameter option.

 20. Expand the Wires node, right-click one of the wires, and choose View Path. Notice how 

the wire path is highlighted.

 21. Click the Finish Sketch button.

Here are a few more settings and options to use when working with nailboard drawings:

 ◆ Right-click the top-level harness node in the browser, and choose Nailboard Settings to 

adjust the global settings of the nailboard view.
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 ◆ You can open a drawing template fi rst and use the Nailboard button on the Place Views tab 

to create a nailboard view and set the display settings, rotation, and other view options as 

you place the view.

 ◆ You can use the Table tool to place wire/pin tables from existing XLS fi les.

 ◆ You can use the Broken Sketch Entity tool in the drawing view sketch environment to 

break long harness runs so they will fi t on the drawing sheet.

Th e Bottom Line

Create routes and runs.  Using routed systems tools allows you to quickly defi ne many dif-

ferent route types in order to check for clearance and fi ts within a design, all while creating a 

bill of materials that can be used downstream in the manufacturing process.

Master It  You have a model containing equipment and structural components defi ning 

the space requirements for a new route. Can you create a route using this geometry or are 

you required to create a sketch fi rst? 

Author a tube and pipe component.  To create your own fi ttings, couplings, and so on to 

be used within tube and pipe design, you need to fi rst author them for use with the tube and 

pipe tools.

Master It  How can you set the depth at which pipe, tube, or hose segments are inserted 

into a fi tting?

Author an electrical component.  To create your own electrical connector components to be 

used within cable and harness designs, you need to fi rst defi ne pins within the parts.

Master It  How can you create a family of electrical connectors with varying numbers 

of pins?

Create and document cable and harness assemblies.  Cable and harness assemblies are 

created using a specifi c subassembly and part structure. Each harness is contained in a har-

ness subassembly, and the parts such as wires, cables, and segments are created within a har-

ness part fi le.

Master It  You have a complex design that includes many harness assemblies and would 

like to turn some of them off while you work on others and/or create new ones. What is 

the best way to do this? 
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Plastics Design Features

When creating thin wall plastic parts, you can choose either of two popular approaches to get 

started. One approach is to start with a solid and shell it out; the other is to start with a surface 

and thicken it. Although these methods approach thin wall features from different starting 

points, the end result can be the same. You can also mix and match the two methods as required 

to achieve your design.

Typically, once you’ve established the base feature, you will add other plastic part features. 

The Autodesk® Inventor® software has several specialized tools for creating plastic part features 

when you are working in the parts modeling environment. You’ll fi nd these tools on the Plastic 

Part panel of the 3D Model tab. Although many of the other tools covered in this chapter, such 

as Shell and Thicken/Offset, are used to design all types of parts, they are commonly used 

along with the plastic-specifi c tools and, therefore, are covered in this chapter as well.

In this chapter, you’ll learn to:

 ◆ Create thicken/offset features

 ◆ Create shell features

 ◆ Create split features

 ◆ Create grill features

 ◆ Create rule fi llet features

 ◆ Create rest features

 ◆ Create boss features

 ◆ Create lip and groove features

 ◆ Create snap fi t features

 ◆ Create rib and web features

 ◆ Create draft features

 ◆ Create an injection mold

Creating Th icken/Off set Features
You can use the Thicken/Offset Feature to add thickness to a surface feature to create a thin 

wall solid. Although you can use this tool to create surfaces and remove solid material, typically 
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when using Thicken/Offset to create plastic thin wall features, you’ll select an existing surface 

feature to thicken and then set the output type to produce a solid.

To create a thin wall part using the thicken method, follow these steps:

 1. Click Open on the Get Started tab, browse for mi_19a_022.ipt in the Chapter 19 direc-

tory of your Mastering Inventor 2014 folder, and open it.

If you have not already downloaded the Chapter 19 fi les from www.sybex.com/go

/MasteringInventor2014, please refer to the “What You Will Need” section of the 

Introduction for the download and setup instructions.

 2. On the 3D Model tab, select the Revolve tool, and notice that Output defaults to Surface 

because the sketch is an open profi le.

 3. For the profi le selection, click any solid line in the sketch.

 4. For the axis, select the dashed centerline.

 5. Leave the extents solution set to Full, and click the OK button.

 6. Select the Thicken/Offset tool on the Surface panel of the 3D Model tab.

 7. Switch the select mode from Face to Quilt, and then select any face on the revolved 

surface.

 8. Set Distance to 2 mm, and change the direction arrow so that the thickened material is 

placed to the inside of the part.

 9. Ensure that the output is set to Solid, and then click the OK button.

Notice the sharp edges. Although you could use the Fillet tool to select all the outside 

edges of the solid and then attempt to set fi llets to all the inside edges of the solid, there 

is an easier way. If you place the fi llets on the surface, the thickened solid feature will fol-

low the shape and include the fi llets. To do this, continue with these steps.

 10. From the browser, select the end-of-part (EOP) marker, and drag it above the thicken 

feature.

 11. Select the Fillet tool on the Modify panel, and set the radius to 8 mm.

 12. Set Select Mode to Feature, and then select the revolved surface.

 13. When you see a preview of three fi llet edges, click the OK button.

 14. Drag the EOP marker down below the thicken feature in the browser, and you’ll note that 

the thickened solid now includes the fi lleted edges.

 15. Right-click the revolution feature in the browser, and toggle the visibility off.

Figure 19.1 shows the revolved and thickened part. You can close this fi le without saving the 

changes and continue on to the next section, where you’ll create the same basic part but using a 

different method.

http://www.sybex.com/go
http://www.sybex.com/go/MasteringInventor2014
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Figure 19.1

A revolved and 

thickened part

Using Plastic Part Templates

When working with plastic thin wall parts, it is helpful to follow certain design parameters 

throughout the features of the part to avoid issues with shrinkage and voids caused by uneven 

cooling once the part comes out of the mold. To help with this, you may want to create a plastic 

part template with your design parameters already set up. Here is an example of the parameters 

in such a template with the design rules already set up and ready for use:

Creating Shell Features
Another approach to creating thin wall features and parts is to create a solid and then use the 

Shell tool to hollow it out. When creating a shell feature, you set the wall thickness and select 

the faces you want to remove. Material from the interior of the part is removed, resulting in a 

cavity. To create a thin wall part using the shell method, open mi_19a_024.ipt found in the 

Chapter 19 directory of your Mastering Inventor 2014 folder, and then follow these steps:

 1. On the 3D Model tab, select the Revolve tool, and notice that Output defaults to Solid 

because the sketch is closed. The profi le and axis selections will automatically select 

because there is only one possible solution for each.

 2. Leave the extents solution set to Full, and click the OK button.
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 3. Click the Shell button on the Modify panel of the 3D Model tab.

 4. Select the circular face on the top of the revolution feature as the Remove Faces selection.

 5. Ensure that the direction is set to Inside, set the thickness to 2 mm, and then click the OK 

button.

Notice the odd result at the opening of the part. You will fi x this by creating a boundary 

patch surface and then using the Thicken/Offset tool to recut the hole. You’ll also place 

some fi llets on the sharp outside edges.

 6. Select the Boundary Patch tool on the Surface panel.

 7. Click the larger-diameter edge of the center hole for the BoundaryLoop selection, and 

click the OK button. This creates a surface feature you’ll use to recut the hole.

 8. Select the Thicken/Offset tool on the Surface panel, and click the boundary patch’s 

surface.

 9. Set Solution to Cut, set Distance to 2 mm, and set the direction to go down into the part.

 10. Make sure the output is set to Solid, and then click the OK button.

 11. Select the Fillet tool on the Modify panel, and set the radius to 8 mm.

 12. Select the three outside edges—two along the bottom and one along the top. Be certain 

these are the outside edges and not the inside edges; then click the OK button.

 13. Drag the fi llet feature above the shell feature in the browser. This will allow the shell to 

follow the outside fi llets and translate them to the inside edges. If you cannot drag the 

fi llet above the shell feature, mostly likely you have inadvertently selected an inside edge. 

If so, the fi llet cannot exist before the shell, because it is dependent on the edge created by 

the shell.

 14. Right-click the boundary patch feature in the browser, and toggle the visibility off. 

Figure 19.2 shows the revolved and shelled part.

Figure 19.2

A revolved and 

shelled part
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If you were to compare the parts created by the Thicken/Offset method and the Shell 

method, you would fi nd that the two are not quite identical. The difference is in the opening 

cutout. In the shelled version, a boundary patch was used to recut the opening down into the 

part (along the y-axis). In the thickened version, the opening was left in its natural condition. 

You could use the Boundary Patch tool to clean up the opening in that case as well.

Using either method, it is also important to consider a draft angle for the walls that are in the 

direction in which a mold would be separated. Not including drafts early on can lead to a lot of 

diffi cult cleanup work in the long run, before a mold can be created. You can close this fi le with-

out saving the changes and continue on to the next section, where you’ll explore the Split tool.

Reordering Shell Features

You may fi nd that you’ve added a previous feature that gives an incorrect result when creating 

shell features later in the design. Often, you can just click the shell feature and drag it above 

the other features to let it rebuild. To explore this, you can open the fi le mi_19a_064.ipt in 

the Chapter 19 folder, click Shell1 in the browser, and drag it above Extrusion2. When you do 

so, you’ll see that the resulting part is quite diff erent than when the shell was created after the 

extrusion and fi llet features.

Creating Split Features
Often when designing plastic parts, it is useful to create mating parts within the same fi le. To do 

this, you can use the Split tool to divide a single body into two mating bodies. You can also use 

the Split tool to split the surfaces on a solid so that they can be manipulated individually. To see 

how the Split tool is used, open the fi le mi_19a_026.ipt in the Chapter 19 directory of your 

Mastering Inventor 2014 folder, and then follow these steps:

 1. Expand the Solid Bodies folder in the browser, and notice that there is currently only a 

single solid listed in the folder. You will use the Split tool to divide this into two separate 

solids.

 2. On the 3D Model tab’s Modify panel, select the Split tool.

 3. For the Split tool selection, click the sketch profi le running through the part.

 4. For the method, click the Split Solid button (third from the top), which will split the exist-

ing part into two separate solids.

 5. Click the OK button, and notice that Solid1 has been replaced with two new solids in the 

Solid Bodies folder.

 6. To work with just the top solid, select it in the Solid Bodies folder of the browser, right-

click, and choose Hide Others.

 7. Next, you’ll create a 3D sketch to split the surface of the solid. Use the Sketch drop-down 

on the 3D Model tab, and select Create 3D Sketch.
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 8. On the 3D Sketch tab, select the Silhouette Curve tool, choose the solid as the Body selec-

tion and the visible y-axis as the Direction selection, and then click the OK button.

 9. This creates a sketch curve along the face where a beam of light shining down from above 

would create a shadow. Click Finish Sketch to exit the 3D sketch.

 10. Select the Split tool again, and choose the 3D Sketch curve for the Split tool selection.

 11. For the Face selection, choose the face that the 3D Sketch curve is encircling. Ensure that 

the Faces option is set to Select and not All. This will split just the outside face of the part, 

whereas All would split both the outside and inside faces. Click the OK button.

 12. Now select the Thicken/Offset tool, choose the bottom half of the face you just split, and 

set Distance to 1 mm.

 13. Ensure that Output is set to Solid, Solution is set to Join, and Direction is thickening out 

from the part; then click the OK button.

 14. Right-click the thickened part you just created in the browser, and choose Properties.

 15. Set Feature Appearance to Blue – Glazing or something similar, and click the OK button.

 16. Right-click the solid in the Solid Bodies folder, and choose Properties. Enter Cover 

for the name. Click the Update button to set the general properties of this solid. You’ll 

notice also that you can set the color for the entire solid body here. Selecting the Clear 

All Overrides check box would reset the blue thicken feature to abide by the color of the 

entire solid. Feel free to choose a color of your liking, and then click the OK button.

 17. Right-click the solid in the Solid Bodies folder, and choose Show All to turn the visibil-

ity of the other solid back on.

There are a number of uses for a multi-body part, but for this type of product they are invalu-

able. You can close this fi le without saving the changes and continue on to the next section, 

where you’ll learn to create grill features.

Creating Grill Features
You can use the Grill tool to create vents and openings on thin wall parts to provide access 

and airfl ow to parts housed within an exterior part. To create grill features, use the Grill tool 

to project 2D sketches onto the surface of the part to create various raised or recessed features. 

Although the boundary sketch is the only required grill element, you can create islands, ribs, 

and spars, and then give them all a draft angle. You can also check the fl ow area of the open-

ing to ensure that it meets the required area. Open the fi le mi_19a_028.ipt in the Chapter 19 

directory of your Mastering Inventor 2014 folder, and then follow these steps to create a grill 

feature:

 1. Select the Grill tool from the Plastic Part panel of the 3D Model tab. You’ll see a sketch 

with all the various elements of what will become the grill within it. Figure 19.3 shows 

the sketch elements separated out into the grill elements.

 2. For the Boundary profi le, select the outer profi le of the sketch, as identifi ed in Figure 19.3. Set 

Thickness to 2 mm, Height to 6 mm, and Outside Height to 2 mm, as shown in Figure 19.4.
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Figure 19.3

Grill elements

Boundary Island

Ribs Spars

Figure 19.4

Grill boundary 

settings

 3. Click the Island tab, and select the elliptical profi le of the sketch, as identifi ed in 

Figure 19.3. Leave Thickness set to 0 mm so that the island is a solid fi ll.

 4. Click the Rib tab, and select the four arcs identifi ed as the ribs in Figure 19.3. Set 

Thickness to 2 mm, Height to 4 mm, and Top Offset to 2 mm, as shown in Figure 19.5.

Figure 19.5

Grill rib settings

 5. Click the Spar tab, and select the two lines identifi ed as the spars in Figure 19.3. Set Top 

Offset to 2 mm, Thickness to 6 mm, and Bottom Offset to 0 mm, as shown in Figure 19.6.

Figure 19.6

Spar rib settings

 6. Click the >> button at the bottom of the dialog box, and note the Flow Area setting; then 

click the OK button to create the grill feature.

 7. Next, you’ll pattern the grill feature around the parts. Click the Circular Pattern tool 

(located next to the Work Features tools).
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 8. Select the grill feature for the Features selection, and then click the visible y-axis for the 

Rotation Axis selection.

 9. Enter 3 for Occurrence Count and 90 deg for Occurrence Angle.

 10. Click the Midplane button to set an occurrence on each side of the original grill feature, 

and then click the >> button.

 11. In the Positioning Method area, select Incremental to set the spacing of the grills at 

90 degrees each, and then click the OK button. Figure 19.7 shows the patterned grill 

features.

Figure 19.7

Grill features 

patterned

Feel free to edit the grill feature and experiment with the options, adding a draft angle and 

so on. You might want to drag the EOP marker above the pattern feature before doing so to 

allow the edits to take place more quickly. Then just drag it back down once the edits are com-

plete. When you’ve fi nished, you can close this fi le without saving the changes and move on to 

the next section, where you’ll learn about rule fi llet features.

Creating Rule Fillet Features
With rule fi llets, you can create fi llets based on a list of rules you’ve set up to determine which 

edges to fi llet. This approach can be a powerful time-saver when you’re working with plastic 

parts because it allows you to create many fi llets all at once without having to select each and 

every edge. When a part feature is changed with signifi cance to the rule-based fi llets, the rule 

is evaluated to determine whether it still applies. If so, the fi llets are regenerated for new edges 

that fi t the rule and discarded for edges that do not. Although the Rule Fillet tool is categorized 

as a plastic feature tool, you can use rule-based fi llets for any part you design.

Open the fi le mi_19a_030.ipt in the Chapter 19 directory of your Mastering Inventor 

2014 folder, and then follow these steps to create a rule fi llet feature:

 1. Expand the Solid Bodies folder in the browser, right-click the solid named Cover, and 

choose Hide Others.

 2. Select the Rule Fillet tool on the Plastic Part panel.

 3. Click the drop-down under the Source column, and select Face.

 4. Rotate the part around, and select the underside face of the grill features (they’ve each 

been colored yellow for easy identifi cation).

 5. Set the Radius to 2 mm, and then set the drop-down in the Rule column to Incident 

Edges.
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 6. In the Options area, deselect the All Rounds check box, leaving All Fillets selected.

 7. In the Incident Edges area, select the visible y-axis as the Direction selection, and then 

click the OK button to create all the previewed fi llets. Figure 19.8 shows the results of the 

rule fi llet on one of the grill faces.

Figure 19.8

An example of rule 

fi llets

You’ll notice that the edges, where one of the spars meets the grill boundary along the top, 

did not receive fi llets. This is because those edges do not qualify according to the rule of inci-

dent edges. Although it might seem as if the rule fi llet has malfunctioned, close inspection of 

the grill feature will show there is a very small gap between the spar and the boundary face. To 

resolve this, the lines in the grill sketch used for the spars would need to be extended past the 

boundary edge. If you edit Sketch3, you can see where the issue is.

Here are brief descriptions of the results of the Rule Fillet tool when Faces is selected:

Incident Edges  Only edges contacting the source faces that are parallel to a selected axis 

(within a specifi ed tolerance) are fi lleted.

All Edges  Edges generated by the selected faces and other faces of the part body are 

fi lleted.

Against Features  Two selection sets are created: a “source” selection and a “scope” selec-

tion. Only edges formed by the intersection of the faces in the source with features in the 

scope selections are fi lleted.

Here are brief descriptions of the results of the Rule Fillet tool when Features is selected:

All Edges  Edges generated by the selected features and the part body are fi lleted.

Against Part  Only edges formed by the intersection of the faces of the feature(s) and the 

faces of the part body are fi lleted.

Against Features  Two selection sets are created: a “source” selection and a “scope” selec-

tion. Only edges formed by the intersection of the features in the source with features in the 

scope selections are fi lleted.

Free Edges  Only edges formed by faces of the selected feature are fi lleted.

When you have fi nished with this part, you can close the fi le without saving changes and 

move on to the next topic: rest features.

Creating Rest Features
A rest feature is a shelf or landing area applied to a curved or slanted face of a plastic part, 

often used as a surface on which to mount other components. The results of the rest feature are 
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largely dependent on the orientation of the rest sketch in relation to the target body and the 

combination of settings and selections you choose. The Through All option will extend the rest 

profi le through the extents of the target body and the direction arrow will change the results, as 

you can see by comparing Figure 19.9 and Figure 19.10.

Figure 19.9

Th rough All ter-

mination with 

the direction set 

downward

Profile Sketch

Figure 19.10

Th rough All ter-

mination with 

the direction set 

upward

Profile Sketch

Additionally, you can set a Distance extent. Figure 19.11 shows a rest created 25 mm off the 

profi le sketch in both directions.

Figure 19.11

Using Distance 

extents for a rest

Profile Sketch

You can also set the rest to terminate using a selected surface. Figure 19.12 shows a rest set to 

use the target body surface as a termination, with the direction set to go up from the sketch. The 

result adds material but does not create a pocket.

Figure 19.12

A rest using a sur-

face termination
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You can use the More tab in the Rest dialog box to set Landing options such as taper angles 

and termination settings. Open the fi le mi_19a_032.ipt in the Chapter 19 directory of your 

Mastering Inventor 2014 folder, and then follow these steps to create a rest feature:

 1. Expand the Solid Bodies folder in the browser, right-click the solid named Cover, and 

choose Hide Others.

 2. On the Plastic Part panel, select the Rest tool. Because only one profi le is available in the 

visible sketch, it is selected automatically.

 3. Set the direction arrow to point up (use the fl ip arrow on the left).

 4. Set the thickness to 2 mm, and set the thickness direction to Outside.

 5. Click the More tab, set the Landing Options drop-down to To Surface, and then select the 

visible surface. Set the landing taper to 12 deg, and then click the OK button.

 6. Turn off the visibility of the landing surface, and inspect the results. You’ll notice that the 

surface contours are translated to the tapered faces. If this is not the result you want, you 

can use the Delete Face option to clean up the contours.

 7. On the Surface panel, select the Delete Face tool.

 8. Select the Heal check box. Then select the four contoured faces, as shown in Figure 19.13, 

and click the OK button.

Figure 19.13

Deleting and heal-

ing faces

The Delete Face tool is a good way to clean up geometry when needed, but it should not be 

used indiscriminately, because it may create unpredictable results during feature edits. If you 

have the option to edit an existing sketch or feature to get the same result as using the Delete 

Face tool, then that is typically the best option.

There are also times when cleaning up geometry can be bypassed by using a different tech-

nique. Rather that cleaning up an interior corner to apply an edge fi llet, you may be able to apply 

a two-face fi llet and have the fi llet feature “absorb” the inconsistent faces that would be patched 

over. Also, it is a good idea to create small selection sets to delete multiple faces rather than try-

ing to delete them all at once. For example, in this design you would need to delete the contours 

on the sides of the rest feature on all the inside and outside faces to remove the contours com-

pletely. This would be best to do as several different features, each created with the Delete Face 

tool. Once you’ve experimented with the Delete Face tool, you can close this fi le without saving 

changes and continue to the next section, where you’ll learn about boss features.
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Creating Boss Features
To hold plastic parts together without risking damage to the thin wall features, boss features 

are often used to provide a more rigid connection point than just a simple hole. You can use 

the Boss tool in Inventor to create matched pairs of bosses on mating parts. The half accept-

ing the fastener is the head, and the other half is the thread. You can create both types of bosses 

using the Boss tool. When required, you can add strength ribs so that the boss features will 

not be snapped off under load. As a rule, you should consider adding ribs when the length of 

the boss exceeds the diameter by more than three times.

Open the fi le mi_19a_034.ipt in the Chapter 19 directory of your Mastering Inventor 

2014 folder, and then follow these steps to create boss features:

 1. Expand the Solid Bodies folder in the browser, right-click the solid named Base, and 

choose Hide Others.

 2. Because the Base part has an uneven edge, the boss features to be created will be differ-

ent heights. To locate the bosses, you will fi rst create work points. Select the Point tool on 

the Work Features panel.

 3. To create a work point, select the edge of Work Plane4, and then select the inside edge of 

the base near the intersection of the work plane and the edge.

Repeat Command for Work Features

When you start any of the work feature tools (Work Planes, Work Axis, and Work Point), you can 

right-click and choose Repeat Command to set the work feature tools to stay on until you right-

click and choose Done. Th is helps when you are creating a lot of work features, because you do not 

have to click the button each time.

 4. Repeat this for Work Plane5 and the inside edge of the part. You’ll note that the work 

points are placed at different heights from the bottom of the base part. Figure 19.14 shows 

the resulting work points.

Figure 19.14

Work point 

locations
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 5. Next, you will create grounded work points to establish the inset location for the boss fea-

tures. Use the drop-down on the Work Features panel to select the Grounded Point tool.

 6. Select the fi rst work point you created at the intersection of the part edge and Work 

Plane4. You will see the 3D Move/Rotate dialog box, and the triad will appear at the work 

point location.

 7. Click the Redefi ne Alignment Or Position button in the dialog box.

 8. Next, select the small plane on the triad running between the green y-axis and the red 

x-axis (you might need to rotate your view). Then select the edge of Work Plane4. The 

triad will realign to the work plane.

 9. Now you are ready to place the grounded work point. To do so, fi rst click the red cone 

shape (arrowhead) of the triad for the x-axis. This will isolate x-axis input in the dialog 

box. Enter 15 mm and click Apply. This will create a grounded work point.

 10. Next, click the Redefi ne Alignment or Position button to redefi ne the triad location. Click 

the black/purple ball at the center of the triad fi rst, and then select the work point at the 

intersection of the Work Plane5 and the inside edge of the part.

 11. Click the blue cone shape (arrowhead) of the triad for the z-axis. This will isolate the 

z-axis input in the dialog box. Enter -15 mm (or just click and drag the blue arrowhead 

into position). Then click the OK button. This will create a second grounded work point 

and exit the Grounded WorkPoint tool.

 12. Now you are ready to create the boss features. Select the Boss tool on the Plastic Part 

panel.

 13. Make sure the Placement drop-down is set to On Point, and then select the two grounded 

work points for the Centers selection. Click the visible y-axis for the Direction selection, 

and ensure that the preview shows the bosses extending down toward the part base. If 

they do not, use the Flip arrow to change the direction.

 14. Click the Head tab. Note the buttons on the left of the dialog box. If you click the lower 

one, the Head tab becomes the Thread tab, allowing you to place a different boss type. 

In the Head tab, click the (+) plus button next to the Draft Options area to view the draft 

inputs available. You can leave the inputs at the defaults.

 15. Click the Ribs tab, and select the Stiffening Ribs check box to set these options active. 

Enter 4 in the Number Of Stiffening Ribs input box.

 16. Enter 6 mm for the Shoulder Radius input, and then click the (+) plus button next to the 

Fillet Options area to view the fi llet inputs available. Leave the inputs at the defaults.

 17. Click the Start Direction button at the bottom of the dialog box, and then select either 

Work Plane4 or Work Plane5 to establish the direction. (You can also just enter 45 degrees 

as the angle, in this particular case.)

 18. Click the OK button to create the boss features. You’ll notice that each is created at a dif-

ferent height.
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 19. Use the Mirror tool to mirror the boss feature, using the YZ origin plane as the mirror 

plane. Figure 19.15 shows the completed bosses.

Figure 19.15

Plastic boss 

features

Now that the Base half of this design has the head-boss features completed, you can create 

the sketch or work points at the centers of each boss, toggle the visibility of the cover and base 

so that the cover is visible, and then use those points to create the thread bosses in the cover in 

the same manner you just created the head bosses in the base. To explore the placement of boss 

features using a sketch, you can open the fi le mi_19a_035.ipt from the Chapter 19 directory of 

your Mastering Inventor 2014 folder. Once you’ve fi nished exploring the Boss tool, you can 

close the fi le without saving changes and continue to the next section.

Turning Off Work Feature Visibility

Recall that it is a best practice to right-click and toggle off  the visibility of each work feature you 

create once you have fi nished using it. Leaving the visibility on or using the Object Visibility display 

override at the part level can make managing work features diffi  cult at the assembly level.

Creating Lip and Groove Features
Lip and groove features are used to mate two parts together so that they fi t together precisely. 

You can use the Lip tool in Inventor to create either the lip or the groove of the part by specify-

ing a path consisting of a set of tangent, continuous boundary edges. You can also use work 

planes to establish path extents where a lip is not needed around an entire edge. Open the fi le 

mi_19a_036.ipt from the Chapter 19 directory of your Mastering Inventor 2014 folder, and 

then follow these steps to create lip features:

 1. Expand the Solid Bodies folder in the browser, right-click the solid named Base, and 

choose Hide Others.

 2. Select the Lip tool on the Plastic Part panel, and set the type to Lip by clicking the Lip 

button on the left side of the dialog box.

 3. Select the inside edge along the top of the part for the Path Edges selection, and then 

select the top face for the Guide Face setting.

 4. Next click the Lip tab, set the outside angle to 10 degrees and the clearance to 0.5 mm, 

and then click the OK button. Figure 19.16 shows the Lip selections.

 5. Next, you’ll create the groove on the Cover solid. Expand the Solid Bodies folder in the 

browser, right-click the solid named Cover, and choose Hide Others.

 6. Select the Lip tool, and set the type to Groove by clicking the Groove button on the left 

side of the dialog box.
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Figure 19.16

Creating a lip 

feature

 7. Select the inside edge of the part for the Path Edges selection, and then select the Pull 

Direction check box in the dialog box. Next, select the top face of one of the bosses to 

establish a pull direction.

 8. Next click the Groove tab, set the outside angle to 10 degrees and the clearance to 

0.5 mm, and then click the OK button.

Note that if you did not set a clearance value, you would likely get an error. The clearance 

value is useful for creating a planar surface along the path where needed. You can experiment 

with different settings and values by editing the lip features if you would like, and then you can 

close the fi le without saving changes.

Creating Snap Fit Features
Snap-fi t features are used to secure a plastic part to another part. Although you can model any 

number of snap-fi t connections using the standard modeling tools, Inventor includes a tool to 

create the common hook-and-loop cantilever snap fi t. Figure 19.17 shows a few common snap fi ts 

you might create with the Snap Fit tool and standard modeling tools.

Figure 19.17

From left to right: a 

permanent locking 

snap, nonlocking 

snap, and U-shaped 

removable locking 

snap

To insert a snap fi t, select an insert point made of either a sketch point or a work point. Open 

the fi le mi_19a_038.ipt in the Chapter 19 directory of your Mastering Inventor 2014 folder, 

and then follow these steps to create snap fi t features:

 1. Bring an existing part into the design using the Derive tool. On the Manage tab, click the 

Derive button.

 2. Locate and select the fi le mi_19a_099.ipt in the Chapter 19 folder, and then click Open.

 3. In the Derived Part dialog box, select the fi rst button for the Derive Style to create a single 

solid-body part with merged seams between planar faces.
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 4. Next expand the Solid Bodies folder, and make sure Solid1 is colored yellow, denoting 

that it is set to be derived into your current design. Expand the Work Geometry folder, 

set Work Axis1 to be derived as well, and then click the OK button. You can use the 

ViewCube® to return to the home view.

 5. You’ll now use the derived part to subtract material from the Cover part, so that it will fi t 

into the opening. Click the 3D Model tab, and then select the Combine tool on the Modify 

panel.

 6. For the Base selection, select Cover. For tool body, select the derived part. Set the solution 

to Cut, click the Keep Toolbody check box, and click the OK button.

 7. When the tool body component (in this case the derived part) is combined with the base 

part, its visibility is automatically toggled off. Expand the Solid Bodies folder, and 

you’ll see the derived part listed as a solid with its visibility turned off.

 8. Next, you’ll create a work point to set the location of the snap fi t feature. Select the Point 

tool on the Work Features panel, and zoom into the yellow face located on the cutout of 

the cover. Select the midpoint along the top edge of the yellow face to set the work point.

 9. Now you’re ready to create the snap fi t. Select the Snap Fit tool on the Plastic Part panel.

 10. Ensure that the Placement drop-down is set to On Point and the Cantilever Snap Fit Hook 

button is selected (on the left of the dialog box).

 11. For the Centers selection, click the work point you created.

 12. For the Direction selection, click the visible y-axis.

 13. For the Hook Direction selection, click the derived work axis running through the yellow 

face.

 14. Use the Flip button to set the direction correctly if the preview shows it facing down.

 15. Ensure that the Extend check box is selected so that the snap will match the contour of 

the curved face on which it is being created. The Extend check box might make the pre-

view of the snap fi t feature look as if the feature is going to build to the wrong side of the 

yellow face, but it should be correct if you’ve followed the previous steps.

 16. Click the Beam tab, set the Beam Length setting to 7 mm, the Beam Width At Hook set-

ting to 9 mm, and the Beam Width At Wall setting to 10 mm.

 17. Click the Hook tab, and take a look at the settings; leave these settings at the defaults, and 

then click the OK button.

 18. Use the Circular Pattern tool to pattern the hook around the opening for a total of three.

 19. On the Solid bodies tab, right-click all of the solids, and choose Show All. Investigate the 

snap fi t, and note that the derived part has the mating half of the hook built in. 

Figure 19.18 shows the completed snap fi t feature.

You can turn on the derived solid from the Solid Bodies folder to check to see how the 

snap feature fi ts with the derived part. Once you’re done, you can close the fi le without saving 

changes.
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For more on snap fi t features, you can open the fi le named mi_19a_040.ipt in the Chapter 19 

folder to experiment with the various snap fi t settings. Use the work points to place hook and loop 

features to your liking. You can also open mi_19a_042.ipt for comparison. This fi le contains two 

halves of a simple plastic box. Examine the model features to see how the hook and loops were 

created in combination with extrude features to get a precise placement.

Figure 19.18

A snap fi t feature

Working with Multi-bodies

At any point during your design, you can save the solids within a multi-body part as individual 

parts and even have them automatically placed into an assembly by using the Make Components 

tool. Creating multiple solid bodies in a single-part fi le off ers some unique advantages compared 

to the traditional methods of creating parts in the context of an assembly fi le. You explored the 

steps for doing this in Chapter 5, “Advanced Modeling Techniques.”

Creating Rib and Web Features
Ribs and webs are often used in plastic parts to prevent warping and to add stiffness to thin 

wall parts. To create a rib feature, fi rst create an open profi le sketch to defi ne the cross section. 

Then defi ne the direction and thickness. If the rib feature runs perpendicular to the sketch 

plane, you can add a draft taper. By default, the profi le extends to intersect the next face. To cre-

ate a rib network, you can select multiple sketch profi les at once. Alternatively, you can create a 

single rib feature and then pattern and/or mirror it.

Open the fi le mi_19a_044.ipt in the Chapter 19 directory of your Mastering Inventor 

2014 folder, and then follow these steps to create rib features:

 1. You’ll notice there is a small diagonal line sketched in the corner of the part. This will be 

the sketch profi le of the fi rst rib feature. Select the Rib tool on the Create panel and the 

sketch profi le will be selected automatically.

 2. Select Rib Type from the two buttons on the left side of the dialog box to switch the type 

of rib being created.

Certification
Objective
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Normal To Sketch Plane  Extrudes geometry normal to the sketch plane. The thickness 

is parallel to the sketch plane.

Parallel To Sketch Plane  Extrudes geometry parallel to the sketch plane. The thickness 

is normal to the sketch plane.

 3. Use the direction buttons if needed to ensure that the rib is going from the sketch toward 

the bottom corner of the part.

 4. Set the thickness to 1  mm, and use the arrows to adjust the direction in which the thick-

ness is applied. In this case, you want to use the Midplane option.

 5. Click the OK button, and notice how the rib extends to the profi le.

 6. Next, right-click Sketch3 in the browser, and choose Visibility to make it available for use.

 7. Select the Rib tool again, make sure the Normal To Sketch Plane option button on the left 

of the dialog box is selected, and select the four lines and the ellipse as profi les.

 8. Toggle the Extend Profi le check box off and on to notice the difference in the preview. 

Ensure that this check box is selected so that the profi les do extend.

 9. Set the thickness to 1 mm, and use the arrows to adjust the direction in which the thick-

ness is applied. In this case, you want to use the Midplane option.

 10. To explore the Finite option, click the Finite button and type 3 mm. This holds the depth 

of the ribs to 3 mm rather than allowing them to automatically terminate at the base. Set 

this option back to use the To Next option.

 11. Click the Draft tab and enter 5 deg in the Taper input. Ensure that the Hold Thickness 

option is set to At Root.

At Top  Holds the specifi ed thickness at the sketch plane.

At Root  Holds the specifi ed thickness at the intersection of the rib feature and the ter-

minating face.

 12. Click the Boss tab and make sure the Select All check box is selected. You will see bosses 

added at the locations of the four center points found in the sketch. You can use the 

Centers button to add or remove bosses as needed.

 13. Set Diameter to 4.

 14. Set Offset to 3.

 15. Enter 12 for Draft Angle and then click the OK button to create the webbed rib and bosses 

feature.

To complete the part, you can use the Mirror tool and the XZ origin plane to copy the fi rst 

rib to the opposite side of the part. Once it’s mirrored, you can use the Rectangular Pattern tool 

to pattern the mirror feature 10 mm toward the end of the part. Finally, use the Mirror tool and 

the YZ origin plane to add four identical ribs to the opposite end of the part. Now if you make a 

change to the original rib feature, the copies will update as well. Figure 19.19 shows the fi nished 

example.
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Figure 19.19

Complete rib 

features

Creating Draft Features
Taper or draft often needs to be applied to part faces so the part can be extracted from the mold 

in which it is manufactured. You can create draft features in three different ways:

Fixed Edge  This method works by selecting a pull direction and then selecting the faces/

edges on which to apply the draft.

Fixed Plane  This method works by selecting a fi xed face and applying drafts to the faces 

intersecting it.

Parting Line  This method works by selecting a sketch to defi ne the parting line where the 

top and bottom halves of a mold form would meet.

To explore the Fixed Edge and Fixed Plane methods, open the fi le mi_19a_046.ipt in the 

Chapter 19 directory of your Mastering Inventor 2014 folder, and then follow these steps to 

create draft features:

 1. Select the Draft tool on the Modify tab.

 2. For the Pull Direction selection, click the yellow base face.

 3. To select the faces, you will click the green faces near the edge that contacts the yellow 

base face. If you move your mouse pointer over the faces before selecting them, you will 

see that the edge closest to your mouse pointer will be selected. If you accidentally select 

an extra or errant edge, you can press the Ctrl key and deselect it.

 4. Enter 5 deg for the Draft Angle, and then click the OK button. You’ll notice the top faces 

of the thin walls have been reduced because of the draft taper. To remedy this, you’ll 

place a draft on the outside faces also.

 5. Rotate the part around so you can see the red and blue faces, and then click the Draft tool 

again.

 6. This time, click the Fixed Plane button on the left of the dialog box.
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 7. Select the red face for the Fixed Plane selection, and ensure that the arrow is pointing out.

 8. Select the blue faces for the Faces selection, enter 5 deg for the Draft Angle, and then click 

the OK button.

You can close this fi le without saving changes, and then open the fi le mi_19a_048.ipt in the 

Chapter 19 folder to compare how creating the same tapers is made easier by the inclusion of 

the corner fi llet.

Draft Analysis

You can analyze your part for proper draft using the Draft Analysis tool found on the Inspect tab. 

Th is tool allows you to specify a pull direction and a draft taper to check against. If faces are found 

to be insuffi  cient, they are shown by color variations correlating to departure from the specifi ed 

draft. Th is can be particularly helpful for complex corners and areas of a part where drafted faces 

are blended together.

Once they are created, draft analyses are saved in the browser in a folder called Analysis. You can 

create multiple analyses and turn them on by double-clicking them. To turn existing analyses off , 

simply right-click the Analysis folder and choose Analysis Visibility.

To explore the fi nal method of creating draft features, open the fi le mi_19a_050.ipt from the 

Chapter 19 directory of your Mastering Inventor 2014 folder, and follow these steps:

 1. Select the Draft tool on the Modify tab.

 2. Click the Parting Line button on the left of the dialog box.

 3. For the Pull Direction selection, click the yellow face of the part.

 4. For the Parting Line selection, click the projected loop that encircles the part.

 5. For the Faces selection, choose an outer face of the part.

 6. Click the Asymmetric button so that you have two separate draft angle inputs.

 7. Enter 3 for the fi rst angle and 6 for the second angle, and then click the OK button to cre-

ate the draft feature.

As you can see, creating a draft using the parting line option is quite simple. Creating the 

sketch to use as a parting line is generally done by using the Project Cut Edges option when 

working with a 2D sketch or by using the Include Geometry tool or the Intersection Curve tool 

when working with a 3D sketch. You can open the fi le mi_19a_052.ipt from the Chapter 19 

folder to explore an example of the parting line created from an extruded surface and a 3D 

intersection curve created in a 3D sketch. Figure 19.20 shows a parting line used to create a draft 

feature.
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Figure 19.20

Draft using a part-

ing line

Plastic Parts and Cooling Shrinkage

Designing plastic parts of uniform wall thickness is typically a fairly easy task when the part 

consists of a simple shell. However, when bosses and ribs are introduced, the resulting tees and 

feature intersections can create cross-section thicknesses that are signifi cantly thicker than the 

wall thickness average. As is often the case when modeling 3D parts, there is nothing to tell you 

that the model will not work in the real world other than knowledge and experience. For Autodesk® 

Inventor® Professional users, the Tooling functions that allow mold design include calculations for 

material shrinkage based on the material properties.

Th e issue with adding bosses and ribs arises when the part is cooling after the molding process. 

Uneven part thickness will often result in sinking and deformation where the thicker walls cool 

more slowly than the rest of the part. Th e result can bear a very disappointing resemblance to the 

eye-catching design you intended to create.

To deal with these problem areas, you can do one or more of the following:

 ◆ You can use a textured surface to disguise uneven cooling.

 ◆ You can create cores, corner reliefs, and tee inset features to eliminate thick areas.

 ◆ You can use foam- or gas-assisted molding processes.

 ◆ You can redesign the problem areas to avoid thickened walls.

Although it will certainly vary depending on the materials and process, a rule of thumb is to keep 

tee walls at 60 percent of the standard part wall thickness. As shown here, the feature on the left 

has some obvious problems with areas that exceed a consistent thickness. Th e feature on the right 

has been designed to perform the same function, and yet maintain a desirable wall thickness 

throughout.
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Mold Design Overview
The process of mold design is a complex combination of advanced science and knowledge of an 

individual producer’s equipment and processes, and for the highest quality, it often requires a 

great deal of experience. Too often it isn’t possible to access that experience, and with many com-

panies having their plastic parts injection-molded outside of their own walls, it isn’t reasonable 

to expect to have the thorough understanding of the equipment available. Securing the time and 

expertise of a plastics engineer helps to overcome these issues, but their time is expensive and in 

very high demand. As with the stress analysis tools, Inventor includes tools to help an engineer 

with a lower degree of expertise do a lot of the fundamental analysis to make the best use of an 

expert’s time.

Inventor Tooling
Inventor Professional is an upgrade to the standard Inventor package and includes the Inventor 

Tooling functions used for plastic part analysis and injection mold design. This environment 

allows you to predict how a mold will fi ll and what defects might occur in the part. You can 

review defects such as weld lines and air pockets to decide if you want to change gate placement 

or modify the part being manufactured.

The software includes data for over seven thousand types of resin so you can select the 

appropriate material for the part. This material information affects the quality and fi ll analysis 

settings. The process is fairly straightforward, and the interface allows you to move from step to 

step easily and walks through most of the tools in order.

The process of creating the mold guides you toward a standard component that will accom-

plish your unique design requirement. This is done in a specialized tooling environment. Each 

type of component is listed in the browser as an element of the design rather than just a compo-

nent in the assembly; placing an element may affect several others. The power is in the fact that 

the user doesn’t have to specify these interactions.

If you are using Inventor Professional, you can take a look at some of the tools used in the 

workfl ow to create a mold using the Tooling features. These will be the fi rst tools you will use in 

the exercises to explore designing a mold. These exercises are just an introduction to the Tooling 

toolset. Inventor has several great built-in tutorials to augment this chapter if you want to look 

at some of the advanced features. The intent here is to get you started and introduce the possi-

bilities. Here is a list of the major steps in working with the Inventor Tooling toolset:

Plastic Part  To create a new mold, this is the starting point. This tool will convert an exist-

ing part into a mold design element. Everything else will be built around this part.

Place Core And Cavity  If you have an existing Core and Cavity set, you can import it and 

use it as the basis for the mold design.

Adjust Orientation  To properly align the mold components, an opening direction must be 

established. This orientation can be altered by setting axis directions or rotating the part.

Select Material  To properly adjust for shrinkage and to load temperature properties for 

simulation, you must select the material the component will be made of.
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There are a few tools that you can select in different stages depending on your preference. 

For example, you can place a sketch to defi ne your runner before or after the core and cavity 

have been calculated. These tools are as follows:

Manual Sketch  This tool is a fl yout option under the Auto Runner Sketch tool. It can also 

be used to create a runner sketch, but it is used to sketch complex cooling line routes as well.

Runner  Many of the standard runner shapes can be applied to the core, cavity, or both sides 

of the mold. These shapes have additional options such as applying a cold slug to the end of 

the runner.

Gate  Like the Runner, the Gate has a selection of the common gate types. You can enter val-

ues to modify their size to suit.

Importing a Plastic Part
You will now start the process of defi ning the plastic part and the material that will drop out of 

the mold in the context of the mold design:

 1. In the New File dialog box, click the Metric node in the left pane, and then select the Mold 

Design (mm).iam template.

 2. Give the new design the name Mastering Inventor Tooling.

 3. Click the Browse button to specify the save location for the fi les that will be generated for 

this mold design.

 4. Select the Chapter 19 directory and then create a new folder called MI_Tooling_054.

 5. Select this folder and click Save to return to the previous dialog box.

 6. Check the fi lename and fi le location path, and click the OK button to create the mold 

assembly fi le.

Two new tabs have been added to the ribbon: Mold Layout and Mold Assembly. Keep in 

mind that you may need to manually switch tabs to access certain tools at different times, 

depending on the tasks and the order in which you work. Other tabs will be created dur-

ing the mold design process as well. Next, you’ll import a plastic part to work with.
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 7. Click the Plastic Part button in the Mold Layout tab and select the fi le mi_19a_054

.ipt. Then click Open to import the fi le, right-click and make sure the Align With Part 

Centroid option is selected, and then select Finish.

 8. Select the Adjust Orientation tool from the Mold Layout panel. The preview of the 

Opening Direction will appear. Using the Flip button in the dialog box, fl ip the Z direc-

tion of the part so your preview looks like Figure 19.21.

Figure 19.21

Setting the opening 

direction

 9. Click the OK button when the direction has been properly set.

 10. Click the Select Material button from the Mold Layout panel and change the manufac-

turer to BASF, and the Trade Name to Terluran GP-22; then click the OK button.

 11. Rotate the model so you can see the bottom of the part.

 12. On the Runners And Channels panel, click the fl yout under the Auto Runner Sketch but-

ton and select the Manual Sketch button.

 13. In the resulting dialog box, ensure that the Runner Sketch option is selected and select 

the bottommost face on the part, as shown in Figure 19.22. Click the OK button to create 

the sketch.

 14. Use the Project Geometry tool to project the x-axis (found in the Origin folder) and the 

leftmost edge of the part into your sketch, and then draw a line segment along the x-axis 

13 mm long and 6 mm from the left edge of the part, as shown in Figure 19.23.

 15. When the line is complete, right-click and choose Finish 2D Sketch, and then right-click 

again and choose Finish Edit to return to the Mold Layout tools.
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 16. Save your work, and you will notice that a number of components are being created. Note 

too that these fi les are being saved in the mold design directory you created.

Figure 19.22

Creating a runner 

sketch

Figure 19.23

Dimensioning the 

runner
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In this case you’ve created the runner sketch before creating and calculating the core and 

cavity. Although you are not required to work in this order, it can help to visualize how the run-

ner and gate material will appear attached to the part when it drops from the mold. This is the 

approach you will take for the next exercises. You can close the fi le you have open and continue 

on to explore the creation of runners and gates.

Creating Runners and Gates
Now you will place the runner and gate. To continue, open the fi le mi_19a_056.iam from the 

Chapter 19 directory of your Mastering Inventor 2014 folder. This fi le picks up where you 

left off in the previous exercise:

 1. On the Runners And Channels panel, click the Runner button to bring up the Create 

Runner dialog box.

 2. Set Section Type to U Shape.

 3. Use the radio button to set the runner to be created on the cavity side.

 4. Set the diameter to 3 mm.

 5. Select the 13 mm sketched line for the path selection. Be sure to select it on the end far-

thest from the part. Selecting the line toward the other end creates the runner turned 

in the opposite direction. If you select the wrong end, just hold the Ctrl key and click it 

again to deselect it; then try again.

 6. For Segment1, set the Cold Slug Length to 4 mm.

 7. Check your settings against Figure 19.24, and then click the OK button to create the 

runner.

Figure 19.24

Placing the runner

If you expand the Runner node in the browser, you will see your runner and runner 

sketch listed. You can double-click or right-click them to edit if changes are required. 

Next, you’ll get ready to add a gate.
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 8. On the Runners And Channels panel, click the Gate Location button.

 9. Select the bottom-left edge of the part. This is the edge with a sketch line running along it 

from the runner sketch. You can also use the ViewCube to verify the edge location where 

the left and bottom views intersect.

 10. A ratio will appear in the dialog box. Set this to 0.5, meaning the gate will be placed half-

way along the length of the edge. The preview should show an X at the intersection of the 

runner sketch lines.

 11. Click Apply to create the gate location, and then click Done to close the dialog box.

Now you will add the gate. There are a lot of options, so this will take several steps.

 12. Click the Gate button to open the Create Gate dialog box.

 13. Ensure that Type is set to Edge and then set the Up/Down radio button to Up.

 14. Set Placement to Two Points. Inventor will start looking for the gate location.

 15. Select the work point that displays the gate location you previously defi ned.

 16. Once the work point is selected, Inventor will want the endpoint. Select the end of the 

runner sketch nearest to the part (this correlates to the 6 mm offset dimension).

 17. In the dialog box, set the value of W1 to 22.

 18. Set H1 to 12.

 19. Set W2 to 15.

 20. Set H2 to 6 and compare your inputs to Figure 19.25.

 21. Click the OK button to create the gate when everything appears correct.

Figure 19.25

Placing the gate 

between the part 

and runner

In the previous steps, you explored the creation of runner and gate features. Although these 

features have many variations, the basic selections and steps to create them are the same. You 
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can close the current fi le without saving changes and continue to the next section, where you 

will explore core and cavity design.

Analyzing and Creating Cores and Cavities
Now that you have defi ned your part’s material and how you want the plastic to fl ow into the 

mold, the next step is to begin defi ning the mold itself. Keep in mind that all of the geometry 

you’ve been working on so far will become a void in the components you are about to create.

The tools needed to determine whether the part will fi ll properly and to establish the geom-

etry of the core and cavity are more automated than other tools in Inventor. These tools will also 

inform you if you have missed a step in the process. Here is a brief overview of some of them:

Part Process Settings  Optimal values for the mold temperature and pressures are loaded 

from the material information. This dialog box allows you to make modifi cations to accom-

modate your equipment if need be.

Part Fill Analysis  Inventor Tooling has the ability to analyze the fi ll time, quality, and other 

important considerations regarding where weld lines may appear or air traps may occur.

Defi ne Workpiece Setting  Establishing the size of the tool from which your core and cavity 

will be cut is an important step. You must accommodate the runner and eventually the com-

ponents of the assembly that move the material to the cavity.

Create Runoff Surface  A runoff surface can be seen as an extension of the parting line. It is 

the surface that will be used to divide the workpiece so the parts of the mold can separate.

Generate Core And Cavity  This tool launches you into another environment that is 

focused on the how the workpiece will be modifi ed to create the void for the plastic to fi ll.

To continue, open the fi le mi_19a_057.iam from the Chapter 19 directory of your Mastering 

Inventor 2014 folder. This fi le picks up where you left off in the previous exercise. To create the 

core, cavity, and other components, you will fi rst need to change the environment in which you 

are working:

 1. On the Mold Layout panel, click the Core And Cavity button. This brings up the Core/

Cavity tab, which gives you access to the tools needed to create the workpiece that will be 

added to the mold base to complete the design.

 2. Select the Gate Location button on the Plastic Part panel to place the gate in the work-

piece. Note that these steps will be the same as those you followed in the previous 

exercise.

 3. Select the bottom-left edge of the part near the visible work point.

 4. Set the ratio to 0.5 to place the gate halfway along the length of the edge.

 5. Click the Apply button to create the gate location, and then click Yes when warned about 

the existing analysis results. Then click Done to close the dialog box.

 6. Select the Part Process Settings button from the Plastic Part panel. Review the settings 

and then click the OK button to accept the default and close the dialog box.
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 7. Select the Part Fill Analysis button from the Plastic Part panel. Understand that this 

analysis may take some time to run, so if you prefer, you can just click Close and skip this 

step. If you’d like to run an analysis yourself, click Start, and then click the OK button in 

the message box letting you know that the analysis is running.

 8. When the analysis is complete, a summary showing the results will appear. If you 

skipped the previous step, you can view a previously prepared results summary. To do 

so, expand the node for mi_19a_054 in the browser, and then expand the Results node 

and then the Fill node. Click the Summary node to bring up the results summary.

In Figure 19.26, you can see that the part can be fi lled, but there is concern about the qual-

ity obtained from the current setup.

Figure 19.26

Part fi ll analysis 

summary

 9. Click Cancel to close the summary.

 10. Double-click Fill Time in the browser to display the graphic in the design window 

(Figure 19.27).
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Figure 19.27

Fill time analysis 

results

 11. Select the Defi ne Workpiece Setting button on the Parting Design panel and set the fol-

lowing values, as shown in the lower right of Figure 19.28:

Figure 19.28

Setting the work-

piece size values

 ◆ X_Total value to 150

 ◆ Y_Total value to 75

 ◆ Z_Total value to 30

 12. Click the OK button to preview the workpiece in the design window.

 13. Select the Create Runoff Surface button on the Parting Design panel.

 14. In the upper-left corner of the Create Runoff Surface dialog box, select the Auto Detect 

button to allow Inventor to search for the best parting line and create the runoff surface. 

The result should appear similar to Figure 19.29.
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Figure 19.29

Generating the run-

off  surface for split-

ting the mold

 15. Click the OK button to create the parting surface that will divide the core and cavity.

 16. Click the Generate Core And Cavity button found on the Parting Design panel.

 17. In the resulting dialog box, click the Preview/Diagnose button. This will preview the core 

in blue and the cavity in green.

 18. Drag the Body Separation slider to the right and back to show how the parts will 

separate.

 19. Click the OK button to generate the two parts.

On occasion, the runner and gate information created beforehand does not update with 

the generation of the core and cavity. Select the Mold Update tool from the Quick Access 

bar to bring this data up into the cavity side of the workpiece.

 20. Click the Finish Core/Cavity button at the end of the ribbon to return to the Mold Layout 

tools and compare your work to Figure 19.30. You can close this fi le without saving 

changes, and continue to the next section.

Figure 19.30

Th e completed 

workpiece
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Working with Mold Bases
Now that the workpiece is complete, you can focus on generating the rest of the mold. These 

tools are located on the Mold Assembly tab. The tools in this tab are focused on the tools needed 

by manufacturing to generate the part effi ciently. Inventor Tooling contains tens of thousands 

of parts for mold bases, as defi ned by the manufacturers. This works like a design accelerator to 

keep you from specifying something that will be a custom order or an inaccurate component. In 

the following exercise, you will focus on creating a mold base.

You will now build the entire mold base in just a few steps with minimal input and effort. 

This is a great example of how the functional design approach can work for you. To get started, 

open the fi le mi_19a_059.iam from the Chapter 19 directory of your Mastering Inventor 

2014 folder, and then follow these steps:

 1. Switch to the Mold Assembly tab on the ribbon.

 2. Click the Mold Base button in the Mold Assembly panel to open the Mold Base 

dialog box.

 3. The Mold Base dialog box allows you to select from a huge library of standard mold 

base designs and to select options within those base designs. The following steps use 

items from the Content Center Mold database. To ensure that you can access these fi les, 

check your project and make sure the libraries are loaded. You can do so by selecting the 

Projects button on the Get Started tab, clicking the Confi gure Content Center Libraries 

button (in the lower-right corner), and selecting the Inventor Mold libraries.

 4. From the Vendor And Type drop-down, select the DME; then click the Query button and 

select the type E base. Note that if you have previously selected the Immediately Query 

check box, you will not need to click the Query button.

 5. Set the size to 346 mm × 346 mm.

 6. Expand the dialog box by clicking the double-arrow icons on the top- or bottom-right 

edge of the dialog box.

 7. Expanding the dialog box will show the list of components included in the mold base.

 8. Select the part labeled E 400 346X346X76.

 9. Once the part is selected, several buttons appear for that row. Select the button with the 

ellipsis (three dots; the tool tip will say Property Settings). This will launch a dialog box 

for changing options (if any exist).

 10. Click the H_value and change it in the drop-down list from 76 mm to 56 mm, as shown in 

Figure 19.31.

 11. Click the OK button to close the dialog box. Inventor will update the E400 plate’s descrip-

tion and the preview in the dialog box.

 12. Click the Placement Reference button and select the bottom point in the front-left corner 

of the workpiece (use the ViewCube for reference to fi nd the left and front sides).

 13. You will see a preview outline of where the mold base will be positioned around the 

workpiece. Make sure the workpiece appears inside the rectangle.
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Figure 19.31

Changing the mold-

base components

 14. Once you’ve verifi ed that the workpiece appears inside the rectangle, click the OK button 

in the dialog box to generate the mold base.

 15. If the Mold Update button becomes visible in the Quick Access bar, click it and compare 

your work to Figure 19.32.

Figure 19.32

Th e mold base after 

placement
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You may not have been expecting the entire mold base to be generated, but since the compo-

nents are purchased, it makes sense to place them as a unit as they would be assembled. You can 

close this fi le without saving changes and continue to the next section.

Working with Ejectors and Sprue Bushings
You will now complete one last series of steps to see the fi nal critical details of placing ejectors 

and the sprue bushing:

Ejector  Accessing the library of standard ejector pins is only part of this tool. It will make it 

easy for you to properly align the pins based on the center of the component, using a coordi-

nate system that is used by the toolmakers.

Sprue Bushing  This tool places the standard sprue bushing based on the location of the 

runner, simplifying the process of placement and improving the quality.

To get started, open the fi le mi_19a_060.iam from the Chapter 19 directory of your 

Mastering Inventor 2014 folder. Then follow these steps:

 1. On the Mold Assembly tab, select the Ejector button.

Doing so clears the screen of everything but the original part and runoff surface. It also 

opens the Ejector dialog box, which contains standard ejector pins and their optional 

sizes.

 2. Leaving the options at the default, click on the plastic part to place four ejectors. You can 

choose four approximate locations between the pairs of ribs, as shown in Figure 19.33.

Figure 19.33

Placing the ejectors

 3. Click the >> button in the dialog box and set the values to 33 mm or −33 mm for the 

X column and 17 mm or −17 mm for the Y column.

The order in which you placed your ejectors might cause your positive or negative values 

to differ, but entering the inputs as shown will give you the correct result.

 4. Set the diameter (d1 value) to 2 mm and the length (L value) to 100  mm, and then click 

the OK button to place the ejectors in the mold.
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Placing the ejector will cause Inventor to make clearance cuts in other plates, and cut the 

length or even the contour of the ejector to prepare all of the components in the mold 

base. Select any of the pins in the browser to show how they terminate at the core face of 

the mold.

Next, you’ll place a sprue bushing and a locking ring.

 5. On the Mold Assembly tab, click the Sprue Bushing button. It will be looking for a point 

from which to locate.

 6. Select the visible sketch center point at the end of the runner sketch farthest from the 

part.

 7. Set Type to DME AGN.

 8. Set the length (L value) in the dialog box to 76 mm using the drop-down.

 9. For an offset value, enter −14 mm.

 10. Click the OK button to place the bushing and cut the clearance geometry in the relevant 

parts.

 11. Select Sprue Bushing in the Design window.

 12. Right-click and select Open from the context menu.

 13. Rotate the part to see how the runner geometry has been cut from the bushing, as shown 

in Figure 19.34.

Figure 19.34

Th e runner geom-

etry is cut into the 

sprue bushing.

 14. To return to the assembly, close the Sprue Bushing part and do not save changes.

 15. Click the Locating Ring button from the Mold Assembly panel.

 16. Set the type to Rabourdin 646-Type B and choose the top of the base face (green plate).

 17. Set the D2 value to 32 mm and the A_ value to 22.5 mm, and then set the offset value to 

−22.5 mm.

 18. Click the OK button to place the ring into the assembly.

The fi nished base should look like Figure 19.35.
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Figure 19.35

Th e fi nished base

Through use of functional design techniques, the most tedious steps of designing a mold 

are eliminated or greatly simplifi ed. You can close this fi le without saving changes, explore the 

Inventor Tooling tools with your own design, and take advantage of just how easy it is to create 

a complex mold design.

You can also fi nd additional mold and tooling tutorials built right into Inventor by clicking 

the Tutorials button on the Get Started tab.

Th e Bottom Line

Create thicken/offset features.  When creating plastic parts, you will often fi nd that work-

ing with surfaces allows you to achieve more free-form shapes than working with solids. 

Once the surfaces are created, you’ll need to give them a thin wall thickness.

Master It  How would you create a plastic part fi le with many curved, free-form 

elements?

Create shell features.  Shelling solids parts and features is a common way to create base 

features for plastic parts. Once the shell feature is created, other features can be added to it.

Master It  You want to create a shell feature but need to have some faces be thicker than 

the rest. How would you accomplish this?

Create split features.  Many times you may want to establish the overall shape of a feature 

and then divide the shape into separate parts of the overall design. You can use the Split tool 

to do just that and more.

Master It  You have a plastic part that needs to have a raised face for a rubber grip ap-

plied during the manufacturing process. How would this be done?
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Create grill features.  Grill features allow the infl ow or outfl ow of air through a plastic 

thin-wall part. Grills can be created with a number of subfeatures such as islands, ribs, and 

spars, but only the outer profi le of the grill is required.

Master It  How would you determine the area of a grill opening based on the airfl ow it 

needs to handle?

Create rule fi llet features.  Rule fi llets can be an extremely effi cient way to apply fi llets 

throughout the design to many edges that meet the same rule criteria.

Master It  How would you apply fi llets to all of the edges that are generated by extrud-

ing a shape down to an existing set of base features?

Create rest features.  Rest features can be used to create level platform faces for mounting 

other parts to an irregular plastic part face.

Master It  You want to create a rectangular pocket on the inside of a plastic housing to 

hold an electronic component. How would you do this?

Create boss features.  Boss features are ideal for creating fastener-mounting standoffs for 

thin-wall plastic parts. You can use the Boss tool to create both halves of the fastener boss.

Master It  You want to create multiple boss features around the perimeter of a fl at, pan-

type base part, but you know this base part is likely to change size. How would you set 

up the boss features to adjust to the anticipated edits?

Create lip and groove features.  When designing plastic parts, you may need one half of a 

design to fi t into the other half. The Lip tool allows you to create both lip and groove features 

for these situations.

Master It  You want to create a groove around the edge of an irregular, curved edge. 

How can you ensure that the lip on the corresponding part will match?

Create snap fi t features.  Snap features are a common way to join plastic parts together so 

that they can be disassembled as needed. You can use the Snap Fit tool in Inventor to quickly 

create these features.

Master It  How would you create a U-shaped snap fi t with the Snap Fit tool?

Create rib and web features.  Ribs and webs are often used to add rigidity and prevent 

warping during the design of plastic parts. You can add ribs based on open profi le sketches 

in Inventor.

Master It  How would you create a network of ribs that are evenly spaced, with some of 

them containing different cutouts than others?

Create draft features.  Because plastic parts must be extracted from a mold during the 

manufacturing process, drafted faces must be included to ensure that the parts can indeed be 

extracted from the mold.

Master It  You want to create drafted faces on a complex part containing various shapes 

within it. How would you do this?

Create an injection mold.  To generate the components you have designed with the plastic 

part features, you need to properly defi ne the cavity to create the part and defi ne how the 

material will fl ow into the cavity.

Master It  You want to create a mold base design in an effi cient manner using parts that 

can be purchased.





Chapter 20

iLogic

In this chapter, you will explore the use of iLogic to confi gure your models with intelligence 

and automation. iLogic is often used to speed up tedious design tasks, to enforce consistency 

across designs, and to allow the logic of programming to make design decisions based on pre-

determined design rules. Although this chapter focuses primarily on using iLogic in the parts 

environments, the fundamentals you’ll learn will apply to the assembly and drawing environ-

ments as well.

In this chapter, you’ll learn to:

 ◆ Create iLogic rules

 ◆ Edit iLogic rules

 ◆ Use multi-value list parameters

 ◆ Work with multiple rules in the same fi le

 ◆ Use conditional statements

 ◆ Suppress features

 ◆ Work with iProperties

 ◆ Create iLogic forms

 ◆ Build a part confi guration form

What Is iLogic?
iLogic is a programming add-in that is included with the Autodesk® Inventor® software. It 

extends and enhances the design capabilities and allows you to automate tedious design tasks. 

By creating custom iLogic code, you can add higher levels of design intelligence to your models. 

Using the iLogic tools, you can create simple, rule-based logic to set and drive parameters and 

properties in your designs. iLogic rules can be embedded directly into individual Inventor fi les, 

or they can be saved externally where they can be accessed by all of your Inventor fi les. iLogic 

uses custom parameter types to allow you to customize more than just the numeric data avail-

able with standard Inventor model parameters. These types include Text parameters, True/False 

parameters, and multi-value list parameters.

To understand how iLogic works, you need to think in terms of design rules. Most design 

departments already have certain design rules they follow when creating parts and assemblies. 
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For instance, suppose a design requires a minimum hole spacing to ensure a strong connection. 

If a part length causes the spacing to exceed the minimum hole spacing, then another hole is 

added.

Currently, you might follow these rules manually as you design, but with the use of iLogic, you 

can add the rules to the model fi le so that the design rules are implemented automatically. You can 

even have rules trigger other rules so that a cascade of decisions is made based on initial input from 

the user.

Understanding iLogic Rules
An iLogic rule can be thought of as a small Visual Basic .NET “program” created and used to 

monitor and control Inventor objects such as parameters, features, and components. A rule can 

determine and/or set design parameters within your model. This allows you to control the val-

ues of the model automatically, based on conditions and inputs.

For example, you might have a product line offered to your customer in standard cataloged 

sizes, with standard features included or excluded based on the size and application. But you also 

offer this same design in custom sizes when needed. With traditional Inventor tools, you would 

determine if the requested size is standard, and if it is not, you would create a new custom-size 

component to fi t the need. Once the size is determined, you would decide to include or exclude 

features per your design guidelines and then include other features based on the specifi c applica-

tion of this custom design.

Because the process of confi guring your product line relies on your experience and memory, 

it might be time consuming and error prone, particularly if you need to have another Inventor 

user, with less experience with your product, create the design. You can use iLogic to set up a 

collection of rules in a template fi le. The fi rst rule might allow you to input the requested size 

using a customized dialog form. Another rule would determine whether the requested size is 

an existing standard size or a new custom one. If it is a custom size, a part number and descrip-

tion are automatically generated to honor your standard nomenclature. Yet another rule would 

then determine if standard features are included or excluded based on the size (for example, if 

the hole spacing exceeds X, add another hole). And fi nally, another rule might be invoked to add 

application-specifi c features (for example, add left-hand switch mounting holes, if the custom 

design is for a left-hand application).

What Are Functions?
A function is an instruction created and used within a rule to modify the Inventor model or 

read some data from the fi le. When a rule is run, the functions within it are executed. The pre-

defi ned iLogic functions follow VB.NET syntax and require the coding to follow the syntax to 

work. This syntax is made up of the function category, function name, and function arguments.

In the previous example, where the goal was to create a collection of rules to determine a 

standard or custom size, the fi rst rule would control the dialog box to collect the input from the 

user. So a function would be added to call an input box function and then assign the collected 

input to an Inventor parameter. Here is an example of an input box function used to prompt the 

user for a width value:

myWidth = InputBox(“Please Enter A Width”, “Width Input”, “750”)
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The resulting input box displays as shown in Figure 20.1 and creates a return value called 

myWidth, which is set to the value the user enters into the input box. In this case, the default 

value has been set to 750. So if the user were to accept the default value by clicking the OK but-

ton, myWidth would be set to 750.

Figure 20.1

A basic iLogic input 

box

You might include multiple functions in the same rule, depending on its complexity. When 

doing so, you will typically place functions in order so that information is created or gathered 

from one function and then used later by another function. Typically, each function is indepen-

dent of the remaining code in the rule.

To use the myWidth value from the previous example, you could create a second function to 

set the Inventor parameter controlling the width of the part equal to myWidth. Here, the Inventor 

parameter is a dimension in a sketch that has been named Wid1:

myWidth = InputBox(“Please Enter A Width”, “Width Input”, “750”)

Parameter(“Wid1”) = myWidth

There are several categories of functions provided in iLogic. All of the available functions can 

easily be found when creating rules by expanding the function category node found in the rule 

editing interface. Here is the list of iLogic categories:

Parameter functions Variables functions

Document functions iFeature functions

Feature functions Material Properties functions

Run Other functions Assembly Constraint functions

Component functions Sheet Metal functions

BOM functions Measure functions

iProperties functions Drawing functions

Math functions Work Feature functions

Excel Data Links functions Advanced Drawing API functions

String functions Message Box functions

iPart and iAssembly functions Advanced API functions
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Working with Function Arguments and Data Types

Within functions, you can also have arguments. An argument is a value that is sent to the func-

tion when it is called. Passing an argument to a function gives the function information to work 

with. An argument can be one of the following data types:

Text  Any value specifi ed inside double quotes

Boolean  A value of True or False

Numeric  Any numeric value

Set Values with Functions

Have a look at this example to see the text string and Boolean data types in use:

Feature.IsActive(“Hole1”) = False

Here, the function category Feature is being used. The Feature function IsActive is 

instructed to look for the feature called Hole1, and then the False argument tells the function 

to suppress Hole1. If the Boolean were set to True, then the hole would be set active or not sup-

pressed. You’ll notice Hole1 is set inside double quotes, thereby specifying it as a text string.

Next, look at this example to see numeric data in use:

Parameter(“Diameter1”) = 4.4

Here, the Parameter function is being told to look for the feature called Diameter1 and then 

use 4.4 as the value. In both of these examples, the function is setting a value. In addition to set-

ting values, you can retrieve or get values using functions.

Get Values with Functions

In the following examples, you’ll look at how to get a value from a function. You’ll start off with 

the reciprocal function for the previous function involving Diameter1:

Current_Dia = Parameter(“Diameter1”)

Here, the Parameter function is being told to create a return value placeholder called 

Current_Dia and then set it to the parameter called Diameter1. Next, look at an input box 

function:

Wid1 = InputBox(“Please Enter A Width”, “Width Input”, Wid1)

In this function, the return value happens to be an Inventor dimension parameter named 

Wid1, which is a sketch dimension defi ning the width of the part. The input box reads the Wid1 

parameter into the default value (on the far right) so that the user is presented with the current 

width and at the same time is prompted to enter a new value. When the user clicks the OK but-

ton, the input box value is written to the Inventor dimension parameter named Wid1.

Here is an example comparing the use of functions to get and set information:

iProperties.Value(“Project”, “Revision Number”) = 2

RevNumber = iProperties.Value(“Project”, “Revision Number”)

In the fi rst line, the function is being given the arguments Project and Revision Number 

to specify that the iProperty be set to 2. In the second line, the return value called RevNumber 
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is being set to the current Revision Number iProperty for the fi le. Again, it uses the arguments 

Project and Revision Number to tell the iProperty collection which iProperty to read.

Conditional Statements
You use conditional statements to put the logic in iLogic. The conditional statements evaluate the 

present state of the model and execute logic depending upon that state. For example, if the hole 

spacing in a part exceeds a minimum value due to a change in length, then another set of holes is 

required:

Space1 = Parameter(“Hole_Space”)

If Space1 >= 45 Then

Feature.IsActive(“Hole2”) = True

Else

Feature.IsActive(“Hole2”) = False

End If

In the fi rst line, a return value parameter named Space1 is set to the model parameter called 

Hole_Space. Then, Space1 is evaluated to determine if it is less than or equal to 45. If so, it is set 

to be active (not suppressed). Otherwise, it is suppressed. The following sections include exam-

ples of each of the available conditional statements.

If, Then, Else Statement

If, Then, Else is probably the most common of the conditional statements. It tests for a con-

dition and then applies one or more actions if the condition is found to be true; otherwise, it 

applies one or more other actions:

If <condition> Then

<action if true>

Else

<action if false>

End If

If, Then Statement

If, Then tests for a condition and then applies one or more actions if the condition is found to be 

true. If the condition is not true, then nothing happens.

If <condition> Then

<action if true>

End If

What Are Comments?

Text preceded by an apostrophe in iLogic is interpreted as a comment and not as code. You can 

use this to your advantage by adding notes to your iLogic code to make it easier to understand.
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Null Statement

A null If, Then tests for a condition and then applies no action if the condition is found to be true 

(the ‘do nothing in the following statement is simply a comment and could be omitted). If the 

condition is not true, one or more actions are applied:

If <condition> Then ‘do nothing

Else <action if false>

End If

Single-Line If Statement

You can use a single-line If statement when testing a simple, short condition with short true 

and false statements. Single-line If, Then tests for a condition and then applies one or more 

actions if the condition is found to be true. If the condition is not true, then nothing happens:

If <condition> Then <action if true> Else <action if false>

If, Then, ElseIf Statement

Using the If, Then, ElseIf format, you can add as many conditions as you want. Here is the 

format when three conditions are being tested. If, Then, ElseIf tests for a condition and then 

applies one or more actions if the condition is found to be true. If not true, it tests another condi-

tion, and so on. If none of the tested conditions are found to be true, it applies one or more other 

actions. If no fi nal action is specifi ed, nothing happens unless one of the conditions is found to 

be true:

If <condition 1> Then

<action if condition 1 is true>

ElseIf <condition 2> Then

<action if condition 2 is true>

ElseIf <condition 3> Then

<action if condition 3 is true>

Else

<action if none of the above conditions is true>

End If

Select Case Statement

The Select Case statement is another way to test what is inside a variable. You can use it when 

you know there are only a limited number of values that the variable could hold:

Select Case <test expression>

Case <expression list 1>

<statement list 1>

Case <expression list 2>

<statement list 2>

Case Else

<statement list n>

End Select
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For instance, if a multi-value list parameter named Part_Size consisted of a list containing 

Small, Medium, and Large, you could set the test expression to Part_Size and set up three cases 

called Small, Medium, and Large, as shown here:

Select Case Part_Size

Case “Small”

Len = 50

Wid = 40

Case “Medium”

Len = 75

Wid = 65

Case “Large”

Len = 100

Wid = 90

End Select

When the Part_Size parameter is set to Small, the case named Small is selected and the Len 

and Wid parameters are set to the values corresponding to the small size.

Understanding the iLogic Elements and Interface
There are two primary areas within Inventor used to create and manage iLogic rules: the 

Parameters editing dialog box and the iLogic browser. The Parameters dialog box is used to create 

and edit parameters to be used in iLogic, and the iLogic browser allows you to create and manage 

rules. Figure 20.2 shows the Parameters button, accessed from the Manage tab, and Figure 20.3 

shows the iLogic Browser button, also accessed from the Manage tab.

Figure 20.2

Th e Parameters 

button

Figure 20.3

Th e iLogic Browser 

button
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Exploring iLogic Parameter Types
Recall that Inventor has three types of parameters:

 ◆ Model parameters are created by dimensions and feature inputs.

 ◆ Reference parameters are created from driven dimensions.

 ◆ User parameters are created by you, the user.

Within the user parameter category, you can create three parameter types: the Text parameter, 
the True/False parameter, and the Numeric parameter. The Numeric parameter can be referenced 

into your Inventor model using the standard Inventor tools, but the Text and Boolean param-

eters can be used only with the iLogic tools.

To create user parameters and specify the type, you use the drop-down list in the Parameters 

dialog box, as shown in Figure 20.4.

Figure 20.4

User parameter 

types

Text Parameters

A Text parameter is any value specifi ed within double quotes. For instance, if you wanted to 

use product names in an iLogic rule to fi ll out iProperty information, you could create a Text 

parameter to contain that information. Keep in mind that you can create a Text parameter using 

numeric data by enclosing it in double quotes. For instance, Inventor will read “22 mm” as a text 

string but 22 mm as numeric data. Text parameters can be set to be multi-value list parameters 

or used as static, single-value parameters.

True/False Parameters

True/False parameters fall within the Boolean data type. They have only two states: True and 

False. A True/False parameter would be used, for example, when asking a user a question. 

Figure 20.5 shows an input box with two radio buttons. Depending on which the user chooses, a 

True/False parameter named Part_Type is toggled.
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Figure 20.5

An input box used 

to toggle a True/

False parameter

Here is the iLogic rule that produces the input box and then sets the True/False parameter 

named Part_Type. The Part_Type parameter is then used to set the material iProperty of the 

part fi le:

Part_Type = InputRadioBox(“Choose Manufacturing Type”, “Machined”, “Cast”, _

Part_Type, Title:= “Select Part Type”)

If Part_Type = True Then

iProperties.Material = “Aluminum-6061”

ElseIf Part_Type = False Then

iProperties.Material = “Cast Steel”

End If

Numeric Parameters

Numeric parameters are the parameters used by Inventor sketch dimensions and feature dialog 

box inputs. When you create a sketch dimension and input value, you are creating a Numeric 

parameter. You can create Numeric user parameters to hold formulas, which are then called 

into sketch dimensions, and so on. In addition to using Numeric parameters with the standard 

Inventor modeling tools, you can use them with iLogic. Numeric parameters can be set to be 

multi-value list parameters or used as static, single-value parameters.

Note that you can add unit strings to Numeric parameters and Inventor will still read them 

as numeric. For instance, Inventor will read 45 mm as numeric data. If the model length unit is 

set to millimeters, Inventor will read 45 as numeric data and assume millimeters. Recall that 

you can set the default units for any model fi le by selecting the Tools tab, clicking the Document 

Settings button, and then selecting the Units tab.

Multi-Value Lists

Text and Numeric parameters can consist of a single, static value or can be made into a multi-

value list. To create a multi-value list, follow these general steps:

 1. On the Manage tab, click the Parameters button.

 2. In the Parameters dialog box, choose Add Text or Add Numeric from the drop-down at 

the bottom left.

 3. Name the Text parameter as you see fi t (recall that spaces are not allowed in parameter 

names, but you can use an underscore).
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 4. Right-click the new parameter and choose Make Multi-Value.

 5. Enter values into the list editor to populate your list.

Figure 20.6 shows a multi-value list for product names being populated. The values on the 

bottom have already been added; the ones on the top are being entered.

Figure 20.6

Populating a multi-

value list

Once the multi-value list is populated, you can add or remove entries by right-clicking the 

parameter and choosing Edit Multi-Value List, as shown in Figure 20.7.

Figure 20.7

Editing a multi-

value list

Key Parameters

You can designate some parameters as Key parameters to aid in the placement of iLogic com-

ponents into an assembly later on. For instance, if you had a part fi le with 50 parameters in it, 

you’d likely want to designate only a small number of those as key parameters. This allows you 

to choose which parameters the user can adjust during the fi le placement, and it streamlines the 

process as well. To set a parameter to be a key, click the Filter button found at the lower left of 

the Parameters dialog box.

Using the iLogic Browser
The iLogic browser is the interface item used to create, edit, and manage rules and forms within 

Inventor. You can access the iLogic browser from the Manage tab by clicking the iLogic Browser 
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button found on the iLogic panel, as shown previously in Figure 20.3. Once it’s displayed, you 

will fi nd four tabs in the iLogic browser:

 ◆ Rules

 ◆ Forms

 ◆ Global Forms

 ◆ External Rules

The Rules Tab

The Rules tab allows you to add, edit, run, regenerate, suppress, and delete rules. When rules 

are created, they are automatically listed in the Rules tab; therefore, the Rules tab will always list 

all rules embedded in the current document.

Adding Rules

To add a new rule to an Inventor fi le, right-click anywhere in the Rules tab of the iLogic browser 

and choose Add Rule (Figure 20.8).

Figure 20.8

Choose Add Rule 

from the browser to 

begin creating an 

iLogic rule

Alternatively, you can use the Add Rule button on the iLogic panel of the Manage tab. The 

fi rst step to adding a rule is entering a name for the rule in the Rule Name input box. Once the 

name is entered, you are presented with the Edit Rule dialog box, where you can build the rule. 

You’ll explore the creation of rules in the coming pages.

Editing Rules

To edit an existing rule in an Inventor fi le, right-click the rule in the Rules tab of the iLogic 

browser and choose Edit Rule (Figure 20.9). You will be presented with the Edit Rule dialog box, 

where you can make changes to the rule. The section “Creating iLogic Rules” later in the chapter 

shows how to build rules in this dialog box.

Figure 20.9

Choosing to edit an 

iLogic rule from the 

browser
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The Forms Tab

The Forms tab allows you to add iLogic user input forms. These forms are built using the iLogic 

Form Editor, which makes creating customized user input forms remarkably easy. You’ll work 

with the Form Editor in “Creating iLogic Forms.”

Adding Forms

To add a new form to an Inventor fi le, select the Forms tab in the iLogic browser, right-click in 

the tab, and choose Add Form (Figure 20.10).

Figure 20.10

Choosing to add an 

iLogic form from 

the browser

You can also add forms by selecting the Manage tab, clicking the drop-down found on the 

iLogic panel, and then clicking the Add Form button. When using this method, you’ll have an 

option to choose whether the form is intended to be embedded in the current document or to be 

a global form used by all documents.

Editing Forms

To edit an existing form in an Inventor fi le, right-click the Form button in the Form tab and 

choose Edit (Figure 20.11).

Figure 20.11

Choosing to edit an 

iLogic form from 

the browser

The Global Forms Tab

The Global Forms tab lists all the rules stored outside of Inventor, independent of the actual 

Inventor fi le you are working on. Global forms can be used when you want to use the same form 

across multiple rules so that you don’t need to create the form over and over again. They also 

help promote consistency, and you can make edits to forms in multiple rules quickly and in one 

global location. To add a global form, you set the Global Forms tab active, right-click in the tab, 

and choose Add Form (Figure 20.12).
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Figure 20.12

Choosing to add a 

global iLogic form 

from the browser

You can also add global forms by selecting the Manage tab, clicking the drop-down found on 

the iLogic panel, and then clicking the Add Form button. When using this method, you have an 

option to embed the form in the current document or use it as a global form in all documents.

Global forms are stored within the Design Data folder. You can fi nd the location by clicking 

the Global Forms tab and choosing Open Containing Folder (shown in Figure 20.12). Recall from 

Chapter 1, "Getting Started with Autodesk® Inventor®," that the location of the Design Data 

folder can be specifi ed in two ways:

Application Options  On the Tools tab, click the Application Options button, and then click 

the File tab. Set the Design Data path to the location of your choice. Be aware that this sets the 

location on the installation of Inventor being used to set the path. Therefore, if you work with 

other Inventor users and want to have all of the installs looking at the same Design Data 

folder, you would need to walk around to each machine and set this path or use the Project 

Settings method.

Project Settings  Close all open Inventor fi les. Ensure that no other users are accessing the 

project fi le (*.ipj) that you intend to edit. On the Get Started tab, click the Projects button. 

In the Projects editor dialog, locate the Folder Options node in the bottom pane and expand 

it. Set the Design Data path to the location of your choice. This method sets the path per the 

project fi le and therefore overrides the Application Options setting if the two do not match. 

If multiple users are using the same project, then all of them will now be using the new 

Design Data folder.

The External Rules Tab

The External Rules tab lists all of the rules stored outside of Inventor, independent of the 

actual Inventor fi le you are working on. External rules can be used as iLogic rules or as small 

programs that are run manually (like VBA macros). To add an existing external rule, set the 

External Rules tab active, right-click in the tab, and choose Add External Rule, as shown in 

Figure 20.13.

Figure 20.13

Adding an exter-

nal rule from the 

browser
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When you choose Create New External Rule, you will be prompted with the Create Rule File 

dialog box, where you can browse to a location and save the rule as one of the three available 

fi le formats: plain text (*.txt), iLogic VB (*.ilogicVb), or Visual Basic (*.vb). Generally, this 

location is on a shared network where all users can access the fi les. Figure 20.14 shows a new 

external rule being created and saved in a location called iLogic Rules found in the Mastering 

Inventor project path. Once the rule fi le is created, you are presented with the Edit Rule dialog 

box, where you can build the rule. External rules are often used with event triggers, such as 

Before Save, which will run the rule when the fi le is saved.

Figure 20.14

Creating an exter-

nal rule

External Rule File Save Location

You can set up default external rule fi le save locations and the default fi lename extension by 

selecting the Tools tab, clicking the drop-down on the Options panel, and then clicking the iLogic 

Confi guration button, as shown here.
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Understanding the iTrigger
An iTrigger is an Inventor user parameter that you can include in the current fi le to trigger 

rules manually. This parameter is often used to test a rule while you are creating it. The iTrigger 

parameter may not be as useful as it was before the iLogic browser made the rules more easily 

accessed.

The iTrigger button found on the iLogic panel of the Manage tab initially creates a user 

parameter named iTrigger0. If the parameter already exists, the value of the iTrigger param-

eter is incremented by 1 and triggers any rule containing the iTrigger0 parameter. If multiple 

rules contain the iTrigger, they are all triggered. Here is a rule to save the current fi le as a PDF 

that contains the iTrigger:

‘set the trigger

trigger = iTrigger0

‘path and file name without extension

path_and_name = ThisDoc.PathAndFileName(False)

‘call the PDF addin

PDFAddIn = ThisApplication.ApplicationAddIns.ItemById_

(“{0AC6FD96–2F4D-42CE-8BE0–8AEA580399E4}”)

oDocument = ThisApplication.ActiveDocument

oContext = ThisApplication.TransientObjects.CreateTranslationContext

oContext.Type = IOMechanismEnum.kFileBrowseIOMechanism

oOptions = ThisApplication.TransientObjects.CreateNameValueMap

oDataMedium = ThisApplication.TransientObjects.CreateDataMedium

‘set the PDF publish options

If PDFAddIn.HasSaveCopyAsOptions(oDataMedium, oContext, oOptions) Then

‘oOptions.Value(“All_Color_AS_Black”) = 0

oOptions.Value(“Remove_Line_Weights”) = 1

oOptions.Value(“Vector_Resolution”) = 400

oOptions.Value(“Sheet_Range”) = Inventor.PrintRangeEnum.kPrintAllSheets

‘oOptions.Value(“Custom_Begin_Sheet”) = 2

‘oOptions.Value(“Custom_End_Sheet”) = 4

End If

‘Set the destination file name

oDataMedium.FileName = path_and_name & “.pdf”

‘Publish PDF.

Call PDFAddIn.SaveCopyAs(oDocument, oContext, oOptions, oDataMedium)

Working with Event Triggers
An event trigger is used to set up a rule to trigger automatically. For instance, you might want 

to create a rule to prompt you to fi ll out the fi le properties when you save the fi le. To do so, you 

simply add the rule to the Before Save event. The rule is triggered when you save a fi le, allowing 

you to enter or confi rm the iProperties, and then the fi le is saved. Here is a list of the available 

event triggers:

 ◆ When a new fi le is created

 ◆ After a fi le is opened
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 ◆ Before a fi le is saved

 ◆ After a fi le is saved

 ◆ Before a fi le is closed

 ◆ When any model parameter is changed

 ◆ When an iProperty is changed

 ◆ When a feature of a part is suppressed or unsuppressed

 ◆ When the geometry of a part is changed

 ◆ When the material of a part is changed

 ◆ When a component of an assembly is suppressed or unsuppressed

 ◆ When a component of an iPart or iAssembly is changed

 ◆ When a drawing view is changed

To add a rule to an event trigger, select the Manage tab, and click the Event Trigger button 

found on the iLogic panel. Then select the event you want to use, and click the Select Rules but-

ton. You can then select from the available rules. Keep in mind that you will see only applicable 

event triggers in the list when setting a trigger for an event. For instance, if the current fi le you 

are working in is an IDW fi le, you will not see event triggers such as Material Change (changing 

the material of a part) in the list.

Creating iLogic Parameters, Rules, and Forms
Now that you’ve had an overview of the iLogic tools and components, you are ready to create 

iLogic parameters, rules, and forms. You’ll start out by focusing on rules using input and mes-

sage boxes and then look at creating and using iLogic forms.

Creating iLogic Rules
In the following pages, you’ll explore the methods and options of creating iLogic rules. To add 

a new rule to an Inventor fi le, you right-click the fi le node in the Rules tab of the iLogic browser 

and choose Add Rule.

Creating Your First Rule

Once a rule is created using Add Rule, you are presented with the Edit Rule dialog box. This 

dialog has four main interface panes, as shown in Figure 20.15:

Function Category List (#1)  Contains all of the iLogic function categories for easy access 

and reference.

Rule Authoring Pane (#2)  The area where you input and edit your rule code.

Tabs Area (#3)  Provides access to the Model, Options, Search And Replace, and Wizards 

tools. In Figure 20.15, the Model tab is selected. You can see that it gives you access to the 

model parameters and features for inclusion in the rule.
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Subtabs (#4)  A subset of the Model tab. As displayed in Figure 20.15, the Parameters tab 

shows a listing of the model parameters because Model Parameters is selected on the left.

Figure 20.15

Th e Edit Rule dialog 

box

1

3

4

2

To see how all of this works, you can use the following steps to create a simple rule. 

If you have not already downloaded the Chapter 20 fi les from www.sybex.com/go/

MasteringInventor2014, please refer to the “What You Will Need” section of the Introduction 

for the download and setup instructions. The goal of the rule you will create in this example is 

to create user inputs to control the width and length of the plate:

 1. Click the Open button on the Get Started tab, browse for mi_20a_001.ipt in the Chapter 20 

directory of your Mastering Inventor 2014 folder, and open it.

 2. Click the Manage tab and select the iLogic Browser button on the iLogic panel to ensure 

your iLogic Browser is displayed.

 3. In the iLogic Browser, ensure that the Rules tab is selected, and then right-click anywhere 

in the Rules tab, and choose Add Rule or click the Add Rule button found on the iLogic 

panel of the Manage tab in the ribbon.

 4. Enter Size Input into the Rule Name dialog box, and then click the OK button.

 5. In the Edit Rule dialog box, make sure the Model tab along the top is set active and then 

expand the model node (if needed) and select Model Parameters. All of the model param-

eters for this part fi le are now listed in the Parameters subtab on the right.

 6. In the Model tab, click Extrusion1 and notice the Parameters tab now shows only the 

Parameters used in Extrusion1.

 7. In the Function Category list (on the left), locate the MessageBox node and expand it by 

clicking the plus sign.

http://www.sybex.com/go
http://www.sybex.com/go/MasteringInventor2014
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 8. Locate the InputBox item toward the bottom of the list and double-click it. This will place 

the generic InputBox function into your rule, thereby providing the template syntax you 

need to follow. This function should read as follows:

myparam = InputBox(“Prompt”, “Title”, “Default Entry”)

 ◆ myparam is the placeholder for the return value (the value retrieved from the input 

box).

 ◆ InputBox is the name of the function.

 ◆ “Prompt” is the placeholder for the message to appear in the box.

 ◆ “Title” is the placeholder for the text to appear in the title bar of the box.

 ◆ “Default Entry” is the placeholder for the text to display in the input fi eld of the box 

when it is fi rst opened.

Function Syntax Guide

If you look in the help fi les under User’s Guide ➢ iLogic ➢ Functions and then refer to the Quick 

References tab, you can fi nd a listing of all of the functions with a guide and example of each one’s 

syntax.

 9. Select myparam in the Rule Authoring pane, and then double-click Width in the 

Parameters subtab. This will replace myparam with the word Width.

Note that the color coding indicates that Width is a recognized parameter. You could have 

just deleted the word myparam and then typed in the word Width as well. If you had done 

so, and accidentally typed width with no uppercase W, the word would not have turned 

blue to indicate a recognized parameter.

 10. Next, delete the word Prompt and replace it with “Enter Width” (with quotation marks).

 11. Delete the word Title and replace it with “Width Input” (with quotation marks).

 12. And fi nally, replace the words Default Entry with 100 mm (no quotation marks).

Your result should read as follows:

Width = InputBox(“Enter Width”, “Width Input”, 100 mm)

 13. Click the OK button to close the Edit Rule dialog and test the rule. You should be 

prompted with an input box that looks like the one in Figure 20.16.

Figure 20.16

Th e width input box

 14. Enter 150 in the input box and then click the OK button.
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You’ll notice that the model width did not change as you might have expected. This is because 

the input box has only changed the Width parameter, and now the fi le needs to be updated. You 

should see that the Update button is active, indicating the model needs to be updated. You can 

click the Update button to see the model width change to 150 mm. In the next section, you’ll edit a 

rule to make the model automatically update when the rule is run.

You can right-click the rule and choose Run Rule in order to test it and change the width 

value again. When you have fi nished, you can close the fi le without saving changes.

Editing Your Rule

In this exercise, you’ll pick up where you left off and edit the Size Input rule you created in the 

previous exercise:

 1. Click the Open button on the Get Started tab, browse for mi_20a_002.ipt in the Chapter 20 

directory of your Mastering Inventor 2014 folder, and open it.

 2. From the iLogic browser, locate the Size Input rule on the Rules tab, and then right-click it 

and choose Edit Rule.

 3. Place your cursor at the end of the existing function and press the Enter key on the key-

board a couple of times to provide some space in the rule.

 4. In the Function Category list (on the left), locate the Document node and expand it by 

clicking the plus sign.

 5. Locate the UpdateWhenDone item toward the middle of the list and double-click it. This 

will place the UpdateWhenDone function into your rule so that it looks like this:

Width = InputBox(“Enter Width”, “Width Input”, 100 mm)

iLogicVb.UpdateWhenDone = True

 6. Click the OK button to test the rule.

 7. Enter 190 in the input box and click the OK button. Your part width should automatically 

change to 190 mm.

 8. From the iLogic browser, right-click the Size Input rule and choose Edit Rule again.

Currently, your rule is coded to set the default entry of the input box to 100 mm. If you 

built this plate with a standard size of 100 mm for the width most of the time, then hard-

coding that value might be the way to go. But often, it’s more useful to retrieve the cur-

rent parameter value and have it display in the input so the user knows the value before 

changing it.

 9. Replace the 100 mm with Width. You can do this by typing over the value or by selecting it 

and then clicking Extrusion1 in the Model tab along the top. Then double-click the Width 

parameter to “push” it into the Rule Authoring pane. In either case, your function should 

look like this:

Width = InputBox(“Enter Width”, “Width Input”, Width)

 10. Click the OK button to test the rule, and notice that the current width value of the model 

is listed in the input box. Replace this with 165 and click the OK button.



894 | CHAPTER 20 ILOGIC

To fi nish this rule, you will add another function to change the length of the part. Follow the 

steps you used to create the width function so that your rule reads as follows, and then test the 

part to see how it works:

Width = InputBox(“Enter Width”, “Width Input”, Width)

Length = InputBox(“Enter Length”, “Length Input”, Length)

iLogicVb.UpdateWhenDone = True

You can right-click the rule and choose Run Rule in order to test it and see how it functions. 

When you have fi nished, you can close the fi le without saving changes.

Creating a Rule Using a Multi-Value Parameter

In the previous exercises, you used an input box to change parameter values so that you could 

adjust the dimensions of the plate part. In this exercise, you’ll create a multi-value parameter 

and then create a rule to get the user to select from the list. Follow these steps:

 1. Click the Open button on the Get Started tab, browse for mi_20a_003.ipt in the Chapter 

20 directory of your Mastering Inventor 2014 folder, and open it.

 2. From the Manage tab, click the Parameters button.

 3. Right-click the Length parameter and choose Make Multi-Value.

 4. In the Value List Editor dialog box, enter the following values into the top pane and then 

click Add. If 175 mm is listed in the bottom pane, select it and click Delete to remove it.

 ◆ 150

 ◆ 160

 ◆ 170

 ◆ 180

 ◆ 190

 5. Click the OK button to close the Value List Editor dialog box, and then click Done to close 

the Parameters dialog box.

 6. From the iLogic browser, ensure that the Rules tab is selected and then right-click any-

where in the Rules tab, and choose Add Rule.

 7. Enter Size List Input into the Rule Name dialog box, and click the OK button.

 8. In the Edit Rule dialog box, make sure the Model tab along the top is set active, and then 

expand the model node (if needed) and select Model Parameters. All of the model param-

eters for this part fi le are now listed in the Parameters subtab on the right.

 9. In the Model tab, click Extrusion1 to show the parameters used in Extrusion1.

 10. In the Function Category list (on the left), locate the MessageBox node and expand it by 

clicking the plus sign.
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 11. Locate the InputListBox item toward the bottom of the list and double-click it. This will 

place the generic InputListBox function into your rule, thereby providing the template 

syntax you need to follow. This function should look similar to this:

d0 = InputListBox(“Prompt”, MultiValue.List(“d0”), d0, _

 Title:= “Title”, ListName:= “List”)

 ◆ d0 is the placeholder for the return value (the value retrieved from the input box).

 ◆ InputListBox is the name of the function.

 ◆ “Prompt” is the placeholder for the message to appear in the box.

 ◆ MultiValue.List(“d0”) is the subfunction and the name of the multi-value list to 

use.

 ◆ d0 is the placeholder for the default list value to select in the input list of the box when 

it is fi rst opened.

 ◆ The space and underscore that appear in this text break the line and allow it to wrap 

to the next line; however, you will not see this in your rule by default.

 ◆ “Title” is the placeholder for the text to appear in the title bar of the box.

 ◆ “List” is the placeholder for the text to appear above the list in the box.

 12. Select d0 in the Rule Authoring pane, and then double-click Length in the Parameters 

subtab. This will replace d0 with the word Length (no quotation marks).

When to Use Quotation Marks

Quotation marks indicate a text string. When you want the function to see your entry as a text 

string, use quotation marks. When you want the function to read a parameter (either from the 

model or from the rule), don’t use quotation marks.

 13. Delete the word Prompt and replace it with “Select Length” (with quotation marks).

 14. Replace d0 in MultiValue.List(“d0”) with “Length” (with quotation marks).

 15. Replace the next instance of d0 with 150 (no quotation marks). In this case, you want the 

input box to have a hard-coded default of 150.

 16. Delete the word Title and replace it with “Length Selector” (with quotation marks).

 17. Replace the word List with “Available Standard Lengths” (with quotation marks).

 18. To make your code more readable in the editor, add an underscore after the comma 

following MultiValue.List(“Length”) and then press Enter on the keyboard. The 
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underscore must have a space in front of it. This acts as a carriage return within the code, 

allowing the line to fi t on-screen without upsetting the syntax.

Once the edits are made, your result should read as follows:

Length = InputListBox(“Select Length”, MultiValue.List(“Length”), _

150, Title:= “Length Selector”, ListName:= “Available Standard Lengths”)

 19. Click the OK button to exit the Edit Rule dialog and run the rule.

 20. Click the Update button to see the model update.

To fi nish this rule, you will edit the Width parameter and make it a multi-value parameter 

with the same values you used for the length. Then, edit the rule and add another input list box 

function to change the width of the part. Follow the steps you used to create the length function. 

Then, add the function to make the part update when the rule is fi nished running (recall that 

you’ll fi nd this in the Document function category list) so that your rule reads as follows:

Length = InputListBox(“Select Length”, MultiValue.List(“Length”), _

150, Title:= “Length Selector”, ListName:= “Available Standard Lengths”)

Width = InputListBox(“Select Width”, MultiValue.List(“Width”), _

150, Title:= “Width Selector”, ListName:= “Available Standard Widths”)

iLogicVb.UpdateWhenDone = True

Finally, test the part to see how it works. When you have fi nished, you can close the fi le with-

out saving changes.

Working with Multiple Rules in the Same File

In the next exercises, you’ll work with both of the rules you created in the previous exercises 

and then create a third rule to choose which of the other two to run. Follow these steps to work 

with multiple rules in the same fi le:

 1. Click the Open button on the Get Started tab, browse for mi_20a_004.ipt in the Chapter 20 

directory of your Mastering Inventor 2014 folder, and open it.

 2. From the iLogic browser, locate the Size Input rule on the Rules tab, and then right-click it 

and choose Run Rule.

 3. Enter 150 for Length and click the OK button.

 4. Enter 150 for Width and click the OK button.

You’ll notice that the Size List Input rule is run automatically when you click the OK but-

ton, presenting you with the Length Selector list input box.

 5. Click the OK button in both the Length Selector and Width Selector input boxes.

The issue here is caused by both rules handling the same parameters. Currently, any 

change to those parameters causes the rules to run automatically. Although this might be 

the desired result in some cases, in this instance, it is causing a problem. To resolve this, 

you will edit both rules and change their options.

 6. From the iLogic browser, locate the Size Input rule on the Rules tab, and then right-click it 

and choose Edit Rule.
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 7. Along the top, select the Options tab, select the Don’t Run Automatically option, as 

shown in Figure 20.17, and then click the OK button to exit the Edit Rule dialog box.

Figure 20.17

Rule options

 8. Click the OK button in the Length Input and Width Input boxes to accept the default 

values.

Next, you’ll do the same thing for the Size List Input box.

 9. From the iLogic browser, locate the Size List Input rule on the Rules tab, and then right-

click it and choose Edit Rule.

 10. Along the top, select the Options tab, select the Don’t Run Automatically option, and then 

click the OK button to exit the Edit Rule dialog box.

 11. Click the OK button in the Length Selector and Width Selector boxes to accept the default 

values.

As a test to see that the issue is resolved, you can run the rules and change the width and 

length values to ensure that neither rule runs when the other makes a change. Once you’ve 

tested this, you can close the fi le without saving and continue on. 

Handling Errors

Often, your rules will work fi ne when you test them because you enter expected results. But you can 

rest assured that as soon as you have other people test your rules, they’ll encounter errors when 

they provide invalid input, for example.

Depending on the complexity of your code, you can often add a simple error handler to manage 

null inputs and other issues created when the user doesn’t provide predictable or desired input.

You can use a simple On Error Resume Next line to skip or ignore an error. Although this is not 

considered a good practice for programming, it will often suffi  ce for simple errors. For example, 

you can open the fi le mi_20a_022.ipt and run Rule0. If you click the Cancel button in the input 

box, you’ll receive an error because the rule returns an empty string value. If you do the same for 

Rule1, the error is skipped because Rule1 includes an On Error Resume Next line.

Rule2 includes an On Error Goto ErrorHandler line that instructs Inventor to skip to the 

ErrorHandler line and display a message if an error is encountered. You can run Rule2 and click 

the Cancel button in the input box to see how this works. Rule3 checks for the specifi c problem of 

an empty text string and provides the user with a message. Rule4 does the same but just uses the 

existing value rather than the null input.

You can search online for “VB error checking” to fi nd many more error-checking strategies.
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Use a Conditional Statement to Run Another Rule

Next, your goal is to create a new rule to choose between two existing rules. But before doing so, 

you’ll add a True/False user parameter and then edit the existing rule names to make them a bit 

more meaningful for your next task:

 1. Click the Open button on the Get Started tab, browse for mi_20a_005.ipt in the Chapter 20 

directory of your Mastering Inventor 2014 folder, and open it.

 2. From the Manage tab, click the Parameters button.

 3. From the lower-left corner, select the user parameter drop-down list (it shows Add 

Numeric by default).

 4. Set it to Add True/False and then Enter Standard_Size for the parameter name.

 5. Click Done to exit the Parameters dialog box.

Next, you’ll rename the existing rules.

 6. From the iLogic browser, locate the Size Input rule on the Rules tab, click it once to select 

it, and then slowly click it again to set the name active for renaming.

 7. Enter Custom Size Input for the new name.

 8. Repeat this for the Size List Input rule and rename it Standard Size List Input.

 9. In the iLogic browser, right-click anywhere in the Rules tab, and choose Add Rule (note 

that you can also click anywhere in the blank space of the iLogic browser with the Rules 

tab active to add a rule).

 10. Enter Size Type Input into the Rule Name dialog box, and then click the OK button.

 11. In the Function Category list (on the left), locate the MessageBox node and expand it by 

clicking the plus sign.

 12. Locate the InputRadioBox item toward the bottom of the list and double-click it. This will 

place the generic InputRadioBox function into your rule, thereby providing the template 

syntax you need to follow. This function should read as follows:

booleanParam = InputRadioBox(“Prompt”, “Button1 Label”, “Button2 Label”, booleanParam, 

Title:= “Title”)

 ◆ booleanParam is the placeholder for the return value (the value retrieved from the 

input box).

 ◆ InputRadioBox is the name of the function.

 ◆ “Prompt” is the placeholder for the message to appear in the box.

 ◆ “Button1 Label” and “Button2 Label” are the labels for the radio buttons.

 ◆ booleanParam is the placeholder for the default radio button to select when the input 

box is fi rst opened.

 ◆ “Title” is the placeholder for the text to appear in the title bar of the box.
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 13. Make sure the Model tab along the top is set active, and then expand the model node 

(if needed) and select User Parameters. All of the user parameters for this part fi le are now 

listed in the Parameters subtab on the right. In this case, there is just the one you created.

 14. Select booleanParam in the Rule Authoring pane, and then double-click Standard_Size in 

the Parameters subtab. This will replace booleanParam with Standard_Size (no quota-

tion marks).

 15. Delete the word Prompt and replace it with “Select Size Type” (with quotation marks).

 16. Replace Button1Label with “Standard Sizes” (with quotation marks).

 17. Replace Button2Label with “Custom Size” (with quotation marks).

 18. Replace booleanParam with True (no quotation marks). This sets the default to be true, 

which will be the fi rst button, or the standard size option.

 19. Delete the second instance of the word Title and replace it with “Standard or Custom” 

(with quotation marks).

 20. To make your code more readable in the editor, add an underscore after the comma fol-

lowing “Select Size Type” and then press Enter on the keyboard. The underscore must 

have space in front of it. This acts as a carriage return within the code, allowing the line 

to fi t on-screen without upsetting the syntax.

Once the edits are made, your result should read as follows:

Standard_Size = InputRadioBox(“Select Size Type”, _

“Standard Sizes”, “Custom Size”, True, Title:= “Standard or Custom”)

Currently, this rule doesn’t do anything other than display an input box to let you choose 

between two buttons. To make those buttons do something meaningful, you will add a 

conditional statement to run one of the other existing rules.

 21. From the toolbar along the top of the Rule Authoring pane, select the If…Then…End If 

button to place the syntax snippet in your rule.

 22. Delete the My_Expression placeholder and leave your cursor between If and Then.

 23. Right-click Standard_Size in the Parameters subtab and choose Capture Current State. 

This should result in Standard_Size = True unless you made changes to the True/False 

parameter when creating it. If so, just edit it to read Standard_Size = True.

 24. In the Function Category list (on the left), locate the Run Other node and expand it by 

clicking the plus sign. Locate the RunRule item in the list.

 25. In the Rule Authoring pane, place your cursor on the line after Then and above End If, 

and double-click the RunRule node in the Function Category list. This will place the 

iLogicVb.RunRule(“ruleName”) function into your rule.

 26. Replace ruleName with “Standard Size List Input” (with quotation marks).

 27. Add an empty line above End If and enter Else; then hit Enter on the keyboard and add 

another RunRule function, and replace Replace ruleName with “Custom Size Input” 

(with quotation marks).
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Your resulting rule should read as follows:

Standard_Size = InputRadioBox(“Select Size Type”, _

“Standard Sizes”, “Custom Size”, True, Title:= “Standard or Custom”)

If Standard_Size = True Then

iLogicVb.RunRule(“Standard Size List Input”)

Else

iLogicVb.RunRule(“Custom Size Input”)

End If

Figure 20.18 shows the input radio dialog box.

Figure 20.18

Th e radio buttons 

allow you run one 

rule or the other

You can test this rule and notice that you can now choose between the two input types, 

Custom and Standard. If you choose Custom, you can add anything, and you can choose from 

only the approved standards for the standard inputs.

But what if you enter a value such as 300 for the length? You’ll notice that the hole spacing 

becomes quite large. It would be nice to have a rule to add holes for large custom lengths and 

widths. In the next exercise, you’ll investigate how to do just that.

Use a Message Box to Troubleshoot

Oftentimes, it is helpful to add a message box to return a value to you so you can see what the code 

is returning. Th is is particularly helpful when your code is throwing an error. For example, if, when 

working with a parameter named Shell_OD, you receive an error concerning that parameter, you 

might temporarily add the following line to visually confi rm the value returned for Shell_OD:

MessageBox.Show(Shell_OD, “Test”)

Suppressing Features

In this next exercise, two hole features have been added to the part for you. The goal is create a 

rule to suppress a hole feature if the spacing is under a specifi ed distance and activate it if the 

spacing exceeds the specifi ed distance. You’ll explore a couple of other tips and tricks along the 

way. Follow these steps:

 1. Click the Open button on the Get Started tab, browse for mi_20a_006.ipt in the Chapter 

20 directory of your Mastering Inventor 2014 folder, and open it.

 2. From the Manage tab, click the Parameters button.

 3. Notice that there are two reference parameters present.
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These reference parameters were created in Sketch3, which controls the locations of Hole2 

and Hole3. Recall that a reference parameter is created by adding a driven dimension to a 

sketch. In this case, the distance between the center holes and end holes along the horizon-

tal and vertical edges was dimensioned after the sketch was fully constrained, resulting in 

the driven dimension/reference parameter. Then, those parameters were renamed.

 4. On the Rules tab of the iLogic browser, click and drag the rule named Size Type Input 

to the top of the list. Since this is the rule that is utilized to choose between the others, it 

might be best to place it at the top.

 5. Add a new rule and call it Suppress Center Holes.

 6. From the toolbar along the top of the Rule Authoring pane, select the If…Then…End If 

button to place the syntax snippet in your rule.

 7. Use the drop-down and add Else to the snippet so that you have the following:

If My_Expression Then

Else

End If

 8. Highlight My_Expression in the function code, and then look in the Model tab along the 

top and select Reference Parameters.

 9. Select Center_Hole_Space_H from the Parameters subtab on the right and double-click it 

to replace My_Expression.

 10. From the toolbar along the top of the Rule Authoring pane, select the Operators drop-

down and notice that it contains a list of all the logic operators. Click >= to include it in 

your rule after Center_Hole_Space_H and then enter 45 so that the result is as follows:

If Center_Hole_Space_H >= 45 Then

On the next line, you will add the function to make the hole feature active.

 11. Select Hole2 from the feature tree in the Model tab area, and then right-click it and 

choose Capture Current State.

Capture Current State

You can use the Capture Current State option on any Inventor feature or parameter. You can just 

delete the unneeded information and keep what is pertinent.

 12. Delete all of the extra information and keep only the Feature.IsActive line. IsActive 

can be used to suppress or not suppress any Inventor feature that can be suppressed.

 13. Copy that line below the Else and change True to False so the result reads as follows:

If Center_Hole_Space_H >= 45 Then

Feature.IsActive(“Hole2”) = True
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Else

Feature.IsActive(“Hole2”) = False

End If

 14. Copy your entire block of code and paste it under the original.

 15. Change the reference parameter to Center_Hole_Space_V and the hole feature references 

to Hole3, so your entire rule reads as follows:

If Center_Hole_Space_H >= 45 Then

Feature.IsActive(“Hole2”) = True

Else

Feature.IsActive(“Hole2”) = False

End If

If Center_Hole_Space_V  >= 45 Then

Feature.IsActive(“Hole3”) = True

Else

Feature.IsActive(“Hole3”) = False

End If

 16. Click the OK button to test the rule.

Because the current hole spacing is less than 45 for both of the reference parameters, the 

hole is suppressed. Next, you’ll modify the existing rules to call the Suppress Center 

Holes rule and format the Custom Size Input rule to include a “soft” warning in the form 

of a second line in the input boxes.

 17. Edit the Standard Size List Input rule and add the following line to the very end (after the 

UpdateWhenDone function):

iLogicVb.RunRule(“Suppress Center Holes”)

Of course, you can just type the line in as you are reading it, but for the sake of practice, 

use the Function Category list to fi nd the RunRule function and double-click it to enter it.

 18. Edit the Custom Size Input rule and add the same RunRule line to the very end.

 19. Change the top two lines of code to read as follows:

Length = InputBox(“Enter Length “ & vbCrLf & _

“(max length not to exceed 350)”, “ Length Input”, Length)

Width = InputBox(“Enter Width “ & vbCrLf & _

“(max width not to exceed 300)”, “ Width Input”, Width)

Inserting & vbCrLf & creates a second line in the input line. The underscore preceded 

by a space provides a carriage return without disrupting the code. This makes it easier 

to read in the Edit Rule dialog box. When you test the rule, you’ll see that that second 

line contains a parenthetical statement advising the user of the maximum width. This is 

a “soft” warning because there is nothing in the rule to prevent the user from inputting 

values larger than the stated maximums.
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Because your rules are changing the size of your part, it would be nice to add a bit of code 

to adjust the zoom level to match the size of the new part. To do so, you can call an appli-

cation programming interface (API) object to make this happen with this line:

ThisApplication.ActiveView.Fit

 20. Edit the rule named Size Type Input and add the previous line to the very end.

 21. Add a comment line above it by typing This line Zooms All.

 22. To make that line be seen as a comment and not a line of code, simply add an apostrophe 

to the beginning. The result should be as follows:

‘This Line Zooms All

ThisApplication.ActiveView.Fit

Commenting Code

Any text preceded by an apostrophe is read by iLogic as a comment and not interpreted as code. 

Use this to your advantage by adding notes and documentation to your iLogic code to make editing 

it in the future easier.

You can also use the Comment and Uncomment buttons found on the toolbar above the top of the 

Rule Authoring pane to comment out entire blocks of code and then uncomment them later. Th is is 

particularly helpful when troubleshooting and working out “what if” strategies while creating rules.

If you anticipate using a particular snippet a lot, you might want to save it to the Custom 

Snippets tab. To see how this is done, you’ll save the Zoom All snippet.

 23. Highlight both the comment line and the code line, and then right-click and choose 

Capture Snippet.

 24. For the Title, type Zoom All.

 25. Click the Use Code As Tooltip button, and then click the OK button.

 26. Click the Save Custom Snippets button on the toolbar of the Custom Snippets tab, and 

choose a name and location for your custom snippet fi le.

You’re likely beginning to see the power of iLogic and the use of simple rules to create con-

fi gurations of your model templates. Feel free to experiment with this fi le to tweak the code as 

you like, or you can close the fi le without saving changes and move on to the next section.

Operators

You’ll fi nd the use of operators to be a common method of building logic in your iLogic rules. 

An operator performs a function on one or more objects. Table 20.1 provides a list of some com-

mon operators and examples of their uses for quick reference.
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Table 20.1: Common function operators

Operators Description Example Results

+ Adds two values 12 + 5 Returns 17

– Subtracts one value from 

another value

12 – 5 Returns 7

* Multiplies two values 12 * 5 Returns 60

/ Divides two numbers and 

returns a fl oating-point 

result

12 / 5 Returns 2.4

\ Divides two numbers and 

returns an integer result

12 \ 5 Returns 2

^ Raises a value to a power 2 ̂  2 Returns 4

& Concatenates two strings “Autodesk” & 

“Inventor”

Returns “Autodesk 

Inventor”

> Greater than 12 > 5 Returns True

< Less than 12 < 5 Returns False

= Equal to 12 = 5 Returns False

>= Greater than or equal to 12 >= 5 Returns True

<= Less than or equal to 12 <= 5 Returns False

<> Not equal to 12 <> 5 Returns True

Mod Divides two numbers and 

returns only the remainder

12 Mod 5 Returns 2

And Performs a conjunction on 

two expressions, and checks 

both even if the fi rst is found 

to be false

If 12 > 5 And 5 > 7 

Then both are True 

Else at least one is 

False

Returns the following: 

At least one is 

False

Or Performs a disjunction on 

two expressions

If 12 > 5 Or 5 > 7 

Then at least one is 

True Else both are 

False

Returns the following: 

At least one is True
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Operators Description Example Results

AndAlso Performs a conjunction on 

two expressions, but evalu-

ates the second if and only if 

the fi rst is true

If 12 = 5 AndAlso 5 < 

7 Then both are True 

Else at least one is 

False

Returns the following: 

At least one is 

False, but doesn’t eval-

uate 5 < 7

OrElse Performs a disjunction on 

two expressions, but evalu-

ates the second if and only if 

the fi rst is true

If 12 = 5 OrElse 5 < 

7 Then at least one 

is True Else at least 

one is False

Returns the following: 

At least one is 

False, but doesn’t eval-

uate 5 < 7

Creating iLogic Forms
iLogic forms are used to create a custom user input and control form to work with iLogic rules 

or to handle parameter and iProperty changes directly. iLogic forms are created with a very 

intuitive drag-and-drop interface that is easy to master.

Working with iProperties and Forms

In this next exercise, you’ll explore the use of iProperties in iLogic rules and then create a basic 

iLogic form to manipulate them. The objective here is to create a rule to do the following:

 ◆ Read the available materials from the part fi le and populate a multi-value parameter list 

with those values.

 ◆ Set the material iProperty using the list box selection.

 ◆ Ask the user a question: Is this part to be painted?

 ◆ Set the part color iProperty based on the user input.

Follow these steps to explore the use of iProperties and Forms:

 1. Click the Open button on the Get Started tab, browse for mi_20a_007.ipt in the Chapter 20 

directory of your Mastering Inventor 2014 folder, and open it.

 2. From the Manage tab, select the Parameters button.

 3. Add a new Text user parameter (use the drop-down in the lower-left corner), and call it 

Materials_List.

 4. Right-click the new parameter and choose Make Multi-Value.

 5. Add a new value called Generic to the list.

 6. Create another new Text user parameter and call it Colors_List.

Table 20.1: Common function operators   (continued)
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 7. Make it a multi-value parameter also, and add the following values (make sure your 

spelling and capitalization match exactly):

 ◆ As Material

 ◆ Gunmetal

 ◆ Slate

 ◆ Tan

 ◆ White

 8. Close the Parameter dialog and open the iLogic browser. Add a rule named Material and 
Color Input.

 9. Locate and expand the iProperties node in the Function Category list on the left.

 10. Find the List Of Materials entry and double-click it to add it to your rule.

 11. Clear param from between the parentheses and then select User Parameter from the 

model tree list at the top.

 12. Double-click Materials_List in the Parameters subtab on the right to place it in the quo-

tation marks. Your rule should read as follows so far:

MultiValue.List(“Materials_List”) = iProperties.Materials

This line retrieves the current list of materials from the part fi le and uses it to populate 

the Materials_List parameter you created. Next, you’ll add a line to set the material 

iProperty to be whatever the value of the Materials_List parameter is. And then, you’ll 

do the same for the Colors_List parameter.

 13. From the iProperties node in the Function Category list on the left, select Material and 

double-click it to add it to your rule.

 14. Add an equal sign to the end of the line, and then ensure that User Parameter is still 

selected in the model tree list at the top. Double-click Materials_List in the Parameters 

subtab to add it to the code.

 15. Do the same thing for the iProperty function called PartColor and the user parameter 

called Colors_List so that your fi nal rule code reads as follows:

MultiValue.List(“Materials_List”) = iProperties.Materials

iProperties.Material = Materials_List

iProperties.PartColor = Colors_List

 16. Click the OK button to exit the Edit Rule dialog box.

Next, you’ll build an iLogic form to allow you to easily select a material and a color from 

a list.

 17. In the iLogic browser, switch to the Forms tab and then right-click in the browser space 

and choose Add Form.

The Form Editor opens and shows the form building tools, as illustrated in Figure 20.19.
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Figure 20.19

Th e iLogic Form 

Editor A

B
C

ED

Here is a list of the Form Editor tools:

Filter Tool (A)  Allows you to fi lter the list on the Parameters, Rules, and iProperties 

tabs for All, Key, and Renamed.

Tabs Area (B)  Allows you to drag and drop items from the list to the Form Design Tree 

pane to add controls for your custom interface.

Form Design Tree Pane (C)  Allows you to design a custom interface by doing the 

following:

 ◆ Drag and drop parameters, rules, iProperties, and Toolbox items onto the form.

 ◆ Drag and drop items on the tree to organize the controls.

 ◆ Edit label text.

 ◆ Select an item to edit its properties in the Properties area.

Toolbox (D)  Allows you to drag and drop controls onto your form.

Properties Area (E)  Allows you to edit the properties for the items selected in the form 

design tree.

 18. In the Form Design Tree pane, you will see the name of the form listed as Form 1. Change 

this to read Material and Color Form.

 19. Use the Parameters tab in the top-left pane and select the Materials_List parameter. 

Then, click and drag it up to the top-right pane and drop it under the form name.

 20. Notice that an input box is added to the preview form on the right.
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 21. In the Form Design Tree pane, edit the Materials_List entry to read Select a 

Material, and then adjust the size of the preview form as needed.

 22. Drag the Colors_List parameter to the Form Design Tree pane. Add it above the mate-

rial control by dragging either item to reorder them.

 23. Rename Colors_List to read Select a Color.

 24. Click the Colors_List control in the Form Design Tree pane and then locate and expand 

the Behavior item in the Properties area at the bottom of the dialog box.

 25. Set Edit Control Type to Radio Group, as shown in Figure 20.20.

Figure 20.20

Changing the con-

trol type

 26. Click the OK button to close the Form Editor, and then click the Material And Color Form 

button to bring up the form. Figure 20.21 shows the fi nished form.

Figure 20.21

Th e fi nished 

Material And Color 

Form

Play around with the controls, adjusting the material and color to your liking. Recall that set-

ting a color overrides the material color, and therefore, you’ll need to set the color to As Material 

to see the change of material have any effect on-screen. When you’ve fi nished, you can close this 

fi le without saving changes and continue to the next section.
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Form Properties

You can set various options for the form such as the font and color by selecting the node for the 

form itself in the Form Design Tree pane and then using the Properties area options. Th e Visual 

Style property provides a list of color schemes for the form.

By default, the form includes a Done button, but you can select from the Predefi ned Buttons list. 

If you’re using the OK Cancel or OK Cancel Apply button options, the changes to the model do not 

take place until a button is clicked. If you’re using the default Done button, changes are applied 

automatically.

Building a Part Configuration Form

In the next exercise, you’ll build an iLogic Form for use in confi guring a small plate part. This 

part is a cast part that needs to be machined to include several features. The specifi cations of 

those features vary depending on the application, so it would be ideal to set up a template part 

with an iLogic form to allow quick and consistent confi guration of the plate as needed. Follow 

these steps:

 1. Click the Open button on the Get Started tab, browse for mi_20a_008.ipt in the Chapter 20 

directory of your Mastering Inventor 2014 folder, and open it.

 2. Click the Manage tab and select the iLogic Browser button from the iLogic panel, to make 

sure your iLogic browser is displayed.

On the Rules tab, you’ll see three existing rules. Each rule checks a reference parameter 

found in Sketch6 used to create the sweep feature called Gasket Groove. If a specifi ed 

reference parameter falls below a set minimum, a warning message is displayed.

 3. Set the Forms tab of the iLogic browser active and then right-click the iLogic browser and 

choose Add Form.

 4. Change the Form label from Form 1 to Confi gure Plate.

 5. Locate the Parameters tab on the left and click the plus sign to expand the list of param-

eters (if it’s not already expanded). Notice that the list of parameters includes model, ref-

erence, and user parameters.

 6. Find the parameter named Mount_Dia and then click and drag it into the form design tree 

on the right. Drop it under the form name in the tree, and then change the label to Mount 
Diameter (A).

 7. Add the following parameters to the tree in the same manner, and edit their labels to 

these values (note that Gasket_ID is a user parameter and therefore is found toward the 

very bottom of the Parameters tab):

 ◆ Change Hole_Dia to Hole Diameter (B).

 ◆ Change Cen_Cen to Center to Center Hole Space (C).

 ◆ Change Gasket_ID to Gasket Size (D).

Figure 20.22 shows the results you should have once all four parameters are added and 

renamed.
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Figure 20.22

Parameters added 

and renamed

 8. Select the Group control from the Toolbox and drag it into the tree, and then drop it 

below Gasket Size (D).

 9. Change the name of the label from Group 1 to Minimum Dimension Values.

 10. Locate the Reference node in the list on the Parameters tab, and click and drag the follow-

ing parameters to the tree. Then edit their labels to these values:

 ◆ Change Gasket_Space_Hold to Minimum Space = 2 mm (E).

 ◆ Change Gasket_Space_Hold2 to Minimum Space = 2 mm (F).

 ◆ Change HoleChecks to Minimum Space = 2.5 mm (G).

Drop the parameters right on the Minimum Dimension Values group so they will land 

in the group. If you miss, you can just drag and drop them into the group afterward. It’s 

worth mentioning that the values of 2 mm and 2.5 mm come from the existing check 

rules. The letters listed in parentheses correspond to a legend image to be embedded in 

the form in the next steps. Figure 20.23 shows the Confi gure Plate form at this stage.

Figure 20.23

Th e Confi gure Plate 

form so far

 11. Select the Picture control from the Toolbox and drag to the bottom of the tree.

 12. Select the Picture node and then choose the Image property in the Properties pane at 

the bottom. Select the cell that reads (none) and click the resulting button to browse and 

select an image to use. Figure 20.24 shows the Image browse button.

 13. Click the browse button and locate and select the fi le mi_20a_008_form_pic.png from 

the Chapter 20 folder.
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The image fi le will be placed in your form automatically. This image was created by tak-

ing a screen capture of an IDW fi le, detailing the plate, and then using a photo editor such 

as Microsoft Paint to crop it as needed.

Next, you will change the properties of the Center To Center Hole Space controls to limit 

the inputs to an approved range. Doing so ensures that the user doesn’t specify a value 

that exceeds the size of the plate or would create a need for custom tooling or a special-

order gasket.

Figure 20.24

Adding an image 

fi le

 14. Select the Center To Center Hole Space (C) control from the tree at the top and then locate 

Edit Control Type in the Properties pane.

 15. Change the control type from Text Box to Slider.

 16. Expand the Slider Properties and set them as follows:

 ◆ Minimum Value set to 4

 ◆ Maximum Value set to 25

 ◆ Step Size set to 1

 17. Click the OK button to create the form and close the Form Editor.

 18. Click the Confi gure Plate button on the Forms tab of the iLogic browser to bring up the 

new form. It should look like Figure 20.25.

 19. Test the functionality of the form as follows:

 ◆ Set Mount Diameter to 20 mm, and notice that a warning message is thrown. Click 

the OK button in the warning and then set Mount Diameter back to 15 mm.

 ◆ Use the Center To Center Hole Space slider and drag it to the left. You’ll notice at 

11 mm, the hole becomes a slot. This is due to the Conditional Suppress option on the 

Slot Cut feature. You can right-click Slot Cut in the browser and choose Properties to 

see how this is done.
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 ◆ Set Mount Diameter back to 20 mm, and click the OK button in the warning box.

 ◆ Use the Gasket Size drop-down to select a smaller size of 100 mm.

Figure 20.25

Th e fi nished plate 

confi guration form

Setting the Form Size

You can set up your forms to maintain a specifi c size by following these simple steps:

 1. Edit the form. 

 2. In the lower pane of the Form Editor, locate the Behavior section in the Properties list.

 3. Set the Allow Control Resizing to True.

 4. Click the OK button to exit the Form Editor.

 5. Run the form.

 6. Right-click and choose Resize Controls; then resize as needed.

 7. Th en right-click again and choose Exit Resize Mode.

 8. Close the form, and then edit it again.

 9. Now set Allow Control Resizing to False to prevent the form from being accidentally resized in 

the future. 
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You can continue adjusting the inputs as you like to test the form. Be aware that if you choose 

a combination of values resulting in violations of all three minimum space rules, it can be a bit 

diffi cult to get the form back to usable values. In the next exercise, you’ll add a reset button and 

more functions to the form to make it a bit more robust.

Using Advanced API Objects

One of the things that makes iLogic so powerful is the ability to use functions from the Inventor 

API from within an iLogic rule. If you’re not familiar with the API, you can fi nd several resources 

to help you get started by searching the Web for “Autodesk Inventor Developer Center.”

Adding Rules, Tabs, and Event Triggers

In the next exercise, you’ll add a reset button to the form created in the previous exercise. You’ll 

also create a second tab on the form to set standard iProperties. Then, you’ll add event triggers 

to bring the form up automatically when a new part is created from this template and another to 

prompt for iProperty values when the fi le is closed. Follow these steps:

 1. Click the Open button on the Get Started tab, browse for mi_20a_009.ipt in the Chapter 20 

directory of your Mastering Inventor 2014 folder, and open it.

 2. Create a new rule named Reset Form and add the following code:

‘resets parameters to default values

Mount_Dia = 15 mm

Hole_Dia = 6 mm

Cen_Cen = 18 mm

Gasket_ID = 115 mm

iLogicVb.UpdateWhenDone = True

 3. To keep this rule from setting those parameter values automatically, you need to click the 

Options tab and select the Don’t Run Automatically check box. Once this is done, you can 

click the OK button to exit the Edit Rule dialog box.

 4. From the Forms tab of the iLogic browser, right-click the Confi gure Plate button and 

choose Edit.

 5. Set the Rules tab active in the Tabs pane on the left.

 6. Click and drag the Reset Form rule into Form Design Tree pane and drop it under the 

picture at the bottom of the list. This automatically adds a button to run the reset rule, 

allowing you to quickly reset the form to the original values.

 7. Select the Tab Group control from the Toolbox, and drag and drop it into the Form Design 

Tree pane to create a new tab.

 8. Rename the tab Size Entry.

 9. Drag the tab to the top of the tree, and then drag and drop the following items onto Size 

Entry.
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 ◆ Mount Diameter (A)

 ◆ Hole Diameter (B)

 ◆ Center To Center Hole Space (C)

 ◆ Gasket Size (D)

 10. Drag and drop another Tab Group control into the Form Design Tree pane and rename it 

Property Entry.

 11. Set the iProperties tab on the left active, and then drag the following iProperties into the 

Form Design Tree pane so they reside in the Property Entry tab:

 ◆ Part Number

 ◆ Description

 ◆ Revision Number

Your form design tree and the top of your form should look like Figure 20.26.

Figure 20.26

Th e improved form

Next, you’ll create a rule to call the Confi gure Plate form and set it to automatically trig-

ger when the fi le is initially created (when this part fi le is used as a template) or opened 

(when an existing version of this part fi le is opened for modifi cations).

 12. Create a new rule named Call Form and add the following code:

‘displays the specified form

iLogicForm.Show(“Configure Plate”)

 13. Once the rule is created, select the Manage tab and click the Event Triggers button found 

on the iLogic panel.

 14. Select the New Document event in the Rules Triggered By Events dialog box, click the 

Select Rules button, and then select the Call Form rule. Click the OK button to return to 

the list of events.

 15. Add the Call Form rule to the After Open event using the same steps.

 16. Click the Inventor button in the top-left portion of the application screen, and then choose 

Save As and then Save Copy As Template.
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 17. The template directory opens as specifi ed in the Application Options settings. Save the 

fi le as Plate 4792.

 18. From the Get Started tab, select New, and then make sure you are looking at the main 

Templates directory folder using the right-hand pane. Then select the Plate 4792 

template.

 19. Once the template is loaded, the Confi gure Plate form displays, allowing you to confi gure 

the plate for the new variation. Use the controls to create a variation and then click Done.

 20. Save the fi le to the Chapter 20 directory of your Mastering Inventor 2014 folder and 

name it A-4792.ipt.

 21. Close the fi le and reopen it to make sure the Call Form rule is triggered by the After 

Open event.

Working with iLogic forms is quite simple because of the intuitive drag-and-drop interface. 

You can likely see the power and benefi t to using iLogic rules and forms to confi gure repetitive 

tasks and to enforce consistency as demonstrated here. Feel free to experiment with this fi le to 

add more controls and functionality if you’d like. Or you can close the fi les used in the previous 

steps and continue on to the next section without saving changes.

Set Global Forms to Read-only

If you create your forms as global forms, they are saved outside of the Inventor fi le. Once your global 

forms are created and tested, you might want to prevent them from accidentally being changed by 

other users (or yourself). To do so, follow these steps:

 1. Right-click on any empty area of the form panel in the browser.

 2. Choose Open Containing Folder.

 3. In this folder, locate the XML fi le with the same name as your form.

 4. Right-click and choose Properties.

 5. On the General tab, select the Read Only check box.

Working with iLogic Components
Because parts and subassemblies with iLogic rules are often confi gured to different sizes and 

with different components, placing them directly into an assembly is generally not the correct 

method. Changes to the iLogic component will impact every assembly it is placed in. Instead, 

you will typically use the Place iLogic Component tool to place a copy of an iLogic component 

into an assembly.

The copy is automatically created in the directory of the assembly you are working in, so it 

is important to save the assembly before using the Place iLogic Component tool. For example, 

you have an assembly called 45–1000.iam in a folder named 45–0000. When you attempt to 
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place 45–6799.ipt using the Place iLogic Component tool, it’s actually a copy that is placed 

in the assembly fi le, and the copy will be named 45–6799–01.ipt. This fi le will be created 

in the 45–0000 folder. If you placed another version of 45–6799.ipt into the same assembly 

using the Place iLogic Component tool, it would be named 45–6799–02.ipt and placed in the 

45–0000 folder.

Placing iLogic Subassemblies

When you place an iLogic subassembly, all components in the same directory or subdirectories of 

that subassembly are copied to the directory of the main assembly and assigned unique names.

Th erefore, it’s recommended that you organize your iLogic subassembly fi les with standard mod-

els outside of the directory of the subassembly that will be placed as an iLogic component. Th is 

can be done by saving them in a Content Center directory or another library directory. When you 

place the assembly as an iLogic component, these fi les are not copied to the directory of the main 

assembly and the iLogic component in the assembly maintains its links to the original fi les, in 

their original locations.

You can follow these steps to use the Place iLogic Component tool:

 1. From the Component panel of the Assembly tab, click the Place drop-down arrow and 

select the Place iLogic Component button.

 2. Browse for and select the component to be placed. Then click Open.

The component parameters are listed in a small dialog box. If the component contains 

Key parameters, only those parameters are included in the list; otherwise, all parameters 

are included. Initially, all parameters are designated as <Free> in the From Assembly 

column. This indicates that they are not driven by assembly parameters. Changing a free 

parameter value during placement allows you to confi gure the component upon place-

ment, and the preview updates to show the changes made.

 3. Click the drop-down arrow in the From Assembly column to see the list of assem-

bly parameters available to drive the corresponding parameter. (Driving parameters 

must exist in the assembly and therefore should be created before placing the iLogic 

component.)

 4. Click the OK button after making your changes.

 5. iLogic starts the Place Component tool, allowing you to place a copy of the original iLogic 

component in the assembly.

iLogic Design Copy
You can use the iLogic Design Copy tool to create copies of assemblies and their documenta-

tion. To use the iLogic Design Copy tool, you must fi rst close all of your open Inventor fi les. 

Then, in the iLogic panel on the Tools tab, click the iLogic Design Copy button. In the resulting 

dialog box, you can select the iLogic fi les to copy. When a fi le is selected, the referenced fi les are 

selected as well. You can also choose to copy unlinked Inventor or non-Inventor fi les related to 

the job you are copying.
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Once fi les are selected, you specify the destination folder to which the fi les will be copied, 

and you can set fi le prefi xing or suffi xing to be appended to the original fi lenames. Another 

important option is the ability to maintain or delete the existing rules in the new copy. This 

allows you to start over with a clean project when needed or use the existing iLogic rules in the 

new design when that is preferred.

Use iLogic to Fill Out Title Blocks

If you have a Drawn By fi eld and a Date fi eld in your title block, you might fi nd it diffi  cult to remem-

ber to edit the iProperties when saving the fi le or rolling the revision to a new drawing. You can 

use iLogic to assist with this.

Create an iLogic rule to write the username (pulled from the General tab in the Application Options 

dialog) and the current date (pulled from your system setting) to the drawing fi le’s iProperties. 

You can then set your title block fi elds to read those iProperties. And you can set the rule to be 

triggered using the Before Save Document event trigger so that the title block is always updated 

at the time of the fi le save.

Here is a bit of sample code to do this:

 myName= ThisApplication.GeneralOptions.UserName

If iProperties.Value(“Summary”, “Author”) <> myName Then

iProperties.Value(“Summary”, “Author”) = myName

MessageBox.Show(“The Title block has been updated”, _

“an iLogic message for: “ & myName)

End If

iProperties.Value(“Project”, “Creation Date”) = Now

InventorVb.DocumentUpdate()

You can fi nd this and more iLogic samples online at the From the Trenches with Autodesk Inventor 

blog: http://inventortrenches.blogspot.com.

Th e Bottom Line

Create iLogic rules.  Use iLogic rules to document and embed into your models the com-

mon design rules that you use every day to determine the decisions required in your design 

process.

Master It  How can you add a rule to your part to change the size of it?

Edit iLogic rules.  A large part of working with iLogic is testing and editing the rules you 

create. Often, it’s best to add a function at a time to the rule and test it along the way.

Master It  Your rule works but you have to manually update the model. Do you need to 

create a new rule to handle the update?

http://inventortrenches.blogspot.com
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Use multi-value list parameters.  A common part of any design rule process is selecting 

from a list of standard entities. You can create multi-value list parameters from Numeric or 

Text parameters to add lists.

Master It  How would you create a rule that prompts you to select from a list of ap-

proved sizes?

Work with multiple rules in the same fi le.  It is often best to create several small rules 

rather than try to create one large rule that does it all. This helps you maintain and trouble-

shoot the code later, and it also allows you to use rules in multiple applications without the 

need to remove or edit existing code. This is particularly true when working with external 

rules, which might be used in varying applications later on.

Master It  You’ve created two smaller rules because it makes sense to do so, but when 

you try to run one, the other is triggered also. Do you need to combine them into one 

rule?

Use conditional statements.  Conditional statements are the foundation of any pro-

grammed logic. Learning how to use If, Then, and Select Case statements will go a long 

way in helping you solve logical problems when creating rules.

Master It  How can you check the value of a parameter or its state with an iLogic rule?

Suppress features.  Confi guring a part fi le to include and exclude features is often based on 

engineering decisions you make every day. Setting up your iLogic rules to do this is straight-

forward, provided the model is well constructed to start with.

Master It  When you use the Feature.IsActive function on one feature, it causes an 

error in the part. How can a feature be suppressed without suppressing a dependent 

feature?

Work with iProperties.  iProperties are a powerful part of working with Inventor. Being 

able to retrieve and use metadata helps with all parts of the engineering process. Automating 

the process of fi lling out iProperty data with iLogic is a big step forward.

Master It  Can iLogic be used to update the title block of a drawing?

Create iLogic forms.  iLogic forms make creating a user interface for your iLogic pursuits 

quite easy. The drag-and-drop tools provide professional-looking forms with minimal effort.

Master It  You have existing part fi les with no iLogic in them, and it would be nice to 

use the form you created in the most recent design to update those old designs as revi-

sions require it. Can forms be created and shared across part fi les?

Build a part confi guration form.  Confi guring Inventor components saves time, reduces 

human error, and promotes consistency. Using iLogic forms to confi gure common designs is 

a good way to go.

Master It  Can an iLogic form help with parts that are basically the same but have a lot 

of variation in the features they include? 



Appendix A

Th e Bottom Line

Each of The Bottom Line sections in the chapters suggest exercises to deepen skills and under-

standing. Sometimes there is only one possible solution, but often you are encouraged to use 

your skills and creativity to create something that builds on what you know and lets you 

explore one of many possible solutions.

Chapter 1: Getting Started with Autodesk Inventor

Create parametric designs.  The power of parameter-based design comes from the quick 

and easy edits, when changing a parameter value drives a change through the design. To 

make changes easily, though, you need to follow certain general rules so that the changes 

update predictably.

Master It  You want to create a model of a base plate, a rectangular-shaped part with 

a series of holes and rectangular cutouts. What would your initial sketch look like in 

Inventor?

Solution  To start a model for the base plate, your initial sketch would most likely be just 

a rectangle defi ning the width and length of the part. This rectangle would be extruded 

to give it a thickness, and then you would create secondary sketches for the other features 

and cut them from the plate. This approach follows the best practice of creating simple 

sketches to create simple features to build a complex part.

Get the “feel” of Inventor.  The interface contains many elements that change and update 

to give you the tools you need to perform the task at hand. Getting comfortable with these 

automatic changes and learning to anticipate them will help you get the “feel” of Inventor.

Master It  You create an extrude feature using the Extrude button, but you cannot seem 

to fi nd an Edit Extrude button. How can you edit the extruded feature to change the 

height?

Solution  To edit an extruded feature (or any feature), you can simply right-click it in the 

browser and choose Edit Feature. This makes feature edits universal so a separate edit 

tool is not required for each feature type. Keep in mind that for most features, you can 

double-click the feature button in the browser to edit it as well.

Use the Inventor graphical interface.  Inventor 2014 uses the Ribbon menu interface fi rst 

introduced in Inventor 2010. Tools are grouped, which makes fi nding them intuitive once you 

become familiar with the basic layout.

Master It  You are trying to draw a line on the face of a part, but you seem to have lost 

the Sketch tab in the ribbon. How do you get it back?
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Solution  The Sketch tab is present only when you have created a new sketch or are edit-

ing an existing sketch. To draw a line, you need to access the Line tool. You must fi rst use 

the New Sketch tool to create a sketch, and then you will see the Sketch tab and on it the 

Line tool.

Work with Inventor fi le types.  Inventor supports many different fi le types in its native 

environment, separating tasks and fi les to improve performance and increase stability.

Master It  You have trouble keeping the various fi le types straight because all the fi le 

icons look rather similar to you. Is there a way you can see which fi le is what type?

Solution  You may want to turn on the view of fi lename extensions on your system, so 

that you can read them (.ipt, .iam, .idw, and so on) as you open and save fi les. See the 

sidebar “Turning on Filename Extensions” earlier in Chapter 1 for instructions on how 

to do so.

Understand how project search paths work.  Knowing how Inventor resolves fi le paths 

when it opens linked fi les, such as assembly fi les and drawings, goes a long way toward help-

ing prevent broken links and repairing links that do get broken.

Master It  What type of fi le does Inventor use to point the assembly fi le to the parts that 

it contains?

Solution  Inventor uses the project fi le (*.ipj) to hold workspace and library search 

paths. If fi les are outside of these search paths, Inventor will not fi nd the fi les, and you 

will be required to point the assembly to them each and every time.

Set up Library and Content Center paths.  Library and Content Center paths are read-only 

library confi gurations set up in the project fi le.

Master It  When you set up a Library or Content Center path to a folder that does not 

exist, what happens?

Solution  When you create a path to a nonexistent folder, Inventor will create that folder 

for you. Keep this in mind when you create paths in the project fi le, and watch out for 

spelling and syntax errors because Inventor will create a new folder with an incorrectly 

spelled name as well.

Create and confi gure a project fi le.  Project fi les are a key component of working success-

fully in Inventor, but for many people, this is a one-time setup. Once the project is created, for 

the most part you just use it as is.

Master It  After creating a project fi le initially, you want to make one or more changes to 

the confi guration, but you can’t seem to do so. What could be the problem?

Solution  Keep in mind that while you are working with a project fi le, it is held in a 

read-only status by Inventor. To make changes, you need to fi rst close all of the fi les you 

have open that are included in the project path. If you close all the fi les and the project 

is still held in the read-only state, switch to a different project in Inventor, browse for 

the IPJ fi le in Windows Explorer, and then right-click and check the Read-only attribute 

of the IPJ fi le. Windows often seems to leave the Read-only attribute set on IPJ fi les, and 

then it needs to be manually taken off. Once it is off, you can switch back to that project in 

Inventor and make changes.
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Determine the best project type for you.  Although the Autodesk solution to a multiuser 

environment is Autodesk Vault, many people may not be able to use Vault. For instance, if 

you use another CAD application that links fi les together like Inventor, Vault will likely not 

know how to manage the internal links for those fi les.

Master It  Because you generally do not work concurrently on the same fi les as your 

coworkers, you think it might be best to set up a single-user project for now while you 

continue to investigate the Vault solution, but you are not sure if that will work. Can 

single-user projects be used in this manner?

Solution  Set up a single-user project and then point everyone’s computer to that fi le. 

Keep a close eye on how well it works in the fi rst several days, and watch for signs that 

people are making changes to the fi le at the same time. If your workfl ow is fairly linear, 

with one department handing fi les off to the next, this may not be an issue. However, if 

you see that people are reaching for the same fi les at the same time, you probably need to 

make Vault a priority.

Chapter 2: A Hands-on Test Drive of the Workfl ow

Create a part model.  The process of creating a part model starts with an *.ipt template 

fi le. Once you’ve started a part model from a template, you create sketches to defi ne feature 

profi les, and then you make those profi les into 3D features using one of the 3D modeling fea-

ture tools.

Master It  You created a base 3D feature for your parts by extruding a sketch profi le at 

a distance of 15 mm. Then you created other sketches on the top face of the base feature. 

However, you now realize that the base feature should have been 25 mm thick. Can the 

base feature be changed after you’ve created other features on it?

Solution  To modify part features, you can right-click them in the browser and choose 

Edit Feature. Inventor employs the same dialog box used to create a feature originally, to 

edit that feature.

Create and detail drawings of part models.  The process of creating a drawing fi le starts 

with an *.idw template fi le. Once you’ve started a drawing from a template, you create views 

of a referenced part model fi le. After the views are created, you can add dimensions and 

other annotations to the view.

Master It  You’ve created a drawing of a part model and then realize that you need to 

make a change to that model. How will the change to the part model be handled by the 

drawing fi le?

Solution  When you edit a part model that is referenced in a drawing view, the view 

will automatically update. If you change the length of a part model and you have cre-

ated a dimension for this length in the drawing, that dimension will update as well. If 

you dimensioned from the edge of the part to the center of a hole feature in the drawing 

and then edited the part model fi le and deleted the hole, Inventor will either remove the 

drawing dimension or reserve the dimension and highlight it in a different color, to call 

attention to the removed feature.
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Put part models together in assembly fi les.  The process of creating an assembly model 

starts with an *.iam template fi le. Once you’ve started an assembly model from a template, 

you place part model fi les into the assembly and then use Assembly constraints to arrange 

and assemble the part models.

Master It  You’ve assembled your part models in an assembly fi le and then need to 

make a change to a part-model fi le. How will the change to the part model be handled 

by the assembly fi le?

Solution  Changes made to a part-model fi le will be refl ected in all the assemblies in 

which that part-model fi le was used. If the edit to the part model involved changing the 

length of the part, most likely the Assembly constraints will update properly, because 

the faces and edges of the part model used in the Assembly constraint are still present 

but have just been adjusted in size. If a part feature such as a hole was deleted from the 

part, any Assembly constraints that used that hole feature geometry would need to be 

edited or deleted.

Create and detail drawings of assembly models.  The process of creating an assembly 

drawing starts with an *.idw template fi le, just as it did with creating part drawings. Once 

you’ve started a drawing from a template, you can create views of a referenced assembly 

model fi le. After the views are created, you can add annotations such as parts lists and 

callout balloons, as well as dimensions, text notes, and so on.

Master It  You’ve created a drawing of an assembly model and then realize that you 

need to make a change to one of the part fi les within that the assembly model. How will 

the change to the part model be handled by the drawing of the assembly?

Solution  When you edit a part model that is referenced in an assembly model, the 

assembly is updated. If edits to the Assembly constraints are needed, it’s best to open the 

assembly fi le and take care of those things fi rst. Then the views in the assembly drawing 

will automatically update as expected.

Chapter 3: Sketch Techniques

Set up options and settings for the sketch environment.  Understanding the settings 

and options that apply to the sketch environment is an essential fi rst step in working with 

Inventor.

Master It  You want to confi gure your own set of options and settings for your sketch 

environment and then back them up and/or distribute them to other workstations. How 

would you do this?

Solution  There are primarily two sets of options you can confi gure in Inventor. The ap-

plication options confi gure Inventor itself, and the document settings confi gure the settings 

on a per-fi le basis. You access both options and settings by selecting either the Application 

Options or the Document Settings button on the Get Started tab. In the Application Options 

dialog box, select the Sketch tab to confi gure the sketch environment. Once the changes are 

made, you can click the Export button to save the settings as an XML fi le for redistribution.
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Create a sketch from a part fi le template.  Creating a sketch in a blank template fi le is the 

fundamental step in creating 3D parametric models. You will use this basic step to start most 

of your part designs.

Master It  How would you capture the intent of your design when creating a base sketch 

for a new part?

Solution  Use a combination of lines, arcs, and geometry as well as sketch constraints 

and dimensions to properly constrain your sketch. You can then use this sketch to create 

a base feature for your part. Keep in mind the importance of keeping sketches simple and 

fully constrained.

Use sketch constraints to control sketch geometry.  Understanding what each sketch con-

straint does when applied will allow you to determine when to use each type. Recall that 

often more than one constraint will work in any given situation.

Master It  How would you create a sketch that allows you to test “what if?” scenarios 

concerning the general shape and size of your part?

Solution  First ensure that your sketches are properly constrained. Sketches that are 

properly constrained are needed to allow you to experiment with your dimensional pa-

rameters by changing values and testing “what if?” scenarios. If the sketch geometry is 

not properly constrained, changes to dimensions may create unpredictable results.

Master general sketch tools.  Learning the features and tricks of the sketch tools will allow 

you to master Inventor sketching.

Master It  You are given a print of mixed units to work from, and you need to enter 

dimensions exactly as they are on the print. You understand that you can enter any di-

mensions in any unit simply by adding the correct suffi x. But how would you create a 

radius dimension on a circle or a dimension from the tangents of a slot?

Solution  Recall that you switch between variant dimension solutions such as diameter 

to radius simply by right-clicking after having selected the geometry. You can also get 

alternate dimension solutions by selecting different parts of the same geometry. For in-

stance, selecting a line and then almost anywhere on a circle will give you a dimension 

from the center point of the circle to the line, whereas selecting a line and the tangent 

quadrant point of the circle will give you a dimension from the tangent point of the circle 

and the line.

Create sketches from AutoCAD geometry.  You can use existing AutoCAD fi les to create a 

base sketch for an Inventor model of the same part.

Master It  You have many existing 2D AutoCAD drawings detailing legacy parts. You 

want to reuse these designs as you convert to 3D modeling. How would you proceed?

Solution  You can copy and paste selected geometry from AutoCAD directly into an 

Inventor sketch and then turn it into a solid model. Keep in mind that the results are de-

pendent on the accuracy of the original AutoCAD data. Once you become profi cient with 

Inventor, it is often just as quick to model a part from scratch rather than by copying it.

Use 3D sketch tools.  Much of working with a 3D parametric modeler can be done by 

sketching in a two-dimensional plane and then giving depth to the sketch to create 3D 
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features. However, sometimes you need to create paths or curves that are not planar. In those 

cases, you use the 3D sketch tools.

Master It  You know the profi le of a complex curve as viewed from the top and side. 

How would you create a 3D sketch from this data?

Solution  Start by creating a separate 2D sketch for both the top and side views of the 

curve. Then create a 3D sketch and use the 3D Intersection Curve tool to fi nd the inter-

secting curve.

Chapter 4: Basic Modeling Techniques

Confi gure options and settings for part modeling.  Understanding the settings and 

options that apply to the modeling environment is essential for getting the results you want 

from Inventor.

Master It  You want to confi gure your options and settings for your sketch environment 

and then back them up and/or distribute them to other workstations. How would you go 

about doing this?

Solution  You will fi rst confi gure the options and settings by clicking Application Options 

on the Get Started tab and then selecting the Sketch tab in the Application Options dialog 

box. Then use the Export button to save the settings as an XML fi le.

Create basic part features.  In this chapter, you learned how to plan a workfl ow that allows 

you to create stable, editable parts that preserve the design intent.

Master It  You need to create a fairly complex part consisting of many extrusions, 

revolves, sweeps, and lofts. In addition, you will need to create holes, fi llets, chamfers, 

and other part modifi ers. This part may need signifi cant modifi cation in the future by 

you or by other designers. What considerations will guide your part creation?

Solution  Determine how this part will be manufactured. Think about how the part 

might be designed to minimize production costs while still fulfi lling the intent of the 

design by determining how many machining operations will be required. Determine 

the design intent of this part and how your approach will affect stability and any future 

edits or modifi cations.

Use the Extrude tool.  The Extrude tool is one of the most commonly used feature tools in 

the Inventor modeling toolset. Understanding the options and solutions available in this tool 

will prove useful throughout your designs.

Master It  Imagine that you need to create an extruded feature but don’t know the ex-

act length; instead, you know the extrude will always terminate based on another fea-

ture. However, the location of that feature has not been fully determined just yet. How 

do you get started on the feature?

Solution  Use the Extrude To option and extrude the feature profi le to a face or work 

plane of the other feature. Then, as you determine the location of the other feature and 

make adjustments, your extrusion will update as well.

Create revolved parts and thread features.  Creating revolved features and parts in 

Inventor can often resemble the creation of turned parts and features in the real world. 
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Applying thread features to a cylindrical face allows you to specify threads without having 

to actually model them.

Master It  Let’s say you have a part that you intend to fabricate on a lathe. Although you 

could create the part with a series of stepped circular extrusions, it occurs to you that the 

Revolve tool might work also. How do you decide which method to use?

Solution  Oftentimes it may make sense to create a base extrusion from an extruded 

circle and then use the Revolve tool to create revolved cuts. This allows you to design 

both the stock material and the cut features with the intent of the design in mind, antici-

pating changes that might occur. You can then use the Thread tool to apply threads to 

any features requiring them.

Create work features.  Using work features, work planes, work axes, and work points 

enable you to create virtually any part or feature. Work features are the building blocks for 

sketch creation and use.

Master It  Your design will require creating features on spherical and cylindrical faces. 

You need to precisely control the location and angle of these features. How do you do 

that?

Solution  Using existing origin features, created model features and edges, sketch 

objects, and other existing geometry within the fi le will permit you to create parametric 

work features as the basis for additional geometry creation.

Use the Fillet tool.  The Fillet tool has a great deal of functionality packed into it. Taking 

the time to explore all the options on a simple test model may be the best way to understand 

them all.

Master It  You are trying to create a series of fi llets on a part. You create four sets of edge 

selections to have four different fi llet sizes, but when you attempt to apply them, you re-

ceive an error stating that the feature cannot be built. What went wrong?

Solution  Sometimes the creation of multiple fi llet sizes combined into one feature is not 

the way to go. Instead, identify the edges that will “compete” for a common corner, partic-

ularly where they differ in radius size, and create these fi llets as individual fi llet features. 

This allows Inventor to solve the corner in steps and makes the results more robust and 

less ambiguous.

Create intelligent hole features.  Although you can create a hole in a part by sketching a 

circle and extrude-cutting it, this is typically not the recommended approach.

Master It  You need to create a part with a series of various-sized holes on a plate. You 

would like to lay out the hole pattern in a single sketch and then use the Hole tool to cut the 

holes to the sizes required. However, when you select the From Sketch option in the Hole 

tool, it selects all of the holes, so you think you must need to sketch out the hole pattern as 

circles and then use the Extrude tool to cut them out. Is this really the way to proceed?

Solution  Using the Extrude tool is not the way to go. Instead, create a sketch on the 

face of the plate, and use center points to mark the hole centers. Dimension each center 

point in place, and then start the Hole tool. Hold down Ctrl to deselect the center points 

for holes of a different size, and then create the hole feature for the fi rst set of holes. 

Locate your sketch in the browser, right-click it, and choose Share Sketch. Then use the 

Hole tool to place the next size holes.
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Bend parts.  You can bend a portion of a part after you defi ne a bend line using a 2D sketch 

line. You can specify the side of the part to bend, the direction of the bend, and its angle, 

radius, or arc length.

Master It  You need to create a model of a piece of rolled tube and would like to specify 

the bend direction, but when you use the direction arrow, you get a preview in only one 

direction. How can you get a preview in either direction?

Solution  Use a work plane to create a sketch in the middle of the part and then sketch 

the bend line on that work plane. This will allow you to specify either direction for 

the bend.

Chapter 5: Advanced Modeling Techniques

Create complex sweeps and lofts.  Complex geometry is created by using multiple work 

planes, sketches, and 3D sketch geometry. Honing your experience in creating work planes 

and 3D sketches is paramount to success in creating complex models.

Master It  How would you create a piece of twisted, fl at bar in Inventor?

Solution  Create the fl at bar profi le in a base sketch. Then create a work plane offset 

from the original sketch and make it the length of the bar. Create the profi le sketch on 

this work plane at a rotated orientation to match the degree of twist needed. Create a 3D 

sketch, and connect the corners of the fi rst profi le to the appropriate corners of the second 

profi le. Using the 3D sketch lines as rails, use the Loft tool to loft from one profi le to the 

other to produce the twisted part.

Work with multi-body and derived parts.  Multi-body parts can be used to create part fi les 

with features that require precise matching between two or more parts. Once the solid bod-

ies are created, you can create a separate part fi le for each component.

Master It  What would be the best way to create an assembly of four parts that require 

features to mate together in different positions?

Solution  Create the parts in a multi-body part fi le, and subtract material from one part 

based on the profi le of the other. Consider creating the fi rst two parts in one multi-body 

part fi le and the other two in another multi-body part fi le to keep the fi les as simple as 

possible. You can also derive the fi rst multi-body part into the second for better control.

Utilize part tolerances.  Dimensional tolerancing of sketches allows you to check stack-

up variations within assemblies. When you add tolerances to critical dimensions within 

sketches, you can adjust parts to maximum, minimum, and nominal conditions.

Master It  You want to create a model feature with a deviation so you can test the assem-

bly fi t at the extreme ends of the tolerances. How would this be done?

Solution  Use the Parameters dialog box to set up and adjust tolerances for individual 

dimensions. In the Parameters dialog box, set the tolerance to the upper or lower limits 

for the part, and then update the model using the Update button. Check the fi t of the fea-

ture against its mating part or parts in the assembly environment, and then edit the part 

to set it back to the nominal once done.

Understand and use parameters and iProperties.  Using parameters within fi les assists in 

the creation of title blocks, parts lists, and annotation within 2D drawings. Using parameters 
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in an assembly fi le allows the control of constraints and objects within the assembly. 

Exporting parameters allows the creation of custom properties. Proper use of iProper-

ties facilitates the creation of accurate 2D drawings that always refl ect the current state of 

included parts and assemblies.

Master It  You want to create a formula to determine the spacing of a hole pattern based 

on the length of the part. What tools would you use?

Solution  Set up a user parameter that calls the part length and divides by the number 

of holes or the spacing, and then reference this user parameter in the hole pattern feature.

Troubleshoot modeling failures.  Modeling failures are often caused by poor design 

practices. Poor sketching techniques, bad design workfl ow, and other factors can lead to the 

elimination of design intent within a model.

Master It  You want to modify a rather complex existing part fi le, but when you change 

the feature, errors cascade down through the entire part. How can you change the feature 

without this happening?

Solution  Position the end-of-part marker just under the feature you intend to modify, 

and then make the change. Then move the end-of-part marker back down the feature tree 

one feature at a time, addressing each error as it occurs. Use the Rebuild All tool from 

time to time to see if recomputing the tree will force a “fi x” to cascade down the tree. 

Continue until all features have been fi xed.

Chapter 6: Sheet Metal

Take advantage of the specifi c sheet-metal features available in Inventor.  Knowing what 

features are available to help realize your design can make more effi cient and productive use 

of your time.

Master It  Of the sheet-metal features discussed, how many require a sketch to produce 

their result?

Solution  Five sheet-metal features consume a sketch: Contour Flange, Face, Cut, Punch, 

and Fold. Since Inventor has well-established paradigms for how sketches can be manip-

ulated, knowing which features consume sketches may allow you to develop designs that 

are fl exible and parametrically confi gurable.

Understand sheet-metal templates and rules.  Templates can help get your design started 

on the right path, and sheet-metal rules and associated styles allow you to drive powerful 

and intelligent manufacturing variations into your design; combining the two can be produc-

tive as long as you understand some basic principles.

Master It  Name two methods that can be used to publish a sheet-metal rule from a 

sheet-metal part fi le to the style library.

Solution  Rules and styles can be published or written to the style library either from 

Inventor or by using the Style Management Wizard (the harvester). Using the native 

Inventor method, right-clicking a given rule/style produces an option called Save To 

Style Library. Using the harvester, you can select a specifi c fi le and add its style infor-

mation to your existing style library, or create a new one.
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Author and insert punch tooling.  Creating and managing Punch tools can streamline your 

design process and standardize tooling in your manufacturing environment.

Master It  Name two methods that can be utilized to produce irregular (nonsymmetric) 

patterns of punch features.

Solution  Sketch center marks can be patterned within the insertion sketch as a sym-

metric array. During Punch tool insertion, the Centers control on the Geometry tab can be 

used to deselect center marks where you want a tool to be placed. The feature-patterning 

tools can also be used to create irregular patterns after a punch feature has been created. 

You can do this by fi rst creating a symmetric pattern of punch features, then expanding 

the child pattern occurrences in the feature browser, and fi nally, individually suppress-

ing them. Both methods prevent the feature from being displayed in the folded and fl at 

pattern as well as omit the Punch tool information in the fl at-pattern punch metadata.

Utilize the fl at pattern information and options.  The sheet-metal folded model captures 

your manufacturing intent during the design process; understanding how to leverage this 

information and customize it for your needs can make you extremely productive.

Master It  How can you change the reported angle of all your Punch features by 90 

degrees?

Solution  The fl at pattern’s orientation infers a virtual x-axis for punch angle calcula-

tion, so rotating the fl at pattern by 90 degrees will change all the punch angles by the 

same amount. The fl at pattern can also affect the bend and punch direction (up or down) 

by fl ipping the base face, and reported bend angles can be changed from Bending Angle 

to Open Angle by changing options in the Bend Angle tab of the Flat Pattern Defi nition 

dialog box.

Understand the nuances of sheet-metal iPart factories.  Sheet-metal iPart factories enable 

you to create true manufacturing confi gurations with the inclusion of folded and fl at pattern 

models in each member fi le.

Master It  If you created sheet-metal iPart factories prior to Inventor 2009, any instanti-

ated fi les contain only a folded model. Name two methods that you could use to drive the 

fl at pattern model into the instantiated fi le.

Solution  Once you have opened, migrated, and saved a legacy sheet-metal iPart fac-

tory, you can decide between two methodologies for obtaining the fl at pattern model 

within your instantiated fi les: push or pull. The push method is accomplished from within 

the iPart factory by using the context menu option Generate Files, which is associated 

with the member fi lename. This method pushes out a new defi nition of the member fi le 

including the fl at pattern model. The pull method requires you to be using the Inventor 

Rebuild All tool, followed by saving the factory fi le. Now that the factory has been re-

built, any time you open one of the instantiated fi les associated with the factory, it will 

see that it’s out-of-date and will trip the update fl ag. Selecting Update will pull the fl at 

pattern model into the instantiated member fi le.

Model sheet-metal components with non-sheet-metal features.  Inventor doesn’t always 

allow you to restrict yourself to sheet metal–specifi c design tools; understanding how to uti-

lize non-sheet-metal features will ensure that your creativity is limitless.
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Master It  Name two non-sheet-metal features that can lead to unfolding problems if 

used to create your design.

Solution  As discussed in the chapter, Loft and Shell can lead to numerous problems 

during unfolding because of nondevelopable curvature introduced by Loft and nonuni-

form thickness introduced by Shell.

Work with imported sheet-metal parts.  Understanding the way in which Inventor accom-

plishes unfolding as well as how to associate an appropriate sheet-metal rule are keys to 

successfully working with imported parts.

Master It  Name the one measured value that is critical if you want to unfold an im-

ported part.

Solution  The measured sheet thickness is the most important geometric measure-

ment in an imported sheet-metal part. Ensuring that the thickness of your imported 

part matches the active Thickness parameter means the difference between success and 

frustration. Although you can change the active rule (or create a new one) to match all the 

geometric conditions of your imported part, these will affect only new features or topol-

ogy that you introduce. Thickness is the key.

Understand the tools available to annotate your sheet-metal design.  Designing your 

component is essential, but it’s equally important to understand the tools that are available to 

effi ciently document your design and extract your embedded manufacturing intent.

Master It  What process is required to recover fl at pattern width and height extents 

within your Drawing Manager parts list?

Solution  By creating custom iProperties within your sheet-metal part fi le set equal to 

<FLAT PATTERN LENGTH> cm and <FLAT PATTERN WIDTH> cm, you can refer-

ence fl at pattern extents by your parts list by adding these new properties using the 

Column Chooser tool. To make this process more effi cient, you can predefi ne the custom 

iProperties in your sheet-metal template fi le, and the custom properties can be authored 

into a custom Drawing Manager parts list template for quick application.

Chapter 7: Reusing Parts and Features

Create and modify iParts.  iParts are the solution to creating parts that allow for an infi nite 

number of variations without affecting other members of the same part family already used 

within your designs.

Master It  You use a purchased specialty part in your designs, and would like to create 

the many size confi gurations that this part comes in ahead of time for use within assem-

bly design. How would this be done?

Solution  Create or use an existing model, and edit the parameter list to use logical 

names for specifi c parameters. Add the confi guration table by creating an iPart from this 

model. Confi gure the parameters in the table and add rows according to variations need-

ed. And fi nally, test the newly created iPart by inserting all variations of the part into a 

blank assembly.
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Create and use iFeatures and punches.  Creating a library of often-used features is essen-

tial to standardization and improved productivity within your design workfl ow.

Master It  You want to be able to place common punches, slots, and milled features 

quickly rather than having to generate the feature every time. What is the best way to 

approach this?

Solution  Extract iFeatures from existing standard and sheet-metal part features, and 

place them in user-defi ned folders within the Catalog subfolder. Using your custom-

created iFeatures as well as standard iFeatures, practice placing them into your designs to 

see how they behave and how they can be modifi ed. Finally, once the iFeatures or punch-

es have been proven to work as expected, use them to quickly place common features in 

your production designs.

Copy and clone features.  You do not have to create iFeatures to reuse various part features 

in your designs. If a part feature will have limited use in other designs, it is often better to 

simply copy it from part to part or from face to face on the same part.

Master It  You need to reuse features within a part or among parts. You consider 

iFeatures but realize that this feature is not used often enough to justify setting up 

an iFeature. How would you proceed?

Solution  Right-click the existing feature, and choose Copy. Determine whether depen-

dent and independent features such as fi llets and chamfers need to be copied as well, and 

then paste the feature onto another face in the same part. Or open a different part fi le 

and paste onto a selected face. Copying between two parts is called cloning.

Link parameters between two fi les.  Linking design parameters between two or more fi les 

allows you to control design changes from a single source, making it easy to update an entire 

design from one fi le.

Master It  You want to specify the overall length and width of a layout design in a base 

part and then have other components update as changes are made to this part. What are 

the methods to do this?

Solution  From the other component fi les, open the parameter editor, use the Link but-

ton to specify the source fi le, and then choose which parameters to link. You can then call 

those linked parameters into the sketch and feature dimensions of the other components 

in your design.

Confi gure, create, and access Content Center parts.  Content Center provides a great 

opportunity to reuse database-created geometry within assemblies and within functional-

design modules. The Content Center Editor provides the means to add custom content into 

Content Center. You can create and add custom libraries to your current project fi le.

Master It  You would like to change the part numbers in some Content Center compo-

nents to match the part numbers your company uses. You would also like to add propri-

etary components to Content Center. How do you customize Content Center?

Solution  Create a custom Content Center library. Confi gure your project fi le to include 

your newly created read/write Content Center library. Utilize the Content Center Editor 

to create new categories within your custom Content Center library. Convert a part or an 

iPart to a Content Center component using the Publish option.
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Chapter 8: Assembly Design Workfl ows

Create assembly relationships using the Constraint and Joint tools.  Assembly relation-

ships are an important part of working with Inventor assembly fi les. Assembly constraints 

determine how assembly components fi t together. As relationships are applied between com-

ponents, degrees of freedom are removed.

Master It  You are new to 3D and fi nd the concept of assembly relationships a bit chal-

lenging. Where can you fi nd a simple overview of constraints?

Solution  You can fi nd a good overview of constraints by selecting the Get Started tab 

and clicking the Place And Connect Parts button in the tutorials section. From there, you 

can follow the interactive tutorial using the panel on the right.

Organize designs using structured subassemblies.  Subassemblies add organization, 

facilitate the bill of materials, and reduce assembly relationships; all this results in better per-

formance and easier edits. One of the habits of all Inventor experts is their effective use and 

understanding of subassemblies.

Master It  You need to hand off an accurate BOM for fi nished designs to the purchas-

ing department at the end of each design project. How can the BOM be extracted from 

Inventor?

Solution  Organize parts in subassemblies in a real-world manner matching the way 

components are assembled on the shop fl oor. Use Phantom assemblies when structur-

ing parts merely for the purpose of reducing assembly relationships. Set assemblies as 

Purchased or Inseparable when you want multiple components to appear as a single item 

in the BOM. Export the BOM from the assembly to an Excel spreadsheet or other interme-

diate format to give to purchasing.

Work with adaptive components.  Geometry can be set to be adaptive so that it can be 

sized and positioned in the context of where it is used in the assembly. You can set undercon-

strained geometry to be adaptive by specifying the elements allowed to adapt.

Master It  You want to set a feature of a part to be adaptive so that it can adapt to anoth-

er part in an assembly. However, the feature is based on a fully constrained sketch. How 

would this be done?

Solution  To set a fully constrained sketch to be adaptive, you would edit the sketch and 

then set the dimensions that are intended to adapt to be driven dimensions. Doing so 

leaves the sketch in an underconstrained state, opening it up for adaptivity.

Create assembly-level features.  An assembly feature is a feature created and utilized 

within the active assembly fi le. Because the feature is created within the assembly fi le, it does 

not exist at the single-part or subassembly level.

Master It  You want to make a notch in a standard part that will not affect its use in ev-

ery other assembly it is used in. Can this be done?

Solution  Create the notch in the assembly that it is used in rather than the part fi le 

itself, and then the notch will exist only for that instance of the part and not in other in-

stances of it.
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Manage bills of materials.  Managing a bill of materials can be a large part of any assembly 

design task. Understanding the BOM structure goes a long way toward successfully confi g-

uring your bill of materials.

Master It  You need to mark a component as a reference component in just one assembly 

fi le. However, when you attempt to do so using the BOM Editor, it is designated as a ref-

erence in every assembly. How can you set just a single instance of a component to be a 

reference component?

Solution  When components are set to reference in the BOM Editor, the BOM structure 

for the fi le is being changed globally. To override a component’s BOM structure per in-

stance, right-click it in the browser and choose BOM Structure, and then select Reference.

Use positional reps and fl exible assemblies together.  Often, you may need to show a 

design in various stages of motion to test interference and/or proof of concept. Copying 

assemblies so that you can change the assembly relationships to show different assembly 

positions can become a fi le management nightmare. Instead, use fl exible subassemblies and 

positional representations.

Master It  You need to show your assembly in variations dependent on the position of 

the moving parts and the task the machine is accomplishing at given stages of its opera-

tion. How do you do this?

Solution  Leave subassemblies underconstrained if they have parts that determine their 

position based on the relationships with parts within another subassembly. Set them to 

Flexible to allow them to be mated to other parts and used in different positions within 

the same top-level assembly. Create positional representations to show the design in 

known kinematic states, such as fully opened, closed, opened at a given angle, and so on. 

As an added benefi t, animating assemblies in Inventor Studio is simple when positional 

representations have been set up in the model.

Copy assembly designs for reuse and confi guration.  Because of the live linked data that 

exists in Inventor assemblies, using Windows Explorer to copy designs and rename parts is 

diffi cult and often delivers poor results. Using the tool provided in Inventor will allow you to 

copy designs and maintain the links between fi les.

Master It  How do you duplicate an existing design to create a similar design?

Solution  Use the Copy Components feature in the assembly environment to copy 

designs and choose which parts to copy and rename, reuse, or omit from the new design. 

Use Autodesk Vault to take it to the next level and include all the 2D drawings in the cop-

ied design.

Substitute a single part for entire subassemblies.  Working with large assemblies, particu-

larly where large, complex assemblies are used over and over as subassemblies within a 

top-level design, can tax almost any workstation if not approached in the correct manner.

Master It  You would like to swap out a complex assembly for a simplifi ed version for 

use in layout designs or to use in large assemblies in an attempt to improve performance. 

What is the best way to do that?

Solution  Create LOD representations to suppress components when not in use during 

the design cycle. Create single substitute parts from large complex assemblies to be used 
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as subassemblies within the design. Enjoy the benefi ts of referencing fewer fi les while 

maintaining an accurate bill of materials.

Work with assembly design accelerators and generators.  Design accelerators and genera-

tors allow you to rapidly create complex geometry and the associated calculations that verify 

the viability of your design.

Master It  Your design needs a bolted connection, but you are not certain about the 

number of bolts to use to ensure a proper connection. How do you determine this?

Solution  Use the Bolted Connections tool to determine the optimum number of bolts 

for a given material and loading conditions.

Use design calculators.  Design calculators do not create any geometry, but they permit 

you to store the calculations in the assembly and repeat the calculation with different input 

values at a later time.

Master It  You need to calculate the size of a weld between two plates to withstand a 

certain lateral force. What tool do you use?

Solution  Use the Fillet Weld calculator to determine the size, type, and material of the 

weld bead.

Chapter 9: Large Assembly Strategies

Select a workstation.  Having the right tool for the job is the key to success in anything you 

do. This is true of selecting a large assembly workstation. You have learned that for optimal 

performance you should strive to keep your system working in physical memory (RAM).

Master It  You notice that your computer runs slowly when working with large assem-

blies and you want to know whether you should consider a 64-bit system. How do you 

determine if your system is adequate or if it’s time to upgrade?

Solution  To decide whether your system is adequate, evaluate the amount of time 

you spend working on large assemblies and the percentage of that time that you spend 

waiting on your workstation. Monitor your RAM usage, and decide whether upgrading 

to a 64-bit system is a good solution for your needs. You should plan for hardware 

upgrades in your budget to make them more manageable. Remember that if you have 

a system that was built in the last year or two, it may already be capable of running a 

64-bit operating system, so you may only need to upgrade the OS rather than replace 

the hardware.

Adjust your performance settings.  You have learned that there are many settings in 

Inventor and in Windows that you can use to confi gure the application to work more 

effi ciently with large assemblies.

Master It  You want to make your current workstation run as effi ciently as possible for 

large assembly design. What are some ways to do that?

Solution  Disable the unneeded Windows visual effects and discontinue the use of 

screen savers, large-resolution screen sizes, and desktop wallpapers. Learn the location of 

the Application Options settings within Inventor that will provide performance gains.
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Use best practices for large assembly.  Knowing the tools for general assembly design is 

only half of the battle when it comes to conquering large assemblies. Understanding the 

methods of large assembly design and how they differ from those for general assembly 

design is a key to success.

Master It  You want to create adaptive parts so that you can make changes during the 

initial design stage and have several parts update automatically as you work through 

the details. But you are concerned about how this will adversely affect your assembly 

performance. How do you keep your performance level high in this situation?

Solution  Create adaptive relationships between parts as you normally would, but 

ensure that the adaptivity is turned off once the initial design is done. If the parts require 

an update, turn Adaptivity back on, make the edits, and then turn Adaptivity back off.

Manage assembly detail.  Inventor includes several tools to help manage assembly detail so 

that you can accomplish your large assembly design goals.

Master It  You want to reduce the number of fi les your large assembly is required to ref-

erence while you are working on it and yet maintain an accurate bill of materials. How do 

you do that?

Solution  Use substitute LOD representations to derive a subassembly into a single part 

fi le. Place multiple instances of the subassembly into the top-level assembly at the substi-

tute level of detail.

Simplify parts.  Creating highly detailed parts may be required for generating production 

drawings or Inventor Studio renderings, but using those high-detail parts in large assemblies 

may have an adverse effect on performance.

Master It  You want to create a lower-level-of-detail part fi le for common parts to be 

reused many times over in your large assemblies but are concerned about managing two 

versions of a part. How do you avoid versioning problems?

Solution  Create an embedded link between the two versions so that you can easily 

locate and access the other version if the fi rst version requires an edit.

Chapter 10: Weldment Design

Select and use the right weldment design methodology.  You’ve been shown three weld-

ment design methodologies. Before you start on any weldment design, it is imperative to 

keep the documentation, interference analysis, mass properties, and other design criteria in 

perspective and select the right design methodology.

Master It  How do you choose the right weldment strategy for you?

Solution  If you don’t need to document the weldment design stages, you could con-

sider the part fi les and part features methodology or the weldment assembly and derived 

methodology. With the weldment assembly methodology, you get to document the dif-

ferent stages of weldment design and reap the benefi ts of any new enhancements. Talk 

to your machine shop, and then choose the one that best suits you. Use the weldment as-

sembly design methodology if you can’t decide.
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Create and edit weld preparations and machining features.  Following the weldment 

methodology, you need to plan on creating the gaps needed (weld preparations) to deposit 

the weld beads. You need to create post-weldment machining features that go through the 

weld beads.

Master It  Weld preparations and machining features are similar to part modeling 

features. Based on the weld-bead shape needed, you should plan on creating the prepa-

rations in advance. Once the welds are done, you must create the features for the machin-

ing processes. Where can you fi nd preparation and machining features, and when do you 

use them?

Solution  Double-click the Preparations or Machining tool in the assembly browser to 

go into those environments. Chamfer and Move Face are most commonly used. Most 

groove welds require some kind of weld preparations.

Create and edit different kinds of weld beads, such as cosmetic, fi llet, and 
groove.  Weldment design involves the optimal mix of cosmetic and solid weld beads, based 

on the requirements of your design goals and model verifi cation needs.

Master It  You should create the weld annotations only in drawings, without any need 

to create them in the model. You have weld subassemblies that need only lightweight rep-

resentation in both the model and drawings. In situations involving accurate interference 

and mass properties, you require accurate weld beads. The question is, What type of weld 

beads should you use?

Solution  Double-click Welds in the assembly browser, and choose the desired weld 

bead type. For a lightweight representation with no interference and accurate mass prop-

erties, use cosmetic welds. For interference and accurate mass properties, use the solid 

representation. Use a combination of fi llet and groove welds as needed to generate the 

desired weld-bead shape. Use the split technique in cases where you want precise control. 

Observe that you can use a single weld symbol to call out multiple weld beads.

Document weldment stages in drawings.  Welds need to be documented in assemblies or 

drawings. It is important to show the different stages of weldment design in drawings to get 

a good idea of how to manufacture the weldment. You can use the drawing tools effectively 

to annotate the welds in drawings. This will help the welder understand the design intent 

better.

Master It  Several tools are used for weld documentation. You can annotate the welds 

in assemblies. If you prefer to document the welds in drawings, you could document 

the four stages of weldment design: the as-assembled, as-prepped, as-welded, and 

as-machined stages in drawings. Name two other drawing tools that customize weld 

documentation.

Solution  While creating a drawing view on the Model State tab of the Drawing View 

dialog box, select Assembly, Machining, Welds, or Preparation. Use the End Fill tool to 

customize the weld-bead process shape. Weld Caterpillars is another useful tool to show 

welds in a drawing.

Generate and maintain a consistent BOM across welded assemblies, drawings, and 
presentations.  You have been shown how to generate and maintain a consistent bill of 
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materials for weldment assemblies and a parts list in drawings. Mark parts or assemblies as 

inseparable to designate them as weldments.

Master It  How do you generate the BOM and parts list for your weldment?

Solution  You can generate the bill of materials and mark the components as insepa-

rable. In the drawing, you generate the parts list for the weldment assembly. Click the 

BOM tool in a weldment assembly. In the Structure column, you can set each part to be 

inseparable. Use the Parts List tool and appropriate table-wrapping options to generate 

the parts list.

Chapter 11: Presentations and Exploded Views

Create an exploded assembly view by creating a presentation.  Presentation fi les are used 

to virtually disassemble an assembly so downstream consumers can better visualize the 

design. The explosion created in the presentation fi le can be referenced in an assembly draw-

ing to complement nonexploded assembly views.

Master It  Your assembly design is complex and contains many internal components 

that can’t be visualized in traditional assembly drawing views. What is a good approach 

to showing those components?

Solution  Create a new presentation fi le, reference an assembly, and tweak parts and 

subassemblies away from their constrained positions. Add as many tweaks as necessary 

to communicate the design effectively. You may choose to create several explosions in one 

presentation fi le to achieve this goal.

Create basic linear tweaks.  Tweaks are used to move (or translate) components along a 

specifi ed axis. This allows you to pull your assembly apart, in order to show how it goes 

together.

Master It  Your assembly design includes a number of hardware connections, and you’d 

like to show how they go together in a clear and concise way. How should you do this?

Solution  Creating linear tweaks in a presentation view can often show screw, washer, 

and nut stack-ups more clearly than they can be shown in an assembled view on a 

drawing.

Create rotational tweaks.  Rotational tweaks allow you to move components in an orienta-

tion that is not along the standard x-, y-, and z-axes, and that can be used to show rotation of 

parts for animations.

Master It  Your assembly has a housing that you’d like to tip out of the way to show both 

the parts within and the connection features of the housing. When you apply a linear 

tweak, you can move the housing up and off the assembly to show the parts, but you can-

not see the connection features. What do you need to do to see the connection features?

Solution  You can use a rotational tweak to tip over the housing part and expose the 

underside to the view. Using linear and rotational tweaks together is often the best way 

to add clarity to your assembly presentation views.

Group, reorder, and animate tweaks.  Once tweaks are created, you may want to group 

several of them together into the same sequence of steps, and reorder them to show a specifi c 

assembly step in an animation.
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Master It  You want to create an animated assembly presentation of your assembly 

going together, but when creating the tweaks, you did so by going from top to bottom of 

the assembly rather than following the order in which the assembly would actually take 

place. Can this be resolved?

Solution  You can use the Group and Reorder tools to refi ne your presentation after it’s 

initially created. This is often helpful when you’ve created a presentation for the purpos-

es of a 2D drawing view and didn’t consider the order in which tweaks were created, but 

then decide later to animate it.

Publish presentation fi les.  Although you can place views of your presentation fi le on a 2D 

drawing, it can be helpful to include the 3D animation for customers and colleagues in the 

form of a DWF or DWFx fi le.

Master It  You want to supply the shop fl oor with assembly instructions of your assem-

bly going together. What is a good way to do this?

Solution  You can output your presentation sequences as a lightweight DWF or DWFx 

fi le and then allow the people on the shop fl oor to use Autodesk Design Review or 

Internet Explorer to view the fi les. Using presentation fi les in this way can add a great 

deal of clarity to build procedures and assembly instructions.

Chapter 12: Documentation

Create templates and styles.  Inventor provides numerous methods to create, store, and 

use drawing templates and styles. Careful planning as to how and where to manage these 

resources is important. Consideration must be given to how templates are deployed on your 

network and whether to use the style library.

Master It  Rather than using one of the out-of-the-box drawing settings, you need to set 

up a drawing template, a drafting standard, and annotation styles to conform to a par-

ticular international, industry, or company drafting standard. How do you get started?

Solution  Use one of the drawing templates that are installed with Inventor, and recon-

fi gure it to meet your or your company’s requirements. Edit the drawing resources to 

customize your title block, border, and sketched symbols. Defi ne annotation styles such 

as dimension and parts list styles, and determine how best to share them across your 

workgroup.

Utilize drawing resources.  Each Inventor drawing fi le contains a number of commonly 

used drawing-resource defi nitions, such as title blocks, borders, symbols and so on. These 

resource defi nitions allow you store preconfi gured items for quick and easy reuse.

Master It  You have blocks of general notes that you place on every drawing fi le. 

However, some drawings get one set of notes, and others get another, so making these 

notes part of the title block seems to be the wrong approach. Is there a way to handle this 

in Inventor? 

Solution  You can create a sketched symbol for each of the note blocks and type out 

the notes using the Text tool. Then when you create a new drawing fi le, you can choose 

which block of notes to place on the drawing and insert it from the Sketched Symbols 

folder found in the Drawing Resources folder. 



938 | APPENDIX A THE BOTTOM LINE

Edit styles and standards.  Inventor’s drawing styles and standards allow you to set up 

your dimension styles, layer styles, and so on in advance, so that you can maintain consis-

tency across all of your drawings.

Master It  You have set up your object defaults to use an inch-based dimension style, but 

occasionally you want to place a millimeter-based dimension. Can this be done easily or 

do you have to override the dimension style?

Solution  Typically, you will set up several dimension styles in your template fi le. In this 

case you might have one for Imperial and another for metric dimensions. Although only 

one dimension style can be the default style that is selected when you start the Dimension 

tool, you can set the dimension tool to use another style. To do this, fi rst start the 

Dimension tool, then go to the Format panel and select the styles pull-down, and choose 

a different dimension style from list. You can also select previously placed dimensions 

and change them to use a different style using the same pull-down.

Create drawing views.  Drawing views allow you to make 2D views of your 3D models. 

The hidden line generation and alignment of your projected views are automatic, as are 

updates to the 2D views when your 3D models change. 

Master It  When placing a drawing view, the lines on curved edges don’t show up. Is 

there an option to turn these on?

Solution  When placing a view or editing a view, you can click the Display Options tab. 

Here, you’ll fi nd several options to control the visibility of tangent edges, interference 

edges, thread lines, and many other optional display items.

Annotate part drawings.  Adding annotation to your part drawings is accomplished 

primarily using the tools found on the Annotate tab. Many of these tools automate tradi-

tional drafting annotation, but you might still fi nd the need to add annotation in a more 

manual way.

Master It  You need to create sheet-metal fl at patterns for your parts with laser etch-

ing on them. Often this is text, but you’ve noticed that if you attempt to create text as an 

extrusion on the part, you end up with a stencil effect, rather than single-line characters 

used for etching. Is there a way to do this?

Solution  There are a couple of methods for doing this, but the most common is accom-

plished by creating a sketch in the drawing environment. First, you select the fl at pattern 

view, and then you click the Create Sketch button from the Annotate tab. By selecting 

the view fi rst, the sketch is associated to the view, and if the view is moved, the sketch 

will move also. To add the laser etching information, you can use the Text tool and select 

a font such as Simplex. You can also sketch lines and other geometry if needed. Using 

the Project Geometry tool lets you anchor and dimension your text and lines to the part 

edges for precise placement.

Annotate assembly drawings.  Often, much of the annotation created for assembly draw-

ings concerns bill of materials information, but you can use most of the same annotation 

tools used for part drawings in an assembly drawing.

Master It  You created a section view of your assembly model and then noticed that you 

could hide the hatch pattern by right-clicking it and choosing Hide. But now when you 
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right-click the drawing view, you can’t fi nd an option to bring back the hatch pattern. Is 

gone for good? 

Solution  To bring back a hidden hatch pattern, edit the view and click the Display 

Options tab. On this tab you’ll fi nd a Hatching check box. Select it, and then your hatch 

pattern will be displayed again.

Work with sheet-metal drawings.  Inventor sheet-metal drawings give you access to the 

folded model and the fl at pattern, provided that a fl at pattern has been created in the 3D 

model.

Master It  When you place a bend note on a fl at pattern drawing, it places the direction, 

angle, and bend radius. Your shop is accustomed to seeing only the direction and angle. 

Is there a way to remove the bend radius?

Solution  If you right-click a bend note and choose Edit Bend Note, you can remove the 

radius notation for that note. To do this for all of the bend notes on the sheet, right-click a 

bend note and choose Edit Dimension Style. This will take you to the Notes And Leaders 

tab of the edit dialog for the dimension style containing the bend note. Use the radio but-

ton near the top to select the Bend Note option, and then you can make changes that will 

update all of the bend notes.

Work with weldment views.  Weldment views offer some extra functionality over standard 

assembly views in that they allow you to document your assembly in each weldment stage.

Master It  You want to create a drawing package that shows all of the weldment pieces 

in the prepped stage and then show the weldment assembly in the completed form. 

What’s the best way to do this?

Solution  When you place a view of the weldment assembly, you can use the Model 

State tab of the view creation dialog box to choose each component of the weldment in 

the Preparation stage.

Work with iParts and iAssembly drawings.  One of the benefi ts of creating part and 

assembly families as iParts and iAssemblies is the ability to created tabulated drawings that 

show each member and its key dimensions in a table.

Master It  You’ve created an iPart table and want to set the dimension on the sheet to 

match the table heading. Is this possible?

Solution  You can do this by simply overriding the dimension value. First, edit the di-

mension and then select the Hide Dimension Value check box. Then, type in the table 

heading name.

Share your drawings outside your workgroup.  You can save your drawings in DWF, 

DWFx, and PDF formats in order to share them with people who do not have Inventor. You 

can use Autodesk Design Review to access DWF fi les and Adobe Acrobat Reader to access 

PDF fi les; both are free viewer applications.

Master It  You have a multi-page Inventor drawing, but when you export it as a PDF fi le 

you only get the fi rst page. Is this a bug, or is just the way it is?

Solution  When you export a drawing as a PDF you will be presented with the Save 

Copy As dialog box. In this dialog box, there is an Options button; if you click this button 

you’ll fi nd an option to include all drawing sheets.
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Chapter 13: Tools Overview

Take your models from Inventor to the Autodesk Building Systems program.  If you 

frequently need to take your Inventor models to ABS, BIM Exchange can help you in this pro-

cess with three simple steps. Inventor provides a variety of ways to simplify the model and 

author it. Such models can be published in ABS.

Master It  Describe the basic steps involved in moving Inventor models to Autodesk 

Building Systems.

Solution  You can do this with the following three steps: model simplifying, authoring, 

and publishing. Author the model with cables, conduit, ducts, or pipe. Create part fami-

lies and catalogs.

Create AutoLimits (design sensors).  You use AutoLimits to monitor design parameters in 

which you are interested.

Master It  You want to use AutoLimits for every dimension in your model. How many 

AutoLimits can you use at once?

Solution  Create the AutoLimits and set up their boundaries. Although technically 

the number of AutoLimits you can use in your model is unlimited, you should consider 

limiting the number of AutoLimits to around 10 to avoid impacting the performance of 

your model.

Manage design data effi ciently using Inventor tools.  There are different tools for manag-

ing design data, which is typically distributed across part, assembly, and drawing fi les. You 

can associate Excel spreadsheets, text fi les, Word documents, and so on with these tools.

Master It  Name some of the Inventor tools for managing design data. Describe what 

each one does and how to initiate it.

Solution  The Design Assistant keeps the fi le relationships while copying, renaming, 

and moving fi les. Whenever you are sending Inventor fi les to others, use Pack And Go, 

which hunts down the fi le relationship for you, and then you can package them into a 

single ZIP fi le. You can delegate many of the tasks in Inventor to the Task Scheduler. You 

can propagate source drawing template information to several destination drawings us-

ing the Drawing Resource Transfer Wizard. In the Design Assistant, click the Manage 

button. Right-click the fi le in the Action column, and select Action. Right-click the fi le in 

the Name column, and select Change Name. Click Save Changes. Right-click the fi le in 

Windows Explorer to use Pack And Go. In the Task Scheduler, use the Create Task menu 

to create your task. In the Drawing Resource Transfer Wizard, select source resources, 

deselect any unwanted resources, and propagate the template information to destination 

drawings.

Manage styles.  You can use the Style Library Manager to organize your styles to keep them 

simple and clean.

Master It  Styles normally need to be copied, edited, and deleted. How do you manage 

your styles? How can you create a central repository of styles?

Solution  You can create a new style library using the Create New Style Library button 

in the Style Library Manager. You can copy styles by clicking Style Library 1 and then 
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clicking Style Library 2. To delete styles, right-click the style in the Style Library Manager, 

and then rename or delete the style.

Create expressions with iProperties.  Property fi elds can be concatenated to produce 

desired customized information in BOM and parts lists. For example, you can break down 

your parts by stock size to be used in your BOM with associativity to model parameters.

Master It  How do you create and manage expressions for iProperties?

Solution  You can create expressions on the Summary, Project, Status, or Custom tab. 

Start with the = sign, and type in the text. To include parameters or iProperty names, 

include them in brackets. A detected expression is denoted by fx. You can create a tem-

plate fi le with predefi ned expressions for iProperties to unify your parts list and other 

documentation.

Give feedback to Autodesk.  You can participate in the Customer Involvement Program 

(CIP). Customer error reporting (CER) helps Autodesk know about any issue you might 

experience.

Master It  You have a repeatable crash that you suspect is related to a specifi c fi le or a 

specifi c machine, and want to know if Autodesk can help you determine this.

Solution  You can use the CER form to supply contact information and step-by-step 

information about repeatable issues and then call reseller support or log a case with 

Autodesk through the subscription website. Autodesk can look up your CER based on the 

submittal time and contact information you entered.

Chapter 14: Exchanging Data with Other Systems

Import and export geometry.  In the design world today, you most likely need to transfer 

fi les to or from a customer or vendor from time to time. Chances are, the fi les will need to be 

translated to or from a neutral fi le format to be read by different CAD packages.

Master It  You are collaborating with another design offi ce that does not use Inventor. 

You are asked which you would prefer, IGES or STEP fi les. Which one should you 

request?

Solution  Request a STEP fi le over IGES when you have the choice. Take advantage of 

the extra intelligence related to assembly structure and fi lenames that can be retained in 

the STEP fi le format.

Use Inventor fi le translators.  Inventor offers native fi le translators for CATIA, Pro/

ENGINEER, SolidWorks, Unigraphics, and other CAD fi le types. This allows you to access 

these fi le formats with Inventor and translate the fi les into Inventor fi les directly.

Master It  You are a “job shop” and in the past have been required to maintain a copy 

of SolidWorks in addition to your copy of Inventor to work with customers who send you 

SolidWorks fi les. You would like to eliminate the cost of maintaining two software pack-

ages. What is a good strategy for doing that?

Solution  Use Inventor to access the customer’s fi les directly and convert them to 

Inventor fi les for your in-house use. Use Save Copy As to export the fi le back out as a 
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SolidWorks fi le to send to the client for review. In this way, you may be able to eliminate 

the need to maintain two software packages.

Work with imported data.  Using the construction environment in Inventor, you can repair 

poorly translated surface fi les. Often, a fi le fails to translate into a solid because of just a few 

translation errors in the part. Repairing or patching the surfaces and promoting the fi le to a 

solid allows you to use the fi le more effectively.

Master It  You download an IGES fi le from a vendor website, but when you attempt to 

use the component in your design, the surface data is found to have issues. How should 

you proceed?

Solution  Open the fi le and copy the surfaces to the construction environment. Use 

Stitch Surface to create composite surfaces, and identify the gaps in the surface data. Use 

the construction tools to delete, patch, and extend surfaces in order to close the gaps and 

promote the data to a solid. Before getting started on this, evaluate the amount of time 

required to repair the surface data. You may fi nd that you can model the vendor compo-

nent—by using catalog specs or by measuring an actual part—faster than you can repair 

some surface models.

Work with Design Review markups.  Design Review offers you and the people you col-

laborate with an easy-to-use electronic markup tool that can be round-tripped from Inventor. 

Design Review markups can be made on both 2D and 3D fi les.

Master It  You want to use Design Review to communicate with vendors and clients 

to save time and resources, but you have found that others are unsure of what Design 

Review is and how to get it. What are some good ways to help others begin to use this 

handy application?

Solution  Suggest using Design Review to the people you collaborate with and mention 

to them that this application is a free download. Send them the link to download the ap-

plication and the online demonstration found in Design Review’s Help menu. Continue 

to offer your collaborators the review material in PDF, DWG, or any other traditional fi le 

type in case they end up in a time crunch, but send them DWF fi les as well. If they use 

Internet Explorer 7, consider sending them DWFx fi les, and mention to them that they can 

open those fi les directly in their web browser.

Chapter 15: Frame Generator

Work with frame fi les.  Frame Generator puts all the members at the same level in the 

assembly.

Master It  You have a frame that is built up in sections that are welded together. How do 

you document the manufacturing process?

Solution  Use Demote to create subassemblies of frame members. Select the frame 

members in the browser. From the context menu, select Component ➢ Demote Frame 

Generator Components. This preserves the Frame Generator relationships.

Insert frame members onto a skeleton model.  Frame Generator builds a skeleton model 

for the frame from the selected lines and edges.
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Master It  Since Frame Generator builds its own skeleton model, you don’t have to build 

a master model before you start creating the frame. What would you reference in your 

assembly to use as a frame skeleton?

Solution  Use layout sketches and surfaces to design the basic frame shape. Position the 

components that will be mounted to the frame in the assembly, and reference edges on 

the parts. As you make changes to the assembly, such as the overall size or the position of 

components, the frame will automatically update.

Add end treatments to frame members.  Frame Generator does not support end treatments 

on merged members.

Master It  Let’s assume you are building a stairway and the handrail has curved sec-

tions. How would you approach the curved handrail so that its ends can be treated?

Solution  You can handle this situation in several ways:

 ◆ When you create the frame member, don’t select the Merge option. This creates indi-

vidual fi les for each segment. You can add end treatments to the end segments and 

document the details in the assembly drawing.

 ◆ Create the sketches so the ends of the curved member terminate at the face of another 

member. If the mating member has a fl at face, you don’t need an end treatment.

 ◆ Add short linear segments that aren’t merged with the rest of the curved mem-

ber. You can document that the length of the curved member does not include end 

treatments.

 ◆ Manually create end treatments using part-modeling commands. Frame members are 

created as custom parts that can be edited.

Make changes to frames.  Inventor provides detailed frame-member information.

Master It  You need to determine the size and wall thickness of the tubing and make it 

either thicker or larger. How do you do that?

Solution  Use the Frame Member Info tool to get the properties for the frame members. 

Then, you can use the Change tool to increase the wall thickness, increase the size, or se-

lect a different structural profi le.

Author and publish structural profi les.  Frame Generator uses structural shapes from 

Content Center.

Master It  How would you add custom aluminum extrusions to Content Center so 

Frame Generator can access them?

Solution  Use the Structural Shape Authoring tool to prepare the parts for publishing. 

Use the Publish Part tool to add the parts to Content Center.

Create BOMs for Frame Generator assemblies.  Frame Generator has special parameters 

for frame members.

Master It  How do you add the profi le dimensions and the length of your frame 

members to the Description fi eld?

Solution  Use the BOM expression builder to add the Stock Number and G_L 

parameters to the Description fi eld.
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Chapter 16: Inventor Studio

Create and animate cameras.  Although static camera animations are a common part of 

any animation, by creating and animating cameras, you give your renderings a much more 

professional feel.

Master It  You know that the most expedient means of capturing camera keyframe 

positions is to create a camera and animate it. How do you do this?

Solution  To create a new camera, do the following:

 1.  Use the view orientation tools to position the view to show what the camera would 

see in the fi rst frame.

 2. Right-click, and select Create Camera From View.

To animate the camera, do the following:

 1.  In the Animation Timeline window, in the drop-down list, select the new camera 

by name.

 2.  In the Animation Timeline window, set the time slider to the time position 

representing when you want the camera to be in another location.

 3. In the Scene browser, right-click the new camera node, and click Animate Camera.

 4.  In the graphics region, use the View Orientation tools to position the view to show 

what you want at that time position.

 5. In the Animation Timeline window, click Add Camera Action.

Repeat as needed.

Start new animations, modify animations, and use the various animation tools.  Animating 

your assemblies so that the function of the mechanism is showcased is often the purpose of an 

assembly animation.

Master It  You have an existing animation but want to do a variation on it. How do you 

copy and edit an existing animation?

Solution  Copy the animation:

 1. In the Scene browser, expand the Animations node.

 2.  Right-click the animation for which you want to make a variation, and click Copy 

Animation.

 3.  Right-click the Animations folder, and click Paste Animation. The Animations 

folder populates a new animation based on the selected animation.

Modify the animation:

 1. Right-click the new animation, and click Activate.

 2. In the Animation Timeline window, make modifi cations to actions as needed.

 3. Add new actions as needed using the animation commands.
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Use multiple cameras to create a video production of your animation.  Video Producer 

provides the means to combine camera shots into a single video output.

Master It  You have created several cameras, animated and static, and want to make a 

composite animation. What are the general steps you will follow?

Solution  Do the following:

 1. In the Scene browser, expand the Productions node.

 2.  If no production exists, right-click the Productions node, and click New 

Production.

 3. The cameras are loaded into the Video Producer window and ready for use.

 4. Drag and drop shots into the timeline, and set their parameters.

 5. Drag and drop the desired transitions between the shots.

Use props to enhance your scene.  Inventor assemblies can be combined with other compo-

nents to create a more realistic scene for rendering.

Master It  You have completed a design and want to render a realistic image of it in its 

working environment. How do you do this?

Solution  Do the following:

 1. Create a new assembly that will be used as a wrapper assembly.

 2. Place your product assembly in the new assembly.

 3.  Add any props, other parts, and other assemblies that make the scene more 

realistic.

Render shaded and illustrative images.  Inventor provides the means to render both 

shaded and illustrative images.

Master It  With your new product nearing completion, the marketing department has 

asked for rendered images for marketing collateral and technical documents such as 

white papers. What are the general steps for both realistic and illustration rendering?

Solution  To create a realistic rendering, do the following:

 1. Prepare the scene with what you want to render.

 2. Click the Render Image command.

 3. In the Render Image dialog box, select Realistic as the render type.

 4. Specify the camera, lighting, and scene styles to use.

 5. Click Render.

To create an illustration rendering, do the following:

 1. Prepare the scene with what you want to render.

 2. Click the Render Image command.

 3. In the Render Image dialog box, select Illustration as the render type.
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 4. Specify the camera, lighting, and scene styles to use.

 5. On the Style tab, specify the appropriate settings for your rendering.

 6. Click Render.

Render animations and video productions.  Inventor provides the means to render 

animations and video productions.

Master It  You’ve created a wrapper assembly and set up the scene with cameras, light-

ing, and a scene style. Now you want to render an animation, for design review and a 

video production, for a multidisciplinary review or marketing. What are the basic steps 

in each process?

Solution  To render the animation, do the following:

 1. In the Scene browser, select and activate the animation you want to render.

 2.  Deactivate any active production. Remember, when a production is active, it is 

the render target. To render a single animation, you must deactivate any active 

production.

 3. In the Inventor Studio tool panel, click Render Animation.

 4. Specify the various styles to use and the render type.

 5. Specify the output fi le type and other parameters.

 6. Render the animation.

To render a production, do the following:

 1. In the Scene browser, select and activate the production you want to render.

 2. If you have not completed composing the production, you should do so.

 3. In the Inventor Studio tool panel, click Render Animation.

 4. Specify the various styles to use and the render type.

 5. Specify the output fi le type and other parameters.

 6. Render the animation.

Chapter 17: Stress Analysis and Dynamic Simulation

Set up and run Stress Analysis simulations.  Oftentimes, you may fi nd yourself guessing 

at what impact a change to your design might have on the strength and overall integrity of 

your part. Questions such as “Can I make this part a bit lighter?” or “Can I move this cutout 

closer to the edge?” become important to the success of your design.

Master It  Set up a parameter study in your model to explore the consequences of edit-

ing features and their locations. Nominate all the crucial parameters to the table, and 

then create the confi guration simulations for all of the combinations.

Solution  Interpret the results of the parameter study, looking for the confi guration that 

promises to exhibit the results that come closest to your goals, such as a target safety 
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factor. Examine the various confi gurations to see which ones would be considered 

underbuilt and overbuilt, and then determine why. Understanding what works and 

doesn’t work will allow you to get closer to the target from the beginning of the design 

process next time.

Set up and run Dynamic Simulations.  When you fi nd yourself working out the details of 

a design with many moving parts, consider using the Dynamic Simulation tools early in the 

process to prove what will or will not work before going forward.

Master It  Even before the assembly is complete, switch over to the Dynamic Simulation 

environment and create assembly relationships in the simulation. Test the motion as you 

build the parts, and attempt to understand how contact will occur from the beginning.

Solution  Enable the automatic Assembly constraint option so that as you create rela-

tionships, standard joints are automatically created. Use the Input Grapher to design in 

the fourth dimension (time), understanding how a mechanism will or will not work as 

you go through the stages of its operation.

Export results from the Dynamic Simulation environment to the Stress Analysis 
environment.  Often when setting up a stress analysis simulation, you are guessing at what 

the loads might be, based on rough calculations. As you make changes to the design, those 

calculations become out-of-date and therefore invalid.

Master It  How do you use the Dynamic Simulation tools to determine the force exerted 

on one part by another?

Solution  Export the FEA information for the crucial time steps from the Dynamic 

Simulation environment into the Stress Analysis environment, and run the simulation. 

This helps keep your calculations both accurate and up-to-date. When the parts are mod-

ifi ed, the load calculations will automatically update based on the mass properties.

Chapter 18: Routed Systems

Create routes and runs.  Using routed systems tools allows you to quickly defi ne many 

different route types in order to check for clearance and fi ts within a design, all while creat-

ing a bill of materials that can be used downstream in the manufacturing process.

Master It  You have a model containing equipment and structural components defi ning 

the space requirements for a new route. Can you create a route using this geometry or are 

you required to create a sketch fi rst? 

Solution  When you have geometry that needs to referenced and routed around, you 

can create a sketch fi rst, but it isn’t required. Instead, you could use the orthogonal route 

tool to defi ne the route. 

Author a tube and pipe component.  To create your own fi ttings, couplings, and so on to 

be used within tube and pipe design, you need to fi rst author them for use with the tube and 

pipe tools.

Master It  How can you set the depth at which pipe, tube, or hose segments are inserted 

into a fi tting?

Solution  The pipe engagement is set during the tube and pipe component authoring 

process to determine how deep the segment will fi t into the fi tting. For butt weld–style 
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components, the engagement is set to 0 since there is no insertion. Content Center 

components have the engagement positioning already set.

Author an electrical component.  To create your own electrical connector components to be 

used within cable and harness designs, you need to fi rst defi ne pins within the parts.

Master It  How can you create a family of electrical connectors with varying numbers 

of pins?

Solution  First, use the Place Pin or Place Pin Group tool to add the maximum number 

of pins to the connector part. Then convert the part to an iPart. In the iPart Author 

dialog box, use the Work Features tab to include only the pins required for each pin 

variation.

Create and document cable and harness assemblies.  Cable and harness assemblies are 

created using a specifi c subassembly and part structure. Each harness is contained in a har-

ness subassembly, and the parts such as wires, cables, and segments are created within a 

harness part fi le.

Master It  You have a complex design that includes many harness assemblies and would 

like to turn some of them off while you work on others and/or create new ones. What is 

the best way to do this?

Solution  You can create level-of-detail representations in cable and harness assemblies 

in much the same way that you would in a standard assembly. You can suppress an entire 

harness assembly and the harness part. But you cannot suppress other harness objects 

within the harness. Harness objects do not include connectors that are within the harness 

assembly. These can be suppressed.

Chapter 19: Plastics Design Features

Create thicken/offset features.  When creating plastic parts, you will often fi nd that work-

ing with surfaces allows you to achieve more free-form shapes than working with solids. 

Once the surfaces are created, you’ll need to give them a thin wall thickness.

Master It  How would you create a plastic part fi le with many curved, free-form 

elements?

Solution  You can use the extrude and revolve features, among others, to create sur-

face shapes that are much more free-form than what you can generally create with solid 

features. Once the surfaces are created, use the Thicken/Offset tool to give them a wall 

thickness.

Create shell features.  Shelling solids parts and features is a common way to create base 

features for plastic parts. Once the shell feature is created, other features can be added to it.

Master It  You want to create a shell feature but need to have some faces be thicker than 

the rest. How would you accomplish this?

Solution  You can use the >> button to expand the Unique Thickness option in the Shell 

tool dialog box to specify faces that require unique face thicknesses. Or you can use the 

Thicken/Offset tool to change the thickness of faces after a shell is created.
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Create split features.  Many times you may want to establish the overall shape of a feature 

and then divide the shape into separate parts of the overall design. You can use the Split tool 

to do just that and more.

Master It  You have a plastic part that needs to have a raised face for a rubber grip 

applied during the manufacturing process. How would this be done?

Solution  Use the Split tool to create a surface that is unique to the rubber grip area, and 

then use the Thicken/Offset tool to build up the rubber face.

Create grill features.  Grill features allow the infl ow or outfl ow of air through a plastic 

thin-wall part. Grills can be created with a number of subfeatures such as islands, ribs, and 

spars, but only the outer profi le of the grill is required.

Master It  How would you determine the area of a grill opening based on the airfl ow it 

needs to handle?

Solution  Edit the sketch from which the grill feature was created, and then use the 

Measure Region tool to determine the general area of the opening. Or create a sketch 

on the grill, project all of the islands, ribs, and spars into the sketch, and then use the 

Measure Region tool on it to determine the exact area of the opening.

Create rule fi llet features.  Rule fi llets can be an extremely effi cient way to apply fi llets 

throughout the design to many edges that meet the same rule criteria.

Master It  How would you apply fi llets to all of the edges that are generated by 

extruding a shape down to an existing set of base features?

Solution  Use the Rule Fillet tool with the source set to the new extruded shape, the rule 

set to Against Features, and the scope set to include all the base features to create inter-

secting fi llets. If this feature changes to create new edges or remove existing edges that fi t 

the rule, the fi llets are added or removed automatically.

Create rest features.  Rest features can be used to create level platform faces for mounting 

other parts to an irregular plastic part face.

Master It  You want to create a rectangular pocket on the inside of a plastic housing to 

hold an electronic component. How would you do this?

Solution  On a work plane, create a sketch that defi nes the shape of the pocket. The work 

plane location will defi ne the orientation. Use the Rest tool to create the pocket, using the 

options in the Rest tool to achieve the exact result you require.

Create boss features.  Boss features are ideal for creating fastener-mounting standoffs for 

thin-wall plastic parts. You can use the Boss tool to create both halves of the fastener boss.

Master It  You want to create multiple boss features around the perimeter of a fl at, pan-

type base part, but you know this base part is likely to change size. How would you set 

up the boss features to adjust to the anticipated edits?

Solution  On a work plane, create a 2D sketch that defi nes the height of the bosses. Use 

the Offset tool in the sketch environment to create an offset loop based on the perimeter 

of the part. Add sketch center points at all the required locations. Ensure that the offset 

loop and the sketch center points are fully constrained and dimensioned, and then use 

these points when creating the boss feature.
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Create lip and groove features.  When designing plastic parts, you may need one half of a 

design to fi t into the other half. The Lip tool allows you to create both lip and groove features 

for these situations.

Master It  You want to create a groove around the edge of an irregular, curved edge. 

How can you ensure that the lip on the corresponding part will match?

Solution  Use the clearance height to remove uneven mating surfaces during the lip and 

groove creation, ensuring a proper fi t.

Create snap fi t features.  Snap features are a common way to join plastic parts together so 

that they can be disassembled as needed. You can use the Snap Fit tool in Inventor to quickly 

create these features.

Master It  How would you create a U-shaped snap fi t with the Snap Fit tool?

Solution  Use the standard sketch and extrude methods to create the base of the 

U-shape. Then use the Snap Fit tool to add the snap and loop as needed.

Create rib and web features.  Ribs and webs are often used to add rigidity and prevent 

warping during the design of plastic parts. You can add ribs based on open profi le sketches 

in Inventor.

Master It  How would you create a network of ribs that are evenly spaced, with some of 

them containing different cutouts than others?

Solution  Create an open profi le sketch for the fi rst single rib. Then use the Rib tool to 

create it. Use the Rectangular Pattern tool to pattern the rib as needed, and then create the 

cutout profi le and use the Extrude tool to cut the shape from the fi rst rib. Then pattern 

the cutout to match the rib pattern. Finally, suppress the cutouts you do not need.

Create draft features.  Because plastic parts must be extracted from a mold during the 

manufacturing process, drafted faces must be included to ensure that the parts can indeed be 

extracted from the mold.

Master It  You want to create drafted faces on a complex part containing various shapes 

within it. How would you do this?

Solution  Start the Draft tool and then click the Help button in the lower-left corner, 

or just press F1 on the keyboard. This will open the help page specifi cally for the Draft 

tool. Expand the nodes on the Concept tab to explore the examples of the various results 

achieved by different settings. Use the various methods throughout the part where they 

will provide the correct result. Set up work planes to help establish fi xed-plane faces.

Create an injection mold.  To generate the components you have designed with the plastic 

part features, you need to properly defi ne the cavity to create the part and defi ne how the 

material will fl ow into the cavity.

Master It  You want to create a mold base design in an effi cient manner using parts that 

can be purchased.

Solution  Use the many steps of the Inventor Tooling package to properly defi ne the 

core and cavity. Then use the analysis tools to ensure that the part will be made correctly. 

Finally, use the library of features included with Inventor to construct the mold base 

assembly.
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Chapter 20: iLogic

Create iLogic rules.  Use iLogic rules to document and embed into your models the 

common design rules that you use every day to determine the decisions required in your 

design process.

Master It  How can you add a rule to your part to change the size of it?

Solution  Create a rule and use a parameter function to get and set the model 

parameters.

Edit iLogic rules.  A large part of working with iLogic is testing and editing the rules you 

create. Often, it’s best to add a function at a time to the rule and test it along the way.

Master It  Your rule works but you have to manually update the model. Do you need to 

create a new rule to handle the update?

Solution  You can edit your existing rule and add the UpdateWhenDone document 

function to run at the end of the rule.

Use multi-value list parameters.  A common part of any design rule process is selecting 

from a list of standard entities. You can create multi-value list parameters from Numeric or 

Text parameters to add lists.

Master It  How would you create a rule that prompts you to select from a list of 

approved sizes?

Solution  To start, you will create a user parameter and then make it a multi-value 

list parameter. Then you can use the InputListBox function or create an iLogic form to 

reference that list.

Work with multiple rules in the same fi le.  It is often best to create several small rules 

rather than try to create one large rule that does it all. This helps you maintain and trouble-

shoot the code later, and it also allows you to use rules in multiple applications without the 

need to remove or edit existing code. This is particularly true when working with external 

rules, which might be used in varying applications later on.

Master It  You’ve created two smaller rules because it makes sense to do so, but 

when you try to run one, the other is triggered also. Do you need to combine them into 

one rule?

Solution  When one rule updates the parameters another rule is referencing, the other 

rule is triggered by that update by default. To resolve this, you can choose to edit the rule. 

Select the Options tab, and then select the Don’t Run Automatically option. This prevents 

the rule from running automatically when the parameters are updated.

Use conditional statements.  Conditional statements are the foundation of any pro-

grammed logic. Learning how to use If, Then, and Select Case statements will go a long 

way in helping you solve logical problems when creating rules.

Master It  How can you check the value of a parameter or its state with an iLogic rule?

Solution  You can do this with an If, Then statement. For instance, if you want to check 

a parameter to ensure that it is not too small, you would use function operator such as < 

(less than) or <= (less than or equal to).
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Suppress features.  Confi guring a part fi le to include and exclude features is often based 

on engineering decisions you make every day. Setting up your iLogic rules to do this is 

straightforward, provided the model is well constructed to start with.

Master It  When you use the Feature.IsActive function on one feature, it causes an 

error in the part. How can a feature be suppressed without suppressing a dependent 

feature?

Solution  Oftentimes, the issue is the use of projected geometry in the sketch of the 

dependent feature. Other times, the part was simply modeled in a manner that prevents 

suppressing a base feature. In these cases, it’s best just to edit the part and redefi ne the 

base feature so that it is based on the origin geometry, and not on unrelated features.

Work with iProperties.  iProperties are a powerful part of working with Inventor. Being 

able to retrieve and use metadata helps with all parts of the engineering process. Automating 

the process of fi lling out iProperty data with iLogic is a big step forward.

Master It  Can iLogic be used to update the title block of a drawing?

Solution  If you set the title block up to read the iProperties of the model and/or the 

drawing, then an iLogic rule created to write to those properties will automatically 

update the title block.

Create iLogic forms.  iLogic forms make creating a user interface for your iLogic pursuits 

quite easy. The drag-and-drop tools provide professional-looking forms with minimal effort.

Master It  You have existing part fi les with no iLogic in them, and it would be nice to 

use the form you created in the most recent design to update those old designs as 

revisions require it. Can forms be created and shared across part fi les?

Solution  You can create an external global form and then use it in the future when you 

need to revise old designs of the same type.

Build a part confi guration form.  Confi guring Inventor components saves time, reduces 

human error, and promotes consistency. Using iLogic forms to confi gure common designs is 

a good way to go.

Master It  Can an iLogic form help with parts that are basically the same but have a lot 

of variation in the features they include?

Solution  Although you can’t access the active status of the features directly, you can use 

rules to determine when a feature should be included or excluded, and then use the rules 

in the form. 
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Autodesk Inventor Certifi cation

Autodesk certifi cations are industry-recognized credentials that can help you succeed in your 

design career, providing benefi ts to both you and your employer. Getting certifi ed is a reliable 

validation of skills and knowledge, and it can lead to accelerated professional development, 

improved productivity, and enhanced credibility.

This Autodesk Offi cial Training Guide can be an effective component of your exam prepara-

tion. Autodesk highly recommends (and we agree!) that you schedule regular time to prepare, 

review the most current exam preparation roadmap available at www.autodesk.com/

certification, use Autodesk Offi cial Training Guides, take a class at an Authorized Training 

Center (fi nd ATCs near you here: www.autodesk.com/atc), and use a variety of resources to pre-

pare for your certifi cation—including plenty of actual hands-on experience.

To help you focus your studies on the skills you’ll need for these exams, the following tables 

show the objectives that could potentially appear on an exam, and in what chapter you can fi nd 

information on that topic—and when you go to that chapter, you’ll fi nd certifi cation icons like 

the one in the margin here.

Table B.1 is for the Autodesk Certifi ed Associate Exam and lists the section, exam objectives, 

and chapter where the information is found. Table B.2 is for the Autodesk Certifi ed Professional 

Exam. The sections and exam objectives listed in the table are from the Autodesk Certifi cation 

Exam Guide.

These Autodesk exam objectives were accurate at press time; please refer to www.autodesk

.com/certification for the most current exam roadmap and objectives.

Good luck preparing for your certifi cation!

Table B.1: Certifi ed Associate Exam sections and objectives

Topic Learning Objective Chapter

User Interface: Primary 

Environments

Name the four primary environments: 

Parts, Assemblies, Presentations, and 

Drawings.

Chapters 1, 2 

User Interface: UI Navigation/

Interaction

Name the key features of the user interface 

(ribbon ➢ panels ➢ tabs).

Chapter 1

Describe the listing in the browser for an 

assembly fi le.

Chapter 8

Certification
Objective

http://www.autodesk.com
http://www.autodesk.com/atc
http://www.autodesk
http://www.autodesk.com/certification
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Topic Learning Objective Chapter

Demonstrate how to use the context 

(right-click) menus.

Chapter 1

Demonstrate how to use the menus. Chapter 1

Demonstrate how to add Redo to the Quick 

Access Toolbar.

Chapter 1

User Interface: Graphics Window 

Display

Describe the steps required to change the 

background color of the graphics window.

N/A (Tools tab ➢ 

Application Options 

➢ Colors tab)

Use Application Options ➢ Display. N/A (Tools tab ➢ 

Application Options 

➢ Display tab)

Demonstrate how to turn on/off  the 3D 

Indicator.

N/A (Tools tab ➢ 

Application Options 

➢ General tab)

Name the key elements of the ribbon. Chapter 1

User Interface: Navigation Control Describe the functionality of the 

ViewCube.

Chapter 1

Describe the Navigation bar. Chapter 1

Name the navigation tools started by the 

F2 to F6 shortcut keys:

Pan (F2)

Zoom (F3) 

Orbit (F4)

Previous View (F5) 

Home View (F6)

N/A 

File Management: Project Files Name the fi le extension of a project fi le 

(.ipj).

Chapter 1

List the types of project fi les that can be 

created.

Chapter 1

Defi ne the term workspace. Chapter 1

Table B.1: Certified Associate Exam sections and objectives   (continued)
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Topic Learning Objective Chapter

List the types of fi les stored in a library. Chapter 1

List the three categories in Folder Options. Chapter 1

Describe how to set the active project. Chapter 1

Sketches: Creating 2D Sketches Name the fi le extension of a part fi le 

(.ipt).

Chapter 1

Describe the purpose of a template fi le in 

the sketch environment.

Chapter 3

Describe the function of the 3D Coordinate 

System icon.

N/A (Use the 3D 

Coordinate System to 

realign the sketch 

coordinate system.) 

Defi ne a sketch plane. Chapter 3

Label the entries on the browser. Chapter 3

Sketches: Draw Tools Complete a 2D sketch using the appropri-

ate draw tools: Line, Arc, Circle, Rectangle, 

Point, Fillet, Polygon.

Chapter 3 (Th e Fillet 

tool is used to round 

corners between 

sketch lines.)

Sketches: Sketch Constraints List the available geometric constraints: 

coincident, colinear, concentric, fi xed, 

parallel, perpendicular, horizontal, verti-

cal, tangent, symmetric, and equal.

Chapter 3

Describe parametric dimensions (general 

and automatic).

Chapter 3

Describe how to control the visibility of 

constraints.

Chapter 3

Describe the degrees of freedom on a 

sketch and how they can be displayed.

Chapter 3

Sketches: Pattern Sketches Demonstrate how to pattern a sketch (rect-

angular, circular, and rotate).

N/A (Although it is 

not common to do so, 

sketches can be 

rotated using the 

Rotate tool.)

Table B.1: Certified Associate Exam sections and objectives   (continued)
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Topic Learning Objective Chapter

Sketches: Modify Sketches Demonstrate how to move a sketch. Chapter 3

Demonstrate how to copy a sketch. Chapter 3

Demonstrate how to rotate a sketch. N/A (Rotates sketch 

geometry relative to a 

specifi ed center point. 

Results are impacted 

by constraints and 

dimensions.)

Demonstrate how to trim a sketch. Chapter 3

Demonstrate how to extend a sketch. N/A (Use the Extend 

tool to extend curves 

to other curves. In a 

3D sketch, extend 

curves to intersec-

tions with a face, work 

plane, or surface.

Demonstrate how to off set a sketch. Chapter 3

Sketches: Format Sketches Describe how to format sketch line types. Chapter 3

Discuss overconstrained sketches. Chapter 3

Sketches: Sketch Doctor Examine a sketch for errors. Chapter 4

Sketches: Shared Sketches Describe the function of a shared sketch. Chapter 3 (Shared 

sketches can be used 

by more than one 

feature. To share a 

sketch, make it visible 

or right-click it in the 

browser and choose 

Share Sketch.)

Sketches: Sketch Parameters Describe how parameters defi ne the size 

and shape of features.

Chapter 3

Parts: Creating Parts Name the fi le extension of a part fi le 

(.ipt).

Chapter 4

Label the entries on the browser. Chapter 4

Table B.1: Certified Associate Exam sections and objectives   (continued)



AUTODESK INVENTOR CERTIFICATION | 957

Topic Learning Objective Chapter

Defi ne a base feature. Chapter 4

Defi ne an unconsumed sketch. Chapter 4 (An uncon-

sumed sketch is any 

sketch that is not 

used by a feature, 

such as an Extrusion.)

Demonstrate how to create an extruded 

part.

Chapter 4

Demonstrate how to create a revolved part. Chapter 4

Demonstrate how to create a lofted part. Chapter 4

Describe the termination options for a 

feature.

Chapter 4

Demonstrate how to create a hole feature. Chapter 4

Demonstrate how to create a fi llet feature. Chapter 4

Demonstrate how to create a chamfer 

feature.

Chapter 4

Demonstrate how to create a shell feature. Chapter 5

Demonstrate how to create a thread 

feature.

Chapter 4

Parts: Work Features Describe the use of work features (plane, 

point, axis) in the part-creation workfl ow.

Chapter 4

Parts: Pattern Features Demonstrate how to create a rectangular 

pattern.

Chapter 5

Demonstrate how to create a circular 

pattern.

Chapter 5

Demonstrate how to mirror features. Chapter 5

Parts: Part Properties Describe part properties and how they are 

applied.

Chapter 5

Assemblies: Creating Assemblies Name the fi le extension of an assembly fi le 

(.iam).

Chapter 8

Table B.1: Certified Associate Exam sections and objectives   (continued)
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Topic Learning Objective Chapter

Label the entries on the browser. Chapter 8

Name the six degrees of freedom on a 

component.

Chapter 8

Demonstrate how to place a part in an 

assembly.

Chapter 8

Discuss degrees of freedom and a grounded 

part.

Chapter 8

Demonstrate how to apply various 

Assembly constraints.

Chapter 8

Describe the various assembly environ-

ment techniques (top-down, bottom-up, 

and middle-out).

Chapter 8

Demonstrate how to create a new part in 

the assembly environment.

Chapter 8

Demonstrate how to place a Content 

Center part in an assembly.

Chapter 8

Assemblies: Viewing Assemblies Label the entries on the browser. Chapter 8

Assemblies: Animation Assemblies Demonstrate how to animate an assembly 

using drive constraints.

Chapter 8

Assemblies: Adaptive Features, 

Parts, and Subassemblies

Demonstrate how to make and use an 

adaptive part.

Chapter 8

Presentations: Creating 

Presentations

Name the fi le extension of a presentation 

fi le (.ipn).

Chapter 11

Label the entries on the browser. Chapter 11

Discuss the various uses of Presentation 

fi les.

Chapter 11

Demonstrate how to apply tweaks to a 

part.

Chapter 11

Demonstrate how to apply trails to a part. Chapter 11

Demonstrate how to animate an assembly. Chapter 11

Table B.1: Certified Associate Exam sections and objectives   (continued)
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Topic Learning Objective Chapter

Drawings: Creating Drawings Name the fi le extension of a drawing fi le 

(.idw).

Chapter 12

Describe the use of template fi les. Chapter 12

Label the entries on the browser. Chapter 12

Describe the content within Drawing 

Resources.

Chapter 12

Demonstrate how to create a part drawing. Chapter 12

Demonstrate how to create an assembly 

drawing.

Chapter 12

Describe the various annotation options. Chapter 12

Demonstrate how to add balloons to an 

assembly.

Chapter 12

Sheet Metal: Creating Sheet Metal 

Parts

Name the fi le extension of a sheet-metal 

part fi le (.ipt).

Chapter 6

Discuss the use of sheet metal defaults. Chapter 6

Demonstrate the creation of a sheet metal 

bend. Use Create Tools ➢ Bend, Face, and 

Flange.

Chapter 6

Sheet Metal: Modify Sheet Metal 

Parts

Demonstrate the creation of a corner seam. Chapter 6

Demonstrate the creation of a punch tool. Chapter 6

Demonstrate the creation of a cut across a 

bend.

Chapter 6

Sheet Metal: Flat Pattern Demonstrate how to create a fl at pattern. Chapter 6

Demonstrate how to insert a fl at pattern in 

a drawing.

Chapter 6

Demonstrate how to export a fl at pattern. Chapter 6

Visualization: Create Rendered 

Images

Describe the process to activate Inventor 

Studio.

Chapter 16

Table B.1: Certified Associate Exam sections and objectives   (continued)
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Topic Learning Objective Chapter

Demonstrate how to create a new camera. Chapter 16

Demonstrate how to create a rendered 

image.

Chapter 16

Visualization: Animate an 

Assembly

Demonstrate how to create a new 

animation.

Chapter 16

Demonstrate how to create an animation 

by animating a camera.

Chapter 16

Demonstrate how to create an animation 

by animating a constraint.

Chapter 16

Demonstrate how to create an animation 

by animating a fade.

Chapter 16

Table B.2: Certifi ed Professional Exam sections and objectives

Topic Learning Objective Chapter

Advanced Modeling Create a 3D path using the Intersection Curve and the Project 

to Surface commands.

Chapter 3

Create a loft feature. Chapter 5

Create a multi-body part. Chapter 5

Create a part using surfaces. Chapters 4, 5, 19

Create a sweep feature. Chapter 5

Create an iPart. Chapter 7

Create and constrain sketch blocks. Chapter 8

Use iLogic. Chapter 20

Emboss text and a profi le. N/A (Create a 

sketch with text 

and then go to 

the Model tab ➢ 

Create panel ➢ 

Emboss button.) 

Table B.1: Certified Associate Exam sections and objectives   (continued)
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Topic Learning Objective Chapter

Assembly Modeling Apply and use Assembly constraints. Chapter 8

Create a level of detail. Chapter 9

Create a part in the context of an assembly. Chapter 8

Describe and use Shrinkwrap. Chapter 9

Create a positional representation. Chapter 8

Create components using the design accelerator commands. Chapter 8

Modify a bill of materials. Chapter 8

Find minimum distance between parts and components. Chapter 8

Use the Frame Generator command. Chapter 15

Drawing Create and edit dimensions in a drawing. Chapter 12

Edit a section view. Chapter 12

Modify a style in a drawing. Chapter 12

Edit a hole table. Chapter 12

Modify a parts list. Chapter 12

Edit base and projected views. Chapter 12

Part Modeling Create a pattern of features. Chapter 5

Create a shell feature. Chapter 5

Create extrude features. Chapter 4

Create fi llet features. Chapter 4

Create hole features. Chapter 4

Create revolve features. Chapter 4

Create work features. Chapter 4

Use the Project Geometry and Project Cut Edges commands. Chapter 3

Presentation Files Animate a presentation fi le. Chapter 11

Table B.2: Certified Professional Exam sections and objectives   (continued)
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Topic Learning Objective Chapter

Project Files Control a project fi le. Chapter 1

Sheet Metal Create fl anges. Chapter 6

Annotate a sheet-metal part in a drawing. Chapter 6

Create and edit a sheet-metal fl at pattern. Chapter 6

Describe sheet-metal features. Chapter 6

Sketching Create dynamic input dimensions. Chapter 3

Use sketch constraints. Chapter 3

User Interface Identify how to use visual styles to control the appearance of a 

model.

Chapter 16

Weldments Create a weldment. Chapter 10

Table B.2: Certified Professional Exam sections and objectives   (continued)



Numbers
1st Principal Stress category, 776
2D contact joints, 789
2D data, importing, 670–671, 670–671
2D paths for sweeps, 202, 202
2D presentation views, 526
2D sketches

base, 46–47, 46–47
secondary, 48–49, 49

3 point work planes, 164, 164
3D contact joints, 789
3D features

base, 48, 48
patterning, 50–51, 51
secondary, 50, 50

3D grips, 133
3D helical rails, 204–205, 204–205
3D input devices, 16
3D Intersection Curve dialog box, 125, 125
3D Line tool, 119
3D Model tab, 11, 11, 46, 48, 50
3D Move/Rotate dialog box, 849
3D Orthogonal Route tool, 812, 813, 817–819, 817–818
3D Sketch settings, 135
3D sketches, 67, 119

coordinate triads, 121–124, 121, 123
curves, 125–128, 125, 127–128
geometry, 124–125, 124
paths, 119–120, 120
refi ning and constraining, 129
routes, 814–815, 816
splines, 119–120, 120

3D Snap Spacing setting, 138
3D solids, importing, 669–670, 669
3rd Principal Stress category, 776

A
abs function, 242
acceleration

animation, 749–750
stress analysis simulations, 770

Acceleration tab, 749
accelerators, 38, 431

functional design, 431–432
inputs, 432, 433
outputs, 433–434
solve states, 434–436, 435

Access Options settings, 345
acos function, 241
acosh function, 241
Activate Sketch Edit Immediately option, 327

adaptivity, 460–461
creating, 402–404, 403
cross-part, 402–405, 403–404
removing, 404–405, 404
temporary use, 405

Adaptivity Used In Assembly option, 137
Add Camera Action tool, 752–754
Add Custom iProperty Columns dialog box, 408–409, 

409–410
Add Design Constraint option, 779
Add External Rule option, 887, 887
Add Files option, 651
Add Folder option, 651
Add Form option, 886, 886
Add-In Manager, 664
Add Materials As New Family Members option, 348
Add Participant command, 407
Add Path command, 34
Add Paths From File command, 34
Add Points option, 832
Add Project option, 651
Add Rule option, 885, 885, 890
Add To Accumulate option, 660
addition operator, 904
Adjust Displacement Scale tool, 777
Adjust Orientation dialog box, 860, 860
Adjust tool, 15, 15
Adjust Orientation tool, 858
ADMS (Autodesk Data Management Server), 26, 339

custom libraries for, 345–346, 346
installing, 340
logging in to, 342

ADR (Autodesk Design Review), 617, 685
ADSK fi les, 630
Advanced Feature Validation option, 137
Advanced System Settings tab, 456
Advanced Systems Format (ASF), 760
Advanced tab for system settings, 456
Against Features setting, 845
Against Part setting, 845
Align To Edge option, 581
Align With Part Centroid option, 860
Aligned extend corner option, 278, 278
aligned fl anges, 265, 265
Aligned option for Insert constraints, 359, 369
alignment

axes, 790, 790
center marks, 581
dimensions, 112, 112, 583, 583
Frame Generator members, 701–703, 702
Insert constraint, 369

Alignment Mate constraint, 373
All Components Suppressed option, 425, 470

Index
Note to the Reader: Throughout this index boldfaced page numbers indicate primary discussions of a topic. 

Italicized page numbers indicate illustrations.
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All Content Center Suppressed option, 425, 470
All Edges setting, 845
All Fillets option, 173, 173
All Parts Suppressed option, 425, 470
All Rounds option, 173, 173, 845
All Unrouted Wires option, 827, 830
Allow Control Resizing setting, 912
allowance vs. tolerance, 245
Alpha Channel option, 744
Alt key for constraints, 366–367
Always Break option, 133
Always Relax option, 133
Ambience setting, 733
ampersand (&) operator, 904
analysis, stress. See stress analysis
anchoring sketches, 189
And operator, 904
AndAlso operator, 905
Angle constraints, 359, 365–368, 366
Angle tool, 660
angles

bending, 292–293, 298
circular patterns, 228–229, 229
lofted fl ange faces, 260
measuring, 660
work planes, 166–167, 166–167

angular dimensions
creating, 583–584, 583–584
description, 112, 112

Angular tab for stress analysis simulations, 770
Animate Camera dialog box, 753–754
Animate Component tool, 750
Animate Constraints tool, 751
Animate Displacement tool, 778
Animate Fade tool, 750–751, 751
Animate Light dialog box, 755–756
Animate Parameters tool, 751–752, 756
Animate Positional Representations tool, 752, 753
Animate tool for frame analysis, 784
animate tweaks, 526–528, 526–527
animation, 747

rendering, 759–760, 759
tools, 747–756, 748–749, 751, 753, 755–756
Video Producer, 757–759, 758

Animation dialog box, 527, 527
Animation Favorites folder, 747, 749
Animation Timeline tool, 747–749, 748
Annotate tab

projected views, 54
switching to, 11

annotation
part drawings. See parts
sheet metal design, 303–307, 304–306

ANSI content library, 342
ANSI standards, 497, 497
antialias settings, 744–745, 760
API objects, 913
appearance

libraries, 33

styles, 728–731, 729–731
Appearance Adjust tools, 729, 729
Appearance box, 15, 15
Appearance Browser, 730–731, 731
Appearance Editor, 731, 731
Appearance panel, 18–19
Appearance settings, 451, 452
Application Options dialog box

assemblies, 460, 465
cables and harnesses, 828
Colors tab, 745
constraints, 381
Content Center, 345
Display tab, 451–452, 452
Drawing tab, 448, 448
dynamic prompting, 75
edges, 188
File tab, 458
General tab, 453–454, 454
global forms, 887
global settings, 132–133
graphics cards, 446
Hardware tab, 451
iFeatures, 327
import settings, 668
Inventor Fusion, 683
LODs, 470, 474
opacity, 403
origin planes, 46, 46
origins, 82, 186
Part tab, 132–133, 132
paths, 344
raster views, 466
shortcuts, 39
single-user projects, 35
sketches, 68–72, 68–72, 74–75
templates, 141, 474, 537
threads, 180
tubes and pipes, 804
view previews, 468
wheel mouse, 16
work features, 163

Apply Auto-Mitering option, 263
Apply Geometric Constraints option, 118, 672
Apply Notch Profi le option, 709
Apply tool, 343–344
applying appearance styles, 728–731, 729–730
archives, Pack And Go for, 643–646, 644–645
arcs

creating, 108–109, 108–109
dimension options, 586, 586

area code changes, 552–553
area lofts, 211–213, 211–213
Area-Perimeter limits, 633
Area tool, 660
areas, measuring, 660
arguments, function, 878
as-assembled weldments, 481
as-machined weldments, 481
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as-welded weldments, 481
ASF (Advanced Systems Format), 760
asin function, 241
asinh function, 242
Assemble Constraint Management dialog box, 376
Assemble tab, 11, 11
Assemble tool for constraints, 375–376
assemblies, 55

accelerators, 431
functional design, 431–432
inputs, 432, 433
outputs, 433–434
solve states, 434–436, 435

balloons, 64, 64
constraints, 58–62, 59–61
degrees of freedom, 57–58, 57–58
derived, 224–226, 225–226
design workfl ow, 355–356

BOM management, 408–415, 409–410, 413–414
constraints. See constraints
copying, 415–417, 416
cross-part adaptivity, 402–405, 403–404
features, 405–407, 407
iAssemblies, 427–431, 427–431
joints. See joints
layout sketches, 398–401, 400
representations, 417–427, 418–424, 426
subassemblies, 392–393, 393–394
top-down, 394–402, 395–398

detail view, 62–64
drawings

balloons, 607–608, 607
center of gravity display, 608–609, 609
interference and tangent edge display, 604, 605
parts lists, 604–607
reference data, 603–604, 604

in DWF fi le publishing, 686, 687
exporting to PDF fi les, 65
instructions, 529–532, 530–531
iPart factories, 324
large. See large assemblies
measuring in, 661–662, 661
model simplifi cation, 622

Create Simplifi ed Part tool, 625–626, 626
Defi ne Envelopes tool, 624–625, 624–625
Include Components tool, 622–624, 623–624

modeling best practices, 8–10
parameters, 243
parts, 3, 4, 64, 64
placing, rotating, and moving parts in, 55–57
representations, 601–603, 602
slice participation, 569
tubes and pipes, 803–805, 804–805
welds, 482–483, 483–484, 509, 509

Assembly Shrinkwrap Options dialog box, 472–473, 
473

Assembly tab, 447
Assembly weldment state, 613
Assign Materials dialog box, 766–767, 767

Assign Virtual Parts tool, 832
Associative load tool, 797
associative views, 601, 603
asterisk (*) operator, 904
atan function, 241
atanh function, 242
Attach Balloon command, 607, 607
Attach Balloon From List command, 608
Attach Text To Leader option, 608
Audio Video Interleave (AVI) format, 759–760
authored connection points, 811
authoring

BIM for, 629–630
electrical components, 821–822
iParts, 319–320, 319
parts, 720–724, 720–723
tube and pipes, 808–810, 809–810

Auto Balloon tool, 608
Auto-bend option, 122
Auto-Bend Radius setting, 73, 136
Auto-bend With 3D Line Creation option, 72, 72
Auto-Consume Work Features And Surface Features 

option, 133
Auto Dimension dialog box, 114, 114
Auto-Hide In-line Work Features option, 133
Auto Recognize option, 629
Auto Route dialog box, 827
Auto Stitch option, 675, 677–678
AutoCAD drawings

blocks, 551
copying and pasting, 119
importing, 116–119, 118–119
sketches from, 116–119, 118–119

AutoCAD spline fi ts, 70, 70
Autodesk Data Management Server (ADMS), 26, 339

custom libraries for, 345–346, 346
installing, 340
logging in to, 342

Autodesk Design Review (ADR), 617, 685
Autodesk Multi-Sheet Plot tool, 663, 663
Autodesk Vault data management program

vs. Design Assistant, 643
implementing, 39
multiuser projects, 38–39
project fi les, 29
purpose, 28, 39

AutoDrop toolbar, 343, 343
AutoLimits, 633–634, 633–634

creating, 635–636, 636–637
editing, 637
limiting use of, 637

AutoLimits Settings dialog box, 633–634, 634
AutoLimits tool, 633–634, 633–634
automated centerlines, 582
Automated Centerlines dialog box, 582
Automatic Contact tool, 770–771
Automatic Dimension tool, 113–114, 114
automatic dimensions, 113–114, 114
Automatic Edge Chain option, 489
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automatic joint option, 360
Automatic Route tool, 825, 829–831
Automatic Solve state, 434–435, 435
automatic tangents, 109, 110
Automatically Convert Constraints To Standard Joints 

option, 786, 786
Automatically Manage Paging File Size For All Drives 

option, 456
Autoproject Edges During Curve Creation option, 71, 

71
Autoproject Edges For Sketch Creation And Edit 

option, 71, 71, 188
Autoproject Part Origin On Sketch Create option, 71, 

76, 82, 187
Autoroute tool, 813–814, 814
Average Size setting, 773
AVI (Audio Video Interleave) format, 759–760
axes

aligning, 790, 790
work, 170, 170

axial moments in frame loads, 783

B
background images

settings, 738–739, 739
transparent, 744

Background tab, 738–739
background updates, 449–450
backslash (\) operator, 904
Backup K-factor, 293
backup settings, 35
.bak fi les, 35
ball joints

description, 360
working with, 391–392, 392

balloons, 64, 64, 607–608, 607
base 2D sketches, 46–47, 46–47
base 3D features, 48, 48
base features

creating, 2, 2
parts, 186–187, 187
sheet metal, 256–261, 256–258, 260–261

Base Quantity property, 139, 408, 724
base sketches, 1–2, 2
base views

assemblies, 601, 602
creating, 51–53, 52–53, 560–562

Baseline Dimension tool, 588
Baseline Dimension Set tool, 588
baseline dimensions, 584, 584, 588, 589
bases, mold, 868–870, 869
batch plots, 652
Batch Publish tool, 350
batch select tools, 697–698
Bead Report command, 507
beads, welds

creating, 491–492
property reports, 506–507, 507

Beam and Column Calculator, 712
Beam Calculation tab, 715–718, 715, 719
Beam Graphs tab, 718
Column Calculator tab, 718–719, 720
fi le naming, 719
HTML page, 719
section properties, 712–714, 712–714

Beam Calculation tab, 715–718, 715, 719
Beam Detail tool, 784
Beam Graphs tab, 718
Beam Length setting, 852
Beam tab, 852
Beam Width At The Hook setting, 852
Beam Width At The Wall setting, 852
bearing loads in stress analysis, 769
bearing pads, 386–389, 387–388
bearings, sliding, 58–60, 59–60
belt joints, 788
Bend Angle tab, 298
Bend command, 280–281, 281
Bend Compensation setting, 294–295, 295
Bend Edit dialog box, 260–261
Bend from Adjacent Face option, 265, 266
Bend from the intersection of the two inner faces 

option, 265, 265
Bend from the intersection of the two outer faces 

option, 265, 265
Bend Order Annotation tool, 296
Bend Order Edit dialog box, 296, 296
Bend Part tool, 185, 186
Bend Radius setting

cables, 829
contour fl anges, 257

bend tables, 291–294, 292
Bend tangent to side face option, 265, 266
Bend Zone Edit dialog box, 260–261, 261
bending angles, 292–293
bending moments, 783
bends, 280

aligned fl anges, 265, 265–266
annotations, 305–306
Bend Part tool, 185, 186
centerlines, 610
for enclosures, 281–282, 281
notes, 610–611, 611
radius, 73, 257, 829
settings, 72, 72, 280–282
sheet metal, 289
tables, 611–612, 612

Between option, 157, 157
Bi-sect Miter, 705, 706
Bill Of Materials dialog box, 408, 409

columns, 408–411, 409–410
expressions, 657, 657
structure designations, 411–412, 412
view tabs, 412–415

Bill Of Materials tab, 138–139, 139
bills of materials (BOM), 407

assemblies, 604–607
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assembly-level control, 408–415, 409–410, 413–414
Frame Generator, 724–725, 724–725
generating, 514–515, 515
parts-level control, 408
structure, 395–396, 395
weldment design, 514–515, 515

BIM (Building Information Modeling), 621–622
assembly model simplifi cation, 622

Create Simplifi ed Part tool, 625–626, 626
Defi ne Envelopes tool, 624–625, 624–625
Include Components tool, 622–624, 623–624

authoring, 629–630, 629–630
part model simplifi cation, 627–629, 627–628
publishing, 630–632, 631
scenario, 632

bisectors for centerline, 580, 580
blind holes, 594
blocks, AutoCAD, 551
boat hull, 208–211, 208–211
Body as Work Surface option, 302
body loads in stress analysis, 770
Body Properties dialog box, 177
bolt strength calculations, 438–440
Bolted Connection dialog box, 437
Bolted Connection Generator, 436–440, 436–437
Bolted Connection tool, 344
bolted connections, 436–440, 436–437
Bolted Connections tool, 436
BOM. See bills of materials (BOM)
BOM editor, 606
Bonded contact types, 771, 772
Boolean data type, 878, 882–883
borders

importing, 671, 671
templates for, 540–541

Boss tool, 848–850, 848, 850
bottom-up design, 394, 394
Bounced Light setting, 733
boundaries, AutoLimits, 635–636, 636
Boundary Condition tool, 777
Boundary Patch tool, 210, 840–841
Boundary tab for AutoLimits, 635, 636
Bounding Box/Bounding Cylinder control, 624, 624
Bounding Box previews, 449
brackets, green corner, 560
Break dialog box, 576
Break Link option

adaptive links, 404
chamfered edges, 198
projected curves, 126, 128
projected geometry, 78,111, 251, 251
projected loops, 76–77, 76, 334
simulations, 775

break views, creating, 575–576
breaking links, 198, 251, 251
breakout views, working with, 570–573, 570–572
Brightness tool, 731
Broken Sketch Entity tool, 836
Browser pane, 19

browsers
iLogic. See iLogic
iParts, 312, 312

BSI standards, intermittent welds, 497, 497
Building Information Modeling (BIM), 621–622

assembly model simplifi cation, 622
Create Simplifi ed Part tool, 625–626, 626
Defi ne Envelopes tool, 624–625, 624–625
Include Components tool, 622–624, 623–624

authoring, 629–630, 629–630
part model simplifi cation, 627–629, 627–628
publishing, 630–632, 631
scenario, 632

Butt Welded piping, 806–807
By Hole placement option, 436

C
Cable & Harness Library, 828, 828
cables and harnesses, 821

cable placement, 829–830
copying designs, 832–834, 833
electrical parts, 821–824, 824
harness creation, 825–826
library, 828, 828
nailboard drawings, 834–836
segment placement and editing, 830–832, 831, 833
wire placement, 826–828, 827

CAD Files folder, 23
Calculate button, 432
Calculation Properties group, 717, 717
Calculation tab, 433, 439
calculations

bolt strength, 438–440
Design Accelerators, 435–436

calculators
beam and column. See Beam and Column 

Calculator
Design Calculators

input, 432
output, 433
weld, 492, 492

Camera tool, 742–743
cameras

animation, 752–755, 755
creating and using, 742–743
matching to images, 740–741, 740–741
saving, 526, 526

Capture Current State option, 901
caret (̂ ) operator, 904
casters, 392–393
Catalog folder, 324, 327
categories

Content Center, 353, 353
properties, 347–349, 348

caterpillars, weld, 513–514, 513
CATIA fi le translators, 679
cavities, 864–867, 865–867
ceil function, 242
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Center Mark tool, 578, 580–581
center marks

creating, 580–581
dimensions, 609

center of gravity (COG) display, 608–609, 609
center-point arcs, 108, 108
Center Point Circle option, 47
center points

holes, 192
profi les, 145
with punches, 330, 332
sketches, 109, 110

Centered Pattern tool, 578, 581
Centerline tool, 160, 578–580, 579
Centerline Bisector tool, 580, 580
Centerline Ff Bend option, 279
centerlines

annotations, 578–582, 579–580
automated, 582
bend, 610
lofts, 213–215, 213–214
Mate constraints, 365, 365
revolved cylindrical parts, 160, 160
sketches, 114–115, 114

Centroid Cylinder option, 258–259
CER (customer error reporting), 662–663
Chain Dimension tool, 589–590
Chain Dimension Set tool, 589
chain dimensions, 585, 585, 589–590
Chain option for welds, 489
Chain Select command, 696–698
Change dialog box, 704
Change Fitting Diameter option, 811
Change Name option, 642
Change tool for Frame Generator, 704–705
Change Size tool, 344
Check All Bend Radii option, 827
Check Bend Radius function, 830
Check Design button, 631
Check Feature button, 631
Check Parts During Load option, 675, 677–678
Choose Column dialog box, 408, 409
Choose Project File dialog box, 44
Chord Tolerance setting, 260
CIP (Customer Involvement Program), 662
circles, sketched, 47, 47
circular edges for routes, 812
circular extrusions, stacked, 160–161, 160–161
Circular Pattern dialog box, 51, 51, 228–229, 229
Circular Pattern tool, 219–220, 219–220, 843, 852
circular patterns, 228–230, 229–230
cleanup, Pack And Go for, 646
Clear Accumulate option, 660
Clear All Overrides option, 842
Clear Screen icon, 19
Clear tool, 15, 15
clearance fi ts, 248–250
Clearance Hole option, 183, 184

clearance spreadsheets for holes, 180–181
Clearance.xls fi le, 180–181
Click To Add bar, 635
Click to Add option for Move Bodies, 221
cloning geometry, 335–336
Closed positional representation option, 603
COG (center of gravity) display, 608–609, 609
Coil dialog box, 231
Coil Pattern Sketch feature, 231
Coil Size tab, 179–180, 180
Coil tool, 179
coils

patterns, 231–232, 232–233
threads, 160, 179–180, 180

Coincident constraints, 69, 70
extrusions, 189
placing, 102, 102

collaborative environments, 38–39
Collect workgroups option, 645
Collinear constraints, 103, 103
Collision Detection option, 380–381
color

appearance styles, 729
border sketches, 541
faces, 177
gradients, 738
iLogic, 892
images, 745–746
iParts, 318–319, 318
light, 736
stress analysis simulations, 776–777
styles, 40
weld beads, 501–502

Color bar dialog box, 776–777
Color Fill Source setting, 745–746
Color Gradient option, 738
color wheel, 729
Colors tab, 745
Column Calculator tab, 718–719, 720
combinations of welds, 502–503, 502–503
Combine Style button, 625
commands vs. tools, 12
Comment button, 903
Comment column for part parameters, 240
comments in iLogic, 903
communication for weldment, 485
Compact Model History option, 137, 651
Compatibility setting for graphics cards, 446
Complete option for DWF fi les, 686
Complete publication option, 531
Component Authoring dialog box, 350–351, 351
Component Pattern tool, 192
Component Priority tool, 661
Component tab

assembly drawings, 601, 602
sheet metal design, 303–304, 304
sheet metal drawings, 610

components
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iLogic, 915–916
tweaks, 525

Components tab for iAssemblies, 428–429, 428–429
composing images, 741–746, 742
composites, 675
concatenation operator, 904
Concentric constraints, 102–103, 103
Concentric option for holes, 183
Concentric placement of bolted connections, 436
conditional statements

overview, 879–881
for rules, 898–900, 900

Conditions tab, 214–215, 214
Conduit Connector dialog box, 629–630, 629
confi gurations

Content Center libraries, 339, 340–341
importing data, 672

Confi gure Content Center Libraries option, 341, 346
Confi gure Libraries dialog box, 38, 38, 341, 341
conjunction operators, 904–905
Connection Line option, 574, 574
connections

bolted, 436–440, 436–437
frames, 783–784, 784

connectors
creating, 822–823, 822
orientation, 835

constant edge fi llets, 172–173, 172–173
Constrain End Points option, 118, 672
Constrain Offset option, 94
Constrain sketch plane to selected face or plane option, 

403
Constraint And DOF Symbol Scale setting, 69
constraint inferences, 69, 86
Constraint Limits option, 377–378, 378
Constraint Placement Priority section, 68–69, 69
constraints, 3, 356

3D sketches, 129
Angle, 365–368, 366
animation, 751
Assemble tool for, 375–376
assemblies, 55, 58–62, 59–61
Constraint Limits option, 377–378, 378
Constraint Sets option, 376–377
Contact Solver, 380–381, 380
degrees of freedom, 356–358, 356–357
Drive, 378–380, 379
environmental, 791–797, 792, 795–796
frames, 782–783, 782
grounded components, 358
iAssemblies, 429–431, 430
for importing data, 672
Insert, 369–370, 370
vs. joints, 382
lines, 81–82, 83
with loads, 769
Mate, 361–365, 361, 365
motion, 372

operation, 358–360
origin geometry, 10
reduction strategies, 458–460, 459–460

for adaptivity, 462
view representations, 463

redundant, 381
Relationship Audio Notifi cation option, 376
Rotate-Translational, 373–374
Rotation, 372–373, 372
sketches, 1, 67, 83–85, 84–85

coincident, 102, 102
collinear, 103, 103
concentric, 102–103, 103
degrees of freedom with, 86–87, 86
dimensions with, 87–90, 88–89
equal, 105, 107
fi x, 105–106, 106
horizontal, 103–104, 104
inference and persistence, 69, 86
parallel, 101–102, 101
perpendicular, 101, 101
smooth, 107, 107
symmetric, 106–107, 106
tangent, 100–101, 100
tools, 100, 100
vertical, 104–105, 104

stress analysis
applying, 767–768, 767–768
parameter studies, 778–780, 779–780

Symmetry, 371–372, 371
Tangent, 368–369, 369
Transitional, 374–375, 375

construction environment, 683
construction geometry, 91–92, 91
Construction setting, 132–133
contact conditions in stress analysis, 770–772, 771–772
contact joints, 789
Contact Solver, 380, 380

collision detection, 381
operation, 381

Content Center, 339–340, 339
categories, 353, 353
category properties, 347–349, 348
Confi guring, 340–341
families, 349, 349
frames, 712, 712
libraries

confi guring, 38, 38
customizing, 345–347, 346–347
overview, 339–341, 339

materials, 348
publishing parts to, 350–352, 351–352
tubes and pipes, 807
working with, 341–346, 342–343

Content Center Editor, 347, 347, 352
Content Center Files folder, 23, 26–27
context menus, 84
continuous loads, 783
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Contour Flange tool, 256–258, 257, 266–268, 266, 268
contour fl anges, 256–258, 257, 266–268, 266, 268
Contour Roll tool, 258–259, 258
Converge option for lofted fl anges, 260
Convert Assembly Constraint tool, 786
Convert To Sheet Metal Part option, 329
Convert To Sheet Metal tool, 302
Convert To Standard Part option, 329
Convert To Weldment dialog box, 501, 502
Convert To Weldment option, 485
converting

constraints, 786, 786
iParts, 315
sheet-metal components, 302–303
weldments, 501, 502

cool colors, 736
cooling shrinkage in plastics design, 857
coordinate triads in 3D sketches, 121–124, 121, 123
coplanar edges for work planes, 166, 166
Copy Components command, 502
Copy Components: File Names dialog box, 416–417, 416
Copy Components: Status dialog box, 416, 416
Copy Design Properties dialog, 658, 658
Copy Model iProperty Settings dialog box, 544, 655, 

656
Copy Properties command, 594, 609
Copy To Level of Detail option, 463
Copy To Single path option, 645
copying

assembly designs, 415–417, 416
AutoCAD drawings, 119
cable and harness designs, 832–834, 833
Drawing Resource Transfer Wizard for, 646–647, 

647
fi les, 642
Frame Generator components, 693
geometry, 333–335, 333
iProperties, 655, 656
libraries, 347, 347
sketches, 337–338, 338
styles, 648
views, 564–565

cores, mold, 864–867, 865–867
corner brackets, green, 560
Corner Chamfer tool, 274–275
corner intersections, 600
Corner Round tool, 274–275
Corner Seam tool, 275–278, 275, 277–278
corners, sheet metal references for, 289
cos function, 241
cosh function, 241
Cosmetic Centerlines tool, 296–297, 297
cosmetic threads, 178–179, 178
Cosmetic Weld dialog box, 487–491, 488, 490–491, 507
cosmetic welds, 487–491, 488, 490–491
counterbores, 182–183, 182
countersink settings, 183, 183
creases, 297

Create 2D Sketch option, 46, 406
Create 3D Sketch option, 120, 124–125
Create Block dialog box, 399
Create Cable tool, 825
Create Camera From View option, 743, 754
Create Curved Mesh Elements option, 773
Create Gate dialog box, 863, 863
Create In-Place Component dialog box

assemblies, 458
BOM structure, 395–397, 395, 397
virtual components, 412, 412

Create Mold Design dialog box, 859, 859
Create New Bodies option, 233
Create New External Rule option, 888
Create New File dialog box, 45, 45

IPN templates, 518, 518
IPT templates, 80, 81

Create New Frame dialog box, 693, 693
Create New Simulation dialog box, 801, 802
Create New Style Library dialog box, 647–648, 649
Create OLE Link To Results File option, 775
Create Pipe Run tool, 819
Create Projected Views Immediately After Base View 

Creation option, 52, 561, 564
Create Ribbon Cable tool, 825
Create Route dialog box, 815
Create Rule File dialog box, 888, 888
Create Runner dialog box, 862, 862
Create Runoff Surface dialog box, 866, 867
Create Runoff Surface tool, 864
Create Segment tool, 825, 830
Create Sheet Format command, 552
Create Silhouette Curve dialog box, 128, 128
Create Simplifi ed Part tool, 625–626, 626
Create Splice tool, 825
Create Surfaces As option, 681
Create Task option, 530
Create Tube & Pipe Run dialog box, 804, 804
Create View tool, 525
Create Wire dialog box, 827–828, 827
Create Wire tool, 825
Crop tool, 577
cropping views, 577
cross breaks, 297, 297
cross-part adaptivity, 402–405, 403–404
“current Design View Representation is locked” 

message, 419
Current Time Position tool, 748
current views, 743, 754
curves, 667

3D sketches
helical, 127–128, 127
intersection, 125, 125
Project Curve To Surface tool, 125–126, 127
silhouette, 128, 128

classifi cation, 70
patterns along, 230–231, 231
work planes, 168, 169



CUSTOM COLUMNS IN BOM • DESIGN REVIEW | 971

custom columns in BOM, 408–411
custom constraints, 782–783
Custom Cylinder option, 259
Custom Family Default option, 345
custom iParts, 320–321, 321
custom libraries, 345–347, 346–347
custom node connections, 784
Custom option in DWF fi le publishing, 686
Custom Parameter Cell option, 320
Custom Parameter Column option, 320
custom parameters, 320
Custom Point controls, 697
Custom Property Format dialog box, 657, 657
Custom publication option, 531
Custom tab for iProperties, 238, 654
custom tasks, 652
customer error reporting (CER), 662–663
Customer Involvement Program (CIP), 662
Cut Across Bend option, 271, 271, 285
cut feature for punches, 330
Cut tool

extrusions with, 148, 149
for sheet metal, 271–272, 271

cylinders, hydraulic, 401–402
cylindrical joints

description, 360, 787
working with, 389–390, 390

cylindrical parts, 160–161, 160–161

D
damper joints, 789
Damping setting, 792
dashes for centerlines, 581
data management plans, 30
Data Sheets folder, 23
data types for functions, 878
date-based numbering scheme, 36–37
Datum Identifi er Symbol command, 595
decay, lighting, 736
decimal dimensions, 671
deep PosReps, 752
Default mm (ANSI) dimension style, 593
Default Parameter Input Display setting, 135, 135
Default Tolerance tab, 140, 140, 245–247, 246
defaults

Design Accelerator values, 435–436
fi lename extensions, 888
object, 553–556, 556
project setups, 29
segment, 832
templates, 537

Defi ne Conditions option, 796
Defi ne Envelopes tool, 624–625, 624–625, 628, 628
Defi ne Gravity option, 797
Defi ne New Border option, 540
Defi ne New Symbol option, 548
Defi ne New Title Block option, 542

Defi ne New Zone Border option, 540
Defi ne Workpiece Setting tool, 864, 866, 866
Defi nition tool for cameras, 753
Degree of Freedom Analysis dialog box, 356–357, 357
degrees of freedom (DOF)

assembly fi les, 57–58, 57–58
with constraints

analysis, 356–358, 356–357
environmental, 792–793
sketches, 86–87, 86

joints, 786
Degrees of Freedom (DOF) tool, 86–87, 86
Delete Existing End Treatments(s) option, 704
Delete Face tool, 302, 847, 847
Delete Pin Group, 824
Delete Section Paths option, 34
Delete View dialog box, 563–564
deleting

end treatments, 704
Mate constraints, 363–365
sketches, 78

demoting components, 458, 459–460
density

iProperties, 655
shadows, 733, 734

dependent features, 8, 141
Depth Of Field setting, 743
Derive tool, 851
Derive Component tool, 227
derived assemblies, 224–226, 225–226
Derived Assembly dialog box, 226, 226
Derived Component tool, 502
Derived Part dialog box, 224, 225, 269, 851
derived parts

creating, 224–226, 225–226
Derive Component tool, 227
modifying, 226
weldment, 482–483, 484

Design Accelerators, 38, 431
functional design, 431–432
inputs, 432, 433
outputs, 433–434
solve states, 434–436, 435
weld, 492, 492

Design Assistant, 637–639, 638–639
fi le operations, 642–643
Find Files tool, 640, 640
iProperties, 658, 658
Pack And Go tool, 643–646, 644–645
vs. Vault, 643
Where Used command, 640–641, 641

Design Assistant dialog box, 638–639, 638–639
Design calculators, 433
Design Copy tool, 916–917
Design Data folder, 887
Design Doctor tool, 15, 15
design property reports, 659
Design Review, 617, 686–687
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Design tab for accelerators, 432, 433
design views, 418
Design Web Format (DWF) fi les, 685

accessing, 688–689, 688–689
publishing, 653, 686, 687
reviewing and marking up, 687, 687–688

design workfl ows. See assemblies
Designs folder, 23–26, 25
Desktop Content

libraries for, 346–347, 347
settings, 26

Detail View dialog box, 62, 574
detail views, 62–64, 573–575, 574
Developed Length option, 259
Diagram tool, 784
dialog boxes, task-based, 20, 20
diameters

bolted connection holes, 437
circles, 47, 47
dimensions, 584, 584, 586, 586
tapped holes, 138

Dimension dialog box, 54
Dimension tool, 80, 87–89
Dimensional AutoLimits dialog box, 636, 636
dimensions

arranging, 97
automatic, 113–114, 114
baseline, 588, 589
center marks, 609
to centerlines, 114–115, 114
chain, 589–590
with constraints, 87–90, 88–89
creating, 79–80, 79, 582–585, 583–585
decimal and fractional, 671
driven, 96–99, 96–99
fi lters, 587
formatting and editing, 592–594, 593
general, 585–586, 586
General Dimension tool, 112–113, 112–113
harnesses, 835
isometric views, 591–592, 592
limits, 633
ordinate, 590–591
over-constrained, 69
parts, 54–55, 55
recovering, 587–588
sketches, 67, 112–115, 112–116
styles, 594
tolerances. See tolerances
zero-value, 321

DIN standards, 497, 497
Direct Manipulation toolset, 147, 147
Directed Angle constraints, 359, 366
Directed Order iPart method, 317
Directed Reorder option, 297
Direction and Offset setting, 739
Direction Condition option, 214
Direction To Wrap Table option, 605
directional lights, 736

Directional tab, 736
directions

loads, 797
rectangular holes, 193
rectangular patterns, 227–228, 228

disabling visual effects, 456–457
discrete lights, 735
disjunction operators, 904–905
Displacement category in stress analysis, 776
Display Accumulate option, 660
display appearance setting, 134
Display area, 69
Display As Actual Diameter option, 835
Display As Expression option, 135
Display Coincident Constraints On Creation option, 

69, 70
Display Degrees of Freedom option, 87
Display Extended Information After Feature Node 

Name In Browser option, 133
Display Joints Table button, 787
Display Line Weights option, 449
Display Line Weights by Range option, 136
Display option for loads, 797
Display Options tab

assembly drawings, 604, 605
section views, 566
sheet-metal, 305, 305
weldment views, 614

Display Published File In Viewer option, 617
Display Quality setting, 451–452
Display tab, 16, 451–452, 452
Display True Line Weights setting, 136
distance

animation, 750
extrusions, 153–159, 154–159
measuring, 660–661

Distance extent setting, 846, 846
Distance to Between setting, 157
Distance to To setting, 153–155
Distance to To Next setting, 156
Distance tool, 660
division operator, 904
DivX codec, 760
DNA, part, 253
Document Links And Embedding dialog box, 775
Document Settings dialog box, 133–134

Bill Of Materials tab, 138–139, 139
Default Tolerance tab, 140, 140
Drawing tab, 450, 450
Modeling tab, 136–138, 137
Sketch tab, 72–73, 135–136, 136
Standard tab, 134, 134
tolerances, 244–245, 246
Units tab, 134–135, 135

document-specifi c settings, 133–140, 134–137
documentation, 535

Drawing Manager. See Drawing Manager
drawing resources. See drawing resources
sheet formats, 551–552
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sheet metal drawings, 609–613, 611–613
styles and standards

administering, 559
creating, 557–558
editing, 553–556, 556
substyles, 558–559

views, 560
base, 560–562
break, 575–576
breakout, 570–573, 570–572
cropping, 577
detail, 573–575, 574
draft, 577
moving and copying, 564–565
overlay, 577–578
projected, 562–564, 563
section, 565–568, 566–568
slice, 568–569
weldment, 613–614, 614–615

welds, 507–514
Don’t Run Automatically option, 897, 913
Double Bend option, 281
double quotes (“) for text, 878, 882, 895
dovetailed slots

dimensions, 54–55
extruding, 50, 50
patterning, 50–51, 51
views

base, 51–53, 53
projected, 54

Draft tool, 855–856, 857
Draft View dialog box, 577
draft views, 577
drag and drop

animation shots and transitions, 757–758, 758
tweaks, 523, 524

dragging sketches, 87
Drawing Manager, 535–536

assembly drawings. See assemblies
bend tables, 305
fl at patterns, 298
part drawings. See parts
punch tables, 306, 306
templates and styles

creating, 536–537, 537
fi le formats, 538
locations, 537

Drawing Resource Transfer Wizard, 547, 552–553, 
646–647, 647

drawing resources, 539, 539
AutoCAD blocks, 551
borders, 540–541
fi le properties, 546–547
iProperties, 544–545
multiple sheets, 540
prompted entry, 547–548
sheet formats, 551–552
sheet size, 539–540
sketched symbols, 548–549, 549

title blocks, 541–544, 543
transferring, 552

Drawing Resources folder, 548
Drawing Resources settings, 539, 539
Drawing tab, 448, 448

background updates, 449–450
iProperties, 655
line weights, 449
memory savings, 450, 450
previews, 439
raster views, 466
shaded views, 451

Drawing View dialog box
assemblies, 601, 604, 604
base views, 52, 52, 560–561
breakout views, 573
hidden lines, 468, 468
LOD representations, 467–468
previewing views, 449
projected views, 563
sheet metal design, 304–305, 304–305
sheet metal drawings, 610
welds, 510

Drive Adaptivity option, 380
Drive (Angle Constraint) dialog box, 378, 379
Drive constraints, 378–380, 379
Driven Dimension tool, 98–99
driven dimensions, 6, 69, 69, 96–99, 96–99
driving dimensions, 6, 7, 69, 69, 80
Dual Unit option, 660
DWF (Design Web Format) fi les, 685

accessing, 688–689, 688–689
exporting to, 532
publishing, 653, 686, 687
reviewing and marking up, 687, 687–688

DWG/DXF File Wizard, 669
DWG fi les, 22

importing, 118, 118–119
translating, 668–672, 669–672
working with, 538

DXF fi les, 668–672, 669–672
dynamic patterns, 236–238, 237
dynamic prompting, 75
Dynamic Simulation, 756, 764, 785

environmental constraints, 791–797, 792, 795–796
information for stress analysis, 801, 802
joints, 786–790, 786, 790
redundancy, 790–791, 791
running, 797–799, 798–800

E
e function, 243
Edge option

fl ange widths, 264
welds, 489

edges
display settings, 604, 605
fi llets, 172–173, 172–173
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fl anges, 262–271, 262, 266
Frame Generator member selection, 697
Mate constraints, 365, 365
routes, 812
sweeps along, 207
welds, 489
work planes, 166–168, 166–168

Edit Automatic Contact dialog box, 771, 771
Edit Balloon option, 608
Edit Base Solids Using option, 133, 683
Edit Bend option, 266
Edit Center Mark Style option, 581
Edit Connections dialog box, 811
Edit Corner option, 266
Edit Derived Assembly command, 226
Edit Derived Part command, 226
Edit dialog box, 594
Edit Dimension dialog box, 54

gravity, 609
Mate constraints, 364
sketch constraints, 87–88

Edit Dimension Style command, 594
Edit Dimension When Created option, 70
Edit Feature option, 195
Edit Flat Pattern Defi nition tool, 298, 333
Edit Hatch Pattern dialog box, 568
Edit Hole Note dialog box, 595
Edit Imposed Motion option, 794
Edit Include Components option, 623
Edit Initial Conditions option, 792
Edit Joint Torque option, 793
Edit Local Mesh Control option, 774
Edit Model Dimension command, 588
Edit Multi-Value List option, 884, 884
Edit Offset option, 830, 832
Edit Parts List tool, 307
Edit Pin Group, 824
Edit Rule dialog box, 885, 888, 891–897, 891
Edit Select Filters command, 587
Edit Sheet Metal Rule option, 287
Edit Simulation Properties dialog box, 778–779, 778
Edit Sketch option, 13, 195
Edit Table Via Spreadsheet option, 314
Edit Task & Sequences dialog box, 529–530, 530
Edit Using Spread Sheet icon, 328
Edit Via Spreadsheet option, 312
Edit View Orientation option, 835
Edit Welding Symbol command, 506
editing

animation actions, 747
AutoLimits, 637
Content Center families, 349, 349
dimensions, 592–594, 593
in Express mode, 447
extrusions, 148
features, 194–196, 194, 196
forms, 886, 886
iFeatures, 328

imported data, 683–685, 684–685
iPart tables, 312–314, 313–314
iParts, 321–322
Mate constraints, 363–365
PosRep animation, 752, 753
projects, 31
rules, 893–894
segments, 830–832, 831, 833
shots and transitions, 757–759, 758
sketches, 194–196, 194, 196
styles and standards, 553–556, 556

Effects dialog box, 758–759
Ejector tool, 870
ejectors, 870–872, 870–872
Elastic Stiffness setting, 793
electrical parts, 821–824, 824
Element Visibility tool, 778
Enable Advanced Healing option, 675, 677–678
Enable Associative Edge/Loop Geometry Projection 

During In-place Modeling option, 461
Enable Background Updates option, 466
Enable Constraint Redundancy Analysis option, 460
Enable Express Mode Workfl ows option, 447–448
Enable Heads-Up Display (HUD) option, 72, 80
Enable Imposed Motion tool, 794
Enable Joint Torque option, 793
Enable Optimized Selection option, 453–454
Enable Prehighlight tool, 462
Enable Related Constraint Failure Analysis option, 460
End Fill dialog box, 511–512, 511
End of Features (EOF) market and nodes, 487
End of Part (EOP) markers and node, 250–253, 250–252, 

487
end treatments in Frame Generator, 704, 704–705

lengthen-shorten, 710
miter, 705–707, 705–707
notches, 709–710, 709
trim and extend, 707–708, 707–708
trim to frame member, 708, 708–709

endpoints for arcs, 108, 108
Engagement settings, 809, 809
engineering administrators, 30
Engineer’s Handbook, 715
Enterprise Resource Planning (ERP) system, 37
Entities To Import settings, 674
Environment tab, 739–740
environmental constraints, 791–792, 792

external forces, 796–797
imposed motion, 793–794
initial position, 792
input grapher, 794–796, 795–796
joint torques, 792–793, 793

environments
multiuser, 38–39
scenes, 739–740

EOF (End of Features) market and nodes, 487
EOP (End of Part) markers and node, 250–253, 250–252, 

487
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Equal constraints, 105, 107
equal to operator, 904
equations for part parameters, 240
equivalent stress, 776
ERP (Enterprise Resource Planning) system, 37
errors, mesh, 774
events, 889–890, 913–915, 914
exchanging data, 667

DWF fi les, 686–689, 687–689
to FEA, 800, 801
fi le translators, 678–682, 682
geometry. See geometry
imported data

placing, 682
working with, 683–685, 684–685

ISOGEN fi les, 821
Exclude From Simulation option, 766, 766
Exhaustive Set Of Confi gurations setting, 780
existing sketches, sketches on, 74–75, 74–75
Exp function, 242
Explicit Reference Vector constraints, 359, 365–368, 366
explosions

creating, 517–520, 518–520
multiple, 525, 529
recording, 528–529

Export Building Components dialog box, 631–632
Export dialog box, 831
Export Parameters column, 240
Export Standard Tolerance Values option, 140, 246
Export to DWF option, 617
Export to FEA tool, 769
Export to PDF option, 532, 617
exporting

data. See exchanging data
drawings to PDF fi les, 65

Express mode, 447–448
Express publication option, 531
expressions from iProperties, 410, 655–657, 656–657
Extend option, 852
Extend Bend Aligned to Side Faces option, 267, 280
Extend Bend Perpendicular to Side Faces option, 267
Extend Corner option, 278
extensions, fi lename, 21, 888
extents

cosmetic welds, 490–491, 491
sheet metal drawings, 610

external forces, 796–797
external linked fi les from stress analysis, 775
External Rules tab, 887–888, 887
Extract iFeature dialog box, 330–331, 331
Extrude command, 187, 189, 189
Extrude dialog box, 48, 50, 661, 661
Extrude tool, 302
extrusions

base, 48, 48
basic features, 145–146, 146
with Between, 157, 157
Cut and Taper, 148, 149

dovetailed slot, 50, 50
editing, 148
with Intersect, 149–150, 150
minimum solution option, 155–156, 156
multibodies, 158–159, 158–159
settings, 187, 189, 189
solids, 152–153, 152–153, 234–235, 235–236
stacked circular, 160–161, 160–161
surface-based workfl ows, 302
surfaces, 150–152, 151–152
with To, 153–155, 154–155
with To Next, 156–157, 157

F
f-Stop setting, 743
Face/Edge method, 275, 277
Face Extents rips, 282
Face tool, 256, 256, 269–271, 270
faces

appearance overrides, 730, 730
color, 177
fi llets, 175, 175
plastics, 842
replacing, 235, 235

Faces And Edges Select Priority option, 661
Facet Angle setting, 260
factories

iAssembly, 427
iPart, 300–301, 300, 310, 324

fades
animation, 750–751, 751
Video Producer, 757

failures troubleshooting, 250–253, 250–252
families, Content Center, 349, 349
Fan In tool, 835
Fan Out tool, 835
fastening parts, 60–62, 61
FEA (fi nite elements analysis), 763
feature control frame, 596, 596
Feature Priority tool, 637
Feature Selection fi lter, 463
features

3D
base, 48, 48
patterning, 50–51, 51
secondary, 50, 50

adding, 3, 3
creating, 2, 2, 7–8
dependencies, 141
iFeatures. See iFeatures
parts. See parts
renaming, 171
suppressing

iLogic, 900–903
iParts, 315, 316
parts simplifi cation, 476–478, 476–477
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work, 163, 163
visibility vs. display, 172
work axes and work points, 170–171, 170–171
work planes, 164–170, 164–169

Features Are Initially Adaptive option, 460
Features settings for hole tables, 599
File Open Options dialog box, 464–465, 465, 519, 519
fi le properties in title blocks, 546–547
File Resolution dialog box, 36
File tab

assemblies, 458
LODs, 474
single-user projects, 35
templates, 537

fi le translators, 678–679
CATIA, 679
IDF, 681–682
Pro/ENGINEER, 679–680
Rhino, 681
Solidworks, 680–681
Unigraphics and Parasolids, 680

fi les and fi le management
archiving, 643–646, 644–645
copying, 642
Design Assistant. See Design Assistant
exchanging data. See exchanging data
extensions, 21, 888
fi nding, 640, 640
format types, 21–22, 538
Frame Generator, 711
linking, 8–9
migrating, 650–652, 650–652
names, 36–37, 711, 719
open times, 457–458
for projects, 28–29, 341, 341
renaming, 642
replacing, 643
size, 22
usage, 640–641, 641

Fill Direction option, 499
Fill/Hatch Sketch Region tool, 469
Fill Voids tool, 628, 628
Fillet Weld dialog box, 493–494, 494
fi llet welds

creating, 491–497, 493–497
groove combinations, 502–503, 503

fi llets
creating, 171, 176–177, 177
edge, 172–173, 172–173
face, 175, 175
failures, 173
full round, 175, 175
setback, 174, 174

Filter tool, 907
fi lters

Content Center, 342
dimensions, 587
work planes, 463

Find Assembly Components dialog box, 464, 464
Find tool, 464, 464
Find Files tool, 640, 640
Finish Cable And Harness tool, 826, 828–829
Finish Core/Cavity tool, 867
Finish Route tool, 815
fi nite elements analysis (FEA), 763
fi t, splines, 70, 70
Fit Center Mark option, 581
fi t tolerances, 248–250, 250
fi tted angles, 228–229, 229
fi ttings placement, 810–811, 810–811
Fix constraints, 105–106, 106
fi xed constraints, 767–768, 768, 782
Fixed load tool, 797
Flange dialog box, 262–264, 262–263
Flange tool, 262–264, 262–263
fl anges

contour, 256–258, 257, 266–268, 266, 268
creating, 261–266, 262–263, 265
lofted, 259–261, 260–261
piping, 806, 806
widths, 264–266, 265

Flat Pattern Defi nition dialog box, 298, 298
Flat Pattern Extents dialog box, 259
Flat Pattern Translation dialog box, 299
fl at patterns, 295–296

annotations, 305–306
edit features, 296, 296
manufacturing, 299–300, 299
sheet metal, 283, 609–610, 611

fl exibility of subassemblies, 401–402, 401
fl exible hoses, 805, 806, 819–821, 820
Flip command, 734
Flip Component option

Ball joints, 391
Cylindrical joints, 389
Planar joints, 390
Rigid joints, 382–383
Rotational joints, 382–383
Slider joints, 386

Flip Fixed Edge option, 280
Flip Normal option, 339
Flip Section option, 713
fl oating constraints, 782
fl oor function, 242
Flush constraint solution, 359, 361–362
Focus Limits setting, 743
Focus Plane setting, 743
Fold tool, 278–279, 279
folded members, 278–279, 279
Folder Options option, 21, 35
folders

Content Center Files, 26–27
library folders, 26
project search paths, 23–26, 23, 25, 27
single-user projects, 35

fonts, mapping, 671
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forces and force loads
frames, 782
stress analysis, 768–769

Form Design Tree pane, 907
Form Editor, 886, 906–908, 907–908
form factor of shear, 717
Format Column dialog box, 599
Format Column tool, 307
Format Text dialog box

annotations, 306, 306, 597
title blocks, 542–543, 543, 545, 547

formats
animation settings, 760
fi le, 21–22, 538
sheet, 551–552

formatting
border sketches, 541
dimensions, 592–594, 593
parameters, 241
symbols, 549–550, 549

forms. See iLogic
Forms tab, 886, 886
formulas

dynamic patterns, 236–237, 237
mixed-unit, 94

fractional dimensions, 671
frame 0, 747
Frame Generator, 349, 691

Beam and Column Calculator, 712
Beam Calculation tab, 715–718, 715, 719
Beam Graphs tab, 718
Column Calculator tab, 718–719, 720
fi le naming, 719
HTML page, 719
section properties, 712–714, 712–714

and BOMs, 724–725, 724–725
Change tool, 704–705
Content Center in, 341
fi le maintenance, 711
frames

creating, 698–699, 699, 701
maintaining, 710–711

members
alignment, 701–703, 702
anatomy, 694, 694–695
end treatments, 704–710, 704–709
orientation, 696–697, 696–697
placement geometry, 697–698, 698
publishing, 720–723, 720–723
structural shape, 695–696, 695

structure, 692–693
tools access, 691–692, 691

Frame Member Info dialog box, 703
Frame Member Information tool, 711
Frame Member Naming dialog box, 699, 711
frames

analysis, 782
connections, 783–784, 784

constraints, 782–783, 782
creating, 698–699, 699, 701
loads, 783
maintaining, 710–711
results, 784–785, 784

Free Condition, 214
Free Drag option, 221
Free Edges option, 845
Free Move tool, 362–363
Free Position option, 793
Free Rotate tool, 56, 362–363
Freeing Conditions dialog box, 796, 796
Frequency Modes category, 777
frequently used fi les, shortcuts to, 34–35
friction fi ts, 248
Friction setting, 793
frictionless constraints, 768, 768
From Sketch option, 181
From To option, 264
Full Boundary option, 574, 574
Full Face option, 498
Full Face Weld option, 497–498
full round fi llets, 175, 175
fully constrained sketches, 2
Function Category for rules, 890, 891
functional design

Design Accelerators, 431–432
generators. See Frame Generator

functions, 876–877, 877
arguments and data types, 878
parameter, 241–242
syntax, 891–892
for values, 878–879

G
game pieces, 390–391, 391
gaming cards, 446
gaps

fi llet welds, 495, 495–496
miter, 705–707, 705

gaskets, 402–404
Gate tool, 859
Gate Location tool, 864
gates for molds, 859, 862–864, 862–863
GB standards, 497, 497
gears and rolling joints, 788
General Dimension tool, 12

dimension types, 112–113, 112–113
sketches, 87
working with, 585–586, 586

General tab
animation, 759
application options, 453–454, 454
Content Center, 347
dynamic prompting, 75
images, 744
iProperties, 238, 653
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lighting styles, 731–732, 735–736
tubes and pipes, 806–808, 807

General Table tool, 597
Generate Core and Cavity tool, 864, 867
Generate Files option, 300, 300
Generate Members option, 320
generators. See Frame Generator
generic date-based numbering scheme, 36–37
geometric modeling vs. functional design, 431
geometry

3D, 124–125, 124
construction, 91–92, 91
exchange, 667

DWG and DXF fi les, 668–672, 669–672
MDT fi les, 672–673, 673
SAT fi les, 676–677
STEP and IGES fi les, 673–676, 674, 676

measuring, 114, 116
projecting, 75–77, 76–77, 110–111, 111
reuse, 333

cloning, 335–336
copying, 333–335, 333
sketches, 337–338, 338

Geometry tab
fl at patterns, 299
punches, 332

Get Region Properties tool, 115
Get Started tab, 18, 18
get values, functions for, 878–879
Get Weld Annotations option, 511
Get Welding Symbols option, 511
Getting Started tab, 44–45
Global Forms tab, 886–887, 887
Global harness settings, 826
global settings, 132–133, 132
global tolerances, 245–247, 246
glyphs

camera path, 755
symbols, 82–83, 82

Go To End tool, 748
Go To Start tool, 748
gradients

color, 738
wipe transitions, 757

Grading Factor setting, 773
graphical interface, 14, 14

Browser pane, 19
dialog boxes, 20, 20
Ribbon menu, 17–19, 18
task-based tools, 20–21, 20
title bar, 14–15, 14–15
tools, 16–17, 16–17

graphics cards, 445–446
graphics images. See images
gravity

Beam and Column calculator, 713
environmental constraints, 797
stress analysis, 769

greater than operator, 904
green corner brackets, 560
Grid Display settings, 73, 136
Grill tool, 842–844, 843–844
grips, 133
groove features in plastics design, 850–851, 851
Groove weld tool, 499
groove welds

creating, 497–500, 497–500
description, 492
groove and fi llet weld combinations, 502–503, 502

grounded components, 9, 9, 358
Grounded Point tool, 849
group animate tweaks, 526–528, 528
Guide Face setting, 850
Guide Surface sweep option, 302

H
handles, camera path, 755, 755
hard drives, 446–447
hardware

ROI, 444–445
workstations, 444–447

Hardware tab, 446
Harness Dimension tool, 835
Harness Properties tool, 822
harnesses. See cables and harnesses
hatch patterns

importing, 568
mapping materials to, 567

heads of fasteners, 848
Heads-Up Display (HUD), 72, 80
Heads-Up Display Settings dialog box, 72
Height Datum for fl anges, 265, 265
Height setting for images, 744
Helical Curve tool, 127–128
helical curves, 127–128, 127
helical rails, 204, 204
help for sheet metal, 289
Help toolbar, 14
Hem tool, 268–269
Hidden folder, 531
hidden lines, 468, 468
Hide All Constraints option, 84
Hide All Degrees of Freedom option, 87
Hide Extensions For Known File Types option, 21
Hide Relationships tool, 364
Hide Trails option, 524
hiding components, 531
Hierarchy reports, 659
High antialiasing option, 744
high speed raster views, 466–467, 467
Highest antialiasing option, 745
history-based modeling, 4–5, 5
HMH (Huber-Mises-Hencky) method, 717
Hole dialog box, 191, 192
Hole Table - View tool, 306, 613
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Hole/Thread Note tool, 594
Hole tool, 191, 192
holes

bolted connections, 436–440
creating, 181–184, 182–184
notes, 594–595, 595
rectangular, 192–194, 193–194
sketch-based, 190–191, 191
tables, 306, 598–601, 599–600
threads and clearance spreadsheets, 180–181
tolerances, 184–185, 184

Home icon, 16
Hook tab, 852
horizontal constraints, 82, 84–85, 85, 103–104, 104
Hose Length tool, 820
hoses, fl exible, 805, 819–821, 820
HTML page, 719
Huber-Mises-Hencky (HMH) method, 717
hubs, rotary, 397, 397
HUD (Heads-Up Display), 72, 80
hydraulic cylinders, 401–402

I
IAM fi les, 21–22, 617
iAssemblies

drawings, 615–616, 616
overview, 427–431, 427–431
tables for, 597

iAssembly Author dialog box, 428–431, 429–431
iCheck It add-in, 546
iCopy tool, 415–416
IDF (Intermediate Data Format) fi les, 681–682, 682
IDW fi les, 22, 538, 617
If, Then statements, 879
If, Then, Else statements, 879
If, Then, ElseIf statements, 880
iFeature Author Table dialog box, 328
iFeatures, 324–325, 324

creating, 324–326, 326
editing, 328
placing, 326–329, 327, 329
punch, 329–333, 330–332

IGES (Initial Graphic Exchange Specifi cation) fi les, 
673–676, 674, 676

Ignore Internal Loop option, 498, 498
Illumination tab, 736
iLogic, 875

browser, 884–885
event triggers, 889–890
External Rules tab, 887–888, 888
Forms tab, 886, 886
Global Forms tab, 886–887, 887
iTriggers, 889
Rules tab, 885, 885

comments, 903
components, 915–916
conditional statements, 879–881

Design Copy tool, 916–917
forms

adding, 886, 886
editing, 886, 886
global, 886–887, 887
iProperties, 905–909, 907–908
part confi guration, 909–913, 910–912
size, 912

functions, 876–877, 877
arguments and data types, 878
syntax, 892
for values, 878

operators, 903–905
overview, 875–876
parameters, 882–884, 882–884
rules

adding, 885, 885, 913–915, 914
conditional statements for, 898–900, 900
creating, 890–893, 891–892
editing, 893–894
error handling, 897
external, 887–888, 888
multi-value parameters, 894–896
multiple, 896–897, 897
names, 898
overview, 875
saving, 888
subassemblies, 916
suppressing features, 900–903
tabs, 913–915, 914
title blocks, 917

triggers
event, 889–890, 913–915, 914
iTriggers, 889

iLogic Design Copy dialog box, 693
Image Background setting, 740
Image property, 910
Image setting, 738–739, 739
Image Sphere option, 739
images

2D sketches from, 116–117, 117
background, 738–739, 739
cameras

creating and using, 742–743
matching to, 740–741, 740–741

composing, 741–746, 742
rendering, 743–746, 745–746
settings, 738–739, 739

Immediate Update option, 97
Import As Single Part option, 677
Import Assembly As Single Part option, 674, 681
Import Destination Options dialog box, 117, 669–670
Import From File option, 632
Import Harness Data tool, 831
Import IDF Options dialog box, 682, 682
Import Into Repair Environment option, 675, 677, 

680–681
Import Multiple Solid Parts As Assembly option, 675



980 | IMPORT OPTIONS DIALOG BOX • IPARTS

Import Options dialog box, 674, 676–678
Import Simulation option, 799
imported data

sheet metal, 302–303
working with, 683–685, 684–685

importing
2D data, 670–671, 670–671
3D solids, 669–670, 669
AutoCAD drawings, 116–119, 118–119
AutoCAD electrical parts, 831
DWG and DXF fi les, 668–672, 669–672
geometry. See exchanging data
hatch patterns, 568
Mechanical Desktop fi les, 672–673, 673
plastic parts, 859–862, 859–861

imposed motion, environmental constraints on, 
793–794

Incident Edges settings, 845
Include Assembly Graphics For Express Mode option, 

651
Include Components tool, 622–624, 623–624
Include Cosmetic Welds option, 507
Include Geometry tool, 124, 814
Include Linked Files option, 645
Include Tangent Faces option, 175
included fi les in single-user projects, 33
incremental angles in circular patterns, 228–229, 229
independent features, 8
Indirect tab, 733
Individual Surface Bodies option, 675, 677, 680–681
inferences, constraint, 69, 86
Initial Graphic Exchange Specifi cation (IGES) fi les, 

673–676, 674, 676
initial position, environmental constraints on, 792
input boxes, 876–877, 877
input grapher, 794–796, 795
InputBox function, 876–877, 892
InputListBox function, 895
InputRadioBox function, 898
inputs

Design Accelerators, 432, 433
input grapher, 794, 795

Inseparable BOM structures, 396, 411
Inseparable components, 139
Insert Components In Target Assembly option, 222
Insert constraints

assemblies, 369–370, 370
description, 359
fastening parts, 60–62, 61

Insert dialog box, 695, 695, 697
Insert Frame dialog box, 711
Insert iFeature dialog box, 327, 327, 329
Insert iFeature tool, 327, 331–332
Insert Joint dialog box, 787
Insert Members Between Points option, 697, 701
Insert Members On Edges mode, 697, 703
Insert Multiple tool, 343–344
insert selection methods, 697

Inside constraint solution, 359
Inside of base face extents option, 265, 265
Inspect tab for AutoLimits, 634
INSUNITS system variable, 672
intensity of light, 736
interactive actions in Video Producer, 758, 758
interfaces

context intuitive, 11–12, 11–12
graphical, 14, 14

Browser pane, 19
Ribbon menu, 17–19, 18
title bar, 14–15, 14–15
tools, 16–17, 16–17

iLogic. See iLogic
interference edge display, 604, 605
interference fi ts, 248–250
Intermediate Data Format (IDF) fi les, 681–682, 682
intermittent fi llet welds, 496–497, 496–497
Internal View Extents settings, 138
international drafting standards, 536
Intersect tool, 149–150, 150
intersection curves, 125, 125
intersections

apparent, 600
dimensions, 585, 585

Inventor Fusion tool, 133, 683–685, 684–685
Inventor Open dialog box, 464
Inventor Precise Input toolbar, 120, 121
Inventor Project Wizard, 30–31, 30–31
Inventor Studio, 727

animation, 747
rendering, 759–760, 759
tools, 747–756, 748–749, 751, 753, 755–756
Video Producer, 757–759, 758

composing and rendering images, 741–746, 742, 
745–746

environment, 727–728
styles, 728

appearance, 728–731, 729–731
lighting. See Lighting Styles dialog box
scenes, 738–741, 740–741

Inventor Studio icon, 728, 728
Inventor Tooling, 858–859
Inventor View dialog box, 638–639, 639
inverse lighting decay, 736–737
inverse lighting squared decay, 736–737
Invert Alignment option

Ball joints, 391
Cylindrical joints, 389
Planar joints, 390
Rigid joints, 382–383
Rotational joints, 382–383
Slider joints, 386

Invert Selection tool, 462
iPart Author dialog box, 314, 316, 322
iParts, 309–310

authoring option, 319–320, 319
color, 318–319, 318
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converting, 315
creating, 311–312, 312
custom, 320–321, 321
in designs, 322–323, 322–323
drawings, 615–616, 616
editing, 321–322
factories, 310

in assemblies, 324
fold progression, 301

features, 315–316, 316
key selection, 313
member fi les, 320
modifying, 310, 313–314
parameter lists, 310–311, 311
sheet-metal, 317, 317
tables, 312–314, 313–314, 597
testing, 321
threaded features, 316

IPJ fi les, 22–23
item-based setups, 25–26, 25
job based setups, 23–24
library editor, 26
single setups, 24–25

IPN fi les, 22, 617
templates, 518
views, 518–520, 518–520

iProperties, 653–655, 654
copying, 655, 656
Design Assistant, 640, 640–641, 658, 658
expressions from, 655–657, 656–657
forms, 905–909, 907–908
and parameters, 238–239
stress analysis, 767
title blocks, 544–545

iProperties dialog box, 501, 507
IPT fi les, 21–22, 617
IsActive function, 878
Island tab, 843
ISO standards, 497, 497
ISOGEN Output tool, 821
isolate function, 236–237, 242
isometric views

dimensions in, 591–592, 592
extrusions in, 187

item-based IPJ setups, 25–26, 25
iTriggers, 889

J
jack joints, 789
JIS standards, 497, 497
job based IPJ setups, 23–24
Join option for pattern solids, 233
Joint Table, 790
joint torques, 792–793, 793
joints, 381, 786–787

2D contact, 789
Ball, 391–392, 392

vs. constraints, 382
Cylindrical, 389–390, 390
Planar, 390–391, 391
Rigid, 382–384, 382–384
rolling, 788
Rotational, 384–386, 385–386
selection inputs, 381
Slider, 386–389, 387–388
sliding, 788–789
standard, 787
types and options, 360
working with, 789–790, 789–790

joysticks, 16
jumping-off points, 296

K
K-factor value, 289–291, 290, 294
Keep Folder Hierarchy option, 645
Keep Toolbody option, 852
Key parameters, 240, 884
key selection, 313
Keyway Cut feature, 406–407

L
large assemblies

adaptivity, 460–461
drawing views, 467–468
fi le open times, 457–458
general settings, 453–454, 454
hidden lines, 468, 468
high speed raster views, 466–467, 467
LOD strategies, 469–471, 470

subassembly LODs, 474–476, 475
substitution LODs, 471–474, 473–474

model opening, 464–465, 465
models, 457
parts simplifi cation, 476–478, 476–477
performance settings, 447–451, 448, 450, 452
reduction strategies

constraints, 458–460, 459–460
view representations, 463

selection tools, 461–463, 462
sheet reductions, 469
system settings, 455–457, 456
title block logos, 469
workstations, 443–447

Last Used style setting, 557
latitude setting for directional lights, 736
Launch tools, 18
laws for input grapher, 795–796
layers

fl at patterns, 299
importing, 669
mapping, 671, 671

layout sketches, 398–401, 400
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Leader Text tool, 597
leadered symbols, 595–596, 595
leaders

balloons, 608
sketched symbols, 548–549
text, 597

leg length measurement, 492
legacy projects, 29
Legacy Solid Edit Environment tool, 133
Length AutoLimits, 636, 637
Lengthen/Shorten At Both Ends option, 710
Lengthen/Shorten At One End option, 710
lengthen-shorten end treatments, 710
Lengthen/Shorten tool, 710
less than operator, 904
level of detail (LOD) representations, 424–427, 426, 443

assemblies, 602–603
copying, 463
drawing views, 467–468
names, 476
opening, 464–465, 465
strategies, 469–471, 470
subassemblies, 465, 474–476, 475
substitution, 471–474, 473–474

libraries
appearance, 731
Content Center

confi guring, 38, 38
customizing, 345–347, 346–347
overview, 339–341, 339

including, 24
iParts, 322
single-user projects, 33–34, 34
styles, 33–34, 40, 559

Library Edit project fi le, 322
Library Files folder, 23, 26
library folders, 26
Light Parameter setting, 733–734
lighting

animation, 755–756, 756
settings. See Lighting Styles dialog box
styles, 134

Lighting Style menu, 744
Lighting Styles dialog box, 731–732, 731

adding lights, 734
creating styles, 735
Directional tab, 736
General tab, 731–732, 735–736
Illumination tab, 736
Indirect tab, 733
local lights, 737
Point tab, 736–737
Position tab, 734
Shadows tab, 733–734, 733–734, 736
Spot tab, 737

lightning bolt icons, 435
limits, fi t, 248–250, 250
line-plane joints, 787

Line tool
automatic tangents, 109, 109
line creation, 81–83, 82

Line Weight Display Options settings, 73, 136
line-weight for border sketches, 541
Linear Diameter dimensions, 586
linear dimensions, 583, 583
Linear option for holes, 181
Linear placement of bolted connections, 436
Linear Precision setting, 593
Linear Symmetric dimensions, 586
Linear tab for stress analysis, 770
linear tweaks, 520–522, 520–522
lines

creating, 81–83, 82
hidden, 468, 468

Link Camera To View option, 743
Link Levels of Detail dialog box, 474–475
Link Parameters dialog box, 336, 336
linked fi les from stress analysis, 775
linking

fi les, 8–9
iProperties, 544
parameters, 336–337, 336–337

links, breaking, 198, 251, 251
Lip tool, 850–851, 851
ln function, 242
Load Curve tool, 796
load time, Add-in Manager for, 664
loading AutoLimits tools, 634
loads

environmental constraints, 797
frames, 783, 783
stress analysis, 768–770, 768

Loads & Supports settings, 715–716, 717
local lights

animated, 756, 756
description, 737

Local Mesh Control tool, 774
Locating Ring tool, 871
Location setting for loads, 797
Location tab, 178, 178
Locked option, 792
LOD representations (LODReps). See level of detail 

(LOD) representations
Loft command, 208
Loft dialog box, 208, 209
Lofted Flange tool, 259–261, 260–261
lofts, 208

area, 211–213, 211–213
centerline feature, 213–215, 213–214
patch and stitch surfaces, 209–210, 209–210
with rails, 208, 208–209
and Sculpt, 215–216, 215–216
with shells, 210–211

log fi les, 37
log function, 242
logging in to ADMS, 342
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logos, 469
longitude setting for directional lights, 736
Look At Sketch Plane On Sketch Creation option, 71
Look At tool, 17
Loop Select option, 94
Loop tool, 660
loops

measuring, 660
selecting, 94
welds, 489

Low antialiasing option, 744
Lower option for tolerance, 244

M
machining operations

vs. modeling, 142–143, 142–143
weldment, 500–501, 500–501, 509, 509

Machining weldment state, 613
Magnitude load setting, 797
Maintain Each Solid As A Solid Body option, 472
Maintain Enhanced Graphics Detail option, 137
Major Every settings, 136
Make Adaptive dialog box, 834
Make All Views Precise option, 560
Make All Views Raster option, 560
Make Components dialog box, 221–222, 222–223
Make Components Options dialog box, 138
Make Components tool, 358, 399, 484, 853
Make Origin option, 588
Make Part tool, 398–399
Make View Precise option, 466
Make View Raster option, 466
Manage tab

event triggers, 890
forms, 886
iProperties, 544
iTriggers, 889
parameters, 881, 881
rules, 885, 891

Manual Sketch tool, 859
Manual Solve stage, 434–435
manufacturing information for fl at patterns, 296–297
manufacturing process, mimicking, 10
Manufacturing Resource Planning (MRP) system, 37
mapping

imported data, 671, 671
materials to hatch patterns, 567

Mapping Options dialog box, 671, 671
Mark mode, 13
marked DWF fi les

accessing, 688–689, 688–689
creating, 687, 687–688

Marking Menu tab, 13
marking menus, 13, 74, 145, 145
mass

overriding, 655
weld properties, 506–507, 507

Master LODs, 469
Match Shape option, 152–153, 153
matching cameras to images, 740–741, 740–741
Mate constraints, 359

edges, centerlines, and vertices, 365, 365
editing and deleting, 363–365
overview, 361–362, 361
rotate and move, 362–363
sliding bearings, 58–60, 59–60

Material And Appearance panel, 730, 730
Material And Color Form dialog box, 908, 908
Material button, 15, 15
Material Guide, 348
Material List style, 725, 725
material styles vs. appearance, 730
Material Types dialog box, 714
materials. See also bills of materials (BOM)

Beam and Column calculator, 713–714
Content Center, 348
libraries, 33
mapping to hatch patterns, 567
mold components, 858
stress analysis simulations, 766–767, 767

max function, 242
Maximum Gap method, 275
Maximum Gap Distance method, 276, 277
Maximum tool, 777
Maximum Turn Angle setting, 773
MDT (Mechanical Desktop) fi les, 672–673, 673
Measure tool, 371, 659–662, 660–661
Measure Angle tool, 115, 662
Measure Area tool, 115
Measure Distance tool, 15, 15, 115, 661
Measure Loops tool, 115
Measure Region tool, 115, 116
measuring geometry, 114, 116
Mechanical Desktop (MDT) fi les, 672–673, 673
Mechanism Status And Redundancies dialog box, 

790–791, 791
Mechanism Status tool, 790, 791
Median option for tolerance, 244
member fi les for iParts, 320
member parts, 310
Member Scope edit mode, 317, 317
memory

assemblies, 450
Content Center, 340
workstations, 444–445

Memory Saving Mode, 450
MemProbe utility, 455, 455
Menu mode, 13
menus, marking, 74, 145, 145
Merge option, 698
merging Frame Generator members, 698
Mesh Settings tool, 774
meshes, 773–774, 774
message boxes, 900
Metric folder, 45, 45
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Metric tab, 80, 81
middle-out design, 394, 395
Midplane option, 189
MidSurface tool, 772
Migrate Files dialog box, 650, 650
migrating, task for, 650–652, 650–652
Migration Options dialog box, 651, 651
min function, 242
Minimize Frame Rate (Hz) setting, 453
Minimum Distance AutoLimits button, 635
Minimum Element Size setting, 773
Minimum Energy spline fi ts, 70
Minimum Solution option, 155–156, 156
Minimum tool, 777
minus sign (-) operator, 904
Mirror Components command, 502
Mirror Frame Member option, 696
Mirror tool

boss features, 850
lofts, 214, 216

mirrors, feature-level, 7
Miter Cut At One Side option, 705
Miter dialog box, 705–707, 705
Miter end treatment, 705–707, 705–707
mixed-unit formulas, 94
Mixed Units piping, 806
Mobile Groups folder, 789, 790
Mod operator, 904
modal stress analysis vs. static, 765–766
Mode of Reduced Stress settings, 717
Model Browser, 19

history in, 4, 5
turning on, 19
view representations, 463

Model Data tab, 412–413, 413
Model Files Only option, 645
model parameters, 882
model simplifi cation in stress analysis, 766, 766
model state, 747
Model State tab

assembly drawings, 604, 604
settings, 304, 304
weldment views, 614–615, 614
welds, 510

Model tab, 891
Model Value column for part parameters, 240
Modeling Dimension Display settings, 134–135
Modeling tab, 136–138, 137
modeling techniques, 131

BIM, 621–622
assembly model simplifi cation. See assemblies
authoring, 629–630, 629–630
publishing, 630–632, 631

derived assemblies, 224–226, 226
derived parts, 224, 225
document-specifi c settings, 133–140, 134–137
extrusions. See extrusions
fi llets, 171–176, 172–175, 177

global settings, 132–133, 132
holes, 180–185, 182–184
lofts. See lofts
parameters. See parameters
parts. See parts
patterns. See patterns
preparation, 485–487, 486
revolved parts, 160–163, 160–163
sweeps, 202–207, 202–207
threaded features, 177–180, 178, 180
work features, 163, 163

visibility vs. display, 172
work axes and work points, 170–171, 170–171
work planes, 164–170, 164–169

modeling vs. machining, 142–143, 142–143
models

dimensions, 587–588
large assemblies, 457
opening, 464–465, 465
parts, 43–44, 44

modifi cations of parts, 310, 313–314
Mold Assembly tab, 859, 870–871
Mold Base dialog box, 868, 869
Mold Base tool, 868
mold design, 858

bases, 868–870, 869
cores and cavities, 864–867, 865–867
importing plastic parts, 859–862, 859–861
Inventor Tooling, 858–859
runners and gates creation, 862–864, 862–863
sprue bushings, 870–872, 870–872

Mold Layout tab, 859–860
Mold Update tool, 867
moment loads

frames, 783
in stress analysis, 769

motion constraints, 372
Motion Loads Analysis option, 770, 801, 802
motion loads in stress analysis, 769–770
mouse clicks in centerline creation, 580
Move Along Ray option, 221
Move Bodies tool, 220–221, 221
move constraints

Rotate-Translational, 373–374
Rotation, 372–373, 372
Transitional, 374–375, 375

Move Face functionality, 485
Move Segment tool, 814
moving Mate constraints, 362–363
moving parts in assembly fi les, 55–57
moving views, 564–565
MRP (Manufacturing Resource Planning) system, 37
multi-bodies

creating, 216–223, 217–223
extruding, 158–159, 158–159
part fi les, 484–485, 484
working with, 853

multi-edge fl ange feature, 266, 266
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Multi-Process Settings dialog box, 652, 653
Multi Select selection mode, 697
multi-value parameters

description, 883–884, 884
rules using, 894–896

Multiple Composite Features option, 675
multiple explosions, 525, 529
multiple rules in same fi le, 896–897, 897
multiple sheets, 540
Multiple Solid Part option, 674, 677, 679–681
multiple solids

creating, 217–219, 217–218
importing, 674, 677, 679–681

multiple views, 525, 525
multiplication operator, 904
multiprocess settings, 652, 653
multithreaded applications, 447
multiuser projects, 28, 38–39

N
Nailboard tab, 834
names

assembly components, 416–417, 416
DWF fi les, 653
features, 171
fi les, 36–37, 642, 711, 719
frames, 699
LODs, 475, 476
parameters, 94, 239–240, 310–311
rules, 885, 891, 894, 898
runs and routes, 805

Naming Prefi x setting, 138
Navigate panel, 19
navigating view representations, 464, 464
navigation bar, 17, 17
nesting LODs, 474–475, 475
neutral fi le formats, 668
Neutral Radius option, 259
neutral surfaces, 289–290
Never Break option, 133
Never Relax option, 133
New Derived Substitute Part dialog box, 472
New File dialog box

AutoCAD drawings, 116
molds, 859
templates, 141

New File Location setting, 626
New icon, 15, 15
New Light tool, 731, 734
New Lighting Style tool, 735
New Property tool, 307
New Route tool, 817, 819
New Sketch option, 187
New Solid tool, 158, 484
newtons, 783
No New Sketch option, 46, 46, 132
nodes, route, 813, 813

Nominal option for tolerance, 244
Nominal Value column for part parameters, 240
non-sheet-metal features, 301–302
Non-Unique Project File Names dialog box, 37, 37
Normal BOM structures, 396, 411
Normal components, 138
not equal to operator, 904
Notch dialog box, 709, 709
Notch tool, 709–710
notches, 709–710, 709
Notes And Leaders tab, 595, 595
NPT For PVC Pipe And Fitting tab, 809
null statements, 880
Number Of Beam Divisions setting, 717
Number Of Stiffening Ribs setting, 849
numbering schemes for fi les, 36–37
Numeric data type, 878, 883

O
Object Defaults style, 555
Object Visibility option, 18, 172, 850
objects

API, 913
importing, 669
selecting, 190–191

Offset tool, 94–95, 264, 772
offsets

fl ange widths, 264
plastics design, 837–838, 839
polygons, 94–95, 95
routes, 812, 812, 819
segments, 830, 832
work planes, 166, 166

Old Method option for fl anges, 266
Old Versions folder, 35
Old Versions To Keep On Save option, 35
On Error Goto statements, 897
On Error Resume Next statements, 897
On Point option

bolted connections, 436
holes, 183

opacity in animation, 750–751
open angles, 292–293
Open Base Component command, 226
Open Containing Folder option, 887
Open Current Version option, 35
Open dialog box

drawing views, 468
Express mode, 447
images, 738
for importing components, 669, 669, 672, 682
Mechanical Desktop fi les, 672
for renaming fi les, 642
representations, 417, 418

Open Express option, 447
Open From Content Center tool, 340
Open In New Window option, 417
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Open Old Version option, 35
Open Template dialog box, 395, 834
Open tool, 15, 15
opening

LODs, 464–465, 465
models, 464–465, 465

Opening Direction setting, 860, 860
operators in iLogic, 903–905
Opposed constraint solution, 359, 369
Optimized for Single Selection option, 175
Options dialog box for frames, 716, 717
Options tab

hole tables, 600
rules, 897, 897

Or operator, 904
Orbit tool, 17
Ordinate Dimension tool, 590–591
Ordinate Dimension Set tool, 591
ordinate dimensions, 584, 584, 590–591
OrElse operator, 905
orientation

base views, 52, 52, 561
connectors, 835
fl at patterns, 298
Frame Generator members, 696–697, 696–697, 

702–703, 702
lighting style, 734
models, 739, 740
mold components, 858

Orientation pane, 52, 52
Origin folder, 45, 47
origin geometry

constraining to, 10
parts, 45–46, 45

origins
base 2D sketches, 46–47, 46–47
changing, 591
dimension, 590
part fi les, 141
sketches, 71, 81–82
turning on, 82, 186–187
UCS, 631
work features, 163, 163

orthogonal fl anges, 265, 265
orthographic views, 19
Out Of Defi nition options, 796
Outdoor lighting style, 741
Output Grapher dialog box, 799, 799–800
Output tab

Render Animation dialog box, 759–760, 759
Render Image dialog box, 744–745

outputs from Design Accelerators, 433–434
Outside constraint solution, 359
Outside of base face extents option, 265, 266
Overconstrained dimensions area, 69
overlap settings for Corner Seam tool, 276–278, 277
Overlay View dialog box, 578

overlay views, 577–578
Override Object dialog box, 419–421, 421
overriding

appearance, 729–730, 729–730
color, 177
mass and volume, 655
positional representations, 419–424, 421
styles, 554

P
Pack And Go tools, 638, 643–646, 644–645
paging fi le size, 456, 456
Pan tool, 17
parallel constraints, 101–102, 101
parallel planes, 164–165, 164–165
Parallel to the fl ange termination detail face option, 

265, 265
Parameter Favorites tool, 752
Parameter function, 878
Parameter Mapping tab, 350, 351, 721–722, 722
Parameter tool, 15, 15
parameters

animation, 749, 749, 751–752, 755–756
assembly, 243
Content Center, 348–349
dynamic patterns, 236–237, 237
formatting, 241
functions, 241–242
iFeatures, 326, 326
iParts, 310–311, 311
iProperties, 238–239
linking, 336–337, 336–337
names, 94
parts, 239–243, 239
reference, 240
stress analysis, 778–781, 778–781
in templates, 243
types, 882–884, 882–884
user, 240

Parameters dialog box
driven dimensions, 96–97, 97
Frame Generator members, 694, 695
iLogic, 882–883, 882
iParts, 310, 311
iProperties expressions, 656, 656
linking parameters, 336, 336
parts, 239–241, 239

Parameters Favorites dialog box, 749, 749
Parameters tab, 348, 348, 891
parametric design, 1

assembly modeling best practices, 8–10
base sketches, 1–2, 2
changes, 3–4
features, 2, 2
history-based modeling, 4–5, 5
intuitive interface, 11–12, 11–12
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part modeling best practices, 6–8
parts in assemblies, 3, 4
right-clicking, 12–13
with Simplify tools, 627
sketch dimensions, 5–6, 7
tools vs. commands, 12

Parametric Table dialog box, 779–781, 779–780
Parasolids fi les, 680
Part Family dialog box, 344
Part Fill Analysis dialog box, 865, 865
Part Fill Analysis tool, 864
Part Number Merge Settings icon, 410–411
Part Number property, 724
Part Process Settings tool, 864
Part tab

Inventor Fusion, 683
origin planes, 46, 46
settings, 132–133, 132

Part Template Parameters dialog box, 350–351, 722, 723
PartColor function, 906
Participate In Assembly And Drawing Sections option, 

137–138, 573
parts, 140–142, 140

2D sketches
base, 46–47, 46–47
secondary, 48–49, 49

3D features
base, 48, 48
patterning, 50–51, 51
secondary, 50, 50

assemblies, 3, 4, 55
constraints, 58–62, 59–61
degrees of freedom, 57–58, 57–58
detail view, 62–64
exporting to PDF fi les, 65
parts lists and balloons, 64, 64
placing, rotating, and moving, 55–57

bend, 185, 186
confi guration forms, 909–913, 910–912
derived, 224–226, 225–226
dimensions, 54–55, 55
drawing annotations

baseline, 588, 589
centerlines and center marks, 578–582, 579–580
chain, 589–590
creating dimensions, 582–585, 583–585
dimensions in isometric views, 591–592, 592
drawing text, 597
formatting and editing dimensions, 592–594, 593
general dimensions, 585–586, 586
general table, 597
hole and thread notes, 594–595, 595
hole tables, 598–601, 599–600
leadered symbols, 595–596, 595
ordinate dimensions, 590–591
recovering dimensions, 587–588

DWF fi le publishing, 686

end-of-part markers, 250–253, 250–252
extruding. See extrusions
features

added to, 187–189, 188–189
base, 186–187
editing, 194–196, 194, 196
parts, 187
repairing, 197–199, 197–198

holes in, 181–184, 182–184
importing drawings as, 671
iParts. See iParts
lines, 81–83, 82
models

best practices, 6–8
creating, 43–44, 44
simplifi cation, 627–629, 627–628

multi-body, 216–223, 217–223
origin geometry, 45–46, 45
parameters, 239–243, 239
profi les in sketches, 47–48, 47
publishing, 724
rectangular hole pattern, 192–194, 193–194
reuse and revision, 309

Content Center. See Content Center
geometry, 333–339, 333, 336–338
iFeatures, 324–329, 324–327

revolved, 160–163, 160–163
sheet metal. See sheet metal
simplifying sketches, 143–144, 143–144
sketch-based hole feature, 190–191, 191
templates, 45, 45, 80–81, 82
tolerances, 244–250, 245–246, 250
views

base, 51–53, 52–53
projected, 54, 54

weldments, 482–485, 482–484, 514–515, 515
parts-level BOM control, 408
Parts List dialog box, 427, 605–606
Parts List tool, 307
parts lists, 407–408

assembly fi les, 64, 64
formatting, 604–606
generating, 514–515, 515

Parts Only tab, 413–414, 414
passing arguments, 878
Paste Features dialog box, 333–335, 333
Paste Path option, 34
pasting

AutoCAD drawings, 119
sketches, 337–338, 338

patch surfaces for lofts, 209–210, 209–210
Path & Guide Rail option, 204–205, 204
Path & Guide Surface option, 205–207, 205–207
Path control, 750
paths

3D sketches, 119–120, 120
animation, 750, 755, 755



988 | PATTERN ENTIRE SOLID OPTION • PLAYBACK TOOLS FOR ANIMATION

project, 23–26, 23, 25, 27
relative, 37
searching, 641
single-user projects, 33–34
sweeps, 202, 202

Pattern Entire Solid option, 233
patterns, 227

3D features, 50–51, 51
circular, 228–230, 229–230
along curves, 230–231, 231
dynamic, 236–238, 237
feature-level, 7
fl at, 283, 609–610, 611
rectangular, 227–228, 228
sheet metal annotations, 307–308
solids, 233–236, 233–236
spiral, 231–232, 233

PCA (printed circuit assembly) fi les, 681
PDF Drawing dialog box, 65
PDF fi les, 65, 532, 617
penumbra setting, 733
performance

cross-part adaptivity, 402
graphics cards, 446
settings, 447–451, 448, 450, 452
subassemblies for, 393
view representations, 463
visual effects, 456–457

perpendicular constraints, 101, 101
Perpendicular extend corner option, 278, 278
persistence, constraint, 86
Perspective With Ortho Faces view, 19
Phantom BOM structure, 396, 411
phantom components, 139
phantom subassemblies, 459
physical material setting, 134
physical memory for workstations, 444–445
Physical Property limits, 633
Physical tab, 238, 653–654, 654
physical threads, 179–180, 180
PI function, 242
Pick Part First option, 361
pin constraints, 768, 768
Pin Group tool, 823–824
Pin Insert Cut feature, 230
Pin Insert Path Sketch feature, 230
pinned components, 9, 9, 782
Pipe Run tool, 815
pipes. See tubes and pipes
Pivot tool, 835
pivots for harnesses, 835
Place Component dialog box, 465
Place Connector Views tool, 835
Place Constraint dialog box

Angle constraints, 365–367
Constraint Limits option, 378
Constraint Set tab, 376
iAssemblies, 430, 430

Insert constraints, 60–61, 370, 370
Mate constraints, 58–60, 59–61, 361, 364
Rotate-Translational constraints, 373, 374
Rotation constraints, 372, 373
Symmetry constraints, 371–372, 371
Tangent constraints, 369, 369
Transitional constraints, 375, 375

Place Core And Cavity tool, 858
Place Feature command, 341
Place From Content Center dialog box, 342, 342
Place From Content Center tool, 340
Place iLogic Component tool, 915–916
Place iPart dialog box, 322, 322
Place Joint dialog box

Ball joints, 392
Cylindrical joints, 389
Planar joints, 390
Rotational joints, 383
Slider joints, 387–389

Place Pin Group dialog box, 823–824, 824
Place Pin tool, 822
Place Pin Group tool, 823–824
Place Views tab, 11, 11, 52
placed features, 8, 192
placement geometry, 697–698, 698
placing

cables, 829–830
electrical parts, 821–824, 824
fi ttings, 810–811, 810–811
holes, 181–184, 182–184
parts in assembly fi les, 55–57
segments, 830–832, 831, 833
wires, 826–828, 827

planar faces, 166, 166
planar joints

description, 360, 787
working with, 390–391, 391

Plastic Part tool, 858
plastics design, 837

Boss features, 848–850, 848, 850
cooling shrinkage, 857
Grill features, 842–844, 843–844
importing parts, 859–862, 859–861
lip and groove features, 850–851, 851
mold design, 858–872, 859–863, 865–867, 869–872
rest features, 845–847, 846–847
Rib and Web features, 853–854, 855
Rule Fillet features, 844–845, 845
Shell features, 839–841, 840
Snap fi t features, 851–853, 851, 853
Split features, 841–842
templates, 839, 839
Thicken/Offset features, 837–838, 839

Plate Calculator, 712
plates, threaded holes in, 438
Play Animation tool, 748
Play Animation In Reverse tool, 748
playback tools for animation, 747–749, 748
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plus sign (+) operator, 904
PNG fi les, 744
Point Alignment On setting, 71, 72
point lights, 735–737
point-line joints, 787
point-plane joints, 787
Point tab, 736–737
Point To Point rips, 282
points

arcs, 108–109
sketches, 109, 110
work, 170–171, 170

Polygon tool, 92–93, 92–93
polygons, 92–93, 92–93
Populate Route tool, 815
Position control for animation, 750
Position tab for lighting, 734
positional change of bolted connection holes, 437
positional representations (PosReps)

animation, 752, 753
assembly drawings, 602–603
overlay view, 578
overview, 419–424, 420–424

pounds-force, 783
pow function, 242
Power Saving Mode option, 456
Precise Input toolbar, 120, 121
Precise Redefi nes, 121–122, 121
precision

dimensions, 593–594
measurements, 660

Precision And Tolerance tab, 594
Predict Offset And Orientation option, 59, 361
preparation stage for welds, 509, 509
Preparations folder, 487
Preparations weldment state, 613
Presentation color scheme, 745
presentation environment

advanced, 522–528, 523–528
assembly instructions, 529–532, 530–531
cameras, 526, 526
explosions, 517–520, 518–520
multiple views and explosions, 525, 525
tweaks. See tweaks

presentation fi les, 686
press fi ts, 248
pressure loads in stress analysis, 769
previewing

Mate constraints, 59, 361
snap fi t, 852

Previous Selection tool, 462
printed circuit assembly (PCA) fi les, 681
priorities for measurements, 661, 661
prismatic joints, 787
Pro/ENGINEER fi le translator, 679–680
Probe Labels Display tool, 777
Probe tool, 777, 784
processors, 447

product-based numbering scheme, 37
Productivity panel, 357
profi les

extruding solids from, 152–153, 152–153
extruding surfaces from, 150–152, 151–152
sketch center points for, 145
in sketches, 47–48, 47
structural, 691
sweeps, 202–204, 203
velocity, 749–750

Project Along A Vector output, 126
project-based numbering scheme, 36
Project Curve To Surface dialog box, 126, 127
Project Curve To Surface tool, 125–126, 127
Project Editor, 664
Project File screen, 31, 31
Project Flat Pattern tool, 285–287, 286
Project Geometry tool, 76–77, 79

adaptivity, 403
Projected Loops, 334
sweeps, 203, 206
working with, 110–111, 111

Project tab, 238, 653
Project To Closest Point output, 126
projected dimensions, 591
Projected Loops, 334
projected views, 54, 54, 562–564, 563
projecting geometry, 75–77, 76–77, 110–111, 111
projects and project fi les

Content Center fi les, 26–27, 341, 341
creating, 29–31
description, 22–23
fi le types, 28–29
library folders, 26
multiuser, 38–39
search paths, 23–26, 23, 25, 27
settings, 32–38, 32, 37–38
switching and editing, 31

Projects dialog box, 32–38, 32, 44, 887
Promote Confi guration To Model option, 781
Promote Dimensions To Sketch option, 670
promoting components, 460
prompted entry for title blocks, 547–548
prompting, dynamic, 75
Propagate To Parent View option, 576
properties

categories, 347–349, 348
forms, 905–909, 907–908
iProperties. See iProperties
welds, 501–502, 502, 506–507, 507

Properties area for forms, 907
Property Expression dialog box, 410, 410
props, 742, 742
Publish dialog box, 686
Publish Guide dialog box, 351, 352
Publish Guide wizard, 724
Publish Presentation dialog box, 531–532, 531
Publish tool, 617
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Publish To Studio tool, 756
publishing

BIM for, 630–632, 631
DWF fi les, 531–532, 653, 686, 687
Frame Generator members, 720–723, 720–723
parts, 350–352, 351–352, 724

pucks, 16
Punch Representation tab, 298
punch tables, 612–613, 613
Punch tool, 272–274, 273
Punch Tool dialog box, 273–274, 332–333, 332
punches

annotations, 306, 307–308
and iFeatures, 329–333, 330–332
notes, 610–611, 611

Purchased BOM structures, 396, 411
Purchased components, 139
Purge Old Versions option, 651

Q
Quality setting

graphics cards, 446
shadows, 733

Quick Access toolbar, 14, 14–15, 729
quotation marks (“) for text, 878, 882, 895

R
radial dimensions, 584, 584
radius

bend, 136
dimensions, 584, 584, 586

Radius Fill option, 499, 499
rails

lofts with, 208, 208–209
sweeps, 204, 204

raising values to a power operator, 904
RAM

assemblies, 450
Content Center, 340
workstations, 444–445

random function, 242
ranges for stress analysis parameters, 779
Raster View option, 560
Raster View Only option, 466
raster views, 449
read-only libraries, 33–34
real-time BOM databases, 407
Rebuild All tool, 252, 301
recipes, part, 253
Recognize Extrude option, 628
Recognize Revolve option, 628
Recognize Sweep option, 629
Record Animation tool, 748
recording explosions, 528–529

Recover option, 198, 198
recovering model dimensions, 587–588
Rectangle section properties, 713–714, 713
Rectangle Three Point option, 95, 95
rectangles

sketched, 48–49, 49
three point, 94–95, 95–96

rectangular holes, 192–194, 193–194
Rectangular Pattern dialog box

pattern parameters, 193–194, 193
patterns along curves, 230, 231
rectangular patterns, 227–228, 228
solid patterns, 233–234, 233–234

Redefi ne Alignment or Position option, 849
Redefi ne Feature option, 824
Redefi ne Point option, 832
Redo tool, 15, 15
Reduced Memory Mode option, 472
redundancy for dynamic simulations, 790–791, 791
redundant constraints, 381
RefDes property, 822
Reference BOM structures, 396, 411
reference components, 139
reference data in assembly drawings, 603–604, 604
reference parameters, 240, 882
Referencing Files Found window, 645, 645
refi ning 3D sketches, 129
refl ections

displaying, 740
surfaces, 745

Refold tool, 283–285
Refresh Out-Of-Date Standard Parts During Placement 

option, 345
Refresh tool for frames, 711
Region Properties tool, 660, 713
Related Relationship Failure Analysis option, 381
Relationship Audio Notifi cation option, 376
Relationship Redundancy Analysis option, 381
relationships, 8–9
relative paths, 37
Relax If No Equation option, 133
release connections, 784
remainder operator, 904
remote force loads, 769
Remove Details tool, 627, 627
Remove End Treatments tool, 704, 710–711
Remove Faces option, 210
Remove Geometry By Visibility option, 472
Remove Object Line Weights option, 65
Remove Participant command, 407
removing

adaptivity, 404–405, 404
unneeded features, 476–478, 476–477

Rename Browser Nodes tool, 711
renaming

DWF fi les, 653
features, 171
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fi les, 642
parts, 711
rules, 898

Render Animation dialog box, 759–760, 759
Render Image dialog box, 743

General tab, 744
Output tab, 744–745
Style tab, 745–746, 745

Render tab, 728, 728
rendering

images, 743–746, 745–746
video and animations, 759–760, 759

reorder tweaks, 526–528, 528
Repair Redundancy tool, 790
repairing features and sketches, 197–199, 197–198
Repeat Command, 848
Repeat Corner Round option, 275
Replace Face dialog box, 235, 235
replacing fi les, 643
replication of welds, 502
Report tool, 778
reports, design property, 659
representations

assembly fi les, 417, 418, 601–603, 602
iAssemblies, 427–431, 427–431
positional, 419–424, 420–424
view, 418–419, 419

LOD. See level of detail (LOD) representations
Representations folder, 472
resolution, screen, 457
resources, transferring, 552
rest features, 845–847, 846–847
Restore Old Version To Current Version option, 35
restoring older versions, 35
Results folder, 776
results in frame analysis, 784–785, 784
Results node, 776–777
Results pane, 717–718
Results window for Design Accelerators, 432
Retrieve Dimensions tool, 587
return on investment (ROI) calculations for hardware, 

444–445
reuse of parts and features, 309

Content Center. See Content Center
geometry, 333–339, 333, 336–338
iFeatures, 324–329, 324–327
iParts. See iParts

reviewing DWF fi les, 687, 687–688
revisions, rolling, 417
Revit application, 621–622, 628–629
revolution joints, 787
revolutions

animation, 750
turntable, 754

Revolve dialog box, 161–163, 162–163
Revolve tool for surfaces, 302

revolved parts
creating, 161–163, 162–163
cylindrical, 160–161, 160–161

Rhino fi les, 681
Rib tab, 843, 843
Rib tool for plastics design, 853–854, 855
Ribbon menu, 17–19, 18
Ribs tab, 849
right-clicking

appearance styles, 729
context menus, 12–13, 84

right-hand rule, 368
rigid joints

description, 360
working with, 382–384, 382–384

rigid link connections, 784
rigid pipe routes, 819
rigid piping, 805–806, 806
rigid tubing, 806
Rip tool, 261, 282–283, 282
rips for lofted fl anges, 261
ROI (return on investment) calculations for hardware, 

444–445
roll angle for cameras, 753
rolling joints, 788
rolling revisions, 417
Rollup option for hole tables, 600
rotary hubs, 397, 397
Rotate constraints, 359, 372–373, 372
Rotate option for Move Bodies, 221
Rotate-Translational constraint, 373–374
rotation

appearance styles, 729
Mate constraints, 362–363
parts in assembly fi les, 55–57

Rotation control for animation, 750
Rotation Snap option, 818
Rotation-Translation constraint solution, 359
rotational joints

description, 360
working with, 384–386, 385–386

rotational tweaks, 522–523, 523
round function, 242
Route tool, 825, 831
routed systems

cables and harnesses. See cables and harnesses
tubes and pipes. See tubes and pipes

rubber bumpers, 720–723, 720–723
Rule Authoring pane, 890–891, 891
Rule Fillet tool, 844–845, 845
Rule Name dialog box, 891, 894, 898
rules

iLogic. See iLogic
sheet metal, 287

creating, 287–289, 288
vs. styles, 289
unfold, 289–295
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Rules tab
iLogic, 885, 885, 891
tubes and pipes, 808

Rules Triggered By Events dialog box, 914
Runner tool, 859
runners

creating, 862–864, 862–863
description, 859
sketches, 860, 861

running simulations
dynamic, 797–799, 798–800
stress analysis, 775

runs, tubes and pipes, 803–805, 804–805

S
safety factor

constraints, 780
stress analysis, 777

Same Scale option, 777
SAT (Standard ACIS Text) fi les, 676–677
Save All option for sketches, 90
Save As option for sketches, 90
Save As Pack And Go option, 644
Save As Type option

IGES fi les, 676
SAT fi les, 677
STEP fi les, 676

Save At Import File Location option, 674, 678
Save Copy As command

SAT fi les, 677
sketches, 90
STEP and IGES fi les, 676

Save Copy As dialog box, 73
Save Copy As Template option, 40, 537

document settings, 73
parts, 141
sketches, 90

Save Curve tool, 796
Save dialog box for images, 744
Save icon, 15, 15
Save In Workspace option, 674, 676, 678
Save Item Overrides To BOM command, 606
Save options for sketches, 90
Save Rendered Image option, 744
Save Simulation option, 799
Save Styles To Style Library tool, 559
Save tab for iProperties, 238, 654
saving

cameras, 526, 526
fl at patterns, 299
Frame Generator members, 693
rules, 888

scales, lighting style, 734
Scene Styles dialog box, 738

Background tab, 738–739
Environment tab, 739–740
matching cameras to images, 740–741, 740–741

screen resolution, 457
Screen Saver tab, 456–457
screw joints, 788
Sculpt tool, 215–216, 215–216
search paths, 23–26, 23, 25, 27, 33
search times, 36
secondary 2D sketches, 48–49, 49
secondary 3D features, 50, 50
Section Dimensions dialog box, 212, 212
Section View dialog box, 565, 568
Section View Preview As Uncut option, 449
section views, 565–568, 566–568
sections

participation, 573
properties, 712–714, 712–714

Segment Properties dialog box, 832, 833
segments

placing and editing, 830–832, 831, 833
wire, 827

Select All In Camera tool, 463
Select All Inventor Dimensions option, 587
Select All Occurrences button

Defi ne Envelopes, 624
Include Components, 623, 623

Select All Occurrences tool, 462
Select Assembly dialog box, 519–520, 519, 525
Select At Import File Location option, 677
Select Body Priority tool, 461
Select By Layer option, 669
Select By Object option, 669
Select By Plane tool, 463
Select By Size dialog box, 462, 462
Select Case statement, 880–881
Select Center Line option, 212–213
Select Component dialog box, 552
Select Component Offset tool, 463
Select Component Priority tool, 461
Select Component Size tool, 462
Select Components control, 750–751
Select Constrained To tool, 462
Select Design Constraint dialog box, 780, 780
Select Dimensions button, 587
Select External Components tool, 463
Select Faces And Edges tool, 462
Select Feature Priority tool, 462
Select Internal Components tool, 463
Select Libraries screen, 31, 31
Select Material tool, 858
Select Orientation tools, 811
Select Other Direction option, 812
Select Other tool, 365, 365, 814
Select Part Priority tool, 461
Select Placement command, 608
Select Save Location option, 674, 677–678
Select Sketch Features tool, 462
Select Source Drawing And Resources screen, 646, 647
Select Sphere Offset tool, 463
Select Target Drawings screen, 647
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Select tool, 15, 15
Select View tool, 307
Select Visible Only tool, 462
Selection command, 599
selection tools, 461–463, 462
selections

objects, 190–191
removing components from, 521

self-draining piping, 806
self-intersecting features, 203
semi-isolated projects, 29
Separation contact types, 771
Separation/No Sliding contact types, 771
Sequence View, 528
sequential product-based numbering scheme, 37
sequential project-based numbering scheme, 36
Sequential Reorder iPart method, 317
Sequential Reorder option, 297
sequential tasks, scheduling, 652
Set Defer Updates (Drawings Only) option, 651
set values, functions for, 878
setback fi llets, 174, 174
Shaded Views, 451
Shading tool, 777
shadows

displaying, 739
setting, 733–734, 733–734, 736

Shadows tab, 733–734, 733–734, 736
Shaft Generator, 341
shapes

Frame Generator members, 695–696, 695
solids for, 219–223, 219–223

shared projects, 29
sharing drawings, 616–617. See also exchanging data
Sharp option, 750
Sharp Point option, 214
sharp shadows, 733, 733
sheet formats, 551–552
sheet metal

annotations, 305–307, 305–306
bends, 280–282, 281

centerlines, 610
notes, 610–611, 611
tables, 611–612, 612

Contour Flange tool, 256–258, 257, 266–268, 266, 
268

Contour Roll tool, 258–259, 258
converting, 302–303
Corner Round and Corner Chamfer tools, 274–275
Corner Seam tool, 275–278, 275, 277–278
Cut tool, 271–272
design annotation, 303–307, 304–306
drawings, 609–613, 611–613
Face tool, 256, 256, 269–271, 270
feature placement, 329, 331–333, 333
Flange tool, 262–264, 262–263
Fold tool, 278–279, 279
help, 289

Hem tool, 268–269
imported parts, 302–303
iPart factories, 300–301, 300
iParts, 317, 317
Lofted Flange tool, 259–261, 260–261
non-sheet-metal features, 301–302
overview, 255–256
patterns

annotations, 307–308
fl at, 609–610, 611

Project Flat Pattern tool, 285–287, 286
punch tables, 612–613, 613
Punch tool, 272–274, 273
Rip tool, 282–283, 282
rules, 256, 287–295, 288
styles and templates, 295
tables for, 597
Unfold and Refold tools, 283–285, 284–285

Sheet Metal Defaults dialog box, 293, 295
Sheet Metal Punches Root setting, 273
sheets

multiple, 540
reducing, 469
size, 539–540

Shell tool
for features, 839–841, 840
lofts with, 210–211
sheet-metal, 301

shortcuts
to frequently used fi les, 34–35
project, 39

Shot dialog box, 758–759
shots

camera, 757
Video Producer, 757–759

Shoulder Radius setting, 849
Show All Constraints key, 69
Show All option, 506
Show All Degrees of Freedom option, 86–87
Show Command Prompting (Dynamic Prompts) 

option, 75
Show Consumed Only option, 506
Show Dimensions option, 661
Show Me Animations screen, 577
Show Me Animations tool, 367
Show Parameters option, 778
Show Preview option, 361
Show Preview As option, 439
Show Refl ections option, 739–740
Show Relationships tool, 364
Show Shadows option, 739
Show Shiny Highlights option, 746
Show Sick Relationships tool, 364
Show Trails option, 524
Show Unconsumed Only option, 506
Show Violations option, 829
Shrink Fit/No Sliding contact types, 772
Shrink Fit/Sliding contact types, 772



994 | SIGN FUNCTION • SLIDING JOINTS

sign function, 242
Silhouette Curve tool, 128, 842
silhouette curves, 128, 128
simple sketches, 142
simplifi cation

benefi ts, 7
BIM for, 622

Create Simplifi ed Part tool, 625–626, 626
Defi ne Envelopes tool, 624–625, 624–625
Include Components tool, 622–624, 623–624
part models, 627–629, 627–628

parts, 476–478, 476–477
sketches, 143–144, 143–144

Simulate dialog box, 775
Simulation Guide, 765
Simulation Player, 797–798, 798
Simulation Properties dialog box, 770, 801
Simulation Settings option, 786, 786
Simulation_Timeline parameter, 756
simulations

dynamic. See Dynamic Simulation
stress analysis. See stress analysis

sin function, 241
Single Body Keep Seams Between Planar Faces option, 

472
Single Composite Feature option, 472, 674, 677–681
single IPJ setups, 24–25
single-line If statements, 880
Single Point rips, 282
Single Segment option, 827
single-user projects, 28

description, 29
Inventor Project Wizard, 30–31, 30–31
settings, 32–38, 32, 37–38
Tool panel, 37–38, 37

sinh function, 241
size

fi les, 22, 538
fl anges, 264–266, 265
forms, 912
images, 744
sheets, 539–540

Size tab, 332
skeleton models, 697
skeletons, 691
sketch-based features, 7–8
sketch-based holes, 190–191, 191
sketch center points, 145
Sketch Dimension tool, 586
sketch dimensions, 5–6, 7
Sketch Doctor dialog box, 198
Sketch On New Part Creation option, 46, 46, 132
Sketch Select command, 696–698
Sketch tab, 11, 11

Application Options, 68–72, 69
Document Settings, 135–136, 136
options, 74
origins, 82

sketched features, 188, 192
sketched routes, 814–817, 815–816
sketched slots, 110
sketched symbols

importing blocks as, 671
working with 536–538, 549

sketches, 67
3D. See 3D sketches
activating, 91
anchoring, 189
arcs, 108–109, 108–109
AutoCAD geometry, 116–119, 118–119
base 2D, 46–47, 46–47
basics, 73–74
best practices, 129–130
borders, 541
centerlines, 114–115, 114
constraints. See constraints
construction geometry, 91–92, 91
copying, 337–338, 338
creating, 78–79, 78
deleting, 78
dimensions, 79–80, 79, 112–115, 112–116
driven dimensions, 96–99, 96–99
editing, 194–196, 194, 196
existing sketches, 74–75, 74–75
fl at patterns, 300
from images, 116–117, 117
layout, 398–401, 400
lines, 81–83
measuring, 114, 116
options and settings, 68–72, 68–72
part fi les from templates, 80–81, 82
points/center points, 109, 110
polygons, 92–93, 92–93
profi les in, 47–48, 47
projecting geometry, 75–77, 76–77, 110–111, 111
repairing, 197–199, 197–198
saving, 90
secondary 2D, 48–49, 49
simplifying, 143–144, 143–144
tangents, 109, 110
three-point rectangles, 94–95, 95–96

Skip All Unresolved Files option, 465
Skip Files with Unresolved References option, 651
Skip Libraries option, 645
Skip Migrated Files option, 651
Skip Styles option, 645
Skip Templates option, 645
Skylight tool, 732–733
slash (/) operator, 904
Slice All Parts option, 569
slices, 565, 568–569
slider joints

description, 360
working with, 386–389, 387–388

sliding bearings, 58–60, 59–60
sliding joints, 788–789
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Sliding/No Separation contact types, 771, 772
sliding point curve joints, 789
slip latches, 389–390, 390
slots, sketched, 110
Smart Set Of Confi gurations setting, 780
smooth constraints, 107, 107
Smooth option for animation path, 750
Smooth Cutout option, 574
Smooth (G2) Condition option, 214
Snap Fit features, 851–853, 851, 853
Snap Spacing settings, 73, 136
Snap To Grid option, 70
Snaps Per Minor setting, 136
snapshot views, 418
soft shadows, 733, 733
Software Graphics setting, 446
Solid Body Merging Out Seams Between Planar Faces 

option, 472
Solid Color option, 738
solids

description, 667
extruding, 152–153, 152–153
importing, 669–670, 669
multiple, 217–219, 217–218
pattern, 233–236, 233–236
for shapes, 219–223, 219–223
split, 221

Solids To Single Part File option, 670
Solidworks fi les, 680–681
Solve Off state, 435
solve states for Design Accelerators, 434–436, 435
Space series tools, 16
spar rib settings, 843, 843
spatial joints, 787
Specifi cation tab, 178, 178
spherical joints, 787
spiral patterns, 231–232, 233
Spline Fit Method settings, 70, 70
Spline tool, 120, 120
splines

3D, 119–120, 120
translating, 299, 299

split faces for cosmetic welds, 490, 490
Split features and splits

creating, 841–842
lines, 96
for loads, 770
surface faces, 302
for welds, 503–505, 503–505

Split Solid tool, 841
split solids, 221
Split tool, 841–842

cosmetic welds, 490
description, 221

splitting tables, 598
Spot tab, 737
spotface settings, 182, 182
spotlights, 735, 737

spreadsheets
for holes, 180–181
tables for, 597

Spring contact types, 771–772
spring joints, 789
Sprue Bushing tool, 870–871
sprue bushings, 870–872, 870–872
sqrt function, 242
stacked circular extrusions, 160–161, 160–161
stacked features, 316
Standard ACIS Text (SAT) fi les, 676–677
Standard for the Exchange of Product (STEP) model 

data, 673–676, 674, 676
standard joints, 787
Standard spline fi ts, 70, 70
Standard tab, 134, 134
standards

company, 40
editing, 553–556, 556
templates, 538

Start Point Mate constraint, 374
start points for routes, 812, 812
static stress analysis vs. modal, 765–766
status bar settings, 454, 455
Status tab, 238, 654
STEP (Standard for the Exchange of Product) model 

data, 673–676, 674, 676
Stiffening Ribs setting, 849
Stitch tool, 210
stitching surfaces, 209–210, 209–210
strength of bolts, 438–440
stress analysis, 763

dynamic simulation information for, 801, 802
exporting to FEA, 800, 801
frames, 782

connections, 783–784, 784
constraints, 782–783, 782
loads, 783, 783
results, 784–785, 784

introduction, 763–764
Simulation Guide, 765
simulations, 764–765

constraints, 767–768, 767–768
contact conditions, 770–772, 771–772
display tools, 777–778, 778
external linked fi les from, 775
loads, 768–770, 768
materials, 766–767, 767
meshes, 773–774, 774
model simplifi cation, 766, 766
parameter studies, 778–781, 778–781
results, 775–777, 776
running, 775
static stress vs. modal analysis, 765–766
thin bodies, 772, 773

string data type, 878
structural profi les, 691
Structural Shape Authoring tool, 720–723, 720–723
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structural shape for Frame Generator members, 
695–696, 695, 720–723, 720–723

structure BOM designations, 395–396, 395, 411–412, 
412

Structured tab, 414, 414
Studio. See Inventor Studio
Style and Standard Editor, 553

default objects, 555–556, 556
dimensions, 593
hole tables, 599
mapping materials to hatch patterns, 567
rules, 287–289, 288, 291–292
sheet-metal drawings, 610
sheet-metal rules, 295
styles, 557–558

Style Editor dialog box, 594
Style Library Manager, 647–649, 648
Style Management Wizard, 295
Style tab

Render Animation, 759
Render Image, 745–746, 745

styles, 728
administering, 559
appearance, 728–731, 729–731
balloons, 607
copying, 648
creating, 536–537, 537, 557–558
dimensions, 594
editing, 553–556, 556
general tables, 597
hole tables, 598–601, 599–600
images, 741–746, 742, 745–746
libraries, 33–34, 40
lighting, 731–737, 733–734
object defaults, 553–556, 556
parts lists, 605
vs. rules, 289
scenario, 554
scene, 738–741, 739–741
settings. See Style and Standard Editor
sheet metal, 295
Style Library Manager, 647–649, 648
substyles, 558–559
tubes and pipes, 805–810, 806–807
understanding, 559

Styles Editor, 562
subassemblies, 355

benefi ts, 392–393, 393–394
fl exibility, 401–402, 401
iLogic, 916
LOD in, 465, 474–476, 475
phantom, 459

substitute LODs, 425–426, 426, 471–474, 473–474
substyles, 558–559
subtabs area for rules, 891, 891
subtraction operator, 904
Summary tab for iProperties, 238, 653

Summary window for Design Accelerators, 432
Suppress (Override) option, 422, 422
suppressing

features
iLogic, 900–903
iParts, 315, 316
parts simplifi cation, 476–478, 476–477

vs. visibility, 425
surface-based workfl ows, 301–302
surfaces, 667

extruding, 150–152, 151–152
lofts, 209–210, 209–210

Sweep dialog box, 123, 123, 203–204, 203
Sweep tool, 302
sweeps, 201

2D paths, 202, 202
3D sketches, 123–124, 123
options, 204–207, 204–207
profi les, 202–204, 203
surface-based workfl ows, 302

swipe left transitions, 757
swipe right transitions, 757
switching projects, 31
symbols

leadered, 595–596, 595
sketched, 548–551, 549

Symbols dialog box, 549
symmetric constraints, 106–107, 106
Symmetric Gap option, 276
Symmetry constraints

assemblies, 371–372, 371
description, 359

syntax of functions, 892
System Properties tab, 456
system settings, 455–457, 456

T
Table dialog box, 612
tables

bend, 291–294, 292, 611–612, 612
general, 597
holes, 598–601, 599–600
iParts, 312–314, 313–314
punch, 612–613, 613
splitting, 598

tabs, adding, 913–915, 914
Tabs area

forms, 907
rules, 890, 891

tan function, 241
tangent arcs, 108–109
Tangent Condition, 214
Tangent constraints

overview, 368–369, 369
placing, 100–101, 100

tangent edge display, 604, 605
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Tangent option, 214–215
Tangent To Plane option, 215
tangents

automatic, 109, 110
for work planes, 167–168, 167–168

tanh function, 241
taper sweeps, 203, 203
Taper tool, 148
Tapped Hole Diameter setting, 138
Tapped Hole option, 191
Target constraints, 359
target placement for cameras, 753
task-based tools, 20–21, 20
Task Scheduler, 649–650

batch plots, 652
custom tasks, 652
for migrating fi les, 650–652, 650–652
multiprocess settings, 652, 653
sequential tasks, 652

TechSmith codec, 760
templates, 40, 40

available, 395
borders, 540–541
creating, 141, 536–537, 537
drawing resources, 539, 539
fi le formats, 538
harnesses, 834
for importing data, 672
IPN, 518
locations, 537
multiple sheets, 540
part fi les from, 80–81, 82
parts, 45, 45
plastics design, 839, 839
sheet metal, 295
sheet size, 539–540
standard, 538
title blocks. See title blocks
user parameters in, 243

Templates folder, 23
temporary LODs, 426
Terminate Feature On Extended Face option, 154
testing iParts, 321
text

center marks, 609
drawing, 597
sheet metal annotations, 306, 306
title blocks, 541–544, 543

Text data type, 878, 882
Text tab, 609
Text tool, 306, 597
Thicken/Offset dialog box, 163
Thicken/Offset features, 837–838, 839
thin bodies in stress analysis, 772, 773
Thread dialog box, 178, 178
Thread.xls fi le, 180–181
threaded holes in plates, 438

threads, 177–178
adding, 160
cosmetic, 178–179, 178
fasteners, 848
holes, 180–181, 191, 192
iParts, 316
notes, 594–595, 595
physical, 179–180, 180

Three Point Rectangle tool, 94–95
Through All option, 846, 846
Time Range section, 759, 760
time settings

animation, 749–750, 759, 760
cameras, 754

timeline
animation, 747–749, 748
Video Producer, 758–759

tinting color wheel, 729
title bar, 14–15, 14–15
title blocks

creating, 541–544, 543
Drawing Resource Transfer Wizard for, 647
fi le properties, 546–547
fi lling out, 917
importing, 671, 671
iProperties, 544–545
logos, 469
prompted entry, 547–548

To Next option, 156–157, 157
To option, 153–155, 154–155
Toggle Repeat tool, 748
toggled features, 316
Tolerance column, 240
Tolerance dialog box, 245, 247–248
tolerances, 244

vs. allowance, 245
dimensions, 593–594, 593
fi t, 248–250, 250
global, 245–247, 246
holes, 184–185, 184
parts, 240
settings, 140, 140
in sketches, 244–245, 245

Tool panel, 37–38
Toolbox for forms, 907
tools, 621

Add-in Manager, 664
Autodesk Multi-Sheet Plot, 663, 663
AutoLimits, 633–637, 633–634, 636–637
BIM exchange. See Building Information Modeling 

(BIM)
CER, 662–663
CIP, 662
vs. commands, 12
Design Assistant. See Design Assistant
Drawing Resource Transfer Wizard, 646–647, 647
iProperties, 653–659, 654, 656–658
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Measure, 659–662, 660–661
Project Editor, 664
Style Library Manager, 647–649, 648
task-based, 20–21, 20
Task Scheduler, 649–653, 650–652

Tools tab, 13, 18
iProperties, 544
origin planes, 46
shortcuts, 39

top-down design
effi cient assembly workfl ow, 395–398, 395–398
overview, 394–395, 394

top-level assemblies, 804
torque forces for joints, 792–793, 793
torus shapes, 169, 169
Total Rebuild option, 651
tracking systems for part numbering, 37
trails, tweak, 523–524
transferring resources, 552
transition fi ts, 248–250
Transitional constraints, 374–375, 375
transitions, 757–759
translating

DWG and DXF fi les, 668–672, 669–672
splines, 299, 299

translational constraints, 791
translators, fi le, 678–682, 682
translucency, turning off, 210
transparent backgrounds, 744
Tree View tool, 343
Tresca-Guest method, 717
triads, 121–124, 121, 123
triggers

events, 889–890, 913–915, 914
iTriggers, 889
multiple solids, 217–219, 217–218

trim and extend end treatments, 707–708, 707–708
Trim/Extend to Face tool, 707–708, 707–708
Trim to Frame dialog box, 708, 708
trim to frame member end treatments, 708, 708–709
Trim tool, 96
troubleshooting parts, 250–253, 250–252
true dimensions, 591
True/False data type, 878, 882–883, 883
True Refl ections setting, 745
Tube & Pipe Authoring dialog box, 808–809, 809
Tube & Pipe Styles dialog box, 806–808, 807, 817
tubes and pipes, 803

authoring, 808–810, 809–810
placing fi ttings, 810–811, 810–811
route creation, 811–821, 812–818
routes, runs, and assembly structures, 803–805, 

804–805
styles, 805–810, 806–807

turntable function for cameras, 754
Turntable tab, 754
tutorials, 17, 44

Tweak Component dialog box, 520–522, 520
Tweak Component tool, 523
tweaks

components used in, 525
drag and drop, 523, 524
editing, 524, 525
group, reorder, and animate, 526–528, 526–527
linear, 520–522, 520–522
multiprocess settings, 652, 653
rotational, 522–523, 523
trails, 523–524

Two Point Center Rectangle tool, 48, 49

U
UCS (User Coordinate System), 376, 631, 631
UCS Settings dialog box, 138
Un-split Table option, 598
Uncomment button, 903
Unconsumed Bead tool, 506
underscores (_) for parameter names, 94
Undirected Angle constraints, 359, 365, 367
Undo File Size option, 453
Undo tool, 15, 15
unfold rules, 289

bend tables, 291–294, 292
K-factor value, 289–291, 290

Unfold tool, 283–285, 284–285
unfolding parts, 283–285, 284–285
Uniform Spacing option, 581
Unigraphics fi les, 680
Unique Face Thickness setting, 210–211
Unit/Type column, 240
units

dimensions, 593
for importing data, 672
part parameters, 240
settings, 134–135, 135

Units tab, 134–135, 135, 593
Unroute tool, 831
Update Copied Model iProperties option, 544
Update Mass Properties Of All Rows icon, 410
Update option, 643
Update Physical Properties on Save option, 453
Update Styles tool, 559
Update tool, 15, 15, 97, 97
updates

background, 449–450
meshes, 774, 774

UpdateWhenDone function, 893
Upper option for tolerance, 244
Use Application Options option, 738
Use Classic Context Menu option, 74, 145
Use Default File Names option, 670
Use Density option, 717
Use Document Settings option, 134
Use Offset As Resting Position option, 377
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Use Part-Based Measure For Assembly Mesh option, 
773

Use Refl ection Image setting, 740
Use Shear Displacement Ratio option, 717–718
Use Sheet Plane option, 591
Use Standard Tolerancing Values option, 140, 246
Use Style Library option, 34, 559
Use Style Settings option, 736
Use Vector Components option, 767
User Coordinate System (UCS), 376, 631, 631
User Coordinate System settings, 138
user parameters, 240, 882
Using Unique File Names option, 36

V
Value List Editor dialog box, 894
values, functions for, 878–879
variable edge fi llets, 174, 174
Vault data management program

vs. Design Assistant, 643
implementing, 39
multiuser projects, 38–39
project fi les, 30
purpose, 28, 39

velocity
environmental constraints, 792, 794, 795
stress analysis simulations, 770

Velocity Profi le setting, 749–750
versioning settings, 35
vertical constraints, 83, 83, 104–105, 104
vertices for Mate constraints, 365, 365
Video and Tutorials tools, 17
Video Producer, 757–759, 758
video rendering, 759–760, 759
View Camera Projection setting, 19
View command, 599
View Options icon, 413
View Path option, 835
view preview display, 468
view representations (ViewReps)

overview, 418–419, 419
performance, 463

View tab, 18–19, 18
View Transition Time (Seconds) setting, 452
ViewCube tool, 16–17, 16, 19, 75
views, 560

associative, 601, 603
base, 51–53, 52–53, 560–562
break, 575–576
breakout, 570–573, 570–572
cropping, 577
current, 743, 754
detail, 573–575, 574
dimensions in, 591–592, 592
draft, 577
drawing, 467–468

hole tables, 599
IPN, 518–520, 518–520
isometric, 591–592, 592
moving and copying, 564–565
multiple, 525, 525
overlay, 577–578
preferences, 562
projected, 54–55, 54, 562–564, 563
section, 565–568, 566–568
sheet metal design, 303–305, 304–305
slices, 568–569
weldment, 613–614, 614–615

Virtual Components setting, 396
virtual memory

paging fi le size, 456
workstations, 444

Virtual Memory dialog box, 456, 456
visibility

assembly drawings, 602–603
vs. suppressing, 425
work features, 172, 850

Visibility panel, 18
visual effects, disabling, 456–457
Visual settings, 457
Visual Style property, 909
visual styles, 18
visualization, 727
volume, overriding, 655
Von Mises Stress category, 776

W
warm colors, 736
web features, 853–854, 855
Weld Bead tab, 501–502
Weld Caterpillars dialog box, 513–514, 513
welded piping, 806–807
welding joints, 787
Welding Symbol dialog box, 507–508, 507, 512
weldment design, 405, 481

BOM and parts lists, 514–515, 515
calculators, 492, 492
combinations, 502–503, 502–503
communication for, 485
cosmetic, 487–491, 488, 490–491
documentation, 507–514
fi llet, 491–497, 493–497, 502–503, 503
groove, 497–500, 497–500, 502–503, 502
machining operations, 500–501, 500–501
mass properties, 506–507, 507
methodologies, 481–485, 482–484
modeling preparations, 485–487, 486
properties, 501–502, 502
replication, 502
split technique, 503–505, 503–505
stages, 509–511, 509–511
views, 613–614, 614–615
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weld beads
creating, 491–492
property reports, 506–507, 507

weld symbol, 505–506, 506, 512
workfl ows, 514

Weldment Features panel, 486, 487
welds stage, 509, 509, 613
What’s New button, 18
wheel mouse, 16
Where Used dialog box, 640–641, 641
width

fl anges, 264–266, 265
images, 744

Width setting, 744
Width Extents settings, 264
Window Selections, 190–191
Windows fi le properties. See iProperties
Windows Media Video (WMV) format, 759–760
Windows panel, 19
wipe transitions, 757
Wire Properties dialog box, 833, 833
wires, 667, 826–828, 827
WMV (Windows Media Video) format, 759–760
work axes, 170, 170
work features, 163, 163

visibility vs. display, 172
work axes and work points, 170–171, 170–171
work planes, 164–170, 164–169

work planes, 80
creating, 164–170, 164–169
fi ltering, 463

work points, 170–171, 171
workfl ows

design. See assemblies
surface-based, 301–302
weldment, 514

workgroup search paths, 33
workspaces, 24, 33
workstations, 443

hardware, 444–447
memory, 444–445

worm gear joints, 788
Wrap To Surface output, 126
wrapper assemblies, 742, 742

X
XDIM property, 599
XLS fi les, 22, 597
XML File Export dialog box, 831

Y
YDIM property, 599

Z
zero-value dimensions, 321
zoom setting for cameras, 753
Zoom tool, 17 
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